Documentation for Confluence 5.0
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Editing an Office Presentation from Confluence</td>
<td>364</td>
</tr>
<tr>
<td>Installing the Firefox Add-On for the Office Connector</td>
<td>367</td>
</tr>
<tr>
<td>Importing Content Into Confluence</td>
<td>376</td>
</tr>
<tr>
<td>Importing Content from Another Wiki</td>
<td>377</td>
</tr>
<tr>
<td>Importing Pages from Disk</td>
<td>377</td>
</tr>
<tr>
<td>Sharing Content</td>
<td>378</td>
</tr>
<tr>
<td>Network Overview</td>
<td>379</td>
</tr>
<tr>
<td>Likes and Popular Content</td>
<td>381</td>
</tr>
<tr>
<td>User Status Updates</td>
<td>382</td>
</tr>
<tr>
<td>Using Mentions</td>
<td>385</td>
</tr>
<tr>
<td>Emailing a Page</td>
<td>387</td>
</tr>
<tr>
<td>Organising Content</td>
<td>388</td>
</tr>
<tr>
<td>Exporting Confluence Pages and Spaces to Other Formats</td>
<td>388</td>
</tr>
<tr>
<td>Exporting Confluence Pages and Spaces to HTML</td>
<td>388</td>
</tr>
<tr>
<td>Exporting Confluence Pages and Spaces to PDF</td>
<td>390</td>
</tr>
<tr>
<td>Exporting to a Word document</td>
<td>404</td>
</tr>
<tr>
<td>Exporting Confluence Pages and Spaces to XML</td>
<td>405</td>
</tr>
<tr>
<td>Commenting on pages and blog posts</td>
<td>406</td>
</tr>
<tr>
<td>Linking to Comments</td>
<td>408</td>
</tr>
<tr>
<td>Printing Confluence Pages</td>
<td>409</td>
</tr>
<tr>
<td>Managing Changes and Notifications and Tasks</td>
<td>410</td>
</tr>
<tr>
<td>Watching a Page or Blog Post</td>
<td>411</td>
</tr>
<tr>
<td>Watching a Space</td>
<td>412</td>
</tr>
<tr>
<td>Managing Watchers</td>
<td>415</td>
</tr>
<tr>
<td>Subscribing to Email Notifications of Updates to Confluence Content</td>
<td>415</td>
</tr>
<tr>
<td>Subscribing to RSS Feeds within Confluence</td>
<td>420</td>
</tr>
<tr>
<td>Using pre-specified RSS feeds</td>
<td>421</td>
</tr>
<tr>
<td>Using the RSS Feed Builder</td>
<td>422</td>
</tr>
<tr>
<td>Subscribing to a Network RSS Feed</td>
<td>424</td>
</tr>
<tr>
<td>Managing Notifications in Confluence</td>
<td>425</td>
</tr>
<tr>
<td>Managing Tasks in Confluence</td>
<td>429</td>
</tr>
<tr>
<td>Finding Content</td>
<td>433</td>
</tr>
<tr>
<td>Searching Confluence</td>
<td>436</td>
</tr>
<tr>
<td>Text Tokenisation and Filtering</td>
<td>444</td>
</tr>
<tr>
<td>Confluence Search Syntax</td>
<td>444</td>
</tr>
<tr>
<td>Confluence Search Fields</td>
<td>448</td>
</tr>
<tr>
<td>Ranking of Search Results</td>
<td>452</td>
</tr>
<tr>
<td>Organising Content</td>
<td>455</td>
</tr>
<tr>
<td>Searching the People Directory</td>
<td>455</td>
</tr>
<tr>
<td>Organising Content</td>
<td>457</td>
</tr>
<tr>
<td>Working with Pages</td>
<td>457</td>
</tr>
<tr>
<td>Moving a Page</td>
<td>458</td>
</tr>
<tr>
<td>Copying a Page</td>
<td>460</td>
</tr>
<tr>
<td>Renaming a Page</td>
<td>461</td>
</tr>
<tr>
<td>Deleting a Page</td>
<td>462</td>
</tr>
<tr>
<td>Viewing All Pages in a Space</td>
<td>464</td>
</tr>
<tr>
<td>Changing the Sequential Order of Pages</td>
<td>465</td>
</tr>
<tr>
<td>Managing Orphaned Pages</td>
<td>467</td>
</tr>
<tr>
<td>Managing Undefined Pages</td>
<td>468</td>
</tr>
<tr>
<td>Using the Documentation Theme</td>
<td>468</td>
</tr>
<tr>
<td>Viewing Page Information</td>
<td>472</td>
</tr>
<tr>
<td>Viewing Recently Visited Content</td>
<td>473</td>
</tr>
<tr>
<td>Page History and Page Comparison Views</td>
<td>474</td>
</tr>
<tr>
<td>Using a WebDAV Client to Work with Pages</td>
<td>477</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Working with Blog Posts</td>
<td>477</td>
</tr>
<tr>
<td>Working with Spaces</td>
<td>479</td>
</tr>
<tr>
<td>Viewing All Confluence Spaces</td>
<td>481</td>
</tr>
<tr>
<td>Creating a Space</td>
<td>484</td>
</tr>
<tr>
<td>Setting Up your Personal Space</td>
<td>485</td>
</tr>
<tr>
<td>Administering a Space</td>
<td>486</td>
</tr>
<tr>
<td>Editing Space Details</td>
<td>488</td>
</tr>
<tr>
<td>Deleting a Space</td>
<td>489</td>
</tr>
<tr>
<td>Backing Up and Restoring a Space</td>
<td>490</td>
</tr>
<tr>
<td>Archiving a Space</td>
<td>490</td>
</tr>
<tr>
<td>Viewing Space Activity</td>
<td>492</td>
</tr>
<tr>
<td>Viewing Recently Updated Content</td>
<td>493</td>
</tr>
<tr>
<td>Working with Mail Archives</td>
<td>494</td>
</tr>
<tr>
<td>Adding a Mail Account</td>
<td>495</td>
</tr>
<tr>
<td>Deleting Mail</td>
<td>496</td>
</tr>
<tr>
<td>Fetching Mail</td>
<td>497</td>
</tr>
<tr>
<td>Importing Mail</td>
<td>497</td>
</tr>
<tr>
<td>Managing Mail Accounts</td>
<td>498</td>
</tr>
<tr>
<td>Working with Confluence Labels</td>
<td>499</td>
</tr>
<tr>
<td>Adding Labels</td>
<td>500</td>
</tr>
<tr>
<td>Using Labels to Categorise Spaces</td>
<td>502</td>
</tr>
<tr>
<td>Removing Labels</td>
<td>504</td>
</tr>
<tr>
<td>Using Label Macros to Categorise Wiki Content</td>
<td>505</td>
</tr>
<tr>
<td>Viewing Labels and Labelled Content</td>
<td>506</td>
</tr>
<tr>
<td>Viewing Personal Labels</td>
<td>509</td>
</tr>
<tr>
<td>Working with Favourites</td>
<td>510</td>
</tr>
<tr>
<td>Working with Attachments</td>
<td>512</td>
</tr>
<tr>
<td>Using Drag-and-Drop in Confluence</td>
<td>513</td>
</tr>
<tr>
<td>Attaching Files to a Page</td>
<td>515</td>
</tr>
<tr>
<td>Attachment Versions</td>
<td>516</td>
</tr>
<tr>
<td>Deleting an Attachment</td>
<td>517</td>
</tr>
<tr>
<td>Displaying a List of Attachments</td>
<td>518</td>
</tr>
<tr>
<td>Downloading Attachments</td>
<td>521</td>
</tr>
<tr>
<td>Editing Attachment Properties</td>
<td>522</td>
</tr>
<tr>
<td>Embedding Multimedia Content</td>
<td>522</td>
</tr>
<tr>
<td>Embedding PowerPoint Presentations in a Page</td>
<td>525</td>
</tr>
<tr>
<td>Moving an Attachment</td>
<td>527</td>
</tr>
<tr>
<td>Viewing Attachment Details</td>
<td>527</td>
</tr>
<tr>
<td>Customising Confluence</td>
<td>529</td>
</tr>
<tr>
<td>Personal Customisations</td>
<td>529</td>
</tr>
<tr>
<td>User Profile Overview</td>
<td>530</td>
</tr>
<tr>
<td>Choosing your Home Page</td>
<td>541</td>
</tr>
<tr>
<td>Customising your Personal Dashboard</td>
<td>541</td>
</tr>
<tr>
<td>Customising the Look and Feel of a Confluence Space</td>
<td>543</td>
</tr>
<tr>
<td>Applying a Theme to a Space</td>
<td>543</td>
</tr>
<tr>
<td>Configuring a Sidebar</td>
<td>554</td>
</tr>
<tr>
<td>Changing a Space's Logo</td>
<td>555</td>
</tr>
<tr>
<td>Changing the Confluence Browser Icon, aka favicon</td>
<td>556</td>
</tr>
<tr>
<td>Customising Space Layouts</td>
<td>557</td>
</tr>
<tr>
<td>Editing a Space's Colour Scheme</td>
<td>558</td>
</tr>
<tr>
<td>Styling Confluence with CSS</td>
<td>560</td>
</tr>
<tr>
<td>Requesting Add-ons</td>
<td>566</td>
</tr>
</tbody>
</table>
Confluence Administrator's Guide

Managing Confluence Users

Advanced and Special Uses of Confluence

Working with Confluence Markup

Working with Confluence Gadgets

Developing Technical Documentation on Confluence Wiki

Creating your Technical Documentation Space

Using Templates in Technical Documentation

Re-using Content in Technical Documentation

Managing the Life Cycle of your Technical Documentation

Providing PDF Versions of your Technical Documentation

Exporting and Printing Technical Documentation

Essential Confluence Features for Technical Documentation

Confluence Add-ons for Technical Documentation

Further Reading about Developing Technical Documentation on Confluence

Developing a Knowledge Base on Confluence Wiki

Creating Your Knowledge Base Space

Using Templates and Formatting Macros in a Knowledge Base

Proactive Communications in a Knowledge Base

Additional Add-ons for a Knowledge Base

Developing an Intranet on Confluence Wiki

Confluence Administrator's Guide

Getting Started as Confluence Administrator

Managing Confluence Users

Adding and Inviting Users

Removing or Deactivating Users

Searching For and Administering Users

Editing User Details

Resetting the Login Count for a User

Changing Usernames

Restoring Passwords To Recover Admin User Rights
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing Site-Wide Permissions and Groups</td>
<td>904</td>
</tr>
<tr>
<td>Global Groups Overview</td>
<td>904</td>
</tr>
<tr>
<td>Adding or Removing Users in Groups</td>
<td>905</td>
</tr>
<tr>
<td>Global Permissions Overview</td>
<td>908</td>
</tr>
<tr>
<td>Setting Up Public Access</td>
<td>913</td>
</tr>
<tr>
<td>Configuring User Directories</td>
<td>914</td>
</tr>
<tr>
<td>Configuring the Internal Directory</td>
<td>916</td>
</tr>
<tr>
<td>Connecting to an LDAP Directory</td>
<td>917</td>
</tr>
<tr>
<td>Connecting to an Internal Directory with LDAP Authentication</td>
<td>938</td>
</tr>
<tr>
<td>Connecting to Crowd or JIRA for User Management</td>
<td>945</td>
</tr>
<tr>
<td>Connecting to JIRA 4.2 or Earlier for User Management</td>
<td>957</td>
</tr>
<tr>
<td>Managing Multiple Directories</td>
<td>959</td>
</tr>
<tr>
<td>Managing Nested Groups</td>
<td>961</td>
</tr>
<tr>
<td>Synchronising Data from External Directories</td>
<td>965</td>
</tr>
<tr>
<td>Diagrams of Possible Configurations for User Management</td>
<td>967</td>
</tr>
<tr>
<td>User Management Limitations and Recommendations</td>
<td>972</td>
</tr>
<tr>
<td>Requesting Support for External User Management</td>
<td>976</td>
</tr>
<tr>
<td>Disabling the Built-In User Management</td>
<td>979</td>
</tr>
<tr>
<td>Managing Add-ons and Macros</td>
<td>979</td>
</tr>
<tr>
<td>About Add-ons</td>
<td>980</td>
</tr>
<tr>
<td>Add-on loading strategies in Confluence</td>
<td>981</td>
</tr>
<tr>
<td>Removing Malfunctioning Add-ons</td>
<td>984</td>
</tr>
<tr>
<td>Enabling and Configuring Macros</td>
<td>986</td>
</tr>
<tr>
<td>Configuring a URL Whitelist for Macros</td>
<td>986</td>
</tr>
<tr>
<td>Configuring the User List Macro</td>
<td>988</td>
</tr>
<tr>
<td>Enabling HTML macros</td>
<td>989</td>
</tr>
<tr>
<td>Troubleshooting the Gallery Macro</td>
<td>991</td>
</tr>
<tr>
<td>Adding, Editing and Removing User Macros</td>
<td>991</td>
</tr>
<tr>
<td>Writing User Macros</td>
<td>992</td>
</tr>
<tr>
<td>Configuring the Office Connector</td>
<td>101</td>
</tr>
<tr>
<td>Customising your Confluence Site</td>
<td>102</td>
</tr>
<tr>
<td>Changing the Look and Feel of Confluence</td>
<td>102</td>
</tr>
<tr>
<td>Customising the Confluence Dashboard</td>
<td>102</td>
</tr>
<tr>
<td>Changing the Site Logo</td>
<td>102</td>
</tr>
<tr>
<td>Customising Colour Schemes</td>
<td>102</td>
</tr>
<tr>
<td>Working with Themes</td>
<td>102</td>
</tr>
<tr>
<td>Customising Site and Space Layouts</td>
<td>102</td>
</tr>
<tr>
<td>Customising a Specific Page</td>
<td>104</td>
</tr>
<tr>
<td>Customising the Login Page</td>
<td>104</td>
</tr>
<tr>
<td>Modify Confluence Interface Text</td>
<td>104</td>
</tr>
<tr>
<td>Customising the eMail Templates</td>
<td>104</td>
</tr>
<tr>
<td>Changing the Default Behaviour and Content in Confluence</td>
<td>104</td>
</tr>
<tr>
<td>Administering Site Templates</td>
<td>104</td>
</tr>
<tr>
<td>Importing Templates</td>
<td>104</td>
</tr>
<tr>
<td>Changing the Site Title</td>
<td>104</td>
</tr>
<tr>
<td>Choosing a Default Language</td>
<td>104</td>
</tr>
<tr>
<td>Configuring the Administrator Contact Page</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the Site Home Page</td>
<td>105</td>
</tr>
<tr>
<td>Configuring the What's New Dialog</td>
<td>105</td>
</tr>
<tr>
<td>Customising Default Space Content</td>
<td>105</td>
</tr>
<tr>
<td>Customising the Getting Started Guide on the Dashboard</td>
<td>105</td>
</tr>
<tr>
<td>Editing the Site Welcome Message</td>
<td>105</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Integrating Confluence with Other Applications</td>
<td>105</td>
</tr>
<tr>
<td>Configuring Application Links</td>
<td>106</td>
</tr>
<tr>
<td>Adding an Application Link</td>
<td>106</td>
</tr>
<tr>
<td>Configuring Authentication for an Application Link</td>
<td>106</td>
</tr>
<tr>
<td>Editing an Application Link</td>
<td>107</td>
</tr>
<tr>
<td>Making an Application Link the Primary Link</td>
<td>107</td>
</tr>
<tr>
<td>Relocating an Application Link</td>
<td>107</td>
</tr>
<tr>
<td>Upgrading an Application Link</td>
<td>107</td>
</tr>
<tr>
<td>Deleting an Application Link</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Project Links across Applications</td>
<td>107</td>
</tr>
<tr>
<td>Configuring Workbox Notifications</td>
<td>108</td>
</tr>
<tr>
<td>Integrating JIRA and Confluence</td>
<td>108</td>
</tr>
<tr>
<td>Installing Confluence and JIRA Together</td>
<td>108</td>
</tr>
<tr>
<td>Setting Up Trusted Communication between JIRA and Confluence</td>
<td>109</td>
</tr>
<tr>
<td>Managing your Confluence License</td>
<td>109</td>
</tr>
<tr>
<td>Viewing and Editing License Details</td>
<td>110</td>
</tr>
<tr>
<td>Getting a Confluence License</td>
<td>110</td>
</tr>
<tr>
<td>Reducing the User Count for your Confluence License</td>
<td>110</td>
</tr>
<tr>
<td>Finding Your Confluence Support Entitlement Number (SEN)</td>
<td>110</td>
</tr>
<tr>
<td>Managing Confluence Data</td>
<td>110</td>
</tr>
<tr>
<td>Database Configuration</td>
<td>110</td>
</tr>
<tr>
<td>Database Setup For Any External Database</td>
<td>110</td>
</tr>
<tr>
<td>Database Setup for Oracle</td>
<td>110</td>
</tr>
<tr>
<td>Database Setup for SQL Server</td>
<td>111</td>
</tr>
<tr>
<td>Database Setup For MySQL</td>
<td>111</td>
</tr>
<tr>
<td>Database Setup for PostgreSQL</td>
<td>112</td>
</tr>
<tr>
<td>The Embedded HSQLDB Database</td>
<td>113</td>
</tr>
<tr>
<td>Migrating to Another Database</td>
<td>113</td>
</tr>
<tr>
<td>Database JDBC Drivers</td>
<td>113</td>
</tr>
<tr>
<td>Configuring Database Character Encoding</td>
<td>113</td>
</tr>
<tr>
<td>Configuring database query timeout</td>
<td>113</td>
</tr>
<tr>
<td>Creating Database Schema Manually</td>
<td>114</td>
</tr>
<tr>
<td>Troubleshooting the Embedded Database (HSQL DB)</td>
<td>114</td>
</tr>
<tr>
<td>Troubleshooting External Database Connections</td>
<td>114</td>
</tr>
<tr>
<td>Improving Database Performance</td>
<td>114</td>
</tr>
<tr>
<td>Surviving Database Performance</td>
<td>114</td>
</tr>
<tr>
<td>Site Backup and Restore</td>
<td>115</td>
</tr>
<tr>
<td>Production Backup Strategy</td>
<td>115</td>
</tr>
<tr>
<td>Configuring Backups</td>
<td>115</td>
</tr>
<tr>
<td>Manually Backing Up the Site</td>
<td>115</td>
</tr>
<tr>
<td>Restoring a Site</td>
<td>115</td>
</tr>
<tr>
<td>Restoring a Space</td>
<td>115</td>
</tr>
<tr>
<td>Restoring a Test Instance from Production</td>
<td>116</td>
</tr>
<tr>
<td>Restoring Data from other Backups</td>
<td>116</td>
</tr>
<tr>
<td>Retrieving File Attachments from a Backup</td>
<td>116</td>
</tr>
<tr>
<td>Troubleshooting failed XML site backups</td>
<td>116</td>
</tr>
<tr>
<td>Attachment Storage Configuration</td>
<td>117</td>
</tr>
<tr>
<td>Hierarchical File System Attachment Storage</td>
<td>117</td>
</tr>
<tr>
<td>Confluence Data Directory Configuration</td>
<td>118</td>
</tr>
<tr>
<td>Configuring Attachment Directory Configuration</td>
<td>118</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Confluence Data Model</td>
<td>118</td>
</tr>
<tr>
<td>Finding Unused Spaces</td>
<td>119</td>
</tr>
<tr>
<td>Data Import and Export</td>
<td>119</td>
</tr>
<tr>
<td>Configuring a Confluence Environment</td>
<td>120</td>
</tr>
<tr>
<td>Important Directories and Files</td>
<td>120</td>
</tr>
<tr>
<td>Confluence Home Directory</td>
<td>120</td>
</tr>
<tr>
<td>Confluence Installation Directory</td>
<td>120</td>
</tr>
<tr>
<td>Application Server Configuration</td>
<td>120</td>
</tr>
<tr>
<td>Configuring URL Encoding on Tomcat Application Server</td>
<td>120</td>
</tr>
<tr>
<td>Managing Application Server Memory Settings</td>
<td>120</td>
</tr>
<tr>
<td>Switching to Apache Tomcat</td>
<td>120</td>
</tr>
<tr>
<td>Java Policy Settings for Enterprise or Webhosting Environments</td>
<td>120</td>
</tr>
<tr>
<td>Web Server Configuration</td>
<td>121</td>
</tr>
<tr>
<td>Configuring Web Proxy Support for Confluence</td>
<td>121</td>
</tr>
<tr>
<td>Running Confluence behind Apache</td>
<td>121</td>
</tr>
<tr>
<td>Starting Confluence Automatically on System Startup</td>
<td>122</td>
</tr>
<tr>
<td>Start Confluence Automatically on Linux</td>
<td>122</td>
</tr>
<tr>
<td>Start Confluence Automatically on Windows as a Service</td>
<td>122</td>
</tr>
<tr>
<td>Configuring Confluence</td>
<td>123</td>
</tr>
<tr>
<td>Viewing System Information</td>
<td>123</td>
</tr>
<tr>
<td>Live Monitoring Using the JMX Interface</td>
<td>123</td>
</tr>
<tr>
<td>Tracking Customisations Made to your Confluence Installation</td>
<td>123</td>
</tr>
<tr>
<td>Viewing Site Statistics</td>
<td>123</td>
</tr>
<tr>
<td>Viewing System Properties</td>
<td>123</td>
</tr>
<tr>
<td>Configuring the Server Base URL</td>
<td>123</td>
</tr>
<tr>
<td>Configuring the Confluence Search and Indexes</td>
<td>123</td>
</tr>
<tr>
<td>Configuring Indexing Language</td>
<td>124</td>
</tr>
<tr>
<td>Configuring Quick Navigation</td>
<td>124</td>
</tr>
<tr>
<td>Content Index Administration</td>
<td>124</td>
</tr>
<tr>
<td>Enabling OpenSearch</td>
<td>124</td>
</tr>
<tr>
<td>Enabling the Did You Mean Feature</td>
<td>124</td>
</tr>
<tr>
<td>Rebuilding the Ancestor Table</td>
<td>124</td>
</tr>
<tr>
<td>Setting Up Confluence to Index External Sites</td>
<td>124</td>
</tr>
<tr>
<td>Setting Up an External Search Tool to Index Confluence</td>
<td>124</td>
</tr>
<tr>
<td>Configuring Mail</td>
<td>124</td>
</tr>
<tr>
<td>Configuring a Server for Outgoing Mail</td>
<td>124</td>
</tr>
<tr>
<td>Setting Up a Mail Session for the Confluence Distribution</td>
<td>124</td>
</tr>
<tr>
<td>Configuring the Recommended Updates Email Notification</td>
<td>124</td>
</tr>
<tr>
<td>The Mail Queue</td>
<td>124</td>
</tr>
<tr>
<td>Configuring Character Encoding</td>
<td>124</td>
</tr>
<tr>
<td>Troubleshooting Character Encodings</td>
<td>125</td>
</tr>
<tr>
<td>Other Settings</td>
<td>125</td>
</tr>
<tr>
<td>Configuring a WebDAV client for Confluence</td>
<td>125</td>
</tr>
<tr>
<td>Configuring HTTP Timeout Settings</td>
<td>126</td>
</tr>
<tr>
<td>Configuring Number Formats</td>
<td>126</td>
</tr>
<tr>
<td>Configuring Shortcut Links</td>
<td>126</td>
</tr>
<tr>
<td>Configuring Time and Date Formats</td>
<td>126</td>
</tr>
<tr>
<td>Enabling the Remote API</td>
<td>126</td>
</tr>
<tr>
<td>Enabling Threaded Comments</td>
<td>126</td>
</tr>
<tr>
<td>Enabling Trackback</td>
<td>126</td>
</tr>
<tr>
<td>Installing a Language Pack</td>
<td>126</td>
</tr>
<tr>
<td>Installing Patched Class Files</td>
<td>126</td>
</tr>
</tbody>
</table>
Configuring System Properties .......................................................... 126
Recognised System Properties ......................................................... 128
Working with Confluence Logs .......................................................... 129
  Configuring Logging .................................................................... 129
  Log4j Logging Levels .................................................................. 129
  Troubleshooting SQL Exceptions .................................................... 130
Configuring Confluence Security ......................................................... 130
  Confluence Security Overview and Advisories ................................. 130
  Confluence Cookies ...................................................................... 137
  Configuring Secure Administrator Sessions ...................................... 138
  Using Fail2Ban to limit login attempts .......................................... 138
  Securing Confluence with Apache ................................................ 138
  Managing External Referrers .......................................................... 138
  Best Practices for Configuring Confluence Security ............................ 138
  Hiding the People Directory ........................................................... 139
  Configuring Captcha for Spam Prevention ....................................... 139
  Hiding External Links From Search Engines ..................................... 139
  Configuring Captcha for Failed Logins ........................................... 139
  Configuring XSRF Protection .......................................................... 139
  User Email Visibility ..................................................................... 139
  Anonymous Access to Remote API ............................................... 139
  Running Confluence Over SSL or HTTPS ........................................ 139
  Connecting to LDAP or JIRA or Other Services via SSL .................. 140
  Configuring RSS Feeds .................................................................. 140
  Preventing and Cleaning Up Spam .................................................. 140
Scheduled Jobs ............................................................................... 140
Operating Large or Mission-Critical Confluence Installations .............. 141
Configuring a Large Confluence Installation ....................................... 142
Confluence Clustering Overview ....................................................... 142
  Technical Overview of Clustering in Confluence ............................... 142
  Changing Datasources Manually in a Cluster .................................... 143
  Cluster Troubleshooting ............................................................... 143
  Clustering for Scalability vs Clustering for High Availability (HA) .... 144
  Recommended network topology ................................................... 144
  Cluster Administration page .......................................................... 144
  Cluster Checklist ........................................................................ 145
Performance Tuning ........................................................................ 145
  Cache Performance Tuning ............................................................. 145
  Memory usage and requirements .................................................... 146
  Requesting Performance Support .................................................. 147
  Troubleshooting Slow Performance Using Page Request Profiling .... 147
  Compressing an HTTP Response within Confluence ....................... 147
  Performance Testing Scripts ........................................................... 147
  Garbage Collector Performance Issues .......................................... 148
Confluence Installation and Upgrade Guide ........................................ 149
System Requirements ...................................................................... 149
Server Hardware Requirements Guide .............................................. 149
Example Size and Hardware Specifications From Customer Survey .... 149
Running Confluence in a Virtualised Environment ............................ 150
Confluence Installation Guide ............................................................ 150
Installing Confluence ..................................................................... 150
Installing Confluence on Windows .................................................... 150
Installing Confluence on Linux ............................................. 151
Change listen port for Confluence ....................................... 151
Installing the Confluence EAR-WAR Edition .......................... 152
Known Issues for Apache Tomcat ........................................ 152
Installing Java for Confluence ........................................... 152
Confluence Cluster Installation ........................................... 152
Confluence Cluster Installation with Existing Data ................... 152
Apache and Tomcat load balancing ...................................... 153
Creating a Dedicated User Account on the Operating System to Run Confluence .............................................. 153
Confluence Setup Guide ..................................................... 153
Load Content for the Site .................................................. 154
Restoring from Backup During Setup .................................... 154
Configuring JIRA Integration in the Setup Wizard ..................... 154
Upgrading Confluence ....................................................... 155
Upgrading Beyond Current Licensed Period ......................... 156
Confluence Post-Upgrade Checks ........................................ 156
Upgrading Confluence EAR-WAR Distribution ........................ 156
Migration from Wiki Markup to XHTML-Based Storage Format .... 156
Migration of Templates from Wiki Markup to XHTML-Based Storage Format .................................................... 157
Upgrading Confluence Manually ......................................... 157
Supported Platforms ......................................................... 158
End of Support Announcements for Confluence ....................... 158
Supported Platforms FAQ .................................................. 159
Migrating Confluence Between Servers ................................ 159
Migrating from Confluence OnDemand to a Confluence Installed Site ................................................................. 159
Confluence Release Notes .................................................. 159
Confluence Release Summary .............................................. 160
Confluence Release Cycle .................................................. 160
Upgrade Notes Overview .................................................. 161
Confluence 5.0.2 Release Notes ........................................... 161
Confluence 5.0.2 Upgrade Notes .......................................... 161
Confluence 5.0.1 Release Notes ........................................... 161
Confluence 5.0.1 Upgrade Notes .......................................... 161
Confluence 5.0 Release Notes ............................................. 161
Confluence 5.0 Upgrade Notes ............................................. 163
Issues Resolved in Confluence 5.0 ..................................... 163
Confluence 4.3.7 Release Notes ........................................... 164
Confluence 4.3.7 Upgrade Notes .......................................... 164
Confluence 4.3.6 Release Notes ........................................... 164
Confluence 4.3.6 Upgrade Notes .......................................... 165
Confluence 4.3.5 Release Notes ........................................... 165
Confluence 4.3.5 Upgrade Notes .......................................... 165
Confluence 4.3.3 Release Notes ........................................... 165
Confluence 4.3.3 Upgrade Notes .......................................... 166
Confluence 4.3.2 Release Notes ........................................... 166
Confluence 4.3.2 Upgrade Notes .......................................... 167
Confluence 4.3.1 Release Notes ........................................... 167
Confluence 4.3.1 Upgrade Notes .......................................... 167
Confluence 4.3 Release Notes ............................................. 167
Confluence 4.3 Upgrade Notes ............................................. 168
Issues Resolved in Confluence 4.3 ..................................... 168
Getting Help and Support .................................................. 169
Confluence Resources ................................................................. 169
Confluence Tutorial Videos .................................................. 169
Local Confluence Documentation ........................................... 170
Confluence SharePoint Connector ........................................... 170
Support Policies ................................................................. 170
  Bug Fixing Policy ........................................................... 170
  How to Report a Security Issue ........................................... 170
  New Features Policy ........................................................ 170
  Patch Policy ................................................................. 170
  Security Advisory Publishing Policy ................................... 170
  Security Patch Policy ....................................................... 170
  Severity Levels for Security Issues .................................... 171
Troubleshooting Problems and Requesting Technical Support ............. 171
  Content Anonymiser for Data Backups ................................. 171
  Enabling Detailed SQL Logging ......................................... 171
  Generating a Heap Dump .................................................. 171
  Generating a Thread Dump ............................................... 172
    Generating a Thread Dump Externally ............................... 172
  Getting Java Crash Log File ............................................. 172
  Profiling using the YourKit Plugin ..................................... 172
Contributing to the Confluence Documentation ............................. 172
  Tips of the Trade ........................................................ 172
  Tips via Twitter .......................................................... 173
Confluence Documentation in Other Languages ............................ 173
Confluence Documentation Home

Welcome to the documentation for Atlassian Confluence. We are so glad you have joined us on the wiki!

What's changed in Confluence 5

Need to train your staff before upgrading to Confluence 5? Take a look at our change management guide: Planning for Confluence 5

Getting started

About Confluence
Creating Content
Getting Started as Confluence Administrator
More things to try

Resources

Evaluator
Administrator
Developer
Knowledge base
Getting support

Customising Confluence

Applying a theme to a space
Customising the colour scheme
Changing the logo
Choosing your home page
Importing templates
Planning for Confluence 5

Confluence 5.0 introduces significant changes to the user experience: A new way of creating content, more options in the header, a new sidebar, and new look and feel across your Confluence site.

People in your organisation will need to be aware of the coming changes, so that they can plan and prepare for them.

This guide describes the changes that may affect the way people are used to working. For an alternative view of what's new, see the Confluence 5.0 Release Notes. For an administrator's guide to preparing for the upgrade, see the Confluence 5.0 Upgrade Notes.

New way of creating content

The 'Add' option has disappeared from the top of pages and from the dashboard. Instead, Confluence 5.0 offers these options:

- Create in the Confluence header, for creating a page or blog post
- Create child page in the sidebar.
- The shortcut key C, for quickly opening the ‘Create’ dialog.

When you create a page, you can choose to base it on a template. For a full description, see Creating Content.
To add a comment, scroll to the bottom of the page or press M on your keyboard.

On this page:
- New way of creating content
- Redesigned header
- Browse menu gone, replaced by new sidebar
- More about the sidebar
- Reorganisation of space administration and space tools
- New way of updating site welcome message
- New way of updating default space content
- Easy Reader theme replaced by default Confluence theme
- Other noteworthy changes
- Upgrading from Confluence 3.5 or earlier
- Want to see Confluence 5 in action?

Related pages:
- Confluence 5.0 Release Notes
- Confluence 5.0 Upgrade Notes
- Confluence User's Guide
- Developer's Guide to Preparing for Confluence 5.0

Previously: 'Add' button on page
Now: ‘Create’ option in header

Or ‘Create child page’ in sidebar

Redesigned header

The Confluence header has been updated to look like the JIRA and other Atlassian product headers, and consolidates a number of options in one location:

- If you have Confluence linked to JIRA or another Atlassian application, you can switch to those applications via the application switcher in the header. Administrators can also add links to non-Atlassian applications.
- New options point directly to the space and people directories.
- A help icon presents links to online help, keyboard shortcuts, and other useful pages.
- The cog icon, for site administrators, offers management of add-ons, users, and other site administration tasks.
- The user menu, now represented by your profile picture instead of your name, gives access to your personal settings.

For a full description of the header and page, see Page in View Mode.
Browse menu gone, replaced by new sidebar

The ‘Browse’ menu used to contain a mish-mash of options, some relating to the current space, some to the entire site, and some random options like keyboard shortcuts. Now things are much tidier and will feel familiar to users of JIRA too:

- Site-level items now appear on the left-hand side of the header: links to the dashboard, space directory and people directory.
- Add-ons will also be able to add items to the header. For example, Team Calendars may add a ‘Calendars’ option.
- Space-related items are now in the sidebar (under ‘Space Tools’).

For more details, see Finding Content.

Note: The ‘Browse’ menu remains available in the Documentation theme, because this theme does not include the new sidebar. Instead, the theme retains the left-hand navigation panel and the ‘Browse’ menu as in previous versions of Confluence.
Now: New sidebar

More about the sidebar

Space administrators can configure what is displayed in the top section of the sidebar, adding shortcuts to important documents, and change the space logo and name. See Configuring a Sidebar.
People can collapse the sidebar to gain more space. See Finding Content.

The sidebar also gives access to the space administration pages and other tools. See below.

**Reorganisation of space administration and space tools**

We have changed the layout and organisation of the space administration pages and other space tools, to fit better with the new overall design.

- The 'Space Tools' option on the new sidebar gives initial access to the space configuration, administration and tools.
- A new tab-based navigation offers further access.
If you get lost in the new UI, or cannot find that essential option you know exists somewhere... do not despair. Our guide to spaces is fully updated.

**Note:** In the Documentation theme, you can still access space operations via the 'Browse' menu.

**Previously: Side panels for advanced and space admin options**

**Now: Sidebar plus tab-based navigation**

**New way of updating site welcome message**

We have introduced a system template containing the content of the site welcome message that appears at top left of the dashboard. The template offers the rich text editor for entering and updating the welcome message. See [Editing the Site Welcome Message](#).
Previously: Text box in general configuration section

Now: System template

New way of updating default space content

This release also includes two system templates containing the default content for space home pages, for global spaces and personal spaces. You can now use the rich text editor to update the content. See Customising Default Space Content.
Previously: Text box accepting wiki markup

Now: System templates using rich text editor

Easy Reader theme replaced by default Confluence theme

Confluence 5.0 does not include the Easy Reader theme. If your Confluence site currently uses the Easy Reader theme, your site and the spaces that use the theme will be automatically transferred to the default theme on the upgrade to Confluence 5.0.

If you have feedback on this change, please would you add a comment to the following page: Feedback on removal of Easy Reader theme from Confluence 5.0.
Previously: Easy Reader theme

Now: Default theme

Other noteworthy changes

These changes may affect people using on your site:

- **Direct access to labels view no longer available via menus.** In earlier versions of Confluence, people could get to the labels view by choosing **Browse > Labels.** Now that the 'Browse' menu has gone from the default theme, this option is no longer available.

  To find the labels view:
  - Where you see a label on a page, blog post or attachment, choose the label to go to the labels view. (Any page or blog post that has labels will have them listed together in a block at the bottom of the page.)
  - You will also see labels in the 'Attachments' view or in a listing of attachments provided by the Attachments macro.

Alternatively, visit the following URL:

<MY.CONFLUENCE.SITE>/labels/listlabels-alphaview.action?key=MYSPACE KEY.

For example: https://confluence.atlassian.com/labels/listlabels-alphaview.action?key=DOC

**Note:** The Documentation theme retains the 'Browse' menu in Confluence 5.0, and thus the 'Browse > Labels' option is still accessible.

- **Ability to add space labels has been removed.** Existing space labels will be preserved, but you will be
unable to add new space labels to your spaces. Space categories are not affected by this change.

- **Metadata Details and Details Summary macros renamed.** We have renamed the following macros: Metadata Details is now Page Properties. Details Summary is now Page Properties Report. When you upgrade to Confluence 5.0 or later, an upgrade task will automatically rename existing Metadata Details and Details Summary macros on your Confluence pages. The wiki markup and storage format code for these macros has not changed.

For an alternative view of what's new, see the Confluence 5.0 Release Notes. For an administrator’s guide to preparing for the upgrade, see the Confluence 5.0 Upgrade Notes.

**Upgrading from Confluence 3.5 or earlier**

If you are upgrading from Confluence 3.5 or earlier please note that the change to the Confluence editing experience is significant. See our guide: Planning for Confluence 4.

**Want to see Confluence 5 in action?**

This video is an overview of what’s new in Confluence 5.0:

And this one focuses on the new sidebar:

**Feedback on removal of Easy Reader theme from Confluence 5.0**

Confluence 5.0 does not include the Easy Reader theme. We are moving towards a single Confluence theme that presents a simplified default experience. At the same time, we want to make it easy for add-on developers to extend Confluence with custom themes. Our analysis has shown that very few Confluence sites use the Easy Reader theme.

**What will happen on upgrade**

If your Confluence site currently uses the Easy Reader theme, your site and the spaces that use the theme will be automatically transferred to the default theme on the upgrade to Confluence 5.0.

**Why we removed the Easy Reader theme**

The Easy Reader theme was originally designed to give people an easier way to read Confluence content – narrow width, larger fonts increased contrast, etc. Many of these issues are addressed by the updated default theme being introduced in Confluence 5. For example, we now have a larger default font size and the width of the page is narrower due to the sidebar. Plus, the new default theme in Confluence 5 provides a number of new features, like shortcut links, that aren't available in the Easy Reader theme. These factors reduced the need for the Easy Reader theme quite a bit.

Additionally, many web browsers these days (Firefox, Safari, Mobile Safari) ship with a ‘Reader’ mode which the user can enable to remove all styling from the system and format the page content in a column in the middle. Those that don't have a mode have popular extensions ([iReader](https://addons.mozilla.org/en-US/firefox/addon/ireader), [Tidy Reader](https://addons.mozilla.org/en-US/firefox/addon/tidyreader) or [bookmarklets](https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Operators/window.prompt) ([Readability](https://readability.com/)) to provide this functionality. We don't want to maintain features in the application that are better served by browser features. In this case, browser extensions or settings actually do a better job too – the end user is in control of the readability of their page, rather than the space administrator or site administrator.

**Feedback welcome**

While we do apologize for the disruption this causes you, we think in the long run you'll find the Confluence 5.0
design to be a major improvement over the previous design. If you would like to give us feedback on this change, please add a comment to this page. We are especially interested to know which features of the Easy Reader theme you use and value the most.

**Planning for Confluence 4**

Use this page as a one-stop-shop to help you prepare for Confluence 4 and its new editor. This page is useful to people moving to **Confluence 4.0 or later**, from Confluence 3.5 or earlier.

⚠️ **Note:** The Wiki Markup editor has been removed in Confluence 4 and replaced with a new XHTML-based editor. Please see [Why We Removed the Wiki Markup Editor in Confluence 4.0](#) for full details.

- Download or trial Confluence 4.

### Confluence 4 Guides

<table>
<thead>
<tr>
<th>For Administrators</th>
</tr>
</thead>
<tbody>
<tr>
<td>We’ve been working hard to make your life easier upgrading to Confluence 4. Here are some resources to help:</td>
</tr>
<tr>
<td>• Confluence 4.0 Release Notes</td>
</tr>
<tr>
<td>• Quick Administrator Tips To Prepare for Confluence 4</td>
</tr>
<tr>
<td>• Confluence 4 Editor FAQ</td>
</tr>
<tr>
<td>• Migration from Wiki Markup to XHTML-Based Storage Format</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For Plugin Developers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin developers - check out the guides we’ve created for you to help you migrate your plugins to Confluence 4:</td>
</tr>
<tr>
<td>• Preparing for Confluence 4.0</td>
</tr>
<tr>
<td>• Plugin points for the editor in 4.0</td>
</tr>
<tr>
<td>• Plugin Development Upgrade FAQ for 4.0</td>
</tr>
<tr>
<td>• Watch a webinar on preparing plugins for 4.0</td>
</tr>
<tr>
<td>• Atlascamp 2010 - Confluence 4.0 Plugin Migration Talk</td>
</tr>
<tr>
<td>• Changes to the remote API in Confluence 4.0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>For Users</th>
</tr>
</thead>
<tbody>
<tr>
<td>To make the transition easier to Confluence 4, we’ve created some guides for you:</td>
</tr>
<tr>
<td>• Confluence 4 high-level feature tour</td>
</tr>
<tr>
<td>• Quick Reference Guide for the Confluence Editor</td>
</tr>
<tr>
<td>• What's Changed for Wiki Markup Users</td>
</tr>
<tr>
<td>• What's Changed for Users of the Old Rich Text Editor</td>
</tr>
<tr>
<td>• Confluence 4 Editor FAQ</td>
</tr>
</tbody>
</table>

**Need help upgrading?** Don't forget [Atlassian has a large list of partners](#) that can help you with your upgrade.

### Confluence 4 Editor FAQ

Confluence 4 introduces a new editor. This page contains answers to common questions, to help you with your move to Confluence 4.
Why is Atlassian introducing a new editor in 4.0?

The editor is the single most important feature in Confluence. Confluence 3.5 has two editors: the rich text editor and the wiki markup editor. Each has its strong points and weak points.

- The rich text editor in particular has problems in stability and consistency, because it has to convert all content from rich text to wiki markup before storing content on the database. This leads to the so-called 'round-tripping' problems, where the page looks different in display mode than when created in edit mode.
- Many people find the wiki markup editor hard to use, particularly for long pages and complex layouts. We often hear from customers that the number one barrier to wiki adoption in their organisation is that people have to learn wiki markup.

Many customers have given us great feedback on the shortcomings of the current editors and the things they would like to see in a Confluence editor. We are introducing a single new editor to replace both the wiki markup editor and the rich text editor. The new editor will help us to solve the problems mentioned above and will provide a stable platform on which we can build high-demand features in future releases.

What about features that were previously available only in wiki markup?

We have identified these features and will add support for as many as possible in the new editor. For example, the new editor will include superscript and subscript text formatting, which is currently not available in the Confluence 3.5 rich text editor.

So you are basically eliminating the wiki markup editor and keeping the rich text editor?

No. While the new editor is WYSIWYG like the current rich text editor, the new editor has a completely different architecture based on a new XHTML-based storage format, and is faster and significantly more reliable. Our goal is to incorporate the strengths of wiki markup with the richness and intuitiveness of the WYSIWYG editor to produce a rich, hybrid editing experience. In particular, we are introducing options that offer the speed of the old wiki markup editor, via new features such as autocomplete and shortcut keys.

There will be multiple ways to insert wiki markup in the new editor.

For those of you that have learned wiki markup and are used to the speed of wiki markup we are really excited to let you know that you will still be able to write wiki markup in the new editor. This wiki markup converts 'on the fly', providing one of the fastest editing experiences yet.
For those of you that have scripts that produce wiki markup, or often write wiki markup in meetings, the new Confluence 4.0 editor introduces an Insert > Wiki markup dialog which will let you paste wiki markup for a one-way conversion.

Will Confluence 4.0 support the Office Connector, including 'Edit Page in Word' functionality?

Most of the features of the Office Connector (the View File macros, Import from Word) already work in 4.0. However, the 'Edit in Word' feature will be removed in Confluence 4.0.

When speaking to customers about the use of the 'Edit in Word' functionality, the primary reason for using this feature was 'familiarity'. Business users in organisations have found the 3.5 editor and wiki markup hard to learn.

In Confluence 4.0, we have greatly simplified the new editor user interface. With extensive usability testing, we are confident the new editor will be easier to learn and more reliable to use. We also have a large majority of customers who do not use the 'Edit in Word' functionality.

Please Note: We are referring to the "Edit Page in Word" functionally - not the "Edit Attachment in Word" functionality. Editing attachments in Word will still work fine, i.e. launching Word to edit Word documents that are stored in Confluence.

In Confluence 4.0, will you be able to merge and split table cells?

Yes, you will be able to merge and split table cells. This is a brand new feature in Confluence 4.0.

When will the new editor appear in Confluence?
The new editor is in Confluence 4.0 and later.

What does the new editor look like?

To see the new editor, you can download or trial Confluence 4, or watch a tutorial video.

Will Confluence still have a wiki markup editor?

No. The vision is incorporating the best parts of the wiki markup editor into the new editor to provide the best of both worlds.

What format will Confluence use to store its page content?

A new XHTML-based storage format. Up to now, Confluence has stored its content in the database as wiki markup. In Confluence 4.0 and later, the content will be stored as XML, with a significant proportion of XHTML-based elements.

We refer to the Confluence storage format as ‘XHTML-based’. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We’re using the term ‘XHTML-based’ to indicate that there is a large proportion of HTML in the storage format.

Will you be able to edit the source XML code directly?

Confluence 4.0 will not have an edit source mode by default. More sophisticated macro placeholders, images and link handling in Confluence 4.0 entail a lot of custom XML which make the new storage format much more complex than standard HTML. Editing this storage format by hand could result in corrupt content and the loss of page data. Source editing will still be editable via the APIs and the WebDAV client. There is also a Confluence Source Editor plugin which allows users to edit the storage format of the page. (You need Confluence 4.1.5 or later to use the plugin.)

Will there be a tool to convert existing content from wiki markup to the new format?
Yes. Where possible, Confluence will automatically upgrade existing content into the new storage format. There will be some API changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to the new storage format.

Read the Plugin Development Upgrade FAQ for 4.0 or Planning for Confluence 4.0 to learn more about API changes.

Will there be any API changes?

Yes. There will be some API changes (we are trying to keep these to a minimum) and we will provide mechanisms to convert wiki markup to the new storage format.

Read the Plugin Development Upgrade FAQ for 4.0 or Planning for Confluence 4.0 to learn more about API changes.

How many Confluence 3.x releases will you have before 4.0?

There will be no more 3.x releases before 4.0. Confluence 3.5 is our last 3.x release.

Will the remote XML-RPC API still work in Confluence 4.0?

We currently plan to keep the existing XML-RPC API but only allow write access which will automatically convert wiki markup to the new XML storage format. This will allow you to create new pages or update existing pages as usual. We can't allow read access, however, because we can only return XML, which will break the existing APIs contract of returning wiki markup. To cover those use cases and to have a fully XML capable API, we will introduce a new API available through a separate URL which will also have a new method to migrate wiki markup to the new storage format.

Developers should read Preparing for Confluence 4.0 to learn more about API changes.

Will the new editor be included in JIRA?

At the moment we don't have any plans to do this. However, we are open to this idea and would welcome any customer feedback in this area.

Does the SharePoint Connector support Confluence 4.0?

The SharePoint Connector 1.5 is compatible with Confluence 4.x.

**Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor**

This page is a quick-reference guide describing the changes to the editor in Confluence 4.0 and later, showing you how to perform your day-to-day tasks in the new editor. This guide is for people who regularly used the Rich Text Editor in earlier versions of Confluence.

How to Get Started Quickly

1. **Try the commands and menus you know from the old Rich Text Editor.** The new editor incorporates much of the existing functionality.

2. **Learn the keyboard shortcuts.** Click the help icon on the editor toolbar to see a list of keyboard shortcuts.

3. **Undo the autocomplete and autoformat actions.** To undo something that autocomplete or autoformat has done, press Backspace on your keyboard. Alternatively, press Ctrl+Z (Windows) or Cmd+Z (Mac).
Before and After Guide

Below are the most commonly used menu options from the old Rich Text Editor, and instructions on how to perform the same actions in the new editor.

Using the Editor

<table>
<thead>
<tr>
<th>What You Did Before</th>
<th>What to Do Now</th>
</tr>
</thead>
<tbody>
<tr>
<td>Basic typing and editing: Typed your content directly into the editor window, using the toolbar buttons to insert other content.</td>
<td>Your experience should be much the same. Generally, the transition from using the Confluence 3.5 Rich Text Editor to the new Confluence 4 editor should be smooth. Try doing things the way you always did, and check the table below if you can't find the feature you’re looking for.</td>
</tr>
</tbody>
</table>

Adding Macros

| What you did before | What to do now (press Enter to complete actions) |
Adding a macro to your page:
Clicked 'Insert / Edit Macro'.

Type '{' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:

```
{blog
```

Alternatively, use wiki markup entirely. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `{blogposts:content=titles|author=jsmith}`
- For details of wiki markup syntax, see Confluence Wiki Markup for Macros.

ℹ️ You can still click 'Insert' > 'Other Macros'.

---

### Formatting Text

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Making text bold, italic or underlined:</strong> Selected text and clicked the respective menu button.</td>
<td>No change.</td>
</tr>
<tr>
<td><strong>Heading levels:</strong> Selected text and chose a heading level from the menu.</td>
<td>No change.</td>
</tr>
<tr>
<td><strong>Left, centre and right alignment:</strong> Not available in previous versions of Confluence.</td>
<td>Click the left, centre and right alignment buttons on the editor toolbar:</td>
</tr>
</tbody>
</table>

ℹ️ This can also be used to align images independently of text.
### Indentation:
Click the left and right indentation buttons on the editor toolbar:

No change. Click the left and right indentation buttons on the editor toolbar:

---

### Making text strikethrough, monospace, superscript or subscript:
Selected text and clicked the respective menu button.

Click this button on the editor toolbar and select from the drop-down list. Example:

---

### Quoting text:
Selected text and chose the ‘Quote’ style from the drop-down menu.

No change: Use the Quote style – select ‘Quote’ from the style dropdown menu or use the keyboard shortcut. Example:

---

### Changing text colour:
Selected text and chose a colour from the menu bar.

No change: Click the colour options on the editor toolbar. Example:

---

Adding Symbols and Emoticons
<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Smiley:</strong></td>
<td>Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:</td>
</tr>
<tr>
<td>Clicked 'Insert' &gt; 'Emoticon' on the toolbar. 😊</td>
<td>: )</td>
</tr>
<tr>
<td></td>
<td>You can still click 'Insert' &gt; 'Emoticon' on the toolbar.</td>
</tr>
</tbody>
</table>

| **Tick or check mark:**                    | Type a forward slash in round brackets. Autocomplete will convert it as you type. Example: |
| Clicked 'Insert' > 'Emoticon' > 🙆🏼♀️       | ( / )                                                                         |
|                                             | You can still click 'Insert' > 'Emoticon' > 🙆🏼♀️                             |

**Linking text**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
</table>

Confluence 5.0 Documentation

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Linking to a Confluence page:

Clicked 'Insert' > 'Link' on the toolbar.

<table>
<thead>
<tr>
<th><img src="image" alt="Link suggestions" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Modern Girl song lyrics" /></td>
</tr>
<tr>
<td><img src="image" alt="Search for 'Modern Girl'" /></td>
</tr>
<tr>
<td><img src="image" alt="Insert Web Link" /></td>
</tr>
<tr>
<td><img src="image" alt="Insert Link to Create Page" /></td>
</tr>
</tbody>
</table>

Type a square bracket '[' and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:

```markdown
[Modern Girl|Modern Girl song lyrics]
```

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `[Modern Girl|Modern Girl song lyrics]`

ℹ️ You can still click 'Link' on the toolbar.
### Linking text to a web page:

Selected the text and clicked **Link > Web Link** on the toolbar and typed the URL into the dialog box.}

<table>
<thead>
<tr>
<th><img src="image" alt="Link suggestions" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Modern Girl song lyrics" /></td>
</tr>
<tr>
<td><img src="image" alt="Search for Modern Girl" /></td>
</tr>
<tr>
<td><img src="image" alt="Insert Web Link" /></td>
</tr>
<tr>
<td><img src="image" alt="Insert Link to Create Page" /></td>
</tr>
</tbody>
</table>

Type a square bracket `[` and select **Insert Web Link**, then paste the URL into the link dialog. Example:

```
[ Modern Girl ]
```

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `[Modern Girl|http://www.example.com/song]`

⚠️ You can still use **Link > Web Link** on the toolbar.
**Linking to a page that does not yet exist:**

Not available in previous versions of Confluence.

Type a square bracket `[` and the name of the non-existent page, then select 'Insert Link to Create Page'. Example:

```
Future of the modern girl
```

Alternatively, use wiki markup entirely. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[Future of the Modern Girl]`

---

**Linking to a mailto link:**

Clicked 'Link' > 'Web Link' on the toolbar and typed `mailto:username@example.com`.

No change.

You still click 'Link' > 'Web Link' on the toolbar and type `mailto:username@example.com`.

---

**Linking to an anchor on a page:**

Clicked 'Link' > 'Web Link' on the toolbar and typed 'DestinationPage#AnchorName'.

No change.

You still click 'Link' > 'Web Link' on the toolbar and type 'DestinationPage#AnchorName'.
Linking to an attachment:
Clicked ‘Link’ > ‘Attachment’ on the toolbar.

Type a square bracket ‘[]’ and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example:

Alternatively, use **wiki markup entirely**. Type the link, including the alias (if required), the caret character `^` and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- **This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.**
- **This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.**
- **Example:** `[^attachment name]`

ℹ️ You can still click ‘Link’ > ‘Attachment’ on the toolbar.

Using bulleted and numbered lists

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding bullets:</strong></td>
<td>Type an asterisk <code>*</code> followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:</td>
</tr>
<tr>
<td>Clicked ‘Unordered List’ on the toolbar.</td>
<td>My list:</td>
</tr>
<tr>
<td></td>
<td>• <strong>bullet item</strong></td>
</tr>
<tr>
<td></td>
<td>ℹ️ To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.</td>
</tr>
<tr>
<td></td>
<td>ℹ️ You can still click ‘Bullet List’ on the toolbar.</td>
</tr>
</tbody>
</table>
### Adding numbered items:
Clicked 'Ordered List' on the toolbar.

Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:

My list:

1. bullet item

- To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.
- You can still click 'Numbered List' on the toolbar.

### Adding line breaks in a numbered/bulleted list:
Pressed Shift+Enter.

No change. You can still press Shift+Enter.

### Using tables

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a table:</strong></td>
<td>**Type a series of pipe characters '</td>
</tr>
<tr>
<td>Clicked 'Insert Table' on the toolbar.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>You can still click 'Insert' &gt; 'Table' on the toolbar.</strong></td>
</tr>
<tr>
<td><strong>Editing a table:</strong></td>
<td><strong>No change, you can still use the toolbar table editing controls, with new features such as table merge and split.</strong></td>
</tr>
<tr>
<td>Used the table buttons on the toolbar.</td>
<td></td>
</tr>
</tbody>
</table>

### Displaying images

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
</table>
**Displayed an image attached to the page:**
Typed/pasted the image name inside exclamation marks '!'. Example:

```text
!NoMatterWhat.png!
```

**Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:**

```
<table>
<thead>
<tr>
<th>! NoMatter</th>
</tr>
</thead>
<tbody>
<tr>
<td>suggestions</td>
</tr>
<tr>
<td>NoMatterWhat.png</td>
</tr>
</tbody>
</table>
```

Alternatively, use **wiki markup entirely**. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.
- Example: `!NoMatterWhat.png|align=right`

**Displaying an image attached to another page:**
Clicked 'Insert Image' > 'From the Web' and inserted the URL of the image on the other page.

Click 'Insert' > 'Search' and type search terms to find the image in Confluence. Once found, click the image and it will be added to the page.

**Embedding multimedia files**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now (press Enter to complete actions)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying an image attached to another page:</td>
<td>Click 'Insert' &gt; 'Search' and type search terms to find the image in Confluence. Once found, click the image and it will be added to the page.</td>
</tr>
</tbody>
</table>
Embedding a video, movie or audio file into a page:
Clicked ‘Insert’ > ‘Macro’ > ‘Multimedia Macro’ and chose content from the browser.

Use the Multimedia macro. Type an exclamation mark ‘!’ and select ‘Insert Other Media’. Example:

Or type ‘{’ and start typing the macro name ‘Multimedia’. Example:

Functionality that is No Longer Available
This section contains a list of things you could do in earlier versions of Confluence, but can no longer do in Confluence 4.

1. Edit a page in Microsoft Word. See FAQ entry.

RELATED TOPICS
Planning for Confluence 4
Confluence 4 Editor - What’s Changed for Wiki Markup Users
This quick-reference guide is for people who regularly used the wiki markup editor in earlier versions of Confluence. It shows you how to use the new editor to do the things you have always done. And more.

The editor offers a number of options in the toolbar. But did you know...?

- You can use autocomplete and autoformatting shortcuts instead of the toolbar.
- The trigger characters for autocomplete and autoformatting are derived from wiki markup.
- You can add macros, links and images by typing the entire wiki markup element. As soon as you close the macro, link, or image, Confluence will convert it to rich text format and add it to the page.

Hints to get you started quickly

1. Type wiki markup into the editor. Confluence’s autocomplete and autoformat will convert the wiki markup as you type.
2. **Learn the keyboard shortcuts.** Click the help icon on the editor toolbar to see a list of keyboard shortcuts.

3. **Undo the autocomplete and autoformat actions.** To undo something that autocomplete or autoformat has done, press **Ctrl+Z** (Windows) or **Cmd+Z** (Mac).

---

**On this page:**

- Hints to get you started quickly
- Before and after guide for wiki markup fans
  - Using wiki markup
  - Adding macros
  - Formatting text
  - Adding symbols and emoticons
  - Linking text
  - Using bulleted and numbered lists
  - Using tables
  - Displaying images
  - Embedding multimedia files
- Functionality that is no longer available
- New source editor plugin

**Related pages:**

- Keyboard Shortcuts
- Confluence Wiki Markup
- Using Autocomplete

---

**Before and after guide for wiki markup fans**

Below are the most commonly used autocomplete and autoformatting triggers.

**Using wiki markup**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Typing wiki markup:</strong>&lt;br&gt;Typed text and wiki markup into the Wiki Markup Editor pane.</td>
<td>Start typing wiki markup – try it and see what happens!</td>
</tr>
</tbody>
</table>
## Pasting wiki markup:
Pasted wiki markup into the Wiki Markup Editor pane.

Click 'Insert' > 'Wiki Markup' on the editor toolbar. **Note:** Confluence will convert the wiki markup to rich text as soon as you add it to your page. The wiki markup will not be available for editing after that. Example:

```
{blog-posts}
```

### Adding macros

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a macro to your page:</strong> Typed curly brackets, the macro name and parameters. Example: <em>(blog-posts)</em></td>
<td>Type '{' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example: <em>(blog)</em></td>
</tr>
</tbody>
</table>

Alternatively, use **wiki markup entirely**. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** *(blogposts:content=titles|author=jsmith)*
- For details of wiki markup syntax, see Confluence Wiki Markup for Macros.
### Formatting text

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold text:</strong></td>
<td>Type an asterisk '*', your text, then another asterisk in wiki markup. Example:</td>
</tr>
<tr>
<td>Typed an asterisk '*', your text, then another asterisk in wiki markup. Example:</td>
<td><em>Surf's Up</em></td>
</tr>
<tr>
<td><strong>Heading levels:</strong></td>
<td>Type the heading level and a full stop. Autoformat will convert the line to the appropriate heading immediately. You can continue typing your heading text immediately. Example:</td>
</tr>
<tr>
<td>Typed the heading level in wiki markup. Example:</td>
<td>h2. Midnight at the Lost and Found</td>
</tr>
<tr>
<td><strong>Underlining, italics, superscript, subscript:</strong></td>
<td>Type the wiki markup just as you did before. Autoformatting will convert it as you type.</td>
</tr>
<tr>
<td>Typed the wiki markup characters before and after your text.</td>
<td></td>
</tr>
<tr>
<td><strong>Left, centre and right alignment:</strong></td>
<td>Click the left, centre and right alignment buttons on the editor toolbar:</td>
</tr>
<tr>
<td>Not available in previous versions of Confluence.</td>
<td><img src="alignment_buttons.png" alt="Alignment buttons" /></td>
</tr>
<tr>
<td>This can also be used to align images independently of text.</td>
<td></td>
</tr>
<tr>
<td><strong>Indentation:</strong></td>
<td>Click the left and right indentation buttons on the editor toolbar:</td>
</tr>
<tr>
<td>Not available in previous versions of Confluence.</td>
<td><img src="indentation_buttons.png" alt="Indentation buttons" /></td>
</tr>
<tr>
<td><strong>Line break:</strong></td>
<td>Press Shift + Enter to force a line break without a paragraph break. This is a line break with no extra space.</td>
</tr>
<tr>
<td>Started a new line with no empty line.</td>
<td></td>
</tr>
</tbody>
</table>
**Quotation:**
Typed the \{quote\} macro in wiki markup. Example:

\{quote\}Life is a lemon.\{quote\}

Use the *Quote* style – select ‘*Quote*’ from the style dropdown menu or use the keyboard shortcut. Example:

<table>
<thead>
<tr>
<th>Paragraph</th>
<th>B</th>
<th>I</th>
<th>U</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heading 1</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Heading 2</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Heading 3</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Heading 4</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Heading 5</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Heading 6</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><em>Quote</em></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Or type bq. in the editor.

**Colour:**
Typed the \{color\} macro in wiki markup. Example:

\{color:green\}Bat out of Hell.\{color\}

Click the colour options on the editor toolbar. Example:

**Adding symbols and emoticons**

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Smiley:**
Typed a colon and a round bracket. Example:
:\)
Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example:

:\)

| **Tick or check mark:**
Typed a forward slash in round brackets. Example:
\(/\)
Type a forward slash in round brackets. Autocomplete will convert it as you type. Example:

\(/\)
<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Linking to a Confluence page:**
Typed the text and pasted the page name inside square brackets. Example: |
| [Modern Girl|Modern Girl song lyrics] |
| **What to do now** |
Type a square bracket `[` and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example: |
| ![Link suggestions](image) |
| Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser. |
| • This works if you have 'Autoformatting' enabled in the editor settings in your user profile. |
| • This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually. |
| • Example: [Modern Girl|Modern Girl song lyrics] |
**Linking text to a web page:** 
Typed the text and pasted the link inside square brackets. Example:

[Modern Girl](http://www.example.com/song)

Type a square bracket `[` and select 'Insert Web Link`, then paste the URL into the link dialog. Example:

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [Modern Girl](http://www.example.com/song)

**Linking to a page that does not yet exist:**
Typed the name of the non-existent page inside square brackets. Example:

[Future of the Modern Girl]

Type a square bracket `[` and the name of the non-existent page, then select 'Insert Link to Create Page'. Example:

Alternatively, use **wiki markup entirely**. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: [Future of the Modern Girl]
Linking to an attachment:  
Typed '^' and the attachment name inside square brackets. Examples:

```
[^attachment name]
[Page Name#^attachment name]
```

Alternatively, use **wiki markup entirely**. Type the link, including the alias (if required), the caret character '^' and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[^attachment name]`

Linking to an anchor within a page:  
Typed the page name with the anchor name appended. Example:

```
{anchor:index}
[Page Two#index]
```

To create the anchor: Add an anchor macro using wiki markup. Confluence will convert the macro to rich text format and add it to the page. For example, to create an anchor named 'index', type the following:

```
{anchor:index}
```

To create the link: Use **wiki markup** too. Type the link, including the alias (if required), the hash character '#' and the anchor name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[Index #index]`
<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding bullets:</strong></td>
<td></td>
</tr>
<tr>
<td>Typed an asterisk '*' in wiki markup. Example:</td>
<td></td>
</tr>
<tr>
<td>My list:</td>
<td></td>
</tr>
<tr>
<td>* Bad Attitude</td>
<td></td>
</tr>
<tr>
<td><strong>Type an asterisk '*' followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:</strong></td>
<td></td>
</tr>
<tr>
<td>My list:</td>
<td></td>
</tr>
<tr>
<td>• bullet item</td>
<td></td>
</tr>
<tr>
<td>To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.</td>
<td></td>
</tr>
</tbody>
</table>

| **Adding numbered items:** |
| Typed a hash '#' in wiki markup. Example: |
| My list: |
| # A Time for Heroes |
| **Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:** |
| My list: |
| 1. bullet item |
| To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line. |

| **Adding line breaks in a numbered/bulleted list:** |
| Started a new line. Typed a double slash for an empty line. Example: |
| // |
| **Press Shift + Enter.** |

### Using tables

<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adding a table:</strong></td>
<td></td>
</tr>
<tr>
<td>Typed pipe characters '</td>
<td>' in wiki markup. Example:</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>45 seconds of ecstasy</td>
</tr>
<tr>
<td>2</td>
<td>Amnesty Is Granted</td>
</tr>
<tr>
<td>**Type a series of pipe characters '</td>
<td>' then press Enter. Autoformat will convert the pipes to a table. Example – to create a table with three columns:**</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| **Editing a table:** |
| Edited the text and shuffled the pipe characters around. |
| **Learn the keyboard shortcuts for table editing. Click the help icon on the editor toolbar to see a list of shortcut keys.** |

### Displaying images

| What you did before | What to do now |
**Displayed an image attached to the page:**
Typed/pasted the image name inside exclamation marks '!'. Example:

```
!NoMatterWhat.png!
```

**Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:**

```
!NoMatterWhat.png!
```

Alternatively, use **wiki markup entirely**. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.
- **Example:** `!NoMatterWhat.png|align=right`

**Displaying an image attached to another page:**
Typed/pasted the page name, a '^' and the image name inside exclamation marks. Example – to display an image that is attached to the page titled 'Home By Now':

```
!Home By Now^NoMatterWhat.png!
```

Exactly the same as when the image is attached to the same page, or use the new "Search" tab in "Insert" > "Image"

**Aligning images:**

```
!NoMatterWhat.png|align=right!
```

Click on the image and then:

- Click the left, centre and right alignment buttons on the editor toolbar:

![Alignment buttons](image)

- **This can also be used to align images independently of text.**
<table>
<thead>
<tr>
<th>What you did before</th>
<th>What to do now</th>
</tr>
</thead>
</table>
| **Embedding a video, movie or audio file into a page:**  
Used the wiki markup image format. Example: ![HotPatootie.mov](image) | Use the Multimedia macro. Type an exclamation mark '!' and select 'Insert Other Media'. Example: ![Multimedia](image) |

Or type '{' and start typing the macro name 'Multimedia'. Example: `{mul` |

---

**Functionality that is no longer available**

This section contains a list of things you could do in earlier versions of Confluence, but can no longer do in Confluence 4.

1. Edit a page in Microsoft Word. See FAQ entry.
2. Edit, copy or view the wiki markup source of a page. This is because content is no longer stored in wiki markup format.

**New source editor plugin**

The Confluence Source Editor plugin allows users to edit the XHTML-based storage format of the page. You need Confluence 4.1.5 or later to use the plugin.

**Quick Administrator Tips To Prepare for Confluence 4**

We’ve put together some quick tips on how Administrators can prepare for Confluence 4:

1. **Stay Updated On The Latest Docs**

Watch the Planning for Confluence 4 page. We will update that page with more resources as we make further progress - so make sure you stay updated!

2. **Download, install and trial Confluence 4**

We strongly encourage you to set aside some time to download and install the latest version of Confluence 4.x.
You can be better prepared by conducting an upgrade of your data in a test environment to see how the upgrade goes. Don't forget to get your internal users (especially the power users) to try Confluence 4. Ask them to go to their complex pages and see what they look like in the new editor and get feedback from them.

3. Give us feedback!

We really would love your feedback as you trial Confluence 4. We've made it really easy to do so. All you have to do is simply click the "Got Feedback" button you see in the Confluence toolbar:

![Got Feedback?](image)

This feedback will go directly to the Confluence team.

If you need support, please get in touch with our legendary support department at support.atlassian.com.

4. Upgrade your user macros - Now!

With the introduction of Confluence 4, all macros that are inserted in the editor will need to be entered using Macro Autocomplete, or through the Macro Browser. This includes User Macros too!

However, a problem with User Macros in the past was that the only way to insert them was if you knew what parameters were available - and that wasn't documented anywhere.

Now, if you are running Confluence 3.4 or higher, we introduced the ability for an Administrator to make their user macros visible in the Macro Browser and Macro Autocomplete. So the good news is you can prepare for that now, without having to wait for your Confluence 4 upgrade. How do you do this? You will need to define parameters for your user macros. All the documentation on how to do this can be found here. We've also created two examples to help you get started.

⚠️ Important: This is required to enable user macros in Confluence 4.

6. Test your plugins

Although not all plugins are compatible with Confluence 4 yet, you can still test a majority of your plugins in Confluence 4. We strongly recommend you try this and let Atlassian know if there are any issues. This is really important especially if you have custom plugins that you've built internally.

❓ How do I migrate my plugins to Confluence 4? All this information for plugin developers can be found from the Planning for Confluence 4 landing page.

**Trying Confluence 4 Yourself**

Confluence 4 is here! Try your own hosted or downloadable version, free for 30 days: Try Confluence.

**RELATED TOPICS**

Planning for Confluence 4

- Confluence 4 Editor FAQ
- Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor
- Confluence 4 Editor - What's Changed for Wiki Markup Users
- Quick Administrator Tips To Prepare for Confluence 4
- Trying Confluence 4 Yourself
- Giving Feedback on Confluence Releases
- Confluence 4 Editor - Customer Feedback

Giving Feedback on Confluence Releases

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Atlassian is an open company, and we welcome customer feedback on releases of our products.

To provide your feedback, there are several ways you can get in touch with Atlassian:

1. **Atlassian Answers**

   If you have a question like "How do I do (a given task) with Confluence now?", then Atlassian Answers is the best place to visit. There, our vibrant community of power users and developers quickly answer questions of all kinds and provide information on advanced tips and tricks.

2. **The Atlassian Public JIRA**

   Atlassian collects and tracks customer feature requests and bug reports in our public instance of our issue tracker, jira.atlassian.com. There, you can request new product features or report bugs, as well as see all of the other feature requests and bug reports that customers have raised. If you agree with another point that's been raised, you can vote on it to help it along. The Atlassian product managers read and maintain the issues in JIRA, so this is the best place to lodge your opinion about the product.

**Confluence 4 Editor - Customer Feedback**

**FAQs**

Commonly brought up comments which may be of use to others who are following this page

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Is there a 'Confluence 4 for Wiki Markup users' guide available?</td>
<td>Yes, please see Confluence 4 Editor - What's Changed for Wiki Markup Users. If you have anything you'd like to see added to that page, please leave a comment there.</td>
</tr>
<tr>
<td>How can I edit the source / storage format of a page in Confluence or in an external editor.</td>
<td>You can download the Source Editor, a free plugin maintained by Atlassian and available here.</td>
</tr>
<tr>
<td>I have a script that generates Wiki Markup, can I still insert it into a page?</td>
<td>Yes. You can use the Insert Wiki Markup Dialog, just choose 'Insert' then 'Wiki Markup' or use the shortcut &quot;command/ctl + shift + D&quot;</td>
</tr>
<tr>
<td>I have a script that generates Wiki Markup and writes it to a Confluence page using the API, can I still do this?</td>
<td>Yes. You can still send Wiki markup to the API which will convert it to the new source format and save. See this Answers discussion for more.</td>
</tr>
<tr>
<td>I have a script that consumed Wiki Markup from Confluence, do I need to re-write it?</td>
<td>Yes. Wiki Markup is no longer available as an output from Confluence. Unfortunately this means you will need to re-write any scripts which consumed Wiki Markup from Confluence (often via the API as an example) to instead read the new XML based Storage Format.</td>
</tr>
<tr>
<td>I take notes in meetings etc offline in a text editor, formatted with Wiki markup then add them to a page later, how can I do this now?</td>
<td>Take your notes as before then insert them into a page using the Insert Wiki Markup Dialog, just choose 'Insert' then 'Wiki Markup' or use the shortcut &quot;command(or ctrl)+shift+D&quot;</td>
</tr>
<tr>
<td>How can I move the cursor outside a Macro (eg: a {c ode} or {column} macro) without using the mouse?</td>
<td>You can just press the 'down' arrow until the cursor moves out of the macro and back onto the page.</td>
</tr>
<tr>
<td>A macro I wrote that worked in 3.x no longer works for Confluence 4</td>
<td>See Upgrading and Migrating an Existing Confluence Macro to 4.0</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enter/Return gives me a new paragraph, how do I insert just a line break?</td>
<td>Press Shift+Enter</td>
</tr>
<tr>
<td>How can I quickly turn already entered text into a link?</td>
<td>You can highlight the string you want to convert, press [ and wait until the autocomplete menu appears then select from the available options to Search for a page with the title of that text, insert a web link with that text as the clickable link or to insert a link to create a page with that title.</td>
</tr>
<tr>
<td>A short &quot;how-to&quot; from Shannon Greywalker for doing unbalanced tables, tables within tables, etc. in the new 4.x editor.</td>
<td>Available here.</td>
</tr>
<tr>
<td>Why not make wiki-markup editor on top of XHTML storage? Just some engine, which would convert XHTML to wiki-markup and back on save.</td>
<td>Wiki markup can only represent a subset of what can be represented in XHTML. A wiki to XHTML conversion would be lossy meaning that when a 'wiki preferring' author made changes to the page of an 'xhtml preferring' author they would mangle (to some degree) the original author's page. This is a reverse of the round-tripping bugs that used to be encountered when the storage was wiki but the editor was HTML. One fairly typical example would be the case of merged table cells. Confluence Wiki markup cannot represent merged cells, whereas XHTML (and so therefore Confluence storage format) can.</td>
</tr>
<tr>
<td>I want to force something to stay as Wiki Markup on a page, not be converted.</td>
<td>You can use Bob Swift's Confluence Wiki Plugin, details here.</td>
</tr>
<tr>
<td>Is there a way to search across the instance for where a macro is used in a page?</td>
<td>You can do this with the use of the Confluence Macro Indexer plugin. Details on it's use are available here.</td>
</tr>
</tbody>
</table>

**External Resources**

Contributors to this page have kindly collated the following useful references which may assist anyone transitioning from Wiki Markup to the new Editor

- A short "how-to" from Shannon Greywalker for doing unbalanced tables, tables within tables, etc. in the new 4.x editor is available here.
- Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format by Graham Hannington are available here: Advanced Confluence Tips. These include information about:
  - Wikifier, a tool for converting Confluence XML to wiki markup, and for converting Confluence rich text to wiki markup.
  - A Greasemonkey script for The Wiki markup toolbar button which selects the page contents and opens it in the Insert Wiki Markup Dialog for editing.

**Bugs / Improvement / New Feature Requests**

If you have feedback on a bug, a task you now find harder or are unable to do in the new editor then please leave a comment below and we'll incorporate it into this page (and remove the comment afterwards).
note that these are usually only updated once completely fixed, we track progress separately on an internal queue.

**Resolved**

[Click here to expand...](140 issues)

### JIRA Issues (140 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>CONF-26083</td>
<td>Edit Default Space Content with the new editor</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-26945</td>
<td>option to remove indentation from tasks is not enabled (outdent)</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-28415</td>
<td>Editor is not full height</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-20881</td>
<td>By typing 'Enter' while in the labels dialog, it saves the page</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-29193</td>
<td>Editor creates elements that are only styled like headings or paragraphs</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-28484</td>
<td>Link in Confluence pages cannot be edited in IE9 &amp; IE 10 when Page Layout is in used</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-24567</td>
<td>Copy &amp; paste image data into RTE no longer working in Firefox 10</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-28971</td>
<td>Instructional text in Blueprints loses umlauts and other characters, when saving</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-28839</td>
<td>Copying, restricting then moving a page produces stacktrace</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-28500</td>
<td>Clicking &quot;Cancel&quot; does not delete drafts</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-26234</td>
<td>Fullscreen edit</td>
<td>Fixed</td>
</tr>
<tr>
<td>🟥</td>
<td>CONF-27738</td>
<td>PDF icon doesn't show up in link browser / attachments screen</td>
<td>Fixed</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
<td>Status</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>CONF-29590</td>
<td>Cannot insert instructional text on the same line as normal text (Chrome)</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-28577</td>
<td>Drafts do not save when adding or editing a page unless you close the tab or window and click “Leave this Page”</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-28770</td>
<td>In the edit mode of a blueprint template(Meeting Notes or Product Requirements), the cursor jumps back the last edit item when you type any text in IE8</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-26152</td>
<td>Safari - backspace multiple lines in Info/Warning macro nests another macro</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-25926</td>
<td>Highlighting merged cells is buggy</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-25419</td>
<td>Any inline autoformat (e.g. bold, italic, strikethrough) causes macros on the page to flash/blink. Block level (e.g. h1.) are ok.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-23380</td>
<td>Can't see bottom of some pages in editor</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-23457</td>
<td>Certain combinations of keypresses causes the editor to lose focus in Chrome</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-27472</td>
<td>NumberFormatException When Cancelling Page Edits</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-26546</td>
<td>Inserting an autoformat emoticon in a scrolled page causes the page to jump</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-23575</td>
<td>Links to filesystem are</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>ID</td>
<td>Title</td>
<td>Description</td>
<td>Status</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>CONF-25944</td>
<td>Failure when converting editor format to storage format.</td>
<td>Lost after upgrade to Confluence 4.x or upon saving the page in the new editor</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-23884</td>
<td>Can't create page based on template through link.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-27945</td>
<td>Autoconvert of JIRA filter URLs does not work with JIRA 5.2.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-26030</td>
<td>Pasting code into a code block in Confluence loses existing formatting of the code</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-24665</td>
<td>Add ability to create links using non-standard protocols.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-28665</td>
<td>Body macro properties cannot be edited in IE.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-28098</td>
<td>Batch.css changed to add a background color to confluenceTd.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-28307</td>
<td>Unable to add or edit the description of templates.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-24739</td>
<td>Add templates to editor.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-25268</td>
<td>Autoformat and certain autocomplete functions do not work when preceded by a parenthesis.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-23022</td>
<td>Allow to set default location for newly added pages.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-4042</td>
<td>Search/Replace support in WYSIWYG Editor.</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>CONF-26704</td>
<td>Making tables sortable</td>
<td>Fixed</td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23547</td>
<td>Allow users to specify alt and title for images in the WYSIWYG editor</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-26584</td>
<td>Click an image, or macro placeholder can sometimes activate drag and drop behaviour.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-24624</td>
<td>Links to anchors on other pages in Confluence 4.0+ cannot be edited.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23279</td>
<td>Multi-byte characters in macro placeholder aren't displayed at all.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-25937</td>
<td>Editing an existing link produces a strange behavior in IE8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-24168</td>
<td>Remove Google Gears references</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23633</td>
<td>Actions doeditpage,domovepage,docreatepage do not require XSRF token</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-27785</td>
<td>No 'spade' in symbols dialog</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23829</td>
<td>Mouse cursor is misplaced after bullet list indentation</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23828</td>
<td>Copy and paste a word somewhere in between the line makes the mouse cursor jumped to the end of line after hitting Backspace button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23827</td>
<td>Mouse cursor jumped to the end of line after inserting the auto formatting of asterisk or dash button in Firefox 8</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| CONF-23782 | Extra spaces are inserted when macro }
<table>
<thead>
<tr>
<th>Confluence 5.0 Documentation</th>
<th>Confluence 5.0 Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CONF-27750</strong></td>
<td>Autoconvert cuts out anchor components from anchor links</td>
</tr>
<tr>
<td><strong>CONF-25365</strong></td>
<td>Shift+enter in a list item with a panel macro on the page whole page if you are scrolled</td>
</tr>
<tr>
<td><strong>CONF-26089</strong></td>
<td>On a long page, hitting shift+enter on Chrome will jump your current line to the top of the viewport</td>
</tr>
<tr>
<td><strong>CONF-27749</strong></td>
<td>Hitting Shift+enter in a long, scrolled table jumps the browser down to the current cursor position</td>
</tr>
<tr>
<td><strong>CONF-27748</strong></td>
<td>Image resizing busted?</td>
</tr>
<tr>
<td><strong>CONF-27747</strong></td>
<td>Multiple lines a table heading are not rendered as bold.</td>
</tr>
<tr>
<td><strong>CONF-27746</strong></td>
<td>The &quot;Learn more about templates&quot; link is hard coded and wrong. Change to use help-paths.properties. Check for others.</td>
</tr>
<tr>
<td><strong>CONF-27745</strong></td>
<td>Tablesort icons are repeating incorrectly in tasklist, contentbylabel, RSVP and attachments macros</td>
</tr>
<tr>
<td><strong>CONF-27744</strong></td>
<td>When typing a comment quickly, always seem to be a blank line above</td>
</tr>
<tr>
<td><strong>CONF-27743</strong></td>
<td>Can you make it so that undo in Confluence doesn't jump me to the top of the editor?</td>
</tr>
<tr>
<td><strong>CONF-27741</strong></td>
<td>Able to delete/destroy page layout within the</td>
</tr>
</tbody>
</table>
CONF-27736 Opening a link to an undefined page loads a 404

CONF-27735 Unable to break out of a numbered sublist

CONF-27734 Layout icon incorrect: 50:50 has 66:33 icon instead

CONF-24286 En dash in heading title breaks anchor links

CONF-26698 Separate row/column highlight from the new background colouring

CONF-27080 Make table cell colour buttons more intuitive

CONF-25145 Heading loses formatting when preceding newline is deleted

CONF-27365 Add a new icon for disabling cell highlight - not white

CONF-26019 Editor freezes when moving down with cursor and pasting status macro

CONF-26396 Editor buttons disabled when invalid macro used

CONF-27226 Copy-paste data-uri based images works in edit mode, fails on save

CONF-21091 Add Image in WYSIWYG isn't completely translated to French

CONF-27366 Breadcrumbs do not expand properly when doing a preview during page creation

Fixed
CONF-27364  Highlight row/column doesn't work if whole row/column is selected  Fixed

CONF-27363  Cannot change a table row from header to normal  Fixed

CONF-27367  Editing table with cells with non-white background looses any previous background color set  Fixed

CONF-26348  Find & Replace - Cmd+F should focus find input if previous find session aborted  Fixed

CONF-24201  Ability to nest Expand macros  Fixed

CONF-21788  Link updater changes last modifier of linking page  Fixed

CONF-23410  Can't break out of a list item after shift+enter  Fixed

CONF-27010  Draggable images and macros  Fixed

CONF-24563  Cannot drag and drop within the new editor  Fixed

CONF-26971  View file macro does not detect an office file attached during editing (through insert link/attachment) straight away  Fixed

CONF-24488  Table entered via Wiki Markup Dialog Box wraps cells in p tags.  Fixed

CONF-25994  cut paste of paragraph + bullets loses the paragraph content  Fixed

CONF-26493  Autoconvert for HR after space not just enter  Fixed

CONF-11744  Creating a template  Fixed
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-25062</td>
<td>Making lists out of paragraph text differs from plain text to list context.</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-2493</td>
<td>Sortable Tables</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26497</td>
<td>Sorting little triangle on top of table columns is drawn opposite than expected</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26496</td>
<td>When I add a linefeed to a table header, it unbolds and becomes bottom-aligned...</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26502</td>
<td>it is too easy to drop an object in the wrong place and lose it</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26500</td>
<td>dragging something from one th to another th will highlight the source th</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26504</td>
<td>Unable to drag image across to neighbouring cell (IE9)</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26503</td>
<td>Dragging content into body macro causes placeholder to shake</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26501</td>
<td>Dragging content towards the bottom of a page causes editor to jump</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26226</td>
<td>The table drop-down is positioned over the button instead of beneath it using the quick comment editor</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25406</td>
<td>Centering a paragraph loses image effect</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-24482</td>
<td>Moving the cursor down in a table and pasting freezes the editor.</td>
<td>Fixed</td>
</tr>
<tr>
<td>Ticket</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>CONF-24095</td>
<td>Safari 5 support broken in new editor: cut and paste inside macro blocks is unusable</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-23923</td>
<td>Backspace key can cause unexpected embedded macros to appear on Safari</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26299</td>
<td>Pressing Escape in Wiki Markup Dialog breaks future usages in editing session</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26488</td>
<td>Chrome + Inline Tasks: Enter+Enter creates a &lt;div/&gt;</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25108</td>
<td>Pasting HTML tags into a Confluence table can cause the editor to lock up</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-6482</td>
<td>Custom background colour for rows or cells in table</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-24038</td>
<td>Allow quick insertion of macros, links and embedded content using autoformat</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-23914</td>
<td>Source Editor Plugin - Edit XHTML</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25670</td>
<td>Either Jira or jira should autoformat to JIRA</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25373</td>
<td>Selecting multiple fields in table and utilizing shortcut for bold causes row shift</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25397</td>
<td>Un-indenting a non-indented paragraph scrolls to top of page (Chrome)</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25418</td>
<td>Both Toolbar buttons are Active when nesting a UL inside an OL or vice-versa</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
CONF-25369  Creating list items in the same table cell with a paragraph in between renders with different indentation padding  Fixed

CONF-23281  Highlight panel text look mis-aligned with icon when there is no title.  Fixed

CONF-23809  Mention user name links are occasionally replaced by the page title  Fixed

CONF-24571  Save, Preview, Cancel Button Grey Out When Create JIRA Issue  Fixed

CONF-25226  DEL at the end of the numbered line doesn't delete the line break  Fixed

CONF-25201  Font sizes in the Popular Labels Macro Heatmap are being overridden when placed in the footer section of a page layout  Fixed

CONF-23497  Bullet points are not aligned with the text in Safari/Chrome  Fixed

CONF-24709  Entered text is lost in Firefox after previewing, entering text and saving  Fixed

CONF-24017  Link Text not editable when editing a link to an attachment  Fixed

CONF-24066  Copying and pasting plain text containing brackets into a table cell freezes the editor  Fixed

CONF-23842  Copying and pasting list items into an existing list  Fixed

CONF-25030  No spacing between page first paragraph  Fixed
More weirdness with nested bullets

Confluence editor does not preserve layout when pasting tab characters

Copying and pasting white space inside the code macro does not work (right click also causes the selection to collapse undesirably)

Selecting the whole contents of a code macro and pasting text into it removes the placeholder in webkit

default macro parameter not accessible within EditorImagePlaceholder

Cut, Paste Table row cant be performed to put a row at the buttom.

Ability for users to copy and paste tables and multiple rows and cells

Trying to delete bullets from editor results in unselectable hanging bullet

Cannot delete list item that is before a nested list item in webkit

error when you copy into the table a text containing the
characters '«' or '»' (Windows (CP-1251): '«' - 171 '»' - 187)

- **CONF-24096** crossing out of text does not work
- **CONF-18922** if the last content on a page is a table row, positioning the cursor after it and pressing enter/return in the RTE causes a new line to be created at the top of the page not the end
- **CONF-23456** Copy pasting text into the new editor causes the page to "jump" to the end of the pasted text rather than staying put
- **CONF-23483** Pasting email links containing upper-case (capital) letters does not autoformat correctly
- **CONF-23810** ALT + CTRL + S inserts an illegal control character in safari that prevents the page from being saved
- **CONF-23701** After creating link in editor the backspace removes paragraph text after the cursor in editor 4.0.3
- **CONF-23551** Multi-byte characters aren't displayed correctly in Code Block Macro.

**Open**

Too add your issue, please raise a ticket in the CONF Project using the Component 'Editing' and specify the Affects Version. For bugs, please include your OS and Browser details.

Please note that while JIRA issues have been raised for all these comments, I don't want to set unreasonable expectations so just be aware that being in this list is not a guarantee of something being implemented. As always our Implementation of New Features Policy and Bug Fixing Policy apply.
## Bugs (200 issues)

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-30133</td>
<td>External standalone gadgets can't be inserted in Confluence page</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30123</td>
<td>IE10 adds new attachment if you drag and drop an image in a page</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30122</td>
<td>Page property report macro-Columns to show with special characters üôä</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30121</td>
<td>Non-ascii character of Status property isn't shown correctly.</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30111</td>
<td>copy and paste of image into editor does not attach the file on Windows</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30092</td>
<td>In IE8, the 'Link', 'Insert' and 'Table' are always shown in their collapsed state</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30067</td>
<td>Bullets don't work as expected when used in the vicinity of note macros in IE8</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-30028</td>
<td>Page Properties Macro Inserts Leading Space in Blank Table Cells</td>
<td>Needs Verification</td>
</tr>
<tr>
<td>CONF-30019</td>
<td>Entering a status macro into a page when in DFE causes the editor toolbar to disappear</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29981</td>
<td>Adding a column to a merged cell adds column as merged</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29960</td>
<td>Squared lists converted into Circled lists</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29951</td>
<td>primary toolbar doesn't stalk when distraction free editor is engaged on Chrome/Windows</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29950</td>
<td>diffs on merge conflict screen get hidden by the distraction free editor</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29938</td>
<td>Sometimes cannot save drafts</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29917</td>
<td>Document Reverts to Previous</td>
<td>Open</td>
</tr>
</tbody>
</table>
Version after Hitting Save; All Newer Changes Lost

CONF-29875  Checkboxes in tables are not removable  ➤ Open

CONF-29866  List style parameter "none" is ignored in TOC Zone macro  ➤ Open

CONF-29841  Undo after a mention undoes the whole line  ➤ Open

CONF-29838  Links in a heading style within in a panel on some layouts are not rendered correctly.  ➤ Open

CONF-29819  Multiple task list in a page causes inconsistent behaviour in Chrome  ➤ Open

CONF-29814  Shift + End Selection on IE Selected The Whole Line Instead of Only The Characters  ➤ Open

CONF-29799  Paste images into the editor from clipboard using Firefox 22.x and above does not work  ➤ Open

CONF-29753  Overzealous replacement of content for a table cell in the editor  ➤ Open

CONF-29751  Copy and paste multiple lines in bullet list does not work as expected in Google Chrome  ➤ Open

CONF-29743  Text formatting dropdown too far from the button  ➤ Open

CONF-29740  Unmarshalling of links when transforming Editor XHTML store CDATA when there are non-latin characters  ➤ Open

CONF-29737  Gallery Macro Labels Using OR instead of AND  ➤ Open

CONF-29731  Display Inline / Display on new line not working correctly - not resolved  ➤ Open

CONF-29728  Anchor links on the same page do not work in IE8 when using multi-column layouts  ➤ Open

CONF-29727  Section inline dialog is not  ➤ Open
layered correctly with modal dialog

CONF-29726  "Your browser does not support pasting images" dialog footer too large

CONF-29714  Unable to modify table with unordered list after removing a row in IE

CONF-29684  Inline "show new comment" action doesn't work while replying to a comment

CONF-29650  International characters are not sorted properly in Confluence tables

CONF-29614  pasting pre-formatted text to code, no-format blocks kills spaces

CONF-29595  Form Field Template is Not Migrated Properly After Upgrade

CONF-29585  Page Down/Page Up don't work in Preview mode

CONF-29524  Page layout breaks when using attachments macro inside ordered list in confluence 5.1.3

CONF-29465  Info / tip / warning / note (.aui-message) panels does not respect floating elements

CONF-29459  Line break in Note Macro, Warning Macro, and Info Macro does not work in IE8

CONF-29428  Editor button state does not change in IE8

CONF-29427  Macro in table cell with highlight has extra blank lines

CONF-29420  When two pages are copied at the same time by the same user where one has an attachment, the attachment appears on the wrong copy

CONF-29399  Exclamation points (!) after @ mentions incorrectly trigger the
<table>
<thead>
<tr>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-29368</td>
<td>Macro Browser Disappears After bulleted List at the End of a Long Page</td>
</tr>
<tr>
<td>CONF-29351</td>
<td>Confluence editor combine the color with the font of the overwritten word</td>
</tr>
<tr>
<td>CONF-29337</td>
<td>Copy/Paste Mishaving in Confluence Editor</td>
</tr>
<tr>
<td>CONF-29331</td>
<td>Can't edit pages when using Google Analytics &quot;traditional&quot; snippet in Custom HTML</td>
</tr>
<tr>
<td>CONF-29321</td>
<td>@mentions inconsistently rendered in preview and page</td>
</tr>
<tr>
<td>CONF-29311</td>
<td>Confluence truncates anchor links</td>
</tr>
<tr>
<td>CONF-29284</td>
<td>Inconsistent headings behavior in the info macro</td>
</tr>
<tr>
<td>CONF-29283</td>
<td>Blank space character inserted in new table rows and columns</td>
</tr>
<tr>
<td>CONF-29220</td>
<td>'A title must be specified' error message persists on the Preview mode</td>
</tr>
<tr>
<td>CONF-29152</td>
<td>Code Block Issues when editing</td>
</tr>
<tr>
<td>CONF-29146</td>
<td>Use a column as the header of a table loses format after upgrade</td>
</tr>
<tr>
<td>CONF-29124</td>
<td>Pasting code into a code block in Confluence looses existing formatting of the code - take 2</td>
</tr>
<tr>
<td>CONF-29121</td>
<td>A table copy and pasted from Excel to Confluence is not sortable</td>
</tr>
<tr>
<td>CONF-29084</td>
<td>Significant Issues when changing text colour of a list</td>
</tr>
<tr>
<td>CONF-29076</td>
<td>Copy/Paste of Tables Rows is Broken</td>
</tr>
<tr>
<td>CONF-29048</td>
<td>Confluence fails to merge changes while editing page concurrently</td>
</tr>
</tbody>
</table>
CONF-29032  Unknown named spaced attributes from pasted content produces error message → Open
CONF-29024  Tables using <thead> are rendered incorrectly → Open
CONF-29012  EditorIndent issue when selecting bold → Open
CONF-28974  editor "Restricted" symbol does not update its status if restrictions are added/removed between page load and editor load → Open
CONF-28925  Code blocks become immovable → Needs Verification
CONF-28924  Drag-n-drop code block insertion point jumps around page → Open
CONF-28923  Code blocks unexpectedly being removed, and moving around page → Open
CONF-28921  Applied text style out of sync with style buttons → Open
CONF-28920  Overtyping braces doesn't work → Open
CONF-28901  Curly left brace { in user macro breaks rendering → Needs Verification
CONF-28896  After entering a hyperlink in a page and verifying that it works, the link is replaced with "nofollow" in <a href> when I save. → Needs Verification
CONF-28878  Table of Contents links do not all work → Open
CONF-28871  Failure when converting editor format to storage format with links to emails on page → Open
CONF-28865  Typing while Find/Replace toolbar animates corrupts search term → Open
CONF-28860  Extra space is added in each cell for added table column → Open
CONF-28856  Copy and paste bold text results in a double bold text in Firefox → Open
<table>
<thead>
<tr>
<th>Ticket</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-28855</td>
<td>Saving a page without any changes causes the last changeset to be attributed to the current user</td>
</tr>
<tr>
<td>CONF-28830</td>
<td>Using 'Find' to land on a link then opening and dismissing the 'Edit' dialog, breaks 'Previous'</td>
</tr>
<tr>
<td>CONF-28825</td>
<td>Backspace over bolded text causes cursor jumps</td>
</tr>
<tr>
<td>CONF-28778</td>
<td>Gallery Macro Inside Section Macro Displays Images in New Window Instead of Lightbox</td>
</tr>
<tr>
<td>CONF-28774</td>
<td>Inconsistent line spacing</td>
</tr>
<tr>
<td>CONF-28773</td>
<td>Unexpected side-effect from deleting a line</td>
</tr>
<tr>
<td>CONF-28771</td>
<td>Extra line breaks randomly inserted into page</td>
</tr>
<tr>
<td>CONF-28758</td>
<td>Font color is not consistent</td>
</tr>
<tr>
<td>CONF-28731</td>
<td>Anchor link incorrect when page title starts with _ (underbar)</td>
</tr>
<tr>
<td>CONF-28726</td>
<td>Warning macro inside a Page Properties macro doesn't display the text, only the title</td>
</tr>
<tr>
<td>CONF-28717</td>
<td>Unable to render attachments containing special characters with drag &amp; drop using Mac OS X</td>
</tr>
<tr>
<td>CONF-28690</td>
<td>Pasting a link into the editor containing brackets with a number of characters between them causes Chrome to crash</td>
</tr>
<tr>
<td>CONF-28673</td>
<td>Template migration fails when parameters</td>
</tr>
<tr>
<td>CONF-28667</td>
<td>TIFF images cannot be accessed using attachments macro</td>
</tr>
<tr>
<td>CONF-28661</td>
<td>Unable to create a child page if parent page contains a title with Turkish character &quot; (JDK 1.7)</td>
</tr>
<tr>
<td>CONF-28657</td>
<td>Bullet points overlap with images floated to the left</td>
</tr>
<tr>
<td>CONF-28647</td>
<td>Edit link macro shows garbled characters when using danish characters in page name</td>
</tr>
<tr>
<td>CONF-28634</td>
<td>HibernateSystemException when canceling the addition of a new blank page that has Balsamiq attachments</td>
</tr>
<tr>
<td>CONF-28608</td>
<td>Confluence won't save a page or publish a blog posting after errors creating labels</td>
</tr>
<tr>
<td>CONF-28605</td>
<td>What did you change comment does not get saved when using German language</td>
</tr>
<tr>
<td>CONF-28585</td>
<td>Pasting a link to a protocol (eg. ftp:// or evernote://) modifies the link and adds the base URL to it - resulting in a broken link</td>
</tr>
<tr>
<td>CONF-28582</td>
<td>Code macro does not maintain empty lines when copy and pasted</td>
</tr>
<tr>
<td>CONF-28579</td>
<td>Cell background colors do not print out</td>
</tr>
<tr>
<td>CONF-28561</td>
<td>Confluence Page Layout goes FUBAR</td>
</tr>
<tr>
<td>CONF-28511</td>
<td>Weird Table creation Issue with IE 8</td>
</tr>
<tr>
<td>CONF-28471</td>
<td>Linking issues in different browsers</td>
</tr>
<tr>
<td>CONF-28468</td>
<td>Cancelling a page edit sometimes throws a NullPointerException, caused by a draft that the user does not have permission to edit (not necessarily the page being edited)</td>
</tr>
<tr>
<td>CONF-28426</td>
<td>Confluence table grid lines don't show on Chrome on MacOS</td>
</tr>
<tr>
<td>CONF-28418</td>
<td>tinymce.confluence.MacroUtils.insertMacro will never resolve if macro image fails to load</td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>CONF-28395</td>
<td>Additional Space on editor if there's a break at the end of the page on IE8</td>
</tr>
<tr>
<td>CONF-28391</td>
<td>Font size distorted under a macro</td>
</tr>
<tr>
<td>CONF-28362</td>
<td>Property 'scrollTo' of object [object global] is not a function</td>
</tr>
<tr>
<td>CONF-28352</td>
<td>Editor: cursor jumps to wrong place after inserting macros</td>
</tr>
<tr>
<td>CONF-28344</td>
<td>Setting a line to h1 in a section causes image to disappear</td>
</tr>
<tr>
<td>CONF-28343</td>
<td>Forward delete broken in bullet lists</td>
</tr>
<tr>
<td>CONF-28341</td>
<td>The editor notifications for things like find/replace wrapping no longer appear</td>
</tr>
<tr>
<td>CONF-28335</td>
<td>Can't edit pages when using piwik analytics code</td>
</tr>
<tr>
<td>CONF-28319</td>
<td>Unexpected unicode characters inserted into code block</td>
</tr>
<tr>
<td>CONF-28223</td>
<td>Allow to disable the 'Hint: double-click to select code' 'feature'</td>
</tr>
<tr>
<td>CONF-28206</td>
<td>Scroll Bar Disappears in Edit Mode</td>
</tr>
<tr>
<td>CONF-28094</td>
<td>Creating a link doesn't save correctly</td>
</tr>
<tr>
<td>CONF-28087</td>
<td>Space key is missing when editing links to anchors on other pages</td>
</tr>
<tr>
<td>CONF-28083</td>
<td>Multi-byte characters aren't displayed in the gadget placeholder in editor</td>
</tr>
<tr>
<td>CONF-28077</td>
<td>Inserting a confluence attache as an external image, then making it a thumbnail stays a thumbnail when clicking on it.</td>
</tr>
<tr>
<td>CONF-28035</td>
<td>Insert link dialog fails with [] characters in link</td>
</tr>
<tr>
<td>CONF-28022</td>
<td>Image links not working with</td>
</tr>
</tbody>
</table>
Page Layouts in Firefox

CONF-28017 Creating a macro (note, tip, etc) within a list with a font effect on, then disabling the effect in the macro box causes duplicates that macro.

CONF-28008 Initial cursor position in the Insert Image dialog is wrong

CONF-27980 Images can’t be resized to >900px

CONF-27962 Content of page in preview mode is not able to be copied using CTRL + C

CONF-27957 Emoticons are lost on save when inside a link

CONF-27947 Clicking on an aligned image is no longer reflected in the left|center|right align

CONF-27910 Entering new line before a table will returns cursor back to top of editor

CONF-27858 Insert wiki markup in a template causes wiki markup conversion errors

CONF-27846 Inserting Wiki to Create Link to Page With Full URL Path Fails

CONF-27800 Cut and Paste in Table (IE9)

CONF-27796 Quick Comment Loader Freezes Safari

CONF-27772 Complex Image URL’s not rendering (Google image charts)

CONF-27754 Copying and pasting a link to a Confluence page results in a web URL link instead of a space/page link

CONF-27742 Can insert new lines above page layout

CONF-27707 If the comment editor is open (but not in focus) ‘e’ shortcut jumps to it instead of editing page
<table>
<thead>
<tr>
<th>Ticket</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-27696</td>
<td>Heading loses formatting when preceding newline is deleted</td>
</tr>
<tr>
<td>CONF-27682</td>
<td>Formatting is lost when a line break is used in Expand Macro</td>
</tr>
<tr>
<td>CONF-27653</td>
<td>Accent characters in page title break linking</td>
</tr>
<tr>
<td>CONF-27625</td>
<td>Can't delete macroplaceholder and surrounding text when both are selected (IE9)</td>
</tr>
<tr>
<td>CONF-27619</td>
<td>Editor freezes upon pasting rendered CSS</td>
</tr>
<tr>
<td>CONF-27615</td>
<td>Changing a tables cell colors, while having text selected reverts the cells to white</td>
</tr>
<tr>
<td>CONF-27557</td>
<td>Need horizontal scroll on BROWSER; current end-of-table placement is no good</td>
</tr>
<tr>
<td>CONF-27499</td>
<td>Missing blank when using @mention inside a list-item, with an indented list item following</td>
</tr>
<tr>
<td>CONF-27491</td>
<td>Automatic draft saving stops working when jira-connector plugin is disabled</td>
</tr>
<tr>
<td>CONF-27469</td>
<td>Attachment link failed to update correctly in IE8</td>
</tr>
<tr>
<td>CONF-27457</td>
<td>balsamic mock is positioned incorrectly on a page template</td>
</tr>
<tr>
<td>CONF-27437</td>
<td>When unlinking a link in an &lt;li&gt;, the nolink span will now wrongly propagate to subsequent list items</td>
</tr>
<tr>
<td>CONF-27431</td>
<td>Table height is inconsistent after deleting extra line in one cell in IE 8</td>
</tr>
<tr>
<td>CONF-27417</td>
<td>Deleting a row from a table that has merged cells will mess up the table</td>
</tr>
<tr>
<td>CONF-27406</td>
<td>Embedded code with object id tag in HTML macro will return</td>
</tr>
</tbody>
</table>
'about:blank' page in Chrome

CONF-27390 Storage format shows incorrectly in IE → Open

CONF-27387 macro autocomplete doesn't support scandinavian characters → Open

CONF-27225 Definition lists confuse the editor in Firefox → Open

CONF-27145 Auto convert link doesn't work with multi-byte character → Open

CONF-27140 Italics and bulleted lists in Chrome causes formatting issues → Open

CONF-27114 Select All - Copy -> Paste will not paste images but refer to source images. → Needs Verification

CONF-27079 Awesome paste no longer works for skitch embeds because the URL has changed to Evernote → Open

CONF-27074 Linking to anchors does not always jump to the correct heading → Open

CONF-27036 Creating a Web Link to a URL that contains [] characters results in <a rel="nofollow"></a> → Open

CONF-27014 Sorting table does not work if column contains empty cells → Open

CONF-26925 Selection of multiple objects in Firefox not accurately represented → Open

CONF-26920 Bottom bar of editor disappears when editing table in IE if jira connector plugin is disabled → Open

CONF-26897 Not able to link text to an anchor on a template page. → Open

CONF-26881 Pressing <enter> in the middle of a sentence/word will not create line breaks in IE8 → Open

CONF-26822 Copy/paste of JIRA issue links into editor looks like it works when it doesn't → Open
<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-26783</td>
<td>Tables do not align with images in Easy Reader theme</td>
</tr>
<tr>
<td>CONF-26754</td>
<td>Resuming page edit with IE8 causes the &quot;What did you change?&quot; comment to be added</td>
</tr>
<tr>
<td>CONF-26748</td>
<td>Text formatting misbehave once Shift+Enter is used.</td>
</tr>
<tr>
<td>CONF-26741</td>
<td>Underlined texts in a page from an imported Word doc results in a strange behavior in Firefox</td>
</tr>
<tr>
<td>CONF-26731</td>
<td>Attachment link properties panel doesn't appear in the editor when the link appears broken or greyed out in the page due to missing attachment or other reason</td>
</tr>
<tr>
<td>CONF-26710</td>
<td>Applying text colour to all text via Ctrl + A does not apply the colour to some of the list items</td>
</tr>
<tr>
<td>CONF-26690</td>
<td>Create Page action with provided labelString parameter does not show labels in Label dialog</td>
</tr>
<tr>
<td>CONF-26678</td>
<td>Page title in Edit Link dialog is encoded.</td>
</tr>
<tr>
<td>CONF-26668</td>
<td>Adding row to tables with many columns generates 'script unresponsive' error in IE8</td>
</tr>
<tr>
<td>CONF-26639</td>
<td>Weird behaviour on medium size image on Confluence 4.3 editor using Chrome in Windows 7</td>
</tr>
<tr>
<td>CONF-26629</td>
<td>Quote block disappears after few quote blocks are created in IE8</td>
</tr>
<tr>
<td>CONF-26622</td>
<td>Double click for Macro properties doesn't work for nested macros</td>
</tr>
<tr>
<td>CONF-26596</td>
<td>Using color macro inside headings in Wiki Markup results in double headings</td>
</tr>
<tr>
<td>CONF-26576</td>
<td>Editor: keyboard navigation is broken with large code blocks</td>
</tr>
</tbody>
</table>
CONF-26574  The number of attachment in page edit mode is wrong, it is summing all the version of the attachments

CONF-26556  Mention autocomplete breaks subsequent editor formatting

CONF-26533  Table column Sorting doesn't detect date text

CONF-26530  Protocol of external link changes from "http" to "https" on save

CONF-26494  Inserting HR resulting in blank space intermittently

CONF-26482  Pressing command-z to undo often undoes more than the last actions

CONF-26475  when clicking on a picture to edit it it jumps to a lower position

CONF-26453  selected image doesn't show alignment state

CONF-26445  Deleting text with different foreground colours removes the foreground colour

CONF-26444  Unable to insert links

CONF-26393  Unable to insert horizontal rule between two body macros

CONF-26392  Pasting screenshots in a table places the cursor out of the table

CONF-26389  Editor creates a link with an URL of its own preference, not the one user typed in to create

CONF-26388  Editor: can not edit a link, referencing the same page

CONF-26387  Advanced link edit starts with a blank field

CONF-26380  Editor issues - misalignment of cursor in IE9 browser

CONF-26326  Macros entered with wikimarkup don't preserve parameter values.

CONF-26323  Heading autoformatting does not
Improvements/Feature Requests (71 issues)

<table>
<thead>
<tr>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-30029</td>
<td>Hidden Text Macro/Function</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29583</td>
<td>Undocumented but possible parameters to &quot;noformat&quot;</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29562</td>
<td>Using 2 columns with numbered list and can't make 2nd column to pick up from the number where column 1 finished</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29560</td>
<td>Add option to force a reset/reapply of formatting</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29532</td>
<td>Improving Printing of Check Lists in Confluence - changing colors</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29531</td>
<td>Improving Printing of Check Lists in Confluence - printing the actual check icon</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29379</td>
<td>Warn a user when a session is about to expire during page editing/creation</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29294</td>
<td>Prioritise autocomplete link suggestion results to current space</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29285</td>
<td>Edit a Table in View Mode</td>
<td>New</td>
</tr>
<tr>
<td>CONF-29161</td>
<td>Can't create page based on template through link</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-29057</td>
<td>Automatically embed WuFoo forms and Reports in Confluence when pasting a URL</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28973</td>
<td>Find and replace should work on the Address of Web Links</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28938</td>
<td>Confluence should have proper UI to add links to headings and anchors on other pages.</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28812</td>
<td>Allow copy and paste of</td>
<td></td>
</tr>
<tr>
<td>Issue Key</td>
<td>Description</td>
<td>Status</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>CONF-28720</td>
<td>Lots of text inside a diff view of a bodied macro doesn't compress unchanged text with an ellipsis</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28588</td>
<td>Drag and drop of image with the same name as an existing image on page causes unexpected behavior</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28537</td>
<td>Be able to add labels via an inline control, not a dialog</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28382</td>
<td>Show me who will be notified of my work inside the Editor</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28313</td>
<td>As a plugin developer, I want to render the output of my macro in the editor</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28229</td>
<td>Use Ctrl-Shift-V to 'paste unformatted’</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28225</td>
<td>Have entire page scroll horizontally instead of just tables</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28222</td>
<td>Middle mouse button paste (linux) fails</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28221</td>
<td>Add 'ctrl-g' keyboard shortcut to in editor find and replace</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-28215</td>
<td>Indicate the JIRA instance name in the gadget browser (if there are multiple JIRA application links)</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-27979</td>
<td>Create an easy way to align a macro such as Table of Contents and have content wrap around it</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-27894</td>
<td>Provide ability to easily highlight text with color in WYSIWYG editor</td>
<td>Open</td>
</tr>
<tr>
<td>CONF-27880</td>
<td>Support justification / alignment on a selection of cells in a table</td>
<td>New</td>
</tr>
<tr>
<td>CONF-27848</td>
<td>Add ability to set default sorting appearance for tables in Confluence</td>
<td>New</td>
</tr>
<tr>
<td>CONF-27839</td>
<td>Automatic title suggestion for</td>
<td>Open</td>
</tr>
<tr>
<td>Issue Number</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>CONF-27618</td>
<td>More cell highlight colors in Confluence</td>
<td></td>
</tr>
<tr>
<td>CONF-27263</td>
<td>Allow case sensitive search (and replace) within wiki page</td>
<td></td>
</tr>
<tr>
<td>CONF-27051</td>
<td>Provide navigation in the editor while editing</td>
<td></td>
</tr>
<tr>
<td>CONF-27018</td>
<td>Heading is affecting further than what's being highlighted</td>
<td></td>
</tr>
<tr>
<td>CONF-26808</td>
<td>Respect different number formats when sorting tables</td>
<td></td>
</tr>
<tr>
<td>CONF-26655</td>
<td>Allow multiple page layouts in a single page / nested page layouts</td>
<td></td>
</tr>
<tr>
<td>CONF-26473</td>
<td>Ctrl-e shortcut doesn't go to end-of-line in Confluence editor</td>
<td></td>
</tr>
<tr>
<td>CONF-26173</td>
<td>Rewrite links in macros inside parameterised body macros</td>
<td></td>
</tr>
<tr>
<td>CONF-26165</td>
<td>Ability to create tables without borders</td>
<td></td>
</tr>
<tr>
<td>CONF-26037</td>
<td>Macro Toolbar for changing Macro Options</td>
<td></td>
</tr>
<tr>
<td>CONF-25951</td>
<td>The new table sorting should also sort on emoticons (x), (y), (n)</td>
<td></td>
</tr>
<tr>
<td>CONF-25894</td>
<td>Ctrl-E does not move to end of line in editor in OSX</td>
<td></td>
</tr>
<tr>
<td>CONF-25861</td>
<td>Return to Dashboard on Editor Cancel if you originated there</td>
<td></td>
</tr>
<tr>
<td>CONF-25753</td>
<td>Improve copy-paste experience between HipChat and Confluence for a conversation</td>
<td></td>
</tr>
<tr>
<td>CONF-25750</td>
<td>Make the notify watchers functionality of page edits more discreet</td>
<td></td>
</tr>
<tr>
<td>CONF-25533</td>
<td>Provide a nicer way to link to page anchors</td>
<td></td>
</tr>
<tr>
<td>CONF-25481</td>
<td>CTRL + 1, CTRL + 2, etc...</td>
<td></td>
</tr>
</tbody>
</table>
should be a preference

CONF-25464  Improve editor vertical height usage, especially for smaller screens  → Open

CONF-25416  Upon pressing cancel while editing a page, wiki should ask if the user is sure about about cancelling the work  → Open

CONF-25376  Keyboard shortcut for Cancel while in the Editor  → Open

CONF-25331  Allow WidgetConnector to work with all YouTube link types  → Open

CONF-25216  Allow macro parameters to be editable by KB shortcuts  → Open

CONF-25190  Add Regular Expression support to editor search & replace  → Open

CONF-25181  Copy and paste confluence table from MacOS Firefox 11 into MacOS Lion Mail app loses important formatting  → Open

CONF-24903  Allow macros to return an iFrame rather than just an image for the Macro Placeholder  → Open

CONF-24878  Naming scheme for pasted images from clipboard  → Open

CONF-24805  Keyboard shortcut for editing macro properties  → Open

CONF-24770  Can't select a single table cell in order to paste it to another cell  → New

CONF-24727  Editing a page: add more margin at the bottom of the editing document  → Open

CONF-24721  Improve Confluence's New Editor's copy and paste functionality ....  → Open

CONF-24653  change text style on all marked areas  → Open

CONF-24626  Make find & replace highlight all occurrences of search string and display a count  → Open
| CONF-24502 | Keyboard shortcuts for text alignment |
| CONF-24381 | Ability to extend unbalanced tables |
| CONF-24296 | Make it explicit how tabular content is pasted into/as a table |
| CONF-24291 | Allow alignment to be inherited from existing table line when inserting new line |
| CONF-24094 | Cursor should navigate ‘over’ items |
| CONF-24026 | Provide frames with editable parameters for macros as well as all special editor objects |
| CONF-23966 | Shortcut for font format options |
| CONF-23454 | Cannot drag and drop text in the new editor |
| CONF-23332 | Pasting Confluence content in editor should copy embedded images to destination page |
| CONF-8333 | Real-time concurrent editing to allow multiple editors to collaboratively edit content |

### Additional Ideas

*Click here to expand...*

While we want the focus of this page to remain specific and detailed feedback on the new editing experience that we can address, a number of people have put considerable effort into outlining their ideas for alternate editing strategies and we also wanted to capture these below.
| Alexy Kotenko | Okay, as the WYSIWYG abilities are wider than wiki markup allows - let it be. But you can still provide a solution similar to one implemented in JIRA search. In there you have a search form for rather simple requests, and direct SQL edit for complicated requests. And if directly edited SQL is too complicated to show it as a form - it just tells you "search query is too complicated" and doesn't allow to switch back to form. As earlier you have claimed that implementing XML-to-wiki transformation is easy - I see no problem to still allow wiki edit, but with XML format on backend and disallow wiki if something too complicated was created through WYSIWYG. This can easily be added as a plugin, to solve your problem with complains on the core software. |
| Anonymous | This sounds like a very good idea, and I hope Atlassian will take the time to investigate it. By definition, people who still want to use wiki markup will not be using the most complex WYSIWYG-only formatting, so it should be possible to convert almost everything such users write back to markup. Another suggestion would be to extend the Wiki Markup Styler plugin to do the same thing. Ideally, any content that can be converted back to markup, would be. And any complex elements that cannot be converted would just appear as they do in the normal WYSIWYG view. This would avoid the possibility of one complex piece of content causing a whole page to be marked as "too complicated to edit through wiki markup". If Atlassian choose to do this, the other vital requirement (for me) is that we can copy the wiki markup from the editor. At the moment, the plugin displays markup elements on-screen, but if I try to copy them it just gives me the underlying text. In common with other commenters, sometimes I prefer to copy markup from a Confluence page into a text editor and edit it there, before pasting it back (either into a different page, or into another part of the same page). |
Keep wiki markup format by wrapping in a "wiki markup" macro

---

Todd - Ability to wrap entire pages in the Wiki Markup macro and not have them auto-convert to storage format. Additionally:

- Macros that come from plugins I currently use in 3.5 continue to work the same way in the wiki code block. I'm willing to wait for the authors (Adapatvist, Customware, and the guy who wrote the LaTeX plugin) to upgrade their plugins for 4.0, but the end result must be that I can write in 4.0 wiki code blocks the same way I currently write in the 3.5 wiki editor.
- User macros I wrote for 3.5 need to also appear in the 4.0 wiki code blocks.
- When upgrading from 3.5 to 4.0, I want the upgrade process to wrap every page in a wiki markup block instead of converting it to the new XHTML format.
- Site and Space themes should be definable in terms of Wiki format.
- It would be nice if the wiki code blocks had a button on them that would convert to the new XHTML format if you pressed it. I understand this would be a one-time no-reversal operation, and that would be fine with me.

---

Andrew

- I haven't read through this post, but this page says to post requests here. I'm new to confluence (and like it a lot), but was wondering why wiki markup is translated into a wysiwyg format after entry. I was wondering if it made sense to allow people to make a container (like a new column) which would preserve wiki markup, but render it on the saved page as rich text? I know it's not as friendly to non-technical users, but it seems a bit closer to the middle ground. Just a thought...
- See related issue at CONF-23895 - Authenticate to see issue details.
<table>
<thead>
<tr>
<th>Don Gamble</th>
</tr>
</thead>
</table>
| **Treat macros and all special editor objects (images, links, etc) the same - i.e. they would all have a frame.**  
Currently the new editor doesn't treat everything as equivalent. This results in issues with where the insertion point moves during editing, what is selected, what gets cut or pasted, etc. Treating everything special (i.e. macros, images, links - things with parameters and/or bodies) as a framed object allows everything to be treated as an object, just like a character of text. Providing the frame also now allows you to explicitly see what is inside and outside a special object and allows you to select the object. For example, there is currently no way to select a link. You can select text that is linked, you can select an image that is linked, but you can't select a link. *Raised in CONF-24026.* |

<table>
<thead>
<tr>
<th>Don Gamble</th>
</tr>
</thead>
</table>
| **Display the associated parameters of the object (macro, image, link, etc) as text in the header of the objects frame.**  
With macros and special objects now having a frame, the hidden parameters of a macro/special object can now be displayed. Entering edit mode should expose all of the hidden information that is not visible when the page is rendered. Currently entering edit mode results in still having to enter a deeper edit mode (i.e. the macro browser or the special popups) to see the true values to edit. An edit mode within an edit mode is a huge productive hit. Simply seeing how a page was created is not currently possible while in edit mode.  
A guiding rule should be ”While in edit mode the user will be able to inspect the page and see all the properties effecting how the page renders without needing to do any further activities.” If this rule was true a majority of the productivity hit of the new editor would be resolved. To do this requires displaying the parameters of macros and special objects in their frame. *Raised in CONF-24026.* |
| Don Gamble | Allow the parameters in the frame to be edited as name value pairs and re-interpreted when focus leaves the frame.  

The final hit to productivity of the new editor is the need to enter a sub-edit mode (the macro editor or the special popups) when making a change to a parameter that is already applied to a macro or a link/image. Allowing the name value parameter pairs in the frame to be edited would allow rapid changes to be made with a few keystrokes with no loss of user focus caused by having to visit a dialog.  

Allowing new parameters to be added into the frame by just typing, for example "width" which is an obvious and easily remembered parameter on many macros, would allow common edits to occur quickly. Parameters that could not be parsed after the edit completes (i.e. after focus leaves the frame) could be handled by highlighting or in a similar way to how firebugs lets users change the parameters in the html editor window. **Raised in CONF-24026.** |
|---|---|
| Don Gamble & Eddie Fast | The confluence editor should behave very similar to every other commonly used editor. At a high level, today's user's expectations of how an editor reacts is common across all editors. If the editor doesn't behave as commonly expected then the user's experience is compromised (some would say the editor is broken or unusable). I see these expectations as **(please comment - do others agree?):**  

1. The focus of all activity occurs at the insertion point or selection.  
2. Pressing backspace or delete, removes what is to the left/right of the insertion point or removes what is selected.  
3. Typing or pasting inserts the contents at the insertion point or replaces the selection and leaves the insertion point after what is selected.  
4. Moving left, right, up, down with the arrow keys or page up/down in a document, if the same key presses are reversed, should place the cursor back in exactly the same location as it was before the first key press.  
5. Holding the shift key while moving left, right, up, down should extend (or start a selection from the insertion point). Pressing the opposite key should reduce the selection. |
In general, the new editor doesn't respect these user expectations. This makes it slow, hard to use, and I would argue filled with special situations that while can each be individually explained as correct - as a whole make it wrong. An editor should be a simple experience - not complex.

Specifically with respect to what should happen when the insertion point is at the beginning of a macro, i.e. just inside the body. I would suggest:

- Pressing the backspace key should do something, currently it does nothing when just within the body.
- Pressing the left arrow moves to the outside of the macro (CORRECT), but starting at the same spot and pressing the left arrow, while holding the shift key, doesn't appear to do anything.
- Unfortunately, it is more complex (in Firefox at least) continuing to press the left arrow while holding shift results in first the insertion point disappearing, with nothing selected, then nothing on the next key press. After some number of key presses the insertion point reappears with no selection. Reversing, i.e. pressing the right arrow with shift held, results in the insertion point appearing, then a selection appearing, then an insertion point, etc. Nothing is obvious as you attempt to select across a macro.

Open company, no bullshit

A Message from Atlassian’s Founders

Hi there,

Most of you already know why we removed the wiki markup editor in Confluence 4.0. We pride ourselves on being an open company, so it should be no surprise that we were really upset to learn that a few customers felt we had ‘betrayed them’ with this decision.

Firstly, to those people, we are genuinely sorry that you did not know about this change. We want you to know that we fully understood the enormity of this change for our existing customers - hence why we began communicating our plans over a year in advance in order to give everyone ample time to prepare. We started this process 15 months before shipping Confluence 4.0. During this period we made many public announcements about our intentions, collected tons of feedback throughout our Early Access Program, and built a comprehensive set of resources including:

- **June 2010** - At Summit 2010 we publicly announced our plans to consolidate the wiki markup and rich text editors into one single editor in Confluence 4.0
- **July 2010** - Released an FAQ about the changes we had planned. Over the year we received a
lot of questions and updated the FAQ very frequently

- **December 2010** - Atlassian began using Confluence 4.0 in production internally and began gathering feedback from heavy wiki markup users
- **June 2011** - Released a comprehensive Early Access Program ("EAP") where customers could download 4.0 and provide feedback. We received and responded to over 250 pieces of feedback during the Early Access Program
- **June 2011** - Included with the EAP we released a comprehensive set of "change management" documentation including:
  - A comprehensive set of release notes describing every new feature and planned change in 4.0
  - A comprehensive planning guide for Administrators, End Users and Developers
  - A quick-guide to help administrators prepare
- **June - September 2011** - Frequently updated EAP releases where we collected customer feedback and responded with changes / fixes
- **September 2011** - Released Confluence 4.0 with a microsite to help users discover new features and a complete change guide to help avid wiki markup users learn to be efficient in the new editor

If you did not hear about the new editor via all of these communiques, we're sorry. We will endeavour to communicate even more in the future, especially should there be another such major update.

**Collective customer feedback drove this decision**

We listen to our customers – a lot. The number one reason we made the decision to remove the wiki markup editor was the collective feedback we’d been gathering since we first released Confluence in 2004.

We've always encouraged you to publicly tell us how we can improve our products and make them work better for your organisation. We can't think of another company that is as open as Atlassian and we're proud of that.

Looking at the feedback we received and the things we heard time and time again in countless customer interviews, it was clear as day that the dual editing experience – Wiki Markup and Rich Text – was the number one hindrance to Confluence adoption.

The endless cycle of round-tripping bugs made the editor unreliable and unusable for the majority of users, and the lack of advanced features like the ability to merge table cells was stopping you from seeing the full value of Confluence.

You told us these things, we listened, and replacing wiki markup was the most viable solution to giving you what customers collectively asked for, a kick-ass editing experience with more powerful editing features.

**Customers love the new editor**

Has it been all bad news? No - far from it. We’ve been thrilled with the overall response from customers so far. Here's a sample of the feedback we've been seeing about the new editor in Confluence 4 – there's much much, much more. I didn't have time to list all of the tweets, emails and "Contact the CEO" submissions we've received:

"A recurring comment was on the WSIWYG editor used when creating pages / documents, the editor in Confluence is amazing." - Crucial Cloud Hosting Blog
Yet... there are two sides to every story

Up front communication and listening to users aside, we’re not blind to the fact that there are customers who were completely happy with the wiki markup editor and don’t see the need for a change.

Don’t get us wrong, we do understand their point of view. They just want a wiki markup editor and we understand their frustration at our decision to replace it with a higher fidelity storage format.

We still believe we made the best decision based on the collective feedback we received from the majority of our customers over the years – but, being completely frank, wiki markup is not coming back. The new editor is our path going forward.

We’ve been listening to your feedback

Thanks to all of you who took the time to provide constructive feedback about the new editor. You’ve helped us highlight issues that we need to address. Our Confluence team has been working really hard to get the following features and fixes into your hands:

1. Find and Replace within the editor – shipped in Confluence 4.1
2. Wiki Markup Autoformatting for Macros, Links, and Images – shipped in Confluence 4.1.2
3. WYSIWYG Page Layouts – coming in Confluence 4.2
4. WYSIWYG Page Templates – on our short-term roadmap

We’re 110% committed to making the new editor an even more kick-ass, reliable editing experience. Truly the best editing experience in the world. We’ve made huge leaps in the last year - but we’re not done yet.

We have a team of passionate, dedicated developers working full time to improve the editor and address niggles that arise.

We’re building a source editor!

We’ve learned from your feedback that customers have a number of valid reasons for directly editing the
They feel locked-in - Because people were no longer able to edit a text based version of their page directly, they felt they were locked into Confluence. While you could always still get your content out via the API or through WebDAV but people wanted to be able to see it directly. This was never our intention and we're rectifying it in two ways as you will see below.

2. They want to fix formatting niggles - Unfortunately over the years we trained everyone on this - what do you do when you hit a bug in the RTE? Switch to wiki markup. This wasn't really acceptable then and definitely isn't now, but people have asked for it over and over.

3. Content workflows - We underestimated how many people copy the source of their page out of Confluence to work with it in other ways, whether it be updating content offline, sharing with others via email, or using a preferred text editor for things like bulk changing of link properties.

Since we realise how important source access is to you, we're currently working on a free "Advanced Editor" plugin that will allow your users to edit your page's source amongst other advanced user editing. We hope it will address the major issues that some users have identified, like the ability to search for and update URLs and the file names of embedded images.

You can check out and comment on the spec at Specification - Confluence Advanced Editor.

The beta for this plugin is now available on the plugin exchange under the name Confluence Source Editor.

Storage Format

Some people have questioned whether this is a vendor lock-in play. It is not. The new storage format is based on XHTML with extension tags for Confluence specific functions. We've begun documenting it here so you can see exactly what is happening under the covers - to use in your plugins, remote applications, scripts, integrations etc. I think you'll agree this is pretty "standard stuff" and able to be understood by those who need to script it.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Why didn't we do this in the first place?

When we shipped Confluence 4.0 we decided to not offer a source editor for a number of reasons. First of all, the new XHTML-based storage format is more complex than wiki markup so it's not as readable to the average user. Secondly, we wanted to protect less technical users from breaking their pages by accidently deleting a closing tag or entering invalid HTML. This is why we're proposing that the source editing plugin is only enabled for your advanced users - and the storage format is not meant for day-to-day human editing.

Just try it.

Seriously, I encourage you to give the new editor a go. Listening to your feedback we've seen that many of you have not yet tried the new editor. We spent a lot of time thinking about what most people use wiki markup for - why people love it - and we determined that it was speed. Speed to be able to create content without picking up your mouse. So we've built many features and made design decisions with this in mind.
If you haven't already, please give these editor features a try:

- **Autoformatting** of Wiki Markup
- **Autocomplete** for Links, Media, and Macros
- **Autoconvert** for Pasted Links

If you still feel that you just cannot live without wiki markup, there are many other wikis which have it as their lingua franca. We're happy to provide a list of other wiki solutions, although I assure you none are as feature rich or flexible as Confluence.

We won't stop listening

As I mentioned, we'd love your feedback on the following:

- **Specification - Confluence Advanced Editor**
- **Documenting the Storage Format**

And as per the original purpose of this page, we'd love your feedback on the editor itself and how we can improve it for you. Thank you to everyone who has contributed constructively so far.

We see Confluence changing the way a company works and collaborates. That amazing change is why we come to work every day. Please help us make it a reality for you at your company.

- Mike Cannon-Brookes [Atlassian] and Scott Farquhar [Atlassian]
Feedback on Confluence Storage Format

When upgrading from Confluence 3.x to Confluence 4.x, the underlying storage format for your content will be migrated from a wiki markup-based format to a new XHTML-based format. This page describes the new storage format, and provides an opportunity for people to discuss the storage format and related ideas.

On this page:

- [ Comments welcome ]
- [ Notes about the storage format ]
- [ Macros ]
- [ Headings ]
- [ Text effects ]
- [ Text breaks ]
- [ Lists ]
- [ Links ]
- [ Images ]
- [ Tables ]
- [ Page layouts ]
- [ Emoticons ]
- [ Resource identifiers ]
- [ Template variables ]
- [ Another page available for further discussion ]

Comments welcome

This page has attracted a lot of interest and a number of very valuable comments. Please have a read, to see the ideas that people have proposed.

Notes about the storage format

- You can view the Confluence storage format for a given page by choosing Tools > View Storage Format. This option is only available if one of the following is true:
  - You are a Confluence administrator.
  - Your Confluence site has the Confluence Source Editor plugin installed and you have permission to use the source editor.
- If you would like to edit the storage format for a page, your Confluence system administrator will need to install the Confluence Source Editor plugin.
- Clarification of terminology: If you choose Tools > View Source, you will see the format used within the editor panel, not the storage format of the page.
- We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

⚠️ Under consideration

Provide an XSD - "an XSD could make on the fly validation for persons having an editor supporting it (e.g. Visual Studio), and since an XSD would be a way to validate your input.

🔒 CONF-24884 - Authenticate to see issue details

 Macros

See Confluence Storage Format for Macros.

Headings

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
</table>
### Text effects

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>strong/bold</strong></td>
<td><em>strong</em></td>
<td><code>&lt;strong&gt;</code> <em>strong</em> text <code>&lt;/strong&gt;</code></td>
<td><strong>strong</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;b&gt;</code> will also work but get converted to <code>&lt;strong&gt;</code> upon saving</td>
</tr>
<tr>
<td><strong>emphasis</strong></td>
<td><em>emphasis</em></td>
<td><code>&lt;em&gt;</code> <em>Italic Text</em> <code>&lt;/em&gt;</code></td>
<td><strong>emphasis</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><code>&lt;i&gt;</code> will also work but get converted to <code>&lt;em&gt;</code> upon saving</td>
</tr>
</tbody>
</table>

### Headings

- **Heading 1**
  - Underlined in the Documentation Theme
  - `<h1>`<br>Heading 1`</h1>`
- **Heading 2**
  - Underlined in the Documentation Theme
  - `<h2>`<br>Heading 2`</h2>`
- **Heading 3**
  - `<h3>`<br>Heading 3`</h3>`

Headings 4 to 6 are also available and follow the same pattern.
<table>
<thead>
<tr>
<th>Text</th>
<th>HTML Tag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>strikethrough</td>
<td><code>&lt;span style=&quot;text-decoration:line-through;&quot;&gt;s&lt;/span&gt;</code></td>
<td><code>&lt;s&gt;</code> and <code>&lt;del&gt;</code> will also work</td>
</tr>
<tr>
<td>underline</td>
<td><code>&lt;u&gt;underline&lt;/u&gt;</code></td>
<td></td>
</tr>
<tr>
<td>superscript</td>
<td><code>&lt;sup&gt;superscript&lt;/sup&gt;</code></td>
<td></td>
</tr>
<tr>
<td>subscript</td>
<td><code>&lt;sub&gt;subscript&lt;/sub&gt;</code></td>
<td></td>
</tr>
<tr>
<td>monospace</td>
<td><code>&lt;code&gt;monospaced&lt;/code&gt;</code></td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Example</td>
<td>HTML Code</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>preformatted</td>
<td>n/a</td>
<td><code>&lt;pre&gt;preformatted text&lt;/pre&gt;</code></td>
</tr>
<tr>
<td>block quotes</td>
<td>bq. block quote</td>
<td><code>&lt;bq&gt;block quote&lt;/bq&gt;</code></td>
</tr>
<tr>
<td></td>
<td>or</td>
<td><code>&lt;p&gt;block quote&lt;/p&gt;</code></td>
</tr>
<tr>
<td></td>
<td>{quote}</td>
<td><code>&lt;p&gt;block quote&lt;/p&gt;</code></td>
</tr>
<tr>
<td>text colour</td>
<td>{color:red} red text{color}</td>
<td><code>&lt;span style=&quot;color:rgb(255,0,0);&quot;&gt;red text&lt;/span&gt;</code></td>
</tr>
<tr>
<td>small</td>
<td>n/a</td>
<td><code>&lt;small&gt;small text&lt;/small&gt;</code></td>
</tr>
<tr>
<td>Format type</td>
<td>In Confluence 3.5 and earlier</td>
<td>In Confluence 4.0 and later</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------</td>
<td>-----------------------------</td>
</tr>
<tr>
<td>New paragraph</td>
<td>Paragraph 1 (empty line) Paragraph 2</td>
<td><code>&lt;p&gt;Paragraph 1&lt;/p&gt; &lt;p&gt;Paragraph 2&lt;/p&gt;</code></td>
</tr>
</tbody>
</table>

**Text breaks**
### Lists

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unordered list – round bullets</td>
<td>* Round bullet list item</td>
<td>&lt;ul&gt;&lt;li&gt;round bullet list item&lt;/li&gt;&lt;/ul&gt;</td>
<td>• Round bullet list item</td>
</tr>
<tr>
<td>Unordered list – square bullets</td>
<td>- Square bullet list item</td>
<td>&lt;ul style=&quot;list-style-type: square;&quot;&gt; &lt;li&gt;square bullet list item&lt;/li&gt;&lt;/ul&gt;</td>
<td>• Square bullet list item</td>
</tr>
<tr>
<td>Ordered list (numbered list)</td>
<td># Ordered list item</td>
<td>&lt;ol&gt;&lt;li&gt;numbered list item&lt;/li&gt;&lt;/ol&gt;</td>
<td>1. Ordered list item</td>
</tr>
</tbody>
</table>

### Links
<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to another Confluence page</td>
<td>![Link to another Confluence page](Page Title)</td>
<td>![ac:link&gt;&lt;ri:page ri:content-title=&quot;Page Title&quot; /&gt;<a href="">ac:plain-text-link-body</a>&lt;![CDATA[Link to another Confluence Page]]&gt;&lt;/ac:plain-text-link-body&gt; &lt;/ac:link&gt;</td>
<td>Link to another Confluence page</td>
</tr>
<tr>
<td>Link to an attachment</td>
<td><img src="atlassian_logo.gif" alt="Link to an attachment" /></td>
<td>![ac:link&gt;&lt;ri:attachment ri:filename=&quot;atlassian_logo.gif&quot; /&gt;<a href="">ac:plain-text-link-body</a>&lt;![CDATA[Link to a Confluence Attachment]]&gt;&lt;/ac:plain-text-link-body&gt; &lt;/ac:link&gt;</td>
<td>Link to an attachment</td>
</tr>
<tr>
<td>Link to an external site</td>
<td><img src="http://www.atlassian.com/" alt="Atlassian" /></td>
<td>![a href=&quot;<a href="http://www.atlassian.com%22%3EAtlassian">http://www.atlassian.com&quot;&gt;Atlassian</a>&lt;/a&gt;</td>
<td>Atlassian</td>
</tr>
<tr>
<td>Anchor link (same page)</td>
<td><a href="#anchor">Anchor Link</a></td>
<td>Anchor Link</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------</td>
<td>-------------</td>
<td></td>
</tr>
</tbody>
</table>
|                         | <ac:link ac:anchor="anchor">  
|                         |   <ac:plain-text-link-body>  
|                         |   <![CDATA[Anchor Link]]>  
|                         | </ac:plain-text-link-body>  
|                         | </ac:link> |
| Anchor link (another page) | [Anchor Link](pagetitle#anchor) | Anchor Link |
|                         | <ac:link ac:anchor="anchor">  
|                         |   <ri:page ri:content-title="pagetitle"/>  
|                         |   <ac:plain-text-link-body>  
|                         |   <![CDATA[Anchor Link]]>  
|                         | </ac:plain-text-link-body>  
|                         | </ac:link> |
A note about link bodies

All links received from the editor will be stored as plain text by default, unless they are detected to contain the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link bodies.

An example of different link bodies

```xml
<ac:link>
  <!-- Any resource identifier -->
  <ri:page ri:content-title="Home" ri:space-key="SANDBOX" />
  <ac:link-body>Some <strong>Rich</strong> Text</ac:link-body>
</ac:link>

<ac:link>
  <ri:page ri:content-title="Plugin developer tutorial stuff"
  ri:space-key="TECHWRITING" />
  <ac:plain-text-link-body><![CDATA[A plain <text> link body]]></ac:plain-text-link-body>
</ac:link>

<ac:link>
  <ri:page ri:content-title="Plugin developer tutorial stuff"
  ri:space-key="TECHWRITING" />
  <!-- A link body isn't necessary. Auto-generated from the resource identifier for display. -->
</ac:link>
```

For rich content like images, you need to use `ac:link-body` to wrap the contents.
The markup tags permitted within the `<ac:link-body>` are `<b>`, `<strong>`, `<em>`, `<i>`, `<code>`, `<tt>`, `<sub>`, `<sup>`, `<br>` and `<span>`.

**Images**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached image</td>
<td><img src="attachment" alt="atlassian_logo.gif!" /></td>
<td>![attachment&gt; <img src="attachment" alt="atlassian_logo.gif!" /></td>
<td></td>
</tr>
</tbody>
</table>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
<tr>
<td>ac:thumbnail</td>
<td>Set to &quot;true&quot; to designate this image as a thumbnail.</td>
</tr>
<tr>
<td>ac:alt</td>
<td>alt text</td>
</tr>
</tbody>
</table>
### Tables

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two column, two row (top header row)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Two column, two row (top header row)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Table Heading Cell 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;table&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;tbody&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;tr&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;th&gt;Table Heading Cell 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/th&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;th&gt;Table Heading Cell 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/th&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/tr&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;tr&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;td&gt;Normal Cell 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/td&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;td&gt;Normal Cell 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/td&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/tr&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/tbody&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;/table&gt;</td>
<td></td>
</tr>
</tbody>
</table>
Page layouts

Confluence supports page layouts directly, as an alternative to macro-based layouts such as those using the section and column macros. This section documents the storage format XML created when these layouts are used in a page.

Notes:

- Page layouts were introduced in Confluence 4.2, and are not available in earlier versions of Confluence.
- The word (content) in the layouts below indicates where further XHTML or Confluence storage format block content would be entered, such as <p> or <table> tags.

<table>
<thead>
<tr>
<th>Layout Type</th>
<th>In Confluence 4.2 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two column, three rows, 2nd and third with merged cells in first row</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Right sidebar

Three columns
Two columns with header and footer

```html
<div class="contentLayout"
data-atlassian-layout=""name":pagelayout-two,"columns":[
  "",
],"header":true,"footer":true">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout twoColumns">
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
<div class="contentLayout" data-atlassian-layout="{"name":"pagelayout-two-left","columns":["aside","large"],"header":true,\"footer\":true}">
    <div class="header">
        <div class="innerCell">{content}</div>
    </div>
    <div class="columnLayout twoColumns">
        <div class="cell aside">
            <div class="innerCell">{content}</div>
        </div>
        <div class="cell large">
            <div class="innerCell">{content}</div>
        </div>
    </div>
    <div class="footer">
        <div class="innerCell">{content}</div>
    </div>
</div>
Right sidebar with header and footer

```html
<div class="contentLayout"
data-atlassian-layout=""name:"pagelayout-two-right",
"columns: ["large","aside"],
"header":true,"footer":true">

<div class="header">
  <div class="innerCell">
    {content}
  </div>
</div>

<div class="columnLayout twoColumns">
  <div class="cell large">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="cell aside">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>

<div class="footer">
  <div class="innerCell">
    {content}
  </div>
</div>
```

<table>
<thead>
<tr>
<th>Three columns with header and footer</th>
</tr>
</thead>
</table>
| <div class="contentLayout" data-atlassian-layout="{"name": "pagelayout-three", "columns": [{""}, ","], "header": true, "footer": true}">
  |   |
  |   |
  |   |
  | <div class="header">
  |   |
  |   |
  | <div class="innerCell">
  |   |
  | </div>
  | </div>
  | <div class="columnLayout threeColumns">
  | <div class="cell">
  |   |
  |   |
  | <div class="innerCell">
  |   |
  | </div>
  | </div>
  | <div class="cell">
  |   |
  |   |
  | <div class="innerCell">
  |   |
  | </div>
  | </div>
  | <div class="cell">
  |   |
  |   |
  | <div class="innerCell">
  |   |
  | </div>
  | </div>
  | <div class="footer">
  |   |
  |   |
  | <div class="innerCell">
  |   |
  | </div>
  | </div>
  | </div> |
Emoticons

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emoticons</td>
<td>:)</td>
<td>&lt;ac:emoticon ac:name=&quot;smile&quot; /&gt;</td>
<td>😊</td>
</tr>
<tr>
<td></td>
<td>:(</td>
<td>&lt;ac:emoticon ac:name=&quot;sad&quot; /&gt;</td>
<td>😞</td>
</tr>
<tr>
<td>Resource identifiers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:P</td>
<td>&lt;ac:emoticon ac:name=&quot;cheeky&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>:D</td>
<td>&lt;ac:emoticon ac:name=&quot;laugh&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>;)</td>
<td>&lt;ac:emoticon ac:name=&quot;wink&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(y)</td>
<td>&lt;ac:emoticon ac:name=&quot;thumbs-up&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(n)</td>
<td>&lt;ac:emoticon ac:name=&quot;thumbs-down&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(i)</td>
<td>&lt;ac:emoticon ac:name=&quot;information&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(✓)</td>
<td>&lt;ac:emoticon ac:name=&quot;tick&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(✗)</td>
<td>&lt;ac:emoticon ac:name=&quot;cross&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>(!)</td>
<td>&lt;ac:emoticon ac:name=&quot;warning&quot; /&gt;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Resource identifiers are used to describe "links" or "references" to resources in the storage format. Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Resource identifier format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>&lt;ri:page ri:space-key=&quot;FOO&quot; ri:content-title=&quot;Test Page&quot;/&gt;</code></td>
</tr>
<tr>
<td>Notes:</td>
<td>ri:space-key: (optional) denotes the space key. This can be omitted to create a relative reference.</td>
</tr>
<tr>
<td></td>
<td>ri:content-title: (required) denotes the title of the page.</td>
</tr>
<tr>
<td>Blog Post</td>
<td><code>&lt;ri:blog-post ri:space-key=&quot;FOO&quot; ri:content-title=&quot;First Post&quot; ri:posting-day=&quot;2012/01/30&quot; /&gt;</code></td>
</tr>
<tr>
<td>Notes:</td>
<td>ri:space-key: (optional) denotes the space key. This can be omitted to create a relative reference.</td>
</tr>
<tr>
<td></td>
<td>ri:content-title: (required) denotes the title of the page.</td>
</tr>
<tr>
<td></td>
<td>ri:posting-day: (required) denotes the posting day. The format is YYYY/MM/DD.</td>
</tr>
</tbody>
</table>
| **Attachment** | `<ri:attachment ri:filename>`  
| | ... resource identifier for the container of the attachment ...  
| | `</ri:attachment>`  
| **Notes:** |  
| | • `ri:filename:` (required) denotes the name of the attachment.  
| | • the body of the `ri:attachment` element should be a resource identifier denoting the container of the attachment. This can be omitted to create a relative attachment reference (similar to `[foo.png]` in wiki markup).  
| **Examples:** |  
| | **Relative Attachment Reference**  
| | `<ri:attachment`  
| | `ri:filename="happy.gif"`  
| | `>`  
| | **Absolute Attachment Reference**  
| | `<ri:attachment`  
| | `ri:filename="happy.gif">`  
| | `<ri:page`  
| | `ri:space-key="TST"`  
| | `ri:content-title="Test Page"/>`  
| | `</ri:attachment>`  
| **URL** | `<ri:url`  
| | `ri:value="http://example.org/sample.gif"/>`  
| **Notes:** |  
| | • `ri:value:` (required) denotes the actual URL value.  

### Shortcut

```xml
<ri:shortcut ri:key="jira"
  ri:parameter="ABC-123"/>
```

**Notes:**
- `ri:key`: (required) represents the key of the Confluence shortcut.
- `ri:parameter`: (required) represents the parameter to pass into the Confluence shortcut.
- The example above is equivalent to `[ABC-123@jira]` in wiki markup.

### User

```xml
<ri:user ri:username="fred"/>
```

**Notes:**
- `ri:username`: (required) denotes the name of the user.

### Space

```xml
<ri:space ri:space-key="TST"/>
```

**Notes:**
- `ri:space-key`: (required) denotes the key of the space.

### Content Entity

```xml
<ri:content-entity
  ri:content-id="123"/>
```

**Notes:**
- `ri:content-id`: (required) denotes the id of the content.

---

**Template variables**

This screenshot shows a simple template:
This is Sarah’s template

A single-line text variable: $MyText

A multi-line text variable: $MyMulti

A selection list: $MyList

End of page.

The template contains the following variables:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MyText</td>
<td>Single-line text</td>
<td></td>
</tr>
<tr>
<td>$MyMulti</td>
<td>Multi-line text</td>
<td>Size: 5 x 100</td>
</tr>
<tr>
<td>$MyList</td>
<td>List</td>
<td>List items: Apples, Pears, Peaches</td>
</tr>
</tbody>
</table>

The XML export produces the following code for the template:

```xml
<at:declarations>
  <at:string at:name="MyText" />
  <at:textarea at:columns="100" at:name="MyMulti" at:rows="5" />
  <at:list at:name="MyList">
    <at:option at:value="Apples" />
    <at:option at:value="Pears" />
    <at:option at:value="Peaches" />
  </at:list>
</at:declarations>

<p>This is Sarah's template</p>
<p>A single-line text variable: &nbsp;&lt;at:var at:name="MyText" /></p>
<p>A multi-line text variable: &nbsp;&lt;at:var at:name="MyMulti" /></p>
<p>A selection list: &nbsp;&lt;at:var at:name="MyList" /></p>
<p>End of page.</p>
```

Another page available for further discussion

A new page is available as a place to continue discussions: Confluence 4 further discussion.

Please feel free to add your comments anywhere. We are not shutting down discussion on this page. We are supplying the new page to alleviate the problems caused by slow response on this page, due to the number of comments here.
Specification - Confluence Advanced Editor

1.0 for this plugin is now available (3/Apr) on the plugin exchange under the name Confluence Source Editor.

Fixed:
- Support for using the source editor in comments.

Beta 2 included enhancements include support for:
- Find and replace within the page
- Restricting access to the Source Editor to particular user groups.

We welcome your feedback - please file issues in the JIRA project at https://jira.atlassian.com/browse/SOURCE

- This is a draft of the “Source Editor” specification for Confluence.
- Please see Feedback on Confluence Storage Format for an overview of Confluence’s storage format.

Background and strategic fit

Up until now, we haven’t allowed users to edit the underlying editor storage format (though this was easy for anyone to hack, using Firebug). As customers upgrade to Confluence 4.0, we’re learning there are three main reasons people want source access:

1. Customers Feel “Locked-in”

With the switch from wiki markup to the new XHTML-based storage format, and because people were no longer able to edit a text-based version of their page directly, they felt they were locked into Confluence. While you could always still get your content out via the API or through WebDAV but people wanted to be able to see it directly.

2. Fixing Formatting Niggles

When a user hits an occasional bug, he or she wants a quick workaround. Over the years we trained everyone on this - what do you do when you hit a bug in the RTE? Switch to wiki markup. This wasn't really acceptable then and definitely isn't now, but some customers are asking for it... "give me access to the source so I can quickly fix something that's gone wrong."

3. Offline content editing

Some users want to copy the source of their page out of Confluence to work with it in other ways, whether it be updating content offline, sharing with others via email, or using a preferred text editor for things like bulk changing of link properties. Use cases include:

- Bulk edit link properties
- Bulk edit macro properties
- Confluence offline editing
- Editing via preferred editor (emacs, textmate, etc)

Requirements

<table>
<thead>
<tr>
<th>User Story Title</th>
<th>User Story Description</th>
<th>Priority Order</th>
<th>Implementation Notes</th>
<th>Status</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Importance</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Editor Niggles   | User can access source view from inside the Confluence editor.               | 1: Must have | • This is a short-term solution to working around minor bugs. Long term we should be solving these problems.  
                           • This will edit the storage format source.                             |
<p>| Copy paste source| User can copy / paste source in full fidelity. Users should be able to:     | 1: Must have |                                                                                 |
|                  | 1. Copy the entire content of a page                                       |            |                                                                                 |
|                  | 2. Paste into a separate editor                                            |            |                                                                                 |
|                  | 3. Manipulate it and                                                        |            |                                                                                 |
|                  | 4. Paste it back into the source view of the editor                        |            |                                                                                 |
|                  | 5. Save the page                                                           |            |                                                                                 |
| Edit link source | User should be able to change link source from inside the editor           | 1: Must have | This would help with bulk change operations like changing URLs, or parts of URLs in links. |
| Edit macro parameters | Users should be able to change macro parameters from inside the editor | 1: Must have | Example macro storage format:                                                                 |
|                  |                                                                            |            | <code>&lt;ac:macro ac:name=&quot;status&quot;&gt; &lt;ac:parameter ac:name=&quot;colour&quot;&gt; Green &lt;/ac:parameter&gt; &lt;/ac:macro&gt;</code>  |</p>
<table>
<thead>
<tr>
<th>Validation</th>
<th>1: Must have</th>
<th>There should be at least some basic validation (e.g. that the xml is well formed). This validation is performed when applying the changes in the source editor and returning to the Rich Text Editor. Other markup, that is considered invalid, is either tolerated or stripped when saving the file (the content itself is not lost, just the markup tags). It would be desirable to validate this before save, but this may not be available in the first release. If a save does result in a bad rendering of a page, then reverting an edit via the history is an acceptable trade-off.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syntax highlighting</td>
<td>2: Should have</td>
<td>The markup should be formatted and indented so that the source is as easy as possible to visually parse and spot invalid markup.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Severity</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Search and replace</td>
<td>It should be possible to search and replace text in the source markup.</td>
<td>2: Should have</td>
</tr>
<tr>
<td>Group Permissions</td>
<td>Admin can specify which users / groups can have access to edit source.</td>
<td>3: Nice to have</td>
</tr>
<tr>
<td>Validation</td>
<td>User can see which markup he posts is invalid - editor should <em>refuse</em> bad mark-up</td>
<td>2: Should have</td>
</tr>
</tbody>
</table>

If you define a bad parameter in a macro, Confluence will ignore this parameter:

```xml
<!-- BAD MACRO PARAMETER -->
```

If you erroneously put a macro or link parameter in a rich text field the tags get stripped:

```xml
<!-- BAD MACRO PARAMETER -->
```

---

**UX**

- Expecting an icon to the left of help in the toolbar that will pop up a dialog when enabled for a user.

**Supportability**

- This will be implemented as a separate plugin that can be installed by a Confluence site administrator.
- The plugin will be maintained by Atlassian.

**Notes**

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

**Confluence 101**

We are delighted that you have chosen Confluence. This guide will take you through installing Confluence and
trying out the most relevant features.

Getting started

1. Installing Confluence

If you have not already got Confluence up and running, carry out the following steps:

- **For Windows:** (click to expand)
  1. Go to the Confluence download page.
  2. Download the Confluence Windows Installer file for 32-bit or 64-bit Windows.
  3. Run the installer, choose an installation directory, a home directory, and a port (‘8090’ will do). We recommend you choose to install Confluence as a service.
  4. Confluence will start automatically when the installer finishes. The installer will also add Windows ‘Start’ menu shortcuts which you can use to start and stop Confluence.
  5. To access Confluence, go to your web browser and type this address: http://localhost:8090.
  6. The Setup Wizard will guide you through the process of setting up your Confluence server and creating an administrative user.

For more help on the technical procedures in this section, see the Confluence Installation Guide.

If you need assistance, please create a support ticket.

- **For Linux/Solaris:** (click to expand)
  Download the Confluence Linux Installer (.BIN) file from the Confluence download page, and follow the installation instructions.

  The Setup Wizard will guide you through the process of setting up your Confluence server and creating an administrative user.

  If you need assistance, please create a support ticket.

2. Importing existing content

- **Why would I do this?** (click to expand)
  The best way to spur adoption is to get some content in Confluence. It is likely that you have existing documentation stored in another wiki or in static documents. Confluence makes it easy to import your existing content so that you do not have to re-invent the wheel or start from scratch.

- **How do I do this?** (click to expand)
  Refer to our documentation on Importing Content Into Confluence, for details on:
  
  - Importing content from other Confluence sites
  - Importing content from other wikis.
  - Importing content from an Office document
  - Importing web content
  - Importing other non-wiki content

3. Adding users

Add people so that they can collaborate quickly.

- **Add users and/or enable anonymous access. Click here to expand...**
  There are three ways you can get your users started in Confluence:

  1. **Add users** - manually add accounts for people who will create pages and blogs in your Confluence site
  2. **Invite users** - access an invitation link or send an email directly from Confluence to invite people to create their own account
  3. **Allow users to create their own account** - change the User Signup Options to allow users to create
New users are automatically added to the 'confluence-users' group. You can add them to other groups too - see Add users to groups.

You can also allow 'Anonymous' access to your confluence site and spaces - see Modify Global Permissions.

4. Configuring mail

Confluence can send notifications based on user preferences, such as when people are watching the contributions to a particular space or page. To take advantage of this feature, you will first need to tell Confluence about your SMTP server.

Mastering the basics

Your users will need to access Confluence at http://<Confluence site name>:8090 (not http://localhost:8090)

5. Creating spaces, pages and blog posts

Your new Confluence site contains a 'Demonstration' space, which includes a tutorial. This will guide you through the basics of using the dashboard, creating a space, adding pages and publishing blog posts.

6. Searching Confluence

- Searching Confluence
- Advanced search
- Searching the content of attachments

7. Subscribing to updates

- Creating an RSS feed.
- Watching a page (or space) to be emailed whenever it is edited.
- Marking your favourite places so you can get to them quickly.

Customising Confluence

You need Confluence Administrator permissions to do the tasks in this section. see Global Permissions Overview.

8. Adding your own logo

- Why would I do this? (click to expand)
  If you replace the default Confluence site logo with your organisation's logo, your Confluence site will immediately appear more familiar to visitors. Confluence will even detect the colours in your logo and change the colour scheme of the header to match!

- How do I do this? (click to expand)
  See the following documentation:
    - Changing the Site Logo
    - Changing a space's logo

9. Changing Confluence's colours

- Why would I do this? (click to expand)
  If you replace the default Confluence colours with your organisation's standard colours, your Confluence site will immediately appear more familiar to visitors.
How do I do this? (click to expand)
See the following documentation:

- Customising Confluence’s colour scheme
- Styling Confluence via CSS *(Not applicable to Confluence OnDemand.)*

10. Choosing a different theme

Why would I do this? (click to expand)
Depending on what you are using Confluence for, you may want to alter the theme for an individual space or for the entire site. A theme determines the look and feel of the site, including colours, styles and page layouts. For example, for a space that contains documentation, you may prefer a theme that displays a table of contents on the left and allows you to configure a page header and footer.

How do I do this? (click to expand)
See the following documentation:

- Applying a theme to a site
- Applying a theme to a space

11. Using a page template

Why would I do this? (click to expand)
A page template is a form that is displayed when a user creates a page, so that the user can enter content in particular fields. A page template can be made available to your entire Confluence site or just to a particular space. For example, a human resources space might have a template called 'Leave Request', or an information technology space might have a template called 'Asset Configuration'.

How do I do this? (click to expand)
See the following documentation: Adding a template

12. Installing add-ons

Why would I do this? (click to expand)
There are hundreds of new features and customisations available for Confluence as add-ons. For example, many additions to Confluence's macros are available as add-ons. Take a look at our most popular add-ons for Confluence.

How do I do this? (click to expand)
Confluence comes with a number of bundled add-ons. You can install others via the Confluence administration screens.

**Important next steps**

You need Confluence Administrator permissions to do the tasks in this section. see Global Permissions Overview.

13. Connecting to an external database

Before using Confluence as a production system, you need to switch from the default HSQL database, which is provided for evaluation purposes only. Please see the documentation for details.

14. Backing up data

To back up your Confluence data, and establish processes for regular backups, please see the documentation.

**We hope you have fun with Confluence**

We're always happy to help. Feel free to contact us with any questions you have.
Confluence User's Guide

About this document

The Confluence user's guide begins with an overview of the key features of Confluence, and goes on to describe the use of Confluence as a knowledge management tool and a collaborative environment. If you still have a question that has not been answered, please ask us.

This guide assumes that your Confluence site uses the default theme. If your site's theme has been customised, then your site may look different and the menu items may appear in different locations from those in this guide.

Would you like a full list of the pages in this guide? Here it is: Table of Contents for Confluence User's Guide.

Downloads

You can download the Confluence documentation in PDF, HTML and XML formats.

More resources

Visit the Confluence Administrator's Guide for information on how to administer and configure your Confluence site, or go to the Confluence Documentation Home for a list of further resources.

In this guide

Getting Started with Confluence
Creating Content
Sharing Content
Managing Changes and Notifications and Tasks
Finding Content
Organising Content
Customising Confluence
Giving People Access to Content
Using Confluence on a Mobile Device
Advanced and Special Uses of Confluence

Getting Started with Confluence

<table>
<thead>
<tr>
<th>Getting to know Confluence</th>
</tr>
</thead>
<tbody>
<tr>
<td>The dashboard</td>
</tr>
<tr>
<td>Page layout</td>
</tr>
<tr>
<td>Spaces in Confluence</td>
</tr>
<tr>
<td>Other users</td>
</tr>
</tbody>
</table>
About Confluence

Confluence is a wiki. You can use it to collaborate on writing and sharing content with your team. Your team can be as small or as big as you like. It could encompass the whole world. Your content can be as simple or as rich as you like. It can be just words, or you can add images, diagrams, activity streams, web service integration and more.

In a nutshell, a wiki is a piece of software that runs on a server. It publishes web pages that you can read via a web browser such as Mozilla Firefox, Google Chrome or Microsoft Internet Explorer. The thing that makes wiki pages different from other web pages is the edit button. Provided that you have the right permissions, you can edit the page, save your changes, and the updates will be visible to other people immediately.

Confluence provides extra functionality that transforms it into a social collaboration platform:

- Add a space for your team, then add a page or comment on someone else's page.
- Share content by writing a blog post, sharing a link or calling someone's attention to a page via @mentions. Form a social network and tell people what you are doing via a status update.
- Add images, picture galleries, videos and more.

Related pages:
- Getting Started with Confluence
- Confluence User’s Guide

Dashboard

The dashboard is the front page of a Confluence site. It provides an overview of the site, gives access to the spaces that you have permission to view, and displays a few different lists of the most recently updated content.

You can go to the dashboard from anywhere in your site by choosing the site logo at the top left of the page. This might be the Confluence logo, or may be a customised logo set by your Confluence Administrator.

Overview of the dashboard
The dashboard is divided into these sections:

- **Welcome message**: The information that appears in the top left section of the dashboard. Confluence Administrators can customise this message.

- **Get started**: A quick-start guide for administrators. This section of the dashboard is visible to Confluence administrators and system administrators only. It is not configurable via the web interface, but you can update or remove it by editing the site layout.

- **Spaces, Pages, Network**: Tabs displaying your favourite content and people, displayed in the lower left section of the dashboard.
  - **Spaces** displays the spaces you have marked as favourites, followed by all the spaces that you have permission to view.
  - **Pages** displays the pages you have marked as favourites.
  - **Network** displays the users that you are following (or who are following you).

- **Recent activity**: Tabs on the right-hand side of the dashboard, displaying recently-updated content:
  - **Popular** displays content that has been recently created, liked or commented on. See below for more details.
  - **All Updates** displays updates from all spaces that you have permission to view.
  - **Favourite Spaces** displays updates from your favourite spaces.
  - **Network** displays updates made by the users that you are following (or who are following you).
  - **Space Categories** displays updates from spaces in the category you have selected from the list.

**On this page:**
- Overview of the dashboard
- More about popular content
- Notes

**Related pages:**
- Confluence Glossary
- Working with Spaces
- Confluence User’s Guide

*Screenshot: The dashboard*
More about popular content

The 'Popular' tab on the dashboard displays recent activity of the following types:

- Pages, blog posts and comments that people have recently liked.
- Pages and blog posts that people have recently commented on, and threaded comments that people have recently replied to.
- Pages and blog posts that have recently been created.

'Recent' means any activity in the last seven days.

A bold link means that you have not yet visited the page.

The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. The most recent activity ranks higher than earlier activity.

Notes

- If you have the right permission, you can add a new space from the dashboard. Choose Create Space at the top right of the dashboard, or on the 'Spaces' tab.
- By default, the dashboard is the home page for the Confluence site. However, you can set any other page in Confluence as your home page via your user profile settings.
- Administrators can customise the global dashboard that all users see.
- Users can customise the dashboard for themselves.
- Are you looking for a way to build an RSS feed? Choose Help > Feed Builder.
- Are you looking for a list of the people in your site? Choose People on the header.

Page in View Mode

The images below show the menus and other controls on a typical Confluence page using the default theme. The sidebar is on the left of each page. On the right is the body of the page.
### Related pages:
- Creating Content
- Using the Editor
- Overview of Spaces
- Sharing Content
- Confluence User's Guide

<table>
<thead>
<tr>
<th>Section or option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sidebar</strong></td>
<td>The sidebar helps you to see where you are in the space, and helps you to find pages and other content in the space. The sidebar contains shortcut links to important pages in your space. Space administrators can access options to configure the sidebar and other parts of the space. At the bottom of the sidebar is a contextual navigation section, which adapts depending on the page or blog post that you are viewing. See Finding Content.</td>
</tr>
<tr>
<td><strong>Application Navigator</strong></td>
<td>The application navigator gives you quick and easy access to applications that are linked to your site, for example JIRA. Confluence Administrators can add links to the application navigator, for example external websites.</td>
</tr>
<tr>
<td><strong>Dashboard</strong></td>
<td>Choose the site logo to access to the Confluence dashboard. By default, the dashboard is the home page of your Confluence site.</td>
</tr>
<tr>
<td><strong>Spaces</strong></td>
<td>Choose this option to see the space directory, containing a list of all the spaces that you have permission to view.</td>
</tr>
<tr>
<td><strong>People</strong></td>
<td>Choose this option to see the people directory, showing all the users of your Confluence site.</td>
</tr>
<tr>
<td><strong>Create</strong></td>
<td>Create pages, blog posts, and other content types in Confluence.</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>Type text into this box to see a list of matching pages. Select a page to go directly to it, or press Enter to use the full Confluence search. See <strong>Searching Confluence</strong>.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td>Go to the documentation for help and support, view a list of keyboard shortcuts, or access other help options from this menu.</td>
</tr>
<tr>
<td><strong>Administration</strong></td>
<td>The cog icon gives access to the site administration menu. If you are a Confluence administrator or a system administrator, you can access user and add-on management, and other site administration options here. (Note that the space administration options are in the sidebar, not in the administration menu.)</td>
</tr>
<tr>
<td><strong>Workbox</strong></td>
<td>View and respond to notifications collected from Confluence page watches, shares and mentions. Manage your personal tasks. See <strong>Managing Notifications in Confluence</strong> and <strong>Managing Tasks in Confluence</strong>.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>After you have logged in, your profile picture will appear at top right of the page. When you choose your profile picture, the user menu drops down with options to log out, access your user profile, or view your editing history, personal labels and page watches. You can also retrieve drafts of pages you are editing.</td>
</tr>
<tr>
<td><strong>Tools</strong></td>
<td>Perform miscellaneous actions relating to the page.</td>
</tr>
<tr>
<td><strong>Like</strong></td>
<td>Let people know that you like this page.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>Edit the current page. (Shortcut: press <strong>e</strong> on your keyboard.)</td>
</tr>
<tr>
<td><strong>Share</strong></td>
<td>Email a link to the current page to another Confluence user or email address.</td>
</tr>
<tr>
<td><strong>Labels</strong></td>
<td>View and edit labels (tags) attached to the current page. (Shortcut: press <strong>l</strong> on your keyboard.)</td>
</tr>
<tr>
<td><strong>Add a comment</strong></td>
<td>Click in the text box to begin writing a comment. (Shortcut: press <strong>m</strong> on your keyboard.)</td>
</tr>
<tr>
<td><strong>Title and breadcrumbs</strong></td>
<td>The title is the page name. The breadcrumbs show the position of the page in relation to its parent pages in the space.</td>
</tr>
<tr>
<td><strong>Byline</strong></td>
<td>Shows the original author and the most recent editor of the page, and the date of the most recent edit.</td>
</tr>
</tbody>
</table>
Byline icons

A small padlock indicates page restrictions. A paperclip indicates that the page has attachments. Both icons are clickable, leading to the 'Page Information' and 'Attachments' pages, respectively.

Confluence Glossary

Administration Console

The Administration Console is the interface for the global administration of Confluence.

Only administrators can access the Administration Console.

Administrators

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

CamelCase

CamelCase is a form of markup commonly used in wikis where words compounded together LikeThis without spaces are used to create links.

In Confluence, Camelcasing can be turned on from the Administration Console.

Change Comment

A change comment is a short description entered during the edit of a page to record the changes being made in the edit.

Child Pages

Creating child pages is a means of hierarchically organising content in Confluence. A child page can only have one parent page.

Comments

A comment may be a remark, question, or any other additional information you wish to add to a page pertaining to the topic the page covers. You can comment on any page or news item in Confluence.

Confluence Administrators

The Confluence permission scheme allows the following main levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

Custom Decorators
Decorator files are used to define layouts in Confluence. They are vmd files and require knowledge of the language, Velocity, to edit.

Dashboard
The dashboard is the front page of a Confluence site. It provides an overview of the site, access to all spaces, and displays a list of the most recently updated content within them.

Form Field Markup
Form field markup is a specialised markup used when creating page templates in Confluence 4.2 and earlier. It is no longer needed, because the template editor offers form fields as an option in the editor toolbar.

Global Administrators
A global administrator is the same as a system administrator.

Global Spaces
Known as Site Spaces, these spaces contain content on any theme or topic of your choice.
For more information about site spaces and personal spaces, see Working with Spaces.

Hover Profile
The hover profile is the pop-up you see when the mouse pointer pauses over a Confluence user's name. Use the hover profile to follow the user, visit their profile, and more.

JIRA
JIRA is Atlassian's award winning Issue tracking and project management application.
Visit Atlassian's website to learn more about JIRA.

Labels
Labels are user-defined tag words assigned to pages to categorise content in Confluence.

Macros
A macro is a command wrapped inside curly braces {...} used to perform programmatic functions and generate more complex content structures in Confluence.

Blog Posts
A blog post may be a journal entry, status report or any other timely information pertaining to a space.

Notifications
A notification is an email message sent to you updating you of changes to pages and spaces you choose to 'watch'.

Orphaned Pages
An orphaned page is a page without any incoming links.

Pages
Pages are the primary means of storing information in Confluence and are the building blocks of spaces.
Parent Page

A parent page is a page that has one or more child pages. It may itself be a child of another page.

People Directory

The People Directory contains a list of all users in your Confluence site. Each user's name links to their personal space.

Permalink

A permalink is the url used to link to specific content items like comments.

Personal Spaces

Personal spaces belong to particular users, and rather than being listed on the Dashboard, are available from the People Directory.

For more information about global spaces and personal spaces, see Working with Spaces.

RSS Feeds

An RSS feed is a format for delivering summaries of regularly changing web content. RSS is read by RSS newsreader programs.

You will need an RSS reader to subscribe to feeds within Confluence.

Confluence acts as an RSS reader for feeds from sites outside of Confluence.

RSS Reader

An RSS reader is a specialised RSS program (also called aggregator) that displays the contents of RSS feeds for you. To subscribe to RSS feeds within Confluence, you will need an RSS reader.

Site Administrators

The Confluence permission scheme allows two levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.

Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

Site Spaces

Site spaces contain content on any theme or topic of your choice. Previously known as global spaces.

For more information about site spaces and personal spaces, see Working with Spaces.

System Administrators

The Confluence permission scheme allows two levels of administrator permissions:

- System Administrator – full administrative access to Confluence.
- Confluence Administrator – access to most of the Confluence administrative functions, but excluding those which could compromise the security of the Confluence system.
Please refer to the overview of global permissions for details of the functions which each level of administrator can perform.

**Space Administrators**

A space administrator is a user with the ‘Space Admin’ permission for the space. A user with this permission can perform a host of functions relating to the management of a space and has complete access to the space regardless of any other control settings or permissions.

Permissions for a space are only assigned and modified by space administrators.

**Spaces**

A space is an area within Confluence, containing your pages, blog posts and other content. You can think of each space as a sub-site, or mini-site, each with its own home page.

There are two types of spaces: site spaces and personal spaces - see Working with Spaces.

**Templates**

A template is a pre-defined page that can be used as a prototype when creating pages. Templates are useful for giving pages a common style or format.

**Themes**

Themes are pre-defined ‘look and feel’ styles which are configured from the administration menu and can be applied across Confluence or to a single space.

**Thumbnails**

As of Confluence 4.0, all images on the page that aren’t links are displayed as thumbnails: when you click on an image the full-size image is displayed in a pop-up.

**Tiny links**

A tiny link is the shortened url of a page which is useful when sending links to the page, for example, via email.

**Trackback**

Trackback is a mechanism by which two sites can stay informed each time one site refers to the other by means of trackback ‘pings’.

In Confluence, Trackback is enabled from the Administration Console.

**Trackback Autodiscovery**

Trackback autodiscovery is a block of code that can be placed in a web-page to describe where trackback pings should be sent for that page. You can read the technical specification for autodiscovery here.

When Trackback is enabled, Confluence uses Trackback Autodiscovery to ping pages that are linked to, and to advertise its own pages as being able to receive pings.

**Undefined Links**

An undefined link is a link to a page that has not yet been created. Clicking on the page link allows you create the page.

**User Profile**
Every user account in Confluence is linked to a profile that contains user related information and options to configuring user preferences.

Watching a Page or Blog Post
When you watch a page, you are sent an email notification whenever that page has been modified.

Watching a Space
When you watch a space, you are sent an email notification whenever content has been added or modified in that space.

Wiki
Pioneered by Ward Cunningham, and named after the Hawaiian word for 'quick', a wiki is a website that makes it easy for anyone to contribute pages, and link them together.

Wiki Markup
This is the markup used to write and edit page templates in Confluence.

Related Topics
Take me back to Confluence User's Guide

Keyboard Shortcuts
Confluence provides a number of keyboard shortcuts that you can use to speed up your editing and viewing. This page describes the keyboard shortcuts for the English language. The shortcut keys (letters of the alphabet) may be different in other languages.

Confluence can display a list of available keyboard shortcuts. There are a few ways to see this keyboard shortcuts dialog:

- Choose the help icon at top right of the screen, then choose Keyboard Shortcuts.
- When viewing a page, press Shift+?
- In the editor, choose the question mark icon on the editor toolbar.

The keyboard shortcuts dialog shows the following information:

- **General** – global, page and blog post shortcuts.
- **Editor** – text editing and formatting shortcuts.
- **Editor Autoformatting** – wiki markup and autoformatting shortcuts.

On this page:
- Keyboard shortcuts
- All screens
- Editor
- Tables in the editor
- Autocomplete in the editor
- View screen
- Workbox
- Disabling and re-enabling keyboard shortcuts
- Notes

Related pages:
- Using Autocomplete
- Confluence User's Guide
Keyboard shortcuts

The first section below describes the keyboard shortcuts that are available on all Confluence screens. Subsequent sections describe the shortcuts specific to each type of screen.

**Note:** If you are using Safari on OS X, please substitute 'Control' for 'Cmd' in the shortcuts below.

**All screens**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>/</td>
<td>Enable the quick search</td>
<td>/</td>
</tr>
</tbody>
</table>
| Ctrl+s  | • Submit (where a form is active).  
          • Editor -- save the Confluence page.  
          • Outside the editor -- save the browser page. | Cmd+s    |
| g then d| Go to the dashboard | g then d |
| g then s| Browse the current space | g then s |
| ?       | Open the Keyboard Shortcut help | ?        |
| [       | Toggle the sidebar (left-hand navigation panel) when the space is using the default Confluence theme or the Documentation theme. | [        |

**Editor**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctr+0</td>
<td>Apply the paragraph style.</td>
<td>Cmd+0</td>
</tr>
<tr>
<td>Ctr+(1–6)</td>
<td>Apply a heading level (of the number chosen) to the current line.</td>
<td>Cmd+(1–6)</td>
</tr>
<tr>
<td>Ctr+7</td>
<td>Apply the preformatted style.</td>
<td>Cmd+7</td>
</tr>
<tr>
<td>Ctr+8</td>
<td>Apply the block quote style.</td>
<td>Cmd+8</td>
</tr>
<tr>
<td>Ctrl+Shift+a</td>
<td>Open the Macro Browser.</td>
<td>Cmd+Shift+a</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Make the selected text bold.</td>
<td>Cmd+b</td>
</tr>
<tr>
<td>Ctrl+Shift+b</td>
<td>Format text as a bulleted list.</td>
<td>Cmd+Shift+b</td>
</tr>
<tr>
<td>Ctrl+Shift+d</td>
<td>Insert wiki markup. (Opens the Wiki Markup dialog.)</td>
<td>Cmd+Shift+d</td>
</tr>
<tr>
<td>Ctrl+Shift+e</td>
<td>Preview the page you are editing.</td>
<td>Cmd+Shift+e</td>
</tr>
<tr>
<td>Ctr+i</td>
<td>Make the selected text italic.</td>
<td>Cmd+i</td>
</tr>
<tr>
<td>Ctrl+Shift+j</td>
<td>Insert a JIRA issue. (Opens the Insert JIRA Issue dialog.)</td>
<td>Cmd+Shift+j</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Ctrl+k</td>
<td>Insert a link. (Opens the Insert Link dialog.)</td>
<td>Cmd+k</td>
</tr>
<tr>
<td>Ctrl+Shift+k</td>
<td>See a list of suggested pages or other locations to link to from your page. More about autocomplete...</td>
<td>Cmd+Shift+k</td>
</tr>
<tr>
<td>Ctrl+m</td>
<td>Insert an image. (Opens the Insert Image dialog.)</td>
<td>Cmd+m</td>
</tr>
<tr>
<td>Ctrl+Shift+m</td>
<td>See a list of suggested images, documents and other files to embed in your page. More about autocomplete...</td>
<td>Cmd+Shift+m</td>
</tr>
<tr>
<td>Ctrl+Shift+n</td>
<td>Format text as a numbered list.</td>
<td>Cmd+Shift+n</td>
</tr>
<tr>
<td>Ctrl+s</td>
<td>Save the page you are editing.</td>
<td>Cmd+s</td>
</tr>
<tr>
<td>Ctrl+Shift+s</td>
<td>Format text with a strike through.</td>
<td>Cmd+Shift+s</td>
</tr>
<tr>
<td>Ctrl+u</td>
<td>Make the selected text underlined.</td>
<td>Cmd+u</td>
</tr>
<tr>
<td>Ctrl+y</td>
<td>Revert an action that was undone.</td>
<td>Cmd+y</td>
</tr>
<tr>
<td>Ctrl+z</td>
<td>Undo the most recent action.</td>
<td>Cmd+z</td>
</tr>
<tr>
<td>Tab</td>
<td>Indent current line (only in bulleted lists and numbered lists).</td>
<td>Tab</td>
</tr>
<tr>
<td>Shift+Tab</td>
<td>'Outdent' current line (only in bulleted lists and numbered lists).</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Shift+Enter</td>
<td>Force a line break without a paragraph break. This is a line break with no extra space.</td>
<td>Shift+Enter</td>
</tr>
<tr>
<td>[ then ]</td>
<td>Start a list of tasks. More about tasks...</td>
<td>[ then ]</td>
</tr>
</tbody>
</table>

**Tables in the editor**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+c</td>
<td>Copy the current table row, or the selected rows.</td>
<td>Cmd+Shift+c</td>
</tr>
<tr>
<td>Ctrl+Shift+i</td>
<td>Insert a table. (Opens the Insert Table dialog.)</td>
<td>Cmd+Shift+i</td>
</tr>
<tr>
<td>Ctrl+Shift+v</td>
<td>Paste the table rows from your clipboard, placing them above the current row.</td>
<td>Cmd+Shift+v</td>
</tr>
<tr>
<td>Ctrl+Shift+x</td>
<td>Cut the current table row, or the selected rows.</td>
<td>Cmd+Shift+x</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Add a row above the current row.</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Add a row below the current row.</td>
<td>Alt+Down Arrow</td>
</tr>
</tbody>
</table>

**Autocomplete in the editor**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>[</code></td>
<td>See a list of suggested pages or other locations to link to from your page.</td>
</tr>
<tr>
<td><code>!</code></td>
<td>See a list of suggested images, multimedia files and documents to embed in your page.</td>
</tr>
<tr>
<td><code>{</code></td>
<td>See a list of suggestions as you begin typing a macro name.</td>
</tr>
<tr>
<td><code>@</code></td>
<td>See a list of suggested users to mention.</td>
</tr>
</tbody>
</table>

See more about using@Autowired.

**View screen**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>Create a blog post.</td>
<td>b</td>
</tr>
<tr>
<td>c</td>
<td>Create a child page of your current page.</td>
<td>c</td>
</tr>
<tr>
<td>e</td>
<td>Edit a page or blog post, or return to Edit mode when previewing.</td>
<td>e</td>
</tr>
<tr>
<td>k</td>
<td>Open the Link To dialog.</td>
<td>l</td>
</tr>
<tr>
<td>l</td>
<td>Add or edit labels.</td>
<td>l</td>
</tr>
<tr>
<td>m</td>
<td>Add a comment to a page or blog post.</td>
<td>m</td>
</tr>
<tr>
<td>s</td>
<td>Share the current page</td>
<td>s</td>
</tr>
<tr>
<td>t</td>
<td>View attachments.</td>
<td>t</td>
</tr>
<tr>
<td>v</td>
<td>Return to page view (only if you are viewing page attachments).</td>
<td>v</td>
</tr>
<tr>
<td>w</td>
<td>Add or edit watchers.</td>
<td>w</td>
</tr>
</tbody>
</table>

**Workbox**

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>g then n</td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td>Key</td>
<td>Description</td>
</tr>
<tr>
<td>-----</td>
<td>-------------</td>
</tr>
<tr>
<td>j</td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td>k</td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td>n</td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
<tr>
<td>p</td>
<td>Move up to the previous notification for a particular page or blog post.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected notification.</td>
</tr>
<tr>
<td>u</td>
<td>Return to the notification list after opening a particular notification.</td>
</tr>
</tbody>
</table>

**Note:** The above keyboard shortcuts are available for notifications only, not for tasks, inside the Confluence workbox.

See more about managing notifications and tasks.

### Disabling and re-enabling keyboard shortcuts

Keyboard shortcuts are enabled by default. You can disable general keyboard shortcuts for your personal editing sessions. This setting will not affect other Confluence users. You cannot disable the editor keyboard shortcuts.

**To disable or re-enable general keyboard shortcuts:**

1. Log in to Confluence.
2. Open the keyboard shortcuts dialog, by doing one of the following:
   - Choose the help icon at top right of the screen, then choose **Keyboard Shortcuts**.
   - When viewing a page, press Shift+?.
   - In the editor, choose the question mark icon on the editor toolbar.
3. Choose the **General** tab.
4. Select or clear the **Enable General Shortcuts** check box as required.

**Notes**

- **Note about supported web browsers:** Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: [Supported Platforms](#).
- The keyboard shortcuts dialog also displays the trigger characters for the Confluence autocomplete feature. See [Using Autocomplete](#).
- Confluence keyboard shortcuts are consistent with [JIRA keyboard shortcuts](#).

### Creating Content

Do you want to add a page or a blog post? Just choose the **Create** option in the Confluence header. It looks like this:

![Create](#)

Below is a description of this and other options for creating content, and some answers to questions you may have.

Do you want to update an existing page or blog post? Jump straight to the topic on [Using the Editor](#), or see [Working with Pages](#) for help with moving, renaming and organising content.
**A note about permissions:** To create a page, you need the 'Add Pages' permission for the space where you will add the page. To create a blog post, you need the 'Add Blog' permission for that space. A space administrator can give you these permissions. See Giving People Access to Content.

Adding a page or a blog post

You can add pages and blog posts via the 'Create' dialog.

**To create content via 'Create' in the header:**

1. Choose Create in the Confluence header. The 'Create' dialog will open.
2. Select the space where you want to put your page or blog post. Confluence will offer a list of your recently-visited spaces.
   - **Note:** If the space you want is not in the list, please go to the space and try again. (In very large Confluence sites, Confluence cannot show all spaces in the selection list. By going to the space, you will ensure that it appears in the list.)
3. Choose the type of content you want to create.
   - You can create an empty page, a blog post, or a page based on a template.
4. Choose Next.
5. The Confluence editor will open. Add your content in the editor pane, or update the default content supplied by the template.
6. Choose Save.

Other ways to open the 'Create' dialog:

- Go to the parent page and choose Create child page in the sidebar. (This option is not available in the Documentation theme.)
- Shortcut key: Press C on your keyboard.

---

On this page:

- Adding a page or a blog post
- Location of the new page
- Using an undefined link to create a page later
- Other ways to create a page

Related pages:

- Using the Editor
- Creating Attractive and Dynamic Pages
- Adding a Template
- Finding Content
- Organising Content
- Confluence User's Guide

---

Screenshot: Creating content
Location of the new page

When you create a new page, that page will be a child of another page, in the space that you selected in the 'Create' dialog. The parent page depends on where you are when you create the page.

<table>
<thead>
<tr>
<th>Your location when creating the page</th>
<th>Location of new page</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are viewing a page in the same space where you will put the new page – that is, the space that you select in the 'Create' dialog.</td>
<td>A child of the page you are currently viewing.</td>
</tr>
</tbody>
</table>
| You are viewing any other Confluence screen. For example:  
  • You are on the dashboard.  
  • You are on the 'Pages' view of a space.  
  • You are viewing a blog post.  
  • You are viewing a page in a space, and choose to add your new page in a different space. | A child of the home page in the space you select in the 'Create' dialog. |

The space sidebar in the default theme has useful links to your pages, blog posts, and other parts of the space. For more about the sidebar and the location of pages, see Finding Content.

Using an undefined link to create a page later

You may want to insert a link pointing to a Confluence page that does not yet exist, but which you intend to create later. This type of link is called an undefined link.

**To add an undefined link for later creation of a page:**

1. Edit the page in which the link should appear.
2. Type ‘[’ to trigger autocomplete, and type the name of the undefined page. Alternatively, type the text first, then select the text and type ‘[’.
3. Choose **Insert Link to Create Page**.

When you save the page, Confluence colours the undefined link red. When someone clicks the link, the new page opens in edit mode. That person can then enter the page name, add content and save the page, as usual.
Other ways to create a page

You can import content from other Confluence sites, other wikis, Microsoft Word, and HTML pages. See Importing Content Into Confluence.

The Confluence APIs allow programmatic and scripted creation of pages. See our developer documentation.

Using the Editor

The Confluence editor is the tool that you will use to create and edit Confluence pages, blog posts and comments. You can enter content as you would in a Word document, apply formatting, and embed other content and files into the page.

Looking for a quick start? See the Quick Reference Guide for the Confluence Editor.

To begin an editing session, choose Edit at the top of a page (or press E on the keyboard).

A note about permissions: To edit a page, you need the 'Add Pages' permission for the space. See space permissions. Someone may also apply page restrictions that may prevent you from editing the page.

An editing session

You start an editing session whenever you:

- create a new page or blog post, or add a comment
- edit an existing page, blog post or comment (by pressing 'E' on the keyboard, or choosing Edit).

While in an editing session, you can also:

- Name, or rename, a page or blog post. Note that renaming has effects that you should consider.
- Add a comment describing the changes you made.
- Choose whether or not people watching the page get notified of the change you made
- Add labels to the page.

Confluence automatically saves drafts of your page as you work. If another user begins editing the same page as you, Confluence will display a message, and will try to merge the changes when you save your page.

Click Cancel (at the bottom of the page) if you want to end the session without saving any changes.

The session ends when you click Save.

When you create a new page you can choose the location where the page should be saved. You can also move a page after it has been saved, to make it a child page of a different page, or to move it to another space.

To see changes between different versions of the page, look at the history of the page.
The editor

Screenshot: The Confluence editor

<table>
<thead>
<tr>
<th>Item</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page title</td>
<td>Type the name of the page. This name is used in</td>
</tr>
<tr>
<td></td>
<td>links to the page.</td>
</tr>
<tr>
<td>Page content</td>
<td>Add the words, images and other content that forms</td>
</tr>
<tr>
<td></td>
<td>the content of the page.</td>
</tr>
</tbody>
</table>
### Editor toolbar
Use these tools to format and colour content, create lists and tables, indent and align text, and insert other content into the page, such as symbols, links, images, multimedia files and macros. The toolbar also provides the find and replace option, and the help option.

### Restrictions
Control who can view or edit the page. See Page Restrictions.

### Attachments
View, and manage, the attached files on the page.

### Labels
Add labels to a page, to categorise the page content.

### Change comment
Type a comment that describes the changes you have made.

### Notify watchers
Select this option to prompt Confluence to send an email notification of your changes to people who are watching the page.

### Preview
See how your changes will appear, without saving the page.

### Save
Save the changes you have made to the page. (Keyboard shortcut: Ctrl+S).

### Cancel
End the editing session, without saving any changes.

### Toolbars
From the toolbar you can:

- Apply paragraph styles and character formatting (such as bold, italics, superscript).
- Choose colour for text.
- Create numbered and bulleted lists.
- Set the indenting and alignment for text and images.
- Create links to other pages, attachments, anchors and external resources.
- Add tables, and add, remove, cut and paste rows and columns, highlight cells, rows and columns, and merge and split cells.
- Insert other content into the page, such as images, multimedia, attachments, symbols and wiki markup.
- Use macros to add other types of content, such as a list of JIRA issues or a table of contents.
- Add layouts and columns and sections to your page.
- Find and replace content within the page that you are editing.

Screenshot: The editor toolbar
Embedding content in the page

Choose **Insert** on the editor toolbar to include any of the following types of content into your page:

- An image.
- A link to another Confluence page or external URL, or a link to an attachment or image.
- An emoticon or symbol, or a horizontal line.
- A macro. Choose either a specific macro, or **Other Macros**, from the **Insert** menu.

Things to help you work faster

**Autoformatting**

You can type **Confluence wiki markup** directly into the editor to have Confluence auto-format your text as you type. To learn more, choose ? on the editor toolbar and choose the **Editor Autoformatting** tab. See also See the Quick Reference Guide for the Confluence Editor.

**Autocomplete**

When editing a page or blog post, you can enter a trigger character to show a list of suggested links, media files or macros to add to your page. This feature is called ‘autocomplete’ and provides you with a fast editing solution if you prefer to use key strokes rather than pointing and clicking with the mouse.

Quick summary of autocomplete:

<table>
<thead>
<tr>
<th>Type</th>
<th>To see suggested:</th>
</tr>
</thead>
<tbody>
<tr>
<td>[</td>
<td>pages and blog posts</td>
</tr>
<tr>
<td>!</td>
<td>multimedia files</td>
</tr>
<tr>
<td>{</td>
<td>macros</td>
</tr>
<tr>
<td>@</td>
<td>mentions</td>
</tr>
</tbody>
</table>

For details, see Using Autocomplete.

*Autoconvert for pasted links*
When you paste URLs into Confluence, the editor will analyse what you are pasting and automatically convert it into something that will display well in Confluence. Examples include:

- YouTube videos
- JIRA issue queries
- Google Maps
- Confluence pages, blog posts, comments, user statuses, user profiles.
- Shared screenshot links from Skitch
- And more.

**Drag-and-drop for external images and files**

You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post. Please refer to the following pages for more information:

- Displaying Images – Embedding images onto a Confluence page or blog post.
- Embedding Multimedia Content – Embedding videos, audio files and other multimedia files onto a Confluence page or blog post.
- Displaying Office Files in Confluence – Embedding Office and PDF files onto a Confluence page or blog post.

**Drag-and-drop within the editor**

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

**Note:** For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 9. (Drag and drop in the editor does not work in Internet Explorer 8.)

**Keyboard shortcuts**

To see the keyboard shortcuts available, choose ? on the editor toolbar.

**Finding and replacing text**

Click the find / replace icon on the toolbar, or use the keyboard shortcut Ctrl+F (Windows) or Cmd+F (Mac OS). Search matches are highlighted in yellow. You can step through the results one by one, replace the matching text strings one by one, or replace all matching strings at once. This find and replace feature works only within the current page.

**Enabling and disabling autocomplete and autoformatting**

You can enable or disable the editor's autocomplete and autoformatting functions, by editing the settings in your user profile.

In summary:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Editor under ‘Your Settings’ in the left-hand panel.
For more details, see Editing User Settings.

Quick Reference Guide for the Confluence Editor

This page is a quick-reference guide to using the Confluence editor. The aim is to give you enough information about the editor’s features for you to experiment yourself, rather than describing every possible shortcut key, autocomplete feature or toolbar option.

This guide is for people who want to use the autocomplete, autoformatting and keyboard shortcuts provided by the editor. If you prefer to use the toolbar options, the editor itself should be mostly self-explanatory.

Introductory tips

1. Jump in and start using the Confluence editor. The editor toolbar contains the most important buttons you'll need for creating and editing content.

2. Use the keyboard shortcuts. For example, type these characters in the editor panel:

   - Type `[` (angle bracket) to insert a link.
   - Type `!` (exclamation mark) to insert an image or other media.
   - Type `{` (curly bracket) to insert a macro.

   These characters will trigger the autocomplete functionality, prompting you with a list of suggestions to finish off the entry. For more shortcuts, click the help icon on the editor toolbar.

3. See how to undo the autocomplete and autoformatting actions. To undo something that autocomplete or autoformatting has done, press Ctrl+Z (Windows) or Cmd+Z (Mac).

On this page:

- Introductory tips
- Seeing it in action
- Using the most common formats and features
  - Formatting text
  - Using symbols
  - Linking text
  - Using lists
  - Using tables
  - Using macros
  - Displaying images and multimedia
- Enabling and disabling autocomplete and autoformatting

Related pages:

- Using Autocomplete
- Using the Editor
- Confluence User's Guide

Seeing it in action

This short video shows the autoformatting and autocomplete features of the editor.

See the video on YouTube

This video shows how to add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.
See the video on YouTube.

**Using the most common formats and features**

Below is a list of the most commonly used editor features, and the related keyboard shortcuts.

**Formatting text**

<table>
<thead>
<tr>
<th>Formatting text</th>
<th>What to do</th>
<th>Windows keyboard shortcuts (For Mac OS X, replace 'Ctrl' with 'Cmd')</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Heading levels</strong></td>
<td>Type the heading level and a full stop. Autoformat will convert the line to the appropriate heading immediately. You can continue typing your heading text immediately. Example:</td>
<td>Ctrl + 1 to 6</td>
</tr>
<tr>
<td></td>
<td>h2.</td>
<td></td>
</tr>
<tr>
<td><strong>Bold text</strong></td>
<td>Type an asterisk ‘*’, your text, then another asterisk. Confluence autoformat will convert the text to bold immediately. Example:</td>
<td>Ctrl + b</td>
</tr>
<tr>
<td></td>
<td><em>Surf’s Up</em></td>
<td></td>
</tr>
<tr>
<td><strong>Italic text</strong></td>
<td>Type an underscore ‘_’, your text, then another underscore. Confluence autoformatting will convert the text to italics immediately. Example:</td>
<td>Ctrl + i</td>
</tr>
<tr>
<td></td>
<td><em>Surf’s Up</em></td>
<td></td>
</tr>
<tr>
<td><strong>Underlined text</strong></td>
<td>Type a plus sign ‘+’, your text, then another plus sign ‘+’. Confluence autoformatting will convert the text to underlined immediately. Example:</td>
<td>Ctrl + u</td>
</tr>
<tr>
<td></td>
<td>+Surf’s Up+</td>
<td></td>
</tr>
<tr>
<td><strong>Monospace text</strong></td>
<td>Type two curly braces ‘{’, your text, then another two curly braces ’}’. Confluence autoformat will convert the text to monospace immediately. Example:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>{{Surf’s Up}}</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Instructions</td>
<td>Sample Output</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Left, centre and right alignment</td>
<td>Click the left, centre and right alignment buttons on the editor toolbar: <img src="image" alt="Alignment Buttons" /></td>
<td><img src="image" alt="Alignment Buttons" /> This can also be used to align images independently of text.</td>
</tr>
<tr>
<td>Indentation</td>
<td>Click the left and right indentation buttons on the editor toolbar: <img src="image" alt="Indentation Buttons" /></td>
<td>Tab (right), Shift + Tab (left)</td>
</tr>
<tr>
<td>Line break</td>
<td>Press Shift + Enter to force a line break without a paragraph break. This is a line break with no extra space.</td>
<td>Shift + Enter</td>
</tr>
<tr>
<td>Quotation</td>
<td>Use the <em>Quote</em> style – select <code>'Quote'</code> from the style dropdown menu or use the keyboard shortcut. Example: <img src="image" alt="Style Dropdown" /></td>
<td>Ctrl + 8</td>
</tr>
<tr>
<td>Colour</td>
<td>Click the colour options on the editor toolbar. Example: <img src="image" alt="Colour Options" /></td>
<td>None</td>
</tr>
</tbody>
</table>
Using symbols

<table>
<thead>
<tr>
<th>Adding symbols and emoticons</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tick or check mark</td>
<td>Type a forward slash in round brackets. Autocomplete will convert it as you type. Example: (/)</td>
<td>( + / + )</td>
</tr>
<tr>
<td>Smiley</td>
<td>Type the globally-recognised markup for a smiley face (colon and round bracket), a wink (semicolon and round bracket), and so on. Autocomplete will convert it as you type. Example: : )</td>
<td>: + )</td>
</tr>
</tbody>
</table>

Linking text

<table>
<thead>
<tr>
<th>Linking text</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking to a Confluence page</td>
<td>Type a square bracket <code>[</code> and start typing the page name to see the suggested pages to link to. Press the arrow keys to select the page you want. Example:</td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Link suggestions" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Example:</strong> `[Modern Girl</td>
<td>Modern Girl song lyrics]`</td>
</tr>
</tbody>
</table>
Linking text to a web page

Type a square bracket `[` and select **Insert Web Link**, then paste the URL into the link dialog. Example:

```
[ Modern Girl
```

 Alternatively, use **wiki markup entirely**. Type the link, including the alias and the URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `[Modern Girl|http://www.example.com/song]`
<table>
<thead>
<tr>
<th>Linking to a page that does not yet exist</th>
<th>Type a square bracket <code>[</code> and the name of the non-existent page, then select 'Insert Link to Create Page'. Example:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Link suggestions" /></td>
<td><img src="image" alt="Insert Link to Create Page" /></td>
</tr>
<tr>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the link, including the alias and the page name or URL. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
<td></td>
</tr>
<tr>
<td><img src="image" alt="Link suggestions" /></td>
<td><img src="image" alt="Insert Link to Create Page" /></td>
</tr>
<tr>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
<td></td>
</tr>
<tr>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
<td></td>
</tr>
<tr>
<td>• <strong>Example:</strong> <code>[Future of the Modern Girl]</code></td>
<td></td>
</tr>
<tr>
<td>Linking to an attachment</td>
<td>Type a square bracket <code>[</code> and start typing the attachment name to see the suggested attachments to link to. Press the arrow keys to select the item you want. Example:</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Link suggestions" /> Alternately, use <strong>wiki markup entirely</strong>. Type the link, including the alias (if required), the caret character <code>^</code> and the attachment name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.</td>
</tr>
<tr>
<td></td>
<td>- This works if you have ‘Autoformatting’ enabled in the editor settings in your user profile.</td>
</tr>
<tr>
<td></td>
<td>- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Example:</strong> <code>[^attachment name]</code></td>
</tr>
</tbody>
</table>
Linking to an anchor

To create the anchor: Add an anchor macro using wiki markup. Confluence will convert the macro to rich text format and add it to the page. For example, to create an anchor named 'index', type the following: `{anchor:index}`

To create the link: Use wiki markup too. Type the link, including the alias (if required), the hash character `#` and the anchor name. As soon as you type the closing square bracket, Confluence will convert the link to rich text format and add it to the page. This means that you can skip the link browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- Example: `[Index|#index]`

Using lists

<table>
<thead>
<tr>
<th>Using lists</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
| Adding a bullet list | Type an asterisk `*` followed by a space. Autoformat will convert the line to a bulleted list. You can continue typing your text immediately. Example:  

My list:

• bullet item

i To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line. | Ctrl + Shift + b |
| Adding a numbered list | Type a hash or pound '#' followed by a space. Autoformat will convert the line to a numbered list. You can continue typing your text immediately. Example:  
My list:  
1. bullet item  
   |  
   | To add another line of text to an entry without creating a new list item, press Shift + Enter at the end of the line.  
| Ctrl + Shift + n |

### Using tables

<table>
<thead>
<tr>
<th>Using tables</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
| Adding a table | Type a series of pipe characters '|' then press **Enter**. Autoformat will convert the pipes to a table. Example – to create a table with three columns:  
| | None |

### Using macros

<table>
<thead>
<tr>
<th>Adding macros</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
</table>
Adding a macro to your page.

Type '{' and start typing the macro name to see a list of macros that match your text. Press the arrow keys to select the macro you want. Example:

```
{ blog}
```

Alternatively, use **wiki markup entirely**. Type the macro, including its parameters and the closing curly bracket. As soon as you close the macro, Confluence will convert it to rich text format and add it to the page. This means that you can skip the macro browser.

- This works if you have 'Autoformatting' enabled in the editor settings in your user profile.
- This does not work if you paste the wiki markup onto the page. You need to enter the closing bracket manually.
- **Example:** `{blogposts:content=titles|author=jsmith}`
- For details of wiki markup syntax, see Confluence Wiki Markup for Macros.

### Displaying images and multimedia

<table>
<thead>
<tr>
<th>Displaying images</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displaying images</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Display an image attached to the page</td>
<td>Type an exclamation mark '!' and start typing the image name to see the suggested images to insert onto the page. Press the arrow keys to select the item you want. Example:</td>
<td></td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>!NoMatt</td>
<td>Alternatively, use <strong>wiki markup entirely</strong>. Type the wiki markup for the image insertion, including the exclamation marks, the space and/or page name (if different from the current page) and the image name, as well as any other allowed parameters. As soon as you type the closing exclamation mark, Confluence will convert the image to rich text format and add it to the page. This means that you can skip the image browser.</td>
<td></td>
</tr>
<tr>
<td>• This works if you have 'Autoformatting' enabled in the editor settings in your user profile.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• This does not work if you paste the wiki markup onto the page. You need to enter the closing exclamation mark manually.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Example: !NoMatterWhat.png</td>
<td>align=right!</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Displaying an image attached to another page</th>
<th><strong>Exactly the same as when the image is attached to the same page.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>!</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Embedding multimedia files</th>
<th>What to type</th>
<th>Keyboard shortcut (Windows)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Embedding a video, movie or audio file into a page</td>
<td>Type an exclamation mark ‘!' and select 'Insert Other Media'. Example:</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------</td>
<td></td>
</tr>
</tbody>
</table>

```
{mul}
```

Or type '{' and start typing the macro name 'Multimedia'. Example:
```
{ mul
```

### Enabling and disabling autocomplete and autoformatting

You can enable or disable the editor's autocomplete and autoformatting functions, by editing the settings in your user profile.

In summary:

1. Choose **your profile picture** at top right of the screen, then choose **Settings**.
2. Choose **Editor** under 'Your Settings' in the left-hand panel.

For more details, see **Editing User Settings**.

### Working with Text Effects

The Confluence editor supports most text effects available in standard text editing applications.

#### Applying paragraph styles

Choose a paragraph style from the editor toolbar, or click in the paragraph and use one of the keyboard shortcuts Ctrl+(0–8) .

**Screenshot: Choosing paragraph styles from the editor toolbar**
Applying character formats

To apply a character format, select the text and click one of the editor toolbar buttons, or use a keyboard shortcut. Some formats are available from the 'More' menu.

*Screenshot: Text formatting buttons on the editor toolbar*

<table>
<thead>
<tr>
<th>Format</th>
<th>Shortcut Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Ctrl+B</td>
</tr>
<tr>
<td><em>Italics</em></td>
<td>Ctrl+I</td>
</tr>
<tr>
<td><strong>Underline</strong></td>
<td>Ctrl+U</td>
</tr>
<tr>
<td><strong>Strikethrough</strong></td>
<td>Ctrl+Shift+S</td>
</tr>
<tr>
<td><strong>Subscript</strong></td>
<td>none</td>
</tr>
<tr>
<td><strong>Superscript</strong></td>
<td>none</td>
</tr>
<tr>
<td><strong>Monospace</strong></td>
<td>none</td>
</tr>
</tbody>
</table>

Choose **Clear Formatting** from the 'More' menu to remove all formatting.
**Applying colours to text**

To apply a colour to text, select the text and click the ‘Colour’ button. Choose the colour using the ‘More colours’ button.

*Screenshot: Picking colours from the editor toolbar*

![Colours](image)

**Aligning text**

You can align text to the left, right or centre of a content block. Select the text and click the appropriate alignment option on the editor toolbar.

*Screenshot: Left, centre and right alignment options on the editor toolbar*

![Alignments](image)

**Indenting text**

You can move text to the left or right by a predefined sequence of indentations. Confluence determines the size of the indentation. Select the text and click the left or right indentation option on the editor toolbar.

*Screenshot: Left and right indentation options on the editor toolbar*

![Indentions](image)

**Working with Links**

By adding a link on a Confluence page, you can link to content anywhere within the Confluence site or on another web site.

You can add links to the following types of content:

- Pages in the same space, in another space, or outside Confluence (webpages).
- Blog posts.
- Pages that have not yet been created, but for which you require a placeholder on the current page.
- Attachments, such as images and multimedia files.
- User profiles or personal spaces.
- A section of a page, using an anchor.

You can also link from an image, or use a link to begin composing a new email message.

You create all these kinds of links using the 'Insert Link' dialog that is available in the editor (click **Link** in the menu bar while editing the page). You can also create links using **autocomplete** as a shorthand way of creating the most common types of links.
You can edit and remove links while editing the page, using the link properties panel that appears when you click on a link in the editor:

Notes

- Links in Confluence will not break even when you rename pages or move them between spaces on your site. Confluence will rename the links, provided you have inserted them as relative links, not as full URLs.
- Looking for a link type not shown above? You might find a plugin can help you.

Linking to Pages

This page describes how to create a link in your Confluence page to another page.

You can create links on your page to:

- Other pages in the Confluence site.
- Web pages outside of Confluence.
- Anchors or headings, on the same page or other pages.

You can also create a link to a non-existent Confluence page.

You can use the following methods to create links:

- Autocomplete - to link to Confluence pages or a non-existent page.
- The 'Insert Link' dialog - to link to Confluence pages and web pages.
- Cutting and pasting a link from your browser - to link to Confluence pages and web pages.

Linking to Confluence pages

Adding a link using autocomplete

You can use autocomplete to create a link to any page in the Confluence site, if you know the name of the page you want to link to.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Adding a link using the Insert Link dialog

To create a new link using the 'Insert Link' dialog:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Choose one of the tabs on the left to help you find the page or other location that you want to link to:
   - Search— Use this option to link to a page or file in Confluence.
• Start typing the page name into the text box. Confluence will suggest options as you type.
• If necessary, limit the search to the current space.
• Select your link destination from the autocomplete results, or click Search and select the link destination from the search results.

• Recently Viewed—Use this option to link to a page in Confluence.
• Select your link destination from recently-visited pages.

4. Enter link text that will be displayed on the page, if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.

5. Click Insert.

On this page:

• Linking to Confluence pages
  • Adding a link using autocomplete
  • Adding a link using the Insert Link dialog
  • Copying and pasting a link from your web browser

• Linking to web pages
• Linking to an anchor
• Linking to a heading
• Linking to an undefined Confluence page
• Using a shortcut link

Related pages:

• Working with Links
• Working with Anchors
• Trackback
• Linking to Confluence Pages from Outside Confluence
• Confluence User's Guide

Copying and pasting a link from your web browser

To paste a link from your web browser:

1. In your web browser, select and copy the title of a Confluence page.
2. Edit your Confluence page and paste the title where you want the link to appear.

Linking to web pages

Use the 'Insert Link' dialog to link to an external web page.

To create a link to a web page:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click Web Link and enter or paste the web address into the URL text box.
4. Enter link text that will be displayed on the page if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
5. Click Insert.

You can also simply copy and paste a link to a web page into your Confluence page, as described above.

Linking to an anchor

You can link to a specific location within a page, by marking that location with an Anchor macro and then linking to the anchor name.

You can link to an anchor from:
To link to an anchor from within the same Confluence site:

1. Edit the page where you want to place the link.
2. Choose Link in the editor toolbar, or press Ctrl+K.
3. Choose Advanced and enter the anchor name into the Link box, noting the following:
   - The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.
   - Use the following syntax:

<table>
<thead>
<tr>
<th>Anchor location</th>
<th>Link syntax for anchor</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same page</td>
<td>#anchorname</td>
<td>#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>#important information</td>
</tr>
<tr>
<td>Different page</td>
<td>pagename#anchorname</td>
<td>My page#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>My page#important information</td>
</tr>
<tr>
<td>Page in another space</td>
<td>spacekey:pagename#anchorname</td>
<td>DOCS:My page#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DOCS:My page#important information</td>
</tr>
</tbody>
</table>

4. Enter the Link Text (alias) that will be displayed on the page, if required. If you leave the 'Link Text' box empty, the link will display the destination page name or URL.
5. Choose Insert.

To link to an anchor from another web page or another Confluence site:

Use a full URL in the following format:

<table>
<thead>
<tr>
<th>Link syntax</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://myconfluence.com/display/spacekey/pagename#pagename-anchorname">http://myconfluence.com/display/spacekey/pagename#pagename-anchorname</a></td>
<td><a href="http://myconfluence.com/display/DOCS/My+page#My">http://myconfluence.com/display/DOCS/My+page#My</a> page-bottom</td>
</tr>
<tr>
<td></td>
<td><a href="http://myconfluence.com/display/DOCS/My+page#My">http://myconfluence.com/display/DOCS/My+page#My</a> page-importantinformation</td>
</tr>
</tbody>
</table>

Notes about the full URL:

- The page name is repeated in the URL, after the # sign. The second occurrence of the page name is concatenated into a single word, with all spaces removed.
- There is a single dash (hyphen) between the concatenated page name and the anchor name.
- The anchor name in the full URL is concatenated into a single word, with all spaces removed.
- The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.

Linking to a heading

You can link to a heading that is on the same page, on another page in the same space, or on a page in another space of the same Confluence site.
To link to a heading:

1. Edit the page where you want to put the link.
2. Choose Link in the toolbar, or press Ctrl+K.
3. Choose Advanced and enter the heading into the Link box, noting the following:
   
   - The headingname is case-sensitive and must be entered without spaces.
   - Use the following syntax:

<table>
<thead>
<tr>
<th>Heading location</th>
<th>Link syntax for heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same page</td>
<td>#headingname</td>
</tr>
<tr>
<td>Different page</td>
<td>pagename#headingname</td>
</tr>
<tr>
<td>Page in another space</td>
<td>spacekey:pagename#headingname</td>
</tr>
</tbody>
</table>

4. Enter link text that will be displayed on the page, if required. If you leave the Link Text box empty, the link will display the destination page name or URL.
5. Choose Insert.

Linking to an undefined Confluence page

You may want to insert a link pointing to a Confluence page that does not yet exist, but which you intend to create later. This type of link is called an undefined link.

To add an undefined link for later creation of a page:

1. Edit the page in which the link should appear.
2. Type '[' to trigger autocomplete, and type the name of the undefined page. Alternatively, type the text first, then select the text and type '['.
3. Choose Insert Link to Create Page.

When you save the page, Confluence colours the undefined link red. When someone clicks the link, the new page opens in edit mode. That person can then enter the page name, add content and save the page, as usual.

Using shortcut link

If you have configured shortcut links on your Confluence site, then you can link to an external site using a shortcut link that looks like this: CONF-17025@jira. Our Confluence site (where this documentation is housed) is configured to allow shortcut links to our JIRA site, using the shortcut @jira. So the shortcut link CONF-17025@jira produces this link.

To add a shortcut link using the 'Insert Link' dialog:

1. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
2. Click Advanced and enter or paste the shortcut link into the Link box. Shortcut links are case-insensitive.
3. Enter link text that will be displayed on the page, if required. If you leave the Link Text box empty, the link will display the destination page name or URL.
4. Click Insert.

You can also type '[' and choose Insert Web Link > Advanced to enter a shortcut link.

See Configuring Shortcut Links for more details.

Linking to Images

This page describes how to insert a link on your Confluence page that points to an image. Linking to an image is
a way to have text on a page that, when clicked, takes the user to that image.

**Quick guide to linking to an image**

1. Click Link on the editor toolbar.
2. Select one of these options:
   - **Search** – Search for and link to any image or file attached to any page in your Confluence site.
   - **Attachments** – Link to an image or file attached to the current Confluence page.

The rest of this page gives more details of the above procedure and additional options.

**On this page:**

- Adding a Link with the Link Browser
- Adding a Link using Autocomplete

**Related pages:**

- Linking to Attachments
- Displaying Images

---

**Adding a Link with the Link Browser**

**To link to an image that is attached to the current page:**

1. Edit the page where you want to insert the link.
2. Click Link on the toolbar.
3. Choose the **Attachments** tab in the left-hand panel. You will see a list of all files attached to the page.
   - Now you can:
     - Select an image that is already attached to the page.
     - Attach a new image to the page by clicking **Browse** and uploading your file.
4. Enter the **Link Text**. These are the words that will appear as the hyperlink on the page.
5. Click **Insert**.

**To link to an image that is attached to any Confluence page:**

1. Edit the page where you want to insert the link.
2. Click **Link** on the toolbar.
3. Select the **Search** option in the left-hand panel.
4. Start typing the name of the image. Confluence will suggest image files. If the image does not appear in
   the list, click **Search**.
5. Click the image name in the autocomplete results or the search results.
6. Click **Insert**.

**Screenshot: The link browser, showing autocomplete in the 'Search' option**
Adding a Link using Autocomplete

You can use the autocomplete functionality to link to an image attached to any Confluence page.

You can type `[` to see a list of suggested links. For details, see Using Autocomplete.

Linking from an Image

This page describes how to create a link from an image on one page to another page or URL. When the user clicks the image, they will be redirected to the linked page or other resource.

To create a link from an image:

1. Display the image on the page. The image can either be attached to the page or available on another page. See Displaying Images.
2. Create the link by clicking on the image and then clicking Link in the properties panel. Specify the link target using the 'Insert Link' dialog. See Linking to Pages.

You can edit the link by clicking on the image, when editing the page, and clicking Edit Link in the properties panel.

Screenshot: The properties panel for an image
This page describes how to add a text link pointing to a file attached to your Confluence page. When a reader clicks the link, the file is displayed in the browser.

Quick guide to linking to an attachment

1. Click Link on the editor toolbar.
2. Select one of these options:
   - **Search** – to search for and link to any image or file attached to any page in your Confluence site.
   - **Recently Viewed** – to link to a recently visited page.
   - **Attachments** – to link to an image or file attached to the current Confluence page.
   - **Web Link** – to link to any webpage.

On this page:

- Adding a Link using Autocomplete
- Adding a Link using the Link Browser

Related pages:

- Linking to Images

Adding a Link using Autocomplete

You can use autocomplete to add a text link to a file or image attached to any Confluence page.

You can type `[` to see a list of suggested links. For details, see Using Autocomplete.

Adding a Link using the Link Browser

The 'link browser' is the 'Insert Link' or 'Edit Link' dialog that appears when you click Link in the editor toolbar.

To link to a file or image that is attached to the current page:

1. Edit the page where you want to insert the link.
2. Click Link in the editor toolbar, and then the Attachments tab. You will see a list of all files attached to the page. Now you can do one of the following:
   - Click on the file that you want to link to, if it is already attached to the page.
   - Attach a new file to the page by clicking Browse and uploading your file.
3. Enter the Link Text. These are the words that will appear as the hyperlink on the page.
4. Click Insert to add the link.

To link to a file or image that is attached to any Confluence page:

1. Edit the page where you want to insert the link.
2. Click Link in the editor toolbar, and then the Search tab.
3. Start typing the name of the file or image. Confluence will offer a list of matching file names. If the file does not appear, click Search to find pages that contain the search text.
4. Click the required file in the list or the search results.
5. Enter the Link Text. These are the words that will appear as the hyperlink on the page.
6. Click Insert to add the link.
Linking to Blog Posts

You can link to blog posts in similar ways to how you link to pages. Only two methods are described on this page.

You can also use the Blog Posts macro to display a dynamic list of blog posts on your page.

**You must create the blog post first**
Linking to a blog post that has not been created yet will not result in a link. Blog posts are very tightly bound to the time at which they were created, so it makes no sense to link to them before they exist.

Linking to a Blog Post using Autocomplete

**You need to know the title of the blog post.**

You can use autocomplete to create a link to any blog post in the Confluence site, if you know the name of the post you want to link to.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Linking to a Blog Post using its URL

**You need to know the absolute path to the blog post.**

To create a link to a blog post using the 'Insert Link' dialog:

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click Web Link and enter or paste the absolute path to the blog post into the URL text box.
4. Enter link text that will be displayed on the page if required. If you have not highlighted text in the page,
and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
5. Click Insert.

Related Topics

Working with Blog Posts
Working with Links
Blog Posts Macro

Linking to Personal Spaces and User Profiles

This page describes how to add a link to a user's personal space or user profile from within another Confluence page.

You can link to a user's personal space (or user profile) easily if you know their username.

If the user does not have a personal space, then the link will go to their user profile.

Linking to a User’s Personal Space using Autocompletion

You can use autocomplete to create a link to a user's personal space in the Confluence site. Trigger autocomplete and start typing their name.

You can type [ to see a list of suggested links. For details, see Using Autocomplete.

Linking to a User’s Personal Space using the Insert Link Dialog

1. While editing the page, place your cursor at the point where you want to create the link, or highlight the text that you want linked.
2. Click Link in the toolbar, or press Ctrl+K. See keyboard shortcuts for more information.
3. Click the Search tab on the left.
4. Start typing the user's name into the search field. Confluence will suggest options as you type.
5. Select the user from the autocomplete results.
6. Enter link text that will be displayed on the page, if required. If you have not highlighted text in the page, and leave the 'Link Text' text box empty, the link will display the destination page name or URL.
7. Click Insert.

Related Topics

User Profile Overview
Setting Up your Personal Space
Working with Links

Working with Anchors

You can link to a specific location within a page, by marking that location with an Anchor macro and then linking to the anchor name. Anchor links can be especially useful when navigating between sections of a long document, or when you want to link to a segment of a page instead of the top of the page.

Anchors are invisible to the reader when the page is displayed.

There are two steps to using an anchor:

1. Create the anchor on the page.
2. Create the link to the anchor.

Creating an anchor

Use the Anchor macro to mark the location you want to link to.
1. Add the Anchor macro to a page.
   a. In the Confluence editor, choose Insert > Other Macros.
   b. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

2. **Specify the name of your anchor.** For example, 'bottom' or 'important information'. See the 'Anchor Name' parameter described below.

### On this page:
- Creating an anchor
- Creating a link to an anchor
- Code examples
- Notes

### Related pages:
- Working with Links
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

---

**Macro options (parameters)**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anchor Name</td>
<td>None</td>
<td>This is the anchor name that you will use when creating the link.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The anchor name can include spaces. Confluence will remove the spaces automatically when building a URL that points to this anchor.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The anchor name is case sensitive. You must use the same pattern of upper and lower case letters when creating the link as you use when creating the Anchor macro.</td>
</tr>
</tbody>
</table>

### Creating a link to an anchor

You can link to an anchor from:
- A link on the same page as the anchor
- Another page in the same space
- A page in another space of the same Confluence site.
- Another web page or another Confluence site, using a specifically formatted URL.
To link to an anchor from within the same Confluence site:

1. Edit the page where you want to place the link.
2. Choose Link in the editor toolbar, or press Ctrl+K.
3. Choose Advanced and enter the anchor name into the Link box, noting the following:
   - The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.
   - Use the following syntax:

<table>
<thead>
<tr>
<th>Anchor location</th>
<th>Link syntax for anchor</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Same page</td>
<td>#anchorname</td>
<td>#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>#important information</td>
</tr>
<tr>
<td>Different page</td>
<td>pagename#anchorname</td>
<td>My page#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>My page#important information</td>
</tr>
<tr>
<td>Page in another space</td>
<td>spacekey:pagename#anchorname</td>
<td>DOCS:My page#bottom</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DOCS:My page#important information</td>
</tr>
</tbody>
</table>

4. Enter the Link Text (alias) that will be displayed on the page, if required. If you leave the 'Link Text' box empty, the link will display the destination page name or URL.
5. Choose Insert.

To link to an anchor from another web page or another Confluence site:

Use a full URL in the following format:

<table>
<thead>
<tr>
<th>Link syntax</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://myconfluence.com/display/spacekey/pagename#pagem">http://myconfluence.com/display/spacekey/pagename#pagem</a></td>
<td><a href="http://myconfluence.com/display/DOCS/My+page#My">http://myconfluence.com/display/DOCS/My+page#My</a> page-bottom</td>
</tr>
<tr>
<td>enance-anchoname</td>
<td><a href="http://myconfluence.com/display/DOCS/My+page#My">http://myconfluence.com/display/DOCS/My+page#My</a> page-importantinfor</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notes about the full URL:

- The page name is repeated in the URL, after the # sign. The second occurrence of the page name is concatenated into a single word, with all spaces removed.
- There is a single dash (hyphen) between the concatenated page name and the anchor name.
- The anchor name in the full URL is concatenated into a single word, with all spaces removed.
- The anchor name is case sensitive. You must use the same pattern of upper and lower case letters as you used when creating the Anchor macro.

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
• **Table of contents on page**: Consider using the Table of Contents Macro to generate a list of links pointing to the headings on the page. The list of links will appear on the page, and will be automatically updated each time someone changes the wording of a heading.

• **Linking to headings**: You can link directly to the headings of a page. See Linking to Pages. However, if someone changes the wording of a heading, those direct links will be broken. Use the Anchor macro to ensure a lasting link within the body of a page.

• **Site welcome message**: If you are adding an anchor to a page that you are using in the site welcome message, you can only link to that anchor from another page. Internal links within that page will not work.

• **Templates**: When you are previewing a template, a link to an anchor is displayed as a 'broken' link. However, when you create a page using the template the resulting page will have the correct link.

**Using a Link to Create a New Email Message**

This page describes how to insert a link that, when clicked, launches the default email client.

😊 You can provide your own text to use as the link text instead of the 'mailto' tag.

**To insert a link that creates a new email message:**

1. Edit the page on which you want to insert the link.
2. Choose **Insert > Link** and select the **Web Link** tab.
3. Enter an email address, such as 'jsmith@non-existent.corp.com'.
4. Enter your own link text, if required.
5. Click **Save**.

**Related Topics**

Working with Links

Take me back to Confluence User's Guide

Linking to Confluence Pages from Outside Confluence

Sometimes you may want to link to a Confluence page from outside Confluence, such as from another website or from within an email. In this case, you should consider using a link to a 'permanent' URL (also called a 'permalink'), in case the name of the Confluence page changes.

ℹ️ If you are linking to a page from another page in the same Confluence site, it is better to use an internal wiki link rather than a permalink. Confluence can keep track of internal links and will let you know if the link is broken, such as when someone removes the linked page. See Linking to Pages. Internal wiki links are automatically updated if the page is renamed. This only works for page links that use the relative link syntax, for example [Renaming a Page].

**To link to a page’s permanent URL:**

1. View the page that you want to link to.
2. Choose **Tools > Link to this Page**.
3. Copy the **Tiny Link** and paste it into your email or external web page. This will create a link to the latest version of your Confluence page.

**Related Topics**

Linking to Pages

Working with Links

Take me back to Confluence User's Guide

Inserting JIRA Issues

If your Confluence site is connected to a JIRA site using an application link, you can easily insert individual issues from this JIRA site directly into text on your Confluence page using the 'Insert JIRA Issue' dialog. Each issue inserted onto the page is linked to the issue in JIRA itself.

Using the 'Insert JIRA Issue' dialog, you can also:
- Create a new issue on the JIRA site and insert the issue onto your page.
- Insert a table of JIRA issues onto your page based on the results of a search (using JIRA Query Language (JQL) syntax).

If your Confluence site is not connected to any JIRA site via an application link, this feature will not be available. However, you can still list JIRA issues on a page or blog post using the JIRA issues macro.

On this page:
- Inserting a JIRA Issue from a List of Recently Viewed Issues
- Creating a New JIRA Issue and Inserting it
- Searching for JIRA Issues and Inserting them
- Notes

Related pages:
- JIRA Issues Macro
- Configuring Application Links Not applicable to Confluence OnDemand.
- Confluence User's Guide

Quick guide to inserting JIRA issues
- Choose Insert > JIRA Issue from the editor toolbar.
  - To insert a single issue, use either:
    - Recently Viewed — Insert an issue onto your page from a list of issues you have recently viewed on the JIRA server.
    - Create New Issue — Create a new issue on the JIRA server and insert it into your page.
    - Search — Use JQL syntax to narrow down a list of issues, from which you can select one to insert onto a page.
  - To insert a table of issues:
    - Click Search on the 'Insert JIRA Issues' dialog, use JQL syntax to narrow down a list of issues and choose to insert the list onto a page.

If Confluence is connected to more than one JIRA server, ensure that you choose the appropriate JIRA server before using this dialog to select, create or search for issues.

Inserting a JIRA Issue from a List of Recently Viewed Issues

To insert a JIRA issue onto a page from a list of recently viewed issues on a JIRA site:
1. Choose Insert > JIRA Issue from the editor toolbar.
2. Go to the Recently Viewed tab of the 'Insert JIRA Issue' dialog.
3. If necessary, select a JIRA server from the Server list. See the notes below regarding OAuth outgoing authentication.
4. Select an issue from your list of recently viewed JIRA issues on the JIRA site. The number of items in the list is defined in JIRA.

Creating a New JIRA Issue and Inserting it

This feature works best with JIRA issue types whose mandatory field requirements have not been altered. With the exception of a JIRA issue's 'Component/s' or 'Fix Version/s' fields, you cannot use this dialog to add an issue whose issue type has customised mandatory field requirements upon issue creation.

To create a new JIRA issue on a JIRA site and insert this issue onto a page:
1. Go to the Create New Issue tab of the 'Insert JIRA Issue' dialog.
2. Complete the dialog:
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>The available JIRA servers. See the notes below regarding OAuth outgoing authentication.</td>
</tr>
<tr>
<td>Project</td>
<td>The project on the selected JIRA server to which the new issue will be added.</td>
</tr>
<tr>
<td>Issue Type</td>
<td>The type of issue to log in this project.</td>
</tr>
<tr>
<td>Summary</td>
<td>A one-line summary for the issue.</td>
</tr>
<tr>
<td>Component/s</td>
<td>Choose one or more components which apply to this issue.</td>
</tr>
<tr>
<td>Version/s</td>
<td>Choose one or more versions in which the issue will be addressed.</td>
</tr>
<tr>
<td>Description</td>
<td>A more detailed description about the issue.</td>
</tr>
</tbody>
</table>

Some of these fields may not be visible if they have been customised in your JIRA project.

3. Click **Insert** to create the JIRA issue and insert it onto the page.

### Searching for JIRA Issues and Inserting them

**To search a JIRA site for a subset of issues matching a JQL query and insert one or more of these issues:**

1. Choose **Insert > JIRA Issue** from the editor toolbar.
2. Go to the **Search** tab of the 'Insert JIRA Issue' dialog.
3. Enter a **JQL query**.
4. If necessary, select the JIRA server whose issues you want to insert.
5. Click **Search** to find the issues on the JIRA server which match your JQL query. The first 20 issues retrieved by your JQL query are displayed.
   - To insert a single issue, select the issue from your list and click **Insert**.
   - To insert the full list of issues, select the **Insert all query results as a table** check box before clicking **Insert**.

### Notes

The issues from a JIRA site which you can access in the 'Insert JIRA Issues' dialog depends on the application link's **outgoing authentication** used by Confluence to communicate with that JIRA site. While you can always access publicly visible issues:

- If 'Trusted Applications' outgoing authentication is used — you can also view issues restricted to an account on JIRA whose user name matches your user name in Confluence.
- If 'OAuth' outgoing authentication is used, you may need to click **Login & Approve** at this point to gain access to the JIRA server and restricted issues. You can also view issues restricted to the user account that you 'Login & Approve' (to the JIRA site) on the 'Insert JIRA Issues' dialog.
- If 'Basic Access' outgoing authentication is used — you can also view issues restricted to the user account configured for the JIRA site's 'outgoing authentication'.

### Trackback

Trackback is a mechanism by which two sites can stay informed each time one site refers to the other by means of trackback 'pings'.

In Confluence, Trackback is enabled by a site administrator from the Administration Console. When Trackback is
enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a Trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery, and when Trackback is enabled can receive trackback pings sent by other sites.

**To see who has sent a Trackback ping to a Confluence page:**

1. Go to the page.
2. Choose **Tools > Info** to go to the ‘Information’ view for the page.

Any Trackback pings the page has received will be listed under the page’s **Incoming Links**

![](image.png)

Confluence incoming trackback pings only work with referenced pages that are public (anonymously viewable)

See more information about the Information View.

Related Topics

- Enabling Trackback
- Managing External Referrers
- Linking to Pages
- Working with Links

Take me back to **Confluence User’s Guide**

### Displaying Images

You can display an image on a Confluence page in the following cases:

- The image is attached to the page.
- The image is attached to another page of the same Confluence site, even if in another space.
- The image is on a remote web page.

Once the image is displayed on the page, you can:

- Move the image to a new position on the page simply by cutting and pasting.
- Change how the image appears on the page.
- Link from an image to another page.

**Displaying an image attached to the page**

There are several methods for attaching image files to a page.

Once you have attached an image to a page, there are different methods for choosing where on the page the image should appear:

**Using the 'Insert Image' dialog**

Once an image is attached to the page, you can edit the page to choose where the image should appear.
To position an attached image on the page:

1. While editing the page, position the cursor where you want to place the image.
2. Choose Insert > Image and choose the Attached Images tab.
3. Select the required image and choose Insert (or just double-click the image).

Using autocomplete

Once an image is attached to the page, you can use autocomplete while editing the page to choose where the image should appear.

To position an attached image on the page:

1. While editing the page, position the cursor where you want to place the image.
2. Trigger the autocomplete function by typing '!'.
3. Choose the image from the list that appears.

Using drag-and-drop

Depending on the browser you are using, you can attach and position an image in one step. While you are editing a page, simply drag-and-drop an image file on to the page. The image is attached to the page and is placed at the current cursor position.

Displaying an image attached to a different page

You can display an image that is attached to a different page of the same Confluence site, as long as you know the name of the image. This approach can make it easier to manage your images by allowing you to keep them all in the same place.

To display an image attached to a different page:

1. While editing the page, position the cursor where you want to place the image.
2. Choose Insert > Image and choose the Search tab.
3. Type in the name of the image.
4. Choose whether to search the current space or All Spaces and choose Search.
5. Select the required image from the search results and choose Insert.

Alternatively, you can simply cut and paste the image from another page.
Displaying an image from a remote web page

You can display an image from a remote web page on your Confluence page, without needing to attach it to your page. You need to know the URL for the image, not for the web page it appears on. Note that you should have permission to use that image on your page.

To display an image located on a web page:

1. While editing the page, position the cursor where you want to place the image.
2. Choose Insert > Image and choose From the Web.
3. Type in the URL for the image. An example is: `http://www.atlassian.com/software/confluence/images/icon_customerslove_big.png`
4. Choose Preview to check that the URL and image are correct.
5. Choose Insert.

Alternatively, you can simply cut and paste the image from a web page.

Controlling the image appearance

When editing the page, click the image to show the image properties panel. The panel allows you to set the display size for the image and choose whether the image has a border. See also Linking from an Image.

To set the size of the image, do one of the following:

- Choose one of the size 'preset' buttons (the image width in pixels is displayed to the left).
- Choose the image size text and enter a new image width in pixels (you can specify a size between 16px and 900px).

Note that images are displayed as thumbnails.

To add a border to the image:

- Choose Border in the image properties panel.

To add a hyperlink to the image:

- Choose Link in the image properties panel. For more detail, see Linking from an Image.

To align an image:

- Select the image and choose the paragraph alignment buttons on the editor toolbar.
- If you choose the left or right alignment, the text will wrap around the image. The text does not wrap for centre alignment.

To add border effects to an image:

- Choose Effects in the image properties panel and make a choice.
- **Note:** The Instant Camera effect only works with Latin character languages, due to a lack of handwriting style fonts in multi-byte languages.

To add a caption to an image:

- Choose Effects in the image properties panel and choose the Instant Camera image effect.
- Save the page.
- Choose Tools > Attachments to go to the 'Attachments' view of the page.
- Choose Properties next to the image file.
- Add a comment to the attachment. The text in your comment will appear as the image caption.

**Note:** You will need to re-do the comment each time you upload a new version of the image.

*Screenshot: The image properties panel beneath an image*
High Kicks!

Screenshot: Examples of image border effects

Add Image Effect

- None
- Taped
- Instant Camera
- Curl Shadow
- Snapshot
- Drop Shadow

Setting other image attributes

Certain attributes such as alt-text, title and other HTML parameters can still be set by using the **Insert > Wiki Markup** function from the editor toolbar, then using the syntax described in Confluence Wiki Markup.
Displaying a gallery of images

See the Gallery Macro.

Image file formats

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:

- gif
- jpeg
- png
- bmp (depending on browser support)

Deleting an Image

This page describes how to remove an image from a page. You may want to remove the image from the content of the page, but leave the image available in Confluence. Or you may want to remove the image from Confluence entirely.

Removing an image from the content of a page

A Confluence page can display one or more images, as described in Displaying Images.

To remove an image from the content of a page:

1. Edit the page.
2. Select the image. The image properties panel will appear, letting you know that the image is selected.
3. Press the Delete key on your keyboard.
4. Save the page.

The image will no longer appear as part of the page content. If the image file was originally uploaded as an attachment on the current page or another page, the image is still available in Confluence. If you want to remove the attachment, follow the steps below.

Removing an image attachment from Confluence

To remove an image file from Confluence, you must remove the attachment. See Deleting an Attachment.

Note: A page can display an image that is attached to another page. If you remove an image that is used on a page, readers will see an error message on that page.

Example error message that appears when image attachment is removed:

Unknown Attachment

Related pages:

- Displaying Images
- Working with Attachments
- Confluence User’s Guide

Working with Tables

Confluence pages can include multi-row and multi-column tables. You can highlight cells, rows and columns in different colours. When viewing the page, people can sort the table by clicking the column headers.

Inserting a table

To create a table:

1. While editing the page, place your cursor at the point where you want to insert the table.
2. Choose **Table** on the toolbar.
3. A dropdown menu will appear, showing a table with a variable number of rows and columns. Click in a cell to set the number of columns and rows for your table.
4. Add content and more rows and columns as needed. See below for guidelines on what you can do with your table in the editor.

**Screenshot: Inserting a table with 3 rows and 3 columns**

![Table with 3 rows and 3 columns](image)

**On this page:**
- Inserting a table
- What you can do with your table in the editor
- Shortcut keys
- Sorting the table in view mode

**Related pages:**
- Working with Page Layouts and Columns and Sections
- Using the Editor
- Confluence User's Guide

**What you can do with your table in the editor**

While editing a page, place your cursor inside a table to see the table toolbar.

![Table toolbar](image)

Using the table toolbar you can:

- Insert an empty row above the current one.
- Insert an empty row below the current one.
- Remove the current row.
- Cut the current row and copy it to the clipboard.
- Copy the current row to the clipboard.
- Paste the row from the clipboard to the current row.
- Insert an empty column to the left of the current one.
- Insert an empty column to the right of the current one.
- Remove the current column.
- Merge the selected cells.
- Split the selected merged cells.
- Mark a row as a table header. The cells in the row will be highlighted in grey and the text will be bold.
- Mark a column as a table header. The cells in the column will be highlighted in grey and the text will be bold.
- Highlight cells with a background colour.
Remove the table.

**Shortcut keys**

<table>
<thead>
<tr>
<th>Windows</th>
<th>Action</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Shift+c</td>
<td>Copy the current table row, or the selected rows.</td>
<td>Cmd+Shift+c</td>
</tr>
<tr>
<td>Ctrl+Shift+i</td>
<td>Insert a table. (Opens the Insert Table dialog.)</td>
<td>Cmd+Shift+i</td>
</tr>
<tr>
<td>Ctrl+Shift+v</td>
<td>Paste the table rows from your clipboard, placing them above the current row.</td>
<td>Cmd+Shift+v</td>
</tr>
<tr>
<td>Ctrl+Shift+x</td>
<td>Cut the current table row, or the selected rows.</td>
<td>Cmd+Shift+x</td>
</tr>
<tr>
<td>Alt+Up Arrow</td>
<td>Add a row above the current row.</td>
<td>Alt+Up Arrow</td>
</tr>
<tr>
<td>Alt+Down Arrow</td>
<td>Add a row below the current row.</td>
<td>Alt+Down Arrow</td>
</tr>
</tbody>
</table>

For more editor keyboard shortcuts, see [Keyboard Shortcuts](#).

**Sorting the table in view mode**

When readers view a table on a page, they can sort the table by clicking the sort icons in the header row.

*Screenshot: A colourful, sortable table*

Using Symbols, Emoticons and Special Characters

You can add various symbols and special characters to Confluence pages. You can also use them in other places that display content, such as blog posts, comments, the dashboard welcome message and the configuration panels offered by the Documentation theme.

**Inserting symbols and special characters**

To add a symbol to your page:

1. Edit the page.
2. Choose **Insert > Symbol**. This will display the 'Insert Custom Character' window.
3. Choose a symbol to insert it.
Inserting emoticons

There are two ways to add an emoticon, or smiley, to your page.

By choosing an emoticon from those available:

1. Choose Insert > Emoticon.
2. Choose an emoticon to insert it.

By typing a character combination:
You can insert emoticons by typing commonly-used character combinations. For example, the following code appears as an emoticon when the page is rendered.

`;)

The above example creates this emoticon: 😄

This table shows the emoticons (and other icons) available in Confluence, and the character combinations that create them:
**Preventing emoticons from appearing**

To undo the conversion of a character combination into an emoticon, press **Ctrl+Z** (Windows) or **Cmd+Z** (Mac).

To prevent Confluence from converting text to emoticons automatically, disable 'Autoformatting' in your user profile. See **Editing User Settings**.

The Confluence knowledge base has an article on disabling emoticons for the Confluence site as a whole.

**Using Autocomplete**

When using the Confluence editor, you can type a trigger character or press a **keyboard shortcut** to see a list of suggested links, files or macros to add to your page, or to mention another user (and automatically notify them of this).

**Summary of autocomplete**

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Trigger character</th>
<th>Keyboard shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a link on your page</td>
<td>[</td>
<td>Ctrl+Shift+K</td>
<td>See a list of suggested pages or other locations to link to from your page. <em>More</em>...</td>
</tr>
<tr>
<td>Display an image, video, audio file or document on your page</td>
<td>!</td>
<td>Ctrl+Shift+M</td>
<td>See a list of suggested images, multimedia files and documents to embed in your page. <em>More</em>...</td>
</tr>
<tr>
<td>Add a macro on your page</td>
<td>{}</td>
<td>None</td>
<td>See a list of suggestions as you begin typing a macro name. <em>More</em>...</td>
</tr>
<tr>
<td>Notify another user by email that you have mentioned them on your page</td>
<td>@</td>
<td>None</td>
<td>See a list of suggested users to mention. <em>More</em>...</td>
</tr>
</tbody>
</table>
Using autocomplete for links

Type '[', or press Ctrl+Shift+K, to see a list of suggested pages or other locations to link to from your page. You can link to pages, user profiles, images, documents and other file attachments.

To autocomplete a link:

1. Edit the page.
2. Click where you want to insert a link and do one of the following:
   - Type '[' and then the first few characters of the page title, user's name, image name or file name.
   - Type the first few characters of the page title, user's name, image name or file name (or select relevant text) and then press Ctrl+Shift+K.
3. Click the relevant link from the list of suggestions.

If the item you need is not in the list, either:

   - Choose Search for 'xxx' to continue looking for the page within Confluence, or
   - Choose Insert Web Link to insert a link to an external web page using the link browser.

Screenshot: Autocomplete for a link
Using autocomplete for images, videos, audio files and documents

You can use the autocomplete as a fast way of embedding images, videos, audio files and documents into your page. Type an exclamation mark or press Ctrl+Shift+M to see a list of suggested images, multimedia files and documents to display on your page. You can use autocomplete to embed the following file types:

- Images – any format that Confluence supports. See Displaying Images.
- Videos, audio files and all multimedia formats that Confluence supports. See Embedding Multimedia Content.
- Office documents supported by the Confluence Office Connector: Word, Excel and PowerPoint.
- PDF files.

Autocomplete works most efficiently for files that are already attached to the Confluence page. See Attaching Files to a Page.

To embed an image, video, audio file or document:

1. Edit the page.
2. Click where you want to insert the image, video, audio file or document and do one of the following:
   - Type ‘!’ and then the first few characters of the image, file or document name.
   - Type the first few characters of the name of the image, file or document (or select relevant text) and then press Ctrl+Shift+M.
3. Choose the relevant file from the list of suggestions.

If the item you need is not in the list, either:

- Choose Open Image Browser to find images and documents using the image browser, or
- Choose Insert Other Media to embed videos, audio and other multimedia files using the macro browser. Insert the ‘Multimedia’ macro to display your multimedia file.

Screenshot: Autocomplete for an image or document

Using autocomplete for macros

Type ‘{’ to see a list of suggested macros to add to your page.

Autocomplete provides access to all available macros in your Confluence site, including any user macros that your administrator has added and made visible to all.

You need to know the name of macro. Autocomplete for macros will only match the name of the macro, not the description.
To autocomplete a macro using '{':

1. Edit the page.
2. Click where you want to insert the macro.
3. Type '{' and then the first few characters of the macro name.
4. Choose the relevant macro from the list of suggestions.
5. Configure the macro by completing the form fields as prompted.

If the macro you need is not in the list, choose Open Macro Browser in the list of suggestions to continue looking for the macro in the macro browser. See Working with Macros.

Screenshot: Autocomplete for a macro

---

Using autocomplete for mentions

You can use autocomplete to automatically notify another Confluence user that you have mentioned them in a page, blog post, or comment. Type '@' and part of the person's name, to see a list of suggested users.

**Note:** Use the person's full name. Autocomplete will recognise users' full names only, not their usernames.

To mention someone using '@':

1. Edit the page.
2. Click where you want to insert a mention and type '@' and then the first few characters of the user's full name.
3. Choose the user's name from the list of suggestions.

Screenshot: Autocomplete for mentions

---

Cancelling autocomplete

The autocomplete starts automatically when you press the trigger characters. You may want to close the autocomplete menu or escape from autocomplete once it has started.

There are a few different ways to stop the autocomplete once it has started:
• Press the escape key, 'Esc', on your keyboard.
• Click somewhere else in the editor panel.
• Press an arrow key to move out of the autocomplete area.
• For the link autocomplete only: enter a right-hand square bracket, like this: ]

Enabling and disabling autocomplete

You can turn off the triggering of autocomplete by the '[' and '!' characters. This will prevent the autocomplete from starting automatically when you press one of the trigger characters. You can also turn it back on again.

Notes:

• This setting does not affect the keyboard shortcuts for autocomplete (Ctrl+Shift+K and Ctrl+Shift+M). Even if the trigger characters are disabled, you can still use the keyboard shortcuts for autocomplete.
• This setting affects only you. Other people using Confluence can enable or disable the setting on their user profiles independently.
• Note that autocomplete is enabled by default.

To enable or disable the autocomplete trigger characters:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Editor under 'Your Settings' in the left-hand panel.
3. Choose Edit.
4. Either:
   • Disable autocompletion by selecting Disable Autocomplete.
   • Enable autocompletion by clearing Disable Autocomplete.
5. Choose Submit.

Screenshot: User settings for the editor

Ignoring autocomplete

You can add macros, links and images by wiki markup alone. Type the macro, including its parameters and the closing curly bracket. Add a link, such as an anchor link, and end it with a square bracket. Insert an image or other embedded object, enclosed between exclamation marks. As soon as you close the macro, link, or embedded image, Confluence will convert it to rich text format and add it to the page.

More information about mouse-free macros, links and images:

• Quick Reference Guide for the Confluence Editor
Video

Working with Page Layouts and Columns and Sections

When you want to add structure to the information on your page, it is often useful to split the information into columns. By 'column', we mean a vertical block of content. You may want more than one column across the width of the page.

You may also want to use a common structure on a number of pages, so that readers know where to find the information within each page. In addition to columns, sections are useful here. By 'section', we mean an area of the page. A section may contain one or more columns.

Confluence provides the following ways of creating columns and sections on a page:

- Page layouts offer a set of predefined columns and sections.
- The Section and Column macros allow more flexibility. You can set the width of the columns, and put the sections and columns in any part of the page.

On this page:

- Using page layouts
- Using the Section and Column macros
- Code examples

Related pages:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Using the Editor
- Working with Macros
- Working with Tables

Using page layouts

The Confluence editor offers a set of predefined page layouts. Each layout provides one or more columns. Some layouts also provide a horizontal block at the top and bottom of the page. The layout that you select determines the position of the sections and columns on the page, as well as the relative width of the columns. The page’s content is confined within the borders of the layout. You cannot add content above or below the sections and columns provided by the layout.

To choose a page layout:

1. While editing the page, click the page layout icon. A dropdown list appears, showing icons that illustrate the available layouts.
2. Select a layout.

Screenshot: Choosing a page layout
If your page already has content on it, Confluence will put the existing content into the left-hand column of the new layout. If the page was using a different layout, Confluence will put the content into the appropriate sections and columns of the new layout.

Screenshot: A page with a three-column layout, in edit mode

Notes about page layouts

- **Very wide tables.** The width of each column is set to a percentage of the page width. The icons in the drop down menu indicate the relative widths for each layout. In most cases, Confluence will adapt the width of the columns to fit the width of the page. If a column includes a large table, the content may not fit into the width of the page. You will see a horizontal scroll bar when viewing the page.

- **Mixing and matching.** You can put Section and Column macros inside page layouts. You can also put tables inside page layouts.

Using the Section and Column macros

You can use the Section and Column macros to add a set of columns to the page. The Section macro defines an area that will contain the columns. You can have as many sections as you like. Within each section, you can have as many columns as you like.

To add a section and some columns to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find the Section macro, select it and insert it onto the page.
3. Choose Insert > Other Macros again.
4. Find and insert the Column macro.
5. Add your content to the column.
6. Insert as many columns as you like within the section.

Screenshot: A section and two columns in the editor

When you see the page in view mode, the above layout is displayed like this:

<table>
<thead>
<tr>
<th>Content for column 1 goes here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content for column 2 goes here</td>
</tr>
</tbody>
</table>

Macro parameters

Parameters are options that you can set to control the content or format of the macro output.

Parameters of the Section macro

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Border</td>
<td>false</td>
<td>Select this option to draw a border around the section and columns. Note: Without a Column macro, the border will not be displayed correctly.</td>
</tr>
</tbody>
</table>

Parameters of the Column macro

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Width</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>Specify the width of the column, in pixels (for example, 400px) or as a percentage of the available width (for example, 50%).</td>
</tr>
</tbody>
</table>

Notes about sections and columns
• All content within your section must be enclosed within a Column macro, otherwise the section layout will not work as expected.
• You can put tables inside columns.
• PDF exports do not handle page layouts. See this issue report: CONF-25240 - Authenticate to see issue details

**Code examples**

See:

- Confluence Wiki Markup for Macros -- Section macro
- Confluence Storage Format for Macros -- Section macro

**Working with Macros**

Using a macro, you can add extra functionality or include dynamic content on a page. For example, the Attachments macro will list a page's attachments in the page itself, so that readers do not have to visit the Attachments tab.

**Adding a Macro to your Page**

**Including Macros with the Macro Browser**

To add a macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Macro Parameters**

Many macros allow you to include optional parameters to control the macro's output.

With the Attachments Macro, for instance, you have two optional parameters allowing you to:

- Specify the file formats of the attachments displayed.
- Choose whether or not you want old versions of the attachments displayed.

**Macro Placeholders**

Macro placeholders are displayed in the editor where you have added a macro to the page.

When editing a page, you can:

- Double-click a macro placeholder (or click the placeholder and choose **Edit**) to open the macro dialog window, where you can edit the macro's parameters.
- Select a macro placeholder to cut, copy and paste the macro.
Macros Shipped with your Confluence Installation

When you download your Confluence installation file, many macros are shipped with the download. Below is a list of the macros currently shipped with Confluence. Click a macro name for details of the usage, including optional parameters and examples.

Activity Stream Macro

Anchor Macro

Allows you to link to a specific part of a page.

Attachments Macro

Displays a list of attachments on a given page.

Blog Posts Macro

Lists the most recent news items in the space.

Change-History Macro

Displays a history of updates made to a page.

Chart Macro

Displays a chart based on tabular data.

Cheese Macro

Displays the words "I like cheese!"

Children Display Macro

Displays the children and descendants of the current page.

Code Block Macro

Displays code in your document with the appropriate syntax highlighting.

Column Macro

Used with the Section macro to define columns on a page. See Working with page layouts and columns and sections.

Content by Label Macro

Displays a list of content associated with specific labels.

Content by User Macro

Displays a list of the content items that have been created by a specified Confluence user.

Content Report Table Macro

Displays a set of pages and blog posts in tabular format, based on the labels specified in the macro parameters.

Contributors Macro

Displays a list of Confluence users who have made a contribution of some type to a page.

Contributors Summary Macro
Displays a table of contribution-based statistics for a set of pages.

**Create Space Button Macro**

Displays a create space button linked to the create space page.

**Excerpt Include Macro**

Allows you to display an excerpt from another page within the current page.

**Excerpt Macro**

Define a part of a page as the page's 'excerpt' which can then be displayed in another page.

**Expand Macro**

Displays an expandable/collapsible section of text.

**Favourite Pages Macro**

Displays a list of your favourite pages.

**Gadget Macro**

Allows you to add Confluence gadgets to pages or blog posts.

**Gallery Macro**

Forms a thumbnail gallery of all images attached to a page.

**Global Reports Macro**

Displays a list of links to global reports within a table.

**HTML Include Macro**

Includes the content of an external HTML file into a Confluence page.

**HTML Macro**

Renders your specified HTML code within the current page.

**IM Presence Macro**

Displays graphically when a contact is online.

**Include Page Macro**

Inserts the contents of the specified page into the current one.

**Info Macro**

Displays a block of text in a blue highlight box.

**JUnit Report Macro**

Display a summary of JUnit test results.

**Labels List Macro**

Displays a hyperlinked alphabetical index of all labels within the current space.

**Livesearch Macro**

Add a dynamic search box to a wiki page.

**Loremipsum Macro**

Display a few paragraphs of pseudo-Latin text.

**Multimedia Macro**

Displays videos, animations and more, sourced from a file attached to a Confluence page and displayed on your
page.

**Navigation Map Macro**

Renders the list of pages associated with a specified label as a navigable map.

**Network Macro**

Displays a list of Network activity for users in your Confluence site.

**Noformat Macro**

Displays a block of text in monospace font.

**Note Macro**

Displays a block of text in a yellow highlight box.

**Page Index Macro**

Creates a hyperlinked alphabetical index of all page titles within the current space.

**Page Properties Macro**

Allows you to embed metadata into a page and then display that data in tabular form using the Page Properties Report macro. Previously known as the Metadata Details macro.

**Page Properties Report Macro**

Presents a tabulated summary of selected metadata, which has been embedded on pages using the Page Properties macro. Previously known as the Details Summary macro.

**Page Tree Macro**

Displays a dynamic, hierarchical list of pages starting from a specified parent (root) page.

**Page Tree Search Macro**

Adds a search box to your Confluence page and searches a hierarchy of pages starting from a specified parent (root) page.

**Panel Macro**

Displays a block of text within a fully customisable panel.

**Popular Labels Macro**

Displays the most popular labels used throughout your Confluence site or within a space.

**Profile Picture Macro**

Displays a user's profile picture on a page.

**Recently Updated Dashboard Macro**

Displays a list of the most recently changed content within Confluence and is intended for use on the Confluence dashboard.

**Recently Updated Macro**

Displays a list of recently changed content (pages, news items, comments, etc).

**Recently Used Labels Macro**

Lists labels most recently used in a specified scope (global, space, or personal)

**Related Labels Macro**

Lists labels frequently appearing on the same pages as the current page's labels.

**RSS Feed Macro**

Displays the contents of an RSS feed.

**Search Results Macro**

Searches Confluence, and includes the results in the page.

**Section Macro**
Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

**Space Attachments Macro**

Displays a list of attachments belonging to the current space.

**Space Details Macro**

Includes the summary of a Confluence space in the page.

**Space Jump Macro**

Allows you to link from a page in one space to a page with the same name in another space, without knowing the name of the page when you create the link.

**Spaces List Macro**

Displays a list of all spaces visible to the user.

**Status Macro**

Displays a coloured lozenge, useful for reporting project status.

**Table of Contents Macro**

Displays a table of contents from your page headings.

**Table of Content Zone Macro**

Displays a table of contents from a defined page 'zone'.

**Tasklist Macro**

Displays a dynamic task list which can be modified in 'view' mode.

**Tip Macro**

Displays a block of text in a green highlight box.

**User List Macro**

Displays a list of Confluence users, from an optional group.

**User Profile Macro**

Displays a short summary of any Confluence user's profile on your Confluence page or blog.

**User Status List Macro**

Displays a history of any Confluence user's status updates on your Confluence page or blog.

**View File Macro**

Embeds an Office document or PDF file into your Confluence page.

**Warning Macro**

Displays a block of text in a red highlight box.

**Widget Connector Macro**

Displays videos, slide shows, twitter chats, documents and more, sourced from other web sites and displayed on your Confluence page.

---

**Information about Other Macros**

Other macros are available as plugins or as user macros, and can be installed by your Confluence administrator. For example, macros that may be of interest are available from Adaptavist, CustomWare and the Confluence SharePoint Connector. Not applicable to Confluence OnDemand.

**Writing your own Macros**

To learn how to write your own macro, take a look at the following documentation:

- User macros are simple template-like macros that allow you to create simple formatting macros using the
Confluence web interface. Read more about Writing User Macros. Not applicable to Confluence OnDemand.

- The Confluence Plugin Guide tells you how to develop a plugin for Confluence.

**Code examples**

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Activity Stream Macro

The Activity Stream macro is a specific instance of the Gadget macro. It inserts an Activity Stream gadget onto your page. For instructions, see Activity Stream Gadget.

**Related pages:**

- Activity Stream Gadget
- Gadget Macro
- Confluence User’s Guide

Anchor Macro

The Anchor Macro is documented in Working with Anchors.

Attachments Macro

See Displaying a List of Attachments.

Blog Posts Macro

The Blog Posts macro allows you to display blog posts on a Confluence page. Clicking on a title takes you to the blog post.

**Using the Blog Posts Macro**

**To add the Blog Posts macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**On this page:**

- Using the Blog Posts Macro
- Parameters
- Code examples

**Related pages:**

- Working with Macros
- Working with Blog Posts
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User’s Guide

Parameters
Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Content Type to Display    | titles  | Available values:  
  - **titles** — Display only the title of each blog post.  
  - **excerpts** — Display a short excerpt from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post. |
| Time Frame                 | no limit| Specify how far back in time Confluence should look for the blog posts to be displayed.  
  Available values:  
  - m — Minutes  
  - h — Hours, so '12h' displays blog posts created in the last twelve hours.  
  - d — Days, so '7d' displays blog posts created in the last seven days.  
  - w — Weeks |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to these Labels</td>
<td>None</td>
<td>Filter the results by label. The macro will display only the blog posts which are tagged with the label(s) you specify here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify one or more label values, separated by a comma or a space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of <code>-badpage</code> you will get only content which is not labelled with 'badpage'.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of <code>+superpage,+goodpage</code> you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
<tr>
<td>Restrict to these Authors</td>
<td>None</td>
<td>Filter the results by author. The macro will display only the blog posts which are written by the author(s) you specify here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify one or more authors, separated by a comma. For example: <code>jsmith,jbrown</code></td>
</tr>
<tr>
<td>Restrict to these Spaces</td>
<td>@self, i.e. the space which contains the page on which the macro is coded</td>
<td>This parameter allows you to filter content by space. The macro will display only the pages which belong to the space(s) you specify here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can specify one or more space keys, separated by a comma or a space.</td>
</tr>
</tbody>
</table>
To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.

To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:

- @self — The current space.
- @personal — All personal spaces.
- @global — All site spaces.
- @favorite — The spaces you have marked as favourite.
- @favourite — The same as @favorite.
- @all — All spaces in your Confluence site.
- * — The same as @all above.

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.

| Maximum Number of Blog Posts | 15 | Specify the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied. |
| **Sort By** | **creation** | Specify how the results should be sorted. If this parameter is not specified, the sort order defaults to descending order (newest first) based on the creation date.

Values:
- **title** — Sort alphabetically by title.
- **creation** — Sort by the date on which the content was added.
- **modified** — Sort by the date on which the content was last updated. |

| **Reverse Sort** | **false** | Select to change the sort from descending to ascending order (oldest first). Use this parameter in conjunction with the **Sort By** parameter. This parameter is ignored if the **Sort By** parameter is not specified. |

**Code examples**

See:
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

**Change-History Macro**

The Change-History macro shows the history of updates made to a page: version number, author, date and comment. It displays the information inline.

**Screenshot: The Change-History macro in Confluence**

<table>
<thead>
<tr>
<th>This is the change history macro</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version</strong></td>
</tr>
<tr>
<td>Current Version (v. 4)</td>
</tr>
<tr>
<td>v. 3</td>
</tr>
<tr>
<td>v. 2</td>
</tr>
<tr>
<td>v. 1</td>
</tr>
</tbody>
</table>

**Related pages:**
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User’s Guide
To add the Change-History macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Note:** There are no parameters for this macro.

**Code examples**

See:

- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)

**Chart Macro**

The Chart macro allows you to display a chart based on tabular data. When you add the macro to a page, you:

- supply the data to be charted by the macro as a table in the placeholder of the macro.
- edit the macro parameters in the Macro Browser to configure the format of the chart.

**Screenshot 1: A table of data in the Chart macro placeholder**

<table>
<thead>
<tr>
<th>Weeks</th>
<th>Issues Burndown</th>
</tr>
</thead>
<tbody>
<tr>
<td>04/07/2011</td>
<td>81</td>
</tr>
<tr>
<td>11/07/2011</td>
<td>68</td>
</tr>
<tr>
<td>18/07/2011</td>
<td>67</td>
</tr>
<tr>
<td>25/07/2011</td>
<td>66</td>
</tr>
<tr>
<td>01/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>08/08/2011</td>
<td>65</td>
</tr>
<tr>
<td>15/08/2011</td>
<td>64</td>
</tr>
<tr>
<td>22/08/2011</td>
<td>44</td>
</tr>
<tr>
<td>29/08/2011</td>
<td>24</td>
</tr>
<tr>
<td>05/09/2011</td>
<td>0</td>
</tr>
</tbody>
</table>

**Screenshot 2: The resulting chart**

---

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Using the Chart Macro

To add the Chart macro to a page:

1. Edit the page and use autocomplete to add the Chart macro. (Type `{chart}`.)
2. Enter your chart data as one or more tables in the body of the macro placeholder. (See the screenshot above.)
3. Click the macro placeholder and choose Edit.
4. Select a chart type using the Type parameter (see below).
5. Choose other parameter settings in the macro browser, as described below.
6. Click Refresh in the ‘Preview’ area, to check that the chart appears as you expect.
7. Click Save to add the chart to your page.
8. Click Save again when you are ready to save the page.

Parameters

Chart Type Parameters | Display Control Parameters | Title and Label Parameters | Data Specification
Parameters | Colour Parameters | Axis Parameters | Pie Chart Parameters | Attachment Parameters

Chart Type Parameters

These parameters determine the type of chart to display and the way the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>pie</td>
<td>The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based (see the Time Series parameter).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Standard</strong> — pie, bar, line, area</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>XY Plots</strong> — xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Other</strong> — gantt (beta)</td>
</tr>
<tr>
<td><strong>Display Orientation</strong></td>
<td>vertical</td>
<td>Applies to area, bar and line charts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• vertical — y-axis is vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• horizontal — x-axis is vertical</td>
</tr>
<tr>
<td><strong>Show in 3D</strong></td>
<td>false</td>
<td>Applies to area, bar and line charts.</td>
</tr>
<tr>
<td><strong>Stacked Values</strong></td>
<td>false</td>
<td>Applies to area and bar charts.</td>
</tr>
<tr>
<td><strong>Show shapes</strong></td>
<td>true</td>
<td>Applies to line charts. Shapes are shown at each data point.</td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td></td>
<td>• 75 percent for 3D charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 50 percent for non-stacked area charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• 100 percent for all other charts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>A percentage value between 0 (transparent) and 100 (opaque) that determines how opaque the foreground areas and bars are.</td>
</tr>
</tbody>
</table>

Display Control Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Width</strong></td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Display rendered data</td>
<td>false</td>
<td>Sets whether to display the rendered body of the macro (usually the data tables). By default, the chart data table isn't rendered.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>before</strong> — the data are displayed before the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>after</strong> — the data are displayed after the chart.</td>
</tr>
<tr>
<td>Image format</td>
<td>png</td>
<td>The image format to be used for the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• png</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• jpg</td>
</tr>
</tbody>
</table>

**Title and Label Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chart Title</td>
<td>none</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>Chart Subtitle</td>
<td>none</td>
<td>A subtitle for the chart, using a smaller font than for <strong>Title</strong>.</td>
</tr>
<tr>
<td>Horizontal-axis Label</td>
<td>none</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>Vertical-axis Label</td>
<td>none</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
<td>Show a legend or key.</td>
</tr>
</tbody>
</table>

**Data Specification Parameters**

The data for the chart is taken from tables found when the macro body is rendered. These options control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. Additional conversion options can be specified using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tables</td>
<td>all first level tables</td>
<td>Comma separated list of table ids and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Columns</td>
<td>all columns</td>
<td>Comma separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the (html) title attribute for the column in the header row.</td>
</tr>
</tbody>
</table>
| Content Orientation| horizontal  | • **vertical** — data table columns will be interpreted as series.  
• **horizontal** — data tables rows will be interpreted as series. |
| Time Series        | false       | • true — the x values in an XY plot will be treated as time series data and so will be converted according to date formats. |
| Date format        | Confluence language defined date formats | For time series data, the date format allows for additional customization of the conversion of data to date values. If a **Date format** is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See [simple date format](#). |
| Time Period        | Day         | The time period for time series data. Defines the granularity of how the data is interpreted. Valid values are: **Millisecond**, **Second**, **Minute**, **Hour**, **Day**, **Week**, **Month**, **Quarter**, **Year**. |
| Language           | none        | Use in combination with the **Country** parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Valid values are 2 character ISO 639-1 alpha-2 codes. |
| Country            | none        | Use in combination with the **Language** parameter to form a locale. Valid values are 2 character ISO 3166 codes. |
Forgive | true | • true — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats.
• false — enforce strict data format. Data format errors will cause the chart to not be produced.

Colour Parameters
Colours are specified using hexadecimal notation or HTML colour names.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Colour</td>
<td>White</td>
<td>Background of the chart.</td>
</tr>
<tr>
<td>Border Colour</td>
<td>no border</td>
<td>Border around the chart.</td>
</tr>
<tr>
<td>Colours</td>
<td>Comma-separated list of colours used to customise category, sections, and series colours.</td>
<td></td>
</tr>
</tbody>
</table>

Axis Parameters
Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range Minimum Value</td>
<td>none</td>
<td>Range axis lower bound.</td>
</tr>
<tr>
<td>Range Maximum Value</td>
<td>none</td>
<td>Range axis upper bound.</td>
</tr>
<tr>
<td>Range Axis Tick Unit</td>
<td>none</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>Range Axis Label Angle</td>
<td>none</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>Domain Axis Lower Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the Date format parameter.</td>
</tr>
<tr>
<td>Domain Axis Upper Bound</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the Date format parameter.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Domain Axis Tick Unit</td>
<td>none</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the Time Period parameter. The Time Period unit can be overridden by specifying a trailing character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds), u (milliseconds).</td>
</tr>
<tr>
<td>Domain Axis Label Angle</td>
<td>none</td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
</tr>
<tr>
<td>Category Label Position</td>
<td>none</td>
<td>Placement of the axis label text for categories.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• up45 — 45 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• up90 — 90 degrees going upward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• down45 — 45 degrees going downward</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• down90 — 90 degrees going downward</td>
</tr>
<tr>
<td>Date Tick Mark Position</td>
<td>start</td>
<td>Placement of the date tick mark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• start — tick mark is at the start of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• middle — tick mark is in the middle of the date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• end — tick mark is at the end of the date period.</td>
</tr>
</tbody>
</table>

Pie Chart Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Pie Section Label**

Show only the pie section key value

Format for how pie section labels are displayed. The format uses a string with special replacement variables:

- `%0%` is replaced by the pie section key.
- `%1%` is replaced by the pie section numeric value.
- `%2%` is replaced by the pie section percent value.

Example 1: "%0% = %1%" would display something like "Independent = 20"

Example 2: "%0% (%2%)" would display something like "Independent (20%)"

**Pie Section Explode**

No exploded sections

Comma separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher.

**Attachment Parameters**

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access re-use the attachment. This can be useful especially when combined with the Cache Plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachment</td>
<td>none</td>
<td>The name and location with which the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>^attachmentName.png</code> — the chart is saved as an attachment to the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>page^attachmentName.png</code> — the chart is saved as an attachment to the page name provided.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>space:page^attachmentName.png</code> — the chart is saved as an attachment to the page name provided in the space indicated.</td>
</tr>
</tbody>
</table>
### Attachment Version
- **new**

Defines the versioning mechanism for saved charts.
- **new** — creates new version of the attachment.
- **replace** — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorized to remove attachments for the page specified.
- **keep** — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.

### Attachment Comment
- **none**

Comment used for a saved chart attachment.

### Thumbnail
- **false**

- **true** — the chart image attachment will be shown as a thumbnail.

---

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Fish Type</strong> 2011</td>
<td></td>
</tr>
<tr>
<td><strong>Chart Title</strong></td>
<td>Fish Sold 2011</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td><strong>Content Orientation</strong></td>
<td>vertical</td>
<td></td>
</tr>
</tbody>
</table>

---

**Fish Sold 2011**

- **Herring** 9,500
- **Salmon** 2,900
- **Tuna** 1,500

---

**Examples**

Pie Chart

- **Type**
- **Chart Title**
- **Show Legend**
- **Content Orientation**
## Bar Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Fish Type</strong></td>
<td><strong>Fish Sold</strong></td>
</tr>
<tr>
<td></td>
<td><em>Type</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Herrin g</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Salm on</em></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Tuna</em></td>
<td></td>
</tr>
<tr>
<td><strong>Chart Title</strong></td>
<td><strong>2010</strong></td>
<td><strong>2011</strong></td>
</tr>
<tr>
<td></td>
<td><strong>9,500</strong></td>
<td><strong>8,300</strong></td>
</tr>
<tr>
<td></td>
<td><strong>2,900</strong></td>
<td><strong>4,200</strong></td>
</tr>
<tr>
<td></td>
<td><strong>1,500</strong></td>
<td><strong>1,500</strong></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td><strong>true</strong></td>
<td></td>
</tr>
</tbody>
</table>

## 3D Bar Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Revenue</strong></td>
<td><strong>Expenses</strong></td>
</tr>
<tr>
<td></td>
<td><strong>2009</strong></td>
<td><strong>2010</strong></td>
</tr>
<tr>
<td></td>
<td><strong>12.4</strong></td>
<td><strong>11.8</strong></td>
</tr>
<tr>
<td></td>
<td><strong>43.6</strong></td>
<td><strong>41.8</strong></td>
</tr>
<tr>
<td><strong>Show in 3D</strong></td>
<td><strong>50</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td><strong>true</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td><strong>true</strong></td>
<td></td>
</tr>
</tbody>
</table>

## Time Series Chart

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Tables in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td><strong>Time Series</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Date Format</strong></td>
<td><strong>MM/yyyy</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Time Period</strong></td>
<td><strong>Month</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Month</strong></td>
<td><strong>Revenue</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Reven u e</strong></td>
<td><strong>Expenses</strong></td>
</tr>
<tr>
<td></td>
<td><strong>1/2011</strong></td>
<td><strong>31.8</strong></td>
</tr>
<tr>
<td></td>
<td><strong>1/2011</strong></td>
<td><strong>41.1</strong></td>
</tr>
</tbody>
</table>
XY Line Chart

<table>
<thead>
<tr>
<th>Content Orientation</th>
<th>vertical</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range Axis Lower Bound</td>
<td>0</td>
</tr>
<tr>
<td>Show Legend</td>
<td>true</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/2011</td>
<td>41.8</td>
</tr>
<tr>
<td>3/2011</td>
<td>51.3</td>
</tr>
<tr>
<td>4/2011</td>
<td>33.8</td>
</tr>
<tr>
<td>5/2011</td>
<td>27.6</td>
</tr>
<tr>
<td>6/2011</td>
<td>49.8</td>
</tr>
<tr>
<td>7/2011</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2011</td>
<td>77.3</td>
</tr>
<tr>
<td>9/2011</td>
<td>73.8</td>
</tr>
<tr>
<td>10/2011</td>
<td>97.6</td>
</tr>
<tr>
<td>11/2011</td>
<td>101.2</td>
</tr>
<tr>
<td>12/2011</td>
<td>113.7</td>
</tr>
</tbody>
</table>

XY Area Chart

<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>2/2011</td>
<td>43.8</td>
</tr>
<tr>
<td>3/2011</td>
<td>45.3</td>
</tr>
<tr>
<td>4/2011</td>
<td>45.0</td>
</tr>
<tr>
<td>5/2011</td>
<td>44.6</td>
</tr>
<tr>
<td>6/2011</td>
<td>43.8</td>
</tr>
<tr>
<td>7/2011</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2011</td>
<td>52.3</td>
</tr>
<tr>
<td>9/2011</td>
<td>53.8</td>
</tr>
<tr>
<td>10/2011</td>
<td>55.6</td>
</tr>
<tr>
<td>11/2011</td>
<td>61.2</td>
</tr>
<tr>
<td>12/2011</td>
<td>63.7</td>
</tr>
</tbody>
</table>
### Area Charts

#### Example 1

<table>
<thead>
<tr>
<th>Parameters in Macro Browser</th>
<th>Data Table in Macro Placeholder</th>
<th>Rendered Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>area</td>
<td></td>
</tr>
<tr>
<td><strong>Show Legend</strong></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>300</td>
<td></td>
</tr>
<tr>
<td><strong>Height</strong></td>
<td>300</td>
<td></td>
</tr>
<tr>
<td><strong>Opacity</strong></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td><strong>Revenue</strong></td>
<td>41. 1 31. 8 12. 4</td>
<td></td>
</tr>
<tr>
<td><strong>Expense</strong></td>
<td>31. 1 41. 8 43. 6</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th><strong>Revenue</strong></th>
<th><strong>Expense</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Very satisfied</strong></td>
<td>200 23 34</td>
<td>20 23 34 23</td>
</tr>
<tr>
<td><strong>Satisfied</strong></td>
<td>40 34 23</td>
<td></td>
</tr>
<tr>
<td><strong>Dissatisfied</strong></td>
<td>25 26 25</td>
<td></td>
</tr>
<tr>
<td><strong>Very dissatisfied</strong></td>
<td>15 17 18</td>
<td></td>
</tr>
</tbody>
</table>

---

Example 2
Parameters in Macro Browser | Data Table in Macro Placeholder | Rendered Chart
---|---|---
Type | area | ![](image)
Show Legend | true |  
Width | 300 |  
Height | 300 |  
Stacked Values | true |  

### Code examples

See:

- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)

#### Cheese Macro

The Cheese macro simply displays the words "I like cheese!" You can use this macro to test the Confluence macro functionality.

#### To add the Cheese macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

#### Speeding up macro entry with autocomplete:

Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

#### To edit an existing macro:

Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Note:** There are no parameters for this macro.
Children Display Macro

Use the Children Display macro to list the child pages of a page and the further descendants (children's children). By default, the macro displays links to the child pages as shown in the screenshot below. People viewing the page will see only the links for pages that they have permission to view.

Screenshot: The Children Display macro in Confluence

<table>
<thead>
<tr>
<th>This is the Children Display macro</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Step 1 - download the game</td>
</tr>
<tr>
<td>• Step 2 - Play</td>
</tr>
<tr>
<td>• Step 3 - share your favourite nerd</td>
</tr>
<tr>
<td>• Sample page</td>
</tr>
<tr>
<td>• Games as a communication medium</td>
</tr>
</tbody>
</table>

On this page:

• Using the Children Display macro
• Example
• Parameters
• Code examples

Related pages:

• Working with Pages
• Working with Macros
• Confluence Wiki Markup for Macros
• Confluence Storage Format for Macros
• Confluence User’s Guide

Using the Children Display macro

To add the Children Display macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Example

This list of child pages is generated by a Children Display macro on this page:

• Child Page 1
### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Show Descendants</strong></td>
<td>false</td>
<td>Choose whether to display all the parent page's descendants.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- If true shows the complete tree of pages underneath the parent page, regardless of <strong>Depth of Descendants</strong></td>
</tr>
<tr>
<td><strong>Parent Page</strong></td>
<td>current</td>
<td>Specify the page to display children for, from either the current space or a different space. Enter:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- '/ ' — to list the top-level pages of the current space, i.e. those without parents.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'pagename' — to list the children of the specified page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'spacekey:' — to list the top-level pages of the specified space.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 'spacekey:pagename' — to list the children of the specified page in the specified space.</td>
</tr>
<tr>
<td><strong>Number of Children</strong></td>
<td>none</td>
<td>Restrict the number of child pages that are displayed at the top level.</td>
</tr>
<tr>
<td><strong>Depth of Descendants</strong></td>
<td>none</td>
<td>Enter a number to specify the depth of descendants to display. This setting has no effect of <strong>Show Descendants</strong> is enabled.</td>
</tr>
<tr>
<td><strong>Heading Style</strong></td>
<td>none</td>
<td>Choose the style used to display descendants.</td>
</tr>
<tr>
<td><strong>Include Excerpts</strong></td>
<td>false</td>
<td>Display excerpts for the child pages, if they exist.</td>
</tr>
<tr>
<td><strong>Sort Children By</strong></td>
<td>Manual if manually ordered, otherwise alphabetical</td>
<td>Optional. Choose:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>creation</strong> — to sort by content creation date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>title</strong> — to sort alphabetically on title</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>modified</strong> — to sort of last modification date.</td>
</tr>
</tbody>
</table>
Reverse Sort | false | Use with the Sort Children By parameter. When set, the sort order changes from ascending to descending.

Code examples

See:
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Child Page 1

Grandchild

Child Page 2

This page is used to test the {children} macro.

Related Topics

Children Display Macro

Code Block Macro

The Code Block macro allows you to display source code in your document with the appropriate syntax highlighting. The code block displays on the page as shown below:

```java
public static void main(String[] args)
{
    System.out.println("Hello World!");
}
```

On this page:

- Using the Code Block Macro
- Parameters
- Code examples

Related pages:

- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Using the Code Block Macro

To add the Code Block macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

You can now type the code block directly into the macro placeholder in the editor. Note that any white space
contained in the placeholder is not manipulated in any way by the Code Block macro. This is to provide the writer with flexibility over code indentation.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Syntax highlighting  | java    | Specifies the language (or environment) for syntax highlighting. The default language is Java but you can choose from one of the following languages/environments:  
  - actionscript3  
  - bash  
  - csharp (C#)  
  - coldfusion  
  - cpp (C++)  
  - css  
  - delphi  
  - diff  
  - erlang  
  - groovy  
  - html/xml  
  - java  
  - javafx  
  - javascript  
  - none (no syntax highlighting)  
  - perl  
  - php  
  - powershell  
  - python  
  - ruby  
  - scala  
  - sql  
  - vb |
<p>| Title                | none    | Adds a title to the code block. If specified, the title will be displayed in a header row at the top of the code block. |
| Collapsible          | false   | If selected, the code macro's content will be collapsed upon visiting or refreshing the Confluence page. Clicking the expand and source link allows you to view this content. If false, the code macro's content is always displayed in full. |</p>
<table>
<thead>
<tr>
<th><strong>Show line numbers</strong></th>
<th>false</th>
<th>If selected, line numbers will be shown to the left of the lines of code.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>First line number</strong></td>
<td>1</td>
<td>When <strong>Show line numbers</strong> is selected, this value defines the number of the first line of code.</td>
</tr>
<tr>
<td><strong>Theme</strong></td>
<td>Default</td>
<td>Specifies the colour scheme used for displaying your code block. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is <strong>Confluence</strong> (also known as <strong>Default</strong>), which is typically black and coloured text on a blank background. However, you can also choose from one of the following other popular themes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DJango</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Emacs</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- FadeToGrey</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Midnight</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- RDark</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Eclipse</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Confluence</td>
</tr>
</tbody>
</table>

**Code examples**

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Using the Code Block Macro
- Parameters
- Code examples

**Column Macro**

Used with the Section macro to define columns on a page. See Working with page layouts and columns and sections.

**Content by Label Macro**

The Content by Label macro displays links to pages, blog posts and attachments that have been tagged with specific labels.

**A working example**

Below is a working example of the Content by Label macro, displaying content with the label 'LDAP'.

- Connecting to SSL services (JIRA 5.2)
  - ssl ldap smtp imap
- User Management Limitations and Recommendations (JIRA 5.2)
Using the Content by Label Macro

To add the Content by Label macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| **Label(s)** | None | Filter by label(s). The macro will display only the content tagged with the label(s) specified here. See also the **Operator** parameter below. 
This parameter is required. Specify one or more labels, separated by a comma or a single space. 

- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `-badpage` you will get only content which is not labelled with 'badpage'.
- To indicate that the results *must* match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `+superpage,+goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |
| **Author(s)** | None | Filter by author. The macro will display only the content created or updated by the author(s) specified here. 
Specify one or more authors, separated by a comma. For example: jsmith, jbrown |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include this Content Type Only</td>
<td>all</td>
<td>Filter by content type. The macro will display only the content of the type specified here.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specify one or more content types, separated by a comma or a space. To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of <code>-blogpost</code> you will get pages and all other content except for blog posts. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>page</code> – Pages.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>blogpost</code> or <code>news</code> – Blog posts, also known as news items.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>attachment</code> – Attachments</td>
</tr>
<tr>
<td>Show Labels for Each Page</td>
<td>true</td>
<td>Show or hide labels in the results.</td>
</tr>
<tr>
<td>Show Space Name for Each Page</td>
<td>true</td>
<td>Show or hide spaces in the results.</td>
</tr>
<tr>
<td>List Title</td>
<td>None</td>
<td>Add a title or heading to the list.</td>
</tr>
<tr>
<td>Maximum Number of Pages</td>
<td>15</td>
<td>Limit the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied.</td>
</tr>
<tr>
<td>Display Excerpts</td>
<td>false</td>
<td>Include excerpts from each page listed. Note that you must have defined excerpts on each of those pages, by adding the <code>excerpt macro</code> to the page. Only the first few lines of the excerpt for each page are displayed.</td>
</tr>
</tbody>
</table>
Restrict to these Spaces | @all

Filter by space. The macro will display only the content which belongs to the space(s) specified here.

Specify one or more space keys, separated by a comma or a space.

- To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of `-BADSPACE` you will get only content which is not in the BADSPACE.

- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of `+GOODSPACE` you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
- @self — The current space.
- @personal — All personal spaces.
- @global — All site spaces.
- @favorite — The spaces you have marked as favourite.
- @favourite — The same as @favorite above.
- @all — All spaces in your Confluence site.
- * — The same as @all above.

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.
### Operator

<table>
<thead>
<tr>
<th>Operator</th>
<th>OR</th>
</tr>
</thead>
</table>

The operator to apply when matching content against the labels specified in the **Label(s)** parameter:

- **OR** – Display content with *any* of the non-prefixed labels.
- **AND** – Display content with *all* of the specified non-prefixed labels.

**Note** that this parameter only modifies the behaviour of the **Label(s)** parameter and only affects label values without a plus (+) or minus (-) sign prefix.

### Sort By

<table>
<thead>
<tr>
<th>Sort By</th>
<th>modified</th>
</tr>
</thead>
</table>

Specify how the results should be sorted.

**Values:**

- **title** — Sort alphabetically by title.
- **creation** — Sort by the date on which the content was added.
- **modified** — Sort by the date on which the content was last updated.

**Note:** If this parameter is not specified, the sort order defaults to descending, based on the last modification date (latest first). To change the sort order from ascending to descending, use the **Reverse Sort** parameter.

### Reverse Sort

<table>
<thead>
<tr>
<th>Reverse Sort</th>
<th>false</th>
</tr>
</thead>
</table>

Select **Reverse Sort** to change the sort from descending to ascending. Use this parameter in conjunction with the **Sort By** parameter. **Reverse Sort** is ignored if **Sort By** is not specified.

---

**Code examples**

See:

- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)

Content by User Macro
The Content by User macro generates a tabulated list of the content items, throughout the Confluence installation, that have been created by a specified Confluence user. The list includes all current pages, comments and spaces created by the user. Each item in the table is linked to its corresponding page, page comment or space dashboard.

Note that items for page comments contain a link to the page, followed by a second link to the comment itself, with these separated by a greater-than sign (>).

Using the Content by User macro

To add the Content by User macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type \ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The Confluence username for a person who has created content.</td>
</tr>
</tbody>
</table>

### Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

### Content Report Table Macro

The Content Report Table macro displays a set of pages and blog posts in tabular format, based on the labels specified in the macro parameters.

### A working example

Below is a working example of the Content Report Table macro, displaying content with the label 'LDAP'.

<table>
<thead>
<tr>
<th>Title</th>
<th>Creator</th>
<th>Modified</th>
</tr>
</thead>
</table>

---

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
On this page:

- A working example
- Using the Content Report Table Macro
- Parameters
- Code examples

Related pages:

- Related Labels Macro
- Content by Label Macro
- Working with Confluence Labels
- Working with Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Using the Content Report Table Macro

To add the Content Report Table macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of
suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label(s)</td>
<td>None</td>
<td>This parameter is required. Specify one or more labels, separated by a comma. The macro will display only the content tagged with the label(s) specified here.</td>
</tr>
<tr>
<td>Space(s)</td>
<td>(All spaces)</td>
<td>Specify one or more space keys, separated by a comma or a space. The macro will display only the content which belongs to the space(s) specified here. When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~<a href="mailto:jbloggs@example.com">jbloggs@example.com</a>.</td>
</tr>
</tbody>
</table>

Code examples

See Confluence Storage Format for Macros.

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.

Contributors Macro

The Contributors macro displays a list of Confluence users who have made a contribution of some type to a page. It can also be used to list watchers of the page.

The scope of this macro can be extended to include the immediate children or descendants of the specified page. The list of contributors can be based on people who have:

- authored or edited the page(s)
- contributed comments or added labels to the page(s), or
- are simply watching the page(s).

Screenshot: Example list of Contributors

```
This is the Contributors macro

- Rach Admin
- Josh User
- Sophie Staunton
```

In this example, the Display Format parameter has been set to list.
Using the Contributors Macro

To add the Contributors macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Contribution Type  | authors | Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:  
  - authors - includes people who created or have edited the page(s)  
  - comments - includes people who have added comments to the page(s)  
  - labels - includes people who have added labels to the page(s)  
  - watches - includes people who are watching the page(s).  
You can specify one or more contribution types, separated by commas. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sort By</strong></td>
<td>count</td>
<td>Specifies the criteria used to sort contributors. Sort criteria are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>count</strong> - sorts people based on the total number of contributions to the page(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>name</strong> - sorts people into alphabetical order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>update</strong> - sorts people based on the date of their last contribution to the page(s).</td>
</tr>
<tr>
<td><strong>Reverse Sort</strong></td>
<td>false</td>
<td>Reverses the sort order of contributors in the list. Must be used in conjunction with the <strong>Sort By</strong> parameter.</td>
</tr>
<tr>
<td><strong>Maximum Number of Contributors</strong></td>
<td>no limit</td>
<td>Limits the number of contributors in the list. If a number is not specified, all contributors are included.</td>
</tr>
<tr>
<td><strong>Display Format</strong></td>
<td>inline</td>
<td>Sets how the list of contributor's names is formatted:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>inline</strong> — a comma-separated list</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>list</strong> — a bullet list</td>
</tr>
<tr>
<td><strong>Show Anonymous Contributions?</strong></td>
<td>false</td>
<td>Sets whether to include those who contributed anonymously to a page.</td>
</tr>
<tr>
<td><strong>Show Count?</strong></td>
<td>false</td>
<td>Sets whether to show the number of times each person made a contribution of the specified Contribution Type.</td>
</tr>
<tr>
<td><strong>Show Last Contribution Time?</strong></td>
<td>false</td>
<td>Sets whether to show the last time each person made a contribution of the specified Contribution Type.</td>
</tr>
<tr>
<td><strong>Page Name</strong></td>
<td>current</td>
<td>Specifies the page to use when generating the list of contributors. If <strong>Page Name</strong> and <strong>Space(s)</strong> are left blank, the current page is assumed.</td>
</tr>
<tr>
<td><strong>Label(s)</strong></td>
<td>none</td>
<td>Filters the list of contributors to those who created the specified labels from a page. You can specify one or more labels, separated by commas.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Space(s)          | current             | Specifies the space key of the Confluence space that contains the page set in Page Name or alternatively, specifies the spaces to search. Space keys are case-sensitive. This parameter also takes special values, including:  
  - @global — All site spaces.  
  - @personal — All personal spaces.  
  - @all — All spaces in your Confluence site.  
  You can specify one or more space keys or special values, separated by commas.  
  If no Page Name and Label(s) are specified, all pages from the specified set of spaces are included. |
| Content Type      | both pages and blog posts | Restricts the content type to use when generating the list of contributors:  
  - pages — pages  
  - blogposts — blog posts. |
| Blog Post Date    | none                | Specifies the publish date for a blog post. The date format required is: YYYY/MM/DD. |
| Include Page Hierarchy | specified page only | Specifies additional pages to include when generating the list of contributors:  
  - children — just the child pages of the specified page  
  - descendants — all descendants of the specified page. |
| Show Selected Pages | false                | Sets whether to show a list of the pages used to generate the list of contributors. |
| Custom "None Found" Message | default message | Specifies the message to be used to override the default message that is displayed when no contributors are found. |
Contributors Summary Macro

The Contributors Summary macro displays a table of contribution-based statistics for a set of pages. These statistics can be grouped according to individual pages or individual contributors.

The default scope for this macro is an individual page, but this can be extended to include the immediate children or descendants of a specified page. The statistics cover the following types of contributions:

- edits to the page(s)
- comments added to the page(s)
- labels added to the page(s)
- people watching the page(s)

A simple example of the Contributors Summary macro is shown in the screenshot below. It lists statistics for the number of times each contributor has edited, added comments and added labels to this page.

**Screenshot: Example Contributors Summary table of statistics**

<table>
<thead>
<tr>
<th>User</th>
<th>Edits</th>
<th>Comments</th>
<th>Labels</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sarah Maddox</td>
<td>2</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>Edwin Dawson</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Giles Gaskell</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Rosie Jameson</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Andrew Lui</td>
<td>2</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Charles Miller</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Andrew Prentice</td>
<td>0</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

In this example, all default parameter settings are used. For more information about this macro's parameters, refer to the Parameters section below.

**Using the Contributors Summary Macro**

**To add the Contributors Summary macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros.**
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group By</strong></td>
<td>contributors</td>
<td>Specifies the basis for grouping contribution-based statistics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>contributors</strong> — group by the people who have contributed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>pages</strong> — group by the pages used to find contributors.</td>
</tr>
<tr>
<td><strong>Columns to Display</strong></td>
<td>edits, comments, labels</td>
<td>Sets the columns that should appear in the table. The statistics or type of information presented depends on the basis for grouping set with the <strong>Group By</strong> parameter. Statistics may be calculated for:</td>
</tr>
</tbody>
</table>
- **edits** — the number of times each contributor has edited the page(s) or the number of edits made to each page.
- **edited** — a list of the pages edited by each contributor or a list of contributors who have edited each page.
- **comments** — the number of times each contributor has added comments to the page(s) or the number of comments on each page.
- **commented** — a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
- **labels** — the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- **labeled** — a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- **labellist** — a list of labels either added by each contributor or on each page.
- **watches** — the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
- **watching** — a list of pages being watched by each contributor/person or a list of contributors/people watching each page.
- **lastupdate** — the last time each contributor made an update or when each page was last updated. Valid updates can include edit, comment or label modifications to a page.

One or more columns can be used.
<table>
<thead>
<tr>
<th>Column</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sort By             | edits  | Sets the criterion used for sorting items in the table. The items sorted depend on the basis for grouping set with the Group By parameter. Sort criteria are:  
|                     |        | - `edits` — sorts items in the table based on the total number of edits made, either by a contributor or to a page.  
|                     |        | - `name` — sorts items in the table in alphabetical order, either by contributor or page name.  
|                     |        | - `editTime` — sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.  
|                     |        | - `update` — sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it.  
| Reverse Sort        | false  | Reverses the sort order of items in the table, as specified using the Sort By parameter. (Used only in conjunction with the Sort By parameter.)  
| Maximum Number of Items | no limit | Limits the number of contributors or pages in the table to the value specified. If no number is specified, all items are included.  
| Show Anonymous Contributions? | false | Includes individuals who have made anonymous contributions to a page.  
| Show Zero Counts?   | false  | Sets whether contributors or pages are included for which a calculated statistic is zero.  
| Page Name           | current | Sets the page for which to calculate the contribution-based statistics. If no values for Page Name and Space(s) are specified, the current page is assumed.  

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
| **Label(s)** | none | Restricts the contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas. |
| **Space(s)** | current | Specifies the space key of the Confluence space which contains the specified page name or alternatively, specifies a scope of spaces to search. Space keys are case-sensitive. This parameter also takes special values, including:  
  - @global — All site spaces.  
  - @personal — All personal spaces.  
  - @all — All spaces in your Confluence site. You can specify one or more space keys or special values, separated by commas.  
  If no Page Name and Label(s) are specified, all pages from the specified set of spaces are included. |
| **Content Type** | both pages and blog posts | Restricts page types to either pages (pages) or blog posts (blog posts). If no value is specified in the Macro Browser, both pages and blog posts are included. |
| **Blog Post Date** | none | Specifies the publish date for a blog post. The date format required is: YYYY/MM/DD. |
| **Include Page Hierarchy** | specified page only | Includes either the immediate children or all descendants of the specified page. If no value is indicated in the Macro Browser, only the specified page is included. |

**Code examples**

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Create Space Button Macro
The Create Space Button macro displays a create space icon that links to the 'Create Space' page. To see this icon, viewers need the 'Create Space' permission which is assigned by a site administrator.

Screenshot: The 'create space' button in Confluence

Using the Create Space Button macro

To add the Create Space Button macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icon Size</td>
<td>large</td>
<td>Specify whether to use large or small icon. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• large</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• small</td>
</tr>
</tbody>
</table>

### Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Excerpt Include Macro

The Excerpt Include macro is used to display 'excerpted' (that is, a segment of) content from one page in another.

Before you can use this macro, the excerpt must have been defined using the Excerpt macro. Note that you can have more than one Excerpt Include macro on a page (although you can have only one Excerpt macro on a page).
Example

The paragraph below shows an example of an Excerpt Include macro, containing content from an excerpt which we have defined on the Excerpt Macro page. On the Excerpt Include macro below, we have set the options to show both the title of the page and the panel surrounding the content.

<table>
<thead>
<tr>
<th>Excerpt Macro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define a part of a page as the page's 'excerpt' which can then be displayed in another page.</td>
</tr>
</tbody>
</table>

On this page:
- Example
- Using the Excerpt Include Macro
- Parameters
- Code examples

Related pages:
- Excerpt Macro
- Page Properties Macro
- Working with Macros
- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros
- Confluence User's Guide

Using the Excerpt Include Macro

To add the Excerpt Include macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type ` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Page Containing the Excerpt</strong></td>
<td>none</td>
<td>Type the name of the page that contains the excerpt to be displayed. You can use an excerpt from a page in the same space or another space in the same wiki. When you type the name of the page into the Excerpt Include macro dialog, Confluence will offer a list of matching pages, including those from other spaces. Alternatively, you can type the space key followed by a colon (:) and the page name, like this:</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Remove Surrounding Panel</strong></td>
<td>false</td>
<td>Determines whether Confluence will display a panel around the excerpted content. The panel includes the title of the page containing the excerpt, and the border of the panel. By default, the panel and title are shown.</td>
</tr>
</tbody>
</table>

**Code examples**

**See:**

- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros

**Excerpt Macro**

The Excerpt macro is used to mark a part of a page's content for re-use. Defining an excerpt enables other macros, such as the Excerpt Include and Blog Posts macros, to display the marked content elsewhere.

You can only define one excerpt per page. In other words, you can only add the Excerpt macro once to a page.

**On this page:**

- Using the Excerpt Macro
- Parameters
- Code examples

**Related pages:**

- Excerpt Include Macro
- Working with Macros
- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros
- Confluence User's Guide

**Using the Excerpt Macro**

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
To add the Excerpt macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**To add reusable content to the macro:**

1. Add your content inside the Excerpt macro placeholder.
2. Choose the macro placeholder to see the options panel, and select the option to **Display on new line** or **Display inline**. The default is to display the content of the macro on a new line. If you choose the inline option, the content of the macro will form part of the same paragraph as the text preceding and following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.

**Screenshot: The Excerpt macro placeholder and options panel**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Excerpted Content</td>
<td>false</td>
<td>Controls whether the page content contained in the Excerpt macro placeholder is displayed on the page.</td>
</tr>
</tbody>
</table>

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

**Code examples**

See:

- [Confluence Storage Format for Macros](#)
- [Confluence Wiki Markup for Macros](#)

**Expand Macro**

The Expand macro displays an expandable/collapsible section of text on your page.

Here is an example:

> Click here to expand...

  This text is hidden until you expand the section.
Using the Expand Macro

To insert the Expand macro into a page using the macro browser:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Click here to expand...</td>
<td>Defines the text that appears next to the expand/collapse icon.</td>
</tr>
</tbody>
</table>

### Code examples

See:

- [Confluence Wiki Markup for Macros](#)
- [Confluence Storage Format for Macros](#)

### Notes

- **Text is expanded in PDF and HTML exports.** When you export the page to PDF or HTML, the text between the macro tags is expanded so that readers can see it in the PDF and HTML versions of the page.
- **Nesting your Expand macros.** You can put one Expand macro inside another, and Confluence will correctly show and hide the contents of all Expand macros, including the nested ones.

**Favourite Pages Macro**

Use the Favourite Pages macro to display a list of your favourite pages.

The output of the Favourite Pages macro appears as in the following screenshot.

**Screenshot: The Favourite Pages Macro in Confluence**
Using the Favourite Pages Macro

To insert the favourite pages macro into a page using the Macro Browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

**Code examples**

See:

- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros

**Gadget Macro**

Gadgets are small applications that can offer dynamic content. They are typically served from a web application server and can be re-used in many other web applications. In Confluence, use the Gadget macro to add gadgets to pages or blog posts.

Confluence comes bundled with a few of its own gadgets that you can add to your pages or blog posts. The Confluence gadgets are listed in Confluence Gadgets. However, you can access additional gadgets in this list if your Confluence Administrator has:

- Installed additional gadgets in Confluence (typically as a Confluence plugin) or
- Registered gadgets served from an external web application or website (such as those from a JIRA installation or iGoogle).

Unlike other macros, the name of each gadget macro is unique and follows the convention "<gadget-name> macro", where <gadget-name> is the name supplied by the gadget itself.
Inserting gadgets into a Confluence page or blog post

To add a gadget to a page:

1. Edit your page or blog post.
2. Choose Insert > Other Macros.
3. Click External Content to see a list of gadgets configured for use in your Confluence installation. (Some Confluence macros like the JIRA Issues, RSS Feed, Tasklist and Widget Connector macros also appear in this category because they can also access external content.)
4. Click the desired gadget to access its parameters and properties.
   Almost all gadgets allow you to set basic parameters (listed below), which appear on the right of the macro dialog. Each gadget may also have its own set of parameters, which appear on the left of the macro dialog.
5. Set the parameters to your requirements.
6. Click Refresh to preview your changes.
7. Click Insert to add the gadget to the page.

Editing gadgets on a Confluence page or blog post

To edit an existing gadget on a page or blog post:

1. Edit your page or blog post.
2. Click the Gadget macro placeholder and choose Edit (or double-click the placeholder).
3. Set the gadget's parameters to your requirements.
4. Click Refresh to preview your changes.
5. Save the gadget.

Standard gadget parameters

Almost all gadgets allow you to set basic parameters (listed below), which appear on the right of the macro dialog. Each gadget may also have its own set of parameters, which appear on the left of the macro dialog.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Related pages:

- The big list of Atlassian gadgets
- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros
- Confluence User's Guide
Width | 450 pixels | Set the width of the gadget, using one of the following conventions:
- Width in pixels, using px or plain numbers. For example, 500px or 500
- A percentage of the page width, using %. For example, 50%
- Automatic resizing of the gadget to fit 100% of the page width: auto

Border | true | Places a thin grey border around the gadget.

Contents of a Gadget macro

In the addition to the standard parameters, the gadget macro contains 'parameter-like' content, which represents specific property settings that are particular to each gadget. Hence they are not documented here. Typically, this content would only be changed by customising the gadget's default properties using the macro browser.

Code examples

See:
- Confluence Storage Format for Macros
- Confluence Wiki Markup for Macros

Gallery Macro

The Gallery macro displays a collection of thumbnail images in a table, based on the images attached to a Confluence page. When viewing the page, a user can click a thumbnail image to zoom into a screen-sized image and then view the images as a slide show.

Overview:

- The images shown in the gallery are taken from the files attached to the Confluence page. You can also specify a different page where the attachments are located. For information about attaching images to a page, see Attaching Files to a Page.
- The captions below the images are drawn from the comments on the attachments. For information about adding comments to attachments, see Attaching Files to a Page.
- By default, the gallery will include all the images attached to the page. You can also exclude or include images using parameters.
- You can sort your images into a particular order.
- You can specify a title for the gallery and also configure how many columns you want for the table in which your images are displayed.
On this page:
- Using the Gallery macro
- Parameters
- Image file formats
- Code examples

Related pages:
- Displaying Images
- Attaching Files to a Page
- Editing Attachment Properties
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

Illustration: Live example of the Gallery macro

Some office photos, and a waterfall
Using the Gallery macro

To insert the Gallery macro onto a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

The full list of parameters is shown in the following table. If the name of an attached file or page contains a comma, you can refer to it in the relevant parameters below by enclosing it in single or double quotes, for example "this,that.jpg", theother.png

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gallery Title</td>
<td>Nothing</td>
<td>Specify a title for your gallery.</td>
</tr>
<tr>
<td>Number of Columns</td>
<td>4</td>
<td>Specify the number of columns for your table.</td>
</tr>
<tr>
<td>Images to Exclude</td>
<td>No exclusions. Include all the pictures on the page.</td>
<td>The gallery will ignore any pictures specified. You can specify more than one picture, separated by commas. Note: The filename and filetype for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Include these Images Only</td>
<td>Include all the pictures on the page.</td>
<td>If you specifically include one or more pictures, the gallery will show only those pictures. You can specify more than one picture, separated by commas. Note: The filename and filetype for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.</td>
</tr>
<tr>
<td>Exclude Images with these Labels</td>
<td>No exclusions. Include all the pictures on the page.</td>
<td>The gallery will ignore any pictures that have the specified label. You can specify more than one label, separated by commas. For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>Include Images with these Labels Only</td>
<td>None. The images are not filtered by label.</td>
<td>Filters the images to display, based on a list of labels. If you wish to enter more than one label, separate the labels with commas. Confluence will show only images that have all the labels specified. (The match is an AND, not an OR.) For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>Use Images in these Pages</td>
<td>If no page is specified, the gallery macro displays the images attached to the page on which the macro is used.</td>
<td>Specify the title of the page which contains the images you want displayed. You can specify more than one page name, separated by commas. To specify a page in a different space, use the following syntax: SPACEKEY:Page Title</td>
</tr>
</tbody>
</table>
| Sort Images By                    | None. The sort order is unspecified and therefore unpredictable.          | Specify an attribute to sort the images by. Sort order is ascending, unless you select the Reverse Sort parameter (see below). Options are:  
  * name – file name.  
  * comment – comment linked to the attached file.  
  * date – date/time last modified.  
  * size – size of the attached file.  |
| Reverse Sort                      | Off. Sort order is ascending                                              | Used in combination with the Sort Images By parameter above. Use Reverse Sort to reverse the sort order, from ascending to descending. |
Image file formats

You can attach image files of any format to a page. Confluence supports the following image formats in the Gallery macro and when displaying an image on a page:

- gif
- jpeg
- png
- bmp (depending on browser support)

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Global Reports Macro

The Global Reports macro displays a list of links to some reports about content on your site.

These reports include a list of new or updated pages, orphan pages, undefined pages, and RSS feeds for new pages and blog posts.

Screenshot: The Global Reports macro

Related pages:

- Subscribing to RSS Feeds within Confluence
- Working with Macros
- Confluence User’s Guide

Using the Global Reports Macro

To add the Global Reports macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence 5.0 Documentation

| Width of Table | 99% | Specify the width of the table in which the links are displayed, as a percentage of the window width. |

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

HTML Include Macro

The HTML Include macro allows you to include the contents of an external HTML file in a Confluence page.

⚠️ **CAUTION: Including unknown HTML inside a webpage is dangerous.**

HTML can contain active scripting components. This means that it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user’s authentication cookie and give the attacker their Confluence login password.

Using the HTML Include Macro

To insert the HTML Include macro into a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

To edit an existing macro: Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Related pages:**

- HTML Macro
- Working with Macros
- Configuring a URL Whitelist for Macros
- Confluence User’s Guide

⚠️ **The information on this page does not apply to Confluence OnDemand.**

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML Page’s URL</td>
<td>None</td>
<td>The URL of the page to include.</td>
</tr>
</tbody>
</table>

Troubleshooting

- The HTML Include macro will only be available if it has been **enabled** by your Confluence administrator. Also, your Confluence Administrator can define a **whitelist of trusted URLs**. You will see an error message on the Confluence page if the included URL is not in the whitelist.
- You can only use the HTML Include macro for pages with absolute links. If you use the macro to include an HTML page that has relative links, navigating those links in the wiki results in a ‘Page Not Found’ error.
Code examples

See:  
- Confluence Wiki Markup for Macros  
- Confluence Storage Format for Macros

HTML Macro

The HTML macro allows you to add HTML code to a Confluence page.

Note that the HTML macro will only be available if it has been enabled by your System Administrator.

Using the HTML Macro

To add the HTML macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.  
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

There are no parameters for this macro.

Enter the HTML code into the body of the macro placeholder.

Related pages:

- HTML Include Macro  
- Working with Macros  
- Enabling HTML macros  
- Confluence User's Guide

The information on this page does not apply to Confluence OnDemand.

Code examples

See:  
- Confluence Wiki Markup for Macros  
- Confluence Storage Format for Macros

IM Presence Macro

The IM Presence macro indicates graphically when a contact is signed into an Instant Messaging (IM) service.

The IM Presence macro appears as a small icon on the page, like this image: [Online Now](https://example.com).

Using the IM Presence Macro

To add the IM Presence macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.  
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.
To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID/Screen Name</td>
<td>Identify the user by their ID, account name or screen name.</td>
</tr>
<tr>
<td>Service</td>
<td>aim – AOL Instant Messenger</td>
</tr>
<tr>
<td></td>
<td>gtalk – Google Talk</td>
</tr>
<tr>
<td></td>
<td>icq – ICQ</td>
</tr>
<tr>
<td></td>
<td>jabber – Jabber</td>
</tr>
<tr>
<td></td>
<td>msn – MSN Instant Messenger</td>
</tr>
<tr>
<td></td>
<td>sametime – IBM Lotus Sametime</td>
</tr>
<tr>
<td></td>
<td>skype – Skype</td>
</tr>
<tr>
<td></td>
<td>skypeme – Skype</td>
</tr>
<tr>
<td></td>
<td>wildfire – Openfire Server</td>
</tr>
<tr>
<td></td>
<td>yahoo – Yahoo! Messenger</td>
</tr>
<tr>
<td>Show User ID</td>
<td>Shows or hides the User ID of the contact.</td>
</tr>
</tbody>
</table>

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Related Topics

- Working with Macros
- Confluence User's Guide

Include Page Macro

You can use the Include Page macro to display the contents of one Confluence page or blog post in another page or blog post.

Using the Include Page Macro

To add the Include Page macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open,
where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page to Include</td>
<td>None</td>
<td>This is the name of the Confluence page or blog post that you want to include in the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If the page or blog post is located in another space, add the space key and a colon in front of the page name. For example, DOC:My page name.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• To include a blog post, specify the date as well as the title of the blog post. For example: /2010/12/01/My blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The space key is case sensitive.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• You can include pages from personal spaces using -user name as the space key, where 'username' is the person's username. For example, -jsmith:My page name.</td>
</tr>
</tbody>
</table>

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Notes

- If you want to include part of a page rather than the whole page, use the Excerpt and Excerpt Include macros.
- To display a page's contents, you need 'View' permission for that page. Similarly, people who view the page will need 'View' permissions for the embedded page as well as the page into which it is embedded. See space permissions or contact your Confluence space administrator for more information.
- If someone changes the name of the included page after you have added the macro to your page, the page name does not change automatically in the macro. You will need to change the page name manually in the macro parameters.
- If you want to embed an external page into a Confluence page, you need the HTML Include Macro.

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.
Sample Include Page

Start of sample page content


End of sample page content

Info Macro

The Info macro allows you to highlight helpful information on a Confluence page. It creates a blue-coloured box surrounding your text, as shown below.

Info Macro Example

This text is rendered inside the info macro.

Using the Info Macro

To add the Info macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

On this page:

- Using the Info Macro
- Parameters
- Code examples

Related pages:

- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User’s Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Information Icon</td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>
See:
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

**JIRA Issues Macro**

**JIRA** is the issue tracking and project management system supplied by Atlassian. The JIRA Issues macro allows you to display a list of issues from a JIRA site on a Confluence page. Using this macro, you can list publicly accessible issues from any JIRA site. Alternatively, you can allow users to see the issues that they have permission to see, based on their permissions on the JIRA site, assuming:

- The users are logged in to both the JIRA and Confluence sites, and
- Their usernames on both these sites match.

**Note:** You can also create, find and insert JIRA issues directly within text on a Confluence page or blog post. See **Inserting JIRA Issues**.

**Using the JIRA Issues Macro**

**To add the JIRA Issues macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

---

**On this page:**
- Using the JIRA Issues Macro
- Displaying a List of JIRA Issues from any Accessible JIRA Site
- Parameters
- Displaying Issues which have Restricted Viewing (*Not applicable to Confluence OnDemand.*)
- Rendering HTML from JIRA
- Disabling the JIRA Issues macro
- Troubleshooting
- Code examples

**Related pages:**
- Inserting JIRA Issues
- Working with Macros
- Setting Up Trusted Communication between JIRA and Confluence (*Not applicable to Confluence OnDemand.*)
- Confluence User’s Guide

Refer to the instructions below for details on obtaining the URL of the XML view of a search. An example URL is:

```
SearchRequest.xml?qjqlQuery=project+%3D+CONF+AND+%28summary+%7E+jiraissues+OR+description+%7E+jiraissues+OR+comment+%7E+jiraissues%29&tempMax=10
```

**Screenshot:** Example of JIRA issues shown on a Confluence page
Displaying a List of JIRA Issues from any Accessible JIRA Site

**Step 1 — Obtain the URL of the Issue Filter**

1. Log in to your JIRA system.
2. Go to the 'Issues' screen and create a new filter. Do not modify an existing filter.
3. Set up your search parameters and use 'View' to check the issues returned.
4. Once the filter is finished, go to the Filter's 'View' tab/section in the top-left area of the JIRA interface.
5. Copy the XML link. To do this, follow the appropriate step below:
   - If you are using JIRA 4.0.x or later, choose **Views**, right-click on **XML**, and choose **Copy Link Location**.
   - If you are using **JIRA 3.13.x or earlier**, locate the 'Current View' links section, right-click on **XML**, and choose **Copy Link Location**.

**Step 2 — Embed the Issue Filter URL onto your Confluence Page**

1. Log in to your Confluence system.
2. Edit the page where you wish to display the list of JIRA issues.
3. Add the JIRA Issues macro to the page, as described above.
4. Edit the macro, and paste the JIRA filter URL from your clipboard into the **URL** box.
5. Customise the macro output using the optional parameters. See below.
6. Save the Confluence page.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

The JIRA Issues macro allows the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>URL</strong></td>
<td>none</td>
<td>The URL of the XML view of your selected issues in the JIRA Issue Navigator. Note: If the URL in the URL parameter does not contain a <code>tempMax</code> argument, then the value of <code>tempMax</code> will default to 500. For JIRA 3.12 or earlier, the JIRA Issues macro will return a maximum of 500 issues. For JIRA 3.13 or later, the JIRA Issues macro will return a maximum of 500 issues per page.</td>
</tr>
<tr>
<td><strong>JIRA Field Columns to Display</strong></td>
<td>By default, the following columns are shown: type, key, summary, assignee, reporter, priority, status, resolution, created, updated, due</td>
<td>A list of JIRA column names, separated by semi-colons (;). Example columns are: key, summary, type, created, fixversion, updated, due, assignee, reporter, priority, status and resolution. You can include any columns recognised by your JIRA site, including custom columns. See the JIRA documentation for a list of names.</td>
</tr>
<tr>
<td><strong>Display Total Numbers Only</strong></td>
<td>false</td>
<td>When selected, the issue list will only show the number of issues in JIRA. The count will be linked to your JIRA site.</td>
</tr>
<tr>
<td><strong>Cache</strong></td>
<td>on</td>
<td>• <strong>on</strong> – the macro maintains a cache of the issues which result from the JIRA query. • <strong>off</strong> – the relevant part of the cache is cleared each time the macro is reloaded.</td>
</tr>
<tr>
<td>Anonymous Retrieval</td>
<td>false</td>
<td>When selected, JIRA will return only the issues which allow unrestricted viewing i.e. the issues which are visible to anonymous viewers, as determined by JIRA's viewing restrictions. Otherwise, the results depend on how your administrator has configured the communication between JIRA and Confluence. By default, Confluence will show only the JIRA issues which the user is authorised to view. See more details below.</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>---</td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>100%</td>
<td>The width of the table displaying the JIRA issues. Can be indicated either as a percentage (%) or in pixels (px).</td>
</tr>
</tbody>
</table>
| **Height (pixel value only)** | 480 | The height in pixels of the table displaying the JIRA issues. Note that this height specification is ignored in the following situations:  
  - If you set the **Render Mode** parameter (see below) to **static**.  
  - When the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. |
| **Title**           | JIRA Issues | You can customise the title text at the top of the JIRA issues table with this parameter. For instance, setting the title to 'Bugs-to-fix' will replace the default 'JIRA Issues' text. This can help provide more context to the list of issues displayed. |
Displaying Issues which have Restricted Viewing (Not applicable to Confluence OnDemand)

Maybe your JIRA instance is not visible to anonymous visitors — everyone has to log in before they can see JIRA issues. Or maybe some of the JIRA issues are restricted to viewing by certain users only. This section explains how to handle JIRA issues that have restricted viewing.

Using Confluence-to-JIRA Trusted Communication (Recommended)

For Confluence 2.7.0 and later and JIRA 3.12 and later, your administrator can set up trusted communication between Confluence and JIRA. The entire process is described in the Confluence Administrator's Guide. Provided that your administrator has set up trusted communication, you don't need to add any extra parameters. Confluence and JIRA will work out the security between them, ensuring that the user will see only the issues they are authorised to see. Read the section below if you want more detail.

The following options are available for determining the issues which will be retrieved from JIRA and displayed on the Confluence page:
<table>
<thead>
<tr>
<th>Display the JIRA issues which the logged-in user is authorised to see. And if the user is not logged in, display only issues which allow unrestricted viewing.</th>
<th>Do not specify any authentication parameters. In this case, the behaviour depends on the way your administrator has set up trusted communication between JIRA and Confluence. Here is a summary of the behaviour. If trusted communication is <strong>enabled</strong>, the authorisation will work seamlessly. When a logged-in user views your page, they will see only the JIRA issues they are allowed to see. And if they are not logged in, they will see only the issues which allow unrestricted viewing. If trusted communication is <strong>disabled</strong>, Confluence page will show only the JIRA issues which allow unrestricted viewing.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ensure that Confluence will display only the JIRA issues which allow unrestricted viewing.</td>
<td>Regardless of who the user is (logged in or not), the Confluence page will show only anonymously-visible issues. Confluence will not attempt to set up a trusted communication link with JIRA in this case.</td>
</tr>
<tr>
<td>Use a pre-determined username and password to access the JIRA issues.</td>
<td><strong>Not recommended.</strong> Prior to Confluence 2.7, this was the only way of displaying issues with restricted viewing. For Confluence 2.7 and later, this method will still work. Confluence will not attempt to set up a trusted communication link with JIRA in this case.</td>
</tr>
</tbody>
</table>

| anonymous | &os_username=MYNAME &os_password=MYPASSWORD |
Rendering HTML from JIRA

Formatted fields from JIRA can be displayed in Confluence if you set up a Confluence-to-JIRA Trust as described above. Otherwise, such formatted fields will be escaped within the JIRA issues macro output. This is to prevent the possibility of malicious HTML being served by an untrusted JIRA server. The most likely field where you will notice this is in the description field.

So, for example, without the trust relationship, a description column that rendered in JIRA like this -

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is</td>
</tr>
<tr>
<td>- the description</td>
</tr>
<tr>
<td>- of my issue</td>
</tr>
</tbody>
</table>

- would actually appear in the JIRA issues macro like this -

```
Description
<p>This is<ul><li>the description</li><li>of my issue</li></ul></p>
```

Configuring Confluence-to-JIRA Trust as described above will enable the field to be rendered as expected.

Disabling the JIRA Issues macro

The functionality is provided by a plugin called the 'JIRA Macros Plugin'. To make the macro unavailable on your site, you can disable the plugin. See Disabling or Enabling a Plugin.

Troubleshooting

HTTPS

The JIRA Issues macro can access a JIRA instance running under SSL as long as the Confluence server is set to accept the JIRA SSL certificate. Refer to the Confluence Knowledge Base article for more information about problems connecting to SSL services.

And see also Troubleshooting Trusted Communication between JIRA and Confluence. Not applicable to Confluence OnDemand.

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

JUnit Report Macro

See Inserting JIRA Issues.

JUnit Report Macro

The JUnit Report macro displays a summary of JUnit test results from a directory accessible by the Confluence server. JUnit is a unit testing framework which allows programmers to ensure that individual units of Java source code are functioning correctly.

The JUnit Report macro appears as shown in the screenshot below.

Screenshot: The JUnit Report macro in Confluence
Note: When generating reports from the JUnit Report macro, set the Apache Ant formatter to ‘XML’.

Using the JUnit Report macro

To add the JUnit Report macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL of the test result XML file</td>
<td>None</td>
<td>URL of a particular test result XML file. Is overridden by the Directory (URL) of your test result files parameter if you use both. Example, from a Confluence instance: <a href="http://yourConfluenceInstance.com/download/attachments/">http://yourConfluenceInstance.com/download/attachments/</a>&lt;page id&gt;/file.xml For Confluence installations without anonymous user access, you can specify logon credentials as part of this parameter in the form of URL parameters:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• os_username — The username of a Confluence user with permission to access to the JUnit test results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• os_password — The password of the Confluence user specified in the os_username parameter.</td>
</tr>
</tbody>
</table>
Directory (URL) of your test result files | None | URL of a directory containing your test result files. This must be a directory name and not the XML file itself. Overrides the URL of the test result XML file parameter if you use both.

Example, for a local drive: `file://C:/TEMP/`

Example, for a network drive: `http://*host*/*path*`

Report Detail | all | Detail for the report. Can be all, fixture, summary or failuresonly.

Debug | None | Shows the content of failures, as well as the error messages.

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Related topics

Working with Macros

Take me back to the Confluence User's Guide.

Labels List Macro

The Labels List macro displays a hyperlinked alphabetical index of all labels within the current space.

The label index generated consists of numerous cells, each beginning with one or more letters of the alphabet or a number. Each label within the space is grouped alphanumerically into its appropriately headed cell.

Each label in the list links to a page that displays all the pages on which the label occurs within the current space.

Screenshot: Labels List Macro segment

Using the Labels List macro

To add the Labels List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of
suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to this Space Key</td>
<td>No</td>
<td>Current space</td>
<td>The key of the space whose labels you want to display.</td>
</tr>
</tbody>
</table>

Code examples

See:
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Related topics

Working with Macros

Take me back to the Confluence User's Guide.

Livesearch Macro

The Livesearch macro allows you to add a search box to a Confluence page. When users enter a search term into the search box, Confluence will dynamically display matching results as they type.

Using the Livesearch macro

To add the Livesearch macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type {} and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>none</td>
<td>Uniquely identifies the Livesearch when there are multiple Livesearch macros in one page.</td>
</tr>
</tbody>
</table>
### Restrict to this Space Key

| all spaces | Specify a space key to limit the search to the given space. Case-sensitive. |

### Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

### Related topics

Searching Confluence
Search Results Macro
Working with Macros

Take me back to the Confluence User’s Guide.

Loremipsum Macro

The Loremipsum macro displays paragraphs of pseudo-Latin text (more information). You can use this macro to generate more-or-less meaningless text for demonstration purposes in pages showing a draft layout or arrangement of page elements. The text is deliberately non-meaningful so that it does not influence the viewer’s perception of the page arrangement or design.

A basic example of the Loremipsum text:

```
```

### Using the Loremipsum macro

**To add the Loremipsum macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

### Number of Paragraphs

<table>
<thead>
<tr>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Determines the amount of pseudo-Latin (space-filler) text to display. The macro will display a maximum number of 30 paragraphs.</td>
</tr>
</tbody>
</table>

### Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

### Related topics

- Working with Macros
- Take me back to the Confluence User's Guide.
- Multimedia Macro
  
  See Embedding Multimedia Content.
- Navigation Map Macro

The Navigation Map macro displays the list of pages associated with a specified label as a navigation map.

A label must be specified for this macro.

#### Using the Navigation Map Macro

**To add the Navigation Map macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

#### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>none</td>
<td>Specify the label associated with the pages you want to show in the navigation map.</td>
</tr>
<tr>
<td>Map Title</td>
<td>none</td>
<td>Specify a title for the navigation map.</td>
</tr>
<tr>
<td>Number of Cells Per Row</td>
<td>5</td>
<td>Specify the number of cells in a row</td>
</tr>
<tr>
<td>Cell Width (Pixels)</td>
<td>90 px</td>
<td>Specify the cell width</td>
</tr>
<tr>
<td>Cell Height (Pixels)</td>
<td>60 px</td>
<td>Specify the cell height</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>Navigation Map Theme</strong></td>
<td>Confluence</td>
<td>Define a theme for the navmap.</td>
</tr>
</tbody>
</table>

If you want to create your own navmap 'look and feel' (for example, one with rounded corners), you need to add a customised navmap macro theme file to the WEB-INF/classes/templates/macros directory. The file name convention to use is navmap-mytheme.vm. Use the name of your choice for the mytheme part of the file name, which is also the value you use for this parameter. Hence, if your theme was called navmap-roundededges.vm, use the value of roundededges for this parameter.

**Related Topics**

- Related Labels Macro
- Content by Label Macro
- Recently Used Labels Macro
- Working with Confluence Labels
- Working with Macros

**Network Macro**

The Network macro displays a list of Network activity on a Confluence page or blog post. You can specify the user whose network activity you wish to show. These interactions include the users that the specified user is following or users who are following the specified user. The Network macro shows each listed user by their profile picture. It also provides a choice of two themes and the ability to limit the number of users in the list.

**Screenshot: Network macro**

---

Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/).
Using the Network macro

To add the Network macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Current user's username</td>
<td>The username of the Confluence user whose network interactions you wish to show. If no username is specified, then current user's (that is, your) network interactions are shown.</td>
</tr>
<tr>
<td>Mode</td>
<td>following</td>
<td>Determines which users are listed, with respect to the specified user:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• following – those who the user is following.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• followers – those who are following the user.</td>
</tr>
<tr>
<td>Theme</td>
<td>full</td>
<td>Determines how the user's network is displayed:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• full – shows a large version of user's profile pictures and, if the following mode is set, provides an entry field function to follow more users.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• tiny – shows only the small version of user's profile pictures.</td>
</tr>
</tbody>
</table>
### Maximum Results

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Panel</td>
<td>False</td>
<td>Removes the panel around the content.</td>
</tr>
</tbody>
</table>

Restricts the number of users displayed. If the number of users exceeds the specified maximum, then a **Show All** link is provided. This link leads to the specified user's **Network view**, showing the complete list of network interactions.

### Disabling the Network macro

The Network macro is provided by the 'network' module in the 'Profile Macros' plugin. To remove the macro from your site, you can disable the module in the plugin. See [Disabling and Enabling Add-ons](#).

### Noformat Macro

The Noformat macro displays a block of text in monospace font with no other formatting.

**Using the Noformat Macro**

**To add the Noformat macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Enter the content that is to be unformatted into the body of the macro placeholder.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Panel</td>
<td>False</td>
<td>Removes the panel around the content.</td>
</tr>
</tbody>
</table>

### Related Topics

**Working with Macros**

Take me back to the Confluence User's Guide.

**Note Macro**

The Note macro allows you to highlight a note on a Confluence page.

It creates a yellow-coloured box surrounding your text:

⚠️ **Note Macro Example**

This text is rendered inside the Note macro.
Using the Note Macro

To add the Note macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type \{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Add the text of the note to the body of the macro placeholder.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>If specified, the title is displayed in bold next to the icon.</td>
</tr>
</tbody>
</table>
| Show Exclamation Mark Icon    | true    | • true – displays the warning icon  
|                               |         | • false – the icon is not displayed             |

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Page Index Macro

The Page Index macro creates a hyperlinked alphabetical index of all page titles within the current space.

The top section of the index contains a cell for each letter of the alphabet, with cells for numbers and symbols. Each cell indicates how many pages are in the corresponding list.

The lower section contains lists of page titles followed by the first few sentences of content on that page.

Each letter, number or symbol in the top section is hyperlinked to the corresponding cell in the lower section. Each page title in the lower section is hyperlinked to the page in the space.

Related pages:

- Working with Macros
- Confluence User's Guide.

Screenshot: Page Index macro segment
Using the Page Index Macro

To add the Page Index macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

This macro accepts no parameters.

Page Properties Macro

The Page Properties macro enables you to embed data on a page and then display that data in tabular form on another page. You can put the Page Properties macro on as many pages as you like and use the Page Properties Report macro to display the collected data on one page. You can also choose to hide the metadata on the pages that contain the Page Properties macro.

This macro was previously known as the Metadata Details macro.
Basic usage of the Page Properties and Page Properties Report macros

The Page Properties macro is used in conjunction with the Page Properties Report macro.

To use the macros:

1. Add the **Page Properties** macro to your page and specify a label (for example, Status).
2. Add a two column table in the body of the macro placeholder for your metadata **keys** and **values**.
3. Repeat this process to add the **Page Properties** macro to other pages.
4. Create a new page to contain your report (for example, Status Report).
5. Add the **Page Properties Report** macro and specify the same label (for example, Status).
6. View your new status report page. The data contained in your **Page Properties** macros display in the report.

   **Screenshot: example ‘Status’ report**

   ![Status Report](image)

<table>
<thead>
<tr>
<th>Title</th>
<th>Current Status</th>
<th>Deadline</th>
<th>Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project ABC</td>
<td>In Progress</td>
<td>15 November</td>
<td>Green Parrots</td>
</tr>
<tr>
<td>Project DEF</td>
<td>Not Started</td>
<td>1 June</td>
<td>Purple Monkeys</td>
</tr>
</tbody>
</table>

7. Choose a column heading to sort the report.

When you insert the Page Properties macro on a page Confluence automatically adds the label to the page. You can add more than one Page Properties macro to the page, but they will inherit the same label (e.g. you cannot have two Page Properties macros with different labels on the same page).

Using the Page Properties macro

1. **Add the Page Properties macro to the page:**
   a. In the Confluence editor, choose **Insert > Other Macros**.
   b. Find and select the required macro.
Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

2. Add a label to the macro, using the macro parameters.
   In the macro browser, add a Label. For example, “Status”.

3. Add metadata keys and values as rows in a table, in the body of the macro placeholder.
   In the macro body add a two column table. In the left column specify the keys (these will be the column headings in your report). In the right column specify the values for each key.

Screenshot: The macro placeholder in the Confluence editor

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>(None)</td>
<td>The label used to identify the metadata on this page. Confluence will add this label to the page. Any additional Page Properties macros will inherit this label.</td>
</tr>
<tr>
<td>Hidden</td>
<td>False</td>
<td>Determines whether the data in the Page Properties macro will be displayed on the current page. This setting does not affect the display of the detail in the Page Properties Report macro.</td>
</tr>
</tbody>
</table>

Examples

The following examples outline how you can use the Page Properties and Page Properties Report macros together to create a Status Report or a Risk Report.

Example 1 - Status Report

In this example we wish to create a Status Report page that displays project status metadata from a number of pages.

The label in this example is ‘status’

The keys in this example are:
• Deadline
• Project Status
• Team.

The **values** for each key are:

• Deadline: 1 June, 15 November and so on.
• Project status: Not started, In progress, Complete.
• Team: Purple Monkeys, Green Parrots.

The **Page Properties macro** on each page looks like this:

*Screenshot: two examples of the Page Properties macro from different pages showing values for each key.*

![Page Properties Macro Examples](image)

The label keys are the same on each page. The values are different.

The **Page Properties Report macro** on the Status Report page looks like this:

*Screenshot: Page Properties Report macro with the label 'Status'*

![Page Properties Report Macro](image)

The final Status Report page looks like this, with a row for each page:

*Screenshot: Example of the Page Properties Report macro showing data* 

### Page Properties Report for label "status"

<table>
<thead>
<tr>
<th>Title</th>
<th>Deadline</th>
<th>Project Status</th>
<th>Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project ABC - Example Metadata</td>
<td>16 November</td>
<td>In progress</td>
<td>Green Parrots</td>
</tr>
<tr>
<td>Project DEF - Example Metadata</td>
<td>1 June</td>
<td>Not started</td>
<td>Purple Monkeys</td>
</tr>
</tbody>
</table>

Want to see this example in action? The following pages were created in this documentation space to create this example.

- Status and Risk Reports - example of Page Properties Report macro
- Project ABC - Example Metadata
- Project DEF - Example Metadata

**Example 2 - Risk Report**

In this example we wish to create a Risk Report page that displays project risk metadata from a number of pages.

The **label** in this example is 'risk'

The **keys** in this example are:

• Impact
• Risk Level.
The values for each key are:

- Impact: critical, high, medium, low
- Risk Level: major, minor, trivial.

The Page Properties macro on each page looks like this:

Screenshot: example of the Page Properties macro from one page.

![Page Properties macro example](image)

The Page Properties Report macro on the Risk Report page looks like this:

Screenshot: Page Properties Report macro with the label 'Risk'

![Page Properties Report macro example](image)

The final Risk Report page looks like this, with a row for each page:

Screenshot: Example of the Page Properties Report macro showing data

<table>
<thead>
<tr>
<th>Title</th>
<th>Impact</th>
<th>Risk level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation Option A - Example Metadata</td>
<td>Major</td>
<td>Critical</td>
</tr>
<tr>
<td>Implementation Option B - Example Metadata</td>
<td>Trivial</td>
<td>High</td>
</tr>
<tr>
<td>Implementation Option C - Example Metadata</td>
<td>Major</td>
<td>High</td>
</tr>
</tbody>
</table>

Want to see this example in action? The following pages were created in this documentation space to create this example.

- Status and Risk Reports - example of Page Properties Report macro
- Implementation Option A - Example Metadata
- Implementation Option B - Example Metadata
- Implementation Option C - Example Metadata

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Notes

- If you add a label to the parameter in the Page Properties macro, Confluence adds the label to the page.
- If you remove the label from the Page Properties macro, the label remains on the page.
- If you remove the label from the page but leave it in the Page Properties macro, Confluence puts the label back onto the page.
- You can add many Page Properties macros per page, however all Page Properties macros on the page
will have the same labels applied to them. For example, if you add two Page Properties macros on a page, one with the label "risk" and the other with the label "status", both sets of metadata will appear in the Page Properties Report macro for the "status" label and for the "risk: label. This is true even if you have specified just one label in each Page Properties macro. It is the labels on the page that matter, not the labels in the macros.

- It is not possible to reference the metadata using the metadata key from within the page, or anywhere else on a Confluence page.

Other metadata macros

There are other metadata macros, which are not supported or documented on this page but which are worth mentioning:

- `{metadata-list}` – Adds metadata keys and values. See [Atlassian Answers](https://confluence.atlassian.com杲b).  
- `{metadata-values:pagename}` – Displays the metadata values without the keys. You can use `@self` to get the metadata on the current page. See [Atlassian Answers](https://confluence.atlassian.com杲b).  
- `{metadata-report}`  
- Macros added by the [Confluence Metadata Plugin 2](https://confluence.atlassian.com).  

**Status Report - Example of Page Properties Report Macro**

This page contains examples of the Page Properties Report macro used to show a status report and a risk report.

**Page Properties Report for label "status"**

<table>
<thead>
<tr>
<th>Title</th>
<th>Deadline</th>
<th>Project status</th>
<th>Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project ABC - Example Metadata</td>
<td>15 November</td>
<td>In Progress</td>
<td>Green Parrots</td>
</tr>
<tr>
<td>Project DEF - Example Metadata</td>
<td>1 June</td>
<td>Not Started</td>
<td>Purple Monkeys</td>
</tr>
</tbody>
</table>

**Page Properties Report for label "risk"**

<table>
<thead>
<tr>
<th>Title</th>
<th>Impact</th>
<th>Risk level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation Option A - Example Metadata</td>
<td>Major</td>
<td>Critical</td>
</tr>
<tr>
<td>Implementation Option B - Example Metadata</td>
<td>Trivial</td>
<td>High</td>
</tr>
<tr>
<td>Implementation Option C - Example Metadata</td>
<td>Major</td>
<td>High</td>
</tr>
</tbody>
</table>

**Related pages:**

- Page Properties Report Macro
- Page Properties Macro
- Confluence User's Guide

**Implementation Option A - Example Metadata**

This page contains an example of the Page Properties macro. The data in the macro is not hidden.

<table>
<thead>
<tr>
<th>Risk level</th>
<th>Impact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td></td>
</tr>
<tr>
<td>Major</td>
<td></td>
</tr>
</tbody>
</table>
Implementation Option B - Example Metadata
This page contains an example of the Page Properties macro. The data in the macro is not hidden.

<table>
<thead>
<tr>
<th>Risk level</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Trivial</td>
</tr>
</tbody>
</table>

Related pages:
- Page Properties Report Macro
- Page Properties Macro
- Confluence User's Guide

Implementation Option C - Example Metadata
This page contains an example of the Page Properties macro. The data in the macro is not hidden.

<table>
<thead>
<tr>
<th>Risk level</th>
<th>High</th>
</tr>
</thead>
<tbody>
<tr>
<td>Impact</td>
<td>Major</td>
</tr>
</tbody>
</table>

Related pages:
- Page Properties Report Macro
- Page Properties Macro
- Confluence User's Guide

Project ABC - Example Metadata
This page contains an example of the Page Properties macro. The data in this macro is hidden.

<table>
<thead>
<tr>
<th>Project Status</th>
<th>In Progress</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team</td>
<td>Green Parrots</td>
</tr>
<tr>
<td>Deadline</td>
<td>15 November</td>
</tr>
</tbody>
</table>

Related pages:
- Page Properties Report Macro
- Page Properties Macro
- Confluence User's Guide

Project DEF - Example Metadata
This page contains an example of the Page Properties macro. The data in this macro is hidden.
Page Properties Report Macro

The Page Properties Report macro presents a tabulated summary of metadata that has been embedded, using the Page Properties macro, on any page or blog post in the current Confluence space. The Page Properties Report macro collects metadata from only those pages or blog posts that have a specific label.

The left-hand column of the report shows the name of the page that contains the metadata. Each page name is presented on a single row with a link to the page.

The other columns in the report represent the fields (keys) defined in the Page Properties macros. You can sort the table by choosing the column headers.

This macro was previously known as the Details Summary macro.

Basic usage of Page Properties and Page Properties Report macros

The Page Properties macro is used in conjunction with the Page Properties Report macro.

To use the macros:

1. Add the Page Properties macro to your page and specify a label (for example, Status).
2. Add a two column table in the body of the macro placeholder for your metadata keys and values.
3. Repeat this process to add the Page Properties macro to other pages.
4. Create a new page to contain your report (for example, Status Report).
5. Add the Page Properties Report macro and specify the same label (for example, Status).

Screenshot: example 'Status' report
7. Choose a column heading to sort the report.

When you insert the Page Properties macro on a page Confluence automatically adds the label to the page. You can add more than one Page Properties macro to the page, but they will inherit the same label (e.g. you cannot have two Page Properties macros with different labels on the same page).

Using the Page Properties Report macro

1. **Add the Page Properties Report macro to the page:**
   a. In the Confluence editor, choose **Insert > Other Macros**.
   b. Find and select the required macro.

   **Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in [Using Autocomplete](#).

   **To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

2. **Add a label to the macro, using the macro parameters.**
   In the macro browser, specify a **Label**. For example, 'Status'.

   ![Screenshot: Page Properties Report macro with label specified](Image)

   **Parameters**

   Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Metadata Label</strong></td>
<td>(None)</td>
<td>Identifies the label to be used in the Page Properties Report. The report will show data from all Page Properties macros with the same label on pages in the current space.</td>
</tr>
</tbody>
</table>

   **Examples**

   The following examples outline how you can use the Page Properties and Page Properties Report macros together.

   The following examples outline how you can use the Page Properties and Page Properties Report macros together to create a Status Report or a Risk Report.

   - **Example 1 - Status Report**
In this example we wish to create a Status Report page that displays project status metadata from a number of pages.

The **label** in this example is 'status'

The **keys** in this example are:

- Deadline
- Project Status
- Team.

The **values** for each key are:

- Deadline: 1 June, 15 November and so on.
- Project status: Not started, In progress, Complete.
- Team: Purple Monkeys, Green Parrots.

The **Page Properties macro** on each page looks like this:

_Screenshot: two examples of the Page Properties macro from different pages showing values for each key._

The label keys are the same on each page. The values are different.

The **Page Properties Report macro** on the Status Report page looks like this:

_Screenshot: Page Properties Report macro with the label 'Status'_

The final Status Report **page** looks like this, with a row for each page:

_Screenshot: Example of the Page Properties Report macro showing data_

**Page Properties Report for label "status"**

<table>
<thead>
<tr>
<th>Title</th>
<th>Deadline</th>
<th>Project Status</th>
<th>Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project ABC - Example</td>
<td>16 November</td>
<td>In progress</td>
<td>Green Parrots</td>
</tr>
<tr>
<td>Project DEF - Example</td>
<td>1 June</td>
<td>Not started</td>
<td>Purple Monkeys</td>
</tr>
</tbody>
</table>

Want to see this example in action? The following pages were created in this documentation space to create this example.

- Status and Risk Reports - example of Page Properties Report macro
- Project ABC - Example Metadata
- Project DEF - Example Metadata

**Example 2 - Risk Report**

In this example we wish to create a Risk Report page that displays project risk metadata from a number of pages.
The label in this example is 'risk'

The keys in this example are:

- Impact
- Risk Level.

The values for each key are:

- Impact: critical, high, medium, low
- Risk Level: major, minor, trivial.

The Page Properties macro on each page looks like this:

Screenshot: example of the Page Properties macro from one page.

![Page Properties](image)

The Page Properties Report macro on the Risk Report page looks like this:

Screenshot: Page Properties Report macro with the label 'Risk'

![Page Properties Report](image)

The final Risk Report page looks like this, with a row for each page:

Screenshot: Example of the Page Properties Report macro showing data

<table>
<thead>
<tr>
<th>Title</th>
<th>Impact</th>
<th>Risk level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementation Option A - Example Metadata</td>
<td>Major</td>
<td>Critical</td>
</tr>
<tr>
<td>Implementation Option B - Example Metadata</td>
<td>Trivial</td>
<td>High</td>
</tr>
<tr>
<td>Implementation Option C - Example Metadata</td>
<td>Major</td>
<td>High</td>
</tr>
</tbody>
</table>

Want to see this example in action? The following pages were created in this documentation space to create this example.

- Status and Risk Reports - example of Page Properties Report macro
- Implementation Option A - Example Metadata
- Implementation Option B - Example Metadata
- Implementation Option C - Example Metadata

Code examples

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

Page Tree Macro

The Page Tree macro displays a dynamic, hierarchical list of pages starting from a specified parent (root) page.
It can act as a table of contents or a list of related topics. When viewing the page tree, your reader can click a link to view the relevant page. The page's current position is highlighted in the page tree.

**Note:** The Page Tree macro is used in the Confluence Documentation theme, to create a navigation panel showing a table of contents for your space. Read the instructions on Configuring the Documentation Theme.

**Using the Page Tree Macro**

**To add the Page Tree macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Click **Refresh** in the Macro Browser to see the effect of changes to the macro parameters.

**On this page:**
- Using the Page Tree Macro
- Macro Parameters

**Related pages:**
- Page Tree Search Macro
- Working with Macros
- Confluence User's Guide

**Macro Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

| **Root Page** | The home page of the space | Specify the parent page for the page tree. The tree will include all children of the given page, plus their children and grand-children etc. The tree will *not* include the root page itself. Specify the page title or a special value as follows:

- **Your page title** — to specify a page name for the parent or root of the tree. The tree will include all children and grand-children of the specified root. The tree will *not* include the specified root page itself.
- **@home** — will include all pages under the home page of the space (default).
- **@self** — will include all pages under the current page.
- **@parent** — will include all pages under the parent of the current page, including the current page.
- **@none** — will include all pages in the space, including orphaned pages and the home page. |
| **Sort Pages By** | **position** | Specify the order to display the pages in the tree. This sort order is for display purposes only. It does not permanently re-arrange the page order. The value may be one of the following:

- **bitwise** — sort alphabetically, for example: title1, title10, title2.
- **creation** — sort by date of creation.
- **modified** — sort by order of date last modified.
- **natural** — sort in 'natural' alphabetical order, for example: title1, title2, title10.
- **position** — sort by the default Confluence sorting rules. If your pages have been ordered manually, this sort will respect the defined order. Otherwise the pages will be displayed in the 'natural' alphabetical order, such as: title1, title2, title10. |

| **Include Excerpts in Page Tree** | **false** | Select if you want the page tree to show excerpts from each page. The excerpts must be defined on each page by the [Excerpt macro](https://confluence.atlassian.com/pages/master_page/). |

| **Reverse Order** | **false** | Select to show the pages in reverse (descending) natural order. Must be used in combination with the **Sort Pages By** parameter. |

| **Include Search Box above Page Tree** | **false** | Select if you want to include a search box above the page tree. The search box allows your readers to search within the page tree for the specified value. |

| **Show Expand/Collapse Links** | **false** | Select if you want to display the 'expand all' and 'collapse all' links at the top of your page tree. Your readers can click these links to open or close all branches of the tree at once. |

| **Start Depth** | **1** | Enter any number greater than 0 to set how many levels of children the tree should show when it opens for the first time. |
**Sample Page Tree**

This page is a sample, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the Page Tree Macro.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=false}`</td>
</tr>
</tbody>
</table>

**Another Sample Page Tree**

We’re using this page to demonstrate the Pagetree macro.

For more information, take a look at the main page on the Page Tree Macro.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

**Sample Page Tree 2**

This is another sample page, used to demonstrate the Pagetree macro.

For more information, take a look at the main page on the Page Tree Macro.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>`{pagetree:root=@parent</td>
<td>expandCollapseAll=true}`</td>
</tr>
</tbody>
</table>

**Page Tree Search Macro**

Using the Page Tree Search macro, you can add a search box to your Confluence page. When a viewer enters a search term, Confluence will search a hierarchy of pages starting from a specified parent (root) page and return the search results.

You can also add a search box as part of a dynamic page tree, which looks like a table of contents. See the Page Tree macro.

**Using the Page Tree Search macro**

**To add the Page Tree Search macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Related pages:**

- Page Tree Macro
- Working with Macros
- Confluence User's Guide
Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name of Root Page</td>
<td>none</td>
<td>The name of the root page whose hierarchy of pages will be searched by this macro. If this not specified, the root page is the current page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Unlike the Page Tree macro, the Page Tree Search macro does not accept the special values that start with an @ sign, such as @home or @self.</td>
</tr>
</tbody>
</table>

Panel Macro

The Panel Macro allows you to display a block of text within a customisable panel, like a text box. Here is an example:

```
My Title
A formatted panel.
```

Using the Panel Macro

**To add the Panel macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel Title</td>
<td>none</td>
<td>The title of the panel. If specified, this title will be displayed in its own title row.</td>
</tr>
<tr>
<td>Border Style</td>
<td>solid</td>
<td>The style of the panel's border. Accepted values are solid, dashed and other valid CSS border styles.</td>
</tr>
<tr>
<td>Border Colour</td>
<td></td>
<td>The colour of the panel's border.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Border Pixel Width (Value Only)</td>
<td></td>
<td>The width of the panel's border (in pixels).</td>
</tr>
<tr>
<td>Background Colour</td>
<td></td>
<td>The background colour of the panel.</td>
</tr>
<tr>
<td>Title Background Colour</td>
<td></td>
<td>The background colour of the title row of the panel.</td>
</tr>
<tr>
<td>Title Text Colour</td>
<td></td>
<td>The colour of the text in the title row of the panel.</td>
</tr>
</tbody>
</table>

Colours can be specified HTML colour names or hexadecimal codes.

Notes

- You can use panels within columns and table cells.

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Popular Labels Macro

The Popular Labels macro displays the most popular labels used throughout your Confluence site or within a space.

Using the Popular Labels Macro

To add the Popular Labels macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.
### Style of Labels

<table>
<thead>
<tr>
<th>Style</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>list</td>
<td>list</td>
</tr>
<tr>
<td>heatmap</td>
<td>heatmap</td>
</tr>
</tbody>
</table>

- **list** – displays the popular labels as a bulleted list, ordered by popularity (highest first).
- **heatmap** – displays the popular labels using different font sizes for each label depending on the label’s popularity, ordered by label names.

### Related Topics

- Using Label Macros to Categorise Wiki Content
- Related Labels Macro
- User-contributed extension: Sortable Popular Labels

Take me back to the [Confluence User’s Guide](#).

### Profile Picture Macro

The Profile Picture macro displays a user's profile picture on a page.

- When viewing the page, mouse-over the picture to see the Hover Profile for the user.
- When editing the page, click on the picture and choose View User Profile to see the profile for the user.

The Profile Picture macro is useful for such tasks as creating Team Pages that show all members of a project team.

**On this page:**
- Using the Profile Picture Macro
- Parameters
- Related Topics

#### Using the Profile Picture Macro

**To add the Profile Picture macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type \ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

#### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
User

none
The username, or real name, of a Confluence user.

Related Topics

Working with Macros

Take me back to the Confluence User's Guide

Recently Updated Dashboard Macro

The Recently Updated Dashboard macro displays a list of the most recently changed content within Confluence. It is similar to the Recently Updated macro but is intended for use on the Confluence dashboard.

Using the Recently Updated Dashboard Macro

To add the Recently Updated Dashboard macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space(s)</td>
<td>The space which contains the page on which the macro is added</td>
<td>Filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here. You can specify one or more space keys, separated by commas. &quot;*&quot; means all spaces.</td>
</tr>
<tr>
<td>Include these Content Types Only</td>
<td>all types</td>
<td>Filter content by type. You can specify one or more types, separated by commas. Available types are: page, blogpost or news, spacedesc, attachment, comment, mail, userinfo.</td>
</tr>
</tbody>
</table>
### Label(s)

| none |

Filter content by label. The macro will display only the pages etc which are tagged with the label(s) you specify here. You can specify one or more labels, separated by commas.

**Note:** If there are no pages matching any of the specified labels, then Confluence will ignore the labels and will list all recently updated pages, as well as showing a message, "These labels don't exist and were ignored: xxx." This unexpected behaviour is noted in issue [CONF-13860 - Authenticate](#) to see issue details.

### User(s)

| all users |

Filter by username of the user who updated the content. The macro will only display content created and updated by the user(s) you specify here. You can specify one or more usernames separated by commas.

### Width of Table

| 100% |

Specify the width of the macro display, as a percentage of the window width.

### Show User Profile Pictures

| false |

Select whether profile pictures of the users who updated the content are displayed.

---

**Related Topics**

- Recently Updated Macro
- Viewing Recently Updated Content
- Working with Macros

Take me back to the Confluence User's Guide.

**Recently Updated Macro**

The Recently Updated macro displays a list of the most recently changed content within Confluence.

**Using the Recently Updated Macro**

**To add the Recently Updated macro to a page:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open,
where you can edit the parameters of the macro.

On this page:
- Using the Recently Updated Macro
- Parameters
- Notes

Related pages:
- Recently Updated Dashboard Macro
- Viewing Recently Updated Content
- Working with Macros
- Confluence User's Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s) by username</td>
<td>None specified i.e. display all content</td>
<td>Filter the results by author. The macro will display only the pages etc which were last modified by the author(s) you specify here. You can specify one or more authors, separated by a comma or a space. For example: jsmith, jbrown</td>
</tr>
<tr>
<td>Space(s)</td>
<td>@self, i.e. the space which contains the page on which the macro is used</td>
<td>This parameter allows you to filter content by space. The macro will display only the pages etc which belong to the space(s) you specify here. You can specify one or more space keys, separated by a comma or a space.</td>
</tr>
</tbody>
</table>
• To exclude content in a specific space, put a minus sign (−) immediately in front of that space key. For example: If you specify a space key of −BADSPACE you will get only content which is not in the BADSPACE.

• To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:

• @self — The current space.
• @personal — All personal spaces.
• @global — All site spaces.
• @favorite — The spaces you have marked as favourite.
• @favourite — The same as @favorite above.
• @all — All spaces in your Confluence site.
• * — The same as @all above.

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.
<table>
<thead>
<tr>
<th>Label(s)</th>
<th>None specified i.e. display all content</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Filter the results by label. The macro will display only the pages etc which are tagged with the label(s) you specify here.</td>
</tr>
<tr>
<td></td>
<td>You can specify one or more label values, separated by a comma or a space.</td>
</tr>
<tr>
<td></td>
<td>• To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of <code>~badpage</code> you will get only content which is not labelled with 'badpage'.</td>
</tr>
<tr>
<td></td>
<td>• To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of <code>+superpage,+goodpage</code> you will get only content which has at least two labels, being 'superpage' and 'goodpage'.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Width of Table</th>
<th>100%</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Specify the width of the macro display, as a percentage of the window width.</td>
</tr>
</tbody>
</table>
| Include these Content Types Only | all types | This parameter allows you to filter content by content type. The macro will display only the content of the type you specify here.

You can specify one or more types, separated by a comma or a space.

To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of `-blogpost` you will get pages and all other content except for blog posts.

Available values:

- page — Pages.
- blogpost or news — Blog posts, also known as news items.
- comment — Comments on pages and blog posts.
- attachment — Attachments.
- status — Status updates made by other users. |
<p>| Maximum Number of Results | 15 | Specify the maximum number of results to be displayed. If this parameter is omitted, then a maximum of 15 results are displayed. The theoretical maximum value that this parameter can accept is 2 to the power of 31, minus 1 (or 2147483647), though this has been limited to 200 in the code, for performance reasons. More details are here. |</p>
<table>
<thead>
<tr>
<th>theme</th>
<th>'concise' with the heading 'Recently Updated'</th>
<th>Choose the appearance of this macro:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>• concise — the default list, showing the names of pages which were updated or commented on, the users who made the page modifications and time when the modifications occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• social — lists recent modifications in reverse chronological order, but groups them by user into short time segments. A 'sub' list appears within each user's time segment, showing the names of pages which they updated or commented on and time when these modifications occurred.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• sidebar — lists recent updates in reverse chronological order, showing the names of pages which were updated or commented on and time when the page modifications occurred. This theme does not show authorship.</td>
</tr>
<tr>
<td>Show User Profile Pictures</td>
<td>false</td>
<td>Specify <code>showProfilePic=true</code> to display the profile pictures of the users who updated the content.</td>
</tr>
</tbody>
</table>

Notes

- The Recently Updated Dashboard macro is similar to this macro, but is intended for display on the Confluence dashboard.
- If you would like to change the wording displayed by the Recently Updated macro, please refer to the document on modifying the Confluence interface text. Not applicable to Confluence OnDemand.

Recently Used Labels Macro

The Recently Used Labels macro displays a list of the labels that have been most recently added to a page, blog post or attachment. You can define the number of labels to be displayed and the scope (the current space, your personal space or site spaces, also known as 'global' spaces).

Using the Recently Used Labels Macro

To add the Recently Used Labels macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of
suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

On this page:
- Using the Recently Used Labels Macro
- Parameters of this macro

Related pages:
- Related Labels Macro
- Content by Label Macro
- Recently Used Labels Macro
- Working with Confluence Labels
- Working with Macros
- Confluence User’s Guide

Parameters of this macro

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Labels to Display</td>
<td>10</td>
<td>Specifies the total number of labels to display in the list.</td>
</tr>
</tbody>
</table>
| Scope for Retrieving Labels| global | Specifies the scope of labels to be displayed in the list. Valid values include:
- global — covers all site spaces (non-personal) in the Confluence installation.
- space — the current space.
- personal — your own personal space. |
| List Style                 | list    | • list — displays the list of labels horizontally.                          |
|                            |         | • table — includes additional information such as the page to which the label was added and the user who added it. |
| Table Title                | none    | Adds a title to the top of the list in table style. Titles are only visible when the List Style parameter has been set to table. |

Related Labels Macro

The Related Labels macro lists all labels from every page which has one or more labels in common with the current page.

Using the Related Labels Macro
To add the Related Labels macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restrict to these Labels</td>
<td>none</td>
<td>Specify the labels for which you want to view related labels. For example, documentation,my:stuff.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Navigation Map Macro
- Content by Label Macro
- Recently Used Labels Macro
- Working with Confluence Labels
- Working with Macros

Take me back to the Confluence User's Guide.

**RSS Feed Macro**

The RSS Feed macro embeds an RSS feed on a page. It can display the contents of external feeds, or of internal feeds generated by Confluence. To display blog posts or to list recently updated pages in a space, use the Feed Builder to create an internal feed, then render it using this macro.

⚠️ **CAUTION: Including unknown HTML inside a webpage is dangerous.**

HTML inside an RSS feed can contain active scripting components. This means that it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user's authentication cookie and give the attacker their Confluence login password.

The RSS Feed macro will only be available if it has been enabled by your Confluence administrator. Also, your Confluence administrator can define a whitelist of trusted URLs. You will see an error message on the Confluence page, if the included URL is not in the whitelist.

**Using the RSS Feed macro**

**To add the RSS Feed macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.
To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

### On this page:
- Using the RSS Feed macro
- Parameters
- How up to date is the feed?
- What happens to a page containing a disallowed URL?
- Authentication
- Accessing internal HTTPS feeds
- Enabling and disabling the RSS Feed macro

### Related pages:
- Subscribing to RSS Feeds within Confluence
- Managing Changes and Notifications and Tasks
- Working with Macros
- Configuring a URL Whitelist for Macros
- Confluence User’s Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

### Parameters
Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSS Feed URL</td>
<td>none</td>
<td>The URL of the RSS feed link you want to show.</td>
</tr>
<tr>
<td>Maximum Number of Entries</td>
<td>15</td>
<td>Limit the number of entries displayed.</td>
</tr>
<tr>
<td>Show Item Titles Only</td>
<td>false</td>
<td>Show only the titles of the news items, not the content.</td>
</tr>
<tr>
<td>Show Name/Title of RSS Feed</td>
<td>true</td>
<td>Hide the feeds title bar.</td>
</tr>
</tbody>
</table>

### How up to date is the feed?

By default, the RSS Feed macro caches the feed results for 60 minutes before fetching the data again.

If you wish to change the default caching, use the Cache macro to define how often the RSS Feed macro fetches the feed updates. You will need to install the Cache plugin onto your Confluence site.

### What happens to a page containing a disallowed URL?

Your Confluence Administrator can set up a whitelist of allowed URLs. If this is the case, you may see an error on the pages which contain the RSS Feed macro.

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence "could not access the content at the URL because it is not from an
allowed source" and displays the offending URL. If the person viewing the page is a Confluence Administrator, they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
Configure whitelist >>
```

Here is an example of the error message, but without the link.

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
You may contact your site administrator and request that this URL be added to the list of allowed sources.
```

Authentication

Private feeds from external sites

RSS feeds which require authentication cannot be accessed using the RSS Feed macro.

Accessing internal HTTPS feeds

This applies only to Confluence instances which have enabled HTTPS for all content. If your site is fully HTTPS, the RSS Feed macro cannot access internal feeds. To enable the RSS Feed macro to access internal feeds without affecting your HTTPS setup, enable local-only HTTP access:

1. Shut down Confluence.
2. Consult the SSL guide to enable HTTP access to Confluence. You'll want to ensure that you have an HTTP connector and an SSL connector, both commented in. This means that Confluence will be accessible via both HTTP and HTTPS. However, you should not have a redirect port, nor rules in web.xml to redirect all traffic.
3. Instead of using web.xml to redirect traffic, insert a firewall rule to redirect all HTTP requests not from the Confluence server to the equivalent HTTPS URL. This ensures that users will only be able to access Confluence via HTTPS, as intended. If you have still left HTTP access for attachments enabled (to avoid the IE download bug) you must selectively enable those URLs as well.
4. Modify your Confluence RSS Feed macro feed link to use the HTTP URL, and restart Confluence.

Enabling and disabling the RSS Feed macro

The RSS Feed macro is a module of the Confluence HTML Macros plugin.

**To enable or disable the RSS Feed macro:**

1. Enable the Confluence HTML Macros plugin by following the instructions in Enabling HTML macros.
2. In the plugin module list of the HTML macros, find the RSS (rss-xhtml) module and hover your cursor over it to enable or disable it.

Search Results Macro

The Search Results macro searches your Confluence site based on search terms specified in the macro code, and displays the results on the wiki page.

**Using the Search Results Macro**
To add the Search Results macro to a page:

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in **Using Autocomplete**.

**To edit an existing macro:** Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search Terms</strong></td>
<td>none</td>
<td>The search terms which this macro will use to generate its results. You can refine your search query by using operators such as 'AND' and 'OR'. For example: <code>my_query1 AND my_query2</code>. For more information, take a look at the documentation on the Confluence search syntax.</td>
</tr>
<tr>
<td><strong>Maximum Number of Results</strong></td>
<td>10</td>
<td>Set a limit to the number of search results displayed.</td>
</tr>
<tr>
<td><strong>Restrict to this Space Key</strong></td>
<td>all</td>
<td>Specify the key of the space you want to search in. Note that this is case-sensitive.</td>
</tr>
<tr>
<td><strong>Content Type</strong></td>
<td>all</td>
<td>Specify the content type. The content types are: page, comments, blogpost, attachment, userinformation (the content of user profiles only) and spacedescription (the content of space descriptions only).</td>
</tr>
</tbody>
</table>
### Last Modified

| all | Specify a period of time in weeks, days, hours and/or minutes, to see the content modified within that time frame. For example:
| | - 2h 35m
| | - 3d 30m
| | These are the values you can use:
| | - w = weeks
| | - d = days
| | - h = hours
| | - m = minutes
| | If no time category is specified, Confluence assumes minutes. If you specify more than one time period (e.g. weeks and days), the periods must be separated by a space and they can come in any order. The time categories are not case sensitive e.g. '4d' is the same as '4D'. |

### Restrict to this Username

| all | Specify the username of a Confluence user, to show only content created or updated by that user. |

---

**Permissions**

When a user views the page containing the Search Results macro, the search results will show only pages and other content types for which the user has 'View' permission.

---

**Related Topics**

- Livesearch Macro
- Searching Confluence
- Working with Macros

Take me back to the Confluence User's Guide.

**Section Macro**

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

**Space Attachments Macro**

See Displaying a List of Attachments.

**Space Details Macro**

The Space Details macro renders the space's details in a table within the page.

**Using the Space Details Macro**

To add the Space Details macro to a page:
1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width of Table</td>
<td>100%</td>
<td>The width of the space details table, specified as a percentage (%) of the page width.</td>
</tr>
</tbody>
</table>

Related Topics

Editing Space Details
Working with Macros

This page describes the Space Jump Macro, which is provided with the Documentation theme. You can use space jumping to link from a page in one space to a page with the same name in another space, without knowing the name of the page when you create the link.

Example: We use the Space Jump macro to put a standard message at the top of our archive spaces, telling people that they’re reading an old version of the documentation and letting them jump quickly to the same page in the latest documentation. See the words ‘this page in the current documentation’ in the screenshot below.

⚠️ Advance warning of plans to merge Documentation theme with the default theme

This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, to be introduced in Confluence 5.0, includes a sidebar with contextual navigation. (For a preview, see the Confluence 5.0-m9 release notes.) Our plan is to include all the features of the Documentation theme into the default theme, and then remove the Documentation theme from Confluence.

If you are interested in this change and would like to give us feedback, please add a comment on this blog post: Advance warning of plans to merge Documentation theme with the default theme. We are especially interested to know which features of the Documentation theme you use and value the most.

The Space Jump macro inserts a link onto the page. When the reader clicks the link, they will jump to a page that has the same name in another space. You specify the space when you insert the Space Jump macro.

Take me back to the Confluence User’s Guide.
Using the Space Jump macro

To add the Space Jump macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>None</td>
<td>The space key that contains a page with the same page title that you want the link to jump to. Space keys are case-sensitive.</td>
</tr>
<tr>
<td>Alias</td>
<td>None</td>
<td>The text to display as the hyperlinked text. If you do not supply an alias, Confluence will display the page name.</td>
</tr>
</tbody>
</table>

**Notes**

What happens if there is no page with the same name in the target space?

For the space jump to work, the target space must contain a page with the same name as the page that renders the Space Jump macro. If the target space does not contain such a page, you will see a broken link. Confluence handles this in its usual manner: the link is coloured red. If you click the link, Confluence offers to create the
Can I use the Space Jump macro in any space?

Yes. You can use the Space Jump macro in any space, even if that space is not currently using the Documentation theme. Provided that the Documentation theme plugin and its components are installed and enabled on your Confluence site, the Space Jump macro is available in any space.

Spaces List Macro

The Spaces List macro is used to display a list of spaces within a page, similar to the list of spaces seen on the dashboard.

Using the Spaces List macro

To add the Spaces List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scope of spaces      | no        | all     | Specify the view from which spaces are listed. Available options are:
|                      |           |         | • all – All spaces in the Confluence installation. |
|                      |           |         | • category – Spaces grouped according to space categories. |
|                      |           |         | • favourite – Spaces which you have added to your favourites list. |
|                      |           |         | • new – New spaces which have been created within the last 7 days. |

Related pages:
- Working with Spaces
- Creating Content
- Working with Macros
- Confluence User’s Guide
Notes

There is a bug in this macro that prevents people from selecting a space category. For details, please refer to this issue: CONF-26597 - Authenticate to see issue details.

Status Macro

The Status macro displays a coloured lozenge (a rounded box) that is useful for reporting project status. You can choose the colour of the lozenge and the text that appears inside the lozenge. The macro also displays its current status in the editor, and you can change the status directly in the editor.

**ALL GOOD!**

**Screenshot:** Click on the Status macro lozenge to change the status.

**ALL GOOD!**

On this page:

- Using the Status Macro
- Parameters
- Related Topics

Using the Status Macro

To add the Status macro to a page using the Macro Browser:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Colour</td>
<td>Grey</td>
<td>The colour of the lozenge and its border. The border will be a darker version of the same colour. The following colours are available: Grey, Red, Yellow and Green.</td>
</tr>
</tbody>
</table>
Table of Contents Macro

Hint: For quick access from the editor toolbar, choose Insert > Table of Contents.

To add the Table of Contents macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

---

On this page:

- Using the Table of Contents Macro
- Macro Parameters
- Examples
- Code examples
- Notes

Related topics:

- Table of Content Zone Macro
- Page Tree Macro
- Using the Documentation Theme
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User's Guide

---

Macro Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The colour that you select.</td>
<td>The text that will appear inside the lozenge. If you do not specify any text, the title will be the colour of the lozenge, that is 'Grey', 'Red', 'Yellow' or 'Green'.</td>
</tr>
</tbody>
</table>
| **Output Type** | list | • list — produces a typical list type TOC.  
• flat — produces a horizontal menu-type series of links. |
| **Display Section Numbering** | clear | Select the check box to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3. |
| **List Style** | none | Select the style of bullet point for each list item. You can use any valid CSS style. For example:  
• none — no list style is displayed  
• circle — the list style is a circle  
• disc — the list style is a filled circle. This is the typical bullet list, and is used for this example list.  
• square — the list style is a square  
• decimal — the list is numbered (1, 2, 3, 4, 5)  
• lower-alpha — the list is lower-case, alphabetised (a, b, c, d, e)  
• lower-roman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
• upper-roman — the list style is upper roman numerals (I, II, III, IV, V, VI) |
<p>| <strong>Heading Indent</strong> | | Sets the indent for a list according to CSS quantities. Entering 10px will successively indent heading groups by 10px. For example, level 1 headings will be indented 10px and level 2 headings will be indented an additional 10px. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Separator</td>
<td>brackets</td>
<td>This parameter applies to flat lists only. You can enter any of the following values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- brackets — Each item is enclosed by square brackets: <code>[ ]</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- braces — Each item is enclosed by braces: <code>{ }</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- parens — Each item is enclosed by parentheses: <code>()</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pipe — Each item is separated by a pipe:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- anything — Each item is separated by the value you enter. You can enter any text as a separator, for example &quot;** **&quot;. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters.</td>
</tr>
<tr>
<td>Minimum Heading Level</td>
<td>1</td>
<td>Select the highest heading level to start your TOC list. For example, entering 2 will include levels 2, and lower, headings, but will not include level 1 headings.</td>
</tr>
<tr>
<td>Maximum Heading Level</td>
<td>7</td>
<td>Select the lowest heading level to include. For example, entering 2 will include levels 1 and 2, but will not include level 3 headings and below.</td>
</tr>
<tr>
<td>Include Headings</td>
<td></td>
<td>Filter headings to include according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td></td>
<td>Filter headings to exclude according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.</td>
</tr>
</tbody>
</table>
By default, the TOC is set to print. If you clear the check box, the TOC will not be visible when you print the page.

**CSS Class Name**

If you have custom TOC styles in your CSS style sheet, use this parameter to output the TOC inside `<div>` tags with the specified class attribute.

---

### Examples

The examples below are based on this table of contents:

- **Places**
  - Favourite Places
  - Unknown Places
- **Foods**
  - Favourite Foods
  - Unknown Foods
- **Things**
  - Favourite Foods
  - Unknown Foods

#### Filtered Table of Contents

This example filters the headings to include those that contain 'Favourite', but excludes headings which end with 'Things'. The list is styled with Roman numerals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

The resulting table of contents is:

I. Favourite Places  
II. Favourite Foods

#### Flat List

This example filters all headings to render a flat list of 'Unknowns' enclosed in square brackets (the default list style).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>flat</td>
</tr>
<tr>
<td>Maximum Heading Level</td>
<td>2</td>
</tr>
</tbody>
</table>
Include Headings

The resulting table of contents is:

| Unknown Places | Unknown Foods | Unknown Foods |

**Code examples**

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

**Notes**

- When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template – the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)

- Due to an outstanding issue in the Table of Contents macro (CONF-10619), the macro browser’s Refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Contents macro occurs only after the page is saved.

**Using HTML Heading Markup with the Table of Contents Macro**

The Table of Contents macro cannot handle HTML heading markup on its own. Hence, if you use the HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Contents macro will not create a contents list out of these headings. (For more information about this issue, please refer to TOC-93.)

However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Contents macro will incorporate these headings into your contents list.

```
<h2><a name="pagename-headingname">Heading Name</a></h2>
```

The syntax for the anchor name is the page name and heading name separated by a hyphen, in which the page and heading names have all spaces removed and are converted to lowercase. If punctuation marks occur within a page or heading name, each mark should usually be converted to its URL escape code in the anchor name.

**Table of Content Zone Macro**

The Table of Content Zone macro enables you to mark out a ‘page zone’ from which to create a table of contents. Styling the headings as a flat list enables you to enclose the page text by top and bottom navigation bars similar to web navigation. When styled as a list, headings are indented progressively.

**Using the Table of Content Zone Macro**

**To add the Table of Content Zone macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open,
where you can edit the parameters of the macro.

### Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>location</td>
<td>both</td>
<td>Specifies where in the zone the output list is displayed: top, bottom, or both, which encloses the page zone content.</td>
</tr>
<tr>
<td>Output Type</td>
<td>list</td>
<td>Specifies the layout for the table of contents:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- list – produces a vertical list, typical of a TOC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- flat – produces a horizontal menu-type series of links, for example: [Heading 1] [Heading 2] [Heading 3].</td>
</tr>
<tr>
<td>Display Section Numbering</td>
<td>false</td>
<td>Select to apply outline numbering to your headings, for example: 1.1, 1.2, 1.3.</td>
</tr>
</tbody>
</table>
| List Style          | none                                      | Specifies the style of bullet point for each list item. You can use any valid CSS style. For example:  
|                    |                                          | • none — no list style is displayed  
|                    |                                          | • circle — the list style is a circle  
|                    |                                          | • disc — the list style is a filled circle. This is the typical bullet list, and is the one we’re using for this example list  
|                    |                                          | • square — the list style is a square  
|                    |                                          | • decimal — the list is numbered (1, 2, 3, 4, 5)  
|                    |                                          | • lower-alpha — the list is lower-case, alphabetised (a, b, c, d, e)  
|                    |                                          | • lower-roman — the list style is lower roman numerals (i, ii, iii, iv, v, vi)  
|                    |                                          | • upper-roman — the list style is upper roman numerals (I, II, III, IV, V, VI)  
| Heading Indent     |                                          | Sets the indent for a list output type, according to CSS quantities. Entering "10px" will successively indent list heading levels by 10px. For example, h1 headings will be indented 10px and h2 headings will be indented an additional 10px. |
| **Separator** | brackets | Only applies to the **flat** output type. Specifies the display style of the links. You can enter any of the following values:
| | |  
| | | • **brackets** — Each item is enclosed by square brackets: `[ ]`.
| | | • **braces** — Each item is enclosed by braces: `{ }`.
| | | • **parens** — Each item is enclosed by parentheses: `{ }`.
| | | • **pipe** — Each item is separated by a pipe:
| | | • **anything** — Each is separated by the value you enter. You can enter any text as a separator, for example `****`. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters.
| **Minimum Heading Level** | 1 | Select the largest heading level to start your TOC list. For example, 2 will list h2, h3, and h4 headings, but will not include h1 headings.
| **Max Heading Level** | 7 | Select the smallest heading level to include in the TOC. For example, 2 will list h1 and h2, but will not include h3 and below.
| **Include Headings** | | Filter the included headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.
| **Exclude Headings** | | Exclude headings according to specific criteria. You can use wildcard characters. See Sun's Regex documentation for examples of constructing regular expression strings.
| **Printable** | true | By default, the TOC is set to print. If you clear this parameter, the TOC will not be visible when you print the page.
CSS Class Name

If you have a custom TOC in your CSS style sheet, you can use this parameter to output the TOC with the specified “class” attribute.

Examples

The examples are based on a page with the following headings:

- **Places**
  - Favourite Places
  - Unknown Places
- **Foods**
  - Favourite Foods
  - Unknown Foods
- **Things**
  - Favourite Foods
  - Unknown Foods

Filtered Table of Contents

This example will filter all headings to include those that contain “Favourite”, but will exclude any heading which ends with the word “Things”. The list is styled with upper-case Roman numerals.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>list</td>
</tr>
<tr>
<td>List Style</td>
<td>upper-roman</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Favourite.*</td>
</tr>
<tr>
<td>Exclude Headings</td>
<td>.*Things</td>
</tr>
</tbody>
</table>

**Screenshot: Filtered TOC ‘zone’ headings**

I. Favourite Places
   II. Favourite Foods

Flat List

This example will filter all headings to render a flat list of “Unknowns” enclosed in square brackets.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Type</td>
<td>flat</td>
</tr>
<tr>
<td>Separator</td>
<td>brackets</td>
</tr>
<tr>
<td>Max Heading Level</td>
<td>2</td>
</tr>
<tr>
<td>Include Headings</td>
<td>Unknown.*</td>
</tr>
</tbody>
</table>

**Screenshot: Filtered TOC ‘zone’ headings displayed as a flat list**
Notes

- Due to an outstanding issue in the Table of Content Zone macro (CONF-10619), the Macro Browser's Refresh function does not render any parameter modifications. Currently, the rendering of parameter value modifications to the Table of Content Zone macro occurs only after the page is saved.
- Using HTML Heading Markup with the Table of Content Zone Macro — The Table of Content Zone macro cannot handle HTML heading markup on its own. Hence, if you used the HTML and HTML Include macros to render HTML heading markup in a Confluence page, the Table of Content Zone macro will not create a contents list out of these headings. (For more information on about this issue, please refer to TOC-93.)

However, if you insert an HTML anchor into each HTML heading on your page (based on the following syntax), the Table of Content Zone macro will incorporate these headings into your contents list.

```html
<h2><a name="pagename-headingname"></a>Heading Name</h2>
```

The syntax for the anchor name is usually the page name and heading name separated by a hyphen, in which the page and heading names have all spaces removed and are converted to lowercase. If punctuation marks occur within a page or heading name, each mark should usually be converted to its URL escape code in the anchor name.

Tasklist Macro

The Tasklist macro allows you to create and update a list of tasks on the wiki page. Users viewing the page can modify the tasks without having to edit the page, provided they have the required permissions to modify the page.

You may also be interested in the lightweight task list that you can add directly onto your page, via the editor insert menu. This method also allows you to notify users that tasks have been assigned to them. See Managing Tasks in Confluence.

Using the Tasklist macro

**To add the Tasklist macro to a page:**

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.
On this page:

- Using the Tasklist macro
- Parameters
- Editing the task list while viewing a page
- Sorting the tasks
- Viewing the progress on tasks completed
- Notes

Related pages:

- Managing Tasks in Confluence
- Working with Macros
- Confluence User's Guide

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>'Task List'</td>
<td>The name of the task list. This is displayed as the title above the list of tasks.</td>
</tr>
<tr>
<td>Width of List</td>
<td>530px</td>
<td>The width of the task list.</td>
</tr>
<tr>
<td>Enable Locking</td>
<td>clear</td>
<td>When selected, you can lock individual tasks so that they cannot be changed. See instructions below on editing the task list.</td>
</tr>
<tr>
<td>Prompt on Delete</td>
<td>clear</td>
<td>When selected, the user must confirm the deletion of a task in the list.</td>
</tr>
</tbody>
</table>

Editing the task list while viewing a page

While viewing a page, you can change the tasks in a task list as follows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adding a task</td>
<td>Type the task description in the box under the list title, and click Add.</td>
</tr>
<tr>
<td>Completing/uncompleting a task</td>
<td>Click the check box next to a task to mark the task as complete. The task name will become a lighter color and the progress bar will be updated. Clear the check box to mark the task as uncompleted. You can also click Uncheck all to mark all tasks as uncompleted.</td>
</tr>
</tbody>
</table>
## Editing a task
Move your cursor over the task and click the edit icon (pencil) that appears to the right of the task. The task name will become editable and the edit icon will be replaced with a save icon. Make your change and press the ‘Enter’ key to save or click the save icon.

## Deleting a task
Move your cursor over the task and click the delete icon (trash can) that appears to the right of the task.

## Viewing details of a task
Click the arrow icon to the left of the task name. The task details will open in an expanded view.

## Locking a task
Provided that the Enable Locking parameter has been selected, you can click the lock icon to prevent the task from being edited, deleted, or otherwise changed.

## Changing the priority
When the task details are visible, click the appropriate option — **High**, **Medium** or **Low**.

## Assigning the task
When the task details are visible, change the assignee of the task by typing in or searching for a username.

---

### Screenshot: Task List showing task details

![Planning a Holiday](image)

<table>
<thead>
<tr>
<th>Priority</th>
<th>Assigned To</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>smaddox</td>
</tr>
</tbody>
</table>

### Sorting the tasks
There are two ways to sort the tasks in the list:

- Using the **Sort by** list.
- Using drag and drop.

Select one of the sort options from the ‘Sort by’ list:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>This is the default option.</td>
</tr>
<tr>
<td>Priority</td>
<td>Sort the list in order of the priority you have allocated to each task.</td>
</tr>
<tr>
<td>Date Created</td>
<td>Sort the list in order of the dates upon which the tasks were created.</td>
</tr>
<tr>
<td>Completed</td>
<td>Move all completed tasks to the bottom or top of the list.</td>
</tr>
<tr>
<td>Name</td>
<td>Sort the list in order of the task names.</td>
</tr>
<tr>
<td>Assignee</td>
<td>Sort the list in order of the usernames assigned to the tasks.</td>
</tr>
</tbody>
</table>

Once you have selected a sort option, use the icon beside the **Sort by** box to reverse the sort order.

**Dragging and dropping a task into a new position:**

Drag a task up or down the list using the 'drag me' handle to the right of the task name. Make sure the task is positioned to the left of the existing tasks. A space will open and you will be able to drop the task into its new position.

**Viewing the progress on tasks completed**

The bar at the top of the task list displays two different colours, indicating the percentage of tasks completed.

*Screenshot: Progress Bar on Task List*

<table>
<thead>
<tr>
<th>Planning a Holiday</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Task List" /></td>
</tr>
</tbody>
</table>

**Notes**

- It is not possible to add a due date to the task list. If you are interested in this improvement request, you can comment on or vote for this issue: ![CONF-7371 - Authenticate](image) to see issue details.
- The Tasklist macro does not notify users that a task has been assigned to them. But you can do that using the lightweight task list accessible from the editor tool bar. See Managing Tasks in Confluence.

**Tip Macro**

Using the Tip macro, you can highlight a helpful tip on a Confluence page. The macro creates a green-coloured box surrounding your text as shown below.
Using the Tip macro

To add the Tip macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the tip. If specified, it will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Tip Icon</td>
<td>true</td>
<td>If cleared, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

User List Macro

The User List macro displays a list of users registered in Confluence, based on their group membership.

Using the User List Macro

To add the User List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open,
where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group(s)</td>
<td>none</td>
<td>Specifies one or more groups whose Confluence users you want to list, using a comma-separated list of group names. To see all users registered in a Confluence installation, specify an asterisk (&quot;*&quot;) for this parameter's value.</td>
</tr>
<tr>
<td>Display Online/Offline Users</td>
<td>none</td>
<td>Select to generate a list of online users. Clear to generate a list of offline users. In order to make this feature functional, a System Administrator needs to enable the User Log In Listener for your Confluence site. Not applicable to Confluence OnDemand.</td>
</tr>
</tbody>
</table>

Related Topics

- Working with Macros
- Configuring the User List Macro *Not applicable to Confluence OnDemand.*
- Confluence User's Guide
- User Profile Macro

The User Profile macro displays a short summary of any Confluence user's profile on your Confluence page or blog. This is the same summary that appears in a Hover Profile, which appears whenever you mouse-over any user's name in the Confluence interface.

> The information contained within your own summarised profile can be edited using your User Profile view.

**Screenshot: Example of the User Profile Macro**

![Leah Admin](sample@email.com.au)

"Updating Confluence documentation"

**Position:** Tech Writer

**Department:** Department of Awesome

**Location:** Atlassian, Sydney
Using the User Profile Macro

To add the User Profile macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The username of the Confluence user whose profile summary you wish to show.</td>
</tr>
</tbody>
</table>

**User Status List Macro**

The User Status List macro displays a history of any Confluence user's status updates on your Confluence page or blog. This is the same history that appears in the user's Status Updates view.

**Screenshot: Example output of the User Status List macro**

```
“Time to look at networks
Clear · Delete · Feb 15, 2013

“Upgrading my profile picture
Delete · Feb 15, 2013

“Making Confluence sing...
Delete · Feb 15, 2013
```

Related pages:

- Working with Macros
- User Status Updates
- Confluence User’s Guide.
Using the User Status List Macro

To add the User Status List macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>none</td>
<td>The username of the Confluence user whose history of status updates you wish to show.</td>
</tr>
</tbody>
</table>

If you wish to list status updates made by more than just one user, you can use the Recently Updated macro with the following parameter-value combinations:

- Include these Content Types Only — status
- Author(s) by username — the user(s) whose status updates you want to include in the list. If you leave this field blank, the status updates of all users will be included.

View File Macro

The View File macro allows you to embed an Office or PDF document into your Confluence page. First attach the document to a wiki page and then use one of the View File macros to display the document's content.

When users view the page, they will see the content of the Office document. Users do not need to have Office installed in order to see the content of the Office document. If they do have Office installed, users will be able to open the document for editing in their Office application.

For a full list of Office Connector prerequisites and limitations, please refer to:

- Office Connector Prerequisites
- Office Connector Limitations and Known Issue

For an overview of all Office Connector features, please refer to Working with the Office Connector.

On this page:

- Displaying an Office or PDF Document in Confluence
- Parameters for the Office and PDF Macros
- Editing a Word Document or Excel Spreadsheet
- Troubleshooting
- Related Topics

Displaying an Office or PDF Document in Confluence

To display an Office or PDF document in a page, use one of the following View File macros in the macro browser:

- Office Excel
To add one of the View File macros to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters for the Office and PDF Macros**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All View File macros</td>
<td>Page Name</td>
<td>The page which contains the macro</td>
<td>Enter a page name, if you wish to display a document which is attached to another Confluence page.</td>
</tr>
<tr>
<td></td>
<td>File Name</td>
<td>none</td>
<td>The file name of the Office or PDF document to be displayed. The document must be attached to a page on your Confluence site.</td>
</tr>
<tr>
<td>Office Excel</td>
<td>Show Grid?</td>
<td>true</td>
<td>Select to show grid lines around each cell of the Excel spreadsheet. Clear to hide these grid lines.</td>
</tr>
<tr>
<td></td>
<td>Worksheet Name</td>
<td>Last worksheet viewed in the spreadsheet</td>
<td>The name of the worksheet that you want displayed.</td>
</tr>
<tr>
<td></td>
<td>Last Row</td>
<td>Last row with content</td>
<td>The number of the last row you want displayed, starting from '0' as the first row.</td>
</tr>
<tr>
<td></td>
<td>Last Column</td>
<td>Last column with content</td>
<td>The number of the last column you want displayed, starting from '0' as the first column.</td>
</tr>
</tbody>
</table>
### Office Powerpoint

<table>
<thead>
<tr>
<th>Office Powerpoint</th>
<th>Height</th>
<th>Specify the height of the display, in pixels (default) or as a percentage of the window's height.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide Number</td>
<td>none</td>
<td>Specify the number of the slide that you want displayed on the Confluence page, where the first slide is numbered zero. Instead of a slide show, the page will display just the single slide, represented as a JPEG image.</td>
</tr>
<tr>
<td>Width</td>
<td></td>
<td>Specify the width of the display, in pixels (default) or as a percentage of the window's width.</td>
</tr>
</tbody>
</table>

**Reducing the size of the spreadsheet**

Use the **Last Column** and **Last Row** parameters to reduce the size of the spreadsheet displayed on the wiki page. This is especially useful to prevent the display from showing empty cells. This will also help to prevent 'out of memory' errors.

**Presentation display options**

By default, a presentation is displayed as a dynamic slide show, using Adobe Flash Player. However, you can use the **Slide Number** parameter to display just one of the slides as a static JPEG image.

---

**Editing a Word Document or Excel Spreadsheet**

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence by clicking the title bar of the document.

You will find detailed instructions in **Editing an Office Document from Confluence**.

**Troubleshooting**

Problems? Please refer to our guide to the **Office Connector limitations and known issues**.

**Related Topics**

- Working with the Office Connector
- Working with Macros

**Take me back to the Confluence User’s Guide.**

**Warning Macro**

The Warning macro allows you to highlight a warning note on a Confluence page.

It creates a red-coloured box surrounding your text as shown below.
Warning Macro Example
This text is rendered inside the warning macro.

Using the Warning Macro

To add the Warning macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type {} and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

Parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optional Title</td>
<td>none</td>
<td>The title of the warning note. If specified, will be displayed in bold next to the icon.</td>
</tr>
<tr>
<td>Show Warning Icon</td>
<td>true</td>
<td>If &quot;false&quot;, the icon will not be displayed.</td>
</tr>
</tbody>
</table>

Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

Widget Connector Macro

The Widget macro, or Widget Connector, allows you to embed certain multimedia content from other web sites into your Confluence page.

It supports the following content:

- Gadgets and other widgets: Google Gadgets, Widgetbox.
- Videos: YouTube, MySpace Video, Yahoo Video, Dailymotion, Episodic, Vimeo, Metacafe, blip.tv, Viddler.
- Photos and images: Flickr, Skitch.com.
- Micro-blogging: Twitter, FriendFeed, BackType.
- Documents and presentations: SlideShare, SlideRocket, Scribd, presentations on Google Docs.
- Calendars: Google Calendar.
- Forms and online databases: Wufoo HTML Form Builder.
- Support and customer satisfaction: Get Satisfaction.

There are live examples of many of these on the widget examples page. If you wish to extend the functionality of this plugin, please see Extending the Widget Connector.
Using the Widget Connector

To add the Widget Connector to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete:** Type `{` and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro:** Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

**Parameters**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Site’s Widget URL</td>
<td>This is the URL provided by the external web site for embedding content from that web site onto another web page.</td>
</tr>
<tr>
<td>Pixel Height (Value Only)</td>
<td>Specify the height of the display, in pixels.</td>
</tr>
<tr>
<td>Pixel Width (Value Only)</td>
<td>Specify the width of the display, in pixels.</td>
</tr>
</tbody>
</table>

**Live Example of Flickr Photos**

This example displays all photos from Flickr with the tag ‘Atlassian’. It uses this URL: http://www.flickr.com/photos/tags/atlassian/

**Live Example of Google Gadget**

This example lets you play with a Google Gadget, Gadzi’s Monkey Virtual Pet. It uses this URL: http://www.google.com/ig/directory?synd=open&num=24&url=http://www.gadzi.com/gadgets/monkey.xml&output=html

**More Examples of Macro Code**

Google Gadgets

You need to find the URL for the Google Gadget you want to display.

Here is one way to find a gadget’s URL:

1. Go to the Google Gadgets directory.
2. Find the gadget you want then click its name, such as ‘Spider’.
3. The gadget's summary page will open. Copy the URL from your browser’s address bar. The URL looks something like this one:
You can also use the URL of the 'add gadget' page. The page is called 'Add "gadgetx" to your iGoogle page':

1. There are a couple of ways to get to the 'add gadget' page:
   - Click a '+Google' button underneath the gadget when displayed on a page somewhere.
   - Or click 'Add Stuff' on your iGoogle page.
2. Copy the URL from your browser's address bar. The URL would look something like this one:


Widgetbox widgets

You will need to find the URL for the Widgetbox widget you want to display.

Here is one way to find a widget's URL:

1. Ensure you are logged in to Widgetbox and that you are viewing the Widgetbox Gallery.
2. Find the widget you want then click its name, such as 'cyber-pet'.
3. The widget's summary page will open. Within the Get Widget section, click the Atlassian Confluence icon. The Widgetbox Add to Confluence dialog box appears, containing the URL required for the Widgetbox Add to Confluence Widget Macro.
   - If you cannot see this icon, click the more... link to reveal it.
4. In the Widgetbox Add to Confluence dialog box, click Copy.
5. Copy the URL from your browser's address bar. The URL looks something like this one:

   http://widgetbox.com/confluence/b8327e33-c8eb-4a38-b842-fba866ffdd28

YouTube

You will need to find the URL for the YouTube video that you want to display.

To find a YouTube video's URL:

1. Go to YouTube and search for the video you want.
2. Click the title of the video, such as 'Wikis in Plain English'.
3. The video's summary page will open on YouTube. Choose Share.
4. Choose Options, located under the video's URL.
5. Choose Long link, then copy the long URL. It looks something like this:

   http://au.youtube.com/watch?v=-dnL00TdmLY

   **Note:** You must use the long YouTube URL. The shortened URL (like this one: http://www.youtube.com/watch?v=<video_key>) does not work in the widget connector.
MySpace Videos

You will need to find the URL for the MySpace video that you want to display.

To find a MySpace video's URL:

1. Go to MySpace Video and search for the video you want.
2. Click the title of the video, such as 'Glacier Creek Confluence Time Lapse'.
3. The video's summary page will open. Copy the URL from your browser's address bar. The URL looks something like this:

http://vids.myspace.com/index.cfm?fuseaction=vids.individual&videoid=3376248&searchid=20c789f6-1ae9-459a-bfec-75efcfc2847c

Yahoo Video

You will need to find the URL for the Yahoo video that you want to display.

To find a Yahoo video's URL:

1. Go to Yahoo Video and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

http://video.yahoo.com/watch/423158/2424140

If you are unable to obtain a unique URL from your browser's address bar, click the envelope (Share) icon on the lower section of the video screen and copy the contents of the Link field.

Dailymotion Video

You will need to find the URL for the Dailymotion video that you want to display.

To find a Dailymotion video's URL:

1. Go to Dailymotion and search for the video you want.
2. Click the title of the video, such as 'Wiki Technology Trend: Past, Now and Future'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this:

http://www.dailymotion.com/user/spacevidcast/video/x7zevj_spacevidcast-2009-promo-video_tech

If you are unable to obtain a unique URL from your browser's address bar, click Menu at the lower right section of the video screen, select URL & Embed Code and copy the contents of the Link field.

Episodic

You will need an Episodic user account if you want to create and distribute videos via Episodic.

To embed an Episodic video onto a Confluence page:

1. Find the video and copy the URL from the address bar of your browser. The URL looks something like this:
2. Paste the URL into the Web Site's Widget URL box in the Macro Browser.

Vimeo

You will need to find the URL for the Vimeo video that you want to display.

To find a Vimeo video's URL:

1. Go to Vimeo and search for the video you want.
2. Click the title of the video, such as 'The Wiki Show - Allison the Russian High Kicker'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   http://www.vimeo.com/909808

Metacafe

You will need to find the URL for the Metacafe video that you want to display.

To find a Metacafe video's URL:

1. Go to Metacafe and search for the video you want.
2. Click the title of the video, such as 'Wikis In Plain English (How To)'.
3. The video's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   http://www.metacafe.com/watch/679493/wikis_in_plain_english_how_to/

blip.tv

This integration is currently broken. Please refer to CONF-27266 for details of the issue.

Viddler

This integration is currently broken. Please refer to CONF-27267 for details of the issue.

Flickr

You can embed a slide show of photos from Flickr by supplying a URL that specifies one of the following:

- Photos with a specific tag.
- Photos belonging to the photostream of a specific Flickr user.
- A set of photos as defined by the Flickr user.
- A user's photostream starting at a specific photo.

If you want to do something else, we suggest that you try any Flickr URL. It should work.

Below are some examples of the Widget macro code for embedding Flickr images.

Flickr Photos with a Specific Tag

This URL displays a slide show of Flickr photos that are tagged with the word 'Atlassian'

http://www.flickr.com/photos/your/flickr/with/tag/
Flickr Photos from a Specific User

This URL displays a slide show of photos from the Flickr photostream of user 'Atlassian': [http://www.flickr.com/photos/atlassian/](http://www.flickr.com/photos/atlassian/)

Flickr Photos from a Specific Set

This URL displays a slide show of Flickr photos from the set 'Melbourne Cup - November 2008' created by user 'Atlassian': [http://www.flickr.com/photos/atlassian/sets/72157608657271078/](http://www.flickr.com/photos/atlassian/sets/72157608657271078/)

A Specific Flickr Photo

This URL displays a slide show of photos from the Flickr photostream of the user 'Atlassian', starting with a specific photo: [http://www.flickr.com/photos/atlassian/3003538919/](http://www.flickr.com/photos/atlassian/3003538919/)

Skitch.com

You will need to find the URL for the Skitch image that you want to display.

To embed a Skitch image onto a Confluence page:

1. Go to [Skitch.com](http://skitch.com).
2. Find the image and copy the URL from the address bar of your browser. The URL looks something like this:

   http://skitch.com/atlassian/411g/example-image

**Note:** Skitch is now integrated with Evernote, as described in this blog post from *The Next Web: Evernote is bringing Skitch into its core service, Skitch.com will be archived*. As a result, private images on Skitch.com are no longer accessible and will not work in the Confluence widget connector. Existing public images on Skitch.com will remain available.

Twitter

Use a *Twitter* link in the Widget macro to display a dynamic list of the latest tweets sent by a user or matching a Twitter search.

To display the latest messages from a Twitter user, add the user's Twitter link as the URL in the Widget macro.

[http://twitter.com/username](http://twitter.com/username)

This URL will display Mike Cannon-Brooke's Twitter messages: [http://twitter.com/mcannonbrookes](http://twitter.com/mcannonbrookes)

To display the latest messages resulting from a Twitter search, add the Twitter search link as a URL in the Widget macro.

- Make sure you use the supported format of the search URL:

  [http://search.twitter.com/search?q=my search term](http://search.twitter.com/search?q=my search term)

  The following format is *not* supported:

  [http://twitter.com/#search?q=my search term](http://twitter.com/#search?q=my search term)

  - The '#' tag is not supported (not even in its URL-encoded form %23).
This URL will display the most recent tweets containing the word 'AtlassianDragons': http://search.twitter.com/search?q=AtlassianDragons

FriendFeed

To display the latest messages from a FriendFeed user, add the user's FriendFeed link as the URL in the Widget macro. For example:

BackType

To display the latest blog or website comments from a BackType user, add the user's BackType widget link as the URL in the Widget macro. For example:

SlideShare

You will need to find the URL for the SlideShare presentation that you want to display.

To find a SlideShare presentation's URL:

1. Go to SlideShare and search for the presentation you want.
2. Click the title of the presentation, such as 'Using JIRA & Greenhopper for Agile Development'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:

   http://www.slideshare.net/jleyser/using-jira-greenhopper-for-agile-development-presentation

SlideRocket

You will need to find the URL for the SlideRocket presentation that you want to display.

To find a SlideRocket presentation's URL:

1. Log in to SlideRocket and go to your library of presentations.
2. Copy the 'web link' for the presentation you want to display. This will give you a URL that looks something like this one:

   http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

3. Paste the URL into the Widget macro code on your Confluence page.

Scribd

You will need to find the URL for the Scribd presentation that you want to display.

To find a Scribd presentation's URL:

1. Go to Scribd and search for the presentation you want.
2. Click the title of the presentation, such as 'My Sea Friends Coloring Book'.
3. The presentation's summary page will open. Copy the URL from the address bar of your browser. The URL looks something like this one:


4. Paste the URL into the Widget macro code on your Confluence page.
Google Docs Presentations

This integration is currently broken. Please refer to 📌 CONF-24927 for details of the issue.

Google Calendar

You can embed a Google Calendar into your page and to do this, you will need to add the URL for the Google Calendar that you want to display.

To find the URL for a Google Calendar:

1. Log in to Google Calendar.
2. In the calendar list on the left side of the page, ensure the appropriate calendar is selected, click the down-arrow button next to the calendar name and then select the Calendar settings option. (Alternatively, if available, click the Manage Calendars link at the bottom of the calendar list and then click the name of the appropriate calendar.)
3. In the Calendar Address section, click the HTML button. A pop-up message with your calendar’s public URL appears.
4. Copy the URL from this pop-up message. The URL looks something like this:

   http://www.google.com/calendar/embed?src=somebody%40example.com&ctz=Australia/Sydney

5. Paste the URL into the Widget macro code on your Confluence page.

Wufoo HTML Form Builder

To display an HTML form built in the Wufoo HTML Form Builder, add the form’s link as a URL to the Widget Macro. For example:

http://examples.wufoo.com/forms/contact-form/

Get Satisfaction social support application

To display a feedback form for a Get Satisfaction community, add the community or company link as a URL to the Widget Macro. For example:

http://getsatisfaction.com/atlassian

Troubleshooting

If the URL given in the Widget Connector macro does not work, the macro displays an icon and the base URL.

For example, the following code:

http://example.com/invalid

will result in an image like the one below:
Related Topics

Working with Macros

Take me back to the Confluence User's Guide.

**Widget Connector Examples**

This page contains working examples of some services currently supported by the Widget Connector. This page lets you preview what each widget will look like and see how to interact with it. For detailed usage, see Widget Connector Macro.

**Flickr**

- [http://www.flickr.com/photos/tags/atlassian](http://www.flickr.com/photos/tags/atlassian)
On this page:

- Flickr
- Google Docs
- YouTube
- MySpace
- Vimeo
- BlipTV
- Viddler
- Skitch
- Twitter
- FriendFeed
- SlideShare
- SlideRocket
- Scribd
- Wufoo
- Example of widget error message

Related pages:

- Widget Connector Macro
- Working with Macros
- Confluence User's Guide

**Google Docs**

This integration is currently broken. Please refer to 🔒 CONF-24927 for details of the issue.

**YouTube**

http://au.youtube.com/watch?v=-dnL00TdmLY

**Note:** You must use the long YouTube URL, available under **Share > Options**. For detailed instructions, see the user's guide to the widget macro.

**MySpace**

vids.myspace.com

http://vids.myspace.com/index.cfm?fuseaction=vids.individual&videoid=3376248&searchid=20c789f6-1ae9-459a-bfec-75efcfc2847c

**Vimeo**

http://www.vimeo.com/909808

Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](http://creativecommons.org/licenses/by/2.5/au/).
BlipTV
This integration is currently broken. Please refer to CONF-27266 for details of the issue.

Viddler
This integration is currently broken. Please refer to CONF-27267 for details of the issue.

Skitch
Skitch is now integrated with Evernote, as described in this blog post from The Next Web: Evernote is bringing Skitch into its core service, Skitch.com will be archived. As a result, private images on Skitch.com are no longer accessible and will not work in the Confluence widget connector. Existing public images on Skitch.com will remain available.

Twitter
http://twitter.com/mcannonbrookes
http://search.twitter.com/search?q=AtlassianDragons

FriendFeed
http://friendfeed.com/myname

SlideShare
http://www.slideshare.net/jleyser/using-jira-greenhopper-for-agile-development-presentation

SlideRocket
http://app.sliderocket.com/app/FullPlayer.aspx?id=132f9db7-b0fb-4f51-b974-36652774971b

Scribd

Wufoo
http://examples.wufoo.com/forms/contact-form/

Example of widget error message
This is an example of the error message you will see, if the Widget connector cannot find the URL or service specified.

![Example Image](example.com)

http://example.com/invalid

**Working with Drafts**

A draft is a 'snapshot' of unsaved page content, which Confluence creates automatically at regular intervals while you are editing a page or blog post. This can minimise the loss of work if your Confluence site experiences a problem, since you can retrieve the page content from your last saved draft.

*How do drafts work in Confluence?*

At regular intervals, Confluence automatically saves a draft of the page you are editing. If a network failure or system error prevents you from saving your page, you can retrieve its last saved draft and continue working on the page from the last saved draft.

Drafts are created while you are adding and editing a page or blog post. Each new draft replaces the previously saved draft. By default, Confluence saves a draft of your page once every thirty seconds. However, a Confluence administrator can configure how often drafts are saved. In addition, whenever you edit a page and then move to another screen, Confluence will automatically save a draft.

When you edit the page again, Confluence will let you know that a version of the page you are editing was not saved and will give you the option to resume editing it.

Each time Confluence saves a draft, it displays a message and the time of the last save near the **Save** button on the edit screen.

### On this page:

- How do drafts work in Confluence?
- Viewing drafts
- Viewing your unsaved changes

### Related pages:

- Resuming the Editing of a Draft
- Configuring the Time Interval at which Drafts are Saved
- Concurrent Editing and Merging Changes
- Confluence User’s Guide

**Screenshot: Message displaying the time when the draft was last saved**

![Screenshot](what-did-you-change)

Draft autosaved at 1:56 PM (view change)

More about drafts:

- A user only has access to the drafts of pages they have been working on and whose content has not yet been saved.
- A user cannot create a draft explicitly.
- A user's drafts are listed in the 'Drafts' tab of their profile.
- Once a user has resumed editing a draft, or chosen to discard it, the draft is removed from their drafts tab.

**Viewing drafts**

Your drafts are listed on the **Drafts** tab of your user profile.

**To see your drafts:**

Choose your profile picture at top right of the screen, then choose **Drafts**.

**Viewing your unsaved changes**

While editing a page or blog post, you can view any 'unsaved' changes you have made since the last automatically saved draft, by clicking **view change** (near the **Save** button).

**Screenshot: Segment of the unpublished changes window**

![Unpublished Changes for 'Sample Page'](image)

Configuring the Time Interval at which Drafts are Saved

By default, Confluence saves a draft of your page once every thirty seconds. Confluence administrators can configure how often drafts are saved.

As a **Confluence administrator**, you can set the time interval at which drafts are saved as follows:

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Click **General Configuration** in the left-hand panel.
3. Edit the setting for **Draft Save Interval**.

**Related pages:**

- Working with Drafts
- Resuming the Editing of a Draft

**Concurrent Editing and Merging Changes**

Sometimes, two or more people may edit a page at the same time. When this happens, Confluence will do its best to ensure that nobody's changes are lost.

**How will I know if someone else is editing the same page as I am?**

If another user is editing the same page as you, Confluence will display a message above your edit screen letting you know who the other user is and when the last edit was made.
What happens if two of us are editing the same page and the other user saves before I do?

If someone else has saved the page before you, when you click 'Save', Confluence will check if there are any conflicts between your changes and theirs. If there are no conflicting changes, Confluence will merge both the edits successfully. If there are any conflicts, Confluence will display them for you and give you the option to either 'Overwrite' the other user's changes, 'Merge your changes' manually, or 'Discard' them.

Example Scenario

For example, Alice and Bob both edit the same page at the same time.

If Alice clicks save before Bob, Bob is now effectively editing an out-of-date version of the page. When Bob clicks save, Confluence will examine his changes to see if any overlap with Alice's. If the changes do not overlap (i.e. Alice and Bob edited different parts of the page), Bob's changes will be merged with Alice's automatically.

If Bob's changes overlap with Alice's, Confluence will display an error message to Bob showing where Alice has changed the page, and giving Bob the options to overwrite Alice's changes with his own, to re-edit the document to incorporate Alice's work, or to cancel his own changes entirely.

Resuming the Editing of a Draft

If you have typed some content into a Confluence page or blog post, Confluence will save a draft of it, even if you were not able to successfully save the page or blog post, or add a title to it.

There are two ways to resume editing an unsaved page or blog post:

A. Using your drafts view. To resume editing a draft from this view:

1. Choose your profile picture at top right of the screen, then choose Drafts.
2. Choose Resume Editing next to the appropriate draft to resume editing that draft.

Note: If you had not yet entered a page title, the draft will be listed with the title 'Untitled'.

B. If you had created a new page or blog post but did not save it, then when you next add a page or blog post in that space, Confluence will ask you if you want to resume editing the page that was not saved. If you click resume editing, the draft and its unsaved content will be restored, allowing you to continue editing it.
What happens if I am editing the draft of a page that has since been updated?

When this happens, Confluence will display a message informing you that you are editing an outdated page. If there are no conflicts between the two versions, Confluence will give you the option to **Merge and Resume editing**.

If there are any conflicts, Confluence will give you the option to **View the Conflict** or to **Discard** your changes.

**Recording Change Comments**

A 'change comment' is a short description that summarises the changes made to a page during an editing session. Change comments are a useful way of keeping track of the history of a page.

A change comment is not the same as a comment added to a page. Refer to [Commenting on pages and blog posts](#) for information about that type of comment.

Note that once a change comment has been added and the page has been saved, it is not possible to update or remove the change comment.

**On this page:**
- Entering a Change Comment
- Viewing a Change Comment
- Viewing a History of Change Comments

**Related pages:**
- Viewing Page Information
- Page History and Page Comparison Views
- Confluence User’s Guide

**Entering a Change Comment**

You can enter change comments in the field located below the edit screen:

*Screenshot: Entering change comments*

**Viewing a Change Comment**

Once a comment has been added, it becomes visible in the view mode of the page, so that users are aware of the most recent changes made to a page. If a comment has been recorded, you will see a **show comment** link below the page title. Click the link to view the comment.

*Screenshot: The 'show comment' link*

The **hide comment** link allows you to hide the comment again, so that it does not distract you from the content of the page.

*Screenshot: The 'hide comment' link*
Viewing a History of Change Comments

The change comments for a page are recorded under the 'Recent Changes' section of the page's 'Info' view and in the page's 'History' view.

Screenshot: History of change comments on Info view

<table>
<thead>
<tr>
<th>Time</th>
<th>Editor</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feb 14, 2013 10:58</td>
<td>Josh User</td>
<td>Added penguin image</td>
</tr>
<tr>
<td>Feb 14, 2013 10:57</td>
<td>Sophie User</td>
<td>Fixed a typo</td>
</tr>
<tr>
<td>Feb 14, 2013 09:06</td>
<td>Rach Admin</td>
<td></td>
</tr>
</tbody>
</table>

Screenshot: History of change comments on History view

Creating Attractive and Dynamic Pages

Confluence has a number of features that help you build attractive pages to engage your readers and give them the opportunity to interact with up-to-date information. This page summarises those features and provides links to detailed instructions.

Adding visual appeal
Pictures, photographs and screenshots. Confluence pages can display images from your Confluence site and from other websites. To put an image into Confluence, you can upload it and attach it to a page or blog post, then display it on any page, blog post or comment. Alternatively, display an image from a remote location via the web address (URL). See Displaying Images.

Galleries. Use the Gallery Macro to display a set of images. When viewing the page, people can click any of the pictures to zoom in and view the images as a slide show.

People. Add a Profile Picture Macro to show a picture of a Confluence user, or a User Profile Macro to show a summary of the person’s profile as well as their avatar.

Multimedia. You can display movies, animations and videos, and embed audio files on your Confluence page. For example, Confluence supports Adobe Flash, MP3, MP4, and various other movie formats. See Embedding Multimedia Content.

Social video and image sharing. The Widget macro displays live content from social sites such as YouTube and other video sharing sites, and Flickr for shared photographs. See the guide to the Widget Connector Macro.

On this page:
- Adding visual appeal
- Bringing numbers to life
- Displaying presentations and documents
- Pulling in content from your issue tracker
- Telling a story in pictures
- Varying the structure of your pages
- Integrating your content with social media
- Showing activity streams

Related pages:
- Working with Macros
- Using the Editor
- Confluence User’s Guide

Bringing numbers to life

The Chart Macro offers a variety of graphs and charts that you can use to illustrate statistics and other numerical data.

Illustration: A 3-dimensional bar chart produced by the Chart macro
Displaying presentations and documents

Display your Office documents and other presentations directly in Confluence.

- Attach your Office documents to a Confluence page then display them on the page, using the View File Macro. This works for Excel spreadsheets, PowerPoint presentations and Word documents.
- Display PDF files in Confluence too, also with the View File Macro.
- Use the Widget Connector Macro to show slide decks hosted on SlideShare and other online presentation sites.

Pulling in content from your issue tracker

Many project teams and customers have useful information on a JIRA issue tracker. Rather than copying and pasting it onto your Confluence page, you can display it directly from the source, thus ensuring that the information shown in Confluence is always up to date.

Link to a feature request in your issue tracker, or display a list of fixed issues – useful for release notes and project planning. See the JIRA Issues Macro and the JIRA option in the Confluence editor.

Illustration: A PowerPoint slide deck

Telling a story in pictures

A number of Confluence add-ons provide sophisticated tools for creating diagrams and mockups.
For example:

- Balsamiq Mockups for Confluence
- Creately for Confluence
- Gliffy Confluence Plugin
- Graphviz Plugin for Confluence
- Lucidchart for Confluence

Search the Atlassian Marketplace for more add-ons.

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Varying the structure of your pages

Page layouts provide a fixed set of columns and panels for your page. Alternatively, try breaking up your page into a varied set of sections and columns, via the flexible Section and Column macros. See the detailed guidelines to Working with Page Layouts and Columns and Sections.

Do you need to display tabular data, which your readers can sort when viewing the page? See Working with Tables.

Use other macros to highlight and format sections of your page:

- Panel
- Tip
- Info
- Note
- Warning
- Code block
- Noformat

*Illustration: A Gliffy diagram*
Integrating your content with social media

People share information on various social sites. You can make Confluence a focal point where people collect their shared information and see what is happening in the areas that matter to them.

Use the Widget Connector macro:

- Show a live stream of tweets from a Twitter user, or tweets matching a Twitter search.
- Display a video from YouTube or other online movie sites.
- Share photographs from Flickr.
- Display slide decks hosted on SlideShare and other online presentation sites.
- See what else the Widget Connector macro can do.

Showing activity streams

Make your Confluence pages dynamic and interactive with:

- An activity stream showing updates and comments on Confluence and other linked applications. See Working with Confluence Gadgets.
- An RSS feed from within Confluence or an external site. See Subscribing to RSS Feeds within Confluence.
- A list of recent blog posts from within Confluence. See Blog Posts Macro.

Working with Templates

When you add a new page, you do not have to write the content from scratch. Instead, you can base your new page on a template. A template is a Confluence page with predefined content.

Some examples of where templates are useful:

- A software development project may have a template for use cases.
- A systems administration space may have a template for defining what information is kept about each server.

Global templates and space templates

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Confluence administrators can also download predefined templates.
Creating a template

You can write your template using the Confluence editor. You can also add special variables to the page, if you want to include fields that the author will complete when adding the page. See Adding a Template for more information.

Using a template

Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

See Creating a Page using a Template for more information.

System templates

Confluence also provides 'system templates' containing content like the site welcome message and default space content. See Administering Site Templates.

Useful plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Extended template functionality:

- Scaffolding plugin
- Search the Atlassian Marketplace

Adding a Template

A template is a predefined page that can be used as a framework when creating new pages. Templates are useful for setting a common style or format for a page.

In Confluence, there are two places to store your page templates:

- **Space templates:** These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates:** These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.
Adding a space template

Space templates are available in one space only.

To add a template for a space:

1. Go to the space and choose Space Tools on the sidebar.
2. Choose Content Tools > Templates.
3. Choose Add New Space Template.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Templates from the space administration options.
3. Choose Add New Space Template.

The ‘Create Template’ screen will appear. Add content as described below.

On this page:
- Adding a space template
- Adding a global template
- A template illustration
  - Using the template editor
  - The resulting form when the template contains variables
- Adding content to your template
  - Labels
  - Images and other attachments
  - Variables used as form fields
- Converting an existing page to a template
- Notes

Related pages:
- Creating a Page using a Template
- Working with Templates
- Working with Confluence Labels
- Working with Macros
- Using the Editor
- Confluence User's Guide

Adding a global template

Global templates are available in all spaces in your Confluence site.

To add a global template:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Templates in the left-hand panel.
3. Choose Add New Global Template.

The ‘Create Template’ screen will appear. Add content as described below.

A template illustration

Using the template editor
This illustration shows the template editor with an image, some text, styling, and variables.

The resulting form when the template contains variables

This screenshot shows the form displayed when someone creates a page based on the template containing the above variables. (See Creating a Page using a Template.)
Adding content to your template

Add a name for your template.

Enter text into the body of the template, and use the editor toolbar to apply styles, layout and formatting. You can add links and macros. In general, you can use the Confluence editor in the same way as on a page. In addition, you can add variables which will produce a form for data collection when someone adds a page based on the template.

Below are some points of special interest in templates.

Labels

Choose Labels to add one or more labels to the template. These labels will be included in all pages created using this template.

Images and other attachments

You cannot attach an image or other file to a template. Instead, attach the file to another page, and insert it into the body of the template.

For example:
• You can attach an image to a page and then choose Insert > Image to embed the image into the template.
• You can attach a PDF file to a page and then choose Insert > Other Macros > PDF to embed the PDF file into the template.

Variables used as form fields

You can add variables to your template, to act as form fields. When someone creates a page based on the template, Confluence will display a text entry box for each field. The user can enter data into each field, and the data is inserted onto the new page.

Every variable must have a unique name. If you add the same variable more than once in the same template, Confluence will make sure that they have the same value when the user saves the page. This is useful if you need the same information in more than one place in the page.

To insert a variable into a template:

1. Place your cursor on the template where you want the variable to appear.
2. Choose $ Variables from the editor toolbar.
3. Choose Add New Variable. Alternatively, you can choose the name of an existing variable if you want the same variable to appear more than once in the template.
4. Enter the variable name.
5. Press Enter. By default this will create a single-line text input field.
6. To change the variable type, click the variable placeholder. The variable’s property panel will appear. Choose one of the variable types: Text, Multi-line Text, or List. See below for a description of each type.

Speeding up variable entry with autocomplete: Type $ and the variable name, then press Enter, to add a new variable or to select an existing variable from a list of suggestions. The suggestions are drawn from variables already defined in this template.

These are the types of variable available:

<table>
<thead>
<tr>
<th>Variable type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Creates a single-line text input field.</td>
</tr>
</tbody>
</table>

Screenshot: A template variable called $purpose and its property panel

This tutorial helps you to $purpose .
| Multi-line text          | Creates a text box that allows more than one line of text.  
|                        | By default, the text area is 5 rows depth and 100 characters wide. You can change the size by typing over the digits in the variable property panel.  
|                        | *Screenshot: A multi-line variable and its property panel* |

| List                    | Creates a dropdown list.  
|                        | You must specify the values that will appear in the dropdown list. The values:  
|                        | - Must be separated by commas.  
|                        | - Can include letters, numbers, special characters, and spaces.  
|                        | - Cannot include commas (except as the list separation character).  
|                        | *Screenshot: A list variable and its property panel* |

**Converting an existing page to a template**

If you would like to convert an existing page to a template, you can copy the content from the page and paste it into the template editor. There is no automated way of doing this.

Please note the section above about images and other attachments in templates.

**Notes**

- You cannot insert variables via the 'Insert wiki markup' option in the editor toolbar.
- Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.
- When you use a Table of Contents macro in a template, you will see an error when you preview the template itself. But the Table of Contents macro works on the pages that people create from the template – the table of contents shows up after they have saved the page. (This is probably because the template is not defined as a page, and the Table of Contents macro works for pages only.)
- The editor for templates is available only in Confluence 4.3 and later. Please refer to the earlier documentation for a description of the wiki markup editor templates.
Confluence also provides 'system templates' containing content like the site welcome message and default space content. See Administering Site Templates.

Creating a Page using a Template

You can create a page based on a global template (available to all spaces) or a space template (available only to that space). Before reading this page, make sure that someone has already created a template on your Confluence site.

**Information copied from the template to the page**

When you create a page based on a template, Confluence will copy the following content and information from the template to the new page:

- Labels
- Text and styles
- Layouts and formatting
- Macros
- Embedded images and other files. Note that you cannot attach an image or other file to a template. But if the template displays an image or file from another page, the new page will display that image or file too.

**Form fields displayed by the template**

If the template author included variables in the template, Confluence will display a form prompting you to supply values for the variables when you add the page.

**On this page:**
- Information copied from the template to the page
- Form fields displayed by the template
- Using a template to create a page
- Notes

**Related pages:**
- Adding a Template
- Using the Editor
- Working with Confluence Labels
- Confluence User’s Guide

**Using a template to create a page**

**To create a page based on a template:**

1. Choose Create on the header
2. Select a space and the template you want to use and choose Next
3. If the template contains variables, you will now see a form. Type the relevant information into the form fields, and choose Next.
4. Now you will see a new page based on the template. If you added information in the form fields, the page content will include that information.
5. Type a name for the page where you see 'New Page'.
6. Add more content or make any other changes required.
7. Choose Save.

*Screenshot: Form showing template variables when creating a page from a template*
Page Template Wizard

Step 2: Fill in template variables

The information you supply will become part of the content in your new page.

<table>
<thead>
<tr>
<th>Minutes for</th>
<th>Status Meeting (MeetingName)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>15/02/2013 (Date)</td>
</tr>
<tr>
<td>Time</td>
<td>9:00 AM (Time)</td>
</tr>
<tr>
<td>Location</td>
<td>Meeting Room 1 (Location)</td>
</tr>
<tr>
<td>Attendees</td>
<td></td>
</tr>
<tr>
<td>Apologies</td>
<td></td>
</tr>
</tbody>
</table>

Minutes

- Add the first item here...

<< Back  Next >>

Notes

Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

Editing a template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about changing an existing template.

Note: Page templates are used only when adding a page. It is not possible to apply a template to an already-existing page. Once a page has been added using a template, the template is no longer linked to the page. All further editing is performed as if the template was never used. Some plugins provide enhanced template functionality. You can search the Atlassian Marketplace for template add-ons.

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.

- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration...
Confluence also provides 'system templates' containing content like the site welcome message and default space content. See Administering Site Templates.

Related pages:
- Adding a Template
- Creating a Page using a Template
- Working with Template
- Working with Pages
- Confluence User’s Guide

To edit a space template:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. Choose Content Tools > Templates.
4. A list of templates for the space displays. Choose Edit next to the template that you want to modify.
5. Make changes, or add new content, as you would when adding a template.
6. Choose Save.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Templates from space administration options.
3. A list of templates for the space displays. Choose Edit next to the template that you want to modify.
4. Make changes, or add new content, as you would when adding a template.
5. Choose Save.

To edit a global template:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Templates in the left-hand navigation panel.
3. A list of templates for the Confluence site displays. Choose Edit next to the template that you want to modify.
4. Make changes, or add new content, as you would when adding a template.
5. Choose Save.

Removing a Template

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. This page is about deleting an existing template, at space level or at site (global) level.

Templates are used only when adding a page. Once a page has been added, the template is no longer linked to the page. You can therefore remove the template without affecting any existing pages.

You need to be a space administrator to remove a space template, and you need Confluence Administrator permissions to remove a global template.

Note: Deleted templates cannot be restored.
To remove a space template:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).

1. Choose **Content Tools > Templates**
2. A list of templates for the space displays. Choose **Remove** next to the template that you want to delete.
3. Confirm the deletion when prompted.

If your space uses the Documentation Theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).
2. Choose **Templates** from the space administration options.
3. A list of templates for the space displays. Choose **Remove** next to the template that you want to delete.
4. Confirm the deletion when prompted.

To remove a global template:

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Choose **Global Templates** in the left-hand navigation panel.
3. A list of templates for the Confluence site displays. Choose **Remove** next to the template that you want to delete.
4. Confirm the deletion when prompted.

**Working with the Office Connector**

The Office Connector is bundled with Confluence 2.10 and later. It allows you to:

- Import an Office document into Confluence format
- Attach an Office document to a Confluence page and display its content in Confluence, without converting the content.
- Edit the attached document in the Office application, directly from the Confluence page.

---

**Please be aware that source code is currently not available for the Confluence Office Connector.**

---

**Table of Contents**

- **Office Connector Prerequisites**
- **Displaying Office Files in Confluence**
- **Importing a Word Document into Confluence**
- **Editing an Office Document from Confluence**
- **Editing an Office Spreadsheet from Confluence**
- **Editing an Office Presentation from Confluence**
- **Installing the Firefox Add-On for the Office Connector**

**Related Topics**

---

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
View File Macro

Configuring the Office Connector *(Not applicable to Confluence OnDemand.)*

Confluence User's Guide
Office Connector Prerequisites

The page describes the software and setup you need to use the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the *Confluence Administration Guide* and discuss any configuration problems with your administrator. *(Not applicable to Confluence OnDemand.)*

**Overall prerequisites**

- Ensure that Java 5 (JDK 1.5) or higher is installed on your Confluence server.
- The **WebDAV plugin** must be enabled, because the Office Connector uses WebDAV to transfer information to and from Office documents. Note that the WebDAV plugin is bundled with Confluence, and can be enabled or disabled by the System Administrator. If necessary, refer to the instructions on enabling plugins and configuring the WebDAV options.
- Ensure that your Confluence server's **base URL** is set correctly. (Check it by going to the 'General Configuration' screen in the Confluence Administration Console, as described in Configuring the Server Base URL.) When a user edits a wiki page in Word and then uploads the page back to the Confluence server, the base URL determines where the document will be saved. If the base URL is incorrect, the documents may be saved to a different Confluence server.

**Prerequisites for viewing Office and PDF files in Confluence**

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup described below.

Browsers and Flash Player

You can use any browser to view an Office file on a wiki page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office desktop application installed on your computer in order to view Office files in Confluence.

File Types

Confluence can display files compatible with Microsoft Office 97-2007, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

**On this page:**

- Overall prerequisites
- Prerequisites for viewing Office and PDF files in Confluence
- Prerequisites for importing Word documents into Confluence
- Prerequisites for editing Office files directly from Confluence

**Related pages:**

- Working with the Office Connector
- Configuring the Office Connector *(Not applicable to Confluence OnDemand.)*
- Confluence User's Guide

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Prerequisites for importing Word documents into Confluence

- Document import can import Microsoft Word documents of the file types .doc and .docx. These must be valid Word 97-2007 format documents.

Prerequisites for editing Office files directly from Confluence

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

Office editors

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7, Windows Vista, or Windows XP with Service Pack 2 or 3</td>
<td><strong>OpenOffice</strong> 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>Mac OS X 10.5 and 10.6</td>
<td><strong>OpenOffice</strong> 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td>Linux</td>
<td><strong>OpenOffice</strong> 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
</tbody>
</table>

- The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.
Displaying Office Files in Confluence

Confluence can display Office files that are attached to a page. If you have an Office application installed, you will also be able to edit these Office files in your Office application.

These are two of the ways that Confluence can interact with Office files. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator. (Not applicable to Confluence OnDemand.)

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Prerequisites</td>
</tr>
<tr>
<td>• Attaching and Displaying Office Files and PDF Files</td>
</tr>
<tr>
<td>• Viewing and Editing the Attached Office Files</td>
</tr>
<tr>
<td>• Troubleshooting</td>
</tr>
<tr>
<td>• Related Topics</td>
</tr>
</tbody>
</table>

Prerequisites

If you want to use the View File macro, or to view Office files attached to a Confluence page, you need the setup described below.

Browsers and Flash Player

You can use any browser to view an Office file on a wiki page or attachment view, provided that you have installed Adobe Flash Player version 9 or later. You do not need to have an Office desktop application installed on your computer in order to view Office files in Confluence.

File Types

Confluence can display files compatible with Microsoft Office 97-2007, and PDF files, of the following types:

- .doc and .docx
- .xls and .xlsx
- .ppt and .pptx
- .pdf

Attaching and Displaying Office Files and PDF Files

There are two ways to do this in Confluence:

- Attach Office files to a page and display them in a Confluence page using the View File or Attachments macros
- Attach an Office or PDF file to a page and embed its contents onto the page by simply dragging and dropping it into the editor window

To attach and display Office files in Confluence using macros:

1. Attach the Office file(s) to a Confluence page:
   - View the Confluence page on which you want to display your document.
   - Choose Tools > Attachments.
   - Browse for your Office files and upload them to the Confluence page.
   - Refer to detailed instructions in Attaching Files to a Page.

2. Now you have two options for displaying the attached document:
   - You can embed the document into the Confluence page, using one of the Office Word, Office Excel, Office PowerPoint or View PDF macros. These macros can be found using the macro browser. Refer to the detailed instructions in the View File macro topic.
You can display a list of page attachments using the Attachments macro. People viewing the page will be able to click the View link to see the Office or PDF document in Confluence.

To attach and display an Office file on a Confluence page using 'drag and drop':

- Drag the Office file from your computer and drop it into the editor window. Only one file can be dragged and dropped at a time. The appropriate View File macro placeholder will appear in the position where you dragged the file. However, the contents of the file will be rendered in full when you preview, or save and view, the page.

Older browser versions may not support drag and drop - refer to Using Drag-and-Drop in Confluence.

Viewing and Editing the Attached Office Files

If an Office document is attached to a Confluence page, you can view the attached Office document from within Confluence. View the Office document in one of the following ways:

- Search for the Office document by file name, then click View next to the Office document on the Search results page. (See Searching Confluence.)
- View the list of attachments for a specific Confluence page, then click View next to the Office document on the Attachments page. (See Viewing Attachment Details.)
- View a list of attachments displayed on a page via the Attachments macro, then click View next to the Office document in the list of attachments. (See Displaying a List of Attachments.)
- View a Confluence page which has the Office document embedded in the page via the View File macro. (See View File Macro.)

Any Confluence user who has an Office application installed will also be able to launch their Office editor from within Confluence:

- Editing an Office Document from Confluence.
- Editing an Office Presentation from Confluence.
- Editing an Office Spreadsheet from Confluence.

Troubleshooting

Problems? Please refer to our guide to the Office Connector limitations and known issues.

Related Topics

View File Macro
Working with the Office Connector

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

Confluence User's Guide
Importing a Word Document into Confluence

The Office Connector in Confluence allows you to import a Word document into Confluence, so that the document's content is copied onto one or more Confluence pages.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.
Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator. (Not applicable to Confluence OnDemand.)

The simplest way to import a Word document is to import the entire content of the document into a single wiki page. By default, the content of the document will be created as a new wiki page.

More advanced options allow you to import the content into a new page, to split a single document into more than one wiki page, and to resolve conflicts in the titles of your pages.

These options are described below.

**Prerequisites**

Prerequisites for the Office Connector's document import feature:

- Document import can import Microsoft Word documents of the file types `.doc` and `.docx`. These must be valid Word 97-2007 format documents.

For a full list of Office Connector prerequisites and limitations, please refer to:

- Office Connector Prerequisites
- Office Connector Limitations and Known Issues

---

**Importing a Word Document**

The simplest way to import a Word document is to import the entire content of the document into a single wiki page.

This method will replace any existing content on the wiki page.

**To import a Word document onto a single wiki page:**

1. Create a page in Confluence (see Creating Content) or go to an existing page whose content you want replaced. View the page in view mode (not edit mode).
2. Choose **Tools > Import Word Document**.
3. Click **Browse** and find the Word document on your local drive or network.
4. Click the **Open** or **Upload** button provided by your browser. The path and file name of the document will now appear in the text box on the Office Connector import screen.
5. Click **Next** on the Office Connector import screen. The import document options screen will display.

6. The import document options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root page title</td>
<td>The title of the wiki page that will contain the information from your imported document.</td>
</tr>
<tr>
<td>Import as a new page in the current space</td>
<td>A new wiki page will be created with the page title specified above.</td>
</tr>
<tr>
<td>Replace &lt;pagename&gt;</td>
<td>The contents of the existing page will be replaced.</td>
</tr>
<tr>
<td></td>
<td>The page will be renamed to the page title specified above.</td>
</tr>
<tr>
<td>Delete existing children of &lt;pagename&gt;</td>
<td>The existing child pages of the page you are replacing will be deleted.</td>
</tr>
<tr>
<td>Rename imported pages if page name already exists</td>
<td>Assign new names to any new page which would otherwise have a duplicate name. The content of existing pages will remain unchanged.</td>
</tr>
<tr>
<td>Replace existing pages with imported pages of the same title</td>
<td>If imported pages have titles equal to existing pages, then the content of the Word document will overwrite the content on the existing page. Page history will be preserved.</td>
</tr>
<tr>
<td>Remove existing pages with the same title as imported pages</td>
<td>If imported pages have titles equal to existing pages, then the existing pages will be deleted. This will remove the page history as well as the content.</td>
</tr>
<tr>
<td>Split by heading</td>
<td>The content of the Word document will be split over multiple wiki pages. If you don't want to split your document into multiple wiki pages, leave the default <strong>Don't split</strong> option selected. For more information on splitting your document, please see below.</td>
</tr>
</tbody>
</table>

7. Click **Import**.

When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

**Screenshot: Empty page ready for import**

**Screenshot: Selecting Word document to import**
When importing a Word document, you can split a single document into more than one wiki page, based on the heading styles in the document.

By default, the page names will be the same as the heading text. This may result in a conflict, if a page already exists with the same title. You can instruct the importer how to handle such conflicts.
To import a Word document into multiple wiki pages:

1. Import a Word document as described above. On the import document options screen, choose how to split your document in the 'Split by heading' field:
   • 'Split by heading' — If you want to split the content under each heading in your document into separate child pages, select the desired heading level to split by. A preview of the page hierarchy that will be created by the split will be displayed under 'Document Outline'. Each bullet point in 'Document Outline' represents a new page after import into Confluence.
2. Click 'Import' to import your document.
3. When the upload has finished, the content of the Word document will have been transformed into Confluence page content. You can now view and edit this page in the usual way. There is no connection between the original Word document and this wiki page.

Screenshot: Splitting a single Word document into multiple wiki pages

Editing an Office Document from Confluence

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a Word document from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator. (Not applicable to Confluence OnDemand.)

Prerequisites for Editing an Attached Office Document

The Office Connector allows you to edit Office files embedded in a wiki page or from the page’s attachments view.
To make use of these editing capabilities, you will need the setup described below.

**Browsers**

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

**Office editors**

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

**Configuration matrix**

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7, Windows Vista, or Windows XP with Service Pack 2 or 3</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>Mac OS X 10.5 and 10.6</td>
<td>OpenOffice 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>The &quot;Edit in Word&quot; feature is known to work in OpenOffice 3.2.0.</td>
<td></td>
</tr>
<tr>
<td>Linux</td>
<td>OpenOffice 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
<tr>
<td></td>
<td>The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.</td>
<td></td>
</tr>
</tbody>
</table>
On this page:
- Prerequisites for Editing an Attached Office Document
- Editing an Office Document in your Office Application
- Troubleshooting

Related pages:
- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector
- Confluence User's Guide

Editing an Office Document in your Office Application

To edit an Office document in your Office application:

1. There are two ways to do this:

   - **From an Office document embedded on a page:**
     a. Go to a Confluence page with an Office document embedded on it.
     b. Choose **Edit Document** above the embedded document.

     
     Screenshot: Page with an embedded Word document showing the 'Edit Document' link

     ![Screenshot: Page with an embedded Word document showing the 'Edit Document' link](image)

   - **From an Office document in a list of attachments:**
     - If an Office file is **attached to a Confluence page**, you can edit this file directly in your compatible Office application, in one of the following ways:
       - View the list of attachments for a specific Confluence page, then click **Edit in Office** next to the Office file on the Attachments page. (See Viewing Attachment Details.)
       - View a list of attachments displayed on a page via the Attachments macro, then click
1. **Edit in Office** next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

![Attachments Table](image)

2. A window will pop up, asking you to confirm that you want to open this document.

   **Screenshot: Confirmation window in Firefox**

   ![Confirmation window in Firefox](image)

   **Screenshot: Confirmation window in Internet Explorer**

   ![Confirmation window in Internet Explorer](image)

3. Click ‘OK’. Now you may be asked to log in to your Confluence server.
4. Enter your Confluence username and password, then choose ‘OK’.
5. The Office document will open in your Office application.
6. Make the necessary changes, then save the document. It will be saved back into Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the [Office Connector limitations and known issues](#).

**Editing an Office Spreadsheet from Confluence**

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit an Excel spreadsheet from within Confluence and save it back to Confluence.
This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator. (Not applicable to Confluence OnDemand.)

## On this page:
- Prerequisites for Editing an Attached Office Spreadsheet
- Editing an Office Spreadsheet in your Office Application
- Troubleshooting

## Related pages:
- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector

### Prerequisites for Editing an Attached Office Spreadsheet

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

#### Browsers

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in Installing the Firefox Add-On for the Office Connector.
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: CONF-23322.

#### Office editors

To edit Office files, you will need to have Microsoft Office or OpenOffice installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See Installing the Firefox Add-On for the Office Connector.
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

#### Configuration matrix

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7, Windows Vista, or Windows XP with Service Pack 2 or 3</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
</tbody>
</table>
Editing an Office Spreadsheet in your Office Application

To edit an Office spreadsheet in your Office application:

1. There are two ways to do this:

   • From an Office spreadsheet embedded on a page:
     a. Open a Confluence page with an Office document embedded on it.
     b. Choose Edit Document above the embedded content.

   Screenshot: The title bar showing 'spreadsheet.xls' above an embedded Excel spreadsheet

   • From an Office spreadsheet in a list of attachments:
     • If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
       • View the list of attachments for a specific Confluence page, then click Edit in Office next to the Office file on the Attachments page. (See Viewing Attachment Details.)
       • View a list of attachments displayed on a page via the Attachments macro, then click Edit in Office next to the Office file in the list of attachments. (See Displaying a List of Attachments.)

   • Mac OS X 10.5 and 10.6
     • OpenOffice 2.x – 3.x
     • Firefox – latest stable version
   • Linux
     • OpenOffice 2.x – 3.x
     • Firefox – latest stable version

   The only known supported Office editor for Linux is OpenOffice. But in theory it should work with any WebDAV-aware application.

2. A window will pop up, asking you to confirm that you want to open this document.
3. Click ‘OK’. Now you may be asked to log in to your Confluence server. Enter your Confluence username and password, then click ‘OK’.
4. The Office spreadsheet will open in your Office application.
5. Make the necessary changes, then save the spreadsheet. It will be saved back into Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the Office Connector limitations and known issues.

**Editing an Office Presentation from Confluence**

When viewing a wiki page that displays an attached Office document, you can launch your Office editor directly from Confluence. This allows you to edit a PowerPoint presentation from within Confluence and save it back to Confluence.

This is just one of the ways Confluence can interact with Office documents. For an overview of all Office Connector features, please refer to Working with the Office Connector.

Your System Administrator can enable or disable the Office Connector or parts of it. The Office Connector options can appear in different places on your Confluence page, depending on the themes and configuration of your Confluence site. Please refer to Configuring the Office Connector in the Confluence Administration Guide and discuss any configuration problems with your administrator. (Not applicable to Confluence OnDemand.)
Prerequisites for Editing an Attached Office Presentation

The Office Connector allows you to edit Office files embedded in a wiki page or from the page's attachments view.

To make use of these editing capabilities, you will need the setup described below.

**Browsers**

- If you are using Firefox, you will need to install a Firefox add-on. Firefox will prompt you to do this, the first time the add-on is required. You will find instructions in [Installing the Firefox Add-On for the Office Connector](#).
- **Note: No Chrome support.** Chrome does not support WEBDAV clients, so this feature will not work. Please refer to this issue for more information: [CONF-23322](#).

**Office editors**

To edit Office files, you will need to have [Microsoft Office](#) or [OpenOffice](#) installed. (See the configuration matrix below.)

- If you are using Firefox, you can choose which of the above editors you want to use. The Firefox add-on allows you to configure this option for each file type. See [Installing the Firefox Add-On for the Office Connector](#).
- If you are using Internet Explorer, you will need Microsoft Office. You cannot edit Office files in OpenOffice when using Internet Explorer.

**Configuration matrix**

You need one of the following software combinations to edit Office files from your wiki page:

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Office Version</th>
<th>Browser</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7, Windows Vista, or XP with Service Pack 2 or 3</td>
<td>OpenOffice 2.x – 3.x, or Microsoft Office XP, 2003, 2007 or 2010</td>
<td>Internet Explorer 8.x – 9.x, or Firefox – latest stable version</td>
</tr>
<tr>
<td>Mac OS X 10.5 and 10.6</td>
<td>OpenOffice 2.x – 3.x</td>
<td>Firefox – latest stable version</td>
</tr>
</tbody>
</table>

*The "Edit in Word" feature is known to work in OpenOffice 3.2.0.*
Editing an Office Presentation in your Office Application

To edit an Office presentation in your Office application:

1. There are two ways to do this:

   - **From an Office presentation embedded on a page:**
     a. Open a Confluence page with an Office presentation embedded on it.
     b. Click the 'Edit' icon on the bottom frame of the slide show.

   *Screenshot: PowerPoint presentation displayed on a Confluence page*

   - **From an Office document in a list of attachments:**
     - If an Office file is attached to a Confluence page, you can edit this file directly in your compatible Office application, in one of the following ways:
• View the list of attachments for a specific Confluence page, then click **Edit in Office** next to the Office file on the Attachments page. (See **Viewing Attachment Details**.)
• View a list of attachments displayed on a page via the Attachments macro, then click **Edit in Office** next to the Office file in the list of attachments. (See **Displaying a List of Attachments**.)

![Attachments](image)

2. A window will pop up, asking you to confirm that you want to open this document.

   **Screenshot: Confirmation window in Firefox**

   ![Confirmation window in Firefox](image)

   **Screenshot: Confirmation window in Internet Explorer**

   ![Confirmation window in Internet Explorer](image)

3. Click ‘**OK**’. Now you may be asked to log in to your Confluence server.
   Enter your Confluence username and password, then click ‘**OK**’.
4. The presentation will open in your Office application.
5. Make the necessary changes, then save the presentation. It will be saved back into Confluence.

**Troubleshooting**

Problems? Please refer to our guide to the **Office Connector limitations and known issues.**

Installing the Firefox Add-On for the Office Connector

If you are using Firefox as your browser, you will need to install an add-on into Firefox (the **Firefox WebDAV**...
Launcher) in order to use some features of the Office Connector. You will be prompted to install the add-on the first time you try to use a function which requires it.

For an overview of all Office Connector features, please refer to Working with the Office Connector.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

On this page:

- Installing the Firefox Add-On
- Configuring the Add-On
- Security Risks
- Information about this Firefox Add-On
- Related Topics

Related pages:

- Office Connector Prerequisites
- Displaying Office Files in Confluence
- Importing a Word Document into Confluence
- Editing an Office Document from Confluence
- Editing an Office Spreadsheet from Confluence
- Editing an Office Presentation from Confluence
- Installing the Firefox Add-On for the Office Connector
- Confluence User's Guide.

Installing the Firefox Add-On

You will be prompted to install the add-on the first time you try to use a function which requires it. The add-on is required for editing a wiki page in Office, or for editing an Office document which is displayed on a wiki page.

1. When you choose an option which requires the Firefox add-on, you will see a popup window like this one:

   A plugin is required to use this feature. Would you like to download it?

   ![Popup window](image)

   OK Cancel

2. Click 'OK'. Some browsers may now ask you to confirm the download with a message bar across the top of the page, beneath the browser's address bar.

   - You may see a message like the one shown here:
Click 'Allow'.

- Or you may see a similar message with an 'Edit Options' button like this:

If you see the above message, click 'Edit Options'. You will then see an 'Allowed Sites' window like this one:

This window lets you tell Firefox that your Confluence server is allowed to install add-ons into Firefox. The 'Address of web site' box should already contain the address of your Confluence server.

- Click the 'Allow' button to add your Confluence server to the list.
- Go back to your Confluence page and try to edit your Office document again, e.g. by clicking 'Edit in Word' again. Now you will see the option to install the add-on.

3. A 'Software Installation' window will appear, asking you to confirm the installation. The window will look something like the one below, but the URL will be the address of your own Confluence server:
4. Click 'Install Now'. The installation will happen and a window will pop up asking you to restart Firefox:

5. Make sure you have saved all your Confluence pages and any other work in your browser, then restart Firefox.
6. If Firefox asks you to confirm the restart, confirm it.
7. Firefox will close all the browser windows and will then start up again. You will see a window confirming that a new add-on has been installed, like this:
Configuring the Add-On

After you have installed the add-on into Firefox, you will need to configure it. Basically, you will associate a desktop application (editor) with each relevant file type. This tells the Office Connector which application to launch when it encounters a link to an editable file. The configuration is slightly different for each operating system, as described below.

Configuring the Add-On in Windows

The add-on can will automatically configure itself on Windows via the system registry. The first time you edit a new file type, the add-on will look up the default editor for that file type and make that the permanent setting.

If you want to override the registry settings, or if for some reason the automatic configuration is not working, you can configure the Firefox add-on manually.

1. In Firefox, go to the ‘Tools’ menu and select ‘WebDAV Launcher Options’, as shown in this screenshot:
2. A 'WebDAV Launcher Options' window will appear, allowing you to associate a specific file type (file extension) with a desktop application (editor). The window looks like this one:

3. In the 'File Extension' box, enter the extension for a particular file type. For example, you may want to associate the 'doc' file extension with Microsoft Word 2003 or earlier. To do this, you would type 'doc' in the File Extension text box.

If you use or have recently upgraded to Office 2007

In addition to the original Office 2003 file extensions (that is, 'doc', 'ppt' and 'xls'), you should additionally configure the WebDAV launcher to handle the new Office 2007-specific file extensions for Microsoft Word ('docx'), Microsoft Excel ('xlsx') and PowerPoint ('pptx').

Screenshot: Configuring the WebDAV Launcher - adding the 'doc' file extension.
4. Enter the 'Application Path' — Use one of the following methods to specify the associated application for editing the given file type:

- Click the 'Auto' button to load the associated application from the Windows registry.
- Alternatively, you can click the 'Browse' button to find the application on your computer.
- Or you can manually type in the path to the application's executable file.

_Screenshot: Configuring the WebDAV Launcher - adding the 'Application Path' for the 'doc' file extension._
5. Click the ‘Add’ button. The file extension association will be added to the list. For example, in the picture below you can see that the ‘doc’ extension has been associated with ‘C:\Program Files\Microsoft Office\OFFICE11\WINWORD.EXE’. This is the path to the Microsoft Word 2003 executable on a specific Windows machine.

Screenshot: Configuring the WebDAV Launcher - configuration of the ‘doc’ file extension complete.

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Application Path</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc and docx</td>
<td>/usr/bin/oowriter</td>
</tr>
<tr>
<td>ppt and pptx</td>
<td>/usr/bin/ooimpress</td>
</tr>
<tr>
<td>xls and xlsx</td>
<td>/usr/bin/oocalc</td>
</tr>
</tbody>
</table>

Configuring the Add-On in Mac OS X

The configuration procedure is similar to Windows, as shown above. Note that there is no ‘Auto’ button in Mac OS X.

Configuring the Add-On in Linux

The only known supported Office editor for Linux is OpenOffice. (See Office Connector Prerequisites.)

There is no automatic configuration on Linux. You will need to associate each file type with your Office editor in Firefox. Note that there is no ‘Auto’ button in Linux.

The configuration procedure is similar to Windows, as shown above.

For both Ubuntu and OpenSUSE, the configuration will look something like this:
Security Risks

Please be aware that there are security risks in installing this add-on to Firefox. Internet Explorer is exposed to the same risks, because it can directly open Office documents. By installing the add-in into Firefox, you are exposing Firefox to the same risks.

Summary of the risks:

- Office documents can contain macro viruses. Before opening an Office document, make sure that you trust the source of the document.
- There are known flaws in the Office file formats and Microsoft Office that an attacker can exploit to gain control of your machine. Microsoft has fixed the known exploits in the latest Service Packs for all Microsoft Office versions. But new exploitations may arise at any time. Again, be sure that you trust the source of a document before opening it.

The add-on tries to reduce the risk by supporting the following:

- **Same origin policy** — The add-on can only open documents from the same host that initiated the action.
- **Digital signature** — The add-on is digitally signed. When you install the add-on please verify that it is signed by Benryan Software Inc.

- **Prompt the user for confirmation** — You will always be warned before a file is opened. Please read these warnings carefully before opening a file. The warning tells you the complete URL of the file as well as the complete application path of the application opening the file.

Information about this Firefox Add-On

<table>
<thead>
<tr>
<th>Add-on name:</th>
<th>WebDAV Launcher</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description:</td>
<td>Adds the ability to launch a WebDAV URL directly in a WebDAV-aware client.</td>
</tr>
<tr>
<td>Latest version:</td>
<td>See the WebDAV Launcher add-on page at Mozilla</td>
</tr>
</tbody>
</table>
Importing Content Into Confluence

This page describes how to get text, pages, images and other content into Confluence, by converting the content from another storage format and importing it into the Confluence wiki.

Importing content from other Confluence sites

For content originating from other instances of Confluence:

- If the Confluence major versions are the same, export the space from the originating Confluence site and import it into the destination Confluence site.
- If the Confluence major versions are different, you can use an intermediate server to migrate versions.

Page history, attachments, and page content will be preserved and you will be able to do multiple pages at once. The drawbacks are that it may be inconvenient if the Confluence versions differ, and you cannot have a duplicate space key on the destination instance. (You cannot import a space with the same space key as a space that already exists.)

On this page:

- Importing content from other Confluence sites
- Importing content from other wikis
- Importing content from a Microsoft Word document
- Importing web content
- Importing other non-wiki content
- Note about add-on support

Related pages:

- Working with the Office Connector
- Data Import and Export
- Confluence User's Guide

Importing content from other wikis

Check whether the Universal Wiki Converter can import the content. See Importing Content from Another Wiki.

Importing content from a Microsoft Word document

The Office Connector in Confluence allows you to import a Word document into Confluence. The document’s content is copied onto one or more Confluence pages. See Importing a Word Document into Confluence.

Importing web content

Here are some options for importing or displaying web content on a Confluence page:

- Use the Widget Connector Macro to display videos, slide shows, twitter chats, documents and more, sourced from other web sites and displayed on your Confluence page.
- Convert a HTML file to a Confluence page using the HTML To Confluence Converter plugin.
- Embed an external web page into Confluence with the HTML Include macro.
Importing other non-wiki content

Importing non-wiki markup into Confluence requires a conversion process:

- Text with basic formatting can be pasted directly into the editor. This includes simple Word documents or web pages.
- Files such as Microsoft Excel documents can be imported using a content converter plugin.
- Confluence pages saved to disk can be imported from disk.
- Files can be uploaded in bulk using the Confluence WebDav Plugin.
- Full featured customisation is available using the Confluence remote APIs.

Note about add-on support

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Importing Content from Another Wiki

The Universal Wiki Converter (UWC) allows you to import content from other wikis into Confluence. The Confluence Administration Console offers a link to the Universal Wiki Converter documentation and download sites.

Note: You need to install and run the UWC separately from Confluence. The UWC is a standalone application that communicates with Confluence remotely. You cannot install the UWC directly into Confluence. Instead, download the UWC separately and run it according to the instructions below.

The UWC supports many wiki dialects. In addition, the UWC is an extensible framework, which means that developers can continue writing new conversion modules for other wikis.

- Download the latest version of the UWC from the Atlassian Marketplace.
- For information on installation and usage, see the UWC User Documentation.
- For information on developing your own converter module, see the UWC Developer Documentation.
- For information about a specific wiki, including a list of currently supported wikis, see the UWC documentation - what wikis are currently supported?
- To ask a question, see the UWC discussions on Atlassian Answers.

Related pages:
- Importing Content Into Confluence
- Data Import and Export
- Confluence Administrator's Guide

The information on this page does not apply to Confluence OnDemand.

Importing Pages from Disk

Confluence allows you to import text files from a directory on the Confluence server, and convert them into Confluence pages. Each file will be imported as a separate Confluence page with the same name as the file.

Notes:

- The text file may contain plain text, HTML or Confluence Storage Format..
- You need to be logged in as a System Administrator to import text files.
- You can import pages from disk into site spaces, but not into personal spaces. Please see Working with
Spaces for information about differences between site spaces and personal spaces.

Related pages:
- Importing Content Into Confluence
- Confluence User’s Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

To import text files:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.
   
   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Content Tools > Import**

3. Type your directory path into the **Import directory** box.

4. Select **Trim file extensions** to remove file extensions from the page titles when converting the files to Confluence pages. Note that the Confluence pages will take their titles from the files’ names (including their extensions). To avoid having page titles with a suffix like ‘.txt’ check this box.

5. Select **Overwrite existing pages** if you want to replace existing Confluence pages that have the same page title as one you are importing.

6. Choose **Import**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   **Note:** The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Import** from the space administration options.

3. Follow the steps above.

Confluence will place the new pages at the root of the space.

**Screenshot: Importing text files**

You can use this action to import text files from a directory on the Confluence server.

These text files become pages in Confluence, with the following features:
- The page title is taken from the filename
- The content is the entire page body

Import directory

Trim file extensions

Overwrite existing pages

Import  Cancel

Sharing Content

Confluence provides a number of ways for you to notify other people about content that may be of interest to
them:

- You can share a page link with them.
- You can mention a user when you write a page, blog post or comment. Mentioning a user automatically emails a notification to them about that content.
- You can broadcast a message that appears in Confluence activity streams.
- You can like a page, blog post or comment. The author will receive a notification. If enough people like the content, it will appear in the list of popular content on the dashboard and in the recommended updates email message.

Other users can also find out about changes to content in Confluence by watching pages and spaces.

You may also be interested in exporting Confluence content to other formats such as XML, HTML, Microsoft Word and PDF.

### Network Overview

The 'network' feature provides notifications on the activity of users that you choose to follow. This compares with Confluence’s other content tracking features, which provide notifications on specified types of content updates, made by any user.

The types of activities tracked by the network feature include:

- Additions or edits to pages or blog posts
- Comments added to a page or blog post or edits to existing comments
- Updates to a user’s User Status Updates
- Updates to a user’s User Profile

---

### Related pages:

- Creating Content
- Managing Changes and Notifications and Tasks
- Organising Content
- Confluence User’s Guide

---

### On this page:

- Accessing Your Network View
- Following Another User
- Stop Following a User
- Notes

### Related pages:

- Network Macro
- Subscribing to a Network RSS Feed
- Subscribing to Email Notifications of Updates to Confluence Content
- Confluence User’s Guide.

---

### Accessing Your Network View

**To see your network view:**

- Choose your profile picture at top right of the screen, then choose Network. (Alternatively, choose More in the ‘Network’ section of your profile sidebar.)

You can access another user’s Network view using the Hover Profile.

**Screenshot: Example of the Network view**
Following Another User

You can follow another user by using either the Hover Profile or your Network view.

**To follow a user with the Hover Profile:**

1. Open the user’s hover profile popup:
   - Log in to Confluence, if you have not already done so.
     Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user’s linked name or profile picture. The hover profile popup will appear.
2. Choose **Follow**.

**To follow a user from your Network view:**

1. Choose your **profile picture** at top right of the screen, then choose **Network**.  
   (Alternatively, choose More in the 'Network' section of your profile sidebar.)
2. Enter the first few characters of the name (or username) of the user you wish to follow in the Following field and choose the user from the list of suggestions.
3. Choose **Follow**.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just followed will appear within the 'Following' list on the right. Additionally, their tracked activities will start appearing in the 'Recent Activity' list on this page.

Stop Following a User

**To stop following a user by using the Hover Profile:**

1. Open the user’s hover profile popup:
   - Log in to Confluence, if you have not already done so.
     Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user’s linked name or profile picture. The hover profile popup will appear.
2. Choose **Stop Following**.
You can also stop following a user by going to their Profile view.

If you now refresh or revisit your Network view, the profile picture(s) of the user(s) you just stopped following are removed from the 'Following' list on the right. Additionally, their tracked activities will stop appearing in the 'Recent Activity' list on this page.

Notes

Once you are following a user, you can see their activity in a number of ways:

- Your Network view: your Network view shows all the tracked activities that you have permission to view for all the users that you are following. In the same way, people who follow you will be able to see all your Confluence-based activities on their network views, provided they have permission to view the content. See below for instructions on accessing your network view.
- RSS feeds: you can subscribe to any Confluence user's network RSS feed and receive summaries on the activities of other users they are following in their network. See Subscribing to a Network RSS Feed.
- Email notifications: you can request email notifications of any activity in your network. See Subscribing to Email Notifications of Updates to Confluence Content.

Note that it is not possible to stop another user from following you. If you are interested in the ability to block followers, please watch CONF-16285 for updates on the feature request.

Likes and Popular Content

Has someone written a good blog post or page on Confluence? Or has someone added a comment that you agree with? Click the Like button to let them know.

Confluence has like buttons on every page, blog post and comment. If enough people like a page or post, it will show on the dashboard's 'Popular' tab. The information in the 'Recommended Updates' email message is based on the number of people who have liked the content.

Liking a page, blog post or comment

Click the Like button to let people know that you agree with or enjoy a page, blog post or comment. Click Unlike to remove your name from the list of people who like the content.

You can also see:

- Up to three names of people in your network who have most recently liked the content.
- A link showing the number of people who have liked the comment. For example, 19 people like this. Click the link to see the names. At the top of the list are people in your network, sorted with the most recent likes first. Then follow other people, also sorted chronologically with the most recent first.

On this page:

- Liking a page, blog post or comment
- Effects of liking content
- Disabling the 'like' feature
- Disabling notifications when your content is 'liked'

Related pages:

- Dashboard
- Subscribing to Email Notifications of Updates to Confluence Content
- Network Overview

Screenshot: The Like button at the bottom of a page and on comments
Effects of liking content

When you like a page, blog post or comment:

- The author of the content receives a notification.
- People in your network receive a notification. They will receive the notification only if they do not already know about the content. Let's assume Arthur is in your network. Arthur will not receive a notification if:
  - Someone else in his network has already liked the content.
  - Arthur himself has already liked the content.
  - Arthur has already commented on it.
  - In the case of a threaded comment, Arthur has already replied to the comment.
- If enough people like the content, it will appear on the 'Popular' tab of the dashboard.
- Similarly, if the content is popular enough it will appear in the 'Recommended Updates' summary sent out by email.

Disabling the 'like' feature

The functionality is provided by a plugin called the 'Confluence Like Plugin'. To remove the 'like' functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.

Disabling notifications when your content is 'liked'

There are two ways to turn the 'someone likes your page' notifications off:

1. Open an email notification of a like, and click Manage Notifications
2. Go to _<your confluence URL>/plugins/likes/view-notifications.action_

User Status Updates

You can use your 'user status' to broadcast a short message, which other users can see on various activity streams in Confluence. These short messages could include:
• A description about what you are working on.
• A question you may want answered quickly.
• A hyperlink that you share immediately with other users.
• Any other message you may want to share quickly with other users.
• Another person's Confluence username, in the format [~username], to send that person an email message about your status.

Your 'Status Updates' view shows a history of updates you have made to your status. Your latest status message is shown on the profile popup that appears when people hover over your username, and in various other places in Confluence.

**On this page:**

• Setting or updating your status
• Mentioning another person in your status update
• Viewing status updates
• Clearing your current status
• Deleting a status update
• More about user status updates
• Enabling and disabling status updates

**Related pages:**

• User Profile Overview
• User Status List Macro
• Confluence User’s Guide

### Setting or updating your status

**To set or update your status:**

1. Log in to Confluence.
2. Choose your profile picture at top right of the screen, then choose Update Status. The 'What are you working on' dialog will open.
3. Enter a short message (140 characters maximum) that describes your current status or what you are working on.
4. Choose Update to publish your new or updated status.

**Screenshot: User status**

![Screenshot of User status](image)

### Mentioning another person in your status update

You can include another person's Confluence username in your status update, using square brackets and the tilde sign in the format [~username]. Confluence will send that person an email message containing your
status update. For example, let's assume another Confluence user has the username 'charlie'. You could put this message in your status update, and Charlie will receive an email message:

- Enjoying all the blog posts that [~charlie] has written recently!

**Note:** Mentions in status updates do not appear as notifications in the Confluence workbox.

Viewing status updates

**To view your status updates:**

- Choose your profile picture at top right of the screen, then choose Status Updates.

You can also view another user's status by going to their profile.

**Screenshot: Status updates view**

Clearing your current status

Clearing a message is not the same as deleting it. If you clear a message, it is still shown in your status updates view until it is deleted.

**To clear your current status:**

1. Choose your profile picture at top right of the screen, then choose Status Updates.
2. Choose Clear in the status message at the top of the page.

**Screenshot: Clearing your current status message**
Deleting a status update

To delete your current or a previous status message:

1. Choose your profile picture at top right of the screen, then choose Status Updates.
2. Choose Delete next to the appropriate status message. Your status updates view will be refreshed and the message you deleted will be removed from the list.

More about user status updates

There are a number of activity streams in Confluence that show different types of status updates. These include:

- The 'Recently Updated' list on the Confluence Dashboard, which shows all status updates (when the All tab is selected).
- Your Network page, which shows the status updates of Confluence users you are following.
- The Network page of Confluence users who are following you, which shows your status updates.
- The Recently Updated and Recently Updated Dashboard macros, which shows all status updates (provided that these macros' space parameters have been set to '@all').

Enabling and disabling status updates

The functionality is provided by a plugin called 'User Status'. To remove the status updates functionality from your site, you can disable the plugin. See Disabling or Enabling a Plugin.

You can also set the Confluence site permissions to determine which users can use status updates. By default, users will not have permission to use this feature. See Global Permissions Overview.

Using Mentions

You can mention a person in a special way that prompts Confluence to send that person an email message and a workbox notification. This way of mentioning someone is called an @mention. It works on Confluence pages, blog posts and comments.

When you save the page, Confluence sends an email message to the user letting them know that they have been mentioned on the page (if they have permission to view the page) with a link to the relevant page. Confluence also adds a notification to the person's workbox.

Note: Use the person's full name. The user mention feature recognises the full name only, not the username.

There are two ways to mention someone:

- The quickest way is to start typing '@' and the person's name, then choose from the suggestions that Confluence offers. This is called autocomplete.
- Alternatively, you can choose Insert > User Mention from the editor toolbar.

Each of these methods is described in more detail below.

Using autocomplete to mention someone

To mention someone using '@':

1. Edit the page.
2. Click where you want to insert a mention and type '@' and then the first few characters of the user's full name.
3. Choose the user's name from the list of suggestions.

Screenshot: Autocomplete for mentions
On this page:
- Using autocomplete to mention someone
- Accessing the user mention option in the editor toolbar
- Seeing your mentions in the Confluence workbox
- Notes

Related pages:
- Using the Editor
- Using Autocomplete
- Keyboard Shortcuts
- Confluence User's Guide

Accessing the user mention option in the editor toolbar

To add a user mention via the editor toolbar:

1. Edit the page.
2. Choose Insert > User Mention. Confluence will add an '@' sign to the page, and display a dropdown list of suggested users for you to choose from.
3. Start typing the person's name, to refine the list of suggestions.
4. Choose the person from the list of names.

Screenshot: The user mention option in the editor toolbar

Seeing your mentions in the Confluence workbox

When someone mentions you, you will receive a notification in the Confluence workbox. See Managing Notifications in Confluence.
Notes

- **Disabling the user mention feature.** The functionality is provided by a plugin called the 'Confluence Mentions Plugin'. To remove the user mention functionality from your site, you can disable the plugin. See [Disabling or Enabling a Plugin](#).
- **Mentioning groups.** It is not possible to mention a group and then have the email sent to the entire group. You can only mention individual users. There is a feature request to allow mentions for groups: ![CONF-23015 - Authenticate](#) to see issue details.
- **Mentioning people in status updates.** See [User Status Updates](#).
- **Linking to a user profile.** You can use a square bracket `[]` and a person's name to trigger Confluence autocomplete and link to a person's user profile or personal space. See [Linking to Personal Spaces and User Profiles](#). Confluence will send the person a notification just as if you had used @mention (unless the administrator has disabled the user mention feature).

### Emailing a Page

You can share a Confluence page or blog post by emailing a link to recipients of your choice. The recipients can be Confluence users or any email addresses.

**To email a link to a Confluence page or blog post using the Share button:**

1. Go to the page or blog post you wish to share.
2. Choose **Share** at the top right of the page.
   
   Note: The **Share** button will only visible if your Confluence administrator has configured an outgoing mail server for your Confluence site. See [Configuring a Server for Outgoing Mail](#). *Not applicable to Confluence OnDemand.*
3. Enter the name or username of a Confluence user or any email address. As you start typing a name or username, or when you have typed a valid email address, an autocomplete dropdown will appear.
4. Select the appropriate user or email address from the dropdown. You can add multiple recipients to the list.
5. Enter an optional message into the **Note** box.
6. Choose **Share** to send the link via email.

If you chose one or more Confluence usernames (not email addresses) the recipients will also receive a notification in their Confluence workbox. See [Managing Notifications in Confluence](#).

**Related pages:**

- [Managing Notifications in Confluence](#)
- [Working with Pages](#)
- [Working with Blog Posts](#)
- [Confluence User's Guide](#)

**Screenshot:** Sharing a page
To remove a recipient from the list, choose the bin icon to the right of the recipient.

**Exporting Confluence Pages and Spaces to Other Formats**

You can convert a part of, or the entire contents of a space to various formats, including Microsoft Word, HTML, PDF and XML. This is called 'exporting' the space.

**What would you like to do?**

- Exporting Confluence Pages and Spaces to HTML
- Exporting Confluence Pages and Spaces to PDF
- Exporting to a Word document
- Exporting Confluence Pages and Spaces to XML

**Related topics**

- Working with Spaces
- Confluence User's Guide

**Exporting Confluence Pages and Spaces to HTML**

In Confluence, you can export part of, or the entire contents of, a space into a zipped archive of HTML files. This is useful if you want convert your space into a static website.

To use the space export functionality, you need the ‘Export Space’ permission. See the guide to space permissions.

**To export pages to HTML:**

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

*Note: This option appears only if you are a space administrator for the space or you are a super user (a
member of the confluence-administrators group).

2. Choose **Content Tools > Export**
   Note: This option will only be visible if you have the ‘Export Space’ permission.

3. Select **HTML** then choose **Next**

4. Decide whether you need to customise the export:
   - Select **Normal Export** to produce an HTML file containing all the pages that you have permission to view.
   - Select **Custom Export** if you want to export a subset of pages, or to exclude comments from the export.

5. Select the **Include Comments** check box if you want to include comments for the pages you are exporting.

6. Select the pages you want to export.
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.

7. Choose **Export**. This will create a zipped archive of HTML files.

8. When the export process has finished, download the zipped archive as prompted, and extract the files into a folder.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **HTML Export** from the left menu
3. Follow the steps above to export the Space.

**Related pages:**

- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to XML
- Confluence User's Guide

**Screenshot: Selecting pages to export**
Export HTML Options

Export content within this space as HTML.

- Normal Export
  Generates a HTML file of all pages and blog posts in this space, including comments and attachments.

- Custom Export
  Generates a HTML file of selected pages based on options that you choose from below.

Includes:

- ☑ include comments

Choose pages to export:

Select All  ·  Deselect All

- ☑ Crowd Documentation
  - ☑ Crowd 101
  - ☑ Crowd Administration Guide
  - ☑ Getting Started

Select All  ·  Deselect All

Note

In the zip file, page attachments are placed in individual folders with names in the following format:

```bash
...\download\attachments\xxxxxx
```

where ‘xxxxxx’ is the page ID of the page containing the attachments.

- By default, the ‘Space Details’ page is exported as `index.html` and displays the space's details as well as a list of all available pages within it.

- Blog posts are not included in the HTML export. See the feature request: CONF-14684.

- To customise the HTML output, you will need to modify the file `confluence-x.y.z-jar/com/atlassian/confluence/pages/Page.htmlExport.vm`. To learn how to repackage this file, see How to Edit Files in Confluence JAR Files.

Exporting Confluence Pages and Spaces to PDF

This page explains how you can export individual Confluence pages, blog posts, entire spaces or selections of pages into a single PDF file.

Exporting single pages

You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page.

- Go to a page in the space and choose Tools > Export to PDF. Follow the prompts to export the page.

Note that the export of a single page to PDF applies any PDF stylesheet customisations, but does not apply any PDF layout customisations. To make your PDF layout customisations apply to a single page exported to PDF, use the 'multiple page' method described below to export that single page only. See Customising Exports to PDF.

Exporting a blog post
You can export a Confluence blog post to PDF. This option exports a single blog post and is available to all users who have permission to view the page.

- Go to a blog post and choose **Tools > Export to PDF**. Follow the prompts to export the page.

Blog posts can only be exported individually. Blogs cannot be exported at the space level.

**Exporting multiple pages or the entire space**

Using Confluence’s space export functionality, you can convert multiple pages or an entire space to PDF.

To use the space export functionality, you need the ‘Export Space’ permission. See the guide to space permissions.

**To export a space or selected pages to PDF:**

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).

2. Choose **Content Tools > Export**
   - Note: This option will only be visible if you have the ‘Export Space’ permission.

3. Select **PDF** then choose **Next**

4. Decide whether you need to customise the export:
   - Select **Normal Export** to produce a PDF file containing all the pages that you have permission to view.
   - Select **Custom Export** if you want to export a subset of pages.

5. Select the pages you want to export:
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.

6. Choose **Export**.

7. When the export process has finished, download and save the PDF file as prompted.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **PDF Export** from the left menu
3. Follow the steps above to export the Space.
Customising the appearance of PDF exports

You can add a title page, a table of contents and customised headers and footers to the PDF output. For more advanced customisations, you can apply Cascading Style Sheet (CSS) modifications. These customisations are specific to each space. You need the ‘Space Administrator’ permission to be able to apply these customisations. For more information, see Customising Exports to PDF.

Notes

- Comments on the page are not exported to the PDF file.
- Only image attachments that have been inserted into a page are included when exporting to PDF.
- To export a PDF containing international text, you need to install a Unicode font in Confluence.
• Blog posts can be individually exported, but are not included when you export a space to PDF.
• If you have 'Space Administrator' permissions, the link to customise the PDF Stylesheet is provided at the top of the page tree, as shown in the screenshot above.
• Confluence's PDF export feature is designed to handle a wide variety of content. However, on rare occasions the PDF Export process may fail due to an unrecognised customisation. If that happens the PDF export screen will indicate the title of the page in which the problem occurred, to help you diagnose the cause of the failure.

Customising Exports to PDF

Confluence administrators and space administrators can customise the PDF exports for individual spaces.

Please note:

• PDF customisations are unique to each space.
• Confluence's PDF customisations use a combination of HTML and CSS (Cascading Style Sheets).
• To achieve a particular requirement in the exported PDF file, you make changes in one or both of the following:
  • The PDF Layout, where HTML is used to define the structure of the exported content, including features such as the title page, headers and footers.
  • The PDF Stylesheet, where CSS is used to define the style of elements in the exported content, such as page size and margins, font, colour, and list numbering.

For further customisations, see the Advanced PDF Export Customisations page.

Customising the PDF Layout

You can add your own HTML to customise the title page, page headers and page footers in the PDF output.

Setting a global PDF layout

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose PDF Layout. You can enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.

Setting the PDF layout at space level

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
3. Choose Look and Feel > PDF Layout.
4. Choose Edit.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose PDF Layout in space administration options.
3. Choose Edit.

You can customise the HTML that is generated for the following areas when the space is exported to PDF:

• PDF Space Export Title Page – title page.
• PDF Space Export Header – page headers.
• PDF Space Export Footer – page footers.

Enter your customisations into each text box as required. The PDF layout section accepts HTML code. You can include inline CSS in the HTML too.

On this page:

• Customising the PDF Layout
  • Setting a global PDF layout
  • Setting the PDF layout at space level
• Customising the PDF Stylesheet
  • Setting a global PDF Stylesheet
  • Setting a space PDF stylesheet
• Example Customisations
  • Page Size
  • Page Orientation: Landscape or Portrait
  • Page Margins
  • Page Breaks
  • Title Page
  • Table of Contents
  • Headers and Footers
  • Page Numbering
  • Wrapping Long Words
  • General Formatting

• Notes
• Related Topics

Related pages:

• Advanced PDF Export Customisations

Customising the PDF Stylesheet

You can adjust the appearance of the PDF pages by customising the CSS in the PDF Stylesheet screen.

To get started, download the default CSS rules for the PDF stylesheet - confluencedefaultpdf.css.

Any rule defined in this file can be customised and added to the PDF Export Stylesheet section. Your customisations override any default CSS rule. If no customisations are defined, the default CSS rules will be applied.

By default, the export does not include a title page, headers or footers. You can define these in the PDF layout.

To customise the PDF Stylesheet:

Setting a global PDF Stylesheet

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code that will render content on each page.

Setting a space PDF stylesheet

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   • If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a
1. Choose **Look and Feel > PDF Stylesheet**
2. Choose **Edit**.
3. Enter your customisations.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note: The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).*
2. Choose **PDF Stylesheet** in the space administration options.
3. Choose **Edit**.
4. Enter your customisations.

The PDF Export Stylesheet field accepts Cascading Style Sheets (CSS) rules. The ‘PDF Export Stylesheet’ page shows the current (e.g. customised) contents of your PDF stylesheet.

**Example Customisations**

This section provides examples of typical customisations that you can add. See also [Advanced PDF Customisations](#).

### Page Size

The default page size is based on the location of your Confluence server. For example, if this server is located in the US then the default paper size of your PDF export will be US Letter (8.5 inches wide by 11 inches long). If the server is located in Australia, the default paper size will be A4 (210 mm wide by 297 mm long). More information about paper sizes can be found on [Wikipedia](https://en.wikipedia.org/wiki/Paper_size).

To modify the page size to A4, edit the PDF Stylesheet to add a `size` property to the `@page` rule, like this:

```css
CSS - PDF Stylesheet

@page {
/*The A4 paper size is 210 mm wide by 297 mm long*/
size: 210mm 297mm;
}
```

### Page Orientation: Landscape or Portrait

To change the page orientation of your PDF document, simply reverse the order of the values declared in the `@page` rule’s `size` property. The first and second values of this property represent the width and height of the page, respectively.

For example, to generate PDF space exports in A4-sized landscape orientation, your `@page` rule might look like this:

```css
CSS - PDF Stylesheet

@page {
/*A4-sized pages in landscape orientation are 297 mm wide by 210 mm long*/
size: 297mm 210mm;
}
```
**Page Margins**

To set all margins to 15 mm, with a paper size of A4, edit the CSS `@page` rule in the PDF Stylesheet, like this:

```
CSS - PDF Stylesheet

@page
{
    size: 210mm 297mm;
    margin: 15mm;
}
```

To set the margins independently, edit the `@page` rule as follows:

```
CSS - PDF Stylesheet

@page
{
    margin-top: 2.54cm;
    margin-bottom: 2.54cm;
    margin-left: 1.27cm;
    margin-right: 1.27cm;
}
```

To set margins to provide a gutter for binding a printed document, use the `:left` and `:right` pseudo-classes, as follows:

```
CSS - PDF Stylesheet

@page :left
{
    margin-left: 4cm;
    margin-right: 3cm;
}
@page :right
{
    margin-left: 3cm;
    margin-right: 4cm;
}
@page :first
{
    margin-top: 10cm /* Top margin on first page 10cm */
}
```

Note the use of the `:first` pseudo-class in the example above to define distinct margins for a cover or title page.

**Page Breaks**

By default, Confluence pages are exported without page breaks, so that shorter pages will appear on the same PDF page.

To make each Confluence page appear on a separate page in the PDF file, add the following rule in the PDF Stylesheet:
Title Page

You can add a title page to your PDF document by adding HTML to the Title Page section of the PDF Layout screen. The following example creates the title page and adds a title:

```
HTML - PDF Layout: Title Page Section

<div class="fsTitlePage">
  <img src="/download/attachments/590719/titlepage.png" />
  <div class="fsTitle">Planning for Confluence 4.0</div>
</div>
```

Use CSS rules in the PDF Stylesheet to control the appearance of the title page and the title text:

```
CSS - PDF Stylesheet

.fsTitlePage
{
  margin-left: auto;
  margin-top: 50mm;
  margin-right: auto;
  page-break-after:always
}

.fsTitle
{
  font-size: 42px;
  font-weight: bold;
  margin: 72px 0 4px 0;
  text-align:center;
}
```

Adding an Image to the Title Page

In the example above, the title page includes an image called 'titlepage.png', centred in the middle of the page. The "590719" in the `src` attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your title page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate `src=""` attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before `/download/...`

Table of Contents

By default, a table of contents will be generated after the title page, or at the beginning of the PDF document if no title page is defined in the PDF Layout. To see the default CSS rules applied to the table of contents,
download the default CSS rules (confluencedefaultpdf.css) and examine the specific rules with toc in their name.

To make changes to the appearance of the table of contents, define CSS rules in the PDF Stylesheet.

Disabling the Table of Contents

To prevent the table of contents from being generated in your PDF document, add the div.toc rule to the PDF Stylesheet and set its display property to none:

CSS - PDF Stylesheet

```css
div.toc {
  display: none;
}
```

Changing the Leader Character in the Table of Contents

The leader character is used to link a heading in the table of contents with its page number. By default, the leader character is the '.' (dot) character. Leader values of dotted, solid and space are allowed. You can also use a string, for example leader("... ").

To change the leader character to a solid line, modify the leader() value on the content property of the CSS rule as follows:

CSS - PDF Stylesheet

```css
span.toclead:before {
  content: leader(solid);
}
```

Headers and Footers

You can add headers and footers to your PDF pages using the 'Header' and 'Footer' sections of the PDF Layout screen. By default, headers and footers only apply to a space export and not to exports of single pages (however, see Advanced PDF Export Customisations). The following example adds a simple copyright notice.

HTML - PDF Layout: Footer Section

```
Copyright © 2013, Atlassian Pty Ltd.
```

Page Numbering

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. PDF Layout HTML: In the Footer section (or the Header section), use an empty span element with a unique ID, for example pageNum, to act as a place holder for the page number.
1. HTML - PDF Layout: Footer Section

   ```html
   <span id="pageNum"/>
   ```

2. PDF Stylesheet CSS: Create the following CSS selector rule for the empty span:

   ```css
   #pageNum:before
   {
      content: counter(page);
   }
   ```

   Analysing the above CSS selector rule in more detail:

   - The `#pageNum` rule selects the HTML element with the specified ID of "pageNum", which is the span element we created for the header or footer.
   - The `:before` part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
   - The `counter(page)` is a function that returns the current page number as its content.
   - The `content` property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.

Wrapping Long Words

In order to break long words or words that are not separated by whitespace, add a selector to the PDF stylesheet containing the `word-wrap` property with a value of `break-word`:

```css
div
{
   word-wrap: break-word;
}
```

General Formatting

You can use the stylesheet to customise the output of just about anything else that will influence the look and feel of the final document. This includes fonts, tables, line spacing, macros, etc. The export engine works directly from the HTML output produced by Confluence. Therefore, the first step in customising something is to find a selector for the HTML element produced by Confluence or the Confluence macro. Then add a CSS rule to the PDF stylesheet. Your customisation will appear in the PDF export.

Notes

- **Demotion of heading elements: h1, h2, and so on.** Due to the hierarchical manner in which a space is exported, Confluence will modify the heading elements to generate a uniform appearance for the entire space export. This means that headings will be demoted. This will affect the application of custom PDF Stylesheets. It is possible to calculate the amount by which a heading will be demoted in order to have the
correct CSS styling applied. A heading will be demoted by the value of its depth in the export tree. A page at the first level will be demoted by 1 (all $h_1$ elements will become $h_2$ elements, and so on). A page at the second level will be demoted by 2, and so on.

- **Atlassian support for PDF customisation is limited.** We support the mechanism for customising the PDF layout with HTML and CSS, and we will help if the mechanism is broken or does not work as we say it should in our published examples. But, since custom HTML and CSS offer potentially limitless possibilities, Atlassian will not support issues that are caused by or related to PDF customisations.

### Related Topics

**Advanced PDF Export Customisations**

This page provides information about 'advanced' PDF export customisations. These expand upon the regular customisations described in Customising Exports to PDF.

⚠️ The information below is for advanced users. Customisations are not supported by Atlassian. Be aware that the advanced customisations described below require knowledge of certain parts of Confluence, and of CSS and HTML. This documentation is intended for advanced users. Some of the suggestions below are moderately complex, or irregular in nature. If you are having trouble understanding them we strongly suggest you ask an expert. We do not support any of the customisations described below. This means that the Atlassian support engineers will not be able to help you with these modifications.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Related pages:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Customising Exports to PDF</td>
</tr>
<tr>
<td>• Confluence User’s Guide</td>
</tr>
</tbody>
</table>

**Header and Footer**

### Adding Headers and Footers to Single Page Exports

By default, custom headers and footers set up in the PDF Layout screen (see Customising Exports to PDF), only apply to space exports and not to exports of single pages. However, it is possible to add CSS rules to your PDF Stylesheet that produce headers and footers in single page exports as well as space exports.

For custom headers, define $@top-left$, $@top-center$ and $@top-right$ rules within your $@page$ rule. These rules apply respectively to content that appears on the left-hand side, centre and right-hand side of your page’s header area.

For custom footers, define $@bottom-left$, $@bottom-center$ and $@bottom-right$ rules within your $@page$ rule.

For example, the following rules add a document title at the centre of the header and a page number at the centre of the footer:
CSS - PDF Stylesheet

```css
@page
{
    @top-center
    {
        content: "Document Title Goes Here";
        font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
        font-size: 8pt;
    }
    @bottom-center
    {
        content: "Page " counter(page);
        font-family: ConfluenceInstalledFont, Helvetica, Arial, sans-serif;
        font-size: 8pt;
    }
    /* Any other page-specific rules */
}
```

Notes:

- The `font-family` and `font-size` properties ensure that the header and footer text is rendered in the same default font style used for the body text, based on the default CSS rules.
- It is not possible to use this method to insert images (stored as attachments within your Confluence instance) into the headers and footers of single page exports.

Adding Images to Headers and Footers

To insert an image into the header or footer, add HTML to the Header or Footer section of the PDF Layout screen.

The following example uses an HTML `img` element with `src` attribute to add an image to the left of the header. The `src` attribute refers to an image attached to a Confluence page. The image element is usually placed within a `div` element container.

```
<div style="margin-top:10mm">
    <img src="/download/attachments/12346/header-image.png"/>
</div>
```

In the example above, the header includes an image called 'header-image.png'. The "12346" in the `src` attribute is the ID number of the page to which the image is attached.

Follow these instructions to include an image on your page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page, then right-click the image and copy its location.
3. Paste the link into the appropriate `src=""` attribute in your PDF Stylesheet, as shown above.
4. Edit the image URL so that it is relative, by removing the first part of the URL before `/download/.....`

Notes:

- This example uses an inline CSS property `margin-top` in the `style` attribute to force the image away from the top of the page by 10mm. This comes in handy when your header image is large enough to touch or spill over the top of the page.
• Likewise, for footers, you can use the margin-bottom:XXmm property to force an image away from the bottom of the page by ‘XX’ mm.

• Very large images can spill over into the body of a page or alter the position of text or other elements used within a header or footer. In such situations, it is recommended that you reduce the size of the image and then attach it to your Confluence page again. If you prefer to keep the image size and want to move the content lower instead, you can do so by configuring the margin-top properties in the @page CSS rule.

• By default, a header or footer image is aligned to the left-hand side of the page. However, you can align this image to the centre or right-hand side of a page by adding either the text-align:center or text-align:right properties to your style attribute. For example, to align the header image to the right-hand side of the page, your style attribute would look similar to this: style="margin-top:10mm; text-align:right".

Incorporating Other Fonts

By default, Confluence provides Times New Roman, Helvetica or Courier fonts for use in PDF exports. You can use your own fonts for PDF exports by declaring them in a @font-face CSS rule in your PDF Stylesheet.

The following CSS rule example shows how to declare the Consolas font and apply it to some elements for your PDF export:

```css
@font-face
{
  src: url(file:///usr/share/fonts/Consolas.ttf);
  -fs-pdf-font-embed: embed;
}

.code pre, .preformatted pre, tt, kbd, code, samp
{
  font-family: Consolas, monospace;
  font-size: 9pt;
}
```

The font path specified in the CSS must be the path to the font on the Confluence server.

Adding a Dynamic Title to the Title Page

When you export an arbitrary set of pages from Confluence, you may like to have a corresponding title added to the cover (or title) page automatically. This can be done (in a somewhat irregular way) by using the top level item from the default table of contents as the title. This method relies on having the exported pages structured as sub-pages of the top-level page. In other words, the pages to be exported should consist of a page (at the top-level) and all of its child pages. The result is that the title that appears on the cover page changes depending on the top-level page that is used for the export.

The CSS below moves, and styles, the top-level TOC item for use as the title on the cover page, and turns off the leader and page number normally associated with this item in the TOC.
CSS - PDF Stylesheet

```
.fsTitlePage
{
    position: relative;
    left: 0px;
}

/* Turn off the default section numbering for this TOC item */
.toclvl0:before
{
    content: " ";
    counter-reset: chapter 0;
}

/* Hide the default page numbering for this TOC item */
.toclvl0 .tocnum
{
    display: none;
}

/* Move and style this TOC item */
.toclvl0
{
    position: absolute;
    top: 250px;
    font-size: 42px;
    font-weight: bold;
    margin: 72px 0 4px 0;
    text-align: center;
}
```

### Hiding Text from the PDF Output (Not applicable to Confluence OnDemand.)

This section describes a way to hide text from your PDF export. In other words, you can have text on the Confluence page that will not appear in the PDF export.

There are three steps:

1. Follow the instructions to define the NoPrint user macro. *Not applicable to Confluence OnDemand.*
2. Use the NoPrint macro to mark some text on a Confluence page.
3. Add the following CSS to your PDF stylesheet to make the PDF export recognise the NoPrint macro:

```
.CSS - PDF Stylesheet

.noprint
{
    display: none;
}
```

### Indexing

To obtain an index at the end of the exported PDF file, consider using the [Scroll Wiki PDF Exporter plugin](#) that is produced by K15t Software GmbH.
Notes

If styling is not working as expected, it is useful to look at the intermediary HTML source to which the CSS is applied. This intermediary HTML is created whenever you create an HTML export that contains multiple pages, and is stored in the temp directory in Confluence's home directory. For example:

```
<confluence-home>/temp/htmlexport-20110308-154047-1/export-intermediate-154047-2.html
```

Creating PDF in Another Language

To export a Confluence page written in a language other than English, you need to install the necessary font for that language. This means that you need to upload the font file to Confluence, as described below.

Uploading a Font File to Confluence

1. Find the appropriate font file:
   - **Windows users:** All font files in Windows are stored in a directory called:
     ```
     C:\WINDOWS\Fonts
     ```
   - **Unix users:** All font files in Unix are stored in:
     ```
     /usr/share/fonts
     ```
   - Microsoft True Type core fonts such as Verdana can be downloaded from this page: http://corefonts.sourceforge.net/

2. Copy the font file into a temporary folder, for example a folder on your desktop.

3. Choose the cog icon at top right of the screen, then choose Confluence Admin. then choose PD F Export Language Support.
   Note: If you are using Confluence OnDemand, go to this URL instead:
   ```
   https://<account_name>.atlassian.net/wiki/admin/flyingpdf/configure pdflanguagesupport.action
   ```

4. Upload the file you copied in step 2.
5. Choose Install.

Related pages:
- Exporting Confluence Pages and Spaces to PDF
- Confluence Administrator's Guide

Notes

- The only font files supported are true type fonts and true type collections. The accepted file extensions are *.ttf and *.ttc.
- We recommend that you use Unicode font Verdana for correct character encoding and exporting to PDF.
- If the font file size is bigger than your current attachment size limit, you will not be able to upload it.
  Please increase the attachment size limit temporarily and re-upload again. An improvement of the error messaging is tracked at CONF-24706 - Authenticate to see issue details.

Exporting to a Word document
Confluence allows you to export a single page into a Word document. By default, this will create a Word document with the same name as the Confluence page. This is useful for emailing content to people who do not have access to Confluence.

Anyone who has permission to view the page will be able to export it to Word.

**To export a page to a Word document:**

Go to the page and choose **Tools > Export to Word**.

**Useful plugins**

*Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.*

This plugin provides extended functionality for exporting Confluence pages to Microsoft Word: **Scroll Office**.

**Exporting Confluence Pages and Spaces to XML**

You can export part of, or the entire contents of, a Confluence space into a zipped archive of XML files. This is useful if you want to make a backup of the space, import the space into another Confluence site, or use the data from the space in another application.

To export a space or pages to XML, you will need the ‘Export Space’ permission. See **Space Permissions**.

**Notes:**

- There are some restrictions when importing a space. See:
  - Restoring a Space *(Not applicable to Confluence OnDemand)*.
  - Importing wiki data *(For Confluence OnDemand)*.
- If you are doing the export for backup purposes, consider another means of backup. See **Production Backup Strategy *(Not applicable to Confluence OnDemand)*.

**To export pages or an entire space to XML:**

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.
     
     *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

2. Choose **Content Tools > Export**

   *Note:* This option will only be visible if you have the ‘Export Space’ permission.

3. Select **XML** then choose **Next**

4. Decide whether you need to customise the export:
   - Select **Full Export** to produce an XML file containing all the pages in the space, including those that you do not have permission to view.
   - Select **Custom Export** if you want to export a subset of pages, or to exclude comments from the export.

5. Select **Include Comments** if you want to include comments made on the pages you are exporting.

6. Select the pages you want to export:
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.

7. Choose **Export**. This will create a zipped archive of XML files.

8. When the export process has finished, download and save the zipped archive file as prompted.
If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**
2. Choose **XML Export** from the left menu
3. Follow the steps above to export the Space.

**On this page:**

**Related pages:**
- Restoring a Space *(Not applicable to Confluence OnDemand.)*
- Importing wiki data *(For Confluence OnDemand.)*
- Exporting Confluence Pages and Spaces to PDF
- Exporting Confluence Pages and Spaces to XML
- Working with Spaces
- Confluence User's Guide

**Screenshot: Exporting a space**

## Export XML Options

**Export content within this space as XML.**

- **Full Export (includes pages not visible to you)**
  
  Generates a XML file of all pages and blog posts (including ones not visible to you) in this space, including comments and attachments.

- **Custom Export**
  
  Generates a XML file of selected pages based on options that you choose from below.

**Includes:**

- [x] Include comments

**Choose pages to export:**

Select All  ·  Deselect All

- [x] Crowd 101
- [ ] Crowd Administration Guide
- [ ] Getting Started

Select All  ·  Deselect All

[Export]

**Notes**

If you are running Confluence behind Apache HTTP Server and are facing timeout errors, please consider creating the export directly from Tomcat, instead of going through Apache. This will speed up the process and prevent timeouts.

**Commenting on pages and blog posts**

A comment is a remark, question, or any other additional information you wish to add to a page or blog post. People can use comments to interact with each other on your Confluence site.

You can add a comment to any page or blog post, provided that you have the 'Add Comments' permission in the space. You can also show that you agree with or enjoyed someone else's comment, by **liking** it.

Comments are displayed at the bottom of the page, below the page content. They appear in one of two views,
configured globally by a site administrator:

- **Threaded** – This view shows the comments in a hierarchy (tree) of responses. The replies are indented to indicate the relationships between the comments.
- **Flat** – This view displays all the comments in a single list and does not indicate the relationships between comments.

On this page:

- Adding a comment
- Editing a comment
- Deleting a comment
- Disabling comments
- Notes

Related pages:

- Linking to Comments
- Working with Pages
- Working with Blog Posts
- Sharing Content
- Confluence User’s Guide
- Enabling Threaded Comments

Adding a comment

You can add a comment on pages and blog posts in Confluence.

To add a comment, you need the ‘Add Comments’ permission. See Space permissions.

To add a new comment:

1. Position your cursor in the comment box, next to your profile picture at the bottom of the page.
2. Type in your comment.
3. Choose Preview to see how your comment will appear.
4. By default, Watch this page is ticked. This means that you will start receiving notifications about this page. Remove the tick if you do not want to watch the page.
5. Choose Save.

If the Confluence site displays comments in the threaded view, you can respond to previous comments.

To respond to a comment:

1. Choose Reply located below the text of a comment.
2. Type in your response.
3. Choose Save.

Editing a comment

To edit a comment, you need the ‘Add Comments’ permission. See Space permissions. Space administrators can edit all comments within their space. The date on a comment always indicates the time the comment was last edited.

To edit a comment:

1. Go to the comment and choose Edit.
2. Make changes to the comment just as if you were adding a comment.
3. Choose Save.

Deleting a comment
To delete a comment from a page, you need the 'Remove Comments' permission. See Space permissions.

**Note:** Deleted comments cannot be restored.

**To delete a comment:**

1. Go to the page that contains the comment.
2. Choose **Delete** at the bottom of the comment box.

**Disabling comments**

To prevent all users from adding comments in a space, remove the 'Add Comments' permission from the 'confluence-users' group, anonymous users and all other users and groups. See Space permissions. The option to add comments will no longer appear on pages or blog posts. You need to be a space administrator to change the space permissions.

There is no permission that controls comments across the entire site.

**Notes**

- You can choose **Tools > Watch** to receive an email notification whenever anyone edits the page or adds a comment to the page.
- Your profile picture will appear next to each comment that you have added. (This is true if your space uses the Confluence Default theme.)
- On blog posts only, an 'Author' lozenge will appear on any comments made by the original author of the post.
- Comments are not auto-saved. See feature request: [CONF-12978 - Authenticate](https://confluence.atlassian.com/nav/formatting) to see issue details
- It is not possible to delete all comments for a page simultaneously.

**Linking to Comments**

You can add a link to a comment by making use of the permalink (permanent link) associated with each comment. Alternatively, using wiki markup you can link directly to the ID of a comment.

**Linking to a comment via the permalink**

To link to a comment from within Confluence:

1. Right-click the **date/time** at the lower right of the comment box.
2. Use your browser's 'copy link location' function to copy the link on the date/time text. That link is the URL of the comment.
3. Edit the page from which you want to link to the comment.
4. Choose **Insert > Link** in the editor toolbar.
5. Choose the **Web Link** tab.
6. Paste the comment's URL into the address field.
7. Provide link text if required.
8. Choose **Insert**.
9. Save the page.

To link to a comment from outside Confluence:

1. Right-click the **date/time** at the lower right of the comment box.
2. Use your browser's 'copy link location' function to copy the link on the date/time text. That link is the URL of the comment.
3. Use this URL to link to the comment from your web page.
**Linking to a comment via the comment ID**

You can enter wiki markup into the Confluence editor, either via Insert > Wiki Markup, or by typing the full wiki markup into the editor and allowing Confluence to autoconvert it.

Here is the wiki markup syntax for linking to a comment, where the comment ID is '12345'.

Without an alias:

```
[$12345]
```

With an alias:

```
[alias text|$12345]
```

To find the ID of a comment, right-click the date/time at the lower right of the comment box and examine the URL of the comment.

- The comment URL looks something like this:

```
https://confluence.atlassian.com/display/DOC/Linking+to+Comments?focusedCommentId=302812339#comment-302812339
```

- The comment ID is a number, something like this: 302812339.

**Sample Page**

Start of sample page content


End of sample page content

**Printing Confluence Pages**

You can print one or more Confluence pages:

- To print a single page, use your browser's 'Print' option.
Confluence allows you to export a single page, single blog post, part of a space, or an entire space into a single PDF file. See Exporting Confluence Pages and Spaces to PDF.

Managing Changes and Notifications and Tasks

Confluence provides several ways in which you can watch for changes to single pages, entire spaces, and all spaces on the site. You can also follow the updates made by specific people. You can only track updates to content that you have permission to see.

Personal tasks appear in the task-and-notification dialog, and you can assign team tasks via a task list on a page.

Making yourself a watcher of pages or spaces

You can 'watch' a page, blog post or space that you have permission to view. Confluence will then send you an email notification whenever someone adds or updates content on, or adds a comment to, that page or space. See:

- Watching a Page or Blog Post
- Watching a Space

If you have space administrator permissions, you can manage watchers of pages and spaces.

Requesting other notifications

You can configure Confluence to send you various digest reports via email. See Subscribing to Email Notifications of Updates to Confluence Content.

On this page:
- Making yourself a watcher of pages or spaces
- Requesting other notifications
- Tracking updates by specific people
- Managing your notifications and tasks
- Using Confluence RSS feeds

Related pages:
- Page History and Page Comparison Views
- Viewing Space Activity
- Contributors Macro
- Confluence User's Guide

Tracking updates by specific people

You can also follow the activity of people who interest you (see Network Overview) and receive a notification when someone follows you (see Subscribing to Email Notifications of Updates to Confluence Content).

Managing your notifications and tasks

There are a few ways to manage notifications and tasks in Confluence:

- You can manage your email notification settings via the options in your user profile. See Subscribing to Email Notifications of Updates to Confluence Content.
- The Confluence workbox displays all notifications collected from Confluence page watches, shares and mentions. See Managing Notifications in Confluence.
- You can manage your personal tasks in the Confluence workbox, and also create a list of tasks on a page. See Managing Tasks in Confluence.

Using Confluence RSS feeds
You can build RSS feeds to monitor content changes in Confluence.

- Create a customised RSS feed using the RSS Feed Builder.
- Subscribe to one of the pre-specified feeds generated by Confluence.

**Watching a Page or Blog Post**

You can 'watch' a Confluence page, blog post or space. Confluence will then send you a notification by email whenever anyone updates the watched content.

You will receive email notifications for:

- Edits (unless the user clears the Notify watchers check box).
- Deletions.
- Attachments, including new versions or deletions of an existing attachment.
- Comments, including new comments, edits of existing comments or deletions of existing comments.

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can control autowatch.

There is no daily digest for email notifications. You will receive an email notification every time someone makes a change.

You will not receive email notifications for content changes due to the output of a macro, because the page content itself has not been edited.

You need 'View' permission for the page, blog post or space to receive notifications.

On this page:
- Watching a Page or Blog Post
- Setting Autowatch and Other Notification Options
- Watching an Entire Space
- Watching for New Blog Posts
- Managing Watches from your User Profile
- Managing Watches from the Email Message

Related pages:
- Watching a Space
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- Updating Email Address
- Confluence User's Guide

**Watching a Page or Blog Post**

**To start watching a page or blog post:**

1. Go to the page or blog post.
2. Choose Tools > Watch.

**To stop watching a page or blog post:**

1. Go to the page or blog post.
2. Choose Tools > Stop watching.

**Setting Autowatch and Other Notification Options**

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can turn autowatch on or off, and set other notification options, in the email
settings section of your user profile. See Setting User Settings.

Watching an Entire Space

You can choose to watch all the pages and blog posts in a given space. See Watching a Space.

Watching for New Blog Posts

You can choose to watch for:

- New blog posts in a given space. See Watching a Space.
- All new blog posts in the Confluence site. See Subscribing to Email Notifications of Updates to Confluence Content.

Managing Watches from your User Profile

The 'Watches' page in your user profile displays a list of all pages and spaces you are currently watching.

To manage your watches:

1. Choose your profile picture at top right of the screen, then choose Watches.
2. Choose Stop Watching for any unwanted spaces or pages.

Managing Watches from the Email Message

The email notifications that you receive from Confluence have some useful links at the bottom of the email message. The links in each message vary, depending on the context. In general, the links allow you to view the page online, reply to a comment, and so on. In particular with respect to setting your notification preferences, you will see one or more of the following links:

- **Stop watching page** – Click this link to stop watching the page that triggered the email notification.
- **Stop watching space** – Click this link to stop watching the space that triggered the email notification.
- **Stop following this user** – Click this link to stop following the user whose update triggered the email notification.
- **Manage Notifications** – Click this link to go to the email settings page in your user profile.

Screenshot: Email notification footer showing links

Watching a Space

You can 'watch' a Confluence page, blog post or space. Confluence will then send you a notification by email whenever anyone updates the watched content.

You will receive email notifications for:

- Edits (unless the user clears the Notify watchers check box).
- Deletions.
- Attachments, including new versions or deletions of an existing attachment.
- Comments, including new comments, edits of existing comments or deletions of existing comments.

By default, Confluence will assign you as a watcher of any page or blog post that you create or edit. This behaviour is called 'autowatch'. You can control autowatch.

There is no daily digest for email notifications. You will receive an email notification every time someone makes a change.

You will not receive email notifications for content changes due to the output of a macro, because the page
content itself has not been edited.

You need 'View' permission for the page, blog post or space to receive notifications.

### On this page:
- Watching all pages in a space
- Watching for new blog posts in a space
- Watching all Spaces on the Site
- Managing watches from your user profile
- Managing watches from the email message
- Managing watchers
- Notes

### Related pages:
- Watching a Page or Blog Post
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- Updating Email Address
- Managing Watchers
- Confluence User’s Guide

### Watching all pages in a space

If you want to receive notifications of updates to any content in the space you can watch all pages.

**To start watching a space:**

1. Choose **Pages** in the space sidebar.
2. Choose **Watch this space** at the top right.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **Watch this space** in the left-hand menu.

**To stop watching a space:**

1. Choose **Pages** in the space sidebar.
2. Choose **Stop watching this space** at the top right.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **Stop watching this space** in the left-hand menu.

### Watching for new blog posts in a space

You can choose to receive a notification whenever someone adds a blog post in the space. You will not receive notification of updates to or deletions of blog posts, nor of comments on the blog posts.

**To start watching for new blog posts in a space:**

1. Choose **Blog** in the space sidebar.
2. Choose **Watch this blog** at the top right.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **Watch this blog** in the left-hand menu.

**To stop watching for new blog posts in a space:**

1. Choose **Blog** in the space sidebar.
2. Choose **Stop watching this blog** at the top right.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **Stop watching this blog** in the left-hand menu.

**Watching all Spaces on the Site**

You can receive notifications about changes to the content of pages, blog posts and comments from across all spaces on a Confluence site.

**To start watching for content changes across the whole site:**

1. Choose **your profile picture** at top right of the screen, then choose **Settings**.
2. Choose **Email**.
3. Choose **Edit** then choose **Subscribe to daily updates**.
4. Choose **Submit**.

**Managing watches from your user profile**

The ‘**Watches**’ page in your user profile displays a list of all pages and spaces you are currently watching.

**To manage your watches:**

1. Choose **your profile picture** at top right of the screen, then choose **Watches**.
2. Choose **Stop Watching** for any unwanted spaces or pages.

**Managing watches from the email message**

The email notifications that you receive from Confluence have some useful links at the bottom of the email message. The links in each message vary, depending on the context. In general, the links allow you to view the page online, reply to a comment, and so on. In particular with respect to setting your notification preferences, you will see one or more of the following links:

- **Stop watching page** – Click this link to stop watching the page that triggered the email notification.
- **Stop watching space** – Click this link to stop watching the space that triggered the email notification.
- **Stop following this user** – Click this link to stop following the user whose update triggered the email notification.
- **Manage Notifications** – Click this link to go to the email settings page in your user profile.

**Screenshot: Email notification footer showing links**

Managing watchers

Space administrators can view the watchers of a page or space, and manage the watchers of a page. See **Managing Watchers**.

**Notes**

If your space administrator has removed the Pages and Blogs options from the space sidebar, it will not be
possible to access the Watch this space and Watch this blog options.

Managing Watchers

If you are a space administrator for a space, you can manage the watchers for all pages and blog posts in that space. This means that you can:

- View a list of the watchers of a page/blog post.
- View a list of the watchers of the space for that page/blog post.
- Add users as watchers of the page/blog post.
- Remove existing watchers of the page/blog post.

It is not possible to remove watchers of the space.

To manage your watchers for a page/blog post:

1. Navigate to the page or blog post for which you want to manage the watchers. Note, you must be a space administrator for the space that the page is in.
2. Choose Tools > Manage Watchers. The 'Manage Watchers' screen will be displayed (see screenshot below). The left-hand column of the 'Manage Watchers' screen will contain the users watching the page/blog post, the right-hand column will contain the users watching the space.
   - To remove an existing page watcher, click the icon (trash can) next to the user's name.
   - To add a user as a watcher of the page, type in the box and choose the user's name from the list.
3. Click Done to save your changes.

Subscribing to Email Notifications of Updates to Confluence Content

You can 'watch' a page, blog post or space. Confluence will then send you a notification by email whenever anyone adds or updates content on that page or space. You can also subscribe to daily email reports and other notifications of various updates, as described below.

You will only receive notifications for content that you have permission to view. Users that have been disabled by an administrator will not receive email notifications.

Subscribing to email notifications

You can subscribe to the following email summary reports:

On this page:

Related pages:
- Watching a Space
- Watching a Page or Blog Post
- Subscribing to Email Notifications of Updates to Confluence Content
- Managing Changes and Notifications and Tasks
- User Profile Overview
- Confluence User's Guide.
To edit your email notification settings:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click Email in the left-hand panel.
3. Click Edit.

On this page:

- Subscribing to email notifications
  - Subscribe to daily updates
  - Subscribe to all blog posts
  - Subscribe to network
  - Subscribe to new follower notifications
  - Subscribe to recommended updates
- Notes for administrators

Below is an explanation of all the email settings is explained below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Content</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autowatch</td>
<td>Option: Do you want Confluence to automatically add you as a watcher on each page or blog post that you add or update? If you are a watcher of a page or a post, you will receive notification of future changes.</td>
<td>• Pages and blog posts that you create, edit or comment on.</td>
<td>(Not applicable)</td>
</tr>
<tr>
<td>Subscription Type</td>
<td>Description</td>
<td>Notifications Included</td>
<td>Frequency</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
<td>------------------------</td>
<td>-----------</td>
</tr>
</tbody>
</table>
| **Subscribe to daily updates** | Receive email reports showing changes to content in all spaces that you have permission to view. | • Pages and blog posts that are added, edited or deleted.  
• Comments on a page or blog post that are added, edited or deleted.  
• Updates by users who have changed their personal profile. | Daily |
| **Subscribe to all blog posts** | Receive email notifications for changes to blogs in your Confluence installation that you have permission to view. | • Blog posts added, edited or deleted. | Immediately |
| **Subscribe to network** | Receive email notifications for changes to content by all users that you are following, which you have permission to view. | • Pages being added, edited or deleted.  
• Blog posts being added, edited or deleted.  
• Comments being added, edited or deleted.  
• Status updates by the user. | Immediately |
| **Subscribe to new follower notifications** | Receive an email message when anyone chooses to follow you. | | Immediately |
| **Notify on my actions** | **Option:** Do you want to receive email notifications for your own changes? | • All pages and spaces that you are watching.  
• This affects all subscriptions set. | (Not applicable) |

Note: Daily email reports do not include information about attachments on a page or blog post that are added, edited or deleted.
<table>
<thead>
<tr>
<th>Show changed content</th>
<th>Option: Do you want your notifications to include details of the changes made to the content?</th>
<th>Edits to pages and blog posts.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• If you do not select this option, your notifications will include only the title of the page, and any comment the author made when updating the page.</td>
<td>(Not applicable)</td>
</tr>
<tr>
<td></td>
<td>• If you do select this option, your notifications will show the differences between the current and previous versions of the page. See Page History and Page Comparison Views.</td>
<td></td>
</tr>
</tbody>
</table>

*(Not applicable)*
<table>
<thead>
<tr>
<th>Subscribe to recommended updates</th>
<th>Confluence chooses the content to display, based on:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>- Pages and blog posts that people have recently liked.</td>
</tr>
<tr>
<td></td>
<td>- Pages and blog posts that people have recently commented on.</td>
</tr>
<tr>
<td></td>
<td>- Pages and blog posts that have recently been created.</td>
</tr>
</tbody>
</table>

How do you set the frequency of the mail message? A link in the email message allows you to choose daily or weekly notifications.

How do you enable and disable the notification? You can turn off the notification by clicking a link in the email message. You can also turn the notification on or off by setting the ‘Subscribe to recommended updates’ option in your user profile.

‘Recent' means any activity that occurred since the last recommended updates message was sent to you.

The activities are listed in order of popularity, with the most popular at the top. Likes, comments and content creations are scored equally. Activity that involves people in your network ranks higher than activity not involving your network. Content in your favourite spaces also ranks higher than content in other spaces. The recommended updates summary does not include any content that you created yourself, and it gives a lower ranking to content that you have participated in, for example by adding a comment or updating the page.

If there is no activity to report, Confluence will not send the email message.

Daily (weekdays at 1pm) or weekly

Notes for administrators
To enable Confluence to send email notifications, a System Administrator must configure an email server. See Configuring a Server for Outgoing Mail. Not applicable to Confluence OnDemand.

Confluence Administrators can set the default options for the recommended updates notification. Choose the cog icon at top right of the screen, then choose Confluence Admin. Click Recommended Updates Email in the left-hand panel. See Configuring the Recommended Updates Email Notification.

### Subscribing to RSS Feeds within Confluence

An RSS feed is a format for delivering summaries of regularly changing web content. Subscribing to an RSS feed allows you to stay informed of the latest content from sites that you are interested in.

RSS is not designed to be read in a regular web browser. Specialised RSS newsreader programs can check RSS files every so often, and tell you what's new on a site. Your reader may be on a website, an add-on to your browser, part of your email program, or a stand-alone program.

Confluence works with RSS in two ways:

- Confluence generates its own RSS feeds for tracking updates to content within Confluence. You will need an RSS reader which can grab the RSS feeds from Confluence and display them for you.
- Confluence's RSS macro allows you to display the contents of an RSS feed on a Confluence page. The feeds may come from a Confluence feed generator or from external sites. In this way, Confluence can act as an RSS reader.

For a technical description of RSS, read Mark Pilgrim's "What is RSS?" article on XML.com.

### RSS newsreaders

RSS feeds allow you to track updates to content within Confluence. You will need an RSS newsreader to read a feed.

You can create a customised RSS feed using the RSS Feed Builder or subscribe to one of the pre-specified feeds generated by Confluence.

### What would you like to do?

- **Create and subscribe to customised RSS feeds using the RSS Feed Builder** – Create a customised RSS feed. For example, you can filter your feed using a label, specify the number of items and days to include in your feed, and so on.
- **Subscribe to pre-specified RSS feeds** – Generate an RSS feed automatically in a minimal number of steps.
- **Subscribe to a feed of any Confluence user's network** – Track the activities of users the selected person is following.

---

**On this page:**
- Confluence RSS feeds
- RSS newsreaders
- Removing an RSS feed

**Related pages:**
- Managing Changes and Notifications and Tasks
- RSS Feed Macro
- Confluence User's Guide
The following are some popular RSS readers for various operating systems. You can find a more comprehensive list on Google's open directory.

Windows
- SharpReader
- NewsGator
- Syndirella
- FeedDemon
- NewzCrawler

Mac OS X
- Safari
- NetNewsWire
- NewsFire
- Shrook

Multi-platform
- NewsMonster (Runs in the Mozilla web browser)
- Radio Userland (Windows and MacOS)
- AmphetaDesk (Windows, Unix, Mac OS X)

Removing an RSS feed

There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters included in the feed URL (address). For example, take a look at the following feed URL:

http://confluence.atlassian.com/createrssfeed.action?types=page&sort=modified&showContent=true...

The above feed URL will generate a list of pages ("types=page"), sorted by the modification date and showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS feed information stored on the database. For that reason, there is no need to remove anything.

Using pre-specified RSS feeds

This page tells you how to get hold of an RSS feed which Confluence has predefined for you.

To subscribe to predefined RSS feeds for a particular space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. Choose Content Tools > RSS Feeds
3. Copy and paste the link for one of the feeds into your RSS newsreader:

If your space uses the Documentation theme:

1. Choose Browse > Space Operations
2. Choose RSS Feeds in the space operations options.
3. Copy and paste the link for one of the feeds into your RSS newsreader.

Feeds include:

- Pages
- Blog
- Mail
- Comments
- Attachments
- All content

To subscribe to predefined RSS feeds for a particular page (where available):

Note that the word 'page' here means a part of the Confluence user interface, rather than a page that contains Confluence content. For example, your Network view offers an RSS feed.

1. Go to the page.
2. Locate the following icon, which is available in the top-right corner of certain pages: ⚫
3. Copy and paste the icon's link into your RSS newsreader.

Related pages:

- Using the RSS Feed Builder
- Managing Changes and Notifications and Tasks
- RSS Feed Macro
- Confluence User's Guide

Notes

If you want to customise your Confluence RSS feed (for example, use a label to filter your feed), use the RSS Feed builder instead of the above instructions.

Using the RSS Feed Builder

Using the RSS feed builder, you can create customised RSS feeds to subscribe to changes within Confluence.

Wondering what an RSS feed is? See more information about RSS Feeds.

Building an RSS feed

Follow the steps below to build your feed, choosing the type of content and the time period you want to monitor.

To create a customised RSS feed:

1. Choose the help icon  at top right of the screen, then choose Feed Builder.
2. Select the content types you want in your feed.
   - Check Mail if you want to know when the email archive is updated. (See the overview of mail archives in Confluence. Not applicable to Confluence OnDemand.)
3. Select one or more spaces from the list.
4. Click Advanced Options to set the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feed Name</td>
<td>The default name is based on the name of your Confluence installation. For example, 'Extranet RSS Feed'.</td>
</tr>
</tbody>
</table>
5. Choose Create RSS Feed.
6. Drag or copy the link into your RSS reader.

**On this page:**
- Building an RSS feed
- Hints
- Notes

**Related pages:**
- Managing Changes and Notifications and Tasks
- Subscribing to RSS Feeds within Confluence
- Confluence User's Guide

**Hints**

- **Separate feeds.** Try building separate feeds, one for pages only and one that includes comments as well. This allows you to monitor only pages if you are short of time, and to read the comments when you have more time.

- **Labels to customise your feed.**

  You can use the RSS feed builder to track updates to labelled pages and comments on those pages. Here is an idea for customising your RSS feed by using your own personal label(s). This is useful if you want to track updates to specific pages or blog posts, and you do not want to deal with emails. You can use this method as an alternative to watching pages.
  - Build an RSS feed that returns pages, blog posts and comments labelled with a personal label, such as 'my:feed'.
  - Each time you want to 'watch' a page, just label it with 'my:feed'.
  - All updates and comments will automatically come through your RSS feed.

**Notes**

- **Removing an RSS feed:**

  There is no need to try to delete or remove an RSS feed built by the Confluence RSS feed builder.

  Explanation: The feeds generated by the RSS Feed Builder are dynamically generated via the parameters included in the feed URL (address). For example, take a look at the following feed URL:
http://confluence.atlassian.com/createrssfeed.action?types=page&sort=modified&showContent=true...

The above feed URL will generate a list of pages ('types=page'), sorted by the modification date and showing the page content. The feed is generated at the time when the URL is fetched and there is no RSS feed information stored on the database. For that reason, there is no need to remove anything.

- **Feed authentication options**: Confluence can offer you the option of an anonymous feed or a feed that requires authentication.
  - An **anonymous** feed will show only the content that is visible to anonymous users. The feed URL does not contain the &os_authType parameter mentioned below. This feed is useful only if your Confluence site allows anonymous access. If a feed is anonymous, you only get anonymously-viewable content in the feed regardless of whether you are a Confluence user or not.
  - An **authenticated** feed requires you to log in to Confluence before you can retrieve the content. The feed URL contains the following parameter: &os_authType=basic.
  - The option to choose between an anonymous and an authenticated feed is currently not available on the feed builder screen. The feed builder offers only **authenticated** feeds. See CONF-21601 for details and a workaround.

**Subscribing to a Network RSS Feed**

You can create an RSS Feed from any user’s network view, allowing you to receive summaries on the activities of users they are following in their network. The types of activities tracked in these RSS feed summaries include:

- Additions or edits to pages or blog posts
- Comments added to a page or blog post or edits to existing comments
- Updates to a user’s status updates
- Updates to a user’s profile

**Subscribing to a user's network feed**

To subscribe to a user’s network RSS feed:

1. Locate the RSS icon 📰, which is available from the top-right of:
   - The 'Recent activity of the users you are following' section of your network page, or
   - The 'Activity of followed users' section of another user’s network page.
2. Copy and paste the icon's link into your RSS newsreader.

**Customising your network RSS feed**

Confluence does not provide a way of customising a network RSS feed via the user interface. However, you can modify the maximum number of results and type of content displayed in these feeds by directly editing the RSS feed link in your RSS newsreader.
To modify the maximum number of results displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.
2. Change the value of the `max` parameter from its default value of 40 to a value of your choice. Example: http://confluence.atlassian.com/feeds/network.action?username=MYNAME&max=60&publicFeed=false&os_authType=basic&rssType=atom
3. Save the modified link in your RSS newsreader.

To modify the type of content displayed in your RSS feed:

1. Edit the RSS feed link in your RSS newsreader.
2. Append the parameter `contentType` to the end of the link, followed by an equals sign (=) and then add the appropriate content type value of your choice:
   - USER_STATUS — restricts the RSS feed to user status updates.
   - PAGE — restricts the RSS feed to page additions or updates.
   - BLOG — restricts the RSS feed to blog post additions or updates.
   - ATTACHMENT — restricts the RSS feed to attachment additions or updates.
   - COMMENT — restricts the RSS feed to comment additions or updates.

   Content type values are case-sensitive. Ensure that each parameter is separated from the other by an ampersand (&).
   Example: http://confluence.atlassian.com/feeds/network.action?username=ggaskell&max=40&publicFeed=false&os_authType=basic&rssType=atom&contentType=USER_STATUS
3. Save the modified link in your RSS newsreader.

**Notes**

It is not possible to filter for more than one type of content by adding multiple values to the `contentType` parameter.

**Managing Notifications in Confluence**

This page is about the notification-and-task dialog, known as the Confluence 'workbox', which drops down when you choose the icon on the Confluence page header.

Do you want to manage your notification email messages instead? See [Subscribing to Email Notifications of Updates to Confluence Content](#).

Managing your notifications in the Confluence workbox

The workbox displays all notifications collected from Confluence page watches, shares, mentions, and tasks. If your Confluence site is linked to a JIRA issue tracker, you will also see JIRA notifications in your workbox.

You can view your notifications and convert them to personal tasks. Use the inline actions to reply to comments, like a comment or page, or watch a page. Follow the links in a notification to open the relevant page or blog post. With JIRA integration, you can watch or unwatch issues, comment on issues, or follow the link to open the issue in JIRA.

The workbox displays your notifications and your personal tasks in separate tabs.

To manage your notifications:

1. Choose the workbox icon in the Confluence page header.
   - A number may appear on the workbox icon, indicating the number of unread notifications waiting for your attention.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside
the editor pane before pressing the keyboard shortcut keys.)

2. Choose the notifications icon: 

3. Choose a notification from the list, to see the notification details. Now you can do the following:
   - Choose a link or **Open** to open the related page, blog post, or comment. The page will open in a new tab in your browser.
   - Choose **Like** or **Unlike** to let people know that you like, or have stopped liking, a page, blog post, or comment.
   - Choose **Watch** or **Stop Watching** to receive notifications, or stop receiving notifications, about a page or blog post.
   - Choose **Reply** to respond to a comment inline, within the workbox.
   - Choose the ‘add task’ icon to flag a notification as a task. The notification will remain in the notification list too.

---

### On this page:
- Managing your notifications in the Confluence workbox
- Which notifications are included?
- Keyboard shortcuts
- Managing notifications with Confluence mobile
- Notes

### Related pages:
- Configuring Workbox Notifications
- Subscribing to Email Notifications of Updates to Confluence Content
- Watching a Page or Blog Post
- Likes and Popular Content
- Managing Tasks in Confluence
- Confluence User's Guide

**Screenshot:** Your Confluence notifications in the workbox
Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

- Shares a page or blog post with you.
- Mentions you in a page, blog post or comment.
- Assigns you a task by mentioning you in a task list.
- Comments on a page or blog post that you are watching.
- Likes a page or blog post that you are watching.

The workbox does not show notifications triggered because you are watching a space. Only watches on pages and blog posts are relevant here.

If your Confluence site is linked to JIRA, you will also see the following JIRA notifications in your workbox:

- Comments on issues that you are watching.
- Mentions.
- Shares of issues, filters and searches.

Keyboard shortcuts

<table>
<thead>
<tr>
<th>Key</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>g then n</td>
<td>Open the Confluence workbox.</td>
</tr>
<tr>
<td>j</td>
<td>Move down to the next entry in the notification list.</td>
</tr>
<tr>
<td>k</td>
<td>Move up to the previous entry in the notification list.</td>
</tr>
<tr>
<td>n</td>
<td>Move down to the next notification for a particular page or blog post.</td>
</tr>
<tr>
<td>-----</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>p</td>
<td>Move up to the previous notification for a particular page or blog post.</td>
</tr>
<tr>
<td>Enter</td>
<td>Open the selected notification.</td>
</tr>
<tr>
<td>u</td>
<td>Return to the notification list after opening a particular notification.</td>
</tr>
</tbody>
</table>

**Note:** The above keyboard shortcuts are available for notifications only, not for tasks, inside the Confluence workbox.

### Managing notifications with Confluence mobile

You can view and respond to your notifications on your phone or other mobile device too. See Using Confluence on a Mobile Device for more about mobile platforms.

![Confluence mobile notifications](image)

**Notes**

- Read notifications are automatically deleted after 2 weeks.
- Unread notifications are automatically deleted after 4 weeks.
- You cannot delete your notifications yourself.
- If a new notification arrives while you have workbox open, the count appears on the workbox icon but the notification is not added to the workbox. You need to close workbox and re-open it to see the new notification.
- The ability to receive notifications from JIRA or another Confluence site is available in Confluence 4.3.3 and later. To receive JIRA notifications, you need JIRA 5.2 or later.
- Administrators can enable and disable the workbox on your Confluence site. They can also connect a JIRA site or another Confluence site, so that notifications from those sites appear in your workbox too. See Configuring Workbox Notifications.
- The Confluence workbox is provided by a set of plugins. To remove the personal notifications and tasks functionality from your site, you can disable the following plugins. See Disabling or Enabling a Plugin for instructions. Disabling these plugins will disable the entire workbox. It is not possible to disable only tasks or only notifications:
  - Notifications and Tasks - Common Plugin
  - Notifications and Tasks - Host Plugin
Notifications and Tasks - Confluence Provider Plugin
- If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin, Confluence Provider Plugin.
- There is no option to disable the workbox for an individual user.
- The workbox is not available in clustered environments. The plugin will be installed and enabled, but it will detect that the site is in clustered mode and will not display the dialog.

Managing Tasks in Confluence

You can manage your personal tasks in the notification-and-task dialog, known as the Confluence 'workbox', which drops down when you choose the icon 🗟️ in the Confluence page header.

You can also create a list of tasks on a page, and assign them to your colleagues via @mention. Changes made in the workbox are reflected in the task list on the page, and changes made on the page are reflected in the workbox too.

Creating personal tasks and having tasks assigned to you

There are a few ways that you and other people can assign tasks to you:

- You can add a personal task via the workbox.
- You can add a notification to your task list, via the notification workbox. This is useful if you want to get back to it later.
- Someone can assign you a task from a task list on a Confluence page.
- Other Confluence actions may create a task for you. For example, your Confluence site may be running a plugin that creates and assigns tasks.

On this page:
- Creating personal tasks and having tasks assigned to you
- Managing your personal tasks in the workbox
- Adding your notifications to your task list
- Creating task lists and managing tasks on a page
- Managing tasks with Confluence mobile
- Notes

Related pages:
- Tasklist Macro
- Managing Notifications in Confluence
- Subscribing to Email Notifications of Updates to Confluence Content
- Confluence User's Guide

Managing your personal tasks in the workbox

The workbox displays your notifications and your personal tasks in separate tabs. The task tab shows the tasks assigned to you. When you update a task that originated in a task list on a page, the update is reflected in the task list too.

Screenshot: Your personal tasks in the workbox
To manage your tasks:

1. Choose the workbox icon \( \text{workbox icon} \) in the Confluence page header.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside the editor pane before pressing the keyboard shortcut keys.)
   - The icon indicates the number of unread notifications.

2. Choose the personal tasks icon: \( \text{personal tasks icon} \)

3. To add a task and assign it to yourself, type the task summary in the text box and choose **Add task**.
4. To prioritise tasks, drag and drop them into your chosen order. (Click a task, hold down your mouse button to drag the task into position, then release the mouse button.)
5. To complete a task, or mark it as incomplete, choose the check box next to the task.
6. To add notes to a task and see further information (for example, a related page) choose the task item.
   The task details dialog will open.
7. To see the tasks that are marked as complete, choose **View completed**.

Adding your notifications to your task list

You can flag a notification as a task. This is useful if you want to take action on the notification later.

To add a notification to your task list:

1. Choose the workbox icon \( \text{workbox icon} \) in the Confluence page header.
   - You can use the keyboard shortcut: Type `g` then `n`. (When in the Confluence editor, click outside
2. Choose the notifications icon:

3. Choose the notification that you want to add to your task list. The notification details dialog will open.

4. Choose the 'add task' icon to add this notification to your tasks. The notification will remain in the notification list too.

See Managing Notifications in Confluence for a full description of notifications.

Screenshot: The notification details dialog

Creating task lists and managing tasks on a page

Task lists on a page are useful for assigning and managing tasks in a team.

To add a task list on a page:

1. Edit the page.

2. Choose the task-list icon in the editor toolbar, or press [ and then ] on your keyboard.

3. Type the description of the task.

4. If you want to assign a task to someone, type '@' and the person's name in the task description. (For more information about @mentions, see Using Mentions.) That person will receive a notification, and the task will appear in their personal task list in the workbox. If you @mention yourself, the task will appear in your personal task list.

5. To end the list, press Enter twice.

Keyboard shortcuts:

- To add a task list, press press [ and then ] on your keyboard.
- To indent a task, press Tab.
- To undo an indent, press Shift+Tab.

Managing tasks on a page:

- When viewing a page, you and other viewers can mark tasks as complete or incomplete. Updates to a
task on the page will be transferred to the workbox too. (See above.)

- To be able to update a task list when in view mode, you need permission to edit the page:
  - You need the ‘Create page’ permission in the space. See Space Permissions Overview.
  - There must not be any page restrictions that prevent you from editing the page. See Page Restrictions.

What if the update fails?

This section describes what you should do if Confluence displays an error message saying that your change to a task list could not be saved. The cause is probably one of the following:

- Your session has expired. Resolution: Log in and update the task list again.
- You do not have permission to update the task list. Resolution: Check your permissions. You need ‘Create page’ permission in the space. Please check also that there are no page restrictions that prevent you from editing the page.
- The network is down. Resolution: Please try again when the network is available.

Screenshot: A task list on a page

Managing tasks with Confluence mobile

You can view and manage your tasks on your phone or other mobile device too. See Using Confluence on a Mobile Device for more about mobile platforms.

Notes

- Administrators can enable and disable the workbox on your Confluence site. They can also connect a JIRA site or another Confluence site, so that notifications from those sites appear in your workbox too. See Configuring Workbox Notifications.
- The Confluence workbox is provided by a set of plugins. To remove the personal notifications and tasks functionality from your site, you can disable the following plugins. See Disabling or Enabling a Plugin for
instructions. Disabling these plugins will disable the entire workbox. It is not possible to disable only tasks or only notifications:

- Notifications and Tasks - Common Plugin
- Notifications and Tasks - Host Plugin
- Notifications and Tasks - Confluence Provider Plugin

- If you want to re-enable the plugins, do so in the following order: Common Plugin, Host Plugin, Confluence Provider Plugin.
- There is no option to disable the workbox for an individual user.
- The workbox is not available in clustered environments. The plugin will be installed and enabled, but it will detect that the site is in clustered mode and will not display the dialog.
- Completed tasks in the workbox are automatically deleted after 7 days.
- You cannot disable the functionality that provides task lists on a page.
- There is no link between the tasks in a Tasklist Macro and the tasks described above. The tasks from the macro do not appear in the workbox.
- Have a feature request? If you are interested in expanding the functionality of tasks in Confluence, you can collaborate with other customers, vote and view all the open feature requests for this feature in the workbox component of the Confluence issue tracker.
  For example, here are some of the feature requests on the issue tracker:
  - Ability to get a list of tasks from content: CONF-26688
  - Ability to see other users tasks: CONF-26615

Finding Content

Where does a page or blog post go when you create it, and how can you find it again? How can you find content that is most relevant to your team or project, or search for pages that cover the topic you are interested in?

Hint for space administrators: Help your team members and colleagues find important pages and other content, by adding links to the space's sidebar. See Configuring a Sidebar.

A space is an area within Confluence, containing your pages, blog posts and other content. You can think of each space as a sub-site, or mini-site, each with its own home page.

Finding pages and blog posts

These are the quickest ways to find your content:

- Use the links in the sidebar to find your pages, blog posts, and other parts of the space. See more details below.
- Go to the pages view for a list of pages in the space. You can see recently updated pages or browse through a hierarchical (tree) view. See Viewing All Pages in a Space.
- Type the page name or key words into the search box at the top right of the Confluence screen. See Searching Confluence.

More about the sidebar

The sidebar appears on the left of every page in spaces that use the default Confluence theme. You can:

- Choose a different type of content, or perform various operations, via the links on the sidebar.
- Use the contextual navigation options that appear at the bottom of the sidebar, based on the type of content you are viewing.
- Collapse or expand the sidebar.
- Access the sidebar options via slide-out menus even when the sidebar is collapsed.
- Configure the links that appear in the 'Shortcut links' section, if you are a space administrator.
On this page:

- Finding pages and blog posts
- More about the sidebar
- Collapsing the sidebar
- Where does Confluence put your pages and blog posts?
- Can you change the location of a page?
- Can you change the location of a blog post?

Related pages:

- Creating Content
- Organising Content
- Giving People Access to Content
- Using the Documentation Theme
- Confluence User's Guide

Screenshot: Sidebar in the default theme

<table>
<thead>
<tr>
<th>Section or option</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to the space home page</td>
<td>This link appears next to the space logo at the top of the sidebar. It takes you to the home page for this space. Clicking on the space logo will also take you to the home page for the space.</td>
</tr>
</tbody>
</table>
| **Pages and Blog** | This section can contain the links to the following locations:  
  - **Pages**: An index of all pages in the space. See [Viewing All Pages in a Space](#). Note that space administrators can hide the 'Pages' link.  
  - **Blog**: An index of all blog posts in the space. See [Working with Blog Posts](#). Note that space administrators can hide the 'Blog' link.  
  - Other links added by add-ons. |
| **Space shortcuts** | This area contains links to important pages and other locations for your project or team. Space administrators can add and remove links here. See [Configuring a Sidebar](#). |
| **Space Tools** | The 'Advanced' option gives access to space administration and advanced operations like space exports and space watches. |
| **Configure sidebar** | The 'Configure sidebar' option is available to space administrators for setting up shortcut links, changing the space name and logo, and other configuration options. See [Configuring a Sidebar](#). |
| **Contextual navigation** | The links in this area change, depending on the section of the space that you are viewing.  
  - For pages, you will see the child pages (if any) of the current page, and a quick link to create a child page.  
  - For blogs, you will see links to blog posts in the current month, and an expandable list of previous months.  
  - If you are viewing the space tools option, you will see content toots, space administration, and other advanced options. Add-ons can add options here too. |

### Collapsing the sidebar

Advanced users will find it useful to collapse the sidebar and gain more space on the page.  
- Grab and drag the border, or use the keyboard shortcut `[]` to collapse and expand the sidebar.  
- Access the sidebar options via slide-out menus even when the sidebar is collapsed.
Where does Confluence put your pages and blog posts?

When you create a new page, that page will be a child of another page, in the space that you selected in the 'Create' dialog. The parent page depends on where you are when you create the page.

<table>
<thead>
<tr>
<th>Your location when creating the page</th>
<th>Location of new page</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are viewing a page in the same space where you will put the new page — that is, the space that you select in the 'Create' dialog.</td>
<td>A child of the page you are currently viewing.</td>
</tr>
<tr>
<td>You are viewing any other Confluence screen. For example: • You are on the dashboard. • You are on the 'Pages' view of a space. • You are viewing a blog post. • You are viewing a page in a space, and choose to add your new page in a different space.</td>
<td>A child of the home page in the space you select in the 'Create' dialog.</td>
</tr>
</tbody>
</table>

A blog post is part of a chronological sequence of posts, linked from the space's 'Blog' index page.

Can you change the location of a page?

Yes. See Moving a Page.

Can you change the location of a blog post?

No.

Searching Confluence

Quick guide to searching in Confluence:
1. Use the search box at the top right of your Confluence screen. It offers you a quick navigation aid as well as a full site search.
2. You can search Confluence directly from your browser’s search box. Just add your Confluence site as a search provider using the dropdown menu in your browser’s search box.
3. While editing a page or a blog post, you can find and replace text on the page. See Using the Editor.

Using the Quick Navigation Aid

The quick navigation aid automatically offers a dropdown list of pages and other items, matched by title to your search query. You can select one of the offered items or ignore them altogether.

To use the quick navigation aid:

1. Start typing your query into the search box located at the top right-hand corner of every screen. Confluence matches titles as you type, showing a quickly-adjusting dropdown list of pages, blog posts, personal profiles, attachments and so on.
   - Press the Enter key if you want to bypass the quick navigation aid and perform a full search, as described below.
2. To see the space to which an item belongs, let your mouse pointer hover over the item in the dropdown list.
3. Use the up- and down-arrows on your keyboard to move up and down the list of matching titles and select an item.
4. Press the Enter key to open the selected item.
5. If you do not find what you are looking for, click Search for at the bottom of the list to do a full search. This has the same effect as pressing Enter immediately after typing your search query. The full search is described below.

Screenshot: The quick navigation aid showing titles matching the query ‘sta’

Here is more information about how the quick navigation feature works:

- Confluence will truncate any titles that are too long to be displayed.
- The matching items are grouped by content type so that you can quickly find the type you want. Confluence shows a maximum of 6 pages and/or blog posts, 2 attachments, 3 people and 2 spaces. If no matches are found in a particular category, then that category does not appear in the list.
- Items are ordered with the most recent updates first.
- When the matching item is a person's name, their profile picture appears next to their name in the list.
Performing a Full Search

When you perform a full search, Confluence will search all content in all spaces (site and personal), mail, personal profiles, attachments and the space description. The results will appear on a new screen.

To use the full search:

1. Type your query into the search box located at the top right-hand corner of every screen (or type it into the text box at the top of the Search screen).
2. Press the Enter key. (This means that you will ignore the dropdown list of titles offered by Confluence's quick navigation aid, described above.)
3. The Search screen appears, as shown below. If any Confluence pages or items match your search query, the Search screen shows a list of the matching items.
4. Click an item's title to open the Confluence page or other item.

Screenshot: Results of searching for 'permissions'
On the left of the screen you will see a text block for each item that matched the search criteria, with the following information for each item:

- An icon representing the content type (user profile, space, page, blog post, etc).
- The title or name of the content item.
- For attachments: The size and type of file, with a link to download or view the attachment where relevant. See information on viewing Office attachments below.
- For image files: A thumbnail of the image will display to the right of the file name.
- The most relevant few lines of content from within the item. Any words that match your search query are highlighted within the content.
- For personal profile items: The email address.
- The space to which the item belongs, displayed on the last line of the item’s text block.
- The date when the content item was last modified.

You will see only search results which you have permission to view.

On the right of the screen are further options which allow you to tailor or filter your search results. See below.

Viewing Attached Office Documents

When the search results include an attached Office document, you will see a View link as shown in the screen snippet below.

Screenshot: Search results include an attached Office document with 'View' link
Click the View link to view the content of the Office document within Confluence. If you have an Office application installed, you will also be able to launch your Office editor from within Confluence. See Displaying Office Files in Confluence and Working with the Office Connector.

Accepting 'Did you mean' Suggestions from Confluence

When you perform a full Confluence search, as described above, Confluence may offer you an alternative spelling of your search query. The alternative spelling will appear next to the words 'Did you mean', as shown in the example below.

**To accept an alternative spelling suggestion:**

1. Type your query into the search box.
2. Press the Enter key.
3. Confluence will analyse the wiki content, to determine whether an alternative spelling of your search query occurs more often in the wiki content. If this is the case, the words 'Did you mean' will appear on the screen, along with an alternative spelling for your search query.
4. If you want to try the alternative spelling, click the word showing the suggested spelling. In the example below, you would click **confluence**.

**Screenshot: The Search screen with 'Did you mean' offering a corrected spelling**

Here is more information about how the 'Did you mean' feature works:

- Confluence uses both a dictionary (bundled with Confluence) and words mined from the content on your system to work out the best alternative spellings of your search terms. Practically, this means that Confluence can provide spelling corrections for specialised jargon that may not appear in a standard dictionary. In general, when deciding between alternative spellings, Confluence will favour words that appear more often in your content.
- In some cases, the 'Did you mean' suggestion may appear even when there are Confluence pages, etc, which match your search query. In other cases, there will be no items which match your search criteria. In both cases, Confluence will offer a 'Did you mean' suggestion if there is a word which will help you find more relevant content.
- The 'Did you mean' feature may offer more than one suggestion.
- The 'Did you mean' suggestion may even offer an incorrect spelling. This would happen if the incorrect spelling occurs many times within your Confluence site. This is intentional, because the aim of the 'Did you mean' feature is to help you find content, not to correct your spelling.
- Your [Confluence Administrator](https://confluence.atlassian.com/adminguide/configuring-the-search-engine-689637013) can enable or disable the 'Did you mean' feature using the Confluence Administration Console.

Filtering your Search Results

The Search screen, pictured above, appears when you do your first search. By default, Confluence will search all content across your Confluence site, including all spaces, mail archives, attachments and all other content types.
On the right of the screen are options which allow you to tailor or filter the search results.

- **Where** — Restrict your search results to a particular space, or to your favourite spaces, site spaces or personal spaces.
- **What** — Restrict your search results to a particular content type (pages, blog posts, mail, etc).
- **When** — Restrict your search results to content modified within a particular period of time (today, yesterday, within the last week or within the last month).
- **Who** — Restrict your search results to content last modified by a particular user. You can start typing the person's username or part of their name into the text box as follows:
  - Type the username (e.g. 'jsmith').
  - Or start typing the person's first name (e.g. 'john')
  - Or their last name (e.g. 'smith').
  - Or another part of their name, such as a middle name.
  Confluence will offer you a list of possible matches. Use your mouse to select the person you want, then press the Enter key to filter the search results.

More information about the user-matching filter:

- The user-matching filter is *not* case sensitive. You can enter upper or lower case letters and will receive the same results.
- When looking for users to match the name you entered, Confluence divides a person's name into logical units corresponding to first name, middle name (one or more) and last name. It matches the letters of each unit in the name you entered against the letters of each unit in the user directory. For example, you can enter 'jo sm' to look for John Smith. The search is triggered after you have entered at least two letters.
- For each part of the name, you need to enter at least two letters. For example, if you enter just 'john s', the filter will look for users called 'john' and will ignore the 's'. Similarly, if you enter 'j smith' you will see everyone with the name 'smith' even if their first name does not start with a 'j'.
- You are not forced to use the auto-complete list. You can just type 'jsmith' or 'jo sm' and filter on that without choosing a match from the dropdown list. Confluence will warn you if there is more than one user corresponding to the name you have entered.

Click **Clear Filter** if you want to remove all your filters and perform the same search again but without the filter.
Using Labels in the Search

**Searching for Labels**

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

**Browsing Related Labels**

On the right of the search screen, Confluence offers a list of labels which are related to your search query. See the screenshot above. You can click a label to see all pages and blog posts tagged with that label. See Viewing Labels and Labelled Content.

**Searching the Content of Attachments**

When you search Confluence, by default the search will include the content of the following types of attachments:

- Word
- Text
- PowerPoint
- Excel
- PDF
- HTML

To search the content of other attachment types, you will need to use an attachment content extractor plugin. (Not applicable to Confluence OnDemand.) For more information, take a look at the following:

- Existing extractor plugins which you can install on your Confluence site. See this search on Atlassian Marketplace.
- Guidelines on developing your own attachment content extractor plugin. See our developer documentation on extractor plugins.

**Search Options When Using the Documentation Theme**

When using the Documentation theme, the Confluence search offers a few options as described below.

Using the search box at the top right of the page:

- By default, the main Confluence search is configured to search the entire Confluence site.
  - You will see the words 'Search Confluence' in the search box at top right of the page.
  - The Confluence search will look for matches in the entire Confluence site. This is the default
behaviour for other themes too.

- A space administrator can configure the Documentation theme to restrict the search to the current space.
  - You will see the words 'Search this space' in the search box at top right of the page.
  - The search will return results from the current space only.
  - You can override the search restriction. Enter 'all:' and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for 'technical writing':

```
all: technical writing
```

Using the search box in the left-hand panel:

- By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are children of the space’s home page.
- If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

For screenshots and a full description, see Using the Documentation Theme.

Advanced Search Syntax

See Confluence Search Syntax for more ways to refine the text you enter into the search box.

Additionally, see Confluence Search Fields for special parameters you can use in the search box to search on various metadata.

Searching Confluence from your Browser's Search Box

If you are using Firefox or Internet Explorer 7 or later, you can add your Confluence site as a search provider, using the dropdown menu next to the browser's search box.

The example below shows the 'Extranet' Confluence site offered for inclusion as a search engine in the browser's search box.

**Screenshot: Adding your Confluence site to your browser's search box**

Information about OpenSearch:

- Confluence supports the autodiscovery part of the OpenSearch standard, by supplying an OpenSearch
description document. This is an XML file that describes the web interface provided by Confluence's search function.

- Any client applications that support OpenSearch will be able to add Confluence to their list of search engines.
- Your Confluence Administrator can enable or disable the Open Search feature using the Confluence Administration Console.

Useful plugins (Not applicable to Confluence OnDemand.)

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

This plugin extends the Confluence search, so that you can search for macro parameter names and values: the Confluence Macro Indexer plugin.

Notes

For developers: The rendering of search results in Confluence is pluggable. If you are a developer, you may wish to write your own search result renderer to change how the search results are displayed. For more information, please refer to the following developer document: Writing a search result renderer.

Text Tokenisation and Filtering

When searching for content based on search terms entered by the user, Confluence splits the text of the content into tokens, and then filters and modifies those tokens according to the following rules.

**Tokenisation**

Confluence uses Lucene's Standard Tokenizer. This splits the text into tokens as follows:

- Splits words at punctuation characters, removing punctuation. However, a dot that's not followed by white space is considered part of a token.
- Splits words at hyphens, unless there's a number in the token, in which case the whole token is interpreted as a product number and is not split.
- Recognises email addresses and internet host names as one token.

An example: The string 'foo-bar5' won't be split into 'foo' and 'bar5', so a search for 'bar5' or 'bar*' will not find any results.

**Filtering**

Confluence then:

- Removes "s" from the ends of words.
- Removes the dots from acronyms, e.g. I.B.M. becomes IBM.
- Converts everything to lower case.
- Removes common words like 'the' and 'or' are removed.
- Converts words to their stems. For example, 'fishing' and 'fishes' both become 'fish'.

**Note**

At this moment, the query string for search with wildcards have issues with case sensitive words. We have an open bug, kindly have a look.

**Related Topics**

- Searching Confluence
- Confluence Search Syntax
This page describes how you can refine your search. Confluence will ignore common words like 'the' unless you place your query within quotes.

**Exact phrase search**

To search for content that contains the exact phrase "chalk and cheese"

"chalk and cheese"

- Confluence will ignore common words (**stop words**) like "and" above. **This** is the default list of stop words used by lucene. Please cast your vote towards **this** improvement request.
  
  - Searching for "The One" returns all pages containing "One" because "The" is a stop word.
  - Searching for "Cheese One" would only return pages in which "One" appears as the first word (other than stop words) after "Cheese". So it would return "Cheese for One" or "Cheese to One" or "Cheese One". It would not match "One Cheese" or "Cheese Flamingo One"

**OR search**

To search for content that contains one of the terms, "chalk" **OR** "cheese"

chalk OR cheese

Please note that the operator OR must be typed in capitals.

---

**On this page:**

- Exact phrase search
- OR search
- AND search
- NOT search
- Excluded term search
- Grouping search
- Title search
- Wild card searches
- Proximity searches
- Range search
- Fuzzy search
- Combined search
- Searching for macros
- Searching for labels

**Related pages:**

- Searching Confluence
- Confluence Search Fields
- Confluence User's Guide

---

**AND search**

To search for content that contains both the terms "chalk" **AND** "cheese"

chalk AND cheese
Please note that the operator AND must be typed in capitals.

**NOT search**

To search for content that contains "chalk" but NOT "cheese"

```
chalk NOT cheese
```

Please note that the operator NOT must be typed in capitals.

**Excluded term search**

Similar to the NOT search, to search for content that contains "chalk" and "butter" but NOT "cheese"

```
chalk butter -cheese
```

**Grouping search**

To search for content that MUST contain "chalk" but CAN contain either "cheese" or "butter" use the search:

```
(cheese OR butter) AND chalk
```

**Title search**

To search for content with "chalk" in its title, where title is the field keyword.

```
title:chalk
```

**Wild card searches**

**Single character**

To search for "butter" or "batter" you can use the search:

```
b?tter
```

To search for "chicken" or "chickpea" you can use the search:

```
chick*
```

- Wildcards can be used anywhere within a word, except at the very beginning.

For example:

```
*chick
```
is an invalid search term.

**Multiple characters**

To search for "chick" or "chickpea":

```
c*c*
```

You can also combine search characters to get the exact word. For example the search term below will return "chick" yet not "chickpea":

```
c*c?
```

**Case Sensitivity in wildcard searches**

Since the fix for CONF-13846 Confluence is case sensitive for wildcard searches.

You should note that all the example searches given previously search across the default set of fields which are stored as lower case and therefore all searches of that style should be given lower case search terms (as shown in the examples).

However, if you were to search one of the case sensitive fields, such as 'content-name-untokenized' the case of your search term would need to match the document you are searching for.

**Proximity searches**

This search ensure that the two words specified must be within a certain number of words of each other to be included.

```
"octagon post"-1
```

will return "Octagon blog post".

```
"octagon post"-0
```

is an invalid search term.

**Range search**

Searches for names that fall alphabetically within the specified range.

```
[adam TO ben]
```

Note: You can't use the **AND** keyword inside this statement and that TO must be written in capitals to form a valid search.

**Fuzzy search**

This search looks for words spelled similarly.
To search for octagon, if unsure about spelling:

```
octogan~
```

will correctly return "octagon"

**Combined search**

You can also combine various search terms together:

```
o?tag* AND past~ AND ("blog" AND "post")
```

**Searching for macros**

You can search Confluence content for anywhere a macro is used. To do this, just add `macroName:` to your search and append the macro name after the column. For example, search for all excerpt-include macros:

```
macroName:excerpt-include*
```

For more information about `macroName` and other search fields, see [Confluence Search Fields](#).

**Searching for labels**

Use the `labelText:` prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The `labelText:` prefix is an example of a search field. See more about [Confluence Search Fields](#).

**Confluence Search Fields**

This page gives an overview of the Apache Lucene search fields used in Confluence.

**Searching for content in specific fields**

Confluence data is stored in fields which can be specified in the search. To search a specific field, type the name of the field followed by a colon `:` and then the term you are looking for.

Preliminary examples:

```
title:"Some Title"
```
The field specification applies only to the term directly preceding the colon. For example, the query below will look for "Some" in the title field and will search for "Heading" in the default fields.

```
title:Some Heading
```

### On this page:
- Searching for content in specific fields
- Confluence search fields
  - Personal Information
  - Pages
  - Blog
  - Attachments
  - Mail items
- More examples
  - Searching for labels
- Useful plugins

### Related pages:
- Searching Confluence
- Confluence Search Syntax
- Ranking of Search Results
- Text Tokenisation and Filtering
- Confluence User’s Guide

### Confluence search fields

Below are the fields which can be searched, listed by content type.

#### Personal Information

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>fullName</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>
## Pages

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>lastModifiers</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who last updated the page.</td>
</tr>
<tr>
<td>creatorName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who added the page.</td>
</tr>
<tr>
<td>macroName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>The name of a macro used on the page</td>
</tr>
</tbody>
</table>

## Blog

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Indexed</td>
<td>Stored</td>
<td>Tokenised</td>
<td>Notes</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>--------</td>
<td>-----------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>lastModifiers</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who last updated the blog post.</td>
</tr>
<tr>
<td>creatorName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>Username of the user who created the blog post.</td>
</tr>
<tr>
<td>macroName</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td>The name of a macro used in the blog.</td>
</tr>
</tbody>
</table>

**Attachments**

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>filename</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>comment</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>modified</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>created</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>userpermission</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>contentBody</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

**Mail items**

<table>
<thead>
<tr>
<th>Name</th>
<th>Indexed</th>
<th>Stored</th>
<th>Tokenised</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>handle</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>urlPath</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>title</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>messageid</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>inreplyto</td>
<td>true</td>
<td>true</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>recipients</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>labelText</td>
<td>true</td>
<td>true</td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>
More examples

Searching for labels

Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

Useful plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

This plugin extends the Confluence search, so that you can search for macro parameter names and values: the Confluence Macro Indexer plugin.

Ranking of Search Results

When you perform a search in Confluence, it is likely that there will be many pages or other content items that match your search terms. Confluence will rank the matching items by evaluating their relevance. This should mean that the items most relevant to you will appear at the top of the search results list, so that you can quickly
select the item you need.

Below is an overview of the method Confluence uses to determine the relevance of the items returned by the search, that is, to rank the search results.

**Philosophy behind the Ranking**

Confluence gives highest priority to personal information i.e. documents which take you to a user’s profile when you click on them. Collaboration is a primary function of a wiki, so Confluence makes it easy to find people.

For example, if you search for 'John Smith', the first results you see will be for John Smith's user profile and personal space. There may also be other content (wiki pages, email messages, etc) which contain the words 'John Smith'. These other content types may even have 'John Smith' as the page title and repeated multiple times in the content, but they will still appear lower down in the list of search results.

Matching terms found in the title of a page, or in the title of any content type, are considered a strong match. So are matches found in labels, because when someone applies a label it means that they think the content is particularly relevant to the labelled term.

Matches found in the content body are of average importance. If the matched term appears more than once, the document will be given a proportionately higher ranking.

We also assume that information created recently is slightly more relevant than older information.

**Summary of the Ranking Method**

When displaying the results of a search, Confluence applies a weighting to each of the content items returned.

To determine the weighting:

1. For each content item, Confluence first applies three weightings based on the following:
   a. The content type of the item returned — user profile, page, blog post, attachment, etc. (More details below.)
   b. The type of field in which the search term was found — title, name, label, or content body. (More details below.)
   c. The age of the item returned. (More details below.)

2. Confluence then combines the three weightings to arrive at a single weighting for the content item.

The item with the heaviest weighting will appear at the top of the list of search results, and the other items will appear below in descending order of weighting.

---

**On this page:**
- Philosophy behind the Ranking
- Summary of the Ranking Method
- Weighting of Content Types
- Weighting of Fields
- Weighting Based on Age
- Simplified Example

**Related pages:**
- Searching Confluence
- Confluence Search Syntax
- Confluence Search Fields
- Text Tokenisation and Filtering
- Search Results Macro
- Livesearch Macro
- Page Tree Macro (includes an optional search box)
- Confluence User's Guide

---

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Weighting of Content Types

<table>
<thead>
<tr>
<th>Content Type</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Profile</td>
<td>9</td>
</tr>
<tr>
<td>Page</td>
<td>8</td>
</tr>
<tr>
<td>Blog</td>
<td>7</td>
</tr>
<tr>
<td>Attachment</td>
<td>6</td>
</tr>
<tr>
<td>Comment</td>
<td>5</td>
</tr>
<tr>
<td>Mail</td>
<td>0.5</td>
</tr>
<tr>
<td>Space Description</td>
<td>0.4</td>
</tr>
</tbody>
</table>

Simple example
If the search returns 7 matching items, and each item is one of the above types, then the items will be presented in the above order on the results screen. (This example assumes that the search term is found in the same field in each item — see more about fields below.)

Weighting of Fields

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>9</td>
</tr>
<tr>
<td>Full name</td>
<td>8</td>
</tr>
<tr>
<td>Label text</td>
<td>7</td>
</tr>
<tr>
<td>Content</td>
<td>5</td>
</tr>
</tbody>
</table>

Note that 'content' above could be the content of a page, or the content of a comment, or the body of any other content type. See more about content types above.

Simple example
A match for a search term in the title of a document is 1.8 times (9/5) more important than a match in the content.

Weighting Based on Age

This weighting is based on the age of the item returned in the search results. The age of the item is calculated from the creation date of the item. The age intervals are quite coarse-grained, as shown in the table below.

<table>
<thead>
<tr>
<th>When the Item was Created</th>
<th>Weighting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today</td>
<td>1.5</td>
</tr>
<tr>
<td>Yesterday</td>
<td>1.3</td>
</tr>
<tr>
<td>Up to 1 week ago</td>
<td>1.25</td>
</tr>
</tbody>
</table>
The weighting is fairly small, so will not have a large effect. When an item is more than a year old, the age weighting is just ‘1’ i.e. it has no effect.

**Simplified Example**

Let's assume you search for a single term.

Confluence finds a match in the title of an email message created today:

| Weighting for the content type (email) | 0.5 |
| Weighting for field (title)          | 9   |
| Weighting for age (today)            | 1.5 |
| **Total weighting**                  | 6.75|

Confluence also finds a match in the content of a comment created three weeks ago:

| Weighting for the content type (comment) | 5    |
| Weighting for field (content)            | 5    |
| Weighting for age (up to 1 month ago)    | 1.2  |
| **Total weighting**                      | 30   |

**Result:** The comment (weighting 30) will be appear higher in the search results than the e-mail (6.75).

Confluence uses the Apache Lucene search engine library. Lucene's score calculation has a number of additional terms, not mentioned in the above example. We have simplified above, for purposes of illustration. If you are interested, you can see more information in the Lucene documentation.

**Searching the People Directory**

The people directory displays a list of people who are authorised to log in to your Confluence site.

The people directory includes anybody who has logged into Confluence or who has had a user account created for them in Confluence. The people directory does not include users who can log into Confluence using external user management if they have never yet logged in.
Viewing the people directory

Choose **People** at the top of the screen.

Searching for people

To search for a particular person, type their first name and/or last name into the search box and choose **Search**.

- To see everyone who uses your Confluence site, choose **All People**.
- To see just those people who have set up a **personal space**, choose **People with Personal Spaces**.

Following people’s activities

Confluence’s network features allow you to ‘follow’ (that is, keep track of) other people's activities in your Confluence site. For more information, please refer to **Network Overview**. You can use the **hover profile** feature in the people directory to start following other people.

- To start following someone, move your mouse over their name or profile picture and choose **Follow** in their profile popup.
- To stop following someone, move your mouse over their name or profile picture and choose **Stop Following** in their profile popup.

Once you start following another person, their activities will start appearing in your **network view**.

**On this page:**
- Viewing the people directory
- Searching for people
- Following people’s activities
- Notes

**Related pages:**
- Setting Up your Personal Space
- Editing your User Profile
- Choosing a Profile Picture
- Confluence User’s Guide

**Screenshot: The people directory**

The Confluence administrator can **hide the people directory**. If it is hidden, you will not see the **People Directory** option. Not applicable to Confluence OnDemand.

The people directory uses the hCard microformat for simple integration with a variety of microformat-enabled tools. hCard is an open data format for representing people, companies, organisations, and places. Read more about microformats and hCard.

By default, **deactivated users** (disabled user accounts) are excluded from the people directory. You can
include them by adding the `showDeactivatedUsers` parameter to the URL. For example:

```
http://my.confluence.com/dopeopledirectorysearch.action?showDeactivatedUsers=true
```

- By default, externally deleted users (for example, users deleted from an LDAP repository) are excluded from the people directory. You can include them by adding the `showExternallyDeletedUsers` parameter to the URL. For example:

```
http://my.confluence.com/dopeopledirectorysearch.action?showExternallyDeletedUsers=true
```

## Organising Content

Confluence provides a number of ways for organising and structuring content in the wiki:

- **Spaces** allow you to group content according to major categories.

- **Pages** are used for discrete topics, and can be structured into page trees to show the relation between them.

- **Favourites** are particular pages or spaces that have been bookmarked by a user, to make them easy to find again.

- **Labels** are user-defined tags that are added to related pages in order to categorise them in some way.

- **Attachments** to a page can include images, multimedia, Office and PDF files, and provide a way to include other forms of content in the wiki.

- The **sidebar** is a good place to display important links for your team or project.

- **Email** can be collected and archived within each space, to manage all mail related to a project. *Not applicable to Confluence OnDemand.*

## Related pages:

- Changing the Sequential Order of Pages
- Creating Content
- Searching Confluence
- Confluence User's Guide

## Working with Pages

Pages are the primary means of storing and sharing information in Confluence. Pages are contained within spaces.

- Use **spaces** to organise your wiki content into your primary logical groups. For example, you could have a space per team, per product, or per department.

- Use **pages** to organise your content into lower-level groups. For example, you could have a page for a particular team activity, or for a feature in a product, or for a chapter in a book. Add more child pages to contain lower-level details if necessary.

Things you can do with pages in Confluence:

- **Create a new page** from anywhere within the site.
- **Write content using the editor.**
- **Rename** a page.
- **Copy** a page.
• **Delete** a page or remove a specific version of a page.
• Move pages and organise them hierarchically while editing a page or while viewing the space's Tree view.
• Navigate within and between spaces through flexible linking.
• Collaborate via comments on a page.
• Control access through page security restrictions.
• Monitor page updates and other activity through page notifications.
• View page history, and manage and compare versions of a page.
• Search page content, including attachments.
• Export pages to PDF, WORD, HTML or XML.
• Email page content.
• Like a page.

**Related pages:**

• Creating Content
• Working with Drafts
• Working with the Office Connector
• Viewing Recently Visited Content
• Confluence User's Guide

**Moving a Page**

This guide describes how to change a page's location. You can:

• Change the default location of a new page.
• Move an existing page to a different space.
• Move an existing page to a different parent page within the same space.
• Reorder pages that are children of the same parent.

When you move a page, attachments and comments will be moved with the page. All child and descendent pages will also be moved.

**Notes about permissions:**

To move a page, you need the following permissions:

• 'Add' permission on the page you are moving, and
• 'View' permission on the page's parent page. So if you are moving the page to a different parent, you need 'View' permission on the new parent.

To move a page into a different space, you also need:

• 'Remove' permission on the space you are moving from, and
• 'Add' permission on the space you are moving to.

To move a page while keeping its page restrictions, you will also need:

• Space administrator permission on the space you are moving to. Alternatively, remove the page restrictions before performing the move.
Setting the location of a new page

While you are creating a new page, you can set the page's location before saving the page.

To set the location for a new page:

1. While editing the page, choose Location.
2. Use the tabs on the left of the 'Set Page Location' dialog to help you find the new space and parent page for your page. They determine the location of your page. The 'Current location' and 'New location' breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, select Reorder. (When you choose Move in the next step, you will be able to reorder the page.)
4. Choose Move.
5. If you are reordering the child pages, position the pointer in the list to set the new position for the page and choose Reorder.

Screenshot: Setting the location of a new page
Moving a page to a different space

You can move a page, along with its child pages, to a different space. Confluence will automatically adjust all links to the moved pages, to point to the pages in the new space.

To move a page to another space in your Confluence site:

1. Go to the page and choose **Tools > Move**.
2. Use the tabs on the left to help you find the new space and parent page for your page. They determine the location of your page. The 'Current location' and 'New location' breadcrumb trails at the bottom of the dialog indicate the current parent page and new parent page.
3. If you want to move a page to a different position amongst the child pages, select **Reorder**. (When you choose **Move** in the next step, you will be able to reorder the page.)
4. Choose **Move**.
5. If you are reordering the child pages, position the pointer in the list to set the new position for the page and choose **Reorder**.

Moving a page within a space

You can move a page to a different position in the page tree. This allows you to:

- Move a single page, or a family of pages, to a different parent within the space.
- Reorder pages that are children of the same parent.

All links to the page are maintained. When you move a parent page, the entire hierarchy of child pages will move too.

To move a page:

1. Go to a page in the space and choose **Pages** in the sidebar. For more options, choose **Browse and reorder all pages**.
   Or, if you are using the Documentation theme, choose **Browse > Pages** at the top of the screen.
2. Choose **Browse and reorder all pages** (*default theme*).
3. Expand the branches to locate the page you want to move.
4. Drag the page to a new position in the tree.
5. While dragging the page, you see one of the following:
   - A thin line between existing pages — this indicates the potential new position for the page. Release the mouse button when the page is where you want it.
   - A wide highlight over one or more existing pages — this indicates that you can drop the page into a page family. Release the mouse button to add the page to the family. The page will appear either in alphabetical sequence or as the last page in the family, depending on the family's **sequential order**.

Notes

- The new position of the page is saved as soon as you release the mouse button.
- To cancel the move, press the 'Esc' key before releasing the mouse button.

Copying a Page

You can copy a page, to create a duplicate of the page content. You will need to rename the page, because a page name must be unique within a space.

You need ‘Create Pages’ permission, which is assigned by a **space administrator** from the Space Administration screens. See **space permissions** or contact a space administrator for more information.

To copy a page:
1. Go to a page in the space and choose Tools > Copy. Confluence will open a copy of the page in the editor. By default, Confluence will name the page 'Copy of <<original page name>>'.
2. Rename the page and make any other changes required in the body of the page.
3. If you need to move the new page to a different space or a different parent, you can edit the Location. Refer to the instructions on moving a page.
4. Click Save.

Screenshot: Copying a page

<table>
<thead>
<tr>
<th>Copy of Sample Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two penguins find themselves together on an ice floe, drifting helplessly into warmer waters. Suddenly the ice floe splits in half. Right between the penguins. As they drift apart, one penguin says &quot;Chocolate milk!&quot;</td>
</tr>
</tbody>
</table>

Notes

- Copying a page will duplicate all of the original page's attachments and labels, but will not copy comments from the original page.
- This method of copying a page does not copy the child pages. Please add your vote to issue CONF-2814 if you'd like to see this improvement.
- You can copy an entire space, including all pages in the space (parents and children) — refer to these instructions on copying a space.
- Consider using WebDAV to move or copy a page hierarchy from one space to another, provided that none of the page names already exist in the target space.

Renaming a Page

To rename an existing page, you require 'Edit Pages' permission which is assigned by a space administrator from the Space Administration screens. See Space permissions or contact a space administrator for more information.

To rename a page:

1. Go to a page in the space, and click Edit at the top to view the page in 'Edit' mode.
2. Change the page title as required.
3. Click Save.

Notes

- Confluence will automatically update all internal links to point to your new page title. This only works for page links that use the relative link syntax, for example [Renaming a Page].
- In macros, page links will not be updated. You need to update these manually.
- Links from external sites will be broken, unless they use the page's permanent URL.

Related Topics

Linking Pages
Working with Pages

Take me back to Confluence User's Guide

Deleting a Page

By default, when you delete a page in Confluence, this will remove all versions of the page. To do that, you need the 'Remove Pages' permission. See Space permissions. If someone has applied page restrictions to the page, the restrictions may prevent you from deleting the page too.

If you want to delete a specific version of a page, you need to be a space administrator.

Deleting all versions of a page

To delete a page:

Go to the page and choose Tools > Remove. Confirm the action as prompted.

Note: The 'Remove' option will only appear if you have permission to remove this page.

Deleting a specific version of a page

To delete just one version of a page:

1. Go to the page and choose Tools > Page History.
2. Choose Remove next to the version you want to delete, and confirm the action as prompted.

On this page:

- Deleting all versions of a page
- Deleting a specific version of a page
- Deleting a page and all its children
- Notes

Related pages:

- Restoring a Deleted Page
- Purging Deleted Pages
- Creating Content
- Editing or Deleting a Page That Won't Render
- Confluence User's Guide

Deleting a page and all its children

If the page you are deleting has any child pages, they will be moved to the root of the space. The child pages will not be deleted.

Hint: If you need to remove a parent page and a large number of child pages:

- Create a temporary new space.
- Move the parent page to the new space. The child pages will move too.
- Remove the space.

Notes

- When you delete a page, Confluence moves it to the trash. Space administrators can recover pages from the trash.
- Purge the trash to remove the page permanently.
- When you delete a version of a page, the version is not stored in the trash. The deletion of a version is therefore permanent and cannot be undone.
- Attachments attached to a deleted page will remain in the database (allowing potential retrieval) until the trash is purged. When the trash is purged, all attachments on that page are permanently removed.
- When you remove a version of a page, the version numbers of the later versions will change accordingly.
For example, if a page has four versions and you remove version 2, then version 3 will become version 2 and version 4 will become version 3.

Purging Deleted Pages

When a user deletes a page from a Confluence space, the page is not permanently removed. Instead, Confluence places the deleted page into the ‘Trash’. The page will remain in ‘Trash’ until a space administrator purges the page.

Purging deleted pages permanently clears them from ‘Trash’.

You need to be a space administrator to purge deleted pages for a space.

To purge deleted pages:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Content Tools > Trash

3. A list of deleted pages and blog posts for the space displays. Choose Purge for a specific page or Purge All to permanently clear all deleted pages and news items.

If your space is using the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   - Note: The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Trash from the space administration options

3. A list of deleted pages and blog posts for the space displays. Choose Purge for a specific page or Purge All to permanently clear all deleted pages and news items.

When the trash is purged, all attachments on purged pages are permanently removed as well.

Restoring a Deleted Page

When you restore a page, you are moving it from ‘Trash’ to the root of the space where it existed before it was deleted.

You need to be a space administrator to restore deleted pages.

To restore a deleted page:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space
Admin.

Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Content Tools > Trash
3. A list of deleted pages and blog posts for the space displays. Choose Restore for the page you wish to restore.

If your space is using the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Trash from the space administration options
3. A list of deleted pages and blog posts for the space displays. Choose Restore for the page you wish to restore.

Note

If a new page has already been created in that space with the same name as the deleted page, you will be given an option to rename the page before it is restored.

Viewing All Pages in a Space

All Confluence pages are contained within a space. You can use the ‘Pages’ view to see a list of recently updated pages and all pages within a space.

To access the 'Pages' view:

1. Go to a page in the space and choose Pages in the sidebar. For more options, choose Browse and reorder all pages.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Recently updated pages and a hierarchical (tree) view of all pages in the space display.

Screenshot: The pages view

Viewing an alphabetical list of pages

To view an alphabetical list of all pages in a space:
1. Go to a page in the space and choose Pages in the sidebar. For more options, choose Browse and reorder all pages.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Choose Browse and reorder all pages (default theme)
3. Choose Alphabetical
4. Choose a letter to view all pages starting with that letter.

Hint: If you know the title of a page, you might find it faster using the Confluence search.

Viewing a hierarchical list of pages

The hierarchical (tree) view is a useful way to see the parent-child relationships between the pages.

To view an alphabetical list of all pages in a space:

1. Go to a page in the space and choose Pages in the sidebar. For more options, choose Browse and reorder all pages.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Choose Browse and reorder all pages (default theme)
3. Choose Tree
4. Expand the branches of the tree to view pages.

Screenshot: Tree view

Changing the Sequential Order of Pages

Confluence allows you to present your pages in any order (sequence) you choose. The position of a page is reflected in the following places:

- The navigation area of the space sidebar. (See Finding Content.)
- The pages Tree on the ‘Pages’ view in the space.
- Pages exported to PDF, HTML and XML.
- The Page Tree macro.
- The Children macro.

Alphabetical versus manual order
By default, Confluence will present your pages in alphabetical order. When you move a page to a different position, the order becomes manual for the affected page family. When we say 'page family' we mean the immediate children of the parent page, not including the grand-children.

When ordering pages alphabetically, Confluence applies a more sophisticated 'natural' order rather than a straight alphabetical order. The natural order handles numeric values correctly when doing string comparisons.

Now let's consider what happens when you add a page to a page family, by creating a new page or by moving or copying a page into the family:

- If the page family's order is alphabetical, the new page will appear in alphabetical order too.
- If the page family's order is manual, the new page will appear at the bottom of the list of pages in the family.

### Related pages:
- Finding Content
- Working with Pages
- Confluence User's Guide

### Changing the page order manually

**To change the order of pages in the space:**

1. Go to a page in the space and choose Pages in the sidebar. For more options, choose Browse and reorder all pages.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Choose Browse and Reorder Pages (default theme only).
3. Expand the branches of the tree to find the page family you wish to sort.
4. Drag each page to a new position in the tree.

When you drag a page to a new position, the order of the page family changes to Manual. Newly added pages will not be sorted alphabetically, but will appear at the bottom of the list.

### Changing the page order to alphabetical

If the pages in a page family have been ordered manually, you can change the page order back to alphabetical.

**To set the page order to alphabetical:**

1. Go to a page in the space and choose Pages in the sidebar. For more options, choose Browse and reorder all pages.
   Or, if you are using the Documentation theme, choose Browse > Pages at the top of the screen.
2. Choose Browse and Reorder Pages (default theme only).
3. Expand branches of the tree to find the page family you wish to sort.
4. Choose the Sort Alphabetically (A-Z) icon beside the parent page.

The Sort Alphabetically (A-Z) icon only appears next to the parent page if the page family is currently sorted manually.

If you change your mind, you can use the Undo Sorting icon to revert back to the previous manual page order for that page family. This option is only available immediately after sorting the page (while you are still on the 'Reorder Pages' tab and have not performed any other action).

Screenshot: Page tree showing the Sort Alphabetically and Undo Sorting icons.
Sort Alphabetically only sorts the immediate children of the parent page. The grandchildren will not be re-ordered, sorting happens for one node at a time. If you want to re-order grandchildren, you need to click the Sort Alphabetically icon next to the parent of those pages.

Managing Orphaned Pages

An orphaned page is a page without any incoming links. This means that, unless you know that the page exists, you are not likely to come across it in the space during the natural course of navigation.

When you are working in a large space with a number of pages, it is difficult to keep track of all of them. An orphaned page may be redundant or may need to be referred to from another page. Confluence allows you to view all the orphaned pages in a space so you can tidy up the space by either deleting pages or reorganising them.

To view the orphaned pages in a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Content Tools > Orphaned Pages.

If your space uses the Documentation theme:

1. Choose Browse > Space Operations at the top of the screen.
2. Choose Orphaned Pages in the space operations options.

You can do the following:

- Delete an orphaned page by choosing the 'trash can' icon next to the page name.
- Edit a page by choosing the 'pencil' icon next to the page name.
- Give an orphaned page a parent — see Moving a Page.
Managing Undefined Pages

In Confluence, you can add links to pages that you intend to create later. These are links to ‘undefined pages’. This is useful because it allows you to create links first and enter content for those pages later.

For example, this link to new page is a link to a non-existent page, also called an undefined page. The link is shown in dark red. If someone clicks the link, Confluence will create a new page called 'link to new page'.

The ‘Undefined Pages’ view gives a consolidated report of all undefined pages so that you can manage your space better. The undefined page links are badged with this icon to remind you that those pages need to be created.

To view a list of the undefined links in a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   
   If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Content Tools > Undefined Pages

If your space uses the Documentation theme:

1. Choose Browse > Space Operations at the top of the screen.
2. Choose Undefined Pages in the space operations options.

You can choose the link for an undefined page to create the page and add content to it.
This page tells you how to view pages in your Confluence space when your space uses the Documentation theme. For the full list of features and instructions on applying the theme to a space, see the guide to configuring the Documentation theme.

Quick guide to using the Documentation theme:

- The left-hand panel contains a page tree. This is a table of contents that shows the pages in the space.
- Click the plus signs in the page tree to see the child pages.
- Drag the thick vertical bar to change the width of the panels.
- Show/hide the left-hand panel: Click the sidebar icon at top right, next to the search box, to remove the left-hand panel altogether. Click the icon again to restore the panel.
- Alternatively, press '[' on your keyboard to show/hide the left-hand panel.
- Overriding a space-restricted search: If your theme is configured to restrict the search to the current space, you can enter 'all:' and your search term to search the entire site.

The rest of this page gives more details of the above guidelines.

On this page:

- Using the Documentation theme
- Searching the space or the site
- Hints and tips
- Notes

Related pages:

- Configuring the Documentation Theme
- Space Jump Macro
- Changing the Sequential Order of Pages
- Confluence User’s Guide

Using the Documentation theme

By default in a space that uses the Documentation theme, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.

Diagram: The Documentation theme with default settings
A **space administrator** can customise the Documentation theme as follows:

- Change the content in the left-hand panel and add a header and footer to the page. This means that your own pages may look different from the screenshot above.
- Restrict the search so that it will show results from the current space only, not from the entire Confluence site.

**Diagram: The Documentation theme with space-restricted search**

Here is a summary of the things you can do on a page that uses the Documentation theme:

- Click the plus signs to open and close the branches of the page tree (table of contents) in the left-hand panel.
- Drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel.
• Click the sidebar icon [at top right, next to the search box, to remove the left-hand panel. This will remove the panel for you only. Other people will still see it.
• Click the sidebar icon [again to restore the left-hand panel.
• Alternatively, press [' on your keyboard to show/hide the left-hand panel.
• Use the scroll bars to scroll the left-hand and right-hand panels independently of each other.
• Search the content of the space or the site. See below.

**Searching the space or the site**

When using the Documentation theme, the Confluence search offers a few options as described below.

Using the search box at the top right of the page:

• By default, the main Confluence search is configured to search the entire Confluence site.
  • You will see the words ‘**Search Confluence**’ in the search box at top right of the page.
  • The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
• A space administrator can configure the Documentation theme to restrict the search to the current space.
  • You will see the words ‘**Search this space**’ in the search box at top right of the page.
  • The search will return results from the current space only.
  • You can override the search restriction. Enter ‘**all:**’ and your search term to search the entire site. For example, enter the following into the search box at top right of the page to search the entire site for ‘technical writing’:

```
all: technical writing
```

Using the search box in the left-hand panel:

• By default, the Documentation theme's left-hand panel includes a search box. Enter your search term there, to restrict the search to the current space. Specifically, this will search only the pages that are children of the space's home page.
• If your administrator has restricted the main search to the current space, there will not be a search box in the left-hand panel.

**Hints and tips**

Below are some hints that you may find useful when using the Documentation theme. Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the [Atlassian documentation wiki](https://confluence.atlassian.com), you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme's table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the ‘Home’ page. You can specify the home page in the [space administration section](https://confluence.atlassian.com).  

Help, my pages do not appear in the Documentation theme table of contents

**Cause 1: Your pages are not under the space's home page.** The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space’s home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:
• You can change the designated space home page in the space administration section.
• Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the ‘Pages’ section of the space ‘Browse’ screen. See Moving a Page.

**Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled.** If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.

Can I change the default width of the left-hand navigation panel?

The Confluence user interface does not offer a way to change the default width of the left-hand navigation panel supplied by the Documentation theme. Users can change the width by dragging the middle bar, but the default width is not configurable. This post on Atlassian Answers gives a way to do it with CSS: Documentation Theme - Default Width (in px) of left panel.

**Notes**

• The Confluence default theme supplies a **sidebar**, which is different to the left-hand panel in the Documentation theme. For information about the sidebar, see Finding Content and Configuring a Sidebar.
• The Documentation theme supplies a **Browse** menu in the Confluence header, which gives access to the space administration and advanced options.

**Viewing Page Information**

The ‘information’ view for a page shows you various bits of useful information about the page.

**To see the information view for a page:**

1. View the page.
2. Choose **Tools > Info** to go to the ‘Information’ view for the page.

You will see the following information:

1. Page details: Title, author, date of creation, date of last modification and the tiny link of the page.
3. Labels: Any labels (tags) that have been applied to this page. See Working with Confluence Labels.
4. Page Permissions: Displays page-level security restrictions that apply to the page (if present). See Page Restrictions.
5. Hot Referrers: The external website pages which send the most viewers to the page. See Managing External Referrers.
6. Recent Changes: Links to the five most recent versions of the page along with the name of the editor and the date of modification. See Page History and Page Comparison Views. Choose **View page history** to see the page history view, all the versions of the page in reverse chronological order and allows you to compare versions or to restore a previous version.
7. Outgoing links: A summary of the links contained on this page, pointing to other pages on the Confluence site or to external websites.

**Related pages:**

• Working with Pages
• Confluence User’s Guide
Viewing Recently Visited Content

Confluence keeps track of pages you have recently visited in Confluence. You can view 20 of your recent pages and navigate back to them using the Recently Viewed list.

To view the list of recently viewed pages:

1. Choose your profile picture at top right of the screen, then choose Recently Viewed.
2. Choose the title of the page you wish to revisit.

To filter the list type part of a page title or user's name in the Filter field.

Related pages:

- Working with Pages
- Confluence User's Guide

Screenshot: A page's information view
Page History and Page Comparison Views

Confluence tracks the history of changes to each page by creating a new version of the page each time it is modified. You can view the changes between different versions, and roll back to a previous version if required.

**Accessing the page history**

**To view the history of a page:**

Go to the page and choose **Tools > Page History.**

You can choose a version number to view the content of that version.

**On this page:**

- Accessing the page history
- Viewing an older version of a page
- Restoring an older version of a page
- Removing a specific version of a page
- Viewing the changes made to a page
- Comparing two versions of a page

**Related pages:**

- Viewing Page Information
- Working with Pages
- Tracking Updates
- Confluence User's Guide

**Screenshot: Page history**
Viewing an older version of a page

To view a specific version of a page:

1. Go to the page and choose Tools > Page History.
2. Choose a version number to view the contents of that version of the page. You will see a header like this, at the top of the old version of the page:

   ![Header for viewing an older version of a page]

If you want to send this page version to someone, copy and paste the URL from your browser. The link will look something like this: http://confluence.atlassian.com/pages/viewpage.action?pageId=12345.

When you are viewing a specific version of the page, the following functions are available:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>current version</td>
<td>View the latest version of the page.</td>
</tr>
<tr>
<td>Compare with Current</td>
<td>Compare the differences between the version of the page you are viewing and the current version.</td>
</tr>
<tr>
<td>Restore this Version</td>
<td>Roll back the content of the page to the previous version that you are viewing.</td>
</tr>
<tr>
<td>View Page History</td>
<td>Return to the list of page versions.</td>
</tr>
<tr>
<td>&lt;&lt; Previous and Next &gt;&gt;</td>
<td>View the previous or next version of the page.</td>
</tr>
</tbody>
</table>

Restoring an older version of a page

You can roll back the content of the page to a specific version.

To restore an older version of a page:

1. Go to the page and choose Tools > Page History.
2. Choose Restore this version beside the version you want to restore.
3. Change the default comment if necessary, and choose OK.

Notes

- All page history is retained. Restoring an older version creates a copy of that version. For example, if you restore version 39, Confluence will create a copy of version 39. This copy will become the new, current version.
- If you are viewing a specific version of a page, you can restore that version of the page by choosing Restore this Version at the top of the page.

**Removing a specific version of a page**

Choose Remove next to a version, to delete that version. See Deleting a Page.

**Viewing the changes made to a page**

Using the page history view or the page information view, you can see the recent changes made to a page.

**To view recent changes made to a page:**

1. Choose view change at the top of the page below the page title. The page comparison view is displayed, showing the differences between the current version and the previous version.
   
   Or:
   
   2. Choose Tools > Info to go to the 'Information' view for the page.
      
      • In the section titled 'Recent Changes' you will see the most recent versions of the page, along with the date of their modification and the name of the modifying author.
      
      • Choose View Changes beside the required version. The page comparison view is displayed, showing the differences between the selected and previous versions.

**Comparing two versions of a page**

**To compare two versions of a page:**

1. Go to the page and choose Tools > Page History.
2. Choose the versions you want to compare by selecting the check boxes beside them.
3. Choose Compare selected versions. The page comparison view is displayed, showing the differences between the selected versions.

Changes are highlighted in different colours, as shown in this table:

<table>
<thead>
<tr>
<th>Highlighted colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Added content</td>
</tr>
<tr>
<td>Red</td>
<td>Deleted content</td>
</tr>
<tr>
<td>Blue</td>
<td>Changed formatting</td>
</tr>
</tbody>
</table>

**Screenshot: Comparing changes**
More options on the comparison view

When a page comparison view is first displayed, all large sections of unchanged text are hidden and reduced to an ellipsis, like this: . . .

You can view page changes between versions which are adjacent to your current page comparison view. Click the link containing:

- << to view the page comparison with the earlier adjacent version
- >> to view the page comparison with the more recent adjacent version.

For example, if your page comparison view is between v. 30 and v. 34 of a page, you can view changes between:

- v. 29 and v. 30 by clicking << Changes from 29 to 30
- v. 34 and v. 35 by clicking Changes from 34 to 35 >>

Using a WebDAV Client to Work with Pages

You can access Confluence content via a WebDAV client, such as 'My Network Places' in Microsoft Windows. Provided that you have permission, you will be able to read and write to spaces, pages and attachments in Confluence. You will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

Please refer to the page on configuring and setting up a WebDAV client.

Working with Blog Posts

You can publish a blog post from any space in Confluence, provided you have permission. Blog posts may be announcements, journal entries, status reports, or any other timely information.

To view the blog posts within a space: Go to a page in the space and choose Blog in the sidebar. Or, if you are using the Documentation theme, choose Browse > Blog at the top of the screen.

Confluence lists the latest blog posts. You can click through to earlier posts via the navigation area in the sidebar.

Creating and editing a blog post is just as easy as creating and editing any other page in Confluence. You can also let people know you care by liking a blog post.

Creating a blog post

To create a blog post, you need the 'Add Blog' permission. See Space Permissions, and Creating Content.
You can create attractive, engaging content in a blog post in the same way as in a page. See Creating Attractive and Dynamic Pages.

1. **Creating a blog post**
2. **Editing a blog post**
3. **Deleting a blog post**
4. **Exporting a blog post**

**On this page:**
- Creating a blog post
- Editing a blog post
- Deleting a blog post
- Exporting a blog post

**Related pages:**
- Linking to Blog Posts
- Subscribing to RSS Feeds within Confluence
- Managing Changes and Notifications and Tasks
- Blog Posts Macro
- Sharing Content
- Exporting Confluence Pages and Spaces to PDF
- Confluence User's Guide

**Editing a blog post**

To edit a blog post, you need the ‘Add Blog’ permission. See Space Permissions.

**To edit a blog post:**

1. Go to a page in the space and choose **Blog** in the sidebar.
   Or, if you are using the Documentation theme, choose **Browse > Blog** at the top of the screen. You will see the most recent blog posts within the space, and you can find earlier posts via the navigation area in the sidebar.
2. Go to the blog post and choose **Edit**.
3. Make changes to the blog post.
4. *(optional)* Add a comment, in the text box below the editing pane, to describe your changes.
5. **Preview** your changes if desired, and choose **Publish**.

Editing a blog post is similar to editing any other page in Confluence. However, there are a few things to keep in mind:

- You cannot change the date of an existing blog post. You can only backdate when adding a blog post.
- You cannot move a blog post to another space.
- A blog post has no parent.

**Deleting a blog post**

By default, when you delete a blog post in Confluence, this will remove all versions of the post. To do that, you need the 'Remove Blog' permission. See Space permissions. If someone has applied page restrictions to the blog post, the restrictions may prevent you from deleting the post too. Deleted blog posts are stored in the space’s trash and can be recovered by a space administrator.

If you want to delete a specific version of a blog post, you need to be a space administrator. When you delete a version of a blog post, the version is not stored in the trash. The deletion of a version is therefore permanent and cannot be undone.

**To delete all versions of a blog post:**

Go to the page and choose **Tools > Remove**. Confirm the action as prompted.

*Note:* The ‘Remove’ option will only appear if you have permission to remove this page.

**To delete just one version of a blog post:**
1. Go to the page and choose **Tools > Page History**.
2. Choose **Remove** next to the version you want to delete, and confirm the action as prompted.

### Exporting a blog post

You can export individual blog posts to PDF format. This is useful, for example, if you want to email an internal blog post to people outside your organisation.

See [Exporting Confluence Pages and Spaces to PDF](#) for more information on exporting blog pages to PDF.

*Screenshot: A blog within a Confluence space*

---

**Chocolate Blog**

**Chocolate Tuesday**

> Tuesdays are my favourite day of the week, because they're **Chocolate Tuesday**! This week Andrew will treat us to his decadent *Death by Chocolate* tart.

Would you like to share your yummy chocolate dish with the team next week? Add a comment to this page.

---

### Working with Spaces

In Confluence, content is organised into spaces. There are two types of space:

- Site spaces, sometimes called 'global' spaces, are areas on your site into which you can group content items (pages, attachments, news, etc) based on any subject or topic of your choice. For example, you may want separate areas on your site for each team or project within your organisation.
- Personal spaces belong to specific users. You can keep your personal space private, or open it up so the whole world can view or edit it. Personal spaces are listed in the **People Directory**. They are not listed on the 'Spaces' tab on the dashboard.

*What is a Space?*

A space is an area within Confluence, containing your pages, blog posts and other content. You can think of
each space as a sub-site, or mini-site, each with its own home page.

Each space:

- Has its own pages, blog posts, comments, RSS feeds and mail \(\textit{mail applies to site spaces only}\).
- Has its own access control settings. You can set different levels of access for different spaces.
- Can be separately exported to PDF, HTML or XML. The XML export provides a way of backing up and restoring a space.

There is no limit to the number of site spaces you can create in Confluence.

On this page:

- What is a Space?
- Viewing the spaces in a Confluence site
- Guidelines for dividing content into spaces and pages
- Example: Favourite spaces as shown on the dashboard
- Notes

Related pages:

- Creating a Space
- Configuring a Sidebar
- Setting Up your Personal Space
- Viewing All Confluence Spaces
- Archiving a Space
- Deleting a Space
- Backing Up and Restoring a Space
- Viewing Space Activity
- Using Labels to Categorise Spaces
- Administering a Space
- Confluence User's Guide

Viewing the spaces in a Confluence site

Confluence displays a list of spaces in the following locations:

- The \textbf{dashboard} displays a list of all the spaces in the Confluence site that you have permission to see. You can make a space as a favourite, or categorise the space, to get easy access to the content that is most relevant to you. See \textit{Customising your Personal Dashboard}.
- The \textbf{space directory} displays a list of all the site and personal spaces in the Confluence site that you have permission to see. You can choose to see all spaces, the spaces you have marked as favourite, or the spaces in a given space category. You can further restrict the number of spaces displayed, by entering a word or words in the Filter box. Confluence will display only the spaces that have the matching words in the space name or description. See \textit{Viewing All Confluence Spaces}.
- The \textbf{people directory} displays a list of all Confluence users, including those who have personal spaces. See \textit{Searching the People Directory}.

Guidelines for dividing content into spaces and pages

To ensure maintainable and logical spaces, consider the following points when allocating your content to pages and spaces:

- Group the content by topic, subject, project or team.
- Evaluate permissions across the wiki content. If members require conflicting access, for example John must access content on topics A and B, while Jane must access content for topics B and C, then the topics should be separated into three spaces.
Useful notes about spaces and pages:

- Spaces cannot be nested. You cannot have parent and child spaces, but you can have parent and child pages within a space.
- Page permissions can prevent users from accessing a specific page, even though they have permission to access the space.
- Page permissions alone cannot keep the existence of a page secret. The page should be in a restricted space instead.
- Pages can be moved between spaces.
- You can group related spaces, using space categories.

Example: Favourite spaces as shown on the dashboard

The screenshot below shows the area of the Confluence dashboard that displays the spaces that you have marked as favourite:

```
Spaces  Pages  Network

Favourite Spaces

Angry Nerds ★
Sample Space ★

Site Spaces

Angry Nerds ★
Demonstration Space ★
Documentation ★
Sample Space ★

Create Space
```

Notes

A space key is a short, unique identifier for a space. For example, you might give your documentation space a key of "DOC". To find the key of an existing space, look at the Confluence URL for a page in the space. The standard Confluence URL has this format:

```
http://my.confluence.site.com/display/SPACEKEY/Page+Name
```

Viewing All Confluence Spaces

Quick guide to viewing spaces:

- The dashboard displays a list of all the spaces in the Confluence site that you have permission to see. You can make a space as a favourite, or categorise the space, to get easy access to the content that is most relevant to you. See Customising your Personal Dashboard.
- The space directory displays a list of all the site and personal spaces in the Confluence site that you have permission to see. You can choose to see all spaces, the spaces you have marked as favourite, or the spaces in a given space category. You can further restrict the number of spaces displayed, by
entering a word or words in the Filter box. Confluence will display only the spaces that have the matching words in the space name or description. See Viewing All Confluence Spaces.

- The people directory displays a list of all Confluence users, including those who have personal spaces. See Searching the People Directory.

### On this page:
- Viewing spaces on the dashboard
- Viewing spaces in the space directory
- Viewing personal spaces in the people directory
- Notes

### Related pages:
- Working with Spaces
- Archiving a Space
- Confluence User's Guide

---

**Viewing spaces on the dashboard**

The Confluence dashboard displays a list of spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your username's permissions.

The Spaces tab displays all the global spaces on the site that you have permission to view, and the spaces you have marked as your favourites.

**To see the spaces on the dashboard:**

1. Choose the site logo at the top left of your Confluence screen.
2. Scroll down and choose the Spaces tab.

**Screenshot: Viewing spaces on the dashboard**

![Spaces](image)

**Viewing spaces in the space directory**

The space directory displays a list of site and personal spaces that you have permission to view. Remember to log in, so that you can see the complete list of spaces based on your username's permissions. The order of
spaces is random.

**Categorising the spaces:** The spaces are displayed on a number of tabs, each showing a different set of spaces, as follows:

- **All Spaces** – Shows all the global and personal spaces on the site. The list excludes spaces that you do not have permission to view, and spaces that have been archived.
- **Site Spaces** – Excludes personal spaces.
- **Personal Spaces** – Shows only personal spaces.
- **Favourite Spaces** – Shows the spaces that you have marked as your favourites.
- **Various categories** – You will see a number of tabs showing spaces categorised by label. You can add any space category you like. See Using Labels to Categorise Spaces.
- **Archived Spaces** – Shows all the global and personal spaces on the site that have been archived, and that you have permission to view.

**Filtering the list of spaces:** To restrict the number of spaces displayed, enter a word or words in the Filter box. Confluence will display only the spaces that have the matching words in the space name or description.

**To see the spaces in the space directory:**

1. Choose Spaces at the top of the screen.
2. Choose one of the tabs to see the spaces you want.
3. If you want to restrict the number of spaces shown, entering a word or words in the Filter box.

**Screenshot: Viewing favourite spaces in the space directory**

---

**Viewing personal spaces in the people directory**

The people directory displays a list of Confluence users, including those who have personal spaces. See Searching the People Directory. It excludes spaces that have been archived.

**To see the personal spaces in the people directory:**

1. Choose People at the top of the screen.
2. Choose People with Personal Spaces.

**Screenshot: The people directory**
Notes

- If you do not log in, you will be treated as an 'anonymous user'. Confluence will display only those spaces that anonymous users have permission to see.
- Permission to access a space is granted by a space administrator. See the overview of space permissions.
- You can use the Spaces List macro to display a list of spaces on a Confluence page.

Creating a Space

There are two types of space in Confluence: 'site' spaces and 'personal' spaces. This page is about site spaces. For help with personal spaces, see Setting Up your Personal Space.

Site spaces, sometimes called 'global' spaces, are areas on your site into which you can group content items (pages, attachments, news, etc) based on any subject or topic of your choice. For example, you may want separate areas on your site for each team or project within your organisation.

To set up a new site space, you need the 'Create Space' permission. 'Create Space' is one of the global permissions that can be assigned by a Confluence administrator.

To create a new space:

1. Choose Add Space located above the list of spaces on the dashboard, or at the top right of the dashboard, or at the top right of the space directory. The 'Create Space' dialog appears.
2. Enter the following information about your new space:
   - Space name: A name for the space. Space names do not have to be unique.
   - Space key: A simple key to identify your space (A-Z, a-z, 0-9). This key is a shorthand name for the space, used when linking content between spaces, for web URLs and for reports. For example, a 'Development Space' might have a space key of 'DEV'. The space key must be unique within the entire Confluence site.
   - Make this space private: A private space will be visible only to the person who created it. If you do not make it private, the space will have the default space permissions. The creator will have space administrator permissions on the new space, and can change the permissions at any time after creating the space.
3. Choose Create. The home page for your new space is displayed. Note that the home page will automatically contain any default space content as defined by your Confluence administrator.

Next, you can choose a theme and start adding pages to your space. You can also add links to the sidebar, to help people find important content.
Related pages:
- Setting Up your Personal Space
- Configuring a Sidebar
- Editing Space Details
- Deleting a Space
- Working with Spaces
- Confluence User’s Guide

Screenshot: Adding a space to Confluence

Create space

Create a space for your team or project:

- Space name: Chocolate
- Space key: CHOC

Used in the space's URL:
http://localhost:8000/display/CHOC

Make this space private

Create  Cancel

Notes

A space administrator can change the permissions at any time after creating the space.

Setting Up your Personal Space

Your personal space is a place where you can publish your own pages and blog posts. Once you have set up your personal space, Confluence users can reach it by clicking your name in the People Directory. You can get to your personal space by clicking your name at the top of the page and choosing 'Personal Space'.

Creating your personal space

To set up your personal space, you need the 'Personal Space' permission which is assigned by a Confluence administrator. See Giving People Access to Content and Global Permissions Overview.

To create your personal space:

1. Choose your profile picture at top right of the screen, then choose Add Personal Space.
2. Indicate whether your space should be private or not. A private space will be visible only to you. If you do not make it private, the space will have the default space permissions. Note that you can change these settings again later. You will have space administrator permissions on your space.
3. Choose Create.
4. The home page of your new space will appear. Your home page will contain any default space content as defined by your Confluence administrator. You can change this content at any time.
Creating your personal space

You can now start adding pages to your personal space. You may also want to upload your photo.

Changing the look and feel of your space

If you like, you can apply a different theme to your personal space, or modify its colour scheme. You can also add and arrange links in the sidebar.

Granting access to your space

When you created the space, you set the option to make your space private, or to allow other people to view and contribute content to your space. You can change the permissions on your space at any time.

Watching updates made in your space

By default, Confluence assigns you as a watcher of your space. This means that you will receive an email notification each time someone adds or updates content in your space. You can stop watching the space (see Watching a Space) and change your notification settings at any time.

Administering a Space

This page gives an overview of the administration functions available in site and personal spaces. You need to be a space administrator to perform space administration functions.
Space administrators can also add and remove links in the space sidebar. See Configuring a Sidebar.

**Administering a space**

**To view the space tools page:**

1. Go to the space you wish to manage.
2. • If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   • If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

*Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. The ‘Space Permissions’ page displays.

---

On this page:

- Administering a space
- Administering a space that uses the Documentation theme

**Related pages:**

- Configuring a Sidebar
- Working with Spaces
- Confluence User's Guide

---

The administration options are divided into the following categories. Some options may not be applicable for personal spaces or Confluence OnDemand.

**Overview**

- Space Details - see Editing Space Details.
- Space Labels - see Using Labels to Categorise Spaces.
- Remove Space - see Deleting a Space.

**Permissions**

- Permissions - see Assigning Space Permissions.
- Restricted Pages - see Viewing Restricted Pages.

**Content Tools**

- Templates - see Working with Templates.
- Orphaned Pages - see Managing Orphaned Pages
- Undefined Pages - see Managing Undefined Pages
- Attachments - see Viewing Attachment Details
- Trash - see Purging Deleted Pages and Restoring a Deleted Page.
- Export - see Exporting Confluence Pages and Spaces to Other Formats
- Import - see Importing Pages from Disk. *Not applicable to Confluence OnDemand. Not available for personal spaces.*
- RSS Feeds - see Using pre-specified RSS feeds

**Look and Feel**

- Themes – see Applying a Theme to a Space.
- Colour Scheme – see Editing a Space's Colour Scheme.
- Layout - see Customising Space Layouts
- Stylesheet - see Styling Confluence with CSS
- PDF Layout – see Customising Exports to PDF.
- PDF Stylesheet – see Customising Exports to PDF.
• **Integrations**
  - Application Links – see Configuring Application Links. *Not applicable to Confluence OnDemand.*
  - Mail Accounts – see Working with Mail Archives. *Not applicable to Confluence OnDemand. Not available for personal spaces.*
  - Mailbox Import – see Importing Mail. *Not applicable to Confluence OnDemand. Not available for personal spaces.*
  - Mail – see Working with Mail Archives. *Not applicable to Confluence OnDemand. Not available for personal spaces.*

You can also customise the sidebar, including changing the space logo and adding shortcuts to other spaces - see Configuring a Sidebar for more information.

**Administering a space that uses the Documentation theme**

In this theme the standard Confluence sidebar is replaced by a page navigation sidebar. As a result the layout of the space administration options are slightly different.

**To view the space admin page:**

1. Go to the space you wish to manage.
2. Choose **Browse > Space Admin** at the top of the screen.
   *Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).*
3. The 'Space Details' page displays.

For spaces using the Documentation theme, the administration options are divided into the following categories:

• **General**
  - Space Details – see Editing Space Details.
  - Space Labels – see Using Labels to Categorise Spaces.
  - Templates – see Working with Templates.
  - Remove Space – see Deleting a Space.
  - Trash – see Purging Deleted Pages and Restoring a Deleted Page.

• **Security**
  - Permissions – see Assigning Space Permissions.
  - Restricted Pages – see Viewing Restricted Pages.
  - Application Links – see Configuring Application Links. *Not applicable to Confluence OnDemand.*

• **Mail**
  - Mail Accounts – see Working with Mail Archives. *Not applicable to Confluence OnDemand.*
  - Mailbox Import – see Importing Mail. *Not applicable to Confluence OnDemand.*

• **Look and Feel**
  - Themes – see Applying a Theme to a Space.
  - Colour Scheme – see Editing a Space's Colour Scheme.
  - PDF Layout – see Customising Exports to PDF.
  - PDF Stylesheet – see Customising Exports to PDF.
  - Change Space Logo – see Changing a Space's Logo.

• **Import**
  - Import Pages from Disk – see Importing Pages from Disk. *Not applicable to Confluence OnDemand.*

**Editing Space Details**
To edit the details of a space you need to be a space administrator for the space.

**To edit the details of a space:**

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.
   
   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

3. Choose **Overview > Edit Space Details**

4. The 'Edit Space Details' page displays.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
2. The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

2. The 'Edit Space Details' page displays.

On the 'Edit Space Details' page you can:

- Change the name of the space (you can also do this via the sidebar - see **Configuring a Sidebar**).
- Change the description of the space.
- Change the status of the space from 'Current' to 'Archived' or back again - see **Archiving a Space**.
- Select a new home page for the space. The home page is the default page that users see when they navigate to the space.

*Note:* If you set this field to blank (no selection) the default home page will be the 'Pages' page.

**Related pages:**

- **Configuring a Sidebar**
- **Working with Spaces**
- **Archiving a Space**
- **Confluence User's Guide**

**Notes**

- You cannot edit the space key or the space creator's name.
- The space fields do not accept wiki markup. Any wiki markup entered in these fields will be displayed as plain text.

**Deleting a Space**

Deleting a space permanently removes the space and all of its contents. To delete a space you must be the space administrator for the space.

*Note:* Deleting a space is permanent. Always create an XML backup of the space before proceeding. Once you have deleted the space, there is no way to restore it unless you have made an XML space backup.

**To delete a space:**

1. Go to a page in the space you wish to delete.
2. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
3. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

*Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).
3. Choose **Overview > Remove Space**
4. Choose **OK**.

If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).*

2. Choose **Remove Space** in the space administration options.

3. Choose **OK**.

**Related pages:**

- Working with Spaces
- Archiving a Space
- Copying or Renaming a Space
- Confluence User's Guide

**Notes**

There is a problem in some versions of Confluence, where space deletion does not work. See issue [CONF-26122 - Authenticate](#) to see issue details. If you like, you can watch that issue to be informed of progress.

**Backing Up and Restoring a Space**

Confluence can back up all the content, comments and attachments for a space. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) that define the content of the space, and optionally a folder containing the attachments in the space. To transfer this data to another Confluence site, you can upload the zip file.

*Creating a space backup*

See [Exporting Confluence Pages and Spaces to XML](#).

*Restoring (importing) a space backup*

See:

- [Restoring a Space](#) *(Not applicable to Confluence OnDemand.)*
- [Importing wiki data](#) *(For Confluence OnDemand.)*

**Archiving a Space**

You can archive a space, so that its content is less visible but still available on your Confluence site. You need to be a **space administrator** to archive a space. You can change a space's status from archived to current at any time.

**The effect of archiving a space**

If a space is archived:

- The pages and other content do not appear in the Confluence quick navigation aid, which drops down when you enter text in the search box.
- By default, the pages and other content do not appear in the Confluence search results. If a Confluence site contains any archived spaces, the search screen will provide an option to include them in the search results.
- The space and its pages do not appear on the dashboard.
- Updates to the space’s content do not appear in activity streams, such as the recent updates section of the dashboard.
- The space does not appear in space-selection dropdown menus. Similarly, its pages and other content do
not appear in any dropdown menus in the Confluence user interface.

- In the space directory, the archived space will no longer appear in the general space lists. Archived spaces will appear on the 'archived spaces' tab. They will also appear on the category tabs, as determined by their labels.

These functions remain available for archived spaces:

- People can view the content as usual, by following a link or typing in a URL belonging to the archived space.
- People can edit the content as usual, as determined by the space permissions.
- RSS feeds, watches and notifications remain active.

---

**On this page:**

- The effect of archiving a space
- Archiving a space
- Notes

**Related pages:**

- Working with Spaces
- Deleting a Space
- Confluence User’s Guide

---

**Archiving a space**

**To archive a space:**

1. Go to a page in the space you wish to archive.
2. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
3. The 'Edit Space Details' screen appears. Select **Archived** in the **Status** dropdown menu.
4. Choose **Save**.

**Notes**

Archiving a space has no effect on search results of external search engines. For example, the space will still appear in Google search results.

**Screenshot: An archived space**
Viewing Space Activity

Space activity information is **disabled by default**.

If enabled, the space activity screen displays statistics on the activity in each space. These include:

- How many pages and blog posts have been viewed, added or updated over a given period.
- Which content is the most popular (most frequently viewed).
- Which content is the most active (most frequently edited).
- Which people are the most active contributors/editors of content.

The ‘Activity’ tab will not be visible unless the Space Usage Stats plugin is enabled. See notes below.

**To view the activity in a space:**

1. Choose **Space Tools** in the space sidebar.
2. Choose the **Activity** tab.

Confluence will show a graphic display of the number of pages and blog posts that have been viewed, added and edited, showing trends over a period of time.

**Related pages:**

- Page History and Page Comparison Views
- Managing Changes and Notifications and Tasks
- How Do I Get More Statistics from Confluence?
- Finding Unused Spaces **Not applicable to Confluence OnDemand.**
- Viewing Site Statistics **Not applicable to Confluence OnDemand.**
- Confluence User's Guide

**Screenshot 1: The Space Activity tab**
In addition to the graphical representation of Views and Edits, the top ten most popular and most active pages and/or blog posts will be listed, with a link to each.

**Screenshot: Popular content, active content and active contributors.**

<table>
<thead>
<tr>
<th>Most popular content (Views)</th>
<th>Most active content (Edits)</th>
<th>Most active contributors (Edits)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Angry Nerds Home (6)</td>
<td>1. Ideas for Angry Nerds 2 - revenge of the... (2)</td>
<td>1. Josh User (5)</td>
</tr>
<tr>
<td>2. Which nerd are you? (3)</td>
<td>2. Why I loved Angry Nerds (1)</td>
<td>2. Ewan User (3)</td>
</tr>
<tr>
<td>3. Step 1 - download the game (2)</td>
<td>3. Which nerd are you? (1)</td>
<td>3. Rach Admin (1)</td>
</tr>
<tr>
<td>4. Why I loved Angry Nerds (2)</td>
<td>4. Step 2 - Play (1)</td>
<td></td>
</tr>
<tr>
<td>5. Step 2 - Play (2)</td>
<td>5. Status update (1)</td>
<td></td>
</tr>
<tr>
<td>6. Ideas for Angry Nerds 2 - revenge of the... (2)</td>
<td>6. Games as a communication medium (1)</td>
<td></td>
</tr>
<tr>
<td>7. Status update (1)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Games as a communication medium (1)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Notes**

- The Confluence Usage Stats plugin, which provides the 'Space Activity' screen, is known to cause performance problems on large installations. This plugin is **disabled by default**. Your Confluence system administrator can enable the plugin, but please be aware of the possible impact upon your site's performance.
- The plugin is sometimes called 'Confluence Usage Tracking'.
- If your Confluence site is clustered, the space activity information will not be available.

**Viewing Recently Updated Content**

The 'Recently Updated' view is a useful way of keeping track of the changes being made in a space. It displays links to the most recently added or modified content within the space including pages, blog posts, mail messages and comments.

Are you looking for a way to display a list of recently updated pages on a page? Try the **Recently Updated Macro**.

**To view the recently updated content in a space:**

1. Go to a page in the space and choose **Pages** in the sidebar. For more options, choose **Browse and reorder all pages**.
   Or, if you are using the Documentation theme, choose **Browse > Pages** at the top of the screen.
2. Choose **Recently Updated**. A list of the most recently added or modified content in the space is displayed. Choose a link to open the corresponding document.
Working with Mail Archives

Confluence allows you to collect and archive mail within each space. This is useful for storing the email messages that relate to a particular project – you can put them in the same Confluence space as the content for that project.

You can download mail from one or more POP or IMAP accounts. You can also import mail from mbox files either on your local system or on the Confluence server.

You need space administration permissions to manage the mail archives. See Space Permissions Overview.

To see archived mail:

- Go to a space and choose Space Tools > Integration > Mail
  Or, if your space uses the Documentation theme, choose Browse > Mail at the top of the screen.
- Choose a message to see its contents, or choose Next, Previous and other options to navigate around the mail archives.

Managing mail archives:

- Adding a Mail Account
- Deleting Mail
- Fetching Mail
- Importing Mail
- Managing Mail Accounts

The information on this page does not apply to Confluence OnDemand.

Screenshot: Viewing a message in the mail archive

Notes

- Only site spaces can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- You can also search the mail messages and their attachments. See Searching Confluence.
• Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose Confluence Admin > Manage Add-ons > Show System Add-ons, then enable the Confluence Mail Archiving Plugin.

Adding a Mail Account

When you add a mail account, you are configuring Confluence to download mail from that account and archive the mail within the space.

You need space administration permissions to add a mail account. See Space Permissions Overview.

⚠️ Note: Confluence will remove email messages from an email account when it transfers them to the mail archive. You must therefore configure Confluence to poll a clone email account rather than the actual account. For example, to archive the actual account sales@company.com to your Confluence Sales space, you must first create a clone account such as conf-sales@company.com that contains the same email content.

Step 1. Create a clone email account on the mail server

1. Add a new email account on the mail server with the clone email address.
2. Copy all existing email messages from the actual account to the clone account.
3. Set up the actual account to bcc sent email messages to the clone account.
4. Set up the actual account to forward received email messages to the clone account.

Related pages:

• Working with Mail Archives
• Managing Mail Accounts
• How Do I Check Which Spaces Have Email Accounts?
• How Do I Disable Automatic Mail Polling?
• Confluence User's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

Step 2. Configure Confluence to archive the clone account

1. Go to the 'Mail Accounts' view:
   - If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

   • Choose Integration > Mail Accounts

   If your space uses the Documentation theme:

   • Choose Browse > Space Admin at the top of the screen.

   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

   • Choose Mail Accounts in the space administration options.

2. Choose Add mail account.
3. Enter configuration details for the account.
   - Account Name: Enter a name for this account by which it will be known in Confluence.
   - Description: Provide a description for this account (optional).
Confluence 5.0 Documentation

- **Protocol:** Choose from POP, IMAP, POPS or IMAPS.
- **Hostname:** Enter the host name of the mail server on which the account resides.
- **Port:** Do not edit this field. The mail server's port number will be displayed by default.
- **Username:** Enter a username that has permission to retrieve mail from this account.
- **Password:** Enter the account's password.

4. Choose **Test Connection** to verify the details.
5. Choose **Create** to add the account to Confluence.

**Notes**

- Only **site spaces** can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose Confluence > Manage Add-ons > Show System Add-ons, then enable the **Confluence Mail Archiving Plugin**.

**Deleting Mail**

To delete mail from a space, you need 'Remove Mail' permission. See Space Permissions.

Only a space administrator can delete all email messages for the space simultaneously.

To delete mail from a space:

1. Go to a space and choose **Space Tools > Integration > Mail**
   - Or, if your space uses the Documentation theme, choose **Browse > Mail** at the top of the screen. A list of email messages in the space is displayed in reverse chronological order.
2. Delete an individual email message by choosing the trash icon beside it.
3. If you are a space administrator, you can delete all email messages within a space at once by choosing **Delete All**.

Space administrators can restore deleted email messages, provided they were deleted individually.

**Note:** Email messages deleted using the 'Delete All' option cannot be restored.

To restore mail that has been deleted:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

2. Choose **Content Tools > Trash**.
3. You will see a list of email messages and other content deleted from the space. Choose **Restore** beside the email message you want to restore.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.

   **Note:** The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

2. Choose **Trash** in the left-hand panel.
3. You will see a list of email messages and other content deleted from the space. Choose **Restore** beside the email message you want to restore.
Fetching Mail

Confluence fetches mail from the server once every 30 minutes. If necessary, you can manually retrieve new mail from the configured mail accounts.

You need to be a space administrator to manually retrieve mail. See Space Permissions.

To manually retrieve mail:

1. Go to a space and choose Space Tools > Integration > Mail
   Or, if your space uses the Documentation theme, choose Browse > Mail at the top of the screen.
2. Choose Fetch new mail. Any new messages will be displayed in order of most recent first.

Notes

- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose Confluence Admin > Manage Add-ons > Show System Add-ons, then enable the Confluence Mail Archiving Plugin.
- Once mail is fetched, it will be removed from the server.

Importing Mail

Confluence allows you to import mail from mbox files located either on your local system or on the Confluence server. Confluence will store the imported email messages in the space’s mail archive.

You need to be a space administrator to import mail for a space. See Space Permissions.

NB: You may need to enable the Confluence Mail Archiving Plugin as it is disabled by default.

To import mail from an mbox file:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.
   
   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Integrations > Mailbox Import.
   - To import from a location on your file system: Browse to the location of the mbox file, select the file and then choose Import.
   - To import from the Confluence server: Enter the location of the mbox file on the server, then choose Import.
If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Mailbox Import** in the space administration options.
   
   - To import from a location on your file system: Browse to the location of the mbox file, select the file and then choose **Import**.
   
   - To import from the Confluence server: Enter the location of the mbox file on the server, then choose **Import**.

---

### Related pages:

- Working with Mail Archives
- Adding a Mail Account
- Confluence User's Guide

---

**Notes**

- Only **site spaces** can store mail archives. Personal spaces cannot. See Working with Spaces for an explanation of site spaces and personal spaces.
- Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose **Confluence > Manage Add-ons > Show System Add-ons**, then enable the **Confluence Mail Archiving Plugin**.

### Managing Mail Accounts

**You need to be a space administrator to manage mail accounts for a space. See Space Permissions.**

Confluence will import mail from these POP/IMAP mail accounts into the space's mail archive.

**To manage mail accounts:**

1. Go to the 'Mail Accounts' view:
   
   - If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

   - Choose **Integration > Mail Accounts**

   If your space uses the Documentation theme:

   - Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

   - Choose **Mail Accounts** in the space administration options.

2. **Add** an account if required. See **Adding a Mail Account**.

3. For each of the existing mail accounts listed, you can:
   
   - **Edit:** Change the configuration settings for the mail account.
   
   - **Remove:** Remove the account permanently.
   
   - **Disable/Enable:** Temporarily disable the account, or enable a disabled account.
Notes

Confluence mail archiving is an optional feature. This means that the 'Mail' options may be disabled and will therefore not appear in the Confluence user interface. Mail archiving features are contained in a bundled plugin. To activate mail archiving features in Confluence, enable the plugin – choose Confluence Admin > Manage Add-ons > Show System Add-ons, then enable the Confluence Mail Archiving Plugin.

Working with Confluence Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence.

For example, you could assign the label 'accounting' to all accounts-related pages on the site. You can then browse all pages with that label in a single space or across the site, or display a list of pages with that label. You can search based on the label, or use it to filter items when you subscribe to a Confluence RSS feed.

Because labels are user-defined, you can add any word that helps you identify the content in the site.

You can add or remove labels without affecting the page content.

Content labels

You can add labels to pages, blog posts and attachments. Any user with permission to view the page can also view its labels. See Adding Labels.

Space categories

You can also apply labels to spaces and use them to categorise your spaces. These are known as space categories. See Using Labels to Categorise Spaces.

Advantages of labels

Here are some of the advantages of using labels:

- Labels are user-defined which means that you decide what information is relevant to you and how you are going to label it.
• You can group pages and spaces without having to restructure the site.
• Labels are easy to add and edit, and do not affect the content of the page.
• You can add as many labels as you like to a page or space.

Using labels

• Adding Labels
• Using Labels to Categorise Spaces
• Removing Labels
• Using Label Macros to Categorise Wiki Content
• Viewing Labels and Labelled Content
• Viewing Personal Labels

Notes

Note: Personal labels are deprecated: Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

Adding Labels

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content.

Labelling a page or blog post

Any user with permission to edit a page can add a label to a page.

To add a label to a page or blog post:

1. Go to the page. If the page already has labels, these will be listed at the bottom of the page, below the page content.
2. Choose the edit icon beside the list of labels, or press L on your keyboard.
3. Type in a new label. Existing labels are suggested as you type.
4. Choose Add.
Labelling an attachment

If you have permission to view or edit the page that contains the attachment, you can add a label to the attachment.

To add a label to an attachment:

1. Go to the page that contains the attachment. Choose Tools > Attachments.
2. Alternatively, go to the attachments view of the space:
   - If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. Choose Content Tools > Attachments
4. You will see a list of attachments, with columns for attachment name and other details. If the attachment already has labels, these will be listed in the Labels column.
5. Choose the edit icon beside the list of labels.
6. Type in a new label. Existing labels are suggested as you type.
7. Choose Add.

You can also add labels in a list of attachments displayed by the Attachments macro, by choosing the edit icon beside each label.

*Screenshot 2: Adding a label to an attachment*
Notes

- **Note: Personal labels are deprecated.** Earlier versions of Confluence recognised a special type of label called a 'personal' label. A personal label starts with 'my:' and is only visible to the user who created it. We are removing personal labels from Confluence, as announced in the Confluence 4.1 Upgrade Notes. The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

- If you add a label to a template, that label will be copied to the page when someone adds a page based on that template. See Adding a Template.

Using Labels to Categorise Spaces

A space category is a label that you can apply to a whole space for the purpose of categorising your spaces in the space directory, and in the recent activity area of the dashboard.

You need to be a space administrator to add space categories.

**Using space categories**

Here is an example of using space categories. Let's assume that you have one or more spaces that your Sales team may be interested in. You can use the category 'sales' to group those spaces together.

1. First add the 'sales' category to the relevant spaces, as described below.
2. Then, in the space directory, you can click the relevant tab to see only the spaces with the chosen label. See Viewing All Confluence Spaces.
3. And, you can see updated content in those spaces by choosing the 'sales' category under the Space Categories tab in the recent activity area of the dashboard. See Customising your Personal Dashboard.
Categorising a space

When you categorise a space, you add a 'space category' to the space. A category does not exist if there are no spaces labelled with that category.

To add a space category to a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Overview > Space Categories: Edit.
3. Under 'Space Categories', enter your category name and choose Add.
   Alternatively, choose a category in the list of 'Suggested Space Categories'
4. Choose Done.

If your space is using the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Space Labels in the space administration options.
3. Under 'Space Categories', enter your category name and choose Add.
   Alternatively, choose a category in the list of 'Suggested Space Categories'.
4. Choose Done.

Removing a space from a category

Removing a space from a category is the same as removing the category from the space.

To remove a space category from a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Overview > Space Categories: Edit.
3. Choose the x next to the space category.

If you are using the Documentation theme:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the *confluence-administrators* group).

2. Choose **Space Labels** in the space administration options.
3. Choose the x next to the space category.

**Removing an entire space category**

To remove a whole space category from Confluence, just remove that category from all spaces, as described above. A category cannot exist if there are no spaces labelled with that category. The space category will disappear from the dashboard and space directory.

**To remove an entire space category from Confluence:**

1. Choose **Spaces** at the top of the screen.
2. Choose the space category that you want to remove.
3. You will see a list of all spaces in that category. Choose the spaces one by one, and remove the category from each space, as described above.

**Screenshot: Space categories**

![Space categories](image_url)

**Notes**

The ability to add space labels has been removed in **Confluence 5.0** in order to simplify the way labels are used in spaces. Existing space labels will be preserved, but you will be unable to add new space labels. Space categories are unaffected by this change.

**Removing Labels**

Labels are key words or tags that you can add to pages, blog posts and attachments. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. You can see the existing labels, and the pages which contain the labels, by viewing labels and labelled content.

**Removing labels in Confluence**

**To remove a label from a page or blog post:**

1. Go to the page that contains the label. You will see the labels at the bottom of the page below the page content.
2. Choose the edit icon 📝 beside the list of labels, or press L on your keyboard.
3. In the 'Labels' dialog, choose the X next to a label to remove that label.
4. Choose Close.

**Related pages:**
- Working with Confluence Labels
- Confluence User's Guide

**To remove a label from an attachment:**
1. Go to the page that contains the attachment. Choose **Tools > Attachments**.
2. Alternatively, go to the attachments view of the space:
   - If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
   - Choose **Content Tools > Attachments**
3. You will see a list of attachments, with columns for the attachment name and other details. If the attachment already has labels, these will be listed in the **Labels** column.
4. Choose the edit icon beside the list of labels.
5. In the 'Labels' dialog, choose the X next to a label to remove that label.
6. Choose **Close**.

When you have removed the label from all content, the label will disappear from the labels view in the space too.

**Notes**
- **Deleted pages containing labels:** If you have deleted pages that contain a label, you may need to purge the deleted pages from the space's trash to ensure that the label disappears too.
- **Bulk removal of labels:** There is no way to remove a number of labels at once, via the Confluence user interface. Instead, we suggest that you use the Confluence Command Line Interface. See the 'removeLabels' action described in the CLI documentation. For an introduction to the CLI, see this blog post: Confluence CLI for bulk actions like deleting or publishing pages.

---

**Using Label Macros to Categorise Wiki Content**

Using labels, you can categorise pages and refer to content across multiple categories, pages and even spaces.

**Example**

For the purpose of this example, imagine we have a space with pages of content on various type of vehicles. Pages are shown in **bold** text, while the labels are in **blue**.

- **Cars** vehicle-type
  - Toyota Prius vehicle car
  - Honda Civic vehicle car
  - Porsche Carrera vehicle car
- **Motorbikes** vehicle-type
  - Harley Davidson Sportster vehicle motorbike
  - Suzuki GSX-R vehicle motorbike
This page hierarchy can then be categorised using labels, with pages referenced using the `Content by Label Macro`.

<table>
<thead>
<tr>
<th>If you want to list...</th>
<th>You would use this label:</th>
<th>These would be the pages that you would get:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle types</td>
<td>vehicle-type</td>
<td>Cars, Motorbikes</td>
</tr>
<tr>
<td>All vehicles</td>
<td>vehicle</td>
<td>Toyota Prius, Honda Civic, Porsche Carrera, Harley Davidson Sportster, Suzuki GSX-R</td>
</tr>
<tr>
<td>All cars</td>
<td>car</td>
<td>Toyota Prius, Honda Civic, Porsche Carrera</td>
</tr>
</tbody>
</table>

**Related pages:**
- Working with Confluence Labels
- Working with Macros
- Confluence User’s Guide

**Label macros**

**Navmap macro**

The `Navigation Map macro` renders the list of pages associated with a specified label as a navigation map.

**Related Labels macro**

The `Related Labels macro` lists labels commonly associated with the current page's labels.

**Content by Label macro**

The `Content by Label macro` displays a list of content marked with specified labels.

**Content Report Table macro**

The `Content Report Table macro` displays a set of pages and blog posts in tabular format, based on the specified labels.

**Labels List macro**

The `Labels List macro` lists all labels of a space, grouped alphabetically.

**Recently Used Labels macro**

The `Recently Used Labels macro` lists labels most recently used in a specified scope - global (site), space, or personal.

**Popular Labels macro**

The `Popular Labels macro` displays popular labels in a list or in a heatmap (also called a cloud).

Finding the labels view

Labels are key words or tags that you can add to pages, blog posts, attachments and spaces. You can define your own labels and use them to categorise, identify or bookmark content in Confluence. This page describes a few ways of viewing labels and labelled content. The focus of this page is on labels that are visible to everyone. You may also be interested in viewing personal labels.
Global labels are visible to all users with 'view' permission on the page, and personal labels are visible only to the person who added them.

- Any page or blog post that has labels will have them listed together in a block at the bottom of the page.
- You will also see labels in the 'Attachments' view or in a listing of attachments provided by the Attachments macro. (See Displaying a List of Attachments.)

**To find the labels view by choosing a label:**

If you are in a page that has labels, choose a label.

- If it is a personal label (starts with 'my:') you will go to the personal labels page in your user profile. See Viewing Personal Labels.
- If it is a global label, you will go to the 'Labels' tab of the space. Choose Popular Labels or All Labels to see all labels in the space.

*Screenshot: Labels as they are displayed on a page*

![Label Example](image)

**To find the labels view via URL:**

Visit the following URL:

<MY.CONFLUENCE.SITE>/labels/listlabels-alphaview.action?key=MYSPACEKEY

For example: https://confluence.atlassian.com/labels/listlabels-alphaview.action?key=DOC

**To find the labels view from the menu (Documentation theme only):**

If the space is using the Documentation theme, you can access the labels view directly via the menu:

- Go to a page in the space and choose **Browse > Labels**.
- Choose **Popular Labels** or **All Labels** to see all labels in the space.

---

**On this page:**

- Finding the labels view
- Using the labels view
- Searching for labels
- Navigating pages by URL and label

**Related pages:**

- Viewing Personal Labels
- Searching Confluence
- Confluence User's Guide

---

**Using the labels view**

The labels view in a space offers the following options:

- **Popular Labels**: Choose this option to see a list of the most frequently used labels in that space. From here, you can also view the most popular labels across the site. The bigger the font size, the more popular the label.
- **All Labels**: View all labels in the space. From this view, you can choose a link to view an alphabetical
listing of all labels across the site. Choosing a label will list all content in the space with that label. It will also display any related labels if they exist. Related labels are labels that frequently appear on pages together. For example, if pages labelled with 'sales' also tend to have the label 'marketing', these will be displayed as related labels.

- **See content from all spaces:** Expand the list of labels to include pages and other labelled content from all spaces.

**Screenshot: The labels view, showing all 'logo' labels**

```
Label: logo

- Our new logo > Logo2.jpg
  8 minutes ago • Rach Admin
  logo

- Our new logo > atlassian_logo_detail.gif
  8 minutes ago • Rach Admin
  logo

- Sample Page > iBugs.gif
  33 minutes ago • Josh User
  useful logo

- Sample Page > sitelogo.png
  33 minutes ago • Josh User
  logo confluence
```

**Searching for labels**

A quick way to find labelled content is to search for it. If there is a label matching your query, you will see it in the panel titled **Browse Labels** in the search results. Choose a label to see all content in the site with that label.

**Screenshot: Searching for labelled content**

Advanced label searching
Use the 'labelText:' prefix to search specifically for content that has a specific label. The table below gives examples of search terms that you can enter into Confluence's search box, and the search results that you can expect.

<table>
<thead>
<tr>
<th>Searching for ...</th>
<th>Returns content that ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>recipe labelText:chocolate</td>
<td>contains the word 'recipe' or has the label 'chocolate'</td>
</tr>
<tr>
<td>recipe AND labelText:chocolate</td>
<td>contains the word 'recipe' and has the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake labelText:chocolate</td>
<td>has the label 'cake' or the label 'chocolate'</td>
</tr>
<tr>
<td>labelText:cake AND labelText:chocolate</td>
<td>has both labels 'cake' and 'chocolate'</td>
</tr>
</tbody>
</table>

The 'labelText:' prefix is an example of a search field. See more about Confluence Search Fields.

Navigating pages by URL and label

This section describes how to move around your Confluence pages by adding and subtracting labels from the list of labels that you want to match. You can search for matching labels by entering a URL. You can also add and subtract labels from the search.

To search labelled pages by typing a URL:

1. Open a new web browser window.
2. In the address bar of your web browser, type an URL such as:
   
   http://CONFLUENCE_HOSTNAME/label/foo+bar

3. Press Enter.
4. The 'View Labels' page will load, showing search results for pages with the labels 'foo' and 'bar'.

Adding a label to your results:

- Choose a label from the Related Labels list (at the top left).
- A new page loads, showing pages that contain all of the labels selected so far. You can continue to add labels to the results in this way.

Subtracting a label from your search results:

When two labels are in use, links to subtract a label from the search appear at the end of the labels list. These are easily identified because these links have a preceding minus sign, like this:

- education

Viewing Personal Labels

Any page that has labels (global or personal) will have them listed at the bottom of the page. Personal labels start with 'my:', and are only visible to the user that created them.

**Note: Personal labels are deprecated.** The functionality for personal labels is still in Confluence, but we recommend that you stop using them. In a future release, we plan to remove the functionality altogether.

To view your personal labels:

- If you are on a page that has personal labels, click one of those labels to get to the screen showing all your personal labels.
• Alternatively, visit the URL: `<your Confluence site>/users/viewmylabels.action`. For example: `http://confluence.atlassian.com/users/viewmylabels.action`

You will see a list of your personal labels along with the pages that contain the label.

**Related pages:**
- Adding Labels
- Viewing Labels and Labelled Content
- Confluence User's Guide

---

**Working with Favourites**

You can mark pages and spaces as favourites and then access them quickly from the Confluence dashboard and from your user profile.

**Adding favourites**

**To add a page as a favourite:**

1. Go to the page.
2. Choose **Tools > Favourite**.
   The menu item will change to ‘Remove Favourite’ to indicate the page is a favourite.

**To add a space as a favourite:**

1. Choose **Spaces** at the top of the screen.
2. Choose the star icon next to the space name in the list of spaces.
   The star icon will change colour to indicate that you have added this space as a favourite.

**To add someone's personal space as a favourite:**

This option is only available for personal spaces. You cannot mark a person's profile as favourite, so this option is not available if the person has not yet created a personal space.

1. Choose **Spaces** at the top of the screen.
2. Choose **Personal Spaces**.
3. Choose the star icon next to the space name in the list of spaces.
   The star icon will change colour to indicate that you have added this space as a favourite.

---

**Removing favourites**

**To remove a page as a favourite:**

1. Go to the page.
2. Choose **Tools > Remove Favourite**.
   This will change to ‘Favourite’ to indicate that you have removed this page from your favourites.
To remove a space as a favourite:

1. Go to the dashboard or choose Spaces in the header.
2. Choose the star icon beside the space in the list of spaces.
   The star icon will change colour to indicate that you have removed this space as a favourite.

To remove a personal space as a favourite:

1. Choose Spaces in the header.
2. Choose Personal Spaces.
3. Choose the star icon beside the space in the list of personal spaces.
   The star icon will change colour to indicate that you have removed this space as a favourite.

Viewing favourites

You can see your favourite pages via your user profile and on the dashboard.

To view your favourites via your profile:

1. Log in to Confluence, if you have not already done so.
2. Choose your profile picture at top right of the screen, then choose Favourites.

Screenshot: Viewing your favourites in your profile

Viewing your favourites via the dashboard

On the dashboard, you can see:

- your favourite spaces on the Spaces tab.
- your most recently added favourite pages on the Pages tab.

Recently updated content in your favourite spaces will be listed on the Favourite Spaces tab on the dashboard.

Screenshot: Viewing your favourites on the dashboard
Working with Attachments

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format. You can attach files to any page or blog post, provided you have permission to do so.

When a page you are viewing contains attachments, a small paperclip icon appears next to the page byline, under the page name. Clicking the paperclip will take you to the ‘Attachments’ view, where you will see the full list of attachments.

A quick guide to attachments

Choose Tools > Attachments to view and attach files to a Confluence page. (See Attaching Files to a Page.) If you attach a file with the same name as an existing attachment, Confluence will create a new version of the existing attachment.

Once you have attached the relevant files, you can display attached images and multimedia content on the page. If the attachment is an Office document, use the View File macro to display the content of the document on the Confluence page. If you have an Office application installed, you will also be able to launch your Office editor from within Confluence. See Displaying Office Files in Confluence and Working with the Office Connector.

Your page can display a list of attachments – these may be the files that are attached to the page or to any page in the space. You can also display a link to an attachment. When a user clicks the link, the attachment will open, provided that the user has the software application needed to open the attachment.

You can label an attachment, and then use labels to categorise your content.
Using Drag-and-Drop in Confluence

This page describes the drag-and-drop functionality in Confluence, and the browser configurations needed to support that functionality.

Overview of the drag-and-drop features

Confluence supports these forms of drag-and-drop:

- **Drag-and-drop within the editor.** Working inside the editor panel, you can drag an image or a macro and drop it into a different location on the page.

- **Drag-and-drop for external images and files.** You can drag a file from a location outside Confluence, and drop it directly into the editor. For example, try it with images, video files, audio files, Office documents, and PDF files. The contents of the file will be embedded into the page or blog post.

**Drag-and-drop within the editor**

Working within the editor panel, you can drag an image or a macro from one location on the page and drop it into a different location on the page. Hover your cursor over the image or the macro placeholder. The cursor changes to a drag-and-drop icon and you can click the image or macro and drag it to a new location.

If you want to abandon the drag-and-drop action, press Escape. The image/macro will return to its original position.

**Requirements for internal drag-and-drop**

For the drag-and-drop of images and macros in the editor, Confluence supports the following browsers: Chrome, Firefox, and Internet Explorer 9. (Drag and drop in the editor does not work in Internet Explorer 8.)
Drag-and-drop for external images and files

You can drag files from your computer or file system onto your browser and attach them to your Confluence pages or blog posts. You can drag and drop:

- multiple files at once.
- image, multimedia and PDF files, and Office documents.

When you drag and drop files onto the different Confluence views, you get the following results:

<table>
<thead>
<tr>
<th>Confluence View</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Page</td>
<td>Files are attached</td>
</tr>
<tr>
<td>Edit</td>
<td>Files are attached, and embedded at the cursor position</td>
</tr>
</tbody>
</table>

Requirements for external drag-and-drop

- For dragging files from your computer or file system onto your browser, your browser must support the drag-and-drop functionality of HTML5. Browsers such as Firefox 3.5, Safari 4 and Internet Explorer 9 offer limited HTML5 functionality and don't support drag-and-drop.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

- Some older Confluence themes do not support Confluence's drag-and-drop feature.
  - **Supported themes**: Confluence Default theme, Documentation theme.
  - **Themes that are not supported**: Left Navigation theme, Clickr theme. You cannot drag and drop attachments into spaces that use these themes.

Disabling drag-and-drop for external files

- If you wish to disable the drag-and-drop feature, you can disable the entire Confluence Drag and Drop Plugin. See Disabling and Enabling Add-ons.
You can also disable the drop zone that appears on the 'Attachments' view or the image dialog box, by disabling the View Attachments Drop Zone or Image Dialog Drop Zone modules of the above plugin. This will remove these drop zones while retaining Confluence's drag-and-drop functionality.

Attaching Files to a Page

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format. Read more in Working with Attachments.

When you attach a file to a page, Confluence makes a copy of the file and stores it on the Confluence server. Page attachments in Confluence are managed using the 'Attachments' view of the page.

To attach a file, you need the 'Create Attachments' permission. See Space Permissions.

When a page you are viewing contains attachments, a small paperclip icon appears next to the page byline, under the page name. Clicking the paperclip will take you to the 'Attachments' view, where you will see the full list of attachments.

---

**On this page:**
- Attaching files
- Attachment versions
- Notes

**Related pages:**
- Working with Attachments
- Configuring Attachment Size
- Displaying Images
- Attachment Versions
- Deleting an Attachment
- Confluence User's Guide

---

### Attaching files

This page describes the following ways of attaching files to a Confluence page:

- Drag and drop files on to a Confluence page.
- Browse to, and upload files from, your computer or network.

### To attach a file to a page using drag-and-drop:

1. View the page to which you want to attach files.
2. Drag one or more files from your computer onto the page. The 'Attach File(s)' message box appears, indicating the upload status of the files being attached to your page.

You can drag and drop more than one file at a time onto a page. You cannot drag a folder of files onto a page. Expand this section to see other ways to drag-and-drop a file on to a page...

---

You can also drag and drop files:

- directly onto the 'Attachments' view for the page.
- directly onto the editor view of the page.
- onto any tab of the 'Insert Link' or 'Insert Image' dialogs, which are available from the Insert menu while editing.

---

To attach a file to a page from the computer's (or network's) file system:
1. Choose **Tools > Attachments**.
2. Choose **Browse** and navigate to the file.
3. Select the file and click **Open**.
4. Add a descriptive comment for the file (optional).
5. Choose **Attach more files** if required.
6. Choose **Attach**.

You can attach than one file at a time. You cannot attach a folder of files.

Expand this section to see other ways to upload a file to a page...

You can also browse, and upload, a file from:

- the 'Attachments' tab of the 'Insert Link' dialog. (While editing the page, choose **Insert > Link**.)
- the 'Attached Images' tab of the 'Insert Image' dialog. (While editing the page, choose **Insert > Image**.)

**Attachment versions**

If you upload a file with the same name as an existing attachment, Confluence will rename the old file and keep it as a previous version. Read more about **Attachment Versions** and **Viewing Attachment Details**.

**Notes**

- **Reusing attachments**: If you want to display the same file on more than one page, the best way is to put the attachment on a page (say, page A) and then use the **Include Page Macro** to include page A into page B, page C, and all the pages where you want the diagram, presentation, or other file. Alternatively, you can display an image that is attached to another page.
- **Updating the original file**: Any changes you make to the source file do not affect the copy that was uploaded to Confluence. To update the Confluence copy, you need to upload the new version of the file.

**Attachment Versions**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

When viewing a list of attachments, you can add a **new version of an existing attachment** by uploading an attachment with the same file name, as displayed on the attachment view. Existing files will be kept with the name **'Version x'**, where the value of 'x' increments with each upload of an attachment with the same file name.

**To see all versions of an attachment**: Choose the arrow next to an attachment name.

**Related pages:**

- Attaching Files to a Page
- Deleting an Attachment
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User's Guide

**Screenshot**: Attachment versions
Notes

- You cannot revert to a previous version of an attachment. See feature request CONF-1943.
- Confluence does not track the history of attachments in the same way as it does for pages. See feature request CONF-13943.
- By default, attachments and their versions are stored in the `<confluence_home>/attachments` directory. (See Attachment Storage Configuration. Not applicable to Confluence OnDemand.)
- There is no limit to the number of attachments or attachment versions, provided that there is enough disk space.

Deleting an Attachment

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

By default, when you remove an attachment, this will delete all versions of the attachment. To do that, you need the 'Remove Attachments' permission. See Space permissions.

If you want to delete a specific version of an attachment, you need to be a space administrator.

Related pages:
- Working with Attachments
- Deleting an Image
- Displaying Images
- Confluence User's Guide

To delete all versions of an attachment:

1. Go to the page that contains the attachment.
2. Choose Tools > Attachments. A list of the page’s attachments will appear.
3. Choose Remove next to the attachment you want to delete.
4. Choose Remove to confirm your action.

To delete a specific version of an attachment:

1. Go to the page that contains the attachment.
2. Choose Tools > Attachments. A list of the page’s attachments will appear.
3. Choose the arrow on the left next to the attachment you want to manage. A list of attachment versions will appear.
4. Choose Remove next to the version you want to delete.
5. Choose Remove to confirm your action.
Displaying a List of Attachments

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can display a list of attachments on your page – these may be the files that are attached to the page or to any page in the space. Use the Attachments macro to show a list of the attachments on the current page. Use the Space Attachments macro to show a list of the attachments in the current space. Both these macros generate a table of attachments which is clickable.

Using the macros

To add the Attachments or Space Attachments macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the required macro.

Speeding up macro entry with autocomplete: Type `{ and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

To edit an existing macro: Click the macro placeholder and choose Edit. A macro dialog window will open, where you can edit the parameters of the macro.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Size</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creator</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creation Date</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Labels</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Related pages:

- Attaching Files to a Page
- Working with Attachments
- Working with Macros
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros
- Confluence User’s Guide

Parameters of the Attachments macro

Parameters are options that you can set to control the content or format of the macro output.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Filename Patterns**           | all   | A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:  
  - To match a file suffix of ‘jpg’, use `.jpg` (not `*.jpg`).  
  - To match file names ending in ‘jpg’ or ‘png’, use `.*jpg,*png`  
  Here is a tutorial on regular expressions. |
| **Attachment Labels**           | (none)| A list of labels, used to filter the attachments to display. If you wish to enter more than one label, separate the labels with commas. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.) For information on labelling the attachments, see Adding Labels. |
| **Include Old Attachment Versions** | false | A value of true will include previous attachment versions in the list. |
| **Sort By**                     | date | The sort order for attachments. Note that people viewing the page can change the sort order by clicking the column headings. Valid values are:  
  - **date** – sorts by reverse chronological order (newest first)  
  - **size** – sorts largest to smallest  
  - **name** – sorts alphabetically |
| **Sort Order**                   | ascending | Used in combination with the **Sort By** parameter, to sort the attachments in ascending or descending order. |
| **Allow Upload**                | true  | If selected, the list of attachments will include options allowing users to browse for, and attach, new files. |
**Page Title**

(none)

Used to display attachments from another page. If you do not enter a page title, the macro will display the files attached to the current page.

---

**Viewing files and changing file properties from the Attachments macro**

The list of files displayed by the Attachments macro includes options for viewing the files and other actions, provided the user has the relevant permissions.

- If you have specified the 'Allow Upload' parameter, users will be able to upload attachments directly from the list.
- Users can remove attachments. Note that they can only remove the entire attachment, including all versions of the attachment. To remove a specific version of an attachment, they must go to the 'Attachments’ view. See Deleting an Attachment.
- Users can edit attachment properties and labels. If an attachment is an Office or PDF file, they will see the appropriate options for Office Connector files.

**Screenshot: The Attachments macro**

![Sample Page](image)

**Parameters of the Space Attachments macro**

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>(none)</td>
<td>Selects the Confluence space to display all attachments for. If no space is specified, the current space will be used.</td>
</tr>
<tr>
<td>Attachment Labels</td>
<td>(none)</td>
<td>Filters the attachments to display, based on a list of labels. If you wish to enter more than one label, separate the labels with commas. For information on labelling the attachments, see Adding Labels.</td>
</tr>
</tbody>
</table>
Show Filter Controls | true
---|---
Determine whether or not the filter panel is shown. The filter panel allows you to filter the list of attachments by file type (extension).

**Screenshot: The Space Attachments macro**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator</th>
<th>Creation Date</th>
<th>Last Modification Date</th>
<th>Labels</th>
<th>Attached To</th>
</tr>
</thead>
<tbody>
<tr>
<td>penguin.png</td>
<td>5 kB</td>
<td>Rach Admin</td>
<td>20 minutes ago</td>
<td>20 minutes ago</td>
<td>penguin</td>
<td>Sample Page</td>
</tr>
<tr>
<td>Bugs.gif</td>
<td>22 kB</td>
<td>Josh User</td>
<td>about an hour ago</td>
<td>about an hour ago</td>
<td>useful</td>
<td>Sample Page</td>
</tr>
<tr>
<td>site-logo.png</td>
<td>2 kB</td>
<td>Josh User</td>
<td>about an hour ago</td>
<td>about an hour ago</td>
<td>logo</td>
<td>Sample Page</td>
</tr>
<tr>
<td>DefaultSpace.logo_AngryTerrorists.png</td>
<td>10 kB</td>
<td>Rach Admin</td>
<td>Feb 13, 2013</td>
<td>Feb 13, 2013</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Code examples**

See:
- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

**Downloading Attachments**

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

**To download a single attachment from a page:**

1. View the page.
2. Choose Tools > Attachments.
3. Right-click the link on the attachment name, and select Save Link As, Save Target As or a similar option provided by your browser. This will open a ‘Save’ dialog.
4. Select the location into which you want to download the file and choose Save.

**Related pages:**
- Attaching Files to a Page
- Working with Attachments
- Confluence User's Guide

**To download all the attachments from a page:**

1. View the page.
2. Choose Tools > Attachments.
3. Choose the Download All button at the end of the page to download a zipped file of all the page's attachments.

**Notes**
There is no permission that controls the downloading of attachments. See an article in our knowledge base about disabling the download of attachments.

Confluence does not supply an option to download all attachments from a space. See the closed feature request: CONF-5669 - Authenticate to see issue details.

Editing Attachment Properties

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

To edit an attachment's properties, you need the 'Create Attachments' permission. See Space Permissions.

To edit the properties of an attachment:

1. View the page that contains the attachment.
2. Choose Tools > Attachments.
3. Choose Properties next to the attachment. The 'Properties' screen will appear.
4. Make your changes:
   - File Name — Rename or modify the name of the attachment.
   - New Comment — Update the existing comment or enter a new comment.
   - New Content Type — Change the content type of the attachment by entering a valid MIME type.
   - Page — Move the attachment to another page.
5. Choose Save.

Related pages:
- Attaching Files to a Page
- Moving an Attachment
- Viewing Attachment Details
- Working with Attachments
- Confluence User's Guide

Screenshot: Editing an attachment's properties
Embedding Multimedia Content

Using multimedia files you can display movies, animations and videos, and embed audio files on your Confluence page. There are several methods for attaching files to a page. Once you have attached the multimedia file to a Confluence page, you then edit the page to set where the multimedia content should appear.

In the example below, we display a Flash file that is attached to this page.

Confluence supports the following multimedia formats:

- Adobe Flash (.swf)
- Apple QuickTime (.mov)
- Windows Media (.wma, .wmv)
- Real Media (.rm, .ram)
- MP3 and MP4 files (.mp3, .mp4)
- MPEG files (.mpeg, .mpg)
- AVI files (.avi) You may need to enable an avi decoder within your browser.

**Quick guide to displaying multimedia content on a page**

Choose one of these methods:

- **Add the macro yourself**: Attach the multimedia file to the page in the usual way. Add the Multimedia macro using the macro browser.
- **Autocomplete**: Attach the multimedia file to the page in the usual way. Type ‘!’ in the editor and choose the multimedia file from the list that appears.
- **Drag and drop**: Drop the video or other file into the editor. Confluence will attach the file and insert the Multimedia macro for you.
- **Adjust parameters if necessary**: Click on the Multimedia macro placeholder to set options for the macro, such as adjusting the width or height of the display, or setting autoplay on.

**Displaying a multimedia file attached to the page**

Once you have attached a multimedia file to a page, there are different methods for choosing where on the page the multimedia content should appear:

**Inserting the Multimedia macro yourself**

You can add the Multimedia macro to the page yourself using the Macro Browser. This allows you to display a multimedia file that is attached to either the current page or to another page in the Confluence site.

**To insert the Multimedia macro on the page at the current cursor position:**

1. In the Confluence editor, choose **Insert > Other Macros**.
2. Find and select the required macro.

**Speeding up macro entry with autocomplete**: Type { and the beginning of the macro name, to see a list of suggested macros. Details are in Using Autocomplete.

**To edit an existing macro**: Click the macro placeholder and choose **Edit**. A macro dialog window will open, where you can edit the parameters of the macro.
Using autocomplete

Once a multimedia file is attached to the page, you can use autocomplete, while editing the page, to choose where the multimedia content should appear.

To position an attached multimedia file on the page using autocomplete:

1. While editing the page, position the cursor where you want to place the multimedia content.
2. Trigger the autocomplete function by typing '!'.
3. Choose the multimedia file from the list that appears.
4. If necessary, click on the Multimedia macro placeholder and choose Edit to set various options such as the width, height or autoplay.

Using drag-and-drop

Depending on the browser you are using, you can attach and position a multimedia file in one step using drag-and-drop.

To attach and position multimedia content using drag-and-drop:

1. While you are editing a page, simply drag-and-drop the multimedia file on to the page. Confluence will attach the file to the page and insert the Multimedia macro at the current cursor position for you.
2. If necessary, click on the Multimedia macro placeholder and choose Edit to set various options such as the width, height or autoplay.

Multimedia macro parameters

Parameters are options that you can set to control the content or format of the macro output.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Name</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached. If you are using the Macro Browser, just start typing the name of the page and then select it from the dropdown list that appears. The page can be in the same space or another space.</td>
</tr>
<tr>
<td>Attachment</td>
<td>None</td>
<td>File name of the multimedia file.</td>
</tr>
<tr>
<td>Width</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td></td>
</tr>
</tbody>
</table>
Autoplay | False | If this option is checked (that is, if the parameter is set to 'true') then the video or audio file will start playing as soon as the page is loaded. If this option is not checked (set to 'false') then the file will not play until the user clicks the icon or image on the page. See the note about autoplay below.

Notes

- **The multimedia file must be attached to a Confluence page.** For security reasons, files located on remote servers are not permitted. See the [Widget Connector](#) for displaying live content from external sites.

- **You will need the relevant multimedia plugin for your browser.** Your browser (Firefox, Internet Explorer, Safari and others) needs a plugin to play the video or audio file on a Confluence page. For example, to play a Flash movie you need the Flash plugin. Many plugins are shipped with the major browsers by default. If a user does not have the required plugin installed and enabled in their browser, they will not be able to view the multimedia files on the page.

- **Autoplay may not always work as expected.** You can set autoplay on, so that your video or audio file should start playing as soon as the page is loaded into the browser. (See parameters.) However, this setting may not always work as expected. Confluence will send an instruction to the browser plugin that plays the multimedia file. Different browsers and different media plugins behave in different ways, and not all of them respect such instructions.

- **Use the Office Connector to display Office documents.** Take a look at the [Office Connector](#) for embedding Word documents, presentations and other Office documents onto your Confluence page.

- If you get the error, 'Unable to embed content of type application/octet-stream', this means the [MIME type](#) is not recognised.

- **Advanced users can try styling via CSS.** By default, each embedded object is wrapped in a `div` tag. If you wish to style the `div` and its contents, override the `embeddedObject` CSS class. Specifying an ID as a property also allows you to style different embedded objects differently. CSS class names in the format `embeddedObject-ID` are used.

**Code examples**

See:

- Confluence Wiki Markup for Macros
- Confluence Storage Format for Macros

**Related topics**

Working with Macros
Widget Connector Macro
Working with the Office Connector
Working with Attachments

Take me back to [Confluence User’s Guide](#)
Embedding PowerPoint Presentations in a Page

Below are some ideas on how your wiki page can include information from a Microsoft PowerPoint presentation.

**Option 1 — Office Connector for Confluence**

The Office Connector provides the most straightforward way to display PowerPoint slides.

**To attach and display a PowerPoint presentation in Confluence:**

1. Attach the presentation to a Confluence page:
   - View the Confluence page where you want to display your presentation.
   - Open the ‘Tools’ menu and select ‘Attachments’.
   - Browse for your PowerPoint presentation and upload it to the Confluence page.
   - You will find detailed instructions in [Attaching Files to a Page](#).

2. Now you can display the document embedded into the Confluence page, using the View File macro. Refer to the detailed instructions for the View File macro.

---

**Option 2 — Gallery or Slide Show of JPEG or PNG Images**

1. Convert your PowerPoint pages into JPEG or PNG images, using 'save as' from PowerPoint (slide1.jpg, slide2.jpg...).
2. Upload the image files as attachments to your Confluence page. To upload in bulk, consider using a Web DAV client.
3. Use the Gallery macro to display the images as a slide show in Confluence.

---

**Option 3 — Convert PowerPoint to HTML and display using the HTML Include macro (Not applicable to Confluence OnDemand)**

You can convert the PowerPoint file to web page format and embed the page inside your Confluence document.

1. Review the risks associated with enabling the HTML Include macro [here](#).
2. If you decide to proceed, follow the instructions to enable embedded HTML pages using the macro.
3. Select an PowerPoint converter. There are at least two applications that can convert PPT to HTML:
   - Producer for PowerPoint.
   - If you do not have the PowerPoint application on your machine, you can use the Internet Assistant for Powerpoint instead.
4. Download and install your chosen converter.
5. Follow the converter documentation to perform the HTML conversion. An Internet Assistant conversion guide can be found [here](#). The conversion process will create a small collection of HTML pages. Each slide will have its own page, plus an index page with buttons to let you switch between slide pages.
6. If you wish, you can test the HTML presentation now by loading the index page in your browser.

---

**Related pages:**

- Working with the Office Connector
- Working with Attachments
- Confluence User's Guide

---

**On this page:**

- Option 1 — Office Connector for Confluence
- Option 2 — Gallery or Slide Show of JPEG or PNG Images
- Option 3 — Convert PowerPoint to HTML and display using the HTML Include macro (Not applicable to Confluence OnDemand.)
7. Place the HTML files into their own directory, named uniquely by the title of your presentation.
8. Find a suitable location to host these files within your web server. Confluence hosts all files within the `<my-install-directory>/confluence/directory, so a good example location for Confluence distribution users is to go to `<my-install-directory>/confluence/pages/ and create a subdirectory called `powerpoint`.
9. Move the HTML directory into the PowerPoint folder, e.g. `<my-install-directory>/confluence/pages/powerpoint/<my-presentation-name>` containing index.html, slide01.html... or similar.
10. Edit or create the page where you wish to embed the PowerPoint presentation. Add the HTML Include macro pointing to the index page of your slides. Remember that URLs are case sensitive.
11. Save the page. The index page to your slides should now appear.

Moving an Attachment

You can move an attachment from its current location to any page within the site.

To move an attachment, you need the following permissions (see Space Permissions):

- 'Add Page' permission on the page where the attachment currently exists.
- 'Add Attachment' permission on the space into which you are moving the attachment.

To move an attachment:

1. Go to the page that contains the attachment.
2. Choose Tools > Attachments.
3. Choose Properties next to the attachment.
4. Type the name of the page where you want to move the attachment into the Page field.
5. Choose Save.

Viewing Attachment Details

An attachment is any file that is included with your page. Examples of attachments are screenshots, photographs, other images, Word documents, presentations, PDF documents, videos and sound files. Attachments are useful when you want to share information that exists in another file format.

You can view attachment details in the following places:

- The list of attachments in a space. This will show all files attached to all pages in the space. See below.
- The list of attachments for a specific page. See below.
- A list of attachments created by a macro and displayed on a page. See Displaying a List of Attachments.

Viewing attachments in a space

To view the attachments associated with a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
• Choose **Content Tools > Attachments**

2. You will see a list of all the attachments in the space, along with their details and the pages they are attached to.

To see only files of a particular type:
• Type the last part of the file name in the Filter By File Extension box. For example, enter 'gif' to see only image files of the GIF format.
• Choose **Filter**.

3. To see only files that have a particular label or labels:
• Type the label or labels in the Filter by Label box. If you enter more than one label, separate the labels with commas or spaces. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.)
• Choose **Filter**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **Attachments** from the left menu.

**On this page:**
• Viewing attachments in a space
• Viewing attachments on a page
• Attachment details

**Related pages:**
• Working with Attachments
• Displaying a List of Attachments
• Confluence User’s Guide

**Screenshot: List of attachments for a space**

---

**Viewing attachments on a page**

When a page you are viewing contains attachments, a small paperclip icon  
appears next to the page byline, under the page name. Clicking the paperclip will take you to the 'Attachments' view, where you will see the full list of attachments.

**To view the attachments associated with a page:**

1. Go to the page.
2. Choose **Tools > Attachments**. You will see a list of the attachments in the page along with their details.
3. To see all versions of an attachment, choose the arrow on the left of the attachment name.

The list of attachments includes options for viewing the files, and other actions, provided the user has the relevant permissions. If you have specified the 'Allow Upload' parameter, users will be able to upload attachments directly from the list too. Users can also remove attachments or edit attachment properties and labels. If an attachment is an Office or PDF file, you will see the appropriate options for Office Connector files.

**Screenshot: List of attachments for a page**
**Attachment details**

Note that the page view shows a different subset of fields from the space view.

- **Name** is the name of the attached file.
- **Size** tells you how much space the attachment takes up. You can sort by size by clicking the column title.
- **Creator** is the person who attached the file. Clicking on the link takes you to the person’s user profile.
- **Creation Date** is the date the file was attached. You can sort by date by clicking the column title.
- **Labels** are keywords, or tags, that you can enter to categorise the attachments. See how to add labels.
- **Last Mod. Date** (in the space view) is the date the file was last modified.
- **Attached To** (in the space view) tells you which page contains the attachment.
- **Comment** (in the page view) is a short description of the attachment.
- The **Properties** link (in the page view) lets you edit the attachment details. See how to edit attachment properties.
- The **Remove** link (in the page view) lets you delete the attachment, or a specific version of the attachment.
- The **Edit in Office** link (in the page view) appears next to Office files only, and lets you edit that attachment.
- The **Attach File** option lets you add another attachment or another version of an existing attachment. See how to upload attachments.

**Customising Confluence**

You can customise or configure many aspects of Confluence:

- The **look and feel** of any Confluence space.
- **Personal aspects**, including your personal profile and homepage.
- Setting up your **user profile**.
- **User access**, including permissions and page restrictions.
- **Add-ons** such as gadgets and macros.
- Customisations for **specific uses** of Confluence.

**Related pages:**

- Configuring Confluence
- Configuring Confluence Security
- Managing Add-ons and Macros (Not applicable to Confluence OnDemand.)
- Confluence User’s Guide

**Personal Customisations**

There are several ways that you can customise the way that Confluence works for you, including:

- Your **personal home page**
- Your **personal dashboard**
- Your **personal profile**
- Your **email notifications**
- Your **RSS Feed settings**
User Profile Overview

Each Confluence user has a user profile. In your own profile, you can access account management features and updated information about yourself. You can also view other users' profiles.

**To find your user profile:**

Choose **your profile picture** at top right of the screen, then choose **Profile**.
Or, choose the **Profile** link in the sidebar of your personal space.

**To find someone else's user profile:**

1. Open the user's hover profile popup:
   - Log in to Confluence, if you have not already done so.
   - Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   - Move your mouse pointer over a user's linked name or profile picture. The hover profile popup will appear.
2. Choose the user's linked name to open the user profile.

Alternatively, you can choose the **Profile** link in the sidebar of the user's personal space or go directly to this URL:

```
http://MY.CONFLUENCE.COM/users/viewuserprofile.action?username=USERNAME
```

**Screenshot: User profile screen for the current user**
• View and edit your personal details, such as your name and email address details and optionally, your photograph and other personal information. Note that as a security precaution, in order to change your email address, you will be required to re-enter your password.

• Upload a profile picture (optional).

• Change your password.

Network

• View the recent activity of users that you are following via the Network view.

• Follow other users from this view.

Status Updates

• View your history of status updates.

Favourites

• View a list of your favourite spaces.

Watches

• View a list of the pages and spaces you are currently watching.

Drafts

• Retrieve any pages you were in the process of editing. See Working with Drafts.

Settings

• Edit your General Settings (homepage, language and timezone).

• Subscribe to email notifications.

• View and revoke your OAuth access tokens.

Notes

The ‘Administer User’ link is visible to Confluence administrators only. The administrator can click this link to go directly to the user management screen in the Administration Console.

Changing Password

To change your Confluence password:

1. Choose your profile picture at top right of the screen, then choose Profile.
2. On your Profile tab, click Password in the left-hand column.
3. Enter your current password and your new password in the form displayed.
4. Click Submit.

Related Topics

Viewing User Profile
Editing Your User Profile
Choosing a Profile Picture
Setting Up your Personal Space
Updating Email Address
Email Address Privacy

Take me back to the Confluence User’s Guide.

Editing User Settings

You can set various Confluence preferences that affect your personal session:

• General preferences such as home page, language and time zone, as described below.

• Editor settings, as described below.
Email settings for subscriptions to email reports. See Subscribing to Email Notifications of Updates to Confluence Content.

OAuth access tokens that you have granted from your Confluence user account. See Viewing and Revoking OAUTH Access Tokens.

General User Preferences

To edit your general user settings:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click Edit and update the settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site Homepage</td>
<td>Select the page that you would like to see whenever you log into Confluence.</td>
</tr>
<tr>
<td>Language</td>
<td>Select your language. See below.</td>
</tr>
<tr>
<td>Time zone</td>
<td>Select your time zone.</td>
</tr>
<tr>
<td>Use Keyboard Shortcuts</td>
<td>Enable keyboard shortcuts, other than for the editor.</td>
</tr>
</tbody>
</table>

3. Click Submit.

On this page:

- General User Preferences
- More about Language
- Editor Preferences

Related pages:

- Editing Your User Profile
- Choosing a Profile Picture
- Setting Up your Personal Space
- Email Address Privacy
- Using Autocomplete
- Confluence User’s Guide

Screenshot: Editing your user profile settings
More about Language

Setting your language preference in your user profile is described in the section above. This section gives more information about that setting and other settings that affect the language Confluence will use.

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from highest to lowest:

- The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
- The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too. Not applicable to Confluence OnDemand.
- The language set in your browser.
  - Note that your Confluence administrator can disable this option by setting a system property. Not applicable to Confluence OnDemand.
  - The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list.
- The default language for your site, as defined by your Confluence site administrator.

Editor Preferences

You can set some options that determine the way the Confluence editor works. Note that these settings affect only you. Other people using Confluence can enable or disable the settings on their user profiles independently.

To change your editor preferences:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click Editor under 'Your Settings' in the left-hand panel.
3. Click Edit.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
4. Click Submit.

Screenshot: User settings for the editor

Editing Your User Profile

Your user profile contains basic information about you. If you do not have a personal space, your user profile will be displayed when anyone clicks your name in the People Directory.

To edit your user profile:

1. Choose your profile picture at top right of the screen, then choose Profile.
   Or, choose the Profile link in the sidebar of your personal space.
2. Choose Edit Profile.
3. Enter details about yourself in the form displayed.
4. Click Save.

Related pages:
- Viewing User Profile
- Choosing a Profile Picture
- Setting Up your Personal Space
- Email Address Privacy
- Confluence User's Guide.

<table>
<thead>
<tr>
<th>Detail</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full Name</td>
<td>Your name as you would like it to appear in your profile.</td>
</tr>
<tr>
<td>Email</td>
<td>Your email address which will be used to send you mail notifications.</td>
</tr>
</tbody>
</table>
Phone | Your phone number.

IM | Your Instant Messenger (IM) details. To suit a variety of IM applications, this option accepts any string value. For example, you can enter IM details in the form of an email address, such as ‘example@atlassian.com’ or a user ID, like ‘123456789’.

Website | Your website’s URL.

About me | Information about yourself that other users can view (such as your professional information, hobbies, and other interests). You can use Confluence wiki markup in this field.

Position | The title of your position within your organisation.

Department | The name of your department within your organisation.

Location | Your location. This could be a town, city, region or country.

**Handy Hint**
Confluence administrators can configure Confluence to mask email addresses (e.g. ‘example@atlassian.com’), protecting your email address from search engine spiders and the like.

Email Address Privacy
Confluence can mask the email addresses of users to protect them from mail spammers.

This is done by a Confluence administrator and is configured through the Administration Console. The Confluence administrator has three options for email address privacy:

- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Private**: only Confluence administrators can see the email addresses.

For more information on setting these options, which are configured using the Administration Console, refer to [User Email Visibility](#). *Not applicable to Confluence OnDemand.*

**Related pages:**
- [Editing Your User Profile](#)
- [Viewing User Profile](#)
- [User Email Visibility](#) (*Not applicable to Confluence OnDemand.*)
- [Confluence User's Guide](#)

Updating Email Address
The email address you specify in your profile settings is used for your mail notifications and is also displayed in your profile description.

**To update your email address:**

1. Choose your profile picture at top right of the screen, then choose Profile.
2. Click Edit in the 'Personal' section.
3. In the Email field, specify your new email address which will be used when sending you mail notifications.
4. Click **Save**.

Related Topics

**Changing Password**

**Editing Your User Profile**

Take me back to the **Confluence User's Guide**.

**Choosing a Profile Picture**

Your profile picture is used as the icon for your personal space, to represent you in the People Directory, and to illustrate your comments. It also appears in various other places next to your name, such as in the list of recent updates on the dashboard.

You can upload your own profile picture or use one of the images provided by Confluence. If you upload your own profile picture, you will have an opportunity to crop (trim) the picture.

**To choose a profile picture:**

1. Choose your profile picture at top right of the screen, then choose **Profile**.
2. Click **Picture** on the left.
3. Choose one of the following two options:
   - Upload a new picture: Click **Browse** to locate your picture, then click **Upload** to upload it from your computer or file server.
   - Or select one of the default icons provided.
4. Click **Set Profile Picture**.

---

**On this page:**

**Related pages:**

- Deleting a Profile Picture
- Editing Your User Profile
- Setting Up your Personal Space
- Confluence User's Guide

---

**Screenshot: Choosing a profile picture**

If you upload a profile picture that is larger than 48x48 pixels, the 'Edit My Profile Picture' screen will appear. You can select part of the picture or the entire picture, to be used as the final image for your profile. Note that the size
of the final image will always be scaled down to 48x48 pixels.

**To edit your profile picture:**

1. Click and drag the centre of the superimposed square to select the centre of the new image.
2. Click the corners of the square to resize the area for your new image.
3. Click **Save**.
4. The image from your selected area will be cropped, resized to 48x48 pixels and saved.

**Screenshot: Trimming a profile picture**

Deleting a Profile Picture

You can delete the profile picture images that you have uploaded to Confluence.

**To delete a profile picture:**

1. Choose your profile picture at top right of the screen, then choose Profile.
2. Click Picture on the left.
3. Locate and select the picture file you wish to delete, then click **Delete**.
   
   *Note that you can only delete images that you have uploaded to Confluence. The standard icons cannot be deleted.*
4. Click **Delete** to confirm the action. The picture is permanently removed from the server.

**Related pages:**

- Choosing a Profile Picture
- Editing Your User Profile
- Setting Up your Personal Space
- Confluence User's Guide.

**Screenshot: Deleting a Profile Picture**
Viewing User Profile

Each Confluence user has a user profile. In your own profile, you can access account management features and update information about yourself. You can also view other users' profiles, add them to your network, and add their personal spaces to your list of favourites.

To find your user profile:

Choose your profile picture at top right of the screen, then choose Profile.
Or, choose the Profile link in the sidebar of your personal space.

To find someone else's user profile:

1. Open the user's hover profile popup:
   • Log in to Confluence, if you have not already done so.
   Note: If a Confluence Administrator has granted the 'View User Profiles' permission to anonymous users, you can access people's hover profile popups without logging in. However, the hover profile features available to anonymous users are restricted.
   • Move your mouse pointer over a user's linked name or profile picture. The hover profile popup will appear.

2. Choose the user's linked name to open the user profile.

Alternatively, you can choose the Profile link in the sidebar of the user's personal space or go directly to this URL:

http://MY.CONFLUENCE.COM/users/viewuserprofile.action?username=USERNAME

Related pages:

• User Profile Overview
• Setting Up your Personal Space
• Confluence User's Guide

Screenshot: User profile for the current user.
Updating your profile

You can update the following aspects of your profile from this view:

- **Information about yourself** – see Editing Your User Profile.
- **Your Profile picture** – see Choosing a Profile Picture.
- **Your login password** – see Changing Password.

Viewing and Revoking OAuth Access Tokens

This page describes the purpose of OAuth access tokens which have been issued on behalf of your Confluence user account and provides instructions on how to revoke them.

On this page:

- **OAuth Access Tokens**
- Viewing your OAuth Access Tokens
  - OAuth Access Token Details
- Revoking your OAuth Access Tokens

OAuth Access Tokens

OAuth access tokens allow you to use a Confluence gadget on an external web application or website (also known as the 'consumer') and grant this gadget access to Confluence data which is restricted or privy to your Confluence user account.

OAuth access tokens will only appear in your user profile if the following conditions have been met:

1. Your Confluence Administrator has established an OAuth relationship between your Confluence site and the consumer.
   Confluence Administrators should refer to Configuring OAuth for more information about establishing these OAuth relationships. Not applicable to Confluence OnDemand.
2. You have accessed a Confluence gadget on the consumer and have conducted the following tasks:
   a. Logged in to your Confluence user account via the gadget and then,
   b. Clicked the 'Approve Access' button to allow the gadget access to data that is privy to your Confluence user account.

   Confluence will then send the consumer an OAuth 'access token', which is specific to this gadget. You can view the details of this access token from your Confluence site's user account.

   An OAuth access token acts as a type of 'key'. As long as the consumer is in possession of this access token, the Confluence gadget on the consumer will be able to access Confluence data that...
is both publicly available and privy to your Confluence user account. As a Confluence user, you can revoke this access token at any time. Furthermore, all access tokens expire after seven days. Once the access token is revoked or has expired, the Confluence gadget will only have access to publicly available Confluence data.

Viewing your OAuth Access Tokens

To view all of your Confluence user account's OAuth access tokens:

1. Choose your profile picture at top right of the screen, then choose Settings.
2. Click View OAuth Access Tokens. A view similar to screenshot below is displayed. Refer to OAuth Access Token Details below for information on interpreting this table.
   ![Screenshot: Viewing your OAuth Access Tokens](image)
   
   If no access tokens have been set, then 'None specified' is shown.

OAuth Access Token Details

Your list of OAuth access tokens is presented in a tabular format, with each access token presented in separate rows and each property of these tokens presented in a separate columns:

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumer</td>
<td>The name of the Confluence gadget that was added on the consumer.</td>
</tr>
<tr>
<td>Consumer Description</td>
<td>A description of this consumer application. This information would have been obtained from the consumer's own OAuth settings when an OAuth relationship was established between Confluence and that consumer. If the consumer is another Atlassian application, this information is obtained from the Consumer Info tab's 'Description' field of the OAuth Administration settings. The application's administrator can customise this Consumer Info detail.</td>
</tr>
<tr>
<td>Issued On</td>
<td>The date on which the OAuth access token was issued to the consumer by Confluence. This would have occurred immediately after you approved this gadget access to your Confluence data (privy to your Confluence user account).</td>
</tr>
<tr>
<td>Expires On</td>
<td>The date when the OAuth access token expires. This is seven days after the 'Issued On' date. When this date is reached, the access token will be automatically removed from this list.</td>
</tr>
<tr>
<td>Actions</td>
<td>The functionality for revoking the access token.</td>
</tr>
</tbody>
</table>
Revoking your OAuth Access Tokens

To revoke one of your OAuth access tokens:

1. View your Confluence user account’s OAuth access tokens (described above).
2. Locate the Confluence gadget whose OAuth access token you wish to revoke and click **Revoke OAuth Access Token** next to it.
   The gadget’s access token is revoked and the Confluence gadget on the consumer will only have access to publicly available Confluence data.

Choosing your Home Page

By default, all users are directed to the dashboard after logging in. However, you can choose to be redirected to the home page of any space on the Confluence site after logging in.

To set the home page:

1. Choose your profile picture at top right of the screen, then choose **Settings**.
2. Choose **Edit**.
3. Choose a page from the **Site Homepage** drop down. Only spaces for which you have ‘view’ access display. You will be directed to the home page of the selected space when you next log in.
4. Click **Submit**.

Related pages:
- User Profile Overview
- Confluence User’s Guide

Customising your Personal Dashboard

You can customise the Confluence dashboard to provide access to the content on the site that is most relevant to you. The options described on this page will change your own personal dashboard, but will not affect the dashboard that other people see.

If you have System Administrator permissions, you can change the global dashboard, as seen by all Confluence users. See the administrator’s guide to customising the dashboard. Not applicable to Confluence OnDemand.
**Displaying your favourite spaces**

Mark some spaces as favourites. You can now choose the **Spaces** tab on the dashboard to see a list of your favourite spaces. You can also choose the **Favourite Spaces** tab at the top right of the dashboard to see recently updated content from just your favourite spaces.

**Categorising your spaces**

To help keep Confluence spaces organised, you can label spaces with different space categories. See Using Labels to Categorise Spaces. Space categories are used to group related spaces.

For example, you might want to group spaces on your Confluence site by applying the following space categories to the relevant spaces:

- 'design' (for spaces relevant to a design team), and
- 'development' (for spaces relevant to a development team).

If a subset of these spaces is relevant to both teams, apply both the 'design' and 'development' categories to each of these spaces to make the spaces appear in both groups.

Once you have added space categories, you can choose the **Space Categories** tab at the top right of the dashboard and select a category from the drop-down menu to display only spaces belonging to that category.

---

**On this page:**

- Displaying your favourite spaces
- Categorising your spaces
- Displaying your favourite pages

**Related pages:**

- Working with Confluence Labels
- Working with Favourites
- Configuring the Site Home Page
- Customising the Confluence Dashboard
- Confluence User's Guide

---

**Displaying your favourite pages**

Mark some pages as favourites. You can now choose the **Pages** tab on the dashboard to see a list of your favourite pages.

**Screenshot: The dashboard, showing favourite pages and space categories**
Customising the Look and Feel of a Confluence Space

You can customise the 'look and feel' of a space on your Confluence site through options available in the Space Administration menu. By default, the look and feel of a space is based on site-wide settings configured from the Administration Console.

You need to be a space administrator to change the look and feel of a space.

- Applying a Theme to a Space
- Configuring a Sidebar
- Changing a Space's Logo
- Changing the Confluence Browser Icon, aka favicon
- Customising Space Layouts
- Editing a Space's Colour Scheme
- Styling Confluence with CSS

**Related pages:**
- Changing the Look and Feel of Confluence
- Working with Spaces
- Confluence User’s Guide

Applying a Theme to a Space

Themes allow you to personalise the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site or to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. In addition, a site administrator can install new themes as plugins via the Confluence Administration Console. Provided that the theme is installed into your Confluence site, any space administrator can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.
To apply a theme to a space:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).

2. Choose **Look and Feel > Themes**.
3. Select a theme option.
4. Choose **Confirm**.

**Screenshot: Applying a theme**
If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Themes** from the space administration options

3. Select a theme option.

4. Choose **Confirm**.

**Configuring the Documentation Theme**

The Documentation theme is one of the themes bundled with Confluence.

---

**Advance warning of plans to merge Documentation theme with the default theme**

This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, to be introduced in Confluence 5.0, includes a sidebar with contextual navigation. (For a preview, see the [Confluence 5.0-m9 release notes](#).) Our plan is to include all the features of the Documentation theme into the default theme, and then remove the Documentation theme from Confluence.

If you are interested in this change and would like to give us feedback, please add a comment on this blog post: Advance warning of plans to merge Documentation theme with the default theme. We are especially interested to know which features of the Documentation theme you use and value the most.

---

The Documentation theme is designed for spaces containing technical documentation, but you may find it useful for other types of content too. It provides an inbuilt table of contents for your wiki space, a configurable header and footer, and text styles suited to documentation. (See features below.)

**Quick guide to applying and customising the Documentation theme:**

- Go to **Space Admin** and choose **Themes**.
- Select **Documentation Theme** and choose **Confirm**.
- If you want to customise the theme, choose **Configure theme**.
  - Select or deselect the default page tree.
  - Select or deselect the space-restricted search.
  - Enter the text and wiki markup for your custom left-hand panel header and footer.
  - Choose **Save**.

The rest of this page gives more details of the above procedure.
Applying the Documentation theme to your space

You need space administrator permissions to apply a theme to a space.

Follow the steps below to apply the Documentation theme to your space. All pages in the space will start using the theme immediately.

**To apply a theme to a space:**

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.
3. Choose **Look and Feel > Themes**.
4. Select a theme option.
5. Choose **Confirm**.

*Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).*
If your space is using the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).

2. Choose **Themes** from the space administration options
3. Select a theme option.
4. Choose **Confirm**.

### Applying the Documentation theme to your site

If you have site administrator permissions, you can apply the theme at site level. It will then be the default theme for all spaces in the site. See the administrator's guide to applying a theme.

### Customising the Documentation theme

The theme works well without any customisation. If necessary, you can restrict the search to just one space, change the content of the left-hand navigation panel and add your own header and footer.

### To customise the Documentation theme:

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   
   *Note:* This option appears only if you are a space administrator for the space or you are a super user (a member of the `confluence-administrators` group).

2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

3. Choose **Themes** in the left-hand panel under the heading 'Look and Feel'.
3. If the space is not yet using the Documentation theme, apply the theme as described above.
4. Choose Configure theme in the yellow area of the ‘Current Theme’ section at the top of the page. See screenshot below. The ‘Documentation Theme Configuration’ screen appears. See screenshot below.
5. Select or deselect the Page Tree check box. This determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
6. Select or deselect the Limit search results to the current space check box.
   - If you select the check box:
     - The Confluence search will look for matches only in the current space by default. Users can override this restriction when entering their search term. See Using the Documentation Theme.
     - The default page tree in the left-hand panel will not include a search box.
   - If you do not select the check box:
     - The Confluence search will look for matches in the entire Confluence site. This is the default behaviour for other themes too.
     - The default page tree in the left-hand panel will include a search box, which restricts search results to the current space.
7. Enter text, images, macros and other wiki markup into any or all of the three text boxes.
   - You can use the Include or Excerpt Include to include re-usable content into your footer. See hint below.
   - ‘Navigation’ – This text box contains content for the left-hand panel.
     - If the Page Tree check box is selected, the navigation panel contains the default search box and page tree. Any content you enter into the ‘Navigation’ text box will appear above the page tree and search box.
     - You can include your own content underneath the page tree as well as above. See hint below. In summary: Deselect the Page Tree check box. Insert your own page tree using the Page Tree macro, then add your own content under the macro.
   - ‘Header’ – This text box contains content for a page header that will appear above the page title on all pages in the space. See example screenshot below.
   - ‘Footer’ – This text box contains content for a page footer that will appear after the comments and above the site footer, on all pages in the space. See example screenshot below.
8. Choose Save.

Screenshot: The ‘Configure theme’ option
Current Theme

The current theme controls the layout and colours of this space.

**Documentation Theme**

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer.

**Configure theme** - further customise this theme's options

Choose New Theme

To change the theme of this space, select one below.

- **Global Look and Feel**
  The globally configured look and feel. You can customise colour-schemes and layouts manually.

Find more themes...

Confirm

Screenshot: Customising the Documentation theme
Customising the theme at site level

If you have site administrator permissions, you can apply and customise the theme at site level. The customisation options are the same as the space level options, as described above.

Features of the Documentation theme

Screenshot: A customised header, footer and left-hand panel
The above screenshot shows a wiki space with a customised left-hand panel, header and footer.

Here is a summary of the features that the Documentation theme provides:

• By default, the left-hand panel contains a search box and a table of contents (page tree) showing all the pages in your space. Specifically, it shows the pages that are children of the space’s home page.

• The left-hand panel is fully customisable. You can choose to include or exclude the search box and page tree. You can enter your own text, images and wiki markup.

• People viewing the page can drag the thick bar between the left-hand panel and the content, to increase or decrease the width of the panel. They can also remove the panel altogether, by clicking the sidebar icon at top right, next to the search box.

• The left-hand and right-hand panels scroll independently of each other.

• The page title is neatly above the page content, and not uncomfortably above the navigation panel as tends to happen when you insert the navigation panel yourself.

• Because the left-hand panel is part of the theme, it will be upgraded whenever Confluence is upgraded. There is no need to remove and then re-apply your customisations on each upgrade, as you would do if you added your own left-hand navigation bar.

• The theme also provides a customisable header and footer, which will appear at the top and bottom of every page.

• The text and heading styles are designed to enhance the content typically found in a documentation space.

• You can use the Space Jump macro to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link.

• You can limit the Confluence search results to the current space. If you choose this option, the Confluence search will look for matches only in the current space by default. Users can override the restriction. See Using the Documentation Theme.
Hints and tips

Below are some hints that you may find useful when using the Documentation theme.

Where can I see a working example of the Documentation theme?

The Confluence documentation uses the Documentation theme. If you are reading this documentation online on the Atlassian documentation wiki, you are seeing a working version of the Documentation theme.

Which pages will appear in the Documentation theme’s table of contents?

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page. Each space has a single page designated as the ‘Home’ page. You can specify the home page in the space administration section.

Help, my pages do not appear in the Documentation theme table of contents

Cause 1: Your pages are not under the space’s home page. The most probable reason why your pages do not appear in the page tree in the left-hand panel is this: The theme constructs that table of contents from all pages that are child pages of the space’s home page. If your pages are above the home page in the page tree, they will not appear in the left-hand panel.

There are two ways to fix the problem:

- You can change the designated space home page in the space administration section.
- Or you can drag and drop all your pages to make them children of the current home page. You can drag and drop pages in the ‘Pages’ section of the space ‘Browse’ screen. See Moving a Page.

Cause 2: Problem with upgrade from Confluence 3.1, with Documentation theme as plugin, to Confluence 3.2 or later with Documentation theme bundled. If your existing Confluence installation already has the Documentation theme plugin installed, you may find that after upgrading to Confluence 3.2 the left-hand navigation bar is empty in the spaces that use the theme. The fix is to enable all modules of the Documentation theme plugin. See the knowledge base article.

Help, my left-hand panel has disappeared

If your entire left-hand panel has disappeared when using the Documentation theme, this is probably because you have clicked the sidebar icon at top right, next to the search box. Click the icon again to restore the panel.

Can I change the default width of the left-hand navigation panel?

The Confluence user interface does not offer a way to change the default width of the left-hand navigation panel supplied by the Documentation theme. Users can change the width by dragging the middle bar, but the default width is not configurable. This post on Atlassian Answers gives a way to do it with CSS: Documentation Theme - Default Width (in px) of left panel.

Hiding pages from the left-hand table of contents

You can ‘hide’ pages by putting them at the same level as or higher than the space home page.

Each space has a single page designated as the ‘Home’ page. You can specify the home page in the space administration section.

The theme constructs the page tree in the left-hand panel from all pages that are child pages of the space’s home page.

If your documentation pages are at the same level as the space home page, they will not appear in the left-hand navigation bar. So you can ‘hide’ pages by putting them at the same level as or higher than the space home.
page. The pages will show up in the search results and people can see the content if they open the page, but the pages will not appear in the left-hand panel.

More detail: The theme uses the Pagetree macro to produce the table of contents. When entering the Pagetree macro, you can choose the top page in the page tree. The Documentation theme chooses the space home page as the top page.

Using reusable content in your header, footer or left-hand panel

You can use any text or wiki markup in your theme header, footer or left-hand panel. One useful hint is to use the Include or Excerpt Include to include re-usable content into your footer.

The screenshot above shows the theme customisation options, with examples of the macros used to include content from other pages. And the example screenshot also above shows the resulting header, footer and left-hand panel.

Adding content below the page tree in your left-hand panel

If you want to include your own content underneath the page tree, you can deselect the 'Page Tree' check box, add your own page tree using the Pagetree macro in the 'Navigation' text box, and then add your own content under the macro.

The screenshot above shows the theme customisation options, with the default page tree deselected and a custom page tree inserted, along with additional content in the left-hand panel. The example screenshot also above shows the resulting left-hand panel.

Adding underlines to your links

By default, the Documentation theme does not underline hyperlinks. If you prefer to have your links underlined, you can edit the CSS stylesheet for your space and add the following CSS code:

```
.wiki-content a:link, .wiki-content a:visited, .wiki-content a:active {
  text-decoration: underline;
}
```

To edit a space’s CSS style sheets:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Look and Feel > Stylesheet.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.

   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

Notes:
- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to Confluence Admin > Security Configuration and choose Custom Stylesheets for Spaces.

Jumping to the same page in another space

The {spacejump} macro is provided along with the Documentation theme. You can use space jumping to link from a page in one wiki space to a page with the same name in another space, without knowing the name of the page when you create the link. When a reader is viewing a page and chooses the link provided by the macro, they will go to a page with the same name, but in the space specified in the macro. See more about the Space Jump macro.

Hiding the left-hand panel completely

It's not possible to remove the left-hand panel entirely, using the user interface supplied by the theme. There is an improvement request here: ![CONF-25923 - Authenticate](https://jira.atlassian.com/browse/CONF-25923) to see issue details. If you like, you can comment on and/or vote for that request. In the meantime, Atlassian Answers is a good place to ask the question and see if other people can help you with custom code to remove the panel.

Notes
- The Confluence default theme supplies a sidebar, which is different to the left-hand panel in the Documentation theme. For information about the sidebar, see Finding Content and Configuring a Sidebar.
- The Documentation theme supplies a Browse menu in the Confluence header, which gives access to the space administration and advanced options.

Configuring a Sidebar

This guide describes the sidebar on the left of every page in spaces that use the default Confluence theme. For spaces using the Documentation theme, see Configuring the Documentation Theme.

**Hint for space administrators:** Add links to the sidebar, pointing to pages and other locations that are important for your team or project. This is a great way of encouraging collaboration and improving productivity.

You need space administrator permissions to configure the sidebar. See Space Permissions. Any changes you make to a space's sidebar will affect all Confluence users viewing the space.

**To configure a space's sidebar:**

1. Open the sidebar configuration panel, as follows:
   - Make sure the space uses the default Confluence theme. See Applying a Theme to a Space.
   - Go to a page in the space and choose Configure sidebar in the sidebar. (Expand the sidebar if necessary, to see the 'Configure sidebar' option.)
   Note: The ‘Configure sidebar’ option will only appear if you have space administration permissions.

2. Change the space name and/or space logo:
   - Choose the edit icon next to the space name.
   - Type in a space Name.
   - Browse to find an image for the space Logo, and crop the image to the required size.
   - Choose Save.

3. Configure the Pages and Blog links:
   - Choose the icons to hide or show the 'Pages' or 'Blog' link. For example, you may want your space to be used primarily as a blog (hide the 'Pages' link) or you may not need a blog in your space (hide the 'Blog' link).
   - Drag the links to a different sequence within the section. Note that you cannot move a link from one section to another.
   - Note that add-ons may add other links in this section of the sidebar. For example, the Team...
Calendars add-on may put a link in this location.

4. Configure the **shortcut links**:
   - Choose **Add link** to add a shortcut link to the sidebar. This can be a link to an important page for your team, or to an external site, for example.
   - Choose the icon to **remove** a shortcut link.
   - Drag the links to a different sequence within the section. Note that you cannot move a link from one section to another.

### Related pages:
- Finding Content
- Administering a Space
- Confluence User’s Guide

**Diagram: Configuring a space’s sidebar**

**Notes**

If you choose to hide the Pages and Blogs links in the sidebar your users may not be able to access some functionality such as **Watch this space** and **Watch this blog**.

**Changing a Space’s Logo**

In Confluence, you can replace the default logo for a space with an image of your choice. The instructions below apply to site spaces. For your personal space, your **profile picture** is used as the space icon.

You need to be a **space administrator** to replace a space’s logo.

**To change a space’s logo, in spaces using the default theme:**

1. Open the sidebar configuration panel, as follows:
   - Make sure the space uses the default Confluence theme. See **Applying a Theme to a Space**.
   - Go to a page in the space and choose **Configure sidebar** in the sidebar. (Expand the sidebar if necessary, to see the 'Configure sidebar' option.)
   
   **Note:** The ‘Configure sidebar’ option will only appear if you have space administration permissions.

2. Choose the edit icon next to the space name.
3. Choose **Choose File**.
4. Browse to find and upload an image.
5. Adjust the size of the highlighted circle on the image, to crop the image to the required size.
6. Choose **Save**.

**To change a space’s logo, in spaces using the Documentation theme:**

1. Choose **Browse > Space Admin** at the top of the screen.

   **Note:** The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Change Space Logo in the left-hand panel.
3. Use the browse option to locate the new logo and choose Upload.

Related pages:
- Configuring a Sidebar
- Customising the Look and Feel of a Confluence Space
- Confluence User's Guide

Screenshot: Changing a space logo in the default theme

Notes

- **Dimensions of image when using the Documentation theme**: A space logo in the Documentation theme looks best if the height and width of the image are of the same or similar length. In other words, the area occupied by the image, including white space, should be square rather than rectangular.
- **Space logos in the default theme are circular.**

Changing the Confluence Browser Icon, aka favicon

The Confluence logo is displayed in the user's browser to identify the Confluence browser tab. To use a custom image for your Confluence site:

1. Obtain or create an image in ICO file format. To maximise browser compatibility, it should be 32x32 pixels in size, 71x71 DPI (dots per inch) and have an 8 bit colour depth.
2. Inside the root of your Confluence installation directory, find the confluence subdirectory.
3. Back up the file favicon.ico.
4. Replace the favicon.ico file with your custom ICO image.
5. Restart your application server.

⚠️ The information on this page does not apply to Confluence OnDemand.

Users may need to clear their browser cache before they will see the new image. This can be done by pressing ctrl+refresh in the browser when a page in Confluence is open.
Related Topics

Customising the Look and Feel of a Confluence Space
Customising Space Layouts

You can modify Confluence's look and feel by editing the 'decorator' (layout) files. This page tells you how to customise the layout files for a space.

Confluence system administrators can also customise the layout of their entire Confluence site as a whole. For more information, please refer to Customising Site and Space Layouts. Site layout customisations modify the default layout of all spaces in the Confluence site. Not applicable to Confluence OnDemand.

Any space layout customisations will override the equivalent site customisations.

A note about permissions: To perform these customisations, you will require space administrator permissions for that space. For security reasons, you must also have Confluence system administrator permissions to modify any space layout throughout your Confluence site.

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through 'decorators' that define a page's layout and structure.

To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a very simple programming language called Velocity. Learn more about Velocity. Once you become familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, if you want to make changes to the header and the footer, you will need to modify these layouts.

- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but they allow you to alter the way the surrounding comments or attachments are shown.

- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.

Learn more about using decorators.

To edit a decorator file:

1. If this space has the Default theme applied, go to the space and choose Space tools on the...
sidebar.

- If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

**Note**: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Look and Feel > Layout** (Layout is displayed only if you are a Confluence system administrator.)

3. You will see a list of the layouts for the space.
   - Click **View Default** to view the vmd file.
   - Click **Create Custom** to edit the default vmd file. This will open up the vmd file in edit mode. Make changes and click **Update**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.

   **Note**: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Layout** in the left-hand panel (Layout is displayed only if you are a Confluence system administrator.)

3. You will see a list of the layouts for the space.
   - Click **View Default** to view the vmd file.
   - Click **Create Custom** to edit the default vmd file. This will open up the vmd file in edit mode. Make changes and click **Update**.

**Screenshot : Edit Layouts Example**

<table>
<thead>
<tr>
<th>Decorator</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Expert Layout</td>
<td>`&lt;default&gt;</td>
</tr>
<tr>
<td>Page Expert Layout</td>
<td>`&lt;default&gt;</td>
</tr>
</tbody>
</table>

Click the thumbnail to see an example of a vmd file:

Editing a Space's Colour Scheme

Confluence allows you to customise the colour scheme of a space. By default, a space's colour scheme is based on global settings configured from the Administration Console.

You need to be a space administrator to edit a space's colour scheme.
Related pages:
- Customising the Look and Feel of a Confluence Space
- Confluence User's Guide

To change the colour scheme for a space:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Look and Feel > Colour Scheme
3. Choose Select next to a scheme listed under Custom Colour Scheme (if not already selected).
4. Choose Edit.
5. Enter standard HTML/CSS2 colour codes, or use the colour-picker to choose a new colour from the palette provided. Any changes you make will immediately be reflected in this space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.

   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Colour Scheme under the heading Look and Feel.
3. Follow the steps above to select a custom colour scheme and edit the colours.

The colour scheme allows you to edit the colours of UI elements including the top bar, tabs and backgrounds.

Some UI elements below are for specific themes, and colour changes may not take effect for other themes.

- **Top Bar** - the top navigation bar background
- **Top Bar Text** - the text on the top navigation bar
- **Header Button Background** - buttons on the top navigation bar (e.g. Create button)
- **Header Button Text** - the text on buttons on the top navigation bar
- **Top Bar Menu Selected Background** - background colour of top navigation bar menu items when selected (e.g. spaces)
- **Top Bar Menu Selected Text** - text colour of top navigation bar menu items when selected
- **Top Bar Menu Item Text** - text on top navigation bar drop down menus (e.g. help or cog)
- **Menu Item Selected Background** - highlight colour on top navigation bar drop down menu items
- **Menu Item Selected Text** - text colour on highlighted top navigation bar drop down menu items
- **Page Menu Selected Background** - the background colour of the drop down page menu when selected
- **Page Menu Item Text** - the text of the menu items in the drop down page menu
- **Heading Text** - all heading tags throughout the space
- **Space Name Text** - the text of the current space name located above the page title
- **Links** - all links throughout the space
- **Borders and Dividers** - table borders and dividing lines
- **Tab Navigation Background** - the background colour of the tab navigation
- **Tab Navigation Text** - the text of the tab navigation when highlighted
- **Tab Navigation Background Highlight** - the background colour of the tab navigation when highlighted
- **Tab Navigation Text Highlight** - the text of the tab navigation elements when highlighted

Screenshot: Editing the colour scheme
Styling Confluence with CSS

This page explains the facility for changing the look and feel of Confluence with CSS.

Introduction

Cascading Style Sheets (CSS) are an industry-standard way of styling a web page. The content of a page is
rendered with HTML, and its look and feel is determined by CSS files. You can upload a CSS text file, or simply type in a stylesheet, and apply it to a space or even a whole Confluence site.

Notes:
- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to Confluence Admin > Security Configuration and choose Custom Stylesheets for Spaces.

Creating CSS styles that work seamlessly across different browsers is a delicate task for basic web sites, and reasonably challenging when customising web applications like Confluence. It is important to test each change that you make and ensure it works as expected in all areas of Confluence – for example, on the Confluence dashboard as well as on regular pages.

In order to get you started, we have compiled this introduction, a basic styling tutorial.

On this page:
- Introduction
- Considerations for Using Custom CSS
- Getting Started
- CSS Resources

Related pages:
- Basic Styling Tutorial
- Styling Fonts in Confluence
- Confluence User's Guide

The information on this page does not apply to Confluence OnDemand.

Considerations for Using Custom CSS

CSS Knowledge is Required

If you are not familiar with CSS, see the links in the CSS Resources section below. You should spend some time to become confident with Cascading Style Sheets before you start editing your Confluence style sheets.

Security

Custom CSS can be used to inject scripts into a page, opening the risk of cross-site scripting (XSS) attacks. With this feature enabled, space administrators could upload styles that steal other users’ login credentials, trick their browsers into performing actions on the wiki without their knowledge, or even obtain global administration privileges. As such, this feature is disabled by default. Confluence administrators should only enable custom CSS if they are comfortable with the risks listed in this paragraph.

Scaling

Each page needs to scale. Depending on the resolution of the user's screen, the content should render intelligently. Your designs needs to degrade gracefully. Try resizing each page that exists in Confluence. There are quite a few pages in the browse-space-section, like drafts, labels, page hierarchy, and so on. Your style has to work everywhere, not just in the first page you happen to be looking at.

Features Cannot Be Disabled

It is easy to turn off certain links, headers, or even menu items by simply setting their style to 'hidden'. This can help you to roll out Confluence to users that may not be very Wiki-savvy yet. The simpler the UI, the easier it may be for them to use. However, please remember that removing the link to a part of the application does not mean that the functionality is not available. Every user can still change their style from within their browsers, or access the URL directly. Don't rely on CSS to disable parts of Confluence.

Features Should Not Be Disabled

Users familiar with Confluence will expect to find the same controls that they are accustomed to. Removing
buttons or controls from the interface is not advised as it may frustrate your users and cause them to circumvent your design by using direct URL access, as mentioned above.

Confluence Version Compatibility

Be aware of any plans to upgrade your Confluence instance. Future versions of Confluence may not be compatible with your custom CSS — this may cause your CSS to break, requiring maintenance when Confluence is upgraded. Ask your Confluence administrator for more information.

Test on Different Web Browsers

As a rule you should test your modifications on different web browsers. Internet Explorer, Firefox, Opera and Safari (on Mac OS X) are some of the more popular browsers.

Note about supported web browsers: Please ensure that you are using one of the web browsers supported by Confluence. If you are using an unsupported browser or browser version, some features may not work correctly. You can find the list of supported web browsers and browser versions on this page: Supported Platforms.

CSS Customisation is Not Supported

As creating custom CSS has potentially limitless possibilities, Atlassian will not support issues that are caused by or related to CSS customisation.

Gotting Started

Editing the CSS

To edit a space’s CSS style sheets:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
2. If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.
   
   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. Choose Look and Feel > Stylesheet.
4. Choose Edit.
5. Paste your custom CSS into the text field.
6. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

To edit your global CSS stylesheet:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Stylesheet.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Choose Save.

Note:
The new CSS will be visible across all spaces, provided they do not define their own custom stylesheet and are not using a theme. This CSS will also overwrite all styles defined in custom global themes.

You may be able to add CSS to your site by choosing Custom HTML in the administration section, and adding your CSS definitions to the HEAD or BODY of the page. You should only use this option if you cannot achieve the desired results via the global stylesheet.

Follow the Tutorial

Follow the examples in the Basic Styling Tutorial to get started.

CSS Resources

- W3C CSS Standards
- W3schools CSS Introduction
- Mozilla Developer Network
- W3resource.com

This page contains instructions on how to get started with custom CSS styling in Confluence.

CSS Editing Quick-Start

To edit a space's CSS style sheets:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.
   
   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose Look and Feel > Stylesheet.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Click Stylesheet in the left-hand panel under the heading 'Look and Feel'.
3. Choose Edit.
4. Paste your custom CSS into the text field.
5. Save your changes. The new CSS will be visible on all content pages in the space.

On this page:

- CSS Editing Quick-Start
- Tutorial: Changing the Header Background
- CSS Editing Tips
- Notes

Related pages:

- Styling Confluence with CSS
- Confluence User's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.
Tutorial: Changing the Header Background

The header is the menu area at the top of a default Confluence page where the Breadcrumb Links, Browse menu, User menu and the Quick Search box reside. In this example, we are going to change the background of the header to include a custom graphic.

1. Create a custom graphic. For this example, we created a custom header graphic of 1046 x 61 pixels.
2. Upload the custom graphic to a page in the space that you are customising.
3. Note the page ID of the page where you uploaded the new graphic. (in this example, the page ID was '658833839'.)
4. Compose your custom CSS for the header. The example below loads the new graphic (called 'header.png') from a specific page (denoted by page ID '658833839') in the same space.

```css
#header {
    background-image:url('..download/attachments/658833839/header.png');
    background-repeat: no-repeat;
}
```
5. Log in as the Space Administrator.
6. Open the Space Admin page.
7. Click Stylesheet.
8. Click Edit to change the code in the text field.
9. Paste your custom CSS into the text field.
10. Click Save and then reload the page (you may have to shift-reload). The background of the header will change.
11. The custom header will be visible on all content pages in the space. To revert your change, simply delete the custom code from the 'Stylesheet' page and click Save.

CSS Editing Tips

Begin With a Space Stylesheet

A space stylesheet is a good starting point for CSS customisation, as it already includes all of the elements that can be changed. When you work on the space stylesheet it styles all content pages in the space. Build and test it at space-level, before considering applying the new stylesheet to your entire site. Once you are satisfied with your space design, test it thoroughly until you are confident that it has no problems. Then, you can look into advanced customisation of the Confluence CSS such as adjusting the Search page, the Dashboard and other integral pages.

Use the Right Tools

As the Confluence CSS is reasonably sophisticated, web development applications will help you to understand how the page styles have been created. In particular, you will need to view the existing source for the pages you're starting to work on. If you don't already have some, tools such as the following free applications will allow you to do this.

1. Firebug
   Firebug, a plugin for the Firefox web browser, allows you to take a look at the style of each element on your page. This is very useful to see what styles are currently applied, for example styles applied to the header only.

2. Web Developer
   The Web Developer plugin for Firefox allows you to edit CSS inline and create new page designs.

3. CSS Edit
   CSS Edit is a stand-alone CSS editor for Macintosh that extracts all existing styles from a given page and allows
you to overwrite these.

Edit Simple Elements First

Begin by editing simple elements and checking that they work. By making changes, then checking that each one worked, you can easily isolate any CSS code that is causing problems. Be aware that some page elements are more suited to customisation than others. For example, adding a gradient to the toolbar is less likely to ‘break’ the page than changing the page width. Editing reasonably static elements such as background graphics will render more predictably than designs which attempt to completely change the user interface or the Javascript-powered drop-down menus (which we don’t recommend editing).

Notes

Notes:

- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to Confluence Admin > Security Configuration and choose Custom Stylesheets for Spaces.

Styling Fonts in Confluence

Confluence provides the ability to adjust its visual style via Cascading Style Sheets (CSS). This tutorial shows you to change the fonts and font sizes of a Confluence page, using a few lines of CSS.

Screenshot 1: Default font in a Confluence page

![Screenshot 1: Default font in a Confluence page](image1)

My name is Matt Ryall. I'm a developer on the Confluence team, and I started at Atlassian in January 2006.

I'm very interested in web development, specifically accessible and semantic site design. Wikis are actually one of the most interesting areas of web development, I believe, because they're a totally new form of content. Blogs came from the idea of personal journals, most static websites look like marketing brochures, but there's nothing comparable to a wiki in the physical world. On a wiki you can create an array of linked and searchable content, then anyone can improve on the words you've written, collaborating on whatever you want.

Below are some of the pages on this wiki where I've made a significant contribution:

- Character Encodings in Confluence (and the other Confluence Internals documents)
- Running Confluence behind Apache
- Understanding User Management in Confluence

Screenshot 2: Custom font in a Confluence page

![Screenshot 2: Custom font in a Confluence page](image2)

My name is Matt Ryall. I'm a developer on the Confluence team, and I started at Atlassian in January 2006.

I'm very interested in web development, specifically accessible and semantic site design. Wikis are actually one of the most interesting areas of web development, I believe, because they're a totally new form of content. Blogs came from the idea of personal journals, most static websites look like marketing brochures, but there's nothing comparable to a wiki in the physical world. On a wiki you can create an array of linked and searchable content, then anyone can improve on the words you've written, collaborating on whatever you want.

Below are some of the pages on this wiki where I've made a significant contribution:

- Character Encodings in Confluence (and the other Confluence Internals documents)
- Running Confluence behind Apache
- Understanding User Management in Confluence

Below is the code for the custom font. Copy and paste it into the Space Stylesheet form within the Space Administration section.

Related pages:

- Basic Styling Tutorial
- Confluence User’s Guide
Changing the fonts

In order to customise the fonts in Confluence, you first need to set the body font to the font you want. Secondly, you may want to adjust the font size because different fonts have different relative sizes.

The relevant CSS is shown below. It changes Confluence's font from the default of Helvetica/Arial – sans serif to Times/Times New Roman – serif. To adjust for the fact that Times is a bit smaller than Helvetica, we increase the font size to 14 pixels. The many styles that 'wiki-content' in their definition are necessary to change the font size for all the tags in the wiki content.

```css
body {
    font-family: Times, "Times New Roman", serif;
    font-size: 14px;
}
.wiki-content, .wiki-content p, .wiki-content table, .wiki-content tr, .wiki-content td, .wiki-content th, .wiki-content ol, .wiki-content ul, .wiki-content li {
    font-size: 14px;
}
```

Notes

Notes:
- You need system administrator permissions to edit the CSS for a space or for the site.
- This function is turned off by default. To turn it on, go to Confluence Admin > Security Configuration and choose Custom Stylesheets for Spaces.

Requesting Add-ons

The Atlassian Marketplace website offers hundreds of add-ons that the administrator of your Atlassian application can install to enhance and extend Confluence. If the add-on request feature is enabled for your Confluence instance, you can submit requests for add-ons from the Marketplace to your Confluence administrator.

The 'Atlassian Marketplace for Confluence' page provides an integrated view of the Atlassian Marketplace from within your Confluence instance. The page offers the same features as the Marketplace website, such as searching and category filtering, but tailors the browsing experience to Confluence.

This in-product view of the Marketplace gives day-to-day users of the Atlassian applications, not just administrators, an easy way to discover the add-ons that can help them work. When you find an add-on of interest, you can submit a request with just a few clicks.

Submitting an add-on request

To browse for add-ons in the Atlassian Marketplace, follow these steps:

1. Choose your profile picture at top right of the screen, then choose Atlassian Marketplace.
2. In the Atlassian Marketplace page, use the search box to find add-ons or use the category menus to browse or filter by add-ons by type, popularity, price or other criteria. You can see what your fellow users
have requested by choosing the **Most Requested** filter.  
3. When you find an add-on that interests you, click **Request** to generate a request for your administrator.  
4. Optionally, type a personal message to your administrators in the text box. This message is visible to administrators in the details view for the add-on.

5. When ready, click **Submit Request**.  
6. Click **Close** to dismiss the 'Success!' message dialog box.

At this point, a notification appears in the interface your administrators use to administer add-ons. Also your request message will appear in the add-on details view, visible from the administrator's 'Find New Add-ons' page. From there, your administrator can purchase the add-on, try it out or dismiss requests.

**Updating an add-on request**

After submitting the request, you can update your message at any time. Click the **Update Request** button next to the listing in the Atlassian Marketplace page to modify the message to your administrator.

The administrator is not notified of the update. However, your updated message will appear as you have modified it in the details view for the add-on immediately.

**Giving People Access to Content**

Confluence gives you the choice to make the site as open or as closed as you wish. Here are some points to consider:

- As a tool for communication and collaboration, Confluence is at its best when all your users can participate fully.  
- So it is advisable not to restrict users unless you have a good reason for doing so.  
- Confluence keeps a history of all changes to pages and other content. So it is easy to see who has changed what, and to reverse any edits if required.

**Levels of permission**

There are three levels of permissions in Confluence.

**Global permissions**

Global permissions are site-wide permissions, and are assigned by administrators. Confluence allows two levels of administrator permissions:

- **System Administrator** - Users with this permission can perform all the Confluence administrative
functions.

- **Confluence Administrator** - Users with this permission can perform most of the Confluence administrative functions, but excluding those functions which could compromise the security of the Confluence system.

Users with 'System Administrator' or 'Confluence Administrator' permission can assign permissions to other users. For full details, please refer to the overview of global permissions in the **Administrator's Guide**.

**Space permissions**

The permission to create a new space or to administer one is granted by a Confluence Administrator from the global Administration Console.

Every space has its own independent set of permissions. These permissions determine the access settings for different users of the space. In order to assign these permissions to other users, a user must be a **space administrator** i.e. must have the 'Admin' permission for that space.

See **Users and Groups** to learn how these permissions are assigned.

**Note**: If you misconfigure a space so that nobody has access to administer it any more, someone in the 'confluence-administrators' group will need to fix the permissions for you.

**Page restrictions**

You can set **page-level restrictions**, if you have the 'Restrict Pages' permission within the space concerned.

Page restrictions allow you to control who can view or edit individual pages. To set page restrictions, edit the page and use the page restriction options below the text-entry box.

**On this page:**

- Levels of permission
  - Global permissions
  - Space permissions
  - Page restrictions
- More information
  - How do space permissions and page restrictions work together?
  - How do space permissions and page restrictions affect links?

**Related pages:**

- Users and Groups
- Global Permissions Overview
- Space Permissions Overview
- Page Restrictions
- Configuring Confluence Security
- Confluence Security Overview and Advisories (Not applicable to Confluence OnDemand.)
- Confluence User's Guide

**More information**

*How do space permissions and page restrictions work together?*

**Example**: In the HR (Human Resources) space, everyone in the organisation has the 'View' space permission, but only the HR team has the 'Pages --> Create' space permission (i.e. the ability to create and edit pages in the space). A member of the HR team starts to create a new page called 'Annual Leave Policy'. Because the page is not yet finished, she sets the 'Viewing' page restriction so that only the HR team can view the page. When the page is finished, she will remove the 'Viewing' restriction so that everyone in the company can see the page.

*How do space permissions and page restrictions affect links?*
Space permissions and page restrictions affect how links between pages are displayed to a visitor:

- if the link points to a page in a space to which the visitor does not have 'View' space permission, the link will not be rendered at all.
- if the visitor has 'View' space permission, but page restrictions prohibit her from viewing the page, the link will be rendered but an 'Access Denied' message will be displayed when she clicks the link.
- if the visitor has 'View' space permission, and is not restricted from viewing the page, the link will display and behave as normal.

Links to attachments are also affected: If the visitor does not have permission to view the page to which the attachment is attached, the link will not be rendered.

**Page Restrictions**

Page restrictions allow you to control who can view or edit individual pages. You set the page restrictions using the Page Restrictions dialog, either directly by choosing **Tools > Restrictions**, or when editing a page.

For instructions on using the Page Restrictions dialog, refer to **Setting a Page's Restrictions**.

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed.

---

**On this page:**

- The Confluence Permissions and Page Restrictions Hierarchy
- Requirements for Setting Restrictions
- Page Security Rules
- Inherited Restrictions and Child Pages
- Example of Child Page Restrictions
- How to Open Part of a Space
- Related Topics

---

**Screenshot: The Confluence Page Restrictions dialog**

![Page Restrictions Dialog](image)

---

**The Confluence Permissions and Page Restrictions Hierarchy**

Permissions and page restrictions in Confluence work within a hierarchical manner. For example, users who can access and modify global permissions (for instance, Confluence Administrators) can define which users can access and modify space level permissions (that is, space administrators). Space administrators can then define which users have access to create and modify pages. These users in turn can then apply viewing and editing restrictions to a page. By inheritance, these restrictions will also be applied to any child or descendant pages which are then added to that page.

---

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
See the diagram below for an illustration.

*Diagram: Confluence Restrictions Hierarchy*

Requirements for Setting Restrictions

In order to set or modify page restrictions, you need to have both:

- 'Restrict Pages' permission in the space to which the page belongs (since page restrictions operate within the bounds of space permissions).
- Permission to edit the page itself. That is, if a user is prevented from editing a page through page restrictions, they are also prevented from changing the restrictions themselves.

Page Security Rules

Users can only view page or space content for which they (or a group they are in) have 'View' permission. Pages that a user does not have 'View' access to are referred to as 'inaccessible' pages. Visit Inaccessible Page to see how Confluence deals with pages a user cannot view:
• Anonymous users are directed to the login page.
• Logged-in users are shown a permissions error page.

It is not possible to conceal the existence of pages, though you can restrict 'View' access to page content. Users will still be able to find the page if they know its URL. But they will not be able to view the content if they don't have the correct permissions.

Inherited Restrictions and Child Pages

If a page has its 'View' restriction set, that restriction will be inherited by all its children (and their children, and so on). If a 'View' restriction is added to a page that has already inherited page restrictions from its parent, users must satisfy both restrictions in order to see the page.

'Edit' restrictions are not inherited from the parent page, only from the space. In a space, the 'Add Pages' permission governs both the creation and the editing of pages. See Space Permissions Overview.

Example of Child Page Restrictions

Consider the page 'Documents', with a child page 'Executive', which itself has a child page 'Payroll'. To begin with, anyone who can view the space to which these pages belong can see all three pages.

For security reasons, 'View' restrictions are set on the 'Executive' page, restricting it to the 'mycompany-management group'. At this point, anyone can still see the 'Documents' page, but you must be in the 'mycompany-management group' in order to view either 'Executive' or 'Payroll'.

Since 'Payroll' information is considered particularly private, the 'Payroll' page then has its page restrictions set to only allow members of the 'mycompany-financial' group to view it. At this point, anyone can see the 'Documents' page, only members of 'mycompany-management' can see 'Executive', and only users who are members of both the 'mycompany-management' and 'mycompany-financial' groups can view 'Payroll'.

How to Open Part of a Space

If designing a large site implementation with this strategy, consult Page Restrictions Performance Considerations.

Often there are cases for which a section of a space should be opened to a group or set of users (for this example, we'll call them group B), but the rest of the space should not be visible to your main users (for this example, we'll call them group A). In this case:

1. Add 'view' permission for both groups A and B in space permissions.
2. Move the page to be opened to the root of the space. When browsing the pages in the space, your normal space home page and this page should both be at the root level.
3. Add a page restriction to allow Group A and B to see this page.
4. Add a page restriction to your main landing page for Group A, thereby excluding this set of pages from Group B.

You can repeat this with any page hierarchy.

Administrators

• Space administrators are responsible for the management of a space and its contents. They therefore have the ability to remove all restrictions from a page (as described in Viewing Restricted Pages). This means that space administrators can view and edit all content in the space.
• Users who are members of the 'confluence-administrators' group ('super-users') cannot immediately see pages from which they are excluded by page restrictions. Also, to be able to edit the page, you will need to remove the restriction from it first – go to Space Administration > Res...
You cannot exclude yourself
As creator or editor of a page, you cannot use page restrictions to deny yourself access to the page. Confluence will automatically add your username into the list of users/groups allowed to view/edit the page. If you remove your username, Confluence will put it back again.

Related Topics
View a Page's Restrictions
Set a Page's Restrictions
View All Restricted Pages
Page Restrictions Performance Considerations

Working with Pages
Take me back to the Confluence User's Guide.

Inaccessible Page
Please do not change the page restrictions on this page.

This page is intentionally restricted to viewing by the 'documentation' group only. We use it for demonstration purposes, to show what happens if someone tries to view a restricted page. For example, 'Page Restrictions' links to this page.

Setting a Page's Restrictions

Page restrictions control who may view or edit a specific page, within the bounds of the space permissions:

- View restrictions make the page invisible to everyone except the chosen users and groups.
- Edit restrictions prevent everyone except the chosen users and groups from editing the page.

You can restrict the page to as many users and groups as you like.

In order to set or modify page restrictions, you need to have the ' Restrict Pages' permission in the space to which the page belongs, as well as permission to edit the page itself.

Setting Page Restrictions

To set restrictions on a page:

1. Choose Tools > Restrictions. The Page Restrictions dialog opens. You can also click the padlock icon in the page's byline (if available), or click either Unrestricted or Restricted when editing the page.
2. Select the restriction option required.
3. Choose the users and groups who you want to be able to view or edit the page:
   - To choose just yourself, click Me.
   - To choose a particular user or group, type the user's username (or their full name), or the group name, into the Enter ... name box, and click Restrict. You can enter multiple user and group names, when separated by commas.
   - To search for a user or group (if you are unsure of the name), click Person... or Group... (You can read more about searching for users.)
4. Click Save.

Screenshot: The Confluence Page Restrictions dialog
Removing Page Restrictions

To remove restrictions on a page:

1. Choose Tools > Restrictions. The Page Restrictions dialog opens. You can also click the padlock icon in the page's byline (if available), or click either Unrestricted or Restricted when editing the page.
2. Click Remove restriction next to the appropriate users or groups.
3. Click Save.

Notes

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed.

View and edit restrictions apply to all users including space administrators. However, space administrators can remove any restriction on a page. See Viewing Restricted Pages.

Related Topics

Space Permissions Overview
Viewing a Page's Restrictions
Viewing Restricted Pages
Working with Pages

Take me back to the Confluence User's Guide.
Viewing a Page's Restrictions

Viewing page restrictions in View mode

When a page you are viewing has restrictions applied, a small padlock icon appears next to the page byline. Clicking the padlock will open the Page Restrictions dialog, where full details on the page restrictions are displayed. See Setting a Page's Restrictions for instructions on how to change these.

Viewing page restrictions in Edit mode

You can view a page's restrictions when editing the page. You can only edit the page if you have permissions to do so.
To view the restrictions that apply to a page:

- When editing the page, click **Restrictions**. See Setting a Page's Restrictions for instructions on how to change these.

**Related Topics**

- Setting a Page's Restrictions
- Viewing Restricted Pages
- Working with Pages

Take me back to the Confluence User's Guide.

**Viewing Restricted Pages**

Restricted pages are pages that have viewing or editing restrictions applied to them through page-level restrictions.

You need to be a space administrator to view the list of restricted pages in a space.

**To view restricted pages:**

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. Choose **Permissions > Restricted Pages**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.

   **Note:** The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Restricted Pages** in the space administration options.

A list of all restricted pages in the space displays.

**Related pages:**

- Setting a Page's Restrictions
- Working with Pages
- Space Permissions Overview
- Confluence User's Guide

**Screenshot: Restricted pages in a space**
Site Administrators and their Permissions

All site administrative functions are performed from the Administration Console. You need ‘System Administrator’ or ‘Confluence Administrator’ permissions to access the Administration Console.

The Confluence permission scheme allows the following levels of site administrator permissions, with the most powerful at the top of the list:

- **Super user** – A ‘super user’ belongs to the `confluence-administrators` group, has full administrative access to Confluence, and can see all the content.
- **System Administrator** – A person with 'System Administrator' permission has full administrative access to Confluence.
- **Confluence Administrator** – A person with 'Confluence Administrator' permission has access to most of the Confluence administrative functions.

⚠️ Some functionality described on this page is restricted in Confluence OnDemand.

Please refer to the overview of global permissions for full details.

**Related Topics**

- Users and Groups
- Confluence User’s Guide

**Contacting Confluence Administrators**

If you receive an error message from Confluence, the error page may offer you a link to click in order to contact the administrators of the Confluence site.

When you click the link to contact the Confluence administrators, you will see an administrator contact page with the title ‘Contact Site Administrators’. By default, the administrator contact page looks like the screenshot below.

*Screenshot: The administrator contact screen*
The screen may look different

In certain configurations of Confluence, you will not be able to use the form shown in the screenshot above. Instead, you will see a message telling you about one of the following conditions:

- If your Confluence administrator has not configured a mail server for Confluence, this means that Confluence will not be able to send an email message to the administrators.
- If none of the Confluence administrators has an email address, Confluence will not be able to send an email message to them.
- If there are no Confluence administrators defined to Confluence, Confluence will not be able to send an email message to them.
- The Confluence administrator can disable the form and specify a different message to be displayed on the above screen instead of the default message and form. See the administrator’s guide.

Notes

You can also access this contact form using the following URL.

yoursite.com/wiki/contactadministrators.action

Space Administrators and their Permissions
A space administrator is a user with the ‘Space Admin’ permission for a space. This permission itself is assigned from the Space Administration screens by a space administrator.

Who is a space administrator?

The person who creates a space is automatically the administrator of that space. That person can then assign other space administrators as required.

Confluence administrators are not necessarily space administrators.

- A user who has the ‘Administer Confluence’ permission is not automatically a space administrator for a particular space. In order for them to be a space administrator, they must belong to a group which has space administration rights on the space, or their username must be specifically granted space administration rights on the space.
- Users who are members of the ‘confluence-administrators’ group do automatically have space administration permissions for all spaces.

Refer to the Administrator’s Guide for more details about Confluence administrator permissions.

What can a space administrator do?

A space administrator has permission to do anything in the space regardless of any other setting. Space administrators are responsible for the management of a space and its contents. Note that page permissions affect space administrators differently from other users.

Space administrators can:

- view all content in the space. If there are page permissions that restrict the viewing of a page to a single user, or to a group to which the space administrator doesn’t belong, a space administrator can still view the page by removing the restriction.
- edit all content on any page in the space.
- remove restrictions from any page in the space (using the Space Administration interface).
- manage the watchers for any page in the space (but not watchers of the space).
- grant themselves any other space permissions (e.g. permission to set restrictions on a particular page).

All space administration functions, with the exception of managing watchers, are performed from the ‘Space Admin’ tab (choose Browse > Space Admin). You need to be a space administrator to access the Space Administration screens.

Related Topics

Space Permissions Overview

Take me back to Confluence User's Guide

Space Permissions Overview

Every space has its own independent set of permissions. Space permissions can only be granted by a space administrator.

Permissions can be assigned to any group, to any individual user in the Confluence-User group, and to users in the Anonymous group.

These are the permissions that can be assigned at the space level:

- **View**: user can view this space's content, including the space's details, and its pages and news items (blog posts)
- **Pages**:
  - Add – user may create and edit pages in this space.
  - Restrict – user may apply page-level restrictions.
• Remove – user may remove pages in this space.

• **Blog:**
  • Add – user may add and edit blog posts in this space.
  • Remove – user may remove blog posts in this space.

• **Comments:**
  • Add – user may make comments in this space.
  • Remove – user may remove comments from this space.

• **Attachments:**
  • Add – user may add attachments in this space.
  • Remove – user may remove attachments from this space.

• **Mail:**
  • Remove – user may delete individual mail items.

• **Space:**
  • Export – user may export content from this space via the space-level export screens. Note that this permission does not affect the exporting of a single page's content. Anyone who has permission to view the page also has permission to export its content.
  • Admin – user has administrative permissions over this space.

### Related pages:
- Space Administrators and their Permissions
- Users and Groups
- Assigning Space Permissions
- Page Restrictions
- Confluence User’s Guide

### Notes

• **Warning:** If you deny all administrative access to a space by mistake, so that nobody has access to administer the space any more, you will need to ask someone in the confluence-administrators group to fix the permissions for you.

• The Confluence CLI tool is useful for bulk operations, including adjustments to space permissions. You can download it from the Atlassian Marketplace. The documentation for the Confluence CLI includes information about the AddPermissions action.

### Assigning Space Permissions

You can assign space permissions to groups or to individual users. You need to be a space administrator to assign space permissions. In addition, Confluence administrators can set the default permissions that will be applied to new spaces as described below.

### To access the permissions for a space:

1. Go to the 'Space Permissions' view:
   - If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   - If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **Edit Permissions**.

If your space is using the Documentation theme:

1. Go to the 'Space Permissions' page:
   - Choose **Browse > Space Admin** at the top of the screen.
**Note:** The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the *confluence-administrators* group).

- Choose **Permissions** from the space administration options.

2. Choose **Edit Permissions**.

The ‘Edit Space Permissions’ page is divided into the following sections:

- Groups – a list of groups which already have permissions to access the site.
- Individual Users – a list of users who already have permissions to access the site.
- Anonymous Access – the space permissions granted to all anonymous users of the site.

<table>
<thead>
<tr>
<th>On this page:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Assigning space permissions to groups</td>
</tr>
<tr>
<td>• Assigning space permissions to users</td>
</tr>
<tr>
<td>• Assigning space permissions to anonymous users</td>
</tr>
<tr>
<td>• Setting default space permissions</td>
</tr>
<tr>
<td>• Notes</td>
</tr>
</tbody>
</table>

**Related pages:**

- Space Permissions Overview
- Users and Groups
- Confluence User’s Guide

**Screenshot: Space permissions**
Assigning space permissions to groups

- To assign a permission, check the box next to the relevant group.
- To deny a permission, uncheck the relevant box.
- To add a new group to the list, type the group name into the text box in the 'Groups' section and choose Add. The group will appear in the list of groups. You can then assign the permissions.
- To search for a group:
  - Choose the icon.
  - The Group Search window opens. Enter all or part of the group name. You can use an asterisk '*' as a wild card.
  - Check the boxes to select the required group(s).
  - Choose Select Groups. The group name(s) will appear in the text box in the 'Groups' section.
  - Choose Add.
- To bulk assign or revoke group member permissions, choose either Select All or Deselect All from the Actions dropdown list.

Choose Save All to apply the changes.

Assigning space permissions to users

- To assign a permission, check the box next to the relevant user.
- To deny a permission, uncheck the relevant box.
- To add a new user to the list, type the username into the text box in the 'Individual Users' section and
choose **Add**. The user will appear in the list of users, with 'View' permission assigned. You can then add more permissions if necessary.

- **To search for a user:**
  - Choose the search icon.
  - The **User Search** window opens. You can read more about searching for users.
  - Check the boxes to select the required user(s).
  - Choose **Select User(s)**. The username(s) will appear in the text box in the 'Individual Users' section.
  - Choose **Add**.
- **To bulk assign or revoke individual user permissions,** choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Choose **Save All** to apply the changes.

**Assigning space permissions to anonymous users**

- To assign a permission, check the box for the required permission.
- To deny a permission, uncheck the relevant box.
- To bulk assign or revoke anonymous user permissions, choose either **Select All** or **Deselect All** from the **Actions** dropdown list.

Choose **Save All** to apply the changes.

**Note:** You cannot grant space administration rights or page restriction rights to anonymous users.

**Setting default space permissions**

If you are a **Confluence Administrator**, you can set the default permissions that will be applied to new spaces. The default permissions are configurable for groups only, not for individual users or anonymous users.

**To set the default space permissions:**

1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **Space Permissions** under Security in the sidebar.
3. Choose **Edit Permissions**.

**Screenshot: Default space permissions**
Notes

Assigning permissions in bulk. There is no way to change a number of space permissions at once, via the Confluence user interface. Instead, take a look at the Confluence Command Line Interface. Here is a link to the CLI documentation. For an introduction to the CLI, see this blog post: Confluence CLI for bulk actions like deleting or publishing pages.

Users and Groups

A 'user' is the account for an individual who accesses Confluence.

New users are created by a Confluence administrator via the Administration Console. See Searching For and Administering Users for more information.

A Confluence administrator can also group users together into user groups for more convenient administration. This means that any permissions you assign at the site, space and page levels can be assigned to a whole group. A user in one of these groups will automatically be granted all permissions granted to the group.

There are two special groups in Confluence:

- **Confluence-Administrators** - This is a 'super-group' and a user from this group has permission to do anything in the site regardless of any other setting.

- **Confluence-Users** - This is the default group into which all new users are assigned. Permissions you assign to this group will be assigned to all newly signed-up users of Confluence.

Anonymous Users

Confluence treats all users who do not log in when they access Confluence as being 'Anonymous'. Administrators can assign permissions to this group separately.

**Overlapping group and user permissions**

When a user is assigned more than one permission, the most powerful permission will prevail.

Further explanation:

- A user may be assigned a permission specifically to their username. They may also be assigned a permission by belonging to a group, or even several groups.
- The user will then be able to perform all functions assigned to them.
- So if a user is allowed to do something over and above what the group can do, the user will be able to do it. And if the group is allowed to do something over and above the specific permissions granted to the user, the user will still be able to do it.

Related Topics

Space Permissions Overview
Assigning Space Permissions
Page Permissions
Managing Confluence Users
Confluence User's Guide
Searching for Users

This page describes how to use the 'User Search' window, which appears when you click Choose Users or a user search icon on a Confluence page.

Accessing the User Search
To access the 'User Search' window:

1. Choose the user search icon when you are performing one of the following actions:
   - When assigning space permissions, choose the user search icon in the users section.
   - When adding members to a group, choose the user search icon.

2. The simple 'User Search' window will appear, as shown below.

   **On this page:**
   - Accessing the User Search
   - Using the Simple User Search
   - Searching for Users in One or More Groups
   - Selecting One or More Users
   - Notes

   **Related pages:**
   - Searching Confluence
   - Setting a Page's Restrictions
   - Assigning Space Permissions
   - Adding or Removing Users in Groups
   - Confluence User's Guide

---

**Using the Simple User Search**

To search via the simple user search:

1. Select the User tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. Enter information about the user in the User Details field, such as all or part of a username, full name or email address.
3. Choose Search.
4. Confluence will return a list of matching users. See below for instructions on selecting one or more users.

---

**Screenshot: Simple user search**
**Searching for Users in One or More Groups**

You can also list the users who appear in a particular group or in a set of groups.

**To search for users in a particular group:**

1. Select the **Membership** tab on the 'User Search' screen. (See above for instructions on accessing the screen.)
2. Enter all or part of a group name into the **Group Membership** field.
3. Choose **Search**.
4. Confluence will return a list of users belonging to any groups which match your search term.
   - In the example screenshot below, we entered a group name of 'dev'. The search results show all users belonging to the group 'developers' and all users belonging to the group 'developers-mates'.
5. Now you can select one or more users, as described **below**.

**Screenshot: Searching for users in a group**

![User Search](image)

**Selecting One or More Users**

After searching for users and receiving a list of names from Confluence, as described above, you can now select the user(s) you need.

**To select one or more users:**

1. Click the box next to the username(s) to select or deselect one or more users.
   - You can click **Check All** to select or deselect all users.
2. Click **Select User(s)**.
3. The 'User Search' window will close and the selected users will appear on the screen which you were using before you accessed the user search.

**Notes**

- **Case sensitivity**: The search is not case sensitive. You can enter either upper- or lower-case text, and it will make no difference to the search results.
- **Wild cards**: The search allows the asterisk as a wild card, but you do not need to use it. The search
results will be the same whether you use a wild card or not. The wildcard functionality remains available for compatibility with older versions of Confluence.

- **Multiple user directories:** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See [Managing Multiple Directories](#) (Not applicable to Confluence OnDemand.)

- **Crowd and the user search:** If you are using Atlassian's Crowd for user management, you will need Crowd 1.5.1 or later to use the 'Simple' option in the user search. If your version of Crowd does not support the simple user search, you will see only the 'Advanced' search form.

**Using Confluence on a Mobile Device**

When you view a Confluence page on a mobile device, such as an iPhone or an iPad, Confluence will display an optimised version of the page. Confluence chooses the mobile or desktop interface based on your device. See [Supported Platforms](#) for details of supported mobile devices.

On your phone or other supported mobile device, you can:

- View the Confluence dashboard, pages, blog posts, and user profiles.
- Add a comment to a page or blog post.
- Like a page, blog post or comment.
- Manage your personal tasks and notifications.

You cannot add or edit pages or blog posts, or edit existing comments, using the mobile interface.

**The dashboard – the first thing you see**

*Screenshot: The dashboard in Confluence mobile*

```
Choose a tab to see:

- Popular content – what people like in your wiki.
- Recent blogs – the latest blog posts.
- Network – updates by people in your network.
```
Tap the links to view the full content of a page, blog post or comment.

Searching for content and people

Tap the menu icon to open the menu panel on the left of the page. Then type text or a person’s name in the Search box. The mobile interface offers the quick navigation search, which returns matches on page title only. (See Searching Confluence.) To use the full search, switch to desktop mode.

Screenshot: The menu panel in Confluence mobile

Viewing pages, blog posts and comments

Tap a link on the dashboard or on any other page. Confluence will display the linked page, blog post or comment.

You can:

- View the content, tap a link to move to another page, and interact with the page using the standard functionality supported by mobile browsers.
- Like or unlike a page, blog post or comment.
- Add a comment. Confluence mobile supports plain-text comments only.

Screenshot: A page with a ‘Like’ button and a comment box
Viewing people's profiles

Search for a person's name, then view that person's user profile. Tap the options to phone, SMS or email a colleague directly from your mobile device.

Screenshot: A user profile on Confluence mobile

Following up on notifications

You can view and respond to your notifications on your phone or other mobile device. Tap the menu icon to open the menu panel on the left of the page. Choose Notifications, and tap a notification to see its details. You can reply, watch or like via the inline actions. Tap Open to open the page or blog post in a new page. For full details, see Managing Notifications in Confluence.

Screenshot: Notifications in Confluence mobile
Managing tasks

You can view and manage your tasks on your phone or other mobile device too. Tap the menu icon to open the menu panel on the left of the page. Choose Tasks, and tap the plus sign to add a new task. Tap a task to see its details. You can add notes, complete a task, and tap a link to open the related page. For full details, see Managing Tasks in Confluence.

Screenshot: Tasks in Confluence mobile
See Notes about Confluence Mobile.

Related pages

- Dashboard
- Managing Notifications in Confluence
- Managing Tasks in Confluence
- Confluence User's Guide

Notes about Confluence Mobile

When you view a Confluence page on a mobile device, such as an iPhone or an iPad, Confluence will display an optimised version of the page. Confluence chooses the mobile or desktop interface based on your device. See Supported Platforms for details of supported mobile devices.

For a summary of mobile features, see Using Confluence on a Mobile Device. Below are additional notes that you will find useful.

On this page:

- Some macros may not work
- You can swap from mobile to standard Confluence and back again
- Administrators can disable Confluence mobile on your site
- Confluence mobile is a web interface, not a native app
- Request for Android support
- Related pages

Some macros may not work

Confluence macros are not yet fully supported in Confluence mobile. If you view a page that contains an unsupported macro, you will see a message inviting you to click through to the desktop version of the page.

Screenshot: Macro not rendered in Confluence mobile

You can swap from mobile to standard Confluence and back again

You can swap from the mobile view to the standard view of a page at any time. Choose the menu icon then choose Switch to desktop version.

Screenshot: The menu panel in Confluence mobile
You can also swap from the desktop view to the mobile view, if you are on a mobile device. Choose the option **Switch to Confluence Mobile** at the top of the window.

**Screenshot: Option to switch to Confluence mobile**

Administrators can disable Confluence mobile on your site

The mobile functionality is provided by a plugin called the 'Confluence Mobile Plugin'. To remove the functionality from your site, you can disable the plugin.

**Confluence mobile is a web interface, not a native app**

Atlassian does not supply a native mobile application that you can download and install onto your mobile device. Confluence mobile is a web-based user application that the Confluence server displays when it detects a mobile client.

**Request for Android support**

You can watch this ticket to be informed when support for Android devices is added:  

[CONF-25529](#) - Authenticate to see issue details

### Related pages

- Using Confluence on a Mobile Device
- Dashboard
- Confluence User's Guide

### Advanced and Special Uses of Confluence

This section describes the more advanced features of Confluence, and gives guidelines on some specific uses of the wiki.

**Confluence markup formats**

The syntax and usage of Confluence wiki markup and the Confluence XHTML-based storage format – see Working with Confluence Markup.
Gadgets

How to add gadgets to a wiki page, or use Confluence gadgets on other sites – see Working with Confluence Gadgets.

Using Confluence for technical documentation

A technical communicator’s guide to using Confluence – see Developing Technical Documentation on Confluence Wiki.

Setting up a knowledge base

A support engineer’s guide to using Confluence as a knowledge base – see Developing a Knowledge Base on Confluence Wiki.

Setting up an intranet

A quick guide to setting up an intranet wiki – see Developing an Intranet on Confluence Wiki.

Working with Confluence Markup

This section describes two types of markup found in Confluence:

- **Confluence storage format.** Confluence stores the content of pages and blog posts in an XHTML-based format. Advanced users can view the storage format of a page and even edit it, provided their Confluence site is configured to allow that. See Confluence Storage Format for a description of the core elements of the storage format. For details of the elements used to define a macro, see Confluence Storage Format for Macros.

- **Wiki markup.** Confluence allows data entry via a shorthand code called wiki markup. Some parts of the Confluence administration interface also accept wiki markup for defining content. For a description of the wiki markup syntax, see Confluence Wiki Markup. For details of the wiki markup used to define Confluence macros, see Confluence Wiki Markup for Macros.

A request from the Atlassian technical writers about comments and feedback: When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we've missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks.😊

Confluence Storage Format

This page describes the XHTML-based format that Confluence uses to store the content of pages, page templates, blog posts and comments. This information is intended for advanced users who need to interpret and edit the underlying markup of a Confluence page.

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.
Notes:

- You can view the Confluence storage format for a given page by choosing **Tools > View Storage Format**. This option is only available if one of the following is true:
  - You are a Confluence administrator.
  - Your Confluence site has the Confluence Source Editor plugin installed and you have permission to use the source editor.
- If you would like to edit the storage format for a page, your Confluence system administrator will need to install the Confluence Source Editor plugin.
- Clarification of terminology: If you choose **Tools > View Source**, you will see the format used within the editor panel, not the storage format of the page.
- **A request from the Atlassian technical writers about comments and feedback**: When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we’ve missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks.

### On this page:

- Macros
- Headings
- Text effects
- Text breaks
- Lists
- Links
- Images
- Tables
- Page layouts
- Emoticons
- Resource identifiers
- Template variables

### Related pages:

- Confluence Storage Format for Macros
- Feedback on Confluence Storage Format (*Not applicable to Confluence OnDemand.*)
- Working with Confluence Markup

### Macros

See Confluence Storage Format for Macros.

### Headings

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Heading 1</td>
<td>h1. Heading 1</td>
<td><code>&lt;h1&gt;Heading 1&lt;/h1&gt;</code></td>
<td><strong>Heading 1</strong></td>
</tr>
</tbody>
</table>

Underlined in the Documentation Theme
Heading 2

<h2>Heading 2</h2>

Underlined in the Documentation Theme

Heading 3

<h3>Heading 3</h3>

Headings 4 to 6 are also available and follow the same pattern

Text effects

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>strong/bold</td>
<td><em>strong</em></td>
<td>&lt;strong&gt;strong text&lt;/strong&gt;</td>
<td>strong, &lt;b&gt; will also work but get converted to &lt;strong&gt; upon saving</td>
</tr>
<tr>
<td>emphasis</td>
<td><em>emphasis</em></td>
<td>&lt;em&gt;Italics Text&lt;/em&gt;</td>
<td>emphasis, &lt;i&gt; will also work but get converted to &lt;em&gt; upon saving</td>
</tr>
</tbody>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Strike-through</th>
<th>-strikethrough-</th>
<th>&lt;span style=&quot;text-decoration: line-through;&quot;&gt;s-trikethrough&lt;/span&gt;</th>
<th>Strike-through</th>
<th>&lt;s&gt; and &lt;del&gt; will also work</th>
</tr>
</thead>
<tbody>
<tr>
<td>Underline</td>
<td>+underline+</td>
<td>&lt;u&gt;underline&lt;/u&gt;</td>
<td>Underline</td>
<td>---</td>
</tr>
<tr>
<td>Superscript</td>
<td>^superscript^</td>
<td>&lt;sup&gt;superscript&lt;/sup&gt;</td>
<td>Superscript</td>
<td>---</td>
</tr>
<tr>
<td>Subscript</td>
<td><del>subscript</del></td>
<td>&lt;sub&gt;subscript&lt;/sub&gt;</td>
<td>Subscript</td>
<td>---</td>
</tr>
<tr>
<td>Monospace</td>
<td>{{monospaced}}</td>
<td>&lt;code&gt;monospaced&lt;/code&gt;</td>
<td>Monospaced</td>
<td>---</td>
</tr>
<tr>
<td>Format</td>
<td>Value</td>
<td>Sample HTML</td>
<td>Sample Text</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>---------</td>
<td>---------------------------------</td>
<td>---------------</td>
<td></td>
</tr>
</tbody>
</table>
| preformatted    | n/a     | `<pre>
preformatted text
</pre>` | preformatted text |
| block quotes    | bq. block quote or `{quote}` | `<blockquote>
<p>block quote</p>
</blockquote>` | block quote   |
| text colour     | `{color:red}red text{color}` | `<span style="color:rgb(255,0,0);">red text</span>` | red text      |
| small           | n/a     | `<small>small text</small>`     | small text    |
### Text breaks

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>New paragraph</td>
<td>Paragraph 1 (empty line)</td>
<td>&lt;p&gt;Paragraph 1&lt;br&gt;Paragraph 2&lt;/p&gt;</td>
<td>Paragraph 1 Paragraph 2</td>
</tr>
</tbody>
</table>
| Line break       | Line 1 \ Line 2                                                                 | Line 1 <br/> Line 2 | Line 1  
Line 2  
Note: Created in the editor using Shift + Return/Enter |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Horizontal rule</td>
<td>----</td>
<td>&lt;hr /&gt;</td>
<td></td>
</tr>
<tr>
<td>— symbol</td>
<td>---</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>– symbol</td>
<td>--</td>
<td>—</td>
<td>–</td>
</tr>
</tbody>
</table>

**Lists**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unordered list – round bullets</td>
<td>* Round bullet list item</td>
<td>&lt;ul&gt; &lt;li&gt;round bullet list item&lt;/li&gt; &lt;/ul&gt;</td>
<td>• Round bullet list item</td>
</tr>
<tr>
<td>Unordered list – square bullets</td>
<td>- Square bullet list item</td>
<td>&lt;ul style=&quot;list-style-type: square;&quot;&gt; &lt;li&gt;square bullet list item&lt;/li&gt; &lt;/ul&gt;</td>
<td>• Square bullet list item</td>
</tr>
<tr>
<td>Ordered list (numbered list)</td>
<td># Ordered list item</td>
<td>&lt;ol&gt; &lt;li&gt;numbered list item&lt;/li&gt; &lt;/ol&gt;</td>
<td>1. Ordered list item</td>
</tr>
</tbody>
</table>

**Links**
<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Link to another Confluence page</td>
<td>![Link to another Confluence page</td>
<td>Page Title]</td>
<td>![ac:link&gt; &lt;ri:page ri:content-title=&quot;Page Title&quot; / &gt; ![CDATA[Link to another Confluence Page]]&gt; ![ac:plain-text-link-body&gt; ![CDATA[Link to another Confluence Page]]&gt; ![ac:link&gt;</td>
</tr>
<tr>
<td>Link to an attachment</td>
<td>![Link to an attachment^atlassian_logo.gif]</td>
<td>![ac:link&gt; &lt;ri:attachment ri:filename=&quot;atlassian_logo.gif&quot; /&gt; ![CDATA[Link to a Confluence Attachment]]&gt; ![ac:plain-text-link-body&gt; ![CDATA[Link to a Confluence Attachment]]&gt; ![ac:link&gt;</td>
<td>![ac:plain-text-link-body&gt; ![CDATA[Link to an attachment]]&gt; ![ac:link&gt;</td>
</tr>
</tbody>
</table>

**Confluence 5.0 Documentation**

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Anchor link (same page)</th>
<th><img src="#anchor" alt="Anchor Link" /></th>
<th>Anchor Link</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="#anchor" alt="Anchor Link" /></td>
<td>&lt;ac:link ac:anchor=&quot;anchor&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="">ac:plain-text-link-body</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;![CDATA[Anchor Link]]&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/ac:plain-text-link-body&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/ac:link&gt;</td>
<td></td>
</tr>
<tr>
<td>Anchor link (another page)</td>
<td><img src="pagetitle#anchor" alt="Anchor Link" /></td>
<td></td>
</tr>
<tr>
<td><img src="pagetitle#anchor" alt="Anchor Link" /></td>
<td>&lt;ac:link ac:anchor=&quot;anchor&quot;&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;ri:page ri:content-title=&quot;pagetitle&quot;/&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td><a href="">ac:plain-text-link-body</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;![CDATA[Anchor Link]]&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/ac:plain-text-link-body&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;/ac:link&gt;</td>
<td></td>
</tr>
</tbody>
</table>
### Link with an embedded image for the body

![google.png][pagetitle#anchor]

```ac:link
   ac:anchor="Anchor Link">
   <ac:link-body>
   <ac:image>
     ri:url="http://confluence.atlassian.com/images/logo/confluence_48_trans.png" />
   </ac:image>
   </ac:link-body>
   </ac:link>
```

---

**For rich content like images, you need to use `ac:link-body` to wrap the contents.**

---

### A note about link bodies

All links received from the editor will be stored as plain text by default, unless they are detected to contain the limited set of mark up that we allow in link bodies. Here are some examples of markup we support in link bodies.

#### An example of different link bodies

```ac:link
   <!-- Any resource identifier -->
   <ri:page ri:content-title="Home" ri:space-key="SANDBOX" />
   <ac:link-body>Some <strong>Rich</strong> Text</ac:link-body>
</ac:link>

<ac:link>
   <ri:page ri:content-title="Plugin developer tutorial stuff"
   ri:space-key="TECHWRITING" />
   <ac:plain-text-link-body><![CDATA[A plain <text> link body]]></ac:plain-text-link-body>
</ac:link>

<ac:link>
   <!-- A link body isn't necessary. Auto-generated from the resource identifier for display. -->
</ac:link>
```
The markup tags permitted within the `<ac:link-body>` are `<b>`, `<strong>`, `<em>`, `<i>`, `<code>`, `<tt>`, `<sub>`, `<sup>`, `<br>` and `<span>`.

**Images**

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attached image</td>
<td><img src="" alt="atlassian_logo.gif!" /></td>
<td><img src="" alt="atlassian_logo.png!" /></td>
<td><code>&lt;ac:image&gt;&lt;ri:attachment ri:filename=&quot;atlassian_logo.gif&quot;/&gt;&lt;/ac:image&gt;</code></td>
</tr>
</tbody>
</table>

Supported image attributes (some of these attributes mirror the equivalent HTML 4 IMG element):

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ac:align</td>
<td>image alignment</td>
</tr>
<tr>
<td>ac:border</td>
<td>Set to &quot;true&quot; to set a border</td>
</tr>
<tr>
<td>ac:class</td>
<td>css class attribute.</td>
</tr>
<tr>
<td>ac:title</td>
<td>image tool tip.</td>
</tr>
<tr>
<td>ac:style</td>
<td>css style</td>
</tr>
<tr>
<td>ac:thumbnail</td>
<td>Set to &quot;true&quot; to designate this image as a thumbnail.</td>
</tr>
<tr>
<td>ac:alt</td>
<td>alt text</td>
</tr>
</tbody>
</table>
### Tables

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two column, two row (top header row)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Table Heading Cell 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Normal Cell 1</td>
</tr>
</tbody>
</table>
Two column, three rows, 2nd and third with merged cells in first row

<table>
<thead>
<tr>
<th>Table Heading</th>
<th>Table Heading</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merged Cell</td>
<td>Normal Cell 1</td>
</tr>
<tr>
<td>Normal Cell 1</td>
<td>Normal Cell 2</td>
</tr>
</tbody>
</table>

Page layouts

Confluence supports page layouts directly, as an alternative to macro-based layouts such as those using the section and column macros. This section documents the storage format XML created when these layouts are used in a page.

Notes:
- Page layouts were introduced in Confluence 4.2, and are not available in earlier versions of Confluence.
- The word (content) in the layouts below indicates where further XHTML or Confluence storage format block content would be entered, such as <p> or <table> tags.

<table>
<thead>
<tr>
<th>Layout Type</th>
<th>In Confluence 4.2 and later</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Two columns

<table>
<thead>
<tr>
<th>Column 1</th>
<th>Column 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>{content}</td>
<td>{content}</td>
</tr>
</tbody>
</table>

### Left sidebar

<table>
<thead>
<tr>
<th>Sidebar</th>
<th>Main Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>{content}</td>
<td>{content}</td>
</tr>
<tr>
<td>{content}</td>
<td>{content}</td>
</tr>
</tbody>
</table>
## Two columns with header and footer

```
<div class="contentLayout" data-atlassian-layout="{"name":"pagelayout-two","columns":["",""],"header":true,"footer":true}">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout twoColumns">
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
Left sidebar with header and footer

```html
<div class="contentLayout" data-atlassian-layout="{"name":"pagelayout-two-left","columns":["aside","large"],"header":true,"footer":true}"

<div class="header">
    <div class="innerCell">
        {content}
    </div>
</div>

<div class="columnLayout twoColumns">
    <div class="cell aside">
        <div class="innerCell">
            {content}
        </div>
    </div>
    <div class="cell large">
        <div class="innerCell">
            {content}
        </div>
    </div>
</div>

<div class="footer">
    <div class="innerCell">
        {content}
    </div>
</div>
```
Right sidebar with header and footer

```html
<div class="contentLayout" data-atlassian-layout="{"name":"pagelayout-two-right","columns":["large","aside"],"header":true,"footer":true}"

  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>

  <div class="columnLayout twoColumns">
    <div class="cell large">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell aside">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>

  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>

</div>
```
Three columns with header and footer

```html
<div class="contentLayout" data-atlassian-layout="" name="" pagelayout-three", columns=["", ""], header=true, footer=true">
  <div class="header">
    <div class="innerCell">
      {content}
    </div>
  </div>
  <div class="columnLayout threeColumns">
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell ">
      <div class="innerCell">
        {content}
      </div>
    </div>
    <div class="cell">
      <div class="innerCell">
        {content}
      </div>
    </div>
  </div>
  <div class="footer">
    <div class="innerCell">
      {content}
    </div>
  </div>
</div>
```
Emoticons

<table>
<thead>
<tr>
<th>Format type</th>
<th>In Confluence 3.5 and earlier</th>
<th>In Confluence 4.0 and later</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emoticons</td>
<td>:)</td>
<td>&lt;ac:emoticon ac:name=&quot;smile&quot; /&gt;</td>
<td>😊</td>
</tr>
<tr>
<td></td>
<td>:(</td>
<td>&lt;ac:emoticon ac:name=&quot;sad&quot; /&gt;</td>
<td>😞</td>
</tr>
<tr>
<td>Resource identifiers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;cheeky&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:D</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;laugh&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>:)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;wink&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(y)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;thumbs-up&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(n)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;thumbs-down&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(i)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;information&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(/)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;tick&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(x)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;cross&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(!)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;ac:emoticon ac:name=&quot;warning&quot; /&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Resource identifiers are used to describe "links" or "references" to resources in the storage format. Examples of resources include pages, blog posts, comments, shortcuts, images and so forth.

<table>
<thead>
<tr>
<th>Resource</th>
<th>Resource identifier format</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td><code>&lt;ri:page ri:space-key=&quot;FOO&quot; ri:content-title=&quot;Test Page&quot;/&gt;</code></td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>• ri:space-key: (optional) denotes the space key. This can be omitted to create a relative reference.</td>
<td></td>
</tr>
<tr>
<td>• ri:content-title: (required) denotes the title of the page.</td>
<td></td>
</tr>
<tr>
<td>Blog Post</td>
<td><code>&lt;ri:blog-post ri:space-key=&quot;FOO&quot; ri:content-title=&quot;First Post&quot; ri:posting-day=&quot;2012/01/30&quot;/&gt;</code></td>
</tr>
<tr>
<td>Notes:</td>
<td></td>
</tr>
<tr>
<td>• ri:space-key: (optional) denotes the space key. This can be omitted to create a relative reference.</td>
<td></td>
</tr>
<tr>
<td>• ri:content-title: (required) denotes the title of the page.</td>
<td></td>
</tr>
<tr>
<td>• ri:posting-day: (required) denotes the posting day. The format is YYYY/MM/DD.</td>
<td></td>
</tr>
<tr>
<td><strong>Attachment</strong></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| `<ri:attachment ri:filename>`  
... resource identifier for the container of the attachment ...  
`</ri:attachment>` |  
**Notes:**  
- `ri:filename`: (required) denotes the name of the attachment.  
- The body of the `ri:attachment` element should be a resource identifier denoting the container of the attachment. This can be omitted to create a relative attachment reference (similar to `[foo.png]` in wiki markup).  
**Examples:**  
- **Relative Attachment Reference**  
  `<ri:attachment ri:filename="happy.gif" />`  
- **Absolute Attachment Reference**  
  `<ri:attachment ri:filename="happy.gif">  
  `<ri:page ri:space-key="TST" ri:content-title="Test Page"/>  
  </ri:attachment>` |
| **URL** |  
| `<ri:url ri:value="http://example.org/sample.gif"/>` |  
**Notes:**  
- `ri:value`: (required) denotes the actual URL value. |
<table>
<thead>
<tr>
<th><strong>Shortcut</strong></th>
<th><code>&lt;ri:shortcut ri:key=&quot;jira&quot; ri:parameter=&quot;ABC-123&quot;&gt;</code></th>
</tr>
</thead>
</table>
| Notes:       | • `ri:key:` (required) represents the key of the Confluence shortcut.  
• `ri:parameter:` (required) represents the parameter to pass into the Confluence shortcut.  
• The example above is equivalent to `[ABC-123@jira]` in wiki markup. |
| **User**     | `<ri:user ri:username="fred"/>` |
| Notes:       | • `ri:username:` (required) denotes the name of the user. |
| **Space**    | `<ri:space ri:space-key="TST"/>` |
| Notes:       | • `ri:space-key:` (required) denotes the key of the space. |
| **Content Entity** | `<ri:content-entity ri:content-id="123"/>` |
| Notes:       | • `ri:content-id:` (required) denotes the id of the content. |

**Template variables**

This screenshot shows a simple template:
The template contains the following variables:

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>$MyText</td>
<td>Single-line text</td>
<td></td>
</tr>
<tr>
<td>$MyMulti</td>
<td>Multi-line text</td>
<td>Size: 5 x 100</td>
</tr>
<tr>
<td>$MyList</td>
<td>List</td>
<td>List items: Apples, Pears, Peaches</td>
</tr>
</tbody>
</table>

The XML export produces the following code for the template:

```xml
<at:declarations>
  <at:string at:name="MyText" />
  <at:textarea at:columns="100" at:name="MyMulti" at:rows="5" />
  <at:list at:name="MyList">
    <at:option at:value="Apples" />
    <at:option at:value="Pears" />
    <at:option at:value="Peaches" />
  </at:list>
</at:declarations>

<p>This is Sarah's template</p>
<p>A single-line text variable: $MyText</p>
<p>A multi-line text variable: $MyMulti</p>
<p>A selection list: $MyList</p>
<p>End of page.</p>
```

Confluence Storage Format for Macros

Work in progress

We are adding the details for each macro in turn. They are not all here yet. See CONF-24972 - Authenticate to see issue details.

This page is an extension of the page about the Confluence storage format. This page describes the XML used.
to define specific Confluence macros – those that are shipped with Confluence. For each macro, we define the macro name, parameter names, and accepted parameter values.

This information is intended for advanced users who need to interpret and edit the underlying markup for a Confluence page.

**Anchor macro**

Allows you to link to a specific part of a page.

**Macro name:** anchor

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The name of the anchor.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```html
<ac:macro ac:name="anchor">
   <ac:default-parameter>here</ac:default-parameter>
</ac:macro>
```
On this page:

- Anchor macro
- Attachments macro
- Blog Posts macro
- Change-History macro
- Chart macro
- Cheese macro
- Children Display macro
- Code Block macro
- Column macro
- Content by Label macro
- Content by User macro
- Content Report Table macro
- Contributors macro
- Contributors Summary macro
- Create Space Button macro
- Excerpt Include macro
- Excerpt macro
- Expand macro
- Favourite Pages macro
- Gadget macro
- Gallery macro
- Global Reports macro
- HTML Include macro
- HTML macro
- IM Presence macro
- Include Page macro
- Info macro
- JIRA Issues macro
- JUnit Report macro
- Labels List macro
- Livesearch macro
- Loremipsum macro
- Multimedia macro
- Page Properties macro
- Page Properties Report macro
- Section macro
- Table of Contents macro
- Macro format notes
  - Macro bodies
  - Plain text bodies
  - Other notes

Related pages:

- Confluence Storage Format
- Working with Confluence Markup
- Working with Macros
- Confluence User's Guide

Attachments macro
Displays a list of attachments on a given page.

**Macro name:** attachments

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>old</td>
<td>No</td>
<td>false</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false - Displays only the latest version of each attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true – Displays all versions of each attachment, including the old versions.</td>
</tr>
<tr>
<td>patterns</td>
<td>No</td>
<td>(None)</td>
<td>A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match a file suffix of 'jpg', use .*jpg (not .*jpeg).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match file names ending in 'jpg' or 'png', use .*jpg,.*png.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Here is a tutorial on regular expressions.</td>
</tr>
<tr>
<td>sortBy</td>
<td>No</td>
<td>date</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• size</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• name</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page on which the macro exists.</td>
<td>Page name, used to display attachments from another page.</td>
</tr>
</tbody>
</table>
### sortOrder

No

The default sort order is determined by the `sortBy` type:
- Reverse chronological for 'date'.
- Largest to smallest for 'size'.
- Alphabetical for 'name'.

Available values:
- ascending
- descending

### labels

No

(None)

A comma-separated list of labels. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.)

### upload

No

false

Determines whether the list of attachments will include options allowing users to browse for, and attach, new files.

**Example:**

```xml
<ac:macro ac:name="attachments">
  <ac:parameter ac:name="old">false</ac:parameter>
  <ac:parameter ac:name="patterns">.*png,.*jpg</ac:parameter>
  <ac:parameter ac:name="sortBy">name</ac:parameter>
  <ac:parameter ac:name="page">My page about chocolate</ac:parameter>
  <ac:parameter ac:name="sortOrder">descending</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cookies</ac:parameter>
  <ac:parameter ac:name="upload">false</ac:parameter>
</ac:macro>
```

**Blog Posts macro**

Lists the most recent news items in the space.

**Macro name:** blog-posts

**Macro body:** None.
<table>
<thead>
<tr>
<th>content</th>
<th>No</th>
<th>entire</th>
<th>Available values:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>entire</strong> – Display the whole content of each blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>excerpts</strong> – Display a short extract from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>titles</strong> – Display a list of blog posts, showing titles only.</td>
</tr>
</tbody>
</table>

| spaces | No | @self | One or more space keys, separated by a comma or a space. |
To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.

To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:

- * @self — The current space.
- @personal — All personal spaces.
- @global — All site spaces.
- @favorite — The spaces you have marked as favourite.
- @favourite — The same as @favorite above.
- @all — All spaces in your Confluence site.
- * — The same as @all above.
<table>
<thead>
<tr>
<th>Field</th>
<th>Required</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author</td>
<td>No</td>
<td>(None)</td>
<td>One or more usernames, separated by commas.</td>
</tr>
</tbody>
</table>
| time    | No       | (None)      | Available values:  
- m — Minutes  
- h — Hours  
- d — Days  
- w — Weeks  
For example,  
- time=12h — Display blog posts created in the last twelve hours.  
- time=7d — Display blog posts created in the last seven days. |
| reverse | No       | false       | A value of true changes the sort order. |
| sort    | No       | creation    | Available values:  
- title — Sort alphabetically by title.  
- creation — Sort by the date on which the content was added.  
- modified — Sort by the date on which the content was last updated. |
| max     | No       | 15          | The maximum number of results to be displayed. |

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.
| label          | No                  | (None)          | One or more label values, separated by a comma or a space.  
- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of -badpage you will get only content which is not labelled with 'badpage'.  
- To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of +superpage,+goodpage you will get only content which has at least two labels, being 'superpage' and 'goodpage'.

Example:

```xml
<ac:macro ac:name="blog-posts">
<ac:parameter ac:name="content">titles</ac:parameter>
<ac:parameter ac:name="spaces">@self,ds</ac:parameter>
<ac:parameter ac:name="author">jsmith</ac:parameter>
<ac:parameter ac:name="time">4w</ac:parameter>
<ac:parameter ac:name="reverse">true</ac:parameter>
<ac:parameter ac:name="sort">creation</ac:parameter>
<ac:parameter ac:name="max">10</ac:parameter>
<ac:parameter ac:name="label">chocolate,cookies</ac:parameter>
</ac:macro>
```

**Change-History macro**

Displays a history of updates made to a page.

**Macro name:** change-history

**Macro body:** None.
Parameters: None

Example:

```xml
<ac:macro ac:name="change-history"/>
```

Chart macro

Displays a chart based on tabular data.

Macro name: chart

Macro body: Accepts rich text, consisting of tables that hold the chart’s data.

This macro recognises a large number of parameters, listed here by type for convenience.

Chart type parameters

These parameters determine the type of chart to display and how the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>No</td>
<td>pie</td>
<td>The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based. See the <code>timeSeries</code> parameter. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>Standard charts</strong> – pie, bar, line, area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>XY plots</strong> – xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>Other charts</strong> – gantt (beta)</td>
</tr>
<tr>
<td>orientation</td>
<td>No</td>
<td>vertical</td>
<td>The display orientation. Applies to area, bar and line charts. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• vertical – y-axis is vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• horizontal – x-axis is vertical</td>
</tr>
</tbody>
</table>
### Chart display parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
</tbody>
</table>
| dataDisplay | No       | false   | Determines whether to display the body of the macro, consisting of the data table. By default, the chart data table is not displayed. Available values:  
- false – the data is not displayed.  
- true or after – the data is displayed after the chart.  
- before – the data is displayed before the chart. |
| imageFormat | No       | png     | The image format to be used for the chart. Available values:  
- png  
- jpg |
### Chart data parameters

The data for the chart is taken from tables found in the macro body. The parameters below control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. You can specify additional conversion options using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tables</td>
<td>No</td>
<td>All first level tables</td>
<td>You can supply a comma-separated list of table IDs and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>Setting</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>All columns</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can supply a comma-separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the HTML title attribute for the column in the header row.</td>
<td></td>
</tr>
<tr>
<td>dataOrientation</td>
<td>No</td>
<td>horizontal</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The content orientation. By default, the data tables will be interpreted as columns (horizontally) representing domain and x values.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• vertical – data table columns will be interpreted as series.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• horizontal – data tables rows will be interpreted as series.</td>
<td></td>
</tr>
<tr>
<td>timeSeries</td>
<td>No</td>
<td>false</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If 'true', the x values in an XY plot will be treated as time series data and so will be converted according date formats.</td>
<td></td>
</tr>
<tr>
<td>dateFormat</td>
<td>No</td>
<td>Confluence language defined date formats</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For time series data, the date format allows for additional customisation of the conversion of data to date values. If a date Format is specified, it will be the first format used to interpret date values. Specify a format that matches the time series data. See simple date format.</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>timePeriod</td>
<td>No</td>
<td>day</td>
<td>The time period for time series data. Defines the granularity of how the data is interpreted. Available values: millisecond, second, minute, hour, day, week, month, quarter, year</td>
</tr>
<tr>
<td>language</td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the country parameter to form a locale. These additional number and date formats will be used for data conversion before the default languages. Available values are the two-character ISO 639-1 alpha-2 codes.</td>
</tr>
<tr>
<td>country</td>
<td>No</td>
<td>(None)</td>
<td>Use in combination with the language parameter to form a locale. Valid values are the two-character ISO 3166 codes.</td>
</tr>
<tr>
<td>forgive</td>
<td>No</td>
<td>true</td>
<td>Determines whether the macro will forgive (allow) some data formatting errors. Available values: • true — the macro tries to convert numeric and date values that do not totally match any of the default or user-specified formats. • false — the macro enforces strict data formatting. If there are data format errors, the chart will not be produced.</td>
</tr>
</tbody>
</table>

**Chart colour parameters**

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Colours are specified using hexadecimal notation or HTML colour names.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bgColor</td>
<td>No</td>
<td>White</td>
<td>Background colour of the chart.</td>
</tr>
<tr>
<td>borderColor</td>
<td>No</td>
<td>No border</td>
<td>Colour of the border around the chart.</td>
</tr>
<tr>
<td>colors</td>
<td>No</td>
<td></td>
<td>A comma-separated list of colours used to customise the colours of categories, sections, and series.</td>
</tr>
</tbody>
</table>

**Chart axis parameters**

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rangeAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Minimum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Maximum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td>rangeAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>domainAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
</tr>
<tr>
<td>domainAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>domainAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the timePeriod parameter. The timePeriod unit can be overridden by specifying a trailing character: y (years), M (months), d (days), h (hours), m (minutes), s (seconds), u (milliseconds).</td>
</tr>
<tr>
<td>domainAxisLabelAngle</td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. The angle for the domain axis label, in degrees.</td>
</tr>
<tr>
<td>categoryLabelPosition</td>
<td>No</td>
<td>(None)</td>
<td>Placement of the axis label text for categories. Available values: up45 — 45 degrees going upward up90 — 90 degrees going upward down45 — 45 degrees going downward down90 — 90 degrees going downward</td>
</tr>
<tr>
<td>dateTickMarkPosition</td>
<td>No</td>
<td>start</td>
<td>Placement of the date tick mark. Available values: start — tick mark is at the start of the date period. middle — tick mark is in the middle of the date period. end — tick mark is at the end of the date period.</td>
</tr>
</tbody>
</table>

**Pie chart Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| pieSectionLabel    | No       | Show only the pie section key value | Format of pie section labels. The format uses a string with special replacement variables:  
  - `%0%` is replaced by the pie section key.  
  - `%1%` is replaced by the pie section numeric value.  
  - `%2%` is replaced by the pie section percent value.  
  Example 1: To display something like 'Independent = 20':  
    ![Example 1](image)  
  Example 2: To display something like 'Independent (20%)':  
    ![Example 2](image) |
| pieSectionExplode  | No       | No exploded sections | A comma-separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher. |

**Chart attachment parameters**

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access to re-use the attachment. This can be useful especially when combined with the Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.
<table>
<thead>
<tr>
<th>attachment</th>
<th>No</th>
<th>(None)</th>
</tr>
</thead>
</table>

The name and location where the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.

Available syntax for this parameter:

- `^attachmentName.png` — the chart is saved as an attachment to the current page.
- `page name^attachmentName.png` — the chart is saved as an attachment to the page name provided.
- `spacekey:page name^attachmentName.png` — the chart is saved as an attachment to the page name provided in the space indicated.
| attachmentVersion | No | new | Defines the the versioning mechanism for saved charts. Available values:  
|                  |    |     | • new — creates new version of the attachment.  
|                  |    |     | • replace — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorised to remove attachments for the page specified.  
|                  |    |     | • keep — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.  
| attachmentComment| No | (None) | Comment used for a saved chart attachment.  
| thumbnail        | No | false | If true, the chart image attachment will be shown as a thumbnail (small, expandable) image.  

**Example:**

Below is a simple example of a pie chart. See more examples in Storage Format Examples for Chart Macro.
<ac:macro ac:name="chart">
<ac:parameter ac:name="title">Fish Sold</ac:parameter>
<ac:parameter ac:name="type">pie</ac:parameter>
<ac:rich-text-body>
<table>
<thead>
<tr>
<th>Fish Type</th>
<th>2004</th>
<th>2005</th>
</tr>
</thead>
<tbody>
<tr>
<th>Herring</th>
<td>9,500</td>
<td>8,300</td>
</tr>
<tr>
<th>Salmon</th>
<td>2,900</td>
<td>4,200</td>
</tr>
<tr>
<th>Tuna</th>
<td>1,500</td>
<td>1,500</td>
</tr>
</tbody>
</table>
</ac:rich-text-body>
</ac:macro>

**Cheese macro**

Displays the words "I like cheese!"

**Macro name:** cheese
**Macro body**: None.

**Parameters**: None

**Example**:

```
<ac:macro ac:name="cheese"/>
```

---

**Children Display macro**

Displays the children and descendants of the current page.

**Macro name**: children

**Macro body**: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the sort order in the list of child pages. Use this parameter in conjunction with the sort parameter described below. A value of true will change the sort order from ascending to descending.</td>
</tr>
</tbody>
</table>
| sort           | No       | Manual if the pages have been manually reordered, otherwise alphabetical by page title | Determines the sort order of the list of child pages. Available values:

- creation – Sort by the date on which the page was created.
- title – Sort alphabetically by page name.
- modified – Sort by the date on which the page was last updated.

<p>| style          | No       | Bullet list | A heading style to be applied to the list of child pages. Available values: h1 (heading level 1) through to h6 (heading level 6). |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>The page that contains the macro. The name of the parent page. The macro will display the children of the specified page. To specify a page in a different space, use a space key followed by a colon. For example: MYSPACE:My page. If the value of this parameter is a forward slash (/) the macro will list the pages at the root of the current space. In other words, the pages without parents.</td>
</tr>
<tr>
<td>excerpt</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>first</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>depth</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>all</td>
<td>No</td>
<td>false</td>
</tr>
</tbody>
</table>

**Example:**
**Code Block macro**

Displays code in your document with the appropriate syntax highlighting.

**Macro name:** code

**Macro body:** Accepts plain text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Adds a title to the code macro box.</td>
</tr>
<tr>
<td>theme</td>
<td>No</td>
<td>Confluence</td>
<td>Specifies the colour scheme used for displaying your code. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. Available themes:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DJango</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Emacs</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FadeToGrey</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Midnight</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RDark</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Eclipse</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Confluence (same as default)</td>
</tr>
<tr>
<td><strong>linenumbers</strong></td>
<td><strong>No</strong></td>
<td><strong>false</strong></td>
<td>If true, a line number will be shown to the left of each line of code. Numbering is incremented by 1. If false, no line numbers are shown.</td>
</tr>
<tr>
<td>----------------</td>
<td>--------</td>
<td>-----------</td>
<td>-------------------------------------------------</td>
</tr>
</tbody>
</table>
| **language**   | **No** | **java**  | Specifies the language (or environment) for syntax highlighting.  
|                |        |           | - (none) — that is, no syntax highlighting  
|                |        |           | - actionscript3  
|                |        |           | - bash  
|                |        |           | - csharp — that is, C#  
|                |        |           | - coldfusion  
|                |        |           | - cpp — that is, C++  
|                |        |           | - css  
|                |        |           | - delphi  
|                |        |           | - diff  
|                |        |           | - erlang  
|                |        |           | - groovy  
|                |        |           | - java  
|                |        |           | - javafx  
|                |        |           | - javascript  
|                |        |           | - perl  
|                |        |           | - php  
|                |        |           | - powershell  
|                |        |           | - python  
|                |        |           | - ruby  
|                |        |           | - scala  
|                |        |           | - sql  
|                |        |           | - vb — that is, Visual Basic  
<p>|                |        |           | - html/xml |</p>
<table>
<thead>
<tr>
<th><strong>firstline</strong></th>
<th><strong>No</strong></th>
<th><strong>1</strong></th>
<th>When linenumbers is true, this value defines the number of the first line of code.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Markup</td>
<td>What you will get</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------</td>
<td></td>
</tr>
</tbody>
</table>
| Code block macro with a body and no optional parameters | `<ac:macro ac:name="code">
<ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>` | this is my code         |
| Code block macro with a body and the optional `language` parameter defined | `<ac:macro ac:name="code">
<ac:parameter ac:name="language">html/xml</ac:parameter>
<ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>` | this is my code         |
Code block macro with a body and optional title, line numbers and language parameters defined

```
<ac:macro ac:name="code">
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:parameter ac:name="linenumbers">true</ac:parameter>
  <ac:parameter ac:name="language">html/xml</ac:parameter>
  <ac:plain-text-body><![CDATA[this is my code]]></ac:plain-text-body>
</ac:macro>
```

This is my title
this is my code

---

**Column macro**

Used with the Section macro to define columns on a page. See [Working with page layouts and columns and sections](#).

**Macro name:** column

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>The width of the column. Can be specified either in pixels (for example, 400px) or as a percentage of the available page width (for example, 50%).</td>
</tr>
</tbody>
</table>

**Example:**

```
<ac:macro ac:name="column">
  <ac:parameter ac:name="width">100px</ac:parameter>
  <ac:rich-text-body>
    <p>This is the content of <strong>column 1</strong>.</p>
  </ac:rich-text-body>
</ac:macro>
```

---

**Content by Label macro**

Displays a list of content associated with specific labels.

**Macro name:** contentbylabel

---

* Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#). *
**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| spaces         | No       | @all    | Filters the results by space. The macro will display only the pages and other content types which belong to the space(s) you specify here. You can specify one or more space keys, separated by a comma or a space.  
  - To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of -BADSPACE you will get only content which is not in the BADSPACE.  
  - To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.) |
<table>
<thead>
<tr>
<th>Filter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@self</td>
<td>No</td>
<td>(None)</td>
<td>The current space.</td>
</tr>
<tr>
<td>@personal</td>
<td>No</td>
<td>(None)</td>
<td>All personal spaces.</td>
</tr>
<tr>
<td>@global</td>
<td>No</td>
<td>(None)</td>
<td>All site spaces.</td>
</tr>
<tr>
<td>@favorite</td>
<td>No</td>
<td>(None)</td>
<td>The spaces you have marked as favourite.</td>
</tr>
<tr>
<td>@favourite</td>
<td>No</td>
<td>(None)</td>
<td>The same as @favorite above.</td>
</tr>
<tr>
<td>@all</td>
<td>No</td>
<td>(None)</td>
<td>All spaces in your Confluence site.</td>
</tr>
<tr>
<td>@all</td>
<td>No</td>
<td>(None)</td>
<td>The same as @all above.</td>
</tr>
</tbody>
</table>

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~jbloggs@example.com.

<table>
<thead>
<tr>
<th>Filter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author</td>
<td>No</td>
<td>(None)</td>
<td>Filters the results by author. The macro will display only the pages and other content types which are written or updated by the author(s) you specify here. You can specify one or more authors, separated by a comma. For example: jsmith, jbrown</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Adds a heading to the list.</td>
</tr>
<tr>
<td>showLabels</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the matching labels in the list of results.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Use this parameter in conjunction with the sort parameter. Set reverse=true to change the sort from ascending to descending. This parameter is ignored if the sort parameter is not specified.</td>
</tr>
</tbody>
</table>
| sort      | No    | modified    | Determines how the results are sorted. To change the sort order from ascending to descending, use the reverse parameter described above. If this parameter is not specified, the sort order defaults to descending order based on the last modification date. Values:  
  - title — Sort alphabetically by title.  
  - creation — Sort by the date on which the content was added.  
  - modified — Sort by the date on which the content was last updated. |
<p>| max       | No    | 15          | Determines the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied. |
| excerpt | No | false | If this parameter is set to <code>true</code>, the macro displays an excerpt from each page listed in the results. Note that you must define the excerpts on each of those pages, by adding the Excerpt macro to each page. If a particular page does not have an excerpt defined, then the Content by Label macro will not attempt to show an excerpt for that page. The Content by Label macro will show only the first few lines of the excerpt for each page. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>labels</td>
<td>Yes</td>
<td>(None)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>showSpace</td>
<td>No</td>
<td>true</td>
</tr>
</tbody>
</table>
| type  | No | All | Filters the results by content type. The macro will display only the content of the type you specify here.  

You can specify one or more types, separated by a comma or a space.  
To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of -blogpost you will get pages and all other content except for blog posts.  
Available values:  
- page — pages.  
- blogpost or news — blog posts, also known as news items.  
- attachment — attachments. |
|---|---|---|---|
### Operator

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>No operation</td>
</tr>
<tr>
<td>OR</td>
<td>Logical OR</td>
</tr>
</tbody>
</table>

The operator to apply to the supplied lists of labels. By default, a page with **any** of the non-prefixed labels (that is, labels without a plus (+) or minus (-) sign immediately preceding it) will be listed. If you specify a value of **AND**, only pages with **all** of the supplied non-prefixed labels will be listed.

Note that this parameter only modifies the behaviour of the 'Label(s)' parameter and only affects label values without a plus (+) or minus (-) sign prefix. To avoid confusion or unexpected results, we recommend that you do not use the `operator` parameter in conjunction with any label values prefixed with '+' or '-' signs.

#### Example:

```xml
<ac:macro ac:name="contentbylabel">
  <ac:parameter ac:name="spaces">@personal,@self</ac:parameter>
  <ac:parameter ac:name="author">admin,smaddox</ac:parameter>
  <ac:parameter ac:name="title">My labelled pages</ac:parameter>
  <ac:parameter ac:name="showLabels">false</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">creation</ac:parameter>
  <ac:parameter ac:name="max">10</ac:parameter>
  <ac:parameter ac:name="excerpt">true</ac:parameter>
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>
  <ac:parameter ac:name="showSpace">false</ac:parameter>
  <ac:parameter ac:name="type">page</ac:parameter>
  <ac:parameter ac:name="operator">AND</ac:parameter>
</ac:macro>
```

**Content by User macro**

Displays a list of the content items that have been created by a specified Confluence user.

**Macro name:** `content-by-user`
Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The Confluence username for the person whose content you wish to display</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="content-by-user">  
  <ac:default-parameter>jsmith</ac:default-parameter>
</ac:macro>
```

**Content Report Table macro**

Displays a set of pages and blog posts in tabular format, based on the labels specified in the macro parameters.

**Macro name:** content-report-table

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaces</td>
<td>No</td>
<td>(None)</td>
<td>This parameter is required. Specify one or more labels, separated by a comma. The macro will display only the content tagged with the label(s) specified here.</td>
</tr>
<tr>
<td>labels</td>
<td>Yes</td>
<td>(None)</td>
<td>Specify one or more space keys, separated by a comma or a space. The macro will display only the content which belongs to the space(s) specified here. When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbloggs or ~<a href="mailto:jbloggs@example.com">jbloggs@example.com</a></td>
</tr>
</tbody>
</table>

Example:
Contributors macro

Displays a list of Confluence users who have made a contribution of some type to a page.

**Macro name:** contributors

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors displayed in the list.</td>
</tr>
</tbody>
</table>
| spaces         | No       | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
|                |          |           | - @global — All sitespaces.  
|                |          |           | - @personal — All personal spaces.  
<p>|                |          |           | - @all — All spaces in the Confluence site. |
| reverse        | No       | false     | Reverses the order of contributors in the list. Must be used in conjunction with the order parameter. |</p>
<table>
<thead>
<tr>
<th><strong>Parameter</strong></th>
<th><strong>Default</strong></th>
<th><strong>Description and Examples</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>scope</td>
<td>No</td>
<td>The specified page only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specifies additional pages to include when generating the list of contributors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Available values:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- children – only the child pages of the specified page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- descendants – all descendants of the specified page.</td>
</tr>
<tr>
<td>labels</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limits the list of contributors to those who created the specified labels on a page. You can specify one or more labels, separated by commas.</td>
</tr>
<tr>
<td>showPages</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the value is true, the macro will display a list of the pages used to generate the list of contributors.</td>
</tr>
<tr>
<td>noneFoundMessage</td>
<td>No</td>
<td>&quot;No contributors found for:” (and a summary of selected parameter values)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any message given here will override the default message that is displayed when no contributors are found.</td>
</tr>
<tr>
<td>showCount</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Determines whether the macro will show the number of times each person made a contribution.</td>
</tr>
<tr>
<td>contentType</td>
<td>No</td>
<td>Both pages and blog posts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Restricts the content type that the macro will use when generating the list of contributors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Available values:</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pages – pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- blogposts – blog posts</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>include</td>
<td>No</td>
<td>authors</td>
</tr>
<tr>
<td>mode</td>
<td>No</td>
<td>inline</td>
</tr>
<tr>
<td>showAnonymous</td>
<td>No</td>
<td>false</td>
</tr>
</tbody>
</table>
| order | No | count | Specifies the criteria used to sort contributors. Sort criteria are:  
- **count** – sorts the names based on the total number of contributions to the page(s)  
- **name** – sorts the names into alphabetical order  
- **update** – sorts the names by the date of their last contribution to the page(s). |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>The current page</td>
<td>Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed.</td>
</tr>
<tr>
<td>showLastTime</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show the last time each person made a contribution.</td>
</tr>
<tr>
<td>publishDate</td>
<td>No</td>
<td>(None)</td>
<td>Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.</td>
</tr>
</tbody>
</table>

**Example:**

This example specifies a content type of blog posts:

```xml
<ac:macro ac:name="contributors">  
  <ac:parameter ac:name="limit">10</ac:parameter>  
  <ac:parameter ac:name="spaces">ds,@personal</ac:parameter>  
  <ac:parameter ac:name="reverse">true</ac:parameter>  
  <ac:parameter ac:name="labels">chocolate,cake</ac:parameter>  
  <ac:parameter ac:name="showPages">true</ac:parameter>  
  <ac:parameter ac:name="noneFoundMessage">Oh dear, no contributors found</ac:parameter>  
  <ac:parameter ac:name="showCount">true</ac:parameter>  
  <ac:parameter ac:name="contentType">blogposts</ac:parameter>  
  <ac:parameter ac:name="include">authors,comments,labels,watches</ac:parameter>  
  <ac:parameter ac:name="mode">list</ac:parameter>  
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>  
  <ac:parameter ac:name="order">update</ac:parameter>  
  <ac:parameter ac:name="showLastTime">true</ac:parameter>  
  <ac:parameter ac:name="publishDate">2012/06/30</ac:parameter>  
</ac:macro>
```
This example specifies a content type of pages:

```xml
<ac:macro ac:name="contributors">
  <ac:parameter ac:name="limit">10</ac:parameter>
  <ac:parameter ac:name="spaces">ds, @personal</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="scope">descendants</ac:parameter>
  <ac:parameter ac:name="labels">chocolate, cake</ac:parameter>
  <ac:parameter ac:name="showPages">true</ac:parameter>
  <ac:parameter ac:name="noneFoundMessage">Oh dear, no contributors found</ac:parameter>
  <ac:parameter ac:name="showCount">true</ac:parameter>
  <ac:parameter ac:name="contentType">pages</ac:parameter>
  <ac:parameter ac:name="include">authors, comments, labels, watches</ac:parameter>
  <ac:parameter ac:name="mode">list</ac:parameter>
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>
  <ac:parameter ac:name="order">update</ac:parameter>
  <ac:parameter ac:name="page">ds: Advanced Topics</ac:parameter>
  <ac:parameter ac:name="showLastTime">true</ac:parameter>
</ac:macro>
```

**Contributors Summary macro**

Displays a table of contribution-based statistics for a set of pages.

**Macro name:** contributors-summary

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors or pages displayed in the table.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
</tbody>
</table>
| spaces | No | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
  - @global — All site spaces.  
  - @personal — All personal spaces.  
  - @all — All spaces in the Confluence site. You can specify one or more space keys or special values, separated by commas. If no page and labels are specified, all pages from the specified set of spaces are included. |
| reverse | No | false | Reverses the order of items in the table. Must be used in conjunction with the order parameter. |
| showAnonymous | No | false | Determines whether to include those who contributed anonymously to a page. |
| scope | No | The specified page only | Specifies additional pages to include when generating the list of contributors. Available values:  
  - children — only the child pages of the specified page.  
  - descendants — all descendants of the specified page. |
| order | No | edits | Sets the criterion used for sorting items in the table. Available values:
- **edits** - sorts items in the table based on the total number of edits made, either by a contributor or to a page.
- **name** - sorts items in the table in alphabetical order, either by contributor or page name.
- **editTime** - sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.
- **update** - sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it. |
| page | No | The current page | A page title. Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed. |
| labels | No | (None) | Limits contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas. |
| columns | No | edits, comments, labels | |
Determines the columns that should appear in the table. The statistics or type of information presented depends on the `groupby` parameter.

Available values:

- `edits` – the number of times each contributor has edited the page(s) or the number of edits made to each page.
- `edited` – a list of the pages edited by each contributor or a list of contributors who have edited each page.
- `comments` – the number of times each contributor has added comments to the page(s) or the number of comments on each page.
- `commented` – a list of pages to which each contributor has added comments or a list of contributors who have commented on each page.
- `labels` – the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- `labeled` – a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- `labellist` – a list of labels either added by each contributor or on each page.
<table>
<thead>
<tr>
<th>Column</th>
<th>Default</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>watches</td>
<td>No</td>
<td>contributors</td>
<td>the number of pages being watched by each contributor/person or the number of contributors/people watching each page.</td>
</tr>
<tr>
<td>watching</td>
<td>No</td>
<td>contributors</td>
<td>a list of pages being watched by each contributor/person or a list of contributors/people watching each page.</td>
</tr>
<tr>
<td>lastupdate</td>
<td>No</td>
<td>contributors</td>
<td>the last time each contributor made an update or when each page was last updated. Valid updates can include edits, comments or label modifications to a page.</td>
</tr>
</tbody>
</table>

You can specify one or more columns, separated by commas.

| groupby    | No      | contributors            | Specifies the basis for grouping contribution-based statistics: |
|           |         |                         | • contributors – group by the people who have contributed. |
|           |         |                         | • pages – group by the pages used to find the contributors. |

| contentType | No      | Both pages and blog posts | Restricts the content type that the macro will use when generating the list of contributors. |
|            |         |                          | Available values: |
|            |         |                          | • pages – pages |
|            |         |                          | • blogposts – blog posts. |
showZeroCounts | No | false | Determines whether contributors or pages are included for which the calculated statistic is zero.

publishDate | No | (None) | Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.

Example:

This example specifies a content type of blog posts:

```xml
<ac:macro ac:name="contributors-summary">
  <ac:parameter ac:name="limit">10</ac:parameter>
  <ac:parameter ac:name="spaces">ds, @personal</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>
  <ac:parameter ac:name="order">update</ac:parameter>
  <ac:parameter ac:name="labels">chocolate, cake</ac:parameter>
  <ac:parameter ac:name="columns">edits, comments, labels, lastupdate</ac:parameter>
  <ac:parameter ac:name="groupby">pages</ac:parameter>
  <ac:parameter ac:name="contentType">blogposts</ac:parameter>
  <ac:parameter ac:name="showZeroCounts">true</ac:parameter>
  <ac:parameter ac:name="publishDate">2012/06/07</ac:parameter>
</ac:macro>
```

This example specifies a content type of pages:

```xml
<ac:macro ac:name="contributors-summary">
  <ac:parameter ac:name="limit">10</ac:parameter>
  <ac:parameter ac:name="spaces">ds, @personal</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="showAnonymous">true</ac:parameter>
  <ac:parameter ac:name="scope">descendants</ac:parameter>
  <ac:parameter ac:name="order">update</ac:parameter>
  <ac:parameter ac:name="page">ds:Advanced Topics</ac:parameter>
  <ac:parameter ac:name="labels">chocolate, cake</ac:parameter>
  <ac:parameter ac:name="columns">edits, comments, labels, lastupdate</ac:parameter>
  <ac:parameter ac:name="groupby">pages</ac:parameter>
  <ac:parameter ac:name="contentType">pages</ac:parameter>
  <ac:parameter ac:name="showZeroCounts">true</ac:parameter>
</ac:macro>
```

Create Space Button macro

Displays a create space button linked to the create space page.

**Macro name:** create-space-button

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| size           | No       | large   | Determines the size of the 'create space' icon displayed. Available values:  
|                |          |         | • large  
|                |          |         | • small |
| width          | No       | Natural size of icon (1:1 pixel ratio) | The width of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the width of the icon to the number of pixels specified.  
|                |          |         | Note: This parameter is not available via the macro browser. |
| height         | No       | Natural size of icon (1:1 pixel ratio) | The height of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the height of the icon to the number of pixels specified.  
|                |          |         | Note: This parameter is not available via the macro browser. |

Example:

```xml
<ac:macro ac:name="create-space-button">
  <ac:parameter ac:name="size">small</ac:parameter>
</ac:macro>
```

**Excerpt Include macro**

Allows you to display an excerpt from another page within the current page.

**Macro name:** excerpt-include

**Macro body:** None.
Excerpt macro

Define a part of a page as the page's 'excerpt' which can then be displayed in another page.

Macro name: excerpt

Macro body: Accepts rich text.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>hidden</td>
<td>No</td>
<td>False</td>
<td>Determines whether the content of the Excerpt macro body is displayed on the page that contains the Excerpt macro. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.</td>
</tr>
</tbody>
</table>
| atlassian-macro-output-type                 | No       | BLOCK   | Determines whether the content of the Excerpt macro body is displayed on a new line or inline. Available values:  
  - BLOCK – Displays the content of the macro on a new line.  
  - INLINE – Displays the content of the macro as part of the same paragraph as the text preceding and following it. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused. |

**Example:**

```xml
<ac:macro ac:name="excerpt">
  <ac:parameter ac:name="hidden">true</ac:parameter>
  <ac:parameter ac:name="atlassian-macro-output-type">BLOCK</ac:parameter>
  <ac:rich-text-body>
    <p>This is the &lt;strong&gt;text&lt;/strong&gt; I want to reuse in other pages. This text is inside an Excerpt macro.&lt;/p&gt;
  </ac:rich-text-body>
</ac:macro>
```

**Expand macro**

Displays an expandable/collapsible section of text.
Macro name: expand

Macro body: Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>No</td>
<td>Click here to expand...</td>
<td>Text that will be displayed on the line that people can click to expand the hidden text.</td>
</tr>
</tbody>
</table>

(Unnamed in wiki markup)

Example:

```xml
<ac:macro ac:name="expand">
  <ac:default-parameter>This is my message</ac:default-parameter>
  <ac:rich-text-body>
    <p>This text is <em>hidden</em> until you expand it.</p>
  </ac:rich-text-body>
</ac:macro>
```

Favourite Pages macro

Displays a list of your favourite pages.

Macro name: favpages

Macro body: None.

Parameters: None.

Example:

```xml
<ac:macro ac:name="favpages"/>
```

Gadget macro

Allows you to add Confluence gadgets to pages or blog posts.

Macro name: gadget

Macro body: None.
<table>
<thead>
<tr>
<th>Property</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| width    | No       | 450 pixels | The width of the gadget, using one of the following conventions:  
- Width in pixels, using px or plain numbers. For example, 500px or 500  
- A percentage of the page width, using %. For example, 50%  
- Automatic resizing of the gadget to fit 100% of the page width: auto |
| border   | No       | true    | Determines whether Confluence will draw a border around the gadget. |
| url      | Yes      | (none.) | This is the location of the gadget specification (XML file). |
| preferences | No   | (Gadget-dependent.) | Specific property settings that are particular to each gadget. |

**A note about editing a gadget’s properties (preferences) in markup:** It is possible to edit the values of these properties directly in the wiki markup or storage format. However, this will allow the entry of invalid values. If a gadget property supports a certain set of values, the macro browser will restrict the user to selecting only valid values for that property. For that reason, we recommend that you use the macro browser to edit a gadget’s properties.

**Example:**

This example shows the Confluence Page gadget:

```xml
<ac:macro ac:name="gadget">  
    <ac:parameter ac:name="width">500</ac:parameter>  
    <ac:parameter ac:name="border">false</ac:parameter>  
    <ac:parameter ac:name="url">rest/gadgets/1.0/g/com.atlassian.confluence.plugins.gadgets:confluence-page-gadget/gadgets/confluence-page-gadget.xml</ac:parameter>  
    <ac:parameter ac:name="preferences">spaceName=Documentation&spaceKey=DOC&quickfind-space=Documentation&pageId=753666&pageName=Documentation%20Home&quickfind-page=Documentation%20Home&isEditable=true&isConfigured=true&refresh=15&amp;showLink=false</ac:parameter>  
</ac:macro>
```

This example shows the Confluence News gadget:
### Gallery macro

Forms a thumbnail gallery of all images attached to a page.

**Macro name:** gallery

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Specify a title to be displayed above your gallery of pictures.</td>
</tr>
</tbody>
</table>
| reverse        | No       | Not specified. Sort order is ascending. | Used in combination with the sort parameter, to change the sort order from ascending to descending. Available values:  
  - true – Sort order is descending.  
  - false – Sort order is ascending. |
| sort           | No       | None. The sort order is unspecified and therefore unpredictable. | Specify an attribute to sort the images by. Sort order is ascending, unless you specify the reverse parameter. Available values:  
  - name – file name.  
  - comment – comment linked to the attached file.  
  - date – date/time last modified.  
  - size – size of the attached file. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>If no page is specified, the gallery macro displays the images attached to the page on which the macro is used. Specify the title of the page which contains the images you want displayed. You can specify more than one page name, separated by commas. To specify a page in a different space, use the following syntax: SPACEKEY:Page title.</td>
</tr>
<tr>
<td>includeLabel</td>
<td>No</td>
<td>None. The images are not filtered by label. The gallery will include only those pictures that have the specified label. If you wish to enter more than one label, separate the labels with commas. Confluence will show only images that have all the labels specified. (The match is an AND, not an OR.) For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>excludeLabel</td>
<td>No</td>
<td>No exclusions. The gallery will include all the pictures on the page. The gallery will ignore any pictures that have the specified label. You can specify more than one label, separated by commas. For information on labelling the attachments, see Adding Labels.</td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>4</td>
</tr>
</tbody>
</table>
### Exclude

**No**

No exclusions. Include all the pictures on the page.

Specify images by file name. The gallery will ignore any images specified. You can specify more than one image, separated by commas. Note: The file name and file type for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.

### Include

**No**

Include all the pictures on the page.

If you specifically include one or more pictures, the gallery will show only those pictures. You can specify more than one picture, separated by commas. Note: The file name and file type for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.

### Example:

```xml
<ac:macro ac:name="gallery">
  <ac:parameter ac:name="title">My holiday pictures</ac:parameter>
  <ac:parameter ac:name="reverse">true</ac:parameter>
  <ac:parameter ac:name="sort">size</ac:parameter>
  <ac:parameter ac:name="page">My page1, ds:Welcome to Confluence</ac:parameter>
  <ac:parameter ac:name="excludeLabel">badlabel1, badlabel2</ac:parameter>
  <ac:parameter ac:name="columns">3</ac:parameter>
  <ac:parameter ac:name="exclude">badpicture.png</ac:parameter>
</ac:macro>
```

### Global Reports macro

Displays a list of links to global reports within a table.

**Macro name:** global-reports

**Macro body:** None.
| width | No | 99% | Specify the width of the table in which the links are displayed, as a percentage of the window width. |

**Example:**

```
<ac:macro ac:name="global-reports">
  <ac:parameter ac:name="width">50%</ac:parameter>
</ac:macro>
```

**HTML Include macro**

Includes the content of an external HTML file into a Confluence page.

**Macro name:** html-include

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>Yes</td>
<td>(None)</td>
<td>Specify a URL of the content to be included into your Confluence page.</td>
</tr>
</tbody>
</table>

**Example:**

```
<ac:macro ac:name="html-include">
  <ac:parameter ac:name="url">http://www.example.com</ac:parameter>
</ac:macro>
```

**HTML macro**

Renders your specified HTML code within the current page.

**Macro name:** html

**Macro body:** Text, consisting of HTML code.

**Parameters:** None.

**Example:**

```
<ac:macro ac:name="html">
  <ac:plain-text-body><![CDATA[<a href="http://www.atlassian.com">Click here</a> to see the <b>Atlassian</b> website.]]></ac:plain-text-body>
</ac:macro>
```

**IM Presence macro**
Displays graphically when a contact is online.

**Macro name:** im

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| showid         | No       | true    | Determines whether the macro shows or hides the user ID of the contact. Available values:  
  * true – User ID is shown on the page.  
  * false – User ID is not shown on the page. |
| service        | Yes      | Not specified. | The web service that Confluence should query. Available values:  
  * aim – AOL Instant Messenger  
  * gtalk – Google Talk  
  * icq – ICQ  
  * jabber – Jabber  
  * msn – MSN Instant Messenger  
  * sametime – IBM Lotus Sametime  
  * skype – Skype  
  * skypeme – Skype  
  * wildfire – Openfire Server  
  * yahoo – Yahoo! Messenger |
| default-parameter | Yes | Not specified. | User ID. Identifies the IM contact by their ID, account name or screen name. |

**Example:**

```xml
<ac:macro ac:name="im">
  <ac:parameter ac:name="showid">false</ac:parameter>
  <ac:parameter ac:name="service">skype</ac:parameter>
  <ac:default-parameter>MySkypeName</ac:default-parameter>
</ac:macro>
```
Include Page macro

Inserts the contents of the specified page into the current one.

Macro name: include

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None.)</td>
<td>The name of the page whose content should be included on the current page</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td>To include content from a page in another space, type the space key followed by a colon (:) and the page name, like this:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SPACEKEY:My page name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>To include a blog post, specify the date as well as the title of the blog post. For example: /2010/12/01/My blog post.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>You can include pages from personal spaces using ~username as the space key, where 'username' is the person's username. For example, ~jsmith:My page name.</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="include">
   <ac:default-parameter>DOC:My chocolate page</ac:default-parameter>
</ac:macro>
```

Info macro

Displays a block of text in a blue highlight box.

Macro name: info
Macro body: Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the icon in the title bar of the information box.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the information box. If specified, the title text will be displayed in bold next to the icon.</td>
</tr>
</tbody>
</table>

Example:

The following example shows all parameters and a body:

```xml
<ac:macro ac:name="info">
  <ac:parameter ac:name="icon">false</ac:parameter>
  <ac:parameter ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:macro>
```

Below are some examples of the Info macro with various optional parameters used.

<table>
<thead>
<tr>
<th>Description</th>
<th>Markup</th>
<th>What you will get</th>
</tr>
</thead>
</table>
| Info macro with a body defined and no optional parameters | `<ac:macro ac:name="info">
  <ac:rich-text-body>
    <p>This is <em>important</em> information.</p>
  </ac:rich-text-body>
</ac:macro>` | !Important This is important information. |
Info macro with a body and an optional *Title* parameter defined

```xml
<ac:macro
ac:name="info">
  <ac:parameter
ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
<p>This is *important* information.</p>
</ac:macro>
```

Info macro with a body and optional *Title* and *Icon* parameters defined

```xml
<ac:macro
ac:name="info">
  <ac:parameter
ac:name="icon">false</ac:parameter>
  <ac:parameter
ac:name="title">This is my title</ac:parameter>
  <ac:rich-text-body>
<p>
  <span>This is </span>
  <em>important</em>
  <span>information.</span>
</p>
</ac:macro>
```

**JIRA Issues macro**

Displays a list of JIRA issues in a page.

**Macro name:** jiraissues

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>anonymous</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>baseurl</td>
<td>No</td>
<td>The value of the 'url' parameter</td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>By default, the following columns are shown: type, key, summary, assignee, reporter, priority, status, resolution, created, updated, due</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>count</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>cache</td>
<td>No</td>
<td>on</td>
</tr>
</tbody>
</table>
| height    | No      | 480   | The height in pixels of the table displaying the JIRA issues. Note that this height specification is ignored in the following situations:  
  - If you set the 'renderMode' parameter (see below) to 'static'.  
  - When the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| **renderMode** | No      | In formats not mentioned below, the default is 'dynamic'. The default is 'static' when the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. By default, the JIRA Issues macro offers a dynamic display with the following features:  
  - Click the column headers to sort the output.  
  - Drag and drop the columns into a different order.  
  - Temporarily remove a column from the display.  
  - View a page of issues at a time, for faster response times. Set the 'renderMode' parameter to 'static' if you want to disable the dynamic display features. |
<p>| <strong>title</strong>    | No      | JIRA Issues                                                                                                                                 |
|             |         | You can customise the title text at the top of the JIRA issues table with this parameter. For instance, setting the title to 'Bugs-to-fix' will replace the default 'JIRA Issues' text. This can help provide more context to the list of issues displayed. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>Yes</td>
<td>none</td>
<td>The URL of the XML view of your selected issues in JIRA Issue Navigator. Note: If the URL in the 'url' parameter does not contain a tempMax argument, then the value of tempMax will default to 500. If your JIRA server is version 3.12 or earlier, this means that the JIRA Issues macro will return a maximum of 500 issues. If your JIRA server is version 3.13 or later, a value of 500 means that the JIRA Issues macro will return a maximum of 500 issues per page.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td>100%</td>
<td>The width of the table displaying the JIRA issues. Can be indicated either as a percentage (%) or in pixels (px).</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="jiraissues">
    <ac:parameter ac:name="anonymous">true</ac:parameter>
    <ac:parameter ac:name="columns">type;key;summary</ac:parameter>
    <ac:parameter ac:name="url">http://jira.atlassian.com/sr/jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project+%3D+CONF+AND+%28summary+%7E+jiraissues+OR+description+%7E+jiraissues+OR+comment+%7E+jiraissues%29%26tempMax=10</ac:parameter>
</ac:macro>
```

**JUnit Report macro**

Display a summary of JUnit test results.

**Macro name:** junitreport

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required/Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>directory</td>
<td>Must include either the directory or the url parameter</td>
<td>URL of a directory containing your test result files. This must be a directory name and not the XML file itself. Overrides the url parameter if you use both. <strong>Note:</strong> When using a local drive, you must use a directory name and not the XML file itself.</td>
</tr>
<tr>
<td>reportdetail</td>
<td>No</td>
<td>Level of detail required in the report. Available values: all, fixture, summary, failuresonly.</td>
</tr>
</tbody>
</table>
| url             | Must include either the directory or the url parameter | URL of a particular test result XML file. This parameter is overridden by the directory parameter if you use both. For Confluence installations that require authentication, you can specify login credentials as part of this parameter, in the form of URL parameters:  
  * os_username — The username of a Confluence user with permission to access the JUnit test results.  
  * os_password — The password of the Confluence user specified in the os_username parameter. |
### JUnit Report macro

If the value of this parameter is `true`, the report will show the content of failures, as well as the error messages.

**Example:**

```xml
<ac:macro ac:name="junitreport">
  <ac:parameter ac:name="reportdetail">summary</ac:parameter>
  <ac:parameter ac:name="directory">http://confluence.com/download/attachments/123/</ac:parameter>
  <ac:parameter ac:name="debug">true</ac:parameter>
  <ac:parameter ac:name="url">http://confluence.com/download/attachments/123/file.xml</ac:parameter>
</ac:macro>
```

### Labels List macro

Displays a hyperlinked alphabetical index of all labels within the current space.

**Macro name:** listlabels

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaceKey</td>
<td>No</td>
<td>Current space</td>
<td>The key of the space whose labels you want to display.</td>
</tr>
</tbody>
</table>

**Example:**

```xml
<ac:macro ac:name="listlabels">
  <ac:parameter ac:name="spaceKey">DOC</ac:parameter>
</ac:macro>
```

### Livesearch macro

Add a dynamic search box to a wiki page.

**Macro name:** livesearch

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter name</td>
<td>Required</td>
<td>Default</td>
<td>Parameter description and accepted values</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>---------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>id</td>
<td>No</td>
<td>(None)</td>
<td>Uniquely identifies the Livesearch macro when there are more than one Livesearch macros in a page.</td>
</tr>
<tr>
<td>spaceKey</td>
<td>No</td>
<td>All spaces</td>
<td>Specify a space key to limit the search to the given space.</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="livesearch">
  <ac:parameter ac:name="id">mysearch1</ac:parameter>
  <ac:parameter ac:name="spaceKey">DOC</ac:parameter>
</ac:macro>
```

**Loremipsum macro**

Display a few paragraphs of pseudo-Latin text.

**Macro name:** loremipsum

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>No</td>
<td>3</td>
<td>Number of paragraphs. Determines the amount of pseudo-Latin (space-filler) text to display. The macro will display a maximum number of 30 paragraphs.</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="loremipsum">
  <ac:default-parameter>2</ac:default-parameter>
</ac:macro>
```

**Multimedia macro**

Displays videos, animations and more, sourced from a file attached to a Confluence page and displayed on your page.

**Macro name:** multimedia

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached.</td>
</tr>
<tr>
<td>space</td>
<td>No</td>
<td>Current space</td>
<td>Space key of the page that has the multimedia file attached.</td>
</tr>
<tr>
<td>name</td>
<td>Yes</td>
<td>None</td>
<td>File name of the multimedia file, which is attached to a Confluence page.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td>Width of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window’s width, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td>Height of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window’s height, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>autostart</td>
<td>No</td>
<td>false</td>
<td>If the parameter is set to true then the video or audio file will start playing as soon as the page is loaded. If this option is set to false then the file will not play until the user clicks the icon or image on the page.</td>
</tr>
</tbody>
</table>

Example:
Page Properties macro

The page Metadata Details Macro could not be found.
The page _MetadataDetailsMacroMarkup could not be found.

Example:

```xml
<ac:macro ac:name="details">
    <ac:parameter ac:name="hidden">true</ac:parameter>
    <ac:parameter ac:name="label">status</ac:parameter>
    <ac:rich-text-body>
        <table>
            <tbody>
                <tr>
                    <td style="text-align: left;">Project Status</td>
                    <td style="text-align: left;">Complete</td>
                </tr>
                <tr>
                    <td colspan="1" style="text-align: left;">Team</td>
                    <td colspan="1" style="text-align: left;">Green Parrots</td>
                </tr>
                <tr>
                    <td colspan="1" style="text-align: left;">Deadline</td>
                    <td colspan="1" style="text-align: left;">2012-09</td>
                </tr>
            </tbody>
        </table>
    </ac:rich-text-body>
</ac:macro>
```

Page Properties Report macro

The page Details Summary Macro could not be found.
The page _DetailsSummaryMacroMarkup could not be found.

Example:

```xml
<ac:macro ac:name="detailssummary">
    <ac:parameter ac:name="label">status</ac:parameter>
</ac:macro>
```

Section macro

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.
Macro name: section

Macro body: Rich text, consisting of one or more Column macros.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>border</td>
<td>No</td>
<td>False</td>
<td>If the value is true, the columns in this section will have a dashed border.</td>
</tr>
</tbody>
</table>

Example:

```xml
<ac:macro ac:name="section">
   <ac:parameter ac:name="border">true</ac:parameter>
   <ac:rich-text-body>
      <ac:macro ac:name="column">
         <ac:parameter ac:name="width">100px</ac:parameter>
         <ac:rich-text-body>
            <p>This is the content of <strong>column 1</strong>.</p>
         </ac:rich-text-body>
      </ac:macro>
      <ac:macro ac:name="column">
         <ac:rich-text-body>
            <p>This is the content of <strong>column 2</strong>.</p>
         </ac:rich-text-body>
      </ac:macro>
   </ac:rich-text-body>
</ac:macro>
```

Table of Contents macro

Displays a table of contents from your page headings.

Macro name: toc

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>printable</td>
<td>No</td>
<td>true</td>
<td>If you set this parameter to false, the table of contents will not be visible when you print the page.</td>
</tr>
</tbody>
</table>
| style          | No     | none          | The style of bullet point for each list item. You can use any valid CSS style. For example:
|               |        |               | - none – No list style is displayed.
|               |        |               | - circle – The list style is a circle.
|               |        |               | - disc – The list style is a filled circle. This is the typical bullet list, and is the one we are using in this example list.
|               |        |               | - square — The list style is a square.
|               |        |               | - decimal — The list is numbered (1, 2, 3, 4, 5).
|               |        |               | - lower-alpha — The list style is lower case, alphabetised (a, b, c, d, e).
|               |        |               | - lower-roman — The list style is lower-case roman numerals (i, ii, iii, iv, v, vi).
|               |        |               | - upper-roman — The list style is upper-case roman numerals (I, II, III, IV, V, VI).
<p>| maxLevel      | No     | 7             | Maximum heading level. Use this parameter to select the highest heading level to include. For example, a value of 2 will list h1 and h2 levels, but will not include h3 and below. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>indent</td>
<td>No</td>
<td>(None)</td>
<td>This parameter applies to vertical lists only (type = list). Use this parameter to indent the list items according to CSS quantities. For example, a value of <code>10px</code> will successively indent list heading groups by 10 pixels. Level 1 headings will be indented 10px, and level 2 headings by an additional 10px, and so on.</td>
</tr>
<tr>
<td>minLevel</td>
<td>No</td>
<td>1</td>
<td>Minimum heading level. The heading level at which the table of contents will start. For example, a value of 2 will list h2, h3, and h4 headings, but will not include h1 headings.</td>
</tr>
<tr>
<td>class</td>
<td>No</td>
<td>(None)</td>
<td>A CSS class name. If you have a custom style sheet, you can use this parameter to output the table of contents with the specified class attribute.</td>
</tr>
<tr>
<td>exclude</td>
<td>No</td>
<td>(None)</td>
<td>Specifies the headings to exclude by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will include only the headings that match the regular expression. Example: <code>.\.*\.</code> See Sun's Regex documentation for examples of constructing regular expression strings.</td>
</tr>
</tbody>
</table>
| **type** | **No** | **list** | Defines the overall format of the table of contents. Available values:
- `list` – displays the table of contents in a vertical list.
- `flat` – displays a horizontal series of links. For example: [Heading 1] [Heading 2] [Heading 3]. |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>outline</strong></td>
<td><strong>No</strong></td>
<td><strong>false</strong></td>
<td>A value of <code>true</code> will apply outline numbering to the headings as displayed in the table of contents. For example: 1.1, 1.2, 1.3.</td>
</tr>
<tr>
<td>parameter</td>
<td>value</td>
<td>description</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>separator</td>
<td>No</td>
<td>This parameter applies to flat lists only ( \text{type} = \text{flat} ). Use this parameter to style the display of a flat list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values: \begin{itemize}</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>\item <strong>brackets</strong> – Each item is enclosed by square brackets: ([]. )</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>\item <strong>braces</strong> – Each item is enclosed by braces: ({}).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>\item <strong>parens</strong> – Each item is enclosed by parentheses: ().</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>\item <strong>pipe</strong> – The items are separated by a pipe:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>\item <strong>anything</strong> – The items are separated by the value you enter. You can enter any text as a separator, for example (*\ast\ast\ast).</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters.</td>
<td></td>
</tr>
<tr>
<td>include</td>
<td>No</td>
<td>Specifies the headings to include by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will ignore any headings that do not match the regular expression. Example: (\ast\ast\ast) (.). .[1//2] )</td>
<td></td>
</tr>
</tbody>
</table>

See Sun's Regex documentation for examples of constructing regular expression strings.
Example:

This example shows a list-type table of contents.

```xml
<ac:macro ac:name="toc">
    <ac:parameter ac:name="printable">true</ac:parameter>
    <ac:parameter ac:name="style">square</ac:parameter>
    <ac:parameter ac:name="maxLevel">2</ac:parameter>
    <ac:parameter ac:name="indent">5px</ac:parameter>
    <ac:parameter ac:name="minLevel">2</ac:parameter>
    <ac:parameter ac:name="class">bigpink</ac:parameter>
    <ac:parameter ac:name="exclude">[1//2]</ac:parameter>
    <ac:parameter ac:name="type">list</ac:parameter>
    <ac:parameter ac:name="outline">true</ac:parameter>
    <ac:parameter ac:name="include">.*</ac:parameter>
</ac:macro>
```

This example shows a flat table of contents.

```xml
<ac:macro ac:name="toc">
    <ac:parameter ac:name="printable">true</ac:parameter>
    <ac:parameter ac:name="maxLevel">2</ac:parameter>
    <ac:parameter ac:name="minLevel">2</ac:parameter>
    <ac:parameter ac:name="class">bigpink</ac:parameter>
    <ac:parameter ac:name="exclude">[1//2]</ac:parameter>
    <ac:parameter ac:name="type">flat</ac:parameter>
    <ac:parameter ac:name="outline">true</ac:parameter>
    <ac:parameter ac:name="separator">pipe</ac:parameter>
    <ac:parameter ac:name="include">.*</ac:parameter>
</ac:macro>
```

Macro format notes

Macro bodies

Some macros accept a body as well as parameters.

- The Info macro and Expand macro are examples of macros that accept a rich text body.
- The Code Block macro is a good example of a macro that accepts a plain text body.

Plain text bodies

The body of a plain text macro must be inside a CDATA block. So the following is not sufficient:

```xml
<ac:plain-text-body>text</ac:plain-text-body>
```

The correct usage is:

```xml
<ac:plain-text-body> <![CDATA[text]]> </ac:plain-text-body>
```

Other notes
The 'Required' column indicates whether the parameter is required on data entry. If the parameter is not supplied, Confluence will insert default values as indicated in the 'Default' column.

- **A request from the Atlassian technical writers about comments and feedback:** When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we've missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled [Confluence 4 Editor - Customer Feedback](#), and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks. 😊

### Confluence Storage Format Examples for Chart Macro

This page is an extension of [Confluence Storage Format for Macros](#), which contains storage format examples for all Confluence macros. The Chart macro is a special case, because it offers so many options via parameters and chart types. This page offers additional examples for the Chart macro.

#### Pie chart

Here is a simple example of a pie chart.

*Storage format*
<ac:macro ac:name="chart">
  <ac:parameter ac:name="title">Fish Sold</ac:parameter>
  <ac:parameter ac:name="type">pie</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Fish Type</th>
          <th>2004</th>
          <th>2005</th>
        </tr>
        <tr>
          <th>Herring</th>
          <td>9,500</td>
          <td>8,300</td>
        </tr>
        <tr>
          <th>Salmon</th>
          <td>2,900</td>
          <td>4,200</td>
        </tr>
        <tr>
          <th>Tuna</th>
          <td>1,500</td>
          <td>1,500</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Bar chart

Here is a simple example of a bar chart.

**Storage format**
<ac:macro ac:name="chart">
  <ac:parameter ac:name="title">Fish Sold</ac:parameter>
  <ac:parameter ac:name="type">bar</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Fish Type</th>
          <th>2004</th>
          <th>2005</th>
        </tr>
        <tr>
          <th>Herring</th>
          <td>9,500</td>
          <td>8,300</td>
        </tr>
        <tr>
          <th>Salmon</th>
          <td>2,900</td>
          <td>4,200</td>
        </tr>
        <tr>
          <th>Tuna</th>
          <td>1,500</td>
          <td>1,500</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Time series chart

Here is an example of a time series chart.

Storage format

```
<ac:macro ac:name="chart">
  <ac:parameter ac:name="timePeriod">Month</ac:parameter>
  <ac:parameter ac:name="dataOrientation">vertical</ac:parameter>
  <ac:parameter ac:name="rangeAxisLowerBound">0</ac:parameter>
  <ac:parameter ac:name="dateFormat">MM/yyyy</ac:parameter>
  <ac:parameter ac:name="type">timeSeries</ac:parameter>
  <ac:parameter ac:name="domainaxisrotateticklabel">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th><p>Month</p></th>
          <th><p>Revenue</p></th>
        </tr>
        <tr>
          <td><p>1/2005</p></td>
          <td><p>31.8</p></td>
        </tr>
        <tr>
          <td><p>2/2005</p></td>
          <td><p>41.8</p></td>
        </tr>
        <tr>
          <td><p>3/2005</p></td>
          <td><p>51.8</p></td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>
```
<table>
<thead>
<tr>
<th>Date</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>3/2005</td>
<td>51.3</td>
</tr>
<tr>
<td>4/2005</td>
<td>33.8</td>
</tr>
<tr>
<td>5/2005</td>
<td>27.6</td>
</tr>
<tr>
<td>6/2005</td>
<td>49.8</td>
</tr>
<tr>
<td>7/2005</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2005</td>
<td>77.3</td>
</tr>
<tr>
<td>9/2005</td>
<td>73.8</td>
</tr>
<tr>
<td>10/2005</td>
<td>97.6</td>
</tr>
<tr>
<td>Month</td>
<td>Expenses</td>
</tr>
<tr>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>1/2005</td>
<td>41.1</td>
</tr>
<tr>
<td>2/2005</td>
<td>43.8</td>
</tr>
<tr>
<td>3/2005</td>
<td>45.3</td>
</tr>
<tr>
<td>4/2005</td>
<td>45.0</td>
</tr>
<tr>
<td>5/2005</td>
<td></td>
</tr>
<tr>
<td>6/2005</td>
<td>101.2</td>
</tr>
<tr>
<td>7/2005</td>
<td></td>
</tr>
<tr>
<td>8/2005</td>
<td></td>
</tr>
<tr>
<td>9/2005</td>
<td></td>
</tr>
<tr>
<td>10/2005</td>
<td>113.7</td>
</tr>
<tr>
<td>11/2005</td>
<td></td>
</tr>
<tr>
<td>12/2005</td>
<td></td>
</tr>
<tr>
<td>Month</td>
<td>Value</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>6/2005</td>
<td>44.6</td>
</tr>
<tr>
<td>7/2005</td>
<td>51.8</td>
</tr>
<tr>
<td>8/2005</td>
<td>52.3</td>
</tr>
<tr>
<td>9/2005</td>
<td>53.8</td>
</tr>
<tr>
<td>10/2005</td>
<td>55.6</td>
</tr>
<tr>
<td>11/2005</td>
<td>61.2</td>
</tr>
<tr>
<td>12/2005</td>
<td>63.7</td>
</tr>
</tbody>
</table>
Resulting chart

Here is an example of an XY line chart.

Storage format
Resulting chart
XY bar chart

Here is an example of an XY bar chart.

Storage format
<ac:macro ac:name="chart">
  <ac:parameter ac:name="opacity">60</ac:parameter>
  <ac:parameter ac:name="type">xybar</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>&nbsp;</th>
          <th>2005</th>
          <th>2006</th>
          <th>2007</th>
        </tr>
        <tr>
          <td>Revenue</td>
          <td>41.1</td>
          <td>31.8</td>
          <td>12.4</td>
        </tr>
        <tr>
          <td>Expense</td>
          <td>31.1</td>
          <td>41.8</td>
          <td>43.6</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>

Resulting chart
Here is an example of an XY area chart.
Resulting chart
Area chart

Here are two examples of area charts.

Storage format for area chart 1

```xml
<ac:macro ac:name="chart">
  <ac:parameter ac:name="height">300</ac:parameter>
  <ac:parameter ac:name="legend">true</ac:parameter>
  <ac:parameter ac:name="width">300</ac:parameter>
  <ac:parameter ac:name="opacity">50</ac:parameter>
  <ac:parameter ac:name="type">area</ac:parameter>
  <ac:parameter ac:name="dataDisplay">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Satisfaction</th>
        </tr>
        <tr>
          <td>2002</td>
        </tr>
        <tr>
          <td>2003</td>
        </tr>
        <tr>
          <td>2004</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>
```
<table>
<thead>
<tr>
<th></th>
<th>Satisfied</th>
<th>Disatisfied</th>
<th>Very Satisfied</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>40</td>
<td>25</td>
<td>15</td>
</tr>
<tr>
<td>Percent</td>
<td>34%</td>
<td>26%</td>
<td>17%</td>
</tr>
<tr>
<td>N/A</td>
<td>23</td>
<td>26</td>
<td>18</td>
</tr>
</tbody>
</table>
### Resulting area chart 1

![Area chart showing satisfaction levels from 2002 to 2004](chart.png)

#### Satisfaction Levels

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>

### Storage format for area chart 2

```xml
<ac:macro ac:name="chart">
  <ac:parameter ac:name="stacked">true</ac:parameter>
  <ac:parameter ac:name="height">300</ac:parameter>
  <ac:parameter ac:name="legend">true</ac:parameter>
  <ac:parameter ac:name="width">300</ac:parameter>
  <ac:parameter ac:name="type">area</ac:parameter>
  <ac:parameter ac:name="dataDisplay">true</ac:parameter>
  <ac:rich-text-body>
    <table>
      <tbody>
        <tr>
          <th>Satisfaction</th>
          <th>2002</th>
          <th>2003</th>
          <th>2004</th>
        </tr>
        <tr>
          <td>Very satisfied</td>
          <td>20</td>
          <td>23</td>
          <td>34</td>
        </tr>
        <tr>
          <td>Satisfied</td>
          <td>40</td>
          <td>34</td>
          <td>23</td>
        </tr>
        <tr>
          <td>Dissatisfied</td>
          <td>25</td>
          <td>26</td>
          <td>25</td>
        </tr>
        <tr>
          <td>Very dissatisfied</td>
          <td>15</td>
          <td>17</td>
          <td>18</td>
        </tr>
      </tbody>
    </table>
  </ac:rich-text-body>
</ac:macro>
```
<table>
<thead>
<tr>
<th></th>
<th>12</th>
<th>23</th>
<th>31</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
</tr>
</tbody>
</table>
Confluence Wiki Markup

This page describes the wiki markup used on some administration screens in Confluence. Another page describes the wiki markup for macros.

Wiki markup is useful when you want to do one of the following:

- Configure the Documentation theme.
- Type wiki markup directly into the editor. Confluence will convert it to the rich text editor format as you type.
- Create links using the Advanced tab of the Links Browser.
- Insert a block of wiki markup into the Confluence editor. (Choose Insert > Wiki Markup.)

**Note: You cannot edit content in wiki markup.** Confluence does not store page content in wiki markup. Although you can enter wiki markup into the editor, Confluence will convert it to the rich text editor format immediately. You will not be able to edit the wiki markup after initial entry.

**A request from the Atlassian technical writers about comments and feedback:** When adding comments to this page, please restrict your comments to constructive feedback on the documentation itself: Things we’ve missed in the documentation, and things that will be useful to other readers. If you have other feedback about the editor, wiki markup, the XML storage format, and Confluence 4 in general, please add your comments in the section titled Confluence 4 Editor - Customer Feedback, and its child pages. Our reason for this request: When a page attracts a large number of comments, it makes it difficult for everyone to read the page, and to add or respond to comments about the documentation. Thanks. 😊
Can I type wiki markup into the editor?

Yes. You can type wiki markup directly into the editor, and Confluence will convert it as you type. (You cannot edit the wiki markup after conversion.) See it in action in this video:

Read this blog post for more examples: 12 Things You Didn’t Know About the Confluence Editor.

### Headings

To format a line as a heading, type "hn." at the start of your line, where n can be a number from 1 to 6.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>h1. Biggest heading</td>
<td>Biggest heading</td>
</tr>
<tr>
<td>h3. Big heading</td>
<td>Big heading</td>
</tr>
<tr>
<td>h5. Small heading</td>
<td>Small heading</td>
</tr>
</tbody>
</table>

### Lists

Wiki markup allows you to create bulleted or numbered lists, and is flexible enough to allow a combination of the two list types.

**Simple lists**

Use the hyphen (-) to create simple lists.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
</table>

If you need to separate the text within lists using line breaks, make sure you do so using a double slash (/). Empty lines may disrupt the list.
Bulleted lists

Use the asterisk (*) to create bullets. For each subsequent level, add an extra asterisk. Make sure there is a space between the asterisk and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>* some</td>
<td>• some</td>
</tr>
<tr>
<td>* bullet</td>
<td>• bullet</td>
</tr>
<tr>
<td>** indented</td>
<td>• indented</td>
</tr>
<tr>
<td>** bullets</td>
<td>• bullets</td>
</tr>
<tr>
<td>* points</td>
<td>• points</td>
</tr>
</tbody>
</table>

Numbered lists

Use the hash (#) to create numbered lists. Make sure there is a space between the hash and your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># a</td>
<td>1. a</td>
</tr>
<tr>
<td># numbered</td>
<td>2. numbered</td>
</tr>
<tr>
<td># list</td>
<td>3. list</td>
</tr>
</tbody>
</table>

A second level of hashes will produce a sub-list, such as the alphabetical sub-list shown below.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># Here's a sentence.</td>
<td>1. Here's a sentence.</td>
</tr>
<tr>
<td>## This is a sub-list point.</td>
<td>a. This is a sub-list point.</td>
</tr>
<tr>
<td>## And a second sub-list point.</td>
<td>b. And a second sub-list point.</td>
</tr>
<tr>
<td># Here's another sentence.</td>
<td>2. Here's another sentence.</td>
</tr>
</tbody>
</table>

You can use a third level of hashes to produce a sub-sub-list.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
</table>
# Here's a sentence.
## This is a sub-list point.
### Third list level.
### Another point at the third level.
### And a second sub-list point.
# Here's another sentence.

1. Here's a sentence.
   a. This is a sub-list point.
      i. Third list level.
      ii. Another point at the third level.
   b. And a second sub-list point.
2. Here's another sentence.

**Note:** In numbered lists as described above, the format of the ‘number’ displayed at each list level may be different, depending upon your browser and the style sheets installed on your Confluence instance. So in some cases, you may see letters (A, B, C, etc; or a, b, c, etc) or Roman numerals (i, ii, iii, etc) at different list levels.

### Mixed lists

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td># Here</td>
<td>1. Here</td>
</tr>
<tr>
<td>#* is</td>
<td>• is</td>
</tr>
<tr>
<td>#* an</td>
<td>• an</td>
</tr>
<tr>
<td># example</td>
<td>2. example</td>
</tr>
<tr>
<td>#* of</td>
<td>• of</td>
</tr>
<tr>
<td>#* a</td>
<td>• a</td>
</tr>
<tr>
<td># mixed</td>
<td>3. mixed</td>
</tr>
<tr>
<td># list</td>
<td>4. list</td>
</tr>
</tbody>
</table>

### Tables

You can create two types of tables.

**Table Type 1**

Allows you to create a simple table with an optional header row. You cannot set the width of the columns in this table.

Use double bars for a table heading row.

**What you need to type:**

```
<table>
<thead>
<tr>
<th></th>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
<td></td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
<td></td>
</tr>
</tbody>
</table>
```

**What you will get:**

<table>
<thead>
<tr>
<th>heading 1</th>
<th>heading 2</th>
<th>heading 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>cell A1</td>
<td>cell A2</td>
<td>cell A3</td>
</tr>
<tr>
<td>cell B1</td>
<td>cell B2</td>
<td>cell B3</td>
</tr>
</tbody>
</table>

You can also use a vertical header.
What you need to type:

```markdown
| heading 1 | col A1 | col A2 | col A3 |
| heading 2 | col B1 | col B2 | col B3 |
```

What you will get:

| heading 1 | col A1 | col A2 | col A3 |
| heading 2 | col B1 | col B2 | col B3 |

**Table Type 2**

This method allows you to specify the width of the columns in the table.

What you need to type

```markdown
{section:border=true}
{column:width=30%}
Text for this column goes here. This is the smaller column with a width of only 30%.
{column}
{column:width=70%}
Text for this column goes here. This is the larger column with a width of 70%.
{section}
```

What you will get

- Text for this column goes here. This is the smaller column with a width of only 30%.
- Text for this column goes here. This is the larger column with a width of 70%.

For more details please see the [Column Macro](#) and the [Section Macro](#).

**Advanced Formatting**

Colour and Other Formatting

To add colour and other formatting to your tables, you can use the [Panel Macro](#) within columns.

More table-formatting options may be available if your Confluence administrator has installed additional [macros](#).

Lists

Here's an example of how to embed lists in a table:

What you need to type

```markdown
<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Item 1</td>
<td></td>
</tr>
<tr>
<td>* Item 2</td>
<td></td>
</tr>
<tr>
<td>* Item 3</td>
<td></td>
</tr>
<tr>
<td># Item 1</td>
<td></td>
</tr>
<tr>
<td># Item 2</td>
<td></td>
</tr>
<tr>
<td># Item 3</td>
<td></td>
</tr>
</tbody>
</table>
```
What you will get

<table>
<thead>
<tr>
<th>Heading 1</th>
<th>Heading 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Item 1</td>
<td>1. Item 1</td>
</tr>
<tr>
<td>• Item 2</td>
<td>2. Item 2</td>
</tr>
<tr>
<td>• Item 3</td>
<td>3. Item 3</td>
</tr>
</tbody>
</table>

Text Effects

Use the markup shown in the examples below to format text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>strong</em></td>
<td>strong</td>
</tr>
<tr>
<td><em>bold text</em></td>
<td>bold text</td>
</tr>
<tr>
<td><em>emphasis</em></td>
<td>emphasis</td>
</tr>
<tr>
<td><em>italics</em></td>
<td>italics</td>
</tr>
<tr>
<td>??citation??</td>
<td>—citation</td>
</tr>
<tr>
<td>-deleted-</td>
<td>deleted</td>
</tr>
<tr>
<td>+inserted+</td>
<td>inserted</td>
</tr>
</tbody>
</table>

Text with ^superscript^  

Hint: There are two ways to make superscripts work, when used directly after another word or character:

- Add a space before the superscript. For example,  
  \( \text{kg/m}^3 \)  gives you this: \( \text{kg/m}^3 \)
- Add braces (curly brackets) around the superscript markup. For example,  
  \( \text{kg/m}\{^3\} \)  gives you this: \( \text{kg/m}^3 \)

Text with ~subscript~

Text with **subscript**

bq. Here's how you make a paragraph appear as a block quotation.

{color:red}look ma, red text!{color}  

look ma, red text!
Text Breaks

Paragraph Break

In wiki markup, a paragraph is a continuous line of text ending in two carriage returns. This is equivalent to a continuous line of text followed by a blank line.

When rendered into HTML, the result is a line of text wrapped in a set of `<p>` tags.

Line Break

Confluence provides two options for forcing a line break within a paragraph of text:

- Implicitly, by entering a single carriage return at its end.
- Explicitly, by entering two consecutive backslashes: `\`\`

When rendered into HTML, the result is a paragraph of text that is split into separate lines by `&lt;br&gt;` tags, wherever a forced line break appears.

For most purposes, explicit line breaks are not required because a single carriage return is enough.

The examples below show how to use explicit line breaks.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>here is some text</td>
<td>here is some text</td>
</tr>
<tr>
<td>\</td>
<td>divided</td>
</tr>
<tr>
<td>divided \</td>
<td>using line \</td>
</tr>
<tr>
<td>using line \ \</td>
<td>breaks</td>
</tr>
<tr>
<td>breaks\</td>
<td></td>
</tr>
</tbody>
</table>

This is a short list:
* Point 1
  Text to go with point 1
* Point 2
  \ \ \ \                                  
  Text to go with point 2 with a break

This is a short list:
* Point 1
  Text to go with point 1
* Point 2
  Text to go with point 2 with a break

If you wish to use multiple consecutive line breaks, each should be separated by a space character. For example, use this for two consecutive line breaks:
\\

Horizontal Rule

To create a horizontal line across the width of your page or content block, type four dashes (like this: `----`) at the beginning of a line, then press Enter or space.

Make sure that the dashes are on a separate line from the rest of the text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Links

You can use wiki markup to add hyperlinks to your text.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td>[#anchor]</td>
<td>A link to an anchor on the same page.</td>
</tr>
<tr>
<td>[Confluence Wiki Markup^attachment.ext]</td>
<td>A link to a file attached to the page.</td>
</tr>
<tr>
<td>[pagetitle]</td>
<td>A link to a page.</td>
</tr>
<tr>
<td>[pagetitle#anchor]</td>
<td>A link to an anchor on another page.</td>
</tr>
<tr>
<td>[pagetitle^attachment.ext]</td>
<td>A link to a file attached to another page.</td>
</tr>
<tr>
<td>[spacekey:pagetitle]</td>
<td>A link to a page in another space.</td>
</tr>
<tr>
<td>[spacekey:pagetitle#anchor]</td>
<td>A link to an anchor on a page in another space.</td>
</tr>
<tr>
<td>[spacekey:pagetitle^attachment.ext]</td>
<td>A link to a file attached to a page in another space.</td>
</tr>
<tr>
<td>[/2004/01/12/blogposttitle]</td>
<td>A link to a blog post.</td>
</tr>
<tr>
<td>[spacekey:/2004/01/12/blogposttitle]</td>
<td>A link to a blog post in another space.</td>
</tr>
<tr>
<td>[/2004/01/12]</td>
<td>A link to a whole day's blog posts.</td>
</tr>
<tr>
<td>[spacekey:/2004/01/12]</td>
<td>A link to a whole day's blog posts in another space.</td>
</tr>
<tr>
<td>[spacekey:]</td>
<td>A link to the space homepage (or the space summary page of the space.</td>
</tr>
<tr>
<td>[~username]</td>
<td>A link to the user profile page of a particular user.</td>
</tr>
<tr>
<td>[phrase@shortcut]</td>
<td>A shortcut link to the specified shortcut site. Shortcuts are configured by the site administrator.</td>
</tr>
<tr>
<td>[<a href="mailto:legendaryservice@atlassian.com">mailto:legendaryservice@atlassian.com</a>]</td>
<td>A link to an email address.</td>
</tr>
<tr>
<td>[file://z:/file/on/network/share.txt]</td>
<td>A link to a file on your computer or on a network share that you have mapped to a drive. <em>This only works on Internet Explorer.</em></td>
</tr>
</tbody>
</table>

Note that Confluence treats headings as anchors, so you can link to headings using this pattern: [spacekey:pagename#headingname], where headingname is case-sensitive and must be entered without spaces.

For each of these link forms:

- You can prepend a link alias, so that alternate text is displayed on the page. Example: [link alias|pagetitle#anchor]
• You can append a link tip, which appears as a tooltip. Example: [pagetitle#anchor|link tip]

**Images**

You can display images from attached files or remote sources.

<table>
<thead>
<tr>
<th>What you need to type</th>
<th>What you will get</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.gif" alt="http://www.host.com/image.gif!" /></td>
<td>An image from a remote source is displayed on the page. Uses a fully qualified URL.</td>
</tr>
<tr>
<td><img src="attachment" alt="attached-image.gif!" /></td>
<td>An image file attached to the page is displayed.</td>
</tr>
<tr>
<td><img src="attachment" alt="pageTitle^image.gif!" /></td>
<td>An image file attached to a different page is displayed.</td>
</tr>
<tr>
<td><img src="attachment" alt="spaceKey:pageTitle^image.gif!" /></td>
<td>An image file attached to a page in a different space is displayed.</td>
</tr>
<tr>
<td><img src="attachment" alt="/2010/05/23/My Blog Post^image.gif!" /></td>
<td>An image file attached to a blog post is displayed.</td>
</tr>
<tr>
<td>![image.jpg</td>
<td>thumbnail!](attachment)</td>
</tr>
<tr>
<td>![image.gif</td>
<td>align=right, vspace=4!](attachment)</td>
</tr>
</tbody>
</table>

Available HTML image tags include:

<table>
<thead>
<tr>
<th>Image tag</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>align</td>
<td>Available values are 'left', 'right', 'bottom', 'center', 'top'.</td>
</tr>
<tr>
<td>border</td>
<td>Specifies the width of the border (in pixels).</td>
</tr>
<tr>
<td>bordercolor</td>
<td>Use with the 'border' tag. Specify colours by name or hex value.</td>
</tr>
<tr>
<td>hspace</td>
<td>Specifies the amount of whitespace to be inserted to the left and right of the image (in pixels).</td>
</tr>
<tr>
<td>vspace</td>
<td>Specifies the amount of whitespace to be inserted above and below the image (in pixels).</td>
</tr>
<tr>
<td>width</td>
<td>Specifies the width of the image (in pixels). This will override the natural width of the image.</td>
</tr>
<tr>
<td>height</td>
<td>Specifies the height of the image (in pixels). This will override the natural height of the image.</td>
</tr>
<tr>
<td>title</td>
<td>Specifies alternate text for the image, which is displayed when the pointer hovers over the image.</td>
</tr>
</tbody>
</table>
Page Layouts

There is no wiki markup representation for page layouts.

Useful Information

- A **space key** is a short, unique identifier for a space. For example, you might give your documentation space a key of "DOC". To find the key of an existing space, look at the Confluence URL for a page in the space. The standard Confluence URL has this format:

  ```
  http://my.confluence.site.com/display/SPACEKEY/Page+Name
  ```

- If you would like to edit the XML source of a page, your Confluence system administrator will need to install the Confluence Source Editor plugin. See more about the Confluence Storage Format.

- Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Confluence Wiki Markup for Macros

This page is an extension of Confluence Wiki Markup. It describes the wiki markup used to define specific Confluence macros – the macros that are shipped with Confluence. For each macro, we define the macro name, parameter names, and accepted parameter values.

Wiki markup is useful when you want to do one of the following:

- Configure the **Documentation theme**.
- Type wiki markup directly into the editor. Confluence will convert it to the rich text editor format as you type.
- Create links using the Advanced tab of the Links Browser.
- Insert a block of wiki markup into the Confluence editor. (Choose Insert > Wiki Markup.)

**Note:** You cannot edit content in wiki markup. Confluence does not store page content in wiki markup. Although you can enter wiki markup into the editor, Confluence will convert it to the rich text editor format immediately. You will not be able to edit the wiki markup after initial entry.

**Anchor macro**

Allows you to link to a specific part of a page.

**Macro name:** anchor

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The name of the anchor.</td>
</tr>
<tr>
<td>(Unnamed in wiki markup)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Example:**

```
{anchor:here}
```
On this page:
- Anchor macro
- Attachments macro
- Blog Posts macro
- Change-History macro
- Chart macro
- Cheese macro
- Children Display macro
- Code Block macro
- Column macro
- Content by Label macro
- Content by User macro
- Content Report Table macro
- Contributors macro
- Contributors Summary macro
- Create Space Button macro
- Excerpt Include macro
- Excerpt macro
- Expand macro
- Favourite Pages macro
- Gadget macro
- Gallery macro
- Global Reports macro
- HTML Include macro
- HTML macro
- IM Presence macro
- Include Page macro
- Info macro
- JIRA Issues macro
- JUnit Report macro
- Labels List macro
- Livesearch macro
- Loremipsum macro
- Multimedia macro
- Page Properties macro
- Page Properties Report macro
- Section macro
- Table of Contents macro
- Notes

Related pages:
- Confluence Wiki Markup
- Working with Confluence Markup
- Working with Macros
- Confluence User’s Guide

Attachments macro
Displays a list of attachments on a given page.

Macro name: attachments
**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>old</td>
<td>No</td>
<td>false</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>false</code> - Displays only the latest version of each attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>true</code> – Displays all versions of each attachment, including the old versions.</td>
</tr>
<tr>
<td>patterns</td>
<td>No</td>
<td>(None)</td>
<td>A comma-separated list of regular expressions, used to filter the attachments by file name. Note that the parameter values must be regular expressions. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match a file suffix of 'jpg', use <code>.*jpg (not .*jpg)</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To match file names ending in 'jpg' or 'png', use <code>.*jpg,.*png</code>.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Here is a tutorial on regular expressions.</td>
</tr>
<tr>
<td>sortBy</td>
<td>No</td>
<td>date</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>date</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>size</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <code>name</code></td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>The page on which the macro exists.</td>
<td>Page name, used to display attachments from another page.</td>
</tr>
<tr>
<td>sortOrder</td>
<td>No</td>
<td>The default sort order is determined by the <code>sortBy</code> type:</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Reverse chronological for 'date'.</td>
<td>• <code>ascending</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Largest to smallest for 'size'.</td>
<td>• <code>descending</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Alphabetical for 'name'.</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>labels</td>
<td>No</td>
<td>(None)</td>
<td>A comma-separated list of labels. Confluence will show only attachments that have all the labels specified. (The match is an AND, not an OR.)</td>
</tr>
<tr>
<td>upload</td>
<td>No</td>
<td>false</td>
<td>Determines whether the list of attachments will include options allowing users to browse for, and attach, new files.</td>
</tr>
</tbody>
</table>

**Example:**

```
(attachments:old=false|patterns=.*png,.*jpg|sortby=name|page=My page about chocolate|sortorder=descending|labels=chocolate,cookies|upload=false)
```

**Blog Posts macro**

Lists the most recent news items in the space.

**Macro name:** blog-posts

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| content        | No       | entire  | Available values:  
  - **entire** – Display the whole content of each blog post.  
  - **excerpts** – Display a short extract from each blog post. If the post contains an Excerpt macro, the Blog Posts macro will display the content defined in the Excerpt macro. If the post does not contain an Excerpt macro, the Blog Posts macro will display the first few sentences of the post.  
  - **titles** – Display a list of blog posts, showing titles only. |
<table>
<thead>
<tr>
<th>spaces</th>
<th>No</th>
<th>@self</th>
<th>One or more space keys, separated by a comma or a space.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To exclude content in a specific space, put a minus sign (-) immediately in front of that space key. For example: If you specify a space key of −BADSPACE you will get only content which is not in the BADSPACE.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)</td>
</tr>
</tbody>
</table>

Special values:
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@self</td>
<td>No</td>
<td>@self</td>
<td>The current space.</td>
</tr>
<tr>
<td>@personal</td>
<td>No</td>
<td>@personal</td>
<td>All personal spaces.</td>
</tr>
<tr>
<td>@global</td>
<td>No</td>
<td>@global</td>
<td>All site spaces.</td>
</tr>
<tr>
<td>@favorite</td>
<td>No</td>
<td>@favorite</td>
<td>The spaces you have marked as favourite.</td>
</tr>
<tr>
<td>@favourite</td>
<td>No</td>
<td>@favourite</td>
<td>The same as @favorite above.</td>
</tr>
<tr>
<td>@all</td>
<td>No</td>
<td>@all</td>
<td>All spaces in your Confluence site.</td>
</tr>
<tr>
<td>*</td>
<td>No</td>
<td>*</td>
<td>The same as @all above.</td>
</tr>
</tbody>
</table>

When specifying a personal space, remember to use the tilde (~) sign in front of the username, such as ~jbl oggs or ~jbloggs@example.com.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>author</td>
<td>No</td>
<td>(None)</td>
<td>One or more usernames, separated by commas.</td>
</tr>
<tr>
<td>time</td>
<td>No</td>
<td>(None)</td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• m — Minutes</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• h — Hours</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• d — Days</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• w — Weeks</td>
</tr>
</tbody>
</table>

For example,

• time=12h – Display blog posts created in the last twelve hours.
• time=7d – Display blog posts created in the last seven days.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>A value of true changes the sort order.</td>
</tr>
<tr>
<td><strong>sort</strong></td>
<td>No</td>
<td><strong>creation</strong></td>
<td>Available values:</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>title</strong> — Sort alphabetically by title.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>creation</strong> — Sort by the date on which the content was added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>modified</strong> — Sort by the date on which the content was last updated.</td>
</tr>
</tbody>
</table>

| **max** | No | 15 | The maximum number of results to be displayed. |

| **label** | No | (None) | One or more label values, separated by a comma or a space. |
|  |  |  | • To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `badpage` you will get only content which is not labelled with 'badpage'. |
|  |  |  | • To indicate that the results must match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `superpage,goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |

**Example:**

```
(blog-posts:content=titles|spaces=@self,ds|author=jsmith|time=4w|reverse=true|sort=creation|max=10|label=chocolate,cookies)
```
Change-History macro

Displays a history of updates made to a page.

Macro name: change-history

Macro body: None.

Parameters: None

Example:

{change-history}

Chart macro

Displays a chart based on tabular data.

Macro name: chart

Macro body: Accepts rich text, consisting of tables that hold the chart’s data.

This macro recognises a large number of parameters, listed here by type for convenience.

Chart type parameters

These parameters determine the type of chart to display and how the chart looks.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>type</td>
<td>No</td>
<td>pie</td>
<td>The type of chart to display. XY charts have numerical x- and y-axes. The x values may optionally be time-based. See the timeSeries parameter. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Standard charts – pie, bar, line, area</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• XY plots – xyArea, xyBar, xyLine, xyStep, xyStepArea, scatter, timeSeries</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Other charts – gantt (beta)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>orientation</td>
<td>No</td>
<td>vertical</td>
<td>The display orientation. Applies to area, bar and line charts.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• vertical – y-axis is vertical</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• horizontal – x-axis is vertical</td>
</tr>
<tr>
<td>3D</td>
<td>No</td>
<td>false</td>
<td>Show in three dimensions. Applies to area, bar and line charts.</td>
</tr>
<tr>
<td>stacked</td>
<td>No</td>
<td>false</td>
<td>Stacked values. Applies to area and bar charts.</td>
</tr>
<tr>
<td>showShapes</td>
<td>No</td>
<td>true</td>
<td>Applies to line charts. Shapes are shown at each data point.</td>
</tr>
<tr>
<td>opacity</td>
<td>No</td>
<td></td>
<td>A percentage value between 0 (transparent) and 100 (opaque) that determines how opaque the foreground areas and bars are.</td>
</tr>
</tbody>
</table>

**Chart display parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>300</td>
<td>The width of the chart in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>300</td>
<td>The height of the chart in pixels.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------</td>
<td>---------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>dataDisplay</td>
<td>No</td>
<td>false</td>
<td>Determines whether to display the body of the macro, consisting of the data table. By default, the chart data table is not displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• false – the data is not displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• true or after – the data is displayed after the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• before – the data is displayed before the chart.</td>
</tr>
<tr>
<td>imageFormat</td>
<td>No</td>
<td>png</td>
<td>The image format to be used for the chart.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• png</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• jpg</td>
</tr>
</tbody>
</table>

**Chart title and label parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>The title of the chart.</td>
</tr>
<tr>
<td>subTitle</td>
<td>No</td>
<td>(None)</td>
<td>A subtitle for the chart.</td>
</tr>
<tr>
<td>xLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the x-axis (domain).</td>
</tr>
<tr>
<td>yLabel</td>
<td>No</td>
<td>(None)</td>
<td>The label for the y-axis (range).</td>
</tr>
<tr>
<td>legend</td>
<td>No</td>
<td>false</td>
<td>Determines whether to show a legend (key) for the chart.</td>
</tr>
</tbody>
</table>

**Chart data parameters**

The data for the chart is taken from tables found in the macro body. The parameters below control how this data is interpreted. By default, numeric and date values are interpreted according to the Confluence global default language (locale) formats. If conversion fails, other languages defined in Confluence will be tried. You can specify additional conversion options using the parameters below.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tables</td>
<td>No</td>
<td>All first level tables</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can supply a comma-separated list of table IDs and/or table numbers (starting at 1) contained within the body of the macro that will be used as the data for the chart. If data tables are embedded in other tables, then table selection will be required. This occurs when more complex formatting is done (for example using section and column macros).</td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>All columns</td>
</tr>
<tr>
<td></td>
<td></td>
<td>You can supply a comma-separated list of column labels and/or column titles and/or column numbers for tables used for chart data. This applies to all tables processed. Columns are enumerated starting at 1. Column label is the text for the column in the header row. Column title is the HTML title attribute for the column in the header row.</td>
</tr>
<tr>
<td>dataOrientation</td>
<td>No</td>
<td>horizontal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The content orientation. By default, the data tables will be interpreted as columns (horizontally) representing domain and x values.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• vertical – data table columns will be interpreted as series.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• horizontal – data tables rows will be interpreted as series.</td>
</tr>
<tr>
<td>parameter</td>
<td>default</td>
<td>description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>timeSeries</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>dateFormat</td>
<td>No</td>
<td>Confluence language defined date formats</td>
</tr>
<tr>
<td>timePeriod</td>
<td>No</td>
<td>day</td>
</tr>
<tr>
<td>language</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>country</td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>forgive</td>
<td>No</td>
<td>true</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Chart colour parameters**

Colours are specified using hexadecimal notation or HTML colour names.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>bgColor</td>
<td>No</td>
<td>White</td>
<td>Background colour of the chart.</td>
</tr>
<tr>
<td>borderColor</td>
<td>No</td>
<td>No border</td>
<td>Colour of the border around the chart.</td>
</tr>
<tr>
<td>colors</td>
<td>No</td>
<td></td>
<td>A comma-separated list of colours used to customise the colours of categories, sections, and series.</td>
</tr>
</tbody>
</table>

**Chart axis parameters**

Depending on the chart type, the range and domain axis may be customised. These values are automatically generated based on the data but can be overridden by specifying one or more more of these parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>rangeAxisLowerBound</td>
<td>No</td>
<td>(None)</td>
<td>Minimum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisUpperBound</td>
<td>No</td>
<td>(None)</td>
<td>Maximum value for the range axis.</td>
</tr>
<tr>
<td>rangeAxisTickUnit</td>
<td>No</td>
<td>(None)</td>
<td>Range axis units between axis tick marks.</td>
</tr>
<tr>
<td><strong>rangeAxisLabelAngle</strong></td>
<td>No</td>
<td>(None)</td>
<td>Angle for the range axis label in degrees.</td>
</tr>
<tr>
<td>-------------------------</td>
<td>----</td>
<td>--------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td><strong>domainAxisLowerBound</strong></td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis lower bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
</tr>
<tr>
<td><strong>domainAxisUpperBound</strong></td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis upper bound. For a date axis, this value must be expressed in the date format specified by the <code>dateFormat</code> parameter.</td>
</tr>
<tr>
<td><strong>domainAxisTickUnit</strong></td>
<td>No</td>
<td>(None)</td>
<td>Only applies to XY plots. Domain axis units between axis tick marks. For a date axis, this value represents a count of the units specified in the <code>timePeriod</code> parameter. The <code>timePeriod</code> unit can be overridden by specifying a trailing character: <code>y</code> (years), <code>M</code> (months), <code>d</code> (days), <code>h</code> (hours), <code>m</code> (minutes), <code>s</code> (seconds), <code>ms</code> (milliseconds).</td>
</tr>
</tbody>
</table>
| **categoryLabelPosition** | No | (None) | Placement of the axis label text for categories. Available values:  
- `up45` — 45 degrees going upward  
- `up90` — 90 degrees going upward  
- `down45` — 45 degrees going downward  
- `down90` — 90 degrees going downward |
### dateTickMarkPosition

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>dateTickMarkPosition</td>
<td>No</td>
<td>start</td>
<td>Placement of the date tick mark.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>start</strong> — tick mark is at the start of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>middle</strong> — tick mark is in the middle of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>date period.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• <strong>end</strong> — tick mark is at the end of the date</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>period.</td>
</tr>
</tbody>
</table>

### Pie chart Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
</table>
| pieSectionLabel    | No       | Show only the pie section key value | Format of pie section labels. The format uses a string with special replacement variables:  
|                    |          |         | • %0% is replaced by the pie section key.                       |
|                    |          |         | • %1% is replaced by the pie section numeric value.             |
|                    |          |         | • %2% is replaced by the pie section percent value.             |
|                    |          |         | Example 1: To display something like 'Independent = 20':        |
|                    |          |         | %0% = %1%                                                       |
|                    |          |         | Example 2: To display something like 'Independent (20%)':       |
|                    |          |         | %0% (%2%)                                                       |
### Chart attachment parameters

These are advanced options that can be used for chart versioning, to enable automation and to improve performance. Use these options carefully! Normally, the chart image is regenerated each time the page is displayed. These options allow for the generated image to be saved as an attachment and have subsequent access to re-use the attachment. This can be useful especially when combined with the Cache plugin to improve performance. Depending on the options chosen, chart images can be versioned for historical purposes.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachment</td>
<td>No</td>
<td>(None)</td>
<td>The name and location where the chart image will be saved as an attachment. The user must be authorised to add attachments to the page specified.</td>
</tr>
</tbody>
</table>

Available syntax for this parameter:

- `^attachmentName.png` — the chart is saved as an attachment to the current page.
- `page name^attachmentName.png` — the chart is saved as an attachment to the page name provided.
- `spacekey:page name^attachmentName.png` — the chart is saved as an attachment to the page name provided in the space indicated.

### pieSectionExplode

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pieSectionExplode</td>
<td>No</td>
<td>No exploded sections</td>
<td>A comma-separated list of pie keys that are to be shown exploded. Note: requires jFreeChart version 1.0.3 or higher.</td>
</tr>
<tr>
<td>attachmentVersion</td>
<td>No</td>
<td>new</td>
<td>Defines the versioning mechanism for saved charts. Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- new — creates new version of the attachment.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- replace — replaces all previous versions of the chart. To replace an existing attachment, the user must be authorised to remove attachments for the page specified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- keep — only saves a new attachment if an existing export of the same name does not exist. An existing attachment will not be changed or updated.</td>
</tr>
<tr>
<td>attachmentComment</td>
<td>No</td>
<td>(None)</td>
<td>Comment used for a saved chart attachment.</td>
</tr>
<tr>
<td>thumbnail</td>
<td>No</td>
<td>false</td>
<td>If true, the chart image attachment will be shown as a thumbnail (small, expandable) image.</td>
</tr>
</tbody>
</table>

**Example:**

Below is a simple example of a pie chart. See more examples in Wiki Markup Examples for Chart Macro.

```
{chart:type=pie|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring  | 9,500 | 8,300 |
|| Salmon   | 2,900 | 4,200 |
|| Tuna     | 1,500 | 1,500 |
{chart}
```

**Cheese macro**

Displays the words "I like cheese!"

**Macro name:** cheese

**Macro body:** None.

**Parameters:** None
Example:

```
{cheese}
```

**Children Display macro**

Displays the children and descendants of the current page.

**Macro name:** children

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the sort order in the list of child pages. Use this parameter in conjunction with the sort parameter described below. A value of true will change the sort order from ascending to descending.</td>
</tr>
</tbody>
</table>
| sort           | No       | Manual if the pages have been manually reordered, otherwise alphabetical by page title | Determines the sort order of the list of child pages. Available values:
  - creation – Sort by the date on which the page was created.
  - title – Sort alphabetically by page name.
  - modified – Sort by the date on which the page was last updated. |
| style          | No       | Bullet list | A heading style to be applied to the list of child pages. Available values: h1 (heading level 1) through to h6 (heading level 6). |

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td></td>
<td>The page that contains the macro. The name of the parent page. The macro will display the children of the specified page. To specify a page in a different space, use a space key followed by a colon. For example: <code>MYSPACE:My page</code> If the value of this parameter is a forward slash (<code>/</code>) the macro will list the pages at the root of the current space. In other words, the pages without parents.</td>
</tr>
<tr>
<td>excerpt</td>
<td>No</td>
<td>false</td>
<td>If <code>true</code>, Confluence will display any excerpts that are defined on the child pages. The excerpts must be defined via an Excerpt macro.</td>
</tr>
<tr>
<td>first</td>
<td>No</td>
<td>(None)</td>
<td>The maximum number of child pages to be displayed (at the top level). For example, if the value of this parameter is 99, the macro will display the first 99 pages at the top level. It will also display their children, as determined by the <code>depth</code> and <code>all</code> parameters.</td>
</tr>
<tr>
<td>depth</td>
<td>No</td>
<td>(None)</td>
<td>The number of levels of child pages to display. For example, if the value is 2, the macro will display 2 levels of child pages.</td>
</tr>
<tr>
<td>all</td>
<td>No</td>
<td>false</td>
<td>If <code>true</code>, Confluence will display all levels of child pages. This setting will override the <code>depth</code> setting.</td>
</tr>
</tbody>
</table>

**Example:**
Code Block macro

Displays code in your document with the appropriate syntax highlighting.

**Macro name:** code

**Macro body:** Accepts plain text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Adds a title to the code macro box.</td>
</tr>
</tbody>
</table>
| theme          | No       | Confluence| Specifies the colour scheme used for displaying your code. Many of these themes are based on the default colour schemes of popular integrated development environments (IDEs). The default theme is Confluence (also known as Default), which is typically black and coloured text on a blank background. Available themes:  
  - DJango  
  - Emacs  
  - FadeToGrey  
  - Midnight  
  - RDark  
  - Eclipse  
  - Confluence (same as default) |
| linenumbers    | No       | false     | If true, a line number will be shown to the left of each line of code. Numbering is incremented by 1. If false, no line numbers are shown. |
| **language** | **No** | **java** | Specifies the language (or environment) for syntax highlighting.  
- (none) — that is, no syntax highlighting  
- actionscript3  
- bash  
- csharp — that is, C#  
- coldfusion  
- cpp — that is, C++  
- css  
- delphi  
- diff  
- erlang  
- groovy  
- java  
- javafx  
- javascript  
- perl  
- php  
- powershell  
- python  
- ruby  
- scala  
- sql  
- vb — that is, Visual Basic  
- html/xml |
| **firstline** | **No** | **1** | When linenumbers is true, this value defines the number of the first line of code. |
| **collapse** | **No** | **false** | If true, the code macro's content will be collapsed upon visiting or refreshing the Confluence page. Clicking the 'expand source' link allows you to view the content.  
If false, the code macro's content is always displayed in full. |

**Example:**
Column macro

Used with the Section macro to define columns on a page. See Working with page layouts and columns and sections.

Macro name: column

Macro body: Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>100% of the page width, divided equally by the number of columns in the section.</td>
<td>The width of the column. Can be specified either in pixels (for example, 400 px) or as a percentage of the available page width (for example, 50%).</td>
</tr>
</tbody>
</table>

Example:

```html
{column:width=100px}
This is the content of *column 1*.
{column}
```

Content by Label macro

Displays a list of content associated with specific labels.

Macro name: contentbylabel

Macro body: None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaces</td>
<td>No</td>
<td>@all</td>
<td></td>
</tr>
</tbody>
</table>
Filters the results by space. The macro will display only the pages and other content types which belong to the space(s) you specify here.

You can specify one or more space keys, separated by a comma or a space.

- To exclude content in a specific space, put a minus sign (−) immediately in front of that space key. For example: If you specify a space key of −BADSPACE you will get only content which is not in the BADSPACE.
- To indicate that the results must come from a specific space, put a plus sign (+) immediately in front of that space key. For example: If you specify a space key of +GOODSPACE you will get only content in GOODSPACE. (Note that this is not particularly useful, because each content item belongs to one space only. If you put a plus sign next to one space key and list other space keys too, the other space keys will be ignored.)

Special values:
### Macro Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>author</code></td>
<td>No</td>
<td>No (None)</td>
</tr>
<tr>
<td><code>title</code></td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td><code>showLabels</code></td>
<td>No</td>
<td>true</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Use this parameter in conjunction with the sort parameter. Set reverse=true to change the sort from ascending to descending. This parameter is ignored if the sort parameter is not specified.</td>
</tr>
<tr>
<td>sort</td>
<td>No</td>
<td>modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Determines how the results are sorted. To change the sort order from ascending to descending, use the reverse parameter described above.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If this parameter is not specified, the sort order defaults to descending order based on the last modification date.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• title — Sort alphabetically by title.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• creation — Sort by the date on which the content was added.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• modified — Sort by the date on which the content was last updated.</td>
</tr>
<tr>
<td>max</td>
<td>No</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Determines the maximum number of results to be displayed. Note that the results are sorted first, and then the maximum parameter is applied.</td>
</tr>
<tr>
<td>excerpt</td>
<td>No</td>
<td>false</td>
</tr>
</tbody>
</table>
| Parameter | Yes | (None) | Use this parameter to filter the results by label. The macro will display only the pages and other content types which are tagged with the label(s) you specify here. See also the operator parameter.

You can specify one or more label values, separated by a comma or a space.

- To exclude content which matches a given label, put a minus sign (-) immediately in front of that label value. For example: If you specify a label value of `-badpage` you will get only content which is not labelled with 'badpage'.
- To indicate that the results **must** match a given label value, put a plus sign (+) immediately in front of that label value. For example: If you specify a label value of `+superpage,+goodpage` you will get only content which has at least two labels, being 'superpage' and 'goodpage'. |
| showSpace | No | true | Determines whether to display the spaces in the list of results. |
| type   | No   | All   | Filters the results by content type. The macro will display only the content of the type you specify here. You can specify one or more types, separated by a comma or a space. To exclude content of a given content type, put a minus sign (-) immediately in front of that content type. For example: If you specify a content type of `-blogpost` you will get pages and all other content except for blog posts. Available values:  
- page — pages.  
- blogpost or news — blog posts, also known as news items.  
- attachment — attachments. |

|       |      |       |                                             |
| operator | No | OR | The operator to apply to the supplied lists of labels. By default, a page with any of the non-prefixed labels (that is, labels without a plus (+) or minus (-) sign immediately preceding it) will be listed. If you specify a value of AND, only pages with all of the supplied non-prefixed labels will be listed. Note that this parameter only modifies the behaviour of the 'Label(s)' parameter and only affects label values without a plus (+) or minus (-) sign prefix. To avoid confusion or unexpected results, we recommend that you do not use the operator parameter in conjunction with any label values prefixed with '+' or '-' signs. |

**Example:**

```
(contentbylabel:spaces=@personal,@self|author=admin,smaddox|title=My labelled pages|showLabels=false|reverse=true|sort=creation|max=10|excerpt=true|labels=chocolate,cake|showSpace=false|type=page|operator=AND)
```

**Content by User macro**

Displays a list of the content items that have been created by a specified Confluence user.

**Macro name:** content-by-user

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None)</td>
<td>The Confluence username for the person whose content you wish to display</td>
</tr>
</tbody>
</table>
Example:

{content-by-user:jsmith}

**Content Report Table macro**

Wiki markup is not available for this macro. You cannot add this macro via wiki markup.

**Contributors macro**

Displays a list of Confluence users who have made a contribution of some type to a page.

**Macro name:** contributors

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors displayed in the list.</td>
</tr>
</tbody>
</table>
| spaces         | No       | Current space | Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:  
|                |          |         | • @global — All sites.  
|                |          |         | • @personal — All personal spaces.  
|                |          |         | • @all — All spaces in the Confluence site.  
|                |          |         | You can specify one or more space keys or special values, separated by commas.  
|                |          |         | If no page and labels are specified, all pages from the specified set of spaces are included.  
<p>| reverse        | No       | false   | Reverses the order of contributors in the list. Must be used in conjunction with the order parameter. |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>scope</strong></td>
<td>No</td>
<td>The specified page only</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Specifies additional pages to include when generating the list of contributors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- children – only the child pages of the specified page.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- descendants – all descendants of the specified page.</td>
</tr>
<tr>
<td><strong>labels</strong></td>
<td>No</td>
<td>(None)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Limits the list of contributors to those who created the specified labels on a page. You can specify one or more labels, separated by commas.</td>
</tr>
<tr>
<td><strong>showPages</strong></td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the value is true, the macro will display a list of the pages used to generate the list of contributors.</td>
</tr>
<tr>
<td><strong>noneFoundMessage</strong></td>
<td>No</td>
<td>&quot;No contributors found for:” (and a summary of selected parameter values)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Any message given here will override the default message that is displayed when no contributors are found.</td>
</tr>
<tr>
<td><strong>showCount</strong></td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Determines whether the macro will show the number of times each person made a contribution.</td>
</tr>
<tr>
<td><strong>contentType</strong></td>
<td>No</td>
<td>Both pages and blog posts</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Restricts the content type that the macro will use when generating the list of contributors.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pages – pages</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- blogposts – blog posts</td>
</tr>
</tbody>
</table>
| include | No | authors | Filters by either the type of contribution made to a page (and optionally its descendant pages), or the watches on the page. Contribution types are:
|         |    |         | • authors - includes people who created or have edited the page(s)
|         |    |         | • comments - includes people who have added comments to the page(s)
|         |    |         | • labels - includes people who have added labels to the page(s)
|         |    |         | • watches - includes people who are watching the page(s).
|         |    |         | You can specify one or more contribution types, separated by commas.
| mode    | No | inline  | Determines how the list of contributors is formatted:
|         |    |         | • inline — a comma-separated list
|         |    |         | • list — a bullet list.
| showAnonymous | No | false | Determines whether to include those who contributed anonymously to a page. |
| order | No | count | Specifies the criteria used to sort contributors. Sort criteria are:  
|       |    |       | - count – sorts the names based on the total number of contributions to the page(s)  
|       |    |       | - name – sorts the names into alphabetical order  
|       |    |       | - update – sorts the names by the date of their last contribution to the page(s).  
| page  | No | The current page | Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed.  
| showLastTime | No | false | Determines whether to show the last time each person made a contribution.  
| publishDate | No | (None) | Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.  

**Example:**

This example specifies a content type of blog posts:

```
{contributors:limit=10|spaces=ds,@personal|reverse=true|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=blogposts|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|showLastTime=true|publishDate=2012/06/30}
```

This example specifies a content type of pages:

```
{contributors:limit=10|spaces=ds,@personal|reverse=true|scope=descendants|labels=chocolate,cake|showPages=true|noneFoundMessage=Oh dear, no contributors found|showCount=true|contentType=pages|include=authors,comments,labels,watches|mode=list|showAnonymous=true|order=update|page=ds:Advanced Topics|showLastTime=true}
```
**Contributors Summary macro**

Displays a table of contribution-based statistics for a set of pages.

**Macro name:** contributors-summary

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>limit</td>
<td>No</td>
<td>(None)</td>
<td>Limits the number of contributors or pages displayed in the table.</td>
</tr>
<tr>
<td>spaces</td>
<td>No</td>
<td>Current space</td>
<td>Specifies the space key of the Confluence space to search. Space keys are case sensitive. Special values:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• @global — All site spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• @personal — All personal spaces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• @all — All spaces in the Confluence site.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>You can specify one or more space keys or special values, separated by commas.</td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>false</td>
<td>Reverses the order of items in the table. Must be used in conjunction with the order parameter.</td>
</tr>
<tr>
<td>showAnonymous</td>
<td>No</td>
<td>false</td>
<td>Determines whether to include those who contributed anonymously to a page.</td>
</tr>
</tbody>
</table>
| **scope** | No | The specified page only | Specifies additional pages to include when generating the list of contributors.

**Available values:**
- `children` – only the child pages of the specified page.
- `descendants` – all descendants of the specified page.

| **order** | No | edits | Sets the criterion used for sorting items in the table.

**Available values:**
- `edits` – sorts items in the table based on the total number of edits made, either by a contributor or to a page.
- `name` – sorts items in the table in alphabetical order, either by contributor or page name.
- `editTime` – sorts items in the table based on when the contributor last edited a page (or a specified set of pages) or when the page was last edited.
- `update` – sorts items in the table based on when the contributor last made any contribution to a page (or a specified set of pages) or when the page last had any contribution made to it. |
<table>
<thead>
<tr>
<th><strong>page</strong></th>
<th>No</th>
<th>The current page</th>
<th>A page title. Specifies the page to use when generating the list of contributors. If page and spaces are left blank, the current page is assumed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>labels</strong></td>
<td>No</td>
<td>(None)</td>
<td>Limits contribution-based statistics to the specified labels only. You can specify one or more labels, separated by commas.</td>
</tr>
</tbody>
</table>
| **columns** | No | edits, comments, labels | Determines the columns that should appear in the table. The statistics or type of information presented depends on the groupby parameter. Available values:  
- **edits** – the number of times each contributor has edited the page(s) or the number of edits made to each page.  
- **edited** – a list of the pages edited by each contributor or a list of contributors who have edited each page.  
- **comments** – the number of times each contributor has added comments to the page(s) or the number of comments on each page.  
- **commented** – a list of pages to which each contributor has added comments or a list of contributors who have commented on each page. |
- **labels** – the number of times each contributor has added labels to the page(s) or the number of labels on each page.
- **labeled** – a list of pages to which each contributor has added labels or a list of contributors who have added a label to each page.
- **labellist** – a list of labels either added by each contributor or on each page.
- **watches** – the number of pages being watched by each contributor/person or the number of contributors/people watching each page.
- **watching** – a list of pages being watched by each contributor/person or a list of contributors/people watching each page.
- **lastupdate** – the last time each contributor made an update or when each page was last updated. Valid updates can include edits, comments or label modifications to a page.

You can specify one or more columns, separated by commas.
groupby | No | contributors | Specifies the basis for grouping contribution-based statistics:

- contributors – group by the people who have contributed.
- pages – group by the pages used to find the contributors.

contentType | No | Both pages and blog posts | Restrictions the content type that the macro will use when generating the list of contributors.

Available values:
- pages
- blogposts

showZeroCounts | No | false | Determines whether contributors or pages are included for which the calculated statistic is zero.

publishDate | No | (None) | Specifies the publication date for a blog post. The date format required is: YYYY/MM/DD.

Example:

This example specifies a content type of blog posts:

{(contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|order-update|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupby=pages|contentType=blogposts|showZeroCounts=true|publishDate=2012/06/07)}

This example specifies a content type of pages:

{(contributors-summary:limit=10|spaces=ds,@personal|reverse=true|showAnonymous=true|scope=descendants|order-update|page=ds:Advanced Topics|labels=chocolate,cake|columns=edits,comments,labels,lastupdate|groupby=pages|contentType=pages|showZeroCounts=true)}

Create Space Button macro

Displays a create space button linked to the create space page.
**Macro name:** create-space-button

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| size           | No       | large   | Determines the size of the 'create space' icon displayed. Available values:  
|                |          |         | • large  
|                |          |         | • small |
| width          | No       | Natural size of icon (1:1 pixel ratio) | The width of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the width of the icon to the number of pixels specified.  
|                |          |         | Note: This parameter is not available via the macro browser. |
| height         | No       | Natural size of icon (1:1 pixel ratio) | The height of the icon to be displayed, specified in pixels. Confluence will stretch or shrink the height of the icon to the number of pixels specified.  
|                |          |         | Note: This parameter is not available via the macro browser. |

**Example:**

```
{create-space-button:size=small}
{create-space-button:height=50px|width=50px}
```

**Excerpt Include macro**

Allows you to display an excerpt from another page within the current page.

**Macro name:** excerpt-include

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Excerpt Include Macro

**Definition:** Define a part of a page as the page's 'excerpt' which can then be displayed in another page.

**Macro name:** excerpt

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>Yes</td>
<td>(None.)</td>
<td>The name of the page that contains the excerpt to be displayed. To include an excerpt from a page in another space, type the space key followed by a colon (:) and the page name, like this: SPACEKEY:My page name. <strong>Note:</strong> The ability to include excerpts from other spaces is available only in Confluence 4.3.2 and later. In earlier versions of Confluence, the Excerpt Include macro does not work across spaces. Use the Include Page macro instead.</td>
</tr>
</tbody>
</table>

| nopanel | No | False | Determines whether Confluence will display a panel around the excerpted content. The panel includes the title of the page containing the excerpt, and the border of the panel. By default, the panel and title are shown. |

**Example:**

```confluence
{excerpt-include:My page name|nopanel=true}
```

**Excerpt macro**

Define a part of a page as the page's 'excerpt' which can then be displayed in another page.

**Macro name:** excerpt

**Macro body:** Accepts rich text.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>hidden</td>
<td>No</td>
<td>False</td>
<td>Determines whether the content of the Excerpt macro body is displayed on the page that contains the Excerpt macro. Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused.</td>
</tr>
</tbody>
</table>
| atlassian-macro-output-type | No | BLOCK | Determines whether the content of the Excerpt macro body is displayed on a new line or inline. Available values:  
- **BLOCK** – Displays the content of the macro on a new line.  
- **INLINE** – Displays the content of the macro as part of the same paragraph as the text preceding and following it.  
Note that this option affects only the page that contains the Excerpt macro. It does not affect any pages where the content is reused. |

**Example:**

```markdown
{excerpt:hidden=true|atlassian-macro-output-type=BLOCK}
This is the *text* I want to reuse in other pages. This text is inside an Excerpt macro.
{excerpt}
```

**Expand macro**

Displays an expandable/collapsible section of text.

**Macro name:** expand

**Macro body:** Accepts rich text.
default-parameter
(Unnamed in wiki markup) | No | Click here to expand... | Text that will be displayed on the line that people can click to expand the hidden text.

Example:

```
{expand:This is my message}
This text is _hidden_ until you expand it.
{expand}
```

**Favourite Pages macro**

Displays a list of your favourite pages.

**Macro name:** favpages

**Macro body:** None.

**Parameters:** None.

**Example:**

```
{favpages}
```

**Gadget macro**

Allows you to add Confluence gadgets to pages or blog posts.

**Macro name:** gadget

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| width          | No       | 450 pixels | The width of the gadget, using one of the following conventions:  
  • Width in pixels, using px or plain numbers.  
    For example, 500px or 500  
  • A percentage of the page width, using %.  
    For example, 50%  
  • Automatic resizing of the gadget to fit 100% of the page width: auto |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>border</td>
<td>No</td>
<td>true</td>
<td>Determines whether Confluence will draw a border around the gadget.</td>
</tr>
<tr>
<td>url</td>
<td>Yes</td>
<td>(none.)</td>
<td>This is the location of the gadget specification (XML file).</td>
</tr>
<tr>
<td>preferences</td>
<td>No</td>
<td>(Gadget-dependent.)</td>
<td>Specific property settings that are particular to each gadget.</td>
</tr>
</tbody>
</table>

**A note about editing a gadget's properties (preferences) in markup:** It is possible to edit the values of these properties directly in the wiki markup or storage format. However, this will allow the entry of invalid values. If a gadget property supports a certain set of values, the macro browser will restrict the user to selecting only valid values for that property. For that reason, we recommend that you use the macro browser to edit a gadget's properties.

**Example:**

This example shows the Confluence Page gadget:

```
{gadget:width=500|border=false|url=rest/gadgets/1.0/g/com.atlassian.confluence.plugins.gadgets:confluence-page-gadget/gadgets/confluence-page-gadget.xml|spaceName=Documentation&spaceKey=DOC&quickfind-space=Documentation&pageId=753666&pageName=Documentation%20Home&quickfind-page=Documentation%20Home&isEditable=true&isConfigured=true&refresh=15&showLink=false}
```

This example shows the Confluence News gadget:

```
{gadget:url=rest/gadgets/1.0/g/com.atlassian.confluence.plugins.gadgets:confluence-news-gadget/gadgets/confluence-news-gadget.xml}
```

**Gallery macro**

Forms a thumbnail gallery of all images attached to a page.

**Macro name:** gallery

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>title</td>
<td>No</td>
<td>(None)</td>
<td>Specify a title to be displayed above your gallery of pictures.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Value</td>
<td>Description</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td>-------------</td>
<td>-------</td>
</tr>
<tr>
<td>reverse</td>
<td>No</td>
<td>Not specified. Sort order is ascending.</td>
<td>Used in combination with the <code>sort</code> parameter, to change the sort order from ascending to descending. Available values: * <code>true</code> – Sort order is descending. * <code>false</code> – Sort order is ascending.</td>
</tr>
<tr>
<td>sort</td>
<td>No</td>
<td>None. The sort order is unspecified and therefore unpredictable.</td>
<td>Specify an attribute to sort the images by. Sort order is ascending, unless you specify the <code>reverse</code> parameter. Available values: * <code>name</code> – file name. * <code>comment</code> – comment linked to the attached file. * <code>date</code> – date/time last modified. * <code>size</code> – size of the attached file.</td>
</tr>
<tr>
<td>page</td>
<td>No</td>
<td>If no page is specified, the gallery macro displays the images attached to the page on which the macro is used.</td>
<td>Specify the title of the page which contains the images you want displayed. You can specify more than one page name, separated by commas. To specify a page in a different space, use the following syntax: <code>SPACEKEY:Page title</code>.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------------</td>
<td>-------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>includeLabel</td>
<td>No</td>
<td>None. The images are not filtered by label. The gallery will include only those pictures that have the specified label.</td>
<td></td>
</tr>
<tr>
<td>excludeLabel</td>
<td>No</td>
<td>No exclusions. The gallery will include all the pictures on the page.</td>
<td></td>
</tr>
<tr>
<td>columns</td>
<td>No</td>
<td>4. Specify the number of columns for the table that forms the gallery.</td>
<td></td>
</tr>
<tr>
<td>exclude</td>
<td>No</td>
<td>No exclusions. Include all the pictures on the page. Specify images by file name. The gallery will ignore any images specified.</td>
<td></td>
</tr>
</tbody>
</table>
### HTML Include macro

Includes the content of an external HTML file into a Confluence page.

**Macro name:** html-include

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>include</td>
<td>No</td>
<td></td>
<td>Include all the pictures on the page.</td>
</tr>
</tbody>
</table>

If you specifically include one or more pictures, the gallery will show only those pictures. You can specify more than one picture, separated by commas.

Note: The file name and file type for this parameter are case-sensitive. For example, 'my picture.PNG' will not be recognised as 'my picture.png'.

Example:

```
{gallery:title=My holiday pictures|reverse=true|sort=size|page=My page1, ds:Welcome to Confluence|excludeLabel=badlabel1, badlabel2|columns=3|exclude=badpicture.png}
```

### Global Reports macro

Displays a list of links to global reports within a table.

**Macro name:** global-reports

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>No</td>
<td>99%</td>
<td>Specify the width of the table in which the links are displayed, as a percentage of the window width.</td>
</tr>
</tbody>
</table>

Example:

```
{global-reports:width=50%}
```

**Example:**

```
{(global-reports:width=50%)}
```
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>url</td>
<td>Yes</td>
<td>(None)</td>
<td>Specify a URL of the content to be included into your Confluence page.</td>
</tr>
</tbody>
</table>

**Example:**

```{html-include:url=http://www.example.com}```

**HTML macro**

Renders your specified HTML code within the current page.

**Macro name:** html

**Macro body:** Text, consisting of HTML code.

**Parameters:** None.

**Example:**

```{html}<a href="http://www.atlassian.com">Click here</a> to see the <b>Atlassian</b> website.{html}```

**IM Presence macro**

Displays graphically when a contact is online.

**Macro name:** im

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
</table>
| showid         | No       | true    | Determines whether the macro shows or hides the user ID of the contact. Available values:  
• true – User ID is shown on the page.  
• false – User ID is not shown on the page. |
### service

| Yes | Not specified. | The web service that Confluence should query. Available values:
|     |               | - aim – AOL Instant Messenger
|     |               | - gtalk – Google Talk
|     |               | - icq – ICQ
|     |               | - jabber – Jabber
|     |               | - msn – MSN Instant Messenger
|     |               | - sametime – IBM Lotus Sametime
|     |               | - skype – Skype
|     |               | - skypeme – Skype
|     |               | - wildfire – Openfire Server
|     |               | - yahoo – Yahoo! Messenger

### default-parameter

(Unnamed in wiki markup) | Yes | Not specified. | User ID. Identifies the IM contact by their ID, account name or screen name.

#### Example:

```
{im:MySkypeName|service=skype|showid=false}
```

### Include Page macro

 Inserts the contents of the specified page into the current one.

**Macro name:** include

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>icon</td>
<td>No</td>
<td>true</td>
<td>Determines whether to display the icon in the title bar of the information box.</td>
</tr>
</tbody>
</table>

**Info macro**

Displays a block of text in a blue highlight box.

**Macro name:** info

**Macro body:** Accepts rich text.

Example:

```
{include:DOC:My chocolate page}
```
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>anonymous</td>
<td>No</td>
<td>false</td>
<td>If this parameter is set to 'true', JIRA will return only the issues which allow unrestricted viewing i.e. the issues which are visible to anonymous viewers, as determined by JIRA's viewing restrictions. If this parameter is omitted or set to 'false', then the results depend on how your administrator has configured the communication between JIRA and Confluence. By default, Confluence will show only the JIRA issues which the user is authorised to view. See more details below.</td>
</tr>
</tbody>
</table>

### JIRA Issues macro

Displays a list of JIRA issues in a page.

**Macro name:** jiraissues

**Macro body:** None.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>baseurl</strong></td>
<td>No</td>
<td>The value of the 'url' parameter. If you specify a 'baseurl', then the link in the header, pointing to your JIRA site, will use this base URL instead of the value of the 'url' parameter. This is useful when Confluence connects to JIRA with a different URL from the one used by other users.</td>
</tr>
</tbody>
</table>
| **columns** | No | By default, the following columns are shown:  
  - type  
  - key  
  - summary  
  - assignee  
  - reporter  
  - priority  
  - status  
  - resolution  
  - created  
  - updated  
  - due  
  A list of JIRA column names, separated by semi-colons (;). Example columns are: key, summary, type, created, fixversion, updated, due, assignee, reporter, priority, status and resolution. You can include any columns recognised by your JIRA site, including custom columns. See the [JIRA documentation](https://docs.atlassian.com/software/jira/pages endorsed) for a list of names. |
<p>| <strong>count</strong> | No | false | If this parameter is set to 'true', the issue list will show the number of issues in JIRA. The count will be linked to your JIRA site. |
| <strong>cache</strong> | No | on | The macro maintains a cache of the issues which result from the JIRA query. If the 'cache' parameter is set to 'off', the relevant part of the cache is cleared each time the macro is reloaded. (The value 'false' also works and has the same effect as 'off'.) |</p>
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Required</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>height</td>
<td>No</td>
<td>480</td>
<td>The height in pixels of the table displaying the JIRA issues. Note that this height specification is ignored in the following situations: - If you set the <code>renderMode</code> parameter (see below) to 'static'. - When the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed.</td>
</tr>
<tr>
<td>renderMode</td>
<td>No</td>
<td></td>
<td>In formats not mentioned below, the default is 'dynamic'. The default is 'static' when the JIRA issues are displayed in a PDF or Word document, in an email message or in an RSS feed. By default, the JIRA Issues macro offers a dynamic display with the following features: - Click the column headers to sort the output. - Drag and drop the columns into a different order. - Temporarily remove a column from the display. - View a page of issues at a time, for faster response times. Set the <code>renderMode</code> parameter to 'static' if you want to disable the dynamic display features.</td>
</tr>
<tr>
<td>title</td>
<td>No</td>
<td>JIRA Issues</td>
<td>You can customise the title text at the top of the JIRA issues table with this parameter. For instance, setting the title to 'Bugs-to-fix' will replace the default 'JIRA Issues' text. This can help provide more context to the list of issues displayed.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Required</td>
<td>Default</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>----------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>url</td>
<td>Yes</td>
<td>none</td>
<td>The URL of the XML view of your selected issues in JIRA Issue Navigator. Note: If the URL in the 'url' parameter does not contain a tempMax argument, then the value of tempMax will default to 500. If your JIRA server is version 3.12 or earlier, this means that the JIRA Issues macro will return a maximum of 500 issues. If your JIRA server is version 3.13 or later, a value of 500 means that the JIRA Issues macro will return a maximum of 500 issues per page.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td>100%</td>
<td>The width of the table displaying the JIRA issues. Can be indicated either as a percentage (%) or in pixels (px).</td>
</tr>
</tbody>
</table>

Example:

```plaintext
{jiraissues:anonymous=true|url=http://jira.atlassian.com/|jira.issueviews:searchrequest-xml/temp/SearchRequest.xml?jqlQuery=project+%3D+CONF+AND+%28summary+%7E+jiraissues+OR+description+%7E+jiraissues+OR+comment+%7E+jiraissues%29&tempMax=10|columns=type;key;summary}
```

JUnit Report macro

Display a summary of JUnit test results.

Macro name: **junitreport**

Macro body: None.
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
</table>
| directory   | Must include either the directory or the url parameter                       | (None)    | URL of a directory containing your test result files. This must be a directory name and not the XML file itself. Overrides the url parameter if you use both.  
**Note:** When using a local drive, you must use a directory name and not the XML file itself. |
| reportdetail| No                                                                           | all       | Level of detail required in the report.  
Available values:  
- all  
- fixture  
- summary  
- failuresonly |
| url         | Must include either the directory or the url parameter                       | (None)    | URL of a particular test result XML file.  
This parameter is overridden by the directory parameter if you use both.  
For Confluence installations that require authentication, you can specify login credentials as part of this parameter, in the form of URL parameters:  
- os_username — The username of a Confluence user with permission to access the JUnit test results.  
- os_password — The password of the Confluence user specified in the os_username parameter. |
**debug** | No | false | If the value of this parameter is **true**, the report will show the content of failures, as well as the error messages.

---

**Example:**

Loading JUnit reports from a local drive:

```
{junitreport:directory=file:///C:/TEMP/}
```

Loading JUnit reports from a network drive:

```
{junitreport:url=http://*host*/*path*}
```

Loading JUnit reports from a Confluence site:

```
{junitreport:url=http://yourConfluenceInstance.com/download/attachments/<page id>/file.xml}
```

Loading JUnit reports from a Confluence site that requires authentication:

If your Confluence site is not accessible by anonymous users, specify login credentials with the **os_username** and **os_password** URL parameters (as part of the macro's **url** parameter). In this case, we are specifying a username of 'admin' and a password of 'secret'.

```
{junitreport:url=http://yourConfluenceInstance.com/download/attachments/<page id>/file.xml?os_username=admin&os_password=secret}
```

---

**Labels List macro**

Displays a hyperlinked alphabetical index of all labels within the current space.

**Macro name:** listlabels

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaceKey</td>
<td>No</td>
<td>Current space</td>
<td>The key of the space whose labels you want to display.</td>
</tr>
</tbody>
</table>

**Example:**
**Livesearch macro**

Add a dynamic search box to a wiki page.

**Macro name:** livesearch

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>No</td>
<td>(None)</td>
<td>Uniquely identifies the Livesearch macro when there are more than one Livesearch macros in a page.</td>
</tr>
<tr>
<td>spaceKey</td>
<td>No</td>
<td>All spaces</td>
<td>Specify a space key to limit the search to the given space.</td>
</tr>
</tbody>
</table>

**Example:**

```
{livesearch:spaceKey=DOC|id=mysearch1}
```

**Loremipsum macro**

Display a few paragraphs of pseudo-Latin text.

**Macro name:** loremipsum

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>default-parameter</td>
<td>No</td>
<td>3</td>
<td>Number of paragraphs. Determines the amount of pseudo-Latin (space-filler) text to display. The macro will display a maximum number of 30 paragraphs.</td>
</tr>
</tbody>
</table>

**Example:**

```
(loremipsum:2)
```
Multimedia macro

Displays videos, animations and more, sourced from a file attached to a Confluence page and displayed on your page.

**Macro name:** multimedia

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>page</td>
<td>No</td>
<td>Current page</td>
<td>Name of the page to which the multimedia file is attached.</td>
</tr>
<tr>
<td>space</td>
<td>No</td>
<td>Current space</td>
<td>Space key of the page that has the multimedia file attached.</td>
</tr>
<tr>
<td>name</td>
<td>Yes</td>
<td>None</td>
<td>File name of the multimedia file, which is attached to a Confluence page.</td>
</tr>
<tr>
<td>width</td>
<td>No</td>
<td>If not specified, the browser will determine the width based on the file type.</td>
<td>Width of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's width, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>height</td>
<td>No</td>
<td>If not specified, the browser will determine the height based on the file type.</td>
<td>Height of the movie window to be displayed on the page. By default, this value is specified in pixels. You can also choose to specify a percentage of the window's height, or any other value accepted by HTML.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Required</td>
<td>Default</td>
<td>Parameter description and accepted values</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>---------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>autostart</td>
<td>No</td>
<td>false</td>
<td>If the parameter is set to <code>true</code> then the video or audio file will start playing as soon as the page is loaded. If this option is set to <code>false</code> then the file will not play until the user clicks the icon or image on the page.</td>
</tr>
</tbody>
</table>

**Example:**

```plaintext
{multimedia:space=DOC|page=My macros|name=ninjas.swf|autostart=true}
```

**Page Properties macro**

Allows you to embed metadata into a page and then display that data in tabular form using the **Page Properties Report macro**. Previously known as the Metadata Details macro.

**Macro name:** details

**Macro body:** Accepts rich text.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>hidden</td>
<td>No</td>
<td>false</td>
<td>Determines whether the data in the Page Properties macro will be displayed on the current page. This setting does not affect the display of the detail in the Page Properties Report macro.</td>
</tr>
<tr>
<td>label</td>
<td>No</td>
<td>(None)</td>
<td>The label used to identify the metadata on this page. Confluence will add this label to the page.</td>
</tr>
</tbody>
</table>

**Example:**

```plaintext
{details:hidden=true|label=status}
Project Status: Complete
Team: Green Parrots
Deadline: 2012-09
(details)
```

**Page Properties Report macro**
Presents a tabulated summary of selected metadata, which has been embedded on pages using the Page Properties macro. Previously known as the Details Summary macro.

**Macro name:** detailssummary

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>label</td>
<td>No</td>
<td>(None)</td>
<td>Identifies the metadata to be included in the Page Properties Report. The report will show data from the Page Properties macros on the pages in the current space that have this label on the page.</td>
</tr>
</tbody>
</table>

**Example:**

```
{detailssummary:label=status}
```

**Section macro**

Used with the Column macro to define columns on a page. See Working with page layouts and columns and sections.

**Macro name:** section

**Macro body:** Rich text, consisting of one or more Column macros.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>border</td>
<td>No</td>
<td>False</td>
<td>If the value is true, the columns in this section will have a dashed border.</td>
</tr>
</tbody>
</table>

**Example:**

```
{section:border=true}
{column:width=100px}
This is the content of *column 1*.
{column}
{column}
This is the content of *column 2*.
{column}
{section}
```
**Table of Contents macro**

Displays a table of contents from your page headings.

**Macro name:** toc

**Macro body:** None.

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Required</th>
<th>Default</th>
<th>Parameter description and accepted values</th>
</tr>
</thead>
<tbody>
<tr>
<td>printable</td>
<td>No</td>
<td>true</td>
<td>If you set this parameter to false, the table of contents will not be visible when you print the page.</td>
</tr>
<tr>
<td>style</td>
<td>No</td>
<td>none</td>
<td>The style of bullet point for each list item. You can use any valid CSS style. For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• none – No list style is displayed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• circle – The list style is a circle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• disc – The list style is a filled circle. This is the typical bullet list, and is the one we are using in this example list.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• square — The list style is a square.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• decimal — The list is numbered (1, 2, 3, 4, 5).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• lower-alpha — The list style is lower case, alphabetised (a, b, c, d, e).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• lower-roman — The list style is lower-case roman numerals (i, ii, iii, iv, v, vi).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• upper-roman — The list style is upper-case roman numerals (I, II, III, IV, V, VI).</td>
</tr>
<tr>
<td>Parameter</td>
<td>Default</td>
<td>Example Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>maxLevel</td>
<td>No</td>
<td>7</td>
<td>Maximum heading level. Use this parameter to select the highest heading level to include. For example, a value of 2 will list h1 and h2 levels, but will not include h3 and below.</td>
</tr>
<tr>
<td>indent</td>
<td>No</td>
<td>(None)</td>
<td>This parameter applies to vertical lists only (type = list). Use this parameter to indent the list items according to CSS quantities. For example, a value of 10px will successively indent list heading groups by 10 pixels. Level 1 headings will be indented 10px, and level 2 headings by an additional 10px, and so on.</td>
</tr>
<tr>
<td>minLevel</td>
<td>No</td>
<td>1</td>
<td>Minimum heading level. The heading level at which the table of contents will start. For example, a value of 2 will list h2, h3, and h4 headings, but will not include h1 headings.</td>
</tr>
<tr>
<td>class</td>
<td>No</td>
<td>(None)</td>
<td>A CSS class name. If you have a custom style sheet, you can use this parameter to output the table of contents with the specified class attribute.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default Value</td>
<td>Values</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>exclude</td>
<td>Specifies the headings to exclude by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will include only the headings that match the regular expression. Example: .* .[1-2]</td>
<td>(None)</td>
<td><strong>Exclude by pattern matching</strong>.</td>
</tr>
<tr>
<td>type</td>
<td>Defines the overall format of the table of contents. Available values:</td>
<td>No</td>
<td>list</td>
</tr>
<tr>
<td></td>
<td>- list – displays the table of contents in a vertical list.</td>
<td></td>
<td><strong>list</strong></td>
</tr>
<tr>
<td></td>
<td>- flat – displays a horizontal series of links. For example: [Heading 1] [Heading 2] [Heading 3].</td>
<td></td>
<td><strong>flat</strong></td>
</tr>
<tr>
<td>outline</td>
<td>A value of true will apply outline numbering to the headings as displayed in the table of contents. For example: 1.1, 1.2, 1.3.</td>
<td>No</td>
<td>false</td>
</tr>
<tr>
<td>separator</td>
<td>No</td>
<td>brackets</td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>----</td>
<td>----------</td>
<td></td>
</tr>
</tbody>
</table>
|           |    | **brackets** | This parameter applies to flat lists only (type = flat). Use this parameter to style the display of a flat list. Available values:  
- **brackets** – Each item is enclosed by square brackets: `[ ]`.  
- **braces** – Each item is enclosed by braces: `{ }`.  
- **parens** – Each item is enclosed by parentheses: `( )`.  
- **pipe** – The items are separated by a pipe: `|`.  
- **anything** – The items are separated by the value you enter. You can enter any text as a separator, for example `***`. If using a custom separator, be aware that text displays exactly as entered, with no additional white space to further separate the characters. |

<table>
<thead>
<tr>
<th>include</th>
<th>No</th>
<th>(None)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><em>Specifies the headings to include by pattern matching. The value must be a regular expression. If this parameter is specified, the table of contents will ignore any headings that do not match the regular expression. Example: <code>.\.*\.[1//2]</code></em></td>
</tr>
</tbody>
</table>

See Sun's Regex documentation for examples of constructing regular expression strings.
Example:

This example shows a list-type table of contents.

```text
{toc:printable=true|style=square|maxLevel=2|indent=5px|minLevel=2|class=bigpink|exclude=[1//2]|type=list|outline=true|include=.*)
```

This example shows a flat table of contents.

```text
{toc:printable=true|maxLevel=2|minLevel=2|class=bigpink|exclude=[1//2]|type=flat|outline=true|separator=pipe|include=.*)
```

Notes

- The 'Required' column indicates whether the parameter is required on data entry. If the parameter is not supplied, Confluence will insert default values as indicated in the 'Default' column.
- Wiki markup is not case sensitive. For example, you can specify a parameter name of `sortBy` or `sortby`.
- For a few macros in wiki markup, the default parameter may be unnamed. The examples on this page show the macros concerned. In such cases, the unnamed parameter is always the first parameter specified.
- A request from the Atlassian technical writers about comments and feedback: We would like to distinguish between the documentation of the current solution (this page) and any discussion of the solution and possible changes to Confluence wiki markup and/or the XHTML-based storage format. If you have a suggestion for, or correction of, this documentation, please add your suggestion to this page. If you have feedback on the Confluence markup, storage format and related functionality, please add your suggestion to the page titled Confluence 4 Editor - Customer Feedback. Thanks.😊

Wiki Markup Examples for Chart Macro

This page is an extension of Confluence Wiki Markup for Macros, which contains wiki markup examples for all Confluence macros. The Chart macro is a special case, because it offers so many options via parameters and chart types. This page offers additional examples for the Chart macro.

Pie chart

Here is a simple example of a pie chart.

Wiki markup

```text
{chart:type=pie|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |
|| Salmon | 2,900 | 4,200 |
|| Tuna | 1,500 | 1,500 |
{chart}
```

Resulting chart
**Fish Sold**

Here is a simple example of a bar chart.

*Wiki markup*

```wiki
{chart:type=bar|title=Fish Sold}
|| Fish Type || 2004 || 2005 ||
|| Herring | 9,500 | 8,300 |
|| Salmon | 2,900 | 4,200 |
|| Tuna | 1,500 | 1,500 |
{chart}
```

**Resulting chart**

Here is an example of a time series chart.

*Wiki markup*

```wiki
Time series chart
```

**Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.**
Here is an example of an XY line chart.

Wiki markup
{chart:type=xyline}

<table>
<thead>
<tr>
<th></th>
<th>12</th>
<th>14</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
</tr>
</tbody>
</table>

Resulting chart

XY bar chart

Here is an example of an XY bar chart.

Wiki markup

{chart:type=xybar|opacity=60}

<table>
<thead>
<tr>
<th></th>
<th>2005</th>
<th>2006</th>
<th>2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
</tr>
</tbody>
</table>

Resulting chart
XY area chart

Here is an example of an XY area chart.

Wiki markup

```
{chart:type=xyarea}
<table>
<thead>
<tr>
<th></th>
<th>12</th>
<th>14</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td>Revenue</td>
<td>41.1</td>
<td>31.8</td>
<td>12.4</td>
</tr>
<tr>
<td>Expense</td>
<td>31.1</td>
<td>41.8</td>
<td>43.6</td>
</tr>
</tbody>
</table>
{chart}
```

Resulting chart

Area chart

Here are two examples of area charts.

Wiki markup for area chart 1

```
<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>20</td>
<td>23</td>
<td>34</td>
</tr>
<tr>
<td>Satisfied</td>
<td>40</td>
<td>34</td>
<td>23</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>25</td>
<td>26</td>
<td>25</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>15</td>
<td>17</td>
<td>18</td>
</tr>
</tbody>
</table>

Resulting area chart 1

<table>
<thead>
<tr>
<th>Satisfaction</th>
<th>2002</th>
<th>2003</th>
<th>2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Very satisfied</td>
<td>12</td>
<td>23</td>
<td>31</td>
</tr>
<tr>
<td>Satisfied</td>
<td>1</td>
<td>34</td>
<td>36</td>
</tr>
<tr>
<td>Dissatisfied</td>
<td>4</td>
<td>6</td>
<td>22</td>
</tr>
<tr>
<td>Very dissatisfied</td>
<td>2</td>
<td>7</td>
<td>12</td>
</tr>
</tbody>
</table>

Wiki markup for area chart 2
Working with Confluence Gadgets

This section introduces the concept of gadgets in Confluence and provides an outline on how to use gadgets in Confluence and other web applications.

Introduction to Gadgets in Confluence

A gadget is a small object (i.e. a piece of functionality) offering dynamic content that can be placed into the page of:

- An Atlassian application's website, such as a Confluence page or blog post or a JIRA 4.0+ dashboard.
- A third-party application's website, such as iGoogle or Gmail. (But see the limitations on using Confluence gadgets in other applications.)

Gadgets allow interactions between Confluence and other compatible websites. Confluence interacts with gadgets that support the OpenSocial specification.

For more information about Atlassian gadgets, please refer to the introduction to Atlassian gadgets and the big list of Atlassian gadgets.

Using Gadgets in Confluence

You can place any gadget that complies with the OpenSocial specification from an external source, such as iGoogle or other Atlassian applications such as JIRA 4.0+, onto a Confluence page or blog post. To add a gadget to a page, use the Confluence macro browser to add a Gadget macro.

See the page on adding JIRA gadgets to a Confluence page.
Adding Confluence Gadgets in Other Applications

You can add a Confluence gadget to a JIRA dashboard or another Confluence site. In principle, you can also put a Confluence gadget on any other OpenSocial-compliant website such as iGoogle or Gmail. See the limitations on using Confluence gadgets in other applications.

Adding a Confluence Gadget to JIRA

See Adding a Confluence Gadget to a JIRA Dashboard.

Adding a Confluence Gadget to Non-Atlassian Web Applications

For instructions on how to add Confluence gadgets in another compatible non-Atlassian web application or container, refer to Configuring Confluence Gadgets for Use in Other Applications.

Confluence Gadgets

The Confluence Gadgets topic explains the purpose of the 'Confluence Gadgets' window and provides information about the gadgets which are bundled with Confluence.

Adding a Confluence Gadget to a JIRA Dashboard

JIRA 4.0 is the first major Atlassian application that can incorporate OpenSocial-compliant gadgets, such as Confluence gadgets onto its dashboard. This page explains how to add a Confluence gadget to the dashboard of a JIRA 4.0+ installation.

To add a Confluence gadget to a JIRA dashboard, complete the steps below.

Note:

- You need system administrator privileges in JIRA, to add a gadget to the list of available gadgets.
- In Atlassian OnDemand products, it is not possible for administrators to add gadgets to the directory. If you would like to add an Atlassian gadget to a directory, please contact Atlassian Support.

Creating an Application Link between Confluence and JIRA (Not applicable to Confluence OnDemand.)

If your Confluence gadgets need to access user-restricted Confluence data, then your Confluence administrator must first establish an Application Link between your Confluence site and the JIRA site. For more information about configuring an Application Link between Confluence and other web applications, refer to Configuring OAuth Authentication for an Application Link. (Not applicable to Confluence OnDemand.)

If you only need to access anonymously accessible Confluence data, then you can skip the section about adding
an Application Link, and go directly to Finding a Confluence Gadget's URL, below.

On this page:
- Creating an Application Link between Confluence and JIRA (Not applicable to Confluence OnDemand.)
- Finding a Confluence Gadget's URL
- Adding a Confluence gadget to JIRA's gadget directory (Not applicable to Confluence OnDemand.)
- Adding a Confluence gadget to the JIRA dashboard

Related pages:
- All Atlassian gadgets
- Working with Confluence Gadgets
- Confluence User's Guide

Some functionality described on this page is restricted in Confluence OnDemand.

Finding a Confluence Gadget's URL

A gadget's URL points to the gadget's XML specification file. These URLs look something like this:

http://example.com/my-gadget-location/my-gadget.xml

To find a Confluence gadget's URL:

1. Choose the help icon at top right of the screen, then choose Available Gadgets.
2. Find the gadget you want.
3. Copy the Gadget URL link to your clipboard.

Screenshot: Finding a gadget's URL

Adding a Confluence gadget to JIRA’s gadget directory (Not applicable to Confluence OnDemand.)
To add a Confluence gadget to the gadget directory in JIRA:

1. Go to the dashboard by clicking Dashboard at the top left of the screen.
2. The dashboard will appear. Click Add Gadget.
3. The 'Add Gadget' screen appears, showing the list of gadgets in your directory. See screenshot 1 below. Click Add Gadget to Directory.
   Note: You will only see this button if you have system administrator permissions in JIRA.
4. The 'Add Gadget to Directory' screen appears. See screenshot 2 below. Paste the gadget URL (which you copied to your clipboard above) into the text box.
5. Click Add Gadget.
6. The gadget appears in your gadget directory. (It will be highlighted for a short time, so that you can see it easily.)

Screenshot 1: Gadget directory with 'Add Gadget to Directory' button
Adding a Confluence gadget to the JIRA dashboard

In the procedure below, 'your Atlassian dashboard' and 'your Atlassian application' refers to the JIRA dashboard and application, respectively.

You can add a gadget from the directory of gadgets that are available to your Atlassian application.

To add a gadget to your Atlassian dashboard,

1. Go to the dashboard by clicking the 'Dashboard' link or the 'Home' link at the top left of the screen.
2. The dashboard will appear, looking something like screenshot 1 below. Click 'Add Gadget'.
3. The 'Add Gadget' screen will display a list of available gadgets in your gadget directory, as shown in screenshot 2 below. Find the gadget you want, using one or more of the following tools:
   - Use the scroll bar on the right to move up and down the list of gadgets.
   - Select a category in the left-hand panel to display only gadgets in that category.
   - Start typing a key word for your gadget in the 'Search' textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
4. When you have found the gadget you want, click the 'Add it Now' button to add the gadget to your dashboard.
Screenshot 2: Adding a gadget from the gadget directory

Note:
You need administrator privileges to add a gadget to the list of available gadgets. If you have permission to add gadgets to and remove gadgets from the directory itself, you will see the 'Add Gadget to Directory' and 'Remove' buttons on the 'Add Gadget' screen, as shown in the screenshot about. Please refer to the Gadgets and Dashboards Administration Guide.

In Atlassian OnDemand products, it is not possible for administrators to add gadgets to the directory. If you would like to add an Atlassian gadget to a directory, please contact Atlassian Support.

Configuring Confluence Gadgets for Use in Other Applications

This page tells you how to add a Confluence gadget to another (external) application. The instructions and examples given in this topic focus on adding and using Confluence Gadgets in other web applications.

Atlassian support does not cover gadgets on external sites like iGoogle and Gmail

In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

Gadgets that display information from Atlassian applications, such as Confluence, should be able to run on iGoogle, Gmail and other web applications that provide OpenSocial containers. Below are specific instructions for iGoogle and Gmail. You can experiment by adding a Confluence gadget to other web sites and applications, such as a Ning community like The Content Wrangler.

On this page:

- Overview of Adding a Confluence Gadget to Another Web Application
- Finding a Confluence Gadget's URL
- Adding an Atlassian Gadget to iGoogle
- Adding an Atlassian Gadget to Gmail
- Limitations and Support
- Related Topics

Overview of Adding a Confluence Gadget to Another Web Application

The exact procedure for adding a Confluence gadget depends on the application where you want to add the gadget. The basic steps are the same:

1. Find the Confluence gadget's URL, i.e. the URL for the gadget's XML specification file.
2. Ensure one of the following two mandatory (typically one-off) procedures have been conducted:
   - An OAuth relationship between Confluence (as the 'service provider') and the other web application (as the 'consumer') has been established. Refer to Configuring OAuth for more information about OAuth and instructions on establishing these relationships.
   - A Trusted Applications relationship between Confluence and JIRA has been established. Refer to Configuring Trusted Applications in the JIRA documentation for more information about establishing these relationships.
3. Follow the procedure provided by the external web application where you want to add the Confluence gadget.

Finding a Confluence Gadget's URL

A gadget's URL points to the gadget's XML specification file. These URLs look something like this:
To find a Confluence gadget's URL:

1. Choose the help icon at top right of the screen, then choose Available Gadgets.
2. Find the gadget you want.
3. Copy the Gadget URL link to your clipboard.

Adding an Atlassian Gadget to iGoogle

You can customise your iGoogle home page by adding gadgets and moving them around on the page.

To add an Atlassian gadget to your iGoogle page:

1. First find the gadget's URL as described above.
2. Go to iGoogle and log in if you have a username and password.
3. Click Add stuff near the top right of the iGoogle page.
4. The Google gadget directory will appear, showing a list of available gadgets. Click Add feed or gadget in the right-hand panel.
5. A text box will open, as shown above. Enter or paste the gadget's URL from your clipboard into the textbox and click Add.
6. Go back to your iGoogle home page. The gadget will appear on your iGoogle page.

Adding an Atlassian Gadget to Gmail
You can add gadgets to the left-hand panel of your Gmail page.

**To add an Atlassian gadget to your Gmail page:**

1. First find the gadget's URL as described above.
2. Log in to Gmail.
3. Click Settings near the top right of the Gmail page. The Gmail settings page will appear.
4. Click the Labs tab. The Gmail Labs page will appear. This is a laboratory area or testing ground where Google allows you to use experimental features in Gmail.
5. Scroll down to find the feature called 'Add any gadget by URL'.
6. Select the Enable option, as shown here:

   ![Enable option](image)

7. Click Save Changes.
8. A new Gadgets tab will appear on your 'Settings' page. Click the Gadgets tab. The 'Gadgets' page will appear, as shown in the screenshot below.
9. Enter or paste your gadget's URL into the Add a gadget by its URL box, then click Add.
10. The gadget will appear in the left-hand panel of your Gmail page, as shown in the screenshot below.

**Screenshot: Adding a gadget to Gmail**

![Gadgets tab in Gmail](image)

**Limitations and Support**

⚠️ Atlassian support does not cover gadgets on external sites like iGoogle and Gmail.

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
In principle, you should be able to add Atlassian gadgets to iGoogle, Gmail and other external sites that support OpenSocial gadgets. However, these external integrations are experimental at this stage and we have encountered problems with them. Please do not have fun playing around with them, but be aware that Atlassian does not support the use of Atlassian gadgets on iGoogle, Gmail or other external web sites. See the detailed section on gadget limitations.

**Related Topics**

The big list of Atlassian gadgets
Confluence Gadgets

This page describes the purpose of the ‘Confluence Gadgets’ dialog and how to access it, and provides information about the gadgets that are bundled with Confluence.

Gadgets:

- Interact with and provide access to data in your Confluence installation.
- Can be used externally such as on a JIRA dashboard, a page or blog post of another Confluence site, or any compatible page on a website that accepts gadgets, such as iGoogle. (But see the limitations on using Confluence gadgets in other applications.)

**The gadgets dialog**

The ‘Confluence Gadgets’ dialog displays a list of all the Confluence gadgets available in your Confluence installation. The Confluence gadgets bundled with Confluence are described below. Any additional Confluence gadgets installed by your Confluence administrator (typically as Confluence plugins), will also appear in this list.

To access the Confluence Gadgets dialog: Choose the help icon at top right of the screen, then choose Available Gadgets.

You can use a Confluence gadget within the same Confluence site, by adding it to a page or blog post using the gadget macro.

You can also add Confluence gadgets to external applications. See Adding a Confluence Gadget to a JIRA Dashboard and Configuring Confluence Gadgets for Use in Other Applications.

On this page:
- The gadgets dialog
- Confluence gadgets

Related pages:
- Adding a Confluence Gadget to a JIRA Dashboard
- Configuring Confluence Gadgets for Use in Other Applications
- Gadget Macro
- The big list of Atlassian gadgets
- Confluence User's Guide

Screenshot: The ‘Confluence Gadgets’ dialog
Confluence gadgets

This following table lists the gadgets which are bundled with Confluence. Click the name of the gadget for more information.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Page Gadget</td>
<td>The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.</td>
</tr>
<tr>
<td>Activity Stream Gadget</td>
<td>The activity stream gadget is similar to the recently updated macro and shows a list of the most recently changed content within your Confluence site.</td>
</tr>
<tr>
<td>Confluence News Gadget</td>
<td>The Confluence news gadget is an example of a 'news feed' gadget that shows a list of recent Confluence Product Blogs and events at Atlassian.</td>
</tr>
<tr>
<td>Confluence Quicknav Gadget</td>
<td>The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.</td>
</tr>
</tbody>
</table>

Activity Stream Gadget

The activity stream gadget is similar to the recently updated macro and shows a list of the most recently changed content within your Confluence site.

ℹ️ For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.
In addition to showing a list of most recently changed content, the activity stream gadget also provides the following features:

- The ability to add comments to pages and blog posts, by clicking the 'add comment' icon at the top-right of an added or edited page or blog post in the activity stream.
- The ability to reply to a comment by clicking the 'add comment' icon at the top-right of a comment in the activity stream.
- Activities are grouped by separate date.
- An RSS feed link to its content in the top-right corner of the gadget.

**Screenshot: Adding a Comment in the Activity Stream Gadget**

Activity Stream Gadget Properties

Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Yes</td>
<td>None</td>
<td>Adds a title to the top of the Activity Stream.</td>
</tr>
<tr>
<td>Projects</td>
<td>No</td>
<td>None specified (i.e. display content in all spaces)</td>
<td>Filters the content by space. This gadget will display only the pages etc. which belong to the space(s) you specify here.</td>
</tr>
<tr>
<td>Username</td>
<td>No</td>
<td>None specified (i.e. display content by all users)</td>
<td>Filters the results by user. The macro will display only the pages etc. which were last modified by the user(s) you specify here. You can specify one or more users, separated by a comma or a space.</td>
</tr>
<tr>
<td>Number of Entries</td>
<td>No</td>
<td>10</td>
<td>Specify the maximum number of results to be displayed. A maximum of 10 results will be displayed by default. The maximum value that this property can accept is 100.</td>
</tr>
<tr>
<td>-------------------</td>
<td>----</td>
<td>----</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>No</td>
<td>Never/false</td>
<td>Specify the time interval between each 'refresh' action undertaken by the activity stream gadget. A refresh makes the activity stream gadget reflect any new activity that has been conducted on the Confluence site.</td>
</tr>
</tbody>
</table>

Confluence News Gadget

The Confluence news gadget is an example of a 'news feed' gadget that shows a list of recent Confluence Product Blogs and events at Atlassian.

*i* *For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.*

Clicking an item in the Confluence news gadget takes you directly to the selected blog post of the Confluence Product Blogs feed or event details on the events at Atlassian page.

Clicking **More news** takes you to the Confluence Product Blogs feed page and clicking **More events** takes you to the events at Atlassian page.

**Screenshot: The News Gadget**

![News and Events](image)

Confluence: News Gadget Properties
Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show News?</td>
<td>No</td>
<td>True</td>
<td>Shows a short list of the most recent Confluence Product Blogs.</td>
</tr>
<tr>
<td>Show Events?</td>
<td>No</td>
<td>True</td>
<td>Shows a short list of the most recent events at Atlassian.</td>
</tr>
<tr>
<td>Show Banners?</td>
<td>No</td>
<td>True</td>
<td>Shows any banner advertisements (if available).</td>
</tr>
</tbody>
</table>

**Confluence Page Gadget**

The Confluence page gadget allows you to show content from a page on your Confluence site in a gadget. You can optionally configure the gadget to display links to view and/or edit the page on your Confluence site. The page gadget can also be displayed in canvas view, so that it takes up all of the space provided by your dashboard.

ℹ️ For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

**Macros that work with the page gadget**

Please note, not all macros work with the page gadget. Please refer to the Working Macros section below for more information.

**On this page:**
- Confluence Page Gadget Properties
- Working Macros

**Related pages:**
- Confluence Gadgets
- Confluence User’s Guide

**Screenshot: The Confluence page gadget displaying a sample page**

**Sample Page**

Two penguins find themselves together on an ice floe, drifting helplessly into warmer waters. The penguins are very fond of each other. Suddenly **cra-a-a-a-ck** the ice flow splits in half, right between the penguins. As they drift apart, one penguin sadly waves a flipper and calls out "Chocolate milk!"
Properties are settings for Confluence gadgets that allow the user to control the content or presentation of data retrieved by the gadget. These are similar to a Confluence macro's parameters. The table below lists relevant properties for this gadget.

<table>
<thead>
<tr>
<th>Property</th>
<th>Required?</th>
<th>Default</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space</td>
<td>No</td>
<td>None</td>
<td>Specify the space that your desired page is located in. Suggestions will display in a dropdown when you start typing. (Note, this property is only used to make searching for pages easier. It is not required.)</td>
</tr>
<tr>
<td>Page</td>
<td>Yes</td>
<td>None</td>
<td>Specify the page that you want to display in your gadget. Suggestions will display in a dropdown when you start typing.</td>
</tr>
<tr>
<td>Show View Link</td>
<td>No</td>
<td>Yes</td>
<td>Select whether to display a link to view the page on your Confluence site. Clicking the link will open the page in Confluence.</td>
</tr>
<tr>
<td>Show Edit Link</td>
<td>No</td>
<td>No</td>
<td>Select whether to display a link to edit the page on your Confluence site. Clicking the link will open the page for editing in Confluence.</td>
</tr>
<tr>
<td>Refresh Interval</td>
<td>No</td>
<td>Never/false</td>
<td>Specify the time interval between each 'refresh' action undertaken by the page gadget. A refresh makes the activity stream gadget reflect any new activity that has been conducted on the Confluence site.</td>
</tr>
</tbody>
</table>

Working Macros

The Confluence page gadget will only render a subset of the macros that are used in Confluence correctly. Refer to the table below for the list of macros that work and do not work with the page gadget and known limitations.

Some of the issues with macros in the page gadget can be worked around, if you are comfortable developing in Confluence. Please see Troubleshooting Macros in the Page Gadget for more information.
### Key:
- ![Works with the page gadget](image)
- ![Partially works with the page gadget](image)
- ![Does not work with the page gadget](image)

<table>
<thead>
<tr>
<th>Macro</th>
<th>Works with page gadget?</th>
<th>Limitations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Stream</td>
<td><img src="image" alt=" " /></td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Anchor (within a page)</td>
<td><img src="image" alt=" " /></td>
<td>Opens in a new page</td>
</tr>
<tr>
<td>Attachments</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Blog Posts</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Chart</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Children Display</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Content By Label</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Content By User</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Excerpt</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Gallery</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Include Page</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Info</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Labels List</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Livesearch</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Note</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Metadata Summary</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree Search</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Pagetree</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Panel</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Quick Nav</td>
<td><img src="image" alt=" " /></td>
<td>You cannot have another gadget embedded within the Confluence Page Gadget</td>
</tr>
<tr>
<td>Recently Updated</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>RSS Feed</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Section &amp; Column</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Spaces List</td>
<td><img src="image" alt=" " /></td>
<td>N/A</td>
</tr>
<tr>
<td>Table of Contents</td>
<td><img src="image" alt="" /></td>
<td>Works, however links will be opened in a new browser window when clicked.</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tasklist</td>
<td><img src="image" alt="" /></td>
<td>Tasks can be viewed but not added/edited.</td>
</tr>
<tr>
<td>View File (PDF or PPT)</td>
<td><img src="image" alt="" /></td>
<td>Works, but you may need to refresh the gadget the first time (see CONF-19932).</td>
</tr>
</tbody>
</table>
| Widget Connector  | ![](image) | Only works for some content:  
  - **Works**: blip.tv, Episodic, Flickr, Google Calendar, presentations on Google Docs, MySpace Video, Scribd, Skitch.com, SlideRocket, SlideShare, Viddler, Vimeo, YouTube, DailyMotion, Metacafe, FriendFeed, Yahoo Video, Wufoo HTML Form Builder  
  - **Does not work**: FriendFeed, Google Gadgets, Google Video (consumer service discontinued), Twitter, Widgetbox, DabbleDB, BackType |

Confluence Quicknav Gadget

The Confluence QuickNav gadget provides the Quick Navigation Aid functionality for searching the Confluence site. For more information on how to use this feature, refer to the Quick Navigation Aid section of Searching Confluence.

ℹ️ For instructions on how to use Confluence gadgets in your applications, please see Confluence Gadgets.

**Screenshot: Using the QuickNav Gadget**
Confluence QuickNav Gadget Properties

This gadget has no properties and cannot be customised.

Adding JIRA Gadgets to a Confluence Page

This is a summary of the steps required to add a JIRA gadget to a Confluence page:

- If your JIRA site does not allow anonymous access, your JIRA administrator will need to configure JIRA to trust Confluence via Application Links. See the JIRA administrator's guide. (Not applicable to Confluence OnDemand.)
- Your Confluence administrator will need to add the JIRA gadget URL to the list of authorised external gadgets in Confluence. See the Confluence administrator's guide. (Not applicable to Confluence OnDemand.)
- Now you can add the gadget to a wiki page in Confluence using the Macro Browser. See the Confluence user's guide to the Gadget macro.

Note that the Confluence Gadget macro is a specific type of macro which is used to display a gadget in a Confluence page - so once you have configured external gadgets in the Confluence Administration Console, they will appear in the Macro Browser.

Related Topics

All Atlassian gadgets

External Gadgets

Developing Technical Documentation on Confluence Wiki

Welcome! This is a guide to using Confluence wiki for technical documentation. You will find this guide useful if you want to write a technical manual such as a user's guide, administrator's guide, installation guide, and so on.

- Creating your Technical Documentation Space
- Using Templates in Technical Documentation
- Re-using Content in Technical Documentation
- Managing the Life Cycle of your Technical Documentation
- Providing PDF Versions of your Technical Documentation
- Exporting and Printing Technical Documentation
- Essential Confluence Features for Technical Documentation
- Confluence Add-ons for Technical Documentation
- Further Reading about Developing Technical Documentation on Confluence
Related topics

Confluence User's Guide
Confluence Administrator's Guide

Creating your Technical Documentation Space

This guide is for people who want to develop and publish technical documentation on Confluence wiki. You will find it useful if you want to write a technical manual such as a user’s guide, administrator’s guide, installation guide, and so on. This page is a quick-start guide to creating a wiki space for technical documentation.

Quick guide to creating a technical documentation space

- Add a space and select the Documentation theme.
- Set the space permissions.
- Change the title and content of the space home page.
- Customise the Documentation theme.
- Create an inclusions library to manage your re-usable content.
- Create the table of contents for your manual or manuals, by adding top-level pages for all the usual sections (user’s guide, administrator’s guide, and so on).
- Customise your PDF layout and stylesheet, if required.
- Hint: Now that you have a good skeleton for a documentation space, save the space as a template space.

The rest of this page gives more details of the above procedure.

On this page:

- Step 1. Add your Space
- Step 2. Set the Space Permissions
  - A Bit More about Permissions
- Step 3. Customise the Title and Content of the Home Page
- Step 4. Customise the Documentation Theme
  - Example of a Customised Footer
- Step 5. Create an Inclusions Library
  - Examples of Inclusions Libraries
- Step 6. Create the Table of Contents
- Step 7. (Optional) Customise the PDF Layout and Stylesheet
- Step 8. Save your New Space as a Template Space

Step 1. Add your Space

Below is a quick guide to adding a space. See Creating a Space for a full description.

1. Go to the Confluence dashboard and choose Add Space.
   Hint: If you cannot see Add Space, this means that you do not have permission to add spaces. Please contact your Confluence administrator.
2. In the ‘Create Space’ screen, enter a space name and a short, unique space key.
3. Leave the permission settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.
4. Choose OK.
6. Choose Look and Feel > Themes and select the Documentation theme.
7. Choose OK.

The home page of your new space will appear, with the Documentation theme. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.
From this point on, instructions will refer to navigating in the Documentation theme, which is slightly different to the default theme.

**Step 2. Set the Space Permissions**

Define the space permissions to determine who can do what in your new space.

1. Choose Browse > Space Admin at the top of the screen.
   
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose ‘Permissions’.

3. Choose ‘Edit Permissions’.

4. Set the permissions to suit your needs then choose ‘Save All’.
   
   - You can add groups and/or individual users to the list, then select the permissions for each group or user.
   - You can also set the permissions for anonymous users – these are people who have not logged in to the wiki. Anonymous access is available only if enabled for the entire Confluence site.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

**A Bit More about Permissions**

Confluence has a robust and granular permissions scheme that you can use to determine who can view, comment on and even update the documentation. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page. Below we discuss a way of using these in the draft, review and publishing workflow.

**Space permissions** in Confluence are simple yet granular enough to be useful for technical documentation. You can:

- Use the permission levels to control who can create pages in the space, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users.

**Terminology:**

- ‘Anonymous’ means people who have not logged in to the wiki.
- The ‘confluence-users’ group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow your team full edit and administration rights while others can only add comments.
Or you might grant the general public access to your documentation, while only staff members can update it.
Step 3. Customise the Title and Content of the Home Page

When you created your space, Confluence created a home page with default content and a default title, 'Home'. You will want to change the title and content.
1. Go to your space home page.
2. By default, the page title is 'X Home', where 'X' is the name you gave the space.
3. Choose Edit.
4. The page opens in the editor. Change the title to suit your needs.

```
MyProduct Documentation Home
```

```
This is the home of the MyProduct Documentation space
```

5. Update the content to suit your needs.
   *Hint:* If you do not know what to add yet, just add a short description. You can refine the content of the page later. Take a look at an example of a home page.
6. Choose Save.

**Step 4. Customise the Documentation Theme**

When you added the space you chose the Documentation theme, which provides a left-hand navigation bar and a good look and feel for technical documentation. If necessary, you can configure the Documentation theme to add your own page header and footer or to customise the default left-hand navigation bar. These customisations affect the online look and feel of your documentation. See Configuring the Documentation Theme for the full description.
1. **Choose Browse > Space Admin** (if you have not yet applied the Documentation theme choose **Space Tools > Look and Feel > Themes**)

2. Choose **Themes** in the left menu.

3. If the space is not yet using the Documentation theme, apply the theme now.

4. Choose **Configure theme**

---

**Current Theme**

The current theme controls the layout and colours of this space.

---

**Documentation Theme**

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer.

---

**Configure theme** - further customise this theme's options

---

5. The 'Documentation Theme Configuration' screen appears. Customise the left-hand navigation bar, header and footer to suit your needs. Details are in the documentation. Here are some hints:

   - The **Page Tree** check box determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
   - The **Limit search results to the current space** check box determines whether Confluence will search only the current space or the whole Confluence site. This setting affects the default search. Viewers can override it each time they do a search.
   - Enter text, images, macros and other wiki markup into any or all of the three text boxes for the the left-hand navigation bar, header and footer. You can use the **Include macro** and the **Excerpt Include macro** to include re-usable content.
   - Any content you add to the navigation panel will appear above the default page tree.
   - If you like, you can remove the default page tree (by unticking the box) and add your own, customised version of the **Pagetree** macro instead.

6. Choose **Save**.

---

**Example of a Customised Footer**

Take a look at the footer of a page in the **Crowd documentation space**.

To produce the above footer, we have the following content in the footer panel in the Documentation theme configuration screen:

```markdown
Footer:
{include:Documentation Footer[nopanel=true]}
{include:ALLDOC:Copyright Notice[nopanel=true]}
```

---

Created in 2013 by Atlassian. Licensed under a **Creative Commons Attribution 2.5 Australia License**.
Here it is in text form:

{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}

The above content consists of two Include macros.

- The first macro includes a page called _Documentation Footer. This page contains the big blue buttons and hyperlinked text.
- The second macro includes a page from a different space, the ALLDOC space, called _Copyright Notice. This page includes our standard copyright notice, used in all our documentation spaces.

**Step 5. Create an Inclusions Library**

Using Confluence, you can dynamically include content from one page into another page. You can include a whole page into another one, using the Include macro. You can also define an ‘excerpt’ on a page, and then include that excerpted text into another page using the Excerpt Include macro.

To organise your re-usable content, we recommend that you create a set of pages called an ‘inclusions library’.

1. Choose Create and create a new page in your space.
2. Enter a suitable title. We use '_InclusionsLibrary'. The unusual format of the title helps to let people know this page is special.
3. Enter some content and save the page. We enter text explaining the purpose of the inclusions library and how to re-use the content. You can copy our text by clicking through to one of the example pages listed below.
4. Choose Browse > Pages and drag your new page above the space homepage.
5. Go to your new inclusions page and choose Create to add child pages containing your re-usable content. See the examples of our own inclusions libraries listed in the examples below.

Some notes about inclusions libraries:

- The inclusions library is not a specific feature of Confluence. The pages in the inclusions library are just like any other Confluence page.
- The pages are located at the root of the wiki space, not under the home page. This means that they will not appear in the table of contents on the left and they will not be picked up by the search in the left-hand navigation bar either.
- The pages will be picked up by other searches, because they are just normal wiki pages.
- We have decided to start the page name with an underscore. For example, '_My Page Name'. This indicates that the page is slightly unusual, and will help prevent people from changing the page name or updating the content without realising that the content is re-used in various pages.

Examples of Inclusions Libraries
Here are some examples in our documentation:

- Crowd inclusions library
- Confluence inclusions library

**Step 6. Create the Table of Contents**

Create the table of contents for your documentation, by adding the top-level pages for all the usual sections:

- User's guide
- Administrator's guide
- Installation guide
- Configuration guide
- Release notes
- FAQ
- Whatever else you need

Now do the same for all the sections of your technical document.

**Step 7. (Optional) Customise the PDF Layout and Stylesheet**

If you are planning to provide PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. You can skip this step for now and do it later, if you prefer. The instructions are in a separate section of this guide, dedicated to PDF. See [Providing PDF Versions of your Technical Documentation](#).

**Step 8. Save your New Space as a Template Space**

This is a useful suggestion. Once you have set up your first documentation space and are more-or-less happy with it, use the Copy Space plugin (see notes below) to copy the space while it still has very little content. From this point on, you can copy it each time you want to create a new documentation space.
1. Choose **Browse** > **Space Admin**
2. Choose **Copy Space** in the left menu
   
   *Hint: If you cannot see the ‘Copy Space’ option, this means that the plugin is not installed on your Confluence site. Refer to the documentation on installing plugins. (Not applicable to Confluence OnDemand.)*
   
3. The ‘Copy Space’ screen will appear. Enter the details as prompted, to copy your space to another new space.

   ![Copy Space](Image)

   **Copy Space**
   
   You are about to copy this space. Please fill in the new key and space name you wish to use.
   
   Name: [Template for documentation spaces]
   
   Key: [TEMPLATE]
   
   Use existing authors and dates:
   
   Copy comments:
   
   Copy attachments:
   
   Copy personal labels:
   
   Save | Cancel

4. Choose ‘Save’.

You now have a template space. From this point on, you can use the Copy Space plugin to copy the template space each time you want to create a new documentation space.

Notes:

- The Copy Space plugin is not covered by Atlassian support. However, the Atlassian technical writers use it for all our documentation. If you like, you can vote for an comment on the request for Atlassian support to cover this plugin: [CONF-14198](https://jira.atlassian.com/browse/CONF-14198).
- Your site administrator will need to install the Copy Space plugin into Confluence. Refer to the documentation on installing plugins. Not applicable to Confluence OnDemand.

Next Steps

You now have the basic structure and configuration for your technical documentation space. You have also created a handy template to use next time you need a space. What next? Take a look at [Using Templates in Technical Documentation](#).

Using Templates in Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. We have already shown you how to create your technical documentation space. Now we offer an introduction to the templates that Confluence provides.

Quick guide to templates in Confluence
Deciding Where to Put Your Templates

In Confluence, there are two places to store your page templates:

- **Space templates**: These page templates are available in a specific space only. People who have space administrator permission can define templates via the space administration screen.
- **Global templates**: These page templates are available in every space on the site. People who have Confluence Administrator permission can define the global templates via the Confluence Administration Console.

Decide whether your template is useful across more than one space.

- If yes, create a global template. You will need Confluence administrator permissions.
- If no, create a space template.
  - You will need space administrator permissions for the relevant space(s).
  - You may have already saved your documentation space as a template, as described in our guide to creating your documentation space. In that case, it may be useful to save your template page in your template space. When you later copy the space, the template pages will be copied too.

Creating a Global Template

1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **Global Templates** in the left-hand panel.
3. Choose **Add New Global Template**.

See **Administering Site Templates** for more information.

Creating a Space Template

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Templates > Add New Space Template**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose **Templates** from the space administration options.
3. Choose **Add New Space Template**.
See Adding a Template for more information.

**Importing Templates**

Confluence ships with a number of templates, including the 'Charts', 'Document List' and 'Meeting Notes' templates. These templates are not available for use by default. However, if you have the appropriate permissions to access the Administration Console, you can import any of these templates to be used globally or within a specific space. In addition, you can find more template bundles on the Atlassian Plugin Exchange.

1. Log in to Confluence as an administrator.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Import Templates. The 'Import Templates' screen will appear, listing the template packages deployed to your Confluence instance and the templates included in each package.
4. Select the templates you want to import.
   *Note: You can view a preview of the template by clicking the template name.*
5. Choose the destination to Import To. If you want the templates to be available to your documentation space only, select the name of the space, otherwise select 'Global Templates' to make the templates available to all spaces.
6. Choose Import to import the selected templates.

**Using a Template to Create a Page**

When people create a page on your Confluence site, they can choose to base their new page on a template.

Go to the page that will be the parent of your new page, and choose **Create**.

All available templates for that space will display, select a template then choose **Next**.

**Next Steps**

You now have a good idea of how Confluence templates work. What next? Take a look at Re-using Content in Technical Documentation.

**Re-using Content in Technical Documentation**

This page is part of the guide to developing technical documentation on Confluence Wiki. In the page about creating your technical documentation space, we showed you how to set up an 'inclusions library' to contain content that you can re-use on more than one page. Now we offer further guidelines on re-using content in your documentation space.

Your documentation may be about using a software application, or it may be a technical manual for your product range. On this page, we use the term 'widget' to describe the things that you are documenting, such as the screen, form, document, product or object.

**Quick guide to re-using content**

- Create an 'inclusions library' to manage your re-usable content. See our guide to creating your technical documentation space.
- Use the excerpt macro to define a re-usable section ('excerpt') on a page, or just decide to re-use the entire content of the page.
- Use the excerpt-include macro to include the excerpt from one page onto another page.
- Use the include macro to include the entire content of a page onto another page.
- Consider installing the Multi Excerpt plugin if you need to define multiple excerpts per page.

The rest of this page gives an overview and more details of the above procedures.
Reasons for Re-Using Content

A golden rule for technical documentation is to write the content only once but allow that content to be used in many places and in many forms.

For example, you may have the following types of content:

- A technical manual that describes each widget in detail.
- Tips and tricks on how to get the most out of the widget.
- A step-by-step user guide for first-time users on how to use the most common widgets.
- A training manual with exercises or videos that people can follow in their own time.
- A one-page cheat sheet for users to stick up on their workstation.
- Text for a sales brochure that is sent out to a print house for production.

Each of these types of content will share common information, such as a glossary entry, a technical or marketing description of the widget, or a step-by-step guide on how to use the widget.

Some initial planning of your technical documentation will allow you to re-use any or all of the content you write, so there is only ever one place to update the content, and those changes flow through to all of your other documentation.

Defining an Inclusions Library

We recommend that you create an ‘inclusions library’ to manage your re-usable content. If you have not already done this when creating your documentation space, see our guide to creating your technical documentation space.

Working with Excerpts and Inclusions

Excerpts and inclusions (sometimes called ‘includes’) are very useful for re-using content:

- Use the Excerpt macro \(\text{excerpt}\) to define a re-usable section (‘excerpt’) on a page.
- Use the Excerpt Include macro \(\text{excerpt-include}\) to include the excerpt on another page.
- Use the Include Page macro \(\text{include}\) to include the entire content of a page onto another page.

A simple example of an inclusion is a note or warning that is used in many places in your documentation. Here is an example:

⚠ Example note -- "Draft in progress"
This document is still in draft status. Please treat the content with caution.

Tip: Keep your re-usable pages short and sweet. Do not worry if you find that you need hundreds of pages to hold your inclusions. It helps to keep things separate and organised.
Using the Include Page Macro

In this example, we use the Include Page macro to create a note that you can re-use on your documentation pages. The Include Page macro will include the entire content of one page into another page. (See the 'Excerpt' macro below for including parts of a page.)

1. Create a page in your inclusions library called *_Draft Note*.
2. Add the content of the page. In this example, we use the Note macro with some text in the title and body:

   ```
   {note:title=Draft in progress}This document is still in draft status. Please treat the content with caution.{note}
   ```

3. Use the Include Page macro to include that note in any page in your documentation. For example:

   ```
   {include:_Draft Note|nopanel=true}
   ```

See the documentation on the Include Page macro for more details.

Using the Excerpt Include Macro

An excerpt is a section of a page that you can include into another page.

1. Use the `excerpt` macro to define any content in your page that you want to be able to use elsewhere. This content can be as short as a word or as long as the entire page. For example, let's assume we have a page called 'My Short Poem':

   ```
   I really love this poem:
   {excerpt}
   Mary had a little lamb
   Its fleece was white as snow
   {excerpt}
   And I'm going to use it all over the place.
   ```

2. Use the Excerpt Include macro to include the excerpt into another page. For example:

   ```
   {excerpt-include:My Short Poem|nopanel=true}
   ```

You can only define one excerpt on a page. See the documentation on the Excerpt Include macro for more details.

To have multiple excerpts on a page, see the 'Multi Excerpt plugin' below.

Using the Multi Excerpt Plugin (Not applicable to Confluence OnDemand.)

The Multi Excerpt plugin provides additional macros that enable you to have multiple excerpts on a page. A good example of where you would find this useful is in the glossary page discussed below. If you want to include a single glossary entry or a subset of the glossary entries in another page, then the named excerpts allowed by the Multi Excerpt plugin are very useful.

Notes:
• The Multi Excerpt plugin is a commercial plugin and is not free.
• Your Confluence administrator will need to download and install the plugin into your Confluence site before you can use the macros described below. Refer to the documentation on installing plugins.
• Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support. Please refer to the Multi Excerpt plugin page for support details.

1. Use the following code on the base page containing the content you want to use elsewhere:

   ```markdown
   {multi-excerpt:name=ExcerptName1}
   Excerpt text 1
   {multi-excerpt}
   Any other text
   {multi-excerpt:name=ExcerptName2}
   Excerpt text 2
   {multi-excerpt}
   ```

2. Use the following code on the page where you want to include the named excerpt:

   ```markdown
   {multi-excerpt-include:pageTitle=PageName|name=ExcerptName1|nopanel=true}
   ```

3. You can also include excerpts from other spaces using the following syntax:

   ```markdown
   {multi-excerpt-include:spaceKey:pageName|name=excerptName|nopanel=true}
   ```

See the Multi Excerpt plugin page for more details.

**An Example of Content Re-Use: A Glossary**

A glossary is something that most technical documentation will require. There are a few ways to set up glossaries in Confluence. These are the most popular:

• All glossary entries on one page.
• Each glossary entry on separate child pages with a main page showing excerpts of the glossary.

Once you have defined the glossary entry, you can refer to it from the main pages of your technical documentation.

**Creating a One-Page Glossary**

This style of glossary is useful if the glossary entries tend to be short and there are not too many of them.
1. Create a page named **Glossary**.
2. Add an alphabetical index at the top of the page and a heading for each letter of the alphabet:

   ![Alphabetical index](https://example.com)

   ```
   [A|#A]  | [B|#B]  | [C|#C]  ...
   (anchor:A)  
   h2. A 
   (anchor:B)  
   h2. B 
   (anchor:C)  
   h2. C ...
   ```

3. Enter each glossary entry under the relevant alphabetical heading. Each glossary entry (term) should include:
   - An anchor tag, so that you can link to it from other pages.
   - The term itself.
   - A definition of the term.
   - A link to the page in your technical documentation that explains the term in greater detail, where relevant.

   ```
   (anchor:MyGlossaryTerm)  
   h4. MyGlossaryTerm  
   This is the definition of MyGlossaryTerm. See [Page Name] for more information.
   ```

4. Optionally, include a horizontal line between the terms. This depends on how long each entry is. If your glossary tends to have short entries, it may look too cluttered with horizontal lines.

   ```
   ---
   ```

See the glossary in the **Confluence documentation** for an example of this style of glossary (without the alphabetical index).

**Creating a Glossary with Child Pages**

This style of glossary is useful if the glossary entries tend to be quite long or have additional information over and above the definition of the term.
1. Create a page named **Glossary**.

2. Create a child page for each glossary entry (term). Each child page should contain:
   - The term as the title of the page.
   - The definition of the term in the body of the page.
   - Excerpt tags (`excerpt`) tags surrounding the definition.
   - Any additional information after the `excerpt` tags.

   ```excerpts
   This is the definition of MyGlossaryTerm
   {excerpt}
   More information to describe MyGlossaryTerm
   ```

3. On the 'Glossary' page, use the `children` macro to show the excerpts from each child page in a list, with the page name displayed in 'h4' style.

   ```children:excerpt=true|style=h4```

See the glossary in the Crowd documentation for an example of this style of glossary.

**Referring to Glossary Terms**

In the main pages of your technical documentation, create a link to the glossary page for each glossary term.

```
_[MyGlossary Term|Glossary#MyGlossaryTerm]_
```

Note that this is a standard page link with an anchor. We have formatted the link as italics, because it helps to have the glossary links looking different to other page links. Readers can just skip over the glossary link if they are already familiar with the term.

**Further Reading**

- A blog post about content re-use: Technical Writing in a Wiki - Content Re-use and Structure (November 2010).

**Next Steps**

You now have a good idea of how to re-use content in a Confluence documentation space. What next? Take a look at Managing the Life Cycle of your Technical Documentation.

Managing the Life Cycle of your Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. We have already shown you how to create your technical documentation space, including how to set permissions for your space. Now we offer a quick-start guide to managing the life cycle of your technical documentation in Confluence. The life cycle includes drafting, reviewing and publishing a document, as well as managing documentation that is release-specific.

**Quick guide to managing the technical documentation life cycle**

- Create draft pages with restricted permissions, to hide them until they are ready for publication.
- Set the permissions to allow reviewers to comment on and/or update the pages.
- When ready, publish the page by removing the permission restrictions.
- Monitor updates to your draft and published pages by watching your space and/or subscribing to...
RSS feeds.

- Use spaces as a mechanism for matching your documentation version to product releases: one space per major release number.
- Consider installing plugins for extended workflow and publication management.

The rest of this page gives more details of the above procedures.

On this page:

- Using the Built-In Confluence Functionality to Manage Workflow and Release Cycle
  - Drafting, Reviewing and Publishing a Page
  - Keeping Track of Documentation Updates
    - Viewing the History of a Page
    - Receiving Email Notification of Updates
    - Monitoring Updates via RSS Feeds
  - Release Management
    - Space Keys
    - The Release Management Process
  - Other Scenarios using the Built-In Confluence Functionality
    - Using Add-Ons for Extended Workflow, Publication and Concurrent Version Management (Not applicable to Confluence OnDemand.)
- Notes

Using the Built-In Confluence Functionality to Manage Workflow and Release Cycle

This section describes how to use the built-in Confluence functionality to manage your workflow (draft, review, publish) and to align your documentation version control to the product release cycle.

In this scenario we also assume that you want a live space that always has the same space key and always contains the latest version of your documentation. This scenario suits the requirements of an organisation that wants their technical documentation to be 'live'. Various groups of people can refine the content as and when required. People can also subscribe to the space, knowing that they will always get the latest version of the documentation and comments.

This is the way we manage our documentation at Atlassian. The content of the wiki is dynamic, continuously updated, commented on, subscribed to and watched by thousands of people all over the world.

Drafting, Reviewing and Publishing a Page

The workflow is simple.

1. Create a page with restricted permissions. For example, you might restrict viewing to a group of people such as your team. On a public wiki, you might restrict viewing to staff members, so that the general public cannot see the page.
2. Write the page content.
3. Ask other people to review the page. They can add comments to the page or simply edit the page content directly.
4. Publish the page when ready, by doing the following:
   - Delete the comments on the page.
   - Remove the permission restrictions on the page. The page has now been published.
   - The space permissions and site permissions now determine who can see and/or update the page.

The screenshot below shows a page under review. Notice the lock icon at top left, indicating that restricted permissions apply to this page.
Keeping Track of Documentation Updates

On a wiki, it is quite usual for a number of different people to update a single page. Technical writers need to know what happens to our documents, both during review and after publication.

**Viewing the History of a Page**

Confluence creates a new version of the page every time someone edits the page. The page history shows all the versions, with date, author, and any comments made on the update.

1. Go to the page and choose **Tools > Page History**.

On the page history view, you can:

- View the content of a specific version of the page.
- Revert to (restore) a specific version.
- Select any two versions and ask for a comparison, to see what has changed between those two versions.

See [Page History and Page Comparison Views](#) for detailed information.

It is all very well to go to a specific page and see what has happened to it, but how do you know when to go and look at the page? You need a notification of any changes made to your documentation space.

In Confluence, you can monitor updates to your documentation via email notifications and via RSS feeds.
Receiving Email Notification of Updates

You can ‘watch’ a page or an entire space. Whenever anyone updates the page or space, you will receive an email notification.

To watch a page:

Choose 'Tools' > 'Watch'.

To watch a space:

1. Choose 'Browse' > 'Space Operations'.
2. Choose 'Watch this space' in the left-hand menu.

See Subscribing to Email Notifications of Updates to Confluence Content for details of the various notifications Confluence will send, and how to configure your notification settings.

Monitoring Updates via RSS Feeds

RSS feeds provide another way to keep track of updates. The simplest way to build an RSS feed is to use Confluence’s feed builder, accessible from the dashboard. This will give you a URL that you can ping to get the latest updates.

Below we describe how to set up a useful feed for your technical documentation space. Remember that you can adjust the settings to suit your own needs.

2. Check the boxes to select all the content types. (Even if you are not expecting comments, blog posts or mail in your documentation space, it does no harm to receive notifications if they do arrive.):
   - Pages and the comments and attachments on pages.
   - Blog posts and their comments and attachments.
   - Mail.
3. Select your documentation space from the list. Press Ctrl and click to select multiple spaces.
4. Click the Create RSS Feed button to create your feed.
5. This will take you to a new screen. Drag or copy the link into your RSS reader. The feed URL is linked to the words Drag or copy this link to your RSS reader.

Now that you have set up your RSS feed, you need to decide how to read it. There are various options to choose from. For example:

- Use an RSS reader, such as the Sage add-on for Firefox.
- Use an email client, such as Thunderbird.

See Subscribing to RSS Feeds within Confluence for details.

Release Management

Let’s assume that your product goes through a regular release cycle, and that you need to retain separate documentation for each major version of the product.

At Atlassian, we use spaces as our version-control mechanism.

- **Archive spaces.** At each release, we create a new archive space to house the previous version of the documentation.
- **The live space.** The documentation for the latest version of the product resides in the live space. The live space always retains the same space key and is always available for viewing and updating.

Space Keys
The live space has just the product name as its space key. For example, for the Crowd product the space key is 'CROWD'. (See the Crowd documentation space.)

For the archived versions, we use a combination of the product name plus version number as the space key. For example, we use 'CROWD020' for the Crowd 2.0 documentation, 'CROWD016' for the Crowd 1.6 documentation, and so on.

The Release Management Process

Here is an overview of the process we follow at Atlassian.

1. Leading up to release date. Work with hidden draft pages in the live space. A 'hidden draft' is simply a page that has restricted permissions applied:
   - For each new feature, create a new page with restricted permissions.
   - If you need to update existing pages, create a hidden copy of the existing page and apply the updates to the copy.
   - Follow the usual draft and review procedure for each page.

2. A few days before release date. Use the Copy Space plugin to copy the live space to a new space. This creates a snapshot of the current documentation, and will act as an archive for the current release which is soon to become the previous release. (We described the use of the Copy Space plugin in the earlier section of this guide: Creating your Technical Documentation Space.)

3. On release date. Publish the updated documentation for the new version of the product:
   - Rebrand the live documentation space to reflect the new release number. In other words, change the space name and any other descriptions that include the product release number.
   - Unhide all the new pages, by removing the permission restrictions on each hidden page.
   - Copy the content of the updated pages to the proper pages, then delete the copies.
   - Export the newly updated space to PDF, HTML and XML, for those customers who prefer offline versions of the documentation.

Note that the above process is applicable to major releases of the product. For minor bug-fix releases, we simply update the documentation in the live space. We do not create archive spaces for every minor release.

The example below shows an extract from the dashboard of our documentation wiki, listing the spaces for different versions of the Crowd documentation. (Crowd is one of our products.) Each space holds the documentation for a specific major release of Crowd.

Screenshot: Archive Bamboo spaces and Bamboo Latest for the current version of the documentation.
Other Scenarios using the Built-In Confluence Functionality

It is easy to design other ways of managing your documentation spaces using the built-in Confluence functionality. For example, the simplest scenario is to publish a new space for every new release of your product, using the same Copy Space plugin as described above.

Using Add-Ons for Extended Workflow, Publication and Concurrent Version Management (Not applicable to Confluence OnDemand.)

For advanced workflow features, consider installing the Ad Hoc Workflows add-on onto your Confluence site.

For advanced publication and concurrent version management consider using the Scroll Versions add-on. Scroll Versions enables you to set up and manage concurrent versions of your documentation in a single space. Multiple versions of software, different product variants, and even multiple languages of documentation can be managed. Changes to pages are scheduled for a specified version and then published all at once.

1. Install the Scroll Versions add-on from the Marketplace or from the Confluence Universal Plugin Manager.
2. Create a space for your documentation or activate Scroll Versions on your existing documentation.
3. Add the version numbers that you want to work with via the version management screen.
4. When a version is ready to publish go to ‘Browse’ > ‘Scroll Versions’ > ‘Manage Versions’ and publish your documentation within the same space or to another space.

See the documentation of Scroll Versions for further information.

Similarly, consider using the Content Publishing add-on to publish content from a master space to a published space. In this scenario, you will create a master space that contains your drafts in progress and new releases. The master space is visible only to the authors and reviewers. You will periodically publish the master space to a published space. This suits the requirements of an organisation that needs a ‘published’ or ‘official’ set of documentation, published only when a new version of the product is released. There is no requirement for continual updating of the documentation.
1. Install the Content Publishing plugin.
2. Create a space for your master content.
3. Create a space for your published content.
4. When the content in the master space is ready to publish, go to the ‘Advanced’ tab in the ‘Space Admin’ section of the master space (if you are using the Documentation theme).
5. Choose ‘Publish Space’ to configure the settings and then publish your space. See the plugin documentation to choose the options best for your needs.
6. Choose ‘Publish’.

**Automatic publishing.** The Content Publishing plugin can work together with the Ad Hoc Workflows plugin to publish pages automatically when the page reaches a specified state in the workflow.

**Notes**

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on Installing Add-ons. *(Not applicable to Confluence OnDemand.)*
- **Plugin support.** Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Next Steps

Now you know about managing your workflow and documentation release process on Confluence. What next? Take a look at Providing PDF Versions of your Technical Documentation.

Providing PDF Versions of your Technical Documentation

This page is part of the guide on Developing Technical Documentation on Confluence Wiki.

Confluence is a platform for publishing online documentation. It also provides an export to PDF feature for producing PDF versions of your documentation, allowing you to print it, or to provide a copy to customers who are unable to access the online version. This guide describes how to export your technical documentation to PDF using Confluence’s built-in PDF export, and introduces a third-party plugin that provides additional PDF layout and style functionality.

**Quick guide to PDF exports**

- Customise the PDF layout (title page, header and footer) and style, for use each time you export your documentation.
- Export a single page to PDF.
- Export a selection of pages or an entire space to PDF.
- Consider installing a third-party plugin for advanced PDF export functionality.

The rest of this page gives more details of the above procedures.
Customising the PDF Layout and Style

If you plan to create PDF versions of your documentation, you may want to customise the PDF layout and styles for your space. These customisations will be applied every time you export documentation to PDF.

Under **PDF layout** you can add HTML to customise the PDF title page, and page headers and footers. Under **PDF stylesheet**, you can adjust the appearance of the PDF pages.

**Editing the PDF Layout**
Setting a global PDF layout

1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **PDF Layout**. You can enter HTML and CSS that will be rendered on the PDF title page, as well as page headers and footers.

Setting the PDF layout at space level

1. Go to the space and choose **Space tools > Look and Feel** on the sidebar. You'll need **Space Admin permissions** to do this.
2. Choose **PDF Layout**.
3. Choose **Edit**.

If your space uses the Documentation theme:

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Choose **PDF Layout** in space administration options.
3. Choose **Edit**.

You can customise the HTML that is generated for the following areas when the space is exported to PDF:

- **PDF Space Export Title Page** – title page.
- **PDF Space Export Header** – page headers.
- **PDF Space Export Footer** – page footers.

Enter your customisations into each text box as required. The PDF layout section accepts HTML code. You can include inline CSS in the HTML too.

Editing the PDF Stylesheet
Setting a global PDF Stylesheet

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Look and Feel > PDF Stylesheet. The following screen allows you to enter and save CSS code that will render content on each page.

Setting a space PDF stylesheet

1. Go to the space and choose Space tools > Look and Feel on the sidebar. You'll need Space Admin permissions to do this.
2. Choose PDF Stylesheet.
3. Choose Edit.
4. Enter your customisations.

If your space uses the Documentation theme:

1. Choose Browse > Space Admin at the top of the screen.
   Note: The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose PDF Stylesheet in the space administration options.
3. Choose Edit.
4. Enter your customisations.

The PDF Export Stylesheet field accepts Cascading Style Sheets (CSS) rules. The 'PDF Export Stylesheet' page shows the current (e.g. customised) contents of your PDF stylesheet.

Examples of PDF Customisation

Below are typical customisations you may want to make for your technical documentation. For more examples, see Customising Exports to PDF.

Adding a Title Page

You can create a title or cover page to your PDF document using HTML. Use the PDF Space Export Title Page section of the PDF layout to do this. Adding a New Title Page

The following example uses HTML with an inline CSS rule to generate a title page.

```html
<div class="fsTitlePage" style="margin-left:auto;margin-top:75mm;margin-right:auto;page-break-after:always">
  <img src="/download/attachments/12345/titlepage.png"/>
</div>
```

Including Content Above Table of Contents in Default Title Page

The following example includes content above the automatically-generated table of contents that appears on the default title page, so that your title page includes your own content plus the table of contents.

```html
<div class="fsTitlePage"
  style="margin-left:auto;margin-top:75mm;margin-right:auto;">
  <img src="/download/attachments/12345/titlepage.png"/>
</div>
```
Adding an Image to your Title Page

In the examples above, the title page includes an image called 'titlepage.png', centred in the middle of the page. The image is attached to a Confluence page and is referenced via its relative URL (that is, we use only the last part of the URL, excluding the Confluence site's base URL).

Follow these instructions to include an image on your title page:

1. Attach the image to a Confluence page.
2. View the list of attachments on that page.
3. Right-click the image and copy its location.
4. Paste the link into the appropriate src="" attribute within your PDF stylesheet, as shown above.
5. Remove the first part of the URL before /download/....

Adding Headers and Footers

You can add headers and footers to your PDF pages using HTML. Use the 'PDF Space Export Header' and 'PDF Space Export Footer' sections of the PDF layout to do this. For simple headers and footers, plain text is enough. The following example adds a simple copyright notice.

![Copyright © 2010, Atlassian Pty Ltd.](image)

Adding Page Numbering to a Header or Footer

To add page numbering, you need to combine customised HTML in the PDF Layout with customised CSS in the PDF Stylesheet.

1. PDF Layout HTML: In the Footer section (or the Header section), use an empty span element with a unique ID, for example pageNum, to act as a place holder for the page number.

   HTML - PDF Layout: Footer Section
   ```html
   <span id="pageNum"/>
   ```

2. PDF Stylesheet CSS: Create the following CSS selector rule for the empty span:

   CSS - PDF Stylesheet
   ```css
   #pageNum:before {
   content: counter(page);
   }
   ```

   Analysing the above CSS selector rule in more detail:
   
   - The `pageTitle` rule selects the HTML element with the specified ID of "pageTitle", which is the span element we created for the header or footer.
   - The `:before` part of the selector is a pseudo class that allows the insertion of content before the span element is processed.
   - The `counter(page)` is a function that returns the current page number as its content.
   - The `content` property tells the CSS processor that dynamic content (that is, an incrementing page number) is to be inserted at the span tag.
Exporting to PDF

You can use the built-in Confluence PDF export to export a single page, a selection of pages or an entire space to a single PDF file.

Exporting a Single Page to PDF

You can export a Confluence page to PDF. This option exports a single page and is available to all users who have permission to view the page.

- Go to a page in the space and choose Tools > Export to PDF. Follow the prompts to export the page.

Exporting a Selection of Pages or a Space to PDF

1. Go to the space and choose Space tools > Content Tools on the sidebar.
2. Choose Export. This option will only be visible if you have the 'Export Space' permission.
3. Select PDF then choose Next
4. Decide whether you need to customise the export:
   - Select Normal Export to produce a PDF file containing all the pages that you have permission to view.
   - Select Custom Export if you want to export a subset of pages.
5. Select the pages you want to export.
   - You have the option to Select All or Deselect All pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
6. Choose Export.
7. When the export process has finished, download and save the PDF file as prompted.

If your space uses the Documentation theme:

1. Choose Browse > Space Operations
2. Choose PDF Export from the left menu.
3. Follow the steps above to export the Space.
Using the Scroll PDF Exporter Plugin to Export to PDF (Not applicable to Confluence OnDemand.)

The Scroll PDF Exporter provides flexible themes for configuring PDF layout and styles. You can select one of Scroll PDF Exporter’s built-in themes and configure your table of contents, header and title pages. For even more flexibility, see the section HowTos in the Scroll PDF Exporter documentation.

For this advanced PDF export functionality, you will need to install the Scroll PDF Exporter plugin to your Confluence site.

Notes

- **Permissions required to export a space:** To use the space export functionality, you need the 'Export Space' permission. See the guide to space permissions.

- **Installing plugins:** If you decide to use additional plugins, your site administrator will need to install the plugins to your Confluence site. Refer to the documentation on installing plugins. (Not applicable to Confluence OnDemand.)

- **Plugin support:** Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Related Topics

- Developing Technical Documentation on Confluence Wiki
- Customising Exports to PDF
Exporting Confluence Pages and Spaces to PDF

Scroll PDF Exporter

Installing Add-ons (Not applicable to Confluence OnDemand.)

Next Steps

Now you know all about providing PDF versions of your documentation. What next? See other ways of Exporting and Printing Technical Documentation.

Exporting and Printing Technical Documentation

This page is part of the guide to developing technical documentation on Confluence Wiki. Confluence is a great tool for writing and maintaining technical documentation. There are times when we need to export the content out of Confluence into other forms, such as PDF, HTML, Microsoft Word and paper.

Confluence itself provides an export to both PDF and HTML. Plugins provide additional functionality. Below are guidelines on exporting your technical documentation to various formats, including printed output.

Quick guide to printing and exporting content

- Use the browser's print option to print a single page.
- To print more than one page and for more advanced printing options, export your documentation to PDF.
- Confluence can export your pages to PDF, HTML, Confluence-specific XML and Word.
- Consider installing plugins to export your pages to PDF (enhanced functionality), Word (enhanced functionality), DocBook XML, Eclipse Help and JavaHelp.
- Make your exports available to your customers for download by attaching the exported file to a Confluence page.

The rest of this page gives more details of the above procedures.

On this page:

- Printing
- Exporting to PDF
- Exporting to HTML
- Exporting to Confluence-Specific XML
- Exporting to DocBook XML via a Plugin (Not applicable to Confluence OnDemand.)
- Exporting to Microsoft Word
- Exporting to Microsoft Word via a Plugin (Not applicable to Confluence OnDemand.)
- Exporting to Eclipse Help via a Plugin (Not applicable to Confluence OnDemand.)
- Exporting to EPUB via a Plugin (Not applicable to Confluence OnDemand.)
- Exporting to HTML via a Plugin (Not applicable to Confluence OnDemand.)
- Making the PDF and Other Exported Files Available to your Readers
- Notes
- Further Reading

Printing

To print a single Confluence page, just use the browser's print option. This option is available to all users who have permission to view the page.

To print more than one page and for more advanced printing options, export your documentation to PDF. See Providing PDF Versions of your Technical Documentation.

Exporting to PDF

Because this is such an important topic, we have a section of this guide dedicated to PDF. See Providing PDF Versions of your Technical Documentation.
Exporting to HTML

Using the built-in Confluence HTML export, you can export a single page, a selection of pages or an entire space to HTML. Confluence supplies the HTML and associated files in a zip file.

1. Go to the space and choose **Space tools > Content Tools** on the sidebar.
2. Choose **Export**. This option will only be visible if you have the ‘Export Space’ permission.
3. Select **HTML** then choose **Next**.
4. Decide whether you need to customise the export:
   - Select **Normal Export** to produce an HTML file containing all the pages that you have permission to view.
   - Select **Custom Export** if you want to export a subset of pages, or to exclude comments from the export.
5. Select the **Include Comments** check box if you want to include comments for the pages you are exporting.
6. Select the pages you want to export.
   - You have the option to **Select All** or **Deselect All** pages.
   - When you select a page, all its child pages will also be selected. Similarly, when you deselect a page all its child pages will also be deselected.
7. Choose **Export**. This will create a zipped archive of HTML files.
8. When the export process has finished, download the zipped archive as prompted, and extract the files into a folder.

If your space uses the Documentation theme:

1. Choose **Browse > Space Operations**.
2. Choose **HTML Export** from the left menu.
3. Follow the steps above to export the Space.
Exporting to Confluence-Specific XML

Confluence provides an XML export. The XML produced is a proprietary format and is intended for backups or for transferring a space from one Confluence instance to another. If you write your documentation on Confluence and your customers have Confluence too, then you can export your manuals to XML and customers can upload them onto their own Confluence site.

Exporting to DocBook XML via a Plugin (Not applicable to Confluence OnDemand.)

Scroll DocBook Exporter converts Confluence pages to DocBook XML. Your Confluence system administrator will need install the plugin onto your Confluence site.

Exporting to Microsoft Word

Confluence can export a page to Word. (Select 'Export to Word' from the 'Tools' menu.) This option performs a basic conversion of wiki content to HTML and applies some Word CSS stylesheets. It processes just one page at a time.

Exporting to Microsoft Word via a Plugin (Not applicable to Confluence OnDemand.)

Scroll Office is a Confluence plugin. Once installed, Scroll Office replaces Confluence's built-in 'Export to Word' functionality. You can export a single page or a hierarchy of pages.

You can define your templates in Word in the usual way, and upload them to Confluence as global templates or space templates. When you export your Confluence pages to Word, Scroll Office will use those templates to
build native Word documents from the wiki pages.

Scroll Office provides additional features such as enforcing page-breaks, setting the page orientation to landscape or portrait, and ignoring content. The latest version offers a REST-style API for automated export.

**Exporting to Eclipse Help via a Plugin (Not applicable to Confluence OnDemand.)**

Scroll EclipseHelp Exporter provides an export to Eclipse Help format.

You can produce embeddable online help for Eclipse-based applications. Scroll EclipseHelp Exporter converts the Confluence content into EclipseHelp-compatible JAR files to create a standalone online help or a context-sensitive help.

**A hint about the Eclipse Help platform:** You can use a cut-down version of the Eclipse Help platform to provide online documentation for any system. It doesn't have to be an Eclipse tool that you are documenting. For some ideas, take a look at a couple of articles about documenting your project using the Eclipse help system.

**Exporting to EPUB via a Plugin (Not applicable to Confluence OnDemand.)**

The Scroll EPUB Exporter outputs an ebook in the common EPUB format that can be read on iPads, iPhones and any other ebook reader.

**Exporting to HTML via a Plugin (Not applicable to Confluence OnDemand.)**

The Scroll HTML Exporter enables the delivery of Confluence content from a web server. It converts the pages into static HTML pages that can be uploaded to a web server. The output of the Scroll HTML exporter can also be used as an input to produce other HTML-based help formats such as WinHelp and HTML Help.

**Making the PDF and Other Exported Files Available to your Readers**

There are a number of ways to make your exported files available to your readers, such as putting the files on a disc and shipping them with your product.

One of the simplest ways is to attach the files to a Confluence page. (See Attaching Files to a Page.)

For example, Atlassian uses the out-of-the-box Confluence export functionality to provide PDF, HTML and XML versions of our documentation. People can download the files from our documentation wiki. For example, here are the JIRA documentation downloads and the Confluence documentation downloads.

**Notes**

- **Permissions required to export a space.** To use the space export functionality, you need the ‘Export Space’ permission. See the guide to space permissions.

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on installing plugins. Not applicable to Confluence OnDemand.

- **Plugin support.** Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

**Further Reading**

- A blog post about exporting and importing content from/to Confluence: Technical Writing in a Wiki - Single Source Publishing (November 2010).

- A good overview of the Scroll Office features in this blog post (August 2010) and the followup post (November 2010).

Next Steps
Now you know about a number of ways to get your technical documentation out of Confluence into various formats, for printing or for input into another system or process flow. What next? Take a look at Essential Confluence Features for Technical Documentation.

Essential Confluence Features for Technical Documentation

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight the built-in Confluence macros that are most useful in technical documentation. For more information about Confluence macros, see Working with Macros.

On this page:
- Auto-Generating a Table of Contents for Page Content
- Drawing Attention to Elements of a Page
- Putting Content inside Customisable Panels
- Inserting Anchor Links on Pages
- Structuring Content using Sections and Columns
- Making your Documentation more Engaging by Embedding Videos

Auto-Generating a Table of Contents for Page Content

It is important to make it easy for viewers to jump to the section of a Confluence page that they are most interested in. The Table of Contents macro helps you navigate lengthy pages by summarising the content structure and providing links to headings used on the page.

2. Each feature in the release is a heading on the page.
3. You can generate a list of hyperlinks to each of the features in the release notes by inserting the Table of Contents macro:
4. The image below shows the Table of Contents macro inserted at the top of the 'Release Notes' page. Note that we have excluded the 'Highlights of Confluence 4.0' heading from the table of contents by modifying the macro's parameters.

![Image of Table of Contents macro parameters](image)

- **Highlights of Confluence 4.0:**
  - Brand New Editor
  - Simplified Editing Experience
  - New Macros
  - Faster Editing Experience
  - Introducing @mentions
  - Improved Page Comparison Functionality
  - Email Notification Improvements
  - New Confluence Installer and Guided Upgrades
  - New Editor Plug-in Points for Developers
  - Other Improvements
  - Helping You Transition to Confluence 4.0
  - Release Notes

**Table of Contents Macro**
- Minimum Heading Level set to '2'
- Maximum Heading Level set to '4'

5. The image below shows the macro parameters specified in the macro browser. Note the 'Minimum Heading Level' and 'Maximum Heading Level' parameters.

![Image of macro browser](image)

- **Minimum Heading Level:** 2
- **Maximum Heading Level:** 4
### Drawing Attention to Elements of a Page

Often when creating documentation there are elements of a page that you want to highlight, or draw the the viewers attention to. Confluence ships with the following macros that help you focus a viewer’s attention to a note, information, tip or warning.

> Click here to see common examples >>

**Note Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Note macro allows you to highlight a note on a Confluence page.</td>
<td><img src="image" alt="Draft in progress" /> This document is a draft and is under development.</td>
</tr>
<tr>
<td>It creates a yellow coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Note Macro](#) for more examples and instructions.

**Info Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Info macro allows you to highlight helpful information on a Confluence page.</td>
<td><img src="image" alt="Did you know?" /> Confluence is the best wiki ever.</td>
</tr>
<tr>
<td>It creates a blue coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Info Macro](#) for more examples and instructions.

**Tip Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Tip macro allows you to highlight a helpful tip on a Confluence page.</td>
<td><img src="image" alt="Learn more" /> Check out this blog post: Technical Writing in a Wiki: Technical Communicators Explain How &amp; Why?</td>
</tr>
<tr>
<td>It creates a green coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Tip Macro](#) for more examples and instructions.

**Warning Macro**

<table>
<thead>
<tr>
<th>What is it?</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Warning macro allows you to highlight a warning note on a Confluence page.</td>
<td><img src="image" alt="Draft" /> This page is a draft in progress and visible to Atlassian staff only.</td>
</tr>
<tr>
<td>It creates a red coloured box surrounding your text, as shown to the right.</td>
<td></td>
</tr>
</tbody>
</table>

See [Warning Macro](#) for more examples and instructions.
**Putting Content inside Customisable Panels**

The **Panel macro** allows you to place content inside a customisable coloured panel. This is particularly useful when you want to clearly separate elements on a page.

*Click here to see a common example >*

1. You are documenting a procedure which involves a number of steps.
2. You want to call out the steps of the procedure from the rest of the page by placing it inside a coloured box, or panel.
3. You can create a coloured panel using the Panel macro.
4. The image below shows the parameters set for the panel using the macro browser.

![Edit 'Panel' Macro](image)

**Return to top of page**

**Inserting Anchor Links on Pages**

Anchor links can be especially useful when navigating between sections of a long document or when you want to link to a segment of a page from another page. The **Anchor macro** allows you to link to specific parts of a page.

*Click here to see a common example >*

1. You are documenting part of a user guide.
2. The page is split into multiple sections.
3. After each section you want to provide a link for viewers to click, taking them back to the top of the page.
4. To achieve this you first must create an anchor at the top of the page using the Anchor macro. You can give the anchor any name you like. In the image below, the anchor at the top of the page will be named 'top'.

![Insert 'Anchor' Macro](image)

5. The anchor placeholder will appear to indicate where your anchor link is located on the page:

![Anchor | top](image)
6. Create a link to the anchor, anywhere on the page, using the Link Browser. The image below shows a link to the anchor called 'top' by using the hash '#' followed by the name of the anchor you created earlier, with an alias of 'Return to Top'.

See Working with Anchors for more examples and instructions.

Return to top of page

Structuring Content using Sections and Columns

Sometimes it is necessary to structure content into sections and columns. The details are in Working with Page Layouts and Columns and Sections.

- Page layouts offer a set of predefined columns and sections.
- The Section and Column macros allow more flexibility. You can set the width of the columns, and put the sections and columns in any part of the page.
- You can create any number of sections on a Confluence page using the Section macro.
- Each section can contain any number of columns, created using the Column macro.
- Columns can either have a fixed width, specified in pixels, or a dynamic width, specified as a percentage of the page width.
- Note: A column must be created inside a section.

Click here to see a common example >>

The images below show part of a Confluence page with two sections (outlined in red), each with two columns (blue) of different widths.
1. Section 1:

1. Put a name to your face
2. Learn how content is organized
3. Get familiar with the Confluence screens
4. Start creating content
5. Add a panel to your page

2. Columns in section 1 – left column has a fixed width of 400 pixels:
Making your Documentation more Engaging by Embedding Videos

Pictures can be worth a thousand words. The same can be said for videos. Often, it’s easy to explain a concept or demonstrate a procedure using a video. The Widget macro allows you to embed web content, including YouTube, Episodic and Vimeo videos, in a Confluence page.

1. You release a new version of your product.
3. The marketing team creates a video demonstrating the new features of the release and uploads it to YouTube.
4. You can embed the video in your Release Notes using the Widget macro, for playback on your Confluence page.
   a. Select 'Other Macros' from the 'Insert' menu in the Rich Text Editor toolbar.
   b. Search for the 'Widget Connector' in the macro browser.
c. Insert the URL of your YouTube video into the 'Web Sites Widget URL' field.

d. Click 'Insert' and save your page.

See Widget Connector Macro for information on the supported services and for more usage examples.

Return to top of page

Next Steps

Take a look at Confluence Add-ons for Technical Documentation.

Confluence Add-ons for Technical Documentation

This page is part of the guide to developing technical documentation on Confluence. In this section we highlight some of the Confluence add-ons that are useful for technical writers in designing and developing documentation.

An add-on is an extension module that you can add to your Confluence site to extend the wiki’s core functionality. It is similar to an add-on for your browser.

An add-on that specifically plugs into an Atlassian application such as Confluence is sometimes called a plugin. The terms 'plugin' and 'add-on' are often used interchangeably. Confluence add-ons may be developed by
Atlassian or by third parties. To find an add-on featured on this page, and other add-ons too, visit the Atlassian Marketplace.

Quick guide to the plugins featured below

- **Gliffy plugin** – Provides an embedded diagram editor. Commercial.
- **Scroll Versions** – Adds functionality for sophisticated version management, enhanced content reuse, support for context-sensitive help, permalinks, and duplicate page titles. This is a commercial plugin.
- **Composition plugin** – Provides macros which allow finer control over the layout (composition) of a page. For example, outline text; add tabs to your page; flow your text around diagrams. Commercial.
- **Scaffolding plugin** – Provides macros for creating ‘permanent templates’ and editable forms. Commercial.
- **Attachment Checkout plugin** – Adds check-out/check-in functionality for Confluence attachments. Free.

Plugins featured in other parts of this guide

- **Copy Space plugin** – Provides an easy way of copying a space within a Confluence site. Free. See Creating your Technical Documentation Space.
- **Multi Excerpt plugin** – Enables you to have more than one excerpt (re-usable chunk) on a page. Commercial. See Re-using Content in Technical Documentation.
- **Ad Hoc Workflows plugin** – Provides advanced workflow features. Commercial. See Managing the Life Cycle of your Technical Documentation.
- **Content Publishing plugin** – Publishes content from a master space to a published space. Commercial. See Managing the Life Cycle of your Technical Documentation.
- **Scroll PDF Exporter** – Provides advanced PDF export features. Commercial. See Providing PDF Versions of your Technical Documentation and Exporting and Printing Technical Documentation.
- **Scroll EPUB Exporter** – Outputs an ebook in the common EPUB format that can be read on iPads, iPhones and any other ebook reader. Commercial.
- **Scroll HTML Exporter** – Enables the delivery of Confluence content from a web server. It converts the pages into static HTML pages that can be uploaded to a web server. The output of the Scroll HTML exporter can also be used as an input to produce other HTML-based help formats such as WinHelp and HTML Help. Commercial.
- **Scroll EclipseHelp Exporter** – Enables you to collaborate and author all your content in your wiki, and generate embeddable online help for Eclipse-based applications. Commercial.

Drawing Tools

Gliffy Plugin

The Gliffy plugin provides an embedded diagram editor. Gliffy allows you to create and edit diagrams directly from a Confluence page. It supports various diagram types (UML, business process, and so on).

**Alternatives:** As an alternative you can use the standalone version of Gliffy available at [http://www.gliffy.com/](http://www.gliffy.com/).

Gliffy online has a free basic version.

For more information, see the Gliffy plugin page.

*Extended Wiki Markup Features (Not applicable to Confluence OnDemand.)*
All wiki markup extensions are provided by **macros** in Confluence. Some macros are built in to Confluence. Other macros are supplied by plugins.

**Quick Overview of Macros**

Before looking at plugins, let's take a quick look at macros in general. There are two ways to add a macro to your page:

- Use the **macro browser**. This is the simplest and recommended way.
- Or insert the macro's name in curly brackets into the text of your page and specify the parameters.

Click here to see an example of a macro >>

The following code uses the (include) macro to insert the text from the page called 'My Page'. The text will appear on the page where the macro is used:

```plaintext
Page text...
{include:My Page}
page text...
```

The resulting page will look like this:

```plaintext
Page text...
<text from the 'My Page' page>
page text...
```

A number of macros are shipped with your Confluence installation by default. See **Working with Macros**. Below we describe some plugins that provide additional useful macros for Confluence:

**Composition Plugin**

The **Composition plugin** adds some formatting features to compose a page in a more flexible way. Using the macros provided by the Composition plugin, you can:

- Outline your text blocks.
- Add tabs to a page.
- Flow your text around the images or diagrams on the page.

**Using the Composition Plugin to Outline Text Blocks**

Use the `{cloak}` macro to outline a text block.

**Usage:** The following code creates a text block named 'SeeAlso' for the outlined 'See Also' section within a page. The text block with id='SeeAlso' will be hidden after the 'See Also' title:

```plaintext
{composition-setup}
h2. {toggle-cloak:id=SeeAlso} See Also
   {cloak:id=SeeAlso}
h3. Working With Macros:
   [Link 1]
   [Link 2]
   h3. Working with Rich Text Editor:
   [Link 3]
   [Link 4]
   {cloak}
```

**Alternatives:** You can also use the `{expand}` macro available in Confluence by default, but this macro can outline only text of the same level and cannot hide headings within the text. The `{expand}` macro does not require parameters and just hides the text placed between the `{expand}` tags.
**Note:** If you need to outline a text block containing nested headings, consider the text structure. Maybe the block is too big. You could create a child page from this block to decompose the whole text. Then you can include and outline the text block using the `{include}` macro within `{expand}`.

**Using the Composition Plugin to Add Tabs to a Page**

Use the `{deck}` and `{card}` macros to separate content between tabs on the same page.

**Usage:** The following code creates two tabs with client information:

```markdown
{composition-setup}
{deck:id=ClientName}
{card:label=Basic}
Client Company Name: Company
[Client Web Site|http://url.com]
Our projects: [Project1|Project1 Home]
{card}
{card:label=Contacts}
Company CEO: John Brown, e_mail: brown@company.com
{card}
{deck}
```

The tabs on a page will look like this:

![Client Name](shakespeare.jpg)

**Using the Composition Plugin to Flow your Text around Images**

Use the `{float}` macro to make your text flow around images or diagrams.

**Usage:** The following code demonstrates how a picture can be surrounded by the description, as often shown in printed publications:

```markdown
{composition-setup}
{float}
!shakespeare.jpg!
{float}
William Shakespeare (baptised 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's pre-eminent dramatist.
...
```

The page will look like this:
**Scaffolding Plugin** *(Not applicable to Confluence OnDemand.)*

The Scaffolding plugin allows you to create sophisticated page templates in order to add content easily and fast. Scaffolding templates are suitable for dynamically-filled data and allow people to create pages by completing form fields and selecting values from drop-down lists.

The Scaffolding templates are useful for creating pages with a well-determined structure, such as:

- **API methods or property descriptions.**
- **Constant list.**
- **Feature description.**
- **Software requirement specifications.**

**Example:** The following Scaffolding template creates a description of an API method:

---

William Shakespeare (baptised 26 April 1564; died 23 April 1616) was an English poet and playwright, widely regarded as the greatest writer in the English language and the world's preeminent dramatist. He is often called England's national poet and the "Bard of Avon". His surviving works, including some collaborations, consist of about 39 plays, 164 sonnets, two long narrative poems, and several other poems. His plays have been translated into every major living language and are performed more often than those of any other playwright.

Shakespeare was born and raised in Stratford-upon-Avon. At the age of 18, he married Anne Hathaway, with whom he had three children: Susanna, and twins Hamnet and Judith. Between 1585 and 1592, he began a successful career in London as an actor, writer, and part owner of a playing company called the Lord Chamberlain's Men, later known as the King's Men. He appears to have retired to Stratford around 1613, where he died three years later. Few records of Shakespeare's private life survive, and there has been considerable speculation about such matters as his physical appearance, sexuality, religious beliefs, and whether the works attributed to him were written by others.

Shakespeare produced most of his known work between 1598 and 1613. His early plays were mainly comedies and histories, genres he raised to the peak of sophistication and artistry by the end of the 16th century. He then wrote mainly tragedies until about 1608, including Hamlet, King Lear, and Macbeth, considered some of the finest works in the English language. In his last phase, he wrote tragi-comedies, also known as romances, and collaborated with other playwrights.
This template will look like this:
For more information on how to create templates in Confluence, see Adding a Template.

Alternatives: Confluence includes built-in templates which as useful for static data and simple text. For more information, see Working with Templates.

Notes: The Scaffolding (and any) template changes will affect only new pages created from the modified template. In order to change the existing pages, you need to edit each individual page and add or modify the formatting manually.

For more information on Scaffolding, see the Scaffolding plugin page.

Extended Version Control (Not applicable to Confluence OnDemand.)

Scroll Versions

Scroll Versions enables you to set up and manage concurrent versions of your documentation in a single space. Multiple versions of software, different product variants, and even multiple translations of documentation can be managed. Changes to pages are scheduled for a specified version and then published all at once. See the Scroll Versions documentation for an overview of the key features.

Video: Scroll Versions - Version Management for Confluence (4:20)

Attachment Checkout Plugin

The Attachment Checkout plugin adds check-out/check-in functionality for Confluence attachments. It allows you to control the versions of the documents attached to a page with the same file name.
Attachment checkout allows Confluence to warn contributors that the document is being edited by someone else. Note that there are no merge features for attachments.

**Example:** To store and control the versions of Project Vision documentation received from a customer on the Confluence page:

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Creator (Last Modifier)</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client1_Project1_Vision.doc</td>
<td>30 KB</td>
<td>Ekaterina Stepelina</td>
<td></td>
</tr>
<tr>
<td>Version 2 (30 KB - Ekaterina Stepelina - Nov 8, 2010 11:19 AM MDT)</td>
<td></td>
<td></td>
<td>Checkout</td>
</tr>
<tr>
<td>Version 1 (30 KB - Ekaterina Stepelina - Nov 8, 2010 11:19 AM MDT)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For information on working with attachments, see Working with Attachments. For information on attachment versioning, see Attachment Versions.

**Notes**

- **Installing plugins.** If you decide to use additional plugins, your site administrator will need to install the plugins into your Confluence site. Refer to the documentation on installing plugins. *Not applicable to Confluence OnDemand.*

- **Plugin support.** *Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.*

Further Reading

- A blog post about useful plugins and tools for exporting and importing content from/to Confluence: Technical Writing in a Wiki - Single Source Publishing (November 2010).
- Website for exploring and downloading the available plugins: Atlassian Marketplace.
- Documentation on installing and configuring plugins: Universal Plugin Manager Documentation.
- Documentation on using macros: Working with Macros.
- Further Reading about Developing Technical Documentation on Confluence

Further Reading about Developing Technical Documentation on Confluence

This page is part of the guide to developing technical documentation on Confluence. Once you have absorbed all the information in this guide, you may be ready for more reading. 😊

- The Confluence documentation: Confluence Latest.
- Tips from other technical writers, in the Confluence documentation: Tips of the Trade. *Not applicable to Confluence OnDemand.*
- Blog post about using Confluence for online help: Using a wiki for online help.
- Blog posts about version management in Confluence with Scroll Versions plugin:
  - Announcing Scroll Versions.
  - Version management gets serious with Confluence Scroll Versions plugin.
- Now you have your documentation space up and running, it's fun and rewarding to use the full power of the wiki to engage your readers and embed content from other social sites. Here is a blog post and presentation slides on engaging readers in the documentation.

**Let us know about more links**

We plan to add more links to this page or to the 'Tips of the Trade' page. Let us know of any we have missed.

**Developing a Knowledge Base on Confluence Wiki**
Welcome! This is a guide to using Confluence as a knowledge base. You will find this guide useful if you want to produce a knowledge base with a survey, content curation, intelligent search and standardized templates.

In these pages, we'll show you how to use Confluence to achieve a high-functioning knowledge base, including these features:

- **Using Templates**
- **Subscriptions** (RSS or Email)
- **Exporting** articles (PDF or Word)
- **Organizing content** (hierarchically or by label)
- **Involving Customers** (using comments)
- **Populating data**
- **Scripts** to update content programmatically
- A "Was This Helpful?" survey
- **Intelligent searching** algorithms (higher ranked articles are promoted in search results)
- **Targeted searching** across specified Confluence spaces and content types
- How to show related content
- **Extensive metrics and reporting**
- **Maintenance**

**PAGES IN THE GUIDE**

- Creating Your Knowledge Base Space
- Using Templates and Formatting Macros in a Knowledge Base
- Proactive Communications in a Knowledge Base
- Additional Add-ons for a Knowledge Base

**RELATED TOPICS**

Confluence User's Guide
Confluence Administrator's Guide
Creating Your Knowledge Base Space

This guide is for people who want to develop and publish a knowledge base using Confluence. You’ll find Confluence useful because it combines professional web publishing features with the ease-of-use and flexibility of a wiki - requiring a low barrier to entry, but high quality output for all your team members. Confluence provides all of the collaborative features for your reports (such as automatic versioning, granular enterprise security, email and RSS subscriptions, and JIRA integration). This page is a quick-start guide to creating a wiki space for a knowledge base.

**Quick guide to creating a knowledge base space**

- Add a Space and Select the Documentation Theme
- Set the Space Permissions
- Customise the Title and Content of the Homepage
- Customise the Documentation Theme
- Create an Inclusions Library to Manage Reusable Content
- Create the Table of Contents
- Make your Knowledge Base Proactive with a Subscribable RSS Feed
- Set up Atlassian's Content Survey and Reporting Plugin
- Insert Google Analytics Code into Confluence's Custom HTML - Not applicable to Confluence OnDemand.

The rest of this page gives more details of the above procedure.
On this page:
- Step 1. Add a Space and Select the Documentation Theme
- Step 2. Set the Space Permissions
- Step 3. Customise the Title and Content of the Homepage
- Step 4. Customise the Documentation Theme
- Step 5. Create an Inclusions Library to Manage Reusable Content
- Step 6. Create the Table of Contents
- Step 7. Make your Knowledge Base Proactive with a Subscribable RSS Feed
- Step 8. Set up Atlassian's Content Survey and Reporting Plugin
- Step 9. Insert Google Analytics Code into Confluence's Custom HTML

Note about Plugin Support

Step 1. Add a Space and Select the Documentation Theme

Below is a quick guide to adding a space. See Setting up a New Global Space for a full description.

1. Go to the Confluence dashboard and choose Add Space.
   *Hint:* If you cannot see Add Space, this means that you do not have permission to add spaces. Please contact your Confluence administrator.
2. In the ‘Create Space’ screen, enter a space name and a short, unique space key.
3. Leave the permission settings as default, or choose to allow only yourself to view or contribute content to this space. You can change these settings later and with more flexible options.
4. Choose OK.
6. Choose Look and Feel > Themes and select the Documentation theme.
7. Choose OK.

The homepage of your new space will appear, with the Documentation theme. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below. From this point on, instructions will refer to navigating in the Documentation theme, which is slightly different to the default theme.

Step 2. Set the Space Permissions

Define the space permissions to determine who can do what in your new space.

1. Choose Browse > Space Admin at the top of the screen.
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Choose Permissions.
3. Choose Edit Permissions.
4. Set the permissions to suit your needs then click Save All.
   - You can add groups and/or individual users to the list, then select the permissions for each group or user.
   - You can also set the permissions for anonymous users – these are people who have not logged in to the wiki. Anonymous access is available only if enabled for the entire Confluence site. We recommend this setting if you are using this space for Technical Documentation or for a Knowledge Base.
   - Note that you can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

A Bit More about Permissions

Confluence has a robust and granular permissions scheme that you can use to determine who can view,
comment on and even update the documentation. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page. Below we discuss a way of using these in the draft, review and publishing workflow.

Space permissions in Confluence are simple yet granular enough to be useful for technical documentation. You can:

- Use the permission levels to control who can create pages in the space, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users.

Terminology:

- 'Anonymous' means people who have not logged in to the wiki. These are users that won't affect your the number permitted by your license.
- The 'confluence-users' group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow Anonymous users specific view and content creation rights so that they can access and engage with your knowledge base while your team lead (Rach) maintains full Space Administration rights.

**Screenshot: Allow anonymous users to add specific content**

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

**Step 3. Customise the Title and Content of the Homepage**

When you created your space, Confluence created a homepage with default content and a default title, 'Home'. You will want to change the title and content.
1. Go back to your space homepage, by clicking the space name in the breadcrumbs at the top of the screen.
2. The space homepage appears. By default, the page title is 'X Home', where 'X' is the name you gave your space.
3. Click Edit.
4. Change the title to suit your needs.
5. Update the content to suit your needs.
   
   *Hint:* If you do not know what to add yet, just add a short description. You can refine the content of the page later. Take a look at an example of a homepage.
6. Click Save.

**Step 4. Customise the Documentation Theme**

When you added this space you chose the Documentation theme, which provides a left-hand navigation bar and a good look and feel for a knowledge base. If necessary, you can configure the Documentation theme to add your own page header and footer or to customise the default left-hand navigation bar. These customisations affect the online look and feel of your knowledge base. See Configuring the Documentation Theme for the full description in our product documentation.
1. Choose **Browse > Space Admin** (if you have not yet selected the documentation theme, choose Space Tools > Look and Feel)
2. Choose **Themes**.
3. If the space is not yet using the Documentation theme, apply the theme now.
4. Choose **Configure theme**.

### Current Theme

The current theme controls the layout and colours of this space.

#### Documentation Theme

This theme is well suited for structured content, such as documentation. It features a table of contents (page tree) on the left, making it easier to see the structure of a space and move from page to page. You can customise the left-hand panel, page header and page footer.

**Configure theme** - further customise this theme’s options

5. The 'Documentation Theme Configuration' screen appears. Customise the left-hand navigation bar, header and footer to suit your needs. Details are in the [documentation](#). Here are some hints:
   - The **Page Tree** check box determines whether your space will display the default search box and table of contents (page tree) in the left-hand panel.
   - The **Limit search results to the current space** check box determines whether Confluence will search only the current space or the whole Confluence site. This setting affects the default search. Viewers can override it each time they do a search.
   - Enter text, images, macros and other wiki markup into any or all of the three text boxes for the the left-hand navigation bar, header and footer. You can use the **Include macro** and the **Excerpt Include macro** to include re-usable content.
   - Any content you add to the navigation panel will appear above the default page tree.
   - If you like, you can remove the default page tree (by unticking the box) and add your own, customised version of the **Pagetree** macro instead.

6. Choose **Save**.

### Example of a Customised Footer

Take a look at the footer of a page in the Crowd documentation space.

To produce the above footer, we have the following content in the footer panel in the Documentation theme configuration screen:

```
Footer
{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}
```
Here it is in text form:

{include:_Documentation Footer|nopanel=true}
{include:ALLDOC:_Copyright Notice|nopanel=true}

The above content consists of two Include macros.

- The first macro includes a page called _Documentation Footer. This page contains the big blue buttons and hyperlinked text.
- The second macro includes a page from a different space, the ALLDOC space, called _Copyright Notice. This page includes our standard copyright notice, used in all our documentation spaces.
- In each include macro, the content has been drawn from an inclusions library, a hidden content repository, from which you can store frequently and re-usable content throughout your knowledge base space.

**Step 5. Create an Inclusions Library to Manage Reusable Content**

Using Confluence, you can dynamically include content from one page into another page. You can include a whole page into another one, using the Include macro. You can also define an 'excerpt' on a page, and then include that excerpted text into another page using the Excerpt Include macro.

To organise your re-usable content, we recommend that you create a set of pages called an 'inclusions library'.

1. Choose Create and create a new page in your space
2. Enter a suitable title. We use '_InclusionsLibrary'. The unusual format of the title helps to let people know this page is special.
3. Enter some content and save the page. We enter text explaining the purpose of the inclusions library and how to re-use the content. You can copy our text by clicking through to one of the example pages listed below.
4. Choose Browse > Pages and drag your new page above the space homepage.
5. Go to your new inclusions page and choose Create to add child pages containing your re-usable content. See the examples of our own inclusions libraries listed in the examples below.

Some notes about inclusions libraries:

- The inclusions library is not a specific feature of Confluence. The pages in the inclusions library are just like any other Confluence page.
- The pages are located at the root of the wiki space, not under the homepage. This means that they will not appear in the table of contents on the left and they will not be picked up by the search in the left-hand navigation bar either.
- The pages will be picked up by other global searches, because they are just normal wiki pages.
- We have decided to start the page name with an underscore. For example, '_InclusionLibrary'. This indicates that the page is slightly unusual, and will help prevent people from changing the page name or updating the content without realising that the content is re-used in various pages.
Examples of Inclusions Libraries

Here are some examples in our documentation:

- Crowd inclusions library
- Confluence inclusions library

Step 6. Create the Table of Contents

Create the table of contents for your knowledge base, by adding the top-level pages for all the usual sections. For instance, our Technical Support Team designed the following pages in the Confluence Knowledge Base on our public wiki:

- Browse Articles by Label
- Browse Articles by Top Ranked Content
- Browse Articles by Page Tree Hierarchy
- Browse Articles by Version
- Subscribe to Proactive Announcements

1. Go back to your space homepage, by clicking the space name in the breadcrumbs at the top of the screen.
2. Choose Create to add the page as a child of the homepage.
3. Enter the page title, for instance: 'Browse Articles by Label'.
4. Enter the content of the page.
   - Hint: If you do not know what to add yet, just add a short description then refine the content of the page later. If you like, you can follow a similar outline as the Confluence Knowledge Base and add the Label List macro. This displays a hyperlinked alphabetical index of all labels within the current space. As you create content in this space and apply appropriate labels, the macro will update this page automatically.

Browse Content by Label

Click on one of the labels below to find related content:

Below are the 181 labels used in Confluence Knowledge Base listed alphabetically. Click a label to see its associated content.

<table>
<thead>
<tr>
<th>A-B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>apache, applinks, appserver, attachments, backup, bamboo, build</td>
<td>cache, calendar, camelcase, camel_case, captcha, case_sensitivity</td>
<td>dashboard, database, db2, deadlock, directory, doc_import, documentation_theme, dynamic_tasklist</td>
</tr>
</tbody>
</table>

5. Choose Save.

Now do the same for all the sections of your Knowledge Base that you wish to appear in the left-navigation bar of the Documentation theme. Below is what the Table of Contents looks like for our Confluence Knowledge Base:
Step 7. Make your Knowledge Base Proactive with a Subscribable RSS Feed

Let's populate the knowledge base homepage with content by creating an RSS feed that your coworkers and customers can subscribe to and receive important updates on your knowledge base and technical alerts on your products.

This is a strategy that Atlassian's Technical Support Team uses to create a proactive knowledge base that provides technical alerts to customers and coworkers and helps solve support issues before they're even created.

By following the quick guide below, you'll create a homepage similar to the one Atlassian's Technical Support Team has created for the Confluence Knowledge Base on our public wiki and turn your knowledge base from reactive to proactive:

Creating your RSS Feed

Confluence can filter spaces by content type. To filter your knowledge base for 'blog post' content, do the following:

1. Go to a page in the space and choose Blog in the sidebar.
   Or, if you are using the Documentation theme, choose Browse > Blog at the top of the screen.
2. Copy this URL to your clipboard.
3. Create an RSS feed for the URL of your knowledge base space.

Now your RSS feed will consist of any blog posts created in the knowledge base space.
### Highlighting Your Technical Announcement RSS Feed

1. Go to your space home page.
2. Choose **Edit**.
3. Insert an 'h2' heading, such as 'Important Technical Announcements'.
4. Insert bold text that reads something like, 'Copy the RSS feed into your favourite RSS reader:'.
5. Choose **Insert > Other Macros** to open the Macro Browser.
6. Select the 'Panel' macro in the Macro Browser and specify your desired macro preferences. We recommend that you change the **Panel Title**, **Border Style**, and **Background Color** to further highlight the panel on the page.
7. Choose **Insert**.

### Insert a Blog Posts Macro

1. Inside the Panel macro placeholder choose **Insert > Other Macros** to open the Macro Browser again.
2. Select the **Blog Posts** macro in the Macro Browser and specify the following preferences:

   - **Content Type to Display**: Title
   - **Restrict to These Spaces**: Your knowledge base Spacekey
   - **Maximum Number of News Items**: 5
   - **Sort By**: Creation
   - **Reverse Sort**: Tick the box

3. Choose **Insert** to insert the Blog Posts macro onto the page inside your Panel macro.

   ![Blog Posts](image)

   **Blog Posts**

   Lists the most recent news items in the space.

   - Now your panel will display the last 5 blog posts created in your knowledge base space.
Inserting your RSS Feed into your 'Technical Announcement' Panel

First, let's create a link so that your coworkers and customers can view all of the blog posts in your knowledge base space. See Working with Links for a full description in our product documentation.

1. Place your cursor after/below the Blog Posts macro in the Panel macro placeholder.
2. Type: 'View more recent blog posts'.
3. Highlight this text and click Link on the editor toolbar.

```
Insert Link

Search
Recently Viewed
Attachments

URL: http://
Link Text: View more recent blog posts

Web Link

4. Select 'Web Link' and paste the link you copied to create your RSS Feed.
5. Choose Insert.

Now, let's insert your RSS Feed into your panel by linking an image. See Linking an Image for a full description in our product documentation.

1. Attach an RSS Icon to the page by dragging and dropping it into the editor (preferably below the link you just created). See Drag-and-Drop for a full description in our product documentation.
2. Choose the RSS Icon image and choose the 'Align right' button on the editor toolbar.
3. Choose Border in the image properties panel.
4. Link the RSS Icon by selecting the image and then choosing Link on the editor toolbar.
5. Choose the 'Web Link' tab and insert the RSS Feed URL you created.
6. Choose Insert to link your RSS Feed to the RSS Icon image.
7. Choose Save to save your page and test your RSS Icon.

Congratulations! You have successfully created a proactive knowledge base.

Step 8. Set up Atlassian’s Content Survey and Reporting Plugin

Now that you can monitor the traffic and activity of your knowledge base, let's measure its effectiveness. When the Content Survey and Reporting Plugin is activated for a space, it will generate a report that includes:

- Direct feedback from customers about article quality
- Amalgamated "composite score" results
- Answers to secondary questions, such as "Was the info complete?" or "Was the article well-written?".
- Rollup at-a-glance view of the metrics for the whole space.

Lastly, the Content Survey and Reporting Plugin will institute 'intelligent searching' which means that based on the results of the surveys, higher ranked pages are promoted in search results, so your best and most popular pages are found easiest. This is a quick guide for how to set up the Content Survey and Reporting Plugin.

This plugin only functions properly if the Documentation Theme is applied to the space.

Let's install the Content Survey and Reporting Plugin using Confluence's Universal Plugin Manager.
Installing the Content Survey and Reporting Plugin

1. Log into Confluence as a System Administrator or Confluence Administrator.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Manage Add-ons
4. Search for the 'Content Survey and Reporting Plugin'
5. Choose Install.

You can also go to the Atlassian Marketplace and download the plugin and install it directly.

Now that you’ve installed the Content Survey and Reporting Plugin, let’s configure a survey:

Configuring a Survey

1. Go to your space.
2. Choose Browse > Space Admin at the top of the screen.
   
   Note: The 'Space Admin' option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
3. Click Configure Survey under ‘Knowledge Base Survey’. Here you can:
   - Add a question
   - Edit a question’s text
   - Activate or deactivate a question
   - Edit the response text
4. Configure a 'Primary Question' for the survey

5. Choose Save.

Now that you’ve added a primary question, let’s test out the plugin by adding it to the footer of the Documentation theme so that every page within your Knowledge Base space includes your survey.
Invoking the Content Survey and Reporting Macro

1. Choose **Browse > Space Admin** at the top of the screen.
   
   *Note:* The ‘Space Admin’ option appears only if you are a space administrator for the space or you are a super user (a member of the [confluence-administrators](#) group).

2. Choose **Themes**.

3. Choose **Configure theme**.

4. Go to the ‘Footer’ section of the ‘Documentation Theme Configuration’ page and insert this recommended markup to achieve a nice layout of the Content Survey and Reporting Plugin:

   ```
   {section}
   {column:width=5%}
   {column}
   {column:width=90%}
   {panel}
   {kbsurvey}
   {panel}
   {column}
   {column:width=5%}
   {column}
   {section}
   ```

5. Choose **Save** and go to your space homepage to view your Content Survey and Reporting Plugin in the footer of the page.

With the Content Survey and Reporting Plugin you can dramatically improve the quality of your knowledge base and the efficiency with which your team creates and maintains it. Here is an example of how our Technical Support Team uses the Content Survey and Reporting Plugin in the Confluence Knowledge Base:

**Help us improve!**

*Is this article helpful?* ◐ Yes ◐ No

*Is the content complete?* ◐ Yes ◐ No

*Is it well written?* ◐ Yes ◐ No

**Content Survey and Reporting Plugin Results:**

Survey results are viewable by Space Administrators only. The plugin develops three results:

- **Pages with Results** - Determine page-by-page, which are you most effective knowledge base articles and which ones need improvement.

<table>
<thead>
<tr>
<th>View: Pages with Results</th>
<th>Pages without Results</th>
<th>Rollup Report</th>
</tr>
</thead>
</table>
| Confluence Knowledge Base| Total Ballots | Composite Score | Is this article helpful? | Is the content complete? | Is it well written?
| LDAP Error Code 49 | 284 | 585 | 73% (208/285) | 57% (111/195) | 75% (114/143) |
| Confluence Does Not Start with 'MySQL' session isolation level | 69 | 167 | 66% (54/84) | 75% (39/52) | 82% (42/51) |
| REPEATABLE-READ is no longer supported | 86 | 110 | 57% (46/84) | 51% (33/65) | 56% (34/61) |
| Unable to Connect to SSL Services due to PKIX Path Building Failed | 3 | 102 | 67% (20/30) | 50% (1/2) | 100% (2/2) |
| sun.security.provider.certpath.SunCertPathBuilderException | 44 | 100 | 82% (82/102) | 67% (42/63) | 94% (33/35) |
| How to edit the Footer in Confluence | 63 | 77 | 56% (36/65) | 44% (27/63) | 47% (32/68) |
| Exceeds Max Allowed Packet for MySQL | 32 | 72 | 61% (41/66) | 71% (17/24) | 82% (16/20) |

*Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).*
As you can see, the plugin develops a 'Composite Score' which ranks articles in search, so your highest scoring (best) content can be found most easily. The score is based on the last 32 votes cast, using the global search configuration. See Confluence Content Survey and Reporting Plugin for a full description on how Global Search boosting works.

- **Pages without Results** - These are the pages in your knowledge base without survey results.
- **Rollup Report** - This is the summary of all survey results. The report can be used to determine how effective your overall knowledge base content is.

<table>
<thead>
<tr>
<th>View: Pages with Results</th>
<th>Pages without Results</th>
<th>Rollup Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Pages in Space</td>
<td>Total Ballots Cast</td>
<td>Is this article helpful?</td>
</tr>
<tr>
<td>1292</td>
<td>3351</td>
<td>58% (1924/3351)</td>
</tr>
</tbody>
</table>

**Searching Multiple Spaces from your Knowledge Base**

As mentioned, the Content Survey and Reporting Plugin generates a composite score that ranks pages and articles within your knowledge base to make the highest (most well regarded) pages more retrievable by visitors. The plugin also improves Confluence search by allowing users to search multiple spaces without ever leaving your knowledge base space. This is really helpful for users that are unfamiliar with Confluence because they can keep the knowledge base as a point of reference within the greater instance of Confluence.

At Atlassian, our product knowledge bases and product documentation exist in the same Confluence instance so that we can make both available to 'Anonymous' users. Our Technical Support team uses the Content Survey and Reporting Plugin to allow visiting users to search for Confluence resources in the product documentation space from the Confluence Knowledge Base space. This provides the visitor twice the chances of finding an answer to their question.

In the image below, you can see the space specific search used in the left-navigation bar to find content related to Confluence in both the 'Documentation' and 'Knowledge Base' spaces. Pages in the 'Documentation' space are listed first and pages in the 'Knowledge Base' space are listed second.
Step 9. Insert Google Analytics Code into Confluence’s Custom HTML

Now that you have a strong foundation for a knowledge base, it’s critical to assess how effectively it services your customers. Google Analytics is a tool that gives you rich insights into your website traffic and marketing effectiveness. You are going to want to understand how your customers are accessing the resources in your knowledge base. This is a quick guide to inserting Google Analytics HTML code into Confluence so you can measure your knowledge base traffic.

⚠️ The information in this step does not apply to Confluence OnDemand.
1. If you don't have one already, create a Google Account and then create a Google Analytics Account using your Confluence instance's URL.
2. Copy the Google Analytics code to your clipboard.
3. Log into Confluence as a System Administrator or Confluence Administrator.
4. Choose the cog icon at top right of the screen, then choose Confluence Admin.
5. Choose Custom HTML under 'Look and Feel'.
6. Choose Edit to insert custom HTML into your Confluence instance.

7. Paste your Analytics code you have saved to your clipboard into the table labeled At end of the BODY.
8. Choose Save.

You can now monitor the activity and traffic for every page you create in your Confluence instance and Knowledge Base.

Hint: If your knowledge base only represents a space within your greater Confluence instance, you can search Google Analytics for activity in the specific space by exclusively filtering for the space key.

Read David Simpson's blog post about Tracking Confluence Usage with Google Analytics for more information.

Note about Plugin Support

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Next Steps
Using Templates and Formatting Macros in a Knowledge Base

This page is part of the guide to developing a knowledge base on Confluence Wiki. We have already shown you how to create your knowledge base space. Now we offer an introduction to the templates that Confluence provides.

**Quick guide to templates in Confluence**

- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Templates are available across the Confluence site (global templates) or per space (space templates).
- Both 'global templates' and 'space templates', as described on this page, define the content of a page. They do not define the content of an entire space.
- You can import predefined templates, including those shipped with Confluence and additional templates from the Atlassian Plugin Exchange.
- To create a template for an entire space, see our guide to creating your documentation space.

**Space Information Design**

One question that comes up is whether a knowledge base should be implemented as a decision matrix, with a multi-select or other list. We knew that most of our users visit our documentation directly from search engines. Early on, we learned that at least for us, Google Analytics was showing that most traffic was coming from search engines, not from within our site. So, we knew to focus on optimising page titles and tags rather than focus on a decision matrix.

**Confluence's Built-in Feature Set**

Page Templates

Confluence's page templates are an easy place to start. Begin by choosing how you want your templates to look. Here's the wiki markup for our page template:

```markdown
h3. Symptoms
FILL IN SYMPTOMS HERE

h3. Cause
FILL IN CAUSE HERE

h3. Resolution
FILL IN RESOLUTION HERE

{htmlcomment}
ENTER SUPPORT TICKET LINKS
{htmlcomment}
```

The `{htmlcomment}` macro is part of Adaptavist's Content Formatting Macros, a handy plugin.

You might consider the scaffolding plugin or Form Field Markup for filling out forms. Our support engineers are quite used to using wiki markup (we live and breathe Confluence!), so we left this template as is.

Construct a Home Page: Section, Panels, RSS, and Notifications

Check out the Confluence Knowledge Base Home. The colored content in the middle of the page is an amalgamation of panel, rss and attachment macros. Go to Tools >> Wiki Markup to see.
The wiki markup there is a little confusing, but it breaks down like this:

1. A **Section** macro, defining the top and bottom of the page
2. **Column** macros, dividing the panels into three
3. **Panel** macros, with hot, hot, hot html colours
4. **Content By Label** Macros
5. An RSS Icon, embedded as an attachment, with a link to the RSS feed. Notice the magic on this one:

   ```
   ![rss20.gif|align=right!|http://confluence.atlassian.com/createrssfeed.action?types=page&sort=created&showContent=true&spaces=CONFKB&labelString=conf32&rssType=rss1&maxResults=50&timeSpan=120&publicFeed=true&title=Confluence+3.2+Knowledge+Base+Articles&showDiff=false]
   ```

   That's a link, with the attachment as the alias, an alignment parameter, and the URL to the RSS feed. Cool, right?

### Exporting Pages

These are built-in Confluence features. Check [Page Exports](#). You can learn how to customise the PDF export as well.

### Content Macros

Besides the ones listed above, some favourite macros for formatting content around the site are the **Tip**, **Info**, **Warning**, and **Note** Macros, ad the **Code** macro. They make things look great. We also use Adaptavist’s **Content Formatting Macros** when we really want to bring our A-game.

### JIRA Issues Macro

Using JIRA for bug tracking? You can't expect your users to necessarily have exactly the right JQL filters to show the appropriate topics. We have some nice JIRA Issues Macros on display. One of my favourites is in the JIRA KB's **Causes for OutOfMemory Errors**:

```
{jiraissues:url=jira.atlassian.com/sr/jira.issueviews:searchrequest-xml?searchrequestxml=%3Csearchrequest+xmlns%3D%22jiraissuexml%22+%3E%3Csearch+project+%3D+JRA+AND+issuetype+in+%28Bug%2C+Improvement%29+AND+component+%3D+%22Performance+-+Memory+leaks%22+OR+DER+BY+key+DESC%26tempMax=200|columns=fixversion;summary;status;key|anonymous=true}
```

Notice the JQL there including components and sorting, plus the specific columns.

### Labels

Sometimes, an article needs to be cross listed. For that we label our articles. Some great macros to use for this are (**contentbylabel**), (**listlabels**) and the (**dynamiccontentbylabels**) macro in the **Content Survey Plugin**.

### Next Steps

You now have a good idea of how Confluence templates work. What next? Take a look at **Proactive Communications in a Knowledge Base**.

Proactive Communications in a Knowledge Base
This page is part of the guide to developing a knowledge base on Confluence Wiki. We have already shown you how to create your knowledge base space and how to use templates and formatting macros. We touched a bit on creating proactive communications in Creating Your Knowledge Base Space, and discuss a bit further here.

Quick guide to proactive communications

- A template is a page with predefined content that can be used as a prototype when creating other pages.
- Confluence can either produce or consume rss feeds
- Both the rss and blog-posts macro are a good way to show summaries

Proactive Alerts

Sending technical alerts to customers is a great way to keep customers and staff informed, and good way to reduce support load. At Atlassian we use the Knowledge Base both to consume and produce proactive content for which customers can opt in. This page describes how to achieve that.

Using Confluence as a producer

- The Working with Blog Posts describes how to produce blog posts from Confluence.
- Emailing a Page is a great way to send mass emails to users or an email distribution list.

Using Confluence as a consumer

Even if your Confluence instance isn't producing your proactive content, it can consume and display it in a prominent way:

- The RSS Feed Macro can consume content from any RSS feed on the Internet.
- We use the Blog Posts Macrofor It looks especially handsome in a panel, accentuated by an RSS image in a link. Here's the wiki markup:

```wiki
h4. Technical Alerts
{panel:title=Important Technical Alerts for Confluence| borderStyle=solid| borderColor=#ccc| titleBGColor=#f93 | bgColor=#fc9}
{blog-posts:content-title|max=5|sort=modified|spaces=CONFKB|time=30d}
* [View more recent blog posts](http://confluence.atlassian.com/pages/viewrecentblogposts.action?key=CONFKB)
* ![CONFKB:Confluence Knowledge Base Home^rss20.gif|align=right](http://confluence.atlassian.com/createrssfeed.action?types=blogpost&blogpostSubTypes=comment&blogpostSubTypes=attachment&spaces=CONFKB&title=Confluence+KB+-+Technical+Alerts&labelString=techalert&excludedSpaces%3D&sort=modified&maxResults=10&timeSpan=30&showContent=true&showDiff=true&confirm=Create+RSS+Feed|showTitleOnly=true)
{panel}
```

Next Steps

You now have a good idea of how to do proactive communications. Next up, consider Additional Add-ons for a Knowledge Base in more detail.

Additional Add-ons for a Knowledge Base

This page is part of the guide to developing a knowledge base on Confluence Wiki. This page lists additional add-ons that might expand your usage.

Useful Add-ons for a Knowledge Base

These are some great add-ons for Confluence as a Knowledge Base:
• The Content Survey and Reporting Plugin gives a good report on popular and unpopular content.
• The Confluence Archiving Plugin flags old content.
• The Ad hoc Workflows Plugin or Content Publishing Plugin manage workflows and review process.

Note about Add-on Support

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

Bye

Hope you enjoyed the tutorial! Have a chocolate, and please share with us your experiences. You can comment directly on this page.

Developing an Intranet on Confluence Wiki

This guide is for people who are using Confluence as a platform for an intranet. You will find this guide useful if you want to create a space where your team can collaborate and share information.

Quick guide to creating an intranet space

• Create a space.
• Set the space permissions.
• Customise the title and content of the home page.
• Subscribe to email notifications for any updates made to the space.
• Manage your existing Office documents.
• Import page templates.
• Set up your personal space.
• Publish a blog post.

Step 1. Create a Space

Below is a quick guide to adding a space for your team.
1. Go to the Confluence dashboard and choose **Create Space**.
2. The **Create Space** screen appears. Enter a **space name** and a short, unique **space key**.
3. Choose **Create**.

The home page of your new space will appear. Because you created the space, you are the space administrator. Now you can do some basic configuration, as described in the sections below.

**Step 2. Set the Space Permissions**

Define the space permissions to determine who can do what in your new space.

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
2. If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

3. The **Permissions** page appears.
4. Choose **Edit Permissions**.
5. Set the permissions to suit your needs then choose **Save All**.
   - You can add **groups** and/or individual **users** to the list, then select the permissions for each group or user.
   - You can also set the permissions for **anonymous** users – these are people who have not logged in to Confluence and will not count towards the number allocated by your license. Anonymous access is only available if enabled for your entire Confluence site. It is unlikely you will need anonymous users for your intranet.
   - You can change these permissions at any time. You may want to restrict the permissions to specific groups now, and later open the space to more people.

**More about Permissions**
Confluence has a robust and granular permissions scheme that you can use to determine who can view, create content and comment within your intranet. There are three levels of permissions in Confluence:

- Global permissions apply across the entire site.
- Space permissions apply to a space.
- Page restrictions allow you to restrict the editing and/or viewing of a specific page.

**Space permissions** in Confluence are simple yet granular enough to be useful for an intranet. You can:

- Use the permission levels to control who can create pages, delete pages, create comments, delete comments, administer the space, and so on.
- Grant a permission level to one or more users, and/or to one or more groups, and/or to anonymous users. A space administrator has complete control.

Terminology:

- 'Anonymous' means people who have not logged in to Confluence.
- The 'confluence-users' group is the default group into which all new users are assigned. Everyone who can log in to Confluence is a member of this group.

For example, you might allow the 'confluence-users' group permission to create and edit comments, but reserve full editing rights for your team members. Let's assume your team members are all members of the 'developers' group. The example below shows that members of the 'developers' group have all permissions except space administration, but, members of the 'confluence-users' group and the individual 'Josh User' only have a few editing rights.

For detailed information, see the documentation on:

- Global permissions
- Space permissions
- Page restrictions
- Users and groups

**Step 3. Customise the Title and Content of the Home Page**

When you created your space, Confluence created a home page with default content and a default title, 'Home'. You will want to change the title and content to suit your team.
1. Go to your space home page
2. By default, the page title is 'X Home' (where 'X' is the name you gave your space).
3. Choose Edit.
4. The page opens in the editor.
5. Change the title and update the content to suit your needs.
   
   Hint: If you do not know what to add yet, add a short description. You can refine the content of the page at any time.
6. Choose Save to save your home page.

Step 4. Subscribe to Email Notifications for Updates Made to the Space

You can configure your email notifications to suit your needs: You can choose to be notified about all pages in a space, blog posts in a space, or both. Below is a quick guide to monitoring a space's content. See Watching a Space for a full description.

1. Go to your space homepage.
2. Choose Pages in the sidebar.
3. Choose Watch this space.
4. Choose Blog in the sidebar.
5. Choose Watch this blog.

If at any time you wish to stop watching activity in the space, just click 'Stop watching this space' or 'Stop watching this blog'.

Example of an Email Notification

Here is an example of the email notification you will receive when someone adds a comment to a page or blog post:

More about Notifications

You can specify the notifications you want to receive on a global, space and page level. The quick guide above demonstrated how to set up notifications for a space. Now we will show you how to configure your notifications on the global and page levels.

Global Notifications

Global notification settings determine the overall behaviour of the notifications you receive from Confluence.

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Choose your profile picture at top right of the screen, then choose Settings.
2. Choose Email.
3. Choose Edit.
4. Change the default settings to suit your needs. You can alter these email settings at any time.
5. Choose Submit to save your changes.

**Page and Blog Post Notifications**

Follow the quick guide below to receive notifications from Confluence about changes to and comments on a specific page or blog post. See Watching a Page or Blog Post for a full description.

You can watch any given page or blog post that you have permission to view. We will use your space's home page as an example.

1. Go to the home page of your space.
2. Choose Tools > Watch.

You are now watching the current page and Confluence will notify you about any updates made or comments added.

Note that Confluence will not notify you about content changes that are due to the output of a macro. For example: The output of the Children macro will change if someone adds a child page. The page containing the Children macro will show the new child page. But the page content itself has not been edited, so no notifications will be sent.

You can stop watching a page or blog post at any time. Simply choose Tools > Stop Watching.

**Step 5. Attach or Import Office Documents if Applicable**

Below are some guidelines on managing your existing Microsoft Office documents in Confluence. You can choose to attach them to a Confluence page, so that team members can view and access them in Confluence, and edit them in Office. Or you can import the documents into Confluence, converting the content to Confluence pages.

**Attaching Office Documents to a Page**

You can use Confluence as a central repository for your team's Office documents. This means that you can share your Office documents without having to email them to your teammates. People can view the Office documents even if they do not have Office installed on their computers.
1. Go to a page in your space.
2. Choose Tools > Attachments.
3. Use one of the following methods for attaching files to the page:
   - Choose Browse and to locate the file on your computer, enter a comment then choose Attach
   - Alternatively, drag and drop one or more file(s) directly onto the 'Drop files here' region of the attachments screen. The 'Attach File(s)' message box appears, indicating the upload status of the file(s) being attached to your page.

Importing Existing Word Documents into Confluence

You can also import content from Microsoft Word into Confluence, so that it becomes a Confluence page. See Importing a Word Document into Confluence for a full description.
1. Go to your space homepage.
3. Choose **Browse** and locate the Office document on your local drive or network.
4. Choose **Next**. The import document options screen will display.

![Import Word Document: Configuration](image)

5. Choose how you would like the Office Connector to import the file:
   - **Root page title** – This will be the title of the page.
   - **Import as a new page in the current space** – This option specifies that a new page will be created with the title specified.
   - **Rename imported pages if page name already exists** – This is what Confluence will do if there is a conflict.
   - **Split by heading** – If your document contains headings, Confluence can use the heading information to split the document into multiple wiki pages. If you do not want to split your document leave the default ‘Don’t split’ option selected.

6. Choose **Import**.

When the upload has finished, the content of the Office document will have been transformed into Confluence page content. You can now view and edit this page in the normal way, using the Confluence editor. There is now no connection between the original Office document and this page.

**Step 6. Import Page Templates**

In order for an intranet to be effective, people need to use it. One way to spur new user adoption is to provide your team mates with templates so that they can focus more on content creation and less on page format. You can create your own templates or download some from the [Atlassian Marketplace](https://marketplace.atlassian.com). See **Importing Templates** and **Adding a Template** for a more information. In this example we have downloaded some HR related templates from [Atlassian Marketplace](https://marketplace.atlassian.com).
1. Log in to Confluence as an administrator.

2. Choose the cog icon at top right of the screen, then choose Confluence Admin.

3. Choose Import Templates. The 'Import Templates' screen will appear, listing the template packages deployed to your Confluence instance (for example, 'Human Resources Templates') and the templates included in each package.

4. Select the templates you want to import.
   Note: You can view a preview of the template by clicking the template name.

5. Choose the destination to Import To. If you want the templates to be available to your Intranet space only, select the name of the space, otherwise select 'Global Templates' to make the templates available to all spaces.

6. Choose Import to import the selected templates.

Creating a page from a template

Now that you have made some templates available to your site or space, other Confluence users will be able to choose a template when they want to create a page. Templates appear in the Create dialog for users to select when creating a new page.
1. Go to your Intranet space.
2. Choose Create on the header. Available templates will be listed in the Create dialog.
3. Select a template and choose Next.

4. If the template contains variables, a form will appear. Type the relevant information into the form fields, and choose Next.
5. Enter a title for the page, update the content and choose Save.

Step 7. Set Up your Personal Space

Now that you have created a space for your team, let's create your personal space. This is a place where you can publish your own pages and blog posts. Once you have created it, Confluence users can reach your personal space by clicking your name in the People Directory or by searching for your name via the quick navigation search box.

1. Choose your profile picture at top right of the screen, then choose Add Personal Space.
2. Enter a few details about your space:
   - Choose who can view content.
   - Choose who can contribute (create and edit) content.
   - Choose the 'Global Look and Feel' for your personal space.
3. Choose Create.
4. The 'Home' page for your new space is displayed.

Step 8. Publish a Blog Post

Blog posts are a good way of letting your team mates and the company know your news. People can blog about product and strategic ideas, team updates, and things they want to get ideas about. New employees can write blog posts introducing themselves. People write about getting married or the birth of a child. Blog posts are a great way for people to share their visions, get to know their co-workers and start lively discussions.

Remember to set your email notifications to alert you about the blog posts published within Confluence, as described in an earlier step.

See Working with Blog Posts for a full description of adding, editing, viewing and linking to blog posts.
1. Go to a page in your space.
2. Choose Create in the header.
3. Select Blog then choose Next.
4. Add a title and some content.
5. Choose Save to publish your blog post.

Related Topics

Creating a Space
Global Permissions Overview
Assigning Space Permissions
Setting a Page's Restrictions
Users and Groups

Confluence Administrator's Guide

About this document

The Confluence administrator's guide provides information on how to manage and configure your Confluence site. For people just getting started, we offer the guide to Getting Started as Confluence Administrator.

Would you like a full list of the pages in this guide? Here it is: Table of Contents for Confluence Administrator's Guide.

If you still have a question that has not been answered, please ask us.

Downloads

You can download the Confluence documentation in PDF, HTML and XML formats.

More resources

Do you want to install or upgrade Confluence? See the Confluence Installation and Upgrade Guide. Or visit the Confluence User's Guide for information on how to use Confluence as a collaborative tool. You can find a list of further resources at the Confluence Documentation home page.
In this guide

- Getting Started as Confluence Administrator
- Managing Confluence Users
- Managing Add-ons and Macros
- Customising your Confluence Site
- Integrating Confluence with Other Applications
- Managing your Confluence License
- Managing Confluence Data
- Configuring a Confluence Environment
- Configuring Confluence
- Operating Large or Mission-Critical Confluence Installations

Getting Started as Confluence Administrator

This page is an introduction for people just starting out as Confluence administrators. You will find this page useful if your Confluence site is brand new, or you are learning to administer an existing site.

Confluence is a Java-based web application. For the supported environments, there is an installer that will set up an application server and copy the application files to the designated directories on your server machine. If you prefer, you can install Confluence from a zip file. See the Confluence Installation Guide for details.

On this page:
- How to administer and configure Confluence
- Getting started on a new Confluence site
- Getting to know an existing Confluence site
- Prompts from Confluence itself

Related pages:
- Getting Help and Support
- Confluence Administrator's Guide

⚠️ Some functionality described on this page is restricted in Confluence OnDemand.

Diagram: A Confluence installation
How to administer and configure Confluence

After installing Confluence, you will perform the initial configuration via a web interface called the Confluence Setup Wizard.

Introducing the Confluence Administration Console: From this point onwards, many of the administrative functions are available from the Confluence Administration Console, which is part of the Confluence web interface. If you have administrative permissions, you will have access to the Confluence Administration Console via your web browser, using the standard Confluence URL for your site.

To access the Confluence Administration Console:

1. Open your Confluence URL in your web browser.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.

For further configuration options, you can edit the XML and properties files that are part of your Confluence installation directory. To get started, take a look at the important directories and files. The Confluence administration guide will lead you through tasks such as configuring the log files and configuring system properties. Not applicable to Confluence OnDemand.

Getting started on a new Confluence site

Is this a new Confluence site? Here are some things to get started with:

- Decide whether you want to allow public (anonymous) access to your site. See Setting Up Public Access.
- Make sure you have set up an email server. The above task list will include this step, but it is worth mentioning it here again. Email notifications are an important part of collaborating on Confluence. See Configuring a Server for Outgoing Mail. Not applicable to Confluence OnDemand.
- Add a space and some content. See Setting up a New Sitel Space.
- Decide whether you will manage your users in Confluence or hook up an external LDAP directory. See Configuring User Directories. Not applicable to Confluence OnDemand.
- Invite some users to your site. See Adding and Inviting Users.

Now you can continue getting to know your site, as described in the next section.

Getting to know an existing Confluence site
Has the site been around a while, but you are new to Confluence administration? Take a look at these topics:

- Understand the Confluence permission scheme. See Giving People Access to Content.
- Get to know the power of add-ons (also called plugins), for extending and customising your Confluence site. See About Add-ons.
- Investigate more ways of customising Confluence. See Customising your Confluence Site.

Now you are ready to dive into the Confluence Administrator's Guide.

Prompts from Confluence itself

When you go to your Confluence Administration Console, you will see a handy list of tasks that need doing.

Screenshot: The Confluence Administration Console, showing a list of tasks that need doing – these tasks are specific to your site, and those shown below are examples only

Managing Confluence Users

A Confluence user is a person who can read or update a Confluence site. You can choose whether your Confluence site is accessible to anonymous users (people who have not logged in) or only to logged-in users. See Setting Up Public Access.

Confluence user management

You can add users to Confluence, and then assign them permissions that determine their access to the content and administrative functions in your Confluence site. You can also collect users into groups, and assign the permissions to groups for easier management. See the following topics:
Confluence 5.0 Documentation

- Adding and Inviting Users
- Removing or Deactivating Users
- Searching For and Administering Users
- Managing Site-Wide Permissions and Groups

By default, Confluence stores its users and groups in the Confluence database. This is called the internal directory. You can choose to connect Confluence to an external userbase instead, such as Microsoft Active Directory or another LDAP server. You can also use Atlassian Crowd and JIRA as directory managers. When you add a user or group to Confluence, it will be added to the external directory too, based on your configuration options. See Configuring User Directories. *Not applicable to Confluence OnDemand.*

On this page:
- Confluence user management
- Authentication
  - Seraph
  - XML-RPC and SOAP authentication
  - Password authentication
- Earlier user management frameworks

Related pages:
- Configuring Confluence Security
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Authentication

Seraph

Almost all authentication in Confluence (and JIRA) is performed through Seraph, Atlassian's open source web authentication framework. The goal of Seraph is to provide a simple, extensible authentication system that we can use on any application server.

Seraph is implemented as a servlet filter. Its sole job is, given a web request, to associate that request with a particular user (or no user if the request is anonymous). It supports several methods of authentication, including HTTP Basic Authentication, form-based authentication, and looking up credentials already stored in the user's session.

Seraph itself performs no user management functions. It merely checks the credentials of the incoming request and delegates any user management functions (looking up a user, checking a user's password) to Confluence's user management system.

If you want to integrate Confluence with your own single sign-on (SSO) infrastructure, you would do so by installing Atlassian Crowd or by writing a custom Seraph authenticator. See our developer documentation on [Atlassian Crowd](https://developer.atlassian.com/cloud/idm/) or [custom Seraph authenticators](https://developer.atlassian.com/cloud/idm/seraph-authenticators/).

XML-RPC and SOAP authentication

Normally, requests for Confluence's remote API will include an authentication token as the first argument. With this method of authentication, XML-RPC and SOAP authentication requests are checked directly against the user management framework, and tokens are assigned directly by the remote API subsystem. These requests do not pass through Seraph authenticators.

However, if the token argument is blank, Seraph will be used as a fallback authentication method for remote API requests. So, to use a custom Seraph authenticator with XML-RPC or SOAP requests, ensure that you pass an
empty string as the authentication token to remote API methods.

**Password authentication**

By default, password authentication is delegated from Seraph to the user management system. This is not necessary, however. Single sign-on systems may have no password authentication at all, and get all the necessary credentials from the SSO provider.

**Earlier user management frameworks**

- **Atlassian-User – now behind the scenes.** Atlassian-User is a user and group management framework developed by Atlassian. It provides user, group and profile management services to Confluence. In earlier versions of Confluence, you needed to configure your user directories by editing the `atlassian-user.xml` file directly. In Confluence 3.5 and later this is no longer necessary, nor is it possible. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework. Refer to the **Confluence 3.5 Upgrade Notes** for details of the automatic migration that will occur during the upgrade process. **Not applicable to Confluence OnDemand.**

- **OSUser – obsolete.** OpenSymphony User was Confluence’s core user management framework before Atlassian-User. Please refer to the documentation for Confluence 3.4 or earlier, if you need details of this framework.

**Adding and Inviting Users**

There are a number of ways to add users to Confluence:

- **By user signup:** If user signup is enabled on your Confluence site, people can add themselves as users of the site. See below.

- **Via an invitation link:** You can invite people to sign up, by sending them an invitation link. You can copy and paste the link, or prompt Confluence to send the link in an email message. See below.

- **By adding users manually:** Administrators with Confluence Administrator or System Administrator permissions can add new users. See below.

- **Via an external user directory:** See Configuring User Directories. **Not applicable to Confluence OnDemand.**

You may also be interested in information about allowing anonymous users access to your site. Anonymous users do not count against your Confluence license totals. See **Setting Up Public Access.**

**Note:** If you are using Confluence OnDemand with multiple applications, please refer to the following guide for information on adding and inviting users: Managing Users and Groups.

**Allowing user signup**

If you enable user signup, a 'Sign Up' option will appear on the Confluence screens. The option will be on the login screen, and also in the header on public sites. People can choose the option to create their own usernames on Confluence.

You can restrict the signup to people whose email addresses are within a given domain or domains. This is useful if you want to ensure that only people within your organisation can add their own usernames.

You will still be able to add or invite users manually, whether user signup is enabled or not.

You need Confluence Administrator or System Administrator permissions to change the signup options.

**To set the user signup options:**

1. Choose Invite Users on the dashboard, then choose User Signup Options.

Or take the longer route: Choose the cog icon at top right of the screen, then choose Confluence.
Admin. Then choose Users > User Signup Options.

2. Choose Allow people to sign up to create their account.

3. Choose one of the following options:
   - **Restricted by domain(s)** – Note: You need to set up a mail server for Confluence before you can configure domain restricted signup. When you choose this option, a text box will appear. Enter one or more domains, separated by commas. People will only be able to sign up if their email address belongs to one of the domains specified here. Confluence will send the person an email message, asking them to click a link to confirm their email address. For example: mydomain.com, mydomain.net
   
   - **No restrictions** – Anyone will be able to sign up to Confluence. Confluence will not send any email message requesting confirmation.

4. Choose Notify administrators by email when an account is created if you want Confluence to send an email message to all administrators (people with Confluence Administrator or System Administrator permissions) every time someone signs up to Confluence.

On this page:
- Enabling and disabling notifications about user signup
- Inviting people to sign up
- Resetting the invitation link
- Adding users manually
- Notes

Related pages:
- Managing Confluence Users
- Setting Up Public Access
- Configuring a Server for Outgoing Mail (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Enabling and disabling notifications about user signup

By default, Confluence will send an email notification to all Confluence administrators whenever someone signs up to the Confluence site. The administrators (people with Confluence Administrator or System Administrator permissions) will receive this message when someone signs up either by clicking the 'Sign Up' link or by clicking the invitation URL sent by an administrator.

To disable this notification:

1. Choose Invite Users on the dashboard, then choose User Signup Options.

   Or take the longer route: Choose the cog icon at top right of the screen, then choose Confluence Admin. Then choose Users > User Signup Options.

2. Remove the tick from Notify administrators by email when an account is created.

3. Choose Save.

Screenshot: User signup options
Inviting people to sign up

You can invite new users to the site by sending them a signup URL, called an 'invitation link'. You can copy the invitation link and paste it onto a page or into an email message, or you can prompt Confluence to send an email message containing the same link.

The option to send invitations is independent of the signup options. You can send invitations if signup is open to all, restricted by domain, or disabled entirely. Even if signup is disabled, a person who has received an invitation will be able to sign up.

When someone visits the invitation link in a browser, a Confluence signup screen will appear.

To invite people to sign up:

1. Choose Invite Users on the dashboard.
   Or take the longer route: Choose the cog icon at top right of the screen, then choose Confluence Admin. Then choose Users > Invite Users.
2. Copy the Invitation Link and paste it into an email message, or onto a page on your intranet, for example.
3. Alternatively, prompt Confluence to send an email message for you:
   - Enter one or more email addresses in the field labelled Email To. Separate the addresses with commas. For example: john@example.com, sarah@example.com
   - Optional: Change the Message if you want to.
   - Choose Send.

Resetting the invitation link

The invitation link includes a security token, like this:

```plaintext
http://confluence.example.com/signup.action?token=d513a04456312c47
```

This security token is a shared token – individual invitations do not have unique tokens. Anyone who obtains this
token will be able to sign up to Confluence.

You can change the token at any time, by choosing **Reset**. The previous invitation link will become unusable. People will no longer be able to use the previous link to sign up. If they try, they will see an error message that the signup token has expired.

*Screenshot: Inviting users*

Adding users manually

**To add a new user:**

1. Choose **Invite Users** on the dashboard, then choose **Add Users**.
   
Or take the longer route: Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**. Then choose **Users > Add Users**.
2. Enter the user's details: username, name, password, and email address.
3. Choose whether Confluence should send an **email** message informing the person of their new username. The email message will contain a link that the person can use to reset their password.
4. Choose **Create**.

*Screenshot: Adding users*
Notes

- **Multiple directories.** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories. *(Not applicable to Confluence OnDemand.)*

- **Email server required for domain restricted signup and for invitations.** You need to set up a mail server for Confluence, before you can configure domain restricted signup or send email invitations to users.

- **Are the user management options not visible?** If you have external user management turned on, internal user management is disabled. To configure external user management, go to Browse > Confluence Admin > Security Configuration. See Disabling the Built-In User Management. *(Not applicable to Confluence OnDemand.)*

- **Confluence OnDemand:** If you are using Confluence OnDemand with multiple applications, please refer to the following guide for information on adding and inviting users: Managing Users and Groups.

**Removing or Deactivating Users**

If you are a Confluence Administrator, you can remove and deactivate users.

You can **remove** a user from Confluence if they have not yet added or edited any content on the site. Such content includes pages and blog posts, and edits and comments on existing pages.

You can **deactivate**, or disable, a user, including one who has contributed content.

- Deactivated users can no longer log in to Confluence.
- Deactivating a user will not remove the content created by them.
Deactivated users do not count towards your license count. (See the notes below.)

Related pages:
- Managing Confluence Users
- Configuring User Directories (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

To remove a user:

1. Go to the user's profile and choose **Administer User**.
2. Choose **Remove**.

To deactivate a user:

1. Go to the user's profile and choose **Administer User**.
2. Choose **Disable**.

**Screenshot: Administering a user**

**View User: ewan**

- **Back to Users**
- **User: ewan**
- **Full Name: Ewan User**
  - **Email:** sample@email.com.au
- **Directory: Confluence Internal Directory**
- **Created:** Feb 12, 2013 10:59
- **Last Updated:** Feb 12, 2013 10:59
- **Login:** Last Login: Feb 18, 2013 13:37 Last Failed Login: Feb 15, 2013 16:18
  - **Total Failed Login Count:** 1 **Current Failed Login Count:** 0
- **Groups:**
  - confluence-users
  - developers
- **View Profile** · **Edit Groups** · **Edit Details** · **Set Password** · **Remove** · **Disable**

**Notes**

- The **Administer User** link is only visible if you are logged in as an administrator.
- You can also remove or disable users using the **Administration Console**.
- You can edit the **groups** that a user belongs to, to change their permissions without completely preventing their access to Confluence.
- **Multiple user directories:** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence **internal directory** and also connect to an **LDAP** directory server. In such cases, you can define the **directory order** to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:
The order of the directories is the order in which they will be searched for users and groups. Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories. (Not applicable to Confluence OnDemand.)

- **Number of users and your license**: The Confluence 'License Details' screen tells you how many users your Confluence instance is licensed to support, and how many are currently registered. See Viewing and Editing License Details. The number of registered users includes only users who have the 'Can Use' global permission. Deactivated users, as described above, are not included. Choose Refresh to make sure you see the latest count.

### Searching For and Administering Users

If you have Confluence Administrator permissions, you can view users, edit their user details, reset their passwords, and assign them to groups.

#### Accessing the user management screen

There are two ways to do this.

**Option 1: Administer a known user:**

- Go to a user's profile
- Choose Administer User.

**Option 2: Find the user first:**

- Choose the cog icon at top right of the screen, then choose Confluence Admin.
- Choose Users in the left-hand panel.
- The 'Users' screen appears. You can now list all users or search for a specific user.

#### Listing all users

**To list all users:**

1. Choose Show all users. All members of the confluence-users group are listed in alphabetical order, by username. If there are more users than can fit on one page, the results will be divided into multiple pages.
2. To move to another page of results, choose the numbered links, Next or Previous near the top or bottom of the page.
3. To specify how many results should be shown per page, choose a number 10, 20, 50 or 100 near the top of the page.

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.
Using the simple user search

To search for a user via the simple user search:

1. If the Simple link is showing, choose it. (If you see the ‘Advanced’ link and no ‘Simple’ link, then the simple search is already active.)
2. Type some information about the user into the ‘Find User’ text box. You can type all or part of their username, full name or email address.
3. Choose Search.
4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

Using the advanced user search

The advanced user search allows you to specify the field in which your search term appears: username, full name or email address. This is useful if you need to limit the number of users appearing in the search results.

To search via the advanced user search:

1. If the Advanced link is showing, choose it. (If you see the ‘Simple’ link and no ‘Advanced’ link, then the advanced search is already active.)
2. Complete one or more of the following fields:
   - Username — Enter all or part of the person's username. This is their login ID, such as 'joe', or 'bloggs'.
   - Full Name — Enter all or part of the person's name. For example, 'joe bloggs', or 'bloggs', or 'joe'.
   - Email — Enter all or part of the person's email address. For example, 'acme'.
3. Choose Search.
4. Confluence will display a list of matching users. Click the link on a username to see and edit the details for that user.

Notes

- **Multiple user directories**: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories. (Not applicable to Confluence OnDemand.)

- **Crowd and the user search**: If you are using Atlassian’s Crowd for user management, you will need Crowd 1.5.1 or later to use the ‘Simple’ option in the user search. If your version of Crowd does not support the simple user search, you will see only the ‘Advanced’ search form.

_Screenshot: The user management screen_
Editing User Details

You need Confluence administrator permissions to be able to edit the details of a user. The details include the person's name, password, email address, group membership, and ability to access Confluence.

To update a user's details:

1. First, go to the user management screen for the user concerned. There are two ways to do this:
   - Either,
     - Go to the user's Profile and click the 'Administer User' link on the user's profile screen.
   - Or, Choose the cog icon at top right of the screen, then choose Confluence Admin.
     - Select the link 'Manage Users' in the left-hand panel.
     - Locate the user by doing a search on the username or the groups to which they belong.
     - Click the user link.

2. Now you should be able to see the user's current details and links allowing you to edit them.
   - View Profile — View the user's profile.
   - Edit Groups — Add or remove this user from a group.
   - Edit Details — Change details such as the user's name, email address, contact details and team or department information.
     Changing a user's username is not supported. See Changing Usernames for information. (Not applicable to Confluence OnDemand.)
   - Set Password — Edit the user's password details.
   - Remove — You can remove a user permanently if the user has not added or edited any content on the site.
   - Disable — You can disable (i.e. deactivate) access for a user who has already added or edited any content on the site.

Screenshot: User details
Notes

Multiple user directories: You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories. (Not applicable to Confluence OnDemand.)

Resetting the Login Count for a User

Confluence records the number of failed logins attempts made against each user account. When the login attempts exceed a preset number, the user will prompted to authenticate using CAPTCHA until they successfully log in.

If you are a Confluence Administrator, you can manually set the failed login count for a user back to zero.

To reset the failed login count for a user:
1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Manage Users in the left-hand panel.
3. Search for the required user and click the user in the search results. The 'View User' screen will appear.
4. Choose Reset Failed Login Count for the user. The 'Current Failed Login Count' will be reset to 0.

Related pages:
- Configuring Captcha for Failed Logins (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

⚠ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Screenshot: Resetting the failed login count for a user

Changing Usernames

A username is the name used to log into Confluence, eg. jsmith.

⚠ Currently, there is no straightforward method for changing a username and its associated content, to that of another user. The only practicable method currently available is to execute direct SQL queries on your database. There is a feature request to facilitate this process via a web interface and you can vote for it to improve its chances of being implemented. Be aware, however, that no matter what method you use to change usernames in Confluence, there is no support provided for this process. The instructions below provide suggested guidelines on how to change a username via SQL queries, although this may vary depending on your database.

⚠ The information on this page does not apply to Confluence OnDemand.

Instructions For Changing Usernames

⚠ This document is for use with 3.5 or later. If using an earlier version, please see the 3.4 version of the page.
The following SQL commands are only tested for MySQL and PostgreSQL Databases. If you have any other database please contact your DBA to determine the equivalent queries.

Usernames can only be changed through direct update to the Confluence database.

1. If you have a database administrator, request that they approve the database-related steps described below
2. If you are using JIRA user management, Revert from JIRA To Internal User Management
3. Backup Confluence
4. If you are using MySQL, make sure you are not running in safe updates mode:
   
   ```sql
   set sql_safe_updates=0;
   ```

5. Create a `usermigration` table:
   
   ```sql
   create table usermigration
   {
   oldusername varchar(255),
   newusername varchar(255)
   }
   ```

6. Usernames that will be changed must be placed in the `usermigration` table with their current and planned usernames:
   
   ```sql
   insert into usermigration (oldusername, newusername)
   values ('oldusername', 'newusername');
   ```

7. Run the following SQL commands:
   a. If you have command line access to your database, download the scripts for PostgreSQL or MySQL then run them against your database:
      
      **PostgreSQL**
      
      ```bash
      $ psql -f PostgreSQLChangeUsernames.sql your_database_name
      ```

      **MySQL**
      
      ```bash
      $ mysql your_database_name < MySQLChangeUsernames.sql
      ```

   b. Otherwise, run the following:
      
      i. If your DB administration tool does not support multiple SQL queries, these must be entered individually:
         
         **PostgreSQL**
         
         ```sql
         update attachments
         set creator = newusername from usermigration u
         where creator = u.oldusername;
         
         update attachments
         set lastmodifier = newusername from usermigration u
         where lastmodifier = u.oldusername;
         ```
update content
set creator = newusername from usermigration u
where creator = u.oldusername;

update content
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update content
set username = newusername from usermigration u
where username = u.oldusername;

update content_label
set owner = newusername from usermigration u
where owner = u.oldusername;

update content_perm
set creator = newusername from usermigration u
where creator = u.oldusername;

update content_perm
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update content_perm
set username = newusername from usermigration u
where username = u.oldusername;

update cwd_user
set lower_user_name = lower(newusername) from usermigration u
where lower_user_name = lower(u.oldusername);

update cwd_user
set user_name = newusername from usermigration u
where user_name = u.oldusername;

update extrnlnks
set creator = newusername from usermigration u
where creator = u.oldusername;

update extrnlnks
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update follow_connections
set followee = newusername from usermigration u
where followee = u.oldusername;

update follow_connections
set follower = newusername from usermigration u
where follower = u.oldusername;

update label
set owner = newusername from usermigration u
where owner = u.oldusername;

update links
set creator = newusername from usermigration u
where creator = u.oldusername;

update links
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;
update notifications
set creator = newusername from usermigration u
where creator = u.oldusername;

update notifications
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update notifications
set username = newusername from usermigration u
where username = u.oldusername;

update pagetemplates
set creator = newusername from usermigration u
where creator = u.oldusername;

update pagetemplates
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update remembermetoken
set username = newusername from usermigration u
where username = u.oldusername;

update spacegroups
set creator = newusername from usermigration u
where creator = u.oldusername;

update spacegroups
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update spacepermissions
set creator = newusername from usermigration u
where creator = u.oldusername;

update spacepermissions
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update spacepermissions
set permusername = newusername from usermigration u
where permusername = u.oldusername;

update spaces
set creator = newusername from usermigration u
where creator = u.oldusername;

update spaces
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

update trackbacklinks
set creator = newusername from usermigration u
where creator = u.oldusername;

update trackbacklinks
set lastmodifier = newusername from usermigration u
where lastmodifier = u.oldusername;

**MySQL**

```
update ATTACHMENTS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update ATTACHMENTS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update CONTENT a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update CONTENT_LABEL a, usermigration u
set a.owner = u.newusername
where a.owner = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update CONTENT_PERM a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update CWD_USER a, usermigration u
set a.lower_user_name = LOWER(u.newusername)
where a.lower_user_name = LOWER(u.oldusername);

update CWD_USER a, usermigration u
set a.user_name = u.newusername
where a.user_name = u.oldusername;

update EXTRNLNKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update EXTRNLNKS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update FOLLOW_CONNECTIONS a, usermigration u
set a.followee = u.newusername
where a.followee = u.oldusername;
```
update FOLLOW_CONNECTIONS a, usermigration u
set a.follower = u.newusername
where a.follower = u.oldusername;

update LABEL a, usermigration u
set a.owner = u.newusername
where a.owner = u.oldusername;

update LINKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update LINKS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update NOTIFICATIONS a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update PAGETEMPLATES a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update PAGETEMPLATES a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update REMEMBERMETOKEN a, usermigration u
set a.username = u.newusername
where a.username = u.oldusername;

update SPACEGROUPS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update SPACEGROUPS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update SPACEPERMISSIONS a, usermigration u
set a.permusername = u.newusername
where a.permusername = u.oldusername;

update SPACES a, usermigration u
set a.creator = u.newusername

where a.creator = u.oldusername;

update SPACES a, usermigration u
set a.lastmodifier = u.newusername
where a.lastmodifier = u.oldusername;

update TRACKBACKLINKS a, usermigration u
set a.creator = u.newusername
where a.creator = u.oldusername;

update TRACKBACKLINKS a, usermigration u
set a.lastmodifier = u.newusername
ii. Reassign user preferences in the \texttt{OS\_PROPERTYENTRY} table. Usernames in the \texttt{OS\_PROPERTYENTRY} table need to be prefixed with 'CWD_'.

\textbf{PostgreSQL}

\begin{verbatim}
update os_propertyentry
set entity_name = 'CWD_' || newusername from usermigration u
where entity_name = 'CWD_' || u.oldusername;
\end{verbatim}

\textbf{MySQL}

\begin{verbatim}
update OS\_PROPERTYENTRY a, usermigration u
set a.entity_name = concat('CWD_', u.newusername)
where a.entity_name = concat('CWD_', u.oldusername);
\end{verbatim}

iii. Reassign personal spaces and settings associated with the old username to the new username. The tilda ($\sim$) is required as it is prepended to the space key of all personal spaces:

\textbf{PostgreSQL}

\begin{verbatim}
update spaces
set spacekey = '~' || newusername from usermigration u
where spacekey = '~' || u.oldusername;

update bandana
set bandanacontext = '~' || newusername from usermigration u
where bandanacontext = '~' || u.oldusername;
\end{verbatim}

\textbf{MySQL}

\begin{verbatim}
update SPACES a, usermigration u
set a.spacekey = concat('~', u.newusername)
where a.spacekey = concat('~', u.oldusername);

update BANDANA a, usermigration u
set a.bandanacontext = concat('~', u.newusername)
where a.bandanacontext = concat('~', u.oldusername);
\end{verbatim}

8. Each username is associated with a full name. For example, username 'jsmith' may have a full name of 'John M Smith'. If this fullname needs to be changed, modify the \texttt{first\_name}, \texttt{lower\_first\_name}, \texttt{last\_name} and \texttt{lower\_last\_name} in the \texttt{cwd\_user} table. Ensure the \texttt{lower\_columns} are merely copies of their normal counterparts but with all letters in lower case. Then modify the \texttt{display\_name} and \texttt{lower\_display\_name} columns so that they are the \texttt{first\_name} and \texttt{last\_name} columns or the \texttt{lower\_first\_name} and \texttt{lower\_last\_name} columns put together but separated by a space.

\textbf{Rebuild the Indexes}

After all the updates, it's necessary to Rebuild the Indexes from Scratch
All old usernames in Confluence should now be replaced with the new usernames from the `usermigration` table.

**RELATED TOPICS**

- Giving People Access to Content
- Searching For and Administering Users
- Changing Usernames
- Editing User Details
- Disabling the Built-In User Management
- Adding and Inviting Users
- Global Groups Overview
- Adding or Removing Users in Groups
- Setting Up Public Access
- Global Permissions Overview
- Removing or Deactivating Users

Use this document if you are unable to log in to Confluence as administrator. The most common reason for using these instructions is if you have lost the administration password for your Confluence site.

**Before you Start**

Please note the following before you start:

- The following instructions include example SQL that should work on MySQL and PostgreSQL. You may need to customise the queries for other databases or for your installation.
- We strongly recommend testing the queries on a test database before modifying your production database.

New user management in Confluence 3.5 and later

- Confluence now uses the `CWD_USER` table in the database to store and refer to its users.
- During an upgrade from Confluence 3.4.9 or earlier, the upgrade process copied the users from the `OS_USER` table (for upgrades from versions older than 2.7) or the `USERS` table (for versions 2.7 to 3.4) into the `CWD_USER` table.
- The new user management framework also introduced user directories. Making modifications to users in the database will only fully work for users in Confluence's Internal Directory. The instructions below include extra steps for instances in which the user management has been delegated to external sources (via LDAP, Crowd or JIRA).

Please refer to the older documentation if you are still using OSUser or AtlassianUser.

**Using Crowd for SSO**

- If Confluence is configured for SSO through Crowd, you will only be able to authenticate as users from the Crowd server.
- This document covers how to recover administration rights from the local 'Confluence Internal Directory' only. However, you will not be able to authenticate as a local Confluence administrator while Crowd SSO is enabled. Please refer to Integrating Crowd with Atlassian Confluence for details on how to configure or disable Crowd SSO.
On this page:
- Before you Start
- Step 0. Get access to the database
- Step 1. Identify Administrator
- Step 2. Replace Administrator Password
- Step 3. Put the Internal Directory in First Position
- Step 4. Clean Up
- Notes

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Step 0. Get access to the database

If you are using the embedded HSQL database, you can find the files containing your database in `<confluence-home-directory>/database`. When you shut down Confluence, the SQL will be written to a `.script` or `.log` file in that directory to which you can append the SQL described below.

If you are using a proper production database, connect to the database with your normal tools. You will need to have permission to run queries and update data in the database.

Step 1. Identify Administrator

To find out which usernames have admin privileges, connect to your database using a database admin tool such as [DBVisualiser](https://www.dbvisualiser.org/). Please download a database admin tool now if you do not have one installed already. Then connect to your database and retrieve the list of administrator usernames and IDs with:

```
SELECT u.id, u.user_name, u.active FROM cwd_user u
JOIN cwd_membership m on u.id=m.child_user_id
JOIN cwd_group g on m.parent_id=g.id
JOIN cwd_directory d on d.id=g.directory_id
WHERE g.group_name = 'confluence-administrators' and d.directory_name='Confluence Internal Directory';
```

If there are multiple results, choose one ID/username combination to use for the following steps.
If there are no results, skip down to 'If No Local Users Exist' in Step 2.

⚠️ It is important to make sure that the "active" field contains a value of "T". Without this flag trying to authenticate with this user is a non starter.

To set active to true run the following query replacing "<user_name>" with the user name from the previous query

```
UPDATE cwd_user
SET active = 'T'
WHERE user_name = '<user_name>';
```

Step 2. Replace Administrator Password

Confluence does not store passwords in plain text in the database, but uses hashes computed from the original
password. You will need to insert a hash, rather than the plain password, over the existing password in the
database. Below is the hash for the password admin

```
x61Ey612K12gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A==
```

For an External Database

To change the password to admin for a given username:

1. Shut down Confluence.
2. Connect to your database.
3. Run the following SQL:

```
update cwd_user set credential = 'x61Ey612K12gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A=='
where id=<id from Stage 1>;
```

For the Evaluation Embedded HSQL Database

To change the password to admin for a given username:

1. Shut down Confluence.
2. Open <confluence-home>/database/confluencedb.script, or confluencedb.log if the
   .script file looks empty.
3. Search for:

```
INSERT INTO CWD_USER VALUES(
```

Keep searching until you find the appropriate user, then replace their password with the hash value
above.
4. Save the file.
5. Restart Confluence.

If No Local Users Exist

There may be no administrators in your Internal Directory. If this is the case, you need to add one:

1. Add a new admin user by running:

```
insert into cwd_user(id, user_name, lower_user_name, active, created_date, updated_date, first_name, lower_first_name, last_name, lower_last_name, display_name, lower_display_name, email_address, lower_email_address, directory_id, credential) values (1212121, 'admin', 'admin', 'T', '2009-11-26 17:42:08', '2009-11-26 17:42:08', 'A. D.', 'a. d.', 'Ministrator', 'ministrator', 'A. D. Ministrator', 'a. d. ministrator', 'admin@example.com', 'admin@example.com', (select id from cwd_directory where directory_name='Confluence Internal Directory'), 'x61Ey612K12gpFL56FT9weDnpSo4AV8j8+qx2AuTHdRyY036xxzTTrw10Wq3+4qQyB+XURPWx1ONxp3Y3pB37A==');
```

2. Add new groups by running:
3. Add group memberships into cwd_membership:

```sql
insert into cwd_membership(id, parent_id, child_user_id) values (888888, (select id from cwd_group where group_name='confluence-users' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
insert into cwd_membership(id, parent_id, child_user_id) values (999999, (select id from cwd_group where group_name='confluence-administrators' and directory_id=(select id from cwd_directory where directory_name='Confluence Internal Directory')), 1212121);
```

⚠️ If using an Oracle database, use `sysdate` instead of a string for the `created_date` column.

**Step 3. Put the Internal Directory in First Position**

Start Confluence, and try logging in with the username of the user you updated/created and the password 'admin'. If this works, skip to Step 4. Otherwise, your Internal Directory does not have high enough priority.

**To put your Internal Directory in first position:**

1. Find the directory names and their order:

```sql
select d.id, d.directory_name, m.list_index from cwd_directory d join cwd_app_dir_mapping m on d.id=m.directory_id;
```

2. Take note of the ID with list_index 0, and the list_index and ID of the Confluence Internal Directory.

3. Switch the order of the directories:

```sql
update cwd_app_dir_mapping set list_index = 0 where directory_id = <Internal Directory id>;
update cwd_app_dir_mapping set list_index = <Noted Internal Directory list_index> where directory_id = <Directory id that had list_index 0>;
```

4. Check to see if the directory is active (the 'active' column should be set to 'T'):

```sql
select id, directory_name, active from cwd_directory where id = <Internal Directory id>;
```

5. If necessary, activate the directory:
update cwd_directory set active = 'T' where id = <Internal Directory id>;

**Step 4. Clean Up**

To tidy up:

1. Start Confluence.
2. Log in with your modified/created username and use password `admin`.
3. Change your password. **Do not leave your password as admin, or your instance will not be secure.**
4. If you created a new user in Stage 2, create a new admin via the UI and delete the admin you created in Stage 2.
5. If you followed Stage Three, go to Confluence Administration > User Directories and rearrange your directories so they are correctly configured again.

**Notes**

- Learn more about the password hash algorithm Confluence is using.

**Managing Site-Wide Permissions and Groups**

Permissions determine what people can do on your Confluence site. Confluence recognises permissions at site level and at space level, as well as page-level restrictions.

You can create **groups** and allocate people to them, so that you can assign permissions to a number of people at once. For example, it is quicker to give group ‘X’ access to Confluence, rather than giving every team member access individually. You can also set the access levels for **anonymous users**.

```
Related pages:
- Confluence Security Overview and Advisories *(Not applicable to Confluence OnDemand.)*
- Confluence Administrator's Guide
```

**Global Groups Overview**

A group is a collection of users. Administrators create groups so that the administrator can assign permissions to a number of people at once. For example, it is quicker to give group ‘X’ access to Confluence, rather than giving every team member access individually. You need **Confluence Administrator permissions** to view and update groups.

Groups are available at the space and page levels to allow for flexible access control. A user in a group will automatically be granted all permissions granted to the group.

**Special groups**

There are two special default groups in Confluence:

1. **confluence-administrators**: This is a group of ‘super-users’ who can access the Confluence administration screens (‘administration console’) and perform site-wide administration. Members of this group can also see all spaces in the Confluence site. Any user who is a member of this group has site-wide administration powers, regardless of any other setting. The settings on the global permissions screen **do not** affect the powers allowed to members of this group.
2. **confluence-users**: This is the default group for all new users. Permissions you assign to this group will be assigned to all newly signed-up users of Confluence.

**The Confluence Administrator permission and the 'confluence-administrators' group are not related.** Going by the names, you would think the 'confluence-administrators' group and the 'Confluence Administrator' permission are related – but they are not. Granting a user or a group 'Confluence Administrator' permission is **not** the same as granting them membership of the 'confluence-administrators' group. Granting the 'Confluence Administrator' permission allows the user to access the administration screens and perform site-wide administration. For example, this user can view the global permissions screen.
Administrator’ permission enables access to only a subset of the administrative functions. Granting membership to the ‘confluence-administrators’ group gives complete access.

On this page:
- Special groups
- Anonymous users
- Updating groups
- Notes

Related pages:
- Managing Confluence Users
- Global Permissions Overview
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Anonymous users

Confluence treats all users who do not log in when they access Confluence as being ‘anonymous’. You can grant anonymous ‘Use Confluence’ permission via the Global Permissions screen. See Setting Up Public Access. This will allow non-registered users to access pages and spaces in Confluence. A space administrator can further control anonymous access per space via the space permissions.

Updating groups

To add a new group:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Groups in the left-hand panel.
3. Choose Add Group.
4. Enter a name for your group and choose Save.

You are now ready to start adding users to the group.

To remove a group:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Groups in the left-hand panel. You will see a list of all existing groups along with links to remove them.
3. Choose Remove next to the group you want to remove.

Notes

- **Multiple user directories:** You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:
- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

See Managing Multiple Directories. (Not applicable to Confluence OnDemand.)
Adding or Removing Users in Groups

If you are a Confluence Administrator, you can add users and groups, and assign users to groups, in order to determine their permissions.

This page tells you how to add a user to a group or remove a user from a group. For an overview of users and groups, please refer to Users and Groups and Managing Confluence Users.

You can edit group membership in two places:

- From the group management screen.
- From the user management screen for a particular user.

Both methods are described below.

**Adding and removing members via the group management screen**

This is the recommended method. It allows you to manage the group membership for a number of users at the same time.

**To add members to a group:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Groups in the left-hand panel.
3. The 'Groups' screen appears, showing a list of groups. Choose the group to which you want to add users.
4. The 'Group Members' screen appears, showing the users who belong to the selected group. Choose Add Members.
5. Type the username(s) of the people you want to add to the group.
   - If you want to add more than one member, separate the usernames with commas.
   - You can also search for and select users by choosing the search icon, as described in Searching for Users.
6. Choose Add to add the member(s) to the group.

**To remove members from a group:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Groups in the left-hand panel.
3. The 'Manage Groups' screen appears, showing a list of groups. Choose the group from which you want to remove the user.
4. The 'Group Members' screen appears, showing the users who belong to the selected group. (See screenshot below.) Choose the 'Remove user from group' icon next to the user whose group membership you want to remove.

---

**On this page:**

- Adding and removing members via the group management screen
- Editing group membership from the user management screen
- Notes

**Related pages:**

- Managing Confluence Users
- Global Permissions Overview
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.
Editing group membership from the user management screen

You can update a user’s group membership from the user management screen. This functionality allows you to update one user at a time.

To add a user to a group or remove a user from a group:

1. Go to the user management screen for the user concerned. There are two ways to do this:
   - Either,
     - Go to the user’s Profile and choose Administer User on the user’s profile screen.
   - Or, Choose the cog icon at top right of the screen, then choose Confluence Admin.
     - Choose Users in the left-hand panel.
     - The ‘Users’ screen appears. You can now choose to ‘Show all users’ or you can search for a specific user by entering all or part of the person’s username, full name or email address.
     - For more details about the user search, see Searching For and Administering Users.
     - Choose the username you want to edit.
3. Select the group(s) for this user. To remove a user from a group, remove the tick mark in the relevant check box.

Notes

You may define multiple user directories in Confluence, so that Confluence looks in more than one place for its users and groups. For example, you may use the default Confluence internal directory and also connect to an LDAP directory server. In such cases, you can define the directory order to determine where Confluence looks first when processing users and groups.

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission.
Global Permissions Overview

Permissions determine the actions which a user is allowed to perform within Confluence. Global permissions are one of the levels of permission provided by Confluence.

In order to assign these permissions, you must already have the global ‘Confluence Administrator’ or ‘System Administrator’ permission (described below). You can then assign global permissions to groups, individual users and anonymous users. Further permissions are granted from the space administration screens.

The Confluence permission scheme allows the following levels of site administrator permissions, with the most powerful at the top of the list:

- **Super user** – A ‘super user’ belongs to the confluence-administrators group, has full administrative access to Confluence, and can see all the content.
- **System Administrator** – A person with ‘System Administrator’ permission has full administrative access to Confluence.
- **Confluence Administrator** – A person with ‘Confluence Administrator’ permission has access to most of the Confluence administrative functions.

**Note:** The first system administrator and super-user is defined during initial setup. During the initial configuration of Confluence, the Setup Wizard asks for the username of the System Administrator. This user will have the ‘System Administrator’ permission and will be a member of the ‘confluence-administrators’ group.

### On this page:
- Overview of the global permissions
- Comparing the System Administrator permission with the Confluence Administrator permission
- Comparing the confluence-administrators group with the administrator permissions
- Updating global permissions
- Error messages you may see

### Related pages:
- Searching For and Administering Users
- Global Groups Overview
- Confluence Setup Guide (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

⚠️ Some functionality described on this page is restricted in Confluence OnDemand.

### Overview of the global permissions

Global permissions control access across the whole Confluence site. Here is a list:

<table>
<thead>
<tr>
<th>Global Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can Use</td>
<td>This is the most basic permission that allows users to access the site. Users with this permission count towards the number of users allowed by your license. See the information on removing/deactivating users.</td>
</tr>
<tr>
<td>Permission</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Attach Files to User Profile</td>
<td>This allows the user to upload files to be stored in their user profile. This feature was made obsolete by the introduction of personal spaces in Confluence 2.2. Hence, this permission is no longer relevant. Attachments can be accessed from a user profile view (for example, an image within the 'About Me' field of a profile view) by attaching these files to a page within that user's personal space and referencing them using appropriate wiki markup code.</td>
</tr>
<tr>
<td>Update User Status</td>
<td>This allows the user to update their user status message, which can be seen on the user's profile, pages in their personal space and on various activity streams accessible to other Confluence users.</td>
</tr>
<tr>
<td>Personal Space</td>
<td>This permission allows the user to create a personal space.</td>
</tr>
<tr>
<td>Create Space(s)</td>
<td>This permission allows users to create new spaces within your Confluence site. When a space is created, the creator automatically has the 'Admin' permission for that space and can perform space-wide administrative functions.</td>
</tr>
<tr>
<td>Confluence Administrator</td>
<td>This permission allows users to access the 'Administration Console' that controls site-wide administrative functions. Users with this permission can perform most, but not all, of the Confluence administrative functions. See the comparison of 'System Administrator' and 'Confluence Administrator' below.</td>
</tr>
<tr>
<td>System Administrator</td>
<td>This permission allows users to access the 'Administration Console' that controls site-wide administrative functions. Users with this permission can perform all the Confluence administrative functions, including the ones which the 'Confluence Administrator' permission does not allow. See the comparison of 'System Administrator' and 'Confluence Administrator' below. Refer also to the note about the 'confluence-administrators' group below.</td>
</tr>
</tbody>
</table>

**Comparing the System Administrator permission with the Confluence Administrator permission**

Confluence recognises two levels of administrator:

- **System Administrator** – Users with this permission can perform all the Confluence administrative functions, including the ones which the 'Confluence Administrator' permission does not allow.
- **Confluence Administrator** – Users with this permission can perform most, but not all, of the Confluence
The two-tier administration is useful when you want to delegate some administrator privileges to project managers or team leaders. You can give 'Confluence Administrator' permission to users who should be able to perform most administrative functions, but should not be able to perform functions that can compromise the security of the Confluence system.

The following functions are granted to the 'System Administrator' permission but excluded from the 'Confluence Administrator' permission:

<table>
<thead>
<tr>
<th>Administration Screen</th>
<th>Excluded from Confluence Administrator permission</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Server Base URL</td>
</tr>
<tr>
<td></td>
<td>• Remote API plugin</td>
</tr>
<tr>
<td></td>
<td>• Public Signup</td>
</tr>
<tr>
<td></td>
<td>• Connection Timeouts</td>
</tr>
<tr>
<td>Security Configuration</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• External user management</td>
</tr>
<tr>
<td></td>
<td>• Append wildcards to user and group searches</td>
</tr>
<tr>
<td></td>
<td>• Anti XSS Mode</td>
</tr>
<tr>
<td></td>
<td>• Enable Custom Stylesheets for Spaces</td>
</tr>
<tr>
<td></td>
<td>• Show system information on the 500 page</td>
</tr>
<tr>
<td></td>
<td>• Maximum RSS Items</td>
</tr>
<tr>
<td></td>
<td>• XSRF Protection</td>
</tr>
<tr>
<td>Plugins</td>
<td>The following functionality is disallowed:</td>
</tr>
<tr>
<td></td>
<td>• Upgrade</td>
</tr>
<tr>
<td></td>
<td>• Install</td>
</tr>
<tr>
<td></td>
<td>• Confluence Upgrade Check</td>
</tr>
<tr>
<td>Daily Backup Admin</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Mail Servers</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>User Macros</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Attachment Storage</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Layouts</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Custom HTML</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Backup &amp; Restore</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Logging and Profiling</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Cluster Configuration</td>
<td>This function is disallowed entirely.</td>
</tr>
<tr>
<td>Scheduled Jobs</td>
<td>This function is disallowed entirely.</td>
</tr>
</tbody>
</table>
Application Links

People with the ‘Confluence Administrator’ permission can add, modify and remove application links and project links. For example, they can link Confluence to JIRA. However, Confluence administrators can configure only OAuth authentication for application links.

Office Connector configuration

This function is disallowed entirely.

Comparing the confluence-administrators group with the administrator permissions

The ‘confluence-administrators’ group defines a set of ‘super-users’ who can access the Confluence administration console and perform site-wide administration. Members of this group can also see the content of all pages and spaces in the Confluence instance, regardless of space permissions. They cannot immediately see the pages that exclude them via page restrictions without knowing the direct URL to the page. They can remove the page restrictions via the Space Administration screen if need be. For example, they will not see restricted pages displayed by the children macro. But they are able to access restricted pages directly using the page URL.

The settings on the ‘Global Permissions’ screen do not affect the powers allowed to members of the ‘confluence-administrators’ group.

Granting the ‘System Administrator’ or ‘Confluence Administrator’ permission to a user will not automatically grant the user access to all spaces in the site. These permissions will only give access to the administration console.

Be aware, however, that users with ‘System Administrator’ can add themselves to the ‘confluence-administrators’ group and become a super-user.

The Confluence Administrator permission and the ‘confluence-administrators’ group are not related. Going by the names, you would think the ‘confluence-administrators’ group and the ‘Confluence Administrator’ permission are related – but they are not. Granting a user or a group ‘Confluence Administrator’ permission is not the same as granting them membership of the ‘confluence-administrators’ group. Granting the ‘Confluence Administrator’ permission enables access to only a subset of the administrative functions. Granting membership to the ‘confluence-administrators’ group gives complete access.

Updating global permissions

To view the global permissions for a group or user:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Permissions in the left-hand panel. The ‘View Global Permissions’ screen appears.

Add or edit group and user permissions as follows:

To add permissions for a group:

1. First add the group to Confluence, if you have not already done so.
2. Choose Edit Permissions. The ‘Edit Global Permissions’ screen appears.
3. Enter the group name in the Grant browse permission to box in the ‘Groups’ section. You can search for the group name.
4. Choose Add.
5. The group will appear in the list and you can now edit its permissions.

To add permissions for a specific user:

(Consider adding the user to a group and then assigning the permissions to the group, as described above.
instead of assigning permissions to the specific user.)

1. First add the user to Confluence, if you have not already done so.
2. Choose Edit Permissions. The 'Edit Global Permissions' screen appears.
3. Enter the username in the Grant browse permission to box in the 'Individual Users' section. You can search for the username.
4. Choose Add.
5. The username will appear in the list and you can now edit its permissions.

To add or edit the permissions for a user or group:

1. Select, or clear, the check box under the relevant permission in the row for the relevant user/group. A selected check box indicates that the permission is granted.
2. To allow anonymous access to your Confluence site, select the 'Use Confluence' and 'View User Profile' options in the 'Anonymous Access' section.
   For more information about these permissions, refer to Setting Up Public Access.
3. Choose Save All to save your changes.

Screenshot: Editing global permissions

Error messages you may see

Confluence will let you know if there is a problem with some permissions. In rare situations, you may see the following error messages below a permission:

- 'User/Group not found' — This message may appear if your LDAP repository is unavailable, or if the
user/group has been deleted after the permission was created.

- 'Case incorrect. Correct case is: xxxxxx' — This message may appear if the upper/lower case in the permission does not match the case of the username or group name. If you see a number of occurrences of this message, you should consider running the routine supplied to fix the problem.

**Setting Up Public Access**

You can enable anonymous access (also known as public access) to your Confluence site by granting the 'Use Confluence' permission to 'anonymous' users. An 'anonymous' user is someone who has not logged in to the Confluence site. The 'Use Confluence' permission is also called 'can use'.

This user category gives you an easy way to administer users who have not logged into the site. Permissions assigned to this category apply to all anonymous users of the site.

**Enabling anonymous access to the site**

If you want to make your site visible to everyone, including people who have not logged in, you must enable anonymous access at site level.

**To enable anonymous access to your site:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Permissions in the left-hand panel.
3. Choose Edit Permissions.
4. In the ‘Anonymous Access’ section, select the can use check box to enable anonymous access to the content on your site.
5. If you want to allow anonymous users to see user profiles, select the check box in the View User Profiles section.
   
   *Note:* You must grant the 'can use' permission as well, if you want to grant the 'View User Profiles' permission.
6. Choose Save All.

**Disabling anonymous access to the site**

To disable anonymous access to your site, deselect the can use check box, then choose Save All. People will not be able to see the content on the site until they have logged in.

**Granting public access to a space**

To enable public access to a Confluence space, you must grant the following permissions to anonymous users:

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.
• The site-wide 'can use' permission, as described above.
• The relevant space permissions. If you want a space to be publicly accessible, the anonymous user must have at least the 'View Space' permission. To set space permissions, choose Browse > Space Admin > Permissions.

Notes

• We **severely warn against** giving anonymous users any administrative privileges, either within a space, or especially over the Confluence site. Giving administrative privileges to untrusted users may lead to a serious security compromise of your site.
• You can allow people to sign up for usernames themselves, and choose other options for user signup and invitations. See Adding and Inviting Users.

Configuring User Directories

A user directory is a place where you store information about users and groups. User information includes the person's full name, username, password, email address and other personal information. Group information includes the name of the group, the users that belong to the group, and possibly groups that belong to other groups.

The **internal** directory stores user and group information in the Confluence database. You can also connect to **external** user directories, and to Atlassian Crowd and JIRA as directory managers.

- **On this page:**
  - Configuring User Directories in Confluence
  - Connecting to a Directory
  - Updating Directories

| The information on this page does not apply to Confluence OnDemand. |

Configuring User Directories in Confluence

**To configure your Confluence user directories:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'User Directories' in the left-hand panel.

Connecting to a Directory

You can add the following types of directory servers and directory managers:

- Confluence's internal directory. See Configuring the Internal Directory.
- Various other LDAP directory servers. See Connecting to an LDAP Directory.
- An LDAP directory for delegated authentication. See Connecting to an Internal Directory with LDAP Authentication.
- Atlassian Crowd. See Connecting to Crowd or JIRA for User Management.
- Atlassian JIRA 4.3 or later. See Connecting Confluence to JIRA for User Management.
- Atlassian JIRA 4.2 or earlier, using the legacy database connection. See Connecting to JIRA 4.2 or Earlier for User Management.

You can add as many external user directories as you need. Note that you can define the order of the directories. This determines which directory Confluence will search first, when looking for user and group information. See Managing Multiple Directories.

Updating Directories

Limitations when Editing Directories
You cannot edit, disable or remove the directory your user belongs to. This precaution is designed to prevent administrators from locking themselves out of the application by changing the directory configuration in a way that prevents them logging in or removes their administration permissions.

This limitation applies to all directory types. For example:

- You cannot disable the internal directory if your user is an internal user.
- You cannot disable or remove an LDAP or a Crowd directory if your user comes from that directory.

In some situations, reordering the directories will change the directory that the current user comes from, if a user with the same username happens to exist in both. This behaviour can be used in some cases to create a copy of the existing configuration, move it to the top, then remove the old one. Note, however, that duplicate usernames are not a supported configuration.

You cannot remove the internal directory. This precaution aligns with the recommendation below that you always keep an administrator account active in the internal directory.

**Recommendations**

The recommended way to edit directory configurations is to log in as an internal user when making changes to external directory configuration.

⚠️ We recommend that you keep either an administrator or system administrator user active in your internal directory for troubleshooting problems with your user directories.

**Enabling, Disabling and Removing Directories**

You can enable or disable a directory at any time. If you disable a directory, your configuration details will remain but the application will not recognise the users and groups in that directory.

You have to disable a directory before you can remove it. Removing a directory will remove the details from the database.

### Screenshot above: Configuring user directories

**User Directories**

The table below shows the user directories currently configured for Confluence.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Type</th>
<th>Order</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Internal</td>
<td>Internal</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OpEnd DAP</td>
<td>OpEnd DAP (Read-Write)</td>
<td></td>
<td>Disable Edit Synchronise</td>
</tr>
<tr>
<td>Crowd</td>
<td>Atlassian Crowd</td>
<td></td>
<td>Disable Edit Synchronise</td>
</tr>
</tbody>
</table>

**Additional Configuration**

- LDAP Connection Pool Configuration

**RELATED TOPICS**

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
Managing the Internal Directory

The internal directory stores user and group information in the Confluence database.

**Overview**

The internal directory is enabled by default at installation. When you create the first administrator during the setup procedure, that administrator's username and other details are stored in the internal directory.

If needed, you can configure one or more additional user directories. This is useful if you want to grant access to users and groups that are stored in a corporate directory or other directory server.

**On this page:**
- Overview
- Diagram of Possible Configuration

⚠️ The information on this page does not apply to Confluence OnDemand.

**Diagram of Possible Configuration**

![Diagram of Confluence using its internal directory](image)

*Diagram above: Confluence using its internal directory for user management.*

**RELATED TOPICS**

- Configuring User Directories
Connecting to an LDAP Directory

Overview

An LDAP directory is a collection of data about users and groups. LDAP (Lightweight Directory Access Protocol) is an Internet protocol that web applications can use to look up information about those users and groups from the LDAP server.

We provide built-in connectors for the most popular LDAP directory servers:

- Microsoft Active Directory
- Apache Directory Server (ApacheDS)
- Apple Open Directory
- Fedora Directory Server
- Novell eDirectory
- OpenDS
- OpenLDAP
- OpenLDAP Using Posix Schema
- Posix Schema for LDAP
- Sun Directory Server Enterprise Edition (DSEE)
- A generic LDAP directory server

When to use this option: Connecting to an LDAP directory server is useful if your users and groups are stored in a corporate directory. When configuring the directory, you can choose to make it read only, read only with local groups, or read/write. If you choose read/write, any changes made to user and group information in the application will also update the LDAP directory.

Connecting to an LDAP Directory in Confluence

To connect Confluence to an LDAP directory:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click User Directories in the left-hand panel.
3. Add a directory and select one of these types:
   - Microsoft Active Directory – This option provides a quick way to select AD, because it is the most popular LDAP directory type.
   - LDAP – You will be able to choose a specific LDAP directory type on the next screen.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see Managing Multiple Directories.

On this page:
- Overview
- Connecting to an LDAP Directory in Confluence
- Server Settings
- Schema Settings
- Permission Settings
  - Adding Users to Groups Automatically
- Advanced Settings
- User Schema Settings
- Group Schema Settings
- Membership Schema Settings
- Diagrams of Some Possible Configurations
- Notes

Related pages:
- Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

⚠️ The information on this page does not apply to Confluence OnDemand.

Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter a meaningful name to help you identify the LDAP directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Example Company Staff Directory</td>
</tr>
<tr>
<td></td>
<td>• Example Company Corporate LDAP</td>
</tr>
</tbody>
</table>
### Directory Type
Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for many of the options on the rest of screen. Examples:
- Microsoft Active Directory
- OpenDS
- And more.

### Hostname
The host name of your directory server. Examples:
- ad.example.com
- ldap.example.com
- opends.example.com

### Port
The port on which your directory server is listening. Examples:
- 389
- 10389
- 636 (for example, for SSL)

### Use SSL
Tick this check box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.

### Username
The distinguished name of the user that the application will use when connecting to the directory server. Examples:
- cn=administrator,cn=users,dc=ad,dc=example,dc=com
- cn=user,dc=domain,dc=name
- user@domain.name

### Password
The password of the user specified above.

### Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](https://creativecommons.org/licenses/by/2.5/au/).
Base DN

The root distinguished name (DN) to use when running queries against the directory server. Examples:
- `o=example,c=com`
- `cn=users,dc=ad,dc=example,dc=com`
- For Microsoft Active Directory, specify the base DN in the following format: `dc=domain1,dc=local`. You will need to replace the `domain1` and `local` for your specific configuration. Microsoft Server provides a tool called `ldp.exe` which is useful for finding out and configuring the LDAP structure of your server.

Additional User DN

This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN. Example:
- `ou=Users`

Additional Group DN

This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:
- `ou=Groups`

Permission Settings

Note: You can only assign LDAP users to local groups when ‘External Management User Management’ is not selected.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read Only, with Local Groups</td>
<td>LDAP users, groups and memberships are retrieved from your directory server and can only be modified via your directory server. You cannot modify LDAP users, groups or memberships via the application administration screens. However, you can add groups to the internal directory and add LDAP users to those groups.</td>
</tr>
</tbody>
</table>
Read/Write

LDAP users, groups and memberships are retrieved from your directory server. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to your LDAP directory server. Please ensure that the LDAP user specified for the application has modification permissions on your LDAP directory server.

### Adding Users to Groups Automatically

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Default Group Memberships    | *Option available in Confluence 3.5 and later, and JIRA 4.3.3 and later.* This field appears if you select the 'Read Only, with Local Groups' permission. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas.  
*In Confluence 3.5 to Confluence 3.5.1:* Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally.  
*In Confluence 3.5.2 and later, and JIRA 4.3.3 and later:* The first time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added locally. On subsequent logins, the username will not be added automatically to any groups. This change in behaviour allows users to be removed from automatically-added groups. In Confluence 3.5 and 3.5.1, they would be re-added upon next login.  
Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.  
Examples:  
- confluence-users  
- confluence-users, jira-users, jira-developers |

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Use Paged Results</td>
<td>Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.</td>
</tr>
<tr>
<td>Follow Referrals</td>
<td>Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup java.naming.referal) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a 'javax.naming.PartialResultException: Unprocessed Continuation Reference(s)' error.</td>
</tr>
<tr>
<td>Naive DN Matching</td>
<td>If your directory server will always return a consistent string representation of a DN, you can enable naive DN matching. Using naive DN matching will result in a significant performance improvement, so we recommend enabling it where possible. This setting determines how your application will compare DNs to determine if they are equal.</td>
</tr>
</tbody>
</table>

- If this check box is ticked, the application will do a direct, case-insensitive, string comparison. This is the default and recommended setting for Active Directory, because Active Directory guarantees the format of DNs.
- If this check box is not ticked, the application will parse the DN and then check the parsed version.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
</table>
| Enable Incremental Synchronisation           | Enable incremental synchronisation if you only want changes since the last synchronisation to be queried when synchronising a directory. Please be aware that when using this option, the user account configured for synchronisation must have read access to:   
  - The uSNCNChanged attribute of all users and groups in the directory that need to be synchronised.  
  - The objects and attributes in the Active Directory deleted objects container (see Microsoft’s Knowledge Base Article No. 892806 for details).  
If at least one of these conditions is not met, you may end up with users who are added to (or deleted from) the Active Directory not being respectively added (or deleted) in JIRA. This setting is only available if the directory type is set to "Microsoft Active Directory". |
| Synchronisation Interval (minutes)           | Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes. |
| Read Timeout (seconds)                       | The time, in seconds, to wait for a response to be received. If there is no response within the specified time period, the read attempt will be aborted. A value of 0 (zero) means there is no limit. The default value is 120 seconds. |
| Search Timeout (seconds)                     | The time, in seconds, to wait for a response from a search operation. A value of 0 (zero) means there is no limit. The default value is 60 seconds.                                                                 |
| Connection Timeout (seconds)                 | This setting affects two actions. The default value is 0.  
  - The time to wait when getting a connection from the connection pool. A value of 0 (zero) means there is no limit, so wait indefinitely.  
  - The time, in seconds, to wait when opening new server connections. A value of 0 (zero) means that the TCP network timeout will be used, which may be several minutes. |

**User Schema Settings**
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Object Class</td>
<td>This is the name of the class used for the LDAP user object. Example:</td>
</tr>
<tr>
<td></td>
<td>• user</td>
</tr>
<tr>
<td>User Object Filter</td>
<td>The filter to use when searching user objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• {&amp;(objectCategory=Person)(sAMAccountName=*)}</td>
</tr>
<tr>
<td>User Name Attribute</td>
<td>The attribute field to use when loading the username. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td></td>
<td>• sAMAccountName</td>
</tr>
<tr>
<td></td>
<td>NB: In Active Directory, the 'sAMAccountName' is the 'User Logon Name (pre-Windows 2000)' field. The User Logon Name field is referenced by 'cn'.</td>
</tr>
<tr>
<td>User Name RDN Attribute</td>
<td>The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:</td>
</tr>
<tr>
<td></td>
<td>• cn</td>
</tr>
<tr>
<td>User First Name Attribute</td>
<td>The attribute field to use when loading the user's first name. Example:</td>
</tr>
<tr>
<td></td>
<td>• givenName</td>
</tr>
<tr>
<td>User Last Name Attribute</td>
<td>The attribute field to use when loading the user's last name. Example:</td>
</tr>
<tr>
<td></td>
<td>• sn</td>
</tr>
<tr>
<td>User Display Name Attribute</td>
<td>The attribute field to use when loading the user's full name. Example:</td>
</tr>
<tr>
<td></td>
<td>• displayName</td>
</tr>
<tr>
<td>User Email Attribute</td>
<td>The attribute field to use when loading the user's email address. Example:</td>
</tr>
<tr>
<td></td>
<td>• mail</td>
</tr>
<tr>
<td>User Password Attribute</td>
<td>The attribute field to use when loading a user's password. Example:</td>
</tr>
<tr>
<td></td>
<td>• unicodePwd</td>
</tr>
</tbody>
</table>

**Group Schema Settings**
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Object Class</td>
<td>This is the name of the class used for the LDAP group object. Examples:</td>
</tr>
<tr>
<td></td>
<td>- groupOfUniqueNames</td>
</tr>
<tr>
<td></td>
<td>- group</td>
</tr>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td></td>
<td>- (&amp;(objectClass=group)(cn=*))</td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group's name. Example:</td>
</tr>
<tr>
<td></td>
<td>- cn</td>
</tr>
<tr>
<td>Group Description Attribute</td>
<td>The attribute field to use when loading the group's description. Example:</td>
</tr>
<tr>
<td></td>
<td>- description</td>
</tr>
</tbody>
</table>

**Membership Schema Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Members Attribute</td>
<td>The attribute field to use when loading the group's members. Example:</td>
</tr>
<tr>
<td></td>
<td>- member</td>
</tr>
<tr>
<td>User Membership Attribute</td>
<td>The attribute field to use when loading the user's groups. Example:</td>
</tr>
<tr>
<td></td>
<td>-memberOf</td>
</tr>
<tr>
<td>Use the User Membership Attribute, when finding the user's group membership</td>
<td>Put a tick in the checkbox if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)</td>
</tr>
<tr>
<td></td>
<td>- If this checkbox is ticked, your application will use the group membership attribute on the user when retrieving the list of groups to which a given user belongs. This will result in a more efficient retrieval.</td>
</tr>
<tr>
<td></td>
<td>- If this checkbox is not ticked, your application will use the members attribute on the group ('member' by default) for the search.</td>
</tr>
<tr>
<td></td>
<td>- If the 'Enable Nested Groups' checkbox is ticked, your application will ignore the 'Use the User Membership Attribute' option and will use the members attribute on the group for the search.</td>
</tr>
</tbody>
</table>
Use the User Membership Attribute, when finding the members of a group

Put a tick in the checkbox if your directory server supports the user membership attribute on the group. (By default, this is the 'member' attribute.)

- If this checkbox is ticked, your application will use the group membership attribute on the user when retrieving the members of a given group. This will result in a more efficient search.
- If this checkbox is not ticked, your application will use the members attribute on the group ('member' by default) for the search.

**Diagrams of Some Possible Configurations**

*Diagram above: Confluence connecting to an LDAP directory.*
Notes

Currently there is a bug which causes a system error if the username and password are not correct. This also happens if you are accessing anonymously, but the directory server does not support anonymous access. If you get a system error message, try checking the username and password credentials. You can watch this issue to see updates on this bug: 🟢CONF-25961 - Authenticate to see issue details

Configuring the LDAP Connection Pool

When connection pooling is enabled, the LDAP directory server maintains a pool of connections and assigns them as needed. When a connection is closed, the directory server returns the connection to the pool for future use. This can improve performance significantly.

To configure your LDAP connection pool:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click ‘User Directories’ in the left-hand panel.
3. Click ‘LDAP Connection Pool Configuration’ in the ‘Additional Configuration’ section.

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial Pool Size</td>
<td>The number of LDAP connections created when initially connecting to the pool.</td>
<td>1</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>Preferred Pool Size</td>
<td>The optimal pool size. LDAP will remove idle connections when the number of connections grows larger than this value. A value of 0 (zero) means that there is no preferred size, so the number of idle connections is unlimited.</td>
<td>10</td>
</tr>
<tr>
<td>Maximum Pool Size</td>
<td>The maximum number of connections. When the number of connections reaches this value, LDAP will refuse further connections. As a result, requests made by an application to the LDAP directory server will be blocked. A value of 0 (zero) means that the number of connections is unlimited.</td>
<td>0</td>
</tr>
<tr>
<td>Pool Timeout (seconds)</td>
<td>The length of time, in seconds, that a connection may remain idle before being removed from the pool. When the application is finished with a pooled connection, the connection is marked as idle, waiting to be reused. A value of 0 (zero) means that the idle time is unlimited, so connections will never be timed out.</td>
<td>30</td>
</tr>
<tr>
<td>Pool Protocol</td>
<td>Only these protocol types will be allowed to connect to the LDAP directory server. If you want to allow multiple protocols, enter the values separated by a space. Valid values are: plain, ssl</td>
<td>plain ssl (Both plain and ssl)</td>
</tr>
<tr>
<td>Pool Authentication</td>
<td>Only these authentication types will be allowed to connect to the LDAP directory server. If you want to allow multiple authentication types, enter the values separated by a space. See RFC 2829 for details of LDAP authentication methods. Valid values are: none, simple, DIGEST-MD5</td>
<td>simple</td>
</tr>
</tbody>
</table>

**Notes:**
The connection pool settings are system wide and will be used to create a new connection pool for every configured LDAP directory server.

You must restart your application server for these settings to take effect.

RELATED TOPICS

Connecting to an LDAP Directory
Configuring User Directories

If you want to configure a read/write connection with Microsoft Active Directory, you will need to install an SSL certificate, generated by your Active Directory server, onto your Confluence server and then install the certificate into your JVM keystore.

Prerequisites

To generate a certificate, you need the following components installed on the Windows Domain Controller to which you're connecting.

<table>
<thead>
<tr>
<th>Required Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Information Services (IIS)</td>
<td>This is required before you can install Windows Certificate Services.</td>
</tr>
<tr>
<td>Windows Certificate Services</td>
<td>This installs a certification authority (CA) which is used to issue certificates. Step 1, below, explains this process.</td>
</tr>
<tr>
<td>Windows 2000 Service Pack 2</td>
<td>Required if you are using Windows 2000</td>
</tr>
</tbody>
</table>

Step 1. Install the Active Directory Certificate Services

If Certificate Services are already installed, skip to step 2, below. The screenshots below are from Server 2008, but the process is similar for Server 2000 and 2003.

1. Log in to your Active Directory server as an administrator.
2. Click **Start**, point to **Administrative Tools**, and then click **Server Manager**.
3. In the **Roles Summary** section, click **Add Roles**.

![Roles Summary](image)

4. On the **Select Server Roles** page, select the **Active Directory Certificate Services** check box. Click **Next** twice.

![Select Server Roles](image)

5. On the **Select Role Services** page, select the **Certification Authority** check box, and then click **Next**.
6. On the **Specify Setup Type** page, click **Enterprise**, and then click **Next**.

7. On the **Specify CA Type** page, click **Root CA**, and then click **Next**.
8. On the **Set Up Private Key** and **Configure Cryptography for CA** pages, you can configure optional configuration settings, including cryptographic service providers. However, the default values should be fine. Click **Next** twice.

9. In the **Common name for this CA** box, type the common name of the CA, and then click **Next**.
10. On the **Set Validity Period** page, accept the default values or specify other storage locations for the certificate database and the certificate database log, and then click **Next**.
11. After verifying the information on the **Confirm Installation Selections** page, click **Install**.
12. Review the information on the results screen to verify that the installation was successful.

Step 2. Obtain the Server Certificate

The steps above describe how to install the certification authority (CA) on your Microsoft Active Directory server.
Next, you will need to add the Microsoft Active Directory server’s SSL certificate to the list of accepted certificates used by the JDK that runs your application server.

The Active Directory certificate is automatically generated and placed in root of the C:\ drive, matching a file format similar to the tree structure of your Active Directory server. For example: c:\ad2008.ad01.atlassian.com_ad01.crt.

You can also export the certificate by executing this command on the Active Directory server:

```
certutil -ca.cert client.crt
```

### Step 3. Import the Server Certificate

For an application server to trust your directory’s certificate, the certificate must be imported into your Java runtime environment. The JDK stores trusted certificates in a file called a keystore. The default keystore file is called cacerts and it lives in the jre\lib\security sub-directory of your Java installation.

In the following examples, we use server-certificate.crt to represent the certificate file exported by your directory server. You will need to alter the instructions below to match the name actually generated.

Once the certificate has been imported as per the below instructions, you will need to restart the application to pick up the changes.

**Windows**

1. Navigate to the directory in which Java is installed. It’s probably called something like C:\Program Files\Java\jdk1.5.0_12.
2. Run the command below, where server-certificate.crt is the name of the file from your directory server:

   ```
   keytool -import -keystore .\jre\lib\security\cacerts -file server-certificate.crt
   ```

   keytool will prompt you for a password. The default keystore password is changeit.

   4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

   ```
   Enter keystore password: changeit
   Owner: CN=ad01, C=US
   Issuer: CN=ad01, C=US
   Serial number: 15563d6677a4e9e4582d8a84be683f9
   Certificate fingerprints:
   Trust this certificate? [no]: yes
   Certificate was added to keystore
   ```

You may now use the ‘Secure SSL’ option when connecting your application to your directory server.

**UNIX**

1. Navigate to the directory in which Java is installed. cd $JAVA_HOME will usually get you there.
2. Run the command below, where server-certificate.crt is the name of the file from your directory server:
server:

```bash
sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.
4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

```
Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Certificate fingerprints:
Trust this certificate? [no]: yes
```

Certificate was added to keystore

You may now use the 'Secure SSL' option when connecting your application to your directory server.

**Mac OS X**

1. Navigate to the directory in which Java is installed. This is usually `/Library/Java/Home`.
2. Run the command below, where `server-certificate.crt` is the name of the file from your directory server:

```bash
sudo keytool -import -keystore ./jre/lib/security/cacerts -file server-certificate.crt
```

3. `keytool` will prompt you for a password. The default keystore password is `changeit`.
4. When prompted Trust this certificate? [no]: enter yes to confirm the key import:

```
Password:
Enter keystore password: changeit
Owner: CN=ad01, C=US
Issuer: CN=ad01, C=US
Serial number: 15563d6677a4e9e4582d8a84be683f9
Certificate fingerprints:
Trust this certificate? [no]: yes
```

Certificate was added to keystore

You may now use the 'Secure SSL' option when connecting your application to your directory server.

**RELATED TOPICS**
Connecting to an LDAP Directory
Configuring User Directories

Connecting to an Internal Directory with LDAP Authentication

You can connect your Confluence application to an LDAP directory for delegated authentication. This means that Confluence will have an internal directory that uses LDAP for authentication only. There is an option to create users in the internal directory automatically when they attempt to log in, as described in the settings section.

**Overview**

An internal directory with LDAP authentication offers the features of an internal directory while allowing you to store and check users' passwords in LDAP only. Note that the 'internal directory with LDAP authentication' is separate from the default 'internal directory'. On LDAP, all that the application does is to check the password. The LDAP connection is read only. Every user in the internal directory with LDAP authentication must map to a user on LDAP, otherwise they cannot log in.

**When to use this option:** Choose this option if you want to set up a user and group configuration within your application that suits your needs, while checking your users' passwords against the corporate LDAP directory. This option also helps to avoid the performance issues that may result from downloading large numbers of groups from LDAP.

---

**On this page:**

- Overview
- Connecting Confluence to an Internal Directory with LDAP Authentication
- Server Settings
  - Copying Users on Login
- Schema Settings
- Advanced Settings
- User Schema Settings
- Group Schema Settings
- Membership Schema Settings
- Diagrams of Possible Configurations

---

**Connecting Confluence to an Internal Directory with LDAP Authentication**

To connect to an internal directory but check logins via LDAP:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'User Directories' in the left-hand panel.
3. Add a directory and select type 'Internal with LDAP Authentication'.
4. Enter the values for the settings, as described below.
5. Save the directory settings.
6. If you want LDAP users to be used in place of existing internal users, move the 'Internal with LDAP Authentication' directory to the top of the list. You can define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

---

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.
For details see Managing Multiple Directories.

7. Add your users and groups in Confluence. See Adding and Inviting Users and Managing Site-Wide Permissions and Groups.

### Server Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A descriptive name that will help you to identify the directory. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Internal directory with LDAP Authentication</td>
</tr>
<tr>
<td></td>
<td>• Corporate LDAP for Authentication Only</td>
</tr>
<tr>
<td>Directory Type</td>
<td>Select the type of LDAP directory that you will connect to. If you are adding a new LDAP connection, the value you select here will determine the default values for some of the options on the rest of screen. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Microsoft Active Directory</td>
</tr>
<tr>
<td></td>
<td>• OpenDS</td>
</tr>
<tr>
<td></td>
<td>• And more.</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of your directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• ad.example.com</td>
</tr>
<tr>
<td></td>
<td>• ldap.example.com</td>
</tr>
<tr>
<td></td>
<td>• opends.example.com</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which your directory server is listening. Examples:</td>
</tr>
<tr>
<td></td>
<td>• 389</td>
</tr>
<tr>
<td></td>
<td>• 10389</td>
</tr>
<tr>
<td></td>
<td>• 636 (for example, for SSL)</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Select this check box if the connection to the directory server is an SSL (Secure Sockets Layer) connection. Note that you will need to configure an SSL certificate in order to use this setting.</td>
</tr>
<tr>
<td>Username</td>
<td>The distinguished name of the user that the application will use when connecting to the directory server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• cn=administrator,cn=users,dc=ad,dc=example,dc=com</td>
</tr>
<tr>
<td></td>
<td>• cn=user,dc=domain,dc=name</td>
</tr>
<tr>
<td></td>
<td>• <a href="mailto:user@domain.name">user@domain.name</a></td>
</tr>
<tr>
<td>Password</td>
<td>The password of the user specified above.</td>
</tr>
</tbody>
</table>

### Copying Users on Login
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Copy User on Login              | This option affects what will happen when a user attempts to log in. If this check box is selected, the user will be created automatically in the internal directory that is using LDAP for authentication when the user first logs in and their details will be synchronised on each subsequent log in. If this check box is not selected, the user's login will fail. If you select this check box the following additional fields will appear on the screen, which are described in more detail below:  
  - Default Group Memberships  
  - Synchronise Group Memberships  
  - User Schema Settings (described in a separate section below) |
| Default Group Memberships       | This field appears if you select the **Copy User on Login** check box. If you would like users to be automatically added to a group or groups, enter the group name(s) here. To specify more than one group, separate the group names with commas. Each time a user logs in, their group memberships will be checked. If the user does not belong to the specified group(s), their username will be added to the group(s). If a group does not yet exist, it will be added to the internal directory that is using LDAP for authentication. Please note that there is no validation of the group names. If you mis-type the group name, authorisation failures will result – users will not be able to access the applications or functionality based on the intended group name.  
Examples:  
  - confluence-users  
  - bamboo-users, jira-users, jira-developers |
Synchronise Group Memberships

This field appears if you select the **Copy User on Login** check box. If this check box is selected, group memberships specified on your LDAP server will be synchronised with the internal directory each time the user logs in.

If you select this check box the following additional fields will appear on the screen, both described in more detail below:

- **Group Schema Settings** (described in a separate section below)
- **Membership Schema Settings** (described in a separate section below)

### Schema Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Base DN                  | The root distinguished name (DN) to use when running queries against the directory server. Examples:  
  - o=example,c=com  
  - cn=users,dc=ad,dc=example,dc=com  
  - For Microsoft Active Directory, specify the base DN in the following format: `dc=domain1,dc=local`. You will need to replace the `domain1` and `local` for your specific configuration. Microsoft Server provides a tool called `ldp.exe` which is useful for finding out and configuring the LDAP structure of your server. |
| User Name Attribute      | The attribute field to use when loading the username. Examples:  
  - cn  
  - sAMAccountName |

### Advanced Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
</tbody>
</table>
**Use Paged Results**  
Enable or disable the use of the LDAP control extension for simple paging of search results. If paging is enabled, the search will retrieve sets of data rather than all of the search results at once. Enter the desired page size – that is, the maximum number of search results to be returned per page when paged results are enabled. The default is 1000 results.

**Follow Referrals**  
Choose whether to allow the directory server to redirect requests to other servers. This option uses the node referral (JNDI lookup `java.naming.refferal`) configuration setting. It is generally needed for Active Directory servers configured without proper DNS, to prevent a `javax.naming.PartialResultException: Unprocessed Continuation Reference(s)` error.

---

**User Schema Settings**

Note: this section is only visible when **Copy User on Login** is enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Additional User DN       | This value is used in addition to the base DN when searching and loading users. If no value is supplied, the subtree search will start from the base DN.  
  Example:  
  - `ou=Users`                                                            |
| User Object Class        | This is the name of the class used for the LDAP user object. Example:  
  - `user`                                                               |
| User Object Filter       | The filter to use when searching user objects. Example:  
  - `{(objectCategory=Person)(sAMAccountName=*)}`                         |
| User Name RDN Attribute  | The RDN (relative distinguished name) to use when loading the username. The DN for each LDAP entry is composed of two parts: the RDN and the location within the LDAP directory where the record resides. The RDN is the portion of your DN that is not related to the directory tree structure. Example:  
  - `cn`                                                                 |
| User First Name Attribute| The attribute field to use when loading the user's first name. Example:  
  - `givenName`                                                          |
### User Last Name Attribute
The attribute field to use when loading the user’s last name. Example:
- `sn`

### User Display Name Attribute
The attribute field to use when loading the user’s full name. Example:
- `displayName`

### User Email Attribute
The attribute field to use when loading the user’s email address. Example:
- `mail`

### Group Schema Settings
Note: this section is only visible when both Copy User on Login and Synchronise Group Memberships are enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Group DN</td>
<td>This value is used in addition to the base DN when searching and loading groups. If no value is supplied, the subtree search will start from the base DN. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>ou=Groups</code></td>
</tr>
<tr>
<td>Group Object Class</td>
<td>This is the name of the class used for the LDAP group object. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <code>groupOfUniqueNames</code></td>
</tr>
<tr>
<td></td>
<td>• <code>group</code></td>
</tr>
<tr>
<td>Group Object Filter</td>
<td>The filter to use when searching group objects. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>(objectCategory=Group)</code></td>
</tr>
<tr>
<td>Group Name Attribute</td>
<td>The attribute field to use when loading the group's name. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>cn</code></td>
</tr>
<tr>
<td>Group Description Attribute</td>
<td>The attribute field to use when loading the group's description. Example:</td>
</tr>
<tr>
<td></td>
<td>• <code>description</code></td>
</tr>
</tbody>
</table>

### Membership Schema Settings
Note: this section is only visible when both Copy User on Login and Synchronise Group Memberships are enabled.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Group Members Attribute** | The attribute field to use when loading the group's members. Example:  
| | • `member` |
| **User Membership Attribute** | The attribute field to use when loading the user's groups. Example:  
| | • `memberOf` |
| **Use the User Membership Attribute, when finding the user's group membership** | Select the check box if your directory server supports the group membership attribute on the user. (By default, this is the 'memberOf' attribute.)  
| | • If this check box is selected, your application will use the group membership attribute on the user when **retrieving the members of a given group**. This will result in a more efficient retrieval.  
| | • If this check box is not selected, your application will use the members attribute on the group ('member' by default) for the search. |

**Diagrams of Possible Configurations**

Diagram above: Confluence connecting to an LDAP directory for authentication only.
Diagram above: Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagnostics of Possible Configurations for User Management
- User Management Limitations and Recommendations
- Requesting Support for External User Management
- Disabling the Built-In User Management

Connecting to Crowd or JIRA for User Management

You can connect your Confluence application to Atlassian Crowd or to JIRA (version 4.3 or later) for management of users and groups, and for authentication (verification of a user’s login).

On this page:

- Connecting Confluence to Crowd for User Management
- Connecting Confluence to JIRA for User Management
- Diagrams of Some Possible Configurations

⚠️ The information on this page does not apply to Confluence OnDemand.
Connecting Confluence to Crowd for User Management

Atlassian Crowd is an application security framework that handles authentication and authorisation for your web-based applications. With Crowd you can integrate multiple web applications and user directories, with support for single sign-on (SSO) and centralised identity management. The Crowd Administration Console provides a web interface for managing directories, users and their permissions. See the Crowd Administration Guide.

When to use this option: Connect to Crowd if you want to use the full Crowd functionality to manage your directories, users and groups. You can connect your Crowd server to a number of directories of all types that Crowd supports, including custom directory connectors.

To connect Confluence to Crowd:

1. Go to your Crowd Administration Console and define the Confluence application to Crowd. See the Crowd documentation: Adding an Application.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Click 'User Directories' in the left-hand panel.
4. Add a directory and select type 'Atlassian Crowd'. Enter the settings as described below.
5. Save the directory settings.
6. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   For details see Managing Multiple Directories.
7. If required, configure Confluence to use Crowd for single sign-on (SSO) too. See the Crowd documentation: Integrating Crowd with Atlassian Confluence.

Crowd Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this Crowd server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>• Crowd Server</td>
</tr>
<tr>
<td></td>
<td>• Example Company Crowd</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your Crowd console server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <a href="http://www.example.com:8095/crowd/">http://www.example.com:8095/crowd/</a></td>
</tr>
<tr>
<td></td>
<td>• <a href="http://crowd.example.com">http://crowd.example.com</a></td>
</tr>
<tr>
<td>Application Name</td>
<td>The name of your application, as recognised by your Crowd server. Note that you will need to define the application in Crowd too, using the Crowd administration Console. See the Crowd documentation on adding an application.</td>
</tr>
</tbody>
</table>
**Application Password**

The password which the application will use when it authenticates against the Crowd framework as a client. This must be the same as the password you have registered in Crowd for this application. See the Crowd documentation on [adding an application](#).

---

**Crowd Permissions**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd and can only be modified via Crowd. You cannot modify Crowd users, groups or memberships via the application administration screens.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from Crowd. When you modify a user, group or membership via the application administration screens, the changes will be applied directly to Crowd. Please ensure that the application has modification permissions for the relevant directories in Crowd. See the Crowd documentation: <a href="#">Specifying an Application’s Directory Permissions</a>.</td>
</tr>
</tbody>
</table>

---

**Advanced Crowd Settings**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if the user directory or directories in Crowd support nested groups. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
<tr>
<td>Synchronisation Interval (minutes)</td>
<td>Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every x minutes, where ‘x’ is the number specified here. The default value is 60 minutes.</td>
</tr>
</tbody>
</table>

---

**Connecting Confluence to JIRA for User Management**

Note that the license tiers for JIRA and Confluence do not need to match to use this feature. For example, you can manage a Confluence 50 user license with JIRA, even if JIRA only has a 25 user license.
Subject to certain limitations, you can connect a number of Atlassian web applications to a single JIRA server for centralised user management.

**When to use this option:** You can only connect to a server running JIRA 4.3 or later. Choose this option as an alternative to Atlassian Crowd, for simple configurations with a limited number of users.

*If you are running JIRA 4.2 or earlier, please see Connecting to JIRA 4.2 or Earlier for User Management.*

**To connect Confluence to JIRA 4.3 or later:**

1. Go to your JIRA administration screen and define the Confluence application to JIRA:
   - For JIRA 4.3.x, select ‘Other Applications’ from the ‘Users, Groups & Roles’ section of the ‘Administration’ menu.
   - For JIRA 4.4 or later, select 'Users' > 'JIRA User Server’ in Administration mode.
   - Click ‘Add Application’.
   - Enter the application name and password that Confluence will use when accessing JIRA.
   - Enter the IP address or addresses of your Confluence server. Valid values are:
     - A full IP address, e.g. 192.168.10.12.
     - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
   - Save the new application.

2. Set up the JIRA user directory in Confluence:
   - Choose the cog icon at top right of the screen, then choose Confluence Admin.
   - Click ‘User Directories’ in the left-hand panel.
   - Add a directory and select type ‘Atlassian JIRA’.
   - Enter the settings as described below. When asked for the application name and password, enter the values that you defined for your Confluence application in the settings on JIRA.
   - Save the directory settings.
   - Define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen. Here is a summary of how the directory order affects the processing:
     - The order of the directories is the order in which they will be searched for users and groups.
     - Changes to users and groups will be made only in the first directory where the application has permission to make changes.
   - For details see Managing Multiple Directories.

3. In order to use Confluence, users must be a member of the confluence-users group or have Confluence ‘can use’ permission. Follow these steps to configure your Confluence groups in JIRA:
   - **a.** Add the confluence-users and confluence-administrators groups in JIRA.
   - **b.** Add your own username as a member of both of the above groups.
   - **c.** Choose one of the following methods to give your existing JIRA users access to Confluence:
     - **Option 1:** In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
     - **Option 2:** Log in to Confluence using your JIRA account and go to the Confluence Administration Console. Click ‘Global Permissions’ and assign the ‘can use’ permission to the relevant JIRA groups.

---

*Ensure that you have added Confluence URL into JIRA Whitelist in JIRA Administration >> System >> Security >> Whitelist. For example: https://confluence.atlassian.com/ or refer to this guide: Configuring the Whitelist*
### JIRA Settings in Confluence

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>• JIRA Server</td>
</tr>
<tr>
<td></td>
<td>• My Company JIRA</td>
</tr>
<tr>
<td>Server URL</td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
<tr>
<td></td>
<td>• <a href="http://www.example.com:8080">http://www.example.com:8080</a></td>
</tr>
<tr>
<td></td>
<td>• <a href="http://jira.example.com">http://jira.example.com</a></td>
</tr>
<tr>
<td>Application Name</td>
<td>The name used by your application when accessing the JIRA server that acts as user manager. Note that you will also need to define your application to that JIRA server, via the 'Other Applications' option in the 'Users, Groups &amp; Roles' section of the 'Administration' menu.</td>
</tr>
<tr>
<td>Application Password</td>
<td>The password used by your application when accessing the JIRA server that acts as user manager.</td>
</tr>
</tbody>
</table>

### JIRA Permissions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Read Only</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. They can only be modified via that JIRA server.</td>
</tr>
<tr>
<td>Read/Write</td>
<td>The users, groups and memberships in this directory are retrieved from the JIRA server that is acting as user manager. When you modify a user, group or membership, the changes will be applied directly to your application and to the JIRA server that is acting as user manager.</td>
</tr>
</tbody>
</table>

### Advanced JIRA Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Nested Groups</td>
<td>Enable or disable support for nested groups. Before enabling nested groups, please check to see if nested groups are enabled on the JIRA server that is acting as user manager. When nested groups are enabled, you can define a group as a member of another group. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups.</td>
</tr>
</tbody>
</table>
Synchronisation Interval (minutes)

Synchronisation is the process by which the application updates its internal store of user data to agree with the data on the directory server. The application will send a request to your directory server every \( x \) minutes, where \( x \) is the number specified here. The default value is 60 minutes.

---

**Diagrams of Some Possible Configurations**

*Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.*
Diagram above: Confluence connecting to JIRA for user management.
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
Reverting from Crowd or JIRA to Internal User Management

If your Confluence site currently uses JIRA or Crowd for user management, you can revert to internal user management as described below. If your Confluence instance has only a few users, it is easier to recreate the users and groups in Confluence manually. If you have a large number of users and groups, it is more efficient to migrate the relevant users and groups into the Confluence Internal directory.

Both options provided below will reset the affected users’ passwords. When done, be sure to notify them to use the ‘Reset My Password’ link on the Confluence log in page before they attempt to log in.

Option 1 – Manually Recreate Users and Groups in Confluence

Use this option if you have only a few users and groups.

1. Log in to Confluence as a Confluence system administrator.
2. Go to the user directories administration screen and move the internal directory to the top of the list of directories, by clicking the arrows in the ‘Order’ column.
3. Make sure that you have at least one user from the internal directory in each of the confluence-users and confluence-administrators groups.
4. Make sure that you have a username in the internal directory with Confluence system administrator permissions.
   - If you do not have such a user, add a new one now, and log out of Confluence.
   - Log back in as the user you just added, and go back to the user directories administration screen.
5. Disable the ‘Atlassian Crowd’ directory.
6. Manually add the required users and groups in Confluence. They will be added to the internal directory, because you have moved it to the top of the list of directories.
   - If you have assigned Confluence permissions to a group which exists in JIRA, you must create a group in Confluence with the same name.
   - If a user who exists in JIRA has created content or has had permissions assigned to them in Confluence, you must also create that user in Confluence.
7. Add the users to the required groups.

Option 2 – Transfer Crowd/JIRA Users and Groups to the Confluence Database

Use this option to migrate External Application (Crowd or JIRA) users into the Confluence database. You need a knowledge of SQL to perform this task.
The SQL commands given below are tailored for MySQL. If you are using a database other than MySQL, you will need to modify the SQL to work in your database.

**Step 1. Create Backups**

Creating backups is the only way to restore your data if something goes wrong.

1. From Confluence, create a full XML site backup including attachments.
2. Stop Confluence.
3. Make a backup copy of the Confluence home and installation directories.
4. Repeat the above steps for your External Application.
5. From your MySQL administration tool, create a database backup for the Crowd/JIRA and Confluence databases.

**Step 2. Replace Confluence User Management**

Use the SQL below to move groups and users from your External Application to Confluence by transferring table content. The SQL provided is specific to MySQL and must be modified for other databases.

Find the IDs for your Directories

1. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as `<Confluence Internal ID>`.

   ```sql
   select id from cwd_directory where directory_name='Confluence Internal Directory';
   ```

2. From the User Directories administration page, find the name of the directory who's users/groups you want to move. Run the following command and take note of the resulting number. It will be referenced throughout the following instructions as `<External Application ID>`.

   ```sql
   select id from cwd_directory where directory_name='<External Directory Name>';
   ```

**Move Groups to Confluence**

1. It is possible that you have several groups in your Internal Directory that have the same name as groups in your External Application. To find these, run:

   ```sql
   select distinct a.id, a.directory_id, a.group_name, d.directory_name from cwd_group a join cwd_group b on a.group_name=b.group_name join cwd_directory d on d.id=a.directory_id where a.directory_id != b.directory_id;
   ```

   a. If you have results from the previous query, for each of the group names that have duplicates, find the id for the group in the Confluence Internal Directory (<internal group id>) and the External Application (<external group id>). Run the following:
move all the groups in the external application to the confluence internal directory.

update cwd_group set directory_id=<confluence internal id> where directory_id=<external application id>;

move users to confluence

1. it is possible that you have several users in your internal directory that have the same name as users in your external application. to find these, run:

select distinct a.id, a.directory_id, a.user_name, d.directory_name from cwd_user a join cwd_user b on a.user_name=b.user_name join cwd_directory d on d.id=a.directory_id where a.directory_id != b.directory_id;

a. if you have results from the previous query, for each of the user names that have duplicates, find the id for the user in the confluence internal directory (<internal user id>) and the external application (<external user id>). run the following:

update cwd_membership set child_user_id=<internal user id> where child_user_id=<external user id>;
update cwd_user_credential_record set user_id=<internal user id> where user_id=<external user id>;
update cwd_user_attribute set user_id=<internal user id>, directory_id=<confluence internal id> where user_id=<external user id>;
delete from cwd_user where id=<external user id>;

2. move all the users in the external application to the confluence internal directory.

update cwd_user set directory_id=<confluence internal id> where directory_id=<external application id>;

delete the external application directory

1. you need to change the order of your directories so that the internal directory is at the top, and active.

   a. if you have only two directories - the internal and the external application directory you are deleting, then do the following:

   update cwd_app_dir_mapping set list_index = 0 where directory_id = <confluence internal id>;
b. If you have more than two directories, you need to rearrange them so the Internal Directory is at the top (list_index 0) and the External Application directory you are deleting is at the bottom.

- List the directories and their order using

\[
\text{select d.id, d.directory_name, m.list_index from cwd_directory d}
\text{ join cwd_app_dir_mapping m on d.id=m.directory_id order by}
\text{m.list_index;}
\]

- Change the list indexes so that they are in the order you want. Directory order can be rearranged using

\[
\text{update cwd_app_dir_mapping set list_index = \langleposition\rangle where}
\text{directory_id = \langledirectory id\rangle;}
\]

c. Check that the internal directory is enabled.

- List the internal directory. An enabled directory will have its 'active' column set to 'T'

\[
\text{select id, directory_name, active from cwd_directory where id =}
\text{\langleInternal Directory id\rangle;}
\]

- If the internal directory is not active, activate it by

\[
\text{update cwd_directory set active = 'T' where id = \langleInternal}
\text{Directory id\rangle;}
\]

2. When the directories are ordered correctly, delete the External Application directory from the directory order:

\[
\text{delete from cwd_app_dir_operation where app_dir_mapping_id = (select id from}
\text{cwd_app_dir_mapping where directory_id = \langleExternal Application ID\rangle);}
\text{delete from cwd_app_dir_mapping where directory_id = \langleExternal Application}
\text{ID\rangle;}
\]

3. The External Application directory is referenced in several other tables in the database. You need to remove the remaining references to it:

\[
\text{delete from cwd_directory_attribute where directory_id=\langleExternal Application}
\text{ID\rangle;}
\text{delete from cwd_directory_operation where directory_id=\langleExternal Application}
\text{ID\rangle;}
\]

4. All references to the External Directory should now have been removed. Delete the directory using:

\[
\text{delete from cwd_directory where id = \langleExternal Application ID\rangle;}
\]

Reset passwords

1. All users who were in the External Directory you deleted, including admins, will be unable to log in. Their passwords need to be reset by choosing the 'Forgot your password?' link on the login page. Alternatively,
use the instructions at Restoring Passwords To Recover Admin User Rights to reset the administrator password, then set the users’ passwords for them via the Manage Users page in the administration screen.

RELATED TOPICS

Configuring User Directories
Connecting to JIRA 4.2 or Earlier for User Management

Atlassian JIRA is an issue and project tracking tool. Like Confluence, JIRA offers the ability to store its users and groups in its database. You can configure Confluence to look for its users and groups in the JIRA database. This page describes the legacy JIRA database connector, which provides a direct connection to the JIRA database.

When to use this option: Choose the legacy JIRA database connector if your JIRA server is JIRA 4.2 or earlier, for backwards compatibility with the already-existing option for Confluence to use JIRA for user management.

If you are using JIRA 4.3 or later, you cannot use the legacy JIRA database connector. Instead, choose the ‘Atlassian JIRA’ directory type.

On this page:
- Connecting Confluence to JIRA
- JIRA Settings in Confluence

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Connecting Confluence to JIRA

To connect Confluence to JIRA 4.2 or earlier:

1. Edit the Confluence server.xml file, to construct the datasource location, as described below.
2. Restart Confluence.
3. Choose the cog icon at top right of the screen, then choose Confluence Admin.
4. Click User Directories in the left-hand panel.
5. Add a directory and select type Legacy Atlassian JIRA (4.2 and earlier). Enter the settings as described below.
6. Save the directory settings.
7. Define the directory order by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen. Here is a summary of how the directory order affects the processing:
   - The order of the directories is the order in which they will be searched for users and groups.
   - Changes to users and groups will be made only in the first directory where the application has permission to make changes.

For details see Managing Multiple Directories.

8. In order to use Confluence, users must be a member of the confluence-users group or have Confluence ‘can use’ permission. Follow these steps to configure your Confluence groups in JIRA:
   a. Add the confluence-users and confluence-administrators groups in JIRA.
   b. Add your own username as a member of both of the above groups.
   c. Choose one of the following methods to give your existing JIRA users access to Confluence:
      - Option 1: In JIRA, find the groups that the relevant users belong to. Add the groups as members of one or both of the above Confluence groups.
      - Option 2: Log in to Confluence using your JIRA account and go to the Confluence Administration Console. Click ‘Global Permissions’ and assign the ‘can use’ permission to the relevant JIRA groups.

JIRA Settings in Confluence

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A meaningful name that will help you to identify this JIRA server amongst your list of directory servers. Examples:</td>
</tr>
<tr>
<td></td>
<td>• JIRA</td>
</tr>
<tr>
<td></td>
<td>• Example Company JIRA</td>
</tr>
<tr>
<td>Datasource Location</td>
<td>The JNDI name of the JIRA datasource configured in your application server. Example:</td>
</tr>
<tr>
<td></td>
<td>java:comp/env/jdbc/YourJiraDatasource</td>
</tr>
<tr>
<td></td>
<td>In JIRA standalone distributions (using the default application server, Tomcat 6) you can construct the datasource location as follows:</td>
</tr>
<tr>
<td></td>
<td>1. Open your &lt;jira_install&gt;/conf/server.xml file in a text editor.</td>
</tr>
<tr>
<td></td>
<td>2. Look for the database setup section in that file. It looks something like this:</td>
</tr>
<tr>
<td></td>
<td>&lt;Resource auth=&quot;Container&quot; driverClassName=&quot;com.mysql.jdbc.Driver&quot; maxActive=&quot;20&quot; name=&quot;jdbc/JiraDS&quot; password=&quot;jirauser&quot; type=&quot;javax.sql.DataSource&quot; url=&quot;jdbc:mysql://localhost/jira?useUnicode=true&amp;characterEncoding=UTF8&quot; username=&quot;jirauser&quot; validationQuery=&quot;select 1&quot;/&gt;</td>
</tr>
<tr>
<td></td>
<td>3. Copy the above lines (the ‘Resource’ section) and paste it to your Confluence’s server.xml file (located at &lt;confluence_install&gt;/conf/server.xml), under the Context path. This will then expose the value of the name attribute as the JNDI resource locator.</td>
</tr>
<tr>
<td></td>
<td>4. Copy the JNDI name from the name parameter. In this example, the datasource location is:</td>
</tr>
<tr>
<td></td>
<td>java:comp/env/jdbc/JiraDS</td>
</tr>
</tbody>
</table>

### RELATED TOPICS

- Configuring User Directories
  - Configuring the Internal Directory
  - Connecting to an LDAP Directory
  - Connecting to an Internal Directory with LDAP Authentication
  - Connecting to Crowd or JIRA for User Management
  - Connecting to JIRA 4.2 or Earlier for User Management
Managing Multiple Directories

This page describes what happens when you have defined more than one user directory in Confluence. For example, you may have an internal directory and you may also connect to an LDAP directory server and/or other types of user directories. When you connect to a new directory server, you also need to define the directory order.

Avoid duplicate usernames across directories. If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user jsmith in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.

Overview

Here is a summary of how the directory order affects the processing:

- The order of the directories is the order in which they will be searched for users and groups.
- Changes to users and groups will be made only in the first directory where the application has permission to make changes.

On this page:
- Overview
- Configuring the Directory Order
- Effect of Directory Order
  - Login
  - Permissions
  - Updating Users and groups

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Configuring the Directory Order

You can change the order of your directories as defined to Confluence. Select 'User Directories' from the Confluence Administration Console and click the blue up- and down-arrows next to each directory.

<table>
<thead>
<tr>
<th>Directory Name</th>
<th>Type</th>
<th>Order</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confluence Internal Directory</td>
<td>Internal</td>
<td></td>
</tr>
<tr>
<td>OpenLDAP</td>
<td>OpenLDAP (Read-Write)</td>
<td></td>
</tr>
</tbody>
</table>

Notes:
- Please read the rest of this page to understand what effect the directory order will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.

Effect of Directory Order
This section summarises the effect the order of the directories will have on login and permissions, and on the updating of users and groups.

Login
The directory order is significant during the authentication of the user, in cases where the same user exists in multiple directories. When a user attempts to log in, the application will search the directories in the order specified, and will use the credentials (password) of the first occurrence of the user to validate the login attempt.

Permissions
The directory order is significant when granting the user permissions based on group membership. If the same username exists in more than one directory, the application will look for group membership only in the first directory where the username appears, based on the directory order.

Example:
- You have connected two directories: The Customers directory and the Partners directory.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- The user jsmith is a member of group G1 in the Customers directory and group G2 in the Partners directory.
- The user jsmith will have permissions based on membership of G1 only, not G2.

Updating Users and groups
If you update a user or group via the application's administration screens, the update will be made in the first directory where the application has write permissions.

Example 1:
- You have connected two directories: The Customers directory and the Partners directory.
- The application has permission to update both directories.
- The Customers directory is first in the directory order.
- A username jsmith exists in both the Customers directory and the Partners directory.
- You update the email address of user jsmith via the application's administration screens.
- The email address will be updated in the Customers directory only, not the Partners directory.

Example 2:
- You have connected two directories: A read/write LDAP directory and the internal directory.
- The LDAP directory is first in the directory order.
- All new users will be added to the LDAP directory. It is not possible to add a new user to the internal directory.

RELATED TOPICS
Configuring User Directories
- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
- Diagrams of Possible Configurations for User Management
Managing Nested Groups

Some directory servers allow you to define a group as a member of another group. Groups in such a structure are called 'nested groups'. If you are using groups to manage permissions, you can create nested groups to allow inheritance of permissions from one group to its sub-groups. This page describes how Confluence handles nested groups that exist in one or more of your directory servers.

Enabling Nested Groups

You can enable or disable support for nested groups on each directory individually. Go to the 'User Directories' section of the Confluence Administration Console, edit the directory and select 'Enable Nested Groups'. See Configuring User Directories.

Notes:

- Before enabling nested groups for a specific directory type in Confluence, please make sure that your directory server supports nested groups.
- Please read the rest of this page to understand what effect nested groups will have on authentication (login) and permissions in Confluence, and what happens when you update users and groups in Confluence.

On this page:

- Enabling Nested Groups
- Effect of Nested Groups
  - Login
  - Permissions
  - Viewing Lists of Group Members
  - Adding and Updating Group Memberships
- Examples
  - Example 1: User is Member of Sub-Group
  - Example 2: Sub-Groups as Members of the 'jira-developers' group
  - Example 3: Sub-Groups as Members of the 'confluence-users' group
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Effect of Nested Groups

This section summarises the effect nested groups will have on login and permissions, and on the viewing and updating of users and groups.

Login

When a user logs in, they will be allowed access to the application if they belong to an authorised group or any of its sub-groups.

Permissions

The user will be allowed access to a function if they belong to a group that has the necessary permissions, or if they belong to any of its sub-groups.
If you ask to view the members of a group, you will see all users who are members of the group and all users belonging its sub-groups, consolidated into one list. We call this a ‘flattened’ list.

You cannot view or edit the nested groups themselves. You will not be able to see that one group is a member of another group.

Adding and Updating Group Memberships

If you add a user to a group, the user is added to the named group and not to any other groups.

If you try to remove a user from a flattened list, the following will happen:

- If the user is a member of the top group in the hierarchy (tree) of groups contained in the flattened list, the user will be removed from the group.
- Otherwise, you will see an error message stating that the user is not a direct member of the group.

Examples

Example 1: User is Member of Sub-Group

Let's assume that the following two groups exist in your directory server:

- staff
- marketing

Memberships:

- The marketing group is a member of the staff group.
- User jsmith is a member of marketing.

You will see that jsmith is a member of both marketing and staff. You will not see that the two groups are nested. If you assign permissions to the staff group, then jsmith will get those permissions.

Example 2: Sub-Groups as Members of the 'jira-developers' group

In an LDAP directory server, we have groups 'engineering-group' and 'techwriters-group'. We want to grant both groups developer-level access to our JIRA site.

- Add a group called 'jira-developers'.
- Add the 'engineering-group' as a sub-group of 'jira-developers'.
- Add the 'techwriters-group' as a sub-group of 'jira-developers'.

Group memberships are now:

- jira-developers — sub-groups: engineering-group, techwriters-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- techwriters-group — users: rgreen

When JIRA requests a list of users in the 'jira-developers' group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

Diagram: Sub-groups as members of the 'jira-developers' group
Example 3: Sub-Groups as Members of the 'confluence-users' group

In an LDAP directory server, we have groups 'engineering-group' and 'payroll-group'. We want to grant both groups access to our Confluence site.

- Add a group called 'confluence-users'.
- Add the 'engineering-group' as a sub-group of 'confluence-users'.
- Add the 'payroll-group' as a sub-group of 'confluence-users'.

Group memberships are now:

- confluence-users — sub-groups: engineering-group, payroll-group
- engineering-group — sub-groups: dev-a, dev-b; users: pblack
- dev-a — users: jsmith, sbrown
- dev-b — users: jsmith, dblue
- payroll-group — users: rgreen

When Confluence requests a list of users in the 'confluence-users' group, it will receive the following list:

- pblack
- jsmith
- sbrown
- dblue
- rgreen

Diagram: Sub-groups as members of the 'confluence-users' group
Notes

- **Possible impact on performance.** Enabling nested groups may result in slower user searches.

- **Definition of nested groups in LDAP.** In an LDAP directory, a nested group is defined as a child group entry whose DN (Distinguished Name) is referenced by an attribute contained within a parent group entry. For example, a parent group 'Group One' might have an objectClass=group attribute and one or more member=DN attributes, where the DN can be that of a user or that of a group elsewhere in the LDAP tree:

```
member=CN=John Smith,OU=Users,OU=OrgUnitA,DC=sub,DC=domain
member=CN=Group Two,OU=OrgUnitBGroups,OU=OrgUnitB,DC=sub,DC=domain
```

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories
Synchronising Data from External Directories

For certain directory types, Confluence stores a cache of directory information (users and groups) in the application database, to ensure fast recurrent access to user and group data. A synchronisation task runs periodically to update the internal cache with changes from the external directory.

On this page:
- Affected Directory Types
- How it Works
- Finding the Time Taken to Synchronise
- Manually Synchronising the Cache
- Configuring the Synchronisation Interval

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Affected Directory Types

Data caching and synchronisation apply to the following user directory types:

- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to **read only**.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to **read only, with local groups**.
- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to **read/write**.
- Atlassian Crowd.
- Atlassian JIRA.

Data caching and synchronisation do not occur for the following user directory types:

- LDAP (Microsoft Active Directory and all supported LDAP directories) where permissions are set to **authentication only, with local groups**.
- Internal Directory with LDAP Authentication.
- Internal Directory.

How it Works

Here is a summary of the caching functionality:

- The caches are held in the application database.
- When you connect a new external user directory to the application, a synchronisation task will start running in the background to copy all the required users, groups and membership information from the external directory to the application database. This task may take a while to complete, depending on the size and complexity of your user base.
- Note that a user will not be able to log in until the synchronisation task has copied that user’s details into the cache.
- A periodic synchronisation task will run to update the database with any changes made to the external directory. The default synchronisation interval, or polling interval, is one hour (60 minutes). You can change the synchronisation interval on the directory configuration screen.
• You can manually synchronise the cache if necessary.
• If the external directory permissions are set to read/write: Whenever an update is made to the users, groups or membership information via the application, the update will also be applied to the cache and the external directory immediately.
• All authentication happens via calls to the external directory. When caching information from an external directory, the application database does not store user passwords.
• All other queries run against the internal cache.

Finding the Time Taken to Synchronise

The ‘User Directories’ screen shows information about the last synchronisation operation, including the length of time it took.

Manually Synchronising the Cache

You can manually synchronise the cache by clicking ‘Synchronise’ on the ‘User Directories’ screen. If a synchronisation operation is already in progress, you cannot start another until the first has finished.

Screen snippet: User directories, showing information about synchronisation

<table>
<thead>
<tr>
<th>Directory</th>
<th>Synchronisation Status</th>
<th>Last Synchronised Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenLDAP</td>
<td>Disable Edit Synchronise</td>
<td>14/01/11 3:07 PM (took 65s)</td>
</tr>
<tr>
<td>Crowd</td>
<td>Disable Edit Synchronise</td>
<td>14/01/11 2:39 PM (took 9s)</td>
</tr>
</tbody>
</table>

Configuring the Synchronisation Interval

Note: The option to configure the synchronisation interval for Crowd and JIRA directories is available in Confluence 3.5.3 and later. Earlier versions of Confluence allow you to configure the interval for LDAP directories only.

You can set the ‘Synchronisation Interval’ on the directory configuration screen. The synchronisation interval is the period of time to wait between requests for updates from the directory server.

The length you choose for your synchronisation interval depends on:

• The length of time you can tolerate stale data.
• The amount of load you want to put on the application and the directory server.
• The size of your user base.

If you synchronise more frequently, then your data will be more up to date. The downside of synchronising more frequently is that you may overload your server with requests.

If you are not sure what to do, we recommend that you start with an interval of 60 minutes (this is the default setting) and reduce the value incrementally. You will need to experiment with your setup.

RELATED TOPICS

Configuring User Directories

• Configuring the Internal Directory
• Connecting to an LDAP Directory
• Connecting to an Internal Directory with LDAP Authentication
• Connecting to Crowd or JIRA for User Management
• Connecting to JIRA 4.2 or Earlier for User Management
• Managing Multiple Directories
• Managing Nested Groups
• Synchronising Data from External Directories
• Diagrams of Possible Configurations for User Management
User Management Limitations and Recommendations
Requesting Support for External User Management
Disabling the Built-In User Management

Diagrams of Possible Configurations for User Management
The aim of these diagrams is to help people understand each directory type at a glance. We have kept the diagrams simple and conceptual, with just enough information to be correct.

Some things that we do not attempt to show:

- In most cases, we do not attempt to show that you can have multiple directory types mapped to Confluence at the same time. We illustrate that fact in just the first two LDAP diagrams.
- We have not included a diagram for Confluence's legacy connection to JIRA database.
- We do not attempt to show all of the possible configurations and layered connections that are available now that you can use JIRA as a directory manager.

On this page:

- Confluence Internal Directory
- Confluence with Read/Write Connection to LDAP
- Confluence with Read-Only Connection to LDAP, with Local Groups
- Confluence Internal Directory with LDAP Authentication
- Confluence with LDAP Authentication, Copy Users on First Login
- Confluence Connecting to JIRA
- Confluence Connecting to JIRA and JIRA Connecting to LDAP
- Confluence and JIRA Connecting to Crowd

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Confluence Internal Directory

Diagram above: Confluence using its internal directory for user management.
Confluence with Read/Write Connection to LDAP

Diagram above: Confluence connecting to an LDAP directory.

Confluence with Read-Only Connection to LDAP, with Local Groups
Diagram above: Confluence connecting to an LDAP directory with permissions set to read only and local groups.

Confluence Internal Directory with LDAP Authentication

Diagram above: Confluence connecting to an LDAP directory for authentication only.

Confluence with LDAP Authentication, Copy Users on First Login

Diagram above: Confluence connecting to an LDAP directory for authentication only, with each user synchronised with the internal directory that is using LDAP authentication when they log in to Confluence.
Diagram above: Confluence connecting to JIRA for user management.

Confluence Connecting to JIRA and JIRA Connecting to LDAP
Diagram above: Confluence connecting to JIRA for user management, with JIRA in turn connecting to LDAP.

Confluence and JIRA Connecting to Crowd
Diagram above: Confluence, JIRA and other applications connecting to Crowd for user management.

RELATED TOPICS

Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
- Synchronising Data from External Directories

User Management Limitations and Recommendations

This page describes the optimal configurations and limitations that apply to user management in Confluence.
General Recommendations

- **Avoid duplicate usernames across directories.** If you are connecting to more than one user directory, we recommend that you ensure the usernames are unique to one directory. For example, we do not recommend that you have a user jsmith in both 'Directory1' and 'Directory2'. The reason is the potential for confusion, especially if you swap the order of the directories. Changing the directory order can change the user that a given username refers to.

- **Be careful when deleting users in remote directories.** If you are connecting to an LDAP directory, a Crowd directory or a JIRA directory, please take care when deleting users from the remote directory. If you delete a user that is associated with data in Confluence, this will cause problems in Confluence.

Recommendations for Connecting to LDAP

Please consider the following limitations and recommendations when connecting to an LDAP user directory.

**Optimal Number of Users and Groups in your LDAP Directory**

The connection to your LDAP directory provides powerful and flexible support for connecting to, configuring and managing LDAP directory servers. To achieve optimal performance, a background synchronisation task loads the required users and groups from the LDAP server into the application's database, and periodically fetches updates from the LDAP server to keep the data in step. The amount of time needed to copy the users and groups rises with the number of users, groups, and group memberships. For that reason, we recommended a maximum number of users and groups as described below.

This recommendation affects connections to LDAP directories:

- Microsoft Active Directory
- All other LDAP directory servers

The following LDAP configurations are not affected:

- Internal directories with LDAP authentication
- LDAP directories configured for 'Authentication Only, Copy User On First Login'

Please choose one of the following solutions, depending on the number of users, groups and memberships in your LDAP directory.

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.
Up to 10,000 (ten thousand) users, 1,000 (one thousand) groups, and 20 (twenty) groups per user

Choose the ‘LDAP’ or ‘Microsoft Active Directory’ directory type. You can make use of the full synchronisation option. Your application’s database will contain all the users and groups that are in your LDAP server.

More than the above

Use LDAP filters to reduce the number of users and groups visible to the synchronisation task.

Our Test Results

We performed internal testing of synchronisation with an AD server on our local network consisting of 10,000 users, 1,000 groups and 200,000 memberships.

We found that the initial synchronisation took about 5 minutes. Subsequent synchronisations with 100 modifications on the AD server took a couple of seconds to complete.

Please keep in mind that a number of factors come into play when trying to tune the performance of the synchronisation process, including:

- **Size of userbase.** Use LDAP filters to keep this to the minimum that suits your requirements.
- **Type of LDAP server.** We currently support change detection in AD, so subsequent synchronisations are much faster for AD than for other LDAP servers.
- **Network topology.** The further away your LDAP server is from your application server, the more latent LDAP queries will be.
- **Database performance.** As the synchronisation process caches data in the database, the performance of your database will affect the performance of the synchronisation.
- **JVM heap size.** If your heap size is too small for your userbase, you may experience heavy garbage collection during the synchronisation process which could in turn slow down the synchronisation.

Redundant LDAP is Not Supported

The LDAP connections do not support the configuration of two or more LDAP servers for redundancy (automated failover if one of the servers goes down).

Specific Notes for Connecting to Active Directory

When the application synchronises with Active Directory (AD), the synchronisation task requests only the changes from the LDAP server rather than the entire user base. This optimises the synchronisation process and gives much faster performance on the second and subsequent requests.

On the other hand, this synchronisation method results in a few limitations:

1. **Externally moving objects out of scope or renaming objects causes problems in AD.** If you move objects out of scope in AD, this will result in an inconsistent cache. We recommend that you do not use the external LDAP directory interface to move objects out of the scope of the sub-tree, as defined on the application’s directory configuration screen. If you do need to make structural changes to your LDAP directory, manually synchronise the directory cache after you have made the changes to ensure cache consistency.

2. **Synchronising between AD servers is not supported.** Microsoft Active Directory does not replicate the uSNCNChanged attribute across instances. For that reason, we do not support connecting to different AD servers for synchronisation. (You can of course define multiple different directories, each pointing to its own respective AD server.)

3. **Synchronising with AD servers behind a load balancer is not supported.** As with synchronising between two different AD servers, Microsoft Active Directory does not replicate the uSNCNChanged attribute.
across instances. For that reason, we do not support connecting to different AD servers even when they are load balanced. You will need to select one server (preferably one that is local) to synchronise with instead of using the load balancer.

4. **You must restart the application after restoring AD from backup.** On restoring from backup of an AD server, the uSNChanged timestamps are reverted to the backup time. To avoid the resulting confusion, you will need to flush the directory cache after a Active Directory restore operation.

5. **Obtaining AD object deletions requires administrator access.** Active Directory stores deleted objects in a special container called cn=Deleted Objects. By default, to access this container you need to connect as an administrator and so, for the synchronisation task to be aware of deletions, you must use administrator credentials. Alternatively, it is possible to change the permissions on the cn=Deleted Objects container. If you wish to do so, please see this Microsoft KB Article.

6. **The User DN used to connect to AD must be able to see the uSNChanged attribute.** The synchronisation task relies on the uSNChanged attribute to detect changes, and so must be in the appropriate AD security groups to see this attribute for all LDAP objects in the subtree.

---

**Recommendations for Connecting to JIRA for User Management**

Please consider the following limitations and recommendations when connecting to a JIRA server for user management.

**Single Sign-On Across Multiple Applications is Not Supported**

When you connect to JIRA for user management, you will not have single sign-on across the applications connected in this way. JIRA, when acting as a directory manager, does not support SSO.

**Custom Application Connectors are Not Supported**

JIRA, Confluence, FishEye, Crucible and Bamboo can connect to a JIRA server for user management. Custom application connectors will need to use the new REST API.

**Custom Directories are Not Supported**

Earlier versions of JIRA supported OSUser Providers. It was therefore possible write a special provider to obtain user information from any external user directory. This is no longer the case.

**Optimal Number of Users and Applications**

Please consider the following limitations when connecting to a JIRA server for user management:

- Maximum 500 users.
- Maximum 5 connected applications.

**Recommendations**

<table>
<thead>
<tr>
<th>Your environment</th>
<th>Recommendation</th>
</tr>
</thead>
</table>

---

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
<table>
<thead>
<tr>
<th><strong>If all</strong> the following are true:</th>
<th>Your environment meets the optimal requirements for using JIRA for user management.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You have fewer than 500 users.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across just a few applications, such as one JIRA server and one Confluence server, or two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not need single sign-on (SSO) between JIRA and Confluence, or between two JIRA servers.</td>
<td></td>
</tr>
<tr>
<td>• You do not have custom application connectors. Or, if you do have them, you are happy to convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>If one or more</strong> of the following are true:</th>
<th>We recommend that you install Atlassian Crowd for user management and SSO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>• You have more than 500 users.</td>
<td></td>
</tr>
<tr>
<td>• You want to share user and group management across more than 5 applications.</td>
<td></td>
</tr>
<tr>
<td>• You need single sign-on (SSO) across multiple applications.</td>
<td></td>
</tr>
<tr>
<td>• You have custom applications integrated via the Crowd SOAP API, and you cannot convert them to use the new REST API.</td>
<td></td>
</tr>
<tr>
<td>• You are not happy to shut down all your servers when you need to upgrade JIRA.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If you are considering creating a custom directory connector to define your own storage for users and groups...</th>
<th>Please see if one of the following solutions will work for you:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• If you have written a custom provider to support a specific LDAP schema, please check the supported LDAP schemas to see if you can use one of them instead.</td>
<td></td>
</tr>
<tr>
<td>• If you have written a custom provider to support nested groups, please consider enabling nested groups in the supported directory connectors instead.</td>
<td></td>
</tr>
<tr>
<td>• If you have written a custom provider to connect to your own database, please consider loading the data into the application’s database instead.</td>
<td></td>
</tr>
<tr>
<td>• If you need to keep the custom directory connection, please consider whether Atlassian Crowd meets your requirements. See the documentation on Creating a Custom Directory Connector.</td>
<td></td>
</tr>
</tbody>
</table>

**RELATED TOPICS**

- Connecting to an LDAP Directory
- Connecting to Crowd or JIRA for User Management
- Configuring User Directories
Requesting Support for External User Management

This page gives guidelines on how to request help from the Atlassian support team if you are having problems with external user management. External user management includes connections to Active Directory, other LDAP servers, Atlassian Crowd or Atlassian JIRA for user management. The information on this page is provided in addition to the more general page on Troubleshooting Problems and Requesting Technical Support.

The cause of such problems may be:

- The LDAP server is not responding.
- The application password is incorrectly configured, causing the LDAP server or other directory to return an authentication error.
- Other LDAP settings are incorrectly configured.

On this page:

- Troubleshooting the Connection to your External User Directory
- Problems During Initial Setup
- Complex Authentication or Performance Problems

⚠️ The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

Troubleshooting the Connection to your External User Directory

The configuration screen for external directories in Confluence has a 'Test Settings' button. This will help you to diagnose problems with user management in Active Directory and other LDAP servers.

To test your directory connection:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'User Directories' in the left-hand panel.
3. Edit the relevant directory.
4. Click 'Test Settings'.
5. The results of the test will appear at the top of the screen.

Please refer to our knowedge base articles for troubleshooting user management and login issues.

If the above resources do not help, continue below.

Problems During Initial Setup

Raise a support request and include the following information.

- Download an LDAP browser to make sure you have the right settings in your LDAP directory. Atlassian recommends LDAP Studio. Include screenshots of your user and group DNs.
- If you can start up Confluence and access the Administration Console, review your directory settings. See Connecting to an LDAP Directory. Attach screenshots of all your settings.

Complex Authentication or Performance Problems

Raise a support request and include the following information.

<table>
<thead>
<tr>
<th>Confluence Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log in to Confluence and access the Administration Console.</td>
</tr>
<tr>
<td>- Take a screenshot of the 'System Information' screen, or save the page as HTML.</td>
</tr>
<tr>
<td>- Take a screenshot of the 'Global Permissions' screen, if people are having problems with logging in.</td>
</tr>
<tr>
<td>- Go to 'Space Admin' for the relevant space and take a screenshot of the 'Permissions' page, if you are having problems with space or page permissions.</td>
</tr>
</tbody>
</table>
Confluence Configuration Files

- If you have implemented a custom authenticator or in any way modified `seraph-config.xml` or `seraph-h-paths.xml`, please provide the modified file.

User Management System

- Include the name and version of your LDAP server.
- Does your LDAP server use dynamic or static groups?
- Review your directory settings. See Connecting to an LDAP Directory. Attach screenshots of all your settings.

Diagnostics

- Enable profiling. See Performance Tuning.
- Enable detailed user management logging, by editing `confluence/WEB-INF/classes/log4j.properties`.

Change this section:

```
###
# Atlassian User
###
#log4j.logger.com.atlassian.user=DEBUG
#log4j.logger.com.atlassian.confluence.user=DEBUG
#log4j.logger.bucket.user=DEBUG
#log4j.logger.com.atlassian.seraph=DEBUG
#log4j.logger.com.opensymphony.user=DEBUG
```

Remove the '#' signs at the beginning of the lines, so that it looks like this:

```
###
# Atlassian User
###
log4j.logger.com.atlassian.user=DEBUG
log4j.logger.com.atlassian.confluence.user=DEBUG
log4j.logger.bucket.user=DEBUG
log4j.logger.com.atlassian.seraph=DEBUG
log4j.logger.com.opensymphony.user=DEBUG
```

- After enabling both the above, please attempt a Confluence LDAP account login and attach a copy of the log files that are produced when the problem occurs. To do this, locate your install directory or exploded WAR directory, then zip the full `/logs` subdirectory into a single file for us to examine. The logs subdirectory is located in your Confluence Home directory.

RELATED TOPICS

Troubleshooting Problems and Requesting Technical Support
Configuring User Directories

- Configuring the Internal Directory
- Connecting to an LDAP Directory
- Connecting to an Internal Directory with LDAP Authentication
- Connecting to Crowd or JIRA for User Management
- Connecting to JIRA 4.2 or Earlier for User Management
- Managing Multiple Directories
- Managing Nested Groups
Disabling the Built-In User Management

By selecting the 'External user management' option in Confluence, you can disable the group and user management screens in Confluence. You need system administrator permissions to set this option.

You will find it useful to select external user management under the following circumstances:

- When Crowd's directory permissions are configured so that Confluence cannot update the Crowd directories, then Confluence's external user management setting must be turned on. Otherwise, a 'System Error' will occur when Confluence attempts to write data into Crowd. For more information about integrating Crowd with Confluence, see Connecting to Crowd or JIRA for User Management.
- If you are using JIRA for user management, we recommend that you turn on Confluence's external user management setting. This centralises user management in JIRA. See Connecting to Crowd or JIRA for User Management and Connecting to JIRA 4.2 or Earlier for User Management.

The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

To disable management of users and groups within Confluence:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'Security Configuration' in the left-hand panel.
3. The 'Edit Security Configuration' screen will appear. Click 'Edit'.
4. Tick the 'External user management' check box.
5. Click 'Save'.

Notes

- Please refer to the following bugs and improvement requests:
  - CONF-16709 – When the External User Management check box is ticked, the group and user management screens are still functional.
  - CONF-21158 – Enabling both public signup and external user management renders a blank screen during signup.
  - CONF-9830 – This is a request to rename this feature to better reflect its functionality.

RELATED TOPICS

Disabling the Built-In User Management

Managing Add-ons and Macros

An add-on is a separately installed component that enhances or modifies Confluence. Some add-ons are shipped with Confluence, others are available for you to install yourself. An add-on that specifically plugs into the architecture of an Atlassian application such as Confluence is sometimes called a plugin, although the terms 'plugin' and 'add-on' are often used interchangeably.

A macro allows a developer to perform programmatic functions within a page, and gives the Confluence user
access to more complex content structures. Many macros are made available by plugins.

You need System Administrator permissions in order to install and configure plugins.

Installing and configuring add-ons and macros

- **About Add-ons**
  - Add-on loading strategies in Confluence
  - Removing Malfunctioning Add-ons
- **Enabling and Configuring Macros**
  - Configuring a URL Whitelist for Macros
  - Configuring the User List Macro
  - Enabling HTML macros
    - Enabling the html-include Macro
    - Troubleshooting the Gallery Macro
- **Adding, Editing and Removing User Macros**
  - Writing User Macros
    - Best Practices for Writing User Macros
    - Examples of User Macros
      - Hello World Example of User Macro
      - Error Box Macro - Example of a User Macro
      - Colour and Size Macro - Example of a User Macro
      - NoPrint Example of a User Macro
      - Panel Preformatted with Specific Colours - Example of a User Macro
      - Preformatted Table - Example of a User Macro
- **Guide to User Macro Templates**

**About Add-ons**

An add-on is an installable component that supplements or enhances the functionality of Confluence in some way. For example, the Team Calendars for Confluence is an add-on that lets users embed team calendars into Confluence pages. Other Confluence add-ons are available for creating charts, tracking usage and modifying the Confluence visual theme.

Confluence comes with many pre-installed add-ons (called system add-ons). You can install more add-ons either by acquiring an add-on from the Atlassian Marketplace or by uploading an add-on from your file system. This means that you can install add-ons that you have developed yourself. For information about developing your own add-ons for Confluence, see the Confluence Developer documentation.

**About the Universal Plugin Manager**

The Universal Plugin Manager (UPM) is itself an add-on that you use to administer add-ons from the Confluence Administration Console. UPM works across Atlassian applications, providing a consistent interface for administering add-ons in Confluence, Crucible, Fisheye, JIRA, Stash or Bamboo.

UPM comes pre-installed in recent versions of all Atlassian applications, so you do not normally need to install it yourself. However, like other add-ons, the UPM software is subject to regular software updates. Before administering add-ons in Confluence, therefore, you should verify your version of the UPM and update it if needed.

**Administering Add-ons in Confluence**

You can update UPM, or any add-on, from the UPM’s own add-on administration pages. Additionally, you can perform these tasks from the administration pages:

- Install or remove add-ons
• Configure add-on settings
• Discover and install new add-ons from the Atlassian Marketplace
• Enable or disable add-ons and their component modules

If the add-on request feature is enabled in your Atlassian application, non-administrative users can also discover add-ons on the Atlassian Marketplace. Instead of installing the add-ons, however, the users have the option of requesting the add-ons from you, the administrator of the Atlassian application. For an end-user's view of the add-on request feature in Confluence, see Requesting Add-ons.

For more information on administering this feature and performing other add-on administration tasks, see the Universal Plugin Manager documentation.

For add-on information specific to Confluence, see these pages:

• Add-on loading strategies in Confluence
• Removing Malfunctioning Add-ons

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Static</td>
<td>cannot be installed or upgraded</td>
<td>without a Confluence restart</td>
</tr>
</tbody>
</table>

Some functionality described on this page is restricted in Confluence OnDemand.

Add-on loading strategies in Confluence

The categories

Confluence add-ons have different behaviour based on how they are loaded by Confluence. The add-ons themselves are the same, but based on how they are loaded, they may or may not be upgraded, or may not be disabled, or may not be uninstalled. This chart should explain how plugins can be loaded by Confluence, and the ramifications for each choice.

The category any particular add-on is in can vary with Confluence version or circumstance. The examples mentioned here describe the way particular add-ons are loaded by default in Confluence 2.8.

The information on this page does not apply to Confluence OnDemand.
### Core
Included with Confluence and cannot be uninstalled. The classes and plugin.xml are not bundled into add-on distribution JAR files, but are mixed in with Confluence source on the main classpath. Additionally, the plugin.xml definitions are not called "atlassian-plugin.xml" as they are everywhere else, but are named for the add-on, e.g., "basic-macros.xml". We would like to separate some of them out and turn them into *Bundled* add-ons.

### WEB-INF/lib
Confluence also places some add-on JAR files inside WEB-INF/lib. They are inserted during the build process by Maven. These add-ons, likewise, cannot be uninstalled. In ancient times, this was the only way to install add-ons, so users were also free to install add-ons here. We now discourage this installation method, however. As of version 3.0, most of the JAR files in this directory are library dependencies, not add-on files.

### Dynamic
The opposite of static, these can be installed/upgraded while Confluence is running

### Admin Sections
**Bundled**

Bundled add-ons can be administered from the Manage Add-ons page in the application's Administration Console. You can upload or disable them there.

Bundled add-ons are included in a ZIP archive of JAR files called `atlassian-bundled-plugins.zip`, which is on the main Confluence classpath, in a resources directory `- <confluence-install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup`. At Confluence startup, they are extracted and copied into the `$CONFLUENCE_HOME/bundled-plugins` directory, from whence they are loaded. To remove a bundled add-on (you shouldn't normally have to do this), remove the add-on from the atlassian-bundled-plugins.zip file and the bundled-plugins directory, otherwise Confluence will just put it back in place on the next startup. In versions later than 2.6, you'll have to recreate the `.jar` file (if the jar file is from the lib folder) or recreate the zip folder (if its in the classes folder). Bundled add-ons can be upgraded or disabled.

**Uploaded**

Installed by the user via the plugin repository or the Universal Plugin Manager. These add-ons are stored in the database and then copied to the `$CONFLUENCE_HOME/plugins-cache` folder on each Confluence node.

To summarise the relationships of categories in the table, all add-ons are either Static or Dynamic. Static add-ons can be further categorised into Core or WEB-INF/lib. Dynamic add-ons are divided into Bundled and Uploaded.

### Use of the categories in Confluence

Within Confluence, the Core and WEB-INF/lib categories are not actually named as such, and they don't map neatly to other names (though they do map, as will be explained). They are used here because of the logical distinction they provide.

In Confluence, some of the Core add-ons are called “System Add-ons”. Add-ons can be designated as “System” by adding a flag to the add-on manifest file. To do this, `system=true` should be added to the top-level `atlassian-plugin` element of the manifest file. The manifest file is generally called `atlassian-plugin.xml`, but it could be anything.
could have another name; the Core add-on files do.

All the Core add-ons were once labeled "System", but the convention has faded over time. If an add-on is designated as "System", it cannot be enabled/disabled in the Manage Add-ons page. However, it will show up in the Plugin Repository Client, where it can be disabled; allowing disabling there is probably incorrect behavior.

Static add-ons that are not marked as "System" (any remaining Core and WEB-INF/lib plugins), are simply called Static in Confluence. There is no way to tell the WEB-INF/lib and Core add-ons apart from within Confluence. You just have to figure out where the classes are.

Members of the other specific categories—Bundled and Uploaded—can be determined. We can tell which add-ons are Bundled and which add-ons are Uploaded, so we know which add-ons are Uploaded though this specific term is never used in the Confluence UI. Instead, they are called Dynamic.

**Updating add-on versions**

- Core add-ons cannot be upgraded.
- WEB-INF/lib add-ons can be upgraded by replacing the JAR in WEB-INF/lib and restarting Confluence.
- Bundled add-ons can be upgraded using the Universal Plugin Manager or from the Plugin Repository Client. A new add-on JAR is uploaded and stored as an Uploaded add-on. Confluence compares the version number with the Bundled add-on and uses the newer.
- Uploaded add-ons are upgradable using the Universal Plugin Manager or from the Plugin Repository Client. When a new add-on JAR file is uploaded, the previous version is discarded from the database and the $CONFLUENCE_HOME/plugin-cache directory.

**RELATED TOPICS**

**Removing Malfunctioning Add-ons**

Confluence goes to some lengths to prevent itself being unusable due to a problematic add-on. However, sometimes an add-on will manage to do this anyway. This page describes what to do if an add-on cannot be disabled or deleted from the administration console (from Administration > Manage Add-ons).

⚠️ The information on this page does not apply to Confluence OnDemand.

**Add-on Loading Strategies**

1. Read through .
2. Determine where your add-on file is located. The usual locations are:
   a. The PLUGINDATA table on the database
   b. The <confluence-home>/bundled-plugins folder
   c. The <confluence-home>/plugin-cache folder
   d. The <confluence-home>/plugins-osgi-cache folder
   e. The <confluence-home>/plugins-temp folder
   f. The <confluence-install>/confluence/WEB-INF/lib folder (deprecated approach)

Check these locations when troubleshooting add-on loading issues.

✅ Check the How to display classpath utility for tips on what’s loading, and the Knowledge Base Article on plugin malfunctioning.

Deleting an add-on from the Database

To remove an add-on from Confluence when Confluence is not running,
1. Connect to the Confluence database.
2. Run the following SQL statement in your database:

   ```sql
   select plugindataid, pluginkey, filename, lastmoddate from PLUGINDATA;
   ```

3. After you have found the `plugindataid` value for the offending add-on, run the following:

   ```sql
   delete from PLUGINDATA where plugindataid='XXXXXX';
   ```

   where `XXXXXX` is the `plugindataid` value.

4. Restart Confluence.

Disabling an add-on from the database

**To disable the add-on in the database,**

Run the following query on your Confluence database:

```sql
select BANDANAVALUE from BANDANA where BANDANAKEY = 'plugin.manager.state.Map'
```

This will return a value like:

```xml
<map>
  <entry>
    <string>com.atlassian.confluence.ext.usage</string>
    <boolean>true</boolean>
  </entry>
</map>
```

Edit the value `boolean` to have `false`:

```xml
<map>
  <entry>
    <string>com.atlassian.confluence.ext.usage</string>
    <boolean>false</boolean>
  </entry>
</map>
```

Deleting a Bundled Add-on

Bundled add-ons can be administered from the Manage Add-ons page in the application's Administration Console. You can upload or disable them there.

Bundled add-ons are included in a ZIP archive of JAR files called `atlassian-bundled-plugins.zip`, which is on the main Confluence classpath, in a resources directory - `<confluence-install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup`. At Confluence startup, they are extracted and copied into the `$CONFLUENCE_HOME/bundled-plugins` directory, from whence they are loaded. To remove a bundled add-on (you shouldn’t normally have to do this), remove the add-on from the atlassian-bundled-plugins.zip file and the bundled-plugins directory, otherwise Confluence will just put it back in place on the next startup. In
versions later than 2.6, you'll have to recreate the .jar file (if the jar file is from the lib folder) or recreate the zip folder (if its in the classes folder). Bundled add-ons can be upgraded or disabled.

If you need to remove a bundled add-on, check to see if you have duplicates in the `<confluence-home>/bundled-plugins` or `<confluence-home>/plugin-cache` directory.

Usually, the problem is that an old add-on is getting loaded along with the properly bundled one, but if you need to remove a bundled add-on, check Add-on loading strategies in Confluence.

**Enabling and Configuring Macros**

Macros allow you to perform programmatic functions within a page, and can be used for generating more complex content structures.

Generally speaking, a macro is simply a command wrapped inside curly braces {...}. To learn how to write your own macro, or use macros written by other people, read the Confluence Plugin Guide.

⚠️ The information on this page does not apply to Confluence OnDemand.

**RELATED TOPICS:**

- Configuring a URL Whitelist for Macros
- Configuring the User List Macro
- Enabling HTML macros
  - Enabling the html-include Macro
- Troubleshooting the Gallery Macro

**Configuring a URL Whitelist for Macros**

This page tells you how to restrict some Confluence macros so that they can get information from authorised sources (URLs) only.

**Whitelisting URLs for the RSS and HTML Include macros**

The RSS and HTML Include macros are used to include content dynamically from other websites onto a Confluence page. The included content may possibly be malicious or harmful to your Confluence instance.

Confluence administrators can set up a list of trusted URLs, thus limiting the locations from which the RSS macro and the HTML Include macro can draw their content.

The form below allows you to define specific URLs and/or URL patterns which are trusted, or to allow inclusion from all URLs without restriction.

**To configure the URL whitelist:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select Configure Whitelist in the left-hand panel. The 'Configure Whitelist' screen will appear, as shown in the screenshot below.
3. Select one of the options as follows:
   - **Allow all domains** — There will be no restrictions to the content which can be included onto your Confluence pages.
   - **Restrict to listed domains** — Confluence will allow content from trusted URLs only. When you select this option, a textbox will open allowing you to enter specific URLs and/or URL patterns. Enter one or more URLs, each on its own line. You can enter the full URL, or use the pattern matching rules described below.
4. Click Save.
Whitelisting URLs for the RSS and HTML Include macros

URL Pattern-Matching Rules

Enter one URL or URL pattern per line. You can enter a full URL or use pattern-matching as described below:

- If the rule starts with an equals sign (=), only the exact URL following the '=' will be allowed.
- If the rule starts with a slash (/) then the whole rule will be treated as a regular expression.
- Otherwise, any asterisk (*) will be treated as a wildcard to match one or more characters.

Notes

Some things to be aware of:

- By default, the RSS and HTML Include macros are disabled in Confluence. A System Administrator can enable them on the 'Plugins' screen of the Confluence Administration Console.
- A user who has the 'Confluence Administrator' permission, but not necessarily the 'System Administrator' permission, can configure the URL whitelist for the HTML Include and RSS macros.
What Happens to a Page Containing a Disallowed URL?

A user can add the RSS Feed macro or the HTML-include macro to a Confluence page. The macro code includes a URL from which the content is drawn. When the page is displayed, Confluence will check the URL against the whitelist. If the URL is not allowed, Confluence will display an error message on the page.

The error message says that Confluence "could not access the content at the URL because it is not from an allowed source" and displays the offending URL. If the person viewing the page is a Confluence Administrator, they will also see a link to the Administration page where they can configure the URL whitelist.

Here is an example of the error message, including the link shown only to Confluence Administrators:

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
Configure whitelist >>
```

Here is an example of the error message, but without the link.

```
Could not access the content at the URL because it is not from an allowed source.
http://feathers.wordpress.com
You may contact your site administrator and request that this URL be added to the list of allowed sources.
```

Configuring the User List Macro

The User List macro has an optional Display Online parameter. If the User Listener plugin is configured to allow this feature, then the page author can select Display Online to show a list of all online users.

ℹ️ You need to have System Administrator permissions in order to perform this function.

To enable the Display Online filter in the User List macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select Plugins in the left-hand panel. This will list the currently installed plugins.
3. Scroll down and click User Listener. The User Listener plugin panel will appear at the top of the screen.
4. Enable the User Log In Listener module by clicking Enable on its right.
5. Restart Confluence.

⚠️ The information on this page does not apply to Confluence OnDemand.

ℹ️ List of online users can be misleading

When the Display Online parameter is used, Confluence uses a context listener to generate the list of online users. A context listener is a J2EE term for something that listens for events in the application server. We listen for session open and close events, so a user is 'online' if they have a session on the application server. Some application servers don't correctly despatch close events for sessions – in these cases, the list of online users may be misleading.

Screenshot: Enabling the User Log In Listener
The `{html}` macro allows you to use HTML code within a Confluence page.

The `{html-include}` macro allows you to include the contents of an HTML file in a Confluence page.

**Caution: Including unknown HTML inside a web page is dangerous.**

Because HTML can contain active scripting components, it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user's authentication cookie and give the attacker their Confluence login password.

By default, the HTML macros are disabled. You should only turn on these macros if you trust all your users not to attempt to exploit them.

You need **System Administrator** permissions in order to perform this function.

**Related pages:**

- Working with Macros
- Confluence Administrator’s Guide

**The information on this page does not apply to Confluence OnDemand.**

To enable the HTML macros:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Manage Add-ons in the left-hand panel. This will display the installed add-ons on this Confluence installation.
4. Choose Confluence HTML Macros, then choose Enable.
5. Choose 0 of 11 modules enabled to see the list of modules in the plugin.
6. Enable one or both of the following modules:
   - The `html (html-xhtml)` module for the HTML Macro.
   - The `html-include (html-include-xhtml)` module for the HTML Include Macro. Next, configure one
or more allowed sources for this macro.

Enabling the html-include Macro

The `{html-include}` macro allows you to include the content of an HTML file in a Confluence page. This page tells you how to enable the macro, so that it is available on your Confluence site. For help on using the macro, see HTML Include Macro.

![CAUTION: Including unknown HTML inside a web page is dangerous.](image)

Because HTML can contain active scripting components, it would be possible for a malicious attacker to present a user of your site with script that their web browser would believe came from you. Such code could be used, for example, to steal a user's authentication cookie and give the attacker their Confluence login password.

⚠️ The information on this page does not apply to Confluence OnDemand.

Enabling the HTML Macros

By default, the HTML macros are disabled. You should only turn on these macros if you trust all your users not to attempt to exploit them.

ℹ️ You need to have System Administrator permissions in order to perform this function.

To enable the HTML macros,

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'Plugins' in the left-hand panel. This will display the installed plugins active for this Confluence installation.
3. Click 'HTML macros', then click 'Enable Plugin'.

To embed an external page,

Use the following syntax:

```
{html-include:url=http://www.example.com}
```

To include HTML inline,

Use the following syntax:

```
{html}
<b>I like cheese</b>
{html}
```

RELATED TOPICS

- HTML Include Macro
- Include Page Macro
- Enabling HTML macros
- Enabling the html-include Macro
Adding, Editing and Removing User Macros

Writing User Macros

Troubleshooting

Troubleshooting the Gallery Macro

For guidelines on using the macro, see Gallery Macro.

Troubleshooting

If you encounter the following error message: System does not support thumbnails: no JDK image support then ensure that you have following system property available for your JVM:

```
JAVA_OPTS=-Djava.awt.headless=true
```

Also see CONF-1737

Please note that gallery-ext.jar is available at CONF-6620

The information on this page does not apply to Confluence OnDemand.

Adding, Editing and Removing User Macros

User macros are short pieces of code that perform an often-used function or add some custom formatting to a page. People can call the macro into action by adding the macro keyword to their Confluence pages. You can write a 'user macro' by adding code on a screen in the Confluence Administration Console.

Notes:

- You need System Administrator permissions in order to perform this function.
- See Shared User Macros for a list of community-donated macros.
- Be careful when installing user macros from unknown authors.
- If you remove a user macro that is in use on Confluence pages, you will need to remove the macro from the pages manually. When you remove the user macro, the usage of the macro on the page will become invalid. Hint: Use the Confluence search to find all occurrences of the macro on pages and blog posts.

The information on this page does not apply to Confluence OnDemand.

To add a user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click User Macros in the left-hand panel.
3. Click Create a User Macro at the top of the list of macros.
4. Enter the macro details as explained in the guide to writing user macros.
5. Click Add.

To edit a user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select User Macros in the left-hand panel. This will list the currently configured user macros.
3. Click Edit next to the relevant macro.
4. Update the macro details as explained in the guide to writing user macros.
5. Click Save.
To remove a user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select User Macros in the left-hand panel. This will list the currently configured user macros.
3. Click Remove next to the relevant macro.

Related Topics

Best Practices for Writing User Macros
Examples of User Macros

Writing User Macros

User macros are short pieces of code that perform an often-used function or add some custom formatting to a page. People can add the macro to a page by choosing it from the Macro Browser when editing a Confluence page. The macro is run when the page is loaded by the browser. You can write a user macro by adding code on a screen in the Confluence Administration Console.

You need to have System Administrator permissions in order to create user macros.

Do you need a plugin instead?
If you want to distribute your user macro as a plugin, please refer to the developer’s guide to the User Macro plugin module. If you want to create more complex, programmatic macros in Confluence, you may need to write a Macro plugin.

On this page:
- Creating a User Macro
- Examples and Best Practices
- Related Topics

⚠️ The information on this page does not apply to Confluence OnDemand.

Creating a User Macro

To create a user macro:

1. Go to the Confluence Administration Console and click User Macros in the left-hand panel.
2. Click Create a User Macro.
3. Supply the information in the input fields as explained below, then click Add.

The sections below tell you about each of the input fields.

Macro Name

Enter the text that people will see when looking for the macro in the Macro Browser.

Visibility

Set the visibility options to specify who can see this macro when they are searching using the Macro Browser or Autocomplete.

User macros must have parameters defined in order to appear in the Confluence 4.0 Macro Browser.

The options are as follows:
<table>
<thead>
<tr>
<th>Visibility Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible to all users</td>
<td>All users will see this macro when searching for a macro using the Macro Browser or Autocomplete.</td>
</tr>
<tr>
<td>Visible only to system administrators</td>
<td>Choose this option if you want the macro to be ‘hidden’ from most users when the users are looking for a macro to add to a page. Note that this does not completely hide the macro. Instead, it is useful if you want to avoid cluttering the Macro Browser and Autocomplete with unnecessary macros. Specifically, if you are:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Editing a page and inserting a macro using the Macro Browser:</strong> Only system administrators will see this macro in the Macro Browser. For other users, the macro will not show up in the Macro Browser when the user searches for a macro to add to a page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Editing a page and inserting a macro using Autocomplete:</strong> Only system administrators will see this macro in Autocomplete. For other users, the macro will not show up in the Autocomplete list when the user searches for a macro to add to a page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Viewing the page:</strong> The macro output will be visible to all users who have permission to see the page.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Editing a page that already contains the macro:</strong> Provided a user has permission to edit the page, the macro will be visible to all users when editing the page, and all users who have permission to edit the page will also be able to edit or remove the macro.</td>
</tr>
</tbody>
</table>

Please note that all the macro information will also be discoverable, including the macro title, description, parameter names and other metadata. Do not include confidential data anywhere in the definition of a user macro, even if it is marked as visible only to system administrators.

**Macro Title**

Enter the text that should appear in the Macro Browser and in Autocomplete, to identify this macro when people are looking for it to insert onto a page.

**Description**

Enter the text that should appear in the Macro Browser describing this macro. Note that the Macro Browser's search will pick up matches in the description as well as in the title.

**Categories**

Select one or more categories for your macro. To select more than one category, hold down the ‘Ctrl’ key while
selecting. These are the categories that appear in the Macro Browser, helping users to choose a macro from a logical set.

**Icon URL**

If you would like the Macro Browser to display an icon for your macro, enter the URL here. You can enter an absolute URL or a path relative to the Confluence base URL. For example:

- **Absolute URL:**
  
  ```
  http://mysite.com/mypath/status.png
  ```

- **Relative URL:**
  
  ```
  /images/icons/macrobrowser/status.png
  ```

**Documentation URL**

Enter the URL pointing to the online help or other documentation for your macro.

**Macro Body Processing**

Specify how you want Confluence to process the body of your macro before passing it to your macro. Below is an explanation of the macro body and the options available.

**What is the macro body?**

The macro body is the content that is displayed on the wiki page. If the macro allows a body, users will be able to enter body content when configuring the macro in the Macro Browser.

**How can I use the macro body?**

If you specify that your macro has a body, you will be able to pass text to the macro when you invoke it from within a page.

If your macro has a body, any body content that the user enters will be available to the macro in the `@body` variable. See the section about the template below. In addition, the options below allow you to tell Confluence to pre-process the body before it is placed in the macro output.

**What are the options for macro body?**

<table>
<thead>
<tr>
<th>Body Processing Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>No macro body</td>
<td>Select this option if your macro does not need a body.</td>
</tr>
</tbody>
</table>
| **Escaped** | If your macro has a body, and you make use of the body as $body in your template, Confluence will add escape characters to the HTML markup in the macro body. You could use this if you want to show the HTML markup in the rendered page. For example, if the body is:

```
<b>Hello World</b>
```

Then value of $body will be:

```
&lt;b&gt;Hello World&lt;/b&gt;
```

This will render as:

```
<b>Hello World</b>
```

| **Unrendered** | If your macro has a body, and you make use of the body as $body in your template, HTML in the body will be processed within the template before being output. Ensure that HTML is ultimately output by the template. |
| **Rendered** | If your macro has a body, and you make use of the body as $body in your template, Confluence will recognise HTML in the macro body. For example, if the body is:

```
<b>Hello World</b>
```

Then value of $body will be:

```
<b>Hello World</b>
```

This will render as:

```
Hello World
```

---

**Template**

Enter code to specify what the macro will do. For example, to add a macro inside the macro you are writing, you would write:

```
<ac:macro ac:name="someOtherMacro" />
```
Quick guide:

- Use HTML and Confluence-specific XML elements in the macro template. Details of Confluence's storage format are in Confluence Storage Format.
- You can use the Velocity templating language. Here is more information on the Velocity project.
- If your macro has a body, your template can refer to the macro body text by specifying '$body'.
- Each parameter variable you use must have a matching metadata definition. Use @param to define metadata for your macro parameters.
- When using the information passed using parameters, refer to your parameters as $paramXXX where 'XXX' is the parameter name that you specified in the @param metadata definition.
- Use @noparams if your macro does not accept parameters.

See our detailed guide to writing a user macro template.

Examples and Best Practices

See:

- Examples of User Macros
- Best Practices for Writing User Macros

Related Topics

Developer documentation:

- User Macro Module
- Macro Module
- Confluence Plugin Guide

Library of user-contributed user macros

- Shared User Macros

Be careful when installing user macros. Ideally use only macros from authors and sources that are well known to you.

Best Practices for Writing User Macros

This section contains tips and suggestions for best practice in macro coding. To see how to write a user macro and add it to your Confluence site, take a look at our guide to writing user macros.

⚠️ The information on this page does not apply to Confluence OnDemand.

Add a Descriptive Header to your Macro Template

We recommend that you include a short description of your macro via comments at the top of the Template field as shown below. You can see an excellent example in the 'Image rollover' user macro.
Exceed your Parameters in the Macro Browser

Confluence offers great options for making your macro look good in the macro browser. You can specify the macro category, link to an icon, define the parameters that the macro browser will use to prompt the user for information, and more.

In particular, read the documentation on defining the macro parameters to be displayed in the macro browser.

Supply Default Values for Macro Parameters

You cannot guarantee that a user will supply parameters, so one of the first things to do in the macro is check that you have received some value if you expect to rely on it later on in the macro code.

In the example below, the macro expects three parameters. It substitutes sensible defaults if they are not supplied:

```plaintext
#set($spacekey= $paramspacekey)
#set($numthreads= $paramnumthreads)
#set($numchars= $paramnumchars)

## Check for valid space key, otherwise use current
#if (!$spacekey)
    #set ($spacekey=$space.key)
#end

## Check for valid number of threads, otherwise use default of 5
#if (!$numthreads)
    #set ($numthreads=5)
#end

## Check for valid excerpt size, otherwise use default of 35
#if (!$numchars)
    #set ($numchars=35)
#end
```

Related Topics

Writing User Macros

Examples of User Macros

Below are some sample user macros. To see how to write a user macro and add it to your Confluence site, take a look at our guide to writing user macros.

Example 1: A macro that displays 'Hello World'

Take a look at an example of a 'Hello World' macro.
Example 2: The 'Error' macro that creates a red box

Let's write a simple macro that creates a red box (using an existing Confluence style) around some text. See Error Box Macro - Example of a User Macro.

Example 3: A macro that demonstrates the use of parameters

See Colour and Size Macro - Example of a User Macro.

Example 4: A macro that prevents text from being printed

See NoPrint Example of a User Macro.

Example 5: A macro that creates a preformatted panel

This user macro creates a panel preformatted with specific colours. See Panel Preformatted with Specific Colours - Example of a User Macro.

Example 6: A macro that creates a preformatted table

This user macro creates a table with predefined headings. See Preformatted Table - Example of a User Macro.

Community-contributed user macros

You may want to take a look at the library of shared user macros. Be careful when installing user macros from unknown authors.

Hello World Example of User Macro

This page tells you how to create a user macro that displays the text 'Hello World!' and any text that the user places in the body of the macro. For full details about creating a user macro, see the guide to writing user macros.

Defining the 'Hello World' user macro

To create the 'Hello World' user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: helloworld
   - Visibility: Visible to all users in the Macro Browser
- **Macro Title:** Hello World
- **Description:** Displays "Hello World" and the macro body.
- **Categories:** Confluence Content
- **Icon URL:** You can leave this field empty.
- **Documentation URL:** You can leave this field empty.
- **Macro Body Processing:** Rendered
- **Template:**

```template
## @noparams
Hello World!
$body
```

5. Choose **Save**.

**Related pages:**
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

⚠️ *The information on this page does not apply to Confluence OnDemand.*

_Screenshot: Defining the 'Hello World' user macro_
Using the ‘Hello World’ macro on a page

Now you can add the macro to your Confluence page using the Macro Browser.

The result is:
You can also use autocomplete to add the macro onto your page: start typing '{hello' in the editor, and select the 'Hello World' macro from the list of suggestions that appears.

**Error Box Macro - Example of a User Macro**

Let's write a simple macro that creates a red box (using an existing Confluence style) around some text. This may be useful for writing about error conditions, for example. For full details about creating a user macro, see the guide to writing user macros.

**Defining the 'Error' user macro**

To create the 'Error' user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - **Macro Name:** error
   - **Visibility:** Visible to all users in the Macro Browser
   - **Macro Title:** Error
   - **Description:** Displays a red box around some text
   - **Categories:** Confluence Content
   - **Icon URL:** You can leave this field empty.
   - **Documentation URL:** You can leave this field empty.
   - **Macro Body Processing:** Rendered
   - **Template:**

```
## @noparams
<div class="error">$body</div>
```

5. Choose Save.

**Related pages:**

- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

⚠️ The information on this page does not apply to Confluence OnDemand.

**Using the ‘Error’ macro on a page**

To add the macro to a page, edit the page and choose Insert > Other Macros and find the 'Error' macro. (Or use autocomplete: start typing ‘err’ in the editor, and select the 'Error' macro from the list of suggestions that appears.)

Your page will display an error box, like this:
Colour and Size Macro - Example of a User Macro

This example demonstrates how you can pass parameters into your macro. Let’s say you want to write your own font colour macro, with a parameter allowing the user to specify the colour. Then perhaps you want to add another parameter, that allows the user to specify the font size.

For full details about creating a user macro, see the guide to writing user macros.

Defining the ‘Colour’ user macro

This example uses a single parameter.

To create the ‘Colour’ user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: colour
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: Colour
   - Description: Colours a block of text
   - Categories: Confluence Content
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Rendered
   - Template:

```
## @param 0:title=colour|type=string
<span style="color: $param0">$body</span>
```

5. Choose Save.

Related pages:
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

The information on this page does not apply to Confluence OnDemand.

Using the ‘Colour’ macro on a page

To add the macro to a page, edit the page and choose Insert > Other Macros and find the ‘Colour’ macro. (Or use autocomplete: start typing ‘colo’ in the editor, and select the ‘Colour’ macro from the list of suggestions that appears.)

Defining the ‘Stylish’ user macro

If your macro requires more than one parameter, you can use variables $param0 to $param9 to represent them. Let's say that you want to add a parameter that allows the user to specify the size of the text.

Enter the macro attributes as follows:

- Macro Name: stylish
• Visibility: Visible to all users in the Macro Browser
• Macro Title: Stylish
• Description: Applies colour and size to text
• Categories: Confluence Content
• Icon URL: You can leave this field empty.
• Documentation URL: You can leave this field empty.
• Macro Body Processing: Rendered
• Template:

```
## @param 0:title=colour|type=string
## @param 1:title=size|type=string
<span style="color: $param0; font-size: $param1">$body</span>
```

**Naming your parameters**

Alternatively, you can also use explicitly-named parameters in your macro. These macro parameters will appear as variables with the name $param<x>$ where <x> is the name of your parameter.

```
## @param Colour:title=colour|type=string
## @param Size:title=size|type=string
<span style="color: $paramColour; font-size: $paramSize">$body</span>
```

**NoPrint Example of a User Macro**

This page gives an example of a user macro, the 'NoPrint' macro, that you can use to prevent text from being printed. For full details about creating a user macro, see the guide to writing user macros.

**Defining the 'NoPrint' user macro**

To create the 'NoPrint' user macro:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   • Macro Name: noprint
   • Visibility: Visible to all users in the Macro Browser
   • Macro Title: NoPrint
   • Description: Hides text from printed output.
   • Categories: Confluence Content
   • Icon URL: You can leave this field empty.
   • Documentation URL: You can leave this field empty.
   • Macro Body Processing: Rendered
   • Template:

```
## @noparams
<div class="noprint">$body</div>
```

5. Choose Save.
Using the 'NoPrint' Macro on a page

Now you can add the macro to your Confluence page using the Macro Browser. Text entered into the body of the macro placeholder will not be printed, but will appear when the page is viewed online.

```
<table>
<thead>
<tr>
<th>NoPrint</th>
</tr>
</thead>
<tbody>
<tr>
<td>This text will not be printed.</td>
</tr>
</tbody>
</table>
```

Making the PDF export recognise the NoPrint macro

See Advanced PDF Export Customisations.

Panel Preformatted with Specific Colours - Example of a User Macro

This user macro creates a panel pre-formatted to specific colours. It will create a panel that looks like this:

```
|     |
|     |
|     |
|     |
|     |
```

Note: The panel's title will be empty if the user does not give a value for the title parameter.

Defining the 'Formatted Panel' user macro

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: formpanel
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: Formatted Panel
   - Description: Creates a panel preformatted with specific colours
   - Categories: Formatting
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Escaped
   - Template:
5. Choose **Save**.

**Explanation of the code in the macro template**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>## @param Title:title=Title</td>
<td>type=string</td>
</tr>
<tr>
<td>@param Title</td>
<td>This parameter is called &quot;Title&quot;.</td>
</tr>
<tr>
<td>title=Title</td>
<td>defines the parameter title that will appear in the macro dialog window as &quot;Title&quot;.</td>
</tr>
<tr>
<td>type=string</td>
<td>defines the field type for the parameter as a text field.</td>
</tr>
<tr>
<td>desc=Title</td>
<td>defines the description of the parameter.</td>
</tr>
</tbody>
</table>
This command activates the Confluence **Panel** macro.

**Hint:** To discover the code name of a Confluence macro, see [Confluence Storage Format for Macros](#). If the macro you want is not documented there, follow these steps:

1. Create and save a page containing a Confluence macro you want to investigate.
2. Choose **Tools > View Storage Format**. This option is available to Confluence administrators only, and shows the XML source code for the page. (See [Confluence Storage Format](#).)
3. A Confluence macro starts with the following string: `<ac:macro ac:name="`.

```
<ac:parameter ac:name="titleBGColor">#ccc</ac:parameter>
<ac:parameter ac:name="borderStyle">solid</ac:parameter>
<ac:parameter ac:name="borderColor">#6699CC</ac:parameter>
<ac:parameter ac:name="borderWidth">2</ac:parameter>
<ac:parameter ac:name="titleColor">#000000</ac:parameter>
```

Sets the parameters for the macro: the background colour, border style, border colour, border width and title colour.

**Hint:** To discover the names of the parameters for a Confluence macro, see [Confluence Storage Format for Macros](#). If the macro you want is not documented there, follow these steps:

1. Create and save a page containing a Confluence macro you want to investigate.
2. Choose **Tools > View Storage Format**. This option is available to Confluence administrators only, and shows the XML source code for the page. (See [Confluence Storage Format](#).)
3. The macro parameters start with the following string: `<ac:parameter ac:name=

```
<ac:parameter ac:name="title">$!paramTitle</ac:parameter>
```

Enters the value stored in the 'Title' parameter into the title section of the macro.

The `!` tells the macro to leave the title blank, when there is no data in the "Title" parameter.

```
<ac:rich-text-body>$body</ac:rich-text-body>
```

Users can enter data that is stored in the body of the macro. This line enables the macro to access and store the body content passed to your macro.

```
</ac:macro>
```

This command marks the end of the macro.

### Preformatted Table - Example of a User Macro

This user macro creates a 2 x 2 table, with the headings defined as 'Parameter' and 'Description'. It will create a table that looks like this:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>

Created in 2013 by Atlassian. Licensed under a [Creative Commons Attribution 2.5 Australia License](#).
Note: As the macro is written, the user cannot amend the heading titles when using the macro on a Confluence page.

Related pages:
- Writing User Macros
- Guide to User Macro Templates
- Examples of User Macros

⚠️ The information on this page does not apply to Confluence OnDemand.

Defining the 'Formatted Table' user macro

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose User Macros in the left-hand panel.
3. Choose Create a User Macro at the bottom of the list of macros.
4. Enter the macro attributes as follows:
   - Macro Name: formtable
   - Visibility: Visible to all users in the Macro Browser
   - Macro Title: Formatted Table
   - Description: Creates a simple 2 x 2 table with the column headings filled in
   - Categories: Formatting
   - Icon URL: You can leave this field empty.
   - Documentation URL: You can leave this field empty.
   - Macro Body Processing: Escaped
   - Template:

```
## @param Head1:type=string|desc=Heading
## @param Head2:type=string|desc=Heading
## @param Cell1:type=string|desc=cell
## @param Cell2:type=string|desc=cell
#set ($paramHead1 ="Parameter")
#set ($paramHead2 ="Description")

<div id="preformattedtable">
<table>
<tr>
<th>$paramHead1</th>
<th>$paramHead2</th>
</tr>
<tr>
<td>$!paramCell1</td>
<td>$!paramCell2</td>
</tr>
</table>
</div>
```

5. Choose Save.

Using the macro on a Confluence page

To add the macro to a page:

1. In the Confluence editor, choose Insert > Other Macros.
2. Find and select the 'Formatted Table' macro.
3. Enter the cell contents into the form.
4. Choose Insert.
Amending the contents of the table

To change the content in the cells of the table:

1. Edit the page.
2. Click the macro placeholder for the 'Formatted Table' macro, to see the properties panel.
3. Choose Edit.
4. Enter the cell contents into the form.
5. Choose Save

Note: Content entered into the body of the 'Formatted Table' macro will not appear on the page.

Guide to User Macro Templates

You can create a user macro in Confluence by typing it into a screen in the Confluence Administration Console. The ‘template’ is one of the fields that you define when writing a user macro. (See the rest of the guide to writing user macros.) This page gives you guidelines about the code you can enter in a user macro template.

Quick guide to user macro templates:

- Use HTML and Confluence-specific XML elements in the macro template. Details of Confluence’s storage format are in Confluence Storage Format.
- You can use the Velocity templating language. Here is more information on the Velocity project.
- If your macro has a body, your template can refer to the macro body text by specifying ’$body’.
- Each parameter variable you use must have a matching metadata definition. Use @param to define metadata for your macro parameters.
- When using the information passed using parameters, refer to your parameters as $paramXXX where ‘XXX’ is the parameter name that you specified in the @param metadata definition.
- Use @noparams if your macro does not accept parameters.

On this page:
- Accessing your macro’s body
- Using parameters in your user macro
- Objects available to your macro
- Controlling parameter appearance in the editor placeholder

Related pages:
- Writing User Macros
- Examples of User Macros

⚠️ The information on this page does not apply to Confluence OnDemand.

Accessing your macro’s body

Use the $body object within your user macro template to access the content passed to your macro in the macro body.

The $body object is available if you have specified that your macro has a body (in other words, if you have not selected No macro body).

Example: Let’s assume your macro is called helloworld.

Enter the following code in your template:

```
Hello World: $body
```
A user, when editing a Confluence page, chooses your macro in the macro browser and then enters the following in the macro placeholder that is displayed in the edit view:

```
From Matthew
```

The wiki page will display the following:

```
Hello World: From Matthew
```

### Using parameters in your user macro

You can specify parameters for your macro, so that users can pass it information to determine its behaviour on a Confluence page.

#### How your macro’s parameters are used on a Confluence page

When adding a macro to a Confluence page, the macro browser will display an input field for each of your macro’s parameters. The field type is determined by the parameter type you specify for each parameter.

### Defining the parameters

A parameter definition in the template contains:

- @param
- The parameter name
- A number of attributes (optional)

Format:

```
## @param MYNAME:title=MY TITLE|type=MY TYPE|desc=MY
DESCRIPTION|required=true|multiple=true|default=MY DEFAULT VALUE
```

Additional notes:

- The order of the parameters in the template determines the order in which the macro browser displays the parameters.
- We recommend that you define the parameters at the top of the template.
- There may be additional attributes, depending on the parameter type you specify.

The sections below describe each of the attributes in detail.

<table>
<thead>
<tr>
<th>Attribute name</th>
<th>Description</th>
<th>Required / Recommended / Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>(an unnamed, first attribute)</td>
<td>A unique name for the parameter. The parameter name is the first attribute in the list. The name attribute itself does not have a name. See the section on name below.</td>
<td>Required</td>
</tr>
<tr>
<td>title</td>
<td>The parameter title will appear in the macro browser. If you do not specify a title, Confluence will use the parameter name.</td>
<td>Recommended</td>
</tr>
<tr>
<td><strong>Parameter</strong></td>
<td><strong>Description</strong></td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>The field type for the parameter. Refer to the section on type below. Recommended.</td>
<td></td>
</tr>
<tr>
<td>desc</td>
<td>The parameter description will appear in the macro browser. Optional.</td>
<td></td>
</tr>
<tr>
<td>required</td>
<td>Specifies whether the user must enter information for this parameter. Defaults to 'false'. Optional.</td>
<td></td>
</tr>
<tr>
<td>multiple</td>
<td>Specifies whether the parameter accepts multiple values. Defaults to 'false'. Optional.</td>
<td></td>
</tr>
<tr>
<td>default</td>
<td>The default value for the parameter. Optional.</td>
<td></td>
</tr>
</tbody>
</table>

Parameter name

The parameter name is the first attribute in the list. The name attribute itself does not have a name.

**Example:** The following code defines 2 parameters, named 'foo' and 'bar':

```
## @param foo
## @param bar
```

Parameter type

The field type for the parameter. If you do not specify a type, the default is *string*.

#### Parameter type

<table>
<thead>
<tr>
<th>Parameter type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boolean</td>
<td>Displays a checkbox to the user and passes the value 'true' or 'false' to the macro as a string.</td>
</tr>
</tbody>
</table>
| enum           | Offers a list of values for selection. You can specify the values to appear in a dropdown in the macro browser. Example of specifying the enum values:  

```
## @param
colour:title=Colour|type=enum
|enumValues=Grey,Red,Yellow,Green
```

*Note about i18n:* Confluence does not support internationalisation of the enum values. The value the user sees is the one passed to the macro as the parameter value, with the capitalisation given. In this case 'Grey', 'Red', etc.
<table>
<thead>
<tr>
<th>Field Type</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| string             | A text field. This is the default type. Example with a required field:       | ```
## @param
status:title=Status|type=string|required=true|desc=Status to display
``` |
| confluence-content | Offers a control allowing the user to search for a page or blog post. Example: | ```
## @param
page:title=Page|type=confluence-content|required=true|desc=Select a page to use
``` |
| username           | Search for user.                                                            | ```
## @param
user:title=Username|type=username|required=true|desc=Select username to display
``` |
| spacekey           | Offers a list of spaces for selection. Passes the space key to the macro.   | ```
## @param
space:title=Space|type=spacekey
``` |
| date               | Confluence accepts this type, but currently treats it in the same way as 'string'. Example: | ```
## @param
fromDate:title=FromDate|type=date|required=true|desc=Date to start from. Format: dd/mm/YYYY
```  

**Note about dates:** A user can enter a date in any format, you should validate the date format in your user macro.
<table>
<thead>
<tr>
<th>int</th>
<th>Confluence accepts this type, but currently treats it in the same way as 'string'. Example with a default value:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td># @param numPosts:title=Number of Posts</td>
</tr>
<tr>
<td>percentage</td>
<td>Confluence accepts this type, but currently treats it in the same way as 'string'. Example:</td>
</tr>
<tr>
<td></td>
<td># @param pcent:title=Percentage</td>
</tr>
</tbody>
</table>

Using the parameters in your macro code

The parameters are available in your template as $paramfoo, $parambar for parameters named "foo" and "bar".

Normally, a parameter like $paramfoo that is missing will appear as '$paramfoo' in the output. To display nothing when a parameter is not set, use an exclamation mark after the dollar sign like this: $!paramfoo

Using no parameters

If your macro does not accept parameters, you should use @noparams in your template. That will let Confluence know that it need not display a parameter input field in the macro browser.

If the user macro contains no parameters and does not specify @noparams, then the macro browser will display a free-format text box allowing users to enter undefined parameters. This can be confusing, especially if the macro does not accept parameters.

Example: Add the following line at the top of your template:

```plaintext
## @noparams
```

Objects available to your macro

Including the macro body and parameters, the following Confluence objects are available to the macro:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Class Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>$body</td>
<td>The body of the macro (if the macro has a body)</td>
<td>String</td>
</tr>
<tr>
<td>$paramfoo, $parambar, ... $param&lt;name&gt;</td>
<td>Named parameters (&quot;foo&quot;, &quot;bar&quot;) passed to your macro.</td>
<td>String</td>
</tr>
</tbody>
</table>
### $config
The BootstrapManager object, useful for retrieving Confluence properties.

### $renderContext
The PageContext object, useful for (among other things) checking $renderContext.outputType

### $space
The Space object that this content object (page, blog post, etc) is located in (if relevant).

### $content
The current ContentEntity object that this macro is a included in (if available).

Macros can also access objects available in the default Velocity context, as described in the developer documentation.

**Controlling parameter appearance in the editor placeholder**

You can determine which macro parameters should appear in the placeholder in the Confluence editor.

By default as many parameters as can fit will be displayed in the placeholder, as shown here:

You can control which parameters you want to display here, to ensure the most relevant information is visible to the author.

For example, the Confluence Warning macro has two parameters, `title` and `icon`. We consider `title` to be the most interesting parameter, so we have configured the Warning macro to show only the value of the `title` parameter.

Let's assume an author adds the Warning macro to a page, and gives it a title of 'The title of the warning'. The macro configuration leads to a placeholder as shown here:

To configure the macro placeholder for a user macro, you will add attributes to the @param entry in the template.

For example, if our Warning macro is a user macro, the configuration for the `title` parameter is as follows:

```bash
## @param
title:type=string|option-showNameInPlaceholder=false|option-showValueInPlaceholder=true
```
The attribute `showNameInPlaceholder` specifies that the `title` parameter's `name` should not be shown.

The attribute `showValueInPlaceholder` specifies that the `title` parameter's `value` should be shown.

If none of the parameters in a macro include any of the above attributes, then the default behaviour is to show all the parameters that fit in the placeholder: full title and value.

If one or more parameters has either attribute set, then all parameters that do not include the attributes will default to false (that is, they will not be shown).

**Configuring the Office Connector**

The Office Connector is a Confluence add-on that allows Confluence users to interact with Microsoft Office and Open Office in various ways. You can display content from Office documents on a wiki page and import content from an Office document into Confluence. Please refer to the User Guide for details of these interactions.

The Office Connector add-on is shipped with Confluence. A System Administrator can enable or disable parts of the Office Connector and can configure options as described below.

**Enabling and Disabling the Office Connector and its Modules**

The Office Connector is bundled with Confluence, so you should not need to install it. But you may wish to enable or disable some of its modules.

**To enable or disable the Office Connector and its modules:**

1. Select **Manage Add-ons** in the left-hand panel of the Confluence Administration Console.
2. Click **Show system add-ons** under ‘System Add-ons’.
3. Enter ‘Office Connector’ in the **Filter Visible add-ons** field to quickly find the Office Connector add-on.
4. Open the details view of the add-on by clicking on the Office Connector add-on in the system add-ons list.
5. From the details view, you can:
   - Click **Configure** to specify preferences for the Office Connector. This open the configuration screen described below.
   - Click **Disable** to disable all modules of the add-on.
   - View the **modules** that make up the add-on by expanding the modules list. You can enable or disable certain Office Connector modules.

---

**On this page:**

- Enabling and Disabling the Office Connector and its Modules
- Configuring the Office Connector Options

**Related pages:**

- Office Connector Prerequisites
- Office Connector Limitations and Known Issues
- Working with the Office Connector
- Managing Add-ons and Macros

---

⚠️ *The information on this page does not apply to Confluence OnDemand.*

**To disable or enable a module:**

1. Open the details view for the Office Connector add-on in the ‘Manage Add-ons’ page.
2. Expand the active modules link. The text of this link indicates the number of enabled modules out of the total modules in the add-on.
3. Hover over the module in the list to make the **Enable** or **Disable** button visible, and click the button to apply the action.

Only certain Office Connector modules can be disabled. Modules that are integral to the operation of the add-on cannot be disabled, and do not have an **Enable** or **Disable** button. Modules that can be disabled include the button and provide a brief, on-screen description of the module.

### Configuring the Office Connector Options

Confluence administrators can configure settings that control the behaviour of the Office Connector on your Confluence site.

**To set the configuration options for the Office Connector:**

1. Select **Office Connector** under 'Configuration' in the left-hand panel of the 'Confluence Administration Console'. The 'Configure Office Connector plugin' screen appears.
2. Set the configuration options as described in the table below.

The configuration options are described in the table below:

<table>
<thead>
<tr>
<th>Option</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit in word button location</td>
<td>Page action icon</td>
<td>Where the button for editing the content in Word is located. You can configure the button to appear in the page action icon or from the view page tab.</td>
</tr>
<tr>
<td>Feature</td>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Warnings:</strong> Show a warning before allowing a user to perform an import</td>
<td>Disabled</td>
<td>If this option is enabled, the user will receive a warning when importing a Word document. The warning will tell the user when they are about to overwrite existing content.</td>
</tr>
<tr>
<td><strong>Advanced Formatting Options:</strong> Use the footnote macro for Word footnotes</td>
<td>Disabled</td>
<td>If this option is enabled, a Confluence page created from an imported Word document will use the {footnote} macro from Adaptavist to render any footnotes contained in the document. Note that you will need to install the Footnotes add-on onto your Confluence site. For more information about this add-on and macro, please refer to the Footnotes add-on.</td>
</tr>
<tr>
<td><strong>Authentication:</strong> Allow authentication tokens in the URL path</td>
<td>Disabled</td>
<td>If this option is enabled, the Office Connector will use authentication tokens in the URL.</td>
</tr>
<tr>
<td><strong>Temporary storage for viewfile macro</strong></td>
<td>The Confluence Home directory.</td>
<td>The {viewfile} macro will cache data temporarily. This option allows you to set the location of the cache. Available settings are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Confluence home directory</strong> – The temporary file will be stored in your Confluence Home directory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>A directory specified in the directories.properties file</strong> – You can specify a location by editing the Office Connector's directories.properties file:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Go to the bundled-plugins directory in your Confluence Home directory.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Copy the Office Connector JAR file to a temporary location: OfficeConnector-x.xx.jar, where 'x.xx' is the version number.</td>
</tr>
</tbody>
</table>
3. Unzip the JAR file and find the `directories.properties` file in the `resources` directory. The content of the file looks like this:

```properties
#Complete the following line to set a custom cache directory.
#If resetting to blank, don't delete anything before or including the '='
com.benry.an.confluence.word.edit.cacheDir=
```
4. Edit the last line, adding the path to your required temporary location directly after the '=' character. For example:
   - On Windows:
     
     ```
     com.be
     nryan.
     conflu
     ence.w
     ord.ed
     it.cac
     heDir=
     c:\my\path\n     ```
   - On Linux:
     
     ```
     com.be
     nryan.
     conflu
     ence.w
     ord.ed
     it.cac
     heDir=
     /home/
     myuser
     name/m
     y/path
     ```

5. Save the file, recreate the JAR and put it in the `bundled-plugins` directory in your Confluence Home directory, overwriting the original JAR.

   - **Cache in-memory** – The temporary file will be held in memory. We recommend this option if you are running in a clustered environment.

| Maximum file space for cache (MB) | 500 | This is the maximum size of the cache used by the `{viewfile}` macro. (See above.) |
| Number of Conversion Queues | 6 | This is the maximum number of threads used to convert PowerPoint or PDF slide shows. You can use this setting to manage Confluence performance, by limiting the number of threads so that the Office Connector does not consume too many resources. Click Manage Queues to view attachments that are still pending conversion. |

**Customising your Confluence Site**

This page is an introduction to customising Confluence at site level. This is of interest to Confluence administrators – people with System Administrator or Confluence Administrator permissions.

For guidelines on customisations at a personal and space level, see the user’s guide to Customising Confluence.

We have documented the customisations under two broad headings:

- You can change the **appearance** of Confluence by customising the dashboard, adjusting the colours, adding a site logo, and more. See Changing the Look and Feel of Confluence.
- You can determine the **default behaviour** by setting various options, or define the **default content** that appears in new spaces, on the dashboard, and in other Confluence locations. See Changing the Default Behaviour and Content in Confluence.

**Related pages:**

- Managing Add-ons and Macros *(Not applicable to Confluence OnDemand.)*
- Integrating Confluence with Other Applications *(Not applicable to Confluence OnDemand.)*
- Tracking Customisations Made to your Confluence Installation *(Not applicable to Confluence OnDemand.)*
- Confluence Administrator’s Guide

**Changing the Look and Feel of Confluence**

You can customise the 'look and feel' of Confluence at both the site (global) and space levels.

Any changes you make to the look and feel at site level will be applied as the default look and feel for all the spaces in the site. This means that any customisations will only be reflected in the "Default" theme. No other theme will have an impact from this change. An individual space can be configured to have its own look and feel through the **space administration screens**.

**Ways to customise the look and feel of your site:**

- Change the appearance of the **dashboard**. See Customising the Confluence Dashboard.
- Add your own site logo. See Changing the Site Logo.
- Change the **colour scheme** of the user interface. See Customising Colour Schemes.
- Use **themes** for advanced layout customisation. See Working with Themes.
- Change the **site or space layouts**, which determine how the controls are laid out in the site. This does not change the actual page layouts, but it does change the way the surrounding controls appear in the page. See Customising Site and Space Layouts. *(Not applicable to Confluence OnDemand.)*
- Apply more advanced configurations – see the children of this page.
Customising the Confluence Dashboard

If you are a Confluence Administrator, you can customise the site dashboard, affecting the way all users will see the dashboard. Some of the actions below require Confluence Administrator permissions, whereas others require System Administrator permissions.

Confluence users can customise their own view of the dashboard too. See the user's guide.

**Sending users to a space home page instead of the dashboard**

See Configuring the Site Home Page.

**Editing the top left-hand section of the dashboard**

See Editing the Site Welcome Message.

**Disabling the 'Popular' tab on the dashboard**

In some environments, you may prefer not to display the 'Popular' tab on the dashboard. For example, if your wiki allows only a small group of people to log in and contribute content or comments, then the tab may not be relevant to you.

To prevent the tab from appearing, you can disable the relevant plugin module. You need System Administrator permissions to do this. Go to the Dashboard Macros plugin (See Configuring a Plugin), choose Manage plugin modules and disable the Popular Tab module.

---

**Advanced customisations**

These configurations require knowledge of plugin development and/or the Velocity template language. See our guide to the Atlassian Plugin SDK and our introduction to Velocity.

**Editing the bottom left-hand section of the dashboard**

This section can be updated using Confluence web panels. You can add items to the dashboard by including a web panel with the key `atl.dashboard.left`:
You can remove the existing entities panel by disabling the global-entities-panel plugin from the dashboard macros plugin.

**Editing the top right-hand action bar**

You can add more links to the top right navigation bar by adding web items to `system.dashboard.button`:

```
<web-item key="{key}" name="{name}" section="system.dashboard.button">
    <label key="{label}"/>
    <link/>
    <styleClass/>
</web-item>
```

**Modifying the global template or layout**

You can also modify files to add content to the global dashboard.

To make modifications to the dashboard, modify the global template `/confluence/decorators/global.vm` or the layout at `Confluence Admin > Layouts > Global Layout`.

For example, search the global layout for these macros:

```
$helper.renderConfluenceMacro("{recently-updated-dashboard:dashboard|showProfilePic=true}"")
```

To modify the bundled plugin macros used in the Confluence dashboard:

2. Update the `confluence-dashboard-macros-x.x.jar` file, rezip it and then put it back to `<Confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup`. Refer to How to Edit Files in Confluence JAR Files
3. Delete the JAR from `<confluence-home>/bundled-plugins`.
4. Restart Confluence.

To customise the space list, you can work with `spacelist.vm`.

**Changing the Site Logo**

You can customise the look and feel of your Confluence site by changing the logos.

You can change:

- the **site logo**
- the **default space logo** for all spaces
- the **space logo** for individual spaces.

_Screenshot: Location of the Site Logo and Space Logo in Confluence._
Changing the site logo

The Site Logo appears in the header and is visible throughout Confluence.

You need to be a Confluence Administrator to change the site logo.

To change the site logo:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Site Logo in the left-hand panel.
3. Choose Browse to upload a new logo
4. Choose Show Logo Only or Show Logo and Title depending on whether you wish the Site Title to display in the header
5. Choose Save.

Confluence’s Auto Look and Feel will detect the colours in your new logo, and change the site colour scheme to match.

If you would prefer to use the default colour scheme with your custom logo go to Confluence Admin > Colour Scheme > Edit and then choose Reset to revert back to the default scheme.

Screenshot: Header showing Site Logo, Site Title and auto look and feel changes to the colour of the header

Changing the default space logo

The Space Logo appears in the sidebar and as an icon in the Sites Directory. If you are using the Documentation theme the Space Logo displays beside the Space Title.
The default space logo applies to all spaces that do not have a custom space logo applied - see Changing a Space's Logo.

You need to be a Confluence Administrator to change the default space logo.

To change the default space logo:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Default Space Logo in the left-hand panel.
3. Choose Logo:ON
4. Choose Browse to upload a new logo
5. Choose Upload Logo
6. Choose Save.

Screenshot: Confluence spaces showing the default logo, and a space with a customised logo

Changing a specific space logo

Space Administrators can change the logo for their space. This overrides the default space logo and any changes to the default space logo will not appear in these spaces. See example above - ‘Sample Space’ has a custom logo.

See Changing a Space's Logo to find out how to change the logo in a specific space.

Customising Colour Schemes

Confluence administrators can configure a new colour scheme for the site. The default colour scheme for the site will also become the default for all spaces within it. Space administrators can configure a different colour scheme for spaces. The space colour scheme will override the site-wide colour scheme.

To change the site’s colour scheme:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Colour Scheme in the left-hand panel.
3. Choose Edit.
4. Enter standard HTML/CSS2 colour codes, or use the colour-picker to choose a new colour from the palette provided.
5. Choose Save. Any changes you make will immediately be reflected across the Confluence site.
Some UI elements below are for specific themes, and colour changes may not take effect for other themes.

- **Top Bar** - the top navigation bar background
- **Top Bar Text** - the text on the top navigation bar
- **Header Button Background** - buttons on the top navigation bar (e.g. Create button)
- **Header Button Text** - the text on buttons on the top navigation bar
- **Top Bar Menu Selected Background** - background colour of top navigation bar menu items when selected (e.g. spaces)
- **Top Bar Menu Selected Text** - text colour of top navigation bar menu items when selected
- **Menu Item Selected Background** - highlight colour on top navigation bar drop down menu items
- **Menu Item Selected Text** - text colour on highlighted top navigation bar drop down menu items
- **Page Menu Selected Background** - the background colour of the drop down page menu when selected
- **Page Menu Item Text** - the text of the menu items in the drop down page menu
- **Heading Text** - all heading tags throughout the space
- **Space Name Text** - the text of the current space name located above the page title
- **Links** - all links throughout the space
- **Borders and Dividers** - table borders and dividing lines
- **Tab Navigation Background** - the background colour of the tab navigation
- **Tab Navigation Text** - the text of the tab navigation when highlighted
- **Tab Navigation Background Highlight** - the background colour of the tab navigation when highlighted
- **Tab Navigation Text Highlight** - the text of the tab navigation elements when highlighted
Reset your colour scheme after uploading a site logo

When you upload a site logo, Confluence automatically detects the colours in your logo and customises the colour scheme for you.

You can change the colour scheme as above, or reset your colour scheme back to the default (and still keep your new site logo).

To reset the colour scheme:
1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Choose **Colour Scheme** in the left-hand panel.
3. Choose **Edit**.
4. Choose **Reset**.

**Notes**

- If you make a mistake, just choose **Reset** and then try again.
- Some UI elements are specific to the default theme and may not take effect for other themes.

**Working with Themes**

Themes are pre-defined style sets that you can apply to Confluence, to alter the appearance of your site. This is a way of personalising the 'look and feel' of Confluence. You can apply a theme to your entire Confluence site and to individual spaces. Choose a specific theme if you want to add new functionality or significantly alter the appearance of Confluence.

Confluence comes with a selection of themes. In addition, a **site administrator** can install new themes as add-ons via the **Confluence Administration Console**. Provided that the theme is installed on your Confluence site, any **space administrator** can apply a theme to a space.

By default when you create a new space, the space will have the Confluence default theme.

**To look at the themes installed on your Confluence site:**

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Choose **Themes** in the left-hand panel.
3. You will see a list of all installed themes.

**Useful add-ons**

*Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.*

Visit the Atlassian Marketplace to search for additional themes you can add to your site.

**Related pages:**

- Applying a Theme to a Space
- Applying a Theme to a Site
- Configuring the Documentation Theme
- Creating a Theme (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

**Applying a Theme to a Site**

You can use a theme to personalise the 'look and feel' of Confluence. Some themes simply change the basic styling, others add new functionality or significantly alter the appearance of Confluence. You can apply a theme to your entire Confluence site and to individual spaces.

Confluence comes with a selection of themes. In addition, a **site administrator** can install new themes as plugins via the **Confluence Administration Console**. (Not applicable to Confluence OnDemand.)

Provided that the theme is installed into your Confluence site, any **space administrator** can apply a theme to a space. By default when you create a new space, the space will have the Confluence default theme.

**To apply a theme across the site:**
1. Ensure that the theme you wish to use has been installed as a plugin, if it is not shipped with Confluence. See Managing Add-ons and Macros. (Not applicable to Confluence OnDemand.)

2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Themes in the left-hand panel.
4. The screen will display all available themes. Select a radio button to choose a theme.
5. Choose Confirm.

Related pages:
- Applying a Theme to a Space
- Configuring the Documentation Theme
- Creating a Theme (Not applicable to Confluence OnDemand.)
- Confluence Administrator's Guide

Screenshot: Applying a theme

Customising the Left Navigation Theme

⚠️ The Left Navigation theme is no longer part of Confluence
This theme is no longer part of Confluence and is not supported from Confluence 3.4 onwards. We suggest the Documentation theme, as it provides a customisable left-hand navigation panel and additional configurable features. If you are using an earlier version of Confluence, please refer to the
Creating a Theme

If you want to create your own theme, you will need to write a Confluence plugin. Please refer to the following pages in our developer documentation:

- Get started with [plugin development](#).
- Follow the developer's tutorial for [writing a Confluence theme](#).
- Create a theme using the [theme plugin module](#).

**Related pages:**
- Applying a Theme to a Site
- Applying a Theme to a Space
- Configuring the Documentation Theme
- Confluence Administrator's Guide

⚠️ *The information on this page does not apply to Confluence OnDemand.*

Customising Site and Space Layouts

You can modify Confluence's look and feel by editing the 'decorator' (layout) files. Modifying these files allows you to change the look and feel of:

- The Confluence site as a whole, which includes all spaces within the Confluence site.
- An individual space within the Confluence site.

This page tells you how to customise the layout files for your Confluence site as a whole. These customisations:

- Modify the default 'decorator' files of each space in your site.
- Are reflected in every space unless the space's own equivalent layout files have been customised.

You need [System Administrator](#) permissions to perform these customisations.

You can also customise the layout files for a given space. For more information, refer to [Customising Space Layouts](#). Space layout customisations override the equivalent site customisations.

**Note:** If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with your customisation. For more information on updating your customisations, please refer to [Upgrading Customised Site and Space Layouts](#).

**On this page:**
- Editing a site decorator file
- Using Velocity macros
- Advanced customisations

**Related pages:**
- Velocity Template Overview
- Basic Introduction to Velocity
- Customising your Confluence Site
- Confluence Administrator's Guide

⚠️ *The information on this page does not apply to Confluence OnDemand.*
Confluence is built on top of the open source SiteMesh library, a web-page layout system. Read more on the SiteMesh website. To edit the layout of Confluence, you will need to modify these decorator files. A decorator file is a .vmd file and is written in a simple programming language called Velocity. You can learn more from the Velocity User Guide.

Once you are familiar with Velocity, you can edit the decorator files to personalise the appearance of Confluence.

The decorator files in Confluence are grouped into the following categories:

- **Site layouts**: These are used to define the controls that surround each page in the site. For example, the header and the footer.
- **Content layouts**: These control the appearance of content such as pages and blog posts. They do not change the way the pages themselves are displayed, but allow you to alter the way the surrounding comments or attachments are displayed.
- **Export layouts**: These control the appearance of spaces and pages when they are exported to HTML. If you are using Confluence to generate a static website, for example, you will need to modify these layouts.

**Editing a site decorator file**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select **Layouts** under **Look and Feel** in the left-hand navigation panel.
   - Click **View Default** to view the .vmd file.
   - Click **Create Custom** to edit the default .vmd file. This will open the .vmd file in edit mode.
3. Make changes and click **Update**.

If something goes wrong: Click Reset Default to revert to the original layouts.

**Using Velocity macros**

When editing Custom Decorator Templates, there are a number of macros available to define complex or variable parts of the page such as menus and breadcrumbs. You may insert these macros anywhere in your templates. More information on Working With Decorator Macros.

**Advanced customisations**

**Overriding Velocity templates**

The velocity directory is at the front of Confluence’s Velocity template search path. As such, you can override any of Confluence’s Velocity templates by placing an identically named file in the right place. While we don’t recommend you do this unless you know exactly what you’re doing, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through the web interface.

**Caching**

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in WEB-INF/classes/velocity.properties, or restart the server to make your changes visible.

**Location of Velocity files**

You will find the Velocity files in your Confluence installation directory. The primary Velocity files are located in the `<CONFLUENCE-INSTALLATION>\confluence\decorators` directory. For example, you will find the following files in that directory: `main.vmd`, `space.vmd`, `form-aul.vmd`, `global.vmd`, and more.
Finding the layout via the URL

If the layout has changed so extensively as to not be visible, you can browse to the URL directly:

```
http://<confluence base url>/admin/resetdecorator.action?decoratorName=decorators/main.vmd
```

Substitute the base URL and the appropriate .vmd file.

Adding a Navigation Sidebar

You can include a left-hand navigation sidebar (table of contents) in your Confluence space. There are two ways to do this:

- **Recommended: Use the Documentation Theme** – The Documentation theme provides the left-hand navigation sidebar that you see in this documentation. Please go to the page that tells you how to configure the Documentation theme.
- **Customise the Space Layouts** — This is an alternative method (documented below) that is more complex to set up than the Documentation theme and requires more maintenance with Confluence major release upgrades.

⚠️ **The information on this page does not apply to Confluence OnDemand.**

Notes to Read before you Start

Please take note of the following points before you use the method documented on this page:

- **Reapply customisation whenever you upgrade Confluence.** Every time you upgrade Confluence, you must reapply the layout customisations described on this page. When you upgrade to a new major Confluence version (such as moving from Confluence 2.9.x to Confluence 2.10.x or from Confluence 3.0.x to Confluence 3.1.x) you will need to reapply the layout customisation. See instructions below.
- **Check your wiki permissions.** To customise a space layout as described below, you must be a space administrator in the given space and you must be a system administrator on the Confluence site. See the overview of permissions and the glossary entries for space administrator and for Confluence administrator and system administrator.

Customising your Space Layouts to Add a Navigation Sidebar

*Screenshot: A left-hand navigation bar resulting from customising the space layouts*
Follow the instructions below to add the navigation sidebar to your Confluence space.

Step 1. Create the TreeNavigation Page

First, you will create a Confluence page containing the `pagetree` macro. This is just a normal Confluence page. The only slight oddity is that it should reside at the root of your space, instead of under the space’s home page.

Follow these instructions:

1. Go to a page in the space and choose **Pages** in the sidebar. For more options, choose **Browse and reorder all pages**.
   Or, if you are using the Documentation theme, choose **Browse > Pages** at the top of the screen. You are now at the ‘root’ level of your space. The ‘root’ level contains pages that are added above the space's home page, not as children of the home page.
2. At the root level of the space, create a page named ‘TreeNavigation’.
3. On the page, insert the following text:

   ```
   {pagetree}
   ```

4. Now decide if you want to add extra functionality to your page tree. By default, using the code above, the page tree will use the home page of the space as its root. You can choose to:
   * Specify a different root for your page tree.
   * Add a search box at the top of the tree.
   * Allow the viewers to expand and collapse the whole tree.
   * Control other aspects of the display.
   For more information, read about the Pagetree macro.

Step 2. Change the Space's Page Layout

Now you will change the space's page layout, to include the above page on the left of every web page displayed.

1. If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
• If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Make sure the Confluence Default theme is selected from the Themes menu.

3. Click Layout in the Look and Feel section.
   Note: The layout option is only displayed if you are a system administrator on the Confluence site.

4. Click Create Custom in the Page Layout section.

5. In the layout, locate the VIEW section, and find this code:

```plaintext
<div class="wiki-content">
$body
</div>
```

6. Replace the above code block with this code:

```plaintext
#if ($action.isPrintableVersion() == false)
<style>
.spacetree * ul{
padding-left:0px;
margin-left: 0px;
}
.spacetree * li{
margin-left: 5px;
padding-left:5px;
}
</style>
<table cellspacing="2" cellpadding="5">
<tr>
<td valign="top" align="left" width="22%" bgcolor="#F9F9F9" class="noprint">
<div class="tabletitle">Table of Contents</div>
<div class="spacetree">
#includePage($helper.spaceKey "TreeNavigation")
</div>
</td>
<td valign="top" align="left" width="78%" class="pagecontent">
<div class="wiki-content">
$body
</div>
</td>
</tr>
</table>
#else
<div class="wiki-content">
$body
#end
```

7. If you want to, you can change the table title in the above code from 'Table of Contents' to something else. For example, it might say 'Confluence Documentation'.

8. Save the updated layout.

Reapplying the Customisation on Upgrade
When you upgrade to a new major Confluence version (e.g. from Confluence 2.9.x to Confluence 2.10.x or from Confluence 3.0.x to Confluence 3.1.x), you will need to reapply this customisation.

**Reason:**
The new Confluence version may contain updates to the space layouts. Because you have customised the space layouts, Confluence will not overwrite your customisation. So your space will not get the latest updates until you set the layout to default and then reapply your changes.

**Here’s how to do it:**

1. First make a copy of your customised code, if you have changed it from the code above:
   - Go to **Space Admin**, click **Layout** and edit the customised page layout (as created above).
   - Copy the section of code that inserts the customised left-hand navigation panel.
   - Close the page layout.
2. Click **Reset Default** next to **Page Layout**, to set the page layout back to default. This will bring in the new code for the upgraded version of Confluence.
3. Create a custom layout as described in step 2 above, and reinsert the custom left-hand navigation code.
4. Save the updated layout.

**RELATED TOPICS**
- Configuring the Documentation Theme
- Customising Site and Space Layouts
- Upgrading Customised Site and Space Layouts
- Example Confluence Designs
- Adding an All Versions Section to your Navigation Bar

This page gives an example of how you might add an 'All Versions' section to your navigation sidebar, as currently used in the Confluence documentation, Crowd documentation and the other Atlassian product documentation spaces.

If you are viewing this page online on the Atlassian documentation wiki, you will be able to see the 'All Versions' section at the top left of the navigation sidebar. Below is a screenshot.

A number of people have asked how we do it, so this page gives the answer. For details about creating the navigation side bar itself, please refer to **Adding a Navigation Sidebar**.

---

**Adding the Version Index to the Navigation Sidebar**

This is how we added the 'All Versions' section to the sidebar:

- For each product (Confluence, Crowd, Bamboo, etc) there is a page in the Inclusions Library of the ALLDOC space. The page lists all the versions of that product's documentation, linking to the relevant spaces. For example, here is the page for Confluence and the page for Crowd.

  - We put the 'all versions' page in ALLDOC because the page is used in a number of different spaces, via the {include} macro. For example, the 'all versions' page may be included:
    - In every documentation space (each version) for the product concerned, such as DOC, CONF29, CONF28, CROWD, CROWD013, CROWD012, etc.
    - As a panel on the documentation home page, as shown in the 'All Versions' panel of the above screenshot, as well as in the left-hand navigation bar.
    - Any other places where useful.

- In each documentation space, there is a page called 'TreeNavigationVersions' like this one or this one, which copies in the content of the above 'all versions' page.
- For each documentation space, the space's page layout now includes two pages instead of just one:
  - The 'TreeNavigation' page, as already described on the page above.
The new ‘TreeNavigationVersions’ page.

Here's the relevant section of our page layout as it is currently for the Confluence documentation (DOC) space:

```html
#if ($action.isPrintableVersion() == false)
<style>
.spacetree * ul{
padding-left:0px;
margin-left: 0px;
}
.spacetree * li{
margin-left: 5px;
padding-left:5px;
}
</style>
<table cellspacing="2" cellpadding="5">
<tr>
<td valign="top" align="left" width="30%" bgcolor="#eeecec" class="noprint">
<div class="tabletitle">All Versions</div>
<div class="spacetree">
#includePage($helper.spaceKey "TreeNavigationVersions")
</div>
<div class="tabletitle">Confluence 2.10 Documentation</div>
<div class="spacetree">
#includePage($helper.spaceKey "TreeNavigation")
</div>
</td>
<td valign="top" align="left" width="70%" class="pagecontent">
$body
</td>
</tr>
</table>
#else
<div class="wiki-content">
$body
</div>
#end
```

Adding the Expand/Collapse Functionality to the Version Index

Another question we are asked is how we group the content of the included page under a collapsible control.

We use the Expand macro. The details are on the Expand macro's documentation page.

Related Topics

Adding a Navigation Sidebar
Upgrading Customised Site and Space Layouts

As Confluence evolves, so do the default site and space layouts that drive the rendering of every page. As new functionality is added or current functionality is changed, the default layouts are modified to support these changes.

⚠️ If you are using custom layouts based on defaults from a previous Confluence version, you run the risk of breaking functionality, or worse, missing out on great new features!
Take care on each new release of Confluence to reapply your changes to the new default templates.

To reapply your custom layouts, you need to:

1. Obtain the source of your custom layouts from your current version of Confluence.
2. Reapply your customisations to the new default layouts.

⚠️ The information on this page does not apply to Confluence OnDemand.

Step 1. Obtain your Custom Layouts

Ideally, you should keep a record of each customisation you have applied to each of your Confluence site or space layouts.

If not, you should be able to find your customisations using the following method. This method extracts all site- and space-level layouts from your Confluence site as a single output. From this output, you should be able to identify your customisations.

Custom layouts are stored in the DECORATOR table within your Confluence database. You can SELECT for the source of the layout using SQL like this:

```sql
mysql> select SPACEKEY,DECORATORNAME,BODY from DECORATOR;
+----------+---------------------+------+
| SPACEKEY | DECORATORNAME       | BODY |
|----------|---------------------+------|
| NULL     | decorators/main.vmd | ...  |
+----------+---------------------+------+
1 row in set (0.03 sec)
```

This example was tested on MySQL, but should be applicable to all SQL databases.

Step 2. Reapply your Customisations

When you upgrade Confluence to another major release of Confluence, you will need to manually reapply any customisations you made to any site-wide or space-specific layouts. Unless otherwise stated, you should not need to reapply customisations after conducting a minor release upgrade of Confluence.

What are 'major' and 'minor' releases? Major release upgrades are ones where the 1st digit of Confluence's version number or the 1st digit after the 1st decimal place differ after the upgrade, for example, when upgrading from Confluence 3.0 to 3.1, or 2.8 to 3.0. Minor release upgrades are ones where the 1st digit of Confluence's version number and the 1st digit after the 1st decimal place remain the same after the upgrade, for example, when upgrading Confluence 3.0 to 3.0.1.

If you have made Confluence site-wide layout customisations:

1. Choose the cog icon 🔄 at top right of the screen, then choose Confluence Admin.
2. Select Layouts in the left-hand navigation panel. The decorators are grouped under Site, Content and Export layouts.
3. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).
4. Click Reset Default next to the layout whose customisations need to be reapplied.
5. Click **Create Custom** next to the same layout and reapply your customisations (by copying and pasting them) into the appropriate locations within the new default layout.

6. Click the **Save** button.

7. Repeat this procedure from step 4 for each layout whose customisations need to be reapplied.

If you have made space-specific layout customisations:

1. Visit any page in the relevant space.
2. • If this space has the Default theme applied, go to the space and choose **Space tools** on the sidebar.
   • If this space has the Documentation theme applied, go to **Browse** in the top bar and select **Space Admin**.

   **Note:** This option appears only if you are a space administrator for the space or you are a super user (a member of the **confluence-administrators** group).

3. Click **Layouts** in the left-hand navigation panel. The decorators are grouped under **Site**, **Content** and **Export** layouts.

4. Ensure you have all your customisations available (preferably in a form which can be copied and pasted).

5. Click **Reset Default** next to the layout whose customisations need to be reapplied.

6. Click **Create Custom** next to the same layout and reapply your customisations (by copying and pasting them) into the appropriate locations within the new default layout.

7. Click the **Save** button.

8. Repeat this procedure from step 5 for each layout whose customisations need to be reapplied.

**Step 3. Test your Modifications Carefully**

Changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site. It's beyond the scope of Atlassian Support to test and deploy these changes.

**Turning Off Caching**

Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off Velocity's caching temporarily in `WEB-INF/classes/velocity.properties`, or restart the server to make your changes visible.

The `velocity.properties` file is available in the `confluence-x.x.x.jar` file, where `x.x.x` is the Confluence version number. The JAR file is located in the `WEB-INF/lib` directory. If you wish to make modification to the files in the JAR, we recommend the following steps:

1. Stop Confluence.
2. Make a backup copy of the JAR file.
3. Un-jar the file.
4. Locate and edit the appropriate file that you wish to modify.
5. Re-jar the `confluence-x.x.x.jar` file.
6. Relocate the JAR file to the appropriate directory.
7. Restart Confluence.

**RELATED TOPICS**

**Customising Site and Space Layouts**

**Working With Decorator Macros**

Decorator Macros are **Velocity** macros which are used to draw complex or variable parts of the page such as menus and breadcrumbs when editing **Custom decorators**. Decorator macros can be inserted anywhere in your
The macro is called by inserting a string of the form: `#macroName("argument1" "argument2" "argument3")`. There are no commas between the arguments. Unless otherwise noted, these macros take no arguments.

**NOTE:** These macros will only work reliably when customising `.vmd`. They may not work in other Velocity decorators. Decorator macros will not work inside normal Confluence pages.

---

⚠️ The information on this page does not apply to Confluence OnDemand.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>#breadcrumbs()</code></td>
<td>Draws the &quot;You are here&quot; breadcrumbs list, like the one found above the page name in the default template.</td>
</tr>
<tr>
<td><code>#includePage(pageTitle)</code></td>
<td>Includes a Confluence page with the specified title. If you have 2 or more pages with the same title across multiple spaces, this macro will include the page belonging to the space you are currently viewing.</td>
</tr>
<tr>
<td><code>#searchbox()</code></td>
<td>Inserts a search box into the page, like the one to the far right of the breadcrumbs in the default template.</td>
</tr>
<tr>
<td><code>#globalnavbar(type)</code></td>
<td>Draws the global navigation bar, as found in the top right-hand corner of the default template. The navigation bar can be displayed in two modes:</td>
</tr>
<tr>
<td></td>
<td><code>#globalnavbar(&quot;table&quot;)</code> Displays the navigation bar in its default mode: drawn as a table of links with coloured backgrounds and mouse-over effects.</td>
</tr>
<tr>
<td><code>#globalnavbar(&quot;text&quot;)</code></td>
<td>Displays the navigation bar as series of text links separated by `</td>
</tr>
<tr>
<td><code>#usernavbar()</code></td>
<td>Draws the user-specific navigation-bar. This bar contains the links to the user’s profile and history, or to the login and signup pages if the user is not logged in.</td>
</tr>
<tr>
<td><code>#helpicon()</code></td>
<td>Draws the help icon, and link to the Confluence help page.</td>
</tr>
<tr>
<td><code>#printableicon()</code></td>
<td>On pages where a printable version is available, draws the printable page icon, linking to the printable version of the page. Otherwise, draws nothing</td>
</tr>
</tbody>
</table>
When you are viewing a page in a Confluence space, draws the name of the space that page is in. Otherwise, writes the word "CONFLUENCE". The "class" argument is the CSS class that the title should be drawn in. Unless you have customised your Confluence installation's CSS file, you should call this with "spacenametitle" as the class: `#pagetitle("spacenametitle")`

#poweredby()

Writes out the "Powered by Confluence" and Confluence version-number boilerplate found at the bottom of the default template.

#bottomshadow()

Draws the fading shadow-effect found at the bottom of the content area in the default template.

#dashboardlink()

Inserts a link to the dashboard page.

**RELATED TOPICS**

- Include Page Macro
- Enabling HTML macros
- Enabling the html-include Macro
- Adding, Editing and Removing User Macros
- Writing User Macros
- Custom Decorator Templates

**About Decorators**

Confluence is built on top of the Open Source SiteMesh library, a web-page layout system that provides a consistent look and feel across a site. SiteMesh works through "decorators" that define a page's layout and structure, and into which the specific content of the page is placed. If you are interested, you can read more on the SiteMesh website.

What this means for Confluence is that you can customise the look and feel of almost all of your Confluence site through editing three decorators:

- The "Main" decorator defines the look and feel of most pages on the site
- The "Popup" decorator defines the look and feel of the popup windows such as the "Insert Link" and "History" pages.
- The "Printable" decorator defines the look and feel of the printable versions of pages (available through the printer icon on each page)

You can view and edit these decorators from within Confluence: they are available from the "Layouts" option on the site's Administration menu. Changes to the decorators will affect all spaces hosted on that Confluence installation.

The decorator that is used to draw Confluence's administrative pages can not be edited from within Confluence. This means that if you make some editing mistake that renders the rest of the site unuseable, the administrative pages should still be available for you to fix the template.

⚠️ *The information on this page does not apply to Confluence OnDemand.*
**Browsing the Default Decorators**

At any time, you can browse the default decorators that come packaged with Confluence by following the "View Default" links on the "Site Layouts" page. The template browser also allows you to view the "#parsed" templates that are included within the template when it is compiled. While you can't edit these included templates, you will probably have to copy some or all of them into your custom template as you do your customisation.

**Editing Custom Decorators: Add a Logo**

To edit Confluence decorators, you should have a good knowledge of [HTML](https://developer.mozilla.org/en-US/docs/Web/HTML), and some understanding of the [Velocity templating language](https://velocity.apache.org/).

The first thing you will see when you choose to create a custom "Main" decorator is... there's not much to edit. By default, most of the content of this decorator is included from other files:
We can add our logo, changing the "logocell" table cell:
When you insert this into the right section of the template and hit save, visitors to the site will see the logo at the top of each page. Note, the administrative pages will be unaffected: you will have to go to the dashboard or to a space to see the changes you have made.

**Macros**

Some parts of the page are drawn using Velocity macros, including the navigation bar. The macros you should know about when editing decorators are described in [Working With Decorator Macros](#).

**If Something Goes Terribly Wrong**

From the “Site Layouts” page in Confluence’s administrative menu, you can delete your custom templates. When you do this, the default template will be restored, fixing anything that may have been broken.

Alternatively, the custom templates are stored in the DECORATOR table in the database. If you have somehow managed to render Confluence completely unuseable through editing your templates, delete the relevant entries from the DECORATOR table.

**For Advanced Users**

The velocity directory is at the front of Confluence’s velocity template search path. As such, you can override any of Confluence’s velocity templates by placing an identically named file in the right place.

While we don't recommend you do this unless you know exactly what you're doing, it does give you complete control over the look of every aspect of Confluence. It also means that you can edit your templates in a text-editor if you wish, rather than through the web interface.

There are, however, two important caveats:

1. Velocity is configured to cache templates in memory. When you edit a page from within Confluence, it knows to reload that page from disk. If you are editing the pages on disk, you will either have to turn off velocity's caching temporarily in WEB-INF/classes/velocity.properties, or restart the server to make your changes visible.
2. Because we only officially support the modification of the three global decorator files, other changes may interact unpredictably with future versions of Confluence. When upgrading, you should always test your custom modifications thoroughly before deploying them on a live site.

**Customising a Specific Page**

If you’d like to change the appearance of a specific page, you can modify the corresponding Velocity template. Here’s how to find out which one:

1. Access the page. Note the name of the action. For example, the “Contact Administrators” page is `<baseURL>/administrators.action`.
3. Unzip or unjar the file using a standard unzipper or the [Java jar utility](http://www.oracle.com/technetwork/java/javase/technologies/index-137656.html).
4. Open xwork.xml. Search the file for the name of the action corresponding to the page you’d like to modify. You’ll see an entry like:
5. The file to look for is the vmd or vmd file. In the above example, it's administrators.vmd. Because there is no context path (just a / before the name of the file), its in the root of the Confluence webapp. For the stand-alone, that's <confluence-install>/confluence folder.

6. Modify the file.

For details on how to configure the file, check the Velocity Template Overview.

The information on this page does not apply to Confluence OnDemand.

RELATED CONTENT
- Changing the Look and Feel of Confluence
- Customising Colour Schemes
- Customising Site and Space Layouts
- Upgrading Customised Site and Space Layouts
- Working With Decorator Macros
- Administering Site Templates
- Customising a Specific Page

Customising the Login Page
This page gets you started on customising the Confluence login page, to add your own logo or custom text. This will not customise the login process, just what users sees when they log in.

Notes:

- Customisations to the Confluence login page will need to be reapplied when you upgrade Confluence. Consider this before making drastic changes to the layout, and be sure to keep a list of what you have changed for your upgrade process later.
- Please test your changes on a test Confluence site first.

Only administrators with access to the server where Confluence is running can modify the Confluence login page.

Related pages:
- Changing the Site Logo
- Velocity Template Overview
- Customising Site and Space Layouts
- Changing the Look and Feel of Confluence
- Modify Confluence Interface Text

The information on this page does not apply to Confluence OnDemand.

To change the login page:
1. Shut down your Confluence server.
2. In the Confluence installation directory, find the file `confluence/login.vm`.
3. Make a copy of this file as a backup.
4. Edit the file with a text editor to make the required changes. The content contains a mixture of HTML and Velocity. See Velocity Template Overview (in our developer documentation).
5. Start Confluence and test your changes.

The same process can be applied to modify most of the templates in the Confluence web application. Be careful to test your changes before applying them to a live site. The templates contain code that is vital for Confluence to function, and it is easy to accidentally make a change that prevents use of your site.

Modify Confluence Interface Text

All Confluence UI text is contained in a single Java properties file. This file can be modified to change the default text, and also to translate Confluence into other languages than English.

The UI text file is `ConfluenceActionSupport.properties`. From your Confluence install directory:

```
\confluence\WEB-INF\lib\confluence-x.x.x.jar
```

Replace "x.x.x" with your Confluence version, for example for 4.3.2, it will be named "confluence-4.3.2.jar". Within this File, the relevant file to edit is :
```
\com\atlassian\confluence\core\ConfluenceActionSupport.properties.
```

Refer to Editing jar files for reference.

⚠️ The information on this page does not apply to Confluence OnDemand.

The file contains parameters with name=value pairs, in the format:

```
parameter.name=Parameter value
```

Parameter names are any text before the '=' character and should never be modified. Any text after the '=' character is the parameter value, which can be modified freely and can also contain variables. An example involving variables is:

```
popular.labels=The three most popular labels are {0}, {1} and {2}.
```

For more information on replacing values, check out Translating ConfluenceActionSupport Content. Note that plugins store their text internally, so you must modify plugin text individually.

Steps For Modification

1. Stop Confluence
2. Under your install directory, open \confluence\WEB-INF\lib\confluence-x.x.x.jar\com\atlassian\confluence\core\ConfluenceActionSupport.properties
3. Search for the text you wish to modify, replace it and save the file in <Confluence-Install>\confluence\WEB-INF\classes\com\atlassian\confluence\core. Please create this folder structure, if it does not exist already.

✔️ If you re-bundle the JAR file, rather than re-deploy the class in the WEB-INF\classes directory,
4. Restart Confluence

**Common Modifications**

- Rename 'Dashboard' by searching for Dashboard. To change "Dashboard" to "My Portal", change `dashboard.name=Dashboard` to `dashboard.name=My Portal`

<table>
<thead>
<tr>
<th>Task</th>
<th>Search For</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename 'Dashboard'</td>
<td>Dashboard</td>
<td>The <code>dashboard.name</code> parameter has the name. To change 'Dashboard' to 'My Portal', change <code>dashboard.name=Dashboard</code> to <code>dashboard.name=My Portal</code> and update any other occurrences of the word 'Dashboard' in the instance</td>
</tr>
<tr>
<td>Modify login page text</td>
<td>login.</td>
<td>The <code>login.instructions</code> parameter has the &quot;Enter your account details below to login to Confluence&quot; text</td>
</tr>
</tbody>
</table>

**Modify Keyboard Shortcuts**

Confluence provides a set of keyboard shortcuts. You could customise the shortcuts by making modifications inside the `ConfluenceActionSupport.properties` file.

- To disable a particular shortcut, you can simply just comment out a respective line of code. One may like to disable the shortcut to one of the navigation links: View, Edit, Attachments, Info. For instance, to disable shortcut to Attachments one would comment out the following line:
  
  ```
  #navlink.attachments.accesskey=a
  ```

- To modify an access key, one could simply just change the letter, bearing in mind the fact that the letter must be unique.

**Customising the eMail Templates**

Customisations to the Confluence email templates will need to be reapplied when you upgrade Confluence. Consider this before making drastic changes to the layout, and be sure to keep a list of what you have changed for your upgrade process later.

Only administrators with access to the server where Confluence is running can modify the Confluence email templates.

⚠️ *The information on this page does not apply to Confluence OnDemand.*

**Process to change the email templates**
1. Shut down your test instance of Confluence.
2. In the Confluence web application folder, find the file `/confluence/WEB-INF/lib/confluence-2.x.jar`.
3. Make a copy of this file as a backup.
4. Learn how to edit files within .jar archives.
5. Within the jar file, find the `/templates/email` folder. Find the appropriate file(s) within that folder.
6. Edit the file with a text editor to make the required changes. The content is mostly HTML, but has some Velocity template variables in it. See Velocity Template Overview for more information about how these work.
7. Again using the guide on editing files within .jar archives, either rejar the set of folders or drop the new files into the identical folder structure in the `WEB-INF/classes` directory.
8. Start Confluence up again and test your changes.
9. Apply the changes to your production Confluence instance.

The same process can be applied to modify most of the templates in the Confluence web application. For velocity files that are not in a jar file, you need not shut down and restart Confluence. Be careful to test your changes before applying them to a live site. The templates contain code that is vital for Confluence to function, and it is easy to accidentally make a change that prevents use of your site.

**RELATED TOPICS**

- Velocity Template Overview
- Customising Site and Space Layouts
- Changing the Look and Feel of Confluence
- Modify Confluence Interface Text

**Changing the Default Behaviour and Content in Confluence**

Confluence comes with some handy default settings that determine what people see when they first enter the Confluence site, and the default content that is put into new spaces and other areas of Confluence.

Confluence administrators can change the settings to customise the behaviour and the default content of their Confluence site:

- Administering Site Templates
- Importing Templates
- Changing the Site Title
- Choosing a Default Language
- Configuring the Administrator Contact Page
- Configuring the Site Home Page
- Configuring the What's New Dialog
- Customising Default Space Content
- Customising the Getting Started Guide on the Dashboard
- Editing the Site Welcome Message

**Related pages:**

- Changing the Look and Feel of Confluence
- Customising your Confluence Site
- Confluence Administrator's Guide

**Administering Site Templates**

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format. See Working with Templates.

Administrators can import templates, to make them available to other people using Confluence. See Importing Templates.
Confluence also provides 'system templates' which contain default content for the site welcome message (see Editing the Site Welcome Message) and default space content (see Customising Default Space Content).

### Related pages:
- Customising your Confluence Site Not applicable to Confluence OnDemand.
- Confluence Administrator's Guide

## Importing Templates

A template is a predefined page that can be used as a prototype when creating new pages. Templates are useful for giving pages a common style or format.

You can create your own templates within Confluence. See Adding a Template.

In addition, you can download pre-defined templates from the Atlassian Marketplace in the form of a template bundle. Each template bundle contains one or more templates, created by Atlassian or third parties. Here is a summary of the steps required:

- Download the template bundle from the Atlassian Marketplace.
- Install the template bundle into your Confluence site.
- Make the templates available by importing them into the site or into an individual space.

You need 'System Administrator' permission to install template bundles into your Confluence site. You need 'Confluence Administrator' permission to manage the existing template bundles on your Confluence site. See Global Permissions Overview.

### Step 1. Check the template bundles installed on your Confluence site

To see the template bundles that are currently available for import on your Confluence site:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Import Templates in the left-hand panel. You will see a list of the template bundles installed on your Confluence site, and the templates included in each bundle.

### On this page:
- Step 1. Check the template bundles installed on your Confluence site
- Step 2. (Optional) Download and install additional template bundles from the Atlassian Marketplace
- Step 3. Import the templates to make them available to users
- Notes

### Related pages:
- Creating Content
- Working with Templates
- Confluence Administrator's Guide

### Step 2. (Optional) Download and install additional template bundles from the Atlassian Marketplace

Follow the steps below if you want to add more template bundles to your site.

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

To upload more templates:

1. Go to the Atlassian Marketplace and download the template bundle that you need. It will be in the form of a JAR file. Save the JAR file somewhere in your file system.
2. Log in to Confluence as a System Administrator.
3. Choose the cog icon at top right of the screen, then choose Confluence Admin.
4. Choose Manage Add-ons in the left-hand panel.
5. Choose Upload Add-on.
6. Browse to find the template bundle that you downloaded, and upload it to Confluence. The template bundle will appear in the list under 'User-installed Add-ons'.

Step 3. Import the templates to make them available to users

You now have one or more template bundles on your site. The templates are not available until you have 'imported' them.

To import a template:

1. Log in to Confluence as a System Administrator or Confluence Administrator.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Import Templates in the left-hand panel. You will see the template bundles installed on your Confluence site and the templates included in each bundle.
   Note: You can see a preview of the template by choosing the template name.
4. Select the templates to be imported by ticking the check boxes next to the relevant template names.
5. Choose the import destination for the templates in the Import To dropdown menu. If you want the templates to be available to only a specific space, choose the name of the space, otherwise choose Global Templates to make the templates available to all spaces.
6. Choose Import.

Screenshot: Importing a template

Notes

- Building your own template bundles. You can build a template bundle as an add-on (also called a
'plugin') and then upload it to your Confluence site. You can then import the templates from your custom template bundle, as described above. You will need some programming knowledge to develop a template bundle. See Creating A Template Bundle.

- **Duplicate template names.** If a template with the same name already exists on import, a duplicate template of the same name will be created. You will need to check the templates and rename them manually.

- **Removing the template.** Removing the add-on that contains a template will not remove the template from your Confluence site if you have already imported it. You will need to remove the template manually via the administration console or space administration screen.

### Changing the Site Title

The site title appears in your browser's title bar. By default, it is set to 'Confluence'.

**To change the title of your Confluence site:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose 'General Configuration' in the left-hand panel.
3. Choose 'Edit' at the top of the 'Site Configuration' screen.
4. Enter a new title for your site in the input field next to 'Site Title'.
5. Choose 'Save'.

**Related pages:**

- Changing the Site Logo
- Editing the Site Welcome Message
- Customising your Confluence Site
- Confluence Administrator's Guide

### Choosing a Default Language

Administrators can define a default language to be applied to all spaces in your Confluence site. Note that individual users can select a language preference for their session.

**Related pages:**

- Editing User Settings
- Recognised System Properties
- Configuring Indexing Language
- Installing a Language Pack

⚠️ The information on this page does not apply to Confluence OnDemand.

### Setting the Default Language

**To change the default language for the Confluence site:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'Languages' in the 'Configuration' section of the left-hand panel.
3. The 'Language Configuration' screen will appear. Select the language that you want to use as the default language for your Confluence site.

**Other Settings that Affect the Language**

Individual users can choose the language that Confluence will use to display screen text and messages. Note that the list of supported languages depends on the language packs installed on your Confluence site.

The language used for your session will depend on the settings below, in the following order of priority from highest to lowest:
• The language preference defined in your user profile. Note that you need to be logged in for this setting to take effect.
• The language that you choose by clicking an option at the bottom of the Confluence login screen. Confluence stores this value in a cookie. When the cookie expires, the setting will expire too. *Not applicable to Confluence OnDemand.*
• The language set in your browser.
  • Note that your Confluence administrator can disable this option by setting a system property. *Not applicable to Confluence OnDemand.*
  • The browser sends a header with a prioritised list of languages. Confluence will use the first supported language in that list.
• The default language for your site, as defined by your Confluence site administrator.

**Showing User Interface Key Names for Translation**

This feature is useful if you are working on creating translations of the Confluence user interface. After opening the Confluence dashboard, you can add this text to the end of your Confluence URL:

```
?i18ntranslate=on
```

Then press Enter.

This will cause each element of the user interface to display its special **key name**. This makes it easier to find the context for each key within the user interface. You can then search for the key on [http://translations.atlassian.com](http://translations.atlassian.com) where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a 'lightning bolt' graphic. For example:

```
Dashboard/title.dashboard → Invite Users/easyuser.add users button → Create Space/dashboard button add space
```

To turn off the translation view, add this code to the end of the Confluence URL:

```
?i18ntranslate=off
```

**Configuring the Administrator Contact Page**

The administrator contact page is a form that allows a user of Confluence to send a message to the administrators of their Confluence site. (In this context, administrators are those users who are members of the ‘confluence-administrators’ group. See the explanation of *site administrators.*)

The title of the administrator contact page is ‘Contact Site Administrators’. Typically, Confluence users may get to this page by clicking a link on an error screen such as the ‘500 error’ page.

**Customising the Administrator Contact Message**

You can customise the message that is presented to the user on the ‘Contact Site Administrators’ page.

**To edit the administrator contact message:**

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Choose **General Configuration** in the left-hand panel.
3. Choose **Edit** at the top of the ‘Site Configuration’ section.
4. Enter your text in the **Custom Contact Administrators Message** box. You can enter any text or **Confluence wiki markup**.
5. Choose **Save**.
The Default Administrator Contact Message

By default, the 'contact administrators message' looks much like the highlighted area in the screenshot below, starting with 'Please enter information...'.

Screenshot: The default 'Contact Site Administrators' message

To restore the message to its default simply remove the custom message you entered when following the instructions above, so that the 'Custom Contact Administrators Message' field is empty.

Disabling the Administrator Contact Form

If you prefer to disable the ability for users to send an email message to the site administrators, you can disable the form portion of this screen. You can only disable the form if you first provide a 'Custom Contact Administrators Message' as described above.

To enable or disable the administrator contact form:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit at the top of the 'Site Configuration' section.
4. Select on or off for the 'Contact Administrators Form'.
5. Choose Save.

Configuring Spam Prevention

You can configure Confluence to use Captcha to help prevent spam, including the spamming of Confluence administrators. The administrator contact form is covered by the site-wide Captcha settings as documented in Configuring Captcha for Spam Prevention.

Configuring the Site Home Page

You can configure Confluence to send people to any space home page when they log in, rather than to the dashboard.
The spaces available to set as the site home page will depend on the access permissions of the space and the site.

- The site home page must be accessible to the 'confluence-users' group.
- If the site allows anonymous access, the site home page must also be accessible to anonymous users, that is, people who have not logged in to Confluence.

To configure the site-wide home page:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Select a space from the Site Homepage dropdown menu. When users log in, Confluence will open the home page of the space you choose here.
5. Choose Save.

Notes

- The user's personal settings will override the global setting.
- If you allow anonymous access to the dashboard, but not anonymous access to the site home page, then when logging on to the site, users will be redirected to the original dashboard instead of the site home page. To avoid this, either make the site home page accessible anonymously, or make the dashboard not accessible anonymously.

Configuring the What's New Dialog

The 'What's New' dialog pops up automatically when a user logs in for the first time after a major Confluence upgrade (such as an upgrade to Confluence 4.3). The dialog displays a summary of the new features for the release, sourced from the Atlassian website (by default).

Confluence administrators can configure the behaviour of the 'What's New' dialog, as follows:

- Change the URL that the 'What's New' dialog retrieves information from.
- Disable the dialog.

On this page:

- Changing the 'What's New' Dialog URL
- Disabling the 'What's New' Dialog

Related pages:

- Disabling and Enabling Add-ons
- Local Confluence Documentation

⚠️ The information on this page does not apply to Confluence OnDemand.
Changing the 'What's New' Dialog URL

The 'What's New' dialog URL is stored in your Confluence help-paths.properties file. This URL is a concatenation of the help.prefix property with the help.whats.new.iframe.link.

Note: The help.prefix property also defines the base URL for Confluence help links, i.e. help links in the Confluence application.

To change the 'What's New' Dialog URL:
Follow the instructions in the 'Changing the Links for Individual Help Pages' section on Local Confluence Documentation. You will need to update the 'help.prefix' and 'help.whats.new.iframe.link' properties, as desired.

For example, you may have installed your Confluence documentation behind a firewall at http://www.example.com/ and created a page http://www.example.com/whatsnew that you use for change management. In this case, you would do the following:

- Set help.prefix to http://www.example.com/
- Set help.whats.new.iframe.link to whatsnew

There is an additional property 'help.whats.new.full.link'. This is only used if the content pointed to by the updated URL isn't loaded in 10 seconds, in which case a 'timeout' screen is displayed with a link to the full 'What's New' content. For locally-hosted pages you can just set this property to the same value as help.whats.new.iframe.link.

Disabling the 'What's New' Dialog

The 'What's New' dialogue is enabled via a plugin. To disable the 'What's New' dialogue, you need to disable the Confluence What's New plugin in Confluence.

To disable the 'Confluence What's New' plugin:
Follow the instructions on Disabling and Enabling Add-ons. Please note, the 'Confluence What's New' plugin is a 'System Plugin'. Click 'Show System Plugins' on the Manage Add-ons administration page to display the system plugins.
Customising Default Space Content

Confluence Administrators can edit the template that is used to create the home page for new sites. This default content appears on the home page when a new space is created. There is a different template for site spaces and for personal spaces.

The default content in the template only appears for new spaces (those that are created after you have defined the content). Changes to the template do not affect existing home pages.

*Edit the default space content*

To edit the default space content template:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Template in the left-hand panel.
3. Choose Edit next to 'Default Space Content' or 'Default Personal Space Content' depending on whether you want to customise the content for new site space or personal space home pages.
4. Enter the content that you want to appear on the home page for new site spaces. You can add variables, macros and other content in the same as editing a page template.
5. Choose Save.

The following variables are available to be added to the default space content templates.

- **$spaceKey** - inserts the space key into the site space homepage
- **$spaceName** - inserts the space name into the site space homepage
- **$userFullName** - inserts the user (owner of the personal space) into the personal space homepage
- **$userEmail** - inserts the email address of the user (owner of the personal space) into the personal space homepage.

Default space templates differ from ordinary page templates in that they do not present the user with a form to complete, so variables should be limited to those listed in the Variables menu.

Some macros, such as the Table of Contents macro, may not display correctly when you preview the template as they are designed to work on a page. The macros will display correctly on the home page when you create a new space. For more information on editing a template, including adding macros see - Adding Content to a Template.

On this page:

- Edit the default space content
- Reset the original default content

Related pages:

- Working with Spaces
- Working with Templates
- Confluence Administrator’s Guide

*Reset the original default content*

To reset the original default content:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Template in the left-hand panel.
3. Choose Reset to default next to 'Default Space Content' or 'Default Personal Space Content' depending on the template you wish to reset.

From this point on, all new space home pages will be created with the original default content.
Customising the Getting Started Guide on the Dashboard

By default, the Confluence dashboard displays a quick-start guide for administrators under the site welcome message on the left. This section of the dashboard is visible to Confluence administrators and system administrators only. It is not configurable via the web interface, but you can update or remove it by editing the site layout as described below.

You need System Administrator permissions to perform this customisation.

**Editing or removing the getting-started section**

To customise the getting-started guide on the dashboard:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Layouts in the left-hand panel.
3. Choose Create custom (or Edit) next to Global Layout.
   
   Note: If the global layout has already been customised, the 'Edit' option will be available. Otherwise, you will need to create the custom layout now, by choosing 'Create custom'.
4. Find the following code:
5. Update the code as required:
   - To remove the 'get started' section, delete the entire block of text shown above.
   - Alternatively, edit the code to suit your requirements. See Customising Site and Space Layouts for guidelines.

6. Choose Save.

The default getting-started section

By default, the getting-started guide looks more or less like the screenshot below, starting with the heading 'Get started'.

To restore the default getting-started guide:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Layouts in the left-hand panel.
3. Choose Reset Default next to Global Layout.
   Note: This will reset any other customisations applied to this layout too.
The information on this page does not apply to Confluence OnDemand.

### Editing or removing the getting-started section

If you modify the look and feel of Confluence by following these instructions, you will need to update your customisations when upgrading Confluence. The more dramatic the customisations are, the harder it will be to reapply your changes when upgrading. Please take this into account before proceeding with your customisation. For more information on updating your customisations, please refer to Upgrading Customised Site and Space Layouts.

### Editing the Site Welcome Message

The site welcome message appears at the top left of the Confluence dashboard. You can change the default message by editing the appropriate system template. For example, you may want the welcome message to display an introduction to your site or a message of the day.
To edit the site welcome message:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Templates in the left-hand panel.
3. Choose Edit next to Default Welcome Message.
4. Type your message into the template editor.
5. Choose Save.

The default site welcome message

By default, the site welcome message looks more or less like the screenshot below, starting with the heading 'Welcome to Confluence' and ending with '...diagrams, and projects'.

To restore the default site welcome message:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Global Templates in the left-hand panel.
3. Choose Reset to default next to Default Welcome Message.

On this page:

- The default site welcome message
- Using the template editor
- Including content from another page

Related pages:

- Configuring the Site Home Page
- Changing the Site Title
- Changing the Site Logo
- Customising Default Space Content
- Confluence Administrator's Guide

Screenshot: Site welcome message at top left of the dashboard

Using the template editor

Enter text into the body of the template, and use the editor toolbar to apply styles, layout and formatting. You can add links and macros. In general, you can use the Confluence editor in the same way as on a page.

Notes:

- You cannot use template variables in the welcome message template.
You cannot attach an image or other file to a template. Instead, attach the file to another page, and insert it into the body of the template.

For example:
- You can attach an image to a page and then choose Insert > Image to embed the image into the template.
- You can attach a PDF file to a page and then choose Insert > Other Macros > PDF to embed the PDF file into the template.

**Including content from another page**

It may be useful to write your welcome message on a normal Confluence page and include the page into the welcome message template. Using a normal page means that you can allow other people, who are not Confluence administrators, to change the welcome message.

To include content from another page:

1. Create a Confluence page as usual and add your welcome message as the page content. Remember to limit the size of the content, because it must fit nicely onto the dashboard. For this example, let's assume the title of your page is 'Dashboard Message'. You can put it in any space you like.

2. Add page permissions or space permissions to the 'Dashboard Message' page or space, to suit your requirements. You may want to restrict the editing of the page to a group of people, or you may want to allow any employee to edit the page. This will determine who can update the welcome message on the dashboard.

3. Edit the welcome message template, and add the Include Page macro to display the content from your 'Dashboard Message' page.

4. Save the welcome message template. The dashboard will display the content of the template immediately, including the content of your 'Dashboard Message' page. Similarly, if you or anyone else edits the page, the welcome message on the dashboard will change as soon as the page is saved.

**Integrating Confluence with Other Applications**

You can integrate Confluence with other applications using Application Links. The Application Links feature allows you to link Confluence to applications like Atlassian's JIRA. Linking two applications allows you to share information and access one application's functions from within the other. For example, if you linked your Confluence server with a JIRA server, you could view JIRA issues in a Confluence page via the JIRA Issues Macro.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Getting Started**

The Application Links quick start guide provides instructions on how to set up the most common application link configuration.

**Administrator’s Guide**

The administrator's guide is for administrators who want to configure application links for their applications. The guide contains information on adding a new application link, configuring the authentication for an application link, setting up project links and more.

**Developer Resources**

These resources are for developers who want to develop with the Application Links plugin. Take a look at the Development Hub.

**Related Topics**
Configuring Application Links

An application link is a trust relationship between two applications. Linking two applications allows you to share information and to access one application's functions from within the other.

The information on this page does not apply to Confluence OnDemand.

Screenshot above: Application links for a Confluence server

Notes

- In the above screenshot, the column titled 'Incoming Authentication' is visible in Confluence 3.5.1 and later. The column does not appear in Confluence 3.5.

Related Topics

- Adding an Application Link
- Configuring Authentication for an Application Link
- Editing an Application Link
- Making an Application Link the Primary Link
- Relocating an Application Link
- Upgrading an Application Link
- Deleting an Application Link
- Configuring Project Links across Applications

Adding an Application Link

This page describes how to add a new application link in Confluence. The process for adding an application link is different depending on whether the application that you are linking Confluence to, supports Application Links (i.e. has Application Links installed) or not.

If you are linking Confluence to an application that does not have Application Links, you will need to do additional configuration in that application. This is because Application Links in Confluence will not be able to automatically configure authentication in your remote application.

Please read the appropriate set of instructions below:

- Linking to an application that supports Application Links.
- Linking to an application that does not support Application Links.

On this page:

- Adding an Application Link to an Application That Supports Application Links
- Adding an Application Link to an Application That Does Not Support Application Links
- Notes

The information on this page does not apply to Confluence OnDemand.
Adding an Application Link to an Application That Supports Application Links

Before you begin:

- Make sure that the base URL is set correctly in Confluence. See Configuring the Server Base URL for instructions.
- Make sure that the base URL is set correctly in the application which you intend to link to. See the appropriate instructions: JIRA instructions | FishEye/Crucible instructions | Bamboo instructions). This is required for synchronisation to work correctly.

To link to an application that supports Application Links:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click 'Add Application Link'. Step 1 of the link wizard will appear.
3. Enter the server URL of the application that you want to link to (the 'remote application').
4. Click the 'Next' button. Step 2 of the link wizard will appear.
5. Enter the following information:
   - 'Also create a link from 'XYZ' back to this server' -- Select this option if you want to create a two-way link between the remote application (which in this case is called 'XYZ') and your application. If you want to do this, you will need to enter the username and password of an administrator for the remote application.
     **Please Note:**
     - These credentials are not saved. They are only used at this step of the wizard to authenticate with the remote application, so that a reciprocal Application Link can be created in the remote application back to your application.
     - If the remote application is JIRA or Confluence, these credentials need to be a user account with the system administrator global permission.
   - 'Reciprocal Link URL' -- The URL you give here will override the base URL specified in your remote application's administration console, for the purposes of the application links connection. Application Links will use this URL to access the remote application.
8. Click the 'Next' button. Step 3 of the link wizard will appear.
9. Enter the information required to configure authentication for your application link:
   - 'The servers have the same set of users and usernames' or 'The servers have either different sets of users or usernames' -- Select one of these options depending on how you manage users between the two applications.
   - 'These servers fully trust each other' -- Select this option if you fully understand and trust the behaviour of both applications at all times and are sure that each application will maintain the security of their private key.
     *For more information about configuring authentication, see Configuring Authentication for an Application Link.*
10. Click the 'Create' button to create the application link.
Adding an Application Link to an Application That Does Not Support Application Links

Before you begin:

- Make sure that the base URL is set correctly in Confluence. See Configuring the Server Base URL for instructions.
- Make sure that the base URL is set correctly in the application which you intend to link to. See the appropriate instructions: JIRA instructions | FishEye/Crucible instructions | Bamboo instructions. This is required for synchronisation to work correctly.

To link to an application that does not support Application Links:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click 'Add Application Link'. Step 1 of the 'Link to another server' dialogue will be displayed.
3. Enter the server URL of the application that you want to link to, in the 'Server URL' field. Click the 'Next' button. Step 2 of the 'Link to another server' dialogue will be displayed.
4. Fill out the fields, as follows:
   - 'Application Name' — Enter the name by which this remote application will be referred to, in your application.
   - 'Application Type' — Select the type of application that you are linking to: Generic, FishEye/Crucible, Confluence, Stash, Bamboo, JIRA.
   - 'Application URL' — This will be set to the server URL you entered in the previous step and will not be editable.
5. Click the 'Create' button to create the application link. The 'Configure Application Links' page will be displayed, listing all of the application links that have currently been set up for your application including the one you just added.
6. Configure the desired authentication type (Trusted Applications, OAuth, basic HTTP, none) for your new application link. See Configuring Authentication for an Application Link.
7. In your application that does not support Application Links, configure the same type of authentication that you configured for your application link's outgoing authentication (in the previous step). For example, if you configured outgoing Trusted Applications authentication in your Application-Links-enabled
application, you also need log into your non-Application-Links application and manually configure Trusted Applications (see the relevant administrator's documentation for the application).

Step 1

Screenshots above: Adding an application link to an application that supports Application Links (click to view full-sized images)

Notes

Related Topics

- Making an Application Link the Primary Link
- Configuring Authentication for an Application Link
- Configuring Project Links across Applications

Configuring Authentication for an Application Link

Configuring authentication for an application link is essentially defining the level of trust between Confluence and the application that it is linked to.

On this page:

- Choosing Authentication for an Application Link
- Security Implications for each Authentication Type
- About Primary Authentication Types
- About Impersonating and Non-Impersonating Authentication Types

⚠️ The information on this page does not apply to Confluence OnDemand.

Choosing Authentication for an Application Link

The level of authentication that you should configure for your application link depends on a number of factors.

- **Do the two applications you are linking trust each other?** i.e. are you sure that the code in the application will behave itself at all times and that the application will maintain the security of its private key?
- **Do the two applications you are linking share the same user base or not?**
- **Do you have administrative access to the application you are linking to?**

Common scenarios include:

- If the two applications you are linking trust each other and share the same user base, configure **two-w**
A user authentication using Trusted Applications for both incoming and outgoing authentication. For example, you may link your internal Confluence server to an internal JIRA server.

- If the two applications you are linking trust each other but do not share the same user base, configure two-way authentication using OAuth for both incoming and outgoing authentication. For example, you may link your internal Confluence server to an external (customer-facing) JIRA server.
- If you do not have administrative rights to the application that you are linking to (e.g., linking to a public FishEye server), configure a one-way outgoing link authenticated using basic HTTP authentication or do not configure any authentication for the link. For example, you may link your external Confluence server to a partner organisation's Confluence server. An unauthenticated link will still allow the local application to render hyperlinks to the remote application or query anonymously-accessible APIs.

The flowchart below provides a guide to what authentication you should configure for your application link.

Read the following topics for information on how to configure authentication for an application link:

- Configuring Basic HTTP Authentication for an Application Link
- Configuring OAuth Authentication for an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Incoming and Outgoing Authentication

Flowchart above: Determining what authentication to configure for an Application Link

Security Implications for each Authentication Type

If you configure Trusted Applications authentication for your application (i.e., your servers have the same set of users and they fully trust each other), please be aware of the following security implications:

- Trusted applications are a potential security risk. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all
code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.

If you configure **OAuth authentication** for your application (i.e. your servers have different sets of users and they fully trust each other), please be aware of the following security implications:

- Adding an OAuth consumer requires the transmission of sensitive data. To prevent 'man-in-the-middle' attacks, it is recommended that you **use SSL** for your applications while configuring OAuth authentication.
- Do not link to an application using OAuth authentication, unless you **trust all code in the application** to behave itself at all times. OAuth consumers are a potential security risk to the applications that they are linked to.

```
Confluence 5.0 Documentation

Screenshot above: Configuring authentication during application link setup

**About Primary Authentication Types**

You can configure multiple authentication types for each application link. When a feature makes a request using an Application Link, it will use one of the configured authentication types. If more than one authentication type is configured, it will by default use the authentication type that is marked as the primary authentication type. The default authentication type is indicated by the green tick ✓ next to the authentication type on the list application link screen.

You **cannot** configure which authentication type is the primary authentication type. The primary authentication
type is determined automatically by Application Links and depends on a weight defined by each authentication type method. However, every feature that uses Application Links can also choose to use a specific authentication type and might not use the default primary authentication type.

**About Impersonating and Non-Impersonating Authentication Types**

Applications Links allows you to configure 'impersonating' and 'non-impersonating' authentication types:

- **Impersonating authentication types** make requests on behalf of the user who is currently logged in. People will see only the information that they have permission to see. This includes OAuth and Trusted Applications authentication.
- **Non-impersonating authentication types** always use a pre-configured user when making a request. Everyone logged into the system will see the same information. This includes basic HTTP authentication.

**Configuring Basic HTTP Authentication for an Application Link**

The instructions on this page describe how to configure Basic HTTP authentication for outgoing authentication and/or incoming authentication for an application link.

Basic HTTP authentication allows Confluence to provide user credentials to a remote application and vice versa. Once authenticated, one application can access specified functions on the other application on behalf of that user. For example, if you supply the credentials of a Confluence administrator on your Confluence server to a remote application, the remote application will be able to access all functions on your Confluence server that the Confluence administrator can access.

This method of authentication relies on the connection between Confluence and the remote application being secure. We recommend that you use Trusted Applications authentication or OAuth authentication for your application link instead, if possible.

**On this page:**
- Before You Begin
- Configuring Basic HTTP Authentication for Outgoing Authentication
- Configuring Basic HTTP Authentication for Incoming Authentication
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

**Before You Begin**

- The instructions assume that both of the applications that you are linking have the Application Links plugin installed. If the remote application that you are linking to supports Basic HTTP authentication, but does not have the Application Links plugin installed, you will need to configure Basic HTTP authentication from within the remote application (see the relevant administrator’s documentation for the application). This is in addition to configuring the outgoing/incoming authentication for the application link (as described below).
- You must be a Confluence administrator to configure Basic HTTP authentication for an application link.

**Configuring Basic HTTP Authentication for Outgoing Authentication**

Configuring outgoing basic http authentication will allow Confluence to trust a remote application (i.e. allow the remote application to access specified functions in Confluence).

**To configure basic http authentication for an outgoing application link:**

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure authentication for.
3. Click the ‘Outgoing Authentication’ tab. The outgoing authentication page will be displayed.
4. Click the ‘Basic Access’ tab.
5. Click the ‘Configure’ button and enter the credentials (username and password) that the remote application will use to log into your application.
6. Click the ‘Apply’ button to save your changes.

Configuring Basic HTTP Authentication for Incoming Authentication

Configuring incoming basic http authentication will allow the remote application that you are linking to, to trust Confluence (i.e. allow Confluence to access specified functions on the remote application it is linked to).

To configure basic http authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure authentication for.
3. Click the ‘Incoming Authentication’ tab. The incoming authentication page will be displayed.
4. Click the ‘Basic Access’ tab.
5. Click the ‘Configure’ button and enter the credentials (username and password) that the your application will use to log in to the remote application.
6. Click the ‘Apply’ button to save your changes.

Notes

Related Topics

- Configuring OAuth Authentication for an Application Link
- Configuring Trusted Applications Authentication for an Application Link
- Configuring OAuth Authentication for an Application Link

The instructions on this page describe how to configure OAuth for outgoing authentication and/or incoming authentication for an application link.

OAuth is a protocol that allows a web application to share data/resources with any other OAuth-compliant external application. These external applications could be another web application (such as a JIRA installation or an iGoogle home page), a desktop application or a mobile device application, provided that they are accessible from within your network or available on the Internet.

For example, you could set up an application link between Confluence and an iGoogle page using OAuth authentication. This would allow you to view data from your Confluence server in a Confluence gadget on the iGoogle page (see Configuring Confluence Gadgets for Use in Other Applications).

A typical scenario is setting up an application link between two applications which trust each other, do not share the same set of users but both applications have the Application Links plugin installed. In this case, you would configure OAuth for both outgoing authentication and incoming authentication. See Configuring Authentication for an Application Link for other configurations.

**Key OAuth Terminology**

- **Service provider** — An application that shares (‘provides’) its resources.
- **Consumer** — An application that accesses (‘consumes’) a service provider’s resources.
- **User** — An individual who has an account with the Service Provider.

For more information about OAuth, see Configuring OAuth as well as the OAuth specification.
Before You Begin

- Adding an OAuth consumer requires the transmission of sensitive data. To prevent 'man-in-the-middle' attacks, it is recommended that you use SSL for your applications while configuring OAuth authentication.
- Do not link to an application using OAuth authentication, unless you trust all code in the application to behave itself at all times. OAuth consumers are a potential security risk to the applications that they are linked to.
- The instructions assume that both of the applications that you are linking have the Application Links plugin installed. If the remote application that you are linking to supports OAuth, but does not have the Application Links plugin installed, you will need to configure OAuth from within the remote application (see the relevant administrator's documentation for the application) in addition to configuring the outgoing/incoming authentication for the application link (as described below).
- You must be a Confluence administrator to configure OAuth authentication for an application link.

Configuring OAuth for Outgoing Authentication

Configuring outgoing OAuth authentication will allow Confluence to access data in a remote application on behalf of a user (i.e. allow Confluence to access specified functions in the remote application).

To configure OAuth authentication for an outgoing application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to configure OAuth for.
3. Click the 'Outgoing Authentication' tab. The outgoing authentication page will be displayed.
4. Click the 'OAuth' tab.
5. If you are not currently logged in to the remote application (or you logged in to the remote application under a variant of the application's hostname, such as the IP address), a login dialogue will display.
   - Enter the 'Username' and 'Password' for the remote server, not your local server, and click the 'Login' button. The remote server needs to learn the identity of your local server for the OAuth protocol to work and your admin credentials are used to store your local server's public key on the remote server. If you are already logged into your remote server, then the appropriate changes can be made without having to log in again.
6. Click the 'Enable' button to enable OAuth authentication for the outgoing link. Your application will be automatically set up to be the 'consumer' and the remote application as a 'service provider'.

Configuring OAuth for Incoming Authentication

Configuring incoming OAuth authentication will allow the remote application that you are linking to, to access data in Confluence.

To configure OAuth authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that
have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure OAuth for.
3. Click the ‘Incoming Authentication’ tab. The incoming authentication page will be displayed.
4. Click the ‘OAuth’ tab.
5. Click the ‘Enable’ button to enable OAuth authentication for the incoming link. The remote application will be automatically set up to be the ‘consumer’ and your local application as a ‘service provider’.

Related Topics

Conﬁguring Basic HTTP Authentication for an Application Link
Conﬁguring Trusted Applications Authentication for an Application Link
Conﬁguring Conﬂuence Gadgets for Use in Other Applications
Conﬁguring Trusted Applications Authentication for an Application Link

The instructions on this page describe how to conﬁgure Trusted Applications for outgoing authentication and/or incoming authentication for an application link.

Trusted Applications authentication allows one application to allow access to speciﬁed functions on another application on behalf of any user, without the user having to log into the second application. For example, if you configure a JIRA server to trust a Confluence server, every Confluence user will see exactly the same list of issues when they view the Confluence ‘JIRA Issues’ macro as they see when they use the JIRA Issue Navigator as a logged-in JIRA user.

A typical scenario is setting up an application link between two applications which trust each other, have the same set of users and both have the application links plugin installed. In this case, you would configure Trusted Applications for both outgoing authentication and incoming authentication. See Conﬁguring Authentication for an Application Link for other conﬁgurations.

On this page:
- Before You Begin
- Conﬁguring Trusted Applications for Outgoing Authentication
- Conﬁguring Trusted Applications for Incoming Authentication
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Before You Begin

- Trusted applications are a potential security risk. When you conﬁgure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not conﬁgure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.

- The instructions below assume that both of the applications that you are linking have the Application Links plugin installed. If the remote application that you are linking to supports Trusted Applications, but does not have the Application Links plugin installed, you will need to conﬁgure Trusted Applications from within the remote application (see the relevant administrator’s documentation for the application) in addition to conﬁguring the outgoing/incoming authentication for the application link (as described below).

- You must be a Confluence administrator to conﬁgure Trusted Applications authentication for an application link.

Conﬁguring Trusted Applications for Outgoing Authentication

Conﬁguring outgoing Trusted Applications authentication will allow the remote application to trust Confluence (i.e. allow Conﬂuence to access speciﬁed functions and data on the remote application).
To configure Trusted Applications authentication for an outgoing application link:

1. Log in as a system administrator and go to the administration page. Click ‘Application Links’ in the administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
2. Click the ‘Configure’ link next to the application link that you want to configure Trusted Applications authentication for.
3. Click the ‘Outgoing Authentication’ tab. The outgoing authentication page will show, with the ‘Trusted Applications’ tab displayed.
4. If you are not currently logged into the remote application (or you logged into the remote application under a variant of the application’s hostname, e.g. the IP address), a login dialogue will display.
   - Enter the ‘Username’ and ‘Password’ for the remote server, (not your local server), and click the ‘Login’ button. You need to enter the credentials for the remote server, as the remote server needs to be instructed to trust your local server for the Trusted Applications protocol to work. If you are already logged into your remote server, then the appropriate changes can be made without having to log in again.
5. Configure the settings for the Trusted Applications authentication:
   - ‘IP Patterns’ — Enter the IP addresses (IPv4 only) from which the remote application will accept requests (this effectively is the IP address your local server). You can specify wildcard matches by using an asterisk (*), e.g. ‘192.111.*.1’ (note, you cannot use netmasks to specify network ranges). If you are entering multiple IP addresses, separate them with commas or spaces.
     **Please note, if you are setting up Trusted Applications between two applications that both have the Application Links plugin installed, you can leave this field blank (or explicitly use *.*.*.*). However, if your remote application does not have the Application Links plugin installed and you are configuring the IP Patterns in the remote application (not the Application Links plugin), you must not leave this field blank nor use *.*.*.*. Failure to configure IP address restrictions in this scenario is a security vulnerability, allowing an unknown site to log into your site under a user’s login ID.**
   - ‘URL Patterns’ — Enter the URLs in the remote application that your local application will be allowed to access. Each URL corresponds to a particular application function. Enter one URL per line, as follows:
     - If your remote application is JIRA, enter the following URL Patterns: /plugins/servlet/streams,/ar/jira.issueviews:searchrequest,/secure/RunPortlet,/rest,/rpc/soap
     - If your remote application is Confluence, enter the following URL Patterns: /plugins/servlet/streams,/plugins/servlet/applinks/whoami
   - ‘Certificate Timeout (ms)’ — Enter the certificate timeout. The default is 10 seconds. The certificate timeout is used to prevent replay attacks. For example, if a Trusted Applications request is intercepted and (maliciously) re-sent, the application will be able to check when the request was first sent. If the second request is sent more than 10 seconds (or whatever the certificate timeout is set to) after the initial request, it will be rejected. Please note, you should not have to change the default value of this field for most application links. Note that the certificate timeout relies on the clocks on both servers being synchronised.
6. Click the 'Apply' button to save your changes.

Configuring Trusted Applications for Incoming Authentication

Configuring incoming Trusted Applications authentication will allow Confluence to trust the remote application that you are linking it to (i.e. allow your 'trusted' remote application to access specified functions and data on Confluence).

To configure Trusted Applications authentication for an incoming application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to configure Trusted Applications authentication for.
3. Click the 'Incoming Authentication' tab. The incoming authentication page will show, with the 'Trusted Applications' tab displayed.
4. The tab will show whether Trusted Applications is currently enabled or not. Use the 'Modify' or 'Configure' button to configure Trusted Applications. The Trusted Applications configuration settings will be displayed:

- 'IP Patterns' — Enter the IP addresses (IPv4 only) from which our application will accept requests. You can specify wildcard matches by using an asterisk ('*'), e.g. '192.168.1.1.*.*' (note, you cannot use netmasks to specify network ranges). If you are entering multiple IP addresses, separate them with commas or spaces.

Please note, if you are setting up Trusted Applications between two applications that both have the Application Links plugin installed, you can leave this field blank (or explicitly use '*.*.*.*'). However, if your remote application does not have the Application Links plugin installed and you are configuring the IP Patterns in the remote application (not the Application Links plugin), you must not leave this field blank nor use '*.*.*.*'. Failure to configure IP address restrictions in this scenario is a security vulnerability, allowing an unknown site to log into your site under a user's login ID.

Consider the following scenarios, if you want to limit access by using this field:

- If the remote application is using a proxy server, you need to add the proxy server's IP address to this field.
- If the remote application is a clustered instance of Confluence, you need to accept requests from each cluster node. If you do not specify each node's address, Confluence users may not be able to view any data from your application. You can set this up by either specifying each individual IP address for each node of the cluster (e.g. 172.16.0.10, 172.16.0.11, 172.16.0.12), or specifying the IP address for your clustered Confluence instance using wildcards (e.g. 172.16.0.*).

- 'URL Patterns'— Enter the local URLs that the remote application will be allowed to access. Each URL corresponds to a particular application function. Enter one URL per line, as follows:
  - If your local application is JIRA, enter the following URL Patterns — /plugins/servlet/streams,/sr/jira.issueviews:searchrequest,/secure/RunPortlet,/rest,/rpc/soap
  - If your local application is Confluence, enter the following URL Patterns — /plugins/servlet/streams,/plugins/servlet/applinks/whoami

- 'Certificate Timeout (ms)' — Enter the certificate timeout. The default is 10 seconds. The certificate timeout is used to prevent replay attacks. For example, if a Trusted Applications request is intercepted and (maliciously) re-sent, the application will be able to check when the request was first sent. If the second request is sent more than 10 seconds (or whatever the certificate timeout is...
set to) after the initial request, it will be rejected. Please note, you should not have to change the default value of this field for most application links. Note that the certificate timeout relies on the clocks on both servers being synchronised.

5. Click the 'Apply' button to save your changes.

Notes

Related Topics

Configuring Basic HTTP Authentication for an Application Link
Configuring OAuth Authentication for an Application Link
Incoming and Outgoing Authentication

When you configure authentication for an application link, you are defining the level of trust between the two linked servers. When configuring a link from one application to another, you can set up:

- **Incoming authentication** (authentication of requests coming from a linked application into this application).
- **Outgoing authentication** (authentication of requests sent from this application to a linked application).

See Configuring Authentication for an Application Link.

⚠️ The information on this page does not apply to Confluence OnDemand.

Editing an Application Link

You can change the details, such as the application name and display URL, for an existing application link.

On this page:
- [Editing an Application Link](#)
- [Notes](#)

⚠️ The information on this page does not apply to Confluence OnDemand.

**Editing an Application Link**

**To edit an application link:**

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Configure' link next to the application link that you want to edit the details for. The application details for the application link will be displayed.
3. Update the application details as desired. Please note, you cannot update the Application Type nor the Application URL.
   - 'Application Name' — Update this field to change the display name for the application that you are linking to.
   - 'Display URL' — This URL is used when displaying links to the application in the browser. When creating the application link, you may have used a URL that is not accessible to other users, such as an internal IP address. If so, you can change the display URL to an address in a domain that is accessible to other users.
4. Click the 'Update' button to save your changes.
1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the...
administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.

2. Click the 'Make Primary' link next to the application link that you want to make the primary link. A symbol will display in the 'Primary' column next to the application link.

The 'Primary' column and 'Make Primary' link will only display if you have set up application links to more than one of the same application type, e.g. you have linked your application to two JIRA servers.

Notes

Please read Making a Project Link the Primary Link for information on how primary project links also influence the information shared between servers.

Related Topics

Making a Project Link the Primary Link
Relocating an Application Link

This page describes how to change the location of an application link. You will need to relocate an application link if the target application has been moved to a new address.

The information on this page does not apply to Confluence OnDemand.

To relocate an application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.

2. If the remote application for an application link cannot be reached by your application, the 'List Application Links' page will display a warning message (see 'Relocate Link - Warning Message' screenshot below).

3. If your remote application has been moved to a different address (rather than just being offline temporarily), click the 'Relocate' link in the warning message (see 'Relocate Link - Updating URL' screenshot below).

4. Enter the new URL for the remote application of your application link and click 'Relocate'.

5. You will need to confirm the relocation, if the new URL cannot be contacted. Otherwise, the application link will be updated.

Screenshot above: Relocate link – The warning message
The instructions on this page describe how to upgrade an existing application link. You may want to upgrade an application link in either of the two situations below:

- Your Confluence instance has been upgraded from a version that does not include Application Links to a version that does. For example, you may have configured Trusted Applications or OAuth in a Confluence 3.4 instance (does not include Application Links) and then upgraded to Confluence 3.5 (includes Application Links).
- Your remote application has been upgraded to a version that includes Application Links. For example, you had set up an application link in a Confluence 3.5 instance (includes Application Links) to JIRA 4.2 instance (does not include Application Links), and then upgrade to JIRA 4.3 (includes Application Links).

**On this page:**
- Upgrading an Application Link (Local App Upgraded to Include Application Links)
- Upgrading an Application Link (Remote App Upgraded to Include Application Links)
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

**Upgrading an Application Link (Local App Upgraded to Include Application Links)**

When you upgrade from a Confluence version that does not include Application Links to version that does, you will have the option of converting any Trusted Applications or OAuth links to Application Links. The advantage of converting your links to Application Links is that link configuration will be simplified in future.

**To upgrade an application link when your local application has been upgraded to include Application Links:**

1. After your application upgrade, navigate to the administration console.
2. Click ‘Application Links’. The ‘Configure Application Links’ screen will be displayed with the following message:

   "There are existing Trusted Applications or OAuth relationships that should be upgraded to Application Links. Click here to upgrade."

3. Click the ‘Click here to upgrade’ link. The ‘Existing Trust Relationships’ screen will be displayed showing all Trusted Applications and OAuth relationships that can be upgraded to Application Links.
4. Click the ‘Upgrade to Application Link’ link next to the desired trust relationship. The ‘Upgrade to
Application Link’ wizard will be displayed.
5. Complete the wizard. The process will be similar to adding a new link (described on Adding an Application Link), except that most fields should be pre-filled.

Screenshots above: Upgrading an application link for local application

Upgrading an Application Link (Remote App Upgraded to Include Application Links)

When an application link is created between a version of Confluence that supports Application Links, and a remote legacy application (either a non-Atlassian product, or an older version of an Atlassian product that did not ship with Application Links), this link is configured to run in “legacy mode”. While there is no distinguishable difference to a user, connection and configuration without Application Links is a little different. For example:

- Setting up OAuth requires manual configuration by the administrator. In OAuth authentication for between applications that support Application Links, exchange of the consumer keys and public keys is done automatically.
- The Trusted Applications protocol (Atlassian-specific) will not be available for authentication.

If you upgrade your remote application to a version that does include Application Links, the application link will continue to work. However, upgrading your link may simplify link configuration and make additional authentication protocols available (as mentioned above).

To upgrade an application link when your remote application has been upgraded to include Application Links:

1. After you have upgraded your remote application to a version that includes Application Links, go to the administration console of your local application. A warning will be displayed, requesting that you upgrade the link to full Application Links mode.
2. Click ‘Upgrade’ in the warning message to start the upgrade wizard. Note the following:
   - You will be prompted to make your application link a reciprocal link. You will need to provide administrator credentials for your remote application, if you choose to do so.
   - If you make your application link a reciprocal link, you will also be able to make reciprocal links for your project links. For example, you may be able to link your JIRA project to a FishEye repository and also make a link from your FishEye repository back to the JIRA project.
Configure Application Links

<table>
<thead>
<tr>
<th>Name</th>
<th>Application</th>
<th>Application URL</th>
<th>Configured Authentication</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>REFAPP</td>
<td>Reference Application</td>
<td><a href="http://localhost:5992/refapp">http://localhost:5992/refapp</a></td>
<td>Basic Access</td>
<td></td>
</tr>
</tbody>
</table>

### Screenshot above: Upgrading an application link for remote application

**Link to Reference Application**

- **RefApp - erik**
- **REFAPP**

- **Create a link back to this server.** Provide administrator credentials for ‘REFAPP’. These are used once to authenticate you and will not be saved. Read More.
  - Username: admin
  - Password: ****

- **For each existing Charlie link, create an incoming link from the remote application.**

Accessible URL of this application for the reciprocal link:

http://erik.sydney.atlassian.com:5990/refapp

### Screenshot above: Upgrading an application link wizard

**Notes**

**Related Topics**

- Adding an Application Link
- Configuring Authentication for an Application Link
Deleting an Application Link

Deleting an application link stops the two applications from sharing information. You will no longer be able to make requests from one application to the other. This means that certain features may not work, e.g. JIRA issues macro in Confluence, Confluence Page Gadget in JIRA, etc.

If you have set up application links to multiple servers of the same application type, e.g. you have linked your application to multiple JIRA servers, deleting the primary link will mean that another of the links will be made the primary link.

Deleting an application link will also delete all project links set up for that application link.

To delete an application link:

1. Log in as a system administrator and go to the administration page. Click 'Application Links' in the administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
2. Click the 'Delete' link next to the application link that you want to delete. A confirmation screen will be displayed.
3. Click the 'Confirm' button to delete the application link.

RELATED TOPICS

Editing an Application Link
Relocating an Application Link
Configuring Project Links across Applications

Let's assume that you are managing a project or team. You would like to connect your project's Confluence space with your JIRA project, and link up your team's source repository too.

When you have connected your applications via Application Links, you can also connect the areas of those applications that contain information relating to your project or team. Using project links (also called entity links) you can associate one or more projects, spaces and repositories across the linked applications.

To connect all the information relating to the project or team that you are managing, you can link one or more of the following:

- JIRA projects.
- Confluence spaces.
- FishEye repositories.
- FishEye projects. A FishEye 'project' is the Crucible project if you have installed FishEye and Crucible, otherwise it is the paths associated via the 'FishEye Project Content' function in FishEye.
- Crucible projects.
- Bamboo projects.

Uses for Project Links

The following integration features use project links:

- Activity streams. For example, the project links determine the activity retrieved from JIRA to display in the activity stream of a FishEye repository or a Crucible project.
The JIRA FishEye plugin. For example:

- The link between a JIRA project and a FishEye repository determines the repository searched for a particular issue key when displaying the FishEye source tab in JIRA.
- The link between a JIRA project and a Crucible project determines the Crucible project scanned for review activity when displaying the Crucible reviews tab in JIRA.
- When you create a defect in Crucible, Crucible will know which JIRA project to put it in.
- Third-party plugins may make use of project links to enrich their functionality too.

Managing Project Links

- Adding Project Links between Applications
- Making a Project Link the Primary Link
- Deleting a Project Link

RELATED TOPICS

Adding an Application Link

Let's assume that you are managing a project or team. You would like to connect your project's Confluence space with your JIRA project, and link up your team's source repository too.

When you have connected your applications via Application Links, you can also connect the areas of those applications that contain information relating to your project or team. Using project links (also called entity links) you can associate one or more projects, spaces and repositories across the linked applications.

To connect all the information relating to the project or team that you are managing, you can link one or more of the following:

- JIRA projects.
- Confluence spaces.
- FishEye repositories.
- FishEye projects. A FishEye 'project' is the Crucible project if you have installed FishEye and Crucible, otherwise it is the paths associated via the 'FishEye Project Content' function in FishEye.
- Crucible projects.
- Bamboo projects.

⚠️ The information on this page does not apply to Confluence OnDemand.

To link a Confluence space to a project in another application:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.

   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).
2. Click ‘Application Links’ in the left-hand panel.
3. Choose the Confluence space that you want to link from.
4. The instructions for adding a project link will vary depending on whether the target application has the Application Links functionality installed:
   - If the target application has Application Links:
     a. Click ‘Add Link’. A dropdown menu will appear listing the applications you have already linked to.
     b. In the dropdown menu, click the application that contains the project you want to link to. For example, if you want to link to a specific JIRA project, click the JIRA site that contains that
project. If you want to link to a Confluence space, click the Confluence site that contains that space.

c. Click one of the options on the 'Authorization required' screen:
   - 'Authorize' — Click this option if you want to grant your project authorised access to the target project. The target application will open in a new window, so that you can log in and authorise access.
   - 'Skip – your access is anonymous' — Click this option if you only want to allow anonymous access to the target project.

d. In the 'Name or Key' field, enter the name/key of the project in the remote application that you want to link to. For example, if you want to link to a JIRA project, enter the project key. If you want to link to a Confluence space, enter the space key.

e. Click the 'Create' button to create the project link.

   • If the target application does not have Application Links:
      a. Click 'Add Link'. A dropdown menu will display listing the applications you have already linked to.
      b. In the dropdown menu, click the application that contains the project you want to link to. For example, if you want to link to a specific JIRA project, click the JIRA site that contains that project. If you want to link to a Confluence space, click the Confluence site that contains that space.
      c. In the 'Key' field, enter the name/key of the project in the remote application that you want to link to. For example, if you want to link to a JIRA project, enter the project key. If you want to link to a Confluence space, enter the space key.
      d. (optional) Enter the alias for the project in the 'Alias' field. This is the display name for the project in your administration console.
      e. Click the 'Create' button to create the project link.
one of the JIRA projects as the primary link. Every time Confluence requests JIRA information (for example, in a JIRA issues macro) it will request it from the primary link's JIRA project. Note, both JIRA projects can still request information from the Confluence space (for example, a Confluence page gadget on the dashboards of each JIRA instance).

⚠️ The information on this page does not apply to Confluence OnDemand.

To make a project link the primary link:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.
   
   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Click ‘Application Links’ in the left-hand panel.
3. Click the ‘Make Primary’ link in the ‘Action’ column for the project link that you want to make the primary link.
   A ☑ symbol will display in the ‘Primary’ column next to the link.
   
   Note: The ‘Primary’ column and ‘Make Primary’ link will appear only if you have set up multiple project links to the same application, for example you have linked a Confluence space to a number of JIRA projects.

   Screenshot above: Viewing the project links for a Confluence space

RELATED TOPICS

Adding Project Links between Applications
Deleting a Project Link
Deleting a Project Link

Deleting a project link stops the two projects from sharing information.

If you have set up multiple project links to the same application, for example you have linked a Confluence space to multiple JIRA projects, deleting the primary link will mean that another of the links will be made the primary link.

⚠️ The information on this page does not apply to Confluence OnDemand.

To delete a project link:

1. If this space has the Default theme applied, go to the space and choose Space tools on the sidebar.
   - If this space has the Documentation theme applied, go to Browse in the top bar and select Space Admin.
   
   Note: This option appears only if you are a space administrator for the space or you are a super user (a member of the confluence-administrators group).

2. Click ‘Application Links’ in the left-hand panel.
3. Click the ‘Delete’ link next to the link that you want to delete.
4. A confirmation screen will appear. Click the ‘Confirm’ button to delete the link.

![Screenshot above: Confirming the deletion of a project link](image)

**Related Topics**

---

**Adding Project Links between Applications**

**Making a Project Link the Primary Link**

**Configuring Workbox Notifications**

People can view and manage in-app notifications and tasks in their Confluence workbox. This page tells you how to enable in-app notifications and configure some related settings.

In addition, people can receive notifications from JIRA and other Confluence servers in their Confluence workbox. To make this possible, your Confluence server must be linked to the other server(s) via application links.

**Possible configurations:**

- Your Confluence server provides in-app notifications and displays them in its own workbox. There are two sub-configurations here:
  - This Confluence server is the only server involved.
  - Alternatively, this Confluence server displays its own in-app notifications, and also displays notifications from JIRA and/or other Confluence servers.
- Your Confluence server sends in-app notifications to another Confluence server. *Not applicable to Confluence OnDemand.*
- Your Confluence server does not provide or display in-app notifications.

**Notes:**

- **Workbox includes notifications and tasks:** When you enable in-app notifications, personal tasks are also enabled in the workbox. When you disable in-app notifications, the workbox no longer appears and personal tasks are therefore not available on this server.
- **Confluence OnDemand can include JIRA notifications:** If you have JIRA OnDemand as well as Confluence OnDemand, you can configure Confluence to display notifications from JIRA OnDemand. You cannot receive notifications from another Confluence server, nor from an installed JIRA server.
Which notifications are included?

The workbox displays a notification when someone does one of the following in Confluence:

- Shares a page or blog post with you.
- Mentions you in a page, blog post or comment.
- Assigns you a task by mentioning you in a task list.
- Comments on a page or blog post that you are watching.
- Likes a page or blog post that you are watching.

The workbox does not show notifications triggered because you are watching a space. Only watches on pages and blog posts are relevant here.

If your Confluence site is linked to JIRA, you will also see the following JIRA notifications in your workbox:

- Comments on issues that you are watching.
- Mentions.
- Shares of issues, filters and searches.

Enabling Confluence workbox and in-app notifications

Confluence workbox and in-app notifications are disabled by default.

**To enable workbox and in-app notifications:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose In-app Notifications in the left-hand panel.
3. Choose displays in-app notifications (or displays in-app notifications from other servers). The workbox icon will appear in the Confluence top menu bar and will be visible to all users.

Screenshot: Simple configuration with Confluence workbox and in-app notifications enabled for this server only
### Configuring the polling intervals

The polling intervals are used by the Confluence server that displays in-app notifications and tasks in its workbox.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active polling interval</strong></td>
<td>This is the number of seconds that Confluence will wait before checking (polling) for new notifications relevant to the page that the user is currently viewing. This setting applies to the page open in the browser tab that currently has focus. It does not matter whether the user has the workbox open or not.</td>
</tr>
<tr>
<td><strong>Inactive polling interval</strong></td>
<td>This is the number of seconds that Confluence will wait before checking (polling) for new notifications relevant to all pages that are not currently in focus. These pages may be on the Confluence server that displays the workbox, or on other Confluence or JIRA servers that send their notifications to this server. This setting defines an upper limit. For inactive pages, Confluence starts with a polling interval equal to the active polling interval, then gradually increases the interval between polls until it reaches the limit defined here.</td>
</tr>
</tbody>
</table>

### Including notifications from JIRA

Confluence workbox can include notifications from your JIRA issue tracker. In Confluence OnDemand, you can do this if you have JIRA OnDemand too.

**To include notifications from JIRA:**

1. Connect JIRA and Confluence via application links: *(Not applicable to Confluence OnDemand.)*
   - Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
   - Choose **Application Links** in the left-hand panel.
   - Set up the link as described in **Adding an Application Link**.
   - If your JIRA server is linked to more than one Confluence server, make sure that the **primary** link is the Confluence server that will display the in-app notifications in its workbox. See the **JIRA guide** to making an application link the primary link.
2. Choose In-app Notifications in the left-hand panel of the Confluence administration console.
3. Choose displays in-app notifications from other servers.
   - Your JIRA server will appear in the list of linked applications below this option.
   - People will see JIRA notifications in their workbox, as described in Managing Notifications in Confluence.

Notes:
- JIRA sends its notifications to the Confluence server that is configured as the primary application link.
- Your JIRA server must be running JIRA 5.2 or later.
- The following plugins must be present and enabled in JIRA. The plugins are shipped with JIRA 5.2 and later:
  - 'Notifications and Tasks – Common Plugin'
  - 'Notifications and Tasks – JIRA Provider Plugin'
- You do not need to configure JIRA. The plugins are enabled by default in JIRA, and JIRA will automatically send notifications to Confluence.
- Confluence can display notifications from more than one server.

Screenshot: This Confluence server displays in-app notifications from itself and from JIRA

Stopping JIRA from sending notifications to Confluence

You may wish to configure Confluence to display its own notifications in its workbox, but prevent notifications from JIRA from appearing in the workbox, even when JIRA and Confluence are linked via application links.

The JIRA administration interface does not offer a way of disabling notifications sent to Confluence.

To stop JIRA from sending notifications to Confluence: Disable the following plugins in JIRA. (See the Universal Plugin Manager guide to disabling plugins.)

- 'Notifications and Tasks – Common Plugin'
- 'Notifications and Tasks – JIRA Provider Plugin'

Including notifications from another Confluence server

Confluence workbox can include notifications from another Confluence server. Not applicable to Confluence OnDemand.

Let's assume that you have two Confluence servers, ConfluenceChatty and ConfluenceQuiet. Let's also assume that you want ConfluenceChatty to display a workbox, and to include notifications from ConfluenceQuiet.
To include notifications from other Confluence servers:

1. Connect ConfluenceChatty and ConfluenceQuiet via application links. In ConfluenceChatty:
   - Choose the cog icon at top right of the screen, then choose Confluence Admin.
   - Choose Application Links in the left-hand panel.
   - Set up the link as described in Adding an Application Link.
2. Configure the notification settings in ConfluenceChatty:
   - Choose In-app Notifications in the left-hand panel of the Confluence administration console.
   - Choose displays in-app notifications from other servers.
3. Configure the notification settings in ConfluenceQuiet:
   - Choose In-app Notifications in the left-hand panel of the Confluence administration console.
   - Choose sends in-app notifications to another server.
   - Select the Confluence server that will display the workbox – in our example, this is ConfluenceChatty. (The entry for ConfluenceChatty will appear here only if you have already configured ConfluenceChatty to display in-app notifications.)

Notes:

- Your Confluence servers must be running Confluence 4.3.3 or later.
- Confluence can display notifications from more than one server.
- Confluence can send notifications to only one server.
- Only one of the linked Confluence servers can display the in-app notifications.

Screenshot: This Confluence server displays in-app notifications from itself, from JIRA, and from another Confluence server

Sending Confluence notifications to another Confluence server

You can configure Confluence to send all notifications to a different Confluence server. In this case, the current Confluence server will not display the workbox.

To send notifications to another Confluence server: Follow the instructions in our example for ConfluenceQuiet above.

Screenshot: This Confluence server sends its in-app notifications to another Confluence server
Disabling workbox and in-app notifications in Confluence

If you choose **does not provide in-app notifications**:

- The Confluence workbox icon will no longer be visible and people will be unable to access their workboxes on this server.
- This Confluence server will no longer send notifications to its workbox, and will not send notifications to any other Confluence server.

Integrating JIRA and Confluence

Please refer to the guide to [Installing Confluence and JIRA Together](#).

**JIRA** and **Confluence** are designed to complement each other. Collect your team's thoughts, plans and knowledge in Confluence, track your issues in JIRA, and let the two applications work together to help you get your job done.

Below are some ways you can get JIRA and Confluence working together.

Setting Up Trusted Communication between JIRA and Confluence

An administrator can configure JIRA (3.12.0 or later) and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.

Trusted communication is used when embedding information from one application (for example, a list of JIRA issues) into another application (for example, a Confluence page).

Read more about [trusted communication](#).

Inserting JIRA Issues

You can insert issues from a JIRA site onto your Confluence page using the 'Insert JIRA Issue' dialogue box. You can also use this dialogue box to create a new issue on the JIRA site. See [Inserting JIRA Issues](#).

Combining Confluence Shortcuts and JIRA Quick Search

In our Confluence site's global configuration ([Administration > Shortcut Links](#)) we have the following shortcut defined:

```
JIRA: http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=
```

Use the above option to create links using Confluence’s shortcut notation.

- Link directly to JIRA issues like this: CONF-1000
- Use JIRA’s quick-search functionality to create links to particular groups of issues. The following link will
display a list of all open issues in the Confluence project of type 'Improvement': CONF open improvements.

**On this page:**
- Setting Up Trusted Communication between JIRA and Confluence
- Inserting JIRA issues
- Combining Confluence Shortcuts and JIRA Quick Search
- Viewing Confluence Content in JIRA or JIRA Content in Confluence
- Integrating JIRA and Confluence User Management
- Useful Plugins

**Related pages:**
- Integrating Confluence with Other Applications
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

**Screenshot: Configuring shortcuts**

![Screenshot of Configuring shortcuts](image)

Viewing Confluence Content in JIRA or JIRA Content in Confluence

**Using Gadgets**

You can embed a Confluence activity stream or a Confluence page in JIRA's dashboard. Likewise, JIRA gadgets can be rendered on a Confluence page. See [Adding a Confluence Gadget to a JIRA Dashboard](#) and [Gadget Macro](#) for information on how to set up gadgets.

**Using the JIRA Issues macro**

For versions earlier than Confluence 3.1 and JIRA 4.0, use the `{jiraissues}` macros to embed JIRA reports and portlets into your Confluence site.

Any JIRA search result can be embedded in a Confluence page using the [JIRA Issues macro](#) with your choice of
included fields and field ordering, and any JIRA gadgets can be embedded in a Confluence page by Registering External Gadgets.

Integrating JIRA and Confluence User Management

To save you having to enter users into both JIRA and Confluence, you may benefit from using Atlassian Crowd as the user repository for both applications. Alternatively you can configure Confluence to use JIRA's user database. See Connecting to Crowd or JIRA for User Management.

Useful Plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on's information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

The JIRA Linker plugin provides a custom field that helps you find an URL, particularly a Confluence page, so you can add a page link into a JIRA issue.

Installing Confluence and JIRA Together

This page describes Atlassian's recommendation for installing JIRA and Confluence on the same server. Refer to Here Be Dragons for instructions on integrating all Atlassian applications.

⚠️ Do not deploy multiple Atlassian applications in a single Tomcat container —

Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).

We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.

Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.

⚠️ The information on this page does not apply to Confluence OnDemand.

Recommended Setup - Separate Stand-Alone Installations

Atlassian recommends running JIRA and Confluence in separate stand-alone instances running behind an Apache Web Server. See the guides for:

- Installing Confluence
- Running Confluence behind Apache
- Installing JIRA
- Integrating JIRA with Apache

Advantages

- Each application can be restarted without affecting the other.
- If one webapp hangs for any reason (eg. running out of memory), it doesn’t affect the other.
- Any problems can be debugged more easily. Logs are separate and product-specific, rather than everything going to catalina.out. Thread and heap dumps are smaller and more relevant.
- It reduces the likelihood of jar conflicts (eg. jars that must be installed in common/lib or lib for Confluence running off Apache Tomcat version 6 or above), particularly if you later want to install a third webapp not from Atlassian.
- Apache HTTP Web Server is well suited for running publicly available sites, with extensive modules for
security and efficiency. It also allows for flexibility with URLs (i.e., http://confluence.atlassian.com, http://confluence, and so on).

Apache Web Server is recommended and reliable. It is also a third-party product, and therefore not developed nor supported by Atlassian. See Atlassian Support Offerings for details.

Setting Up Trusted Communication between JIRA and Confluence

An administrator can configure JIRA and Confluence to communicate in a trusted way, so that Confluence can request information from JIRA on behalf of the currently logged-in user. JIRA will not ask the user to log in again or to supply a password.

Trusted communication is used when embedding information from one application (for example, a list of JIRA issues) into another application (for example, a Confluence page).

Prerequisites

The following setup is required:

- JIRA 4.2.0 or later.
- Confluence 3.5.0 or later.
- In order to authenticate successfully against JIRA, the Confluence user must also be registered as a JIRA user with the same username.

Note: It is highly recommended that your JIRA and Confluence instances share a common user base, rather than two separate user bases with duplicated usernames. You will receive an error if Confluence passes JIRA a username which JIRA cannot recognise. Also, with separate user bases you run the risk that the same username may be used by two different people. The trusted application does not supply the user's password, so the trusting application will assume the username belongs to the user registered in the trusting application's own user base.

Tip: Try Atlassian Crowd for a tidy user management solution.

On this page:

- Prerequisites
- Why do we need Trusted Communication?
- Overview
- Configuring JIRA to trust Confluence
- Adding the macro to a Confluence page
- Viewing the Confluence page
- Security Risks
- Troubleshooting

Related pages:

- JIRA Issues Macro
- Troubleshooting the JIRA Issues Macro and Trusted Applications
- Connecting to LDAP or JIRA or Other Services via SSL
- Confluence Administrator's Guide
Why do we need Trusted Communication?

The JIRA Issues macro allows you to embed a list of JIRA issues into a Confluence page. Prior to Confluence 2.7, if you wanted to display JIRA issues that had restricted viewing, then you needed to store the JIRA user’s credentials (username and password) in the macro code directly on the Confluence page. This was not very secure.

The reasons we require the user credentials are:

- Your JIRA instance might not be public, and you might not want to allow anonymous access to your issues.
- You might have security restrictions on some of your issues. You may not want to allow someone to leak data from your JIRA project by using the JIRA Issues Macro on a Confluence page.

Overview

Here is a summary of the integration points in a trusted communications relationship. Each of the following points is described in more detail in the sections below.

- A JIRA or Confluence system administrator configures JIRA to trust Confluence.
- A Confluence user adds one of the macros to a Confluence page.
- A Confluence user or anonymous user views the Confluence page.

Configuring JIRA to trust Confluence

Trust only has to be established once between the two applications. Once trust has been established, it is entirely transparent to the Confluence users.

You can use Application Links to enable trust relationships between two applications. Linking two applications allows you to share information and access one application's functions from within the other.

You can configure an application link to use Trusted Applications as the authentication mechanism. For instructions, see Configuring Trusted Applications Authentication for an Application Link.

Adding the macro to a Confluence page

The Confluence user can add and edit the macros as described on the following page: JIRA Issues macro.

The following options are available for determining the issues which will be retrieved from JIRA and displayed on the Confluence page:

<table>
<thead>
<tr>
<th>What you want to do</th>
<th>Macro parameter</th>
<th>URL parameter</th>
<th>Comments</th>
</tr>
</thead>
</table>

The information on this page does not apply to Confluence OnDemand.
| Display the JIRA issues which the logged-in user is authorised to see. And if the user is not logged in, display only issues which allow unrestricted viewing. | Do not specify any authentication parameters. In this case, the behaviour depends on the way your administrator has set up trusted communication between JIRA and Confluence. Here is a summary of the behaviour. If trusted communication is enabled, the authorisation will work seamlessly. When a logged-in user views your page, they will see only the JIRA issues they are allowed to see. And if they are not logged in, they will see only the issues which allow unrestricted viewing. If trusted communication is disabled, the Confluence page will show only the JIRA issues which allow unrestricted viewing. | Ensure that Confluence will display only the JIRA issues which allow unrestricted viewing. | anonymous | Regardless of who the user is (logged in or not), the Confluence page will show only anonymously-visible issues. Confluence will not attempt to set up a trusted communication link with JIRA in this case. |
| Use a pre-determined username and password to access the JIRA issues. | &os_username=MYNAME&os_password=MYPASSWORD | Not recommended. Prior to Confluence 2.7, this was the only way of displaying issues with restricted viewing. For Confluence 2.7 and later, this method will still work. Confluence will not attempt to set up a trusted communication link with JIRA in this case. |
Viewing the Confluence page

When a user views a Confluence page which contains a JIRA Issues macro, this is what happens:

- If the macro markup contains an explicit username and password in the URL parameter, Confluence will not request trusted communication with JIRA. Confluence will retrieve the JIRA issues which the specified username is authorised to see. This behaviour is the same as Confluence versions prior to 2.7.
- If the macro markup contains the `anonymous` parameter, Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If the user is anonymous (not logged in), Confluence will retrieve only the JIRA issues which allow unrestricted viewing. Confluence will not attempt to set up a trusted communication link with JIRA in this case.
- If the user is logged in, then Confluence attempts trusted communication with JIRA. Confluence sends the username to JIRA. JIRA returns a set of issues which that username is authorised to access, based on the JIRA user base and the JIRA groups and permissions. Confluence displays those issues on the page.
- If JIRA or Confluence encounters a problem during the trusted communication process, an error message may appear on the Confluence page above the macro output – see troubleshooting below.

Security Risks

Please take the following considerations into account when setting up trusted communication:

- When you configure JIRA to trust an application, you are allowing the application to access JIRA in the name of a particular user. The trusted application passes JIRA the user's login name, but no other authentication information. JIRA does not request the user's password. By doing this, you are bypassing JIRA's authentication mechanism.
- Do not configure a trusted application unless you trust all code in that application to behave itself at all times.
- Trusted communication uses public/private key cryptography to establish the identity of the trusted server. The trusted application needs to maintain the security of its private key. Confluence stores its private key in the database. So you must be sure that the Confluence database is secure, and also any full backups of the database.
- Ensure that you specify an IP address for your Confluence site when configuring trusted applications in JIRA. Do not use the wild card `*.*.*.*` as the IP address. Failure to configure IP address restrictions is a security vulnerability, allowing an unknown site to log into your JIRA site under a user's login ID.
- Be aware of the risks associated with using separate user bases, as explained above. We strongly recommend a common user base between the trusted and trusting applications.
- When configuring an application to trust another application, you should use a trusted network or SSL to protect the sensitive information passed between the applications during the configuration procedure. This will help to prevent man-in-the-middle attacks.

Troubleshooting

Below are the warning messages which may appear on your Confluence page, above the output of the JIRA Issues macro.

<table>
<thead>
<tr>
<th>Warning Message</th>
<th>Cause</th>
<th>Solution</th>
<th>Warning Message Can Be Turned Off?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA is running over SSL</td>
<td>Add JIRA's SSL Certificate to the Java Keystore</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------------------------</td>
<td>----</td>
<td></td>
</tr>
<tr>
<td>The JIRA server does not recognise your user name. Issues have been retrieved anonymously.</td>
<td>The logged-in Confluence user is not registered in the JIRA user base.</td>
<td>Add the username to your JIRA user base. It is highly recommended that your JIRA and Confluence instances share a common user base.</td>
<td>No</td>
</tr>
</tbody>
</table>
| The JIRA server does not trust this Confluence instance for user authentication. Issues have been retrieved anonymously. You can set the macro to always use an anonymous request by setting the 'anonymous' parameter to 'true'. | Your JIRA instance has not been configured to trust your Confluence instance. | One of the following solutions:  
- Configure JIRA to trust Confluence.  
- Disable trusted communications for the JIRA macros in Confluence.  
- Use the anonymous parameter in all your JIRA Issues macros. | Yes |
| The JIRA server does not support trust requests. Issues have been retrieved anonymously. You can set the macro to always use an anonymous request by setting the 'anonymous' parameter to 'true'. | Your JIRA instance is not able to handle trusted communications (i.e. the JIRA version is earlier than 3.12.0). | One of the following solutions:  
- Download the latest version of JIRA and then configure JIRA to trust Confluence.  
- Disable trusted communications for the JIRA macros in Confluence.  
- Use the anonymous parameter in all your JIRA Issues macros. | Yes |
| Failed to login trusted application: confluence:1415982 due to: com.atlassian.security.auth.trustedapps.CertificateTooOldException: OLD_CERT; Certificate too old. | There is a date/time difference between the JIRA server and Confluence server. | Certificate Too Old KnowledgeBase Entry | - |

Consult Troubleshooting the JIRA Issues Macro and Trusted Applications for further troubleshooting.

### Registering External Gadgets

You can register gadgets from external web sites (such as JIRA, iGoogle or Gmail) with your Confluence installation, so that the gadgets appear in the macro browser and people can add them to Confluence pages via a gadget macro.

Choose one of the following ways to register the external gadgets on Confluence:

- **Subscribe to all of the external application’s gadgets**: You can add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.

- **Register the external gadgets one by one**: If you cannot subscribe to an application’s gadgets, you will need to add the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.

Both methods are described below. First, consider whether you need to set up a trust relationship between Confluence and the other application.

### Setting up a trust relationship with the other application

In addition to registering the external gadgets, we recommend that you set up an OAuth or Trusted Application relationship between the application that serves the gadget (the service provider) and Confluence (the consumer). The trust relationship is required for gadgets that access restricted data from the external web application.

See how to configure OAuth or Trusted Applications Authentication, using Application Links.

If the external web application provides anonymous access to all the data you need in the gadgets, then you do not need a trust relationship.

For example, if your gadgets will retrieve data from JIRA and your JIRA server includes projects and issues that are restricted to logged-in users, then you will need a trust relationship between Confluence and JIRA. If you do not set up the trust relationship, then the gadgets will show only the information that JIRA makes visible to anonymous users.

### Subscribing to all of the application’s gadgets

You can add all the gadgets from your JIRA, Bamboo, FishEye or Crucible site – or from another Confluence site – to your Confluence gadget directory. People can then pick and choose the gadgets to add to their Confluence pages.
To subscribe to another site's gadgets:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose External Gadgets in the left-hand panel.
3. Click the Gadget Feeds tab.
4. Enter the base URL of the application you want to subscribe to, in the text box labelled Gadget Feed URL. For example, http://example.com/jira or http://example.com/confluence.
5. Choose Add. Confluence will convert the URL to a gadget feed and place it in the list of ‘Added Gadget Feeds’.

On this page:

- Setting up a trust relationship with the other application
- Subscribing to all of the application's gadgets
- Registering individual gadgets
- Removing access to external gadgets

Related pages:

- Configuring a URL Whitelist for Gadgets
- The big list of Atlassian gadgets
- Adding JIRA Gadgets to a Confluence Page
- Configuring Application Links

⚠ The information on this page does not apply to Confluence OnDemand.

### Screenshot: Subscribing to a gadget feed

![External Gadgets](image)

Registering individual gadgets

If you cannot subscribe to an application's gadgets, you will need to register the gadgets one by one. This is necessary for applications and websites that do not support gadget subscription, and for applications where you cannot establish a trusted relationship via Application Links.

First you will need to obtain that gadget's URL and copy it to your clipboard.

**Getting a gadget's URL from an Atlassian application**

If your web application is another Atlassian application such as Confluence or JIRA:

A gadget's URL points to the gadget's XML specification file. In general, a gadget's URL looks something like
If the gadget is supplied by a plugin, the URL will have this format:
http://my-app.my-server.com:port/rest/gadgets/1.0/g/my-plugin.key:my-gadget/my-path/my-gadget.xml

For example:
http://mycompany.com/jira/rest/gadgets/1.0/g/com.atlassian.streams.streams-jira-plugin:activitystream-gadget/gadgets/activitystream-gadget.xml

To find a gadget's URL in JIRA:

- Go to your dashboard by clicking the **Dashboards** link at the top left of the screen.
- Click **Add Gadget** to see the list of gadgets in the directory.
- Find the gadget you want, using one or more of the following tools:
  - Use the scroll bar on the right to move up and down the list of gadgets.
  - Select a category in the left-hand panel to display only gadgets in that category.
  - Start typing a key word for your gadget in the **Search** textbox. The list of gadgets will change as you type, showing only gadgets that match your search term.
- Right-click the **Gadget URL** link for that gadget and copy the gadget's URL into your clipboard.

To find a gadget's URL in Confluence:

- Choose **Help > Confluence Gadgets** to see the list of available Confluence gadgets.
- Find the gadget you want.
- Right-click the **Gadget URL** link for that gadget and copy the gadget's URL into your clipboard.

Getting a gadget's URL from another application

If the gadget comes from a non-Atlassian web application or web site, please consult the relevant documentation for that application to obtain the gadget's URL.

Registering the gadget for use in Confluence

Now that you have the gadget's URL, you can register it in Confluence, so that people can add it to their pages.

To register the gadget in Confluence:

1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **External Gadgets** in the left-hand panel.
3. Paste your gadget's URL into the **Gadget Specification URL** field in the 'Add a new gadget' section.
4. Choose **Add**. Your gadget will be shown in the list of registered gadgets below and it will also become available in the macro browser.

**Screenshot: Registering external gadgets one by one**
Removing access to external gadgets

To remove a single gadget from Confluence, click the Remove button next to the gadget URL.

If you have subscribed to an application's gadgets, you will need to remove the entire subscription. You cannot unregister a single gadget. Click the Remove button next to the gadget feed URL.

The gadget(s) will no longer be available in the macro browser, and people will not be able to add them using the Gadget macro. Any pages that already use the gadget will show a broken gadget link.

Configuring a URL Whitelist for Gadgets

For security reasons, you may wish to limit the URLs from which users can get content that is displayed on your Confluence site, such as the content displayed in a gadget. A whitelist is a list of URLs whose content you wish to make available to users of your site.

Adding whitelist URLs for external gadgets

By default, Confluence will block a gadget's access to third-party data sources. When you are using a gadget that draws content from a third-party data source, you will need to add the URL of that data source to the gadget whitelist.

To add a URL to the whitelist for gadgets:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose External Gadgets in the left-hand panel.
3. Choose the Gadget Whitelist tab.
4. Enter a URL for the Host to Whitelist. For example, http://jira.atlassian.com. You can also enter a URL pattern, as described below.
5. Choose Add.
Rules for URL pattern-matching

Enter one URL or URL pattern per line. You can enter a full URL or use pattern-matching as described below:

- If the rule starts with an equals sign (=), only the exact URL following the '=' will be allowed.
- If the rule starts with a slash (/) then the whole rule will be treated as a regular expression.
- Otherwise, any asterisk (*) will be treated as a wildcard to match one or more characters.

Notes

- URLs for which Application Links are configured are automatically whitelisted, so you do not need to add them to this list.
- When a gadget or subscription is removed from your site, the whitelist entry is not automatically removed.

Managing your Confluence License

The license on your Confluence site entitles you to run Confluence and to have Atlassian support for a specified period. It also defines the number of users who are entitled to log in to the Confluence site.

Read how to find the details of your existing license, and get a Confluence license if you do not have one already.

Are too many people authorised to use your site, exceeding the number allowed by the license? Try reducing the user count, or see the licensing and pricing overview on the Atlassian website if you want to upgrade to a higher user count.

You may also need to find the support entitlement number (SEN) when dealing with the Atlassian support team.
Viewing and Editing License Details

When you upgrade or renew your Confluence license, you will receive a new license key. You will need to update your Confluence installation with the new license key.

You can access your existing license key, or generate an evaluation license key, at http://my.atlassian.com.

Updating your license details in Confluence

**To update your Confluence license:**

1. If you do not already have a license key, get your existing license key, or generate an evaluation license key, at http://my.atlassian.com.
2. Log in to Confluence as a user with Confluence Administrator or System Administrator permissions.
3. Choose the cog icon at top right of the screen, then choose Confluence Admin.
4. Choose License Details in the left-hand panel.
5. Enter your new license details into the License field.
6. Choose Save.

If you are running a Confluence cluster, you will need to:

- Update each server's Confluence license separately.
- Ensure that the new license has enough nodes to cover all servers that are currently running in your cluster. To check the number of active servers in your cluster, see the Cluster Administration page.
Viewing your license details

To view the details of your Confluence license:

1. Log in to Confluence as a user with Confluence Administrator or System Administrator permissions.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose License Details in the left-hand panel.

The 'License Details' screen tells you:

- What type of license you have (for example: Commercial, Academic, Community, or Evaluation).
- How many users your Confluence site is licensed to support, and how many are currently registered ('signed up currently'). See below for more about the user count. Choose Refresh to make sure you see the latest count.
- How much time remains in your one-year support and upgrades period (for full licenses) or 30-day trial (for trial licenses).
- Your server ID, which:
  - is generated when you install Confluence for the first time
  - exists for the life of the Confluence installation
  - survives an upgrade
  - is held in the database
Understanding the user count for your Confluence license

The number of registered users allowed on your Confluence site may be limited, depending on your license type. See the licensing and pricing overview on the Atlassian website. If you have an 'unlimited' license, then the number of registered users is not significant.

The number of registered users is also called the 'user count' or the number of users 'signed up currently'. It is determined as follows:

- It includes only those users who have the 'can use' global permission for the Confluence site. (See Global Permissions Overview for more about the 'can use' permission.)
- It does not include anonymous users, who may access your Confluence site if you have allowed anonymous access. (See Setting Up Public Access for more about allowing anonymous access.)
- It does not include deactivated users.

Downgrading your Confluence license to pay for fewer users

If you want to downgrade your Confluence license to one which allows fewer users, please make sure first that your new license covers your current user count.

- View your license details as described above.
- Check whether the number of users 'signed up currently' is lower than the number allowed by the new license.
- If you currently have more users signed up than the new license allows, please follow these instructions on reducing the user count.
- When the number of users 'signed up currently' is lower than the number allowed by your new license, you can add the new license key to Confluence as described above.

Getting a Confluence License

Need a Confluence license or license key?

- If you do not yet have a license, you can get a free multi-user evaluation license or a 10-user starter license immediately.
- If you already have a Confluence license, you can retrieve your key or generate a new key from the license viewer.
- For enterprise, non-profit, open source and educational licenses, see Confluence licensing and pricing.
- If you cannot find your key or are having problems, contact sales@atlassian.com.

Related pages:
- Viewing and Editing License Details
- Reducing the User Count for your Confluence License
- Confluence Administrator's Guide

Reducing the User Count for your Confluence License

This page tells you how to reduce the number of users that count towards your Confluence license. You may want to reduce your user count in Confluence if you have exceeded your license limit, or if you want to change to a lower-tier license to reduce costs.

Understanding the user count for your Confluence license

The number of registered users allowed on your Confluence site may be limited, depending on your license type. See the licensing and pricing overview on the Atlassian website. If you have an 'unlimited' license, then the number of registered users is not significant.
The number of registered users is also called the 'user count' or the number of users 'signed up currently'. It is determined as follows:

- It includes only those users who have the 'can use' global permission for the Confluence site. (See Global Permissions Overview for more about the 'can use' permission.)
- It does not include anonymous users, who may access your Confluence site if you have allowed anonymous access. (See Setting Up Public Access for more about allowing anonymous access.)
- It does not include deactivated users.

Reducing the user count

The recommended method for reducing your user count is to remove or deactivate the users. You can remove users who do not require access to Confluence and have never created content in Confluence. You can deactivate users who have created content but no longer require access to Confluence. See Deleting or Deactivating Users.

Alternatively, if you have connected Confluence to an LDAP directory, you may want configure Confluence to synchronise a subset of users from LDAP rather than all users. This is described in the following knowledge base article: Changing the Number of Users Synchronized from LDAP to Confluence. This can be a complicated procedure and we recommend that you do not use this method unless necessary.

**Finding Your Confluence Support Entitlement Number (SEN)**

There are three ways to find your Support Entitlement Number (SEN):

- **Method 1: Check in the Confluence Administration Interface**
  1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
  2. Choose License Details in the left-hand panel. The SEN is shown:
Method 2: Log into my.atlassian.com as the Account Holder or Technical Contact
Method 3: Atlassian Invoice

Your Support Entitlement Number (SEN) appears on the third page of your Atlassian invoice.

See Finding Your Support Entitlement Number in the support space for more general information about how Atlassian Support uses this number.

⚠️ The information on this page does not apply to Confluence OnDemand.

Managing Confluence Data

This page is an overview of recommended techniques for managing the data on your Confluence site. This is of interest to Confluence administrators – people with System Administrator or Confluence Administrator permissions.

- Database Configuration
- Site Backup and Restore
- Attachment Storage Configuration
- Confluence Data Directory Configuration
- Configuring Attachment Size
- Confluence Data Model
- Finding Unused Spaces
- Data Import and Export

Related pages:

- Managing Add-ons and Macros
- Integrating Confluence with Other Applications
- Getting Started as Confluence Administrator
- Confluence Administrator's Guide
Database Configuration

This document provides information on configuring an external database.

The embedded HSQL database for evaluation purposes

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the \database folder under your Confluence Home directory. See also Important Directories and Files.

Embedded Database is Not Suitable for Production Instances of Confluence

Production instances of Confluence should use an external database. When using the default HSQLDB database, you run the risk of unrecoverable data loss due to not being transaction safe.

- Corruption is occasionally encountered after sudden power loss and can usually be corrected using this data recovery procedure.
- HSQLDB is still suitable for evaluation purposes, but the risk can only be eliminated by switching databases. External databases may also provide superior speed and scalability.

Selecting an external database

Note: Take time to choose your database wisely. The XML backup built into Confluence is not suited for migration or backup of large data sets. If you need to migrate later, you will need to use a third party database migration tool.

Below is more information on selecting and migrating to an external database:

- Migrating to a Different Database
- List Of Supported Databases
- Database Troubleshooting

Database setup

Here are the setup instructions for the supported databases:

- Database Setup for Oracle
- Database Setup For MySQL
- Database Setup for PostgreSQL
- Database Setup for SQL Server
Optimising database performance

To improve database responsiveness:

- Improving Database Performance
- Database Troubleshooting

Database troubleshooting

For solving database-related problems:

- Troubleshooting External Database Connections
- Troubleshooting the Embedded Database (HSQldb)
- Interpreting DB2 error codes
- Database Troubleshooting

Obtain technical support from Troubleshooting Problems and Requesting Technical Support.

Notes

Issue CONF-12599 requests a more robust strategy for migrating large Confluence sites.

Database Setup For Any External Database

If you are using Confluence in a production environment, data should be stored in an external database. The embedded database is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss.

This document provides instructions for setting up Confluence for use with a production-ready database. It covers both migration from an evaluation installation of Confluence and installation of an empty database during initial setup. The following specific database guides have additional information:

- PostgreSQL Guide
- MySQL Guide
- Oracle Guide
- SQL Server

Preparation

Install the following on the Confluence server:

- Database administration tool, for example DBVisualizer
- JDBC database drivers
- The database server (unless accessed remotely)

The instructions refer to two particular directories:

- The `<Confluence Installation Directory>` is the directory where you unpacked the Confluence download.
- The `<Confluence Home Directory>` is the directory where Confluence stores its data, which you set by editing the `confluence-init.properties` file in `Confluence Installation Directory/confluence/WEB-INF/classes`.

Database Setup

Create the schema and setup permissions:

1. Visit the Database Configuration page to review any known issues and database setup for your database.
2. Create a new schema using the correct database encoding.
3. Create a user with full read/write access to the Confluence schema, including the ability to create tables.
4. If the database only permits users to log in from approved hosts (e.g. localhost), grant database access permission for the Confluence server.
5. If the database is hosted remotely to the Confluence server, set up any firewall permissions.
6. Test the connection by using the database administration tool installed on the Confluence server to log in to the database.

### Migration From an Evaluation Instance of Confluence

Continue here if you are migrating from an evaluation instance with the built-in database. If you are installing Confluence for the first time, continue below.

#### Create Backups

To keep any existing Confluence content:

1. If you are already using an external database, use your database administration tool to create a full database backup.
2. Manually create an XML backup of Confluence under `Administration` -> `Backup & Restore`. If you have less than 100MB of attachments, check 'Backup attachments' when creating the backup. If you have over 100MB of attachments, you should not check the 'Backup attachments' and instead you should manually copy the `/attachments` directory in your Confluence home to a backup location. This attachments directory will later be copied into the new home directory.
3. Download the backup file to a backup location.

#### Database Connection Setup

Set up Confluence's database connection:

1. Stop Confluence if it is already running.
2. The JDBC database drivers for your database must be available to the application server. You can skip this step if the drivers are already loaded.
   a. Copy the database driver JAR file into the `lib` directory. In Confluence this directory is `/confluence/WEB-INF/lib`. Other application servers will use a different path.
   b. If the application server does not support dynamic library loading, stop your application server.
3. Create a new Confluence home directory.
4. Open the `WEB-INF/classes/confluence-init.properties` file in your Confluence installation and change the `confluence.home` property to point to this new Confluence home directory.
5. Start up Confluence. Refer to the platform-specific installation instructions to learn how. You should be presented with the Confluence setup wizard. Enter your license information.
6. Select 'Custom install'.
7. Select a database from the drop down list.
8. Select Direct JDBC and then enter the username, password and database driver of the new database.
9. If you created a Confluence backup earlier and wish to restore it, import it into Confluence now.
10. Once the wizard is complete, if you did not check the 'Backup attachments', copy the backed up `/attachments` directory into the new Confluence home.

#### RELATED TOPICS

**Troubleshooting External Database Connections**

**Database Setup for Oracle**

This guide covers deploying the Confluence or Confluence WAR distributions with an Oracle database.

⚠️ **This database can only be set up by an Oracle database administrator (DBA)**

If you are not a DBA, you should not attempt to set up this database.

Oracle has a history of being extremely difficult to set up. If you do not have access to an experienced Oracle
DBA in your organisation, you are recommended to select any free, scalable and easy-to-install alternative rather than proceeding with Oracle. Users evaluating Confluence are recommended to start with an alternative database and only consider migrating to Oracle after approval from their DBA. Atlassian's technical support for Oracle setup difficulties will also reflect the high minimum skill requirements for attempting an Oracle setup.

**Database Setup Information**

This setup guide must be used in conjunction with the list of Known Issues For Oracle. Please review that page before continuing.

**Schema Requirements**

Confluence can be deployed to a schema in any Oracle instance.

**Database Compatibility**

Please refer to Supported Platforms for information about supported database versions. If your version of Oracle is not supported, please upgrade to a supported version before installing Confluence.

Check your database drivers, to see if you need an update.

- For Oracle 11.1, use the 10.2.0.4 or 11.1.0.7.0 driver (Java 6 ojdbc6.jar).
- For Oracle 11.2, use the 11.2.0.1.0 driver (Java 6 ojdbc6.jar).

Tip: search for the jar filename on the download site.

Check that your version of Oracle does not have any known issues:

<table>
<thead>
<tr>
<th>Oracle Version</th>
<th>Oracle Driver</th>
<th>Issue</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Any</td>
<td>Pre 10g</td>
<td>Driver incompatibilities</td>
<td>Upgrade to latest 10g drivers if compatible</td>
</tr>
</tbody>
</table>

You may be also interested in the relevant JIRA documentation to check the compatibility of your Oracle server and driver.

**Deploying Confluence with Oracle**

Complete the instructions for installing Confluence, then return to this document instead of proceeding to the Confluence Setup Guide.

**Database Preparation**

Tailor these instructions to your particular database version:

1. Perform any necessary database or driver upgrades. Download the latest compatible database drivers. See the Oracle JDBC driver FAQ.
2. Create a Confluence user and grant the appropriate roles only to the user (connect role is required to set up a connection, while resource role is required to allow the user to create objects in it's own schema. Create table, sequence and trigger are required to configure the schema):

```
create user <user> identified by <password>;
grant connect to <user>;
grant resource to <user>;
grant create table to <user>;
grant create sequence to <user>;
grant create trigger to <user>;
```
3. Add a local "all_objects" view to the user's schema, so that there is no possibility that a table with the same name as one of the Confluence tables in another schema will cause any conflicts. This is a workaround for the bug CONF-3613:

```sql
create view <user>.all_objects as
select *
from sys.all_objects
where owner = upper('<user>');
```

**Warning:** Do not grant the database user the `select` any table permission, or it can cause problems with other schemas, as per the same bug CONF-3613.

### Determining Your JDBC URL

The JDBC thin driver for Oracle use three different styles of URL:

**New Style**

```
jdbc:oracle:thin:@//[HOST][:PORT]/SERVICE
```

**Old Style**

```
jdbc:oracle:thin:@[HOST][:PORT]:SID
```

**tnsnames**

```
jdbc:oracle:thin:@(DESCRIPTION=
  (SDU=32768)
  (enable=broken)
  (LOAD_BALANCE=yes)
  (FAILOVER=yes)
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver1.example.com)
    (PORT=1525))
  (ADDRESS=
    (PROTOCOL=TCP)
    (HOST=dbserver2.example.com)
    (PORT=1525))
  (CONNECT_DATA=
    (SERVICE_NAME=CONFDB)))
```

*The tnsnames style is required for connecting to an Oracle RAC cluster. This example has been broken up over multiple lines for clarity, but it should be compacted into a single line. These may need more analysis than documented below, so you should seek the assistance of an experienced DBA.*

If you use the new style URL, then SERVICE can be either an SID or Service Name, but if you use the old style URL, it can only be the SID.

You should be able to determine the host, port, service name, and/or SID by getting a DBA to run the following...
command as the user running oracle (by default "oracle"):

```bash
lsnrctl status
```

For reference, here is a sample output:

```
SNRCTL for Linux: Version 11.2.0.2.0 - Beta on 29-JUN-2012 15:20:59
Copyright (c) 1991, 2010, Oracle. All rights reserved.
Connecting to (DESCRIPTION=(ADDRESS=(PROTOCOL=IPC)(KEY=EXTPROC_FOR_XE)))
STATUS of the LISTENER
-----------
Alias LISTENER
Version TNSLSNR for Linux: Version 11.2.0.2.0 - Beta
Start Date 06-JUN-2012 08:36:34
Uptime 23 days 6 hr. 44 min. 25 sec
Trace Level off
Security ON: Local OS Authentication
SNMP OFF
Default Service XE
Listener Parameter File
/u01/app/oracle/product/11.2.0/xe/network/admin/listener.ora
Listener Log File
/u01/app/oracle/diag/tnslsnr/<HOSTNAME>/listener/alert/log.xml
Listening Endpoints Summary...
 (DESCRIPTION=(ADDRESS=(PROTOCOL=ipc)(KEY=EXTPROC_FOR_XE)))
 (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=1521)))
 (DESCRIPTION=(ADDRESS=(PROTOCOL=tcp)(HOST=<HOSTNAME>)(PORT=8080))(Presentation=HTTP)(Session=RAW))
Services Summary...
Service "PLSExtProc" has 1 instance(s).
 Instance "PLSExtProc", status UNKNOWN, has 1 handler(s) for this service...
Service "XE" has 1 instance(s).
 Instance "XE", status READY, has 1 handler(s) for this service...
Service "XEXDB" has 1 instance(s).
 Instance "XE", status READY, has 1 handler(s) for this service...
The command completed successfully
```

1. The host and port is determined by the line containing `PROTOCOL=tcp`, **without** `Presentation=HTTP`.
2. Under services summary, each service which has an instance with READY status is a connectable service. The name following `Service` is a service name for connecting to the database name following `Instance` on the next line.
3. The SID is the name of the database instance, as defined by the `$ORACLE_SID` variable when you have sourced the Oracle environment to your shell.

For example, assuming that you are running Confluence on the same server as the Oracle database, with the above lsnrctl status output, you would use one of the following URLs:

```
jdbc:oracle:thin:@//localhost:1521/XE
jdbc:oracle:thin:@localhost:1521:XE
```

The URL can be used in either a direct JDBC connection or using a Tomcat datasource. If you want to use a datasource, please follow the instructions of the next two sections Adding a Datasource to Tomcat and Configuring Confluence Datasource Access, or if you'd prefer to just use a direct JDBC URL, skip to Running the
Confluence Setup Wizard.

For further information on Oracle JDBC URLs, see this page.

Adding a Datasource to Tomcat

1. Open `<INSTALL>/conf/server.xml` for editing.
2. Locate the section `Host -> Context`

```
<Host name="localhost" debug="0" appBase="webapps" unpackWARs="true"
   autoDeploy="false">
   <Context path="" docBase="..\confluence" debug="0" reloadable="true">
     <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
     Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
     <Manager pathname="" />
   </Context>
</Host>
```

3. Paste in the `Resource` section provided, before `Manager` as shown:

```
<Host name="localhost" debug="0" appBase="webapps" unpackWARs="true"
   autoDeploy="false">
   <Context path="" docBase="..\confluence" debug="0" reloadable="true">
     <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for
     Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
     <Resource name="jdbc/confluence" auth="Container"
               type="javax.sql.DataSource"
               driverClassName="oracle.jdbc.OracleDriver"
               url="jdbc:oracle:thin:@hostname:port:sid"
               username="<username>"
               password="<password>"
               connectionProperties="SetBigStringTryClob=true"
               maxActive="25"
               maxIdle="5"
               maxWait="10000"
             />
     <Manager pathname="" />
   </Context>
</Host>
```

4. Change the username and password to match the Oracle login.
5. Change `url` to match what you determined in Determining the JDBC URL. For example:

```
jdbc:oracle:thin:@example.atlassian.com:1521:confluencedb
```

6. If required, choose different maxActive and maxIdle values. These set how many total database connections will be allowed at one time, and how many will be kept open even when there is no database activity.

Configuring Confluence Datasource Access

Configure Confluence to use this datasource:
1. Edit the file `<INSTALL>/confluence/WEB-INF/web.xml
2. Go to the end of the file and just before `</web-app>`, insert the following:

   ```xml
   <resource-ref>
   <description>Connection Pool</description>
   <res-ref-name>jdbc/confluence</res-ref-name>
   <res-type>javax.sql.DataSource</res-type>
   <res-auth>Container</res-auth>
   </resource-ref>
   ```

Running the Confluence Setup Wizard

Now Confluence is ready to attempt to connect to Oracle:

1. Download the Oracle JDBC database drivers for your JDK version via the [Database JDBC Drivers](#) page. We recommend using the thin drivers only. Copy the JAR file into `<confluence install>`/WEB-INF/lib. This directory path is potentially `<INSTALL>`/lib if Confluence is running off Apache Tomcat version 6 or above.
2. Startup Confluence using `<INSTALL>/bin/startup.bat` or `<INSTALL>/bin/startup.sh
3. Insert your licence and select **External Database**.
4. If you are using a Datasource:
   a. Select **Datasource Connection** using your Oracle version.
   b. Enter `java:comp/env/jdbc/confluence` for the name of the datasource.
5. If you are using a Direct JDBC URL:
   a. Select **Direct JDBC URL** using your Oracle version.
   b. Enter your JDBC URL to match what you determined in [Determining the JDBC URL](#)

Confluence should now deploy using the Oracle database specified. Please read this comment on Oracle database optimisation.

*Oracle Configuration Tips*

**24-hour time format with Oracle 8i**

We have received a report from a user that when an Oracle 8i database is configured to use 24-hour time as the default format, an exception like this may occur:
One symptom of this problem is that Confluence may refuse to start after midday.

The workaround is to go to ‘General Configuration’ and set the default time format to "HH:mm".

RELATED TOPICS

Known Issues For Oracle
Database Setup for SQL Server

Use this guide in conjunction with the more general Database Setup Guide for Any Database. These instructions add some reference notes specific to SQL Server.

1. Review the known issues for SQL Server.
2. Identify which character encoding to use. To do this, check the encoding currently used by your application server and Confluence. All three must use compatible encoding. For example, the default SQL Server encoding of UCS-2 is compatible with UTF-8.
3. Create a new database (as an SQL administrator). If you set your application server and Confluence to use an encoding incompatible with UCS-2, specify that character encoding for the database.
4. Set the default collation for the database to be 'SQL_Latin1_General_CP1_CS_AS' (case sensitive). You can do this by issuing the following SQL query:
ALTER DATABASE <database_name> COLLATE SQL_Latin1_General_CP1_CS_AS

Note: if you receive an error at this point stating 'The database could not be exclusively locked to perform the operation', you may need to prevent other connections by setting the mode to single user for the transaction:

ALTER DATABASE <database_name> SET SINGLE_USER WITH ROLLBACK IMMEDIATE;
<your ALTER DATABASE query>
ALTER DATABASE <database_name> SET MULTI_USER;

5. Configure the database to use the isolation level, 'Read Committed with Row Versioning'. You can do this by issuing the following SQL query:

Determine if READ_COMMITTED_SNAPSHOT is enabled

SELECT is_read_committed_snapshot_on FROM sys.databases WHERE name= 'YourDatabase'

Return value:
1 = READ_COMMITTED_SNAPSHOT option is ON. Read operations under the read-committed isolation level are based on snapshot scans and do not acquire locks.
0 = READ_COMMITTED_SNAPSHOT option is OFF (default). Read operations under the read-committed isolation level use share locks.

ALTER DATABASE <database_name>
SET READ_COMMITTED_SNAPSHOT ON
WITH ROLLBACK IMMEDIATE;

6. Create a new SQL user account for Confluence (as an SQL administrator). Provide full create, read and write permissions for the database tables. Note that Confluence must be able to create its own schema.

7. If you are configuring a datasource to connect to your MS SQL server database, install the database drivers.

The JDBC drivers for this database are bundled with Confluence.

- If you are using a direct JDBC connection, you do not need to download or install any JDBC drivers.
- If you are connecting via a datasource, you must download and install the drivers manually. For information about driver versions and download links, see Database JDBC Drivers.
- If you are not sure which connection you are using, it is probably JDBC. A JNDI resource must be configured manually, as described in each database's docs: PostgreSQL, MySQL, SQL Server or Oracle

8. If you are configuring a datasource to connect to your MS SQL server database, place the JAR file in <confluence install>/WEB-INF/lib. You may also find this page helpful: http://jtds.sourceforge.net/faq.html

9. If you are installing a new version of Confluence: Start Confluence and visit the home URL (e.g. http://localhost:8090) to start the Confluence Setup Wizard. Select a custom installation, and insert the relevant
connection information.

- When prompted for a **driver class name** in the database setup step enter:
  
  ```
  net.sourceforge.jtds.jdbc.Driver
  ```

- When prompted for the **jdbc url**, the format to use is:
  
  ```
  jdbc:jtds:sqlserver://<server>:<port>/<database>
  ```

**Related pages:**

- Database Configuration
- Supported Platforms
- Confluence Administrator’s Guide

Configuring a SQL Server Datasource in Apache Tomcat

This page contains instructions on how to set up an SQL Server datasource connection for Confluence or Confluence EAR/WAR.

**On this page:**

- 1. Install the Driver
- 2. Shut down Tomcat
- 3. Configure Tomcat
- 4. Configure the Confluence web application
- 5. Configure Confluence

1. **Install the Driver**

   2. After unpacking the file you have downloaded, you'll find a file called something like `jtds-1.2.5.jar` (whatever is the latest version).
   3. Copy this file into the `common/lib` directory of your Tomcat installation. Be aware that this directory may be just `lib` for Tomcat version 6 and beyond (i.e. `<tomcat-install>/lib` rather than `<tomcat-install>/common/lib`).

   - Alternatively you can get the driver from `/confluence/WEB-INF/lib/jtds-1.2.2.jar` and move it into the `common/lib` directory of your Tomcat installation.

2. **Shut down Tomcat**

   1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.

   - Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE_INSTALL>/conf/server.xml` file so you can easily revert should there be a problem.

3. **Configure Tomcat**

   1. Firstly, you need to edit `<confluence-install>/conf/server.xml` and find the following lines:
2. Within the Context tags, directly after the opening `<Context.../>` line, insert the DataSource Resource tag:

```xml
<Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
    username="yourDatabaseUser"
    password="yourDatabasePassword"
    driverClassName="net.sourceforge.jtds.jdbc.Driver"
    url="jdbc:jtds:sqlserver://localhost:1433/yourDatabaseName"
    maxActive="20"
    maxIdle="10"
    validationQuery="select 1" />
```

- Replace the username and password parameters with the correct values for your database
- In the url parameter, replace the word 'yourDatabaseName' with the name of the database your confluence data will be stored in.

**Why is the validationQuery element needed?**

When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot.

However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

If switching from a direct JDBC connection to datasource, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.

The configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:

- **driverClassName** — Fully qualified Java class name of the JDBC driver to be used.
- **maxActive** — The maximum number of active instances that can be allocated from this pool at the same time.
- **maxIdle** — The maximum number of connections that can sit idle in this pool at the same time.
- **maxWait** — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
- **password** — Database password to be passed to our JDBC driver.
- **url** — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property driverName is also recognized.)
- **user** — Database username to be passed to our JDBC driver.
- **validationQuery** — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

4. Configure the Confluence web application
1. Edit /confluence/WEB-INF/web.xml in your confluence installation
2. Go to the end of the file and just before </web-app>, insert the following:

```xml
<resource-ref>
  <description>Connection Pool</description>
  <res-ref-name>jdbc/confluence</res-ref-name>
  <res-type>javax.sql.DataSource</res-type>
  <res-auth>Container</res-auth>
</resource-ref>
```

5. Configure Confluence

- **If you have not yet set up Confluence**
  1. Follow the steps in the Confluence Setup Guide.
  2. In the Database Setup section, choose the "Datasource Connection" option.
  3. Set the JNDI name to `java:comp/env/jdbc/confluence`
  4. Set the Database dialect to SQL Server.

- **If you are changing an existing Confluence installation over to using a Tomcat datasource**
  1. Edit the `<confluence home>/confluence.cfg.xml` file
  2. Delete any line that contains a property that begins with hibernate.
  3. Insert the following at the start of the `<properties>` section.

```xml
<property name="hibernate.setup">true</property>
<property name="hibernate.dialect">net.sf.hibernate.dialect.SQLServerIntlDialect</property>
<property name="hibernate.connection.datasource">java:comp/env/jdbc/confluence</property>
```

4. Restart Confluence.

**RELATED TOPICS**

- Configuring a MySQL Datasource in Apache Tomcat
- Database Setup For MySQL

This page provides instructions for configuring Confluence to use the MySQL database. If you do not already have a MySQL database driver, you will need to download the MySQL Java connector from MySQL, as described in the steps below.

Before you start, check that your version of MySQL is supported. See Supported Platforms.

**Step 1. Back up your existing Confluence data**

This step is required if you have existing Confluence content you wish to transfer.

**To back up your Confluence data:**

1. Manually create an XML backup of Confluence. See Manually Backing Up the Site.
   - If you have less than 100MB of attachments, check ‘Backup attachments’ when creating the backup.
   - If you have over 100MB of attachments, you should not check the 'Backup attachments'. Instead you should manually copy the /attachments folder, located in your Confluence home (data) directory, to another location. This attachments folder can then be copied into the new home directory as described later in this guide.
2. Download and save the backup file.

**Step 2. Install MySQL Server**

If you do not already have an operational MySQL database server, install 'MySQL Community Edition'. Download the installation package from the MySQL download page and follow the instructions in the MySQL documentation.

On this page:
- Step 1. Back up your existing Confluence data
- Step 2. Install MySQL Server
- Step 3. Configure MySQL Server
- Step 4. Set up your MySQL database and user
- Step 5. Install Confluence
- Step 6. Download and install the MySQL database driver if necessary
- Step 7. Check settings for internationalisation
- Step 8. Set up your database connection in Confluence
- Troubleshooting

Related pages:
- Configuring Database Character Encoding
- Database Setup Guide for Any Database
- Known Issues for MySQL
- Confluence Installation and Upgrade Guide

**Step 3. Configure MySQL Server**

In this step, you will configure your MySQL database server.

*Note: If you intend to connect Confluence to an existing MySQL database server, we strongly recommend that you reconfigure this database server by running through the configuration steps in the MySQL installation wizard as described below.*

To configure MySQL Server:

1. Run the MySQL installation wizard:
   a. If you are connecting Confluence to your existing MySQL server, choose **Reconfigure Instance**.
   b. Choose **Advanced Configuration**.
   c. Choose the **type of MySQL Server** that best suits your hardware requirements. This will affect the MySQL Server's usage of memory, disk and CPU resources. Refer to the MySQL documentation for further information.
   d. Choose **Transactional Database Only** to ensure that your MySQL database will use **InnoDB** as its default storage engine. *It is highly recommended that you only use the InnoDB storage engine with Confluence. Avoid using the MyISAM storage engine as this can lead to data corruption.*
   e. Set the **InnoDB Tablespace** settings to your requirements. (The default settings are acceptable.)
   f. Set the approximate **number of concurrent connections** permitted to suit your Confluence usage requirements. You can use one of the presets or enter a number manually. Refer to the MySQL documentation for further information.
   g. For the **networking options**, ensure the **Enable TCP/IP Networking** and **Enable Strict Mode** options are selected (default). Refer to the MySQL documentation on setting the networking and server SQL modes for further information.
   h. For the MySQL server's **default character set**, choose **Best Support For Multilingualism** (in other words, UTF-8). This will ensure Confluence's support for internationalisation. For more information, see Configuring Database Character Encoding.
1. For the Windows configuration option, choose whether or not to install the MySQL Server as a Windows service. If your hardware is going to be used as a dedicated MySQL Server, you may wish to choose the options to Install As Windows Service (and Launch the MySQL Server automatically). Refer to the MySQL documentation for further information.

   **Note:** If you choose not to install the MySQL Server as a Windows Service, you will need to ensure that the database service has been started before running Confluence.

   i. Select **Modify Security Settings** to enter and set your MySQL Server (root) access password.

2. Edit the `my.cnf` file (often named `my.ini` on Windows operating systems) in your MySQL server. Locate the `[mysqld]` section in the file, and add or modify the following parameters:

   a. Specify the default character set to be UTF-8:

   ```
   [mysqld]
   character-set-server=utf8
   collation-server=utf8_bin
   ...
   ```

   b. Set the default storage engine to InnoDB:

   ```
   [mysqld]
   default-storage-engine=INNODB
   ...
   ```

   c. Specify the value of `max_allowed_packet` to be at least 32M:

   ```
   [mysqld]
   max_allowed_packet=32M
   ...
   ```

   (Refer to MySQL Option Files for detailed instructions on editing `my.cnf` and `my.ini`.)

   ```
   MySQL 4.1.3 and above
   [mysqld]
   ...
   character-set-server=utf8
   collation-server=utf8_bin
   ...
   MySQL 4.1.2 and below
   [mysqld]
   ...
   default-character-set=utf8
   default-collation=utf8_bin
   ...
   ```

3. Restart your MySQL server for the changes to take effect:

   a. On Windows, use the Windows Services manager to restart the service.

   b. On Linux:

   ```
   - Run one of the following commands, depending on your setup: `/etc/init.d/mysqld stop` or `/etc/init.d/mysql stop` or `service mysqld stop`.
   - Then run the same command again, replacing 'stop' with 'start'.
   ```

   c. On Mac OS X, run `sudo /Library/StartupItems/MySQLCOM/MySQLCOM restart`.

**Step 4. Set up your MySQL database and user**

In this step you will create a database within MySQL to hold your Confluence data, and a database user with authority to access that database.

**To create the database and user privileges:**

1. Run the `mysql` command as a MySQL super user. The default user is ‘root’ with a blank password.

2. Create an empty Confluence database schema by running this command:
CREATE DATABASE confluence;

3. Create the Confluence database user by running this command. Replace 'confluenceuser' and 'confluencepass' with a username and password of your choice. If Confluence is not running on the same server as your MySQL database server, replace 'localhost' with the hostname or IP address of the Confluence server:

   GRANT ALL PRIVILEGES ON confluence.* TO 'confluenceuser'@'localhost'
   IDENTIFIED BY 'confluencepass';

**Step 5. Install Confluence**

Install Confluence if you have not done so already. See the Confluence Installation Guide. Stop immediately after the installation, before opening the Confluence Setup Wizard in your browser, and follow the steps below.

If you have already got part-way through the Confluence Setup Wizard, stop at the database setup step and follow the steps below. You will be able to restart the setup wizard at the same step later.

**Step 6. Download and install the MySQL database driver if necessary**

If you are using a direct JDBC connection, you do not need to download or install any JDBC drivers. The JDBC drivers for this database are bundled with Confluence.

If you plan to set up a datasource connection to MySQL, follow the steps described in Configuring a MySQL Datasource in Apache Tomcat.

**Step 7. Check settings for internationalisation**

If you are using an existing database, use the status command to verify database character encoding information. The results should be UTF-8. See Configuring Database Character Encoding.

**Step 8. Set up your database connection in Confluence**

To set up your Confluence MySQL database connection or to switch to using MySQL as your external database:

   1. (If your Confluence installation does not yet have any database, you can skip this step.) If you have already set up Confluence with the built-in (HSQLDB) database, you must change your Confluence home (data) directory.
      a. Ensure that Confluence is stopped. (Make sure that the application server or service which is running Confluence has been stopped or terminated.)
      b. Edit the properties file at `<Confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties` and change the `confluence.home` property to point to a new folder. For example, if your properties file has this entry:

   confluence.home=c:/confluencedata

   You could change it to this:

   confluence.home=c:/confluencedata_mysql
This is your new Confluence home (data) directory. (The name does not have to end in _mysql – that is just an example.)

c. Start Confluence again.

2. If you have just installed Confluence and have not yet run the Confluence Setup Wizard, or you are in the middle of the Confluence Setup Wizard: Start Confluence, and go to the Confluence Setup Wizard in your browser. Follow these steps to set up the new configuration:

   a. Follow the initial steps in the Confluence Setup Guide, until you reach the database setup steps.
   b. When prompted to choose an embedded or external database, select MySQL from the dropdown list and choose External Database.
   c. Choose either the direct JDBC or the datasource connection, to suit the choice you made earlier when setting up the MySQL database driver.
      - For the JDBC connection: Enter confluenceuser as the username, and the password you chose earlier.
      - For a datasource connection: Set the JNDI name to java:comp/env/jdbc/confluence.
   d. If you previously backed up your Confluence data, you can choose to restore it at the 'Load Content' page in the Confluence Setup Wizard. Otherwise, choose either the example or empty site as you wish.

**Troubleshooting**

- If you get the following error message, verify that you have given the confluenceuser user all the required database permissions when connecting from localhost.

```
Could not successfully test your database: : Server connection failure during transaction. Due to underlying exception: 'java.sql.SQLException: Access denied for user 'confluenceuser'@'localhost' (using password: YES)'
```

- The following page contains common issues encountered when setting up your MySQL database to work with Confluence: [Known Issues for MySQL](#)

- If Confluence complains that it is missing a class file, you may have forgotten to place the JDBC driver in the /confluence/WEB-INF/lib folder, or you may possibly have placed it in the wrong folder.
- If none of the above describes your issue, please create a support ticket at [http://support.atlassian.com](http://support.atlassian.com) and be sure to include your logs (found in `<confluence-installation>/logs` and `<confluence-home>/logs`).

### Configuring a MySQL Datasource in Apache Tomcat

This page tells you how to set up a MySQL datasource connection for Confluence.

**Step 1. Shut down Tomcat**

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
2. Make a backup of your `<CONFLUENCE_HOME>/confluence.cfg.xml` file and your `<CONFLUENCE_INSTALLATION>/conf/server.xml` file, so that you can easily revert if you have a problem.

**Step 2. Install the MySQL database driver**

1. Download the MySQL JDBC driver. Links are available on this page: [Database JDBC Drivers](#).
2. Unpack the archive file you have downloaded, and find the JAR file called something like this: `mysql-connector-java-x.x.x-bin.jar`, where `x.x.x` is a version number.
3. Copy the JAR file into the `lib` folder of your Tomcat installation: `<TOMCAT-INSTALLATION>/lib`.  

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Step 3. Configure Tomcat

1. If you are using the Confluence distribution, edit the `conf/server.xml` file in your Tomcat installation. If you are running your own Tomcat instance, edit the XML file where you declared the Confluence Context descriptor.

2. If editing `conf/server.xml`, find the following lines:

   ```xml
   <Context path="" docBase="../confluence" debug="0" reloadable="true">
   <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   </Context>
   
   Within the `<Context>` tags, directly after the opening `<Context.../>` line, insert the `DataSource` Resource tag:

   ```xml
   <Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
     username="yourusername" password="yourpassword"
     driverClassName="com.mysql.jdbc.Driver"
     url="jdbc:mysql://localhost:3306/confluence?useUnicode=true&characterEncoding=utf8"
     maxActive="15"
     maxIdle="7"
     defaultTransactionIsolation="READ_COMMITTED"
     validationQuery="Select 1" />
   ```

   - Replace the `username` and `password` parameters with the correct values for your database.
   - In the `url` parameter, replace the word 'confluence' with the name of the database your Confluence data will be stored in.
   - If you plan to use non-Latin characters, add "&useUnicode=true&characterEncoding=utf8" on the end of the above URL.

Notes

- If switching from a direct JDBC connection to a datasource connection, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.

- Why is the `validationQuery` element needed? When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires an application server reboot. However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat
application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the validationQuery option on the database connection pool.

- The configuration properties for Tomcat's standard datasource resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:
  - driverClassName – Fully qualified Java class name of the JDBC driver to be used.
  - maxActive – The maximum number of active instances that can be allocated from this pool at the same time.
  - maxIdle – The maximum number of connections that can sit idle in this pool at the same time.
  - maxWait – The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
  - password – Database password to be passed to your JDBC driver.
  - url – Connection URL to be passed to your JDBC driver. (For backwards compatibility, the property driverName is also recognised.)
  - user – Database username to be passed to your JDBC driver.
  - validationQuery – SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query must be an SQL SELECT statement that returns at least one row.

Step 4. Configure the Confluence web application

1. Edit this file in your Confluence installation: <CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml.
2. Insert the following element just before </web-app> near the end of the file:

```xml
<resource-ref>
  <description>Connection Pool</description>
  <res-ref-name>jdbc/confluence</res-ref-name>
  <res-type>javax.sql.DataSource</res-type>
  <res-auth>Container</res-auth>
</resource-ref>
```

If you are changing an existing Confluence installation over to using a Tomcat datasource:

1. Edit the <CONFLUENCE_HOME>/confluence.cfg.xml file.
2. Delete any line that contains a property that begins with hibernate.
3. Insert the following at the start of the <properties> section.

```xml
<property name="hibernate.setup"><![CDATA[true]]></property>
<property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.MySQLDialect]]></property>
<property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
```

Step 5. Restart Tomcat

Run bin/startup.sh or bin/startup.bat to start Tomcat with the new settings.

Database Setup for PostgreSQL

This document provides instructions for setting up Confluence for use with a PostgreSQL database. Please check the Known Issues for PostgreSQL before you start.
On this page:

- 1. Install PostgreSQL
- 2. Create a User and a Database
- 3. Configure Confluence to use the PostgreSQL Database
- Troubleshooting

1. Install PostgreSQL

To install PostgreSQL,

1. Download the database software and installer from the PostgreSQL download site and save it to your desktop. Choose the package that matches your operating system. Where available, choose the One Click Installer. These instructions assume you will use the One Click Installer. For example:
   - PostgreSQL One Click Installer for Windows.
   - PostgreSQL One Click Installer for Linux.
   - PostgreSQL One Click Installer for Mac OS X.
2. Run the installer. Please note the following information when installing PostgreSQL:
   - The password that you are prompted to provide during the installation process is for the 'postgres' account, which is the db root level account.
   - The default port for PostgreSQL is 5432. If you decide to change the default port, please ensure that your new port number does not conflict with any services running on that port. You will also need to remember to update all further mentions of db port.
   - Choose the locale that best fits your geographic location, when prompted to enter a locale.
   - Do not launch Stack Builder at the completion of the installer.
3. PostgreSQL is now installed on your machine.

2. Create a User and a Database

All screenshots below are taken from a PostgreSQL configuration on a Windows machine.

To create a PostgreSQL user and database,
1. Start the 'pgAdmin III' administration tool on your machine. The pgAdmin III administration console will display. The database user and database that will be used by Confluence are created via the 'pgAdmin III' tool.

2. Connect to the PostgreSQL server (e.g. double-click on the server name in the object browser). Enter a 'postgres' password when prompted.

3. Create a new user, i.e. login role (e.g. right-click 'Login Roles' in the object browser and select 'New Login Role...'):
   - Enter a name and password for the new user.
   - Do not select any role privileges.

4. Create a database (e.g. right-click 'Databases' and select 'New Database...'):
   - Enter a name for the new database.
   - Set the owner of the database to the user you created in the previous step.
   - Select 'UTF8' for 'Encoding'.
1. **Configure Confluence to use the PostgreSQL Database**

Once you have installed and set up PostgreSQL, you will need to configure Confluence to use the PostgreSQL database.

To configure Confluence to use PostgreSQL,

1. Install Confluence, if you haven't done so already. Ensure that you download the Confluence distribution, not the evaluation installer.
2. Ensure that Confluence is stopped (for example, by ensuring that the application server or service which is running Confluence has been stopped or terminated).

### Creating a User and Database via Linux command-line

If you are on Linux and do not have the above pgAdmin III administration tool, you can use the command line interface instead. Assuming that you are using the default installation directory of `/opt/PostgreSQL/8.3/bin/`, enter the following commands:

```
sudo -s -H -u postgres
# Create the Confluence user:
/opt/PostgreSQL/8.3/bin/createuser -S -d -r -P -E confuser
# Create the Confluence database:
/opt/PostgreSQL/8.3/bin/createdb -O confuser confluence
exit
```
3. Install the database drivers, if needed:

**PostgreSQL JDBC Drivers bundled with Confluence**
The JDBC drivers for this database are bundled with Confluence.
- If you are using a direct JDBC connection, you do not need to download or install any JDBC drivers.
- If you are connecting via a datasource, you must download and install the drivers manually. For information about driver versions and download links, see Database JDBC Drivers.
- If you are not sure which connection you are using, it is probably JDBC. A JNDI resource must be configured manually, as described in each database's docs: PostgreSQL, MySQL, SQL Server or Oracle

*Note: Confluence only bundles the JDBC 3 driver which will work under the 1.6 JVM. However, if you are using Java 6 and want to use the JDBC 4 driver, you can download it via Database JDBC Drivers and install it as described below. You will need to remove the existing PostgreSQL JDBC 3 driver (e.g. postgresql-8.4-701.jdbc3), if you do want to use the JDBC 4 driver.*

- If you are configuring a datasource to connect to your PostgreSQL database, you will need to place the jar file in `<confluence install>/WEB-INF/lib` (for Confluence 2.10 onwards) or `<confluence install>/common/lib` (for earlier versions). Information and links to the appropriate database drivers are available on Database JDBC Drivers.

  Windows renames `.jar` extensions to `.zip`. Just rename it back to `.jar`. You’ll have to set your folder options to view hidden file extensions if you can’t rename it without changing the file type (Tools >> Folder Options >> View >> Uncheck “Hide Extensions for known file types.”)

4. Start Confluence and after entering your license code on the 'Confluence Setup Wizard' page, click 'Custom Installation'. The 'Choose a Database Configuration' page will display.
5. Select 'PostgreSQL' and click 'External Database'. The 'Configure Database' page will display.
6. Choose your desired database connection method (please note that if you choose to connect via datasource, you will need to install the appropriate database drivers as described in the previous step).
7. Enter your PostgreSQL database setup details (as defined in the previous step above):

   **Connecting to an SSL Database**
   Simply add `ssl=true` parameter in the Database URL, for example:

   ```
   jdbc:postgresql://localhost:5432/confluence?ssl=true
   ```

   ! If the server that is hosting the PostgreSQL database is not the same server as Confluence, then please...
Troubleshooting

- **Known Issues for PostgreSQL** contains common issues encountered when setting up your PostgreSQL database to work with Confluence.
- If you are unable to connect to the database from Confluence and they are on different machines, most likely you have a firewall in between the two machines or your pg_hba.conf file is misconfigured. Verify that your firewall is set to allow connections through 5432 or double check your hba configuration.
- If Confluence is complaining that it's missing a class file, you might have forgotten to place the jdbc driver in the WEB-INF/lib folder or possibly have placed it in the wrong folder.
- If none of the above describes your issue, please create a support ticket at [http://support.atlassian.com](http://support.atlassian.com) and be sure to include your logs (found in confluence-install/logs and confluence-data/logs).

Configuring a PostgreSQL Datasource in Apache Tomcat

This page contains instructions on how to set up a PostgreSQL datasource connection for Confluence or Confluence EAR/WAR.

**On this page:**

- 1. Install the Driver
- 2. Shut down Tomcat
- 3. Configure Tomcat
- 4. Configure the Confluence web application
- 5. Configure Confluence

1. **Install the Driver**

2. Copy this file into the common/lib directory of your Tomcat installation. Be aware that this directory may be just lib for Tomcat version 6 and beyond (i.e. `<tomcat-install>/lib` rather than `<tomcat-install>/common/lib`).

   **If you are using Confluence 3.2.0 or later you can get the driver from `/confluence/WEB-INF/lib/postgresql-8.4-701.jdbc3.jar` and move it into the common/lib directory of your Tomcat installation.**

2. **Shut down Tomcat**

1. Run `bin/shutdown.sh` or `bin/shutdown.bat` to bring Tomcat down while you are making these changes.
3. Configure Tomcat

1. Firstly, you need to edit `<confluence install>/conf/server.xml` and find the following lines:

   ```xml
   <Context path="" docBase="../confluence" debug="0" reloadable="true">
     <!-- Logger is deprecated in Tomcat 5.5. Logging configuration for Confluence is specified in confluence/WEB-INF/classes/log4j.properties -->
   </Context>
   ```

   Within the Context tags, directly after the opening `<Context.../>` line, insert the DataSource Resource tag:

   ```xml
   <Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
     username="postgres"
     password="postgres"
     driverClassName="org.postgresql.Driver"
     url="jdbc:postgresql://localhost:5432/yourDatabaseName"
     maxActive="20"
     maxIdle="10"
     validationQuery="select 1" />
   ```

   - Replace the username and password parameters with the correct values for your database.
   - In the url parameter, replace the word 'yourDatabaseName' with the name of the database your confluence data will be stored in.

2. Why is the validationQuery element needed?

   When a database server reboots, or there is a network failure, all the connections in the connection pool are broken and this normally requires a Application Server reboot.

   However, the Commons DBCP (Database Connection Pool) which is used by the Tomcat application server can validate connections before issuing them by running a simple SQL query, and if a broken connection is detected, a new one is created to replace it. To do this, you will need to set the "validationQuery" option on the database connection pool.

   If switching from a direct JDBC connection to datasource, you can find the above details in your `<CONFLUENCE_HOME>/confluence.cfg.xml` file.

   The configuration properties for Tomcat's standard data source resource factory (org.apache.tomcat.dbcp.dbcp.BasicDataSourceFactory) are as follows:

   - `driverClassName` — Fully qualified Java class name of the JDBC driver to be used.
   - `maxActive` — The maximum number of active instances that can be allocated from this pool at the same time.
   - `maxIdle` — The maximum number of connections that can sit idle in this pool at the same time.
   - `maxWait` — The maximum number of milliseconds that the pool will wait (when there are no available connections) for a connection to be returned before throwing an exception.
   - `password` — Database password to be passed to our JDBC driver.
   - `url` — Connection URL to be passed to our JDBC driver. (For backwards compatibility, the property `driverName` is also recognized.)
   - `user` — Database username to be passed to our JDBC driver.
• validationQuery — SQL query that can be used by the pool to validate connections before they are returned to the application. If specified, this query MUST be an SQL SELECT statement that returns at least one row.

4. Configure the Confluence web application

1. Edit /confluence/WEB-INF/web.xml in your confluence installation
2. Go to the end of the file and just before </web-app>, insert the following:

```xml
<resource-ref>
    <description>Connection Pool</description>
    <res-ref-name>jdbc/confluence</res-ref-name>
    <res-type>javax.sql.Datasource</res-type>
    <res-auth>Container</res-auth>
</resource-ref>
```

5. Configure Confluence

• If you have not yet set up Confluence
  1. Follow the steps in the Confluence Setup Guide
  2. In the Database Setup section, choose the "Datasource Connection" option.
  3. Set the JNDI name to java:comp/env/jdbc/confluence
  4. Set the Database dialect to Postgres.

• If you are changing an existing Confluence installation over to using a Tomcat datasource
  1. Edit the <confluence home>/confluence.cfg.xml file
  2. Delete any line that contains a property that begins with hibernate.
  3. Insert the following at the start of the <properties> section.

```xml
<property name="hibernate.setup"><![CDATA[true]]></property>
<property name="hibernate.dialect"><![CDATA[net.sf.hibernate.dialect.PostgreSQLDialect]]></property>
<property name="hibernate.connection.datasource"><![CDATA[java:comp/env/jdbc/confluence]]></property>
```

4. Restart Confluence.

RELATED TOPICS

Configuring a MySQL Datasource in Apache Tomcat

The Embedded HSQLDB Database

The Confluence installation includes an embedded HSQLDB database, supplied for the purpose of evaluating Confluence.

If you are using the embedded database, the database files are stored in the database folder under your Confluence Home directory. See also Important Directories and Files.

⚠️ Embedded Database is Not Suitable for Production Instances of Confluence

Production instances of Confluence should use an external database. When using the default HSQLDB database, you run the risk of unrecoverable data loss due to not being transaction safe.

• Corruption is occasionally encountered after sudden power loss and can usually be corrected using this data recovery procedure.
This document outlines how to migrate your data from your existing database to another database. It is designed for migrating from an evaluation to a production database. Large data sets will require third party database migration tools. You should use this page when moving from the embedded database to an external database. Provided your dataset is not large, you may use this method to move from one type of external database to another – for example, from Oracle to PostgreSQL.

Note: If you are simply moving your database from one server to another you can just change the JDBC URL in <confluence.home>/confluence.cfg.xml (if you are using a direct JDBC connection) or in the definition of your datasource (if you are connecting via a datasource).

Limitations of database migration

Note: The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

Database migration

There are two ways you can perform the migration:

1. Method one is the standard procedure.
2. For large installations of Confluence: If the total size of attachments on your installation exceeds 500MB, use method two.

On this page:

- Method one – standard procedure
  - Step One: Backing up your data
  - Step Two: Configuring the Confluence Home Directory
  - Step Three: Setting up the new database
  - Step Four: Setting up Confluence with the new database

- Method two – for large installations
  - Step One: Backing up your data
  - Step Two: Configuring the Confluence Home Directory
  - Step Three: Moving your attachments
  - Step Four: Setting up new database
  - Step Five: Setting up Confluence with the new database

- A note about case sensitivity in your database
- Troubleshooting

Method one – standard procedure

Step One: Backing up your data

1. Note which plugins are currently installed/enabled, so that you can reinstate them later.
2. Create a backup of your existing data. This is done from the Administration Console. Instructions on how to create a backup can be found here.
4. If you are already using an external database, please make a backup of it using the utilities that were installed with it.

**Step Two: Configuring the Confluence Home Directory**

1. Create a new Confluence Home Directory. You can place this directory anywhere you like and give it a name of your choice.
2. Open WEB-INF/classes/confluence-init.properties file in your Confluence installation and change the confluence.home property to point to this new Confluence Home Directory.

**Step Three: Setting up the new database**

Perform the database setup instructions for your database.

**Step Four: Setting up Confluence with the new database**

If your databases are not already configured for Confluence, refer to Database Configuration to setup your database access.

1. Make sure that the JDBC drivers for your database are available to the application server. If you don’t already have the JDBC driver, please download one from here.
2. Make sure that your database is using a case-sensitive collation. Please refer to the section on case sensitivity below and see this issue for more details: CONF-7917.
3. If you are running the Confluence distribution, copy your JDBC database driver (a .jar file), into the $conf<confluence-install>/lib folder.
4. Start up Confluence. You will see the Confluence Setup Wizard.
5. Select ‘Custom Install’.
6. Select your database from the drop down list.
7. Select ‘Direct JDBC’ and then enter the details of the new database you want to migrate to. 
   Read the documentation on the Setup Wizard for more detailed explanation.
8. When prompted, restore the contents of the backup you made in Step One into the new Confluence site

Your old Confluence data will now be imported to your new database.

**Method two – for large installations**

**Step One: Backing up your data**

1. Before proceeding with these instructions please check that:
   - you are upgrading from at least Confluence version 2.2 and
   - your attachments are stored in the file system, and not in your database. (To migrate between attachment storage systems, please see Attachment Storage Configuration)
   
   These instructions will not work if either of the above is not true.
2. From Confluence, go to Administration -> Backup & Restore and create a manual backup that excludes attachments.
3. Shut down and back up the Confluence Home Directory.
4. If you are already using an external database, please make a backup of it using the utilities that were installed with it.

**Step Two: Configuring the Confluence Home Directory**

1. Create a new Confluence Home Directory. You can place this directory anywhere you like and give it a name of your choice.
2. Open WEB-INF/classes/confluence-init.properties file in your Confluence installation and change the confluence.home property to point to this new Confluence Home Directory.

**Step Three: Moving your attachments**
Move the contents of your attachments directory from your old Confluence Home to your new Confluence Home.

Step Four: Setting up new database

Perform the database setup instructions for your database.

Step Five: Setting up Confluence with the new database

If your databases are not already configured for Confluence, refer to Database Configuration to setup your database access.

1. Make sure that the JDBC drivers for your database are available to the application server. If you don't already have the JDBC driver, please download one from here.
2. Make sure that your database is using a case-sensitive collation. Please refer to the section on case sensitivity below and see this issue for more details: CONF-7917.
3. If you are running the Confluence distribution, copy your JDBC database driver (a .jar file), into the `<confluence-install>/lib` folder.
4. Start up Confluence. You will see the Confluence Setup Wizard.
5. Select 'Custom Install'.
6. Select your database from the drop down list.
7. Select 'Direct JDBC' and then enter the details of the new database you want to migrate to.
   
   Read the documentation on the Confluence Setup Wizard for more detailed explanation.
8. When prompted, restore the contents of the backup you made in Step One into the new Confluence site.

A note about case sensitivity in your database

'Collation' refers to a set of rules that determine how data is sorted and compared. Case sensitivity is one aspect of collation. Other aspects include sensitivity to kana (Japanese script) and to width (single versus double byte characters).

Case sensitive or case insensitive collation – how should you create your Confluence database? What about when you are migrating your existing Confluence instance from one database to another?

Setting up a New Confluence Instance

For new Confluence instances, we recommend using case sensitive collation for your Confluence database. This is the default collation type used by many database systems.

Note: Even if the database is configured for case sensitive collation, Confluence reduces all usernames to lower case characters before storing them in the database. For example, this means that 'joebloggs', 'joeBloggs' and 'JoeBloggs' will be treated as the same username.

Migrating an Existing Confluence Instance to a Different Database

The default Confluence configuration uses case sensitive database collation. This is typical of databases created under default conditions. If you are migrating from this type of configuration to a new database, we recommend that the new database uses case sensitive collation. If you use case insensitive collation, you may encounter data integrity problems after migration (for example, via an XML import) if data stored within your original Confluence site required case sensitive distinctions.

Troubleshooting

If you are unable to restore your XML backup, consult our Troubleshooting Guide.

Database JDBC Drivers

This page provides the download links for the JDBC drivers for all databases currently supported for Confluence. You will need to make the driver available to your application server, as described in the appropriate setup guide.

Note: We bundle a number of JDBC drivers with Confluence, as shown below. If you are using a direct JDBC
connection, you do not need to download or install the drivers that are bundled. If you are connecting via a datasource, you will still need to download and install the drivers manually.

**Related pages:**
- Database Configuration
- Supported Platforms
- Confluence Administrator's Guide

<table>
<thead>
<tr>
<th>Database</th>
<th>JDBC driver bundled with Confluence?</th>
<th>JDBC drivers</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL</td>
<td>![Icon]</td>
<td>8.4-701.jdbc3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The JDBC 3 driver will work under the 1.6 JVM. If you want to use the JDBC 4 driver, you can download it from the PostgreSQL website. However, we recommend that you use the bundled JDBC 3 driver.</td>
</tr>
<tr>
<td>MySQL</td>
<td>![Icon]</td>
<td>5.1.11</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>![Icon]</td>
<td>jTDS 1.2.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The above version is the version bundled with Confluence. All our testing is done on that version. We do not know of any issues with later versions, so you are free to use them if you have tested them and find there are no issues in your environment. However, later versions are technically not supported. That means that if you do run into any problems, Atlassian Support may require you to move back to the above fully-tested version for troubleshooting.</td>
</tr>
<tr>
<td>Oracle</td>
<td>![Icon]</td>
<td>JDBC driver downloads – see Database Setup for Oracle for required JDBC driver versions.</td>
</tr>
<tr>
<td>DB2</td>
<td>![Icon]</td>
<td>JDBC drivers should be included with DB2, otherwise they can be downloaded from the IBM website.</td>
</tr>
</tbody>
</table>

**Configuring Database Character Encoding**

The database used with Confluence should be configured to use the same character encoding as Confluence. The recommended encoding is Unicode UTF-8 (the equivalent for Oracle databases is AL32UTF8).

There are two places where character encoding may need to be configured:

- when creating the database
- when connecting to the database (JDBC connection URL or properties).

The configuration details for each type of database are different. Some examples are below.
On this page:

- JDBC connection settings
- Creating a UTF-8 database
- Updating existing database to UTF-8

⚠️ The information on this page does not apply to Confluence OnDemand.

**JDBC connection settings**

**MySQL**

Append "useUnicode=true to your JDBC URL:

```
jdbc:mysql://hostname:port/database?useUnicode=true&characterEncoding=utf8
```

**Creating a UTF-8 database**

**MySQL**

1. Create a UTF-8 database with binary UTF-8 collation.
   - Binary UTF-8 provides case-sensitive collation.

   ```
   CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;
   ```

2. You will also need to set the Server Character set to utf8. This can be done by adding the following in my.ini for Windows or my.cnf for other OS. It has to be declared in the Server section, which is the section after [mysqld]:

   ```ini
   [mysqld]
default-character-set=utf8
   ```

   If the above option does not work, try using `character_set_server=utf8` in lieu of `default-character-set=utf8`

3. Use the `status` command to verify database character encoding information.
4. In some cases, the individual tables collation and character encoding may differ from the one that the database as a whole has been configured to use. Please use the command below to ensure all tables within your Confluence database are correctly configured to use UTF-8 character encoding and binary UTF-8 collation:

```
use confluence;
show table status;
```

Check for the value listed under the **Collation** column, to ensure it has been set to `utf8_bin` (that is, case-sensitive) collation for all tables.

If not, then this can be changed by the following command, executed for each table in the Confluence database:

```
ALTER TABLE tablename CONVERT TO CHARACTER SET utf8 COLLATE utf8_bin;
```

Please substitute the `<tablename>` above, with each table within the confluence database.

Relevant MySQL manual for more detailed explanation:

- [Specifying Character Sets and Collations documentation](#).
- [Connection Character Sets and Collations](#).
- [SHOW TABLE STATUS Syntax](#).
- [ALTER TABLE Syntax](#).

**PostgreSQL**

```
CREATE DATABASE confluence WITH ENCODING 'UNICODE';
```
Or from the command-line:

```
$ createdb -E UNICODE confluence
```

For more information see the PostgreSQL documentation.

**For PostgreSQL running under Windows**

Please note that international characters sets are only fully supported and functional when using PostgreSQL 8.1 and above under Microsoft Windows.

**For PostgreSQL running under Linux**

Please make sure you check the following to ensure proper handling of international characters in your database.

When PostgreSQL creates an initial database cluster, it sets certain important configuration options based on the host enviroment. The command responsible for creating the PostgreSQL environment `initdb` will check environment variables such as `LC_CTYPE` and `LC_COLLATE` (or the more general `LC_ALL`) for settings to use as database defaults related to international string handling. As such it is important to make sure that your PostgreSQL environment is configured correctly **before you install Confluence**.

To do this, connect to your PostgreSQL instance using `pgsql` and issue the following command:

```
SHOW LC_CTYPE;
```

If `LC_CTYPE` is set to either "C" or "POSIX" then certain string functions such as converting to and from upper and lower case will not work correctly with international characters. Correct settings for this value take the form `<LOCALE>.<ENCODING>` (for example).

If your `LC_CTYPE` is incorrect please check the PostgreSQL documentation for information on configuring database localisation. It is not easy to change these settings with a database that already contains data.

**Updating existing database to UTF-8**

**MySQL database with existing data**

**For an existing database**

If you're using a existing database, confirm the Character Encoding by executing the query:

```
SHOW VARIABLES LIKE 'character%';
SHOW VARIABLES LIKE 'collation%';
```

The results should be UTF-8.

Before proceeding with the following changes, please **backup your database**.

This example shows how to change your database from latin1 to utf8.

1. Dump the database to a text file using `mysqldump` tool from the command-line:

   ```
   mysqldump -p --default-character-set=latin1 -u <username> --skip-set-charset confluence > confluence_database.sql
   ```

2. Copy `confluence_database.sql` to `confluence_utf8.sql`

3. Open `confluence_utf8.sql` in a text editor and change all character sets from 'latin1' to 'utf8'

4. Encode all the latin1 characters as UTF-8:
recode latin1..utf8 confluence_utf8.sql (the recode utility is described at http://directory.fsf.org/recode.html; it can actually be downloaded from http://recode.progiciels-bpi.ca/, and is available for Ubuntu via apt-get)

In MySQL:

1. DROP DATABASE confluence;
2. CREATE DATABASE confluence CHARACTER SET utf8 COLLATE utf8_bin;

Finally, reimport the UTF-8 text file:

1. mysql -u <username> -p --default-character-set=utf8 --max_allowed_packet=64M confluence < /home/confluence/confluence_utf8.sql

To support large imports, the parameter `--max_allowed_packet=64M` used above sets the maximum size of an SQL statement to be very large. In some circumstances, you may need to increase it further, especially if attachments are stored in the database.

Testing database encoding

See Troubleshooting Character Encodings for a number of tests you can run to ensure your database encoding is correct.

RELATED TOPICS:

Configuring Character Encoding
Known Issues for MySQL
Configuring database query timeout

If database queries are taking too long to perform, and your application is becoming unresponsive, you can configure a timeout for database queries. There is no default timeout in Confluence.

To configure a database query timeout, do the following on your test server:

1. Shut down Confluence.
2. Extract databaseSubsystemContext.xml from the confluence-x.x.x.jar that is in confluence/WEB-INF/lib/, and put a copy in confluence/WEB-INF/classes/.
3. Edit confluence/WEB-INF/classes/databaseSubsystemContext.xml to add the defaultTimeout property to the "transactionManager" bean:

```xml
<bean id="transactionManager"
     class="org.springframework.orm.hibernate.HibernateTransactionManager">
  <property name="sessionFactory">
    <ref bean="sessionFactory"/>
  </property>
  <property name="defaultTimeout" value="120"/>
</bean>
```

The timeout is measured in seconds and will forcibly abort queries that take longer than this. In some cases, these errors are not handled gracefully by Confluence and will result in the user seeing the Confluence error page.

4. Start Confluence.

Once the timeout is working properly in your test environment, migration the configuration change to Confluence.

⚠️ You will need to reapply these changes when upgrading Confluence, as the original databaseSubsystemCon
Creating Database Schema Manually

**Database Schema Creation**

This document provides information on how to find the SQL for database table creation.

Often, DBAs will require that table creation be done manually. To find the required SQL statements, you can use the script generated from our evaluation version's HSQLDB database.

- Install Confluence with no external database.
- Shut down Confluence.
- Find the file located in `<confluence-home>/database/confluencedb.script`.

The `confluence-home` directory is not your installation directory, its the directory specified in `confluence-init.properties`. For more information, see [Confluence Home Directory](#) and [Confluence Installation Directory](#).

To see some example SQL statements, click 'Tools' and select 'Attachments' on this wiki page.

To get Confluence to run against this established schema, configure the database with the normal procedure, then modify the hibernate.connection.url, username and password from `confluence-home/confluence.cf` or `server.xml`, depending on whether it's a direct jdbc or resoruce connection. This is described in [Migrating Confluence Between Servers](#).

**RELATED TOPICS**

- **Database Configuration**
- **Troubleshooting the Embedded Database (HSQL DB)**

**java.sql.SQLException: User not found: SA**


HSQLDB periodically must update its files to represent changes made in the database. In doing so, it must delete the current confluencedb.data file on the filesystem (beneath conf.home/database) and replace it with a new one.

If an administrator issues a shutdown on Confluence in this period, data can be lost, and is typically noticed by the error message, when starting Confluence up again, of 'User not found: SA'.

Users encountering this problem should seek to restore backups, contained in the backup directory beneath `confluence.home`. If daily backups have been turned off, and no other copy of data remains, the data is lost.

**HSQldb should not be used as a production database. It is included for evaluation purposes only.**

**Hibernate logging**

It can be useful to enable detailed Hibernate logging when debugging problems with HSQL.

**Connecting to the Embedded Database**

Connecting to the Embedded HSQL Database can be quite difficult. You may need to connect to the database to retrieve information, or for troubleshooting purposes.

Please follow the instructions on how to you can connect to the embedded HSQL Database using the free Database Administration Tool DBVisualizer.

Connecting to HSQLDB using DBVisualizer

The purpose of this guide is to walk you through connecting to Confluence's embedded **Hypersonic SQL**
Database using the Database Administration tool DBVisualizer.

Below are step by step instructions on how to Configure DBVisualizer and connect it to HSQLDB.

**Prerequisites**

1. Download and install the latest copy of DBVisualizer.
2. You will also need to download a copy (preferably the latest version) of HSQLDB
3. Extract the contents of the HSQLDB archive
4. Ensure that Confluence is not running.

**Connection Procedure**

Please ensure that you read and follow the instructions below carefully.

⚠️ Remember to backup your <confluence-home>/database folder before attempting any modifications

1. Enter Connection Name

   1. Click on the icon highlighted in Red
   2. Enter an identifiable name for the connection. e.g. conf2.5.4-std

2. Select JDBC Driver

   You are currently using the DbVisualizer Free edition. Please visit the DbVisualizer website to learn more about the extended DbVisualizer Personal edition.
1. From the drop down list select **HSQldb Embedded**
2. Click on **Load Driver Files**
3. Browse to directory where the HSQLDB.jar file is located. Confluence bundles this and it can be found at:
   `<confluence-installation>/confluence/WEB-INF/lib/hsqldb-*.jar`

3. Select Database Path
   1. Browse to your `<Confluence-Home>` directory
   2. Open the **Database** folder
   3. Select the `confluencedb.properties` file
4. Enter Connection Details
1. Remove the ".properties" from the end of confluencedb
2. Type in sa for the username
3. Leave the password field blank

*refer to the example screenshot above if you are unsure*

5. Connect to embedded Database

1. Click on Test Connection to verify that the details are correct.
2. Click on "Finish" to complete the setup
3. Select the connection from the list on the left hand side.
4. You can now click on "Connect" to connect to the embedded database.

*HSQL database manager*

Alternatively, you can use HSQLDB's database manager. Just copy the value of hibernate.connection.ur
1. In `confluence.cfg.xml` as the URL and you're good to go.

**Related Topics**
- Universal SQL client Squirrel
- HSQL
- Enable Hibernate Logging
- Database Tables Reference
- Confluence data model

**Database Tables Reference**

Below is a diagram of the Table References in Confluence (2.5.4).

This may be useful for Database Administrators that need to manually create the Database tables.

![Database Tables Reference Diagram](image)

Right Click and Select *Save Link As* here to download this image.

**Troubleshooting External Database Connections**

A common administration issue when configuring Confluence is identifying database connectivity problems. This page tells you about a helper utility, in the form of a JSP page, that can help you to isolate database connectivity issues. It checks whether you can connect to a database with your application server. If your application server cannot connect to the database, Confluence will not be able to connect to the database either.

**Introduction to the Atlassian Database Check Utility**

You can use this utility to:

- Check that your application server can successfully query your database, either via immediate JDBC connectivity or a datasource in the context of your application server.
- Pinpoint problems in your configuration which may occur if the above is failing.

This is what the utility does:

- Check that a JDBC driver can be loaded into memory and view what is already loaded.
- Connect to a JDBC URL and do a 'select 1' from the database.
- Find a DataSource in the JNDI environment and do the above.
- View the System classpath (to ensure that the JDBC JAR file is there).

**Using the Utility**

*If you have already set up Confluence completely*

1. Download the attached `testdatabase.jsp` to your `<confluence-install>`\confluence directory.
2. Restart Confluence
4. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the <confluence-install>\lib directory (for Confluence version 2.10 onwards) or <confluence-install>\common\lib (for earlier versions). Here are some instructions.
5. Enter the DB settings Confluence is using and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.

If you cannot set up Confluence because of an error in 'Configuring Database'

1. Record the DB settings you are using for your direct JDBC or datasource connection in the 'Configure Database' step of your setup.
2. Download the attached testdatabase.jsp to your <confluence-install>\confluence directory.
3. Rename your <confluence-install>\confluence\WEB-INF\web.xml file to backup web.xml. This disables redirection.
4. Restart Confluence.
6. Check that your database driver is loaded into memory. If not, check the system classpath for the JDBC driver file, and that the driver is in the <confluence-install>\common\lib directory as described in these instructions.
7. Enter the DB settings you recorded and test the database. If an error appears, check that the db service is running, the location matches, and that any users specified actually exist with the right login and permissions. You may be able to find a workaround by Googling the error.
8. After correcting the error, rename <confluence-install>\confluence\WEB-INF\backup web.xml back to web.xml.

Notes
If you use this utility, please let us know ways in which we could improve it or leave helpful hints for others here.

For a comprehensive set of database instructions that might be helpful for troubleshooting, please refer to the following links:

- PostgreSQL
- MySQL

Requesting Technical Support
If you are still stuck after attempting the suggestions above, lodge a free technical support request with information on your database setup.

Improving Database Performance

Diagnosis
Use native database tools to assess the impact of your database. If you’d like to check what Confluence is doing from it’s side, you can enable sql loggin. If you analyze thread dumps, as this is done in general Troubleshooting Confluence Hanging or Crashing guide, you may find the kinds of threads like this:
These threads are waiting for a database connection. It could be that the database is not performing optimally, or it may just need tuning for allowing more connection threads. Both are discussed below.

Upgrade your Database and Drivers

SQL Server 2000, Oracle 9i, and MySQL with 3.1 drivers are among some of the issues with database performance. Ensure you are using updated versions of databases and their drivers.

Upgrade your hardware

Atlassian does not offer specific recommendations on hardware for database performance. Use good judgment and native OS and database tools for your assessment.

Ensure you have the Latest Database Indices

Confluence has improved database performance over time. You'll want to make sure you have all the latest, if you're getting hung threads waiting for db connections.

Confluence 2.10 or Manual .ddl Indices

With 2.10 and later, Confluence includes database indices bundled. Confluence 2.10 automatically creates the necessary database indexes when you upgrade. If you are not on 2.10, you may have run the ddl manually during the upgrade process. To check, you can look against these.

Additional Indices not Included in 2.10

- One import db index is the lower case page title index. Prior to Confluence 3.0, querying for a page by title and space key can take a long time due to table scans necessary on a lowercase where clause. On most databases it is possible to add a lowercase index on these columns that helps with performance. See Creating a Lowercase Page Title Index for instructions on how to do this. Prior to 2.10, apply lowercase title indexes (all Confluence versions).
- The compound database index for the ATTACHMENTDATA table is described in CONF-13819.
- A composite index on some of the columns in SpacePermissions table is described in CONF-14488.

Tuning the Database Connection Pool

This is described in the knowledge base article Confluence Slows and Times out During Periods of High Load due to DB Connection Pool.

Configure a Database Query Timeout

If a database is getting overloaded, you can prevent it from crashing Confluence by Configuring a Database Query Timeout.

Related Articles
Troubleshooting Database Issues.
Creating a Lowercase Page Title Index

Diagnosis

Confluence sometimes has performance problems retrieving pages by title because the query uses the `lower()` function. For example, the query looks something like this:

```
select * from CONTENT where lower(TITLE) = :title and SPACEID = :spaceid
```

Database profiling might show a query like the following taking a long time to execute (emphasis added):

```
select ... from CONTENT page0__, SPACES space1__
where page0__.CONTENTTYPE='PAGE'
and ((lower(space1__.SPACEKEY)= @P0 and page0__.SPACEID=space1__.SPACEID)
and(lower(page0__.TITLE)= @P1 )
and(page0__.PREVVER is null )and(page0__.CONTENT_STATUS='current' ))
```

Typically, databases don't use indexes when you use a function in a where clause; they do a table scan instead. This makes the performance of this query not ideal (CONF-11577).

Generic solution

On many databases (e.g. Oracle, PostgreSQL, DB2 for z/OS), it is possible to create the index using the normal "create index" syntax, just using the function instead of the column name.

```
create index CONFTITLE_LOWER on CONTENT(lower(TITLE));
```

Sources:

- [http://www.postgresql.org/docs/current/static/sql-createindex.html](http://www.postgresql.org/docs/current/static/sql-createindex.html)
- [http://asktom.oracle.com/tkyte/article1/](http://asktom.oracle.com/tkyte/article1/)

SQL Server

On SQL Server, you can add a computed column to the database table and then add an index on this column.

```
alter table CONTENT add TITLE_LOWER as lower(TITLE);
create index CONFTITLE_LOWER on CONTENT(TITLE_LOWER);
```

Sources:


MySQL

It is not currently possible to create a lowercase index on MySQL. Confluence 3.0 includes some caching improvements which should alleviate this performance problem on this database.

Source:

Workaround for MySQL databases, using a case-insensitive collation:

Please check whether your MySQL database has been set to use case-sensitive or case-insensitive collation. The queries to check whether your database is set to case-insensitive collation are:

- `show full columns from content where field = 'title';`
- `show full columns from spaces where field = 'spacekey';`

If the `collation_name` is returned as `<encoding>_ci`, the `ci` indicates case-insensitive collation.

If the database has been set to use case-insensitive collation, you can try removing `lower` from the following queries, in your `ContentEntityObject.hbm.xml` file residing in your `<Confluence-Install>/confluence/web-INF/lib/confluence-2.x.x.jar/com/atlassian/confluence/core/`:

```xml
<query name="confluence.page_findLatestBySpaceKeyTitle"><![CDATA[
    from Page page
    where lower(page.space.key) = :spaceKey and
    lower(page.title) = :pageTitle and
    page.originalVersion is null and
    page.contentStatus = 'current'
]]></query>

<query name="confluence.page_findLatestBySpaceKeyTitleOptimisedForComments"><![CDATA[
    from Page page
    left join fetch page.comments as theComments
    left join fetch theComments.children
    where lower(page.space.key) = :spaceKey and
    lower(page.title) = :pageTitle and
    page.originalVersion is null and
    page.contentStatus = 'current'
]]></query>
```

DB2 for Linux or Windows

DB2 supports indexes on generated columns which are used for queries with a matching predicate. You can implement it like this:

```sql
ALTER TABLE CONTENT ADD COLUMN TITLE_LOWER GENERATED ALWAYS AS (LOWER(TITLE));
CREATE INDEX CONFTITLE_LOWER ON CONTENT(TITLE_LOWER)
```

Related pages

- Improving Database Performance
- CONF-10030: Queries that use 'lower' do not use index because of case sensitivity

Surviving Database Connection Closures

When a database server reboots or a network failure has occurred, all connections in the database connection pool are broken. To overcome this issue, Confluence would normally need restarting (or for Confluence WAR distributions, the application server running Confluence would need restarting).

However, database connections in the database connection pool can be validated by running a simple SQL query. If a broken database connection is detected in the pool, a new one is created to replace it.

To do this, you can specify an optional validation query for your database connection. Depending on whether you are using a direct JDBC URL, or a data source, this is configured differently.
Determining the validation query SQL for your database type

Different database types have slightly different SQL syntax requirements for their validation query. The validation query should be as simple as possible, as this is run every time a connection is retrieved from the pool.

The following validation queries are recommended for the following types of databases:

<table>
<thead>
<tr>
<th>Database Type</th>
<th>Validation Query</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL</td>
<td><code>select 1</code></td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td><code>select 1</code></td>
</tr>
<tr>
<td>Oracle</td>
<td><code>select 1 from dual</code></td>
</tr>
<tr>
<td>PostgreSQL</td>
<td><code>select 1</code></td>
</tr>
</tbody>
</table>

Enabling validation query using direct JDBC

To ensure Confluence validates database connections in the database connection pool:

1. Shut down Confluence
2. Edit the `confluence.cfg.xml` file at the root of your Confluence Home Directory
3. Add the property "hibernate.c3p0.validate" and set it to "true", and add the property "hibernate.c3p0.preferredTestQuery" and set it to the value of the query you determined above for your database type. See this excerpt of the file with the two added properties for details:

confluence.cfg.xml (excerpt)

```xml
...<property name="hibernate.c3p0.acquire_increment">1</property>
<property name="hibernate.c3p0.idle_test_period">100</property>
<property name="hibernate.c3p0.max_size">30</property>
<property name="hibernate.c3p0.max_statements">0</property>
<property name="hibernate.c3p0.min_size">0</property>
<property name="hibernate.c3p0.timeout">30</property>
<property name="hibernate.c3p0.validate">true</property>
<property name="hibernate.c3p0.preferredTestQuery">select 1</property>
...```
4. Save `confluence.cfg.xml`
5. Restart Confluence

Ensuring validation query using a data source

To ensure Confluence validates database connections in the database connection pool:

1. Shut down Confluence (or the Tomcat installation running Confluence).
2. Edit the `conf/server.xml` file in your Confluence Install Directory, or in the Tomcat installation’s CATALINA_HOME directory.
3. Find the Resource element for your data source, and add the "validationQuery" field, with the value of the query you determined above for your database type. See this excerpt of the file with this added for details:
server.xml (excerpt)

```xml
...<Resource name="jdbc/confluence" auth="Container" type="javax.sql.DataSource"
    username="postgres"
    password="postgres"
    driverClassName="org.postgresql.Driver"
    url="jdbc:postgresql://localhost:5432/yourDatabaseName"
    maxActive="20"
    maxIdle="10"
    validationQuery="select 1" />
...```

4. Save `conf/server.xml`

5. Restart Confluence (or the Tomcat installation running Confluence).

Results and Considerations

You should now be able to recover from a complete loss of all connections in the database connection pool without the need to restart Confluence or the application server running Confluence.

⚠️ **Performance Considerations:**

- Setting this option has a performance impact. The overall decrease in performance should be minimal, as the query itself is quick to run. In addition, the query will only execute when you make a connection. Thus, if the connection is kept for the duration of a request, the query will only occur once per request.
- If you are running a large Confluence installation, you may wish to assess the performance impact of this change before implementing it.

### Site Backup and Restore

⚠️ Atlassian suggests establishing a backup strategy using a native database tool for a production instance of Confluence.

By default, Confluence backs up all data and attachments once a day to a backup file. These files are called XML site backups, and are stored in the `backups` directory of Confluence home. You can also create XML site backups manually. This mechanism is intended for small to medium-sized deployments of Confluence. It is not intended for use with large deployments with lots of pages and attachments (see below).

- Restore your site from an XML site backup
- Manually create an XML site backup
- Configuring Backups
- User Submitted Backup & Restore Scripts

XML site backups are fine for most small to medium-sized instances of Confluence, containing a few thousand pages and attachments. However, large instances of Confluence may find that backups become slow to create and use large amounts of disk space.

⚠️ **The information on this page does not apply to Confluence OnDemand.**

### Backups For Large Instances

XML site backups are unsuitable for instances of Confluence that contain thousands of pages, as XML backups take progressively longer to complete as the amount of text increases. Another issue with XML site backups is
that Confluence instances with gigabytes of attachments will consume disk space rapidly. This is because each site backup contains all content needed for a site restore. For example, if a 1 GB instance of Confluence is backed up daily, it will create 30 GB of backups per month if left unattended. When administering a large instance, you can reduce disk space by setting XML site backups to exclude attachments, then manually scheduling a backup of your attachments from the Confluence home directory or database. The backup manager can save space by saving changed files instead of all content.

<table>
<thead>
<tr>
<th>Creation Delay</th>
<th>Disk Usage</th>
<th>Recommended Backup Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acceptable</td>
<td>Acceptable</td>
<td>XML site backup with attachments</td>
</tr>
<tr>
<td>Acceptable</td>
<td>Unacceptable</td>
<td>XML site backup minus attachments, plus manual backup of attachments</td>
</tr>
<tr>
<td>Unacceptable</td>
<td>Unacceptable</td>
<td>Manual backup of database and attachments</td>
</tr>
</tbody>
</table>

**Creation Delay** is the time it takes to create an XML site backup *minus attachments*.

**Disk Usage** can be estimated by multiplying the frequency of your XML site backups by their current size.

**Manual Backups**

Confluence’s Attachment Storage Configuration can be set to store attachments in the Confluence home directory, or in the database.

**Database Backup**

Use your Database Administration Tool to create a backup of your Confluence database. If your database is storing your attachments, importing this later will restore all content. For instances with big attachments, please note that currently Confluence migrate attachments in a single transaction: CONF-9888.

**Attachment Backup**

If stored on the filesystem, attachments are placed under the attachments directory of your Confluence home directory. Copy this directory to create a backup of all attachments.

To restore from these backups, please refer to Restoring Data from other Backups.

**Related Topics**

Production Backup Strategy
Backup FAQ
Production Backup Strategy

Confluence automatic daily XML backup is suitable if you:

- are evaluating Confluence
- do not have database administration familiarity, and your Confluence installation is small

Once your Confluence installation reaches more than a few thousand pages, the XML backup facility can be inefficient compared to your database’s own backup tools. The built in backup functionality requires a lot of memory to run and is less reliable when restoring data.

**Related pages:**

- Site Backup and Restore
- Backup FAQ

⚠️ The information on this page does not apply to Confluence OnDemand.
**Establishing a production system backup solution**

Atlassian recommends establishing an alternative database backup strategy:

- Create a backup or dump of your database using tools provided by your database.
  
  !> To avoid any data inconsistency and corruption, it is recommended to shut down Confluence before creating a database backup or dump.
- Create a file system backup of your Confluence home directory.

Once this is in place, disable the daily backups through the scheduled jobs feature via 'Administration Console > Administration > Scheduled Jobs'.

We want to stress that creating these two backups is better than having a Confluence XML backup. It is more robust and far more reliable for large production instances. You will be able to restore your whole site, including all data, attachments and configuration information intact with these two backups. See Restoring Data from other Backups.

**Which files need to be backed up?**

Backing up the whole home directory is the safest option, however most files and directories are populated on startup and can be ignored. At minimum, these files/directories must be backed up:

- **attachments** – but if you store your attachments in the database then you can ignore the attachments directory.
- **confluence.cfg.xml**

The rest of the directories will be auto-populated on start up. You may also like to backup these directories:

- **config** – if you have modified your ehcache.xml file.
- **index** – if your site is large or reindexing takes a long time – this will avoid the need for a full reindex when restoring.

**How do I restore?**

Take a look at the Migrating Confluence Between Servers document for instructions on restoring a backup using this technique.

**Other processes**

XML backups are described and used for other processes in Confluence, like upgrading and moving servers. Using the backup strategy described above will work for those processes too.

- Our upgrade guide does not require the use of an XML backup (although the earlier Confluence upgrade procedure, and the JIRA upgrade guide, do use XML backups).
- Our migrate server procedure – used to set up a test server – can use a SQL dump as well.
- The database migration procedure uses the XML backup for small data sets. Large data sets will require third party database migration tools.

**Note:** The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

**Configuring Backups**

Confluence backs up your data regularly into a zipped XML file. By default, this backup is performed at 2.00 a.m. each day and the backup files are stored in the backups folder under the Confluence Home directory. The default naming convention for the backup files is 'backup-yyyy_MM_dd'. Confluence can write backups to both local and mapped network drives.

From the Backup Administration section of Confluence's administration console, you can:
• Include or exclude attachments in backups.
• Configure a different path to store backup files. (By default, this option is not available. See below for information about enabling the configuration option.)
• Change the naming format used for the files.

You can also change the schedule of this backup using Confluence's scheduled jobs feature.

You need to have System Administrator permissions in order to configure these options.

### On this page:
- Configuring Confluence Backups
- Enabling Backup Path Configuration
- Notes

### Related pages:
- Confluence Administrator’s Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

---

## Configuring Confluence Backups

To configure Confluence backups:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'Backup Administration' in the 'Configuration' section.
3. Click the 'Edit' button on the 'Backup Administration' screen.
4. Now you can do the following:
   - To use a different naming prefix format — Enter the new format in the 'Backup File Prefix' input field.
   - To use a different date format — Enter the date format in the 'Backup File Date Pattern' input field using the syntax described in [this document from Sun](https://example.com).
   - To exclude attachments from backups — Deselect 'Backup Attachments'. By default, this feature is 'On'.
   - To specify an alternate path to store backup files (if enabled) — Select 'Custom' and then enter the path. The directory must be on either a local drive or a mounted network drive.

#### Notes:
- By default, this option is not available. See below for information about enabling the configuration option.
- Please ensure the mapped drive is on a physical server, not a Virtual Machine image.

5. ‘Save’ your changes.

You can disable Confluence backups through the scheduled jobs feature.
Enabling Backup Path Configuration

By default, it is not possible to specify a backup path via the Confluence Administration Console. This feature is disabled by default for security reasons. Administrators can restore this functionality by updating the relevant configuration property as described below. However, we recommend that you turn the feature off in production environments. For production environments, please review our Production Backup Strategy.

To enable the configuration option:

1. Edit the `confluence.cfg.xml` file found in the Confluence Home Directory.
2. Set the value of property `admin.ui.allow.daily.backup.custom.location` to 'true' (without the quotation marks).
3. Restart Confluence.

If the value of the above configuration property is 'true', it will be possible to specify a backup path via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, the backup path is not configurable.

Notes

Time is derived from the Confluence server

The time zone is taken from the server on which Confluence is running.

To check the time according to the server, do the following:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'System Information' in the left-hand panel and look at the 'System Time'.

Backup strategy for large Confluence sites

Consider using the production backup strategy if your Confluence site is large or you are encountering problems with your automated backup.

User Submitted Backup & Restore Scripts

These scripts are user-submitted and should be used with caution as they are not covered by Atlassian technical support. If you have questions on how to use or modify these scripts, please post them to Atlassian Answers. Feel free to submit new scripts or post updates by logging in and adding them to the page as a comment.

⚠️ The information on this page does not apply to Confluence OnDemand.
Delete Old Backups - Wscript Script On Windows

This script examines backup filename and deletes them if necessary, it may need to be edited.

```wscript
'If you want 3 day old files to be deleted then insert 3 next to Date - "your number here"
'This script will search out and delete files with this string in them ".2005-12-04-" This of course depends on the number you enter.
'You can always do a wscript.echo strYesterday or strFileName to see what the script thinks you are searching for.

dtmYesterday = Date - 3

strYear = Year(dtmYesterday)
strMonth = Month(dtmYesterday)
If Len(strMonth) = 1 Then
    strMonth = "0" & strMonth
End If

strDay = Day(dtmYesterday)
If Len(strDay) = 1 Then
    strDay = "0" & strDay
End If

strYesterday = strYear & "-" & strMonth & "-" & strDay
strFileName = "C:\test*.." & strYesterday &"*"

Set objFSO = CreateObject("Scripting.FileSystemObject")
objFSO.DeleteFile(strFileName)
```

Delete Old Backups - Basic Bash Script For Linux

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following:

```bash
ls -t <path to your backup dir>/* | tail -n +6 | xargs -i rm {} 
```

Or, using the older form of the `tail` command if your system does not support the standard form:

```bash
ls -t <path to your backup dir>/* | tail +6 | xargs -i rm {} 
```

Delete Old Backups - Advanced Bash Script For Linux

Old XML backups can be deleted automatically by inserting a nightly or weekly automation script or cron similar to the following. Set the BACKUP_DIR and DAYS_TO_RETAIN variables to appropriate values for your site. Between runs, more files than DAYS_TO_RETAIN builds up.
#!/bin/sh

# Script to remove the older Confluence backup files.
# Currently we retain at least the last two weeks worth
# of backup files in order to restore if needed.

BACKUP_DIR="/data/web/confluence/backups"
DAYS_TO_RETAIN=14

find $BACKUP_DIR -maxdepth 1 -type f -ctime +$DAYS_TO_RETAIN -delete

---

**Manual Database & Home Backup - Bash Script For Linux**

This backs up a mySQL database and the Confluence home directory.

#!/bin/bash

CNFL=/var/confluence
CNFL_BACKUP=/backup/cnflBackup/`date +%Y%m%d-%H%M%S`

rm -rf $CNFL/temp/*
mkdir $CNFL_BACKUP
mysqldump -uroot -p<password> confluence|gzip > $CNFL_BACKUP/confluence.mysql.data.gz
tar -cjvf $CNFL_BACKUP/data.bzip $CNFL > $CNFL_BACKUP/homedir.status

---

**Backup by Date - Postgres**

export d=`date +%u`
mkdir -p /home/backup/postgres/$d

sudo -u postgres pg_dumpall | bzip2 > /home/backup/postgres/$d/sql.bz2

---

**Related Topics**

- [Site Backup and Restore](#)
- [Backup FAQ](#)

**Manually Backing Up the Site**

Confluence is configured to back up its data automatically. You can also manually perform this backup from the [Administration Console](#).

You need to have [System Administrator](#) permissions in order to perform this function.

**Note:** Atlassian recommends that you follow the [Production backup strategy](#) if your Confluence site is large or you are encountering problems with your automated backup.

**Note:** The plugindata table will not be backed up under a manual backup, so plugins will need to be reinstalled on completion of the backup.

**Creating the site backup**

To manually back up your site:

1. Choose the [cog icon](#) at top right of the screen, then choose [Confluence Admin](#).
2. Choose [Backup & Restore](#) in the left-hand panel.
3. Choose [Archive to backups folder](#) to store a copy of the backup in the same folder as Confluence's bac
kups.

If you do not archive the backup it will be made available for you to download, and then deleted from the server after 24 hours.

4. Choose **Backup attachments** to include attachments in your backup.

5. Choose **Backup**.

The process will take a few minutes.

---

**Related pages:**

- Restoring a Site
- Configuring Backups
- Production Backup Strategy
- Confluence Administrator's Guide

---

**Retrieving the Backup File**

Confluence stores the backup as a zipped XML file in the 'backups' directory under the Confluence Home directory on your Confluence server. To find your Confluence Home directory, see the documentation. You will need access to the Confluence server in order to retrieve this file.

**Enabling the download of the backup file via the administration console**

By default, it is not possible to retrieve the backup file via the Confluence Administration Console. This feature is disabled for security reasons.

Administrators can enable this functionality by updating the relevant configuration property as described below. If this functionality is enabled, Confluence will prompt you to download the backup file when the backup process finished. However, we recommend that you turn the feature off in production environments.

**To enable download of the backup file from the Administration Console:**

1. Edit the `confluence.cfg.xml` file found in the Confluence Home Directory.
2. Set the value of property `admin.ui.allow.manual.backup.download` to 'true' (without the quotation marks).
3. Restart Confluence.

If the value of the above configuration property is 'true', it will be possible to download the backup file after manually backing up the site via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the configuration file, you will need to retrieve the backup file from the file system on the Confluence server. By default, the value is 'false'.

**Notes**

If you experience timeout errors, please consider bypassing Apache and creating the export directly from Tomcat. This will speed up the process and prevent timeouts. For example, your URL might be something like `http://<domain>.com`. To bypass this and access Tomcat directly, use this URL: `http://localhost:8080/confluence/admin/backup.action`.

---

**Restoring a Site**

**CAUTION:** Restoring a backup of an entire confluence site will:

- Wipe out all Confluence content in the database. Please ensure that your database is backed up before you start.
- Log you out after the restoration process. Please make sure you know the login details contained...
This page describes how to restore data from an XML backup file into an existing Confluence installation. If you want to restore data into a new site, follow the instructions on Restoring from Backup During Setup.

You need System Administrator permissions in order to perform this function.

Notes before you start:

- **All content replaced.** Restoring a site from backup will replace all your content, as described in the warning above.
- **Selective space restoration not possible.** You cannot select a single space to restore from the entire site backup when the backup contains more than one space.
- **Backward version compatibility.** Confluence supports backward compatibility for site backups (but not for space backups). You can successfully restore backups of a site from an older version of Confluence to a newer version of Confluence. You cannot restore backups from a newer version to an older version. For example, if you create a site backup in Confluence 2.4.3, it cannot be restored into a Confluence 2.2.2 site. It can however, be restored into 2.4.5 or 2.5.x, because 2.4.5 and 2.5.x are newer versions of Confluence.

**Related pages:**

- Production Backup Strategy
- Manually Backing Up the Site
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

**Restoring data from an XML backup**

You can restore data from an XML backup file located somewhere on your local computer or a shared drive, or you can copy the XML file into the Confluence installation and restore it from there. The second option is recommended for large backup files. Both options are described below.

**To restore data from an XML backup located outside Confluence:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Backup and Restore in the left-hand panel.
3. Choose Choose File and browse for the backup file.
4. Uncheck Build Index if you want to create the index at a later stage.
5. Choose Upload and Restore.

**To restore data from an XML backup located in your Confluence installation:**

1. Copy your XML backup zip file into the restore directory in your Confluence home directory. For example:
   - On UNIX: `/opt/java/src/confluence/deployments/conf.atlassian.com/home/restore`
   - On Windows: `C:\Program Files\Atlassian\Application Data\Confluence x.x\restore`
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Backup and Restore in the left-hand panel.
4. The zip file that you copied in step 1 will appear in the list of files under the heading Restore a backup from the Confluence Home Directory on your Confluence Administration Console. Select the zip file.
5. Uncheck Build Index if you want to create the index at a later stage.
6. Choose Restore.
**Notes**

- **Production backup strategy preferred.** Atlassian recommends that you follow the Production Backup Strategy for your production Confluence site, because Confluence XML backups are not recommended for non-evaluation sites.
- **Restoring from other backups.** If your daily backup zip files cannot be restored for some reason, but you have backups of both your database and your Confluence home directory, then it is still possible to restore from these backups.

**Restoring a Space**

This page tells you how to import the contents of a Confluence space into another Confluence site, via an XML backup file.

You can export the content of a space, including pages, comments and attachments. The process involves converting the data in the space into XML format. The end product is a zip file that contains XML file(s) and optionally, all the attachments in the space. To transfer this data to another Confluence site, restore this zip file as described below.

Confluence will only allow you to restore a space if there is not already a space by that name on the site. If you already have a space with the identical name, you will need to delete or rename the existing space before restoring the new one.

**Related pages:**

- Restoring a Site
- Confluence Administrator’s Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

---

⚠️ **Cannot restore to a different major Confluence release**

Confluence only supports forward and backward compatibility for space import and export when executed within the same major version of Confluence. (This issue is logged as CONF-26111.)

Clarifying our terminology: By major version, we mean the version defined in the first two sections of the release number. For example, Confluence 2.2 and Confluence 2.3 are different major versions. Confluence 2.2.1 and Confluence 2.2.6 are the same major version.

**Restoration data must share the same major version number**

This means that a space export created in one major version of Confluence cannot be imported into a different major version of Confluence. For example, if you create a space export in Confluence 2.3.5, it cannot be imported into a Confluence 2.2.2 site. It can be however imported into 2.3.6. Similarly, a space export created in 2.2.2 can not be imported into 2.3.5. However, it can be restored into a Confluence 2.2.6 site.

If you try to carry out such an operation, an error message similar to the one below will be displayed and the import action will be stopped.

**Screenshot: Major Version Clash on Space Restore**

The following error(s) occurred:
- Restore denied. You can only restore space backups exported from the same major version (e.g. 2.2.x or 2.3.x).

**Workaround for restoring spaces between major releases**

You'll need to set up a test server, download and install the same version of Confluence as the version you exported the space from, then import the space into this test server. Next upgrade Confluence on your test installation to the right major version so that you can perform the export and import this space.
You need to have System Administrator permissions in order to perform this function.

You can restore data from an XML backup file located somewhere on your local computer or a shared drive, or you can copy the XML file into the Confluence installation and restore it from there. The second option is recommended for large backup files. Both options are described below.

**To restore data from an XML backup located outside Confluence:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Backup and Restore in the left-hand panel.
3. Choose Choose File and browse for the backup file.
4. Uncheck Build Index if you want to create the index at a later stage.
5. Choose Upload and Restore.

**To restore data from an XML backup located in your Confluence installation:**

1. Copy your XML backup zip file into the restore directory in your Confluence home directory. For example:
   - On UNIX: `/opt/java/src/confluence/deployments/conf.atlassian.com/home/restore`
   - On Windows: `C:\Program Files\Atlassian\Application Data\Confluence xx.x\restore`
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Backup and Restore in the left-hand panel.
4. The zip file that you copied in step 1 will appear in the list of files under the heading Restore a backup from the Confluence Home Directory on your Confluence Administration Console. Select the zip file.
5. Uncheck Build Index if you want to create the index at a later stage.
6. Choose Restore.

Changing the version of a space backup

Confluence prevents the import of space backups which aren't from the same major version. The reason for this is that any schema change between the export and imported version of Confluence will cause the import to fail, leaving you with an incomplete import. Even worse, the failure can be database-dependent, so it may work fine on one particular database but your backup will fail to import later.

! Do not import a modified space backup on a production server. Import the modified space backup on a test server, then export from the test server to create a pristine space backup for the new version.

The information on this page does not apply to Confluence OnDemand.

To change the version of a space backup, do the following:

- extract the space backup ZIP file
- edit `exportDescriptor.properties` in a text editor
- change the buildNumber to the buildNumber of the Confluence version you wish to import into
- zip up the modified contents of the backup into a ZIP file again.

This will allow you to import a backup into a test instance of Confluence. After checking the imported space for errors, export it cleanly from the test server and import the fresh backup into your production server.

If your import fails on the test server due to Hibernate errors, this indicates a schema incompatibility and cannot be worked around. You will need to restore your entire site on an old version of Confluence, and export the
space from there. See the last section of Restoring a Space for details.

Restoring a Test Instance from Production

See Migrating Confluence Between Servers for a more comprehensive explanation.

Many Confluence administrators will have a production instance running the "live" version of Confluence, as well as a test instance for testing upgrades and so on. In this situation, it's quite common that the two instances are running different versions of Confluence. This document describes how to copy the data from a production instance to a test instance, where the production version may be different to the test version.

Before proceeding with this guide, ensure you have read and understood the normal procedure for upgrading Confluence.

The information on this page does not apply to Confluence OnDemand.

Upgrading a test Confluence instance with production data

Essentially, we are copying both the production home directory and database to the test instance. We then update the database details on the test instance to point to the test database, leaving all other instance metadata (most importantly the Confluence build number) the same as production.

1. Shut down your test instance.
2. Restore the production database to the test database server.
3. Create a backup of the confluence.cfg.xml file found in the home directory of the test instance.
4. Copy the production confluence-home directory to the test application server.
5. Open the confluence.cfg.xml which has been copied in a text editor. Change the database settings to match the test database server. Ensure you do not point to your production database. (You can compare with the backup you made in Step 3 if you need to get the database settings. Don't just copy this file – you need the build number unchanged from production to indicate the database is from an older version of Confluence.)

Before starting your test instance, you need to do the following steps to ensure no contact with production systems.

Ensuring no contact with production systems

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:

```sql
SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.smtp.mail.accounts';
```

2. Disable space-level mail archiving by running the following database query:

```sql
SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.space.mailaccounts';
```

Change the 'SELECT *' to a 'DELETE' in the above queries once you are sure you want to remove the specified accounts.

Once this is done, you can start your test instance without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, etc.). These should be disabled.
promptly after starting the test instance.

You can create a developer license for this server and update the License Details after starting up.

See also

Upgrading Confluence
Migrating Confluence Between Servers
Restoring to a Test Instance of Confluence from Production
Restoring Data from other Backups

Typically, Confluence data is restored from the Administration Console or from the Confluence Setup Wizard.

If you are experiencing problems restoring from an zipped XML backup file, it is still possible to restore provided you have:

1. A backup of your home directory.
2. A backup of your database (if you're using an external database).

Instructions for this method of restoring differ depending on whether you are using the embedded database or an external database (like Oracle, MS SQL Server, MySQL or Postgres).

⚠️ The information on this page does not apply to Confluence OnDemand.

Embedded Database

If you are running against the embedded database, the database is located inside the database folder of your Confluence Home Directory. Hence, all you need to do is:

1. Retrieve the most recent backup of your home directory.
2. Unpack the Confluence distribution and point the confluence-init.properties file to this directory.

External Database

If you're using an external database, you need to do the following.

1. Prepare backups of your home directory and database (preferably backups that are dated the same). That is, make sure the home directory is accessible on the filesystem and the database available to be connected to.
2. If this database happens to have a different name, or is on a different server, you need to modify the jdbc url in the confluence.cfg.xml file inside the Confluence Home Directory. The value of this property is specified as hibernate.connection.url.
3. Unpack the Confluence distribution and point the confluence-init.properties file to the home directory.

RELATED TOPICS

Important Directories and Files
Migrating to a Different Database

Retrieving File Attachments from a Backup

File attachments on pages can be retrieved from a backup without needing to import the backup into Confluence. This is useful for recovering attachments that have been deleted by users.
Both automated and manual backups allow this, as long as the 'Include attachments' property was set. If you want to restore pages, spaces or sites, see the Confluence Administrator's Guide instead.

Before following the instructions for recovering attachments below, we will review how backups store file and page information.

⚠️ The information on this page does not apply to Confluence OnDemand.

### How Backups Store File and Page Information

The backup zip file contains entities.xml, an XML file containing the Confluence content, and a directory for storing attachments.

#### Backup Zip File Structure

Page attachments are stored under the attachments directory by page and attachment id. Here is an example listing:

```plaintext
Listing for test-2006033012_00_00.zip
\attachments\98\10001
\attachments\98\10002
\attachments\99\10001
entities.xml
```

Inside the attachment directory, each numbered directory inside is one page, and the numbered file inside is one attachment. The directory number is the page id, and the file number is the attachment id. For example, the file `\attachments\98\10001` is an attachment with page id 98 and attachment id 10001. You can read entities.xml to link those numbers to the original filename. Entities.xml also links each page id to the page title.

#### Entities.xml Attachment Object

Inside the entities.xml is an Attachment object written in XML. In this example, the page id is 98, the attachment id is 10001 and the filename is `myimportantfile.doc`. The rest of the XML can be ignored:

```xml
<object class="Attachment" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="fileName"><![CDATA[myimportantfile.doc]]></property>
  ...
  <property name="content" class="Page" package="com.atlassian.confluence.pages">
    <id name="id">10001</id>
  </property>
  ...
</object>
```

#### Entities.xml Page Object

This XML describes a page. In this example, the page id is 98 and the title is Editing Your Files. The rest of the XML can be ignored:

```xml
<object class="Page" package="com.atlassian.confluence.pages">
  <id name="id">98</id>
  <property name="title"><![CDATA[Editing Your Files]]></property>
  ...
</object>
```
**Instructions for Recovering Attachments**

Each file must be individually renamed and re-uploaded back into Confluence by following the instructions below. Choose one of the three methods:

**Choice A - Recover Attachments By Filename**

Best if you know each filename you need to restore, especially if you want just a few files:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the filename and find the attachment object with that filename. Locate its page and attachment id.
3. Using the page and attachment id from entities.xml, go to the attachments directory and open that directory with that page id. Locate the file with the attachment id.
4. Rename the file to the original filename and test it.
5. Repeat for each file.
6. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Choice B - Restore Files By Page**

Best if you only want to restore attachments for certain pages:

1. Unzip the backup directory and open entities.xml.
2. Search entities.xml for the page title and find the page object with that title. Locate its page id.
3. Go to the attachments directory and open that directory with that page id. Each of the files in the directory is an attachment that must be renamed.
4. Search entities.xml for attachment objects with that page id. Every attachment object for the page will have an attachment id and filename.
5. Rename the file with that attachment id to the original filename and test it.
6. Repeat for each page.
7. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Choice C - Restore All Files**

Best if you have a small backup but want to restore many or all the attachments inside:

| Warning | Following process is applicable to space export only. Site xml backups do not require page id to be updated manually due to the nature of persistent page_id's. |

1. Unzip the backup directory and open entities.xml.
2. Go to the attachments directory and open any directory. The directory name is a page id. Each of the files in the directory is an attachment that must be renamed.
3. Search entities.xml for attachment objects with that page id. When one is found, locate the attachment id and filename.
4. Rename the file with that attachment id to the original filename and test it.
5. Find the next attachment id and rename it. Repeat for each file in the directory.
6. Once all files in the current directory are renamed to their original filenames, search entities.xml for the page id, eg directory name. Find the page object with that page id and locate its page title.
7. Rename the directory to the page title and move on to the next directory. Repeat for each un-renamed directory in the attachments directory.
8. To import each file back into Confluence, upload to the original page by attaching the file from within Confluence.

**Troubleshooting failed XML site backups**
XML site backups are only necessary for migrating to a new database. Setting up a test server or Establishing a reliable backup strategy is better done with an SQL dump.

Seeing an error when creating or importing a backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow instructions below</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow Troubleshooting XML backups that fail on restore</td>
</tr>
</tbody>
</table>

The information on this page does not apply to Confluence OnDemand.

Resolve Errors With Creating An XML Backup

The errors may be caused by a slightly corrupt database. If you’re seeing errors such as 'Couldn't backup database data' in your logs, this guide will help you correct the error on your own. We strongly recommend that you backup your database and your Confluence home directory beforehand, so that you can restore your site from those if required. If you are unfamiliar with SQL, we suggest you contact your database administrator for assistance.

Preferable solution

The Production Backup Strategy is a very reliable and more efficient way to do backups. If you are running into problems with XML backups - whether memory related or because of problems like the one described here - use the native backup tool as an alternate solution.

To Identify And Correct The Problem

To work out where the data corruption or problems are, increase the status information reported during backup, then edit the invalid database entry:

1. Stop Confluence.
2. If you have an external database, use a database administration tool to create a manual database backup.
3. Backup your Confluence home directory. You will be able to restore your whole site using this and the database backup.
4. Open the my_confluence_install/confluence/WEB-INF/classes/log4j.properties and add this to the bottom and save:

   ```
   log4j.logger.com.atlassian.confluence.importexport.impl.XMLDatabinder=DEBUG,confluencelog
   log4j.additivity.com.atlassian.confluence.importexport.impl.XMLDatabinder=false
   ```

5. Find your atlassian-confluence.log. Move or delete all existing Confluence logs to make it easier to find the relevant logging output.
6. Restart Confluence and login.
7. Begin a backup so that the error reoccurs.
8. You must now check your log files to find out what object could not be converted into XML format. Open the confluence-home/logs/atlassian-confluence.log. Scroll to the bottom of the file.
9. Do a search for 'ObjectNotFoundException'. You should see an error similar to this:
10. Open a DBA tool such as DbVisualizer and connect to your database instance. Scan the table names in the schema. You will have to modify a row in one of these tables.

11. To work out which table, open catalina.out, check the first line of the exception. This says there was
an error writing the ContentPermission object with id 5 into XML. This translates as the row with primary key 5 in the CONTENTLOCK table needs fixing. To work out what table an object maps to in the database, here’s a rough guide:

- Pages, blogposts, comments --> CONTENT table
- attachments --> ATTACHMENTS table
- More information can be found in the schema documentation

12. Now you must find the primary key of the incorrect row in this table. In this case, you can check the first line and see that the row has a primary key of 5.

13. Each property is written to a column, so the last property that was being written has the incorrect value. The row being written to when the exception was thrown was CONTENT (line 5) with a value of 2535 (line 6). Now you know the column and value. This value 2535 is the id of an entry that no longer exists.

14. Using a database administrative tool, login to the Confluence database. Locate the row in the relevant table and correct the entry. Check other rows in the table for the default column value, which may be null, 0 or blank. Overwrite the invalid row value with the default.

15. Restart Confluence.

16. Attempt the backup again. If the backup fails and you are stuck, please lodge a support request with your latest logs.

Troubleshooting "Duplicate Key" related problems

If you are encountering an error message such as:

could not insert:
[bucket.user.propertyset.BucketPropertySetItem#bucket.user.propertyset.BucketPropertySetItem@a70067d3]; SQL []; Violation of PRIMARY KEY constraint 'PK_OS_PROPERTYENTRY314D4EA8'. Cannot insert duplicate key in object 'OSPROPERTYENTRY'; nested exception is java.sql.SQLException: Violation of PRIMARY KEY constraint 'PKOS_PROPERTYENTRY_314D4EA8'. Cannot insert duplicate key in object 'OSPROPERTYENTRY'.

this indicates that the Primary Key constraint ‘PK_OS_PROPERTYENTRY_314D4EA8’ has duplicate entries in table ‘OS_PROPERTYENTRY’.

You can locate the constraint key referring to ‘PK_OS_PROPERTYENTRY_314D4EA8’ in your table ‘OS_PROPERTYENTRY’ and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OS_PROPERTYENTRY' table is:

```
SELECT ENTITY_NAME,ENTITY_ID,ENTITY_KEY,COUNT(*) FROM OS_PROPERTYENTRY
GROUP BY ENTITY_NAME,ENTITY_ID,ENTITY_KEY HAVING COUNT(*)>1
```

To Help Prevent This Issue From Reoccuring

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should migrate to an external database.

2. If you are using an older version of Confluence than the latest, you should consider upgrading at this point.

RELATED TOPICS

Enabling detailed SQL logging

AdmInistrators Guide Home Confluence Documentation Home

Migrating from HSQLDB to MySQL
Disclaimer

MySQL Migration Toolkit is released by the makers of MySQL and as such, problems with the software should be directed to them. Atlassian Support does not offer support for the Migration Toolkit, nor do we provide support for this migration path. These instructions are offered for strictly informational purposes, and your mileage may vary.

⚠️ Backup Reminder
Please backup your database and your home folder before attempting this.

⚠️ The information on this page does not apply to Confluence OnDemand.

Resources needed

- Empty MySQL DB with appropriate credentials to allow creation, deletion, and insertion of tables and rows.
- A Windows machine that can both communicate to the Confluence server and the destination DB.
- MySQL Migration Toolkit
- HSQL Database Engine

Preparation for migrating to MySQL from HSQLDB

1. Shutdown Confluence
2. Make a copy of the confluence home folder for backup purposes
3. Install the Migration Toolkit
4. Unzip the hsqldb package.
5. Copy the hsqldb.jar from hsqldb/lib into C:\Program Files\MySQL\MySQL Tools for 5.0\java\lib
6. Start the MySQL Migration Toolkit

Running the Migration Toolkit

You should be presented with the following screen.

Choose Direct Migration
Source Database

Select the source database you want to migrate from.

Source Database Connection

<table>
<thead>
<tr>
<th>Database System</th>
<th>Connection String</th>
<th>Driver</th>
<th>Username</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic JDBC</td>
<td>jdbc:hsqldb:file:PATHTODATABASEFOLDER\confluencedb</td>
<td>Generic JDBC</td>
<td>sa</td>
<td>No password. Leave this field blank</td>
</tr>
</tbody>
</table>

Destination Database

Please make sure that the computer that is running MySQL Toolkit is able to access the MySQL server.
and that the user listed has the ability to create, drop, insert, and update tables.

If your MySQL user has a $ character in the password (such as 'pa$sword'), please change the password or create a temporary account with full permissions. If you do not, the toolkit will throw an "Illegal group reference" error and you will not be able to proceed with the migration.

Target Database
Select the destination database.

Connecting to Servers
Establish database connections.

Tasks to execute
The following tasks will now be executed. Please monitor the execution progress. Press [Advanced >>] to see the log:

- Connecting to source database system
- Retrieve schema information from source database system
- Test connection to target database system

Execution completed successfully.

You should see the toolkit trying to connect. If you have problems, please click on the advanced options and sql will show you debugging information. Click Advanced to see the log. If you see "Java Heap Space: Out of Memory", you can start the MySQL Migration Toolkit with a -Xmx flag to allocate more memory to the JVM.

After this screen you should come to reverse engineering. Click next.
Source Schemata Selection

You should see 2 databases, INFORMATION_SCHEMA and PUBLIC. Choose PUBLIC.

Object Type Selection

Migration

In this step, the selected object will be migrated.

Migration of Meta Data

Tasks to execute

The following tasks will now be executed. Please monitor the execution progress. Press [Advanced > X] to see the log:

- [X] Execute Migration Process
- [X] Generate SQL Create Statements

Execution completed successfully.

Click Next.

Object Type Mapping
Object Creation Options

Please define how the object creations should be performed.

<table>
<thead>
<tr>
<th>Object Creation Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Object Creation Parameters</td>
</tr>
<tr>
<td>Select the desired options for the object creation. Click Next to start the creation process.</td>
</tr>
<tr>
<td>✓ Create Objects Online</td>
</tr>
<tr>
<td>Select this option to create the objects on the target database. If there is a problem during the creation process, you will be informed and can fix the error statement by pressing the (Details &gt;&gt;) button.</td>
</tr>
<tr>
<td>☐ Create Script File for Create Statements</td>
</tr>
<tr>
<td>If you want to store the object creation in a script file, enable this option. You can use this option in parallel to creating the objects online option if you want to have a backup of the SQL commands.</td>
</tr>
<tr>
<td>Destination Database</td>
</tr>
<tr>
<td>Select a database that exists in your system. This target database is used in the migration process.</td>
</tr>
<tr>
<td>Click Show Details on both sections. For Migration Method for Type Schema, choose Multilanguage. For Migration Method for Type Table, choose Data Consistency/Multilanguage</td>
</tr>
<tr>
<td>Click Advanced. Check Enabled Detailed Mappings in Next Step</td>
</tr>
</tbody>
</table>

Detailed Object Mapping

Click to rename the destination database to be the one set aside to migrate to.

From this point on, you should be able to click next all the way through to finish the migration.

Troubleshooting XML backups that fail on restore

XML site backups are only necessary for migrating to a new database. Upgrading Confluence, Setting up a test server or Production Backup Strategy is better done with an SQL dump.

If migrating from HSQLDB to MySQL, you might have a better experience using the MySQL Migration Toolkit.

Seeing an error when creating or importing a site or space backup?

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exception while creating backup</td>
<td>Follow Troubleshooting failed XML site backups instead</td>
</tr>
<tr>
<td>Exception while importing backup</td>
<td>Follow instructions below</td>
</tr>
</tbody>
</table>

⚠️ The information on this page does not apply to Confluence OnDemand.

Resolve Errors When Attempting To Restore An XML Backup

The errors may be caused by a slightly corrupt database. You will need to find the XML backup file entry that is violating the DB rules, modify the entry and recreate the XML backup:

1. On the instance being restored, follow the instructions to disable batched updates (for simpler debugging), log SQL queries and log SQL queries with parameters at Enabling Detailed SQL Logging.
2. Once all three changes have been made, restart Confluence.
3. Attempt another restore.
4. Once the restore fails, check your log files to find out what object could not be converted into XML format. For Confluence distribution users, check your Confluence install directory under /logs/ and check both atlassian-confluence.log and catalina.out file. The correct file will contain SQL debug
output.

5. Scroll to the bottom of the file and identify the last error relating to a violation of the database constraint. For example:

```
2006-07-13 09:32:33,372 ERROR
[confluence.importexport.impl.ReverseDatabinder] endElement
net.sf.hibernate.exception.ConstraintViolationException:
could not insert: [com.atlassian.confluence.pages.Attachment#38]
net.sf.hibernate.exception.ConstraintViolationException: could not insert: [com.atlassian.confluence.pages.Attachment#38]
...
Caused by: java.sql.SQLException: ORA-01400: cannot insert NULL into ("CONFUSER"."ATTACHMENTS"."TITLE")
at oracle.jdbc.driver.DatabaseError.throwSqlException(DatabaseError.java:112)
at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:331)
at oracle.jdbc.driver.T4CTTIoer.processError(T4CTTIoer.java:288)
```

This example indicates a row in your attachment table with ID = 38 that has a null title.

6. Go to the server that the backup was created on. You must have a copy of the database from which the backup was created. If you do not have this, use a DBA tool to restore a manual backup of the database.

7. Open a DBA tool and connect to the original database instance and scan the table names in the schema. You will have to modify a row in one of these tables.

8. To work out which table, open catalina.out, check the first line of the exception. To work out what table an object maps to in the database, here's a rough guide:
   - Pages, blogposts, comments --> CONTENT table.
   - attachments --> ATTACHMENTS table.

9. To correct the example error, go to the attachment table and find that attachment object with id 38. This will have a a null title. Give a title using the other attachments titles as a guide. You may have a different error and should modify the database accordingly.

10. Once the entry has been corrected, create the XML backup again.

11. Import the backup into the new version.

12. If the import succeeds, revert the changes made in your SQL logging to re-enable disable batched updates and turn off log SQL queries and log SQL queries with parameters.


**Troubleshooting “Duplicate Entry” for key “cp_” or “cps_”**

If you are encountering an error message such as:

```
com.atlassian.confluence.importexport.ImportExportException: Unable to complete import because the data does not match the constraints in the Confluence schema. Cause: MySQLIntegrityConstraintViolationException:
Duplicate entry '1475804-Edit' for key 'cps_unique_type'
```

This indicates that the XML export came from a version of Confluence with a corrupt permissions database, caused by some 3rd party plugin. This is an issue that was fixed when CONF-22123 was implemented in Confluence 3.5.2. The simplest workaround is to export the space again after upgrading the instance to 3.5.2 or above. If that is not an option, then either the export will need to be edited manually to remove the duplicate permission entries or the source instance will need to have the offending entries removed. The following SQL queries can be used to look for such entries:
SELECT * FROM CONTENT_PERM WHERE USERNAME IS NULL AND GROUPNAME IS NULL;

SELECT cp.ID, cp.CP_TYPE, cp.USERNAME, cp.GROUPNAME, cp.CPS_ID, cp.CREATOR, cp.CREATIONDATE, cp.LASTMODIFIER, cp.LASTMODDATE
FROM CONTENT_PERM cp
WHERE cp.USERNAME IS NOT NULL AND cp.GROUPNAME IS NOT NULL;

SELECT cps1.ID, cps1.CONTENT_ID, cps1.CONT_PERM_TYPE FROM CONTENT_PERM_SET cps1, CONTENT_PERM_SET cps2
WHERE cps1.ID <> cps2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cps1.CONT_PERM_TYPE = cps2.CONT_PERM_TYPE
ORDER BY cps1.CONTENT_ID, cps1.CONT_PERM_TYPE, cps1.CREATIONDATE ASC;

SELECT cp.ID, cp.CP_TYPE, cps.CONTENT_ID,
(SELECT scps.ID FROM CONTENT_PERM_SET scps WHERE scps.CONTENT_ID = cps.CONTENT_ID
AND scps.CONT_PERM_TYPE = cp.CP_TYPE) AS suggested_cps_id
FROM CONTENT_PERM cp, CONTENT_PERM_SET cps
WHERE cp.CPS_ID = cps.ID AND
cp.CP_TYPE <> cps.CONT_PERM_TYPE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID, cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.USERNAME = cp2.USERNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.USERNAME, cp1.CREATIONDATE;

SELECT DISTINCT cp1.ID, cp1.CP_TYPE, cp1.USERNAME, cp1.GROUPNAME, cp1.CPS_ID, cp1.CREATOR, cp1.CREATIONDATE, cp1.LASTMODIFIER, cp1.LASTMODDATE
FROM CONTENT_PERM cp1, CONTENT_PERM_SET cps1, CONTENT_PERM cp2, CONTENT_PERM_SET cps2
WHERE
cp1.CPS_ID = cps1.ID AND
cp2.CPS_ID = cps2.ID AND
cp1.ID <> cp2.ID AND
cps1.CONTENT_ID = cps2.CONTENT_ID AND
cp1.CP_TYPE = cp2.CP_TYPE AND
cp1.GROUPNAME = cp2.GROUPNAME
ORDER BY cp1.CPS_ID, cp1.CP_TYPE, cp1.GROUPNAME, cp1.CREATIONDATE;

SELECT * FROM CONTENT_PERM_SET
WHERE ID NOT IN (SELECT DISTINCT CPS_ID FROM CONTENT_PERM);

Remove all matching entries and perform the export again.

Troubleshooting "Duplicate Key" related problems

If you are encountering an error message such as:
This indicates that the Primary Key constraint 'PK_OS_PROPERTYENTRY_314D4EA8' has duplicate entries in table 'OS_PROPERTYENTRY'.

You can locate the constraint key referring to 'PK_OS_PROPERTYENTRY_314D4EA8' in your table 'OS_PROPERTYENTRY' and locate any duplicate values in it and remove them, to ensure the "PRIMARY KEY" remains unique. An example query to list duplicate entries in the 'OS_PROPERTYENTRY' table is:

```
SELECT ENTITY_NAME,ENTITY_ID,ENTITY_KEY,COUNT(*) FROM OS_PROPERTYENTRY
GROUP BY ENTITY_NAME,ENTITY_ID,ENTITY_KEY HAVING COUNT(*)>1
```

**Troubleshooting "net.sf.hibernate.PropertyValueException: not-null" related problems**

If you're receiving a message like:

```
ERROR [Importing data task]
[confluence.importexport.impl.ReverseDatabinder] endElement
net.sf.hibernate.PropertyValueException: not-null property references a
null or transient value:
com.atlassian.user.impl.hibernate.DefaultHibernateUser.name
```

This means there's an unexpected null value in a table. In the above example, the error is in the name column in the USERS table. We've also seen them in the ATTACHMENTS table.

Remove the row with the null value, redo the xml export, and reimport.

**To Help Prevent this Issue from Recurring**

1. If you are using the embedded database, be aware that it is bundled for evaluation purposes and does not offer full transactional integrity in the event of sudden power loss, which is why an external database is recommended for production use. You should **migrate to an external database**.
2. If you are using an older version of Confluence than the latest, you should consider **upgrading** at this point.

**The problem with different settings for case sensitivity varies between databases. The case sensitivity of the database is usually set through the collation that it uses. Please vote on the existing issue**

**RELATED TOPICS**

- Troubleshooting failed XML site backups
- Confluence Administrator's Guide
- Attachment Storage Configuration

Confluence allows you to store attachments in one of three places:

- Filesystem - locally in the Confluence home directory
- Database - in Confluence's configured database
• WebDAV - remotely on a WebDAV server (*deprecated*)

A System Administrator can configure Confluence's attachment storage via the 'Attachment Storage' option on the 'Administration Console'.

You need to have System Administrator permissions in order to perform this function.

---

**On this page:**
- Attachment Storage Options
  - Local File System
  - Database
  - WebDAV
- Migration between Attachment Storage Systems
- Troubleshooting

**Related pages:**
- Working with Confluence Logs
- Working with Confluence Logs
- Confluence Administrator's Guide

---

The information on this page does not apply to Confluence OnDemand.

**Attachment Storage Options**

**Local File System**

By default, Confluence stores attachments in the attachments directory within the configured Confluence home folder. If you are looking to run Confluence Clustered, attachments must be stored in the database.

**Database**

Confluence gives administrators the option to store attachments in the database that Confluence is configured to use.

Here are some reasons why, as an administrator, you may want to choose this storage system:

- Ease of backup.
- Avoiding issues with certain characters in attachment file names.

While storing attachments in the database can offer some advantages, please be aware that the amount of space used by the database will increase because of the greater storage requirements.

**WebDAV**

Confluence also allows administrators to set an external WebDAV repository as the location for attachment storage.

**WebDAV attachment manager deprecated**

The option to store Confluence attachments on a WebDAV server has never worked in a useful fashion, and has not been maintained for many versions.

- The WebDAV attachment manager will be deprecated from Confluence 2.7, and will be removed from a later version of Confluence.
- If you store attachments on external WebDAV servers, we recommend that you migrate to file-system or database-backed attachment storage as soon as possible. Refer to CONF-9313 and CONF-2887.
Migration between Attachment Storage Systems

You can 'migrate' your attachments from one storage system to another. All existing attachments will be moved over to the new attachment storage system.

- This DOES NOT affect the operation of the WebDAV plugin.

When the migration occurs, all other users will be locked out of the Confluence instance. This is to prevent modification of attachments while the migration occurs. Access will be restored as soon as the migration is complete.

When migrating attachments from your database to a filesystem, the attachments are removed from the database after migration. However, when migrating attachments from a filesystem to your database, the attachments remain on the filesystem after migration. If you wish to change this function's behaviour from 'copy' to 'move', please see CONF-14802 and cast your vote.

To perform a migration, follow the steps below:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'Attachment Storage' in the left-hand panel. The current configuration will be displayed.

   Screenshot: Attachment storage configuration

3. Click the 'Edit' button to modify the configuration.
4. Select the storage system you desire.

   Screenshot: Edit attachment storage

5. Click the 'Save' button to save the changes.
6. A screen will appear, asking you to confirm your changes. Clicking 'Migrate' will take you to a screen that displays the progress of the migration.

   Screenshot: migration warning
attachment migration

warning:
changing your attachment storage location from the current setting will result in a migration occurring. this may take time (depending on the amount of attachments).
during the migration process, users will not be able to access the system.
migration notes:
prior to migration, all records in the attachment data database table will be removed.
are you sure you want to perform this migration?

migrate  cancel

troubleshooting

to enable debug logging for webdav attachment storage, add the following to the bottom of web-inf/classes/log4j.properties and restart confluence:

log4j.logger.com.atlassian.confluence.pages.persistence.dao=DEBUG,confluencelog
log4j.additivity.com.atlassian.confluence.pages.persistence.dao=false

log4j.logger.org.apache.webdav=DEBUG,confluencelog
log4j.additivity.org.apache.webdav=false

for more about log file configuration, see working with confluence logs.

hierarchical file system attachment storage

for confluence version 3.0, the structure of attachments stored on the filesystem was changed. in versions of confluence prior to 3.0, attachments were stored in directories corresponding to the id of the content to which they belong. the more content in confluence with attachments, the more directories you would have immediately beneath your configured attachments directory. this directory structure has been changed in confluence 3.0 and since the default configuration of confluence is to store attachments in the filesystem, this change is likely to have relevance to administrators of most existing confluence installations.

if you are installing confluence for the first time, there will be no consequences as a result of this change. if you are upgrading from a previous version of confluence, the migration to this new filesystem structure should happen automatically during the upgrade.

the reason for introducing this change was to address the issue conf-13004. certain file systems have a limit on the number of files that can be stored in a directory and large confluence installations were reaching this limit. in addition, storing too many files at a single directory level can cause performance degradation in some circumstances. this new attachment storage strategy ensures this will no longer be the case.

⚠️ the information on this page does not apply to confluence ondemand.

⚠️ backup confluence home
before upgrading to confluence 3.0, as with any upgrade you must ensure you have a backup of your confluence home directory before you proceed.
The New Directory Layout

The attachment storage layout was chosen to fulfil the following main requirements:

1. Limit the number of entries at any single level in a directory structure.
2. Partition attachments per space making it possible for a system admin to selectively back up attachments from particular spaces (see the JIRA issue for more details).

An attachment in Confluence can be thought of as having a number of identifying attributes: id, space id and content id. That is to say, the attachment logically belongs to a piece of content which logically belongs in a space (not all content belongs to a space). For attachments within a space in Confluence, the directory structure is typically 8 levels, with the name of each directory level based on the following algorithm:

<table>
<thead>
<tr>
<th>level</th>
<th>Derived From</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (top)</td>
<td>Always 'ver003' indicating the Confluence version 3 storage format</td>
</tr>
<tr>
<td>2</td>
<td>The least significant 3 digits of the space id, modulo 250</td>
</tr>
<tr>
<td>3</td>
<td>The next 3 least significant digits of the space id, modulo 250</td>
</tr>
<tr>
<td>4</td>
<td>The full space id</td>
</tr>
<tr>
<td>5</td>
<td>The least significant 3 digits of the content id, modulo 250</td>
</tr>
<tr>
<td>6</td>
<td>The next 3 least significant digits of the content id, modulo 250</td>
</tr>
<tr>
<td>7</td>
<td>The full content id</td>
</tr>
<tr>
<td>8</td>
<td>The full attachment id</td>
</tr>
</tbody>
</table>

Within the 8th level will be a file for each version of that attachment, named to match the version number e.g. 1

An example:
To find the directory where attachments for a particular space are stored, you can use the JSP `findspaceattachments.jsp` at the location `<confluence url>/admin/findspaceattachments.jsp`. This JSP requires a space key and returns the directory on the file system where attachments for that space are stored.

Attachment D in the above diagram is stored in a slightly different structure. Attachments that are not conceptually within a space replace the level 2-4 directories with a single directory called 'nonspaced'. Examples of such attachments are the global site logo and also attachments on draft content.

Upgrading to the new attachment storage structure
As mentioned previously, this upgrade is only necessary if you have Confluence configured to store attachments on the file system.

If migration is not necessary due to a different storage configuration (for example, because attachments are stored in the database), then no migration will occur during upgrade and the Confluence log will simply show the following messages -

```
INFO [main] [AbstractUpgradeManager] upgradeStarted Starting automatic upgrade of Confluence
INFO [main] [UpgradeTask] isUpgradeNeeded The configured attachmentDataDao does not store attachment data on the file system so the HierarchicalFileSystemAttachmentUpgradeTask is not necessary.
INFO [main] [AbstractUpgradeManager] upgradeFinished Upgrade completed successfully
```

Should migration be required, it will occur automatically during upgrade and the log will show output similar to this -

```
INFO [main] [UpgradeTask] doUpgrade Beginning HierarchicalFileSystemAttachmentUpgradeTask. Depending on the size of the attachment data this may take some time.
INFO [main] [UpgradeTask] run 4023 pages may have attachments to be moved to a new hierarchical structure.
INFO [main] [UpgradeTask] run 0 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 500 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 1000 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 1500 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 2000 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 2500 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 3000 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 3500 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run 4000 of 4023 pages have had their attachments moved to the new structure
INFO [main] [UpgradeTask] run Successfully moved the attachments for all 4023 pages to the new hierarchical structure.
INFO [main] [UpgradeTask] doUpgrade Completed HierarchicalFileSystemAttachmentUpgradeTask.
INFO [main] [AbstractUpgradeManager] upgradeFinished Upgrade completed successfully
```

It should be noted that for most implementations of Java, the migration to the new data structure involves moving the files (not copying them). Hence, there should not be a need to have additional disk space available. It also means that the migration should be relatively fast.
Have you previously applied the CONF-8298 patch?

The patch or workaround on the CONF-8298 issue changed the structure of attachment storage but not to the most efficient possible structure. So during the Confluence 3.0 upgrade process this intermediate (CONF-8298) structure will be detected and automatically upgraded.

Troubleshooting the upgrade

⚠️ It should be noted that in the event of a failure, your attachment directory may be in an inconsistent state and your first step in troubleshooting should be to restore the backup of your home directory.

There are a number of reasons the migration could fail. This will be shown in the log with a message similar to "Failed to move the attachments for all pages to the new hierarchical structure."

Immediately preceding this message in the log will be entries for each page whose attachments could not be moved. The following table shows examples of these messages and offers some possible explanations.

<table>
<thead>
<tr>
<th>Example Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The configured attachment directory <code>&lt;directory name&gt;</code> could not be found or was not a directory.</td>
<td>The configured Confluence attachment directory is not accessible. Check confluence home for the attachment directory and ensure the permissions are correct to allow reading and writing for this directory.</td>
</tr>
<tr>
<td>It is not possible to migrate the attachments to the new structure since files already exist which the attachment process may need to create.</td>
<td>Your attachments directory contains files or directories which the upgrade task wants to create. That is, a top level directory called ver003 containing directories or files with names containing up to 3 digits (e.g. 1, 213). This could be due to a previous failed attempt to migrate the attachments. You should restore a previous good copy of your attachments directory and remove any files or directories with this naming pattern before retrying.</td>
</tr>
<tr>
<td>Couldn't find current Confluence content for the id <code>&lt;content Id&gt;</code>. The attachment is a non-spaced attachment (e.g. global logo, draft attachment, etc) and will be migrated to the nonspaced directory.</td>
<td>This is a normal message indicating that the attachment being migrated does not belong to a space e.g. global logo, global description, personal information (on profile pages) and attachments on draft content.</td>
</tr>
<tr>
<td>Problem while accessing the database for content id <code>&lt;content Id&gt;</code> so its attachments will not be migrated.</td>
<td>It was not possible to access the database at this point during the migration. You will need restore your Confluence attachment directory from the backup and attempt the upgrade again, once the database is accessible again.</td>
</tr>
<tr>
<td>Could not create the new attachment directory <code>&lt;directory&gt;</code>.</td>
<td>The upgrade task could not create the new directory to contain the attachment being moved. Does the server user have sufficient permission to perform this operation in the indicated directory? Is there sufficient disk space?</td>
</tr>
<tr>
<td>Failed to move the current attachment directory <code>&lt;some path&gt;</code> to the new location of <code>&lt;some other path&gt;</code>.</td>
<td>The upgrade task could not move the directory. Does the server user have sufficient permission to perform this operation in the indicated directory?</td>
</tr>
</tbody>
</table>
Confluence Data Directory Configuration

Here is a link listing important Confluence files.

The home directory defines the location of the directory where Confluence will store its data, including attachments, indexes and backups. Administrators can set this location by defining a value for the file `<MY-INST ALL>/confluence/WEB-INF/classes/confluence-init.properties`. To find what your home directory is currently set to, open this file and check the `confluence.home` property. It is unset on new installations.

⚠️ The information on this page does not apply to Confluence OnDemand.

Windows Configuration

On Windows, this path:

```
C:\confluence\data
```

will be written like so:

```
confluence.home=C:/confluence/data
```

Note that all backslashes (\) are written as forward slashes (/).

Linux/Solaris Configuration

On any Linux-based system, the property is defined using the normal directory syntax:

```
confluence.home=/var/confluence/
```

Symbolic links

If your `confluence.home` directory contains a symbolic link, you must define the absolute path.

⚠️ Please note that there can be no symbolic links within the `confluence.home` directory. If disk space is an issue, place the entire `confluence.home` directory on a disk partition where there is enough space.

The absolute path of generated files (such as exports) is compared with the absolute path of the `confluence.home` directory when constructing URLs. When a sub-directory has a different path, the URL will be incorrect, and you may receive "Page not found" errors. These measures are in place to prevent "directory traversal" attacks.

Fixing the Confluence Configuration

The Confluence configuration file: `confluence-cfg.xml` inside the home directory may contain references to the original location of your Confluence home. You will need to edit this file to update these references to also point to the new location. The two properties in this file that need to change are:

- `daily.backup.dir` if you have not configured your backups to be placed elsewhere already
- `hibernate.connection.url` if you are using the embedded HSQL database.

Configuring Attachment Size

Confluence gives you the option of limiting the maximum size of a single file attachment. Confluence
administrators should keep in mind that the amount of disk space used by Confluence is directly proportional to the number and size of attachments put into the system.

To configure the maximum size allowed for an attachment:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Enter the maximum size next to Attachment Maximum Size'. The default is 10 MB.
5. Choose Save.

To configure the maximum 'index-able size of attachments':

By default, large attachment is defined as greater than 1 MB.
The threshold for attachments that won't get excerpts can be modified using the system property atlassian.indexing.contentbody.maxsize, which takes a size in bytes.

Example

To specify 250 kb you would use the following JVM parameter:
-Datlassian.indexing.contentbody.maxsize=256000

Related pages:

- Recognised System Properties Not applicable to Confluence OnDemand.
- Working with Attachments
- Confluence Administrator's Guide

Outcomes of Limiting Attachment Indexing Size

Limiting the size of attachment indexing has the following effects:

- Decreases the size of the index when large attachments are present.
- Decreases the memory used in indexing large attachments.
- Prevent excerpts of large attachments being displayed in search results.

For more details, please refer to the following issue in our issue tracker: CONF-10512.

Confluence Data Model

On this page:

- General Database Diagram
- Authentication
  - Atlassian-user
  - OpenSymphony
- Content
- Clustering
  - System information
  - Spaces
- Appearance
- Miscellaneous

The Hibernate mapping files are the authoritative reference. These are the *.hbm.xml files which have been bundled into the main Confluence .jar file in recent releases.

This document is little more than the Confluence schema with added comments, but the priority was placed on making the information available.

General Database Diagram
Authentication

**Atlassian-user**

This is the "new" authentication system, which is more flexible and extensible than OpenSymphony.

```
  Table "groups"
  Column   |          Type          | Modifiers
  -----------+------------------------+-----------
  id        | bigint                 | not null
  groupname | character varying(255) | not null

Indexes:
  "groups_pkey" PRIMARY KEY, btree (id)
```

```
  Table "users"
  Column  |            Type             | Modifiers
  ----------+-----------------------------+-----------
  id       | bigint                      | not null
  name     | character varying(255)      | not null
  password | character varying(255)      |
  email    | character varying(255)      |
  created  | timestamp without time zone |
  fullname | character varying(255)      |

Indexes:
  "users_pkey" PRIMARY KEY, btree (id)
  "users_name_key" UNIQUE, btree (name)
```

`local_members:` establishes many-to-many association between users and groups.
Table "local_members"
Column | Type    | Modifiers
--------+---------+-----------
userid  | bigint  | not null  
groupid | bigint  | not null  
Indexes:
"local_members_pkey" PRIMARY KEY, btree (groupid, userid)
Foreign-key constraints:
"fk6b8fb44517d5fda" FOREIGN KEY (groupid) REFERENCES groups(id)
"fk6b8fb445ce2b3226" FOREIGN KEY (userid) REFERENCES users(id)

external_entities: Maps users from LDAP (or any other external authentication system) to IDs in Confluence DB

Table "external_entities"
Column | Type            | Modifiers
--------+-----------------+-----------
id     | bigint          | not null  
name   | character varying(255) | 
type   | character varying(255) | not null  
Indexes:
"external_entities_pkey" PRIMARY KEY, btree (id)

external_members: associates LDAP (or other external) users with local groups.

Table "external_members"
Column | Type    | Modifiers
--------+---------+-----------
extentityid | bigint  | not null  
groupid   | bigint  | not null  
Indexes:
"external_members_pkey" PRIMARY KEY, btree (groupid, extentityid)
Foreign-key constraints:
"fkd8c8d8a517d5fda" FOREIGN KEY (groupid) REFERENCES groups(id)
"fkd8c8d8a5f25e5f" FOREIGN KEY (extentityid) REFERENCES external_entities(id)

OpenSymphony
The "old" authentication system, which was the default prior to 2.7.

Table "os_group"
Column | Type     | Modifiers
--------+----------+-----------
id     | bigint   | not null  
groupname | character varying(255) | not null  
Indexes:
"os_group_pkey" PRIMARY KEY, btree (id)
"os_group_groupname_key" UNIQUE, btree (groupname)
Content

The actual information that users are storing and sharing.

attachmentdata: stores the binary data for attached files.
Only used when Confluence is configured to store attachments in the database; otherwise, attachments are stored in the local filesystem.
Table "attachments"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>attachmentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>filesize</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>attachment_comment</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>attversion</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "attachments_pkey" PRIMARY KEY, btree (attachmentid)
- "att_pageid_idx" btree (pageid)
- "att_prevver_idx" btree (prevver)

Foreign-key constraints:
- "fk54475f9017d4a070" FOREIGN KEY (prevver) REFERENCES attachments(attachmentid)
- "fk54475f908c38fbae" FOREIGN KEY (pageid) REFERENCES content(contentid)

bodycontent: stores the actual content of Confluence pages. No versioning information or other metadata is stored here, though; that's all in the content table.

Table "bodycontent"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>bodycontentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>body</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "bodycontent_pkey" PRIMARY KEY, btree (bodycontentid)
- "body_content_idx" btree (contentid)

Foreign-key constraints:
- "fka898d4778dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

content: a persistence table for the ContentEntityObject class of objects. The subclass is indicated by the contenttype column.
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>version</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>versioncomment</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>content_status</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>parentid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>messageid</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftpageid</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftspacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>drafttype</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>draftpageversion</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>parentcommentid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:

- "content_pkey" PRIMARY KEY, btree (contentid)
- "c_draftpageid_idx" btree (draftpageid)
- "c_draftspacekey_idx" btree (draftspacekey)
- "c_drafttype_idx" btree (drafttype)
- "c_messageid_idx" btree (messageid)
- "c_parentcommentid_idx" btree (parentcommentid)
- "c_parentid_idx" btree (parentid)
- "c_prevver_idx" btree (prevver)
- "c_spaceid_idx" btree (spaceid)
- "c_title_idx" btree (title)
- "c_username_idx" btree (username)

Foreign-key constraints:

- "fk6382c05917d4a070" FOREIGN KEY (prevver) REFERENCES content(contentid)
- "fk6382c05974b18345" FOREIGN KEY (parentid) REFERENCES content(contentid)
- "fk6382c059838f5ea" FOREIGN KEY (pageid) REFERENCES content(contentid)
- "fk6382c059b266801" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)
- "fk6382c059b97e9230" FOREIGN KEY (parentcommentid) REFERENCES content(contentid)

content_label: Arbitrary text labels for content.
### Table "content_label"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>labelid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>owner</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "content_label_pkey" PRIMARY KEY, btree (id)
- "cl_contentid_idx" btree (contentid)
- "cl_labelid_idx" btree (labelid)
- "cl_lastmoddate_idx" btree (lastmoddate)
- "cl_spacekey_idx" btree (spacekey)

Foreign-key constraints:
- "fkf0e7436e27072aef" FOREIGN KEY (labelid) REFERENCES label(labelid)
- "fkf0e7436e8dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

**label**: the other half of the **content_label** system.

### Table "label"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>labelid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>name</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>owner</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>namespace</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "label_pkey" PRIMARY KEY, btree (labelid)
- "l_name_idx" btree (name)
- "l_namespace_idx" btree (namespace)
- "l_owner_idx" btree ("owner")

**content_perm**: content-level permissions objects.
Table "content_perm"

| Column    |            Type             | Modifiers |
|-----------|-----------------------------+-----------|
| id        | bigint                      | not null  |
| cp_type   | character varying(10)      | not null  |
| username  | character varying(255)     |           |
| groupname | character varying(255)     |           |
| cps_id    | bigint                      |           |
| creator   | character varying(255)     |           |
| creationdate | timestamp without time zone |           |
| lastmodifier | character varying(255)   |           |
| lastmoddate | timestamp without time zone |           |

Indexes:
"content_perm_pkey" PRIMARY KEY, btree (id)
"cp_gn_idx" btree (groupname)
"cp_os_idx" btree (cps_id)
"cp_un_idx" btree (username)

Foreign-key constraints:
"fkbd74b31676e33274" FOREIGN KEY (cps_id) REFERENCES content_perm_set(id)

content_perm_set: one-to-many mapping for content items and their permissions, with added metadata.

Table "content_perm_set"

| Column     |            Type             | Modifiers |
|------------|-----------------------------+-----------|
| id         | bigint                      | not null  |
| cont_perm_type | character varying(10)      | not null  |
| content_id | bigint                      |           |
| creationdate | timestamp without time zone |           |
| lastmoddate | timestamp without time zone |           |

Indexes:
"content_perm_set_pkey" PRIMARY KEY, btree (id)
"cps_content_idx" btree (content_id)

Foreign-key constraints:
"fkbf45a7992caf22c1" FOREIGN KEY (content_id) REFERENCES content(contentid)

Clustering

clustersafety: normally, this table only contains one row. The value of the safetynumber is what Confluence uses to find out whether another instance is sharing its database without being part of the cluster.

Table "clustersafety"

| Column       |  Type   | Modifiers |
|--------------|---------+-----------|
| clustersafetyid | bigint  | not null  |
| safetynumber  | integer |           |

Indexes:
"clustersafety_pkey" PRIMARY KEY, btree (clustersafetyid)

System information
**confversion** used by the upgrade system to determine what to expect from the database, so as to negotiate upgrades.

<table>
<thead>
<tr>
<th>Table &quot;confversion&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>confversionid</td>
</tr>
<tr>
<td>buildnumber</td>
</tr>
<tr>
<td>installdate</td>
</tr>
<tr>
<td>versiontag</td>
</tr>
<tr>
<td>creationdate</td>
</tr>
<tr>
<td>lastmoddate</td>
</tr>
</tbody>
</table>

Indexes:
- "confversion_pkey" PRIMARY KEY, btree (confversionid)
- "confversion_buildnumber_key" UNIQUE, btree (buildnumber)

**plugindata**: records which plugins have been installed, and when.

**data** is a blob of the actual plugin .jar file. This is principally cluster-related.

<table>
<thead>
<tr>
<th>Table &quot;plugindata&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>plugindataid</td>
</tr>
<tr>
<td>pluginkey</td>
</tr>
<tr>
<td>filename</td>
</tr>
<tr>
<td>lastmoddate</td>
</tr>
<tr>
<td>data</td>
</tr>
</tbody>
</table>

Indexes:
- "plugindata_pkey" PRIMARY KEY, btree (plugindataid)
- "plugindata_filename_key" UNIQUE, btree (filename)
- "plugindata_pluginkey_key" UNIQUE, btree (pluginkey)

**Spaces**

**spacegroups**: this table is only used by the hosted environment.

<table>
<thead>
<tr>
<th>Table &quot;spacegroups&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
</tr>
<tr>
<td>spacegroupid</td>
</tr>
<tr>
<td>spacegroupname</td>
</tr>
<tr>
<td>spacegroupkey</td>
</tr>
<tr>
<td>licensekey</td>
</tr>
<tr>
<td>creator</td>
</tr>
<tr>
<td>creationdate</td>
</tr>
<tr>
<td>lastmodifier</td>
</tr>
<tr>
<td>lastmoddate</td>
</tr>
</tbody>
</table>

Indexes:
- "spacegroups_pkey" PRIMARY KEY, btree (spacegroupid)
- "spacegroups_spacegroupkey_key" UNIQUE, btree (spacegroupkey)
Table "spacepermissions"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>permid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>permtype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>permgroupname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>permusername</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "spacepermissions_pkey" PRIMARY KEY, btree (permid)
- "sp_permtype_idx" btree (permtype)
- "sp_pgname_idx" btree (permgroupname)
- "sp_puname_idx" btree (permusername)
- "sp_spaceid_idx" btree (spaceid)

Foreign-key constraints:
- "fk33f23beb2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)

spaces: information about the spaces themselves: key, human-friendly name and numeric ID.

Table "spaces"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacename</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>spacedescid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>homepage</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>spacetype</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>spacegroupid</td>
<td>bigint</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "spaces_pkey" PRIMARY KEY, btree (spaceid)
- "spaces_spacekey_key" UNIQUE, btree (spacekey)
- "s_homepage_idx" btree (homepage)
- "s_spacedescid_idx" btree (spacedescid)
- "s_spacegroupid_idx" btree (spacegroupid)

Foreign-key constraints:
- "fk9228242d11b7bfee" FOREIGN KEY (homepage) REFERENCES content(contentid)
- "fk9228242d16994414" FOREIGN KEY (spacegroupid) REFERENCES spacegroups(spacegroupid)
- "fk9228242d2c72d3d2" FOREIGN KEY (spacedescid) REFERENCES content(contentid)

Appearance
decorator: storage of custom display templates, for customising layouts.

Table "decorator"
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>decoratorid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>spacekey</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>decoratorname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>body</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "decorator_pkey" PRIMARY KEY, btree (decoratorid)
- "dec_key_idx" btree (spacekey)
- "dec_name_idx" btree (decoratorname)

Miscellaneous

os_propertyentry: for arbitrary association of entities and properties.

Table "os_propertyentry"
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>entity_name</td>
<td>character varying(125)</td>
<td>not null</td>
</tr>
<tr>
<td>entity_id</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>entity_key</td>
<td>character varying(200)</td>
<td>not null</td>
</tr>
<tr>
<td>key_type</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>boolean_val</td>
<td>boolean</td>
<td></td>
</tr>
<tr>
<td>double_val</td>
<td>double precision</td>
<td></td>
</tr>
<tr>
<td>string_val</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>text_val</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>long_val</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>int_val</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>date_val</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "os_propertyentry_pkey" PRIMARY KEY, btree (entity_name, entity_id, entity_key)

bandana: a catch-all persistence layer. It contains things like user settings and space- and global-level configuration data, and is used as storage by plugins such as the Dynamic Task List plugin. Essentially, for storing arbitrary data that doesn't fit anywhere else.

Table "bandana"
<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>bandanaid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>bandanacontext</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>bandanakey</td>
<td>character varying(100)</td>
<td></td>
</tr>
<tr>
<td>bandanavalue</td>
<td>text</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "bandana_pkey" PRIMARY KEY, btree (bandanaid)
- "band_context_idx" btree (bandanacontext)
- "band_key_idx" btree (bandanakey)
**extrnlnks:** storage of referral links.

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>viewcount</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>url</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "extrnlnks_pkey" PRIMARY KEY, btree (linkid)
- "el_contentid_idx" btree (contentid)

**hibernate_unique_key:** used by the high/low ID generator - the subsystem which generates our primary keys.

Mess with this at the cost of being able to create objects.

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>next_hi</td>
<td>integer</td>
<td></td>
</tr>
</tbody>
</table>

**indexqueueentries:** arbitrates full-content indexing across the system.

This table generally contains the last 12 hours or so of updates, to allow re-syncing of cluster nodes after restarts.

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>entryid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>type</td>
<td>integer</td>
<td></td>
</tr>
<tr>
<td>handle</td>
<td>character varying(255)</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "indexqueueentries_pkey" PRIMARY KEY, btree (entryid)

**keystore:** used by the trusted apps framework to store the server’s private key, and other servers' public keys.
Table "keystore"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>keyid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>alias</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>type</td>
<td>character varying(32)</td>
<td>not null</td>
</tr>
<tr>
<td>algorithm</td>
<td>character varying(32)</td>
<td>not null</td>
</tr>
<tr>
<td>keyspec</td>
<td>text</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
"keystore_pkey" PRIMARY KEY, btree (keyid)

links: tracks links within the server (i.e. across and within spaces).

Table "links"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>destpagetitle</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>destspacekey</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
"links_pkey" PRIMARY KEY, btree (linkid)
"l_contentid_idx" btree (contentid)
"l_destspacekey_idx" btree (destspacekey)

Foreign-key constraints:
"fk45157998dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

notifications: storage of page- and space-level watches.
### Table "notifications"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>notificationid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>pageid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>username</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "notifications_pkey" PRIMARY KEY, btree (notificationid)
- "n_pageid_idx" btree (pageid)
- "n_spaceid_idx" btree (spaceid)

Foreign-key constraints:
- "fk594acc88c38fbea" FOREIGN KEY (pageid) REFERENCES content(contentid)
- "fk594acc8b2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)

**pagetemplates**: acts as the back-end of the templates feature.

### Table "pagetemplates"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>templateid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>templatename</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>templatedesc</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>labels</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>content</td>
<td>text</td>
<td></td>
</tr>
<tr>
<td>spaceid</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>prevver</td>
<td>bigint</td>
<td></td>
</tr>
<tr>
<td>version</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "pagetemplates_pkey" PRIMARY KEY, btree (templateid)
- "pt_prevver_idx" btree (prevver)
- "pt_spaceid_idx" btree (spaceid)

Foreign-key constraints:
- "fkbc7ce96a17d4a070" FOREIGN KEY (prevver) REFERENCES pagetemplates(templateid)
- "fkbc7ce96ab2dc6081" FOREIGN KEY (spaceid) REFERENCES spaces(spaceid)
### Table "trackbacklinks"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>linkid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>contenttype</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>viewcount</td>
<td>integer</td>
<td>not null</td>
</tr>
<tr>
<td>url</td>
<td>character varying(255)</td>
<td>not null</td>
</tr>
<tr>
<td>title</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>blogname</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>excerpt</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>contentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>creator</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>creationdate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
<tr>
<td>lastmodifier</td>
<td>character varying(255)</td>
<td></td>
</tr>
<tr>
<td>lastmoddate</td>
<td>timestamp without time zone</td>
<td></td>
</tr>
</tbody>
</table>

Indexes:
- "trackbacklinks_pkey" PRIMARY KEY, btree (linkid)
- "tbl_contentid_idx" btree (contentid)

Foreign-key constraints:
- "fkf6977a478dd41734" FOREIGN KEY (contentid) REFERENCES content(contentid)

confancestors: used to speed up permissions checks, by allowing quick lookup of all a page's ancestors.

### Table "confancestors"

<table>
<thead>
<tr>
<th>Column</th>
<th>Type</th>
<th>Modifiers</th>
</tr>
</thead>
<tbody>
<tr>
<td>descendentid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>ancestorid</td>
<td>bigint</td>
<td>not null</td>
</tr>
<tr>
<td>ancestorposition</td>
<td>integer</td>
<td>not null</td>
</tr>
</tbody>
</table>

Indexes:
- "confancestors_pkey" PRIMARY KEY, btree (descendentid, ancestorposition)

Foreign-key constraints:
- "fk9494e23cc45e94dc" FOREIGN KEY (descendentid) REFERENCES content(contentid)
- "fk9494e23c37e35a2e" FOREIGN KEY (ancestorid) REFERENCES content(contentid)

### Finding Unused Spaces

Sometimes, you want to know what is not being used. It's great to know what's getting most attention, but what about stagnant pages, or even entire spaces that are no longer active?

While viewing space activity can provide hints, it doesn't always provide enough detail. The simple way is to go directly to the database. We recommend DbVisualizer, and have basic instructions for connecting it to HSQLDB.

The following query identifies the last date on which content was modified in each space within a single Confluence instance:
It returns a list of spacenames, and the last date and time at which any content was added or changed.

```
SELECT spaces.spacename, MAX(content.lastmoddate)
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY spaces.spacename;
```

It's also possible to present the information in a wiki page, using the SQL plugin, which can be installed using the Plugin Exchange. You'll also need to define a database resource in `conf/server.xml` and `confluence/WEB-INF/web.xml`, as described here. Having done so, you can use wiki markup code like the following, replacing `confluenceDS` with the name of your own local datasource:

```
### Space activity
{sql:dataSource=confluenceDS|output=wiki}
SELECT spaces.spacename AS Space, MAX(content.lastmoddate) AS LastModified
FROM content, spaces
WHERE content.spaceid = spaces.spaceid
GROUP BY Space;
{sql}
```

The result will be something like this:

<table>
<thead>
<tr>
<th>space</th>
<th>lastmodified</th>
</tr>
</thead>
<tbody>
<tr>
<td>Private Space</td>
<td>2007-10-11 11:34:04.914</td>
</tr>
</tbody>
</table>

You can try the Chart plugin in combination with the SQL plugin to give more visually attractive results.

**Data Import and Export**

Confluence administrators and users can import data into Confluence from a number of sources. The permissions required differ, depending on the scope of the import. See Importing Content Into Confluence.

You can also export Confluence content to various formats. See Exporting Confluence Pages and Spaces to Other Formats.
Configuring a Confluence Environment

This section describes the external setup of your Confluence installation. It includes information on configuring the web server, application server, directories and files – everything to do with the environment that Confluence runs in. For guidelines on modifying settings inside the application, see Configuring Confluence instead.

Confluence is a J2EE web application. On the client side, users access Confluence primarily via a web browser. For a list of important files on the server side, see Important Directories and Files.

This section contains the following guidelines:

- Important Directories and Files
- Application Server Configuration
- Web Server Configuration
- Starting Confluence Automatically on System Startup

Diagram: A Confluence installation

Important Directories and Files

The Installation Directory

The 'Confluence installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data
in this directory. This directory is also sometimes called the ‘Confluence Install directory’.

**Important Files and Directories**

- **confluence/WEB-INF/classes/confluence-init.properties**: This file tells Confluence where to find the Confluence Home Directory. This file is modified by the administrator when installing Confluence.
- **confluence/WEB-INF/classes/osuser.xml**: This file is modified when connecting Confluence to an external user management system such as an LDAP server or JIRA instance in Confluence 2.0 and earlier. For more information, refer to Managing Confluence Users.
- **confluence/WEB-INF/classes/atlassian-user.xml**: This file is modified when connecting Confluence to an external user management system such as an LDAP server or Crowd. For more information, refer to Managing Confluence Users.
- **confluence/WEB-INF/lib/**: This directory is used when deploying plugins, especially those plugins that cannot automatically be loaded through the Administration Console.
- **confluence/WEB-INF/classes/log4j.properties**: Confluence's logging configuration file. See Working with Confluence Logs.
- **confluence/WEB-INF/classes/ehcache.xml**: This is where you can configure the size of Confluence's internal caches
- **confluence/WEB-INF/classes/styles/site-css.vm**: Confluence's main stylesheet, modify at your own risk
- **conf/server.xml**: SSL configuration.

**Memory Settings**
The file used to edit JAVA_OPTS memory settings will depend on the method used to install Confluence, as well as the operating system used for your installation.

- **Windows Users**
  - Confluence — bin/setenv.bat
  - Confluence Installer — wrapperwin32.conf
- **Mac/Linux Users**
  - Confluence — bin/setenv.sh
  - Confluence Installer — wrapperosx.conf

⚠️ The information on this page does not apply to Confluence OnDemand.

**The Temp Directory**
The temp directory is configured in the Java runtime and some Confluence components write temporary files or lockfiles into this directory.

For EAR/WAR installations typically, this directory is /tmp on Linux systems, or C:\Temp on Windows.

For Standalone installations the temp directory is located in the installation directory as /temp.

To change the location of this directory, start the Java Virtual Machine in which confluence is running with the argument:

-Djava.io.tmpdir=/path/to/your/own/temp/directory.

**The Confluence Home Directory**
The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'.

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Administrators can expect the Confluence Home Directory to grow quite large in a busy site.

The location of this directory is configured by the system administrator during installation (see confluence-in it.properties above).

**Important Files and Directories**

- **confluence.cfg.xml**: Confluence's core configuration file; includes the configuration for connecting to its database.
- **default-formatting.properties**: Some auxiliary configuration data concerning default number and date formats.
- **attachments/**: All file attachments in the Confluence site are stored under this directory. This is the only place Confluence keeps attachment files.
- **backups/**: If Confluence is configured to produce daily backups, these are kept in this directory. Administrators should occasionally delete old or unwanted backups from this directory to prevent it from growing too large.
- **config/**: Miscellaneous global and per-space configuration files are kept in this directory.
- **database/**: If Confluence is being run from the embedded HSQL database, the database files will be kept in this directory.
- **index/**: The full-text search index is kept in this directory. Removing or modifying files in this directory may cause search to no longer function. Rebuilding the search index from Confluence's global administration screen will completely regenerate the contents of this directory.
- **plugins/**: Dynamically uploaded plugins are stored in this directory. Administrators can install new plugins by copying them into this directory and triggering a scan from the plugin management page.
- **temp/**: Confluence stores temporary files in this directory, especially during backups and exports. A daily job within Confluence deletes files that are no longer needed.
- **thumbnails/**: Stores temporary files for image thumbnails. The contents of this directory can be safely deleted, as Confluence will regenerate thumbnails as required.
- **velocity/**: Storage for customised page layouts, globally and per-space.

**Database**

All other data — page contents, links, archived mail and so on — is kept in the database. If you have configured Confluence to use the embedded HSQL database, the database will store its files under database/ in the Confluence Home Directory. Otherwise, the database management system you are connecting to is responsible for where and how your remaining data is stored.

**Tip**

All of Confluence's persistent data is stored either in the Confluence Home Directory, or the database. If you have backup copies of both of these, taken at the same time, you will be able to restore Confluence from them (see Restoring Data from other Backups).

**RELATED TOPICS**

Confluence Home Directory
Confluence Installation Directory
The Embedded HSQLDB Database
Database Configuration

Often in the documentation, you’ll see a reference to the ‘Confluence Home directory’.
What is the Confluence Home Directory?

The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'.

The information on this page does not apply to Confluence OnDemand.

Finding the Confluence Home Directory

The location of the Confluence Home directory is defined when you install Confluence. This location is stored in a configuration file called confluence-init.properties, which is located inside the confluence/WEB-INF/classes directory in your Confluence Installation directory.

When Confluence first starts up, it reads the confluence-init.properties file to determine where to look for the Home directory.

Once Confluence is running you can find the Confluence Home directory via the Administration console, under Administration > System Information > Confluence Information - Confluence Home.

Content of the Confluence Home Directory

The Confluence home directory contains some of the configuration data used by Confluence. Other data is stored in the database. This section outlines the purpose of the files and directories in the Confluence home directory.

confluence.cfg.xml

This file contains all of the information necessary for Confluence to start up, such as:

- Product license
- Context path
- Database details, such as location and connection pool settings
- Paths to important directories

attachments

This directory contains every version of each attachment stored in Confluence. This directory is not used when Confluence is configured to store attachments in the database. Attachments are always stored in the database in clustered instances of Confluence.

Since Confluence 3.0, the directory structure has been defined by the Hierarchical File System Attachment Storage method.

For versions before Confluence 3.0, paths within this directory had the following structure:

/attachments/PAGE_ID/ATTACHMENT_ID/VERSION

You can specify an alternative directory for attachment storage by setting the attachments.dir property in confluence.cfg.xml.

backups

Confluence will place its daily backup archives in this directory, as well as any manually generated backups. Backup files in this directory take the following form:
You can specify an alternative directory for backups by setting the `daily.backup.dir` property in `confluence.cfg.xml`.

### bundled-plugins

Confluence ships with a set of bundled plugins. These are plugins written by the Atlassian and the Confluence community that we think provide useful and broadly applicable functionality in Confluence. The `bundled-plugins` directory is where Confluence will unpack its bundled plugins when it starts up. This directory is refreshed on every restart, so removing a plugin from this directory will not uninstall the plugin. It will simply be replaced the next time Confluence starts up.

### database

This is where Confluence stores its database when configured to run with the HSQL embedded database. In such cases this directory contains all Confluence runtime data. Installations configured to run using an external database such as MySQL will not use this directory.

### index

This is where Confluence stores its indexes for rapid retrieval of often used data. The Confluence index is used heavily by the application for content searching and recently updated lists and as such is critical for a running Confluence instance. It is important to note however that should the data in this directory be lost or corrupted, it can be restored by running a full reindex from within Confluence. This can take a long time depending on how much data is stored Confluence’s database.

An alternative directory may be specified for the index by setting the `lucene.index.dir` property in `confluence.cfg.xml`. As this is the most heavily accessed directory in the Confluence home directory you might want to consider hosting it on the fastest disk available. It would also be useful if the disk holding the Confluence index was not heavily used by any other application to reduce access contention.

### plugin-cache

All Confluence plugins are stored in the Confluence database. To allow for quicker access to classes contained within the plugin JARs, Confluence will cache these plugins in the `plugin-cache` directory. This directory is updated as plugins are installed and uninstalled from the system and is completely repopulated from the database every time Confluence is restarted. Removing plugins from this directory does not uninstall them.

### resources

The `resources` directory stores any space logos used in your Confluence instance. For each space with a space logo, there is a directory within `resources` named after the space’s key. That directory contains the space’s logo.

### temp

The `temp` directory is used for various runtime functions such as exporting, importing, file upload and indexing. As the name suggests, and file in this directory is of temporary importance and is only used during runtime. This directory can be safely emptied when Confluence is offline.

An alternative directory may be specified for temporary data by setting the `webwork.multipart.saveDir` property in `confluence.cfg.xml`.

### thumbnails
When Confluence generates a thumbnail of an image (for example when the gallery macro is used), the resulting thumbnail is stored in this directory for quicker retrieval on subsequent accesses. This directory is essentially a thumbnail cache, and deleting files from this directory simply means the thumbnail will have to be regenerated on the next access.

RELATED TOPICS

Confluence Installation Directory
Important Directories and Files
The Embedded HSQLDB Database
Confluence Installation Directory

The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

⚠️ The information on this page does not apply to Confluence OnDemand.

RELATED TOPICS

Confluence Home Directory
Important Directories and Files

Application Server Configuration

The following pages contain information about configuring your application server for Confluence:
- Configuring URL Encoding on Tomcat Application Server
- Managing Application Server Memory Settings
- Switching to Apache Tomcat
- Java Policy Settings for Enterprise or Webhosting Environments

Configuring URL Encoding on Tomcat Application Server

Application servers may have different settings for character encodings. We strongly recommend UTF-8 where possible.

By default, Tomcat uses ISO-8859-1 character encoding when decoding URLs received from a browser. This can cause problems when Confluence's encoding is UTF-8, and you are using international characters in the names of attachments or pages.

To configure the URL encoding in Tomcat:

1. Edit conf/server.xml and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   <Connector port="8090"/>

2. Add a URIEncoding="UTF-8" property to the connector:

   <Connector port="8090" URIEncoding="UTF-8"/>

3. Restart Tomcat

If you are using mod_jk

You should apply the same URIEncoding parameter as above to the AJP connector if you are using mod_jk, and add the following option to your Apache mod_jk configuration:
More information using Apache with Tomcat

For comprehensive examples of how to use Tomcat and Apache with Confluence, see Running Confluence behind Apache.

Managing Application Server Memory Settings

The minimum and maximum JVM heap space allocated to the application server affects performance. Confluence administrators may wish to modify this value from the defaults depending on their server load. This document only provides guidelines rather than rules, so administrators optimising for performance should use this document as a starting point only.

Testing For Optimum Memory Settings

In the general case, both JIRA & Confluence users will benefit from setting the minimum and maximum values identical. In larger installations, there is benefit to memory tuning, if there is a perceived performance issue. If you are experiencing Out of Memory Heap errors, try increasing the -Xmx and -Xms values for your installation to see if this resolves or helps resolve your issue. It's best to increase in small increments (eg 512mb at a time), to avoid having too large a heap, which can cause different problems. If increasing the memory does not help, please lodge a support ticket as there may be other factors contributing.

Memory usage is most likely to be maximised under peak load, and when creating a site XML backup. In many cases, the backup can be the cause of the OOM, so increase -Xmx values and verify if a backup was occurring at the time of OOM. A quick rule of thumb for gauging the success of a memory adjustment is using simple anecdotal evidence from users. Is it snappier? The same? How does it handle while a backup is occurring?

Atlassian recommends in normal use, to disable the XML backup and use a Production Backup Strategy.

- If you normally perform manual XML site backups on your server, test your maximum memory requirements by performing a site XML backup while the server is under maximum load
- If you do not create manual XML site backups, simply monitor the server while under maximum load

Applying Memory Settings

See How to Fix Out of Memory Errors by Increasing Available Memory.

Related Topics

- Garbage Collector Performance Issues
- How to Fix Out of Memory Errors by Increasing Available Memory
- Server Hardware Requirements Guide
- Performance Tuning
- Troubleshooting Slow Performance Using Page Request Profiling
- Tomcat JVM options and Modify the Default JVM Settings
Switching to Apache Tomcat

Apache Tomcat is the only application server supported for Confluence. To move Confluence from an application server (e.g. WebSphere) to Tomcat using the same database, follow the instructions below.

Please note, you cannot simply copy the WAR file or expanded WAR directory from an old Confluence EAR/WAR version in the old application server to Tomcat. **This will not work.**

Follow these instructions:

1. **Before You Start**
2. **Backing Up**
3. **Switching Application Servers**
4. **Applying Customisations**
   - Confluence Server
   - Plugins
   - Look and Feel
   - Performance
   - Advanced Customisations
5. **Testing Confluence**

1. **Before You Start**

1. The following instructions will only work if you are running the same major version of Confluence on both application servers. If you are running different major versions of Confluence, you will need to upgrade Confluence before you can switch to Tomcat.
2. Note that you need current software maintenance, as the process for changing application servers involves installing Confluence or Confluence EAR-WAR.
3. If the environment (e.g. the database system, the operating system and so on) that you are running Confluence in has changed, please ensure it still complies with the Confluence System Requirements.
4. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user login) has sufficient permissions to modify the database schema.
5. Note any customisations that you have made to Confluence, e.g. enabled/installed plugins, modified layouts, custom themes, etc. You will need to reapply these after you have switched to Tomcat. You can view the list of customisations in the Reapplying Customisations section below.
6. We recommend that you do not run any other applications in your Tomcat application server that is running Confluence, to prevent performance issues.

2. **Backing Up**

Before you switching to Tomcat, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored this directory.
   
   Tip: Another term for ‘Home directory’ would be ‘data directory’. The location of the Home directory is stored in a configuration file called confluence-init.properties, which is located inside the confluence/WEB-INF/classes directory in your Confluence Installation directory.
2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade and check that the backup was created properly. If you are not a database expert or unfamiliar with the backup-restore facilities of your database, you should try to restore the backup to a different system to ensure that the backup worked before proceeding. This recommendation is not specific to
Confluence usage, but it is good practice to ensure that your database backup is not broken.

The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes. You don’t need to back it up since it is stored in the home directory. But you should not use this database for production systems anyway, so if you happen to accidentally still use HSQLDB in a production system, please migrate to a proper database before the upgrade.

3. Back up your Confluence installation directory (if you are using Confluence) or your Confluence webapp (if you are using Confluence EAR-WAR edition). The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory also sometimes called the 'Confluence Install directory'.

3. Switching Application Servers

1. Install Confluence on your new application server. We recommend that you install Confluence (from the zip file) as it is preconfigured with Tomcat. If you want more control over the installation process, you can install Confluence EAR-WAR on Tomcat however this requires more manual configuration. Regardless of which method you choose, as part of the installation process:

   • If you are connecting to your database via a standard JDBC connection, enter the URL, username and password for your existing database.
   • If you are connecting to your database via datasource, use the settings for your existing database when you configure the JDBC datasource in your new server. Refer to the appropriate guide below:
     • Configuring a MySQL Datasource in Apache Tomcat
     • Configuring a SQL Server Datasource in Apache Tomcat
     • Configuring a PostgreSQL Datasource in Apache Tomcat

2. Copy the following files from your old Confluence installation to your new one:

   • \{CONFLUENCE_INSTALL\}\confluence\WEB-INF\classes\confluence-init.properties
   • \{CONFLUENCE_INSTALL\}\confluence\WEB-INF\classes\atlassian-user.xml
   • \{CONFLUENCE_INSTALL\}\confluence\WEB-INF\classes\osuser.xml (copy this over if you are using JIRA user management)
   • \{CONFLUENCE_INSTALL\}\confluence\WEB-INF\classes\seraph-config.xml (copy this over if you are using custom SSO)
   • \{CONFLUENCE_INSTALL\}\confluence\WEB-INF\web.xml (copy this over if you have previously modified it, e.g. to configure a datasource)

3. Make sure you shutdown the old server before you startup the new one.

4. If you are running the new application server on a different machine to the old one, carry out the followi actions as soon as you start the new server:

   • Re-index your data.
   • Make sure that the attachments location is valid for the new server.

5. If you have applied special settings to their Confluence server and/or Confluence look and feel, you will need to reapply these customisations as described in below.

4. Applying Customisations

After switching to Tomcat, you need to review any customisations and other special configurations you previously used for your Confluence instance, and re-apply if necessary. This section also contains some Tomcat-specific customisations that you may wish to considering applying, if you haven’t used Confluence with Tomcat before.

⚠️ Before you apply customisations
Please ensure that your Confluence installation works correctly on Tomcat without any customisations before you apply any of customisations listed below. This will make it easier to identify problems, if you run into trouble during the switch to Tomcat.

**Confluence Server**

- For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.
- If you are using the Confluence edition and you have previously defined a CATALINA_HOME environment variable, please check that it points to the correct path for the new Confluence Tomcat server.
- If you were previously running Confluence on a non-standard port, edit your new `<Installation-Directory>`\conf\server.xml file as described in Change listen port for Confluence.

**Plugins**

- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new instance of Confluence. The easiest way to do this is to use the Universal Plugin Manager in the Confluence Administration Console.

**Look and Feel**

- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.
- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here. Please do not just copy your VM (velocity) files across. Ensure that Confluence works without your custom layouts then apply the layout via the Confluence Administration console.

**Performance**

- If the load on your Confluence instance is high, you may need more simultaneous connections to the database. Read more about this in the Performance Tuning guide.
- If you had previously modified the memory flags (Xms and Xmx) in either the `<Installation-Directory>`\bin\setenv.sh or the `<Installation-Directory>`\bin\setenv.bat file, you may want make the modifications in your new installation. The parameters are specified in the JAVA_OPTS variable. See How to Fix Out of Memory Errors by Increasing Available Memory for more information.

**Advanced Customisations**

- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.
- If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.
- If you had changed the Confluence interface text, you will need to copy over the ConfluenceActionSupport.properties file.
- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.

5. Testing Confluence

Make sure you test Confluence on the new server before deploying it in production.

The Working with Confluence Logs document contains the locations for the application logs, if you need to refer to them.

Java Policy Settings for Enterprise or Webhosting Environments
Confluence relies on a number of Java libraries. Some of these libraries make use of features of the Java language that may be restricted by Java security policies.

This does not normally cause any problems. The default security configuration of most application servers will happily run Confluence. However, in some shared-hosting or enterprise environments, security settings may be such that Confluence cannot function.

When you attempt to run Confluence, you may get the following error:

```
java.security.AccessControlException: access denied (java.lang.RuntimePermission accessDeclaredMembers)
at java.security.AccessControlContext.checkPermission(AccessControlContext.java(Compiled Code))
at java.security.AccessController.checkPermission(AccessController.java(Compiled Code))
at java.lang.SecurityManager.checkPermission(SecurityManager.java(Compiled Code))
```

The permissions required by Confluence to run are detailed in the sample policy file below. You may need to give this information to your systems administrator so that they can be deployed with the Confluence application.

```
grant codeBase "file:${catalina.home}/webapps/confluence/-" {
    permission java.security.AllPermission;
};
grant {
    permission java.lang.RuntimePermission "accessDeclaredMembers";
    permission java.lang.reflect.ReflectPermission "suppressAccessChecks";
    permission java.lang.RuntimePermission "defineCGLIBClassInJavaPackage";
};
```

Web Server Configuration

- Configuring Web Proxy Support for Confluence
- Running Confluence behind Apache
  - General Apache Configuration Notes
  - Using Apache with mod_proxy
  - Using Apache with virtual hosts and mod_proxy
  - Using Apache with mod_jk
  - Using mod_rewrite to Modify Confluence URLs
  - Configuring Apache to Cache Static Content via mod_disk_cache

Configuring Web Proxy Support for Confluence

Some of Confluence's macros, such as `{rss}` and `{jiraissues}` need to make web requests to remote servers in order to retrieve data. If Confluence is deployed within a data centre or DMZ, it may not be able to access the Internet directly to make these requests. If you find that the `{rss}` macro does not work, ask your network administrator if Confluence needs to access the Internet through a web proxy.

Configuring an outbound HTTP proxy in Confluence
Proxy support is configured by passing certain system properties to the Java Virtual Machine on startup. These properties follow the conventions defined by Oracle:

- http.proxyHost
- http.proxyPort (default: 80)
- http.nonProxyHosts (default: <none>)

At a minimum, you need to define http.proxyHost to configure an HTTP proxy. System property configuration is described in the Configuring System Properties.

Properties http.proxyHost and http.proxyPort indicate the proxy server and port that the http protocol handler will use.

```
-Dhttp.proxyHost=proxy.example.org -Dhttp.proxyPort=8080
```

Property http.nonProxyHosts indicates the hosts which should be connected to directly and not through the proxy server. The value can be a list of hosts, each separated by a pipe character | . In addition, a wildcard character (asterisk) * can be used for matching. For example:

```
-Dhttp.nonProxyHosts=*.foo.com|localhost
```

Note: You may need to escape the pipe character | in some command-line environments.

If the http.nonProxyHosts property is not configured, all web requests will be sent to the proxy.

Please note that any command line parameters set are visible from the process list, and thus anyone who has the appropriate access to view the process list will see the proxy information in the clear. To avoid this, you can set these properties in the catalina.properties file, located in `confluence-install/conf/`. Add this to the end of the file:

```
http.proxyHost=yourProxyURL
http.proxyPort=yourProxyPort
http.proxyUser=yourUserName
http.proxyPassword=yourPassword
```

### Configuring HTTP proxy authentication

Proxy authentication is also configured by providing system properties to Java in your application server’s configuration file. Specifically, the following two properties:

- http.proxyUser – username
- http.proxyPassword – secret

#### HTTP proxy (Microsoft ISA) NTLM authentication

Confluence supports NTLM authentication for outbound HTTP proxies when Confluence is running on a Windows server.

This means that the {rss} and {jiraissues} macro will be able to contact external websites if requests have to go through a proxy that requires Windows authentication. This support is not related to logging in Confluence users automatically with NTLM, for which there is a user-contributed authenticator available.
To configure NTLM authentication for your HTTP proxy, you need to define a domain system property, `http.auth.ntlm.domain`, in addition to the properties for host, port and username mentioned above:

```
-Dhttp.auth.ntlm.domain=MYDOMAIN
```

Configuring authentication order

Sometimes multiple authentication mechanisms are provided by an HTTP proxy. If you have proxy authentication failure messages, you should first check your username and password, then you can check for this problem by examining the HTTP headers in the proxy failure with a packet sniffer on the Confluence server. (Describing this is outside the scope of this document.)

To set the order for multiple authentication methods, you can set the system property `http.proxyAuth` to a comma-separated list of authentication methods. The available methods are: ntlm, digest and basic; this is also the default order for these methods.

For example, to attempt Basic authentication before NTLM authentication, and avoid Digest authentication entirely, you can set the `http.proxyAuth` property to this value:

```
-Dhttp.proxyAuth=basic,ntlm
```

Troubleshooting

1. There's a diagnostic jsp file in CONF-9719 for assessing the connection parameters.
2. ‘Status Code [407]’ errors are described in APR-160.
3. Autoproxies are not supported. See CONF-16941.

Running Confluence behind Apache

This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Introduction

For improved performance in high-load environments, you should run Confluence behind a web server. In general, web server caching and thread management is far superior to that provided by your application server’s HTTP interface.

To run Confluence behind the Apache httpd web server, there are two main configuration options: mod_jk or mod_proxy.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Features</th>
</tr>
</thead>
</table>
| mod_proxy (also known as reverse proxy) | • recommended connection method  
• simple HTTP proxy to application server  
• works with all application servers  
• if application paths are consistent, there is minimal load on the web server |
### mod_jk (also known as AJP)

- uses the AJP binary protocol
- provides failover (and load balancing, which Confluence supports only with a clustered license)
- only works with some application servers (typically Tomcat)
- if application paths are consistent, there is some load on the web server to translate requests to AJP

<table>
<thead>
<tr>
<th>Features common to both mod_proxy and mod_jk</th>
</tr>
</thead>
<tbody>
<tr>
<td>• application paths must be consistent to avoid complex and slow URL rewriting</td>
</tr>
<tr>
<td>• works with name-based virtual hosting, both on web server and app server</td>
</tr>
<tr>
<td>• web server keeps a pool of connections to application server</td>
</tr>
</tbody>
</table>

**Using mod_proxy**

- Using Apache with mod_proxy is the main documentation for this configuration.
- If you want to set up the common configuration of JIRA and Confluence virtual hosts, you can use Apache 's virtual hosts with separate application servers.

**Using mod_jk**

- Using Apache with mod_jk is the main documentation for this configuration.
- You can follow a similar method to the mod_proxy documentation above for setting up virtual hosts in Apache and Tomcat, if required.

**Mod_jk2 not supported**

The misleadingly-named mod_jk2 is an older method of connecting to Tomcat from Apache. Since mod_jk2 is no longer supported by the Apache Foundation, we do not support this configuration, and are not updating our mod_jk2 documentation. Mod_jk2 also has unresolved problems with Unicode URLs; you need to use either mod_proxy or mod_jk for international characters to work correctly in Confluence.

**Caching static content via mod_disk_cache**

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

**Other related documentation**

- Configuring Tomcat's URI encoding
- Running Confluence Over SSL or HTTPS
- General Apache Configuration Notes

**On this page:**

- Prefer Apache mod_deflate to Confluence's built-in gzip implementation
- Ensure keepalive is enabled
- Enable keepalive for recent MSIE user agents

**Prefer Apache mod_deflate to Confluence's built-in gzip implementation**

1. Disable gzip in confluence. See Compressing an HTTP Response within Confluence.
2. Enable gzip compression in Apache. For RedHat distributions this can be achieved by adding the
following lines:

```
AddOutputFilterByType DEFLATE text/html text/plain text/xml text/css application/x-javascript

# ensure sensible defaults
DeflateBufferSize 8192
DeflateCompressionLevel 4
DeflateMemLevel 9
DeflateWindowSize 15
```

Ensure keepalive is enabled

```
KeepAlive On
```

Enable keepalive for recent MSIE user agents

The standard Apache SSL configuration is very conservative when it comes to MSIE and SSL. By default all keepalives are disabled when using HTTPS with MSIE. While MSIE will always be special, the issues with SSL and MSIE have been solved since Service Pack 2 for Windows XP, released over 4 years ago. For anyone using an XP machine SP2 or above, it is safe to allow keepalive for MSIE 6 and above.

Remove the following lines:

```
SetEnvIf User-Agent ".*MSIE.*" \  
nokeepalive ssl-unclean-shutdown \  
downgrade-1.0 force-response-1.0
```

Add these in their place:

```
BrowserMatch "MSIE [1-5]" nokeepalive ssl-unclean-shutdown downgrade-1.0 force-response-1.0
BrowserMatch "MSIE [6-9]" ssl-unclean-shutdown
```

RELATED TOPICS

Running Confluence behind Apache
Configuring Tomcat's URI encoding
Running Confluence Over SSL or HTTPS
Using Apache with mod_proxy

This page describes how to integrate Confluence into an Apache website using mod_proxy.

There are some common situations where you might use the configuration:

- You have an existing Apache-based website, and want to add Confluence to the mix (for example, http://www.example.com/confluence).
- You have two or more Java applications, each running in their own application server on different ports, for example, http://example:8090/confluence and http://example:8080/jira. By setting up Apache with mod_proxy, you can have both available on the regular HTTP port (80) – for example, at http://www.example.com/confluence and http://www.example.com/jira. This allows each application to be restarted, managed and debugged separately.
**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

**Base configuration**

In these examples, we use the following:

- **http://www.example.com/confluence** - your intended URL
- **http://example:8090** - the hostname and port Confluence is currently installed to
- **/confluence** - the intended context path (the part after hostname and port)

Please substitute the examples below with your intended URL's in your own server. Copy/pasting these suggestions will not work on your server.

**Set the context path**

Set your Confluence application path (the part after hostname and port). To do this in Tomcat (bundled with Confluence), edit `conf/server.xml`, locate the "Context" definition:

```
<Context path="" docBase="..//confluence" debug="0" reloadable="true">
```

and change it to:

```
<Context path="/confluence" docBase="..//confluence" debug="0" reloadable="true">
```

Then restart Confluence, and ensure you can access it at **http://example:8090/confluence**

**Set the URL for redirection**

Set the URL for redirection. In the same `conf/server.xml` file, locate this code segment:

```
<Connector port="8090" maxHttpHeaderSize="8192"
  maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
  enableLookups="false" redirectPort="8443" acceptCount="100"
  connectionTimeout="20000" disableUploadTimeout="true" />
```

And append the last line:

```
<Connector port="8090" maxHttpHeaderSize="8192"
  maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
  enableLookups="false" redirectPort="8443" acceptCount="100"
  connectionTimeout="20000" disableUploadTimeout="true"
  proxyName="www.example.com" proxyPort="80" />
```

If this isn't working for you and you're using SSL, try adding a scheme attribute to your Connector tag: `scheme="https"`. 

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Now we have two options:

- If you want a URL like `http://www.example.com/confluence`, follow the simple configuration.
- If you want a URL like `http://confluence.example.com`, go to the complex configuration.

**Simple Configuration**

Configure mod_proxy

Now enable mod_proxy in Apache, and proxy requests to the application server by adding the example below to your Apache httpd.conf (note: the files may be different on your system; the JIRA docs describe the process for Ubuntu/Debian layout):

```plaintext
# Put this after the other LoadModule directives
LoadModule proxy_module /usr/lib/apache2/modules/mod_proxy.so
LoadModule proxy_http_module /usr/lib/apache2/modules/mod_proxy_http.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
ProxyRequests Off
ProxyPreserveHost On

<Proxy *>
  Order deny,allow
  Allow from all
</Proxy>

ProxyPass /confluence http://www.example.com/confluence
ProxyPassReverse /confluence http://www.example.com/confluence

<Location /confluence>
  Order allow,deny
  Allow from all
</Location>
```

**Note to Windows Users**

It is recommended that you specify the absolute path to the `mod_proxy.so` and `mod_proxy_http.so` files.

**Complex configuration**

Complex configuration involves using the mod_proxy_html filter to modify the proxied content en-route. This is required if the Confluence path differs between Apache and the application server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (Apache) URL</th>
<th><a href="http://confluence.example.com/">http://confluence.example.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

Notice that the application path in the URL is different in each. On Apache, the path is `/`, and on the application server the path is `/confluence`.

For this configuration, you need to install the `mod_proxy_html module`, which is not included in the standard Apache distribution.

Alternative solutions are discussed below.
# Put this after the other LoadModule directives
LoadModule proxy_module modules/mod_proxy.so
LoadModule proxy_http_module modules/mod_proxy_http.so
LoadModule proxy_html_module modules/mod_proxy_html.so

<VirtualHost *>
  ServerName confluence.example.com

    # Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
    ProxyRequests Off
    ProxyPreserveHost On

    <Proxy *>
      Order deny,allow
      Allow from all
    </Proxy>

    ProxyPass / http://app-server.internal.example.com:8090/confluence
    ProxyPassReverse / http://app-server.internal.example.com:8090/confluence

    ProxyHTMLURLMap / /confluence/

    <Location />
      Order allow,deny
      Allow from all
    </Location>

</VirtualHost>

The ProxyHTMLURLMap configuration can become more complex if you have multiple applications running under this configuration. The mapping should also be placed in a Location block if the web server URL is a subdirectory and not on a virtual host. The [Apache Week tutorial](https://www.apache.org/docs/2.4/tutorials/http/ssl.html) has more information how to do this.

**Final Configuration Steps**

**Restart your Apache server**

This is needed to pick up on the new configuration. This can be done by running the following on your command line/terminal/shell:

```
sudo apachectl graceful
```

**Set the Confluence Base URL**

The last stage is to set the Base URL to the address you're using within the proxy. In this example, it would be `http://www.example.com/confluence`

**Adding SSL**

If you're running Apache in front of Tomcat, it's a good idea to terminate your SSL configuration at Apache, then forward the requests to Tomcat over HTTP. You can set up Apache to terminate the SSL connection and use the ProxyPass and ProxyPassReverse directives to pass the connection through to Tomcat (or the appropriate application server) which is running Confluence.

1. Create a new SSL host by creating a virtual host on 443
2. The standard http connection on apache could be used to redirect to https if you want or it could just be firewalled.
3. Within the VirtualHost definition:
   a. define the SSL options (SSLEngin and SSLCertificateFile)
   b. define the ProxyPass and ProxyPassReverse directives to pass through to Tomcat.

Most of the relevant Apache Config:

```apache
Listen 443
NameVirtualHost *:443
<VirtualHost *:443>
  SSLEngine On
  SSLCertificateFile /etc/apache2/ssl/apache.pem
  ProxyPass / http://localhost:8090/
  ProxyPassReverse / http://localhost:8090/
</VirtualHost>
```

Apart from the Apache configuration there is a couple of things you will need to do before you get your server working:

1. You will have to change your base URL to point to https addresses. See the documentation on configuring the server base URL.
2. We need to set up the connector to use https. In your installation directory, edit the file server.xml and add this attributes to your connector:

```xml
    proxyName="proxy.example.com" proxyPort="443" scheme="https"
```

More information

- The [mod_proxy_html site](https://httpd.apache.org/docs/current/mod/mod_proxy.html) has documentation and examples on the use of this module in the complex configuration.
- [Apache Week has a tutorial](http://httpd.apache.org/docs/current/tut/tutorial.html) that deals with a complex situation involving two applications and ProxyHTMLURLMap.
- Using [Apache with virtual hosts and mod_proxy](http://httpd.apache.org/docs/current/tut/tutorial.html) shows how to configure the special case where you want JIRA and Confluence running on separate application servers on virtual host subdomains.

Alternatives

If Tomcat is your application server, you have two options:

- use [mod_jk](http://www.apache.org/dist/mod/mod_jk/) to send the requests to Tomcat
- use [Tomcat's virtual hosts](http://tomcat.apache.org/tomcat-7.0-doc/ssl-howto.html) to make your Confluence application directory the same on the app server and the web server, removing the need for the URL mapping.

If your application server has an AJP connector, you can:

- use [mod_jk](http://www.apache.org/dist/mod/mod_jk/) to send the requests to your application server.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

**Introduction**

The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_proxy simply redirects requests for certain URLs to another web server, so it typically
requires no additional configuration on the application server.

This page documents a very common configuration request: configuring JIRA and Confluence on two Apache virtual hosts, running on different application servers. This is just a special case of mod_proxy configuration.

You can use virtual hosts in your application server if you want to run JIRA and Confluence on the same application server. There is a sample configuration for Tomcat you can use after configuring Apache.

Apache configuration

For this configuration to work properly, the application paths must be the same on both the application servers and the web server. For both JIRA and Confluence below, this is /. 

<table>
<thead>
<tr>
<th>JIRA external URL</th>
<th><a href="http://jira.example.com/">http://jira.example.com/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>JIRA application server URL</td>
<td><a href="http://jira-app-server.internal.example.com:8080/">http://jira-app-server.internal.example.com:8080/</a></td>
</tr>
<tr>
<td>Confluence external URL</td>
<td><a href="http://confluence.example.com/">http://confluence.example.com/</a></td>
</tr>
<tr>
<td>Confluence application server URL</td>
<td><a href="http://confluence-app-server.internal.example.com:8090/">http://confluence-app-server.internal.example.com:8090/</a></td>
</tr>
</tbody>
</table>

Add the following to your Apache httpd.conf:
# Put this after the other LoadModule directives
LoadModule proxy_module /usr/lib/apache2/modules/mod_proxy.so
LoadModule proxy_http_module /usr/lib/apache2/modules/mod_proxy_http.so

# Put this with your other VirtualHosts, or at the bottom of the file
NameVirtualHost *

<VirtualHost *>
    ServerName confluence.example.com
    ProxyRequests Off
    <Proxy>*</Proxy>
    Order deny,allow
    Allow from all
</Proxy>
    ProxyPass / http://confluence-app-server.internal.example.com:8090/
    ProxyPassReverse / http://confluence-app-server.internal.example.com:8090/
    <Location/>
      Order allow,deny
      Allow from all
    </Location>
</VirtualHost>

<VirtualHost *>
    ServerName jira.example.com
    ProxyRequests Off
    <Proxy>*</Proxy>
    Order deny,allow
    Allow from all
</Proxy>
    ProxyPass / http://jira-app-server.internal.example.com:8080/
    ProxyPassReverse / http://jira-app-server.internal.example.com:8080/
    <Location/>
      Order allow,deny
      Allow from all
    </Location>
</VirtualHost>

Points to note:

- ProxyPass and ProxyPassReverse directives send traffic from the web server to your application server.
- The application path is the same on the application server and on the web server (both are /).
- Because the above configuration uses name-based virtual hosting, you must configure your DNS server to point both names (jira.example.com, confluence.example.com) to your web server.

More information

For different ways to configure mod_proxy, see Using Apache with mod_proxy.

If you use Tomcat, mod_jk provides a different way of connecting Apache via AJP. You can also use the above configuration with just one application server if you use Tomcat's virtual hosts.

Using Apache with mod_jk

- The preferred configuration is Using Apache with mod_proxy. This works with any application server, and together with mod_proxy_html allows complex URL rewriting to deal with different application paths on the web server and the application server.
- This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will
**Introduction**

The Apache web server is often used in front of an application server to improve performance in high-load environments. Mod_jk allows request forwarding to an application via a protocol called AJP. Configuration of this involves enabling mod_jk in Apache, configuring a AJP connector in your application server, and directing Apache to forward certain paths to the application server via mod_jk.

Mod_jk is sometimes preferred to mod_proxy because AJP is a binary protocol, and because some site administrators are more familiar with it than with mod_proxy.

The scope of this documentation is limited to configuring the AJP connector in Tomcat 5.x. Other application servers may support AJP connectors; please consult your application server documentation for instructions on how to configure it.

The configuration below assumes your Confluence instance is accessible on the same path on the application server and the web server. For example:

<table>
<thead>
<tr>
<th>Externally accessible (web server) URL</th>
<th><a href="http://www.example.com/confluence/">http://www.example.com/confluence/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>Application server URL (HTTP)</td>
<td><a href="http://app-server.internal.example.com:8090/confluence/">http://app-server.internal.example.com:8090/confluence/</a></td>
</tr>
</tbody>
</table>

The AJP connection of the application server is set to: app-server.internal.example.com:8009.

**Configuring mod_jk in Apache**

The standard distribution of Apache does not include mod_jk. You need to download it from the [JK homepage](https://httpd.apache.org/docs/2.2/mod/mod_jk.html) and put the mod_jk.so file in your Apache modules directory.

Next, add the following in `httpd.conf` directly or included from another file:

```apache
# Put this after the other LoadModule directives
LoadModule jk_module modules/mod_jk.so

# Put this in the main section of your configuration (or desired virtual host, if using Apache virtual hosts)
JkWorkersFile conf/workers.properties
JkLogFile logs/mod_jk.log
JkLogLevel info

JkMount /confluence worker1
JkMount /confluence/* worker1
```

**Configuring workers.properties**

Create a new file called `workers.properties`, and put it in your Apache conf directory. (The path for `workers.properties` was one of the configuration settings above.)
Tomcat 5.x configuration

In Tomcat 5, the AJP connector is enabled by default on port 8009. An absolutely minimal Tomcat server.xml is below for comparison. The relevant line is the Connector with port 8009 – make sure this is uncommented in your server.xml.

```
<Server port="8000" shutdown="SHUTDOWN">
  <Service name="Catalina">
    <!-- Define a HTTP/1.1 Connector on port 8090 -->
    <Connector port="8090" />
    <!-- Define an AJP 1.3 Connector on port 8009 -->
    <Connector port="8009" protocol="AJP/1.3" />
    <Engine name="Catalina" defaultHost="localhost">
      <Host name="localhost" appBase="webapps">
        <Context path="/confluence" docBase="/opt/webapps/confluence-2.2/confluence"/>
        <Logger className="org.apache.catalina.logger.FileLogger"/>
      </Host>
    </Engine>
  </Service>
</Server>
```

Points to note:

- the Connector on port 8009 has protocol of "AJP/1.3". This is critical.
- the Context path of the Confluence application is "/confluence". This must match the path used to access Confluence on the web server.
- we recommend keeping your application Contexts outside the server.xml in Tomcat 5.x. The above example includes them for demonstration only.

Improving the performance of the mod_jk connector

The most important setting in high-load environments is the number of processor threads used by the Tomcat AJP connector. By default, this is 200, but you should increase it to match Apache’s maxThreads setting (256 by default):

```
<Connector port="8009" minSpareThreads="5" maxThreads="256" protocol="AJP/1.3" />
```

All the configuration parameters for the AJP connector are covered in the Tomcat documentation.

Ensuring UTF-8 compatibility

If you have problems downloading attachments with non-ASCII characters in the filename, add the following to your Apache configuration:

```
JkOptions +ForwardURICompatUnparsed
```
And specify UTF-8 as the URIEncoding in the AJP connector configuration:

```xml
<Connector port="8009" protocol="AJP/1.3" URIEncoding="UTF-8" />
```

These settings are discussed further on Configuring Tomcat's URI encoding.

More information

The Tomcat JK website has complete documentation on workers.properties and Apache configuration. You can also find information there on how to use mod_jk with IIS.

Using mod_rewrite to Modify Confluence URLs

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Confluence requires URL rewriting for proper functionality, if Confluence is accessible via different domain names. If Confluence is configured for multiple domains without URL rewriting, you will experience an array of problems. See Various Issues Caused when Server Base URL Does Not Match the URL Used to Access Confluence.

An example of why you may want to access Confluence from different domains:

- From an internal network: http://wiki
- The externally visible domain: http://wiki.domain.com

Using URL rewriting to access Confluence over multiple domains

**To configure Confluence over multiple domains:**

1. Add a DNS entry mapping http://wiki to the externally visible IP address of the Confluence server.
3. Add Apache HTTP proxy, using the instructions from Running Confluence behind Apache.
4. Add the mod_rewrite module to change the URL.

Further information

You may be interested in the UrlRewriteFilter that is Java web filter that works in a similar way of the Apache’s mod_rewrite.

Configuring Apache to Cache Static Content via mod_disk_cache

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content.

Static content in Confluence includes most JavaScript, CSS and image files which are included with the application or an installed plugin. This content will be cached by Apache in this configuration. User-provided content like space logos, attachments or embedded images are not considered static content and will not be cached.

**Note:** This page documents a configuration of Apache, rather than of Confluence itself. Atlassian will support Confluence with this configuration, but we cannot guarantee to help you debug problems with Apache. Please be aware that this material is provided for your information only, and that you use it at your own risk.

Configuring Apache mod_disk_cache
To configure Apache to cache static Confluence content:

1. Add a `mod_disk_cache` stanza to the virtual host configuration:

   ```
   <IfModule mod_disk_cache.c>
     # "/s" is where Confluence serves "static" stuff. Instruct Apache
to cache it:
     CacheEnable disk /s
     CacheIgnoreHeaders Set-Cookie
     CacheRoot "/var/cache/mod_proxy"
   </IfModule>
   ```

2. Configure Apache to load `mod_disk_cache`. For example, in our server configuration this is done in `/etc/httpd/conf/httpd.conf`:

   ```
   LoadModule disk_cache_module modules/mod_disk_cache.so
   ```

3. Restart Apache after both modifications are complete.

Notes

- Please refer to the Apache documentation for `mod_disk_cache`.
- If you encounter problems where users are served stale content, you may need to purge the Apache cache directory (`/var/cache/mod_proxy` in the above configuration) after a Confluence or plugin upgrade. This is a simple 3 step process:
  - Shut down Apache.
  - Clear the cache directory. For example: `sudo rm -r /var/cache/mod_proxy/*`
  - Restart Apache.
- Ensure that you are running the `htcacheclean` daemon in order to prevent excessive use of disk space. In our situation we ran it like this:

  ```
  sudo htcacheclean -d30 -n -t -p /var/cache/mod_proxy -l 512M
  ```

  This will purge content once the cache reaches 512M every 30 minutes. See the Apache documentation for `htcacheclean` for details of the options.

Starting Confluence Automatically on System Startup

You can configure Confluence to start automatically on system startup, allowing it to recover automatically after a reboot.

1. **Start Confluence Automatically on Linux**
2. **Start Confluence Automatically on Windows as a Service**

Start Confluence Automatically on Linux

On Linux/Solaris, the best practice is to install, configure and run each service (including Confluence) as a dedicated user with only the permissions they require.

To install, configure and run Confluence automatically on Linux/Solaris:

1. Create a `confluence` user for instance, using the following command:
1. Create a directory to install Confluence into:

```bash
sudo mkdir /usr/local/confluence
sudo chown confluence: /usr/local/confluence
```

2. Log in as the `confluence` user to install Confluence:

```bash
sudo su - confluence
cd /usr/local/confluence/
tar zxvf /tmp/confluence-3.0.1-std.tar.gz
ln -s confluence-3.0.1-std/ current
```

3. Edit `<<CONFLUENCE_INSTALL_DIRECTORY>>/confluence/WEB-INF/classes/confluence-init.properties` file, and set `confluence.home=/usr/local/confluence/<Confluence_Data_Home>` (ensure you have removed the comment `#`)

4. Then back as root, create the file `/etc/init.d/confluence` (code shown below), which will be responsible for starting up Confluence after a reboot (or when manually invoked).

```bash
#!/bin/bash

# Start Confluence
confluence_root=/usr/local/confluence
confluence_dir=$confluence_root/confluence
confluence_home=$confluence_root/<Confluence_Data_Home>
confluence_pid=$confluence_dir/logs/confluence.pid

start() {
    echo "Starting Confluence..."
    $confluence_dir/bin/confluence start
    echo "Confluence started!"
}

stop() {
    echo "Stopping Confluence..."
    if [ -f $confluence_pid ]; then
        kill $(cat $confluence_pid)
        rm $confluence_pid
        echo "Confluence stopped!"
    else
        echo "Confluence is not running!"
    fi
}

restart() {
    stop
    start
}

# Added by init.d script
case $1 in
    start)
        start
    ;;
    stop)
        stop
    ;;
    restart)
        restart
    ;;
    *)
        echo "Usage: $0 {start|stop|restart}
    ;;
    esac

exit 0
```

5. If you are running Ubuntu Jaunty (or later) do not perform this step. Please use the instructions further down this page.
#!/bin/sh -e
# Confluence startup script
#chkconfig: 2345 80 05
#description: Confluence

# Define some variables
# Name of app ( JIRA, Confluence, etc )
APP=confluence
# Name of the user to run as
USER=confluence
# Location of application's bin directory
CATALINA_HOME=/usr/local/confluence/current
# Location of Java JDK
export JAVA_HOME=/usr/lib/jvm/java-6-sun

case "$1" in
  start)
    echo "Starting $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/startup.sh &> /dev/null"
    ;;
  stop)
    echo "Stopping $APP"
    /bin/su -m $USER -c "$CATALINA_HOME/bin/shutdown.sh &> /dev/null"
    echo "$APP stopped successfully"
    ;;
  restart)
    $0 stop
    sleep 5
    $0 start
    ;;
  *)
    echo "Usage: /etc/init.d/$APP {start|restart|stop}"
    exit 1
    ;;
esac

exit 0

6. Make this file executable:

    sudo chmod +x /etc/init.d/confluence

7. Set this file to run at the appropriate runtime. For example, use `sudo chkconfig --add confluence` on Redhat-based systems, `sudo update-rc.d confluence defaults` or `rcconf` on Debian-based systems.

8. You should now be able to start Confluence with the init script. A successful startup output typically looks like this:
$ sudo /etc/init.d/confluence start
Starting Confluence:
If you encounter issues starting up Confluence, please see the
Installation guide at
http://confluence.atlassian.com/display/DOC/Confluence+Installation
+Guide
Using CATALINA_BASE:   /usr/local/confluence/current
Using CATALINA_HOME:   /usr/local/confluence/current
Using CATALINA_TMPDIR: /usr/local/confluence/current/temp
Using JRE_HOME:       /usr/lib/jvm/java-1.5.0-sun

You should then see this running at http://<server>:8090/

- The port for this will be whatever is defined in your Confluence server.xml file.

Adding Confluence as a service for Ubuntu Jaunty (or later)

To continue configuring Confluence to start automatically as a service on Ubuntu Jaunty (or later):

1. After logging in as the confluence user to install Confluence, create start and stop scripts in /usr/local/confluence:

Example start script:

```bash
#!/bin/bash
export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
cd /usr/local/confluence/current/bin
./startup.sh
```

Example stop script:

```bash
#!/bin/bash
export JAVA_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
export JDK_HOME=/usr/lib/jvm/java-6-sun-1.6.0.16/
cd /usr/local/confluence/current/bin
./shutdown.sh
```

2. Make both of these scripts executable. For example, by issuing the command: sudo chmod a+x /usr/local/confluence/start /usr/local/confluence/stop.

3. Karmic and later: Create two text files in /etc/init/ called confluence-up.conf and confluence-down.conf:

confluence-up:

```bash
```
start on runlevel [2345]

script

date >> /tmp/confluence-startup.out
exec sudo -u confluence /usr/local/confluence/start >>
/tmp/confluence-startup.out 2>&1

end script

confluence-down:

start on runlevel [16]

expect fork
respawn

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/init/confluence-up.conf /etc/init/confluence-down.conf

1. Jaunty, Intrepid: Create two text files in /etc/event.d/ called confluence-up and confluence-down:

confluence-up:

start on runlevel 2
start on runlevel 3
start on runlevel 4
start on runlevel 5

exec sudo -u confluence /usr/local/confluence/start >>
/tmp/confluence-startup.out 2>&1

confluence-down:

start on runlevel 1
start on runlevel 6

exec sudo -u confluence /usr/local/confluence/stop >>
/tmp/confluence-shutdown.out 2>&1

... and make them readable to all users:
sudo chmod a+r /etc/event.d/confluence-up /etc/event.d/confluence-down

RELATED TOPICS

Starting Confluence Automatically on System Startup
Start Confluence Automatically on Windows as a Service

For long-term use, we recommend that you configure Confluence to start automatically when the operating system restarts. For Windows servers, this means configuring Confluence to run as a Windows service.

There are two ways to install the Confluence distribution as a service: using the Confluence installer or manually as described below.

On this page:

- Reasons for Starting Confluence as a Service
- Changing the User Running the Service
- Manually Installing the Confluence Distribution as a Service
- Managing Confluence as a Service
- Upgrading Confluence
- Troubleshooting Confluence while Running as a Windows Service
- Requesting Support

**Problem with 64-bit Windows**
If you are running 64-bit Windows, please note that Apache Tomcat cannot run as a Windows service if you are using a 64-bit JDK. Please ensure that you are using a 32-bit JDK. Refer to our [knowledge base article](#) for more information.

**Reasons for Starting Confluence as a Service**

Installation as a Windows service offers these advantages:

- Reduced risk of shutting down Confluence by accident (If you start Confluence manually, a console window opens and there is a risk of someone accidentally shutting down Confluence by closing the window).
- Automated Confluence recovery after server restart.
- Improved troubleshooting through logging server output to file.

You can read more about Windows services in the [Microsoft Developer Network](#).

**Changing the User Running the Service**

If you wish to run the service as a non-administrator user for security, or if you are using network drives for backups, attachments or indexes, you can run the service as another user. To change users, open the Apache Tomcat Confluence properties, go to the 'Log On' tab and enter the required username and password. Go to your Windows Control Panel -> User Accounts and confirm that the user has write permissions for the `<CONFLUENCE-INSTALL>` and `<CONFLUENCE-HOME>` directories, and all subfolders. Note that any network drives must be specified by UNC and not letter mappings (e.g. `\backupserver\confluence` not `z:\confluence`).

For more detail, see [Creating a Dedicated User Account on the Operating System to Run Confluence](#).

**Manually Installing the Confluence Distribution as a Service**

From your Windows-based server:

1. Open a command prompt in the `<CONFLUENCE-INSTALL>/bin` directory.
2. Confirm that the JAVA_HOME variable is set to the JDK base directory with the command:
echo %JAVA_HOME%

Note that any directory in the path with spaces (e.g. C:\Program Files must be converted to its eight-character equivalent (e.g. C:\Progra~1).

3. If you are installing Confluence on a Windows 2008 server, be sure to run the command prompt using ‘run as administrator’. (Otherwise running 'service.bat', as described in the next step, will fail.)

4. Use the following command to install the service with default settings:

```
service.bat install Confluence
```

NB: This will create a service called **Apache Tomcat Confluence**.

5. Now, to have the service start automatically when the server starts, run:

```
tomatc6 //US//Confluence --Startup auto
```

6. If you have a less than a 512 megabytes of memory, skip this step. For users with large Confluence installations, you can increase the maximum memory Confluence can use. (The default is 256MB). For example, you can set the maximum memory to 512 megs using:

```
tomatc6 //US//Confluence --JvmMx 512
```

7. If you do not have any JVM parameters that you pass to your distribution of Confluence, you can skip this step. If you do, add them to the service using:

```
tomatc6 //US//Confluence ++JvmOptions="-Djust.an.example=True"
```

8. For further configuration options, please refer to the Tomcat Windows Service How-To guide
9. Go to your Windows Control Panel -> Administrative Tools -> Services -> Apache Tomcat Confluence and right-click on Properties to verify the settings are correct.

**Confluence is now installed as a service, but will not automatically start up until the next server reboot**

10. Start the Confluence service with the command:

```
net start Confluence
```

### Managing Confluence as a Service

You can manage the Confluence service from the command prompt.

- Stop Confluence with:

```
net stop Confluence
```

- Uninstall the Confluence service with:
Upgrading Confluence

After upgrading Confluence, you can either uninstall and reinstall the Windows service or change the StartPath parameter to your new folder. Refer to the Tomcat documentation for help.

Troubleshooting Confluence while Running as a Windows Service

- Check the Knowledge Base articles:
  - Unable to Start Confluence Windows Service After Allocating JVM Memory
  - Unable to Install Service on Windows Vista
  - Problems Installing Confluence as a Service on Windows 64bit
  - Unable to Configure Confluence to Run as a Service on Tomcat 5
  - Confluence Does Not Start Due to Windows Firewall
  - Getting ‘The image file tomcat6.exe is valid, but is for a machine type other than the current machine’

- If none of the above solves your problem, please refer to the complete list of known issues in our Knowledge Base.

- When investigating memory issues or bugs, it may be useful to view information from Confluence's garbage collection. To turn on the verbose garbage collection, use the command:

  ```
tomcat6 //US//Confluence
++JvmOptions="-Xloggc:<CONFLUENCE-INSTALL>\logs\atlassian-gc.log"
  ```

- The Confluence 2.9 installer does not work when installed as service, due to a missing semi-colon in service.bat. Please refer to reported issue CONF-12785.

- You can use a Sysinternals tool called Procmon.exe from the The Microsoft Windows Sysinternals Team, to check that the error occurred at the specific time when the Confluence service started. You need to match the time when Tomcat failed, as captured by this tool, against the time in the Windows Event Viewer.

  ![Note]
  
  We do not recommend that you run this tool for too long as it may disrupt other Atlassian applications. Once you have captured the required information you will need to press Ctrl + E to stop capturing.

Requesting Support

If, after following the troubleshooting guide above, you still cannot make Confluence run as a Windows Service or if there is an error when setting the JVM configuration for the service, you can create a support request.

Please provide the following information when creating your support request, because we will need it to assist you:

- Are you running a 32 bit or 64 bit Windows?
- Give us the result of running `java -version` from Windows command line console.
- A screen shot of your Windows Registry setting for Tomcat.
• If you have modified service.bat, please give us a copy of this file for review.
• What application server are you using? eg. Are you using the Confluence distribution?
• Your atlassian-confluence.log file.

RELATED TOPICS

Starting Confluence Automatically on System Startup
How to Fix Out of Memory Errors by Increasing Available Memory

Configuring Confluence

This section focuses on settings and configurations within the Confluence application. For guidelines on external configuration, see Configuring a Confluence Environment. (Not applicable to Confluence OnDemand.)

Would you like a full list of the pages in the administrator's guide? Here it is: Table of Contents for Confluence Administrator's Guide. (Not applicable to Confluence OnDemand.)

If you cannot find what you are looking for, try searching this documentation via the search box at top right of the screen.

• Viewing System Information
• Configuring the Server Base URL
• Configuring the Confluence Search and Indexes
• Configuring Mail
• Configuring Character Encoding
• Other Settings
• Configuring System Properties
• Working with Confluence Logs
• Configuring Confluence Security
• Scheduled Jobs

Related pages:
• Managing Confluence Users
• Managing Add-ons and Macros (Not applicable to Confluence OnDemand.)
• Customising your Confluence Site
• Confluence Administrator's Guide

Viewing System Information

The System Information screen provides information about Confluence's configuration, and the environment in which Confluence has been deployed. Your system configuration information is helpful to us when diagnosing errors you may face using Confluence. If you file a support request or bug report, the more detail you can provide about your installation and environment the faster we will be able to help.

To view your system information,

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'System Information' in the 'Administration' section.

The handy Memory Graph helps you keep track of Confluence's memory usage.

The information on this page does not apply to Confluence OnDemand.

RELATED TOPICS

Cache Statistics
Viewing Site Statistics
Viewing and Editing License Details
About Add-ons
Live Monitoring Using the JMX Interface
Tracking Customisations Made to your Confluence Installation

Live Monitoring Using the JMX Interface

With the JMX interface (introduced in Confluence 2.8), you can monitor the status of your Confluence instance in real time. This will provide you with useful data such as the resource usage of your instance and its database latency, allowing you to diagnose problems or performance issues. To read the JMX data, you will need to use a JMX client.

**Disable JMX**

⚠️ If you experience any problems during Confluence startup that are related to JMX, it is possible to disable the JMX registration process. Please place jmxContext.xml in your `<confluence-install>/confluence/WEB-INF/classes` folder to do so.

⚠️ The information on this page does not apply to Confluence OnDemand.

What is JMX?

JMX (Java Management eXtensions) is a technology for monitoring and managing Java applications. JMX uses objects called MBeans (Managed Beans) to expose data and resources from your application.

1. Enabling JMX Remote with Tomcat

By default, Confluence uses the Apache Tomcat web server. To use JMX, you must enable it on your Tomcat server, by carrying out the steps under the [Apache Tomcat documentation](http://tomcat.apache.org/), entitled Enabling JMX Remote. With those steps completed, restart your Tomcat server.

For the stand-alone, add the startup parameter `-Dcom.sun.management.jmxremote` to `setenv.sh` or `setenv.bat`. See instructions for the [Windows Service](http://example.com/services) - enter it in the same place as PermGen Memory.

2. Selecting your JMX Client

You need to use a JMX client in order to view the JMX output from Confluence. JConsole is a readily available JMX client that is included with the [supported](https://java.com/) Java Developer Kit (version 5 onwards). The full name is the 'Java Monitoring and Management Console', but we will refer to it as JConsole for the purposes of this document.

3. Adding the JMX Client to your Path

You must add the location of the JConsole binary file to your path environment variable. As JConsole resides in the 'bin' (binaries) folder under your Java directory, the path should resemble something like this:

```
JDK_HOME/bin/
```

In this example, replace 'JDK_HOME' with the full system path to your Java directory.

4. Configuring JConsole

**To configure JConsole:**

1. Run the JConsole application.
2. You will be prompted to create a new connection. Choose **remote process** and enter the hostname of your Confluence instance and a port of your choosing.
To connect easily, add the startup parameters to setenv.bat or setenv.sh:
-Dcom.sun.management.jmxremote -Dcom.sun.management.jmxremote.port=8086
-Dcom.sun.management.jmxremote.authenticate=false
Port 8086 is unlikely to be used. Then, connect remotely using port 8086.

JConsole, or any JMX client, will not see applications which are not owned by the same user. For example under Windows, if an application is started as a service, it is the System User which owns the process, and not the Current User.

3. Click Connect.

Note: Other JMX clients besides JConsole can read JMX information from Confluence.

What can I monitor with JMX?

The JMX interface allows you to see live internal information from your Confluence instance, via the following MBeans:

**IndexingStatistics**

This MBean shows information related to search indexing.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flushing</td>
<td>Shows state of cache (i.e. flushing, or not).</td>
<td>True/False</td>
</tr>
<tr>
<td>LastElapsedMilliseconds</td>
<td>Time taken during last indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>LastElapsedReindexing</td>
<td>Time taken during last re-indexing.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>TaskQueueLength</td>
<td>Shows number of tasks in the queue.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SystemInformation**

This MBean shows information related to database latency. It also contains most of the information presented on the System Information page.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>DatabaseExampleLatency</td>
<td>Shows the latency of an example query performed against the database.</td>
<td>Milliseconds</td>
</tr>
</tbody>
</table>

**RequestMetrics**

This MBean shows information related to system load and error pages served.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>AverageExecutionTimeForLastTenRequests</td>
<td>Average execution time for the last ten requests.</td>
<td>Milliseconds</td>
</tr>
<tr>
<td>CurrentNumberOfRequestsBeingServed</td>
<td>Number of requests being served at this instant.</td>
<td>Integer</td>
</tr>
</tbody>
</table>
ErrorCount | Number of times the Confluence error page was served. | Integer

NumberOfRequestsInLastTenSeconds | Obviously, the Number Of Requests In the Last Ten Seconds. | Integer

**MailServer-SMTPServer**

This MBean shows information related to email dispatch attempts and failures. There will be an MBean for every SMTP Mailserver that has been configured in the Confluence instance.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmailsAttempted</td>
<td>The number of email messages Confluence has tried to send.</td>
<td>Integer</td>
</tr>
<tr>
<td>EmailsSent</td>
<td>The number of email messages sent successfully.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**MailTaskQueue**

This MBean shows information related to the email workload.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Function</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>ErrorQueueSize</td>
<td>Number of errors in the queue.</td>
<td>Integer</td>
</tr>
<tr>
<td>Flushing</td>
<td>Shows state (i.e. flushing, or not)</td>
<td>True/False</td>
</tr>
<tr>
<td>FlushStarted</td>
<td>Time that operation began.</td>
<td>Time</td>
</tr>
<tr>
<td>RetryCount</td>
<td>The number of retries that were performed.</td>
<td>Integer</td>
</tr>
<tr>
<td>TaskSize</td>
<td>Number of email messages queued for dispatch.</td>
<td>Integer</td>
</tr>
</tbody>
</table>

**SchedulingStatistics**

This MBean shows information related to current jobs, scheduled tasks and the time that they were last run.

**High CPU consuming threads**

For Java 1.6, add the Top Threads Plugin to monitor whether CPU is spiking. Download it to a directory and run JConsole like this:

```bash
JConsole -pluginpath /path/to/topthreads.jar
```

This works only with JDK 1.6, but that can be on the remote machine if the server is running a lower version.

> Please note, adding live monitoring to a production instance may itself have an impact on performance.

Related Topics

- Viewing System Information
- Cache Statistics
- Viewing and Editing License Details
• Viewing and Managing Installed Plugins

Tracking Customisations Made to your Confluence Installation

The ‘Modification’ section of the Confluence ‘System Information’ screen lists the files that have been changed since your Confluence application was installed. You will find this information particularly useful when upgrading Confluence to a new version, because you will need to re-apply all customisations after the upgrade.

⚠️ The information on this page does not apply to Confluence OnDemand.

To see the modifications made to files in your Confluence installation,

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select ‘System Information’ in the ‘Administration’ section of the left-hand panel.
3. Scroll down to the section titled ‘Modification’.

Screenshot: Modifications tracker on the Confluence System Information screen

Notes

• The modification tracker does not detect changes to class files from the confluence.jar or other JAR files. If you modify classes, the Confluence modification detection does not report the modification. See issue CONF-20993.

RELATED TOPICS

Viewing Site Statistics

Note that the site activity information is disabled by default. See notes below.

If enabled, the global activity screen displays statistics on the activity in your Confluence site. These include:

• How many pages and blog posts have been viewed, added or updated over a given period.
• Which spaces are the most popular (most frequently viewed).
• Which spaces are the most active (most frequently edited).
• Which people are the most active contributors/editors of content.

To view the activity on your site:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘Global Activity’ in the ‘Administration’ section of the left-hand panel (only appears if enabled - see below).

Related pages:

• How Do I Get More Statistics from Confluence?
• Cache Statistics
• Viewing Space Activity
• Live Monitoring Using the JMX Interface
• Installing and Configuring Plugins
• Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.
The top ten most popular and most active pages and/or blog posts will be listed, with a link to each.

**Notes**

- The **Confluence Usage Stats plugin**, which provides the 'Global Activity' screen, is known to cause performance problems on large installations. This plugin is **disabled by default**. A status report on the progress of the performance issues with this plugin is available in this issue: **USGTRK-15**.
- Your Confluence system administrator can enable the plugin, but please be aware of the possible impact.
upon your site's performance.
- The plugin is sometimes called 'Confluence Usage Tracking'.
- If your Confluence site is clustered, the global activity information will not be available.

Viewing System Properties

After adding memory, setting a proxy or changing other Java options, it can be difficult to diagnose whether the system has picked them up. This page tells you how to view the system properties that your Confluence site is using.

⚠️ The information on this page does not apply to Confluence OnDemand.

In Confluence 3.0.2 and Later

You can see the expanded system properties on the 'System Information' screen of the Confluence Administration Console.

To see the system properties recognised by your Confluence installation:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select System Information in the 'Administration' section of the left-hand panel.
3. Scroll down to the section titled 'System Properties'.

In Confluence Versions Earlier than 3.0.2

To find out more about what properties are being picked up, download the file systemproperties.jsp (attached to this page). Place it in your <confluence-install>/confluence/admin directory. Access the following URL:

http://<yourbaseurl>/admin/systemproperties.jsp

No restart of Confluence is required.

Configuring the Server Base URL

The Server Base URL is the URL via which users access Confluence. The base URL must be set to the same URL by which browsers will be viewing your Confluence site.

Confluence will automatically detect the base URL during setup, but you may need to set it manually if your site's URL changes or if you set up Confluence from a different URL to the one that will be used to access it publicly.

You need to have System Administrator permissions in order to perform this function.

⚠️ The information on this page does not apply to Confluence OnDemand.

To configure the Server Base URL:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Enter the new URL in the Server Base URL text box.
5. Choose Save.

Example

If Confluence is installed to run in a non-root context path (that is, it has a context path), then the server base URL should include this context path. For example, if Confluence is running at:
then the server base URL should be:

http://www.foobar.com/confluence

Notes

- **Using different URLs.** If you configure a different base URL or if visitors use some other URL to access Confluence, it is possible that you may encounter errors while viewing some pages.

- **Changing the context path.** If you change the context path of your base URL, you may also need to edit the web server’s `server.xml` file to reflect the new path:
  1. Stop the Confluence server.
  2. Go to your Confluence ‘destination directory’. This is the directory where the Confluence installation files are stored. For example, C:\Program Files\Atlassian\Confluence. Let’s call this directory '{CONFLUENCE_INSTALLATION}'.
  3. Edit the configuration file at '{CONFLUENCE_INSTALLATION}\conf\server.xml'.
  4. Change the value of the `path` attribute in the `Context` element to reflect the context path. For example, if Confluence is running at http://www.foobar.com/confluence, then your `path` attribute should look like this:

```xml
<Context path="/confluence" docBase="../confluence" debug="0" reloadable="false" useHttpOnly="true"/>
```

  5. Save the file.

- **Proxies.** If you are running behind a proxy, ensure that the proxy name matches the base URL. For example: `proxyName="foobar.com" proxyPort="443" scheme="https"`. This will make sure we are passing the information correctly.

**RELATED TOPICS**

- Configuring the Server Base URL
- Changing the Site Logo
- Configuring the Site Home Page
- Customising Default Space Content
- Editing the Site Welcome Message
- Changing the Site Title

**Configuring the Confluence Search and Indexes**

Confluence administrators can adjust the behaviour of the Confluence search, and manage the indexes used by the search and ‘did you mean’ functions.

- Configuring Indexing Language
- Configuring Quick Navigation
- Content Index Administration
- Enabling OpenSearch
- Enabling the Did You Mean Feature
- Rebuilding the Ancestor Table
- Setting Up Confluence to Index External Sites
• Setting Up an External Search Tool to Index Confluence

Related pages:
- Searching Confluence
- Confluence Administrator's Guide

Configuring Indexing Language
Changing the indexing language defined in Confluence may improve the accuracy of Confluence search results, if the majority of the content of your site is in some language other than English. Confluence supports content indexing in English (default), German, Russian, Chinese, CJK, Custom Japanese, French, Brazilian, Czech and Greek.

To configure the indexing language:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Select the Indexing Language from the dropdown list in the Formatting and International Settings section.
5. Choose Save.

Related pages:
- Choosing a Default Language Not applicable to Confluence OnDemand.
- Installing a Language Pack Not applicable to Confluence OnDemand.
- Content Index Administration Not applicable to Confluence OnDemand.
- Rebuild the Content Indices from Scratch
- Creating a Lowercase Page Title Index Not applicable to Confluence OnDemand.
- Confluence Administrator's Guide

Configuring Quick Navigation
When a user is searching Confluence (see Searching Confluence) the quick navigation aid automatically offers a dropdown list of pages and other items, matched by title to the search query. By default, this feature is enabled, with the maximum number of simultaneous quick navigation requests set to 40. These options can be modified as described below.

The maximum number of simultaneous quick navigation requests defines the maximum number of individuals who can use this feature simultaneously on the same Confluence server. If your Confluence server serves a large number of individuals who use this feature regularly, some of whom are being denied access to it, you may wish to increase this value.

To configure the quick navigation feature:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. To disable this feature, remove the tick in the check box beside Quick Navigation.
5. To modify the maximum number of simultaneous quick navigation requests, enter the appropriate number.

Related pages:
- Searching Confluence
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.
in the field beside **Max Simultaneous Requests**.

6. Choose **Save**.

### Content Index Administration

The content indexes power Confluence's search functionality. They are also used for a number of related functions such as building email threads in the mail archive, the **space activity** feature and lists of recently-updated content. The **Gliffy plugin** also uses them for some of its functionality.

For reasons of efficiency, Confluence does not immediately add content to the index. New and modified Confluence content is first placed in a queue and the queue is processed once every minute (by default).

**Viewing the Content Index Summary**

**To see information about your Confluence instance's content indexing:**

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Click ‘**Content Indexing**’ under the heading ‘**Administration**’ in the left-hand panel.

---

**On this page:**

- Viewing the Content Index Summary
- Rebuilding the Content Indexes
- Slow Reindexing
- Viewing the Index Browser
- More Hints and Tips

---

**The information on this page does not apply to Confluence OnDemand.**

---

**Screenshot: Index summary**

---

**Rebuilding the Content Indexes**

The content indexes are maintained automatically, but you may need to rebuild one or both of them manually under circumstances such as these:
• Your searching and mail threading are malfunctioning. (Rebuild the Search Index.)
• The Did You Mean feature is malfunctioning. (Rebuild the Did You Mean Index.)
• After an upgrade. If a content re-index is required after an upgrade, it will be noted in an upgrade subsection of the relevant Confluence Release Notes.

In new Confluence installations, the 'Did You Mean' feature is not initially activated. To activate it, you first need to build its index by clicking its 'Build' button on this page.

To rebuild either of the content indexes:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'Content Indexing' under the heading 'Administration' in the left-hand panel.
3. Click the 'Rebuild' button in either the 'Search Index' or 'Did You Mean Index' sections on this page, depending on the particular index you want to rebuild.

• If one of these indexes has not yet been built, its button will indicate 'Build' instead of 'Rebuild).
• As shown in the image below, only one index can be (re)built at a time.

Screenshot: Content Indexing

Search Index
The search index allows searching of Confluence content. If you are having troubles with search, you may need to rebuild the search index. Please note: rebuilding the search index can severely affect the performance of your instance - it can take hours for some large instances.

Rebuild

Did You Mean Index
You will need to build this index to make "Did You Mean" work. After this has finished, "Did You Mean" will be automatically turned on. Please note, this feature only provides suggestions for the English language.

'Did You Mean' index build temporarily disabled while Search Index build is in progress.

Slow Reindexing
Does the reindexing take a long time to complete? The length of time depends on the following factors:

• Number of pages in your Confluence instance.
• Number, type and size of attachments.
• Amount of memory allocated to Confluence.

It may help to increase the heap memory allocation of Confluence by following the instructions in the JIRA documentation.

If you are running an older version of Confluence and find that the index rebuild is not progressing, you may need to shut down Confluence, and restart it with the following Java system property set:

`bucket.indexing.threads.fixed=1`.

This will cause the re-indexing to happen in a single thread and be much more stable (but slower).
Viewing the Index Browser

Confluence uses a search engine called Lucene. If you need to see more details of the indexed pages in your Confluence site, you can download and run Luke. Luke is a development and diagnostic tool that accesses existing Lucene indexes and allows you to display and modify their content in several ways.

Start Luke and use it to open the index directory, located in your Confluence Home directory. For example: c:\confluence\data\confluence-home\index.

More Hints and Tips

- If you are still experiencing problems after performing the above rebuild, the next step might be to remove the index and rebuild it from scratch.
  - The space activity feature uses the index to store data. If you remove the index file, the existing activity data will disappear.
- A tip for the development community: If you have the Confluence source, you can look for references to the SmartListManager to find the screens and lists that rely on the content index.

RELATED TOPICS

- Working with Macros
- Configuring Indexing Language
- Content Index Administration
- Creating a Lowercase Page Title Index

Enabling OpenSearch

With OpenSearch autodiscovery, you can add Confluence search to your Firefox or IE7 search box (see Searching Confluence from your Browser's Search Box). By default, OpenSearch autodiscovery is enabled. This feature can be enabled or disabled as described below.

To enable or disable OpenSearch autodiscovery:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Add a tick in the check box beside Open Search to enable this feature, or remove the tick to disable the feature.
5. Choose Save.

Related pages:

- Searching Confluence
- Confluence Administrator's Guide

Enabling the Did You Mean Feature

When you perform a full Confluence search, Confluence may offer you an alternative spelling of your search query. The alternative spelling will appear next to the words 'Did you mean'. By default, this feature is disabled. You can enable it as described below.

To enable the 'Did You Mean' feature,
1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'General Configuration' in the left-hand panel.
3. In the 'General Configuration' screen, click 'Edit'.
4. Select 'On' beside 'Did You Mean'.
   - If you have no 'Did you mean' feature index or you have not yet created it, this option will not be available. To create this index, click 'build the did-you-mean index' and on the subsequent page, click 'Build' in the 'Did You Mean Index' section. Then return to the 'General Configuration' screen in Edit mode.
5. Click 'Save'.

Languages and Locales

The 'Did You Mean' feature supports only the English language. In addition, the 'Did You Mean' index requires the built-in UK-English locale (en_UK). If your Confluence site uses a different language pack, such as English (US), the 'Did You Mean' feature will not work. You will see an error message like this:

For Did You Mean both the indexing language and the global default language must be set to English.

For more information about how the 'Did You Mean' feature works, please refer to the user guide.

You can track the request to support other languages by watching issue CONF-14768.

RELATED TOPICS

Searching Confluence

Rebuilding the Ancestor Table

In Confluence, the ancestor table defines what pages are ancestors or descendants of other pages (which can be used by search restrictions with the ancestorids restriction). Occasionally, the ancestor table will become out of sync. When this happens, you can rebuild the table to restore everything to normal.

Access this URL:

http://yoursite/admin/permissions/pagepermsadmin.action

Related pages:

- Searching Confluence
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

Screenshot: Page level permissions

Setting Up Confluence to Index External Sites

Confluence cannot easily index external sites due to technical reasons, but there are two alternatives:

1. Embed External Pages Into Confluence
2. Replace Confluence Search

Technical reasons

Confluence indexes pages using a customised Lucene search engine that returns matching pages, mail and blog posts for which the searcher has view permission. It would require significant source code modifications to enable Confluence to process search results from external pages, as the indexing process has been customised to utilise internal Confluence metadata. Note that users can still index content from new attachment filetypes.

Embedding external pages into Confluence

If you only have a small number of external sites to index, you may prefer to enable the HTML-include Macro and use it embed the external content inside normal Confluence pages.

Related pages:
- Setting Up an External Search Tool to Index Confluence
- Configuring the Confluence Search and Indexes
- Confluence Administrator's Guide

The information on this page does not apply to Confluence OnDemand.

Replacing the Confluence search

Use your own programmer resources to replace Confluence's internal search with a crawler that indexes both Confluence and external sites. This advanced option is easier than modifying the internal search engine. It requires removing Confluence internal search from all pages and replacing the internal results page with your own crawler front-end.

1. Setup a replacement federated search engine to index the Confluence site, as well as your other sites, and provide the results that way. You would need to host a web crawler, such as these open-source crawlers. Note that you can perform a search in Confluence via the remote API
2. Replace references to the internal search by modifying the site layout so that it links to your search front-end
3. Host another site containing the search front-end. You may wish to insert it into a suitable context path in your application server so that it appears to be from a path under Confluence. Tomcat sets Confluence's paths from the Confluence install/confluence/WEBINF/web.xml file.

Setting Up an External Search Tool to Index Confluence

Any web crawler can be configured to index Confluence content, for example the Google Search Appliance or similar. If a login is required to view content that will be indexed, you should create a Confluence user specifically for the search crawler to use. Grant this user view rights to all content you wish to index, but deny that user all delete and administration rights. This ensures that an aggressive crawler will not be able to perform actions that could modify the site.

External applications can also use the search function in the Confluence remote API.

Related pages:
- Setting Up Confluence to Index External Sites
- Configuring the Confluence Search and Indexes
- Confluence Administrator’s Guide

The information on this page does not apply to Confluence OnDemand.

Configuring Mail

- Configuring a Server for Outgoing Mail
Configuring your Confluence server to send email messages allows your Confluence users to:

- Receive emailed notifications and daily reports of updates.
- Send a page via email.

You can personalise email notifications by configuring the 'From' field to include the name and email address of the Confluence user who made the change.

You need **System Administrator** permissions in order to configure Confluence's email server settings.

**On this page:**
- Configuring Confluence to send email messages
- Testing the email settings
- Troubleshooting

**Related pages:**
- The Mail Queue
- Setting Up a Mail Session for the Confluence Distribution

---

**Configuring Confluence to send email messages**

**To configure Confluence to send outgoing mail:**

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Select **Mail Servers** under **Configuration** in the left-hand panel. This will list all currently configured SMTP servers.
3. Click **Add New SMTP Server** (or **edit** an existing server).
4. Edit the following fields as required:
   - **Name**: By default, this is simply 'SMTP Server'.
   - **From Address**: Enter the email address that will be displayed in the 'from' field for email messages originating from this server. This field is mandatory. You will not be able to complete the Confluence mail server configuration until this field has been specified.
   - **From Name**: Enter the name that will be displayed in the 'from' field for email messages originating from this server. This is the text which appears before the user's registered email address (in angled brackets). This field accepts the following variables, which reference specific details defined in the relevant Confluence user's profile:

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>${fullname}</td>
<td>The user's full name.</td>
</tr>
</tbody>
</table>

---
A Confluence administrator can test the email server as follows:

1. Set up a mail server at Confluence Admin > Mail Servers, as described above
2. Click Send Test Email to check that the server is working. Check that you get the test email in your inbox.
3. You can flush the email queue to send the email message immediately. Go to Confluence Admin > Mail Queue, and click Flush Mail Queue. See The Mail Queue.

A user can test that notifications are working as follows:

1. Go to your user profile (using the Settings link) and edit your email preferences. See Subscribing to Email Notifications of Updates to Confluence Content.
2. Enable Notify On My Actions. (By default, Confluence does not send you notifications for your own changes.)
3. Go to a page you wish to get notifications about.
4. Choose Tools > Watch. See Watching a Page or Blog Post.
5. Edit the page, make a change, and save the page.
6. Check your email inbox. You may need to wait a while for the email message to arrive.

Troubleshooting

If you experience problems with these configurations, please check that your <Confluence-Install>/confluence/WEB-INF/lib contains only one copy of the following JAR files:

1. activation-x.x.x.jar
2. mail-x.x.x.jar

Ideally, these should be:

- activation-1.0.2.jar
- mail-1.3.2.jar (or later)

You will then need to move these into the proper directory: Please move (not copy) the two jar files from the <Confluence-Install>/confluence/WEB-INF/lib directory to <confluence-install>/lib and restart Confluence.

Setting Up a Mail Session for the Confluence Distribution
Set up a mail session for the Confluence distribution to use Gmail as follows:

1. Stop Confluence.
2. Move (don't copy) activation-1.0.2.jar and mail-1.4.1.jar from <confluence-install>/confluence/WEB-INF/lib to <confluence-install>/lib.
3. Add the following to your server.xml file found in <confluence-install>/conf/ (add it just before the </Context> tag):

   ```xml
   <Resource name="mail/GmailSMTPServer"
       auth="Container"
       type="javax.mail.Session"
       mail.smtp.host="smtp.gmail.com"
       mail.smtp.port="465"
       mail.smtp.auth="true"
       mail.smtp.user="yourEmailAddress@gmail.com"
       password="yourPassword"
       mail.smtp.starttls.enable="true"
       mail.transport.protocol="smtps"
       mail.smtp.socketFactory.class="javax.net.ssl.SSLSocketFactory"
   />
   ```

4. Restart Confluence.
5. Choose the cog icon at top right of the screen, then choose Confluence Admin.
6. Choose Mail Servers.
7. Choose either Edit an existing configuration, or Add a new SMTP mail server.
8. Edit the server settings as necessary, and set the JNDI Location as:

   ```java
   java:comp/env/mail/GmailSMTPServer
   ```

   Note that the JNDI Location is case sensitive and must match the resource name specified in server.xml.
9. Submit, and send a test email.

Configuring the Recommended Updates Email Notification

Confluence sends a regular email report to subscribers, containing the top content that is relevant to the person receiving the message, from spaces they have permission to view. This is called the ‘Recommended Updates’ notification.

If you have Confluence Administrator or System Administrator permissions, you can configure the default settings that determine how often the Recommended Updates notification is sent. When new users are added to Confluence, the default settings will be applied to their user profiles.

Confluence users can choose their personal settings, which will override the defaults. See Subscribing to Email Notifications of Updates to Confluence Content.

**Initial settings of the defaults**

When you install Confluence, the initial values of the default settings are as follows:

- The default frequency is weekly.
- If your Confluence site has public signup enabled, the Recommended Updates notification is disabled by default. If public signup is not enabled, the notification is enabled by default.
You can change the above settings, specifying a different default value for the site.

Notes:

- The Recommended Updates notification is sent only to people who have a user profile in Confluence. If your Confluence site uses external user management, such as LDAP, then people will receive the report only after they have logged in for the first time. (The first login creates their user profile.)
- The daily email message is sent at 1 p.m. in the user's configured time zone.
- The weekly email message is sent at 1 p.m. on Thursdays in the user's configured time zone.

On this page:

- Initial settings of the defaults
- Configuring the Recommended Updates notification
- Disabling the Recommended Updates notification for the entire site

Related pages:

- Subscribing to Email Notifications of Updates to Confluence Content
- Confluence Administrator's Guide

Configuring the Recommended Updates notification

You can set the default send option (send / do not send) and the default schedule (daily or weekly).

To configure the Recommended Updates email notification:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click Recommended Updates Email in the left-hand panel.

Disabling the Recommended Updates notification for the entire site

You can also turn off the recommended updates notification for the entire site, by disabling the 'Confluence daily summary email' plugin. See Disabling and Enabling Add-ons.

The Mail Queue

Email messages waiting to be sent are queued in a mail queue and periodically flushed from Confluence once a minute. A Confluence administrator can also manually flush messages from the mail queue.

If there is an error sending messages, the failed email messages are sent to an error queue from which you can either try to resend them or delete them.

To view the mail queue:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Mail Queue in the left-hand panel. This will display the email messages currently in the queue.
3. Choose Flush Mail Queue to send all email messages immediately.
4. Choose Error Queue to view failed email messages. You can try to Resend the messages, which will flush the mails back to the mail queue, or you can Delete them from here.

Related pages:

- Configuring a Server for Outgoing Mail
- Setting Up a Mail Session for the Confluence Distribution

⚠️ The information on this page does not apply to Confluence OnDemand.

Configuring Character Encoding

This page explains the encoding settings that are applicable in Confluence and how they relate to application behaviour.
To avoid problems with character encoding, make sure the encoding used across the different components of your system are the same. In general, **always set all character encodings to UTF-8**:

- **Database** – see Configuring Database Character Encoding. *Not applicable to Confluence OnDemand.*
- **Application server** – see Configuring URL Encoding on Tomcat Application Server. *Not applicable to Confluence OnDemand.*
- **Confluence character encoding** – described below.

**Configuring the Confluence character encoding**

By default, Confluence uses UTF-8 character encoding to deliver its pages.

**Note:** While it is possible to change the character encoding, we recommend that you leave this as it is unless you are certain of what you are doing.

In summary: Changing the Confluence character encoding will change your HTTP request and response encoding and your filesystem encoding as used by exports and Velocity templates.

**To change the Confluence character encoding via the UI:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Enter the new character encoding of your choice in the text box next to Encoding.
5. Choose Save.

**Note:** At runtime, the character encoding is available in Settings.defaultEncoding.

**More details about character encoding**

There are three places where character encoding matters to Confluence:

1. **Database encoding** - usually the most important; it is where almost all user data is stored.
2. **Filesystem encoding** - important for attachment storage (pre-2.2), reading Velocity templates and writing exported files.
3. **HTTP request and response encoding** - important for form parsing, correct rendering by the browser and browser interpretation of encoded URLs.

Problems generally arise when Confluence thinks one of the above encoding is different to what it actually is. For example, Confluence might believe the database is using ISO-8859-1 encoding, when in fact it is UTF-8 encoded.

In certain cases (for example, Microsoft Windows), it might not be possible to use a fully Unicode filesystem (that is, a default Windows installation does not support Unicode filenames properly). If so, keep UTF-8 for the other two and be aware that your operating system might have limitations around international attachments (pre-2.2), backup and restore of international data, etc.
Java character encoding

Java always uses the multibyte UTF-16 character encoding for all String data*. This means that each of the encodings above defines how, at that particular point, characters are converted to and from Java's native UTF-16 format into some other format that the browser, filesystem or database might understand.

So when a request comes in to Confluence, we convert it from the request encoding to UTF-16. Then we store that data into the database, converting from UTF-16 to the database's encoding. Retrieving information from the database and sending it back to the browser is the same process in the opposite direction.

*A char represents single Unicode code point from the Base Multilingual Plane (BMP), encoded as UTF-16. Multiple chars are used as surrogate pairs for characters beyond U+FFFF.

Confluence character encoding

The Confluence character encoding is used in the following parts of the system:

- ConfluenceWebWorkConfiguration sets webwork.i18n.encoding to the this encoding, which WebWork uses in the response Content-Type header.
- AbstractEncodingFilter sets the HTTP request encoding to this encoding. This seems unnecessary, since the Content-Type header from the client should include the encoding used. This affects form submissions and file uploads.
- VelocityUtils reads in Velocity templates using this encoding when reading templates from disk.
- AbstractXmlExporter creates its output using this encoding.
- GeneralUtil uses this encoding when doing URLEncode and URLDecode. Different browsers have different support for character sets in URLs, so it's uncertain how much benefit this provides.

See Configuring Confluence Character Encoding (described above.)

Database encoding

The database encoding is the responsibility of your JDBC drivers. The drivers are responsible for reading and writing from the database in its native encoding and translating this data to and from Java Strings (which are UTF-16). For some drivers, such as MySQL, you must set Unicode encoding explicitly in the JDBC URL. For others, the driver is smart enough to determine the database encoding automatically.

Ideally, your database itself should be in a Unicode encoding (and we recommend doing this) for the simplest

---

The information on this page does not apply to Confluence OnDemand.
configuration), but that is not necessary as long as:

- the database encoding supports all the characters you want to store in Confluence
- your JDBC drivers can properly convert from the database encoding to UTF-16 and vice-versa.

See Configuring Database Character Encoding.

### Filesystem encoding

The filesystem encoding is mostly ignored by Confluence, except for the cases where the above configuration setting above plays a part (exports, velocity). When attachments are uploaded, they are written as a stream of bytes directly to the filesystem. It is the same when they are downloaded: the bytes from the file InputStream are written directly to the HTTP response.

In some places in Confluence, we use the default filesystem encoding as determined by the JVM and stored in the `file.encoding` system property (it can be overridden by setting this property at startup). This encoding is used by the Java `InputStreamReader` and `InputStreamWriter` classes by default. This encoding should probably never be used; for consistent results across all filesystem access we should be using the encoding set in the General Configuration.

In certain cases we explicitly hard-code the encoding used to read or write data to the filesystem. Two important examples are:

- importing Mbox mailboxes which are known to be ISO-8859-1
- Confluence Bandana config files are always stored as UTF-8.

Some application servers, Tomcat for example, have an encoding setting that modifies Confluence URLs before they reach the application. This can prevent access to international pages and attachments (really anything with international characters in the URL). See configuring your Application Server URL encoding.

### Problems with character encodings

If Confluence has the wrong idea about encoding for one of the above, it manifests itself in different ways:

1. Incorrect database encoding - user data is corrupted between saving and restoring from the database. This often happens after a delay, as we cache data as it is written to the database and only later retrieve the corrupted copy from the database.
2. Incorrect/non-Unicode filesystem encoding - international filenames break attachment download/upload/removal (pre-2.2); exports break with international content or attachments.
3. Incorrect HTTP encoding - incorrect encoding selected by browser, resulting in incorrect rendering of characters. Changing browser encoding causes page to render properly. Broken URLs when linking to pages or attachments with non-ASCII characters.

See Troubleshooting Character Encodings.

### Notes

- Mac users please note that **MacRoman** encoding is compatible with UTF-8. You do not need to change your encoding settings if you are already using MacRoman.
- This is a good article by Joel Spolsky: The Absolute Minimum Every Software Developer Absolutely, Positively Must Know About Unicode and Character Sets (No Excuses!)

### Troubleshooting Character Encodings

Often users may have problems with certain characters in a Confluence instance. Symptoms may include:

- Non-ASCII characters appearing as question marks (?)
- Page links with non-ASCII characters not working
- Single characters being displayed as two characters
- Garbled text appearing
In most cases, it is due to a mis-configuration in one of the components that Confluence uses.

⚠ The information on this page does not apply to Confluence OnDemand.

Follow these steps to diagnose the problem.

1. Run the encoding test

Confluence includes an encoding test that can reveal problems with your configuration.

To perform the test, access the Encoding Test page via the <confluence base-url>/admin/encodingtest.action page on your Confluence instance. You will be required to copy and paste a line of text and submit a form. The test will take the text and pass it through Confluence, the application server and the database, and return the results.

You should also test pasting some sample text (Japanese for example) if you are experiencing problems with a specific language.

Example:

http://confluence.atlassian.com/admin/encodingtest.action

or

http://<host address>:<port>/admin/encodingtest.action

⚠ If the text displayed in the encoding test is different to what was entered, then there are problems with your character encoding settings.

A successful test looks like the following:

Screenshot: Successful encoding test
2. Ensure the same encoding is used across all components

As mentioned in the Configuring Encoding document, the same character encoding should be used across the database, application server and web application (Confluence).

- To change the character encoding used in Confluence, see Configuring Character Encoding.
- To change the character encoding used in the application server, please ensure you set the Application Server URL encoding and view your application server's documentation on any other settings required to enable your encoding.
- To change the character encoding used in the database, see Configuring Database Character Encoding.

3. Requesting support

If there are still problems with character encoding after following the above steps, create a support request, and our support staff will aid in solving your problem.

Entering in the following details will help us to identify your problem:

- Attach screenshots of the problem
- Attach the results of the encoding test (above)
- Select which application server (and version) you are using
- Select which database (and version) you are using

MySQL 3.x

MySQL 3.x is known to have some problems with the upper- and lower-casing of some characters, and may fail the last two tests. For more information, see MySQL 3.x Character Encoding Problems.
Copy the contents of the System Information page into the 'Description' field.

"€" Euro character not displaying properly.

The € (euro) symbol is a three byte character, with byte values in file (UTF-8) of 0xE2, 0x82, 0xAC.

Sometimes, if the character encoding is not set consistently among all participating entities of the system, Confluence, server and the database, one may experience strange behaviour.

... I write a page with a Euro sign in it (€). All is well, the Euro sign shows up in the wiki markup text-box, and the preview, and the display of the saved page.

One day later, the Euro sign has changed into a question mark upside down!

... What is going on? Why does the Euro sign mysteriously change? How do I prevent it?

Interestingly enough the character encoding test passes with no problems, demonstrating that Confluence and the connected Database both recognise the € symbol.

The information on this page does not apply to Confluence OnDemand.

There are two potential reasons for this behaviour:

Database and Confluence is using utf-8 encoding. The connection is not.

When data transferred to it via the connection which does not use utf-8 encoding gets encoded incorrectly. Hence, updating the connection encoding may resolve this problem from now on, yet it probably would not affect already existing data.

Database is not using utf-8. Confluence and your connection are.

If your Database encoding is not set to UTF-8, yet is using some other encoding such as latin1, it could be one of the potential reasons why you lose the "€" characters at some stage. It could be occurring due to caching.

When Confluence saves data to the database, it may also keep a local cached copy. If the database encoding is set incorrectly, the Euro character may not be correctly recorded in the database, but Confluence will continue to use its cached copy of that data (which is encoded correctly). The encoding error will only be noticed when the cache expires, and the incorrectly encoded data is fetched from the database.

For instance the latin1 encoding would store and display all 2-byte UTF8 characters correctly except for the euro character which is replaced by '?' before being stored. As Confluence's encoding was set to UTF-8, the 2-byte UTF-8 characters were stored in latin1 database assuming that they were two latin1 different characters, instead of one utf8 character. Nevertheless, this is not the case for 3-byte utf8 characters, such as the Euro symbol.

Please ensure that you set the character encoding to UTF-8 for all the entities of your system as advised in this guide.

MySQL 3.x Character Encoding Problems

MySQL 3.x is known to have some problems upper- and lower-casing certain (non-ASCII) characters.

Diagnosing the problem

1. Follow the instructions for Troubleshooting Character Encodings.
2. If the upper- and lower-cased strings displayed on the Encoding Test are different, then your database is probably affected.

An example (faulty) output of the Encoding Test is shown below:

The information on this page does not apply to Confluence OnDemand.

Screenshot: Encoding Test Output (excerpt)
Solution

Upgrade to a newer version of MySQL. (4.1 is confirmed to work.)

Other Settings

- Configuring a WebDAV client for Confluence
- Configuring HTTP Timeout Settings
- Configuring Number Formats
- Configuring Shortcut Links
- Configuring Time and Date Formats
- Enabling the Remote API
- Enabling Threaded Comments
- Enabling Trackback
- Installing a Language Pack
- Installing Patched Class Files

Configuring a WebDAV client for Confluence

WebDAV allows users to access Confluence content via a WebDAV client, such as 'My Network Places' in Microsoft Windows. Provided that the user has permission, they will be able to read and write to spaces, pages and attachments in Confluence. Users will be asked to log in and the standard Confluence content access permissions will apply to the equivalent content available through the WebDAV client.

Introduction to Confluence's WebDAV Client Integration

By default, all WebDAV clients have permission to write to Confluence. Write permissions include the ability for a WebDAV client to create, edit, move or delete content associated with spaces, pages and attachments in a Confluence installation.

On the 'WebDAV Configuration' screen in the Confluence Administration Console, you can:

- Deny a WebDAV client write permissions to a Confluence installation using a regular expression (regex).
- Disable or enable strict path checking.
- Enable or disable access to specific virtual files/folders.

Note:

- The 'WebDav Configuration' page is only be available if the WebDAV plugin has been enabled. Note that this plugin is bundled with Confluence, and can be enabled or disabled by the System Administrator.
- The settings on the 'WebDav Configuration' page do not apply to external attachment storage configuration.

Restricting WebDAV Client Write Access to Confluence

In earlier versions of the WebDAV plugin, separate options for restricting a WebDAV client's write permissions (that is, create/move, edit and delete actions), were available. However, in the current version of this plugin, they...
have been simplified and combined into a general write permission restriction that covers all of these actions.

WebDAV clients are now denied write permission to your Confluence installation by setting a regex that matches specific content within the WebDAV client's user agent header. Upon setting a regex, it will be added to a list of restricted WebDAV clients. Any WebDAV clients whose user agent header matches a regex in this list will be denied write permission to your Confluence installation.

```
Example: A PROPFIND method header generated by a Microsoft Web Folder WebDAV client, showing the user agent header field:

PROPFIND /plugins/servlet/confluence/default HTTP/1.1
Content-Language: en-us
Accept-Language: en-us
Content-Type: text/xml
Translate: f
Depth: 1
Content-Length: 489
User-Agent: Microsoft Data Access Internet Publishing Provider DAV
Host: 127.0.0.1:8082
Connection: Keep-Alive
```

**Note:** Unlike earlier versions of the WebDAV plugin which could only restrict write permissions for all WebDAV clients, the current version of this plugin allows you to restrict write permissions to specific WebDAV clients selectively.

**To restrict a WebDAV client’s write access permissions to your Confluence installation:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘WebDav Configuration’ in the left panel. The ‘WebDAV Configuration’ page is displayed.
3. Enter a regex that matches a specific component of the user agent header sent by the WebDAV client you want to restrict.
4. Click the ‘Add new regex’ button. The regex is added to the list of restricted WebDAV clients.
   You can repeat steps 3 and 4 to add a regex for each additional WebDAV client you want to restrict.
5. Click the ‘Save’ button to save the configuration changes.

**To restore one or more restricted WebDAV client’s write access permissions to your Confluence installation:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click ‘WebDav Configuration’ under ‘Configuration’ in the left panel. The ‘WebDAV Configuration’ page
is displayed.

3. Select the regex(es) from the list that match(es) the user agent header sent by the restricted WebDAV client(s) you want to restore.

4. Click the 'Remove selected regexes' button. The regexes you had selected are removed from the list of restricted WebDAV clients.

5. Click the 'Save' button to save the configuration changes.

Screenshot: WebDAV configuration

Disabling Strict Path Checking

If you observe any idiosyncrasies with your WebDAV client, such as a folder that does exist on your Confluence site but is missing from the client, you can disable the WebDAV plugin's strict path checking option, which may minimise these problems.

To disable the WebDAV plugin's strict path checking option:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'WebDAV Configuration' under 'Configuration' in the left panel. The 'WebDAV Configuration' page is displayed.
3. Clear the 'Disable strict path check' check box.
   - You can re-enable this option at a later point in time by simply selecting this check box.
4. Click the 'Save' button to save this configuration change.

Virtual Files and Folders

In the unlikely event that you observe any problems with the WebDAV client's performance or stability, you can enable access to automatically generated (that is, virtual) files and folders.

Note:

By default, these options are hidden on the 'WebDAV Configuration' page. To make them visible, you must append the parameter ?hiddenOptionsEnabled=true to the end of your URL and reload the page. For example:
To enable or disable access to virtual files and folders:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'WebDAV Configuration' under 'Configuration' in the left panel. The 'WebDAV Configuration' page is displayed.
3. Amend your URL as described in the note above and reload the 'WebDAV Configuration' page.
4. Select or clear the check box options in the 'Virtual Files and Folders' section as required.
5. Click the 'Save' button to save the configuration changes.

Using a WebDAV Client to Work with Pages

The following sections tell you how to set up a WebDAV client natively for a range of different operating systems. WebDAV clients typically appear as drives in your operating system's file browser application, such as Windows Explorer in Microsoft Windows, or Konqueror in Linux.

Setting Up a WebDAV Client in Microsoft Windows

This section covers the two methods for configuring a WebDAV client natively in Microsoft Windows:

- As a network drive
- As a web folder

If possible, use the network drive method as this will enable more comprehensive WebDAV client interaction with Confluence than that provided by a web folder. However, your Confluence instance must meet several environmental constraints if you use this method. If you cannot configure your instance to meet these requirements, then use the web folder method or third-party WebDAV client software.

If you run into any problems with the procedures in this section, please refer to the Troubleshooting WebDAV page.

Windows Network Drive

To map a Confluence WebDAV client network drive, your Confluence instance must be configured so that all of the following criteria is met:

- Uses HTTP (not HTTPS)
- Listens on port 80 (not 8080, which is the default port value used by the popular application server Apache Tomcat that runs many Confluence EAR / WAR installations, or 8090, the default for Confluence distributions)
- Has no context root
There is an issue (WBDV-208) that can prevent Network Drives from being mapped. Please use the Network Folders steps below as a workaround.

The reason for these restrictions results from limitations in Microsoft's Mini-Redirector component. For more information, please refer to Microsoft's server discovery issue.

To map a Confluence WebDAV client network drive in Microsoft Windows:

1. In Windows XP, go to My Computer -> Tools menu -> Map Network Drive.
   In Windows Vista, go to Computer -> Map Network Drive.
   The 'Map Network Drive' dialog box opens.
2. Specify the following input to map the WebDAV client as a network drive:
   - **Drive:** <Any drive letter> (for example, Z:)
   - **Folder:** \<hostname\>\webdav (for example, \localhost\webdav)
3. Click 'Finish'.
   When prompted for login credentials, specify your Confluence username and password.

Windows Web Folder

To map a Confluence WebDAV client web folder in Windows XP:

1. Go to My Network Places and choose 'Add a network place'. The 'Add Network Place Wizard' opens.
2. Click 'Next', ensure that 'Choose another network location' is selected and then click 'Next' again.
3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, http://<confluence server url>/confluence/plugins/servlet/confluence/default or http://<confluence server url>/plugins/servlet/confluence/default) and then click 'Next'.
   When prompted for login credentials, specify your Confluence username and password.
4. Provide a meaningful name for your web folder and proceed with the remainder of the wizard.
5. Click 'Finish'.

Screenshot: A Confluence WebDAV Client Web Folder in Windows XP

To map a Confluence WebDAV client web folder in Windows Vista:
This procedure is very similar to the one for Windows XP. However, the following procedure includes the slight interface differences that are specific to Windows Vista.

1. Open the 'Map Network Drive' dialog box (refer to first step of the procedure above for mapping a network drive).
drive) and choose ‘Connect to a Web site that you can use to store your documents and pictures’.  
The 'Add Network Location' wizard opens.
2. Click ‘Next’, ensure that ‘Choose a custom network location’ is selected and then click ‘Next’ again.
3. In the 'Internet or network address' field, enter the URL for the Confluence WebDAV location (for example, http://<confluence server
url>/confluence/plugins/servlet/confluence/default or http://<confluence server
url>/plugins/servlet/confluence/default) and then click ‘Next’.
   When prompted for login credentials, specify your Confluence username and password.
4. Provide a meaningful name for your network location/web folder and proceed with the remainder of the wizard.
5. Click ‘Finish’.

Setting up a WebDAV client in Linux or Solaris

There are many tools and mechanisms available for configuring WebDAV clients in these operating systems. Therefore, we have chosen to demonstrate this using the file manager Konqueror, which is part of the Linux K Desktop Environment.

To set up a Confluence WebDAV client in Konqueror:

1. Open Konqueror.
2. In the 'Location' field, enter the URL for the Confluence WebDAV location using the 'protocol' webdavs (for example, webdavs://<confluence server
url>/confluence/plugins/servlet/confluence/default or webdavs://<confluence server
url>/plugins/servlet/confluence/default) and press Enter.
   If prompted for login credentials, specify your Confluence username and password.
   You should be able to click to load many, but not all files. In practice, you would normally save a modified file locally, then drag it to the Konqueror window to upload it to Confluence.

Known Issues

Please refer to the WebDAV plugin documentation for a description of the known issues and suggested workarounds.

RELATED TOPICS

Configure a WebDAV client for Confluence (Confluence 5.0)
Attachment Storage Configuration (Confluence 5.0)
Important Directories and Files (Confluence 5.0)
Administrators Guide Home Confluence Documentation Home

Configuring HTTP Timeout Settings

When macros such as the RSS Macro make HTTP requests to servers which are down, a long timeout value is used. You can set this timeout value through a system parameter to avoid this.

To configure the HTTP Timeout Settings:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'General Configuration' under the 'Configuration' heading in the left-hand panel.
3. Find the 'Connection Timeouts' section in the lower portion of the screen.
4. Click 'Edit' to adjust the settings:
   • Adjust External connections enabled: This setting allows system administrators to disable external connections so macros like the RSS Macro won't be allowed to make connections to an external server. It's provides protection against external servers providing insecure HTML, timing out or causing performance problems. The default setting is 'true'.
- **Connection Timeout (milliseconds):** Sets the maximum time for a connection to be established. A value of zero means the timeout is not used. The default setting is ten seconds (10000).
- **Socket Timeout (milliseconds):** Sets the default socket timeout (SO_TIMEOUT) in milliseconds, which is the maximum time Confluence will wait for data. A timeout value of zero is interpreted as an infinite timeout. The default setting is ten seconds (10000).

### Configuring Number Formats
There are two number format settings in Confluence:

- Long number format. For example: #############
- Decimal number format. For example: #############.#############

Confluence uses the guidelines in this Java document from Oracle: [Class NumberFormat](#).

### To change the number formats in Confluence:
1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **General Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Update the **Long Number Format** and **Decimal Number Format** to suit your requirements.
5. Choose **Save**.

### Related pages:
- Choosing a Default Language Not applicable to Confluence OnDemand.
- Installing a Language Pack Not applicable to Confluence OnDemand.
- Content Index Administration Not applicable to Confluence OnDemand.
- Rebuild the Content Indices from Scratch
- Creating a Lowercase Page Title Index Not applicable to Confluence OnDemand.
- Confluence Administrator's Guide

### Configuring Shortcut Links
Shortcut links provide a quick way of linking to resources that are frequently referenced from Confluence. When you create a shortcut link, you assign a key to an URL so that, when editing, a user can type just the key instead of the complete URL.

**Example: Creating a shortcut to Google**
Most Google searches look like this: `http://www.google.com/search?q=`. If you create a shortcut for this search with the key 'google', every time a user needs to use `http://www.google.com/search?q=searchterms`, they can just type `@google` instead.

Here is a screenshot showing the shortcuts currently defined on `http://confluence.atlassian.com`:

<table>
<thead>
<tr>
<th>Key</th>
<th>Expanded Value</th>
<th>Default Alias</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>cache</td>
<td><code>http://www.google.com/search?q=cache:</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>imdb</td>
<td><code>http://us.imdb.com/Tt?</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>jira</td>
<td><code>http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=</code></td>
<td>JIRA Issue %s</td>
<td>Remove</td>
</tr>
<tr>
<td>googlegroups</td>
<td><code>http://groups.google.com/groups?q=</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>google</td>
<td><code>http://www.google.com/search?q=</code></td>
<td></td>
<td>Remove</td>
</tr>
<tr>
<td>dictionary</td>
<td><code>http://www.dict.org/bin/DictDatabase=%26Form=Dict1&amp;Strategy=%26Query=</code></td>
<td></td>
<td>Remove</td>
</tr>
</tbody>
</table>

Shortcut links are added and maintained by Confluence administrators from the **Administration Console**.
Creating shortcut links

To create a shortcut link:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Shortcut Links in the left-hand panel.
3. Enter a Key for your shortcut. This is the shortcut name a user will use to reference the URL.
4. Enter the Expanded Value. This is the URL for the link. You can use ‘%s’ in the URL to specify where the user’s input is inserted. If there is no ‘%s’ in the URL, the user’s input will be put at the end.
5. (Optional. Available in Confluence version 2.3 and later.) Enter a Default Alias. This is the text of the link which will be displayed on the page where the shortcut is used, with the user’s text being substituted for ‘%s’.
6. Choose Submit.

Using shortcut links

Enter a shortcut link on the Advanced tab of the Insert Link dialog. See Linking to Pages for details.

Specify in the link what should be appended to the end of the shortcut URL, followed by an at-sign (@) and the key of the shortcut. Shortcut names are case-insensitive. So, for example, using the keys shown in the above screenshot:

<table>
<thead>
<tr>
<th>To link to...</th>
<th>Type this</th>
<th>Resulting URL</th>
<th>Demonstration</th>
</tr>
</thead>
<tbody>
<tr>
<td>a JIRA issue</td>
<td>CONF-1000@JIRA</td>
<td><a href="http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=CONF-1000">http://jira.atlassian.com/secure/QuickSearch.jspa?searchString=CONF-1000</a></td>
<td>CONF-1000</td>
</tr>
<tr>
<td>a Google search</td>
<td>Atlassian</td>
<td><a href="http://www.google.com/search?q=Atlassian+Confluence">http://www.google.com/search?q=Atlassian+Confluence</a></td>
<td>Atlassian</td>
</tr>
<tr>
<td></td>
<td>Confluence@Google</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Deleting shortcut links

Shortcut links are listed on the Shortcut Links tab of the Administration Console. Click Remove to delete the shortcut.

Configuring Time and Date Formats

You can localise the formats that Confluence uses to display dates and times within the web interface. The settings use the syntax of Java’s SimpleDateFormat class, as described in this document: Java 1.4.2 SimpleDateFormat API.

There are three time and date format settings:

- Time format: Used when displaying only the time of day. For example, when a blog post is published.
  Example of configuration: h:mm a
To change the time and date formats:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose General Configuration in the left-hand panel.
3. Choose Edit.
4. Enter the values for Time Format, Date Time Format and Date Format, to suit your requirements.
5. Choose Save.

Related pages:

- Choosing a Default Language Not applicable to Confluence OnDemand.
- Installing a Language Pack Not applicable to Confluence OnDemand.
- Confluence Administrator's Guide

Enabling the Remote API

Confluence provides XML-RPC and SOAP remote APIs (application programming interfaces). You need to enable the APIs from the Administration Console before you can access Confluence remotely.

You need System Administrator permissions in order to perform this function.

To enable the remote API:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click General Configuration in the left-hand panel.
3. Click Edit.
4. Click the check box next to Remote API (XML-RPC & SOAP).
5. Click Save.

Related pages:

Confluence Remote API Reference

⚠️ The information on this page does not apply to Confluence OnDemand.

Enabling Threaded Comments

Comments on pages or blog posts are displayed in one of two views:

- **Threaded**: Shows the comments in a hierarchy of responses. Each reply to a comment is indented to indicate the relationships between the comments.
- **Flat**: Displays all the comments in one single list and does not indicate the relationships between comments.

By default, comments are displayed in threaded mode. A Confluence Administrator (see Global Permissions Overview) can enable or disable the threaded view for the entire Confluence site.

To enable or disable the threaded view:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select General Configuration in the left-hand panel.
3. Click Edit.
4. Check Threaded Comments to enable threaded mode. Clear the check box to disable threaded mode and display all comments in flat mode.
5. Click Save.
Enabling Trackback

When Trackback is enabled, any time you link to an external webpage that supports Trackback Autodiscovery, Confluence will send a trackback ping to that page to inform it that it has been linked to.

Confluence pages also support Trackback Autodiscovery and when Trackback is enabled, can receive trackback pings sent by other sites.

To enable trackback,

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'General Configuration' in the left panel.
3. In the 'Feature Settings' screen, click 'Edit'.
4. Select "On" beside 'Trackback' and click 'Save'.

RELATED TOPICS

- Running Confluence Over SSL or HTTPS (Confluence 5.0)
- Managing External Referrers (Confluence 5.0)
- Hiding external referrers (Confluence 5.0)
- Excluding external referrers (Confluence 5.0)
- Ignoring External Referrers (Confluence 5.0)
- Hiding External Links From Search Engines (Confluence 5.0)
- Anonymous Access to Remote API (Confluence 5.0)
- Configuring Captcha for Failed Logins (Confluence 5.0)
- Hiding the People Directory (Confluence 5.0)
- Configuring Captcha for Spam Prevention (Confluence 5.0)
- User Email Visibility (Confluence 5.0)
- Configuring the Administrator Contact Page (Confluence 5.0)

Installing a Language Pack

Confluence ships with a number of bundled language packs. These languages appear as options on the 'Language Configuration' screen in the Administration Console when choosing a default language and as 'Language' options for users in their user settings. You can make additional languages available for selection by installing language packs. Please note, you must be a Confluence administrator to install a language pack.

Language packs are plugins. The process of installing a language pack is the same as installing a new plugin.

The information on this page does not apply to Confluence OnDemand.
Installing a Language Pack using the Universal Plugin Manager

To install a language pack using the Universal Plugin Manager:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Find New Add-ons in the left-hand panel.
3. Find the language pack on the Atlassian Marketplace.
4. Choose Install to install the language pack.

Installing a Language Pack Manually

To install a language pack manually, you will need to upload the language pack plugin as described below. The language pack plugin will be enabled by default once you have installed it.

Plugins are distributed as JAR or OBR (OSGi Bundle Repository) files. To install a plugin:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Manage Add-ons.
3. Choose Upload Plugin.
4. Choose Browse to find the plugin file you wish to install from your hard drive and select it, or enter a network location by URL.
5. Choose Upload.
   The plugin will be uploaded to Confluence and will be automatically installed.
6. Check the list of user-installed plugins to ensure that the add-on is available.
7. Enable the plugin if necessary. (Some plugins will be enabled by default when they are installed. Others will have to be manually enabled from the 'Manage Add-ons' page.)

Finding more Language Packs

- You can download official language packs from the Atlassian Marketplace. You can also download language packs developed by the Confluence user community from the Language Pack Translations page.

Showing User Interface Key Names for Translation

This feature is useful if you are working on creating translations of the Confluence user interface. After opening the Confluence dashboard, you can add this text to the end of your Confluence URL:

?i18ntranslate=on

Then press Enter.

This will cause each element of the user interface to display its special key name. This makes it easier to find the context for each key within the user interface. You can then search for the key on http://translations.atlassian.com where you can enter an appropriate translation for your custom language pack.

The key names are displayed with a 'lightning bolt' graphic. For example:

Dashboard\title.dashboard

To turn off the translation view, add this code to the end of the Confluence URL:

?i18ntranslate=off

Installing Patched Class Files
Atlassian support or the Atlassian bug-fixing team may occasionally provide patches for critical issues that have been resolved but have not yet made it into a release. Those patches will be class files which are attached to the relevant issue in our JIRA bug-tracking system.

⚠️ The information on this page does not apply to Confluence OnDemand.

### Installation Instructions for the Confluence Distribution

Follow these steps to install a patched class file:

1. Shut down your confluence instance.
2. Copy the supplied class files to `<installation-directory>/confluence/WEB-INF/classes/<subdirectories>`, where:
   - `<installation-directory>` must be replaced with your Confluence Installation directory. (If you need more information, read about the Confluence Installation Directory.)
   - `<subdirectories>` must be replaced by the value specified in the relevant JIRA issue. This value will be different for different issues. In some cases, the subdirectories will not exist and you will need to create them before copying the class files. Some issues will contain the patch in the form of a ZIP file which will contain the desired directory structure.
3. Restart your Confluence instance for the changes to become effective.

Class files in the `/WEB-INF/classes` directory of a web application will be loaded before classes located in JAR files in the `/WEB-INF/lib` directory. Therefore, classes in the first directory will effectively replace classes of the same name and package which would otherwise be loaded from the JAR files.

### RELATED TOPICS

- How to Edit Files in Confluence JAR Files
- Configuring System Properties

This page describes how to set Java properties and options on startup for Confluence Stand-alone and EAR/WAR versions.

See How to Fix Out of Memory Errors by Increasing Available Memory for specific instructions for OutOfMemory Errors.

### Configuring System Properties

### Linux

To Configure System Properties in Linux Installations,

1. From `<confluence-install>/bin` (Stand-alone) or `<Tomcat-home>/bin` (EAR-WAR installation), open `setenv.sh`.
2. Find the section `JAVA_OPTS=`
3. Refer to the list of parameters below.

Add all parameters in a space-separated list, inside the quotations.

### Windows (starting from .bat file)
To Configure System Properties in Windows Installations When Starting from the .bat File,

1. From `<confluence-install>/bin (Stand-alone) or <Tomcat-home>/bin (EAR-WAR installation), open `setenv.bat`
2. Find the section `set JAVA_OPTS=%JAVA_OPTS%`
3. Refer to the list of parameters below.

   - Add all parameters in a space-separated list. Make sure to keep the string `%JAVA_OPTS%` in place.

Windows Service

There are two ways to configure system properties when you Start Confluence Automatically on Windows as a Service, either via command line or in the Windows Registry

**Setting Properties for Windows Services via Command Line**

1. Identify the name of the service that Confluence is installed as in Windows (Control Panel > Administrative Tools > Services):

   ![Control Panel showing the Windows service](image)

   - In the above example, the **SERVICENAME** is: JIRA030908110721. Find the Confluence equivalent.

2. Open the command window from Start >> Run >> type in 'cmd' >> Enter
3. `cd` to the bin directory of your Confluence instance, or the bin directory of your Tomcat installation if you are running Confluence EAR/WAR.
4. Run:

```
tomcat6w //ES//%SERVICENAME%
```

In the above example, it would be `tomcat6w //ES//JIRA030908110721`

5. Click on the `Java` tab to see the list of current start-up options:

6. Append any new option on its own new line by adding to the end of the existing Java Options. Refer to the list of parameters below.

**Setting Properties for Windows Services via the Windows Registry**

In some versions of Windows, there is no option to add Java variables to the service. In these cases, you must add the properties by viewing the option list in the registry.
To Set Properties for Windows Services via the Windows Registry,

1. Go to {{Start >> Run, and run "regedit32.exe".}}

2. Find the Services entry:
   - **32-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Apache Software Foundation >> Procrun 2.0 >> Confluence
   - **64-bit**: HKEY_LOCAL_MACHINE >> SOFTWARE >> Wow6432Node >> Apache Software Foundation >> Procrun 2.0 >> Confluence

3. To change existing properties, especially increasing Xmx memory, double-click the appropriate value.

4. To change additional properties, double-click options.

5. Refer to the list of parameters below. Enter each on a separate line.
Verifying Your Settings

To see what Confluence is using, check **Viewing System Properties**.

### Recognised System Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Since</th>
<th>Default Value</th>
<th>Module...</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>atlassian.forceSchemaUpdate</td>
<td>1.0</td>
<td>false</td>
<td>atlassian-config</td>
<td>By default, Confluence will only run its database schema update when it detects that it has been upgraded. This flag will force Confluence to perform the schema update on system startup.</td>
</tr>
<tr>
<td>confluence.home</td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
<td>If this system property is set, Confluence will ignore the contents of the confluence-init.properties file, and use this property as the setting for the Confluence Home directory.</td>
</tr>
<tr>
<td>confluence.devmode</td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
<td>Enables additional debugging options that may be of use to Confluence developers (additionally it changes spring bean creation to use lazy initialization by default to decrease startup time). Do not enable this flag on a production system.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Version</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>confluence.disnable.mailpolling</td>
<td>2.4</td>
<td>false</td>
<td>If set to &quot;true&quot;, will prevent Confluence from retrieving mail for archiving within spaces. Manually triggering &quot;check for new mail&quot; via the web UI will still work. This property has no effect on outgoing mail.</td>
<td></td>
</tr>
<tr>
<td>confluence.i18n.reloadbundles</td>
<td>1.0</td>
<td>true</td>
<td>Setting this property will cause Confluence to reload its i18n resource bundles every time an internationalised string is looked up. This can be useful when testing translations, but will make Confluence run <strong>insanely slowly</strong>.</td>
<td></td>
</tr>
<tr>
<td>confluence.ignore.debug.logging</td>
<td>1.0</td>
<td>true</td>
<td>Confluence will normally log a severe error message if it detects that DEBUG level logging is enabled (as DEBUG logging generally causes a significant degradation in system performance). Setting this property will suppress the error message.</td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Default</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
</tbody>
</table>
| confluence.jmx.disabled           | 3.0     | false   | Confluence
|                                   |         |          | If set to "true", will disable Confluence's JMX monitoring. This has the same effect as setting the "enabled" property to false in WEB-INF/classes/jmxCollections.xml. |
| confluence.optimize.index.module | 2.2     | 20      | Confluence
|                                   |         |          | Number of index queue flushes before the index is optimised. |
| confluence.plugins.bundled.disable| 2.9     | false   | Confluence
|                                   |         |          | Starts confluence without bundled plugins. May be useful in a development environment to make Confluence start quicker, but since bundled plugins are necessary for some of Confluence’s core functionality, this property should not be set on a production system. |
| atlassian.mail.fetchdisabled     | 3.5     | false   | Confluence
|                                   |         |          | Disables mail fetching services for IMAP and POP. |
| atlassian.mail.senddisabled      | 3.5     | false   | Confluence and atlassian-mail
<p>|                                   |         |          | Disables sending of mail. |</p>
<table>
<thead>
<tr>
<th>Property</th>
<th>Version</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>atlassian/disable.caches</td>
<td>2.4</td>
<td>true</td>
<td>Setting this property will disable conditional get and expires: headers on some web resources. This will significantly slow down the user experience, but is useful in development if you are frequently changing static resources and don't want to continually flush your browser cache.</td>
</tr>
<tr>
<td>confluence.html.encode.automatic</td>
<td>2.9</td>
<td>Confluence</td>
<td>Setting this property forces the antixss encoding on or off, overriding the behaviour dictated by settings. The default behaviour differs between Confluence versions.</td>
</tr>
<tr>
<td>org.osgi.framework.bootdelegation</td>
<td>2.10</td>
<td>empty</td>
<td>Comma-separated list of package names to provide from application for OSGi plugins. Typically required when profiling Confluence. For example: &quot;com.jprofiler,.com.yourkit.&quot;.</td>
</tr>
<tr>
<td>Setting</td>
<td>Value 1</td>
<td>Value 2</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.diff.pool.size</td>
<td>3.1</td>
<td>20</td>
<td>Confluence Maximum number of concurrent diffs. When that number is exceeded, additional attempts by RSS feeds to create diffs are ignored and logged. (The RSS requests succeed, they are just missing diffs).</td>
</tr>
<tr>
<td>confluence.diff.timeout</td>
<td>3.1</td>
<td>1000</td>
<td>Confluence Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>confluence.html.diff.timeout</td>
<td>4.0</td>
<td>10000</td>
<td>Confluence Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Version</td>
<td>Value</td>
<td>Setting</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>---------</td>
</tr>
<tr>
<td>Confluence.user.experimentalMapping</td>
<td>2.10</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>Confluence.import.use-experimental-importer</td>
<td>3.2</td>
<td>true</td>
<td>Confluence</td>
</tr>
<tr>
<td>Confluence.webrsource.disable.minification</td>
<td>3.3</td>
<td>true</td>
<td>atlassian-plugins</td>
</tr>
<tr>
<td>index.queue.read.count</td>
<td>3.3</td>
<td>true</td>
<td>Confluence</td>
</tr>
</tbody>
</table>
Sets the number of threads to be used for the reindex job. The value has to be in the range of 1 to 10 (inclusive), i.e. at least one thread but no more than 10 threads will be used. There is no default value, i.e.
If you don’t set `index.queue.thread.count`, the number of threads to be used are calculated based on the number of objects that need to be reindexed and the number of processors available (a maximum of 10 threads will be used).

- If you set `index.queue.thread.count=2`, then two threads will be used to reindex the content (regardless of the number of objects to be reindexed or the number of processors available).
- If you set `index.queue.thread.count=200`, then ten threads (the maximum allowed) will be used to reindex the content.
<table>
<thead>
<tr>
<th>Property</th>
<th>Value 1</th>
<th>Value 2</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>index.queue.batch.size</td>
<td>3.3</td>
<td>1500</td>
<td>Size of batches used by the indexer. Reducing this value will reduce the load that the indexer puts on the system, but indexing takes longer. Increasing this value will cause indexing to be completed faster, but puts a higher load on the system. Normally this setting does not need tuning.</td>
</tr>
<tr>
<td>password.confirmation.disabled</td>
<td>3.4</td>
<td>false</td>
<td>This property disables the password confirmation functionality that Confluence uses as an additional security measure. With this property set, Confluence will not require password confirmation for the following actions: administrative actions, change of email address and Captcha for failed logins. Disabling password confirmations is useful if you are using a custom authenticator.</td>
</tr>
<tr>
<td>Property</td>
<td>Value</td>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------</td>
<td>------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td>Confluence</td>
<td>Setting this property to &quot;false&quot; disables the detection of browser language headers, effectively restoring Confluence behaviour to that of earlier releases. Setting this property to &quot;true&quot; enables the detection of the language headers sent by the browser. Confluence will change the UI language based on the browser headers. See documentation on how users can choose a language preference.</td>
</tr>
<tr>
<td>upm.pac.disable</td>
<td>Universal Plugin Manager 1.5</td>
<td>Universal Plugin Manager (UPM)</td>
<td>When this property is set to true, then UPM will not try to access the Atlassian Plugin Exchange. This is useful for application servers that do not have access to the Internet. See the UPM documentation.</td>
</tr>
<tr>
<td>confluence.reindex.documents.to.pop</td>
<td>3.5.9</td>
<td>Confluence</td>
<td>Indicates how many objects each indexing thread should process at a time during a full re-index. Please note that this number does not include attachments</td>
</tr>
<tr>
<td>Configuration</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><code>confluence.reindex.attachments.to.pop</code></td>
<td>3.5.9</td>
<td>Indicates how many attachments each indexing thread should process at a time during a full re-index.</td>
<td></td>
</tr>
<tr>
<td><code>confluence.upgrade.active.directory</code></td>
<td>3.5.11</td>
<td>Forces Confluence to treat any LDAP directories it migrates as Active Directory, rather than relying on looking for sAMAccountName in the username attribute. This is necessary if you are upgrading from before Confluence 3.5, and need to use an attribute other than sAMAccountName to identify your users and are seeing LDAP: error code 4 - Sizelimit Exceeded exceptions in your logs. For more details, see Unable to Log In with Confluence 3.5 or Later Due to 'LDAP error code 4 - Sizelimit Exceeded'</td>
<td></td>
</tr>
<tr>
<td><code>confluence.context.batching.disable</code></td>
<td>4.0</td>
<td>Disables batching for web resources in contexts (e.g. editor, main, admin). Useful for diagnosing the source of javascript or CSS errors.</td>
<td></td>
</tr>
<tr>
<td>Configuration</td>
<td>Value</td>
<td>Description</td>
<td>Details</td>
</tr>
<tr>
<td>---------------</td>
<td>--------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>com.atlassian.logout.disable.session.invalidation</strong></td>
<td>4.0</td>
<td><code>false</code></td>
<td><strong>Confluence</strong> Disables the session invalidation on log out. As of 4.0 the default behaviour is to invalidate the JSession assigned to a client when they log out. If this is set to true the session is kept active (but the user logged out). This may be valuable when using external authentication systems, but should generally not be needed.</td>
</tr>
<tr>
<td><strong>officeconnector.spreadsheet.xlsxmaxsize</strong></td>
<td>4.0.5</td>
<td>$2^{21}$</td>
<td><strong>Office Connector</strong> Indicates the maximum size in bytes of an Excel file that can be viewed using the <code>viewxls</code> macro. If empty, the maximum size defaults to 2Mb. See CONF-21043 for more details.</td>
</tr>
<tr>
<td><strong>com.atlassian.confluence.extra.calendar3.display.events.calendar.maxpe rcalendar</strong></td>
<td>200</td>
<td></td>
<td><strong>Team Calendars</strong> Specifies the maximum number of events per calendar. This property is effective only if the Team Calendars plugin is installed on your Confluence site.</td>
</tr>
</tbody>
</table>
Confluence 5.0 Documentation

Recognised System Properties

Confluence supports some configuration and debugging settings that can be enabled through Java system properties. System properties are usually set by passing the `-D` flag to the Java virtual machine in which Confluence is running. See the full instructions: Configuring System Properties.

⚠️ The information on this page does not apply to Confluence OnDemand.

### Related Topics

- Recognised System Properties
- How to Fix Out of Memory Errors by Increasing Available Memory
- Recognised System Properties

Confluence allows Confluence to start up against the home directory of a newer version of Confluence. Note that running Confluence like that is unsupported. You should only turn this on if you know what you are doing. See After Downgrading, Confluence Will No Longer Run for details.

<table>
<thead>
<tr>
<th>Property</th>
<th>Since</th>
<th>Default Value</th>
<th>Module...</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>com.atlassian.confluence.allow.downgrade</td>
<td>4.3.2, 5.0-OD-10</td>
<td>false</td>
<td></td>
<td>Confluence allows Confluence to start up against the home directory of a newer version of Confluence. Note that running Confluence like that is unsupported. You should only turn this on if you know what you are doing. See After Downgrading, Confluence Will No Longer Run for details.</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
<td>Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.home</td>
<td>1.0</td>
<td>Any filesystem path</td>
<td>Confluence and atlassian-config</td>
<td>If this system property is set, Confluence will ignore the contents of the <code>confluence-init.properties</code> file, and use this property as the setting for the Confluence Home directory.</td>
</tr>
<tr>
<td>confluence.dev.mode</td>
<td>1.0</td>
<td>false</td>
<td>Confluence</td>
<td>Enables additional debugging options that may be of use to Confluence developers (additionally it changes spring bean creation to use lazy initialization by default to decrease startup time). Do not enable this flag on a production system.</td>
</tr>
<tr>
<td>confluence.disabled.mailpolling</td>
<td>2.4</td>
<td>false</td>
<td>Confluence</td>
<td>If set to &quot;true&quot;, will prevent Confluence from retrieving mail for archiving within spaces. Manually triggering &quot;check for new mail&quot; via the web UI will still work. This property has no effect on outgoing mail</td>
</tr>
<tr>
<td>Property</td>
<td>Value</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>confluence.i18n.reloadbundles</code></td>
<td>1.0</td>
<td>true</td>
<td>Confluence</td>
<td>Setting this property will cause Confluence to reload its i18n resource bundles every time an internationalised string is looked up. This can be useful when testing translations, but will make Confluence run <em>insanely slowly</em>.</td>
</tr>
<tr>
<td><code>confluence.ignore.debug.logging</code></td>
<td>1.0</td>
<td>true</td>
<td>Confluence</td>
<td>Confluence will normally log a severe error message if it detects that DEBUG level logging is enabled (as DEBUG logging generally causes a significant degradation in system performance). Setting this property will suppress the error message.</td>
</tr>
<tr>
<td><code>confluence.jmx.disabled</code></td>
<td>3.0</td>
<td>false</td>
<td>Confluence</td>
<td>If set to &quot;true&quot;, will disable Confluence's JMX monitoring. This has the same effect as setting the &quot;enabled&quot; property to false in <code>WEB-INF/classes/jmxCContext.xml</code>.</td>
</tr>
<tr>
<td><code>confluence.optimize.index.modulo</code></td>
<td>2.2</td>
<td>20</td>
<td>Confluence</td>
<td>Number of index queue flushes before the index is optimised.</td>
</tr>
<tr>
<td>Setting</td>
<td>Version</td>
<td>Value</td>
<td>Context</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>---------</td>
<td>-------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.plugins.bundled.disable</td>
<td>2.9</td>
<td>false</td>
<td>Confluence</td>
<td>Starts confluence without bundled plugins. May be useful in a development environment to make Confluence start quicker, but since bundled plugins are necessary for some of Confluence's core functionality, this property should not be set on a production system.</td>
</tr>
<tr>
<td>atlassian.mail.fetchdisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence</td>
<td>Disables mail fetching services for IMAP and POP</td>
</tr>
<tr>
<td>atlassian.mail.senddisabled</td>
<td>3.5</td>
<td>false</td>
<td>Confluence and atlassian-mail</td>
<td>Disables sending of mail</td>
</tr>
<tr>
<td>atlassian.disable.caches</td>
<td>2.4</td>
<td>true</td>
<td>atlassian-plugins, atlassian-cache-servlet</td>
<td>Setting this property will disable conditional get and expires: headers on some web resources. This will significantly slow down the user experience, but is useful in development if you are frequently changing static resources and don't want to continually flush your browser cache.</td>
</tr>
<tr>
<td>confluence.html.encode.automatic</td>
<td>2.9</td>
<td></td>
<td>Confluence</td>
<td>Setting this property forces the antixss encoding on or off, overriding the behaviour dictated by settings. The default behaviour differs between Confluence versions.</td>
</tr>
<tr>
<td>Package/Setting</td>
<td>Version</td>
<td>Value</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>org.osgi.frame</td>
<td>2.10</td>
<td>empty</td>
<td>atlassian-plugins</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Comma-separated list of package names to provide from application for OSGi plugins. Typically required when profiling Confluence. For example: &quot;com.jprofiler,.com.yourkit.&quot;</td>
<td></td>
</tr>
<tr>
<td>confluence.diff.pool.size</td>
<td>3.1</td>
<td>20</td>
<td>Confluence</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Maximum number of concurrent diffs. When that number is exceeded, additional attempts by RSS feeds to create diffs are ignored and logged. (The RSS requests succeed, they are just missing diffs).</td>
<td></td>
</tr>
<tr>
<td>confluence.diff.timeout</td>
<td>3.1</td>
<td>1000</td>
<td>Confluence</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
<td></td>
</tr>
<tr>
<td>confluence.html.diff.timeout</td>
<td>4.0</td>
<td>10000</td>
<td>Confluence</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Number of milliseconds to wait for a diff operation (comparing two page versions) to complete before aborting with an error message.</td>
<td></td>
</tr>
<tr>
<td>Property Name</td>
<td>Value</td>
<td>Type</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>atlassian.user.experimentalMapping</td>
<td>2.10</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes the relationship between local users and local groups to reduce performance degradation when adding a local user to a local group with a large number of users. Please note, setting this property can slow down other user management functions. We recommend that you set it only if you are experiencing performance problems when adding local users to large local groups. Please refer to CONF-12319, fixed in Confluence 3.1.1.</td>
</tr>
<tr>
<td>confluence.import.use-experimental-importer</td>
<td>3.2</td>
<td>false</td>
<td>Confluence</td>
<td>Setting this property changes Confluence to use the Experimental XML Importer. It is designed to be a more stable implementation but, at the time of the release of 3.2, the importer is largely untested and thus not supported.</td>
</tr>
<tr>
<td>atlassian.webresource.disable.minification</td>
<td>3.3</td>
<td>false</td>
<td>atlassian-plugins</td>
<td>Disables automatic minification of JavaScript and CSS resources served by Confluence.</td>
</tr>
<tr>
<td>index.queue.thread.count</td>
<td>3.3</td>
<td>See &quot;Effect&quot;</td>
<td>Confluence</td>
<td></td>
</tr>
</tbody>
</table>
Sets the number of threads to be used for the reindex job. The value has to be in the range of 1 to 10 (inclusive), i.e. at least one thread but no more than 10 threads will be used. There is no default value, i.e.
- If you don't set `index.queue.thread.count`, the number of threads to be used are calculated based on the number of objects that need to be reindexed and the number of processors available (a maximum of 10 threads will be used).
- If you set `index.queue.thread.count=2`, then two threads will be used to reindex the content (regardless of the number of objects to be reindexed or the number of processors available)
- If you set `index.queue.thread.count=200`, then ten threads (the maximum allowed) will be used to reindex the content.
<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>index.queue.batch.size</strong></td>
<td>3.3</td>
<td>Size of batches used by the indexer. Reducing this value will reduce the load that the indexer puts on the system, but indexing takes longer. Increasing this value will cause indexing to be completed faster, but puts a higher load on the system. Normally this setting does not need tuning.</td>
</tr>
<tr>
<td><strong>password.confirmation.disabled</strong></td>
<td>false</td>
<td>This property disables the password confirmation functionality that Confluence uses as an additional security measure. With this property set, Confluence will not require password confirmation for the following actions: administrative actions, change of email address and Captcha for failed logins. Disabling password confirmations is useful if you are using a custom authenticator.</td>
</tr>
<tr>
<td>Property</td>
<td>Value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>confluence.browser.language.enabled</td>
<td>3.5</td>
<td><strong>Confluence</strong> Setting this property to &quot;false&quot; disables the detection of browser language headers, effectively restoring Confluence behaviour to that of earlier releases. Setting this property to &quot;true&quot; enables the detection of the language headers sent by the browser. Confluence will change the UI language based on the browser headers. See documentation on how users can choose a language preference.</td>
</tr>
<tr>
<td>upm.pac.disable</td>
<td>Universal Plugin Manager 1.5</td>
<td><strong>Universal Plugin Manager (UPM)</strong> When this property is set to true, then UPM will not try to access the Atlassian Plugin Exchange. This is useful for application servers that do not have access to the Internet. See the UPM documentation.</td>
</tr>
<tr>
<td>confluence.reindex.documents.to.pop</td>
<td>3.5.9</td>
<td><strong>Confluence</strong> Indicates how many objects each indexing thread should process at a time during a full re-index. Please note that this number does not include attachments.</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td></td>
</tr>
<tr>
<td><strong>confluence.reindex.attachments.to.pop</strong></td>
<td>3.5.9</td>
<td>10</td>
</tr>
<tr>
<td><strong>confluence.upgrade.active.directory</strong></td>
<td>3.5.11</td>
<td>false</td>
</tr>
<tr>
<td><strong>confluence.content.batching.disable</strong></td>
<td>4.0</td>
<td>false</td>
</tr>
<tr>
<td>Property</td>
<td>Version</td>
<td>Value</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>com.atlassian.logout.disable.session.invalidation</td>
<td>4.0</td>
<td>false</td>
</tr>
<tr>
<td>officeconnector.spreadsheet.xlsxmaxsize</td>
<td>4.0.5</td>
<td>$2^{21}$</td>
</tr>
<tr>
<td>com.atlassian.confluence.ext.tra.calendar3.display.events.calendar.maxpercalendar</td>
<td>200</td>
<td></td>
</tr>
</tbody>
</table>
Confluence uses Apache’s log4j logging service. This allows a developer or administrator to control the logging behavior and the log output file by editing a configuration file, without touching the application binary. There are six known log4j logging levels.

If you request help from Atlassian Support, we will almost always ask for the atlassian-confluence.log from the confluence-home/logs directory. You can access the logs from the Confluence Administration Console, via the support tool. If you cannot access the Confluence Administration Console, check the properties file at <confluence-installation>/confluence/WEB-INF/classes/confluence-init.properties, look for the confluence.home setting in that file, then find the logs in the Confluence home directory.

On this page:
- Finding the Confluence Log Files
- Finding the Log Configuration File
- Changing the Destination of the Log Files
- Changing the Logging Levels
- Using Some Specific Confluence Logging Options
- Scanning Log Files for Known Problems
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.
Once the initial startup sequence is complete, all logging will be to \$CONFLUENCE-INSTALL\%/confluence/WEB-INF/classes/confluence-init.properties\%

Note that the default location is the Confluence home directory, not the application server's log file. The home directory is specified in \$CONFLUENCE-INSTALL\%/confluence/WEB-INF/classes/confluence-init.properties\%

Finding the Log Configuration File

Confluence's logging behaviour is defined in the following properties file:
\$CONFLUENCE-INSTALL\%/confluence/WEB-INF/classes/log4j.properties

This file is a standard log4j configuration file, as described in the Apache log4j documentation.

Changing the Destination of the Log Files

Terminology: In log4j, an output destination is called an 'appender'.

To change the destination of the log files, you need to stop Confluence and then change the settings in the 'Logging Location and Appender' section of the log4j.properties file. The location of this file is described above.

In the standard properties file, you will find entries for two appenders:

- com.atlassian.confluence.logging.ConfluenceHomeLogAppender – This is a custom appender which controls the default logging destination described above. This appender allows the following settings:
  - MaxFileSize
  - MaxBackupIndex

- org.apache.log4j.RollingFileAppender – If you want to log to a different location, uncomment the RollingFileAppender line and change the destination file in the line below it. Comment out the previous lines referring to the ConfluenceHomeLogAppender.

Confluence ships with the full suite of appenders offered by log4j. Read more about appenders in the log4j documentation.

Changing the Logging Levels

See Configuring Logging for instructions on how to change the logging configuration of Confluence.

Using Some Specific Confluence Logging Options

This section contains some pointers to specific log configurations you may need.

Log the Details of SQL Requests made to the Database

You may want to increase Confluence's logging so that it records individual SQL requests sent to the database. This is useful for troubleshooting specific problems.

You can enable detailed SQL logging in two ways:

- At runtime – see instructions above.
- Via the logging properties file – see the detailed instructions.

Log the Details of Users Viewing/Accessing each Confluence Page

You can configure the log to show which users are accessing which pages in Confluence. This can only be done
via the logging properties file – see the detailed instructions.

Scanning Log Files for Known Problems

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker. See Troubleshooting Problems and Requesting Technical Support.

Notes

- **Finding the thread dumps.** Thread dumps are logged to the application server log file.

**RELATED TOPICS**

Important Directories and Files
Enabling Detailed SQL Logging
Enabling user access logging
Generating a Thread Dump
Enabling Page Request Profiling
Troubleshooting Problems and Requesting Technical Support

Configuring Logging

We recommend that you configure Confluence's logging to your own requirements. You can change the log settings in two ways:

- Configure logging in Confluence Administration – Your changes will be in effect only until you next restart Confluence.
- Edit the properties file – Your changes will take effect next time you start Confluence, and for all subsequent sessions.

Both methods are described below. In some rare circumstances you may also need to configure Configuring Logging.

**Terminology:** In log4j, a 'logger' is a named entity. Logger names are case-sensitive and they follow a hierarchical naming standard. For example, the logger named com.foo is a parent of the logger named com.fo o.Bar.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Configure logging in Confluence Administration**

You can change some of Confluence's logging behaviour via the Administration Console while Confluence is running. Any changes made in this way will apply only to the currently-running Confluence lifetime. The changes are not written to the log4j.properties file and are therefore discarded when you next stop Confluence.

Not all logging behaviour can be changed via the Administration Console. For logging configuration not mentioned below, you will need to stop Confluence and then edit the logging properties file instead.

The 'Logging and Profiling' screen shows a list of all currently defined loggers. On this screen you can:

- Turn page profiling on or off.
- Turn detailed SQL logging on or off.
- Add a new logger for a class/package name.
- Remove a logger for a class/package name.
- Set the logging level (INFO, WARN, FATAL, ERROR or DEBUG) for each class or package name.
- Reset all logging levels to a predefined profile.

Changing the logging configuration

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'Logging and Profiling' in the 'Administration' section of the left-hand panel.
   You need to have System Administrator permissions in order to perform this function.
3. The 'Logging and Profiling' screen appears, as shown below. Use the following guidelines to change the logging behaviour while Confluence is running:
   - 'Performance Profiling' — See Page Request Profiling.
   - 'SQL Logging' — Click the 'Enable SQL Logging' button to log the details of SQL requests made to the database.
     If you need to enable logging of SQL parameter values, you will need to change the setting in the properties file. This option is not available via the Administration Console.
   - 'Log4j Logging' — Click one of the profile buttons to reset all your loggers to the predefined profiles:
     - The 'Production' profile is a fairly standard profile, recommended for normal production conditions.
     - The 'Diagnostic' profile gives more information, useful for troubleshooting and debugging. It results in slower performance and fills the log files more quickly.
   - 'Add New Entry' — Type a class or package name into the text box and click the 'Add Entry' button. The new logger will appear in the list of 'Existing Levels' in the lower part of the screen.
   - 'Existing Levels' - These are the loggers currently in action for your Confluence instance.
     - You can change the logging level by selecting a value from the 'New Level' dropdown list. Read the Apache documentation for a definition of each level.
     - Click the 'Remove' link to stop logging for the selected class/package name.
4. Click the 'Save' link to stop logging for the selected class/package name.

Screenshot: Changing Log Levels and Profiling

Editing the Properties File
To configure the logging levels and other settings on a permanent basis, you need to stop Confluence and then change the settings in the log4j.properties file, described above.

The properties file contains a number of entries for different loggers that can be uncommented if you are interested in logging from particular components. Read more in the Apache log4j documentation.

See Working with Confluence Logs for some guidelines on specific configuration options you may find useful.

### Configuring Levels for java.util.logging in logging.properties

A few libraries used by Confluence use java.util.logging rather than log4j or slf4j. These libraries include:

- com.sun.jersey
- org.apache.shindig
- net.sf.ehcache

Confluence's logging.properties file is set to redirect java.util.logging at specific levels to log4j via slf4j.

To increase logging levels for these libraries you must first configure the logging.properties file in <CONFLUENCE-INSTALL>/confluence/WEB-INF/classes/. The logging levels are different from log4j and are listed here.

For example, to increase logging for shindig change the following line in the logging.properties file:

```
org.apache.shindig.level = INFO
```

to

```
org.apache.shindig.level = FINE
```

And then use one of the methods above as well to configure the log4j level.

### log4j Logging Levels

**Logging Levels**

- **DEBUG** - designates fine-grained informational events that are most useful to debug an application (*what is going on*)
- **INFO** - announcements about the normal operation of the system - scheduled jobs running, services starting and stopping, user-triggered processes and actions
- **WARN** - any condition that, while not an error in itself, may indicate that the system is running sub-optimally
- **ERROR** - a condition that indicates something has gone wrong with the system
- **FATAL** - a condition that indicates something has gone wrong so badly that the system can not recover
- **TRACE** - n/a within confluence

There are two ways to modify the logging levels, as described in Working with Confluence Logs.

1. Modifying the runtime log levels via the Administration Console.
The information on this page does not apply to Confluence OnDemand.

Default Log Level

The standard Confluence log level **WARN** is a way for Confluence to communicate with the server administrator. Logging at WARN level and higher should be reserved for situations that require some kind of attention from the server administrator, and for which corrective action is possible.

**Reference**: log4j manual

Troubleshooting SQL Exceptions

If you get an exception similar to those shown below, it is a good idea to increase the logging levels of your Confluence instance. If you request Atlassian support, this additional logging will help us work out the cause of the error.

Increased logging levels will enable us to diagnose errors like these:

```java
org.springframework.dao.DataIntegrityViolationException: (HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
  at org.springframework.jdbc.support.SQLStateSQLExceptionTranslator.translate(SQLStateSQLExceptionTranslator.java:88)
caused by: java.sql.BatchUpdateException: Duplicate entry '1234' for key 1
```

or

```java
(HibernateTemplate): data integrity violated by SQL ''; nested exception is java.sql.BatchUpdateException: ORA-00001: unique constraint (CONFLUENCE.SYS_C0012345) violated
```

This document outlines the steps to take to increasing logging on your system.

**Changing the logging levels via the Administration Console**

With Confluence 2.7 and later, you can adjust logging levels at runtime via the Administration Console — read the instructions. Below we tell you how to edit the log4j files directly.

1. Open `confluence/WEB-INF/classes/log4j.properties` and uncomment the following lines. The double `##` lines are comments, leave them intact.

```properties
## log hibernate prepared statements/SQL queries (equivalent to setting 'hibernate.show_sql' to 'true')
#log4j.logger.net.sf.hibernate.SQL=DEBUG

## log hibernate prepared statement parameter values
#log4j.logger.net.sf.hibernate.type=DEBUG
```

If you can not locate these lines in your `log4j.properties` file, please add them to the end of it.
2. Restart Confluence.
3. Redo the steps that led to the error.
4. Zip up your logs directory and attach it your support ticket.
5. If you are using Oracle and received a constraint error, please ask your database administrator which table and column the constraint (that is, CONFLUENCE.SYS_C0012345) refers to and add that information to your support ticket.
6. Open confluence/WEB-INF/classes/log4j.properties again and remove the 4 lines you added in step 1. (The additional logging will impact performance and should be disabled once you have completed this procedure.)

RELATED TOPICS

Enabling Detailed SQL Logging
Working with Confluence Logs
Troubleshooting failed XML site backups

Configuring Confluence Security

This section gives guidelines on configuring the security of your Confluence site:

- Confluence Security Overview and Advisories
- Confluence Cookies
- Configuring Secure Administrator Sessions
- Using Fail2Ban to limit login attempts
- Securing Confluence with Apache
- Managing External Referrers
- Best Practices for Configuring Confluence Security
- Hiding the People Directory
- Configuring Captcha for Spam Prevention
- Hiding External Links From Search Engines
- Configuring Captcha for Failed Logins
- Configuring XSRF Protection
- User Email Visibility
- Anonymous Access to Remote API
- Running Confluence Over SSL or HTTPS
- Connecting to LDAP or JIRA or Other Services via SSL
- Configuring RSS Feeds
- Preventing and Cleaning Up Spam

Related pages:

- Giving People Access to Content
- Configuring a Confluence Environment Not applicable to Confluence OnDemand.
- Confluence Administrator's Guide

Confluence Security Overview and Advisories

This document is for system administrators who want to evaluate the security of the Confluence web application. The page addresses overall application security and lists the security advisories issued for Confluence. As a public-facing web application, Confluence's application-level security is important. This document answers a number of questions that commonly arise when customers ask us about the security of our product.

Other topics that you may be looking for:

- For information about user management, groups and permissions, please refer to the internal security overview.
- For guidelines on configuring the security of your Confluence site, see the administrator's guide to configuring Confluence security.
Application Security Overview

Password Storage

When Confluence's internal user management is used, passwords are hashed through SHA1 before being stored in the database. There is no mechanism within Confluence to retrieve a user's password – when password recovery is performed, a reset password link is generated and mailed to the user's registered address.

When external user management is enabled, password storage is delegated to the external system.

Buffer Overflows

Confluence is a 100% pure Java application with no native components. As such it is highly resistant to buffer overflow vulnerabilities – possible buffer overruns are limited to those that are bugs in the Java Runtime Environment itself.

SQL Injection

Confluence interacts with the database through the Hibernate Object-Relational mapper. Database queries are generated using standard APIs for parameter replacement rather than string concatenation. As such, Confluence is highly resistant to SQL injection attacks.

Script Injection

Confluence is a self-contained Java application and does not launch external processes. As such, it is highly resistant to script injection attacks.

Cross-Site Scripting

As a content-management system that allows user-generated content to be posted on the web, precautions have been taken within the application to prevent cross-site scripting attacks:

- The wiki markup language in Confluence does not support dangerous HTML markup
- Macros allowing the insertion of raw HTML are disabled by default
- HTML uploaded as a file attachment is served with a content-type requesting the file be downloaded, rather than being displayed inline
- Only system administrators can make HTML-level customisations of the application

When cross-site scripting vulnerabilities are found in the Confluence web application, we endeavour to fix them as quickly as possible.
Confluence does not directly support SSL/TLS. Administrators who are concerned about transport-layer security should set up SSL/TLS at the level of the Java web application server, or the HTTP proxy in front of the Confluence application.

For more information on configuring Confluence for SSL, see: Running Confluence Over SSL or HTTPS

### Session Management

Confluence delegates session management to the Java application server in which it is deployed. We are not aware of any viable session-hijacking attacks against the Tomcat application server shipped with Confluence. If you are deploying Confluence in some other application server, you should ensure that it is not vulnerable to session hijacking.

### Plugin Security

Administrators install third party plugins at their own risk. Plugins run in the same virtual machine as the Confluence server, and have access to the Java runtime environment, and the Confluence server API.

Administrators should always be aware of the source of the plugins they are installing, and whether they trust those plugins.

### Administrator Trust Model

Confluence is written under the assumption that anyone given System Administrator privileges is trusted. System administrators are able, either directly or by installing plugins, to perform any operation that the Confluence application is capable of.

As with any application, you should not run Confluence as the root/Administrator user. If you want Confluence to listen on a privileged network port, you should set up port forwarding or proxying rather than run Confluence with additional privileges. The extra-careful may consider running Confluence inside a chroot jail.

### Stack Traces

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

### Finding and Reporting a Security Vulnerability

Atlassian's approach to reporting security vulnerabilities is detailed in How to Report a Security Issue.

### Publication of Confluence Security Advisories

Atlassian's approach to releasing security advisories is detailed in Security Advisory Publishing Policy.

### Severity Levels

Atlassian's approach to ranking security issues is detailed in Severity Levels for Security Issues.

### Our Patch Policy

Atlassian's approach to releasing patches for security issues is detailed in Security Patch Policy.

### Published Security Advisories
This security advisory is not endorsed by Atlassian - this is a public service advisory from a member of the confluence community. **Please** remember to backup any modified files, and use these instructions at your own risk. While this information is based on Confluence v2.1.2, it may have uses with older affected versions of Confluence.

The official security advisory is located at Confluence Security Advisory 2006-01-20
There is a possibility of XSS exploitation of the Full Name user profile field when displayed.

**Solution**

The problem was unescaped outputting of the fullname - wrapping the output in $generalUtil.htmlEncode() resolve it. The vast majority of the problem can be resolved by changing `/confluence/template/includes/macros.vm` in the distribution on the following lines:

- 180
- 186
- 200
- 340
- 893

I have attached the modified `macros.vm` file here which you can copy into your distribution.

**Scope**

There are other places which are still affected which Atlassian have been made aware of, a complete resolution should be provided by Atlassian in their own official advisory.

I hope this helps some of you!

Confluence Security Advisory 2005-02-09

A flaw has been found in Confluence by which attackers can bypass Confluence security and change content on the site. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 1.3.3

**Vulnerability**

By crafting custom URLs, any person with the ability to browse Confluence can modify content on the site, bypassing security settings. This vulnerability does not allow users to view content they would not normally be able to view, or escalate their privileges in other ways.

This flaw affects all versions of Confluence prior to 1.3.3, including the 1.4-DR development releases.

**Fix**

This vulnerability is fixed in Confluence 1.3.3 and later. Customers who do not wish to migrate to 1.3.3 can fix this bug using the procedure below:

1. Edit the file `confluence/WEB-INF/classes/xwork.xml`
2. Find the following section near the top of the file (around line 34):
3. Locate the "autowire" and "params" entries:

   <interceptor-ref name="autowire"/>
   <interceptor-ref name="params"/>

4. Swap the two lines around. The whole stack should now look like this:

   <interceptor-stack name="defaultStack">
     <interceptor-ref name="profiling">
       <param name="location">Before defaultStack</param>
     </interceptor-ref>
     <interceptor-ref name="transaction"/>
     <interceptor-ref name="authentication"/>
     <interceptor-ref name="requestParameterHack"/>
     <interceptor-ref name="eventnotifier"/>
     <interceptor-ref name="autowire"/>
     <interceptor-ref name="params"/>
     <interceptor-ref name="servlet"/>
     <interceptor-ref name="pageAware"/>
     <interceptor-ref name="permissions"/>
     <interceptor-ref name="profiling">
       <param name="location">After defaultStack</param>
     </interceptor-ref>
   </interceptor-stack>

5. Restart Confluence.

Confluence Security Advisory 2005-12-05

A flaw has been found in Confluence by which attackers to inject malicious HTML code into Confluence. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 2.0.2

Vulnerability

By entering HTML code into the Confluence search input fields, attackers can cause arbitrary scripting code to
be executed by the user's browser in the security context of the Confluence instance.

This flaw affects all versions of Confluence between 1.4-DR releases and 2.0.1.

(Atlassian was not informed of the problem before it was published by third-party security researchers. You can read the third-party security advisory here: http://secunia.com/advisories/17833/. The vulnerability was originally reported here.)

**Fix**

This vulnerability is fixed in Confluence 2.0.2 and later. Customers who do not wish to migrate to 2.0.2 can fix this bug using the procedure below:

1. Edit the confluence/decorators/components/searchresults.vmd
2. Replace the following reference (around line 48):

   ```
   $action.getText("search.result", [start, end, total, queryString])
   ```

   with

   ```
   $action.getText("search.result", [start, end, total, 
   generalUtil.escapeXml(queryString)]).
   ```

3. Edit the confluence/search/searchsite-results.vm.
4. Replace the following reference (around line 11):

   ```
   Searched for <b>$action.searchQuery.queryString</b>
   ```

   with

   ```
   Searched for <b>$generalUtil.escapeXml($action.searchQuery.queryString)</b>
   ```

5. Restart Confluence.

Alternatively, you can download the patched source files from CONF-4825. If you are patching a 2.0.x installation, then use the files with the .2.0 suffix. If you are patching a 1.4.x installation, then use the files with the .1.4 suffix.

Confluence Security Advisory 2006-01-20

A flaw has been found in Confluence by which attackers to inject malicious HTML code into Confluence. Atlassian STRONGLY recommends that all Confluence customers apply the fix described below immediately, or upgrade to Confluence 2.1.3.

**Vulnerability**
By entering HTML/JavaScript code into the full name of a user's profile, attackers can cause arbitrary scripting code to be executed by the user's browser in the security context of the Confluence instance.

This flaw affects all versions of Confluence between 1.4-DR releases and 2.1.2.

This issue was initially reported by Ricardo Sueiras and a fix was quickly documented by Dan Hardiker at the Confluence Community Security Advisory 2006-01-19 page. Our thanks to them for bringing this to our attention.

There is an issue in JIRA at CONF-5233.

Fix

This vulnerability is fixed in Confluence 2.1.3 and later. Customers who do not wish to migrate to 2.1.3 can fix this bug using the procedure below:

Steps to fix:

1. Copy macros.vm to your confluence/template/includes folder
2. Restart Confluence

Note: If you are using version 1.4.4, please download and copy this file instead. You will need to rename it back to macros.vm.

If you are not using any of the above versions, you will need to replace wrap calls to display full names of users in $generalUtil.htmlEncode(). Alternatively, send us an email. We do however encourage you to use the latest stable point release regardless of the version you are using.

Confluence Security Advisory 2006-01-23

A flaw has been found in Confluence by which the unrestricted content of a space can be revealed in search results.

Vulnerability

By entering in a space key and blank query string into the Search macro, pages from the specified space will be displayed, without filtering on page and space permissions. This can allow unpermitted users to view the excerpts of pages they don't have access to.

This flaw is confirmed to affect all releases from 1.4 to 2.1.2.

More information is available at CONF-5189.

Fix

This vulnerability is fixed in Confluence 2.1.3 and later. We strongly suggest that customers upgrade to this release to fix the vulnerability.

Customers who are using 1.4.x and do not wish to upgrade can download a patched class from CONF-5198.

Confluence Security Advisory 2006-06-14

Vulnerability

By crafting a custom HTTP request, an attacker can delete or modify global permissions settings on a Confluence site.

This flaw affects all Confluence versions between 1.4 and 2.2.2. 2.2.3 and later are not vulnerable.

Fix

This issue has been fixed in Confluence 2.2.3. Patches are also available for all versions of Confluence between 1.4 and 2.2.2. For more information, please see this issue report.

Atlassian STRONGLY recommends that all customers either upgrade to Confluence 2.2.3, or apply the patch.

Confluence Security Advisory 2007-07-26
In this advisory:

- Users with view permission in a space can copy and save a page
- Space name and key are not validated nor escaped

Users with view permission in a space can copy and save a page

Vulnerability

A user who has only view permissions in a space can copy a page and then save it in the space. In this way, users can create a page in a space where they have only view permission.

This flaw affects only Confluence version 2.5.4.

Fix

This issue has been fixed in Confluence 2.5.5. A patch is also available for Confluence 2.5.4. For more information, including instructions on applying the patch, please see this issue report.

If you are using Confluence 2.5.4, Atlassian strongly recommends that you upgrade to Confluence 2.5.5 or apply the patch.

Space name and key are not validated nor escaped

Vulnerability

The input for space name and key is not validated properly - any characters are allowed. This makes a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.5. For more information, please see this issue report.

Atlassian recommends that you upgrade to Confluence 2.5.5.

Confluence Security Advisory 2007-08-08

In this advisory:

- Input in the RSS Feed Builder is not validated
- Input when editing Space Permissions is not validated
- Number of labels that can be added to a page is not restricted
- Input when editing navigation themes is not validated
- Viewing of space content alphabetically is not validated
- Input when editing Space Name is not validated
- Input when viewing attachments by file-type is not validated

Input in the RSS Feed Builder is not validated

Vulnerability

The input for the RSS Feed Builder is not required to be escaped. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8993.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Input when editing Space Permissions is not validated

Vulnerability

The ‘Grant permission to’ field on the ‘Edit Space Permissions’ screen is not validated. This can make a Confluence instance vulnerable to an XSS or DoS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8993.

Atlassian recommends that you upgrade to Confluence 2.5.6.
This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8980 and CONF-8979.

Atlassian recommends that you upgrade to Confluence 2.5.6.

**Number of labels that can be added to a page is not restricted**

Vulnerability

There is no restriction on the number of labels that can be added to a page at a time. This can make a Confluence instance vulnerable to a DoS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8978.

Atlassian recommends that you upgrade to Confluence 2.5.6.

**Input when editing navigation themes is not validated**

Vulnerability

The 'Navigation Page' specified in the 'Left Navigation Theme' configuration is not validated. This can make a Confluence instance vulnerable to a XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8956.

Atlassian recommends that you upgrade to Confluence 2.5.6.

**Viewing of space content alphabetically is not validated**

Vulnerability

When viewing space content by alphabetic character, the input is not validated as being alphabetic. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8952.

Atlassian recommends that you upgrade to Confluence 2.5.6.

**Input when editing Space Name is not validated**

Vulnerability

The 'Name' field on the 'Edit Space Details' screen is not validated. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8951.

Atlassian recommends that you upgrade to Confluence 2.5.6.

**Input when viewing attachments by file-type is not validated**

Vulnerability

The 'Filter By Extension' field on the 'List Space Attachments' screen is not validated. This can make a Confluence instance vulnerable to an XSS attack.

Fix

This issue has been fixed in Confluence 2.5.6. For more information, please see CONF-8950.

Atlassian recommends that you upgrade to Confluence 2.5.6.

Confluence Security Advisory 2007-11-19

**In this advisory:**
- DWR debug mode enabled
- XSS vulnerability in exception error page
- XSS vulnerability in the URL destination for the print icon
- XSS vulnerability in wiki markup for images

Atlassian recommends that you upgrade to Confluence 2.6.1 to fix the vulnerabilities described below.

**DWR debug mode enabled**

Vulnerability

Debug mode was enabled by default on Direct Web Remoting (DWR). This made it easy for a potential attacker to find information about available AJAX request handlers in Confluence.

Fix

This issue has been fixed in Confluence 2.6.1. If you do not wish to upgrade at this time, you can fix the problem by editing your `<confluence install>/confluence/WEB-INF/web.xml` file. For more information, please see CONF-9718.

**XSS vulnerability in exception error page**

Vulnerability

The attributes and parameters were not escaped on the Confluence exception error page. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. For more information, please see CONF-9704 and CONF-9560.

**XSS vulnerability in the URL destination for the print icon**

Vulnerability

The print icon on the HTTP 404 error page uses the path of the requested URL, which potentially contains malicious JavaScript. The 404 page did not correctly escape it. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. A patch is supplied for customers with Confluence version 2.6 who do not wish to upgrade at this time. For more information, please see CONF-9456.

**XSS vulnerability in wiki markup for images**

Vulnerability

When using image URLs in wiki markup, quotes were not correctly escaped. This is a potential vulnerability to a cross-site scripting attack.

Fix

This issue has been fixed in Confluence 2.6.1. For customers with Confluence 2.6 who do not wish to upgrade at this time, the new `atlassian-renderer` JAR should resolve this issue. For more information, please see CONF-9209.

Confluence Security Advisory 2007-11-27

In this advisory:

- XSS Type 2 Vulnerabilities in Macros and Wiki Markup
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
XSS Type 2 Vulnerabilities in Macros and Wiki Markup

Severity

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed some security flaws which may affect Confluence instances in a public environment. These flaws are XSS (cross-site scripting) vulnerabilities in some of Confluence's macros and Wiki Markup, which potentially allow a malicious user (hacker) to insert their own HTML tags or script into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

Atlassian recommends that you upgrade to Confluence 2.6.2 to fix the vulnerabilities described below.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

The following macros are affected:

- {color}
- {panel}
- {section}
- {column}
- {code}

The Wiki Markup for inserting images (e.g. ![image.png]) is also vulnerable to XSS exploitation.

Fix

The fix is to escape all user input, so that no user input is interpreted as HTML or CSS. In some cases we also perform stricter validation on the range of values a user can supply in an attribute.

These issues have been fixed in Confluence 2.6.2. For more information, please see CONF-9350.

Our thanks to **Igor Minar**, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Please let us know what you think of the format of this security advisory and the information we have provided.

Confluence Security Advisory 2007-12-14

In this advisory:

- XSS Vulnerability in Configure RSS Feed Action
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Configure RSS Feed Action
Severity

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to **Confluence 2.7**, or
- Download and install the patch for Confluence 2.5.8 or Confluence 2.6.2 from our JIRA site – see issue CONF-10164.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the following Confluence action:

```
http://www.anyhost.com/confluence/dashboard/configurerssfeed.action
```

The above Confluence action is used to build an RSS feed based on your Confluence pages and news items. The action is invoked when a selects 'Feed Builder' from your Confluence Dashboard. It can also be invoked by simply entering the URL into the browser address bar.

Fix

These issues have been fixed in **Confluence 2.7**, which you can download from the download centre.

A patch is available for **Confluence 2.5.8** and **Confluence 2.6.2**. For more information, please see CONF-10164.

Our thanks to **jeff peichel**, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

*Please let us know what you think of the format of this security advisory and the information we have provided.*

**Confluence Security Advisory 2008-01-24**

In this advisory:

- XSS Vulnerability in Dashboard Action
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
XSS Vulnerability in Dashboard Action

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7.1, or
- Download and install the patch for Confluence 2.6.2 or Confluence 2.7.0 from our JIRA site – see issue CONF-10289.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signon) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the following Confluence action:

```
http://confluence-location/dashboard.action?spacesSelectedTab
```

The above Confluence action is used to determine which spaces are listed on a user's Dashboard. For example, the following URL requests a list of team spaces only:

```
http://confluence-location/dashboard.action?spacesSelectedTab=team
```

The action is invoked when a user selects one of the 'Spaces' tabs on the Dashboard, such as the 'Team' tab. It can also be invoked by simply entering the URL into the browser address bar.

Fix

These issues have been fixed in Confluence 2.7.1 (see the release notes), which you can download from the download centre.

A patch is available for Confluence 2.6.2 and Confluence 2.7.0. For more information, please see CONF-10289.

Our thanks to Mary Johnson, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate her working with us towards identifying and solving the problem.

Please let us know what you think of the format of this security advisory and the information we have provided.

Confluence Security Advisory 2008-03-06
In this advisory:

- Users with View-Only Permission can Delete (Purge) Pages
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Users with View-Only Permission can Delete (Purge) Pages

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

More explanation of the ranking we chose:

- You might rank this vulnerability as critical, because in most installations the vulnerability will allow anonymous users to delete information.
- We have chosen a ranking of high, because the vulnerability does not allow privilege escalation i.e. it doesn't allow users to gain administration privileges.

Risk Assessment

We have identified and fixed a security flaw which allowed users who have 'View' permission (or higher) on a space to purge (delete) any page in that space.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.7.1 inclusive.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7.2, or
- Download and install the patch for Confluence 2.6.x or Confluence 2.7.x from our JIRA site – see issue CONF-10807.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

If it is not immediately feasible to upgrade to Confluence 2.7.2 or apply a patch, we recommend an alternative strategy:

- As a temporary measure, you can block the URL which allows someone to purge (delete) a page. Please ask your website administrator to block the URL described below.
- The impact is that Space Administrators will not be able to purge individual pages or news items. However, Space Administrators can still use the ‘Purge All’ link to clear the entire contents of Trash.

Vulnerability

Description:

A user can use the following Confluence action to permanently delete (purge) any Confluence page, provided that the user has ‘View’ permission (or higher) in the space to which the page belongs:

```
http://confluence-location/pages/purgetrashitem.action?key=XXX&contentId=XXX
```

The above action is invoked when a space administrator clicks the ‘Purge’ link on the space’s ‘Trash’ page next to a wiki page which has already been deleted.
The action can also be invoked by simply entering the URL into the browser address bar. In this way, it is possible for a user with 'View' permission (or higher) to remove a page via the 'Purge' action, even if the page has not been deleted.

Fix

These issues have been fixed in Confluence 2.7.2 (see the release notes), which you can download from the download centre.

A patch is available for Confluence 2.6.x, Confluence 2.7.0 and Confluence 2.7.1. For more information, please see CONF-10807.

---

Our thanks to Neeraj Jhanji, who reported this issue to Atlassian. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

---

Confluence Security Advisory 2008-03-19

In this advisory:

- XSS Vulnerabilities in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

### XSS Vulnerabilities in Various Confluence Actions

**Severity**

Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

To fix the vulnerabilities described below, Atlassian recommends that you take one of the following steps:

- Upgrade to Confluence 2.7.3, or
- Download and install the patches for Confluence 2.6.x from our JIRA site — refer to the list of issues below.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

**Risk Mitigation**

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

**Vulnerability**

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar.
For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence Actions</th>
<th>Affected Confluence Versions</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create, edit or copy a page or news item</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11027</td>
<td></td>
</tr>
<tr>
<td>Add a comment</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11027</td>
<td></td>
</tr>
<tr>
<td>Create a space</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11042</td>
<td>Wyatt Crossin</td>
</tr>
<tr>
<td>Sign up for an account</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11005</td>
<td></td>
</tr>
<tr>
<td>Choose a page (page picker)</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11137</td>
<td></td>
</tr>
<tr>
<td>View a user</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11002</td>
<td></td>
</tr>
<tr>
<td>Insert an image or link</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11141</td>
<td></td>
</tr>
<tr>
<td>Choose a user or group (user picker and group picker)</td>
<td>From <strong>2.2 to 2.7.2</strong> inclusive</td>
<td>CONF-11040</td>
<td>Jean Marois</td>
</tr>
<tr>
<td>Add a user to favourites</td>
<td>From <strong>2.0 to 2.7.2</strong> inclusive</td>
<td>CONF-11026</td>
<td></td>
</tr>
<tr>
<td>HTTP 500 error page</td>
<td>From <strong>1.3 to 2.7.2</strong> inclusive</td>
<td>CONF-11019</td>
<td></td>
</tr>
<tr>
<td>Add bookmark</td>
<td>All Confluence instances that have the Social Bookmarking plugin. Note that the plugin is bundled with Confluence since version <strong>2.6</strong>, so Confluence 2.6.x and 2.7.x are vulnerable even if you don’t use social bookmarking. Patches are supplied for Confluence 2.6.x and 2.7.x.</td>
<td>CONF-11153</td>
<td></td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in **Confluence 2.7.3** (see the release notes), which you can download from the download centre.

Patches are available for **Confluence 2.6.x**. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.
Our thanks to the people who reported some of the vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate their working with us towards identifying and solving the problem.

Confluence Security Advisory 2008-05-21

In this advisory:

- **Users can Move Attachments to Any Page Regardless of Permissions**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **XSS Vulnerability in Page Information View**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

**Users can Move Attachments to Any Page Regardless of Permissions**

**Severity**

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a security flaw which allows users who have ‘Create Page’ permission in a space to move an attachment from a page in that space to any other page in the Confluence site, regardless of the user’s permissions in the destination space.

The following Confluence versions are vulnerable: All versions from **1.0 to 2.8.0**.

**Risk Mitigation**

This security flaw grants extra powers only to users who already have ‘Create Page’ permissions in one of the spaces on the Confluence site. In most installations, this will be a trusted group of users.

If your Confluence instance allows a less trusted group of users to create and edit pages in one space, while restricting access to other spaces, you may judge it necessary to disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

**Vulnerability**

Any user who has ‘Create Page’ permission in a Confluence space can move an attachment from a page in that space to any other page in the Confluence site, regardless of the user’s permissions in the destination space.

Note: If a user has permission to create a space, they will also have ‘Create Page’ permission in any space they create, including a personal space. Such users could upload an attachment onto the space they have created and then move the attachment to any page in the Confluence site.

**Fix**

This issue has been fixed in Confluence 2.8.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.x or Confluence 2.8.0 from our JIRA site.
XSS Vulnerability in Page Information View

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an XSS (cross-site scripting) vulnerability in a Confluence action, which potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.8.0 inclusive.

Risk Mitigation

If you judge it necessary, you can hide referrers on page information views by disabling this functionality.

Vulnerability

A hacker can inject their own JavaScript into the referrer URLs which are displayed on the 'Info' view of a wiki page. The rogue JavaScript will be executed when a user opens the 'Info' view.

Fix

This issue has been fixed in Confluence 2.8.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.x or Confluence 2.8.0 from our JIRA site – see issue CONF-11524.

Confluence Security Advisory 2008-07-03

In this advisory:

- XSS Vulnerability in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Actions

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each
vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups only.

Vulnerability

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence Actions</th>
<th>Affected Confluence Versions</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create, edit or copy a page or news item</td>
<td>2.8.0 and 2.8.1</td>
<td>CONF-11985</td>
<td>James Rinker</td>
</tr>
<tr>
<td>Page picker and space picker</td>
<td>2.2.0 to 2.8.1 inclusive</td>
<td>CONF-11137</td>
<td></td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 2.8.2 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patches provided on our JIRA site. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Our thanks to James Rinker who reported some of the vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate his working with us towards identifying and solving the problem.

Confluence Security Advisory 2008-09-08

In this advisory:

- XSS Bug: Usernames Not HTML-Encoded in All Places
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
- Inherited Page Restrictions Are Not Applied After 2.9 Upgrade
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
Fix

Access Vulnerability in View Wiki Markup Function
Severity
Risk Assessment
Risk Mitigation
Vulnerability
Fix

Access Vulnerability in Copy Page Function
Severity
Risk Assessment
Risk Mitigation
Vulnerability
Fix

Access Vulnerability in Diff Page Function
Severity
Risk Assessment
Risk Mitigation
Vulnerability
Fix

XSS Bug: Usernames Not HTML-Encoded in All Places

Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allowed certain users to circumvent Confluence’s security measures, by including HTML markup in their own username. This could allow a malicious user to execute Javascript on another user's authenticated session.

The following Confluence versions are vulnerable: All versions from **1.0 to 2.9**.

Risk Mitigation

If the user specified a username that included HTML markup (which could include Javascript), in some places Confluence would not correctly escape this source before displaying it. This could result in Javascript being executed in another user's authenticated session. To address the issue, you should update your Confluence instance as soon as possible (or follow the patch instructions on the issue).

Vulnerability

This is a classic **Cross-Site Scripting** issue where usernames could include malicious Javascript.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

For more information, see issue CONF-7615 which has instructions on how to patch the affected velocity template.

Inherited Page Restrictions Are Not Applied After 2.9 Upgrade

Severity

Atlassian rates this vulnerability as **HIGH**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.
Risk Assessment

We have identified and fixed a security flaw that caused any content permission inherited by a page to be lost during the upgrade process to Confluence 2.9.

The following Confluence versions are vulnerable: Version 2.9; specifically instances of Confluence that were upgraded to version 2.9 (from an earlier version) only.

Risk Mitigation

This issue can be resolved by following the steps under Fix, or upgrading to Confluence 2.9.1. If this cannot be done immediately, it may be prudent to manually apply restrictions to each page that is normally protected by inherited restrictions (that is, all child pages residing under a restricted page). Enacting the fix is trivial and should take around ten minutes for a typical Confluence instance.

Vulnerability

If you had given a parent page restrictions prior to the 2.9 upgrade, then any child pages that should be inheriting these restrictions are no longer restricted. This potentially renders these child pages viewable and editable by Confluence users who should not have these rights. However you should note that any space level restrictions are still respected so these affected pages are only opened as far as the space level security allows for your site. Note for individual pages where you have manually set the permissions, those pages are not at risk — just the pages underneath them using inherited permissions.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

Alternatively, you can apply the manual fix, which involves a simple series of actions in the Confluence administration screens.

For more information see issue CONF-12911.

Access Vulnerability in View Wiki Markup Function

Severity

Atlassian rates this vulnerability as HIGH, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don't have the correct 'View Page' permission in a space to view the Wiki Markup source of the page content.

The following Confluence versions are vulnerable: Version 2.9 only.

Risk Mitigation

If a user knows the URL to view the source of a page they will be able to bypass Confluence's security checks. This will allow the user to view the contents of a page they aren't meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing this string: /pages/viewpagesrc.action. You may judge it necessary to disable public access.

Vulnerability

If a user knows the ID of a page that they do not have 'View Page' permission for they can use the view source URL to view the Wiki Markup of a page. This will allow them to copy and paste the contents of the page to another location, or simply read the markup and deduce its final content.

Note: the user will need to know the page ID of a page. Confluence will not provide any links to the restricted page through a search or other navigation.
Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

For more information see issue CONF-12845.

Access Vulnerability in Copy Page Function

Severity

Atlassian rates this vulnerability as HIGH, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don't have the correct 'View Page' permission in a space to copy a page and therefore see its content.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.

Risk Mitigation

If a user knows the URL to copy a page they will be able to bypass Confluence's security checks. This will allow the user to view the contents of a page they aren't meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing this string: /pages/copypage.action. You may judge it necessary to disable public access.

Vulnerability

If a user knows the ID of a page they do not have permissions for, they can use the copy page URL to copy the page to a space where they do have permission. This will allow them to create a new page based on the content of a page they aren't meant to see.

Fix

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.3 or 2.8.2 from our JIRA site – see issue CONF-12859.

Instruction on installing the patch can be found here.

Access Vulnerability in Diff Page Function

Severity

Atlassian rates this vulnerability as HIGH, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows users who don't have the correct 'View Page' permission in a space to create a diff of a page (a comparison of its contents with another page) and therefore see its content.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.

Risk Mitigation

If a user knows the URL to perform a diff of a page they will be able to bypass Confluence's security checks. This will allow the user to view the contents of a page they aren't meant to see.

To prevent unauthorised access, you may want to use your web server to reject all requests to URLs containing
this string: `/pages/diffpages.action`. You may judge it necessary to disable public access.

**Vulnerability**

If a user knows the ID of a page they do not have permissions for, they can use the 'Diff Page' URL to compare the contents of that page with one where they do. This will allow them to deduce the contents of a page they don't have access to.

**Fix**

This issue has been fixed in Confluence 2.9.1 (see the release notes), which you can download from the download centre.

Alternatively, you can download and install the patch for Confluence 2.7.3 or 2.8.2 from our JIRA site – see issue CONF-12860.

Instruction on installing the patch can be found here.

> Our thanks to Neeraj Jhanji from Atlassian Partner ImaHima, who reported the copy and diff page issues to Atlassian. We fully support the reporting of vulnerabilities and we appreciate it when people work with us towards identifying and solving a problem.

Confluence Security Advisory 2008-10-14

In this advisory:

- **Parameter Injection Vulnerability in Confluence**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **XSS Vulnerability in Various Confluence Actions and Plugins**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Privilege Escalation Vulnerability in Confluence Watches**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- **Privilege Escalation Vulnerability in Confluence Favourites**
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

**Parameter Injection Vulnerability in Confluence**

**Severity**

Atlassian rates this vulnerability as **critical**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a flaw which would allow a malicious user (hacker) to inject their own values into a
Confluence request by adding parameters to the URL string. This would allow a hacker to bypass Confluence's security checks and perform actions that they are not authorised to perform.

Risk Mitigation

To address the issue, you should upgrade Confluence as soon as possible or follow the patch instructions below. If you judge it necessary, you can block all untrusted IP addresses from accessing Confluence.

Vulnerability

A hacker can design a URL string containing parameters which perform specific actions on the Confluence server, bypassing Confluence's security checks. This is because Confluence does not adequately sanitise user input before applying it as an action on the server.

Exploiting this issue could allow an attacker to access or modify data and compromise the Confluence application.

The following Confluence versions are vulnerable: All versions from 1.3 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, a patch is available that will work with any affected version of Confluence. You can download and install the patch from our JIRA site. For more information, please refer to CONF-13092.

XSS Vulnerability in Various Confluence Actions and Plugins

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users’ session cookies or other credentials, by sending the credentials back to the hacker’s own web server.
- The hacker’s text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

A hacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.
<table>
<thead>
<tr>
<th>Confluence Actions</th>
<th>Affected Confluence Versions</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>View children via the Pagetree plugin (bundled with Confluence)</td>
<td>2.8.0 to 2.9.1 inclusive</td>
<td>CONF-13043</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Update bookmark via the Social Bookmarking plugin (bundled with Confluence)</td>
<td>2.6.0 to 2.9.1 inclusive</td>
<td>CONF-13041</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Build RSS feed</td>
<td>2.0 to 2.9.1 inclusive</td>
<td>CONF-13042</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Search via Search macro</td>
<td>All versions from 1.0 to 2.9.1 inclusive</td>
<td>CONF-13040</td>
<td>Thomas Jaehnel</td>
</tr>
<tr>
<td>Search</td>
<td>All versions from 1.0 to 2.9.1 inclusive</td>
<td>CONF-12944</td>
<td></td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported most of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Privilege Escalation Vulnerability in Confluence Watches

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a flaw which would allow an unauthorised user to add a Confluence page to the list of pages they are watching, even if the user does not have permission to view that page. Under some circumstances, the unauthorised user may thus have access to information they are not authorised to see.

Risk Mitigation

This flaw does not allow the unauthorised user to update the page, but it may give the user access to information that they do not have permission to see.

Vulnerability

An unauthorised user can manipulate the HTTP request, so that it adds a watch to a page which the user does not have permission to view. The page then appears in the user's list of watched pages, displaying the page title and the corresponding space name. In this way, the user can bypass Confluence's permission checks and gain access to information they are not authorised to see.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.
ad centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to CONF-13039.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported the vulnerability listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Privilege Escalation Vulnerability in Confluence Favourites

Severity

Atlassian rates this vulnerability as moderate, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a flaw which would allow an unauthorised user to add a Confluence page to their list of favourites, even if the user does not have permission to view that page. Under some circumstances, the unauthorised user may thus have access to information they are not authorised to see.

Risk Mitigation

This flaw does not allow the unauthorised user to update the page, and it gives the user only very limited access to the information they do not have permission to see.

Vulnerability

An unauthorised user can manipulate the HTTP request, so that it marks as 'favourite' a page which the user does not have permission to view. The page is then added to the number of favourites for the user. The user cannot see the page title or content, but can see that the favourite count has been incremented.

The following Confluence versions are vulnerable: All versions from 1.0 to 2.9.1.

Fix

This issue has been fixed in Confluence 2.9.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.9.2, you can download and install the patches provided on our JIRA site. For more information, please refer to CONF-13044.

Our thanks to Thomas Jaehnel of OPTIMAbit, who reported the vulnerability listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2008-12-03

In this advisory:

- XSS Vulnerability in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
- Users can View a List of All Attachments by Supplying an Edited URL
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
XSS Vulnerability in Various Confluence Actions

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. The flaws are all XSS (cross-site scripting) vulnerabilities in various Confluence actions. Each vulnerability potentially allows a malicious user (hacker) to embed their own JavaScript into a Confluence page.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

A hacker can inject their own JavaScript into various Confluence URLs — see the table below for the affected functional areas. A URL may be invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The URL can also be invoked by simply entering it into the browser address bar. If rogue JavaScript is injected into such a URL, the JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Affected Confluence Functionality</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Reporter (If Not Atlassian)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handling of error messages. (Vulnerability in the DWR code library used by Confluence.)</td>
<td>2.7.3 to 2.9.2 inclusive</td>
<td>2.9.2 and 2.10</td>
<td>CONF-11808</td>
<td>Bjoern Froebe</td>
</tr>
<tr>
<td>Attachments macro.</td>
<td>2.8 to 2.9.2 inclusive</td>
<td>2.8.2, 2.9.2 and 2.10**</td>
<td>CONF-13713</td>
<td></td>
</tr>
<tr>
<td>Uploading of attachments.</td>
<td>2.6 to 2.9.2 inclusive</td>
<td>2.8.2, 2.9.2 and 2.10</td>
<td>CONF-13717</td>
<td></td>
</tr>
<tr>
<td>Inserting images as thumbnails.</td>
<td>2.8 to 2.9.2 inclusive</td>
<td>2.8.2, 2.9.2 and 2.10</td>
<td>CONF-13625</td>
<td></td>
</tr>
<tr>
<td>Log events listed in the Confluence 500 error page.</td>
<td>2.9 to 2.9.2 inclusive</td>
<td>2.10 only</td>
<td>CONF-13584</td>
<td></td>
</tr>
<tr>
<td>Wiki Markup link rendering.</td>
<td>2.7 to 2.9.2 inclusive</td>
<td>2.7.x, 2.8.x, 2.9.x, 2.10</td>
<td>CONF-13451</td>
<td></td>
</tr>
</tbody>
</table>
* The patch for CONF-13717 also addresses the bug in CONF-13736.

** To fix this issue, please upgrade your Attachments plugin to the latest version. This plugin is available for Confluence 2.8.2, 2.9.2 and 2.10, via the Confluence Plugin Repository.

Fix

These issues have been fixed in Confluence 2.10 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.10, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.8, you will need to upgrade to version 2.8.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Please note that one of the issues can only be fixed by upgrading to Confluence 2.10. Please see the table above for details.

Our thanks to Bjoern Froebe, who reported one of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Users can View a List of All Attachments by Supplying an Edited URL

Severity

Atlassian rates this vulnerability as medium, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security flaw which allows a user to view the list of all attachments for all pages in a Confluence instance, regardless of space-level or page-level permissions.

While the user cannot open the files, a range of metadata is available for viewing, including file name, the page that the file is attached to, the creator, and the creation and last-modified date of the attachment.

Risk Mitigation

If you judge it necessary, you can disable anonymous access to your wiki until you have applied the necessary patch or upgrade.

Vulnerability

If a user removes the space key from the URL while viewing attachments for a space, Confluence will display the full list of all attachments for all spaces. For more details, please refer to CONF-13874.

Fix

These issues have been fixed in Confluence 2.10 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 2.10, you can download and install the patches provided in the JIRA issue, CONF-13874. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.8, you will need to upgrade to version 2.8.2) and then apply the patch.

Our thanks to Matthew Goonan, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2009-01-07

In this advisory:
Content Overwrite Vulnerability in the Office Connector Plugin

Severity

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified a risk that makes it possible for users with read-only access to a Confluence wiki space to modify its contents via the document import feature of the Office Connector plugin. This issue, however, does not expose restricted content on a Confluence wiki space to unauthorised users.

Risk Mitigation

Please see the 'Fix' section below. If you cannot apply the fix immediately, you can consider taking one or more of the following steps:

- Disable the whole Office Connector plugin, as explained in Disabling and Enabling Add-ons.
- If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade.
- For even tighter control, you could restrict access to trusted groups.

Vulnerability

The Office Connector plugin was first bundled in Confluence version 2.10.0. Hence, this vulnerability affects Confluence **2.10.0** where the Office Connector Plugin is enabled. Additionally, this plugin is compatible with all versions of Confluence from **2.3.0** onwards. Hence, if you have installed the plugin, this vulnerability will affect your Confluence instance.

Fix

Please download and install the latest version of the Office Connector plugin using the Universal Plugin Manager (instructions here). If you wish to install this plugin manually, you can download it from here.

Alternatively, install or upgrade to Confluence version 2.10.1. (See the release notes.) The Confluence 2.10.1 installation files can be downloaded from the download centre.

For more information, please refer to CONF-14014.

Our thanks to **Justin Wong**, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Confluence Security Advisory 2009-02-18

In this advisory:

- HTTP Header Injection Flaw
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

HTTP Header Injection Flaw
Severity

Atlassian rates this vulnerability as **high**, according to the scale published in *Confluence Security*. The scale allows us to rank a vulnerability as critical, high, moderate or low.

An Advanced Warning of this Security Advisory published last week stated the severity of this vulnerability as **critical**. After further assessing the likelihood of attack, however, we have amended this to **high**.

Risk Assessment

We have identified and fixed a security flaw which may affect Confluence instances in a public environment. This flaw is an **HTTP header injection vulnerability** in the Seraph web framework that is used by Confluence. This potentially allows a malicious user (attacker) to modify the HTTP response to insert malicious code. An attacker could present a modified URL to users (e.g. disguised in an email message). If any user clicks the URL, the malicious code would be executed in the user's session.

- The attacker may take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker could also gain control over the underlying system, based on the privileges of the user whose session cookie has been stolen.
- The attacker could redirect the user to undesirable web sites. This is potentially damaging to your company's reputation.

Atlassian recommends that you upgrade to **Confluence 2.10.2** to fix the vulnerabilities described below.

Risk Mitigation

We strongly recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

Alternatively, you may consider taking the following step, although the time required to fix this vulnerability and the extent of its effectiveness will depend on your application server running Confluence and its configuration:

- Consult the vendor of your application server to see whether your application server is immune to header injection vulnerabilities or has configuration options to prevent such attacks. For example, the Coyote (HTTP) connector in Tomcat version 5.5 and later is immune to header injection attacks, as acknowledged in this reference.
  
  **Technical note:** In your application server, header injection vulnerabilities can be mitigated if the `setHeader()`, `addHeader()`, and `sendRedirect()` methods in the `HttpServletResponse` class have their parameters properly checked for header termination characters.
  
  You may wish to forward this technical note to the vendor of your application server to help them assess the vulnerability of your application server to header injection attacks.

Vulnerability

All versions of Confluence prior to 2.10.2 are vulnerable to this security flaw.

Fix

The fix updates the Seraph framework to a version which correctly encodes and validates redirect URLs before sending them back to the user.

To patch your existing installation of Confluence, please refer to [CONF-14275](https://jira.atlassian.com/browse/CONF-14275). This JIRA issue contains the downloadable patch file and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.2. (See the release notes.) The Confluence 2.10.2 installation files can be downloaded from the [download centre](https://confluence.atlassian.com/download-center).

For more information, please refer to [CONF-14275](https://jira.atlassian.com/browse/CONF-14275).

Confluence Security Advisory 2009-04-15

In this advisory:
XSS Vulnerability in Various Confluence Macros

**Severity**

Atlassian rates this vulnerability as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed two security flaws which may affect Confluence instances in a public environment. These flaws are all cross-site scripting (XSS) vulnerabilities in Confluence's Index and Widget Macros. Each vulnerability potentially allows a malicious user (attacker) to embed their own JavaScript into a Confluence page, which will be executed when the page is rendered.

- The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
- The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at [cgisecurity](http://cgisecurity.com), [CERT](http://www.cert.org) and other places on the web.

**Risk Mitigation**

We recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

Alternatively if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

You could also temporarily disable the **Widget Connector** plugin and the **Index Macro module of the Confluence Advanced Macros** plugin until you have applied the necessary patch or upgrade. Be aware, however, that this will cause any occurrence of these macros on existing pages or blogs in your Confluence site to render with 'Unknown Macro' indications.

**Vulnerability**

All versions of Confluence prior to 2.10.3 are vulnerable to this security flaw.

**Fix**

The fixes include an update to the Index Macro, such that it correctly renders content on the page and an update to the Widget Macro, such that it correctly encodes all parameters passed to it.

To patch your existing installation of Confluence, please refer to [CONF-14753](http://jira.atlassian.com/browse/CONF-14753) for the Index Macro and [CONF-14337](http://jira.atlassian.com/browse/CONF-14337) for the Widget Macro. These JIRA issues contain the downloadable patch files and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.3. (See the release notes.)
Installation files can be downloaded from the [download centre](#). For more information, please refer to [CONF-14753](#) and [CONF-14337](#).

Our thanks to [Igor Minar](#), who reported one of the XSS vulnerabilities listed above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

### HTTP Header Injection Flaw with Attachment Filenames

#### Severity

Atlassian rates this vulnerability as **high**, according to the scale published in [Confluence Security](#). The scale allows us to rank a vulnerability as critical, high, moderate or low.

#### Risk Assessment

We have identified and fixed a security flaw with attachment filenames. This vulnerability could lead to an HTTP Header Injection attack through the upload of attachments with modified filenames designed to exploit this flaw. An attacker could insert malicious code into the HTTP response, which would be executed in the user's session.

- The attacker may take advantage of this flaw to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker could also gain control over the underlying system, based on the privileges of the user whose session cookie has been stolen.
- The attacker could redirect the user to undesirable web sites. This is potentially damaging to your company's reputation.

#### Risk Mitigation

We strongly recommend either patching or upgrading your Confluence installation to fix this vulnerability. Please see the 'Fix' section below.

If you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Alternatively, you may consider taking the following step, although the time required to fix this vulnerability and the extent of its effectiveness will depend on your [application server](#) running Confluence and its configuration:

- Consult the vendor of your [application server](#) to see whether your application server is immune to header injection vulnerabilities or has configuration options to prevent such attacks. For example, the Coyote (HTTP) connector in Tomcat version 5.5 and later is immune to header injection attacks, as acknowledged in [this reference](#).

  **Technical note:** In your application server, header injection vulnerabilities can be mitigated if the setHeader(), addHeader(), and sendRedirect() methods in the [HttpServletResponse](#) class have their parameters properly checked for header termination characters.

  You may wish to forward this technical note to the vendor of your application server to help them assess the vulnerability of your application server to header injection attacks.

#### Vulnerability

All versions of Confluence prior to 2.10.3 are vulnerable to this security flaw.

#### Fix

The fix includes a new header-injection prevention filter in Confluence, which ensures attachment filenames or any other user-provided data is correctly encoded before being included in HTTP headers.

To patch your existing installation of Confluence, please refer to [CONF-14704](#). This JIRA issue contains the downloadable patch files and instructions on how to patch your existing Confluence installation.

Alternatively, install or upgrade to Confluence version 2.10.3. (See the [release notes](#).) The Confluence 2.10.3
installation files can be downloaded from the download centre.

For more information, please refer to CONF-14704.

Confluence Security Advisory 2009-06-01

In this advisory:

- XSS Vulnerability in Various Confluence Actions and Macros
  
  **Severity**
  
  Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

  **Risk Assessment**
  
  We have identified and fixed a number of security flaws which may affect Confluence instances in a public environment. These are cross-site scripting (XSS) that affect various Confluence page/blog features and functions.
  
  - The hacker might take advantage of the flaw to steal other users' session cookies or other credentials, by sending the credentials back to the hacker's own web server.
  - The hacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

  You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

  **Risk Mitigation**
  
  We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

  Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

  **Vulnerability**
  
  A hacker can inject their own JavaScript into various Confluence URLs — see the table below for the affected functional areas. A URL may be invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The URL can also be invoked by simply entering it into the browser address bar. If rogue JavaScript is injected into such a URL, the JavaScript will be executed when a user invokes the URL.

  For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Affected Confluence Functionality</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concurrent page edit message</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.9.2 and 2.10.3</td>
<td>CONF-15883</td>
</tr>
<tr>
<td>Gallery Macro</td>
<td>All versions (1.0 to 2.10.3 inclusive)</td>
<td>2.10.3</td>
<td>CONF-15376</td>
</tr>
</tbody>
</table>
These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.9, you will need to upgrade to version 2.9.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

In this advisory:

- Page Content Vulnerabilities
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Page Content Vulnerabilities

If you have already upgraded to Confluence 3.0, then you are not affected by the vulnerabilities described on this page and there is no need to take any further action.

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed two security vulnerabilities which may affect Confluence instances in a public environment. Both of these fixes are associated with a tightening of user access restrictions when either viewing specific page content or adding new page content.

The first of these vulnerabilities allows a user without permission to view a given page, to view the contents of any files attached to that page using the view file macro. This assumes that the user has permission to edit or create another page within the Confluence site and knows the name of the file attached to the page they cannot view. For more information, please refer to the JIRA issue CONF-15809.

The second of these vulnerabilities allows users with space administrator permissions to import pages to a Confluence space. The security level of this function has been tightened to permit only users with the system administration permission to access it. For more information, please refer to CONF-15267.

Risk Mitigation

* This vulnerability may be present in earlier Confluence versions with the Office Connector plugin installed.

Fix

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.9, you will need to upgrade to version 2.9.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

In this advisory:

- Page Content Vulnerabilities
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Page Content Vulnerabilities

If you have already upgraded to Confluence 3.0, then you are not affected by the vulnerabilities described on this page and there is no need to take any further action.

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed two security vulnerabilities which may affect Confluence instances in a public environment. Both of these fixes are associated with a tightening of user access restrictions when either viewing specific page content or adding new page content.

The first of these vulnerabilities allows a user without permission to view a given page, to view the contents of any files attached to that page using the view file macro. This assumes that the user has permission to edit or create another page within the Confluence site and knows the name of the file attached to the page they cannot view. For more information, please refer to the JIRA issue CONF-15809.

The second of these vulnerabilities allows users with space administrator permissions to import pages to a Confluence space. The security level of this function has been tightened to permit only users with the system administration permission to access it. For more information, please refer to CONF-15267.

Risk Mitigation

* This vulnerability may be present in earlier Confluence versions with the Office Connector plugin installed.

Fix

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.9, you will need to upgrade to version 2.9.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

In this advisory:

- Page Content Vulnerabilities
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Page Content Vulnerabilities

If you have already upgraded to Confluence 3.0, then you are not affected by the vulnerabilities described on this page and there is no need to take any further action.

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed two security vulnerabilities which may affect Confluence instances in a public environment. Both of these fixes are associated with a tightening of user access restrictions when either viewing specific page content or adding new page content.

The first of these vulnerabilities allows a user without permission to view a given page, to view the contents of any files attached to that page using the view file macro. This assumes that the user has permission to edit or create another page within the Confluence site and knows the name of the file attached to the page they cannot view. For more information, please refer to the JIRA issue CONF-15809.

The second of these vulnerabilities allows users with space administrator permissions to import pages to a Confluence space. The security level of this function has been tightened to permit only users with the system administration permission to access it. For more information, please refer to CONF-15267.

Risk Mitigation

* This vulnerability may be present in earlier Confluence versions with the Office Connector plugin installed.

Fix

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.9, you will need to upgrade to version 2.9.2) and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

In this advisory:

- Page Content Vulnerabilities
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Page Content Vulnerabilities

If you have already upgraded to Confluence 3.0, then you are not affected by the vulnerabilities described on this page and there is no need to take any further action.

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed two security vulnerabilities which may affect Confluence instances in a public environment. Both of these fixes are associated with a tightening of user access restrictions when either viewing specific page content or adding new page content.

The first of these vulnerabilities allows a user without permission to view a given page, to view the contents of any files attached to that page using the view file macro. This assumes that the user has permission to edit or create another page within the Confluence site and knows the name of the file attached to the page they cannot view. For more information, please refer to the JIRA issue CONF-15809.

The second of these vulnerabilities allows users with space administrator permissions to import pages to a Confluence space. The security level of this function has been tightened to permit only users with the system administration permission to access it. For more information, please refer to CONF-15267.
If you have not already upgraded to Confluence 3.0, then we recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

All versions of Confluence up to and including version 2.10.3 with the Office Connector plugin installed are affected by the first view file macro vulnerability.

All versions of Confluence 2.10.x are affected by the second page imports vulnerability.

Fix

These issues have been fixed in Confluence 3.0 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0, you can download and install the patches provided on our JIRA site. You will need to upgrade to the latest point release for the major version of Confluence that you are running (e.g. if you are running Confluence 2.10.0, you will need to upgrade to version 2.10.3) and then apply the patches. For more information, please refer to the specific JIRA issues shown below.

To download the patch to fix the first view file macro vulnerability, please refer to CONF-15809.

To download the patch to fix the second page import vulnerability, please refer to CONF-15267.

Confluence Security Advisory 2009-08-20

In this advisory:

- Privilege Escalation Vulnerability in Profile Picture Handling
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

- XSS Vulnerability in Various Page and Blog Post Features and Functions
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Privilege Escalation Vulnerability in Profile Picture Handling

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified a privilege escalation vulnerability, which could provide an attacker with access to administrative areas and functions of Confluence when specifying a profile picture. Under some circumstances, the attacker could gain access to Confluence administrative functions that they are not authorised to use.

Risk Mitigation

To address the issue, you should upgrade to Confluence 3.0.1 as soon as possible or follow the patch instructions in the Fix section below. If you judge it necessary, you can disable public signup to your wiki until
you have applied the necessary patch or have performed the upgrade. For even tighter control, you could also restrict access to trusted groups or additionally, disable anonymous access until your system is patched or upgraded.

Vulnerability

The profile picture handling feature in all versions of Confluence up to 3.0.0 are affected by this issue. However, the Form Token Handling mechanism available in Confluence 3.0.0 and later means that the administrative areas in these versions of Confluence cannot be compromised by this vulnerability.

Fix

This issue has been fixed in Confluence 3.0.1 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.1 and you are running Confluence 2.10.x, you can download and install the patches provided on our JIRA site. We strongly recommend that you upgrade to the latest point release (2.10.3) before applying the patch. For more information, please refer to CONF-16141.

Our thanks to Elliot Kendall of Emory University, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSS Vulnerability in Various Page and Blog Post Features and Functions

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of XSS vulnerabilities in various Confluence page/blog features and functions, which may affect Confluence instances in a public environment.

XSS vulnerabilities potentially allow a malicious user (attacker) to embed their own JavaScript into a Confluence page.

- The attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.
<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicking a username link</td>
<td>3.0.0</td>
<td>3.0.0 and 3.0.1</td>
<td>CONF-15970</td>
</tr>
</tbody>
</table>
| Moving pages between spaces | 2.8 to 2.10.3 inclusive | 2.10.x and 3.0.1 | CONF-16019*  
                     |                  |                  | CONF-16135*  |
| Entering content into the WebDAV Configuration page | 3.0.0  
                     | 2.10.x with version 2.0 of the WebDAV plugin | 2.10.x, 3.0.0 and 3.0.1 | CONF-16136 |
| Entering content into the PDF Export Stylesheet | 3.0.0 | 3.0.0 and 3.0.1 | CONF-16209 |

* Applying the patch for one of these issues fixes the other.

Fix

These issues have been fixed in Confluence 3.0.1 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.1, you can patch your existing installation by downloading and installing the patched files provided on our JIRA site. For the WebDAV plugin vulnerability, this would involve upgrading the version of the plugin. We strongly recommend that you upgrade to the latest point release of the major version of Confluence that you are running before applying the patches. For example, if you are running Confluence 2.10.1, you should upgrade to version 2.10.3 and then apply the patches. For more information, please refer to the specific JIRA issues shown in the table of vulnerabilities above.

Confluence Security Advisory 2009-10-06

In this advisory:

- Session Fixation Vulnerability
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix
- XSS Vulnerability in Various Confluence Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

Session Fixation Vulnerability

Severity

Atlassian rates these vulnerabilities as **high**, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security vulnerability which may affect Confluence instances in a public environment. This vulnerability could lead to a session fixation attack, in which the malicious user (attacker) can gain access to a victim's Confluence resources whilst the victim is logged in to their Confluence user account.

The attacker does this by fixating (or setting) their session ID onto the victim's computer. While the victim is
logged in, all the victim's privileges are associated with the attacker's session ID, effectively granting the attacker access to all of the Confluence data and resources accessible to the victim.

For more information about session fixation attacks, please refer to the following sources:

- Chris Shiflett's Security Corner article
- The Web Application Security Consortium's overview

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

All versions of Confluence prior to 3.0.2 are vulnerable to this security issue.

Fix

These issues have been fixed in Confluence 3.0.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.2 and you are currently running Confluence version 2.10.x or 3.0.x, you can patch your existing installation by downloading the appropriate patch file attached to JIRA issue CONF-15108 and installing the patch file using the instructions provided in this JIRA issue.

Our thanks to Ben L Broussard who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSS Vulnerability in Various Confluence Macros

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Confluence Security. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities in Confluence's pagetree, userlister and content by label macros. These XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page.

- The attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability
An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of these actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pagetree Macro</td>
<td>2.8.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-16651</td>
</tr>
<tr>
<td>Userlister Macro</td>
<td>2.6.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-16644</td>
</tr>
<tr>
<td>Content by Label Macro</td>
<td>2.10.0 – 3.0.1</td>
<td>2.10.0 – 3.0.2 inclusive</td>
<td>CONF-15440</td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 3.0.2 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.0.2, you can patch your existing installation by upgrading the plugins for these macros via the Confluence Plugin Repository to the version indicated in the JIRA issues listed in the vulnerability section (above).

Confluence Security Advisory 2009-12-08

In this advisory:

- XSS Vulnerability in Various Confluence Actions and Macros
  - Severity
  - Risk Assessment
  - Risk Mitigation
  - Vulnerability
  - Fix

XSS Vulnerability in Various Confluence Actions and Macros

Severity

Atlassian rates these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities that could occur when creating a page or blog post in a personal space, using the indexbrowser.jsp form and when using the gallery macro.

- The attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Risk Mitigation

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can
disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Vulnerability

An attacker can inject their own JavaScript into the Confluence actions listed in the table below. Each of the actions is invoked when a user performs a specific function in Confluence, such as clicking a link or a button. The actions can also be invoked by simply entering the URL into the browser address bar. The rogue JavaScript will be executed when a user invokes the URL.

For more details please refer to the related JIRA issue, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page or blog post creation in a personal space</td>
<td>2.10 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17031</td>
</tr>
<tr>
<td>Using the indexbrowse r.jsp form</td>
<td>All versions prior to and including 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17165</td>
</tr>
<tr>
<td>Gallery macro</td>
<td>2.9 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17361</td>
</tr>
<tr>
<td>Page tree and page tree search macros</td>
<td>2.9 – 3.0.2</td>
<td>2.8 – 3.1 inclusive</td>
<td>CONF-17967</td>
</tr>
<tr>
<td>Status updates tab of the user profile area</td>
<td>3.0.0 – 3.0.2</td>
<td>3.0.0 – 3.1 inclusive</td>
<td>CONF-17933</td>
</tr>
</tbody>
</table>

Fix

These issues have been fixed in Confluence 3.1 (see the release notes), which you can download from the download centre.

If you do not wish to upgrade to Confluence 3.1, you can patch your existing installation by upgrading the plugins for these macros via the Confluence Plugin Repository to the version indicated in the JIRA issues listed in the vulnerability section (above).

Confluence Security Advisory 2010-05-04

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.2.1. In addition to releasing Confluence 3.2.1, we also provide patches for the most important vulnerabilities mentioned. You will be able to apply these patches to older versions of Confluence. There will, however, be a number of security improvements in Confluence 3.2.1 that cannot be patched or backported. We recommend upgrading to Confluence 3.2.1 rather than applying the patches.

In this advisory:

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
- XSS Vulnerability in Database Check Utility (Not Bundled with Confluence)
  - Severity
  - Risk Assessment
Vulnerability
Risk Mitigation
Fix

Unnecessary Exposure of and Access to Information

Severity
Risk Assessment
Vulnerability
Risk Mitigation
Fix

General Tightening of the Confluence Security Model

Severity
Risk Assessment
Vulnerability
Risk Mitigation
Fix

Available Patches and Plugin Upgrades

Step 1 of the Patch Procedure: Install the Patches
Step 2 of the Patch Procedure: Upgrade your Plugins
Step 3 of the Patch Procedure: Remove the Database Check Utility if Previously Installed

XSS Vulnerabilities

Severity
Atlassian rates these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment
We have identified and fixed a number of security vulnerabilities which may affect Confluence instances in a public environment. These flaws are cross-site scripting (XSS) vulnerabilities exposed in the Confluence functions described in the table below.

- An attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- An attacker's text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Vulnerability
We identified and fixed vulnerabilities in the Confluence features described in the table below.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index browser JSP (JavaServer Page)</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19404</td>
<td>High</td>
</tr>
</tbody>
</table>
A JSP that provides an administrator with the location on the file system where the attachments for a given space are stored

<table>
<thead>
<tr>
<th>Feature</th>
<th>Range</th>
<th>Fix</th>
<th>Risk Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>A JSP that allows and administrator to reset null emails addresses to <a href="mailto:dummyvalue@nowhere.org">dummyvalue@nowhere.org</a></td>
<td>2.8.3 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19404</td>
</tr>
<tr>
<td>Colour scheme settings</td>
<td>3.1.2 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19384</td>
</tr>
<tr>
<td>Error messages</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19390 and CONF-19402</td>
</tr>
<tr>
<td>Searching Confluence</td>
<td>2.7.4 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19382</td>
</tr>
<tr>
<td>Attachment upload</td>
<td>3.0.2 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19388</td>
</tr>
<tr>
<td>Content rendering</td>
<td>3.0.0 – 3.2.0</td>
<td>3.2.1 and patch</td>
<td>CONF-19441</td>
</tr>
<tr>
<td>Advanced Macros plugin</td>
<td>3.1.0 – 3.2.0</td>
<td>3.2.1 and plugin upgrade</td>
<td>CONF-19403</td>
</tr>
<tr>
<td>Social Bookmarking plugin</td>
<td>3.0.0 – 3.2.0</td>
<td>3.2.1 and plugin upgrade</td>
<td>CONF-19381</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend either patching or upgrading your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade or patch immediately and you judge it necessary, you can disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

**Fix**

Confluence 3.2.1 fixes all of these issues. See the release notes. You can download Confluence 3.2.1 from the download centre.

If you cannot upgrade to Confluence 3.2.1, you can patch your existing installation using the patches and plugin upgrades listed below. We strongly recommend upgrading to 3.2.1 however, since it adds even more security features than the patches.

Changed behaviour in Confluence

We have removed the indexbrowser.jsp and the viewdocument.jsp pages that used to provide access to the Confluence index browser. Instead, if you need to see more details of the indexed pages in your Confluence site, you can download and run Luke. Luke is a development and diagnostic tool that accesses existing Lucene
indexes and allows you to display and modify their content in several ways. See our document on content index administration.

Our thanks to Brett Porter of The Apache Software Foundation and to David Belcher of Research in Motion, who reported some of the vulnerabilities mentioned above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

XSS Vulnerability in Database Check Utility (Not Bundled with Confluence)

Severity

Atlassian rates this vulnerability as high, according to the scale published in Confluence Security.

Risk Assessment

We have identified and fixed a cross-site scripting (XSS) vulnerability in the Atlassian database check utility that some customers may have installed. The utility is a JSP file, supplied as an attachment to a documentation page.

Note that this utility is not bundled with Confluence. This vulnerability applies to you only if you have downloaded and installed the JSP.

Vulnerability

An attacker can inject their own JavaScript when invoking the database check utility. The rogue JavaScript will be executed when a user invokes the URL. For more details, please refer to CONF-19406.

Risk Mitigation

If you have previously downloaded and installed the testdatabase.jsp utility from the documentation page, you should now remove the testdatabase.jsp file from your <confluence-install>|confluence directory.

When you need to use the utility again, you can download the updated version from the same documentation page.

Fix

If you have previously downloaded and installed the testdatabase.jsp utility from the documentation page, you should now remove the testdatabase.jsp file from your <confluence-install>|confluence directory.

When you need to use the utility again, you can download the updated version from the same documentation page.

⚠️ This fix is not part of Confluence 3.2.1

Because the JSP file is not shipped with the Confluence installation, there is no patch for this vulnerability and there is no fix for it in Confluence 3.2.1. Please check your installation and remove or update the JSP if present.

Unnecessary Exposure of and Access to Information

Severity

Atlassian rates these vulnerabilities as high and moderate, according to the scale published in Confluence Security.

Risk Assessment
We have identified a number of areas where Confluence exposes an unnecessary amount of information that may be useful to an attacker if such an attacker gained access to the information.

**Vulnerability**

We have identified a number of areas where Confluence exposes an unnecessary amount of information, including sensitive information such as usernames and passwords. If an attacker gains access to such information, it may allow such an attacker to gain access to administrative areas and functions of Confluence that they are not authorised to use. Details of each vulnerability are in the table below.

For more details please refer to the related JIRA issues, also shown in the table below.

<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support request form</td>
<td>3.1.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The Confluence support request form automatically generates a zip file containing system information and log files, and submits the file to a given email address along with the support request. The zip file includes configuration files containing usernames, passwords and license details. See CONF-19391</td>
<td>High</td>
</tr>
<tr>
<td>Issue</td>
<td>Version(s)</td>
<td>Risk Level</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>------------</td>
<td>------------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>Support request form</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The Confluence support request form offers a 'CC' email address, allowing the support request and all attached information to be sent to any email address. In addition, it is also possible to set the default email address to any email address, via the Confluence Administration Console. See CONF-19392</td>
<td></td>
</tr>
<tr>
<td>XML site backup</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>It is possible to download an XML backup of the Confluence site from the Confluence Administration Console. See CONF-19393</td>
<td></td>
</tr>
<tr>
<td>Daily site backup</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The path to the daily site backup is configurable via the Confluence Administration Console. It is possible to set the daily backup path and (partial) name through the web UI. This allows an attacker to put the backup in a location that is served by the application server. See CONF-19397</td>
<td></td>
</tr>
<tr>
<td>SOAP and XML-RPC APIs</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The SOAP and XML-RPC APIs give too much information when returning an error about an incorrect login. See CONF-19398</td>
<td>High</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------</td>
<td>------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Information about Confluence administrators</td>
<td>2.7.0 – 3.2.0</td>
<td>3.2.1 only</td>
<td>The list of Confluence administrators is accessible via a URL and shows the username, full name and email address of all administrators. See CONF-19395</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade or patch immediately, consider applying these measures:

- Control the access to your administrator accounts, as described in our document on best practices for configuring Confluence security.
- Disable access to the SOAP and XML-RPC APIs, if these remote APIs are not required. (Remote API access is disabled by default.) See the page about enabling remote APIs.
- Manually remove the list of Confluence administrators that is accessible via a URL, by editing the relevant Velocity template file as follows:
  1. Edit the `administrators.vm` file, located in `{confluence-install}/confluence` for standalone installations, or at the root of the web app for WAR installations.
  2. Replace the content with a message that you would like to be displayed whenever someone accesses this URL. For example:

    ```html
    <html>
    <head>
      <title>$action.getText("title.administrators")</title>
    </head>
    <body>
      The list of Confluence administrators is no longer available. If you would like to contact an administrator, please email admins at example dot com.
    </body>
    </html>
    ```
  3. Save the file. (There is no need to restart Confluence.)

**Fix**

Confluence 3.2.1 fixes these issues. See the release notes. You can download Confluence 3.2.1 from the download...
load centre.

Changed Behaviour in Confluence

In order to fix these problems, we have changed Confluence’s behaviour as follows:

- We have removed all license, username and password information from the zip file generated by the Confluence support request form.
- It is no longer possible to specify a 'CC' email address on the Confluence support request form.
- By default, it is no longer possible to specify a site support email address in the 'General Configuration' section of the Confluence Administration Console. Administrators can restore this functionality by updating the confluence.cfg.xml file found in the Confluence Home Directory. Confluence now recognises a new property in this configuration file, called admin.ui.allow.site.support.email. If the value of the property is 'true', it will be possible to specify a site support email address via the Confluence Administration Console. If the value of this property is 'false' or the property is not present in the file, the email address is not configurable. By default in Confluence 3.2.1 and later, the value is 'false'.
- By default, it is no longer possible to download an XML backup of the Confluence site from the Confluence Administration Console. Instead, you need access to the Confluence server machine in order to retrieve the XML site backup file. Confluence now recognises a new property called admin.ui.allow.manual.backup.download in the confluence.cfg.xml file. If the value of this property is 'true', the Administration Console provides an option to download the XML site backup file. If the value of this property is 'false' or the property is not present in the file, the XML download is not available from the Administration Console. By default in Confluence 3.2.1 and later, the value is 'false'.
- On invalid login attempts, the SOAP and XML-RPC APIs no longer give away the specific information that the user does not exist or that the password is invalid.
- The administrators.action URL no longer opens a page showing the list of Confluence administrators. Instead, the URL will now present a form which you can use to email all the administrators of the site. This is preferable since it does not give the user any information about who these administrators are. See our documentation on configuring the administrator contact page.

General Tightening of the Confluence Security Model

Severity

Atlassian rates these vulnerabilities as high and moderate, according to the scale published in Confluence Security.

Risk Assessment

We have improved the security of the following areas in Confluence:

- Prevention of brute force attacks by imposing a maximum number of repeated login attempts.
- Handling of decorator layouts.

Vulnerability

We have identified and fixed a problem where Confluence allows an unlimited number of repeated login attempts, potentially opening Confluence to a brute force attack. We have also improved the security around the handling of decorator layouts. Details of each improvement are in the table below.

For more details please refer to the related JIRA issues, also shown in the table below.
<table>
<thead>
<tr>
<th>Confluence action</th>
<th>Affected Confluence Versions</th>
<th>Fix Availability</th>
<th>More Details</th>
<th>Severity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Site and space decorator layouts</td>
<td>All versions up to and including 3.2.0</td>
<td>3.2.1 and patch</td>
<td>The BootstrapManager exposed in site and space layout templates should be read only. See CONF-19401</td>
<td>High</td>
</tr>
<tr>
<td>Login</td>
<td>All versions up to and including 3.2.0</td>
<td>3.2.1 only</td>
<td>Confluence does not set a maximum to the number of repeated login attempts. This makes Confluence vulnerable to a brute force attack. See CONF-19396</td>
<td>Moderate</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade immediately, you can patch your existing installation using the patches listed below. The patch will fix the problem with the decorator layouts.

You can prevent brute force attacks by following our guidelines on using Fail2Ban to limit login attempts.

**Fix**

Confluence 3.2.1 fixes these issues. See the release notes. You can download Confluence 3.2.1 from the download centre.

Alternatively, if you are not in a position to upgrade immediately, you can patch your existing installation using the patches listed below. The patch will fix the problem with the decorator layouts.

**Changed Behaviour in Confluence**

In order to fix these problems, we have changed Confluence's behaviour as follows:

- We have improved the security in the way Confluence handles decorator layouts. The BootstrapManager is now read only.
- After three failed login attempts, Confluence will display a Captcha form asking the user to enter a given word when attempting to log in again. This will prevent brute force attacks via the login screen. In addition, after three failed login attempts via the XML-RPC or SOAP API, an error message will be returned instructing the user to log in via the web interface. Captcha will automatically be activated when they attempt this login.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.2.1, you can apply the following patches and plugin upgrades to fix the most pressing vulnerabilities described in this security advisory.
Step 1 of the Patch Procedure: Install the Patches

Patches are available for Confluence 3.2.0, 3.1.2, 3.0.2, 2.10.4, 2.9.3 and 2.8.3. You need to upgrade to the specified bug-fix release of the relevant major version before applying the patches. For example, if your version is Confluence 3.0.0, first upgrade to 3.0.2 and then apply the relevant patch.

The available patches address the following issues:

- XSS in search (CONF-19382).
- XSS in attachment upload (CONF-19388).
- XSS in the index browser JSP (CONF-19404).
- XSS in the JSP that provides an administrator with the location on the file system where the attachments for a given space are stored (CONF-19404).
- XSS in the JSP that allows an administrator to reset null emails addresses (CONF-19404).
- XSS in colour scheme settings (CONF-19384).
- XSS in error messages (CONF-19390 and CONF-19402).
- XSS in content rendering (CONF-19441).
- Secure handling of site and space decorator layouts (CONF-19401).

Each patch covers all of the above issues, and is applicable to the specific version of Confluence. To install the patch, download the appropriate version and follow the instructions below.

<table>
<thead>
<tr>
<th>Your Confluence Version</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.0</td>
<td>confluence-project-3.2.0-stable.zip</td>
</tr>
<tr>
<td>3.1.2</td>
<td>confluence-project-3.1-stable.zip</td>
</tr>
<tr>
<td>3.0.2</td>
<td>confluence-project-3.0-stable.zip</td>
</tr>
<tr>
<td>2.10.4</td>
<td>confluence-project-2.10-stable.zip</td>
</tr>
<tr>
<td>2.9.3</td>
<td>confluence-project-2.9-stable.zip</td>
</tr>
<tr>
<td>2.8.3</td>
<td>confluence-project-2.8-stable.zip</td>
</tr>
</tbody>
</table>

Applying the patch

If you are using the Standalone distribution of Confluence:

1. Make a backup of the `<confluence_install_dir>/confluence/` directory.
2. Download the `confluence-x-patch.zip` file from the location given in the table above, for your version of Confluence.
3. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files in that location.
4. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
2. Download the `confluence-x-patch.zip` file from the location given in the table above, for your version of Confluence.
3. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files in that location.
4. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
5. Run `build.sh` on UNIX or `build.bat` on Windows.
6. Redeploy the Confluence web app into your application server.
Step 2 of the Patch Procedure: Upgrade your Plugins

Two of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to upgrade the affected plugin to get the fixed version. You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository. Please refer to the documentation for more details on installing plugins.

1. If you are running Confluence 3.1.0 or later, you will need to install the latest version of the Confluence Advanced Macros plugin. Earlier versions of Confluence are not affected and therefore do not need an upgraded plugin.
2. If you are running Confluence 3.0.0 or later, you will need to install the latest version of the Social Bookmarking plugin. Earlier versions of Confluence are not affected and therefore do not need an upgraded plugin.

Step 3 of the Patch Procedure: Remove the Database Check Utility if Previously Installed

If you have previously downloaded and installed the testdatabase.jsp utility from the documentation page, you should now remove the testdatabase.jsp file from your <confluence-install>\confluence directory. See above for more details of this utility.

Confluence Security Advisory 2010-06-02

This security advisory announces a vulnerability in the Confluence Mail Page plugin that may expose a Confluence site to XSS (cross-site scripting) attacks, if it is enabled (note, the Confluence Mail Page plugin is disabled by default). If you do not have this plugin enabled, your site will not be affected. However, we recommend that you still read the advisory below.

In this advisory:

- XSS Vulnerability in Confluence Mail Page Plugin
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

XSS Vulnerability in Confluence Mail Page Plugin

Severity

Atlassian rates this vulnerability as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a security vulnerability which may affect Confluence instances in a public environment. This flaw is a cross-site scripting (XSS) vulnerability that could occur if you have the Confluence Mail Page plugin enabled. The Confluence Mail Page plugin is bundled with Confluence, although it is disabled by default.

- The attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to the attacker's own web server.
- The attacker’s text and script might be displayed to other people viewing the Confluence page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.

Vulnerability

An attacker can execute their own JavaScript when a user enters a custom URL into the browser address bar (e.g. the user clicks a crafted link in an email). The rogue JavaScript will be executed when the user invokes the
URL. For more details, please refer to CONF-19802.

Risk Mitigation

We recommend installing the updated Confluence Mail Page plugin into your Confluence installation to fix this vulnerabilities. Please see the 'Fix' section below.

Alternatively, if you are not in a position to undertake this immediately and you judge it necessary, you can disable the Confluence Mail Page plugin (note, the plugin is disabled by default). You may also wish to disable public access (e.g. anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

Fix

These issues have been fixed in the latest version (v1.10) of the Confluence Mail Page plugin, which you can download from the Atlassian Plugin Exchange. Installation instructions are available on the plugin documentation page.

Please note, version 1.10 of the Confluence Mail Page plugin will only work with Confluence 3.2. You will need to upgrade to Confluence 3.2 before installing the updated plugin.

Confluence Security Advisory 2010-07-06

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.3. In addition to releasing Confluence 3.3, we also provide patches (in the form of plugin upgrades) for the vulnerabilities mentioned. You will be able to apply these plugin upgrades to older versions of Confluence. There will, however, be a number of security improvements in Confluence 3.3 that cannot be patched or backported. We recommend upgrading to Confluence 3.3 rather than applying the plugin upgrades.

In this advisory:

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

XSS Vulnerabilities

Severity

Atlassian rates the severity level of these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances in a public environment. These vulnerabilities are exposed in the Confluence functions described in the table below.

- An attacker might take advantage of the vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker's text and script might be displayed to other people viewing the page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at cgisecurity, CERT and other places on the web.
Vulnerability

We have identified and fixed vulnerabilities in the Confluence features described in the table below.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF export</td>
<td>3.1.0 – 3.2.1</td>
<td>CONF-20121</td>
</tr>
<tr>
<td>Clickr theme</td>
<td>2.7.0 – 3.2.1</td>
<td>CONF-20126</td>
</tr>
<tr>
<td>Tasklist macro</td>
<td>2.8.0 – 3.2.1</td>
<td>CONF-20119</td>
</tr>
<tr>
<td>Contributors plugin (Contributors macro and Contributors Summary macro)</td>
<td>3.0.0 – 3.2.1</td>
<td>CONF-20122 CONF-20125</td>
</tr>
</tbody>
</table>

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities. Please see the ‘fix’ section below.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can apply one or both of the following mitigations:

- Disable every one of the affected plugins, as listed below. You can disable plugins via the Confluence Administration Console. See our Universal Plugin Manager Documentation.
- Disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

In addition, please refer to our guidelines on best practices for configuring Confluence security. In particular, please read our guidelines on using Apache to limit access to the Confluence administration interface.

Fix

Please choose one of the options below that best suits your Confluence version and your ability to upgrade immediately.

Option 1 (Recommended): Upgrade to Confluence 3.3

We recommend that you upgrade to Confluence 3.3, which fixes all of the security issues reported in this advisory. See the Confluence 3.3 release notes. You can download Confluence 3.3 from the download centre.

Option 2: Upgrade or Disable the Affected Plugins

If you cannot upgrade your Confluence installation, you can upgrade or disable the affected plugins to fix the vulnerabilities described in this security advisory.

- You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository or by manually uploading the JAR. Please refer to the documentation for more details on installing plugins.
- You can disable plugins via the Confluence Administration Console. See Universal Plugin Manager Documentation.

<table>
<thead>
<tr>
<th>Affected Feature</th>
<th>Confluence Versions that Can Update the Plugin</th>
<th>Upgrade or Disable Plugin</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugin</td>
<td>Version</td>
<td>Action</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PDF export plugin</td>
<td>3.1 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.1.x or 3.2.x, you should install version 1.9 of the PDF Export plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.0.2 or earlier, you do not need to take any action as these versions are not affected by the security flaw.</td>
</tr>
<tr>
<td>Clickr theme</td>
<td>3.2 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.2.x, you should install version 2.10 of the Clickr Theme plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.1.2 or earlier, you should disable the 'Clickr Theme' plugin.</td>
</tr>
<tr>
<td>Tasklist macro</td>
<td>3.1 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.1.x or 3.2.x, you should install version 3.2.5.2 of the Dynamic Task List 2 plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 2.8.x to 3.0.x, you should disable the 'Dynamic Task List 2' plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 2.7.x or earlier, you do not need to take any action as these versions are not affected by the security flaw.</td>
</tr>
<tr>
<td>Contributors plugin</td>
<td>3.0 – 3.3</td>
<td>If you cannot upgrade to Confluence 3.3:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 3.0.x to 3.2.x, you should install version 1.2.6 of the Contributors plugin.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• If you are running Confluence 2.10.4 or earlier, you do not need to take any action as these versions are not affected by the security flaw.</td>
</tr>
</tbody>
</table>
This advisory announces a security vulnerability in Confluence 3.3 that we have found and fixed in Confluence 3.3.1. We recommend that you upgrade to Confluence 3.3.1 to fix this vulnerability.

In this advisory:

- Secure Administrator Session Vulnerability
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix

Secure Administrator Session Vulnerability

Severity

Atlassian rates this vulnerability as **high**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a vulnerability in the Secure Administrator Sessions feature, introduced in Confluence 3.3, that allows it to be bypassed.

Vulnerability

If an attacker is able to gain access to a session with administrator privileges, they will be able to access all administrator functions without having to re-authenticate.

This vulnerability exists in **Confluence 3.3 only**.

See CONF-20508 for more details.

Risk Mitigation

We recommend upgrading your Confluence installation to fix these vulnerabilities. Please see the 'fix' section below.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary upgrade. For even tighter control, you could restrict access to trusted groups.

Fix

Confluence 3.3.1 fixes this issue. See the release notes. You can download Confluence 3.3.1 from the download centre.

Confluence Security Advisory 2010-09-21

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.3.3. We recommend that you upgrade to Confluence 3.3.3 to fix these vulnerabilities.

In this advisory:

- Path Traversal Vulnerability in Various Confluence Actions
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
Path Traversal Vulnerability in Various Confluence Actions

Severity

Atlassian rates this vulnerability as critical, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank a vulnerability as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a path traversal vulnerability in various Confluence actions. By exploiting a path traversal vulnerability, attackers may be able to retrieve any file on the server that is running Confluence, based on the permissions of the user under which Confluence is running. Path traversal attacks are also called 'directory traversal' or 'dot-dot-slash' (../) attacks.

The degree to which a Confluence instance is vulnerable depends on a number of factors in the implementation of the instance. See the mitigation strategies below, for details of how you can reduce your vulnerability.

You can read more about path traversal attacks at Open Web Application Security Project (OWASP) and other places on the web.

Vulnerability

The path traversal vulnerability exists in various Confluence actions, in all versions of Confluence up to and including 3.3.1.

See CONF-20668 for issue tracking.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately, please consider the following mitigation strategies:

- Make sure that you do not start Confluence from the root directory when starting Confluence
automatically. Instead, start it from a reduced-scope directory such as the \{Confluence-installation\}/bin directory.

- Upgrade your Tomcat version to 6.0.26 or later. This is relevant if you are using a WAR distribution of Confluence in your own Tomcat server.
- If you are running Confluence under UNIX, you should run Confluence inside a chroot jail. See Best Practices for UNIX chroot() Operations from Steve Friedl.
- In addition, please refer to our guidelines on Tomcat security best practices. (This is a JIRA document but the principles apply to Confluence.) In particular, you should restrict the file access of the username under which Confluence is running.

Fix

Confluence 3.3.3 fixes this issue. See the release notes. You can download Confluence 3.3.3 from the download centre.

If you cannot upgrade to Confluence 3.3.3, you can patch your existing installation using the patches listed below.

Our thanks to Warren Leung of UCLA, who reported this vulnerability. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Configuration of Office Connector Temporary Storage Location

Severity

Atlassian rates this vulnerability as high, according to the scale published in Severity Levels for Security Issues.

Risk Assessment

Earlier versions of Confluence allow the administrator to set the temporary storage location for the View File macro, part of the Office Connector. Provided an attacker has gained administrative access to the system in some way, they could then exploit this vulnerability to save malicious files onto the file system.

Vulnerability

This vulnerability exists in the Office Connector configuration, made available to Confluence administrators via the Confluence Administration Console and the related Confluence action.

This vulnerability affects versions of Confluence from 2.8 up to and including 3.3.1, where the Office Connector is installed. Please note that the Office Connector is bundled in Confluence 2.10 and later.

See CONF-20669 for issue tracking.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can choose one of the following mitigation strategies:

- Disable the Office Connector plugin. You can disable plugins via the Confluence Administration Console. See our documentation on installing and configuring plugins.
- Disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary upgrade. For even tighter control, you could restrict access to trusted groups.

In addition, please refer to our guidelines on best practices for configuring Confluence security.

Fix

Confluence 3.3.3 fixes this issue. Administrators must edit a properties file to configure the path. See the release notes for more information. You can download Confluence 3.3.3 from the download centre.
If you cannot upgrade to Confluence 3.3.3, you can patch your existing installation using the patches listed below.

**XSS Vulnerability in the Office Connector**

**Severity**

Atlassian rates the severity level of this vulnerability as **high**, according to the scale published in *Severity Levels for Security Issues*.

**Risk Assessment**

We have identified and fixed a cross-site scripting (XSS) vulnerability which may affect Confluence instances, including publicly available instances.

- An attacker might take advantage of the vulnerability to steal other users’ session cookies or other credentials, by sending the credentials back to such an attacker’s own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker’s text and script might be displayed to other people viewing the page. This is potentially damaging to your company’s reputation.

You can read more about XSS attacks at [cgisecurity](http://www.cgisecurity.com), [CERT](http://www.cert.org) and other places on the web.

**Vulnerability**

The XSS vulnerability is exposed in the document import function of the Confluence Office Connector.

This vulnerability exists in **Confluence 3.3.1 only**, where the Office Connector is enabled. Please note that the Office Connector is bundled in Confluence.

See CONF-20670 for issue tracking.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable the Office Connector plugin. You can disable plugins via the Confluence Administration Console. See our documentation on [installing and configuring plugins](http://docs.atlassian.com/display/DOC/Installing+and+Configuring+Plugins).

In addition, please refer to our guidelines on [best practices for configuring Confluence security](http://docs.atlassian.com/display/DOC/Best+Practices+for+Confluence+Security). In particular, please read our guidelines on [using Apache to limit access to the Confluence administration interface](http://docs.atlassian.com/display/DOC/Using+Apache+to+Limit+Access+to+the+Confluence+Administration+Interface).

**Fix**

Confluence 3.3.3 fixes this issue. See the [release notes](http://docs.atlassian.com/display/DOC/Release+Notes). You can download Confluence 3.3.3 from the [download centre](http://www.atlassian.com/software/atlassian/downloads).

**XSRF Vulnerability in Confluence Mail Page Plugin**

**Severity**

Atlassian rates the severity level of this vulnerability as **high**, according to the scale published in *Severity Levels for Security Issues*.

**Risk Assessment**

We have identified and fixed a cross-site request forgery (XSRF) vulnerability which may affect Confluence instances, including publicly available instances.

An attacker might take advantage of the vulnerability to trick users into emailing the contents of restricted pages to an arbitrary address without their knowledge. An XSRF attack works by exploiting the trust that a site has for...
the user. If a user is logged in to Confluence and an attacker tricks their browser into making a request to a
Confluence URL, then the task is performed as the logged in user.

You can read more about XSRF attacks at cgisecurity and other places on the web.

**Vulnerability**

The XSRF vulnerability is exposed in the Confluence Mail Page plugin.

This vulnerability exists in versions of Confluence from 2.4 up to and including 3.3.1, where the Mail Page
plugin is enabled. Note that the Mail Page plugin is disabled by default. If you do not have this plugin enabled,
your site will not be affected.

See CONF-20671 for issue tracking.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation, or install the updated Confluence Mail Page
plugin into your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable the
Confluence Mail Page plugin. (Note that the plugin is disabled by default).

**Fix**

Confluence 3.3.3 fixes this issue. See the release notes. You can download Confluence 3.3.3 from the download
centre.

The latest version (v1.12) of the Confluence Mail Page plugin also fixes this issue. You can download the plugin
from the Atlassian Marketplace. Please refer to the documentation for instructions on installing plugins.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.3.3, you can apply the following patches and plugin
upgrades to fix the vulnerabilities described in this security advisory.

**Step 1 of the Patch Procedure: Install the Patch**

A patch is available for Confluence 3.2.1. (That is, the Confluence 3.2.1_01 distribution.) If you have Confluence
3.2.0, you need to upgrade to Confluence 3.2.1 before applying the patch.

The patch addresses the following issue:

- Path traversal vulnerability (CONF-20668).

Applying the patch

If you are using the Confluence 3.2.1 distribution:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.2.1-to-3.3.2-security-patch.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.2.1-to-3.3.2-security-patch.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
6. Run `build.sh` on UNIX or `build.bat` on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.

**Step 2 of the Patch Procedure: Update your Plugins**

Some of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to update the affected plugin to get the fixed version. You can update the plugins in the normal manner, via the Universal Plugin Manager. Please refer to the documentation for more details on installing plugins.

1. Install the latest version (v1.12) of the Mail Page plugin.
2. Install version 1.7.1 of the Office Connector plugin.

Confluence Security Advisory 2010-10-12

This advisory announces a number of security vulnerabilities in earlier versions of Confluence that we have found and fixed in Confluence 3.4. In addition to releasing Confluence 3.4, we also provide patches for the vulnerabilities mentioned below. You will be able to apply these patches to existing installations of Confluence 3.3.3. However, we recommend that you upgrade to Confluence 3.4 to fix these vulnerabilities.

**In this advisory:**

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
- Available Patches and Plugin Upgrades
  - Step 1 of the Patch Procedure: Install the Patch
  - Step 2 of the Patch Procedure: Upgrade the Affected Plugins

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of these vulnerabilities as **high**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank the severity as critical, high, moderate or low.

**Risk Assessment**

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances.

- An attacker might take advantage of an XSS vulnerability to steal other users' session cookies or other credentials, by sending the credentials back to such an attacker's own web server.
- XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. An attacker's text and script might be displayed to other people viewing the page. This is potentially damaging to your company's reputation.

You can read more about XSS attacks at [cgssecurity](#) and [CERT](#) and other places on the web.

**Vulnerability**

The table below describes the parts of Confluence affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
</table>

---

*[Creative Commons Attribution 2.5 Australia License](#)*
<table>
<thead>
<tr>
<th>Space names</th>
<th>2.9 – 3.3.3</th>
<th>CONF-20740</th>
</tr>
</thead>
<tbody>
<tr>
<td>Office Connector</td>
<td>3.0 – 3.3.3</td>
<td>CONF-20963</td>
</tr>
<tr>
<td>Tasklist macro</td>
<td>1.3 – 3.3.3</td>
<td>CONF-20964</td>
</tr>
</tbody>
</table>

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public access (such as anonymous access and public signup) to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security and using Apache to limit access to the Confluence administration interface.

**Fix**

Confluence 3.4 fixes these issues. For a full description of this release, see the release notes. You can download Confluence 3.4 from the download centre.

If you cannot upgrade to Confluence 3.4, you can patch your existing installation using the patches listed below.

**Available Patches and Plugin Upgrades**

If for some reason you cannot upgrade to Confluence 3.4, you can apply the following patches and plugin upgrades to fix the vulnerabilities described in this security advisory.

**Step 1 of the Patch Procedure: Install the Patch**

A patch is available for Confluence 3.3.3.

The patch addresses the following issues:

- XSS vulnerability in space names (CONF-20740).
- XSS vulnerability in Office Connector (CONF-20963).

If you are using the Confluence distribution:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.3.3-to-3.4-security-patch.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.3.3-to-3.4-security-patch.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
6. Run `build.sh` on UNIX or `build.bat` on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.

**Step 2 of the Patch Procedure: Upgrade the Affected Plugins**
Some of the above vulnerabilities exist in plugins and are therefore not included in the patch. To fix these vulnerabilities, you will need to upgrade the affected plugins. You can upgrade the plugins in the normal manner, via the Confluence Plugin Repository. Please refer to the documentation for more details on installing plugins.

- Install the latest version (v3.3.1) of the Dynamic Tasklist 2 plugin.
- Install the latest version (v1.2.2) of the Documentation Theme plugin.

Confluence Security Advisory 2010-11-15

Security Vulnerability in Confluence Remote API

Severity

Atlassian rates the severity level of this vulnerability as critical, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, moderate or low.

Risk Assessment

We have identified and fixed a vulnerability in the Remote API which affects Confluence instances, including publicly available instances. The Remote API allows an attacker to escalate user privileges, excluding the level of system administrator privileges.

Vulnerability

The table below describes the Confluence versions and the specific functionality affected by the RPC vulnerability.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Access</td>
<td>2.7 – 3.4</td>
<td>3.4.2</td>
<td>CONF-21162</td>
</tr>
</tbody>
</table>

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

We strongly advise that you disable the remote APIs until your Confluence instance is patched or upgraded. If the Remote API is vital, we recommend you disable anonymous access to the remote API.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

Fix

Confluence 3.4.2 fixes this issue. For a full description of this release, see the release notes. You can download Confluence 3.4.2 from the download centre.

If you cannot upgrade to Confluence 3.4.2, you can patch your existing installation using the patch listed below.

Available Patch

If for some reason you cannot upgrade to the latest version of Confluence, you can apply the following patch to fix the vulnerability described in this security advisory.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security vulnerability in Confluence Remote API</td>
<td>confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip</td>
</tr>
</tbody>
</table>

Patch Procedure: Install the Patch

A patch is available for Confluence 2.7 – 3.4.1.
The patch addresses the following issue:

- Security vulnerability in Confluence RPC (CONF-21162).

Applying the patch

If you are using the Confluence 2.7 – 3.4.1 distributions:

1. Shut down Confluence.
2. Make a backup of the `<confluence_install_dir>/confluence/` directory.
3. Download the `confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip` file.
4. Expand the zip file into `<confluence_install_dir>/confluence/`, overwriting the existing files.
5. Restart Confluence.
6. Visit `<Confluence base url>/admin/patch342applied.jsp` and confirm that it reports: "The Patch for Confluence 3.4.2 has been correctly applied."

If you are using the WAR distribution of Confluence:

1. Shut down Confluence.
2. Make a backup of the `<confluence_exploded_war>/confluence/` directory.
3. Download the `confluence-3.4.2-security-patch-for-2.7-to-3.4.1.zip` file.
4. Expand the zip file into `<confluence_exploded_war>/confluence/`, overwriting the existing files.
5. Run `build.sh clean` on UNIX, or `build.bat clean` on Windows.
6. Run `build.sh` on UNIX or `build.bat` on Windows.
7. Redeploy the Confluence web app into your application server.
8. Restart Confluence.
9. Visit `<Confluence base url>/admin/patch342applied.jsp` and confirm that it reports: "The Patch for Confluence 3.4.2 has been correctly applied."

Confluence Security Advisory 2011-01-18

This advisory announces a number of security vulnerabilities that we have found and fixed in recent versions of Confluence. We also provide patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your Confluence installation rather than applying the patches. Enterprise Hosted customers should request an upgrade by raising a support request at http://support.atlassian.com. JIRA Studio is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

In this advisory:

- XSS Vulnerabilities
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches

XSS Vulnerabilities

Severity

Atlassian rates the severity level of these vulnerabilities as **high**, according to the scale published in *Severity Levels for Security Issues*. The scale allows us to rank the severity as critical, high, moderate or low.

Risk Assessment
We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances (that is, internet-facing servers). XSS vulnerabilities potentially allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at cgisecurity.com, The Web Application Security Consortium and other places on the web.

**Vulnerability**

The table below describes the Confluence versions and the specific functionality affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code macro</td>
<td>2.7 – 3.4</td>
<td>CONF-21098</td>
</tr>
<tr>
<td>Attachments macro</td>
<td>3.3 – 3.4</td>
<td>CONF-21099</td>
</tr>
<tr>
<td>Bookmarks macro</td>
<td>3.1 – 3.4.3</td>
<td>CONF-21390</td>
</tr>
<tr>
<td>Global Reports macro</td>
<td>2.7 – 3.4.3</td>
<td>CONF-21391</td>
</tr>
<tr>
<td>Recently Updated macro</td>
<td>3.0 - 3.4.3</td>
<td>CONF-21392</td>
</tr>
<tr>
<td>Pagetree macro</td>
<td>2.7 - 3.4.3</td>
<td>CONF-21393</td>
</tr>
<tr>
<td>Create Space Button macro</td>
<td>2.7 - 3.4.3</td>
<td>CONF-21394</td>
</tr>
<tr>
<td>Documentation Link macro</td>
<td>2.7 – 3.4.5</td>
<td>CONF-21508</td>
</tr>
</tbody>
</table>

Our thanks to dave b, who reported the vulnerability in the Documentation Link macro. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

**Fix**

Confluence 3.4.6 fixes these issues. For a full description of this release, see the release notes. You can download the latest version of Confluence from the download centre.

**Patches**

If for some reason you cannot upgrade to the latest version of Confluence, you can apply patches to fix the vulnerabilities described in this security advisory. The patches are attached to the relevant issues, as listed in the table above.

Please note that we have released a number of advisories about Confluence recently. We recommend that you review them and upgrade to the most recent release of the product or apply external security controls if you cannot. Most of the disclosed vulnerabilities are not critical and often present less risk when used in a corporate environment with no access from the Internet.

We usually provide patches only for vulnerabilities of critical severity, as an interim solution until you can...
Customers running Confluence 3.4.x:

Please replace the following JAR file with the updated `atlassian-renderer-6.2.jar`:

CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/lib/atlassian-renderer.jar

Customers running Confluence 3.3.x:

Please replace the following JAR file with the updated `atlassian-renderer-6.0.6.jar`:

CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/lib/atlassian-renderer.jar

Customers running Confluence 3.4.x:

Please replace the following `vm` file with the updated `attachments-table.vm-3.4.x.zip`:

CONFLUENCE_INSTALL_DIR/confluence/pages/includes/attachments-table.vm

Customers running Confluence 3.3.x:

Please replace the following `vm` file with the updated `attachments-table.vm`:

CONFLUENCE_INSTALL_DIR/confluence/pages/includes/attachments-table.vm

Update the `.jar` file with the fix contained in the file archive (zip). Follow these steps to do so:
• Browse to CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
• Open the file atlassian-bundled-plugins.zip
• Decompress the contents into another location
• Replace the current socialbookmarking.jar with the correct file according to your version.
• Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
• Please note, make sure you place the files directly inside the zip, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Global Reports Macro</td>
<td>confluence-dashboard-macros-3.4.4.jar</td>
<td>CONF-21391</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Global Reports Macro</td>
<td>confluence-dashboard-macros-1.13.1.jar</td>
<td>CONF-21391</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

• Browse to CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
• Open the file atlassian-bundled-plugins.zip
• Decompress the contents into another location
• Replace the current confluence-dashboard-macros.jar the correct file according to your version.
• Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
• Please note, make sure you place the files directly inside the zip, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Code Macro</td>
<td>confluence-advanced-macros-1.12.3.jar</td>
<td>CONF-21392</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Code Macro</td>
<td>confluence-advanced-macros-1.9.2.jar</td>
<td>CONF-21392</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

• Browse to CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
• Open the file atlassian-bundled-plugins.zip
• Decompress the contents into another location
• Replace the current confluence-advanced-macros.jar with the correct file according to your version.
• Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
• Please note, make sure you place the files directly inside the zip, not contained inside another folder.
<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Pagetree Macro</td>
<td>pagetree-1.20.jar</td>
<td>CONF-21393</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- **Open the file** atlassian-bundled-plugins.zip
- Decompress the contents into another location
- Replace the current pagetree.jar with the correct file according to your version.
- Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
- Please note, make sure you place the files directly inside the zip, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Create Space Button macro</td>
<td>confluence-dashboard-macros-3.4.4.jar</td>
<td>CONF-21394</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Create Space Button macro</td>
<td>confluence-dashboard-macros-1.13.1.jar</td>
<td>CONF-21394</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- **Open the file** atlassian-bundled-plugins.zip
- Decompress the contents into another location
- Replace the current confluence-dashboard-macros.jar with the correct file according to your version.
- Compress all the jar files into another zip with the same name as the original file (atlassian-bundled-plugins.zip)
- Please note, make sure you place the files directly inside the zip, not contained inside another folder.

<table>
<thead>
<tr>
<th>Supported Version</th>
<th>Confluence Feature</th>
<th>File Name</th>
<th>Issue Tracking</th>
<th>Download Security Update</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>Documentation Link macro</td>
<td>confluence-advanced-macros-1.12.3.jar</td>
<td>CONF-21508</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>Documentation Link macro</td>
<td>confluence-advanced-macros-1.9.2.jar</td>
<td>CONF-21508</td>
<td>Download</td>
</tr>
</tbody>
</table>

Update the .jar file with the fix contained in the file archive (zip). Follow these steps to do so:

- **Browse to** CONFLUENCE_INSTALL_DIR/confluence/WEB-INF/classes/com/atlassian/confluence/setup
- **Open the file** atlassian-bundled-plugins.zip
- Decompress the contents into another location
This cumulative security advisory announces a number of security vulnerabilities that we have found in Confluence and fixed in recent versions of Confluence. We also provide upgraded plugins and patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your complete Confluence installation rather than upgrading only the affected plugins. **Enterprise Hosted** customers should request an upgrade by raising a support request at [http://support.atlassian.com](http://support.atlassian.com). **JIRA Studio** is not vulnerable to any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

**In this advisory:**

- **XSS Vulnerabilities**
  - **Severity**
  - **Risk Assessment**
  - **Vulnerability**
  - **Risk Mitigation**
  - **Fix**
  - **Patches**

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of these vulnerabilities as **high**, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank the severity as critical, high, moderate or low.

These vulnerabilities are **not** critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Risk Assessment**

We have identified and fixed a number of cross-site scripting (XSS) vulnerabilities which may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at [ciscosity.com](http://ciscosity.com), [The Web Application Security Consortium](http://www.wasc.org) and other places on the web.

**Vulnerability**

The table below describes the Confluence versions and the specific functionality affected by each of the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Versions</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Page macro</td>
<td>2.7 – 3.4.6</td>
<td>CONF-21604</td>
</tr>
<tr>
<td>Activity Stream gadget</td>
<td>3.1 – 3.4.6</td>
<td>CONF-21606</td>
</tr>
<tr>
<td>Action links of attachments lists</td>
<td>2.7 – 3.4.7</td>
<td>CONF-21766</td>
</tr>
<tr>
<td>Table of Contents macro</td>
<td>2.9 – 3.4.8</td>
<td>CONF-21819</td>
</tr>
</tbody>
</table>
Our thanks to Dave B, who reported the vulnerability in the action links of attachments lists. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

**Risk Mitigation**

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

**Fix**

Confluence 3.4.9 or later fixes all of these issues. Some issues have been fixed in earlier versions as described in the table above. For a full description of this release, see the release notes. You can download the latest version of Confluence from the download centre. The most recent version at the time of this advisory is Confluence 3.5.

**Patches**

If for some reason you cannot upgrade to the latest version of Confluence, you can upgrade the relevant plugins (below) in your Confluence installation to fix the vulnerabilities described in this security advisory.

For details on upgrading Confluence's plugins using the plugin manager, see:

- Upgrading your Existing Plugins (for Confluence 3.4.x) or
- Installing and Configuring Plugins using the Plugin Repository Client (for Confluence 3.3.x).

Patches are also attached to the relevant issues (listed in the table above) if you need to apply these fixes manually.

Please note that we have released a number of advisories about Confluence recently. We recommend that you review them and upgrade to the most recent release of the product or apply external security controls if you cannot. Most of the disclosed vulnerabilities are not critical and often present less risk when used in a corporate environment with no access from the Internet.

We usually provide patches only for vulnerabilities of critical severity, as an interim solution until you can upgrade. You should not expect that you can continue patching your system instead of upgrading. Our patches are often non-cumulative – we do not recommend that you apply multiple patches from different advisories on top of each other, but strongly recommend to upgrade to the most recent version regularly.

We recommend patching only when you can neither upgrade nor apply external security controls.

---

### Include Page Macro

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4.x</td>
<td>CONF-21604</td>
<td>confluence-advanced-macos-1.12.4.jar</td>
<td>Download</td>
</tr>
<tr>
<td>3.3.x</td>
<td>CONF-21604</td>
<td>confluence-advanced-macos-1.9.3.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

---

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
To apply this fix, use the plugin manager to upgrade the Advanced Macros plugin to a version greater than or equal to that specified in the file name above.

Activity Stream Gadget

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3.x</td>
<td>CONF-21606</td>
<td>streams-confluence-plugin-3.3-CONF-21606.jar</td>
<td>Download</td>
</tr>
<tr>
<td>3.4.x</td>
<td>CONF-21606</td>
<td>streams-confluence-plugin-3.4.6.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

It’s currently not possible to upgrade the Activity Streams Plugin automatically using the 3.4 plugin manager or the 3.3 plugin repository. Instead, you will need to manually install the plugin as follows:

1. Download the JAR file for your version of Confluence (see above).
2. Install the plugin manually using the “Upload Plugin” link on the “Install” tab of the plugin manager.

Action links of attachments lists

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3.x, 3.4.x</td>
<td>CONF-21766</td>
<td>confluence-attachments-plugin-2.20.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

To apply this fix, use the plugin manager to upgrade the Confluence Attachments Plugin plugin to a version greater than or equal to that specified in the file name above.

Table of Contents macro

<table>
<thead>
<tr>
<th>Supported Confluence Versions</th>
<th>Issue Tracking</th>
<th>File Name</th>
<th>Downloadable Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3.x, 3.4.x</td>
<td>CONF-21819</td>
<td>toc-plugin-2.4.12.jar</td>
<td>Download</td>
</tr>
</tbody>
</table>

To apply this fix, use the plugin manager to upgrade the Table of Contents Plugin plugin to a version greater than or equal to that specified in the file name above.

Confluence Security Advisory 2011-05-31

It has been incorrectly advised previously that CONF-22479 (User Preferences) affects all versions starting 2.7 while in fact it is exploitable only in 3.5 and above. Our sincere apologies, this will not happen again.

You can still apply the patch to 3.4 in order to remove the root cause of this bug and potentially prevent other similar vulnerabilities from appearing.

This advisory announces security vulnerabilities that we have found in Confluence and fixed in a recent version of Confluence. We also provide upgraded plugins and patches that you will be able to apply to existing installations of Confluence to fix these vulnerabilities. However, we recommend that you upgrade your complete
Confluence installation rather than upgrading only the affected plugins. Enterprise Hosted customers should request an upgrade by raising a support request at http://support.atlassian.com. JIRA Studio is not vulnerable to the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerabilities listed in this advisory have been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

In this advisory:

- **XSS Vulnerabilities**
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches
  - Patch Procedure: Install the Patch
    - Applying the patch

- **XSRF Vulnerability**
  - Severity
  - Risk Assessment
  - Vulnerability
  - Risk Mitigation
  - Fix
  - Patches
  - Patch Procedure: Install the Patch
    - Applying the patch

**XSS Vulnerabilities**

**Severity**

Atlassian rates the severity level of both these vulnerabilities as high, according to the scale published in Severity Levels for Security Issues. The scale allows us to rank the severity as critical, high, medium or low. These vulnerabilities are not critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Risk Assessment**

We have identified and fixed cross-site scripting (XSS) vulnerabilities that may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a Confluence page. You can read more about XSS attacks at cgisecurity.com, The Web Application Security Consortium and other places on the web.

**Vulnerability**

The table below describes the Confluence versions and the specific functionality affected by the XSS vulnerabilities.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Version</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>3.5 – 3.5.2</td>
<td>3.5.3</td>
<td>CONF-22402</td>
</tr>
<tr>
<td>User Preferences</td>
<td>3.5 – 3.5.2</td>
<td>3.5.3</td>
<td>CONF-22479</td>
</tr>
</tbody>
</table>
Our thanks to Marian Ventuneac (http://www.ventuneac.net) who reported the vulnerabilities mentioned above. We fully support the reporting of vulnerabilities and we appreciate it when people work with us to identify and solve the problem.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security.

Fix

These vulnerabilities (CONF-22402 and CONF-22479) are both fixed in Confluence 3.5.3, and later versions. For a full description of the latest version of Confluence, see the release notes. You can download the latest version of Confluence from the download centre.

If you cannot upgrade to the latest version of Confluence, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

Patches

If you are running Confluence 3.5, we highly recommend that you upgrade to Confluence 3.5.3, or later.

If you are running Confluence 3.4, you can apply the following patch to fix the CONF-22479 vulnerability. The CONF-22402 vulnerability does not affect Confluence 3.4.

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Preferences</td>
<td>Attached to issue CONF-22479</td>
<td>CONF-22479_patch.zip</td>
</tr>
</tbody>
</table>

Patch Procedure: Install the Patch

A patch is available for Confluence 3.4 – 3.4.9.

The patch addresses the following issue:

Security vulnerability in Confluence User Preferences (CONF-22479).

Applying the patch

If you are using Confluence 3.4 – 3.4.9:

1. Download the CONF-22479_patch.zip file that is attached to the CONF-22479 issue.
2. Stop Confluence.
3. Make a backup of the <confluence_install_dir> directory.
4. Expand the downloaded zip file into <confluence_install_dir>, overwriting the existing files.
5. Check that the following files were created:
   - confluence/WEB-INF/classes/com/atlassian/confluence/core/ConfluenceActionSupport.properties
   - confluence/WEB-INF/classes/com/atlassian/confluence/languages/DefaultLocaleManager.class
   - confluence/WEB-INF/classes/com/atlassian/confluence/user/actions/EditMySettingsAction.class

XSRF Vulnerability

Severity
Atlassian rates the severity level of both this vulnerability as medium, according to the scale published in Severity Levels for Security Issues for Security Issues. The scale allows us to rank the severity as critical, high, medium or low. This vulnerability is not critical. This is an independent assessment and you should evaluate its applicability to your own IT environment.

Risk Assessment

We have identified and fixed a cross-site request forgery (XSRF) vulnerability that may affect Confluence instances, including publicly available instances (that is, Internet-facing servers). XSRF vulnerabilities allow an attacker to trick users into unintentionally adding bookmarks to Confluence spaces. You can read more about XSRF attacks at http://www.cgisecurity.com/csrf-faq.html and other places on the web.

Vulnerability

The table below describes the Confluence versions and the specific functionality affected by the XSRF vulnerability.

<table>
<thead>
<tr>
<th>Confluence Feature</th>
<th>Affected Confluence Version</th>
<th>Fixed Version</th>
<th>Issue Tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Bookmarking plugin</td>
<td>3.0 – 3.4.9</td>
<td>3.5</td>
<td>CONF-22565</td>
</tr>
</tbody>
</table>

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix these vulnerabilities.

Alternatively, if you are not in a position to upgrade immediately and you judge it necessary, you can disable public signup to your wiki until you have applied the necessary patch or upgrade. For even tighter control, you could restrict access to trusted groups.

We also recommend that you read our guidelines on best practices for configuring Confluence security for configuring Confluence security.

Fix

This vulnerability (CONF-22565) is fixed in Confluence 3.5, and later versions. For a full description of the latest version of Confluence, see the release notes. You can download the latest version of Confluence from the download centre.

If you cannot upgrade to the latest version of Confluence, you can temporarily patch your existing installation using the patch listed below. We strongly recommend upgrading and not patching.

Patches

If you are running Confluence 3.5, the CONF-22565 vulnerability is already fixed, but we highly recommend that you upgrade to the latest version of Confluence.

If you are running Confluence 3.4, you can apply the following patch to fix the CONF-22565 vulnerability.

For details on upgrading Confluence's plugins using the plugin manager, see:

- Upgrading your Existing Plugins

<table>
<thead>
<tr>
<th>Vulnerability</th>
<th>Patch</th>
<th>Patch File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Social Bookmarking plugin</td>
<td>Attached to issue CONF-22565</td>
<td>socialbookmarking-1.3.9.jar</td>
</tr>
</tbody>
</table>
**Patch Procedure: Install the Patch**

A patch is available for Confluence 3.4 – 3.4.9.  

The patch addresses the following issue:

- Security vulnerability in Confluence Settings Social Bookmarking plugin (CONF-22565).

**Applying the patch**

If you are using Confluence 3.4 – 3.4.9, use the plugin manager to upgrade the Social Bookmarking plugin to a version equal to or greater than that specified in the file name above.

For details on using the plugin manager, see **Upgrading your Existing Plugins**.

**Confluence Security Advisory 2012-05-17**

This advisory discloses a critical security vulnerability that exists in all versions of Confluence up to and including 4.1.9.

- **Customers who have downloaded and installed Confluence** should upgrade their existing Confluence installations to fix this vulnerability.

- **Enterprise Hosted customers** need to request an upgrade by raising a support request at http://support.atlassian.com in the “Enterprise Hosting Support” project.

- **JIRA Studio and Atlassian OnDemand customers** are not affected by any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at http://support.atlassian.com.

**In this advisory:**

- **Critical XML Parsing Vulnerability**
  - **Severity**
  - **Description**
  - **Risk Mitigation**
  - **Fix**

**Critical XML Parsing Vulnerability**

**Severity**

Atlassian rates the severity level of this vulnerability as critical, according to the scale published in **Severity Levels for Security Issues**. The scale allows us to rank the severity as critical, high, moderate or low.

This is an independent assessment and you should evaluate its applicability to your own IT environment.

**Description**

We have identified and fixed a vulnerability in Confluence that results from the way third-party XML parsers are used in Confluence. This vulnerability allows an attacker to:

- execute denial of service attacks against the Confluence server, or
- read all local files readable to the system user under which Confluence runs.

The attacker does not need to have an account with the affected Confluence instance.

All versions of Confluence **up to and including 4.1.9** are affected by this vulnerability. This issue can be tracked here: ![CONF-25077 - Authenticate](http://confluence.atlassian.com/pages/viewpage.action?pageId=25077) to see issue details.
The Gliffy for Confluence plugin is also vulnerable to this exploit. If you are using the Gliffy plugin for Confluence with any version of Confluence, you will need to upgrade it (see 'Fix' section below) or disable it.

Risk Mitigation

We recommend that you upgrade your Confluence installation to fix this vulnerability.

Alternatively, if you are not in a position to upgrade immediately, you should do all of the following until you can upgrade. Please note, these measures will only limit the impact of the vulnerability, they will not mitigate it completely.

- Disable access to the SOAP and XML-RPC APIs, if these remote APIs are not required. Note, remote API access is disabled by default. See enabling remote APIs for instructions.
  Disable the following plugins/plugin modules (see Disabling and Enabling Add-ons):
  - Office Connector plugin
  - JUnitReport macro module of the confluence-advanced-macros plugin (called "Advanced Macros" in the interface)
  - confluence-jira3-macros plugin (called "JIRA Macros" in the interface)
  - WebDAV
- Disable public access (such as anonymous access and public signup) to Confluence until you have upgraded.
- Ensure that your Confluence system user is restricted as described in best practices for configuring Confluence security.

Fix

Upgrade

1. Upgrade to Confluence 4.2 or later which fixes this vulnerability. For a full description of this release, see the Confluence 4.2 Release Notes. The following releases have also been made available to fix these issues in older Confluence versions. You can download these versions of Confluence from the download centre.

- Confluence 4.1.10 for Confluence 4.1
- Confluence 4.0.7 for Confluence 4.0
- Confluence 3.5.17 for Confluence 3.5

2. Upgrade the following Confluence third-party plugins, if you are using them. The table below describes which version of the plugin you should upgrade to, depending on your Confluence version. See Updating Add-ons for instructions on how to update a plugin.

<table>
<thead>
<tr>
<th>Plugin</th>
<th>Confluence 4.2</th>
<th>Confluence 4.1</th>
<th>Confluence 4.0</th>
<th>Confluence 3.5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gliffy plugin for Confluence</td>
<td>4.2</td>
<td>4.2</td>
<td>4.2</td>
<td>4.2</td>
</tr>
</tbody>
</table>

Patches

There are no patches available for this vulnerability. Due to the extent of the changes required to fix the vulnerability, it is not possible to provide patches that resolve the issue without compromising the reliability of Confluence. You must upgrade to fix this vulnerability.

Confluence Security Advisory 2012-09-04

This advisory can be found here: Confluence Security Advisory 2012-09-11.

Confluence Security Advisory 2012-09-11
This advisory discloses security vulnerability that we have found and fixed in a recent version of Confluence.

- **Customers who have downloaded and installed Confluence** should upgrade their existing Confluence installations to fix this vulnerability.
- **Enterprise Hosted customers** need to request an upgrade by raising a support request. See Enterprise Hosting Upgrade Time Windows for instructions.
- **Atlassian OnDemand and JIRA Studio customers** are not affected by any of the issues described in this advisory.

Atlassian is committed to improving product security. The vulnerability listed in this advisory has been discovered by Atlassian, unless noted otherwise. The reporter may also have requested that we do not credit them.

If you have questions or concerns regarding this advisory, please raise a support request at [http://support.atlassian.com/](http://support.atlassian.com/).

**In this advisory:**

- **XSS Vulnerability**

**XSS Vulnerability**

**Severity**

Atlassian rates the severity level of this vulnerability as **High**, according to the scale published in [Severity Levels for Security Issues](https://atlassianknowledge.atlassian.net/wiki/spaces/KN/pages/Security+Levels). The scale allows us to rank the severity as critical, high, medium or low. This is an independent assessment and you should evaluate its applicability to your own IT environment. This vulnerability is **not** of Critical severity.

**Description**

We have identified and fixed a reflected, or non-persistent, cross-site scripting (XSS) vulnerability that affects Confluence instances, including publicly available instances (that is, Internet-facing servers). XSS vulnerabilities allow an attacker to embed their own JavaScript into a Confluence page when it is viewed by the victim's browser. An attacker does not need an account on Confluence server. A successful attack does not necessarily modify any server content.

We recommend you to read about XSS attacks at [Wikipedia](https://en.wikipedia.org/wiki/Cross-site_scripting), [The Web Application Security Consortium](https://www.wASC.org) and other places on the web before considering specific mitigations for this vulnerability.

This vulnerability affects all versions of Confluence earlier than 4.1.8. It has been fixed in Confluence 4.1.9 and later. This issue can be tracked here: [CONF-26366 - Authenticate](https://confluence.atlassian.com/pages/viewpage.action?pageId=26366) to see issue details

**Risk Mitigation**

We strongly recommend upgrading your Confluence installation to fix this vulnerability. Please see the ‘Fix’ section below.

One possible workaround is to block requests to certain URLs before they reach Confluence. HTTP GET requests to any Confluence URLs where the file name is ".vm" should be blocked. For example, if you use Apache web server to front Confluence and your Confluence is under /wiki path, then you can set up the following rules to block XSS attempts:
We recommend that you read the links above about how XSS attacks work before applying any workarounds. This code is only an example.

**Fix**

**Upgrade**

The vulnerability and fix version are described in the 'Description' section above.

We recommend that you upgrade to Confluence 4.1.9 or later, if possible. For a full description of the latest version of Confluence, see the [release notes](#). You can download the latest version of Confluence from the [download centre](#).

**Update 13 Sep 2012:** Patch for Confluence 3.5.x is now available. See the issue [CONF-26366](#) - Authenticate to see issue details for patch files and instructions. Please note this patch goes beyond our current [Security Patch Policy](#) and you should not expect availability of similar patches in the future. Patching is a measure of last resort when you cannot upgrade.

Our thanks to **D. Niedermaier** of **Intrest SEC** who reported the XSS vulnerability described in this advisory. **We fully support the reporting of vulnerabilities** and we appreciate it when people work with us to identify and solve the problem.

**Confluence Cookies**

This page lists cookies stored in Confluence users' browsers which are generated by Confluence itself. This page does not list cookies that may originate from 3rd-party Confluence plugins.

**Authentication cookies**

Confluence uses [Seraph](#), an open source framework, for HTTP cookie authentication. Confluence uses two types of cookies for user authentication:

- The JSESSIONID cookie is created by the application server and used for session tracking purposes. This cookie contains a random string and the cookie expires at the end of every session or when the browser is closed.
- The 'remember me' cookie, seraph.confluence, is generated by Confluence when the user selects the [Remember me](#) check box on the login page.

You can read about cookies on the [Wikipedia page about HTTP cookies](#).
On this page:

- Authentication cookies
  - The 'remember me' cookie
- Other Confluence cookies
- Notes

The 'remember me' cookie

The 'remember me' cookie, `seraph.confluence`, is a long-lived HTTP cookie. This cookie can be used to authenticate an unauthenticated session. Confluence generates this cookie when the user selects the **Remember me** check box on the login page.

Cookie key and contents

By default, the cookie key is `seraph.confluence`, which is defined by the `login.cookie.key` parameter in the `CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml` file.

The cookie contains a unique identifier plus a securely-generated random string (i.e. token). This token is generated by Confluence and is also stored for the user in the Confluence database.

Use of cookie for authentication

When a user requests a web page, if the request is not already authenticated via session-based authentication or otherwise, Confluence will match the 'remember me' cookie (if present) against the token (also if present), which is stored for the user in the Confluence database.

If the token in the cookie matches the token stored in the database and the cookie has not expired, the user is authenticated.

Life of 'remember me' cookies

You can configure the maximum age of the cookie. To do that you will need to modify the `CONFLUENCE-INSTALLATION/confluence/WEB-INF/classes/seraph-config.xml` file and insert the following lines below...
Automatic cleanup of 'remember me' tokens

Every cookie issued by Confluence has a corresponding record in the database. A scheduled job runs on the 20th of every month to clean up expired tokens. The name of the trigger is `clearExpiredRememberMeToken sTrigger`.

Note: The only purpose of this job is to prevent the database table from growing too big. For authentication purposes, Confluence will ignore expired tokens even if they still exist in the database.

Is it possible to disable the 'remember me' feature?

Confluence does not offer an option for disabling the 'Remember Me' feature. See the workaround.

Other Confluence cookies

There are several cookies that Confluence uses to store basic 'product presentation' states. Confluence users' authentication details are not stored by these cookies.

<table>
<thead>
<tr>
<th>Cookie Key</th>
<th>Purpose</th>
<th>Cookie Contents</th>
<th>Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>doc-sidebar</td>
<td>Remembers the user's preference for the width of the navigation sidebar in the Confluence documentation theme.</td>
<td>The width of the sidebar in pixels. For example, 300px</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
<tr>
<td>confluence.list.pages.cookie</td>
<td>Remembers the user's last chosen tab in the &quot;list pages&quot; section.</td>
<td>The name of the last selected tab. For example, list-content-tree</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
<tr>
<td>confluence.browse.space.cookie</td>
<td>Remembers the user's last chosen tab in the &quot;browse space&quot; section</td>
<td>The name of the last selected tab. For example, space-pages</td>
<td>One year from the date it was set or was last updated.</td>
</tr>
<tr>
<td>confluence-language</td>
<td>Remembers the user's language chosen on the login page. This cookie relates to a feature that allows a user to change Confluence's language from (and including) the login page, when the language presented to the user prior to logging in is not appropriate.</td>
<td>A locale relating to the chosen language. For example, de_DE</td>
<td>360 days from the date it was set or was last updated.</td>
</tr>
</tbody>
</table>
### AJS.conglomerate.cookie

Tracks which general tabs were last used or expansion elements were last opened or closed.

One or more key-value strings which indicate the states of your last general tab views or expansion elements.

One year from the date it is set or was last updated.

### Notes

- The *autocomplete* feature in browser text fields (which are typically noticeable when a user logs in to Confluence) is a browser-specific feature, not a Confluence one. Confluence cannot enable or disable this autocompletion, which is typically set through a browser's settings.

### RELATED TOPICS

**Configuring Secure Administrator Sessions**

Confluence protects access to its administrative functions by requiring a secure administration session to use the *Confluence administration console* or *administer a space*. When a Confluence administrator (who is logged into Confluence) attempts to access an administration function, they are prompted to log in again. This logs the administrator into a temporary secure session that grants access to the Confluence/space administration console.

The temporary secure session has a rolling timeout (defaulted to 10 minutes). If there is no activity by the administrator in the Confluence/space administration console for a period of time that exceeds the timeout, then the administrator will be logged out of the secure administrator session (note, they will remain logged into Confluence). If the administrator does click an administration function, the timeout will reset.

> **The information on this page does not apply to Confluence OnDemand.**

**To configure secure administrator sessions:**

1. Choose the cog icon at top right of the screen, then choose **Confluence Admin**.
2. Choose **Security Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Configure the setting as follows:
   - To disable secure administrator sessions, uncheck the **Enable check box next to Secure administrator sessions**. When this setting is disabled, administrators will no longer be required to log into a secure session to access the administration console.
   - To change the timeout for secure administrator sessions, update the value next to **minutes before invalidation**. The default timeout for a secure administration session is 10 minutes.
5. Choose **Save**.

**Notes**

- **Disabling password confirmation.** Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the `password.confirmation.disabled` system property to disable the password confirmation functionality. See [Recognised System Properties.](#) See issue CONF-20 958 "Confluence features that require password confirmation (websudo, captcha) do not work with custom authentication".

- **WebSudo.** The feature that provides secure administrator sessions is also called 'WebSudo'.

- **Manually ending a secure session.** An administrator can choose to manually end their secure session by clicking the 'drop access' link in the banner displayed at the top of their screen. For example:
• **Note for developers.** Secure administrator sessions can cause exceptions when developing against Confluence or deploying a plugin. Please read this FAQ: [How do I develop against Confluence with Secure Administrator Sessions?](#) Note: The Confluence XML-RPC and REST APIs are not affected by secure administration sessions.

### Using Fail2Ban to limit login attempts

**What is Fail2Ban?**

We need a means of defending sites against brute-force login attempts. Fail2Ban is a Python application which trails logfiles, looks for regular expressions and works with Shorewall (or directly with iptables) to apply temporary blacklists against addresses that match a pattern too often. This can be used to limit the rate at which a given machine hits login URLs for Confluence.

*The information on this page does not apply to Confluence OnDemand.*

**Prerequisites**

- Requires Python 2.4 or higher to be installed
- Needs a specific file to follow, which means your Apache instance needs to log your Confluence access to a known logfile. You **should adjust the configuration below** appropriately.

**How to set it up**

*This list is a skeletal version of the instructions*

- There's an RPM available for RHEL on the [download page](#), but you can also download the source and set it up manually
- Its configuration files go into `/etc/fail2ban`
- The generic, default configuration goes into `.conf files` (`fail2ban.conf` and `jail.conf`). Don't change these, as it makes upgrading difficult.
- Overrides to the generic configuration go into `.local files` corresponding to the `.conf files`. These only need to contain the specific settings you want overridden, which helps maintainability.
- Filters go into `filter.d` — this is where you define regexps, each going into its own file
- Actions go into `action.d` — you probably won't need to add one, but it's handy to know what's available
- "jails" are a configuration unit that specify one regexp to check, and one or more actions to trigger when the threshold is reached, plus the threshold settings (e.g. more than 3 matches in 60 seconds causes that address to be blocked for 600 seconds)
- Jails are defined in `jail.conf` and `jail.local`. Don't forget the `enabled` setting for each one — it can be as bad to have the wrong ones enabled as to have the right ones disabled.

**Running Fail2Ban**

- Use `/etc/init.d/fail2ban {start|stop|status}` for the obvious operations
- Use `fail2ban-client -d` to get it to dump its current configuration to STDOUT. Very useful for troubleshooting.
- Mind the CPU usage; it can soak up resources pretty quickly on a busy site, even with simple regexp
- It can log either to syslog or a file, whichever suits your needs better

**Common Configuration**

`jail.local`
# The DEFAULT allows a global definition of the options. They can be override
# in each jail afterwards.

[DEFAULT]

# "ignoreip" can be an IP address, a CIDR mask or a DNS host. Fail2ban will not
# ban a host which matches an address in this list. Several addresses can be
# defined using space separator.
# ignoreip = <space-separated list of IPs>

# "bantime" is the number of seconds that a host is banned.
bantime  = 600

# A host is banned if it has generated "maxretry" during the last "findtime"
# seconds.
findtime  = 60

# "maxretry" is the number of failures before a host get banned.
maxretry = 3

[ssh-iptables]

enabled  = false

[apache-shorewall]

enabled  = true
filter   = cac-login
action   = shorewall
logpath = /var/log/httpd/confluence-access.log
bantime = 600
maxretry = 3
findtime = 60
backend = polling

Configuring for Confluence

⚠️ The following is an example only, and you should adjust it for your site.

filter.d/confluence-login.conf

[Definition]

failregex = <HOST>.*"GET /login.action

ignoreregex =
Securing Confluence with Apache

The following outlines some basic techniques to secure a Confluence instance using Apache. These instructions are basic to-do lists and should not be considered comprehensive. For more advanced security topics see the "Further Information" section below.

- Using Apache to limit access to the Confluence administration interface
- Using Fail2Ban to limit login attempts

Further Information

Running Confluence behind Apache

The information on this page does not apply to Confluence OnDemand.

Using Apache to limit access to the Confluence administration interface

Limiting administration to specific IP addresses

The Confluence administration interface is a critical part of the application; anyone with access to it can potentially compromise not only the Confluence instance but the entire machine. As well as limiting access to users who really need it, and using strong passwords, you should consider limiting access to it to certain machines on the network or internet. If you are using an Apache web server, this can be done with Apache's Location functionality as follows:

The information on this page does not apply to Confluence OnDemand.

1. Create a file that defines permission settings

This file can be in the Apache configuration directory or in a system-wide directory. For this example we'll call it "sysadmin_ips_only.conf". The file should contain the following:

```
Order Deny,Allow
Deny from All

# Mark the Sysadmin's workstation
Allow from 192.168.12.42
```

2. Add the file to your Virtual Host

In your Apache Virtual Host, add the following lines to restrict the administration actions to the Systems Administrator:

This configuration assumes you've installed Confluence under '/confluence'. If you have installed under '/' or elsewhere, adjust the paths accordingly.

```
<Location /confluence/admin>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/list>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/view-consumer-info>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/service-providers/list>
  Include sysadmin_ips_only.conf
</Location>
```
<Location /confluence/plugins/servlet/oauth/service-providers/add>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/add>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/consumers/add-manually>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/oauth/update-consumer-info>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/pages/templates/listpagetemplates.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/pages/templates/createpagetemplate.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/spacepermissions.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/pages/listpermissionpages.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/removespace.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/importmbox.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/viewmailaccounts.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/addmailaccount.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/importpages.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/flyingpdf/flyingpdf.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/exportspacehtml.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/spaces/exportspacexml.action>
  Include sysadmin_ips_only.conf
</Location>
<Location /confluence/plugins/servlet/embedded-crowd>
  Include sysadmin_ips_only.conf
</Location>
Managing External Referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

By default, external referrers for a page are listed under 'Hot Referrers' on the 'Info' screen of the page. Confluence shows a maximum of 10 referrers. If there are more than 10, Confluence shows the 10 with the highest number of hits.

Note that you do not need to enable trackback in order to have external referrers enabled.

Screenshot: hot referrers on the page information screen.

To manage your external referrers:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose 'Manage Referrers'.

The following actions will be available:

- **Record or ignore all external referrers**: By default, Confluence records the number of hits made to a page from the link on the external site. If you turn this option off, Confluence will not record the hits.
- **Show or hide all external referrers**: By default, Confluence lists the external referrers as 'Hot Referrers' on the 'Info' screen of a page, as shown below. If you turn this option off, external referrers will not be listed on the page.
- **Specify which external referrers to exclude**: You can decide which referrers you want to exclude from being displayed on your site.
An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral.

You can exclude external referrers to prevent them from being recorded or displayed anywhere on your site.
Once you have specified your list of blocked URLs, any incoming links from URLs that match the list will no longer be recorded. Referrer URLs are blocked if they start with any of the URLs in the exclusion list. So http://evilspamsite.blogspot.com will also match http://evilspamsite.blogspot.com/nastypage.html

There are two instances where you may want to do this:

1. If you are running a Confluence installation that is open to public:
   In a site that is open to public, one unfortunate problem is that malicious sites can spam the display of a page's incoming links statistics. This is usually done to get the site's URL to appear in the sidebar. By adding these sites to the 'excluded referrers' list, you can prevent them from being listed on your site.

2. If Confluence is installed on a server with multiple domain names or IP addresses:
   Confluence will consider any URL originating from the domain name where Confluence is installed as an internal link. However, if Confluence is installed on a server with multiple domain names or IP addresses, you will need to add the other domain name prefixes to this list to let Confluence know that any links from these domains should not be considered external links.

You need to be a Confluence administrator and to know the URL of the site to add it to the excluded referrers list.

**To add a URL to the excluded referrers list:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Manage Referrers
3. Enter the URL in the Referrer URL Prefix field (you must include http://)
4. Choose Add.

You can add multiple URLs to the list.

### Exclude External Referrers

<table>
<thead>
<tr>
<th>Referrer URL Prefix</th>
<th>Operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a URL Prefix that will no longer be recorded in the External Referrers. All URLs that start with this prefix will be excluded.</td>
<td>Add</td>
</tr>
<tr>
<td><a href="http://evilspamsite.blogspot.com">http://evilspamsite.blogspot.com</a></td>
<td>Purge All</td>
</tr>
<tr>
<td>Delete • Purge</td>
<td></td>
</tr>
</tbody>
</table>

**Related Topics**

- Running Confluence Over SSL or HTTPS
- Managing External Referrers
- Hiding external referrers
- Excluding external referrers
- Ignoring External Referrers
- Hiding External Links From Search Engines
- Anonymous Access to Remote API
- Configuring Captcha for Failed Logins
Hiding external referrers

By default, Confluence lists the external referrers as 'Hot Referrers' on the page information screen for a page. If you turn this option off, external referrers will not be listed on the page.

To hide external referrers:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose 'Manage Referrers'.
3. Deselect 'Show Referrers in Page Info'.

Screenshot: Managing external referrers

An external referrer is any site that links to your Confluence instance. Each time someone clicks on the external link, your Confluence site can record the click as a referral. By default, Confluence records the number of hits
made to a page from any link on an external site. If you turn this option off, Confluence will not record the hits.

To ignore external referrers:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘Manage Referrers’ in the left-hand panel.
3. Deselect ‘Record External Referrers’.

Screenshot: Managing external referrers

![External Referrer Settings](image)

Record External Referrers

Allow Confluence to record the external URLs that link to Confluence pages.

More about External Referrers

Show Referrers in Page Info

Show the top 10 external links pointing to that page on the ‘Info’ screen.

Submit Cancel

Related Topics

- Running Confluence Over SSL or HTTPS
- Managing External Referrers
- Hiding external referrers
- Excluding external referrers
- Ignoring External Referrers
- Hiding External Links From Search Engines
- Anonymous Access to Remote API
- Configuring Captcha for Failed Logins
- Hiding the People Directory
- Configuring Captcha for Spam Prevention
- User Email Visibility
- Configuring the Administrator Contact Page

Best Practices for Configuring Confluence Security

The best way to harden a system is to look at each of the involved systems individually. Contact your company’s security officer or department to find out what security policies you should be using. There are many things to consider, such as the configuration of your underlying operating systems, application servers, database servers, network, firewall, routers, etc. It would be impossible to outline all of them here.

This page contains guidelines on good security practices, to the best of our knowledge.

⚠️ The information on this page does not apply to Confluence OnDemand.

Configuring the Web Server

Please refer to the following guides for system administrators:
Confluence 5.0 Documentation

- How to configure Apache to lock down the administration interface to those people who really need it: Using Apache to limit access to the Confluence administration interface.
- How to reduce the risk of brute force attacks: Using Fail2Ban to limit login attempts.

Configuring the Application Server

See the following system administrator guide for general hints on the application server level:

- Tomcat security best practices

Configuring the Application

The way you set up Confluence roles, permissions and processes makes a big difference in the security of your Confluence site.

Below are some more Confluence-specific items to consider. None of these provides 100% security. They are measures to reduce impact and to slow down an intruder in case your system does become compromised.

- Keep the number of Confluence administrators extremely low. For example, 3 system administrator accounts should be the maximum.
- Similarly, restrict the number of users with powerful roles or group memberships. If only one department should have access to particularly sensitive data, then do restrict access to the data to those users. Do not let convenience over-rule security. Do not give all staff access to sensitive data when there is no need.
- The administrators should have separate Confluence accounts for their administrative roles and for their day to day roles. If John Doe is an administrator, he should have a regular user account without administrator access to do his day to day work (such as writing pages in the wiki). This could be a 'john.doe' account. In addition, he should have an entirely separate account (that cannot be guessed by an outsider and that does not even use his proper name) for administrative work. This account could be 'jane smith' – using a username that is so obscure or fake that no outsider could guess it. This way, even if an attacker singles out the actual person John Doe and gets hold of his password, the stolen account would most likely be John's regular user account, and the attacker cannot perform administrative actions with that account.
- Lock down administrative actions as much as you can. If there is no need for your administrators to perform administrative actions from outside the office, then lock down access to those actions to known IP adresses, for example. See Using Apache to limit access to the Confluence administration interface.
- Put documented procedures in place for the case of employees leaving the company.
- Perform security audits regularly. Know who can help in case a security breach occurs. Perform 'what if' planning exercises. (‘What is the worst thing that could happen if a privileged user's password were stolen while he's on vacation? What can we do to minimise damage?’).
- Make sure the Confluence database user (and all datasource database users) only has the amount of database privileges it really needs.
- Monitor your binaries. If an attacker compromises an account on your system, he will usually try to gain access to more accounts. This is sometimes done by adding malicious code, such as by modifying files on the system. Run routine scripts that regularly verify that no malicious change has been made.

As another precaution:

- Regularly monitor the above requirements. There are many things that could start out well, but deteriorate over time:
  - A system may start out with just 3 administrators, but over the course of a year this could grow to 30 administrators if no one prevents expansion.
  - Apache administration restrictions may be in place at the start of the year, but when the application server is migrated after a few months, people may forget to apply the rules to the new system.

Again, keep in mind that the above steps may only be a fraction of what could apply to you, depending on your
security requirements. Also, keep in mind that none of the above rules can guarantee anything. They just make it harder for an intruder to move quickly.

Hiding the People Directory

The **People Directory** provides a list of all users in your Confluence system.

If you need to disable the People Directory **set the following system properties** on your application server command line:

- **To disable the People Directory for anonymous users:**
  
  ```
  -Dconfluence.disable.peopledirectory.anonymous=true
  ```

- **To disable the People Directory entirely:**
  
  ```
  -Dconfluence.disable.peopledirectory.all=true
  ```

⚠️ The information on this page does not apply to Confluence OnDemand.

This workaround will prevent the People directory from appearing on the dashboard, but if you navigate to the profile of a user, and then click on the "People" in the breadcrumb link (Dashboard >> **People** >> **FullName** >> **Profile**) or you go to the URL directly `<CONFLUENCE_INSTALL>/browsepeople.action`, you will be able to access the people directory.

To workaround this, set up your Apache webserver in front of Confluence and redirect requests to this URL.

**Related Topics**

- Running Confluence Over SSL or HTTPS
- Managing External Referrers
- Hiding external referrers
- Excluding external referrers
- Ignoring External Referrers
- Hiding External Links From Search Engines
- Anonymous Access to Remote API
- Configuring Captcha for Failed Logins
- Hiding the People Directory
- Configuring Captcha for Spam Prevention
- User Email Visibility
- Configuring the Administrator Contact Page

Configuring Captcha for Spam Prevention

You need to be a Confluence administrator to configure Captcha for spam prevention in Confluence.

If your Confluence site is open to the public you may find that automated spam is being added, in the form of comments or new pages.

You can configure Confluence to deter automated spam by asking users to prove that they are human before...
they are allowed to:

- Sign up for an account.
- Add a comment.
- Create a page.
- Edit a page.
- Send a request to the Confluence administrators.

Captcha is the technical term for a test that can distinguish a human being from an automated agent such as a web spider or robot. You can read more about Captcha on Wikipedia.

When Captcha is switched on, users will need to recognise a distorted picture of a word, and must type the word into a text field. This is easy for humans to do, but very difficult for computers.

**Screenshot: Example of a Captcha test**

You can configure Confluence to enforce Captcha for certain types of users. You can exempt logged-in users (they will have completed a Captcha when they signed up) or members of particular groups.

By default, Captcha for spam prevention is disabled. If you enable it, the default is that Captcha for spam prevention will apply to anonymous users only. Only anonymous users will have to perform the Captcha test when creating comments or editing pages. Captcha images will not be shown to logged-in users.

**Related pages:**
- Configuring Confluence Security
- Confluence Administrator’s Guide

**To enable Captcha for spam prevention in Confluence:**

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Spam Prevention in the left-hand panel.
3. Choose ON to turn on Captcha.
4. If you want to disable Captcha for certain groups:
   - Select No one if you want everyone to see Captchas.
   - Select Signed in users if you want only anonymous users to see Captchas.
   - If you want everyone to see Captchas except members of specific groups, select Members of the following groups and enter the group names in the text box.
     - You can click the magnifying-glass icon to search for groups. Search for all or part of a group name and click the Select Groups button to add one or more groups to the list.
     - To remove a group from the list, delete the group name.
5. Choose Save.

**Hiding External Links From Search Engines**

Hiding external links from search engines helps to discourage spammers from posting links on your site. If you turn this option on, any URLs inserted in pages and comments will be given the ‘nofollow’ attribute, which prevents search engines from following them.

- Shortcut links (e.g. CONF-2622@JIRA) and internal links to other pages within Confluence are not tagged.
The information on this page does not apply to Atlassian OnDemand sites with multiple apps. If you are using Confluence-only OnDemand, the information does apply.

To hide external links from search engines:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click ‘Security Configuration’ in the left panel.
3. This will display the ‘Security Configuration’ screen. Click ‘Edit’.
4. Check the ‘Hide External Links From Search Engines’ checkbox.
5. Click the ‘Save’ button.

Background to the nofollow attribute
As part of the effort to combat the spamming of wikis and blogs (Confluence being both), Google came up with some markup which instructs search engines not to follow links. By removing the main benefit of wiki-spamming it’s hoped that the practice will stop being cost-effective and eventually die out.

Related Topics

- Running Confluence Over SSL or HTTPS
- Managing External Referrers
- Hiding external referrers
- Excluding external referrers
- Ignoring External Referrers
- Hiding External Links From Search Engines
- Anonymous Access to Remote API
- Configuring Captcha for Failed Logins
- Hiding the People Directory
- Configuring Captcha for Spam Prevention
- User Email Visibility
- Configuring the Administrator Contact Page

Converting Captcha for Failed Logins

If you have confluence administrator permissions, you can configure Confluence to impose a maximum number of repeated login attempts. After a given number of failed login attempts (the default is three) Confluence will display a Captcha form asking the user to enter a given word when attempting to log in again. This will prevent brute force attacks on the Confluence login screen.

Similarly, after three failed login attempts via the XML-RPC or SOAP API, an error message will be returned instructing the user to log in via the web interface. Captcha will automatically be activated when they attempt this login.

‘Captcha’ is the technical term for a test that can distinguish a human being from an automated agent such as a web spider or robot. You can read more about Captcha on Wikipedia.

When Captcha is activated, users will need to recognise a distorted picture of a word, and must type the word into a text field. This is easy for humans to do, but very difficult for computers.

Screenshot: example of a Captcha test
Enabling, Disabling and Configuring Captcha for Failed Logins

By default, Captcha for failed logins is enabled and the number of failed login attempts is set to three.

To enable, disable and configure Captcha for failed logins:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose 'Security Configuration' from the left menu.
3. Choose 'Edit'.
4. To enable Captcha:
   • Select the 'Enable' checkbox next to 'CAPTCHA on login'.
   • Set the maximum number of failed logins next to 'Maximum Authentication Attempts Allowed'.
     You must enter a number greater than zero.
5. To disable Captcha, deselect the 'Enable' checkbox.
6. Choose 'Save'.

Screenshot: Configuring Captcha for failed logins
Notes

- Disabling all password confirmation requests, including Captcha on login. Confluence installations that use a custom authentication mechanism may run into problems with the Confluence security measure that requires password confirmation. If necessary, you can set the `password.confirmation` system property to disable the password confirmation functionality on administrative actions, change of email address and Captcha for failed logins. See Recognised System Properties.

Configuring XSRF Protection

Confluence requires an XSRF token to be present on comment creation, to prevent users being tricked into unintentionally submitting malicious data. All the themes bundled with Confluence have been designed to use this feature. However, if you are using a custom theme that does not support this security feature, you can disable it.

⚠ Please carefully consider the security risks before you disable XSRF protection in your Confluence installation.

Read more about XSRF (Cross Site Request Forgery) at cgisecurity.com.

To configure XSRF protection:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose **Security Configuration** in the left-hand panel.
3. Choose **Edit**.
4. Uncheck the **Adding Comments** checkbox in the **XSRF Protection** section, to disable XSRF protection.
5. Choose **Save**.

### User Email Visibility

Confluence provides three options for email address privacy which can be configured by a Confluence administrator from the **Administration Console**:

- **Public**: email addresses are displayed publicly.
- **Masked**: email addresses are still displayed publicly, but masked in such a way to make it harder for spam-bots to harvest them.
- **Only visible to site administrators**: only Confluence administrators can see the email addresses. Note that, if you select this option, email addresses will not be available in the ‘User Search’ popup (e.g. when setting Page Restrictions).

### To configure user email visibility:

1. Choose the **cog icon** at top right of the screen, then choose **Confluence Admin**.
2. Choose ‘**Security Configuration**’.
3. Choose ‘**Edit**’. The fields on the ‘**Security Configuration**’ screen will be editable.
4. Select one of the options from the ‘**User email visibility**’ dropdown: ‘public’, ‘masked’, or ‘only visible to site administrators’.
5. Choose ‘**Save**’.

**Screenshot: Email Visibility**

![User Email Visibility](image)

**Related Topics**

- [Hiding the People Directory](#)
- [Configuring Captcha for Spam Prevention](#)
- [Anonymous Access to Remote API](#)
- [Hiding External Links From Search Engines](#)
- [Excluding external referrers](#)
- [Ignoring External Referrers](#)
- [User Email Visibility](#)
Anonymous Access to Remote API

Administrators may wish to disable anonymous access to the Confluence remote API. to make it harder for malicious users to write 'bots' that perform bulk changes to the site.

To disable anonymous access to the remote API:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose Edit.
4. Uncheck the Anonymous Access to API check box.
5. Choose Save.

Notes

This page is about access to the remote API. If you are looking for information about preventing anonymous users from accessing Confluence, see Global Permissions Overview.

Running Confluence Over SSL or HTTPS

This document tells you how to configure Confluence to enable access via HTTPS (HTTP over SSL), so that your Confluence logins and data are encrypted during transport to and from Confluence. SSL encryption is a good way to safeguard your Confluence data and user logins from being intercepted and read by outsiders.

These instructions apply to the following platforms:

- **Confluence or Confluence WAR distribution using Tomcat.** Apache Tomcat is the application server shipped with Confluence, and is the only supported application server. If you are using a different application server or Apache HTTP Server ("httpd"), see the page on Apache with mod_proxy for instructions on how to terminate an SSL connection at the Apache web server.

- **Java 6.** JDK 1.6 is the supported Java version for Confluence. Note that you need the JDK, since it includes the keytool utility used in the instructions below. The JRE is not enough. If you are using JDK 1.5, please refer to the Java SE documentation to see the differences in the keytool utility from JDK 1.5 to JDK 1.6.

The default connector port for Confluence is 8090, while a plain Tomcat installation (used for EAR / WAR distribution) will default to 8080.
Step 1. Create or Request a New SSL Certificate

You will need a valid SSL certificate before you can enable HTTPS. If you already have a certificate prepared, skip to step 2 below.

You can choose to create a self-signed certificate or to use a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority'). We described both options below.

Certificate Option 1 – Create a Self-Signed Certificate

Self-signed certificates are useful if you require encryption but do not need to verify the identity of the requesting website. In general, you might use a self-signed certificate on a test environment and on internal corporate networks (intranets).

Because the certificate is not signed by a certificate authority (CA), users may receive a message that the site is not trusted and may have to perform several steps to accept the certificate before they can access the site. This usually will only occur the first time they access the site.

Follow the steps below to generate a certificate using Java's `keytool` utility. This tool is included in the JDK.

1. Use Java's `keytool` utility to generate the certificate:
   - On Windows, run the following command at the command prompt:
     ```
     "%JAVA_HOME%\bin\keytool" -genkeypair -alias tomcat -keyalg RSA
     ```
   - On OS X or UNIX-based systems, run the following command at the command prompt:
     ```
     $JAVA_HOME/bin/keytool -genkeypair -alias tomcat -keyalg RSA
     ```

2. When asked for a password:
   - Specify the password you want to use for the certificate (private key). Note that the password text will not appear as you type it.
   - Make a note of the password you choose, because you will need it in the next step when editing the configuration file.
   - The default password is 'changeit'.

3. Follow the prompts to specify your name, organisation and location. This information is used to construct the X.500 Distinguished Name (DN) of the entity. The CN ("What is your first and last name?") must match the fully-qualified hostname of the server running Confluence, otherwise Tomcat will not be able to use the certificate for SSL. For example for a Confluence running on a server named "confluence.example.com":

   "commonName=confluence.example.com"
4. Enter 'y' to confirm the details.
5. When asked for the password for 'tomcat' (the alias you entered in the keytool command above), press the 'Enter' key. This specifies that your keystore entry will have the same password as your private key. You MUST use the same password here as was used for the keystore password itself. This is a restriction of the Tomcat implementation.
6. Your certificate is now ready. Go to step 2 below.

Certificate Option 2 – Use a Certificate Issued by a Certificate Authority

When running Confluence in a production environment, you will need a certificate issued by a certificate authority (CA, sometimes also called a 'certification authority') such as VeriSign, Thawte or TrustCenter. The instructions below are adapted from the Tomcat documentation.

First you will generate a local certificate and create a 'certificate signing request' (CSR) based on that certificate. You will submit the CSR to your chosen certificate authority. The CA will use that CSR to generate a certificate for you.

1. Use Java's keytool utility to generate a local certificate, as described in the previous section.
2. Use the keytool utility to generate a CSR, replacing the text <MY_KEYSTORE_FILENAME> with the path to and file name of the .keystore file generated for your local certificate:

   ```
   keytool -certreq -keyalg RSA -alias tomcat -file certreq.csr -keystore <MY_KEYSTORE_FILENAME>
   ```

3. Submit the generated file called certreq.csr to your chosen certificate authority. Refer to the documentation on the CA's website to find out how to do this.
4. The CA will send you a certificate.
5. Import the new certificate into your local keystore:

   ```
   keytool -importcert -alias tomcat -keystore <MY_KEYSTORE_FILENAME> -file <MY_CERTIFICATE_FILENAME>
   ```

   If you receive an error, and you use Verisign or GoDaddy, you may need to export the certificate to PKCS12 format along with the private key.

   1. First, remove the certificate added above from the keystore:

      ```
      keytool -delete -alias tomcat -keystore <MY_KEYSTORE_FILENAME>
      ```

   2. Then export to PKCS12 format:

      ```
      openssl pkcs12 -export -in <MY_CERTIFICATE_NAME> -inkey <MY_PRIVATEKEY_NAME> -out <MY_PKCS12_KEYSTORE_NAME> -name tomcat -CAfile <MY_ROOTCERTIFICATE_NAME>-alsoCalledBundleCertificateInGoDaddy -caname root
      ```

   3. Then import from PKCS12 to jks:
Step 2. Modify the Server Configuration File in your Confluence Installation

1. Edit the server configuration file at this location: \{CONFLUENCE-INSTALLATION\}>/conf/server.xml.
2. Uncomment the following lines:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    URIEncoding="UTF-8"
    keystorePass="<MY_CERTIFICATE_PASSWORD>"/
```

3. Replace the text `<MY_CERTIFICATE_PASSWORD>` with the password you specified for your certificate.
4. Make sure that the attribute-value pair `SSLEnabled="true"` is part of the Connector element, as shown above. If this attribute is not present, attempts to access Confluence will time out.
5. Save the server configuration file.

Step 3. Specify the Location of your Certificate

By default, Tomcat expects the keystore file to be named `.keystore` and to be located in the user home directory under which Tomcat is running (which may or may not be the same as your own home directory). This means that, by default, Tomcat will look for your SSL certificates in the following location:

- On Windows: `C:\Documents and Settings\#CURRENT_USER#\.keystore`
- On OS X and UNIX-based systems: `~/.keystore`

You may decide to move the certificate to a custom location. If your certificate is not in the default location, you will need to update your server configuration file as outlined below, so that Tomcat can find the certificate.

1. Edit the server configuration file at this location: \{CONFLUENCE-INSTALLATION\}>/conf/server.xml
2. Add the attribute `keystoreFile="<MY_CERTIFICATE_LOCATION>"` to the Connector element, so that the element looks like this:

```xml
<Connector port="8443" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    URIEncoding="UTF-8"
    keystorePass="<MY_CERTIFICATE_PASSWORD>"
    keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
```
3. Replace the text `<MY_CERTIFICATE_LOCATION>` with the path to your certificate, including the path and the name of the `.keystore` file.
4. Save the server configuration file.

**Step 4. Change your Confluence Base URL to HTTPS**

1. In your browser, go to the Confluence Administration Console.
2. Change the Server Base URL to HTTPS. See the documentation on configuring the server base URL.

**Step 5. Add a Security Constraint to Cause Redirect of All URLs to HTTPS**

Although HTTPS is now activated and available, the old HTTP URLs (`http://localhost:8090`) are still available. Now you need to redirect the URLs to their HTTPS equivalent. You will do this by adding a security constraint in `web.xml`. This will cause Tomcat to redirect requests that come in on a non-SSL port.

1. Check whether your Confluence site uses the RSS macro. If your site has the RSS macro enabled, you may need to configure the URL redirection with a firewall rule, rather than by editing the `web.xml` file. Skip the steps below and follow the steps on the RSS Feed Macro page instead.
2. Otherwise, Edit the file at `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml`.
3. Add the following declaration to the end of the file, before the `</web-app>` tag:

   ```xml
   <security-constraint>
   <web-resource-collection>
   <web-resource-name>Restricted URLs</web-resource-name>
   <url-pattern>/</url-pattern>
   </web-resource-collection>
   <user-data-constraint>
   <transport-guarantee>CONFIDENTIAL</transport-guarantee>
   </user-data-constraint>
   </security-constraint>
   ```


   **i** Confluence has two `web.xml` files. The other one is at `<CONFLUENCE_INSTALLATION>/conf/web.xml`. Please only add the security constraints to `<CONFLUENCE_INSTALLATION>/confluence/WEB-INF/web.xml`, as described above.

**Notes**

- **Background information on generating a certificate**: The `keytool -genkeypair` command generates a key pair consisting of a public key and the associated private key, and stores them in a keystore. The command packages the public key into an X.509 v3 self-signed certificate, which is stored as a single-element certificate chain. This certificate chain and the private key are stored in a new keystore entry, identified by the alias that you specify in the command. The Java SE documentation has a good overview of the utility.

- **Custom SSL port**: If you have changed the port that the SSL connector is running on from the default value of 8443, you must update the `redirectPort` attribute of the standard HTTP connector to reflect the new SSL port. Tomcat needs this information to know which port to redirect to when an incoming request needs to be secure.

- **Multiple instances on the same host**: When running more than one instance on the same host, it is important to specify the `address` attribute in the `<CONFLUENCE_INSTALLATION>/conf/server.xml` file.
e because by default the connector will listen on all available network interfaces, so specifying the address will prevent conflicts with connectors running on the same default port. See the Tomcat Connector documentation for more about setting the address attribute: http://tomcat.apache.org/tomcat-5.5-doc/config/http.html

```
<Connector port="8443" address="your.confluence.url.com" maxHttpHeaderSize="8192"
    maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
    enableLookups="false" disableUploadTimeout="true"
    acceptCount="100" scheme="https" secure="true"
    clientAuth="false" sslProtocol="TLS" SSLEnabled="true"
    URIEncoding="UTF-8"
    keystorePass="<MY_CERTIFICATE_PASSWORD>"
    keystoreFile="<MY_CERTIFICATE_LOCATION>"/>
```

- **Protection for logins only or for individual spaces:** As of Confluence 3.0, Atlassian does not support HTTPS for logins only or for specific pages. We support only site-wide HTTPS. To see the reasoning behind this decision, please see CONF-18120 and CONF-4116.

**Troubleshooting**

- Check the Confluence knowledge base articles on troubleshooting SSL.
- If any of your users will access Confluence from Internet Explorer 7 on Vista, please note the following additional points when using Java's keytool utility:
  - Make sure that you specify the `-keyalg RSA` option, as shown in the example of the keytool command above. The default is the SHA1 algorithm, which results in an error 'Internet Explorer cannot display the webpage' on IE7 on Vista.
  - You may also need to specify the `-sigalg MD5withRSA` option. Otherwise, SHA1 will be used even if you specify the `-keyalg RSA` option. See this Atlassian blogpost for more information.
- Problems with Internet Explorer being unable to download attachments: Applying SSL site wide can prevent IE from downloading attachments correctly. To fix this problem, edit `<CONFLUENCE_INSTALLATION>/conf/server.xml` and add the following line within the `<Context ... />`element:

```
<Vave className="org.apache.catalina.authenticator.NonLoginAuthenticator"
    disableProxyCaching="true" securePagesWithPragma="false" />
```

Related Topics

- SSL Configuration HOW-TO in the Apache Tomcat 6.0 documentation
- SSL Configuration HOW-TO in the Apache Tomcat 5.5 documentation
- keytool - Key and Certificate Management Tool in the Java SE documentation
- Connecting to LDAP or JIRA or Other Services via SSL
- Supported Platforms

**Connecting to LDAP or JIRA or Other Services via SSL**

This page describes how to get Confluence connecting to external servers over SSL, via the various SSL-wrapped protocols.

Here are some examples of when you may need to connect to an external server over SSL/HTTPS:

- You need to connect to an LDAP server, such as Active Directory, if the LDAP server is running over SSL.

  For specific instructions for Active Directory, see Configuring an SSL Connection to Active
Directory.
- You want to set up JIRA as a trusted application in Confluence, when JIRA is running over SSL.
- You want to refer to an https://... URL in a Confluence macro.

If you want to run Confluence itself over SSL, see Running Confluence Over SSL or HTTPS.

The information on this page does not apply to Confluence OnDemand.

There's a Beta version of a Confluence SSL plugin that facilitates this process.

Importing SSL Certificates

The following commands apply to JDK 1.5. For commands/syntax relevant to JDK 1.6, please refer to this document from Oracle.

1. Add the root certificate to your default Java keystore with the following command. This is the certificate that was used to authorise the LDAP server's certificate. It will be either the one that was used for signing it, or will come from further up in the trust chain, possibly the root certificate. This is often a self-signed certificate, when both ends of the SSL connection are within the same network. Again, the exact alias is not important.

```
keytool -import -alias serverCert -file RootCert.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -import -alias serverCert -file RootCert.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
```

2. Import your LDAP or JIRA server's public certificate into the JVM Keystore. This is the certificate that the LDAP server will use to set up the SSL encryption. You can use any alias of your choosing in place of "JIRAorLDAPServer.crt".

```
keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -import -alias ldapCert -file JIRAorLDAPServer.crt -keystore $JAVA_HOME/jre/lib/security/cacerts (Linux/Unix/Mac)
```

3. Verify that the certificate has been added successfully by entering the following command:

```
keytool -list -keystore %JAVA_HOME%/jre/lib/security/cacerts (Windows)
keytool -list -keystore $JAVA_HOME/jre/lib/security/cacerts (Unix/Linux)
keytool -list -keystore /Library/Java/Home/lib/security/cacerts (Mac)
```

4. Ensure that you have updated JAVA_OPTS to specify the path to the keystore, as specified in Connecting to SSL services, before restarting Tomcat/Confluence. There is no need to specify an alias for Confluence to use. On connecting to the LDAP server, it will search through the keystore to find a certificate to match the key being presented by the server.
Troubleshooting

Check the following knowledge base articles:

- Unable to Connect to SSL Services due to PKIX Path Building Failed
  sun.security.provider.certpath.SunCertPathBuilderException
- SSL troubleshooting articles

Related Topics

Configuring an SSL Connection to Active Directory
Configuring Web Proxy Support for Confluence
Running Confluence Over SSL or HTTPS
Configuring RSS Feeds

A Confluence System Administrator can configure the following aspects of RSS feeds:

- The maximum number of items that Confluence returns to an RSS feed request.
- The maximum time period that Confluence allows to respond to an RSS feed request.

Both of these are set in the 'Edit Security Configuration' screen.

To configure RSS feeds:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose Security Configuration.
3. Choose Edit.
4. Enter a value for Maximum RSS Items. The default value is 200.
5. Enter a value for RSS timeout.
6. Choose Save.

On this page:

- Notes

Related pages:

- Using the RSS Feed Builder

⚠️ The information on this page does not apply to Confluence OnDemand.

Screenshot: Configuring RSS feeds

<table>
<thead>
<tr>
<th>Maximum RSS Items</th>
<th>200</th>
</tr>
</thead>
<tbody>
<tr>
<td>Limit the maximum number of items an RSS Feed can request.</td>
<td></td>
</tr>
<tr>
<td>RSS timeout</td>
<td>60 seconds</td>
</tr>
<tr>
<td>The time in seconds allowed to create each RSS Feed. Any items rendered within the timeout will still be returned.</td>
<td></td>
</tr>
</tbody>
</table>

Notes

- When using the RSS Feed Builder, a user could potentially enter such a large value for the number of feed items returned that Confluence would eventually run out of memory.
- When using the Feed Builder, if a users a value greater than this setting (or less than 0) they will get a validation error.
- If any pre-existing feeds are set to request more than the configured maximum, they will be supplied with only the configured maximum number of items. This is done silently - there is no logging and no message is returned to the RSS reader.
- If Confluence times out when responding to an RSS feed request, any items already rendered are...
Preventing and Cleaning Up Spam

If you have a public-facing Confluence site, your site may be affected by spammers.

Stopping Spammers

To prevent spammers:

2. Run Confluence behind an Apache webserver and create rules to block the spammer's IP address.

Blocking Spam at Apache or System Level

If a spam bot is attacking your Confluence site, they are probably coming from one IP address or a small range of IP addresses. To find the attacker's IP address, follow the Apache access logs in real time and filter for a page that they are attacking.

For example, if the spammers are creating users, you can look for `signup.action`:

```
$ tail -f confluence.atlassian.com.log | grep signup.action
1.2.3.4 -- [13/Jan/2010:00:14:51 -0600] "GET /signup.action HTTP/1.1"
200 9956 "-" "Mozilla/4.0 (compatible; MSIE 6.0; Windows NT 5.1; SV1)"
37750
```

Compare the actual spam users being created with the log entries to make sure you do not block legitimate users. By default, Apache logs the client's IP address in the first field of the log line.

Once you have the offender's IP address or IP range, you can add it to your firewall's blacklist. For example, using the popular Shorewall firewall for Linux you can simply do this:

```
# echo "1.2.3.4" >> /etc/shorewall/blacklist
#/etc/init.d/shorewall reload
```

To block an IP address at the Apache level, add this line to your Apache vhost config:

```
Deny from 1.2.3.4
```

You can restart Apache with a "graceful" command which will apply the changes without dropping any current sessions.

If this still does not stop the spam, then consider turning off public signup.

Deleting Spam

Profile Spam

By 'profile spam', we mean spammers who create accounts on Confluence and post links to their profile page.

If you have had many such spam profiles created, it is easier to delete them via SQL, as described below.

To delete a spam profile:

1. Shut down Confluence and back up your database. **Note:** This step is essential before you run any SQL commands on your Confluence database.
2. Find the last real profile:
3. Look through the bodies of the profile pages until you find where the spammer starts. You may have to identify an number of ranges.

4. Find the killset:

```
CREATE TEMP TABLE killset AS SELECT
    bc.bodycontentid, c.contentid, c.username FROM
    bodycontent bc JOIN content c ON bc.contentid = c.contentid
    WHERE
    bodycontentid >= BOTTOM_OF_SPAM_RANGE AND bodycontentID <=
    TOP_OF_SPAM_RANGE
    AND c.contenttype='USERINFO';

DELETE FROM bodycontent WHERE bodycontentid IN (SELECT
    bodycontentid FROM killset);

DELETE FROM links WHERE contentid IN (SELECT contentid FROM
    killset);

DELETE FROM content WHERE prevver IN (SELECT contentid FROM
    killset);

DELETE FROM attachments WHERE pageid IN (SELECT contentid FROM
    killset);

DELETE FROM content WHERE contentid IN (SELECT contentid FROM
    killset);

DELETE FROM os_user_group WHERE user_id IN (SELECT id FROM killset
    k JOIN os_user o ON o.username=k.username);

DELETE FROM os_user WHERE username IN (SELECT username FROM
    killset);
```

5. Once the spam has been deleted, restart Confluence and rebuild the index. This will remove any references to the spam from the search index.

Notes

- See CONF-1469. Your comments that issue are very much appreciated.

Scheduled Jobs

The administration console allows you to schedule various administrative jobs in Confluence, so that they are executed at regular time intervals. The types of jobs which can be scheduled cover:

- Confluence site backups
- Storage optimisation jobs to clear Confluence's temporary files and caches
- Index optimisation jobs to ensure Confluence's search indexes are up to date
- Mail queue optimisation jobs to ensure Confluence's mail queue is maintained and notifications have been sent.
You need to have System Administrator permissions in order to configure and execute jobs.

Accessing Confluence’s Scheduled Jobs Configuration

To access Confluence’s Scheduled Jobs configuration page:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘Scheduled Jobs’ to open the ‘Scheduled Jobs’ page. For each job listed down this page, the following information is shown:
   - **Job** — the name of a job.
   - **Status** — the job’s status, which is either ‘Scheduled’ (it is currently enabled) or ‘Disabled’. See below for details on disabling or re-enabling a job.
   - **Last Execution** — the date and time when the job was last executed. This field will be empty if the job was never executed.
   - **Next Execution** — the date and time when the job is next scheduled to be executed. This field will contain dash symbol (‘-’) if the job is disabled.
   - **Avg. Duration** — the length of time (in milliseconds) that it took to complete the job’s last execution.
   - **Actions** — allows you to configure the job, execute it manually, view a history of previous executions or disable the job.

On this page:

- Accessing Confluence’s Scheduled Jobs Configuration
- Executing a Job Manually
- Configuring a Job’s Schedule
- Disabling/Re-enabling a Job
- Viewing a Job’s Execution History
- Types of Jobs
- Cron Expressions

Related pages:

- Trigger Module
- Configuring Backups

⚠️ The information on this page does not apply to Confluence OnDemand.

**Screenshot: Scheduled Jobs**

<table>
<thead>
<tr>
<th>Job</th>
<th>Status</th>
<th>Last Execution</th>
<th>Next Execution</th>
<th>Avg. Duration</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Confluence</td>
<td>Scheduled</td>
<td>14-Feb-2013 08:07:55</td>
<td>20-Feb-2013 02:00:00</td>
<td>9079</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>Check Update Safety</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:00</td>
<td>19-Feb-2013 15:01:30</td>
<td>3</td>
<td>History · Run</td>
</tr>
<tr>
<td>Clean Index Queue</td>
<td>Scheduled</td>
<td>06-Feb-2013 08:07:55</td>
<td>20-Feb-2013 02:00:00</td>
<td>3869</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>Clean Temporary Directory</td>
<td>Scheduled</td>
<td>14-Feb-2013 08:07:55</td>
<td>20-Feb-2013 04:00:00</td>
<td>3759</td>
<td>History · Run · Edit</td>
</tr>
<tr>
<td>Clear Expired Mail Errors</td>
<td>Scheduled</td>
<td>14-Feb-2013 08:07:59</td>
<td>20-Feb-2013 03:00:00</td>
<td>0</td>
<td>History · Run · Edit</td>
</tr>
<tr>
<td>Clear Expired Remember Me Tokens</td>
<td>Scheduled</td>
<td>06-Feb-2013 08:07:55</td>
<td>20-Feb-2013 00:00:00</td>
<td>0</td>
<td>Run · Edit</td>
</tr>
<tr>
<td>Email Daily Reports</td>
<td>Scheduled</td>
<td>14-Feb-2013 08:07:55</td>
<td>20-Feb-2013 00:00:00</td>
<td>5504</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>Flush Did You Mention Index</td>
<td>Scheduled</td>
<td>19-Feb-2013 14:00:00</td>
<td>19-Feb-2013 16:00:00</td>
<td>15</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>Flush Index Queue</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:26</td>
<td>19-Feb-2013 15:01:27</td>
<td>0</td>
<td>History · Run</td>
</tr>
<tr>
<td>Flush Local Task Queue</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:16</td>
<td>19-Feb-2013 15:02:00</td>
<td>0</td>
<td>History</td>
</tr>
<tr>
<td>Flush Mail Queue</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:16</td>
<td>19-Feb-2013 15:02:00</td>
<td>0</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>Flush Task Queue</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:16</td>
<td>19-Feb-2013 15:02:00</td>
<td>0</td>
<td>History · Run · Disable</td>
</tr>
<tr>
<td>Optimize Indexing</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:16</td>
<td>19-Feb-2013 15:02:00</td>
<td>0</td>
<td>History · Run · Edit</td>
</tr>
<tr>
<td>scheduledjob.desc.refreshSearcherJob</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:01:16</td>
<td>19-Feb-2013 15:02:00</td>
<td>0</td>
<td>History · Run · Edit · Disable</td>
</tr>
<tr>
<td>scheduledjob.desc.summaryEmail</td>
<td>Scheduled</td>
<td>19-Feb-2013 15:00:00</td>
<td>19-Feb-2013 16:00:00</td>
<td>506</td>
<td>History · Run · Disable</td>
</tr>
</tbody>
</table>
Executing a Job Manually

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job you wish to execute manually and click its 'Run' link in the 'Actions' column. The job will be run immediately.

Refer to 'Types of Jobs' (below) for detailed descriptions about each job.

Not all jobs can be run manually.

Configuring a Job's Schedule

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose schedule you wish to configure and click its 'Edit' link in the 'Actions' column. The job's 'Edit Schedule for job' dialog box opens.

Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
3. Enter an appropriate cron expression to define the frequency with which the job is executed.

Refer to 'Cron Expressions' (below) for more details about their syntax. To revert the job's schedule back to its default settings, click the 'Default' button.
4. Click 'Save' to record your job's new schedule.

Not all jobs' schedules are configurable.

Disabling/Re-enabling a Job

By default, all jobs in Confluence are enabled.

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job you wish to disable/re-enable.

Refer to 'Types of Jobs' (below) for detailed descriptions about each job.
• If a job is enabled, click its ‘Disable’ link in the ‘Actions’ column to disable the job.
• If a job is disabled, click its ‘Enable’ link in the ‘Actions’ column to enable the job.

ℹ️ Not all jobs in Confluence can be disabled.

Viewing a Job's Execution History

1. Access the 'Scheduled Jobs' configuration page (above).
2. Locate the job whose execution history you wish to view and click the 'History' link.
   - If a job has not completed at least one execution, its 'History' link will not be available.
   - Refer to 'Types of Jobs' (below) for detailed descriptions about each job.

The 'History for job' dialog box opens, showing a list of previous executions of the job in reverse chronological order, including the:

• Start date and time
• End date and time
• The length of time (in milliseconds) that it took to complete the job

Screenshot: Job Execution History

<table>
<thead>
<tr>
<th>Started</th>
<th>Ended</th>
<th>Duration (ms)</th>
</tr>
</thead>
<tbody>
<tr>
<td>19-Feb-2013 04:00:00</td>
<td>19-Feb-2013 04:00:01</td>
<td>1001</td>
</tr>
<tr>
<td>18-Feb-2013 04:00:00</td>
<td>18-Feb-2013 04:00:00</td>
<td>42</td>
</tr>
<tr>
<td>17-Feb-2013 04:00:00</td>
<td>17-Feb-2013 04:00:00</td>
<td>334</td>
</tr>
</tbody>
</table>

Types of Jobs

<table>
<thead>
<tr>
<th>Job Name</th>
<th>Description</th>
<th>Execution Behaviour</th>
<th>Default Schedule</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back Up Confluence</td>
<td>Performs a backup of your entire Confluence site.</td>
<td>Per cluster</td>
<td>At 2am every day</td>
</tr>
<tr>
<td>Check Cluster Safety</td>
<td>For clustered Confluence installations, this job ensures that only one Confluence instance in the cluster writes to the database at a time. For standard (non-clustered) editions of Confluence, this job is useful for alerting customers who have accidentally connected a second Confluence instance to a Confluence database which is already in use.</td>
<td>Per cluster</td>
<td>Every 30 seconds</td>
</tr>
<tr>
<td>Task</td>
<td>Description</td>
<td>频率</td>
<td>时间</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Clean Index Queue</td>
<td>Triggers a periodical clean of the index queue to ensure that its size does NOT grow indefinitely.</td>
<td>Per cluster</td>
<td>At 2am every day</td>
</tr>
<tr>
<td>Clean Temporary Directory</td>
<td>Cleans up temporary files generated in the 'temp' subdirectory of the Confluence home directory. This temp directory may be created by exports etc. This does not include the temp directory located in the confluence install directory.</td>
<td>Per node</td>
<td>At 4am every day</td>
</tr>
<tr>
<td>Clear Expired Mail Errors</td>
<td>Clears notification errors in the mail error queue. A notification error is sent to the mail error queue whenever the notification fails to be sent due to an error.</td>
<td>Per cluster</td>
<td>At 3am every day</td>
</tr>
<tr>
<td>Clear Expired Remember Me Tokens</td>
<td>Clears all expired 'Remember Me’ tokens from the Confluence site. Remember Me tokens expire after two weeks.</td>
<td>Per cluster</td>
<td>On the 20th of each month</td>
</tr>
<tr>
<td>Email Daily Reports</td>
<td>Emails a daily summary report of all Confluence changes to all subscribers. Since each email report only records changes from the last 24-hour period, it is recommended that you only change the time of this job whilst keeping the job's frequency to 24 hours.</td>
<td>Per cluster</td>
<td>At 12am every day</td>
</tr>
<tr>
<td>Flush Did You Mean Index</td>
<td>Flushes changes to the 'Did You Mean' index, which keeps the 'Did You Mean' feature up to date. Confluence records each content update in the 'Did You Mean' index.</td>
<td>Per node</td>
<td>Every 2 hours from 12 am</td>
</tr>
<tr>
<td>Task Name</td>
<td>Description</td>
<td>Frequency</td>
<td></td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------</td>
<td></td>
</tr>
<tr>
<td>Flush Index Queue</td>
<td>Flushes changes to Confluence's index so that Confluence's search results are up to date. Confluence records each content update in its search index.</td>
<td>Per node Every minute</td>
<td></td>
</tr>
<tr>
<td>Flush Local Task Queue</td>
<td>Flushes the local task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.)</td>
<td>Per node Every minute</td>
<td></td>
</tr>
<tr>
<td>Flush Mail Queue</td>
<td>Sends notifications that have been queued up in the mail queue.</td>
<td>Per cluster Every minute</td>
<td></td>
</tr>
<tr>
<td>Flush Task Queue</td>
<td>Flushes the task queue. (These are internal Confluence tasks that are typically flushed at a high frequency.)</td>
<td>Per node Every minute</td>
<td></td>
</tr>
<tr>
<td>Optimise Indexing</td>
<td>Compacts the confluence indexes to maintain searching performance.</td>
<td>Per node At 3am and 3pm every day</td>
<td></td>
</tr>
<tr>
<td>Poll Mail</td>
<td>Polls POP accounts on all spaces that have them configured.</td>
<td>Per cluster Every minute</td>
<td></td>
</tr>
</tbody>
</table>

Cron Expressions

A cron expression is a string of 6-7 'time interval' fields that defines the frequency with which a job is executed. Each of these fields can be expressed as either a numerical value or a special character and each field is separated by at least one space or tab character.

The table below is shows the order of time interval fields in a cron expression and each field's permitted numerical values.

You can specify a special character instead of a numerical value for any field in the cron expression to provide flexibility in defining a job's frequency. Common special characters include:
• ‘*’ — a ‘wild card’ that indicates ‘all permitted values’.
• ‘?’ — indicates 'ignore this time interval' in the cron expression. That is, the cron expression will not be bound by the time interval (such as 'Month', 'Day of week' or 'Year') to which this character is specified.

For more information about cron expressions, please refer to the Cron Trigger tutorial on the Quartz website.

<table>
<thead>
<tr>
<th>Order in cron expression</th>
<th>Time interval field</th>
<th>Permitted values*</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Seconds</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>2</td>
<td>Minutes</td>
<td>0-59</td>
<td>Yes</td>
</tr>
<tr>
<td>3</td>
<td>Hours</td>
<td>0-23</td>
<td>Yes</td>
</tr>
<tr>
<td>4</td>
<td>Day of month</td>
<td>1-31</td>
<td>Yes</td>
</tr>
<tr>
<td>5</td>
<td>Month</td>
<td>1-12 or JAN-DEC</td>
<td>Yes</td>
</tr>
<tr>
<td>6</td>
<td>Day of week</td>
<td>1-7 or SUN-SAT</td>
<td>Yes</td>
</tr>
<tr>
<td>7</td>
<td>Year</td>
<td>1970-2099</td>
<td>No</td>
</tr>
</tbody>
</table>

* Excluding special characters.

Operating Large or Mission-Critical Confluence Installations

This page gives guidelines for operational management teams who are responsible for a large Confluence installation, or for a Confluence installation which is crucial to the business of their organisation.

Introduction to this Page

Motivation for Presenting these Guidelines

Most Confluence installations start off small. Ten people in an early-adoption department use it for a couple of weeks. Everything works well and the good news starts spreading. Adoption increases throughout the organisation. More and more people use the wiki, and more and more rely on Confluence being up and running. After a while even the CEO starts blogging. And then a system outage occurs.

Now what?

Wikis like Confluence often grow into mission-critical applications within just a few months. Often adoption is so fast that IT departments haven’t had the time to scale up their support.

We have assembled some requirements to help you make sure that your installation of Confluence can be mission critical. There are no surprises to be found here — all of the requirements would apply to any other piece of software that is mission critical within your organisation.

Who should Read these Guidelines?

The guidelines do not apply to you if you are using Confluence with just a few dozen users, and no one really minds if Confluence is down for a couple of hours because your database has crashed.

But if any one of the following applies to you, then these guidelines are a must read for you!

• The wiki has become your organisation’s documentation base.
• Your users can't work properly when Confluence is down.
• Your boss or customer threatens to terminate your contract if you don't meet a strict service level agreement (SLA), such as 99.9% availability.
Requirements of Large or Mission-Critical Confluence Installations

Dedicated Hardware for Confluence

In a small work group with a few dozen or even hundreds of users, your Confluence installation can happily share the CPUs, memory and disks with other low-profile applications and a database.

But with thousands or even tens of thousands of users, you need dedicated hardware that runs Confluence and nothing else, and it needs to be fast hardware with plenty of RAM. While you can run Confluence in a virtualised environment such as VMware, we suggest you don't do it for mission-critical or high-load installations unless you are a real expert in virtualisation. Otherwise your other VMs might have performance problems which propagate to Confluence.

If you experience database-related problems, you should consider moving the Confluence database to a dedicated machine. Confluence itself can run queries that impact the performance of other applications, and other application problems or scheduled tasks can have an adverse affect on the usability of Confluence.

Dedicated Qualified Staff

If your Confluence installation is mission critical and your service level agreements require 24/7 up time, you need to be able to pinpoint problems quickly. You need qualified staff, dedicated to looking after Confluence, who are available during business hours and possibly beyond.

If you require assistance from the Atlassian Support team, you may need to answer some pretty technical questions to help us diagnose what is going on in your systems. Also keep in mind that Atlassian support assists you in finding problems in Confluence, but we can't help you administer your systems.

In particular, we recommend that you have dedicated staff in the roles listed below.

Operations Team with General Administrators

If your organisation relies on Confluence being up and running around the clock with very little downtime, you need people who can set up, maintain, tune and improve your Confluence installation. This requires at least one person, but ideally you will have a team of operational engineers.

If your wiki is mission critical, chances are that other IT systems within your organisation have already made it necessary to have such an operations team. So you will probably not need to hire someone specifically to administrate Confluence. But it is vital that supporting and maintaining Confluence is added to the list of responsibilities of that operations teams, and that you can get them to troubleshoot and analyse Confluence at short notice.
If problems arise and you need to contact Atlassian Support, these engineers will be our first point of contact. We may ask them to provide details of log files, application-server settings, monitoring systems, and so on.

**Network Staff**

If Confluence is mission critical for large numbers of users, it is vital that you have dedicated network staff available to track down problems when they arise.

A mission-critical installation will usually be used by hundreds or even thousands of users, and you don't want to keep them waiting because a network card breaks, or because someone has made an undocumented change to the network and you don't have an expert around who can figure it out.

Again, this only applies to mission-critical systems. If you use Confluence for less critical collaboration and knowledge sharing, and a broken network cable causing a day's downtime is no major catastrophe, then you will not need dedicated networking staff.

**Database Staff**

If Confluence is mission critical for a large number of users, you need an experienced database administrator (DBA) available to troubleshoot database performance issues and other potential problems. It is dangerous not to have an experienced full-time DBA at hand at short notice when running a mission critical application. While small installations of Confluence basically work 'out of the box', any system that involves high load or high-availability requirements needs continual monitoring, optimising and fine tuning of the Confluence database. Database monitoring is no trivial task — it's not something that anyone can learn quickly.

**Developers**

You may have decided to customise Confluence by changing its source-code, or by writing your own plugins. If your server is mission-critical, you must nominate staff who will be responsible for that code, and they must be up for the task. Otherwise you might end up in a situation in which your server experiences downtimes because of custom code is broken, or does not work with a newer version of Confluence anymore, but you can't fix the problem because no one knows how the customized code works, and you can't uninstall it either because it has become critical for your Confluence usage pattern. Keep good track of changes, and have someone available to jump into action if there is a problem. Don’t let the summer intern write mission-critical plugins, unless you have more senior staff to maintain that code as long as it is in use.

**Constant Monitoring of Production Systems**

You will need to monitor your production systems constantly.

When the wiki is the lifeblood of your organisation, you need know exactly what is going on inside, so that you can plan for future needs and analyse potential bottlenecks.

Monitoring involves a number of essential tasks, including those listed below:

- Monitoring log files.
- Checking for HTTP-availability and performance (e.g. by getting the same page every five minutes and displaying the time on a graph).
- Looking at many different parameters such as load, connections, IO, database-trends, and so on.
- Charting long-term trends.
- Keeping an access log of requests to the web server. This is vital, especially when requesting performance-related support from Atlassian.

Monitoring a web application like Confluence implies also monitoring the subsystems it uses. Many outages and downtimes are caused by broken mail servers, databases running out of space, file systems filling up and so on. It is often possible to detect these trends way before the actual web application breaks down. Keep an eye on the file system, and if you see it is getting closer to 90% utilisation, you can mend the situation without
Confluence breaking down. Or even if the worst case happens (e.g. the database breaks down and Confluence is affected straight away) then having the proper monitoring for the database server makes troubleshooting a lot easier.

**Tools for Monitoring Confluence**

At Atlassian we use Hyperic. But the list of monitoring systems is long and we can't recommend a specific product over the other. If your organisation has a monitoring system already, make sure you hook up Confluence to it. If you don't have a monitoring system yet, you need to install one as soon as you feel Confluence is mission critical.

As an example of what our monitoring UI looks like, have a look at this screenshot:
The following screenshot shows one of our sensors looking at the HTTP response times of our documentation wiki over the last 8 days. You can clearly see an incident four days ago. Having the graph (and regularly looking at it) allowed us to pinpoint the problem. We analysed the access logs and found that webpage-profiling had been enabled but not disabled again, which caused performance problems.
This page would get too long if we described all our monitoring sensors - but just to give you an impression, this is what we monitor on the JVM level alone.

**JVM basics**

- Current Loaded Classes
- Daemon Thread Count
- Heap Memory Committed
- Heap Memory Max
- Heap Memory Used
- Loaded Classes
- Loaded Classes per Minute
- Object Pending Finalization Count
- Peak Thread Count
- Thread Count
- Unloaded Classes
- Unloaded Classes per Minute

**JVM garbage collection**

- Collection Count
- Collection Count per Minute
- Collection Time
- Collection Time per Minute

**JVM memory: (Metrics for Eden space, Old Gen, Survivor space, Perm Gen)**

- Commited Memory
- Used Memory

We get the same level of detail for our database, for the file system, for the CPU, for the network, and so on. Not all of this is needed all the time. But if your company depends on an application, then the more information you have at your fingertips the better. Fortunately these metrics can be extracted quite easily once you have a monitoring system in place.

**Adherence to Strict Upgrade Procedures**

Your organisation will have its own upgrading procedure. Here are a few recommendations that you should add to your list:

- Our main recommendation: Never change more than one component at a time. Sometimes it may be tempting to upgrade the server hardware when you upgrade Confluence, but we recommend you don't do that. It makes pinpointing errors much more difficult. So, for example, don't upgrade hard disks in conjunction with a Confluence version upgrade, don't change the Confluence configuration at the same time as you upgrade your Apache software, and don't upgrade a major third-party plugin the day you move your database system to a new machine. The list is endless, these were just a few examples to get you thinking.
- After each upgrade step, run Confluence for a couple of days to check that everything is still fine.
- Keep track diligently of what you change, and when. It will be nearly impossible for us to help you if you can't tell us what exactly you changed at what time.
- Keep a copy of all log files produced during the upgrade, together with notes about what changed.
between successive restarts.

Always take careful note of the upgrade notes published with the Confluence Release Notes of each Confluence version, as well as the Confluence Upgrade Guide.

Example

Here you can see an extract of our change log for http://confluence.atlassian.com — the server that hosts this very page.

<table>
<thead>
<tr>
<th>Sydney time</th>
<th>Server time</th>
<th>Event</th>
<th>Reason/Purpose (including JIRA issues)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2008-03-25 22:18</td>
<td>Started upgrade to 2.8-m9-r3 (build #1314)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-03-25 22:25</td>
<td>App server brought down due to failed database upgrade</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-03-26 00:51</td>
<td>Server brought back up after database restored from backup. Running 2.8-m9-r3.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-03-28 04:18</td>
<td>GC algorithm changed from concurrent to parallel collector. Max heap increased from 1.4 GB to 2.0 GB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-04-24</td>
<td>Hyperic agent started with connection to Resin.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-05-08 20:30 - 22:30</td>
<td>Manual updates to menu.css, comments.js and comments.css in webapp</td>
<td>Temporary fix for @JIRA, @JIRA which was impacting performance</td>
</tr>
<tr>
<td></td>
<td>2008-05-12</td>
<td>Updated cache sizes for five caches, bounced server.</td>
<td>Cache efficiency was low on these caches.</td>
</tr>
<tr>
<td></td>
<td>2008-05-13 18:00-18:20</td>
<td>Upgrade from Resin 3.0 to Tomcat 5.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-05-14 16:30-17:00</td>
<td>Upgrade from Confluence 2.8.1-rc2 to 2.8.1-rc3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2008-05-14 20:30</td>
<td>Install new cronjob as j2ee for automating access log analysis</td>
<td>@JIRA</td>
</tr>
</tbody>
</table>

Testing of Upgrades before Production Implementation

You should test upgrades in a staging environment.
Before rolling out a new version of Confluence (or of the software or hardware that it uses, e.g. database systems, application servers, data storage), make sure that you test the upgrade with real data (e.g. a database dump) on a completely independent machine.

Here's an example of what such a test would pick up: The new release of Confluence may not be compatible with a custom third party plugin you have previously installed, thus breaking the plugin's functionality. You may not even know that anyone installed that plugin — but maybe many people are already using it. You'll want to find out about this before you actually roll out the new version of Confluence.

Here is an outline for a simple upgrade test:

1. Create a clone of your production environment, using a database dump to obtain a copy of the Confluence data. We'll call this your ‘staging environment’.
2. Upgrade the staging environment to the new version of Confluence.
3. Ask a few selected users from different departments to check the pages they commonly access, but have them do it in the staging environment.

Hint: In addition to finding weirdnesses with plugins, this may also show whether training for new functionality is needed in some of the departments. The IT department staff may be able to handle the upgrade to a new version of Confluence without training, but perhaps the sales representatives who use the wiki less often will need some training.

Enforcing Security Guidelines

Security is one of the most important issues for Confluence. We are constantly spending large amounts of effort to keep up with security threats and to Confluence's security model. We treat security breaches with utmost priority, and the recent releases have been improved to fend off advanced attack vectors like cross-site scripting (XSS), cross-site request forgery (XSRF) and header injection flaws. Altogether we believe that Confluence is a very secure product. But of course as with any software there are occasional bugs, and we are fixing security issues whenever they come up. We regularly release minor software releases that contain security fixes. This means you should upgrade your system frequently. Obviously this can affect your system's uptime. You should also make sure your whole infrastructure around Confluence is made robust as well (consider operating systems, webservers, application servers, networks, social engineering aspects, etc).

As with any other distributed system, you need to decide on a case by case basis if classified documents can be stored in it. It is common practice to store the most secure documents on computers that are not even connected to the physical intranet. Please contact your company's security officer to learn more about your enterprise's security procedures.

Make sure to have qualified staff around, so you can deal with security issues quickly. Once a security patch becomes available or a security incident happens, speed is essential.

Please refer to our dedicated Configuring Confluence Security page for more technical details.

Load-Testing Environments

Many customers ask us,

So, how many users and spaces can I put into Confluence, and what is the best hardware do to so?

The answer is, 'It depends'.

It depends a lot on your use case. Confluence is so successful because it can cover a huge range of use cases.
If most of your users only access Confluence infrequently, it is no problem to have 70 000 to 100 000 users. But if each user is a power-user who uses the system the whole day, there's a substantial decrease in number Confluence can take without tuning. If your pages are short, simple, and don't contain a lot of macros, then the situation will be vastly different from a system that relies heavily on macros, background-tasks, or other features.

If your system is large (for example serving more than 10 000 users or storing more than 1000 spaces) or mission-critical (which it could be with as few as 1000 users who use it all the time) you need one or more more load-testing environments.

Even if your system is working nicely for 20 000 users right now, it might take just another 2000 users to push it over the edge.

We recommend the following basic procedure:

- Set up an environment that closely resembles your production environment.
- Gather statistics from your production system.
- Regularly apply a similar kind of load (and slightly higher) to the load-testing environment.
- Analyse how well Confluence scales for your usage patterns.

The Confluence development team has load-testing scripts available which you can use to simulate load. You can also contact Atlassian Support for more details.

**Tuning**

You may need to be able to tune your installation in the ways mentioned below.

**Optimising your System**

If you have large numbers of users, then downloading all the static content (CSS, default images, JavaScript-files) may result in a high additional load on the application server that can be offloaded to a caching web server.

Please refer to the following additional information:

- Our general Performance Tuning page.
- Information on configuring a large Confluence installation.

**Limiting Third-Party Plugins**

You may have to restrict the number of third-party plugins installed on your Confluence instance.

Most third-party plugins are not specifically written for high-load environments. What works fine in low-load environments could have unexpected and adverse effects when thousands of users are competing for your application server's CPU time or for database IO.

A common source of problems is access to database connections. If you have fewer users than database connections, it does not matter if an operation holds on to a database connection for two seconds while it downloads some data from the internet. With hundreds of concurrent users, this could quickly become a bottleneck.

Confluence itself is tested and optimised to handle high loads and avoids these kinds of problems. But if you install a number of plugins that have not been tested against high load, your system may become unstable.

We recommend that you load test the common use cases of each unofficial third-party plugin if your Confluence installation is mission critical. Only activate plugins that are vital to your business, and never allow experimental plugins onto your production system until they have been tested in a staging environment.

**Selecting and Tuning your JVM**

You should select your JVM carefully and you may need to be able to tune it.
The selection of the JVM for your large Confluence instance can have a huge impact on the performance perceived by the users. Between versions 1.4 and 6 of the Sun Java JVM there have been some impressive improvements in performance, especially under high concurrent load.

Here are some essential guidelines:

- Always run the most recent point release of your selected JVM.
- Where ever possible run the most recent major release from your selected JVM manufacturer. The Sun JVM version 6 is much faster than 1.4, especially under high loads.
- Tune your garbage collection algorithms. Experiment with different algorithms and settings to get the response times you desire in your environment. Here are some specific guidelines for Sun JVM in the Sun documentation:
  - Java 6
  - Java 5
  - Java 1.4

**Customising Confluence to Optimise Performance**

You may need to customise Confluence for performance reasons. Depending on your usage scenario, there may be ways to enhance Confluence performance that become necessary when you reach a certain level of usage.

Here are some things you might decide to do:

- Remove the display of the space list on the Dashboard. See Customising the Confluence Dashboard.
- Configure any search appliances or other crawlers which are configured to index the Confluence site:
  - These should be suitably rate limited.
  - Configure them to crawl only pages in the `/display/` URL path, and only current versions of pages.

Please refer to our general Performance Tuning page for more details.

**Related Topics**

- Performance Tuning
- Configuring a Large Confluence Installation
- Confluence Clustering Overview
- Requesting Performance Support
- Confluence Administrator's Guide
- Configuring Confluence
- Server Hardware Requirements Guide
- How to Fix Out of Memory Errors by Increasing Available Memory

**Configuring a Large Confluence Installation**

Deploying any application to several thousand users requires care and planning, especially if those users are going to be relying on the application to get their work done.

> The information on this page does not apply to Confluence OnDemand.

**General Advice**

**Staged Rollout**

Do not try to deploy Confluence immediately to your whole organisation. Instead, roll it out department by department, or project by project.

How Confluence will scale given a particular software and hardware configuration depends very much on how
Confluence is likely to be used in your organisation. Launching Confluence to everybody at once may seem like a neat idea, but it also means that any problems you might experience scaling the system up to your entire organisation will hit you all at once, annoy everyone and possibly hurt adoption.

Rolling Confluence out gradually will give you the chance to tune it as you go, resulting in a much more painless experience. There will also be organisational advantages: you can identify those teams or projects who are most likely to be successful ‘early adopters’, and those teams can experiment with how best a wiki might suit your organisation, and pass on their ‘best wiki practices’ as usage of Confluence expands.

**Plugin Governance**

Confluence plugins can add tremendous value. Before adding one, visit the plugin's page and explore its issues (available from the issue management link). Try the plugin in a test environment and make sure to note any adverse effects after adding it to a production environment. Test plugins independently when upgrading.

**Backup strategy**

Disable the XML backup and use the Production Backup Strategy.

**New Spaces Governance**

For both performance and good practice, put some modest governance in place around the creation of new spaces, such as a simple request that includes a check for duplicates and some strategy around how to best use a space. Duplicates and unused spaces should be purged by a wiki gardener. Try to keep it to one space per group.

**Performance Tuning and Testing**

Check our guides for Performance Tuning, particularly Performance Testing Scripts. You can run performance testing early, to anticipate scaling issues before they happen.

**Choosing User Management and Single Sign-On**

We recommend that you choose and configure your user management solution as soon as possible, rather than adding it to your Confluence installation at a later date.

It is possible to integrate with an LDAP repository, such as Microsoft Active Directory, or add a single sign-on solution later (especially with the addition of Crowd). But if possible it is best to configure your user management system up front. You can configure access for only a specific group or set of groups, thereby keeping the gradual rollout.

Please refer to our detailed guide to Configuring User Directories and examine the User Management Limitations and Recommendations.

**Configuring your Application Server, Web Server and Database**

Because Confluence can be deployed in so many server combinations, we do not currently have guides on the best tuning parameters for each individual server. We will be happy to provide support, however. If you have any tuning parameters that you find particularly useful for Confluence instances, feel free to share them with other Confluence users in the Confluence Community space.

**Best Practices**

**Troubleshooting possible memory leaks**

The Troubleshooting Confluence Hanging or Crashing guide is a good place to start. Some of the known causes listed there could result in performance issues short of a crash or hang. Many of the issues reported there are exacerbated with a large installation.
Memory Usage

The Java virtual machine is configured with a "maximum heap size" that limits the amount of memory it will consume. If Confluence fills up this maximum heap size it will run out of memory, and start behaving unpredictably. You can keep track of Confluence's memory usage from the System Information screen of the administration console:

<table>
<thead>
<tr>
<th>Memory Usage</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Memory</td>
<td>313 MB</td>
</tr>
<tr>
<td>Free Memory</td>
<td>140 MB</td>
</tr>
<tr>
<td>Used Memory</td>
<td>173 MB</td>
</tr>
</tbody>
</table>

This example shows that, at the time of writing, confluence.atlassian.com is using 173MB of an allocated 313MB of heap. (The JVM was configured with a maximum heap size of 450MB, but this information is not available in the graph. The 313MB figure shows that the full 450MB of heap has not yet been needed)

Database Connection Pool

Confluence will need a database connection for each simultaneous user connection to the server. It is also a good idea to have 5-10 connections spare for Confluence internal processes such as backups, re-indexing or daily notification jobs.

Running out of pooled connections will cause the server to slow down as more users are waiting for a connection to be freed before starting their own request, and will eventually cause visible system errors as Confluence times out waiting for a database connection.

If you are using Confluence's internal connection pool, you can increase the number of available connections by modifying the `hibernate.c3p0.max_size` property in `confluence_home/confluence-cfg.xml`, and restarting Confluence. Make sure you have also configured your database to be able to support that many simultaneous connections.

Cache Sizes

The Performance Tuning page includes some useful rules of thumb for configuring the sizes of Confluence's internal caches.

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

Related Topics

Operating Large or Mission-Critical Confluence Installations
Performance Tuning
Confluence Clustering Overview
Requesting Performance Support
Managing Confluence Users
Confluence Administrator's Guide
Configuring Confluence

Confluence Clustering Overview

It is possible to run Confluence in a clustered environment instead of on a single server. This means that you can run multiple copies of Confluence in a cluster, so that clients (such as a browser) can connect to any copy and see the same information.

Consider your options carefully before deciding on a clustered installation
While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change and requires extra planning for deployment and upgrades. Please consider the information on the Cluster Checklist and then consult Atlassian support before making your final decision.

This page gives an overview and links to further pages with information on installing, configuring and administering a Confluence cluster.

⚠️ The information on this page does not apply to Confluence OnDemand.

Before Deciding to Run a Confluence Cluster

1. Read and consider the details on the Cluster Checklist.
2. Consider the difference between clustering for scalability and clustering for high availability (HA).
3. Contact Atlassian support for further information and advice.

Technical Overview

Read a technical overview of clustering in Confluence.

Server and Network Requirements

- Server hardware requirements
- Technical overview of Confluence clustering
- Diagram of recommended network topology

Installation and Upgrading

There are two methods of installing Confluence in a cluster, depending on whether you have existing data:

- Fresh installation
- Existing data

If you are upgrading an existing Confluence cluster to a new version of Confluence, refer to the cluster upgrade guide.

Configuration and Administration

- Cluster Administration page in the Administration Console
- Changing datasources in clusters

Troubleshooting

- Cluster troubleshooting

RELATED TOPICS

Operating Large or Mission-Critical Confluence Installations
Performance Tuning
Requesting Performance Support
Confluence Administrator's Guide
Configuring Confluence
Technical Overview of Clustering in Confluence

Overview of clustering documentation
Refer to the overview of Confluence clustering in the Administrators' Guide.
Introduction

From version 2.3, Confluence has had the ability to configure and run multiple copies of itself in a cluster, so that clients can connect to any copy and see the same information. In effect, a Confluence cluster behaves as a single, powerful Confluence installation. While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change from earlier versions (or non-clustered installations) and consequently, requires extra planning for deployment and upgrades.

This document will give a technical overview of clustering in Confluence, primarily for those users and developers who will be installing and configuring Confluence in a cluster. A separate overview is available for Confluence plugin developers.

Cluster topology

A simple description of the cluster topology for Confluence would be multiple applications, shared data source. A cluster of Confluence consists of:

- multiple homogeneous installations of Confluence (called nodes below)
  - a Confluence home directory for each installation.
- a distributed Oracle Coherence cache (formerly known as Tangosol Coherence), which all nodes use via a multicast group - see networking summary below
- a single database, which all nodes connect to

The user is responsible for configuring an appropriate HTTP load balancer in front of the clustered installations. Typically this means using mod_jk or another application server load-balancing technology. The load balancer must be configured to support session affinity.

Communication between clustered nodes is minimised by using a distributed cache which propagates updates to all other nodes automatically. Where necessary, Coherence provides a locking mechanism for synchronising jobs and a RMI interface for more complex communication.

LAN Clustering Only

Atlassian only supports clustering over a local area network. While it is theoretically possible to configure Confluence to cluster across a WAN, the latency involved is likely to kill performance of the cluster. If you do want to go down that path, you will need to configure Coherence yourself. Atlassian Support won’t be able to support that kind of a configuration, but you can always enlist an Atlassian Expert to help.

Homogeneous Confluence installations

All the Confluence installations must be running exactly the same application, down to the lowest level. Items that must be the same include:

- Confluence version
- Application server version
- JDK version
- Libraries and plugins in the Confluence classpath, WEB-INF/lib
Libraries in the application server classpath

The installation section has more information how to ensure homogeneous node installations.

Creating a Confluence cluster

When installing Confluence in a clustered setup, you will be responsible for configuring your web server and load balancer to distribute traffic between each node. No additional software is required as Coherence is bundled with Confluence.

Here is an overview of the process:

1. Obtain a clustered licence key from Atlassian for each node
2. Upgrade a single node to the clustered licence
3. Start the cluster from that node’s administration menu, specifying a name and optionally a preferred network interface
4. Restart the single node and test it
5. Copy the Confluence application and Confluence home directory to the second node
6. Bring up the second node and it will automatically join the cluster.

Copying the Confluence application and home directory helps ensure that the installations are homogeneous.

An alternative to this method is to copy the Confluence web application, but not the Confluence home directory. In this case, the installation wizard will require your cluster name to connect to the other nodes, and it will automatically configure itself. You will need to rebuild the index manually after this installation, however.

There is now full documentation for a Confluence Cluster Installation.

Upgrade process

Another consequence of the homogeneous requirement is that upgrades must be done by following a strict process.

1. All cluster nodes are brought down
2. Upgrade a single node to the latest Confluence version
3. Start the single node so it can upgrade the database
4. Upgrade subsequent nodes and start them one-by-one.

This is the only safe method of upgrading a Confluence cluster.

Single database

The Confluence database in a cluster is shared by all nodes. This means that the database must be able to scale to service all the Confluence nodes, which will probably mean implementing some kind of database cluster and JDBC-level load balancing. We can not offer support with scaling or tuning your database, you will need to talk to your DBA or database vendor.

For obvious reasons, you must have an external database to run Massive - you can not cluster Confluence when using the embedded HSQL database.

The most important requirement for the cluster database is that it have sufficient connections available to support the expected number of application nodes. For example, if each Confluence instance has a connection pool of 20 connections and you expect to run a cluster with four nodes, your database server must allow at least 80 connections to the Confluence database. In practice, you may require more than the minimum for debugging or administrative purposes.

In a cluster, attachments must be stored in the database. Configuring a cluster in an existing installation will automatically migrate your attachments to the database. Non-clustered installations still have the option of using the Confluence home directory for storing attachments.
While attachments are stored in the database, they are temporarily written to the cluster node's local filesystem, designated `<confluence-home>/temp` folder, when being streamed to users (so Confluence doesn’t have to hold open database connections unnecessarily). For this reason, Confluence will still need enough temporary disk space to hold any attachments currently in transit.

**Distributed cache**

In a normal configuration, Confluence uses many caches to reduce the number of database queries required for common operations. Viewing a page might require dozens of permissions checks, and it would be very slow if Confluence queried the database for this information with every page view. However, caches must be carefully maintained so they are consistent with the application data. If the page permissions change, the old invalid data needs to be removed from the cache so it can be replaced with a fresh correct copy.

To preserve consistent caches across a cluster, Confluence uses a distributed cache called Oracle Coherence, which manages replicating cache updates transparently across all nodes. The network requirements of the distributed cache are quite simple, but must be preserved if the cluster is to work properly.

To discover other nodes in the cluster, Confluence broadcasts a join request on a multicast network address. Confluence must be able to open a UDP port on this multicast address, or it will not be able to find the other cluster nodes.

Once the nodes are discovered, each responds with a unicast (normal) IP address and port where it can be contacted for cache updates. Confluence must be able to open a UDP port for regular communication with the other nodes.

Because the Coherence network requirements are different to those required by the Confluence database connection, the situation can arise where Confluence can use the database but not talk to the other nodes in the cluster via Coherence. When Confluence detects this, it will shut itself down in a **cluster panic**.

For more details on the network configuration of the distributed cache, see the networking summary.

**Home directory**

Confluence’s home directory has a much-reduced role in a cluster. Because the application data must be shared between all nodes for consistency, the only information stored in the Confluence home directory is either node-specific, or needed to start Confluence. This includes information related to:

- database connection
- license
- cluster connection

The only application data stored in the Confluence home directory is the **Lucene search index**. Confluence synchronises this data itself by keeping track of indexing tasks in the database.

This is also why we recommend copying the Confluence home directory from the first node when setting up subsequent nodes. If you did not copy the Confluence home directory, you would need to rebuild the search index from scratch on the subsequent nodes after installation.

**Event handling**

Broadcasting events to all nodes in a cluster is supported in Confluence, but not recommended. The cluster topology uses a shared data store so that application state does not need to be synchronised by events.

The event broadcasting is done only for certain events, like installing a plugin. When a plugin is installed in one node, Confluence puts the plugin data in the database, and notifies the other nodes that they need to load the plugin into memory.

**Indexing**

Confluence maintains a copy of its Lucene search index on each node of the cluster. This index is used for many
things beside full-text searches, including RSS feeds and lists of recently updated content. Indexing in a cluster works like this:

1. Node 1 gets a request to save some page update
2. After saving the page in the database, Node 1 adds a "page-updated" index entry to the queue, which is in the database
3. Periodically, each node picks up the "latest entries" from the queue, where what is latest is determined from a timestamp on a file in the Confluence home directory which indicates when the queue was last inspected. This process is called "flushing the index queue".
4. Each node independently updates its local Lucene index. The "page-updated" index entry is internally changed into a delete-document task and an add-document task to apply the changes to Lucene.
5. Each node updates the timestamp on its index-queue-timestamp file to reflect the most recent processing or "flushing" of the index queue.

Because of step #3, if the timing of the nodes is not synchronised or changes sporadically (due to a virtualisation environment, typically), index changes will not be correctly synchronised in the cluster. This is the most common cause of index sync problems in clusters.

If a node is disconnected from the cluster for a short amount of time (less than three hours), it will be able to bring its copy of the index up-to-date when it rejoins the cluster. If a node is down for a long amount of time and its lucene index has become stale as a result, you may want to avoid the expensive operation of rebuilding the index. To do that, you must copy a "live" version of the Lucene index from an active node. Simply replace the contents of the Confluence Home\/index directory with those from an active node before bringing the stale node back up.

Job synchronisation

For tasks such as sending the daily report emails, it is important that only one node in the cluster does this. Otherwise you would get multiple emails from Confluence every day.

Confluence uses locks in the Coherence distributed cache to ensure only one node can be running certain jobs at a time. This ensures email notifications will only be sent once.

Activity tracking

Activity tracking does not work in a cluster, and will be disabled for clustered deployments. We’re working on making the activity tracker clusterable in a future release. You can follow this issue. You can try some other options for tracking usage.

Cluster panic

In some situations, there can be a network issue or firewall that prevents the distributed cache from communicating but still allows Confluence to update the database. This is a dangerous situation because when the caches on the detached nodes become inconsistent, users on different nodes will see different information and updates can be lost.

Confluence can detect this problem by checking a database value against a cached value, and if they differ, all the clustered nodes will be shut down with a ‘Cluster panic’ message. This is considered a fatal error because the consequences can cause damage to your data. For those administrators that like to live on the edge, there is a system property to prevent cluster panic and allow data corruption. For more information, see Cluster safety mechanism.

If a cluster panic does occur, you need to ensure proper network connectivity between the clustered nodes. Most likely multicast traffic is being blocked or not routed correctly. See the networking summary below.

Summary of network requirements

In addition to normal connectivity with its database, all clustered Confluence instances require access to a
multicast group and the ability to open a UDP unicast port.

By default, the multicast address is automatically generated from the cluster name you provide when starting the cluster and the multicast port is fixed. During cluster setup, Confluence will prompt for the unicast IP address to use if the server has multiple network interfaces, and by default the unicast port is fixed. The cluster multicast group will be joined on the same network interface as the bound unicast IP address.

For any settings which are not configurable through the Confluence web interface, they can be configured via an XML file in the Confluence home directory for more exotic networking requirements.

### Scaling Confluence On A Single Server

Since the maximum addressable memory on a 32 bit JVM is 4GB, some large servers may scale Java applications by running JVM instances concurrently. This would be implemented as separate, clustered Confluence nodes running on a single server and communicating internally. Because each JVM replicates the cache entirely, it may be useful to test a single, massive instance running a 64 bit JVM as an alternative. This configuration may result in superior performance than an internal cluster.

### Geographically Distributed Clusters

Collocating nodes is strongly recommended as high latency will almost certainly degrade performance due to the overhead of cache replication. Cluster nodes will provide the best performance if servers are physically adjacent. However, as long as all nodes share a LAN, users may wish to test alternative configurations to see how performance is affected.

**RELATED TOPICS**

- Server Hardware Requirements Guide
- Overview of Confluence Clusters
- Developers' Guide to Clustering
- Cluster safety mechanism

### Introduction

A mechanism was added in Confluence 2.3 and above to ensure database consistency when running multiple cluster nodes against the same database. This is called the *cluster safety mechanism*, and is designed to ensure that your wiki cannot become inconsistent because updates by one user are not visible to another. A failure of this mechanism is a fatal error in Confluence and is called *cluster panic*.

Because the cluster safety mechanism helps prevents data inconsistency whenever any two copies of Confluence running against the same database, it is enabled in all instances of Confluence, not just clusters.

⚠️ The information on this page does not apply to Confluence OnDemand.

### How cluster safety works

A scheduled task, ClusterSafetyJob, runs every 30 seconds in Confluence. In a cluster, this job is run only on one of the nodes. The scheduled task operates on a safety number – a randomly generated number that is stored both in the database and in the distributed cache used across a cluster. It does the following:

1. **Generate** a new random number
2. **Compare the existing safety numbers**, if there is already a safety number in both the database and the cache.
3. **If the numbers differ**, publish a ClusterPanicEvent. Currently in Confluence, this causes the following to happen:
   - disable all access to the application
   - disable all scheduled tasks
   - update the database safety number to a new value, which will cause all nodes accessing the
database to fail.

4. If the numbers are the same or aren't set yet, **update the safety numbers**:
   - set the safety number in the database to the new random number
   - set the safety number in the cache to the new random number.

**How to fix it**

See 'Database is being updated by an instance which is not part of the current cluster' Error Message

**Technical details**

The cluster safety number in the database is stored in the `CLUSTERSAFETY` table. This table has just one row: the current safety number.

**Changing Datasources Manually in a Cluster**

The recommended way of changing database connections is to shut down the whole cluster, install Confluence into new and empty directories and use the Setup Wizard to configure all new database connection settings.

However, if you wish to manually change your settings, you may proceed as described below.

**It is strongly recommended** that you test all of the following in a staging or test instance of Confluence before performing these steps in your production environment.

**The information on this page does not apply to Confluence OnDemand.**

**Step 1: Prepare**

- Locate the `confluence-cfg.xml` file in the Confluence home directory.
- Make a backup copy of that file.
- Prepare the necessary changes to that file.

**Step 2: Shut Down Confluence**

You need to shut down all the nodes in the cluster, not just one.

**Step 3: Apply your Changes**

Apply your configuration changes to the required node.

**Step 4: Restart the Changed Node**

It is crucial that you bring up the node on which you applied the changes **first**. Otherwise you will get an error message, and have to shut down all instances again.

**Step 5: Restart all Other Nodes**

**Done.**

**RELATED PAGES**

- **Overview of Confluence Clusters**
- **Cluster Troubleshooting**

This page covers troubleshooting for a clustered installation of Confluence.

- For information about clustering in general, refer to the overview of Confluence clustering.
- If you're experiencing Cluster Panic messages in non-clustered installation of Confluence, visit the Knowledge Base article 'Database is being updated by an instance which is not part of the current cluster' Error Message.
Symptoms

Below is a list of potential problems with a Confluence cluster, and their likely solutions. The solutions are listed below.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Likely solutions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database is being updated by an instance which is not part of the current cluster errors on a stand-alone</td>
<td>'Database is being updated by an instance which is not part of the current cluster' Error Message</td>
</tr>
<tr>
<td>Database is being updated by an instance which is not part of the current cluster errors on a cluster</td>
<td>Add multicast route, Check firewall</td>
</tr>
<tr>
<td>Cannot assign requested address on startup, featuring an IPv6 address</td>
<td>Prefer IPv4</td>
</tr>
<tr>
<td>Error in log: The interface is not suitable for multicast communication</td>
<td>Change multicast interface, Add multicast route</td>
</tr>
<tr>
<td>Multicast being sent, but not received (detectable with Multicast Test)</td>
<td>Check firewall, Check intermediate routers, Increase multicast TTL</td>
</tr>
<tr>
<td>Any issue not covered here</td>
<td>Contact support</td>
</tr>
</tbody>
</table>

Confluence cluster debugging tools

There is an umbrella issue opened for all cluster debugging tools here

It includes the tools listed below.

Multicast

- Which multicast address?

The multicast address and port used by Confluence can be found on the Cluster Administration page, or in confluence.cfg.xml in the Confluence home directory.

- Multicast address generation.

Confluence uses a hashing algorithm to take the inputted name during setup and it is then turned into a multicast address stored in the config file. Thus, once the initial setup is completed, Confluence will use the address this is the reason why user can change the address if needed, without actually changing the name. Consequently the additional nodes using the same multicast address specified in the config file are able to join the cluster.

Each node has a multicast address configured in the confluence-cfg.xml file
name="confluence.cluster.address">xxx.xx.xxx.xxx</property>

A warning message is displayed when an user changes the address from the one that Confluence has generated by the hashing of the name. There is no way of eliminating the message any other way other than by returning the address to the one that matches the cluster name. Purpose of the warning message is to remind the user that the address has been changed - as it is not the hashed version any longer - consequently the node can not join the cluster just by using the name. It is also necessary to provide the correct address as well.

**Mapping interface to IP address.**

To ensure that the interface name is mapped correctly, the following tool can be used. It shows the mapping of the interface name to the IP address.

```sh
C:\>java -jar list-interfaces.jar
interfaces.size() = 4
networkInterface[0] = name:lo (MS TCP Loopback interface) index: 1 addresses:
/127.0.0.1;

networkInterface[1] = name:eth0 (VMware Virtual Ethernet Adapter for VMnet8) index: 2 addresses:
/192.168.133.1;

networkInterface[2] = name:eth1 (VMware Virtual Ethernet Adapter for VMnet1) index: 3 addresses:
/192.168.68.1;

networkInterface[3] = name:eth2 (Broadcom NetXtreme 57xx Gigabit Controller - Packet Scheduler Miniport) index: 4 addresses:
/192.168.0.101;
```

**Debugging tools**

Listed below are some debugging tools that help determine what the status of the multicast traffic is:

<table>
<thead>
<tr>
<th>Tool</th>
<th>Information provided</th>
</tr>
</thead>
<tbody>
<tr>
<td>netstat -gn</td>
<td>Lists multicast groups. Does not work on Mac OS X.</td>
</tr>
<tr>
<td>netstat -rn</td>
<td>Lists system routing table.</td>
</tr>
<tr>
<td><strong>Multicast Test</strong></td>
<td>Coherence tool for testing multicast traffic from one node to another.</td>
</tr>
<tr>
<td>tcpdump -i interface</td>
<td>Captures network traffic on the given interface. Most useful on an interface that only receives cluster traffic.</td>
</tr>
</tbody>
</table>

**Add multicast route**

Multicast networking requirements vary across operating systems. Some operating systems require little configuration, while some require the multicast address to be explicitly added to a network interface before Confluence can use it.
If the Multicast Test tool shows that multicast traffic can't be sent or received correctly, adding a route for multicast traffic on the correct interface will often fix the problem. The example below is for a Ubuntu Linux system:

```
route add -net 224.0.0.0 netmask 240.0.0.0 dev eth0
```

To support multiple applications using multicast on different interfaces, you may need to specify a route specific to the Confluence multicast address.

Check firewall

Ensure your firewall allows UDP traffic on the multicast address and port used by Confluence.

Prefer IPv4

There's a known issue with IPv6, especially on Linux.

The fix is to add `-Djava.net.preferIPv4Stack=true` to JAVA_OPTS. This tells the JVM to try binding an IPv4 address first, and resort to IPv6 only if that fails.

Note: A more radical approach is to add `NETWORKING_IPV6=no` to `/etc/sysconfig/network`, yet probably should be left for a later consideration on a production machine.

Change multicast interface

Confluence might have selected the incorrect interface for multicast traffic, which means it cannot connect to other nodes in the cluster. To override the interface used for multicast traffic after initial setup, edit `confluence.cfg.xml` in the Confluence home directory and add a property (or change the existing one) to select your desired network interface. For example to tell Confluence to use `eth1`:

```
<property name="confluence.cluster.interface">eth1</property>
```

Increase multicast TTL

The multicast time-to-live (TTL) specifies how many hops a multicast packet should be allowed to travel before it is discarded by a router. It should be set to the number of routers in between your clustered nodes: 0 if both are on the same machine, 1 if on two different machines linked by a switch or cable, 2 if on two different machines with one intermediate router, and so on.

Create a file in the Confluence home directory called `tangosol-coherence-override.xml`. Add the following to it, setting the TTL value appropriately (1 is the default):

```
<?xml version='1.0'?>
<coherence>
  <cluster-config>
    <multicast-listener>
      <time-to-live system-property='tangosol.coherence.ttl'>1</time-to-live>
    </multicast-listener>
  </cluster-config>
</coherence>
```

Alternatively, simply start Confluence with the system property: `-Dtangosol.coherence.ttl=1`. Again, 1 is the default value, and you should change it to something appropriate to your network topology.

Check intermediate routers
Advanced switches and routers have the ability to understand multicast traffic, and route it appropriately. Unfortunately sometimes this functionality doesn't work correctly with the multicast management information (IGMP) published by the operating system running Confluence.

If multicast traffic is problematic, try disabling advanced multicast features on switches and routers in between the clustered nodes. These features can prevent multicast traffic being transmitted by certain operating systems.

For best results, use the simplest network topology possible for the cluster traffic between the nodes. For two nodes, that means a single network cable. For larger numbers, try using a single high-quality switch.

**Advanced Tangosol configuration**

If the solution to your problem involves changes to the Tangosol configuration, these changes should not be made to the Confluence configuration in confluence/WEB-INF/classes/. Instead, to ensure your configuration survives upgrades, make your changes via:

- Tangosol system properties
- creating a `tangosol-coherence-override.xml` file in the Confluence home directory.

Examples of making these changes are shown in the increasing the TTL section.

**Didn't find a solution?**

Check Related Articles from the Confluence Knowledge Base

- Confluence Cluster Installation
- Upgrading a Confluence Cluster
- Apache and Tomcat load balancing
- Confluence Clustering Overview
- Recommended network topology
- Changing Datasources Manually in a Cluster
- Cluster Troubleshooting
- Technical Overview of Clustering in Confluence
- Cluster safety mechanism
- Cluster Administration page
- Viewing and Editing License Details

Open JIRA Features and Bug Reports

**JIRA Issues (35 issues)**

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Assignee</th>
<th>Reporter</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
<th>Created</th>
<th>Updated</th>
<th>Due</th>
</tr>
</thead>
</table>
**CONF-2322**

Remove the option to store attachments on filesystem when using a cluster.

- **Unassigned**
- **Carlos Alberto Feijoo Schedler [Atlassian]**
- **Open**
- **Unresolved**
- **Sep 14, 2011**
- **Sep 15, 2011**

**CONF-2724**

Workbox (notifications and tasks) support for Confluence clustered.

- **Unassigned**
- **Chris Hubing**
- **Open**
- **Unresolved**
- **Nov 14, 2012**
- **Jul 15, 2013**

**CONF-1228**

Coherence cache fails while retrieving profile picture metadata (dashboard or

- **Unassigned**
- **Matt Ryall [Atlassian]**
- **Open**
- **Unresolved**
- **Jul 01, 2008**
- **Apr 05, 2011**
### Conf-14120

**Description:**
Hibernates Update Time Stamp Cache doesn't handle concurrent writes

**Assignee:**
Chris Kiehl

**Resolution:**
Open

**Status:**
Unresolved

**Created:**
Jan 05, 2009

**Modified:**
May 05, 2009

### Conf-9297

**Description:**
Confluence should be able to automatically recover from cluster panics

**Assignee:**
Gary Weaver

**Resolution:**
Open

**Status:**
Unresolved

**Created:**
Aug 27, 2007

**Modified:**
Apr 12, 2012

### Conf-8959

**Description:**
Attachment migration does not happen when upgrading to a cluster

**Assignee:**
Nicholas Ilacqua

**Resolution:**
Open

**Status:**
Unresolved

**Created:**
Jul 19, 2007

**Modified:**
Feb 25, 2013
<table>
<thead>
<tr>
<th>#</th>
<th>Title</th>
<th>Assigned To</th>
<th>Status</th>
<th>Created</th>
<th>Resolved</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-23033</td>
<td>Viewfile macro does not work in Confluence Cluster when Office Connector is configured to use Cache in Memory for temporary storage</td>
<td>Roy Hartono [Atlassian]</td>
<td>Unresolved</td>
<td>Aug 09, 2011</td>
<td>Oct 16, 2012</td>
</tr>
</tbody>
</table>
red instances

CONF-2050
A cluster panic should not bring down other nodes

CONF-1641
Installing a font for PDF export in a cluster will not carry to cluster nodes that are down or unavailable.

CONF-1708
Reindexing in cluster only runs on one node if triggered from web UI
Unassigned Anatoliy Kazatchkov [Atlassian] ↑ Unresolved Oct 01, 2009 May 12, 2010

CONF-1465
Retrieving the
Unassigned Chris Kiehl [Atlassian] ↑ Unresolved Feb 21, 2009 Nov 08, 2009
<table>
<thead>
<tr>
<th>Issue</th>
<th>Title</th>
<th>Description</th>
<th>Assignee</th>
<th>Op</th>
<th>Status</th>
<th>Created</th>
<th>Updated</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-1086</td>
<td>Node that cannot join cluster due to license restriction causes cluster panic</td>
<td>Unassigned</td>
<td>Ivan Benko [Atlassian]</td>
<td>Op</td>
<td>Unresolved</td>
<td>Feb 29, 2008</td>
<td>Sep 03, 2008</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>CONF-10325</strong></td>
<td>Viewing the members of a group in a clustered environment works only on one node and not the other.</td>
<td>Unassigned</td>
<td>Partha Kamal [Atlassian]</td>
<td>Open</td>
<td>Unresolved</td>
<td>Dec 27, 2007</td>
<td>Jul 02, 2009</td>
</tr>
<tr>
<td><strong>CONF-9594</strong></td>
<td>Conditional PropertySet's cannot be cached breaking cluster install</td>
<td>Unassigned</td>
<td>Dave Loeng [Atlassian]</td>
<td>Open</td>
<td>Unresolved</td>
<td>Sep 28, 2007</td>
<td>Jul 02, 2009</td>
</tr>
<tr>
<td>Issue</td>
<td>Description</td>
<td>Reporter</td>
<td>Status</td>
<td>Resolution</td>
<td>Created</td>
<td>Last Updated</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>----------</td>
<td>--------</td>
<td>------------</td>
<td>---------</td>
<td>--------------</td>
<td></td>
</tr>
<tr>
<td>CONF-9040</td>
<td>Authenticator (subclass of DefaultAuthenticator) can be called twice at almost exactly same time by 2 or more</td>
<td>Gary Weaver</td>
<td>Unassigned</td>
<td>Open</td>
<td>Jul 30, 2007</td>
<td>Nov 04, 2007</td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Status</td>
<td>Assignee</td>
<td>Created</td>
<td>Modified</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------</td>
<td>---------------------------</td>
<td>-------------</td>
<td>-------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-2521</td>
<td>Plugin installation breaks clustered cache</td>
<td>Unassigned</td>
<td>Thomas Krug</td>
<td>Apr 14, 2012</td>
<td>Apr 16, 2012</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Issue ID</td>
<td>Status</td>
<td>Created</td>
<td>Updated</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>--------</td>
<td>---------</td>
<td>---------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-2297</td>
<td>Migrating to a cluster with existing data does not add cluster attributes to the confluence.cfg.xml</td>
<td>Jul 27, 2011</td>
<td>Jul 28, 2011</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-2246</td>
<td>Content Permission changes are propagated between nodes one at a time, should be in bulk</td>
<td>May 09, 2011</td>
<td>May 10, 2011</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-2951</td>
<td>Confluence Cluster Installation with Existing Data no longer works.</td>
<td>Jun 03, 2013</td>
<td>Jun 03, 2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-2050</td>
<td>Upgrade the version of</td>
<td>Jul 30, 2010</td>
<td>Feb 24, 2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ticket</td>
<td>Summary</td>
<td>Assignee</td>
<td>Status</td>
<td>Created</td>
<td>Updated</td>
<td></td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>----------</td>
<td>--------</td>
<td>---------</td>
<td>---------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-1095</td>
<td>Support unicast addressing in cluster when well-known addresses WKA are defined</td>
<td>Ivan Benko [Atlassian]</td>
<td>Unresolved</td>
<td>Mar 06, 2008</td>
<td>Aug 25, 2009</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-1120</td>
<td>Confluence Clustered and JIRA trust delegation</td>
<td>Ivan Benko [Atlassian]</td>
<td>Unresolved</td>
<td>Mar 25, 2008</td>
<td>May 12, 2010</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-1387</td>
<td>After a site Import into a cluster, admin console displays attachment storage</td>
<td>Agnes Ro [Atlassian]</td>
<td>Unresolved</td>
<td>Nov 27, 2008</td>
<td>Sep 04, 2011</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Contact Atlassian support

We have dedicated staff on hand to support your installation of Confluence. Please follow the instructions for raising a support request and mention that you’re having trouble setting up your Confluence cluster.

Related

Cluster Safety Mechanism

Multicast Test

This page describes the Multicast Test, a Coherence tool for testing multicast traffic from one node to another. You may find this useful when troubleshooting a clustered installation of Confluence.

In order to run the Multicast test, you need to download the Coherence for Java from Oracle's website. You will need to sign up for a free Oracle account and sign the license agreement, before downloading the file.

The Multicast Test comes as a script called multicast-test, which you will find located in the bin folder in the above zip file.

Instructions on how to run this script file can be found in the Coherence documentation. You may like to go straight to the subheading called 'Example' in the guide, where there is an example on how to use the multicast-test script.

The Multicast Test will use the multicast address of 237.0.0.1:9000 by default. Confluence creates a unique address based on the cluster name that you enter during setup. As such, you should include the -group flag in your multicast testing to ensure your tests are broadcasting across the same address as your Confluence nodes.

The information on this page does not apply to Confluence OnDemand.

RELATED TOPICS

Cluster Troubleshooting

Confluence Clustering Overview

Clustering for Scalability vs Clustering for High Availability (HA)

People occasionally enquire about setting up High-Availability (HA) Confluence clusters. Confluence's clustering is designed to solve a different problem, that of scaling under high load. This page explains the difference.
What is High Availability (HA)?

HA means that your application will be available, without interruption. It's a very difficult thing to achieve, and is typically what people are talking about when they refer to five-nines availability.

In the context of application clustering, it means that any given node (or combination of nodes) can be shut down, blown up, or simply disconnected from the network unexpectedly, and the rest of the cluster will continue operating cleanly as long as at least one node remains. It requires that nodes can be upgraded individually while the rest of the cluster operates, and that no disruption will result when a node rejoins the cluster. It typically also requires that nodes be installed in geographically separate locations.

What does Confluence's clustering do, then?

Confluence's clustering system allows a single installation to serve a much greater number of concurrent requests than a single server. This is what we refer to as 'scaling under load'.

It does provide a certain amount of resilience, as the death of one node won't bring the other(s) down. However, it requires very low network latency, which rules out geographic separation of the servers, and upgrading can only be performed while the entire cluster is shut down. This doesn't mean that Confluence's clustering is buggy or broken. It simply reflects the difference between the two design aims.

So what kind of resilience can I build into a Confluence installation?

It's still entirely possible to build a resilient Confluence installation, using a 'cold-failover' approach in which two (or more) servers share a database and (normally) a network-mounted file system, where no more than one server is actually running at any given time.

Several different approaches are feasible, but the common elements are:

- a well-configured load balancer (session affinity is irrelevant in this case)
- a reliable monitoring system which can detect and shut down a misbehaving Confluence instance before starting the spare server
- startup scripts with added smarts to check for the presence of another running node before deciding whether to start up a server
- servers with the same view of both the database and the home directory.

It's vital to ensure that only one server is running at any one time, in this kind of setup. If a server starts while another is already running against the same database, the result will be a cluster panic that shuts down both servers.

A single database becomes the single point of failure in such a system. This can be alleviated by database clustering, or by replication from the 'active' database server to the standby server(s) if you wish to separate the failover systems while keeping database latency to a minimum.

In the same vein, the home directory can be hosted on a shared network system — SAN or NAS, preferably with its own replication/rapid recovery system — though there's a known issue to consider. Alternatively, to avoid the
use of networked file systems, a utility such as rsync can be used to periodically bring the spare servers’ home directories up to date, so long as you keep the period sufficiently short — probably between one and five minutes, depending on the rate of activity. This can be avoided altogether by keeping attachments in the database; it increases the demands on the bandwidth between the application and database servers, but guarantees that the system is in a consistent state at switchover. If the data is at all sensitive or confidential, it’s advisable to run rsync over ssh, to minimise the opportunity for the data to be captured on its way across the network.

What's the difference between load balancing and failover?

Load balancing means that all servers are active, and new requests are distributed among them. Several strategies are available, but the most common are:

- **round-robin** — the first request goes to the first server, the second request goes to the second server, and so on. When you run out of servers, the next request goes to the first server, and around it goes again.
- **percentage-based** — if (for example) you have two servers, and one can handle twice the load of the other, you can tell the load balancer to send two requests to the stronger server for every request that goes to the weaker one.
- **availability** — the load balancer sends a test query to each of the servers every second or so, and directs each new request to the server that's currently responding the fastest.

Failover means that only one server is active at any given time, and normally involves two servers (any number of servers may be involved, depending on the system). If the active one stops responding, requests are directed to the other server — the system ‘fails over’ to the second one.

‘Cold failover’ means that the second server is only started up after the first one has been shut down. This is the case for non-clustered Confluence.

‘Hot failover’ or ‘hot standby’ means that all servers are running at all times, and that the load is directed entirely toward one server at any one time.

A load balancer can be used in both scenarios, especially if it's smart enough to keep track of which servers are currently running.

Failover can also be managed via DNS, in a sufficiently well-controlled environment.

What do you mean by 'session affinity'?

Sessions consist of several transmissions in each direction between the client (browser) and the server. Session affinity means that the load balancer keeps track of which server received the initial transmission from a given browser, and that it will then send any subsequent requests from that browser to the same server.

This is necessary with Confluence clustering, in particular, because sessions are not shared across cluster nodes. If you log into one node and then send a request to another, the other node will send you the login screen because it doesn't recognise your session cookie.

RELATED TOPICS

Confluence Clustering Overview
Recommended network topology

Atlassian recommends a network topology similar to the one shown below, to get the best results from a Confluence Clustered deployment.

The number of Confluence nodes in the deployment is adjustable — select the number which suits your own requirements.

The most important aspect is that cluster, database and HTTP (client) traffic are all carried on separate subnets. It is possible, on a sufficiently fast network, to carry cluster and database traffic on the same subnet but we do strongly recommend that HTTP traffic be always confined to a separate subnet on production deployments.
Confluence Clustered does not support clustered communication over WAN, VLAN or VPN. All Confluence Clustered nodes must be on the same local subnet, ideally networked via an ethernet hub or simple switch. The cluster communication network must also support multicast IP networking.

⚠️ *The information on this page does not apply to Confluence OnDemand.*

✔️ **Use this example as a basis for your own network diagram**

When you are considering a Confluence Clustered deployment, you should prepare a network diagram like the one on this page. This will facilitate discussion with Atlassian Support and help with your own planning. Please refer to the cluster checklist for more guidance on planning your clustered deployment.
Cluster Administration page

Overview

Any instance of Confluence which uses a clustered license has a Cluster Configuration page which includes information about the active cluster.

To open the Cluster Administration page:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click 'Cluster Configuration' in the left-hand menu, in the section called 'Clustering'.

⚠️ The information on this page does not apply to Confluence OnDemand.
On this page:
- Overview
- Availability

Related pages:
- Overview of Confluence Clusters
- Confluence Cluster Installation
- Cluster Troubleshooting

Availability

To access this functionality, you must:

- Be a System Administrator (i.e. have global System Administrator permissions), and
- be using Confluence 2.3 or later, and
- be using a clustered Confluence license.

The 'Cluster Administration' page shows your cluster configuration, and allows you to start a new Confluence cluster using data from this instance.

Cluster Status indicates whether your cluster is currently running.

Licensed nodes is the maximum number of instances of Confluence your license allows in a cluster.

Active nodes lists the instances of Confluence currently participating in the cluster.

Starting a new cluster will perform the following changes:

- enable a clustered cache
- migrate attachments from file system to the database
- publish database connection information so other nodes can join the cluster.

ℹ️ All access to Confluence will be locked while this takes place, and you will be forced to restart Confluence afterwards.

Cluster name is a short name for identifying your cluster. Other Confluence instances can join the cluster using this name.

ℹ️ To join an existing cluster, start a clean copy of Confluence on this node and select 'Join Cluster' during the setup wizard.

Cluster Checklist

It is possible to run Confluence in a clustered environment instead of on a single server. This means that you can run multiple copies of Confluence in a cluster, so that clients (such as a browser) can connect to any copy and see the same information.

Refer to the clustering overview for more information and a list of related pages about clustering Confluence.

Note: Consider your options carefully before deciding on a clustered installation. While we have tried to make clustering Confluence as easy and administrator-friendly as possible, it is a major architectural change and requires extra planning for deployment and upgrades. Please consider the information below and then consult Atlassian Sales before making your final decision.

Purpose of this Document

The purpose of this cluster checklist is to help you:
Decide whether Confluence Clustered is the right solution for you.
Create a plan for your clustered deployment.

If you need to raise a support request with Atlassian during or after cluster deployment, we will need to ask you questions about your configuration. It will save crucial time if you can provide us with your deployment plan.

For more information about clustering Confluence, refer to the clustering overview.

Assumed Knowledge

In writing this document, we have assumed that our readers have an in-depth knowledge of the following technical areas:

- Database
- Networking
- Application servers
- Load balancers

Before starting a clustered deployment please read the information on this page carefully, as well as the linked documentation, to assess if you have the assumed knowledge.

On this page:

- Purpose of this Document
- Assumed Knowledge
- General Considerations
- Server Setup
- Database Setup
- Network Setup
- Staging Environment

Related pages:

- Running Confluence in a Virtualised Environment
- Confluence Cluster Installation
- Confluence Clustering Overview
- Recommended network topology
- Apache and Tomcat load balancing
- Confluence Administrator's Guide

⚠️ The information on this page does not apply to Confluence OnDemand.

General Considerations

What will Confluence Clustered do for you?

The points in this section of the page will help you evaluate your reasons for considering a clustered deployment, and then decide whether Confluence Clustered is the right solution for your environment.

Confluence Clustered is designed to scale the number of simultaneously connected users at a much better performance than what a single node can achieve.

Confluence Clustered will not improve performance in systems with few users.

Clustering Confluence means that user requests can be served by independent machines. The performance gains are substantial, and have improved a lot further since Confluence 3.0. Clustering is especially great in dealing with spikes to the load, e.g. during certain hours of business. Just note that if rendering a complicated
Confluence Clustered is not a high availability solution.

Confluence Clustered is not designed specifically to provide a high availability solution.

General availability is higher in a Confluence cluster than on a single installation, you can for example take one node down for minor maintenance tasks e.g. when adding a new CPU or adding RAM. But you still have to bring down all nodes at the same time for software upgrades. Also there are certain conditions, like loss of network connectivity between nodes ('split brain'), that will result in the cluster shutting itself down. Confluence Clustered offers higher reliability, but not high availability.

Confluence Clustered is not for disaster recovery nor for transparent failover.

If one node crashes, there is no transparent failover for the connected client. Also, our network requirements (see below) make Confluence unsuitable for deployment to different cities or even to different buildings.

Server Setup

The number of supported cluster nodes is limited to four.

⚠️ Not supported. In theory, you can connect more than four nodes — but that is not covered by Atlassian Support.

All cluster nodes must have the same version of OS, application server, etc.

Confluence requires a homogeneous environment. All Confluence cluster nodes must have the same version the following:

- Operating system
- CPU
- Installed memory
- Java
- Application server

⚠️ Note that 'same version' means 'same to the last digit'. For example, Java v1.4.2_16 is not the same as v1.4.2_15

🟢 We strongly recommend user to have the same memory configuration (both the JVM and the physical memory) because a cluster uses a replicated cache. A replicated cache requires the same amount of memory on each node in the operating cluster. The memory allocations must be equal.

Use good and up-to-date hardware.

While the details are up to you, we strongly suggest that your servers have at least 4GB of physical RAM. A high number of concurrent users means that a lot of RAM will be consumed. You usually don't need to assign more than 4GB per JVM process, and most of the time even just 1GB or 2GB will be fine, you should just be prepar to fine tune the settings.

Confluence should be the only application on the cluster servers.

No additional applications (other than core operating system services) should be running on the same servers Confluence.

Since your goal should be increased capacity and performance, you should not risk this by running any other process on the machine with a Confluence Clustered node. While it may be fine to run JIRA, Confluence and Bamboo on a dedicated Atlassian software server for small installations, it is strongly discouraged for clustering Confluence.

Do not upgrade and switch to Confluence Clustered at the same time

If you plan to migrate to a clustered solution, make sure you are migrating within the same version of Confluence. If you plan to upgrade to a higher version of Confluence, do this before the migration to the clustered version.

For example, if you are currently running Confluence 2.9.2, and want to roll out the clustered version of
Confluence 3.0, you must first upgrade to Confluence 3.0 and check that everything works fine (e.g. by running and monitoring your production system for a week). Then you are in a good position to migrate to the clustered version.

**Database Setup**

Run the database on its own physical server.

You are optimising for performance, so you don't want the database to slow down your application servers, or vice versa. In high load scenarios, the database may need to have better hardware than the application server to be able to handle all requests. You should find out by performing load testing.

Attachments must be stored in a database and not the local file system

Storing attachments in the database is the only supported attachment storage configuration for clustering Confluence.

Make sure that you use a supported version of a database server to store Confluence's data.

Please check that your intended database is officially supported by Atlassian Confluence. The load on an average cluster solution is higher than on a single box installation, and it is therefore even more crucial to use the right database vendor and version.

Your database must be provisioned to store a large volume of binary data.

Note that Confluence clustered stores file attachments in the database, and you need an experienced DBA who can monitor and manage the data growth.

You need an experienced DBA available to troubleshoot database performance issues.

Not having an experienced full-time DBA at hand at short notice when entering the realm of high load is dangerous. While small installations of Confluence basically work 'out of the box', anything that involves high load and a lot of database space requires continual monitoring, optimising and fine tuning of the Confluence database. When we ramp up the load on our loadtesting environment, we see that database usage goes up a well. Having powerful hardware in place helps, but if there are queries that become inefficient with you particu load pattern, you need an expert to tune it. As an example, we have seen PostgreSQL switch its internal caching mechanism when a particular table reached a certain size, which resulted in a drop of performance by about 200ms per request. This happened from one second to the other. Being able to troubleshoot and then fi issues like these is important in any enterprise system, but it is even more in a high load scenario.

**Network Setup**

We recommend hardware load balancers or putting a software loadbalancer onto its on server.

If you use a software load balancer (which is fine except for really extreme installations), it must be deployed a machine of its own. Running a software load balancer on a cluster node is not supported. If a node unexpectedly got overwhelmed by a spike in load, a load balancer on that node would turn unresponsive. As a result, your whole cluster would be inaccessible even though the other nodes would be available. So using a different server is common practice and common sense.

Use separate network adapters for communication between servers.

The Confluence cluster nodes should have a separate physical network (i.e. separate NICs) for inter-server communication.

This is the best way of getting the cluster to run fast and reliably. Performance problems are likely to occur if y connect cluster nodes via a network that has lots of other data streaming through it.

The switch connecting the Confluence cluster nodes must not be a 'smart switch'.

⚠️ **Not supported.** Smart switches are not covered by Atlassian Support for Confluence Clustered.

Do not use smart switches between cluster nodes. Many problems have been reported and attributed to smar switches. They have a tendency to interrupt broadcast or multicast traffic, thus reliably killing a cluster after a certain amount of time has passed. This makes troubleshooting especially complex and tedious.

Cisco switches need additional configuration.

If the switch connecting the Confluence cluster nodes is a Cisco switch then it might need additional configuration to support Confluence clustering.
Please make sure you find out all the details about your switches before you start the deployment. It is recommended that the database is on a different physical network from the Confluence server nodes.

Since you want to increase your capacity and performance for high loads, it is recommended to have your database on a different network. Please refer to the recommended topology diagram for more information. Minimize the latency between the Confluence cluster nodes and the database. Even though having the nodes and the database on the same physical network usually suffices, you should take the time to explicitly measure network latency, and make sure it is as close to zero as possible.

Prepare a network diagram.

To facilitate discussion and to ease planning, you should prepare a network diagram like this example of recommended network topology.

If you request support with Confluence Clustered, we may ask for your network diagram. We recommend that you create one similar to our example before you proceed with the installation.

You need network support staff available to troubleshoot cluster communication issues.

Setting up a cluster is not trivial. Even small problems in network design will be expanded in a clustered installation. (This is true of any kind of software.)

It is absolutely vital that you have dedicated network staff available to track down problems when they arise. A cluster will usually be used by thousands of users, and you don't want to keep them waiting because a network card breaks, or because someone made an undocumented change to the network and you don't have an expert around who can figure it out.

**Staging Environment**

You need a staging environment that is exactly the same as your production system.

You must be able to test drive any change to the cluster (installing upgrades, installing plugins) and to perform other tests (checking connectivity, debugging problems) on a staging cluster.

The staging environment must be:

- On the same OS, database, and Java version as your production environment.
- Clustered.

If you require support, we may for example ask you to turn off certain third-party plugins. If you can't do this in your production environment and you don't have a staging environment for troubleshooting, we may not be able to help you.

**Performance Tuning**

This document describes tuning your application for improved performance. It is not a guide to troubleshooting Confluence outages. Check Troubleshooting Confluence Hanging or Crashing for help if Confluence is crashing.

**Description**

Like any server application, Confluence may require some tuning as it is put under heavier use. We do our best to make sure Confluence performs well under a wide variety of circumstances, but there's no single configuration that is best for everyone's environment and usage patterns.

If you are having problems with the performance of Confluence and need our help resolving them, you should read Requesting Performance Support.

**Use the latest version of your tools**

Use the latest versions of your application servers and Java runtime environments. Newer versions are usually better optimized for performance. As an example, our internal performance tests show a 20% speed-up (when viewing pages under load) between Tomcat 6 on Java 6 vs Tomcat 5.5 on Java 5 out of the box.

**Avoid swapping due to not enough RAM**
Always watch the swapping activity of your server. If there is not enough RAM available, your server may start swapping out some of Confluence's heap data to your hard disk. This will slow down the JVM's garbage collection considerably and affect Confluence's performance. In clustered installations, swapping can lead to a Cluster Panic due to Performance Problems. This is because swapping causes the JVM to pause during Garbage Collection, which in turn can break the inter-node communication required to keep the clustered nodes in sync.

### On this page:

- Description
- Use the latest version of your tools
- Avoid swapping due to not enough RAM
- Being aware of other systems using the same infrastructure
- Choice of database
- Database connection pool
- Database in general
- Database indexes
- Database statistics and query analysers
- Cache tuning in Confluence and Apache
- Antivirus software
- Enabling HTTP compression
- Virtual operating systems
- Performance testing
- Access logs
- Built-in profiler
- Application server memory settings
- Web server configuration
- Parallel GC
- Troubleshooting possible memory leaks
- Plugins

⚠️ **The information on this page does not apply to Confluence OnDemand.**

### Being aware of other systems using the same infrastructure

It may sound tempting: Just have one powerful server hosting your database and/or application server, and run all your crucial programs on that server. If the system is set up perfectly, then you might be fine. Chances are however that you are missing something, and then one application's bug might start affecting other applications. So if Confluence is slow every day around noon, then maybe this is because another application is using the shared database to generate complicated reports at that time? Either make sure applications can't harm each other despite sharing the same infrastructure, or get these systems untangled, for example by moving them to separate instances that can be controlled better.

### Choice of database

The embedded database that is provided with Confluence is meant only to be used for evaluation, not for production Confluence sites. After the evaluation finishes, you will certainly need to switch to an external relational database management system. Beyond this, we do not recommend any particular RDBMS over another. We recommend using what you are familiar with, because your ability to maintain the database will probably make far more difference to what you get out of it than the choice of database itself.

### Database connection pool

If load on Confluence is high, you may need more simultaneous connections to the database.
If you are using JNDI data-sources, you will do this in your application server’s configuration files. If you have configured Confluence to access the database directly, you will need to manually edit the hibernate.c3p0.max_size property in the confluence.cfg.xml file in your confluence.home directory. After you have changed the URL in this file, restart Confluence.

To assess whether you need to tune your database connection pool, take thread dumps during different times (including peak usage). Inspect how many threads have concurrent database connections.

Database in general

If Confluence is running slowly, one of the most likely cause is that there is some kind of bottleneck in (or around) the database.

The first item you should check is the "Database Latency" field in the System Information tab in the admin console.

The latency is calculated by sending a trivial request to the database, querying a table which is known to have only one column and one row. ("select * from CLUSTERSAFETY"). Obviously this query should be blazing fast, and return within 1 or 2 milliseconds. If the value displayed is between 3 and 5 milliseconds, you might already have an issue. If the value is above 10ms, then you **definitely** need to investigate and improve something! A few milliseconds may not sound so bad, but consider that Confluence sends quite a few database queries per page request, and those queries are a lot more complex too! High latency might stem from all sorts of problems (slow network, slow database, connection-pool contention, etc), so it's up to you to investigate. Don't stop improving until latency is below 2ms on average.

Obviously, latency is just the very first thing to look at. You may get zero latency and still have massive database problems, e.g. if your tables are poorly indexed. **So don't let a low latency fool you either.**

Database indexes

Especially if you have more than a few thousand active users, and all most obvious measures have been tried out but the database still seems to be under high load, you should consider engaging a database administrator (DBA) to tune the database specifically to the demands that your particular Confluence installation is placing on it. If you do not have a full-time DBA and can't even get one for temporary consulting, you may want to consult the database indexing advice that we have been gathering from customer reports and our own experience running and developing Confluence. The instructions on that page are for Oracle, but most of the indexes can be applied to (and will help with) any database.

(These database indexes are now created automatically when Confluence is installed, but existing installations upgrading to a more recent version may still need to add them manually)

Database statistics and query analysers

Modern databases have query optimisers based on collecting statistics on the current data. Using the SQL EXPLAIN statement will provide you information on how well the query optimiser is performing. If the cost estimate is wildly inaccurate then you will need to run statistics collection on the database. The exact command will depend on your database and version. In most cases you can run statistics collection while Confluence is running, but due to the increased load on the database it's best to do this after normal hours or on a week-end.

Cache tuning in Confluence and Apache

To reduce the load on the database, and speed up many operations, Confluence keeps its own cache of data. Tuning the size of this cache may speed up Confluence (if the caches are too small), or reduce memory (if the caches are too big).
Please have a look at our documentation on Cache Performance Tuning for information on how to tune Confluence caches.

To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.

Antivirus software

Antivirus software greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental, and may even cause errors with Confluence. You should configure your antivirus software to ignore the Confluence home directory, its index directory and any database-related directories.

Enabling HTTP compression

If bandwidth is responsible for bottlenecking in your Confluence installation, you should consider enabling HTTP compression. This may also be useful when running an external facing instance to reduce your bandwidth costs.

Take note of the known issues with HTTP compression in versions of Confluence prior to 2.8, which may result in high memory consumption.

Virtual operating systems

Virtual Environments such as VMWare can cause Confluence CPU to spike. Run Confluence on a native OS. Refer to the list of supported operating systems for Confluence in the Supported Platforms topic.

**Note:** In some situation the VMTools can crash, cause a excessive context switches and interrupts causing the JVM to run slowly and Confluence to start up very slowly.

Performance testing

You should try out all configuration changes on a demo system. Ideally, you should run and customize loadtests that simulate user behaviour. Learn about how to test performance issues using the Performance Testing Scripts.

Access logs

You can find out which pages are slow and which users are accessing them by enabling Confluence's built-in access logging.

Built-in profiler

You can identify the cause of page delays using Confluence's built-in profiler according to Troubleshooting Slow Performance Using Page Request Profiling.

Application server memory settings

See How to Fix Out of Memory Errors by Increasing Available Memory.

Web server configuration

For high-load environments, performance can be improved by using a web server such as Apache in front of the application server. There is a configuration guide to Running Confluence behind Apache.

When configuring your new web server, make sure you configure sufficient threads/processes to handle the load. This applies to both the web server and the application server connector, which are typically configured separately. If possible, you should enable connection pooling in your web server connections to the application server.
Parallel GC

If you have multiple CPU's on your server, you can add -XX:+UseParallelOldGC to your JAVA_OPTS options. This will allow garbage collection of the Tenured Space to happen in parallel with the application and can boost performance and can reduce slow performance spikes. For more information, please refer to our detailed page on Garbage Collector Performance Issues, and Sun's summary of collectors.

Troubleshooting possible memory leaks

Some external plugins, usually ones that have been written a long time ago and that are not actively maintained anymore, have been reported to consume memory and never return it. Ultimately this can lead to a crash, but first this manifests as reduced performance. The Troubleshooting Confluence Hanging or Crashing guide is a good place to start. Some of the known causes listed there could result in performance issues short of a crash or hang.

Plugins

Some 3rd-party plugins were not written to scale to large enterprises' needs.

Confluence has been optimized to work under high load and with many pages. Some 3rd party plugins however have been written with small size companies in mind, and can't cope with large numbers of concurrent users, or large numbers of pages and permissions, or large numbers of spaces. It is impossible to tell which ones will fail under which conditions, but it will always help to turn off 3rd-party plugins that are not strictly mission-critical while investigating performance issues.

**RELATED TOPICS**

- Garbage Collector Performance Issues
- Cache Performance Tuning
- Cache Performance Tuning for Specific Problems
- Performance Testing Scripts
- Working with Confluence Logs
- Operating Large or Mission-Critical Confluence Installations
- Confluence Clustering Overview
- Requesting Performance Support
- Confluence Administrator’s Guide
- Configuring Confluence
- Cache Performance Tuning

Confluence performance can be significantly affected by the performance of its caches. It is essential for the administrator of a large production installation of Confluence to tune the caches to suit its environment. There are several configurable parameters for each of the cache regions, most notably cache size, cache expiry delay and eviction policy. In the majority of the cases, cache size is the parameter you would want to change. Fortunately, from Confluence 3.0, it is very easy to adjust cache sizes through the Administration Console. However, if you need to modify parameters other than a cache size, you would need to modify the relevant configuration files manually.

The cache performance information for your Confluence installation is available under Administration > Cache Statistics. For more information about the numbers displayed on that screen, see Cache Statistics.

**Notes:**

- To improve performance of a large Confluence site, we recommend that you move the caching of static content from the JVM into Apache. This will prevent the JVM from having a number of long running threads serving up static content. See Configuring Apache to Cache Static Content via mod_disk_cache.
- If you only need to modify Confluence's maximum cache sizes, you can do this through the Cache Statistics feature of the Administration Console.
Cache tuning example

As an example of how to tune Confluence's caches, let's have a look at the following table:

<table>
<thead>
<tr>
<th>Caches</th>
<th>% Used</th>
<th>% Effectiveness</th>
<th>Objects/Size</th>
<th>Hit/Miss/Expiry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments</td>
<td>87%</td>
<td>29%</td>
<td>874/1000</td>
<td>78226/189715/187530</td>
</tr>
<tr>
<td>Content Attachments</td>
<td>29%</td>
<td>9%</td>
<td>292/1000</td>
<td>4289/41012/20569</td>
</tr>
<tr>
<td>Content Bodies</td>
<td>98%</td>
<td>81%</td>
<td>987/1000</td>
<td>28717/6671/5522</td>
</tr>
<tr>
<td>Content Label Mappings</td>
<td>29%</td>
<td>20%</td>
<td>294/1000</td>
<td>4693/18185/9150</td>
</tr>
<tr>
<td>Database Queries</td>
<td>96%</td>
<td>54%</td>
<td>968/1000</td>
<td>105949/86889/83334</td>
</tr>
<tr>
<td>Object Properties</td>
<td>27%</td>
<td>18%</td>
<td>279/1000</td>
<td>5746/25386/8102</td>
</tr>
<tr>
<td>Page Comments</td>
<td>26%</td>
<td>11%</td>
<td>261/1000</td>
<td>2304/17178/8606</td>
</tr>
<tr>
<td>Users</td>
<td>98%</td>
<td>5%</td>
<td>982/1000</td>
<td>6561/115330/114279</td>
</tr>
</tbody>
</table>

The caches above are of size 1000 (meaning that it can contain up to 1000 objects), which is the default size for caches in the default cache scheme. Refer to Confluence Cache Schemes for more explanation.

You can tell when a cache size needs to be increased because the cache has both:

- a high usage percentage (above 75%)
- a low effectiveness percentage.

Check the 'effectiveness' versus the 'percent used'. A cache with a low percent used need not have its size lowered; it does not use more memory until the cache is filled.

Based on this, the sizes of the "Attachments", "Database Queries", and "Users" caches should be increased to improve their effectiveness.

As the stored information gets older or unused it will expire and be eliminated from the cache. Cache expiry may be based on time or on frequency of use.

There is not much that you can do with a cache that has both a low percentage of usage and effectiveness. Over time, as the cache is populated with more objects and repeat requests for them are made, the cache's effectiveness will increase.
Finding the configuration file

The caches are configured in `ehcache.xml` (for standard editions) or `confluence-coherence-cache-config-clustered.xml` (for clustered editions) which is stored in `<confluence-home>/config/`.

Oracle Coherence Licensing Change:

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).

  - **Important:** If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.

- For more information about these changes, please refer to the Coherence License Changes document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the Confluence 3.0.1 Upgrade Notes for additional upgrade information.

Cache key mappings

The cache configuration file configures caches by their keys. When you move your mouse over the the cache names displayed on the cache statistics page, a tooltip will indicate the actual cache key for that cache name.

| Users | com.atlassian.user.impl.hibernate.DefaultHibernateUser |

The information on this page does not apply to Confluence OnDemand.
Using our example from the table above, if we were to modify parameters for the Users cache we would need to change the cache with the key com.atlassian.user.impl.hibernate.DefaultHibernateUser. Do not get confused with Users (External Mappings) and Users (External Groups) which are in themselves, two separate caches. "Users" is the friendly name for com.atlassian.user.impl.hibernate.DefaultHibernateUser.

**Standard editions of Confluence**

In standard editions of Confluence, the caching layer is Ehcache.

**Understanding the Ehcache configuration file**

For more information about the Ehcache configuration file and a full reference on Ehcache configuration, please refer to the Ehcache configuration documentation.

**Converting your Coherence configuration to Ehcache**

This section only applies to customers who:

- Have an installation of Confluence that was downloaded before the 4th of September 2009.
- Intend to (or have already) upgraded to Confluence 3.0.1 or later (or to Confluence versions 2.6.3, 2.7.4, 2.8.3, 2.9.3 and 2.10.4).
- Will use a non-clustered Confluence license for the Confluence upgrade.
- Have implemented customisations to their Confluence installation's cache configuration file (confluence-coherence-cache-config.xml).

To maintain your existing cache configuration file settings, you will need to transfer any cache customisations you have implemented in the Coherence cache configuration file (confluence-coherence-cache-config.xml) to the relevant entries in the Ehcache cache configuration file (ehcache.xml).

Each cache has a cache-mapping element in the Coherence file (of which there is an equivalent cache element in the ehcache.xml file). Unfortunately, copying across your customisations is not quite a straightforward process because the Coherence file defines several 'caching schemes' to store the actual cache values, which in turn are referenced by the cache-mapping elements. In contrast, the ehcache.xml file does not support caching schemes and a cache's values are expressed explicitly in separate parameters of a cache element.

To convert your Coherence cache configuration file customisations across to the equivalent Ehcache file:

1. Open both the confluence-coherence-cache-config.xml and ehcache.xml files in a text editor. These files are located in the <confluence-home>/config directory.

   - If you implemented your customisations in a version of Confluence prior to 3.0, you will most likely find the confluence-coherence-cache-config.xml file in the <confluence-install>/confluence/WEB-INF/classes directory.

2. In the customised confluence-coherence-cache-config.xml file:

   a. Identify the caching schemes that were customised in this file and make a note of the values of all its child elements.

      - Typically, each caching scheme is located inside a local-scheme element and all of these are enclosed within the cache-schemes element, which appears towards the end of this file.

   b. Note each customised caching scheme by the content of its scheme-name element.

   c. For each cache-mapping element (which typically appears towards the top of this file), identify if it has a scheme-name element whose content matches one noted in the previous step and if so, make a note of its associated cache-name element.

3. In the ehcache.xml file:
a. Identify each cache element whose ‘name’ parameter matches the cache-name elements noted in step ‘2c’.

b. Using the mappings table below, apply the values noted in step ‘2a’ to the appropriate parameters of the cache elements identified in the previous step (‘3a’).

Mappings table showing how elements of the Coherence cache configuration file map to parameters of the equivalent Ehcache file.

<table>
<thead>
<tr>
<th>Coherence Element</th>
<th>Ehcache Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>high-units</td>
<td>maxElementsInMemory</td>
</tr>
<tr>
<td>expiry-delay &gt; 0s</td>
<td>timeToIdleSeconds - Use this attribute for expiry delays greater than 0s along with the eternal attribute set to ‘false’</td>
</tr>
<tr>
<td>expiry-delay = 0s</td>
<td>eternal - For expiry delays of 0s, set this attribute to ‘true’.</td>
</tr>
</tbody>
</table>

Clustered editions of Confluence

Understanding the Coherence configuration file

The Coherence configuration file is a mapping of cache keys to cache schemes. Each cache scheme controls the expiry, eviction policy and size of the caches linked to it. A cache scheme can extend another scheme.

For a full reference, see the Oracle’s Coherence cache configuration documentation.

Defining caching scheme mappings in Coherence cache config file

If a cache key does not have an explicit definition in the caching scheme mappings (defined in confluence-coherence-cache-config.xml) then it will use the “default” cache-mapping.

In our example, com.atlassian.user.impl.hibernate.DefaultHibernateUser is not explicitly defined in the caching scheme mappings. Hence to increase the expiry-delay to 2 hours, we will need to define the mapping ourselves and add the following within the <caching-scheme-mapping> tags:

```xml
<cache-mapping>
  <cache-name>com.atlassian.user.impl.hibernate.DefaultHibernateUser</cache-name>
  <scheme-name>cache:com.atlassian.user.impl.hibernate.DefaultHibernateUser</scheme-name>
</cache-mapping>
```

Then we will need to define a cache schema with name cache:com.atlassian.user.impl.hibernate.DefaultHibernateUser within <caching-schemes> tags.
It's possible to define a local-scheme mapping for a cache key without defining certain parameters (e.g. `<high-units>`). In such a case, their parameters will be inherited from scheme-ref scheme, which is the default scheme in our case.

**Important caches**

The following suggestions are general guidelines. In cases of large databases, 20-30% of the size of the table may be unnecessarily large. Check the effectiveness and Percent Used categories in the cache for more specific assessments.

- `com.atlassian.confluence.core.ContentEntityObject` (known as Content Objects cache) should be set to at least 20-30% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `select count(*)` from `CONTENT` where `prevver` is null.

- `com.atlassian.confluence.core.ContentEntityObject.bodyContents` (known as Content Body Mappings cache) should be set to at least 20% of the number of content entity objects (pages, comments, emails, news items) in your system. To find the number of content entity objects, use the query `select count(*)` from `CONTENT` where `prevver` is null.

- `com.atlassian.confluence.security.PermissionCheckDispatcher.isPermitted()` (known as User Authorized URLs cache) should be set to at least the number of concurrent users you expect to access Confluence at the same time.

- `com.atlassian.user.impl.hibernate.DefaultHibernateUser` (known as Users cache) should be set to the number of users you have: `select count(*)` from `users`. Note that by default, this will also control the LDAP user's cache, including expiration.

- `com.atlassian.confluence.security.SpacePermission` (known as Permissions cache) should be set to the number of space permissions in your deployment (a good rule of thumb is 20 times the number of spaces). You can find the number of space permissions using the query `select count(*)` from `SPACEPERMISSIONS`.

**Cache tuning follow-up**

After you have made changes to your cache config, doing a follow up on the changes in the next week or after the expected performance spike would be important.

Make sure that you take a screenshot of the cache statistics before and after the change. Then compare them with the cache statistics in the later period where performance improvement is expected.

**Notes**

You can monitor what's in the cache by using a JSP included in the Confluence distribution. Browse to `<base-URL>/admin/cachecontents.jsp` to monitor the cache contents.
Cache Performance Tuning for Specific Problems

The following are more specific performance problems that can be resolved from tuning the cache.

LDAP cache sizes and expiry does not appear to be picked up.

This is a known problem, please refer to CONF-11858 for the solution.

⚠️ The information on this page does not apply to Confluence OnDemand.

"Edit Page" screen takes a long time to load

If your installation of Confluence is suffering from this problem, it may be due to insufficient SpacePermissions cache size. To address this problem, first determine the number of space permission objects in your Confluence instance. You can do this by running this query against your database:

```sql
> select count(*) from SPACEPERMISSIONS
```

Now locate the cache entry for SpacePermissions in your `confluence-coherence-cache-config.xml`:

```xml
<local-scheme>
  <scheme-name>cache:com.atlassian.confluence.security.CachingSpacePermissionManager.permissions</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
  <expiry-delay>0s</expiry-delay>
</local-scheme>
```

Adjust the `maxElementsInMemory` or `high-units` property to the number of space permissions you have (in the example above, I've used 10000). Also, just as important, you need to adjust the `timeToLiveSeconds` or `expiry` property to 0.

**Note:** 10K of space permissions consumes approximately 8MB of memory. Please ensure there is enough memory allocated to your instance to cater for this.

How to set specific cache settings

1. Find the cache name from the cache name mappings:
   - For Confluence 2.5.x and earlier, the cache name mappings are in file `confluence/WEB-INF/classes/com/atlassian/confluence/admin/actions/cache-name-mappings.properties`.
   - For Confluence 2.6.0 and later, you will find the cache name mappings in the file `com/atlassian/confluence/core/ConfluenceActionSupport.properties` which is packed into the `confluence-2.x.*.jar` file.

2. Find the appropriate `<cache-mapping>` tag in `confluence-coherence-cache-config.xml` or `confluence-coherence-cache-config-clustered.xml`. If the tag doesn't exist, you can create it within the `<caching-scheme-mapping>` tag.

3. The `<scheme-name>` will correspond to a `<local-scheme>` tag below. It refers to a scheme reference. Either change the high-units tag in the scheme reference, or add a high-units tag to override the scheme reference. For example, the following tag would change the Content Bodies cache from the default 1000 units to 2000 units:

⚠️ Attached to this page are corrected copies of `confluence-coherence-cache-config.xml` and `confluence-coherence-cache-config-clustered.xml`. These are updated from a bug CONF-11857.
Another popular cache to change is the LDAP related User cache:

```xml
<local-scheme>
  <scheme-name>user</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>
```

4. After updating the appropriate file, you do not need to repack it into the jar to use it. You can simply place the file in your `confluence/WEB-INF/classes/` directory. The file in this directory will override the settings in your jar file. If you want to back out the changes, you only need to remove the file from your `confluence/WEB-INF/classes/` directory — then the default values in the `confluence-coherence-cache-config.xml` located in your jar file will apply.

You can find more information about configuring the Coherence cache in the Coherence cache documentation.

RELATED TOPICS

- Cache Performance Tuning
- Performance Testing Scripts
- Confluence Cache Schemes
- Working with Confluence Logs
- Operating Large or Mission-Critical Confluence Installations
- Confluence Clustering Overview
- Requesting Performance Support
- Confluence Administrator's Guide
- Configuring Confluence
- Cache Statistics

Confluence provides statistics about its internal caches that allow you to track the size and hit ratio of each cache and tune it for better performance (if necessary). See Performance Tuning for more information.

Configurable Caches

System administrators can change the sizes of Confluence's internal caches through the Administration Console and these changes will take effect without the need to first shut down and then restart Confluence. The maximum number of units for any of the defined cache regions can be adjusted individually.

Note that larger cache sizes will require more memory at runtime, so you should review the memory allocation of the Confluence Java process and the physical memory available on your server.

⚠️ The information on this page does not apply to Confluence OnDemand.
1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Click ‘Cache Statistics’ in the left-hand panel. There you will find a list of all objects cached within Confluence.
3. Click the ‘Advanced’ tab for more detail. Below is an example for one of the most frequently used caches, the ‘Content Object’ cache.

<table>
<thead>
<tr>
<th>Name</th>
<th>Percent Used</th>
<th>Effectiveness</th>
<th>Objects / Size</th>
<th>Hit / Miss / Expiry</th>
<th>Adjust Size</th>
<th>Flush</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Object</td>
<td>80%</td>
<td>73%</td>
<td>4023 / 5000</td>
<td>374550 / 140460 / 55044</td>
<td>Adjust Size</td>
<td>Flush</td>
</tr>
</tbody>
</table>

About the generated numbers:

- **Percent Used:**
  \[ \text{Percent Used} = \frac{\text{Objects}}{\text{Size}} \]
  
  \[ \text{Percent Used} = 4023/5000 = 80\% \]

- **Effectiveness:**
  \[ \text{Effectiveness} = \frac{\text{Hits}}{\text{Hits} + \text{Misses}} \]
  
  \[ \text{Effectiveness} = \frac{374550}{374550 + 140460} = 73\% \]

- **Objects / Size:**
  The number of entries in the cache / the number of total possible entries allowed (configurable).

- **Hit / Miss / Expiry:**
  The number of reads accessing cache where required content was found / the number of reads accessing cache where required content was not found / the number of objects evicted from the cache.

- **Adjust Size**
  Use this option to specify a different maximum cache size. Enter a new cache size and click the ‘Adjust Size’ button to set it.

- **Flush:**
  Flushes the cache.

For instance, to calculate **Percent Used**:

\[
\text{Percent Used} = \frac{\text{Objects}}{\text{Size}} \\
\text{Percent Used} = \frac{4023}{5000} = 80\%
\]

To calculate **Effectiveness**:

\[
\text{Effectiveness} = \frac{\text{Hits}}{\text{Hits} + \text{Misses}} \\
\text{Effectiveness} = \frac{374550}{374550 + 140460} = 73\%
\]

⚠️ The clustered versions of Confluence use distributed cache called Tangosol Coherence.

Watching the Cache Contents

To see the specific items in the caches, view the cache statistics at `<baseUrl>/admin/cachecontents.jsp`.
Additional Notes about Configurable Caches

Changes to cache size configurations persist across Confluence restarts as they are saved in the `<confluence-home>/config/ehcache.xml` file (or `<confluence-home>/config/confluence-coherence-cache-config-clustered.xml` for a clustered instance). In most cases, a Confluence administrator will never need to know about these files. However, if it is necessary to tune cache options other than the maximum cache size, this can be done by manually editing these files. See Cache Performance Tuning for details.

**Important note about clustered Confluence installations**

The cache configuration file is stored in a home directory of each cluster node. When a Confluence administrator changes a cache size, all running cluster nodes will automatically update their own configuration files in their respective home directories. However, if a cluster node is not running when an administrator adjusts a cache size, the `/config/confluence-coherence-cache-config-clustered.xml` file in its home directory will not be updated. Since cluster caches are configured by the first node to start, if a node with an outdated cache configuration is the first to start up, the whole cluster would end up using the configuration of that node. However, copying this file from one node to another would resolve this issue.

Performance Tuning

If you need to tune your application when under high usage, you may like to review this [document](#) for suggestions.

Related Topics

- [Cache Performance Tuning](#)
- [Cache Performance Tuning for Specific Problems](#)
- [Confluence Cache Schemes](#)
- [Cache Statistics](#)
- [Viewing System Information](#)
- [Viewing and Editing License Details](#)

Confluence Cache Schemes

**Default Scheme**

If a cache has not been defined, then it will use the default cache size and expiry. As the start of your `confluence/WEB-INF/classes/confluence-coherence-cache-config.xml` file you will notice the following:

```xml
<cache-mapping>
  <cache-name>*</cache-name>
  <scheme-name>default</scheme-name>
</cache-mapping>
```

So basically all caches will default to using the default scheme, which is defined as below:
I.e. with a size of 1000 Objects and an expiry of 3600 seconds. Other schemes use the above as their default and either override the size of the cache, or the length of the expiry.

The information on this page does not apply to Confluence OnDemand.

Common Schemes

In addition to the default scheme, there are also common schemes used in Confluence caches:

<!-- Common schemes -->
<local-scheme>
  <scheme-name>large</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>medium</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>small</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>100</high-units>
</local-scheme>
<local-scheme>
  <scheme-name>large-transient</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>10000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>
<local-scheme>
  <scheme-name>user</scheme-name>
  <scheme-ref>default</scheme-ref>
  <high-units>5000</high-units>
  <expiry-delay>300s</expiry-delay>
</local-scheme>

RELATED TOPICS

Cache Performance Tuning
Confluence Cache Schemes
Cache Performance Tuning for Specific Problems
Requesting Performance Support
Confluence Administrator's Guide
Configuring Confluence
Memory usage and requirements

Managing Confluence's performance and memory usage really depends on what resources are available - Confluence will run faster if you give it lots of memory for its caches, but it should still be able to run quite well in low-memory environments, with the right tuning. Below are some tips on getting the most out of your Confluence site.

### Increasing the amount of memory available to Confluence

See [Increasing JIRA Memory](#) for details on how to increase the memory available to web application servers typically used to run Confluence.

### Embedded Database

The embedded HSQL database that comes with Confluence essentially holds all your data in memory while the Confluence server is running. If you are running out of memory, you should consider migrating Confluence to some external RDBMS.

### Caching

By default, Confluence keeps large in-memory caches of data to improve its responsiveness and the user experience. The trade off is an increase in memory requirements to support the cache. Administrators of larger Confluence sites may need to configure the size of their caches to improve performance.

To customise Confluence's cache to meet your needs, see cache tuning.

To increase the amount of memory available to confluence, see [How to Fix Out of Memory Errors by Increasing Available Memory](#).

### Mail error queue

Confluence keeps a copy of all emails that it failed to send within an internal error queue. In the event of intermittent failures such as network connectivity issues, the emails in this queue can be manually resent when the problem is fixed. Under certain circumstances, the mail queue can fill up with large objects. The queue is regularly flushed, but if you get a lot of mail errors, you might get a spike in memory usage.

### Attachments

The indexing of large attachments requires that the attachment be loaded into memory. In the case of large attachments, this can cause a temporary strain on the systems resources, and may result in indexing failing because the attachment could not be fully loaded into memory.

### System backup / restore

The Confluence backup and restore process scales linearly with the size of data. This can have a significant impact on large Confluence instances where the amount of data exceeds the amount of available memory. If you are experiencing an OutOfMemoryError during either a backup or restore processes, then we strongly recommend that you choose and Production Backup Strategy.

If you encounter an OutOfMemoryError while restoring a backup and wish to overcome this issue by increasing memory, how much more will you need to make this process work? A good rule of thumb is to have a look at the size of the entities.xml file in your backup. This file contains all of the data Confluence will be
loading, so at least that much is required. Add another 64-128Mb to ensure that Confluence has enough memory to load and function and that should be enough. To increase the amount of memory available to Confluence, see How to Fix Out of Memory Errors by Increasing Available Memory.

Known issues that we do not have control over.

There are also some memory issues we don't have any control over. For example,

- There's a memory leak in the Oracle 10g JDBC drivers. Not much we can do about that.
- one customer found a rather nasty memory leak that appeared to originate inside Tomcat 5, but only using the IBM JDK on PowerPC.

If you are having problems that appear to result from a memory leak, file an issue on http://support.atlassian.com. Our memory profiler of choice is YourKit. It would be helpful to us if you can provide us with a memory dump from that tool showing the leak.

Confluence is taking long periods of time to respond to some actions

A common cause of random pauses in Confluence is the JVM running garbage collection. To determine if this is what is happening, enable verbose garbage collection and look at how long Java is taking to free up memory. If the random pauses match when Java is running its garbage collection, garbage collection is the cause of the pause.

Verbose garbage collection will generate log statements that indicate when Java is collecting garbage, how long it takes, and how much memory has been freed.


For example, with a Windows service, run:

```
tomcat5 //US//Confluence ++JvmOptions="-XX:+PrintGCDetails
-XX:+PrintGCTimeStamps -verbose:gc -Xloggc:c:\confluence\logs\gc.log"
```

or in bin/setenv.sh, set:

```
export CATALINA_OPTS="$CATALINA_OPTS -XX:+PrintGCDetails
-XX:+PrintGCTimeStamps -verbose:gc -Xloggc:${CATALINA_BASE}/logs/gc.log"
```

If you modify bin/setenv.sh, you will need to restart Confluence for the changes to take effect.

What can you do to minimise the time taken to handle the garbage collection? See http://java.sun.com/docs/hotspot/gl1.4.2/ for details on tuning the JVM to minimise the impact that garbage collection has on the running application.

Requesting Performance Support

Basic Performance Troubleshooting Steps

Begin with the following procedures:

1. Go through the Troubleshooting Confluence Hanging or Crashing page to identify the major known performance problems
2. Proceed with the Performance Tuning tips to help optimize performance

⚠️ The information on this page does not apply to Confluence OnDemand.
Requesting Basic Performance Support

If those tips don't help or you're not sure where to start, open a support ticket starting with at least the basic information:

1. The atlassian-confluence.log
2. The catalina.out log (or your application server log), with a series of three thread dumps separated by 10 seconds
3. A description with as much detail as possible regarding:
   a. What changes have been made to the system?
   b. When did performance problems begin?
   c. When in the day do performance issues occur?
   d. What pages or operations experience performance issues?
   e. Is there a pattern?

Continue with as much of the Advanced Performance Troubleshooting information as you can.

Advanced Performance Troubleshooting

Please gather all of the information listed below and include it in your support request, even if you think you have a good idea what's causing the problem. That way we don't have to ask for it later.

**System Information**

**Confluence Server**

- Take a screenshot of Confluence's Administration System Information (or save the page as HTML)
- Take a screenshot of Confluence's Administration Cache Statistics (or save the page as HTML)
- Find out the exact hardware Confluence is running on
  - How many CPUs? What make and model? What MHz?
  - How much memory is installed on the machine?
  - How much memory is assigned to Confluence's JVM? (i.e. what are the -Xmx and -Xms settings for the JVM?)
  - What other applications are being hosted on the same box?

**Confluence Content**

- How many users are registered in Confluence?
- On average, to how many groups does each user belong?
- How many spaces (global and personal) are there in your Confluence server?
- How many of those spaces would be viewable by the average user?
- Approximately how many pages? (Connect to your database and perform `select count(*) from content where prevver is null and contenttype = 'PAGE'`)
- How much data is being stored in Bandana (where plugins usually store data)? (Connect to your database and perform `select count(*), sum(length(bandanavalue)) from bandana`)

**The Database**

- What is the exact version number of Confluence's database server?
- What is the exact version number of the JDBC drivers being used to access it? (For some databases, the full filename of the driver JAR file will suffice)
- Is the database being hosted on the same server as Confluence?
- If it is on a different server, what is the network latency between Confluence and the database?
- What are the database connection details? How big is the connection pool? If you are using the standard configuration this information will be in your confluence_cfg.xml file. Collect this file. If you are using a
Data source this information will be stored in your application server's configuration file, collect this data.

**User Management**

- Are you using external user management or authentication? (i.e. JIRA or LDAP user delegation, or single sign-on)
- If you are using external JIRA user management, what is the latency between Confluence and JIRA's database server?
- If you are using LDAP user management:
  - What version of which LDAP server are you using?
  - What is the latency between Confluence and the LDAP server?

**Diagnostics**

**Observed Problems**

- Which pages are slow to load?
  - If it is a specific wiki page, attach the wiki source-code for that page
- Are they always slow to load, or is the slowness intermittent?

**Monitoring data**

Before drilling down into individual problems, helps a lot to understand the nature of the performance problem. Do we deal with sudden spikes of load, or is it a slowly growing load, or maybe a load that follows a certain pattern (daily, weekly, maybe even monthly) that only on certain occasions exceeds critical thresholds? It helps a lot to have access to continuous monitoring data available to get a rough overview.

Here are sample graphs from the confluence.atlassian.com system, showing

**Load**

This graph shows the load for two consecutive days. The obvious pattern is that the machine is under decent load, which corresponds to the user activity, and there is no major problem.

![Load Graph](image)

**Resin Threads and Database Connections**
Active number of Java Threads

These two charts show the active threads in the application server (first chart) and the size database connection pool (second chart). As you can see, there was a sudden spike of server threads and a corresponding spike of db-connections.

The database connection pool size

The database connection pool size peaked over 112, which happened to be more than the maximum number connections the database was configured for (100). So it was no surprise that some requests to Confluence failed and many users thought it had crashed, since many requests could not obtain the crucial database connections.

We were able to identify this configuration problem quite easily just by looking at those charts. The next spikes were uncritical because more database connections were enabled.

The bottom line being: it helps a lot to monitor your Confluence systems continuously (we use Hyperic, for example), and it helps even more if you are able to send us graphs when you encounter problems.

Access logs

- How to Enable User Access Logging, including redirecting the logs to a separate file
  - You can run this file through a log file analyser such as AWStats, or manually look through for pages which are slow to load.

Profiling and Logs

- Enable Confluence's built-in profiling for long enough to demonstrate the performance problem using Troubleshooting Slow Performance Using Page Request Profiling.
  - If a single page is reliably slow, you should make several requests to that page
If the performance problem is intermittent, or is just a general slowness, leave profiling enabled for thirty minutes to an hour to get a good sample of profiling times.

- Find Confluence's standard output logs (which will include the profiling data above). Take a zip of the entire logs directory.
- Take a thread dump during times of poor performance

**CPU Load**

- If you are experiencing high CPU load, please install the YourKit profile and attach two profiler dumps taken during a CPU spike. If the CPU spikes are long enough, please take the profiles 30-60 seconds apart. The most common cause for CPU spikes is a virtual machine operating system.
- If the CPU is spiking to 100%, try Live Monitoring Using the JMX Interface, in particular with the Top threads plugin.

**Instance Metrics and Scripts**

- It is essential to understand the user access and usage of your instance. Please use the access log scripts and sql scripts to generate Usage statistics for your instance.

**Next Step**

Open a ticket on https://support.atlassian.com and attach all the data you have collected. This should give us the information we need to track down the source of your performance problems and suggest a solution. Please follow the progress of your enquiry on the support ticket you have created.

If your site is non-responsive, please use our Live Support during business hours once you have created the ticket to escalate your problem.

**Access Log Scripts**

The access log scripts are attached to this page. To use the scripts:

1. Unzip the 7z file.
2. Copy all the daily access logs to a folder called logs.
3. Run Atlassian-processDailyLog.rb. This will generate a csv file called summary.csv and several directories which contain the access logs of each defined user action.
4. Run the appropriate script Atlassian-processDailyLog-hourly.rb <admin/comment/create/edit/search/rss>. Each script will generate a different csv file. For example, Atlassian-processDailyLog-hourly.rb admin will process the admin logs extracted in step 3.
5. Import the csv files to www-log-Analysis.xls (summary.csv to 'raw stats - daily' sheet and admin.csv to 'admin -hours' sheet, etc) to generate the load profiles and graphs. You may need to modify the number of rows in each sheet depending on the number of logs.

⚠️ The information on this page does not apply to Confluence OnDemand.

**Note**

All scripts are written in Ruby and assume the log file name contains the string 'confluence.atlassian.com-access.log'. Scripts need to be changed if another name is used. Modify the line: `filenameRegexp = Regexp.new('confluence.atlassian.com-access.log')`

**Troubleshooting Slow Performance Using Page Request Profiling**

This page tells you how to enable page-request profiling. With profiling turned on, you will see a record of the time it takes (in milliseconds) to complete each action made on any Confluence page. If Confluence is responding slowly, an internal timing trace of the slow page request can help to identify the cause of the delay.
You will need access to the Confluence server to view a profile.

Enabling Page-Request Profiling

To see just the slow performing macros, see Identifying Slow Performing Macros.

From Confluence 2.7, you can use the ‘Logging and Profiling’ option to enable or disable profiling.

You need to have System Administrator permissions in order to perform this function.

To enable page profiling:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘Logging and Profiling’ in the left-hand panel.
   If profiling is already enabled, the button will be labelled ‘Disable Profiling’.

To disable page profiling:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Choose ‘Logging and Profiling’ in the left-hand panel.
   If profiling is already disabled, the button will be labelled ‘Enable Profiling’.

On this page:

- Enabling Page-Request Profiling
- Profiling an Activity
- Example of a Profile
- Start Confluence with Profiling Enabled

Related pages:

- Requesting Performance Support
- Working with Confluence Logs

⚠️ The information on this page does not apply to Confluence OnDemand.

Screenshot: Changing Log Levels and Profiling
Profiling an Activity

1. Enable profiling, using either of the methods described above. Profiles for every page hit, for all users, will now be logged to your application server's default logs until Confluence is restarted. Note that each time a user visits a link, a single profile is printed.

2. Confirm that profiles are being written to the Confluence log file — see Working with Confluence Logs for location of the log files and other details.

3. Perform the activity that is resulting in unusually slow response time.

4. Copy the profile for that action. When deciding which profiles to copy, look for the links that took a long time to respond. If a single page is slow, only that profile is necessary. If Confluence is generally or intermittently slow, copy all profiles logged during the slowdown until a reasonable sample has been collected.

5. If you were instructed to profile your instance by Atlassian technical support, attach all relevant profiles to your support ticket.

6. Turn profiling off again, using either of the methods described above.

7. Confirm that profiles are no longer being printed to the Confluence log file.

Example of a Profile

Below are the first few lines of a normal profile for accessing a page called Confluence Overview.
Start Confluence with Profiling Enabled

There may be some situations where you may wish to have Confluence profiling enabled during startup. This may be useful if you restart often and may forget to enable profiling for Support/Trouble-shooting purposes.

Edit the file `CONFLUENCE_HOME/confluence WEB-INF/web.xml`. You should see a stanza similar to the one below. Set the parameter value for `autostart` to `true`:

```xml
<filter>
    <filter-name>profiling</filter-name>
    <filter-class>com.atlassian.core.filters.ProfilingAndErrorFilter</filter-class>
    <init-param>
        <!-- specify the which HTTP parameter to use to turn the filter on or off -->
        <!-- if not specified - defaults to "profile.filter" -->
        <param-name>activate.param</param-name>
        <param-value>profile</param-value>
    </init-param>
    <init-param>
        <!-- specify the whether to start the filter automatically -->
        <!-- if not specified - defaults to "true" -->
        <param-name>autostart</param-name>
        <param-value>true</param-value>
    </init-param>
</filter>
```

Remember to turn it back to `false` or your logs will grow very large.

Identifying Slow Performing Macros

Page Profiling gives good detail on what operations are slow in a page load. In addition, you can add debug
level logging:
Version 3.1 and Later

Set the package name `com.atlassian.renderer.v2.components.MacroRendererComponent` to `DEBUG` in `Administration >> Logging and Profiling`.
Prior to version 3.1

Download WikiMarkupParser.class, available from the attachments to this page. This will result in logs like:

```
```

To add the class:

1. Add this line to the file `<confluence-install>/confluence/WEB-INF/classes/log4j.properties`:
   ```
   log4j.logger.com.atlassian.renderer=DEBUG
   ```
2. Add the appropriate WikiMarkupParser.class to `/confluence/WEB-INF/classes/com/atlassian/renderer/v2`. You'll have to make the renderer and v2 folders.

In combination with page profiling, this should give good specifics on the amount of time various plugins take. You can also use this utility to Search Confluence for Uses of a Macro.

Resolution

Experiment with the tips from the performance tuning page, or open an enhancement request about the specific macro. In some instances there is no resolution - you'll just be aware of the overhead of various macros.

Compressing an HTTP Response within Confluence

Confluence supports HTTP GZip transfer encoding. This means that if a user's web browser supports it, Confluence will compress the data it sends to the user. This will speed up Confluence over slow or congested Internet links, and reduce the amount of bandwidth consumed by a Confluence server.

Gzipping the HTTP Response is available in Confluence 1.4 and later.

You should turn on Confluence's GZip encoding if:
• Users are accessing Confluence over the Internet, or a WAN connection with limited bandwidth.
• You wish to reduce the amount of data transfer between the Confluence server and client.

If you are accessing Confluence over a Local Area Network or over a particularly fast WAN, you may wish to leave GZip encoding disabled. If the network is fast enough that transferring data from Confluence to the user isn’t a limiting factor, the additional CPU load caused by having to compress each HTTP response may in fact slow Confluence down.

⚠️ The information on this page does not apply to Confluence OnDemand.

### Known issues in Confluence 2.7 and earlier

There are known issues with the GZip filter and memory consumption evident in versions 2.7 of Confluence and earlier ([CONF-9930](#)). If you are running a large instance of Confluence 2.7 or earlier and frequently experiencing ‘out of memory’ errors, we recommend that you do not enable HTTP compression. These issues have been resolved in Confluence 2.8.

### Enabling HTTP Compression

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select ‘General Configuration’ in the left-hand panel.
3. Enable ‘Compress HTTP Responses’.

In Confluence 2.8 and later, you can configure which types of content are compressed within Confluence. By default, the following mime types will be compressed:

- text/html
- text/javascript
- text/css
- text/plain
- application/x-javascript
- application/javascript

If you wish to change the types of content to be compressed, add a replacement `urlrewrite-gzip-default.xml` file within the `WEB-INF/classes/com/atlassian/gzipfilter/` directory in your Confluence Installation Directory. A sample file is provided as an attachment. Generally speaking, it is unlikely that you will need to alter this file.

### RELATED TOPICS

Performance Tuning
Confluence Administrator's Guide
Performance Testing Scripts

### Load Testing Confluence

This page contains scripts and hints on load-testing your Confluence installations.

### Introduction

Before making a new Confluence instance available to your users it is useful to get a feel for how it will perform under your anticipated load and where you may need to consider improving your configuration to remove bottlenecks. Likewise, before making changes to your Confluence instance it would again be useful to assess the impact of these changes before making them live in a production context.

This kind of testing is not an exact science but the tools and process described here are intended to be a
straightforward, configurable and extensible way of allowing you to begin this kind of load testing.

It will rarely be the case that these scripts will perform representative testing for you 'out of the box'. But either through configuration or by extending the scripts it should be possible to build an appropriate load test.

⚠️ Load testing scripts are not designed for a production environment
The load testing scripts will update the data within the targeted Confluence instance and are not designed to be run against a production server. If you want to load test your production environment you will need to perform these tests on a backup of your data and restore your real data after the tests.

On this page:
- Load Testing Confluence
- Introduction
- Setup
- Quick, Just Tell Me How To Run It.
- Creating the Test Data
- Running the Test

⚠️ The information on this page does not apply to Confluence OnDemand.

Setup

You will need the following -

- A Confluence server, set up and running with an admin user. The scripts assume a default username and password for this user: 'admin'/admin'.
- Ensure the Confluence Remote API is enabled in the administration options. See Enabling the Remote API for details on how to configure this.
- Apache JMeter
- The load testing scripts and resources which are available in our public Maven repository— Please choose the version that most closely matches your Confluence version and download the ZIP or Gzip file in that directory. If in doubt, download the ZIP file archive.
  - e.g.

<table>
<thead>
<tr>
<th>Confluence Version</th>
<th>Performance Test Script</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.0.3 - 4.1.x</td>
<td>4.0.3</td>
</tr>
<tr>
<td>4.2 - 5.0.1 and later</td>
<td>4.2.2</td>
</tr>
</tbody>
</table>

Users have reported problems when using the Windows built-in unzip utility. Please use a third party file archiving and extraction program (for example, 7-Zip) to extract these performance tests.

The test scripts have been updated to work with Confluence 3.4 in version 3.4. Using an older version of the tests will result in errors when running the test.

Quick, Just Tell Me How To Run It.

If you don't want to read the rest of this document, here are the main points:

1. Download and Unzip the performance tests
2. Open a command prompt and change directory to the performanceTest directory that has just been unzipped.
3. Create the test data:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx
-Jspace.zip=<path to a demo space ZIP file> -Jadmin.user=<username>
-Jadmin.pass=<password>
```

4. Run the test:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
```

The remainder of this document is just an elaboration of those two steps.

⚠️ For information on how to use JMeter please refer to the manual

**Creating the Test Data**

A known data set is required to run the testing against. By default this is the Confluence demo space (space key = DS) although this can be changed (more on this later). If you decide to use the Confluence demo space, ensure that the group "confluence-users" is able to update content in this space.

The script `jmeter-test-setup.jmx` is used to:

- create a set of users to be used in the test
- import the Confluence demo space for running tests against.

You should first ensure that you don't already have the demo space (key = DS) on your test instance. Delete it if you do.

Run the script from the `performanceTest` directory as follows:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx
-Jspace.zip=<path to a space export.zip>-Jadmin.user=<username>
-Jadmin.pass=<password>
```

Where:

- `<path to a space export.zip>` is the absolute path to the space export zip you want to be used in your testing. For example, the path to `demo-site.zip` as found in your Confluence distribution or source: `<confluence install>/confluence/WEB-INF/classes/com/atlassian/confluence/setup/demo-site.zip`
- `<username>` and `<password>` are the username and password for an admin user that is able to create Confluence users and to import spaces.

By default the setup process will create 250 users — 50 each of the following formats: `tstreader<n>`, `tstcommentor<n>`, `tsteditor<n>`, `tstcreator<n>` and `tstsearcher<n>`. The password for each matches the username.

A typical run of the setup script will only take a few seconds.

**Removing the Test Data**

You can reverse the effects of the setup script by setting the `remove.data` parameter to true, e.g.
<jmeter location>/bin/jmeter -n -t jmeter-test-setup.jmx
-Jremove.data=true -Jadmin.user=<username> -Jadmin.pass=<password>

Setup Script Parameters

You can modify the behaviour of the setup script via JMeter parameters. These are supplied on the command line in the form `-J<parameter name>=<parameter value>`.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>script.base</td>
<td>.</td>
<td>The absolute path to the script. Defaults to the current working directory.</td>
</tr>
<tr>
<td>space.zip</td>
<td>N/A</td>
<td>The absolute path to space export zip file to be imported as test data.</td>
</tr>
<tr>
<td>remove.data</td>
<td>false</td>
<td>Run the script in reverse — remove all test data.</td>
</tr>
<tr>
<td>admin.user</td>
<td>admin</td>
<td>The admin user name used to import data and create users.</td>
</tr>
<tr>
<td>admin.pass</td>
<td>admin</td>
<td>The password for the admin user.</td>
</tr>
<tr>
<td>confluence.context</td>
<td>confluence</td>
<td>The confluence webapp context.</td>
</tr>
<tr>
<td>confluence.host</td>
<td>localhost</td>
<td>The address or host name of the test instance.</td>
</tr>
<tr>
<td>confluence.port</td>
<td>8080</td>
<td>The port of the test instance.</td>
</tr>
<tr>
<td>space.key</td>
<td>ds</td>
<td>The space key for the space import that will be tested against.</td>
</tr>
<tr>
<td>space.setup</td>
<td>true</td>
<td>Control whether the test space will be created (or removed).</td>
</tr>
<tr>
<td>commentor.max</td>
<td>250</td>
<td>The number of users to be created for making comments.</td>
</tr>
<tr>
<td>creator.max</td>
<td>250</td>
<td>The number of users to be created for adding pages.</td>
</tr>
<tr>
<td>editor.max</td>
<td>250</td>
<td>The number of users to be created for editing existing pages.</td>
</tr>
<tr>
<td>reader.max</td>
<td>250</td>
<td>The number of users to be created for viewing existing pages.</td>
</tr>
<tr>
<td>searcher.max</td>
<td>250</td>
<td>The number of users to be created for performing searches.</td>
</tr>
<tr>
<td>resource.max</td>
<td>250</td>
<td>The number of users to be created for downloading site resources.</td>
</tr>
</tbody>
</table>
Setup Script Output

On the console you will see no obvious indication of success or otherwise. JMeter will output something similar to this:

```
Created the tree successfully
Starting the test @ Mon Apr 14 17:35:08 EST 2008 (1208158508222)
Tidying up ... @ Mon Apr 14 17:35:08 EST 2008 (1208158508928)
... end of run
```

The `scripts location/results` directory will contain the file `jmeter-result-setuptest.jtl`. There were failures or errors if there are any assertions in this file that have the value `true` for the failure or error element, e.g.

```
<assertionResult>
  <name>Manage Users</name>
  <failure>true</failure>
  <error>false</error>
  <failureMessage>Test failed: URL expected to contain /browseusers.action/</failureMessage>
</assertionResult>
```

Running the Test

The test script itself will put Confluence under a fixed load. Each thread group will attempt to do a certain amount of work for a prescribed period of time (30 minutes by default). This is by design so that load during test runs can accurately be compared against each other.

Execute the test as follows:

```
<jmeter location>/bin/jmeter -n -t jmeter-test-fixedload.jmx
```

Where:

- `<scripts location>` is the absolute path to where you extracted the scripts e.g. `/Users/YourName/Download/performanceTest`. This is needed for the script to find its external resources.

Test Behaviour

The test has a number of parameters to tweak its behaviour but generally speaking it has the rough format of:

- 5 groups of users - readers, commentors, searchers, editors and creators.
  - readers simply view a set of individual pages or browse space functionality.
  - commentors add comments to a set of pages.
  - searchers perform searches on a fixed set of keywords.
  - editors make small additions to the end of a set of pages.
  - creators add new pages to a particular space.
- Each individual user in each group will repeat for a fixed amount of time with a small pause between each request.

Note that there is no execution of JavaScript by the client. Keep this in mind if you use this test to gauge
Confluence performance in a production environment.

There is also very little use of permissions in these tests. All data involved is accessible to all of the test users.

**Test Script Parameters**

You can modify the behaviour of the test script via JMeter parameters. These are supplied on the command line in the form `-J<parameter name>=<parameter value>`.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>script.base</td>
<td>.</td>
<td>The absolute path to the script. Defaults to the current working directory.</td>
</tr>
<tr>
<td>confluence.context</td>
<td>confluence</td>
<td>The confluence webapp context.</td>
</tr>
<tr>
<td>confluence.host</td>
<td>localhost</td>
<td>The address or host name of the test instance.</td>
</tr>
<tr>
<td>confluence.port</td>
<td>8080</td>
<td>The port of the test instance.</td>
</tr>
<tr>
<td>create.page.prefix</td>
<td>Nihilist</td>
<td>The title prefix for any created page e.g. Nihilist00001.</td>
</tr>
<tr>
<td>script.runtime</td>
<td>1800</td>
<td>The amount of time the script will run for in seconds.</td>
</tr>
</tbody>
</table>

**Test Thread Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>threads.reader</td>
<td>15</td>
<td>Number of readers.</td>
</tr>
<tr>
<td>pause.reader</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between reader repeats.</td>
</tr>
<tr>
<td>threads.searcher</td>
<td>8</td>
<td>Number of searchers.</td>
</tr>
<tr>
<td>pause.searcher</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between searcher repeats.</td>
</tr>
<tr>
<td>threads.creator</td>
<td>3</td>
<td>Number of page creators.</td>
</tr>
<tr>
<td>pause.creator</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between creator repeats.</td>
</tr>
<tr>
<td>threads.editor</td>
<td>3</td>
<td>Number of page editors.</td>
</tr>
<tr>
<td>pause.editor</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between editor repeats.</td>
</tr>
<tr>
<td>threads.commentor</td>
<td>4</td>
<td>Number of page commentors.</td>
</tr>
<tr>
<td>pause.commentor</td>
<td>2000</td>
<td>The approximate (within 500ms) millisecond pause between commentor repeats.</td>
</tr>
</tbody>
</table>

In version 3.0 of the tests, it's now possible to control the percentage executions of certain actions. These percentages are defined in the "Thread Details" configuration screen.

So with the default parameters, you are emulating a load on Confluence of 33 concurrent users who will each be hitting the server approximately every 2 seconds (16 users per second).

23 of these users are read only (searchers or readers) and 10 of them are read/write — 11 read only users per second and 5 read/write users per second.

**Test Script Output**

During the run of the test script Jmeter will output progress to the console of the form:

```
Created the tree successfully
Starting the test @ Fri Apr 18 00:07:39 EST 2008 (1208441259523)
Display Summary Results During Run + 462 in 77.6s = 5.9/s Avg: 1564 Min: 18 Max: 33738 Err: 1 (0.22%)
Display Summary Results During Run + 1338 in 189.9s = 7.0/s Avg: 3596 Min: 24 Max: 34545 Err: 0 (0.00%)
Display Summary Results During Run = 1800 in 257.6s = 7.0/s Avg: 3704 Min: 18 Max: 34545 Err: 1 (0.06%)
Display Summary Results During Run + 1046 in 200.9s = 5.2/s Avg: 4529 Min: 40 Max: 50461 Err: 0 (0.00%)
Display Summary Results During Run = 2846 in 438.2s = 6.5/s Avg: 3609 Min: 18 Max: 50461 Err: 1 (0.04%)
Display Summary Results During Run + 677 in 201.2s = 3.4/s Avg: 6638 Min: 46 Max: 27636 Err: 0 (0.00%)
Display Summary Results During Run = 3523 in 618.1s = 5.7/s Avg: 4191 Min: 18 Max: 50461 Err: 1 (0.03%)
Display Summary Results During Run + 561 in 197.5s = 2.8/s Avg: 8326 Min: 171 Max: 39494 Err: 0 (0.00%)
Display Summary Results During Run = 4084 in 798.3s = 5.1/s Avg: 4759 Min: 18 Max: 50461 Err: 1 (0.02%)
Display Summary Results During Run + 555 in 199.2s = 2.8/s Avg: 8247 Min: 160 Max: 45270 Err: 0 (0.00%)
Display Summary Results During Run = 4639 in 978.0s = 4.7/s Avg: 5177 Min: 18 Max: 504
```

**Garbage Collector Performance Issues**

This document relates broadly to memory management with Oracle's Hotspot JVM. These are recommendations based on Support's successful experiences with customers and their large Confluence instances.

Please do not use the Concurrent Mark Sweep (CMS) Collector with Confluence, unless otherwise advised by Atlassian Support. It requires extensive manual tuning and testing, and is likely to result in degraded performance.
Summary

1. Set the Young space up to 30-40% of the overall heap: `-XX:NewSize=<between 30% and 40% of your Xmx value, eg, 384m>`
2. Use a parallel collector: `-XX:+UseParallelOldGC (make sure this is Old GC)`
3. limit the Tomcat connector’s spare thread counts to minimize impact
4. `effectively` disable explicit garbage collection triggered from distributed remote clients `-Dsun.rmi.dgc.client.gcInterval=900000 -Dsun.rmi.dgc.server.gcInterval=900000`
5. Disable remote clients from triggering a full GC event `-XX:+DisableExplicitGC`
6. set the minimum and maximum Xmx and Xms values as the same (eg. `-Xms1024m -Xmx1024m`) to discourage address map swapping
7. Turn on GC logging (details found at Enable Garbage Collection Logging) and submit the logs in a support ticket
8. Use Java 1.6
9. Read below if heap > 2G

See Configuring System Properties for how to add these properties to your environment.

Background

Performance problems in Confluence, and in rarer circumstances for JIRA, generally manifest themselves in either:

- frequent or infrequent periods of viciously sluggish responsiveness, which requires a manual restart, or, the application eventually and almost inexplicably recovers
- some event or action triggering a non-recoverable memory debt, which in turn envelops into an application-fatal death spiral (Eg. overhead GC collection limit reached, or Out-Of-Memory).
- generally consistent poor overall performance across all Confluence actions

There are a wealth of simple tips and tricks that can be applied to Confluence, that can have a significantly tangible benefit to the long-term stability, performance and responsiveness of the application.

On this page:

- Summary
- Background
- Why Bad Things Happen
- Appreciate how Confluence and the JAVA JVM use memory
- Memory is contiguous
- Figure out which (default) collector implementation your vendor is using
- Use the Parallel Garbage Collector
- Restrict ability of Tomcat to ‘cache’ incoming requests
- Disable remote (distributed) garbage collection by Java clients
- Virtual Machines are Evil
- Use Java 1.6
- Use -server flag
- If using 64bit JRE for larger heaps, use CompressedOops
- Use NUMA if on SPARC, Opteron or recent Intel (Nehalem or Tukwila onwards)
- Use 32bit JRE if Heap < 2GB
- JVM core dumps can be instigated by memory pressures
- Artificial Windows memory limit
- Instigate useful monitoring techniques
• Tuning the frequency of full collections
• Performance tuning works

Why Bad Things Happen

Confluence can be thought of like a gel or a glue, a tool for bringing things together. Multiple applications, data-types, social networks and business requirements can be efficiently amalgamated, leading to more effective collaboration. The real beauty of Confluence, however, is its agility to mould itself into your organizations’ DNA - your existing business and cultural processes, rather than the other way around - your organization having to adapt to how the software product works.

The flip side of this flexibility is having many competing demands placed on Confluence by its users. Historically, this is an extraordinarily broad and deep set of functions, that really, practically can’t be predicted for individual use cases.

The best mechanism to protect the installation is to place Confluence on a foundation where it is fundamentally more resilient and able to react and cope with competing user requirements.

Appreciate how Confluence and the JAVA JVM use memory

The Java memory model is naive. Compared to a unix process, which has four intensive decades of development built into time-slicing, inter-process communication and intelligent deadlock avoidance, the Java thread model really only has 10 years at best under its belt. As it is also an interpreted language, particular idiosyncrasies of the chosen platform Confluence is running can also influence how the JRE reacts. As a result it is sometimes necessary to tune the jvm parameters to give it a "hint" about how it should behave.

There are circumstances whereby the Java JVM will take a mediocre option in respect to resource contention and allocation and struggle along with oftentimes highly impractical goals. For example, The JRE will be quite happy to perform at 5 or 10% of optimum capacity if it means overall application stability and integrity can be ensured. This often translates into periods of extreme sluggishness, which effectively means that the application isn't stable, and isn't integral (as it cannot be accessed).

This is mainly because Java shouldn't make assumptions on what kind of runtime behavior an application needs, but it's plain to see that the charter is to assume 'business-as-usual' for a wide range of scenarios and really only react in the case of dire circumstances.

Memory is contiguous

The Java memory model requires that memory be allocated in a contiguous block. This is because the heap has a number of side data structures which are indexed by a scaled offset (ie n*512 bytes) from the start of the heap. For example, updates to references on objects within the heap are tracked in these "side" data structures.

Consider the differences between:

1. Xms (the allocated portion of memory)
2. Xmx (the reserved portion of memory)

Allocated memory is fully backed, memory mapped physical allocation to the application. That application now owns that segment of memory.

Reserved memory (the difference between Xms and Xmx) is memory which is reserved for use, but not physically mapped (or backed) by memory. This means that, for example, in the 4G address space of a 32bit system, the reserved memory segment can be used by other applications, but, because Java requires contiguous memory, if the reserved memory requested is occupied the OS must swap that memory out of the reserved space either to another non-used segment, or, more painfully, it must swap to disk.

Permanent Generation memory is also contiguous. The net effect is even if the system has vast quantities of cumulative free memory, Confluence demands contiguous blocks, and consequently undesirable swapping may
occur if segments of requested size do not exist. See Causes of OutOfMemoryErrors for more details.

Please be sure to position Confluence within a server environment that can successfully complete competing requirements (operating system, contiguous memory, other applications, swap, and Confluence itself).

Figure out which (default) collector implementation your vendor is using

Default JVM Vendor implementations are subtly different, but in production can differ enormously.

The Oracle JVM by default splits the heap into three spaces

1. Young (New, divided into Eden and Survivor)
2. Tenured (Old)
3. Permanent Generation (classes & library dependencies)

Objects are central to the operation of Confluence. When a request is received, the Java runtime will create new objects to fulfill the request in the Eden Space. If, after some time, those objects are still required, they may be moved to the Tenured (Old) space. But, typically, the overwhelming majority of objects created die young, within the Eden space. These are objects like method local references within a while or for loop, or Iterators for scanning through Collections or Sets.

But in IBM J9 the default policy is for a single, contiguous space - one large heap. The net effect is that for large Websphere environments, garbage collection can be terribly inefficient - and capable of suffering outages during peak periods.

-XX:NewSize=XXXm where XXX is the size in megabytes, is the command line parameter. -XmnXXXm can also be used interchangeably. Ie. -XX:NewSize=700m, -Xmn700m

By setting a larger NewSize, the net effect is that the JRE will spend less time garbage collecting, clearing dead memory references, compacting and copying memory between spaces, and more time doing actual work.

Use the Parallel Garbage Collector

Confluence out of the box, and Oracle Java as default, uses the serial garbage collector on the Full Tenured heap. The Young space is collected in parallel, but the Tenured is not. This means that at a time of load if a full collection event occurs, since the event is a 'stop-the-world' serial event then all application threads other than the garbage collector thread are taken off the CPU. This can have severe consequences if requests continue to accrue during these 'outage' periods. As a rough guide, for every gigabyte of memory allocated allow a full second (exclusive) to collect.

If we parallelize the collector on a multi-core/multi-cpu architecture instance, we not only reduce the total time of collection (down from whole seconds to fractions of a second) but we also improve the resiliency of the JRE in being able to recover from high-demand occasions.

Additionally, Oracle provide a CMS, Concurrent Mark-Sweep Collector (-XX:+UseConcMarkSweepGC), which is optimized for higher-throughput, server-grade instances. As a general rule, the Parallel Collector (-XX:+UseParallelOldGC) is the right choice for JIRA or Confluence installations, unless otherwise advised by support.

Restrict ability of Tomcat to ‘cache’ incoming requests

Quite often the fatal blow is swung by the ‘backlog’ of accumulated web requests whilst some critical resource (say the index) is held hostage by a temporary, expensive job. Even if the instance is busy garbage collecting due to load, Tomcat will still trigger new http requests and cache internally, as well as the operating system
beneath which is also buffering incoming requests in the socket for Tomcat to pick up the next time it gets the
CPU.

```xml
<Connector port="8090" protocol="HTTP/1.1"
    maxHttpHeaderSize="8192" maxThreads="150" minSpareThreads="25"
    maxSpareThreads="75" useBodyEncodingForURI="true"
    enableLookups="false" redirectPort="8443" acceptCount="100"
    connectionTimeout="20000" disableUploadTimeout="true"/>
```

Here the Tomcat Connector is configured for 150 "maxThreads" with an "acceptCount" of 100. This means up to
150 threads will awaken to accept (but importantly not to complete) web requests during performance outages,
and 100 will be cached in a queue for further processing when threads are available. That's 250 threads, many
of which can be quite expensive in and of themselves. Java will attempt to juggle all these threads concurrently
and become extremely inefficient at doing so, exacerbating the garbage collection performance issue.

Resolution: reduce the number of maxThreads and acceptCount to something slightly higher than normal
'busy-hour' demands.

**Disable remote (distributed) garbage collection by Java clients**

Many clients integrate third-party or their own custom applications to interrogate, or add content to Confluence
via its RPC interface. The Distributed Remote Garbage Collector in the client uses RMI to trigger a remote GC
event in the Confluence server. Unfortunately, as of this writing, a `System.gc()` call via this mechanism
triggers a full, serial collection of the entire Confluence heap (as it needs to remove references to remote client
objects in its own deterministic object graph). This is a deficiency in the configuration and/or implementation of
the JVM. It has the potential to cause severe impact if the remote client is poorly written, or operating within a
constricted JVM.

This can be disabled by using the flag `-XX:+DisableExplicitGC` at startup.

**Virtual Machines are Evil**

Vmware Virtual Machines, whilst being extremely convenient and fantastic, also cause particular problems for
Java applications because it's very easy for host operating system resource constraints such as temporarily
insolvent memory availability, or I/O swapping, to cascade into the Java VM and manifest as extremely unusual,
frustrating and seemingly illogical problems. We already document some disk I/O metrics with VMware images.
Although we now officially support the use of virtual instances we absolutely do not recommend them unless
maintained correctly.

This is not to say that vmware instances cannot be used, but, they must be used with due care, proper
maintenance and configuration. Besides, if you are reading this document because of poor performance, the first
action should be to remove any virtualization. Emulation will never beat the real thing and always introduces
more black box variability into the system.

**Use Java 1.6**

Java 1.6 is generally regarded via public discussion to have an approximate 20% performance improvement
over 1.5. Our own internal testing revealed this statistic to be credible. 1.6 is compatible for all supported
versions of Confluence, and we strongly recommend that installations not using 1.6 should migrate.

**Use -server flag**

The hotspot server JVM has specific code-path optimizations which yield an approximate 10% gain over the
client version. Most installations should already have this selected by default, but it is still wise to force it with
-server, especially on some Windows machines.
If using 64bit JRE for larger heaps, use CompressedOops

For every JDK release, Oracle also build a "Performance" branch in which specifically optimized performance features can be enabled; it is available on the Java SE page after a brief survey. These builds are certified production grade.

Some blogs have suggested a 25% performance gain and a reduction in heap size when using this parameter. The use and function of the -XX:+UseCompressedOops parameter is more deeply discussed on Oracle's Official Wiki (which itself uses Confluence!)

Use NUMA if on SPARC, Opteron or recent Intel (Nehalem or Tukwila onwards)

-XX:+UseNUMA flag enables the Java heap to take advantage of Non-Uniform-Memory-Architectures. JAVA will place data structures relevant to the thread which it owns / operates on, in memory locations closest to that particular processor. Depending on the environment, gains can be substantial. Intel market NUMA as Quick Path Interconnect™.

Use 32bit JRE if Heap < 2GB

Using a 64bit JRE when the heap is under 2GB will cause substantial degradation in heap size and performance. This is because nearly every object, reference, primitive, class and variable will use twice as much memory to be addressed.

A 64bit JRE/JDK is only recommended if heaps greater than 2GB are required. If so, use CompressedOops.

JVM core dumps can be instigated by memory pressures

If your instance of Confluence is throwing Java core dumps, it's known that memory pressure and space/generation sizings can influence the frequency and occurrence of this phenomena.

If your Tomcat process completely disappears and the logs record similar to:

```
# An unexpected error has been detected by HotSpot Virtual Machine:
# SIGSEGV (0xb) at pc=0xfe9bb960, pid=20929, tid=17
# Java VM: Java HotSpot(TM) Server VM (1.5.0_01-b08 mixed mode)
# Problematic frame:
# V [libjvm.so+0x1bb960]
#
------------------------  T H R E A D  ------------------------
Current thread (0x01a770e0):  JavaThread "JiraQuartzScheduler_Worker-1" [__thread_in_vm, id=17]

   siginfo.si_signo=11, si_errno=0, si_code=1, si_addr=0x00000000

Registers:
O0=0xf5999882  O1=0xf5999882  O2=0x00000000  O3=0x00000000
O4=0x00000000  O5=0x00000000  O6=0xc24ff0b0  O7=0x00000800
G1=0xfe9bb80c  G2=0xf5999a48  G3=0x0a67677d  G4=0xf5999882
G5=0xc24ff380  G6=0x00000000  G7=0xfdbe3800  Y=0x00000000
PC=0xfe9bb960 nPC=0xfe9bb964
```

then you should upgrade the JVM. See SIGSEGV Segmentation Fault JVM Crash.
Artificial Windows memory limit

On Windows, the maximum heap allocatable to the Tomcat 32bit wrapper process is around 1400MB. If the instance is allocated too close to this limit, chronic garbage collection is likely to result, often producing JAVA core dumps similar to:

```java
# A fatal error has been detected by the Java Runtime Environment:
# java.lang.OutOfMemoryError: requested 8388608 bytes for GrET in
#   C:\BUILD_AREA\jdk6_18\hotspot\src\share\vm\utilities\growableArray.cpp.
# Out of swap space?
# Internal Error (allocation.inline.hpp:39), pid=11572, tid=12284
# Error: GrET in
#   C:\BUILD_AREA\jdk6_18\hotspot\src\share\vm\utilities\growableArray.cpp
# JRE version: 6.0_18-b07
# Java VM: Java HotSpot(TM) Server VM (16.0-b13 mixed mode windows-x86 )
# If you would like to submit a bug report, please visit:
#   http://bugreport.sun.com/bugreport/crash.jsp
#
--------------- Thread ---------------
Current thread (0x002af800): GCTaskThread [stack:
0x00000000,0x00000000] [id=12284]
```

or,

```java
# A fatal error has been detected by the Java Runtime Environment:
# java.lang.OutOfMemoryError: requested 123384 bytes for Chunk::new. Out
# of swap space?
# Internal Error (allocation.cpp:215), pid=10076, tid=4584
# Error: Chunk::new
# JRE version: 6.0_18-b07
# Java VM: Java HotSpot(TM) Server VM (16.0-b13 mixed mode windows-x86 )
# If you would like to submit a bug report, please visit:
#   http://bugreport.sun.com/bugreport/crash.jsp
#
--------------- Thread ---------------
Current thread (0x6ca4d000): JavaThread "CompilerThread1" daemon
[_thread_in_native, id=4584, stack(0x6cd10000,0x6cd60000)]
```

Workarounds include:

- changing the server OS to something other than Windows. For example, Linux
- switching to the 64 bit Tomcat wrapper (this is not supported)
• reducing memory allocation to the Tomcat process. Try backing off 100MB at a time and observe the results.

**Instigate useful monitoring techniques**

At all times the best performance tuning recommendations are based on current, detailed metrics. This data is easily available and configurable and helps us **tremendously** at Atlassian when diagnosing reported performance regressions.

1. enable JMX monitoring
2. enable Confluence Access logging
3. enable Garbage Collection Logging
4. Take **Thread dumps** at the time of regression. If you can't get into Confluence, you can take one **externally**.
5. **Jmap** can take a memory dump in real time without impacting the application. Syntax: 
   ```
   jmap -heap:format=b <process_id>
   ```

Great tools available include:

• The excellent **VisualVM, documentation**.
• **Thread Dump Analyzer** - a great all-round thread debugging tool, particularly for identifying deadlocks.
• **Samurai**, an excellent alternative thread analysis tool, good for iterative dumps over a period of time.
• **GC Viewer** - getting a bit long in the tooth, but is a good mainstay for GC analysis.
• **GChisto** - A GC analysis tool written by members of the Sun Garbage Collection team.

**Documentation:**

• Sun's **White Paper** on Garbage Collection in Java 6.
• Sun's state-of-the-art JavaOne 2009 **session** on garbage collection (registration required).
• IBM stack: **Java 5 GC basics** for WebSphere Application Server.
• An excellent IBM document covering native memory, thread stacks, and how these influence memory constricted systems. Highly recommended for additional reading.
• The **complete list** of JRE 6 options
• I strongly recommend viewing George Barnett's Summit 2010 performance presentation, **Pulling a Rabbit from a Hat**.

Atlassian recommends at the very least to get VisualVM up and running (you will need JMX), and to add Access and Garbage Collection logging.

**Tuning the frequency of full collections**

The JVM will generally only collect on the full heap when it has no other alternative, because of the relative size of the Tenured space (it is typically larger than the Young space), and the natural probability of objects within tenured not being eligible for collection, i.e. they are still alive.

Some installations can trundle along, only ever collecting in Young space. As time goes on, some object will survive the initial Young object collection and be promoted to Tenured. At some point, it will be dereferenced and no longer reachable by the deterministic, directed object graph. However, the occupied memory will still be held in limbo as "dead" memory until a collection occurs in the Tenured space to clear and compact the space.

It is not uncommon for moderately sized Confluence installations to reclaim as much as 50% of the current heap size on a full collection; This is because full collections occur so infrequently. By reducing the occupancy fraction heap trigger, this means that more memory will be available at any time, meaning that fewer swapping/object collections will occur during the busy hour.

Atlassian would classify frequency tuning on collections as an **advanced** topic for further experimentation, and is
provided for informational purposes only. Unfortunately, it's impractical for Atlassian to support these kinds of changes in general.

**Performance tuning works**

Atlassian has a number of high profile and some *extremely* high demanding, mission-critical clients who have successfully, usually through trial and error, applied these recommendations to production instances and have significantly improved their instances. For more information, please file a support case at support.atlassian.com.

**Confluence Installation and Upgrade Guide**

<table>
<thead>
<tr>
<th>About this document</th>
</tr>
</thead>
<tbody>
<tr>
<td>This guide contains information on how to install a new Confluence site, or how to upgrade an existing site to the latest version of Confluence. You can also examine the release notes to see what has changed since the last time you installed or upgraded your Confluence wiki.</td>
</tr>
<tr>
<td>If you still have a question that has not been answered, please ask us.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Downloads</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can download the Confluence documentation in PDF, HTML and XML formats.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>More resources</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visit the Confluence Administrator’s Guide for information on how to administer and configure your Confluence site, or go to the Confluence Documentation Home for a list of further resources.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>In this guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Requirements</td>
</tr>
<tr>
<td>Confluence Installation Guide</td>
</tr>
<tr>
<td>Confluence Setup Guide</td>
</tr>
<tr>
<td>Upgrading Confluence</td>
</tr>
<tr>
<td>Supported Platforms</td>
</tr>
<tr>
<td>Migrating Confluence Between Servers</td>
</tr>
</tbody>
</table>

**System Requirements**

Confluence works with a broad range of operating systems, database systems and application servers. Provided you have the technical knowledge, it is very likely that you will be able to run Confluence with an 8-year-old database or even on some 8-year-old hardware. Realistically, it is not technically feasible for us to provide our legendary support service on all environments available. There can only be a finite number of platforms and release versions of those that we support.

Our rule of thumb when releasing a new version of Confluence is that we will officially support platforms that have been released within the last one to two years (or the latest version of that platform if no new version of it
was released in that period). This does not necessarily mean that you will need to upgrade your database or application server every time you upgrade Confluence. However, if you do run into problems with an unsupported version of a database or application server, we may have to ask you to upgrade to something newer.

Please refer to our Supported Platforms topic for details on platforms that we currently support in this version of Confluence and our Supported Platforms FAQ topic for details on our support handling procedures.

On this page:
- Confluence Software Requirements
- Operating Systems
- Application Servers
- Databases
- Java
- Please Note: Impact of Antivirus Software
- Confluence Hardware Requirements
- Atlassian Hosted Solutions – Atlassian OnDemand

Confluence Software Requirements

Please read the Supported Platforms page for Confluence. That page contains a list of specific software that Confluence will work with.

Operating Systems

Atlassian supports the operating systems listed on the Supported Platforms page.

If you would like to run Confluence on virtualised hardware, please read our Running Confluence in a Virtualised Environment document first.

Application Servers

An application server is required to run Confluence. Apache Tomcat is bundled with the distribution.

Atlassian only supports the application servers listed on the Supported Platforms page, provided they are running on Windows, Linux, or Solaris. If you are using a different application server or earlier version, we may ask you to migrate to one of the supported application servers before we can provide you with further support.

Databases

A database is required to run Confluence. Atlassian supports the databases listed on the Supported Platforms page.

If you have no preference for a particular database and wish to set up Confluence for production purposes, we highly recommend using PostgreSQL. This is a scalable, robust and free database server that is also easy to set up. For database setup information, please refer to Database Setup For Any External Database.

Confluence should work with the database versions listed below. However, we do not test these versions regularly and we may ask you to migrate to one of the supported databases before we can provide you with further support.

- PostgreSQL — 8.2, 8.3, 8.4, 9.0
- MySQL — 5.1 (using the InnoDB storage engine, not MyISAM)
- Oracle — 11.1, 11.2
- DB2 — 9.7
Java

Confluence requires the Java Runtime Environment (JRE) installed.

If using the Zip or archive distribution of Confluence, you will need to install a supported JRE. The automated installer bundles Java and will install this for you. For instructions on installing the JRE for Windows and Linux/Solaris, please refer to Installing Java for Confluence.

Please Note: Impact of Antivirus Software

The presence of antivirus software on your operating system running Confluence greatly decreases the performance of Confluence. Antivirus software that intercepts access to the hard disk is particularly detrimental and may even cause errors in Confluence.

You should configure your antivirus software to ignore the following directories:

- Confluence home directory
- Confluence's index directory
- All database-related directories

⚠️ This recommendation above is particularly important if you are running Confluence on Windows. No matter how fast your hardware is, antivirus software will almost always have a negative impact on Confluence's performance and may render Confluence impossible to use.

Confluence Hardware Requirements

Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.

See Server Hardware Requirements Guide for details.

Refer also to the tips on reducing out of memory errors, in particular the section on Permanent Generation Size.

Atlassian Hosted Solutions – Atlassian OnDemand

If you do not have the resources to set up and maintain a Confluence installation locally, consider Atlassian hosted solutions. Atlassian can run and maintain your installation of Confluence, handling all the testing, monitoring and upgrading processes for you. For more information, please refer to the information about Confluence OnDemand on our website.

Related Topics

End of Support Announcements for Confluence
Confluence Installation Guide
Confluence Setup Guide
Installing Confluence on Windows
Installing the Confluence EAR-WAR Edition
Confluence Cluster Installation
Example Size and Hardware Specifications From Customer Survey
Installing Confluence and JIRA Together
Confluence Documentation Home
Server Hardware Requirements Guide
Supported Platforms FAQ

Server Hardware Requirements Guide
Server administrators can use this guide in combination with the free Confluence trial period to evaluate their server hardware requirements. Because server load is difficult to predict, live testing is the best way to determine what hardware a Confluence instance will require in production.

Peak visitors are the maximum number of browsers simultaneously making requests to access or update pages in Confluence. Visitors are counted from their first page request until the connection is closed and if public access is enabled, this includes internet visitors as well as logged in users. Storage requirements will vary depending on how many pages and attachments you wish to store inside Confluence.

**Minimum hardware requirements**

The values below refer to the minimum available hardware required to run Confluence only, eg the minimum heap size to allocate to Confluence is 512mb. You will need additional physical hardware, of at least the minimum amount required by your Operating System, and any other applications that run on the server. Also please note that these are a guide only, and your configuration may require more.

On small instances, server load is primarily driven by peak visitors.

5 Concurrent Users

- 2GHz+ CPU
- 512MB RAM
- 5GB database space

25 Concurrent Users

- Quad 2GHz+ CPU
- 2GB+ RAM
- 10GB database space

**Note:** Please be aware that while some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.

---

**Example hardware specifications**

These are example hardware specifications for non-clustered Confluence instances. It is not recorded whether the RAM refers to either total server memory or memory allocated to the JVM, while blank settings indicate that the information was not provided.

<table>
<thead>
<tr>
<th>Accounts</th>
<th>Spaces</th>
<th>Pages</th>
<th>CPUs</th>
<th>CPU (GHz)</th>
<th>RAM (Meg)</th>
<th>Notes</th>
</tr>
</thead>
</table>

**On this page:**

- Minimum hardware requirements
- Example hardware specifications
- Server load and scalability
- Maximum reported usages
- Hard disk requirements
- Private and public comparison
- Professional assistance

**Related pages:**

- Confluence Installation Guide
- Performance Testing Scripts
- Operating Large or Mission-Critical Confluence Installations
- Managing Application Server Memory Settings
- Confluence Clustering Overview
- Running Confluence in a Virtualised Environment
<table>
<thead>
<tr>
<th>Visitor</th>
<th>Editor/Viewer</th>
<th>Total Content</th>
<th>Server Load</th>
<th>Scalability</th>
</tr>
</thead>
<tbody>
<tr>
<td>150</td>
<td>30</td>
<td>1,000</td>
<td>1</td>
<td>2.6</td>
</tr>
<tr>
<td>350</td>
<td>100</td>
<td>15,000</td>
<td>2</td>
<td>2.8</td>
</tr>
<tr>
<td>5,000</td>
<td>500</td>
<td>4</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>10,000</td>
<td>350</td>
<td>16,000</td>
<td>2</td>
<td>3.8</td>
</tr>
<tr>
<td>10,000</td>
<td>60</td>
<td>3,500</td>
<td>2</td>
<td>3.6</td>
</tr>
<tr>
<td>21,000</td>
<td>950</td>
<td>2</td>
<td>3.6</td>
<td></td>
</tr>
<tr>
<td>85,000</td>
<td>100</td>
<td>12,500</td>
<td>4</td>
<td>2.6</td>
</tr>
</tbody>
</table>

3 machines total:
application server, database server, Apache HTTPD + LDAP tunnel server. See Accenture's slides and video for full details (That link isn't working, but the slides can be found here).

**Server load and scalability**

When planning server hardware requirements for your Confluence deployment, you will need to estimate the server scalability based on peak visitors, the editor to viewer ratio and total content.

- The editor to viewer ratio is how many visitors are performing updates versus those only viewing content
- Total content is best estimated by a count of total spaces

Confluence scales best with a steady flow of visitors rather than defined peak visitor times, few editors and few spaces. Users should also take into account:

- Total pages is not a major consideration for performance. For example, instances hosting 80K of pages can consume under 512 meg of memory
- **Always use an external database**, and check out the performance tuning guides.

As mentioned on the documentation for Operating Large or Mission-Critical Confluence Installations, some important steps are loadtesting your usecase and monitoring the system continuously to find out where your system could do better and what might need to improve in order to scale further.

**Maximum reported usages**

These values are largest customer instances reported to Atlassian or used for performance testing. Clustering for load balancing, database tuning and other performance tuning is recommended for instances exceeding these values.
## Most Spaces
Most Internal Users
Most LDAP Users
Most Pages

## Hard disk requirements

All wiki content is stored in the database, while attachments use either the database or filesystem. For example, the wiki instance you are reading now uses approximately 1 GB of database space and 9.4 GB of disk space.

Here is a breakdown of the disk usage requirements for this wiki, as at December 2008:

<table>
<thead>
<tr>
<th>Data</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Database size</strong></td>
<td>1003 MB</td>
</tr>
<tr>
<td><strong>Home directory size</strong></td>
<td>9.4 GB</td>
</tr>
</tbody>
</table>

### Size of selected database tables

<table>
<thead>
<tr>
<th>Data</th>
<th>Rows</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content bodies (incl. all versions of blogs, pages and comments)</td>
<td>170462</td>
<td>145 MB</td>
</tr>
<tr>
<td>Content metadata (incl. title, author)</td>
<td>188697</td>
<td>48 MB</td>
</tr>
<tr>
<td>Content and user properties</td>
<td>193652</td>
<td>42 MB</td>
</tr>
<tr>
<td>Users</td>
<td>20679</td>
<td>5.8 MB</td>
</tr>
<tr>
<td>Attachment metadata</td>
<td>25718</td>
<td>5.0 MB</td>
</tr>
<tr>
<td>Labels</td>
<td>43235</td>
<td>4.5 MB</td>
</tr>
</tbody>
</table>

Note: not all database tables or indexes are shown, and average row size may vary between instances.

### Size of selected home directory components

<table>
<thead>
<tr>
<th>Data</th>
<th>Files</th>
<th>Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attachments (incl. all versions)</td>
<td>27484</td>
<td>5.9 GB</td>
</tr>
<tr>
<td>Usage index (now disabled)</td>
<td>240</td>
<td>2.6 GB</td>
</tr>
<tr>
<td>Search index</td>
<td>10</td>
<td>236 MB</td>
</tr>
<tr>
<td>Office Connector cache</td>
<td>44</td>
<td>222 MB</td>
</tr>
<tr>
<td>Temporary files</td>
<td>7269</td>
<td>201 MB</td>
</tr>
<tr>
<td>Plugin files</td>
<td>1508</td>
<td>139 MB</td>
</tr>
<tr>
<td>Thumbnails</td>
<td>10154</td>
<td>84 M</td>
</tr>
<tr>
<td>Did-you-mean search index</td>
<td>3</td>
<td>9.9 MB</td>
</tr>
</tbody>
</table>
Note: not all files are shown, and average file size may vary between instances.

**Private and public comparison**

Private instances manage their users either internally or through a user repository such as LDAP, while online instances have public signup enabled and must handle the additional load of anonymous internet visitors. Please keep in mind that these are examples only, not recommendations:

<table>
<thead>
<tr>
<th>Use Case</th>
<th>Space(s)</th>
<th>User Accounts</th>
<th>Editor(s)</th>
<th>Editor To Viewer Ratio</th>
<th>Pages</th>
<th>Page Revisions</th>
<th>Attachments</th>
<th>Comments</th>
<th>Total Data Size (GB)</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Documentation</td>
<td>140</td>
<td>11,500</td>
<td>1,000</td>
<td>9%</td>
<td>8,800</td>
<td>65,000</td>
<td>7,300</td>
<td>11,500</td>
<td>10.4</td>
<td></td>
</tr>
<tr>
<td>Private Intranet</td>
<td>130</td>
<td>180</td>
<td>140</td>
<td>78%</td>
<td>8,000</td>
<td>84,000</td>
<td>3,800</td>
<td>500</td>
<td>4.5</td>
<td></td>
</tr>
<tr>
<td>Company-Wide Collaboration</td>
<td>100</td>
<td>85,000</td>
<td>1,000+</td>
<td>1%+</td>
<td>12,500</td>
<td>120,000</td>
<td>15,000</td>
<td></td>
<td></td>
<td>Accenture - see slides and video for full details</td>
</tr>
</tbody>
</table>

(That link isn't working, but the slides can be found here.)

**Professional assistance**

For large instances, it may be worthwhile contacting an Atlassian Expert for expertise on hardware sizing, testing and performance tuning. Simply contact a local Expert directly or email our Experts team for a recommendation.

**Example Size and Hardware Specifications From Customer Survey**

Below are the results of a survey conducted by Atlassian in July 2007, showing some capacity statistics for Confluence users. The figures are broken down by industry and number of users.
<table>
<thead>
<tr>
<th>Num Users</th>
<th>Length of time in production</th>
<th>Database</th>
<th>Application Server</th>
<th>Num CPUs/Cores</th>
<th>Physical Memory/RAM</th>
<th>Operating System</th>
<th>Satisfaction with Confluence Performance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Banking/Finance</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>26 - 50</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Windows</td>
<td>Neutral</td>
</tr>
<tr>
<td>26 - 50</td>
<td>2 Years Ago</td>
<td>Sybase ASE</td>
<td>Weblogic</td>
<td>&gt;8</td>
<td>&gt;16G</td>
<td>Unix</td>
<td>Satisfied</td>
</tr>
<tr>
<td>51 - 250</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>4G</td>
<td>Unix</td>
<td>Neutral</td>
</tr>
<tr>
<td>501 - 1,000</td>
<td>3-6 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Websphere</td>
<td>2</td>
<td>2G</td>
<td>AIX</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>3-6 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>4G</td>
<td>Windows</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>2 Years Ago</td>
<td>Oracle</td>
<td>Websphere</td>
<td>4</td>
<td>&gt;16G</td>
<td>Solaris</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>5,001 - 10,000</td>
<td>10-12 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>4</td>
<td>16G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td><strong>Education</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-25</td>
<td>2 Years Ago</td>
<td>DB2</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>26 - 50</td>
<td>10-12 Months Ago</td>
<td>MySQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Linux</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>51 - 250</td>
<td>&lt;3 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1G</td>
<td>Windows</td>
<td>Unsatisfied</td>
<td></td>
</tr>
<tr>
<td>Customer Type</td>
<td>Time Ago</td>
<td>Database</td>
<td>Application</td>
<td>CPU</td>
<td>RAM</td>
<td>OS</td>
<td>Satisfaclion Level</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>---------------------------------</td>
<td>-------</td>
<td>-------</td>
<td>----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>51 - 250</td>
<td>10-12 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1</td>
<td>2G</td>
<td>Unix</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Engineer/Aerospace</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>251 - 500</td>
<td>7-9 Months Ago</td>
<td>Oracle</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1</td>
<td>1G</td>
<td>Mac OS X</td>
<td>Satisfied</td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>7-9 Months Ago</td>
<td>Microsoft SQL Server</td>
<td>JBoss</td>
<td>2</td>
<td>4G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>Entertainment</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1,001 - 5,000</td>
<td>10-12 Months Ago</td>
<td>PostgreSQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>8G</td>
<td>Linux</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Government</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>51 - 250</td>
<td>2 Years Ago</td>
<td>MySQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>2</td>
<td>2G</td>
<td>Mac OS X</td>
<td>Extremely Satisfied</td>
</tr>
<tr>
<td>Technology</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>501 - 1,000</td>
<td>7-9 Months Ago</td>
<td>MySQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1</td>
<td>2G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td>Telecommunications &amp; Media</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-25</td>
<td>3-6 Months Ago</td>
<td>Confluence distribution /HSQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1</td>
<td></td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
<tr>
<td></td>
<td>7-9 Months Ago</td>
<td>MySQL</td>
<td>Confluence distribution /Apache Tomcat</td>
<td>1</td>
<td>2G</td>
<td>Linux</td>
<td>Satisfied</td>
</tr>
</tbody>
</table>
Running Confluence in a Virtualised Environment

This page provides pointers for things to look at when running Confluence on virtualised hardware.

Summary

Running Confluence in a virtual machine (VM) requires specialised skills to set up and manage the virtualised environment. In particular, the performance of Confluence can be affected by the activity of other VMs running on the same infrastructure, as well as how you configure the Confluence VM itself.

Atlassian supports Confluence sites running on a virtualised environment, but we can only offer support for problems which are unrelated to the environment itself. You will need to understand and be prepared to manage your own virtualised environment if you wish to run Confluence on such a platform.

On this page:
- Summary
- Recommendations
- Further help

Related pages:
- Server Hardware Requirements Guide
- Performance Testing Scripts
- Operating Large or Mission-Critical Confluence Installations
- Confluence Installation Guide

Recommendations

The following recommendations come from our experience in running and testing Confluence in virtualised environments like VMWare and KVM, and our experience in working with customers running on these platforms.

- **Know your platform.** Consult the documentation for your operating system and your chosen virtualisation technology, for details on setting up a reliable VM (virtual machine) image.
- **Allocate enough memory.** As a Java web application, Confluence requires a relatively large memory allocation, compared to some other web technologies. Ensure that your VM images have enough physical memory allocated to run Confluence without swapping.
- **Handle high I/O.** Under normal usage, Confluence requires a significant number of input/output (I/O) operations to the database and home directory for each web request. Ensure that you use the correct drivers and consider how you make storage available to your VMs to optimise this access.
- **Handle peak CPU and memory usage.** For certain operations (including PDF export, Office document processing, and displaying large pages) Confluence requires a significant amount of CPU and memory. Ensure that your virtualisation infrastructure has the flexibility and capacity to deal with peak load, not just idle load.
- **Synchronise time correctly.** Some customers have had problems with time synchronisation between the VM and the host system. This causes problems in Confluence due to irregularities in the execution of scheduled tasks. We strongly recommend checking your VM time sync if you have issues with scheduled tasks in a virtualised environment.

Further help

For further assistance in setting up a virtualised environment for running Confluence, you may want to consult an Atlassian Expert. Several experts have experience with installation and performance tuning, and can help you...
with your Confluence configuration.

Confluence Installation Guide

Prerequisites

Before beginning to install Confluence, please check that:

- Your system meets the minimum system requirements to run Confluence.
- This version of the Confluence documentation matches the version of Confluence that you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the 'breadcrumb trail' in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the documentation home page.

Choose the Confluence Installation Type

Choose the type of Confluence installation you'd like from the table below, and follow the link(s) to the installation instructions.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Confluence on Windows</td>
<td>Install Confluence via the Atlassian installer. This is the easiest method</td>
</tr>
<tr>
<td>Installing Confluence on Linux</td>
<td>of installing Confluence. This is the best option for evaluators.</td>
</tr>
<tr>
<td>Installing from a Zip File on Windows</td>
<td>This option requires you to manually carry out installing the files and</td>
</tr>
<tr>
<td>Installing From an Archive File on</td>
<td>configuring system properties. Use this option if there is no specific</td>
</tr>
<tr>
<td>Linux</td>
<td>installer for your operating system.</td>
</tr>
<tr>
<td>EAR/WAR distribution (Zip Archive)</td>
<td>This distribution allows you to deploy Confluence onto your own existing</td>
</tr>
<tr>
<td>Confluence Clusters (Zip Archive)</td>
<td>application server, instead of the Apache Tomcat server bundled with the</td>
</tr>
<tr>
<td></td>
<td>regular distribution.</td>
</tr>
<tr>
<td></td>
<td>Install Confluence as a series of clusters, to improve performance or</td>
</tr>
<tr>
<td></td>
<td>availability. Please read the Confluence Clustering Overview and the</td>
</tr>
<tr>
<td></td>
<td>Cluster Checklist before you consider installing Confluence in a cluster.</td>
</tr>
</tbody>
</table>

Please read Running Confluence in a Virtualised Environment if you are interested in running Confluence in a virtual machine.
If you wish to upgrade Confluence, see Upgrading Confluence.

Related Topics

Upgrading Confluence
System Requirements

Installing Confluence

Choose the type of Confluence installation you'd like from the table below and follow the link to the installation instructions. When you have finished the installation phase, you will be prompted to start the setup phase.

<table>
<thead>
<tr>
<th>Installation Type</th>
<th>Description</th>
</tr>
</thead>
</table>
• Installing Confluence on Windows
• Installing Confluence on Linux

Install Confluence via the Atlassian installer. This is the easiest method of installing Confluence.

ℹ️ This is the best option for evaluators.

• Installing from a Zip File on Windows
• Installing From an Archive File on Linux

This option requires you to manually carry out installing the files and configuring system properties.

ℹ️ Use this option if there is no specific installer for your operating system.

If you have not already done so, please verify that this version of the Confluence documentation matches that of the Confluence version you are installing. The Confluence documentation version you are currently viewing is indicated toward the top of the page tree on the left or in the ‘breadcrumb trail’ in the top banner of this page. If you need to access a different version of the Confluence documentation, use the control at the top of the page tree on the left or you can access it from the documentation home page.

Take me back to the Confluence Installation Guide.

Installing Confluence on Windows

This guide describes how to install a new Confluence installation on Windows using the automated ‘Windows Installer’. You can also install Confluence from a ‘zip’ archive — see Installing Confluence on Windows from Zip File for details.

If you are upgrading Confluence, please refer to the Upgrading Confluence guide.

⚠️ Please Note:

• Some anti-virus or other Internet security tools may interfere with the Confluence installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.

• Before you begin installing Confluence, please read the System Requirements page.

On this page:

• Using the Installation Wizard
  1. Download and Run the Confluence ‘Windows Installer’
  2. Starting Confluence
  3. Run the Setup Wizard
  4. Next Steps
• Performing an Unattended Installation
  • Download and Run the Confluence ‘Windows Installer’ in Unattended Mode

Using the Installation Wizard

Use the installation wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in ‘unattended mode’ without any user input required (see below for details).

1. Download and Run the Confluence ‘Windows Installer’

⚠️ To install Confluence as a service, the Windows Installer must be run using a Windows administrator account. While you can run the Windows Installer with a non-administrator account, your installation options will be much more limited.

1. Download the Confluence ‘Windows Installer’ (.exe) file from the Confluence Download page.
2. Run the installer file to start the installation wizard.
   If a Windows 7 (or Vista) 'User Account Control' dialog box requests if you want to allow the installation wizard to make changes to your computer, click 'Yes'. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.

3. Choose between the 'Express Install' or 'Custom Install' options:
   a. **Express Install** — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the installation wizard. If you want to customise any of these options, click the 'Back' button and choose the 'Custom Install' option instead.
   b. **Custom Install** — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the installation wizard and pre-populated with default values):
      - The 'Destination Directory' in which to install Confluence.
      - The Confluence Home Directory (which must be unique for each Confluence installation).
      - The Windows 'Start' menu folder options.
      - The TCP ports (i.e. an HTTP connector port and a control port) that Confluence will operate on.
      - If you are running the installer using an administrator account, you will be prompted to 'Install Confluence as a service' (recommended). You can also do this manually later, as described in [Start Confluence Automatically on Windows as a Service](#).

4. The installation wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes. Confluence will also be launched automatically in your browser window if you chose this option.

**Please Note:**

- If you chose to install Confluence as a service, the Confluence service will be run as the Windows 'SYSTEM' user account. To change this user account, see [Changing the Windows user that the Confluence service uses](#).
- If you do not install Confluence as a service, then once started, Confluence will be run as the Windows user account under which Confluence was installed.
- If you use Confluence running on a Windows Server in production, we strongly recommend creating a dedicated user account (e.g. with username 'confluence') for running Confluence.
  - For more information about creating a dedicated user account and defining which directories this account should have write access to, refer to our [guidelines](#).
  - If your Windows Server is operating under Microsoft Active Directory, ask your Active Directory administrator to create a dedicated user account that you can use to run Confluence (with no prior privileges).
  - If Confluence is installed as a service, do not forget to change the user account that runs the Confluence service to your dedicated user account for running Confluence.

**2. Starting Confluence**

If Confluence is not already started, you can start Confluence using the appropriate Windows 'Start' menu shortcut or command prompt option.

Once Confluence is started, you can access Confluence from the appropriate Windows 'Start' menu shortcut or a browser on any computer with network access to your Confluence server.

**2.1 Windows 'Start' Menu Shortcuts**

The Installer will have created the following Windows 'Start' menu shortcuts:
• **Access Confluence** — opens a web browser window to access your Confluence application.
  
  * Your Confluence server must have been started for this shortcut to work.

• **Start Confluence Service** — starts up the Apache Tomcat application server which runs your Confluence installation, so that you can access Confluence through your web browser.

• **Stop Confluence Service** — stops the Apache Tomcat application server which runs your Confluence installation. You will not be able to access Confluence through your web browser after choosing this shortcut.

• **Uninstall Confluence** — uninstalls Confluence from your Windows operating system.

### 2.2 Starting and Stopping Confluence from a Command Prompt

Enter the `bin` subdirectory of your Confluence installation directory and run the appropriate file:

• `start-confluence.bat` (to start Confluence)
• `stop-confluence.bat` (to stop Confluence)

* If you followed our guidelines for running Confluence with a dedicated user account, then to run Confluence as this user account (e.g. 'confluence'), use the `runas` command to execute `start-confluence.bat`. For example:

  ```
  > runas /env /user:<DOMAIN>\confluence start-confluence.bat
  (where <DOMAIN> is your Windows domain or computer name.)
  ```

### 2.3 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:

```
http://<computer_name_or_IP_address>:<HTTP_port_number>
```

where:

• `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
• `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

* If Confluence does not appear in your web browser, you may need to change the port that Confluence runs on.

### 3. Run the Setup Wizard

See the Confluence Setup Guide.

### 4. Next Steps

• See Confluence 101.

• If you did not install Confluence as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Windows as a Service.

• To get the most out of Confluence, please see Performance Tuning.

#### Performing an Unattended Installation

If you have previously installed Confluence using the installation wizard (above), you can use a configuration file from this Confluence installation (called `response.varfile`) to re-install 'unattended mode' without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same
configuration.

**Please Note:**

- The `response.varfile` file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
- If you intend to modify the `response.varfile` file, please ensure all directory paths specified are absolute, for example, `sys.installationDir=C:\Program Files\Atlassian\Confluence` Unattended installations will fail if any relative directory paths have been specified in this file.

**Download and Run the Confluence 'Windows Installer' in Unattended Mode**

1. Download the Confluence 'Windows Installer' (.exe) file from the Confluence Download Center to a suitable location.
2. Open the Windows command prompt and perform the remaining steps in the command prompt.
3. copy the `response.varfile` file located in the `.install4j` subdirectory of your previous Confluence installation directory, to the same location as the downloaded 'Windows Installer' file.
   - You can uninstall your previous Confluence installation after this step. Save your `response.varfile` if you need to install Confluence on multiple machines.
4. Change directory (cd) to the location of the 'Windows Installer' file and run the following command:

   ```
   atlassian-confluence-X.Y.exe -q -varfile response.varfile
   ```

   Where:
   - `X.Y` — refers to the version of Confluence you are about to install.
   - `-q` — instructs the installer to operate in unattended mode (i.e. 'quietly').
   - `-varfile response.varfile` — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `-varfile` option.
5. Confluence will start automatically when the silent installation finishes. Continue from step 2 Starting Confluence (above).

**Installing Confluence on Windows from Zip File**

- Confluence distributed as an archive file. This distribution includes Apache Tomcat as the application server.
- **Windows** systems. For other operating systems please refer to the Confluence Installation Guide .
- Manual installation and configuration using a zipped download file. For a simpler installation process, please use the Confluence Installer instead.

Also, please check that the version of Confluence which you are installing coincides with the version that this documentation is written for.

**On this page:**

1. **Before you Start**

   Please check the following points:
   
   1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please refer to our Supported Platforms topic and for further details, our System Requirements topic.
   2. Have your Confluence license key ready. You can obtain a trial, free or commercial license now, or retriev
1. **Install Java**

Please refer to Installing Java for Confluence. If you are certain that this has already been installed and that the JAVA_HOME environment variable has been correctly configured, then proceed to the next step.

2. **Download the Confluence Installation File**

1. If you have not downloaded Confluence already, download the zip file.
2. Please check your unzip program before extracting the downloaded zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one of these before continuing:
   - 7Zip (recommended). If in doubt, download the ‘32-bit.exe’ version.
   - WinZip.
3. Use your unzip program to unzip the installation file to a directory such as c:\confluence.
   - Do not use spaces in your directory path.

   i The directory into which you unzipped the Confluence installation is called the Confluence Installation directory. Next, you will define the Confluence Home directory.

3. **Define your Confluence Home Directory**

Now you need to define the Confluence Home directory. This is where Confluence will store its configuration information, indexes and attachments.

   Tip: Another term for 'home directory' would be 'data directory'.

We suggest using different paths for your installation and home directories. This will facilitate easier upgrades.

   i **Examples of Installation and Home Directories**

   Installation directory: c:\confluence\confluence-vX.X
   Home directory: c:\confluence\data

1. Open your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under the Installation directory, open this file: confluence\WEB-INF\classes\confluence-init.properties in a text editor such as Notepad.
3. Scroll to the bottom of the text and find this line:

   ```
   # confluence.home=c:/confluence/data
   ```

4. Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home
5. If you decide to change the Confluence Home directory from the default, please note the following:
   - Avoid spaces in the directory path or file name.
   - Use forward slashes '/' to define the path.

   For example:

   ```
   confluence.home=c:/data/confluence-home
   ```

4. **Check the Ports**

`...`
If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have an installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port '8090'. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

```
<Server port="8000" shutdown="SHUTDOWN" debug="0">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
      port="8090" minProcessors="5" maxProcessors="75"
      enableLookups="true" redirectPort="8443" acceptCount="10"
      debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
```

You need to modify both the server port (default is 8000) and the connector port (default is 8090) to ports that are free on your machine. The server port is required by Tomcat but is not user facing in any way. The connector port is what your users will use to access Confluence, eg in the snippet above, the URL would be `http://example.com:8090`.

Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector"
      port="8099" minProcessors="5" maxProcessors="75"
      enableLookups="true" redirectPort="8443" acceptCount="10"
      debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
```

To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

⚠️ You should also ensure at this point that if you are using a firewall, it is configured to allow http/https traffic over the port you have chosen.

You will find more information on this page.

---

6. Select an External Database

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements topic for help in choosing an external database.

External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled
with Confluence and should not be used in production.

When you have chosen your external database, follow the appropriate database setup guide to set up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the database setup guide during the Confluence Setup Wizard. (See step 8 below.)

7. Start Confluence

1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: startup.bat. A command prompt window should appear.

⚠️ Please do not close this command prompt window. If you do so, Confluence will stop running.

### Troubleshooting

If the window closes immediately when started, this means that an error is preventing Confluence from starting. To view this error:

- a. Open a command prompt: Click on your 'Start' menu, then click 'Run'. In the Run box, type `cmd` and click 'OK'.
- b. From the command prompt, go to your Confluence Installation directory.
- c. Go into the bin subdirectory.
- d. Run catalina.bat run.

⚠️ You should not run startup.bat at this point, because that would still produce a popup window that would close straight away.

- e. Read the error message.
- f. Find the solution to that error in the Installation Troubleshooting section of the Confluence Knowledge Base.

3. Once Confluence is running, open a web browser and visit `http://localhost:8090/`.

⚠️ If you changed the port earlier, use the port you specified in step 5 above.

⚠️ If your web browser window shows an error, try waiting for 30 seconds or so and then refresh the browser page.

8. Next Step is the Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.

9. Start Confluence automatically on Windows as a Service

Confluence should be run as a service.

Related Topics

- Change listen port for Confluence
- Running Confluence Over SSL or HTTPS
- Confluence Setup Guide
- Configuring Confluence
- Confluence Documentation Home
- Uninstalling Confluence from Windows

This page describes the procedure for uninstalling an instance of Confluence which has been installed using the Windows Installer.

To uninstall Confluence from Windows:
1. Log in to Windows as the same user that was used to install Confluence with the Windows Installer.
2. Start the uninstaller by doing either of the following:
   - Click the Windows Start Menu > All Programs > Confluence > Uninstall Confluence
   - OR
   - Open the Windows Control Panel, choose Add or Remove Programs (on Windows XP) or Programs and Features on (Windows 7, Vista) and then select Confluence X.Y from the list of applications and click Uninstall/Change.
   - OR
   - Open the Windows command prompt and do the following:
     a. Change directory to your Confluence installation directory
     b. Run the uninstall.exe file
3. Follow the prompts to uninstall Confluence from your computer.

Please note:
- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log folder located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the -q option at the Windows command prompt — i.e. uninstall -q
- If you wish to re-install Confluence in 'unattended mode', do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.

Installing Confluence on Linux
This guide describes how to install a new Confluence installation on Linux using the automated 'Linux Installer'.
You can also install from a 'zip' archive — see Installing Confluence on Linux from Archive File for details.
If you are upgrading Confluence, please see Upgrading Confluence.

**Please Note:**
- It is possible that any anti-virus or other Internet security tools installed on your Linux operating system may interfere with the Confluence installation process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence installation.
- You may also wish to consider disabling the Linux OutOfMemory Killer (OOM Killer). This is a Linux function that can kill processes when memory on the server becomes low, and sometimes targets Confluence.
- Before you begin installing Confluence, please read the System Requirements page.

*Using the Console Wizard*

Use the console wizard if you are installing Confluence on your server for the first time or you wish to specify your installation options.

If you have previously installed Confluence using the installation wizard and wish to re-install Confluence again with the same installation options, you can re-install Confluence in 'unattended mode' without any user input required (see below for details).

1. **Download and Install the Confluence 'Linux Installer’**

   If you execute the Linux Installer with 'root' user privileges, the installer will create and run Confluence using a dedicated user account. You can also execute the Linux Installer without 'root' user privileges, although your installation options will be much more limited and a dedicated user account (to run Confluence) will not be created. To run Confluence as a service, the Linux Installer must be executed with 'root' user privileges.
1. Download the appropriate Confluence 'Linux 64-bit / 32-bit Installer' (.bin) file from the Confluence Download page.

   Please Note:
   - To access the 32-bit installer, you may need to click the 'Show all' link on the 'Confluence Download' page to access the other installation packages.
   - The difference between the 64-bit / 32-bit .bin installers relates to their bundled Java platforms that run Confluence. Bear in mind that a Confluence installation installed using the 64-bit installer may require additional memory (to run at a similar level of performance) to a Confluence installation installed using the 32-bit installer. This is because a 64-bit Java platform's object references are twice the size as those for a 32-bit Java platform.

2. Open a Linux console and change directory (cd) to the '.bin' file's directory.

   Please Note:
   If the '.bin' file is not executable after downloading it, make it executable, for example:
   
   chmod a+x atlassian-confluence-X.Y.bin
   
   (where X.Y represents your version of Confluence)

3. Execute the '.bin' file to start the console wizard.

4. When prompted to choose between 'Express Install', 'Custom Install' or 'Upgrade an existing Confluence installation', choose either the 'Express Install' or 'Custom Install' options:

   - Express Install — If you choose this option, Confluence will be installed with default settings which are shown in the next step of the console wizard.

      Please Note:
      - If you are running the installer with 'root' user privileges, Confluence will be installed as a service.
      - If you want to customise any of these options:
        i. Enter 'e' to exit the console wizard.
        ii. Execute the console wizard again (step 3 above).
        iii. Choose the 'Custom Install' option instead.

   - Custom Install — If you choose this option, Confluence will prompt you to specify the following options (which are presented during subsequent steps of the console wizard and pre-populated with default values):

      - The 'Destination Directory' in which to install Confluence.
      - The Confluence Home directory (which must be unique for each Confluence installation).
      - The TCP ports (i.e. an HTTP and a Control port) that Confluence will run through.
      - If you are running the installer with 'root' user privileges, you will be prompted to 'Run Confluence as a service' (recommended). You can also do this manually later, as described in Start Confluence Automatically on Linux.

5. The console wizard will install Confluence onto your operating system and will start Confluence automatically when the wizard finishes.

   Please Note:
   If you executed the Linux Installer with 'root' user privileges, the Linux Installer creates a dedicated Linux user account with username 'confluence', which is used to run Confluence. This account has only:

   - Full write access to your Confluence Home Directory.
   - Limited write access to your Confluence Installation Directory.

   If you executed the Linux Installer without 'root' user privileges, be aware that Confluence can still be run with 'root' privileges. However, to protect the security of your operating system, this is not recommended.

2. Start Confluence

If Confluence is not already started, you can start Confluence using the appropriate command at the Linux console.
Once Confluence is started, you can access Confluence from a browser on any computer with network access to your Confluence server.

2.1 Starting and Stopping Confluence manually

In the Linux console, enter the bin subdirectory of your Confluence installation directory and execute the appropriate file:

- start-confluence.sh (to start Confluence)
- stop-confluence.sh (to stop Confluence)

Confluence will be ready to access (from a browser window) when the following message appears in the application's log file:

```
******************************************************
... You can now access Confluence through your web browser.
******************************************************
```

2.2 Accessing Confluence from a Browser

You can access Confluence from any computer with network access to your Confluence server by opening a supported web browser on the computer and visiting this URL:

```
http://<computer_name_or_IP_address>:<HTTP_port_number>
```

where:

- `<computer_name_or_IP_address>` is the name or IP address of the computer on which Confluence is installed and
- `<HTTP_port_number>` is the HTTP port number specified when you installed Confluence (above).

If Confluence does not appear, you may need to change the port that Confluence runs on.

Note: Application server logs (i.e. for Apache Tomcat) will be written to logs/catalina.out.

3. Run the Setup Wizard

See the Confluence Setup Guide.

4. Next Steps

- See Confluence 101.
- If you did not install Confluence to run as a service, you will need to start Confluence manually every time you restart your computer. To change your Confluence installation to run as a service, please see Start Confluence Automatically on Linux.
- To get the most out of Confluence, please see Performance Tuning.

Performing an Unattended Installation

If you have previously installed Confluence using the console wizard (above), you can use a configuration file from this Confluence installation (called response.varfile) to re-install Confluence in 'unattended mode' without any user input required.

Installing Confluence in unattended mode saves you time if your previous Confluence installation was used for testing purposes and you need to install Confluence on multiple server machines based on the same configuration.

[Please Note:]
• The `response.varfile` file contains the options specified during the installation wizard steps of your previous Confluence installation. Hence, do not uninstall your previous Confluence installation just yet.
• If you intend to modify the `response.varfile` file, please ensure all directory paths specified are **absolute**, for example, `sys.installationDir=/opt/atlassian/confluence`

Unattended installations will fail if any relative directory paths have been specified in this file.

**Download and Run the Confluence 'Linux Installer' in Unattended Mode**

1. Download the Confluence 'Linux Installer' (.bin) file from the Confluence Download Center to a suitable location.
2. Open a Linux console.
3. Copy (`cp`) the file `.install4j/response.varfile` located in your previous Confluence installation directory, to the same location as the downloaded 'Linux Installer' file.
   
   You can uninstall your previous Confluence installation after this step. Save your `response.varfile` if you need to install Confluence on multiple machines.

4. Change directory (`cd`) to the location of the 'Linux Installer' file and execute the following command:

   ```bash
   atlassian-confluence-X.Y.bin -q -varfile response.varfile
   ```

   Where:
   • `X.Y` — refers to the version of Confluence you are about to install.
   • `-q` — instructs the installer to operate in unattended mode (i.e. 'quietly').
   • `-varfile response.varfile` — specifies the configuration file containing the configuration options used by the installer. The location and name of the configuration file should be specified after the `-varfile` option.

5. Confluence will start automatically when the silent installation finishes. Continue from the step above, **Starting Confluence**.

**Installing Confluence on Linux from Archive File**

• Confluence distributed as an archive file. The distribution includes Apache Tomcat as the application server.
• **Linux or Solaris** systems. If you are installing Confluence on a different system, please refer to **Installing Confluence**.

Also, please check the version of Confluence which you are installing. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.

**Hint:** If you are evaluating Confluence on Solaris or you are unsure which version to install, this is the one to use.

**On this page:**

• 1. Before you Start
• 2. Install Java
• 3. Download and Extract the Confluence Installation File
• 4. Define your Confluence Home Directory
• 5. Check the Ports
• 6. Select an External Database
• 7. Start Confluence
8. Confluence Setup Wizard

1. Before you Start

Please check the following points:

1. Ensure that your system meets the minimum requirements to run Confluence. For more information, please read the detailed System Requirements.
2. Have your Confluence license key ready. You can obtain a trial, free or commercial license now, or retrieve your existing license key.
3. You must be able to use a command prompt and install Java to continue. If not, please contact your system administrator to assist you or consider the Confluence Hosted evaluation option.
4. Make sure that you use a Gnu version of zip application - Solaris and AIX are known to have problems with zip, because they use their own (old) versions instead of the Gnu version.

2. Install Java

Please refer to the Supported Platforms for the required version of Java. (OpenJDK is currently not supported. A JIRA issue to request support for this JDK has been created.)

1. If you are not sure whether you have Java installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type `echo $JAVA_HOME` in the shell console and then press Enter
   c. View the result:
      - If a line is displayed such as `/opt/jdk1.6.0_12` or `/usr/lib/jvm/java-6-sun`, then Java is installed and properly configured.
      - If nothing is displayed, then you either need to install Java or set the `JAVA_HOME` environment variable. You can set this environment variable in your user account's 'profile' file.
        Alternatively, you can set this after installing Confluence (in step 4 below) by defining this path in your Confluence installation's setenv.sh file, usually located in the Confluence bin directory.
        - If you have installed an unsupported JDK and you want to use SSL then you need to install the Sun JSSE package.

2. If you need to install Java, follow these instructions:
   - Go to the Java download page.
   - Download the latest JRE or JDK that is listed on the Confluence Supported Platforms page. (Confluence works with either the JDK or the JRE.)
   - When the download has finished, run the Java installer. Detailed installation instructions are provided on Oracle's website.
     Note: you will be asked to choose an installation directory. Make a note of this directory for use later.

3. Download and Extract the Confluence Installation File

1. If you have not downloaded Confluence already, download the TAR.GZ file.

Use your unzip program to unzip the installation file to a directory such as `/home/jsmith/confluence-2.7.0-std/`.

Most Linux/Solaris users can use any unzip program (such as GNU Tar) to extract the Confluence installer. However, Solaris users should not use the Solaris Tar program due to a known issue associated with its use in extracting Confluence. Use another application such as GNU Tar instead.

For example, change directory to your home directory in Linux and enter the following commands in the shell console:
gunzip confluence-<version>-std.tar.gz

```
tar -xf confluence-<version>-std.tar
```

(where <version> refers to the Confluence version you downloaded.)

As usual on Linux/Solaris-based operating systems, avoid using spaces in your directory path. The directory into which you unzipped the Confluence installation is called the Confluence Installation directory. Next you will define the Confluence Home directory.

4. Define your Confluence Home Directory

Now you need to define the Confluence Home directory. This is where Confluence will store its configuration information, indexes and attachments.

Tip: Another term for 'Home directory' would be 'data directory'.

We suggest using different paths for your installation and home directories. This will facilitate upgrades.

Examples of Installation and Home Directories:

- **Installation directory:** `/usr/local/confluence/`
  
  If you wish to install or maintain multiple versions of Confluence, you can add a version number to the Confluence installation directory name like `/usr/local/confluence-3.1-std/` and optionally, create the symbolic link `/usr/local/confluence/` that points to `/usr/local/confluence-3.1-std/`

- **Home directory:** `/usr/local/confluence-data/`

1. Open your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under the Installation directory, find this file: `confluence/WEB-INF/classes/confluence-init.properties`
3. Open the `confluence-init.properties` file in a text editor.
4. Scroll to the bottom and find this line:

```
# confluence.home=c:/confluence/data
```

5. Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with `confluence.home`

6. If you decide to change the Confluence Home directory from the default, use an absolute path rather than a symbolic link to specify the path and file name. For example:

```
confluence.home=/home/jsmith/confluence-data/
```

5. Check the Ports

If you have another application running on your machine which is using the same ports that Confluence uses by default, you may need to change the port which Confluence will use. For example, if you have a installation of JIRA running on this machine, JIRA might be already using the port which Confluence requests by default.

By default, Confluence listens on port '8090'. If this port is already in use in your installation, follow these instructions to change the ports:

- To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:
You need to modify both the server port (default is 8000) and the connector port (default is 8090) to ports that are free on your machine. The server port is required by Tomcat but is not user facing in any way. The connector port is what your users will use to access Confluence, eg in the snippet above, the URL would be http://example.com:8090.

Hint: You can use netstat to identify free ports on your machine. See more information on using netstat on Windows or on Linux.

For example, here are the first four lines of a modified server.xml file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75"
      enableLookups="true" redirectPort="8443" acceptCount="10"
      debug="0" connectionTimeout="20000" useURIValidationHack="false"/>
    ...
```

To access Confluence in this configuration, point your web browser to http://localhost:8099/.

You should also ensure at this point that if you are using a firewall, it is configured to allow http/https traffic over the port you have chosen.

You will find more information on this page.

### 6. Select an External Database

This step is optional for users evaluating Confluence. However, if you are installing Confluence for production purposes, this step is mandatory. Please refer to the database requirements listed on our System Requirements topic for help in choosing an external database.

External databases are those listed on our Supported Platforms topic, excluding HSQLDB, which is bundled with Confluence and should not be used in production.

When you have chosen your external database, follow the appropriate database setup guide to set up your database to work with Confluence.

You can learn more about migration from an existing installation or use of the evaluation database here. You will continue to use the Database Setup Guide during the Confluence Setup Wizard. (See step 8 below.)

### 7. Start Confluence
1. Go to your Confluence Installation directory (created when you unzipped Confluence — see above).
2. Under your Confluence Installation directory, open the bin directory and run the startup script: start-conf
fluence.sh.
3. Once Confluence is running, open a web browser and visit http://localhost:8090/.
   Hint: If you changed the port earlier, use the port you specified in step 6 above.

8. Confluence Setup Wizard

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key.
Follow the instructions on the screens, and read more guidelines on the Confluence Setup Wizard.
Related Topics
Change listen port for Confluence
Running Confluence Over SSL or HTTPS
Confluence Setup Guide
Configuring Confluence
Documentation Home
Uninstalling Confluence from Linux

This page describes the procedure for uninstalling Confluence, which had been installed using the Linux Installer.

To uninstall Confluence from Linux:

1. Open a Linux console.
2. Change directory (cd) to your Confluence installation directory.
3. Execute the command uninstall. This command must be executed as the same user account that was used to install Confluence with the Linux Installer.
4. Follow the prompts to uninstall Confluence from your computer.

Please note:
- The uninstaller will not delete the Confluence Home Directory.
- All log files that were generated while Confluence was running will not be deleted.
- All files within the Confluence Installation Directory will be deleted (with the exception of the Tomcat log folder located in the Confluence Installation Directory).
- The uninstaller can be made to operate in unattended mode by specifying the -q option — i.e. uninstall -q
- If you wish to re-install Confluence in 'unattended mode', do not uninstall your previous installation of Confluence just yet. See Using the Silent Installation Feature for more information.

Change listen port for Confluence

Problem

This page tells you what to do if you get errors like the following when starting Confluence, when you can't access Confluence on port 8090.

If you see this error:

java.net.BindException: Address already in use: JVM_Bind:8090

This means you are running other software on Confluence's default port of 8090. This may be another other process running on the same port. It may also be a previous instance of Confluence that hasn't been shut down cleanly.
To find out what process is listening on that port, load a command prompt and type: `netstat -an`

- `a`: Displays all active TCP connections and the TCP and UDP ports on which the computer is listening.
- `n`: Displays active TCP connections, however, addresses and port numbers are expressed numerically and no attempt is made to determine names.

There is also a Process Explorer tool available to determine what is binding port 8090.

**Solution:** Change the Ports which Confluence Listens On

To change the ports for Confluence, open the file `conf/server.xml` under your Confluence Installation directory. The first four lines of the file look like this:

```
<Server debug="0" shutdown="SHUTDOWN" port="8000">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8090" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false" />
    ...
  </Service>
</Server>
```

You need to modify both the `server` port (default is 8000) and the `connector` port (default is 8090) to ports that are free on your machine. The `server` port is required by Tomcat but is not user facing in any way. The `connector` port is what your users will use to access Confluence, e.g. in the snippet above, the URL would be `http://example.com:8090`.

Hint: You can use `netstat` to identify free ports on your machine. See more information on using `netstat` on Windows or on Linux.

For example, here are the first four lines of a modified `server.xml` file, using ports '8020' and '8099':

```
<Server debug="0" shutdown="SHUTDOWN" port="8020">
  <Service name="Tomcat-Standalone">
    <Connector className="org.apache.coyote.tomcat4.CoyoteConnector" port="8099" minProcessors="5" maxProcessors="75" enableLookups="true" redirectPort="8443" acceptCount="10" debug="0" connectionTimeout="20000" useURIValidationHack="false" />
    ...
  </Service>
</Server>
```

To access Confluence in this configuration, point your web browser to `http://localhost:8099/`.

⚠️ You should also ensure at this point that if you are using a firewall, it is configured to allow http/https traffic over the port you have chosen.

**NOTES**

[1] For more information on `netstat`, see using `netstat` on Windows, or `netstat` man page (Linux).
The JIRA distribution runs on port 8080 by default. If you're looking to change the port of the JIRA distribution, see Changing JIRA Standalone's port.

RELATED PAGES

Installing Confluence
Documentation Home

Installing the Confluence EAR-WAR Edition

The Confluence EAR-WAR distribution is intended for deployment into an existing J2EE application server.

To use this method of installation, you need to know how to deploy a web application on an existing application server. If not, please use the Confluence distribution instead.

On this page:

- Step 1. Check the System Requirements and Known Issues
- Step 2. Download and Extract EAR-WAR Installation File
- Step 3. Review Application Server Memory Allocation
- Step 4. Configure confluence-init.properties
- Step 5. Edit Tomcat Context Descriptors
- Step 6. Add UTF-8 Encoding
- Step 7. (Optional) Configure Tomcat to Run on a Different Port
- Step 8. (Optional) Configure Confluence to Run as a Windows Service
- Step 8. Run the Confluence Setup Wizard
- Notes

Step 1. Check the System Requirements and Known Issues

1. Please check the Confluence system requirements.
2. In addition to the above requirements, the EAR-WAR distribution requires the Apache Tomcat application server. For more information on Confluence's supported application servers, please refer to our Supported Platforms page.
3. If deploying as an unexploded WAR, Ant 1.3 or later is required. This is bundled with the WAR download.
4. Confluence, the database and application server must use the same character encoding. UTF-8 is recommended.
5. Deploying multiple Atlassian applications in a single Tomcat container is not supported. We do not test this configuration and upgrading any of the applications (even for point releases) is likely to break it. There are also a number of known issues with this configuration (see this FAQ for more information).
6. We also do not support deploying multiple Atlassian applications to a single Tomcat container for a number of practical reasons. Firstly, you must shut down Tomcat to upgrade any application and secondly, if one application crashes, the other applications running in that Tomcat container will be inaccessible.
7. Finally, we recommend not deploying any other applications to the same Tomcat container that runs Confluence, especially if these other applications have large memory requirements or require additional libraries in Tomcat's lib subdirectory.
8. Read through the Known Issues for Apache Tomcat.

Step 2. Download and Extract EAR-WAR Installation File

This section gives detailed instructions for installing Confluence EAR-WAR edition on an Apache Tomcat 5.5, or 6 server.

1. Download the Confluence EAR/WAR zip file. (You need to click the 'Show all' link to see the EAR/WAR zip file.)
2. Please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file:
   - Windows users must avoid the Windows built-in unzip utility, as it doesn’t extract all the files. Use a third-party unzip program like 7Zip or Winzip.
   - Solaris users will need to use GNU tar to handle the long file names.
3. Extract the downloaded zip file.
4. You have now unzipped your Confluence installation directory, which should contain the version number e.g. confluence-4.0.1 or confluence-4.0.2. This directory will be later referred to as the Confluence installation directory. Inside is a confluence subdirectory, referred to later as the (Exploded) Confluence WAR directory. Record the absolute path to the Confluence WAR directory.

Step 3. Review Application Server Memory Allocation

Confluence requires a maximum heap allocation (Xmx) of at least 256 MB for normal operation. Also, remember to set the maximum PermGen memory allocation (XX:MaxPermSize). See Increasing Application Server Memory.

⚠️ Do not configure a heap allocation so large that it does not allow enough remaining physical memory for your operating system and other applications on the server. The heap allocation should be large enough for Confluence, but not so large that the memory would be paged to disk during normal operation.

Step 4. Configure confluence-init.properties

1. Inside the Confluence installation directory, edit the confluence_WEB-INF/classes/confluence-init.properties in a text editor.
2. Now define your Confluence Home directory, by setting the confluence.home property to a directory of your choosing.
   - We suggest using different paths for your installation and home directories. This will facilitate upgrades. This is the directory that will contain all of Confluence's configuration, backup and attachment files.
   - Tip: Another term for 'Home directory' would be 'data directory'.
   - Make sure the user that runs Tomcat has full write access to the Confluence Home directory

Step 5. Edit Tomcat Context Descriptors

1. Create a file called confluence.xml and save in the conf/Catalina/localhost sub-directory of Tomcat. If these directories don’t exist you can create them manually.
2. Open your new confluence.xml file and add these lines:

   ```xml
   <Context path="/confluence"
   docBase="<CONFLUENCE_INSTALLATION_DIRECTORY_PATH>/confluence" debug="0"
   reloadable="true">
   </Context>
   ```

⚠️ More on Context Path

To run Confluence without a context path, change the path in the Context tag to an empty string ("""). If not using a context path, your config will need to be saved as ROOT.xml rather than confluence.xml.

In Tomcat, a context path name follows the name of its xml file (except for ROOT.xml where no context path is used. Hence if you wish to change the context path to a different name, change both the context path and the name of the xml file. eg. "/wiki" context path should be saved in file wiki.xml.
3. For `docBase`, specify the value you noted down earlier.
4. Restart Tomcat, and Confluence should be accessible under `/confluence/` on your Tomcat server.
5. Follow the link below to proceed with the setup wizard.

Step 6. Add UTF-8 Encoding

1. Edit `conf/server.xml` and find the line where the Coyote HTTP Connector is defined. It will look something like this, possibly with more parameters:

   ```xml
   <Connector port="8080"/>
   ```

2. Add a `URIEncoding="UTF-8"` property to the connector:

   ```xml
   <Connector port="8080" URIEncoding="UTF-8"/>
   ```

Step 7. (Optional) Configure Tomcat to Run on a Different Port

See Switching to Apache Tomcat.

Step 8. (Optional) Configure Confluence to Run as a Windows Service

Confluence can be run as a service.

Step 8. Run the Confluence Setup Wizard

Once Confluence is running, open a web browser and visit `http://localhost:8080/` (Tomcat default port).

If you changed the port earlier, use the port you specified. Note that the Confluence installer normally uses port 8090 as the default, to avoid conflicts with JIRA (using port 8080).

The Confluence Setup Wizard should appear in your web browser, prompting you to enter your license key. Follow the instructions on screen, and read more guidelines on the Confluence Setup Wizard.

Notes

- Tomcat users, take care not to unzip the Confluence installation into your Tomcat `webapps` folder, as this may cause Confluence to be deployed more than once. It may cause a Cluster Panic error.
- If you deploy Confluence on an unsupported server, server-related issues cannot be covered by Atlassian technical support. You can try Atlassian Answers for assistance instead.

Known Issues for Apache Tomcat

On this page:
- Supported Application Servers
- Tomcat Documentation
- Known Issues

Supported Application Servers

Check the list of supported application servers on the Supported Platforms topic.

Tomcat Documentation

An excellent resource for Tomcat configuration is the Apache documentation.

Known Issues

Confluence Menus Do Not Work, or Confluence Fails to Start when Running in the Same Application Server
Confluence Does Not Start Due to NullPointerException in FelixOsgiContainerManager
Installation or Upgrade of Confluence 4.0 EAR-WAR Fails on Red Hat or CentOS
HTML Macros Fail after Upgrading to 3.4 or Later Due to External URL References to Local Resources
Setup Fails Creating MySQL Schema Due to Tomcat Incompatibility
Confluence Can't Start and Doesn't Create Logfiles due to CATALINA_HOME Being Set
Confluence Startup Referencing a Different Tomcat
Unable to Install Service on Windows Vista
Login Fails After Upgrade
Installing UPM 2.7.2 or later on versions of Tomcat prior to 6 fails
Unable to Enable Workbox's Notifications and Tasks - Host Plugin Due to NoClassDefFoundError
Confluence Deadlocks when Running under Tomcat 6.0.24
Universal Plugin Manager stops working after upgrade to v4.3.5 or v4.3.6
Unable to Configure Confluence to Run as a Service on Tomcat 5
Application Servers Troubleshooting
"NoSuchMethodError: javax.servlet.ServletContext.getContextPath()" when starting Confluence
'All threads (150) are currently busy, waiting. Increase maxThreads (150) or check the servlet status' Due to High Volume Transactions
Unable to Start Tomcat after Confluence User Management Delegation to JIRA
Confluence Does Not Start due to 'Error deploying configuration descriptor'
NotSerializableException on Shutdown
Slow Page Rendering of Large Pages Due to HTTP POST Limitations
Fix 'Not supported by BasicDataSource' Setup or Startup Error
Tomcat 6.0.26 or higher Shutdown Reports 'A web application created a ThreadLocal .... ThreadLocal has been forcibly removed'
Tomcat fails to start with "The system could not find the environment option that was entered."

RELATED TOPICS
Running Confluence behind Apache
Configuring a MySQL Datasource in Apache Tomcat
Installing Java for Confluence

This page contains instructions for installing a Java Development Kit (JDK). This is a manual step that is only required for Confluence installations where you are installing from a zip or archive file.

If you are using the automated installer, the required Java files are bundled and will be automatically put in place, hence you will not need to follow the instructions on this page.

Please refer to our Supported Platforms topic for details of the Java versions that are supported for Confluence.

Installing the JDK

A JDK (Java Development Kit) needs to be installed on the same server machine that will have Confluence installed.

For Windows: (click to expand)
Installing the JDK on Windows

1. If you are not sure whether you have a JDK installed, please confirm by doing the following:
   - Check Control Panel > Programs and Features in Windows 7 (just Programs on older version of Windows).
   - Java should appear as a line item in the list. If not, you do not have Java installed.

2. To install the JDK, follow these instructions:
   - Go to the Java download page.
   - Download the version entitled 'Java SE Update XX (JDK)', where 'XX' stands for some number. (The latest version will be available on that page.)
   - When the download has finished, run the Java installer. At one point, you will be asked to choose a directory to install to. Copy or write this directory down for use later.

3. Check that the JAVA_HOME environment variable has been set correctly.
   - Open the Start menu, choose Run, type cmd in the Run dialog box and click OK.
   - In the command prompt window, type echo %JAVA_HOME% and then press Enter.
   - View the result:
     - If a directory path is displayed that looks similar to one of the following examples, with the letters 'JDK' immediately preceding a series of version numbers, and this path matches the location where you installed the JDK in step 2, then your JDK has been successfully installed and your JAVA_HOME environment variable has been set correctly.

Example of typical JAVA_HOME environment variable values:
- C:\Program Files\Java\JDK7
- C:\Program Files\Java\JDK7
- C:\Java\JDK7
- C:\JDK7

   - If nothing is displayed or you do not see 'JDK' immediately followed by a series of version numbers (like one of the examples above), then you need to set the JAVA_HOME environment variable. Please follow these instructions to set your JAVA_HOME environment variable to the directory you where you have just installed the JDK. By default, this directory is under C:\Program Files\Java.

**Note:** Any Java or JDK version numbers on this page are examples only. Please refer to the Supported Platforms page for the supported versions of Java.

For Linux: (click to expand)

Installing the JDK on Linux

1. If you are not sure whether you have JDK installed correctly, please confirm by doing the following:
   a. Open a shell console.
   b. Type echo $JAVA_HOME in the shell console and then press Enter
   c. View the result:
      - If a line is displayed such as /opt/JDK7 or /usr/lib/jvm/java-7, then your JDK is installed and properly configured.
      - If nothing is displayed, then you either need to install the JDK or set the $JAVA_HOME environment variable. You can set this environment variable in your user account’s ‘profile’ file. Alternatively, you can set this after installing Confluence (in step 4 below) by defining this path in your Confluence installation’s setenv.sh file, usually located in the Confluence bin directory.
      - If you have installed an unsupported JDK and you want to use SSL then you need to install the Sun JSSE package.

2. If you need to install the JDK, follow these instructions:
   - Go to the Java download page.
Download the version entitled 'Java SE Update XX (JDK)', where 'XX' stands for some number. (The latest version is available on that page.)

When the download has finished, run the Java installer. Detailed installation instructions are provided on Oracle's website.

**Note:** Any Java or JDK version numbers on this page are examples only. Please refer to the Supported Platforms page for the supported versions of Java.

Setting the JAVA_HOME Variable in Windows

- **Note:** This information is only relevant if you are installing Confluence on a Windows server.

After you have installed the Java Runtime Environment (JRE) in Windows, you must set the JAVA_HOME environment variable to point to the JRE installation directory.

**Stage 1. Locate the JRE Installation Directory**

If you already know the installation path for the Java Runtime Environment, go to **Stage 2** below. Otherwise, find the installation path by following these instructions:

1. If you didn't change the installation path for the Java Runtime Environment during installation, it will be in a directory under `C:\Program Files\Java`. Using Explorer, open the directory `C:\Program Files\Java`.
2. Inside that path will be one or more subdirectories such as `C:\Program Files\Java\jre6`.

**Stage 2. Set the JAVA_HOME Variable**

Once you have identified the JRE installation path:

1. Right-click the **My Computer** icon on your desktop and select **Properties**.
2. Click the **Advanced** tab.
3. Click the **Environment Variables** button.
4. Under **System Variables**, click **New**.
5. Enter the variable name as `JAVA_HOME`.
6. Enter the variable value as the installation path for the Java Development Kit.
   - If your Java installation directory has a space in its path name, you should use the shortened path name (e.g. `C:\Progra~1\Java\jre6`) in the environment variable instead.

**Note for Windows users on 64-bit systems**

- `Progra~1 = 'Program Files'`
- `Progra~2 = 'Program Files(x86)'`

7. Click **OK**.
8. Click **Apply Changes**.
9. Close any command window which was open before you made these changes, and open a new command window. There is no way to reload environment variables from an active command prompt. If the changes do not take effect even after reopening the command window, restart Windows.
10. If you are running the Confluence EAR/WAR distribution, rather than the regular Confluence distribution, you may need to restart your application server.

**Related Topics**

- Starting Tomcat as a Windows Service
- Installing Confluence in Linux
- Confluence Cluster Installation
Overview

There are two methods of installing Confluence in a cluster, depending on whether you have existing data. This page describes a fresh installation with no existing data.

See also Confluence Cluster Installation with Existing Data.

Oracle Coherence Licensing Change:

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).

  **Important:** If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.

- For more information about these changes, please refer to the Coherence License Changes document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the Confluence 3.0.1 Upgrade Notes for additional upgrade information.

Installation with no existing data

To get Confluence running in a two-node cluster, you must do the following:

1. Ensure you meet the clustering requirements, including obtaining a clustered license key from Atlassian for each node.
2. Install Confluence on a single node, configuring an external database and a cluster name.
3. Load test the single node installation, see whether clustering is required.
4. Shut down the first node, copy the Confluence application and Confluence home directory to the second node.
5. Start the first node, wait until it is running, then bring up the second node and it will automatically join the cluster.
6. Test the cluster is working correctly.
7. Configure a load balancer in front of the two clustered nodes.

Each of these steps will be described in detail below.

1. **Clustering requirements**

Your Confluence cluster installation must meet all the following criteria for clustering:

- You must have a clustered license.
- You must use an external database.
- You must use a load balancer with session affinity in front of the cluster.

Clustered commercial licenses may be purchased through Confluence website. Clustered evaluation licenses may be obtained by emailing sales@atlassian.com.

A cluster can run using two copies of Confluence. However, cluster administrators must understand how to configure an application server and web server with load balancing, so we recommend you are comfortable installing Confluence as a EAR/WAR in your application server before proceeding with a clustered installation.

2. **Installation on first node**

Cluster administrators should already be comfortable with the normal installation method, so it won't be repeated.
here. There are two differences in the Confluence Setup Wizard from a normal installation:

- You must use an external database.
- You must enter a cluster name.

Enter a cluster name to create a new cluster

**Technical note**
The cluster name will be converted into a unique multicast IP address and port for your Confluence cluster. UDP multicast traffic is used for Confluence to automatically discover other nodes in the cluster when they start up.

3. Load test the single node

Most Confluence installations do not need to be clustered. Ensure you have tested your single node installation with the number of users you expect to host before going ahead with the additional complexity of clustering.

Check out our performance tuning tips for ways to improve the performance of a single instance of Confluence.

You can upgrade your single node to a multi-node cluster at any time by resuming this guide from step 4 below.

4. Copy Confluence to second node

Confluence clusters must use the same JDK, application server and application. The easiest way to ensure this is to shut down Confluence on the first node, then copy its web application and home directory to the second node:

1. Shut down Confluence on node #1.
2. Shut down your application server on node #2, or stop it automatically loading web applications.
3. Copy the Confluence web application from node #1 to node #2.
4. Copy the Confluence home directory from node #1 to node #2.
5. If the node #1 and node #2 filesystem structures are different, update the /confluence/WEB-INF/classes/confluence-init.properties file on in the web application directory of node #2 to point to the Confluence home directory path on node #2.

Copying the web application ensures any modifications you have made to the application itself, custom LDAP settings (atlassian-user.xml), and any other advanced configuration are copied to node #2.

Copying the home directory ensures the Confluence search index (the index/ directory), the database and cluster configuration (confluence.cfg.xml), and any other home directory settings are copied to node #2.

5. Start Confluence on the first node, wait, then start Confluence on second node

For the most stable start-up process, it is important to start Confluence one server at a time:

1. Start Confluence on node #1.
2. Wait for Confluence to become available on node #1.
3. Start Confluence on node #2.
4. Wait for Confluence to become available on node #2.

6. **Test cluster connectivity**

The Cluster Administration page (Administration, Cluster Configuration) includes information about the active cluster. When the cluster is running properly, this page displays:

- a correct count of the nodes in the cluster
- a status display for each node in the cluster
- an uptime for each node that is accurate.

![Cluster Configuration](image)

**Cluster Administration page**

A simple process to ensure your cluster is working correctly is:

1. Create a new document on node #1.
2. Ensure the new document is visible by accessing it directly on node #2.
3. Wait one minute (Confluence does batch indexing once per minute).
4. Search for the new document on node #1, ensure it appears.
5. Search for the new document on node #2, ensure it appears.

![Technical note]

If Confluence detects more than one instance accessing the database but not in a working cluster, it will shut itself down in a *cluster panic*. This can be fixed by troubleshooting the network connectivity of the cluster.

7. **Configure load balancer**

For the moment, configuring the load balancer is outside the scope of this document.

However, a simple Apache and Tomcat load-balancing configuration is available, which includes sample configuration for the Apache Tomcat and the Apache web server, using its load-balancing JK connector.

**Troubleshooting**

If you have problems with the above procedure, please see our Cluster Troubleshooting guide.

**Upgrading a cluster**

It is important that upgrades follow the procedure for Upgrading a Confluence Cluster.

**Related documentation**

---

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
Overview of Confluence Clusters
Clustering in Confluence
Confluence Cluster Installation with Existing Data
Confluence Installation Guide
Upgrading a Confluence Cluster
Cluster Administration page
Confluence Cluster Installation with Existing Data

Overview

There are two methods of installing Confluence in a cluster, depending on whether you have existing data. This page describes how to upgrade an existing Confluence instance into a cluster.

See also Cluster installation without existing data.

Oracle Coherence Licensing Change:
- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
    - **Warning:** If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).
- For more information about these changes, please refer to the Coherence License Changes document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the Confluence 3.0.1 Upgrade Notes for additional upgrade information.

Cluster installation from an existing copy of Confluence

BEFORE ATTEMPTING THIS, PLEASE MAKE A BACKUP. To upgrade an existing copy of Confluence to run in a two-node cluster, you must do the following:

1. Ensure that your version of the Confluence distribution has been upgraded to the version you want to run the Cluster on. **Do not upgrade your version of Confluence and switch to the clustered version at the same time.** First upgrade your system (e.g. from Confluence 2.5.8 to 2.7.1) and make sure everything works fine (e.g. for a week) before switching (e.g. from Confluence 2.7.1 to 2.7.1 Clustered)
2. Ensure you meet the clustering requirements, including obtaining a clustered license key from Atlassian for each node
3. Due to CONF-8959, you need to perform attachment migration to the database before you change your license to a clustered license
4. Upgrade the existing Confluence instance to a clustered license. Do this by going to Admin> Licence Details. Confluence should warn you that this version of Confluence is not capable of clustering.
5. Shutdown Confluence. Deploy a clustered version of Confluence (Do not attempt to install any version of Confluence that is not the Clustered equivalent to your current release). Edit confluence-init.properties (confluence-ver-clustered/confluence/WEB-INF/classes/confluence-init.properties) to set confluence.home to the same path as the old home. Start the first node, and verify that things are working correctly.
6. Shut down the first node, copy the Confluence application and Confluence home directory to the second node
7. Start the first node, wait until it is running, then bring up the second node and it will automatically join the cluster
8. Test the cluster is working correctly
9. Configure a load balancer in front of the two clustered nodes.

Each of these steps will be described in detail below.

1. Clustering requirements

Your Confluence cluster installation must meet all the following criteria for clustering:

- you must be running Confluence 2.3 or later
- you must have a clustered license
- you must use an external database
- you must use a load balancer with session affinity in front of the cluster.

Clustered commercial licenses may be purchased through Confluence website. Clustered evaluation licenses may be obtained by emailing sales@atlassian.com.

A cluster can run using two copies of the Confluence distribution. However, cluster administrators must understand how to configure an application server and web server with load balancing, so we recommend you are comfortable installing Confluence as an EAR/WAR in your application server before proceeding with a clustered installation.

You can follow the instructions to Migrate Confluence to an external database.

2. Upgrade existing instance to clustered license

Once you've obtained your clustered license from Atlassian, you can simply update the license in your running Confluence instance:

1. Go to 'Administration'.
2. Go to 'License Details', and paste in the new license.
3. Click 'Save'.

When you enter a clustered license, you will see a new line appear on this page: Licensed Clustered Nodes. This tells you how many nodes your Confluence license will allow.

<table>
<thead>
<tr>
<th>Organisation</th>
<th>Atlassian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Purchased</td>
<td>Aug 15, 2006</td>
</tr>
<tr>
<td>License Type</td>
<td>Confluence: Commercial Server</td>
</tr>
<tr>
<td>Licensed Users</td>
<td>Unlimited</td>
</tr>
<tr>
<td>Licensed Nodes</td>
<td>8 nodes (2 nodes currently clustered).</td>
</tr>
</tbody>
</table>

License Details page shows the number of cluster nodes permitted

3. Migrate your attachments to the Database

You can do this by navigating to Admin> Attachment Storage > Edit, and changing it to "Database".

4. Copy Confluence to second node

For the remaining steps in setting up a cluster with existing data, please continue from step 4 in the normal Confluence cluster installation guide.

5. Start Confluence on the first node, wait, then start Confluence on second node

See comment in step 4.

6. Test cluster connectivity
See comment in step 4.

7. Configure load balancer

See comment in step 4.

Troubleshooting

If you have problems with the above procedure, please see our Cluster Troubleshooting guide.

Upgrading a cluster

It is important that upgrades follow the procedure for Upgrading a Confluence Cluster.

Related documentation

Overview of Confluence Clusters
Confluence Cluster Installation
Confluence Installation Guide
Upgrading a Confluence Cluster
Confluence User Guide
Upgrading a Confluence Cluster

This page contains instructions for upgrading an existing Confluence cluster to a new version of Confluence. If you are not running a clustered instance of Confluence and wish to, see Confluence Cluster Installation with Existing Data.

Oracle Coherence Licensing Change:

- Due to a license agreement change, Confluence is now available in two editions:
  - **Standard Edition** — Confluence with Ehcache's caching technology (available to customers with non-clustered Confluence licenses).
  - **Clustered Edition** — Confluence with Oracle's Coherence clustering and distributed caching technology (available to customers with Confluence clustered licenses only).

  **If you are currently running a clustered installation of Confluence, please do not upgrade it with a standard edition of Confluence.**

- For more information about these changes, please refer to the Coherence License Changes document.
- If you have a Confluence clustered license, are running a clustered installation of Confluence and wish to upgrade to Confluence version 2.6 or later, please ensure that you download only a clustered edition of Confluence and please refer to the Confluence 3.0.1 Upgrade Notes for additional upgrade information.

You can download the latest version of Confluence from here.

Overview

The steps involved in upgrading a multi-node Confluence cluster are:

1. Backup your confluence instance.
2. Read the Release Notes for this version and check you have the required expertise to perform the upgrade.
3. Stop each node in the cluster.
4. Install the new version into the application server on the first node.
5. Install the new version into the application server onto the remaining nodes.

Step One: Backing up


For specific files to backup see Upgrading Confluence.

**Step Two: Things you need to check ...**

- Always check the release-notes for the version of Confluence you are installing for upgrade instructions specific to that version.
- To perform this upgrade you must be familiar with the usage of the application server running your Confluence Cluster, and the web server load balancing it.
- Check the Configuring Confluence for your application server and database, to make sure there isn't anything extra you need to do to get Confluence running.
- Check that you know what configurations or customisations have been made to your Confluence instance. These may include specialised user management configurations and changes to Confluence's Java classes and Velocity templates.

**Step Three: Stopping the cluster**

It is vital that all nodes in the cluster are running the same version of Confluence. That's why the first step is to stop all the nodes.

Stop the Confluence application on each node using your application server.

**Step Four: Upgrading the first node**

We advise configuring your load balancing web server to redirect traffic away from Confluence until the upgrade is complete on multiple nodes.

Upgrading a cluster node uses the same process as Upgrading Confluence.

1. Unzip the new version.
2. Edit its `confluence-init.properties` to point to the existing home directory.
3. Port any immediately required customisations from the old version to the new one. Eg `atlassian-user.xml`.
4. Install the new version into the application server. Eg for Tomcat edit `confluence.xml` or `server.xml` to point to the new location, and restart Tomcat.
5. Wait for the Node to finish upgrading and confirm that you can log in and view pages before continuing to Step Five.
6. Port any additional customisations from the old version to the new version. Eg modifications to Java classes or Velocity templates.

**Step Five: Upgrading other nodes**

Copy the confluence installation, complete with customisations, to the next node.

1. Edit its `confluence-init.properties` to point to the existing home directory.
2. Install the new version into the application server. Eg for Tomcat 5 edit `confluence.xml` to point to the new location, and restart Tomcat.
3. Wait for the Node to finish upgrading and confirm that you can log in and view pages before continuing with the next node.

**Troubleshooting**

For suggested troubleshooting techniques, see our Cluster Troubleshooting page.
Overview

The following is a description of how to set up a Confluence Cluster on a Windows machine using Apache and mod_jk to handle the load-balancing.

The characteristics of this cluster are:

- **Session affinity**: sessions are associated with single servers.
- **Failover**: if a server dies, a connection will be directed to the nearest available server. (NOTE: sessions are not replicated)
- **Failback**: when a server comes back online, it will rejoin the cluster.
- **Weighted load balancing**: the load balancing can be controlled to take into account machine differences. (See the mod_jk documentation for details on this.)

What do you need?

1. Download and install one copy of Apache httpd. Do not install Apache as a service, but set it to listen on port 8080. (Tested with Apache httpd 2.0.55.)
2. Download the latest version of mod_jk. Copy this file into the Apache modules/ directory and rename it to mod_jk.so. (Tested with JK-1.2.19.)
3. Download and extract one copy of the ZIP distribution of Apache Tomcat. (Tested with Tomcat 5.5.)

Apache configuration

Edit the main Apache config file, conf/http.conf:

- add the following immediately after the other LoadModule directives:

  ```
  LoadModule jk_module modules/mod_jk.so
  ```

- add the following just before the end of the file:

  ```
  JkWorkersFile conf/workers.properties
  JkLogFile logs/mod_jk.log
  JkLogLevel info
  JkMount /confluence loadbalancer
  JkMount /confluence/* loadbalancer
  ```

Create a workers.properties file in the Apache conf/ directory. This version of the workers.properties file is configured to use 2 Tomcat instances: tomcat1 and tomcat2.
Tomcat configuration

The Tomcat configuration below will run multiple instances from the same binaries in the main Tomcat directory. For complete documentation of this configuration, see the `RUNNING.txt` file in the Tomcat distribution.

Create instance home directories

Create a directory for each instance of Tomcat, somewhere outside where you installed Tomcat. For example, if you extracted Tomcat to `/opt/apache/tomcat-5.5`, your instances could be in `/var/tomcat-instances/tomcat1`, `/var/tomcat-instances/tomcat2`. These folders will be referred to as the **instance home directories**.

Copy the following folders from the Tomcat installation directory into each instance home directory. Some of the folders may be empty, but copy them anyway.

- conf
- logs
- shared
- webapps

Configure server.xml in each instance

Edit `conf/server.xml` in the instance home directories to include the Confluence application and have distinct listen ports for Server, HTTP Connector and AJP13 Connector. All nodes can use the same Confluence webapp as long as you set `confluence.home` via a system property (see startup scripts below).

Attached are two sample configurations:

- `tomcat1/conf/server.xml` - listens on port 18080 (http) and 18081 (ajp13)
- `tomcat2/conf/server.xml` - listens on port 28080 (http) and 28081 (ajp13)

To use these sample config files, you will need to edit them to set the Confluence web-app location and the data source configuration.

If editing the configuration files yourself, the points to note are:

- 'Server' port must be distinct
- 'Connector' for HTTP must be uncommented and use a distinct port. Use this port for testing the node individually.
- 'Connector' for AJP13 must be uncommented and use a distinct port. This port must match the port of the worker in the Apache `workers.properties`.
- 'Engine' for localhost must have `jvmRoute` matching the name of the worker in Apache's `workers.properties`.
- 'Context' for Confluence must be added inside the 'Host' tag, and include a 'Resource' for the datasource,
as per normal Confluence installation under Tomcat. Create a startup script for each instance

The startup scripts for each instance must set the CATALINA_BASE environment variable and confluence.home system property. The variables in the sample scripts below should reference:

- CATALINA_HOME - Tomcat installation directory
- CATALINA_BASE - Tomcat instance home directory (distinct for each node)
- JRE_HOME - Java runtime directory
- JAVA_OPTS - include a confluence-home system property (distinct for each node)

**tomcat1/startup.bat:**

```
set CATALINA_HOME=C:\home\mryall\opt\apache\apache-tomcat-5.5.16
set CATALINA_BASE=C:\home\mryall\var\tomcat-instances\tomcat1
set JRE_HOME=C:\Java\jre1.5.0_06
set JAVA_OPTS=-Dconfluence.home=C:\home\mryall\data\confluence\cluster\tomcat1
-Xmx512m
%CATALINA_HOME%\bin\startup.bat
```

**tomcat2/startup.bat:**

```
set CATALINA_HOME=C:\home\mryall\opt\apache\apache-tomcat-5.5.16
set CATALINA_BASE=C:\home\mryall\var\tomcat-instances\tomcat2
set JRE_HOME=C:\Java\jre1.5.0_06
set JAVA_OPTS=-Dconfluence.home=C:\home\mryall\data\confluence\cluster\tomcat2
-Xmx512m
%CATALINA_HOME%\bin\startup.bat
```

Continue setting up Confluence

Follow the Confluence Cluster Installation procedure with the steps following the app server setup.

Troubleshooting

**General advice**

The above tomcat configurations enable HTTP connectors on each Tomcat instance so that you can connect to the nodes individually. To check whether the load balancer (Apache & mod_jk) is causing the problem, try connecting to the individual Tomcat instances. Please note that you should not allow users to directly access individual nodes in production mode: You don't want people to bookmark nodes since the node details might change, or single nodes may be taken out of the cluster for maintenance while the cluster itself is still available.

**Session-affinity doesn't seem to be working?**

Ensure the name you use for your worker in workers.properties (e.g. tomcat1) matches the jvmRoute attribute of the engine tag in your Tomcat server.xml. For an example, search for 'Engine' in the [attached sample config](http://tomcat.apache.org/tomcat-5.0-doc/balancer-howto.html).

For troubleshooting your Confluence cluster, see Cluster Troubleshooting.

**References**

**General**


**Tomcat Clustering support**

Creating a Dedicated User Account on the Operating System to Run Confluence

This step is optional if you are evaluating Confluence, but should be mandatory for Confluence installations used in production. If you have used the Confluence installer on Linux, this user will be created automatically.

A dedicated user should be created to run Confluence, because Confluence runs as the user it is invoked under and therefore can potentially be abused. For example:

- If your operating system is *nix-based (for example, Linux or Solaris), type the following in a console:

  $ sudo /usr/sbin/useradd --create-home --comment "Account for running Confluence" --shell /bin/bash confluence

- If your operating system is Windows:

  1. Create the dedicated user account by either:
     - Typing the following at the Windows command line:
       
       > net user confluence mypassword /add /comment:"Account for running Confluence"
       
       (This creates a user account with user name 'confluence' and password 'mypassword'. You should choose your own password.)
     - Opening the Windows 'Computer Management' console to add your 'confluence' user with its own password.

  2. (Optional) Use the Windows 'Computer Management' console to remove the 'confluence' user's membership of all unnecessary Windows groups, such as the default 'Users' group.

    If Windows is operating under Microsoft Active Directory, ask your Active Directory administrator to create your 'confluence' account (with no prior privileges).

Ensure that only the following directories can be written to by this dedicated user account (e.g. 'confluence'):

- The following subdirectories of your Confluence Installation Directory:
  - logs
  - temp
  - work
- Your Confluence Home Directory.

Do not make the Confluence Installation Directory itself writeable by the dedicated user account.

See also Best Practices for Configuring Confluence Security.

Confluence Setup Guide

Before running the Confluence Setup Wizard, as described below, you should have already completed installing Confluence.

When you access Confluence in your web browser for the first time, you will see the Confluence Setup Wizard. This is a series of screens which will prompt you to supply some default values for your Confluence site. It will also offer some more advanced options for setting up data connections and restoring data from a previous installation.

1. Start the Setup Wizard

   1. If Confluence is not already running, start it now:
      - If you are running the Confluence distribution on Windows, click Start > Programs > Confluence > Start Confluence Server.
      - Or, run the start-up script found in the bin folder of your installation directory:
2. Go to the following web address in your web browser: http://localhost:8090
   The above web address uses port '8090'. If you chose a different port during installation, change '8090' to the number you chose.
   - You should see the licensing screen described below.
   - If an error message appears, first check that you are using the port which you specified during installation. Then check the Installation FAQ.

2. Enter your License Key
Find your Confluence license key and paste it into the License Key field, shown on the screenshot above.

If you already have a license key, you can retrieve it from the Atlassian website.

If you do not already have a Confluence license, you can obtain one now:

- To get a free evaluation license:
  1. Click generate an evaluation license online on the setup wizard, shown on the screenshot above.
  2. Follow the prompts to generate your license key and insert it into the setup wizard's licensing screen automatically.
To get a commercial, academic, non-profit or open source license:
1. Copy your Server ID from the setup wizard's licensing screen, shown on the screenshot above.
2. Choose the license type you need from the list on the Atlassian website.
3. Complete the online order form.

3. Choose your Installation Type

Refer to the screenshot above. In this step, you will choose whether you want an evaluation or a production installation.

**Option 1: Evaluation Installation** — Set up Confluence with the embedded HSQLDB database and default settings. This option will also install a Demonstration space with some example content to get you working with Confluence as quickly and easily as possible. You may upgrade to another type of database later on.

Who should choose this option?

- Choose the evaluation installation if you are evaluating Confluence or if you are new to Confluence.
- This option is not recommended for production instances of Confluence.

**For production use, we strongly recommend that you connect to an external database rather than using the embedded database. The evaluation installation is therefore not suitable for production environments.**

Next, you will be asked for details of your system administrator. Go to step 10 below. Yes, you really can skip all the steps between.

**Option 2: Production Installation** — Customise your Confluence instance to use your own database and your own data.

The production installation offers the following options:

- Connect Confluence to an external database. Recommended for Confluence used in production environments.
- Restore data from an existing Confluence database.
- Install Confluence without the demonstration content.

4. Production Installation: Database Configuration
The above screen appears if you have chosen a production installation of Confluence. You can choose to use the embedded database supplied with your Confluence installation, or to connect to an external database.

- **Option 1: Embedded Database** — If you select this option, Confluence will use an embedded HSQLDB database. You should only select this option for the purposes of evaluating or demonstrating Confluence. You can migrate to an external database later on if you wish.

- **Option 2: External Database** — If you wish Confluence to use an external database, select your database type from the dropdown list and then click the 'External Database' button.
  
  - For production purposes, you should use an external database to ensure your data is kept safe and consistent.
  
  - If you choose PostgreSQL, please make sure that the version you install is supported by Atlassian. It is possible that we do not yet support the latest version of PostgreSQL.
  
  - Read the page about supported platforms for more information about which databases are supported. For details about choosing an external database, refer to the page on system requirements. For information about configuring an external database, see Database Configuration.

5. Production Installation: External Database
You can choose how you wish Confluence to connect to your database - via a direct JDBC connection or via a server-managed datasource connection. Choose one of the two options below.

**Option 1: Direct JDBC** — This uses a standard JDBC database connection. Connection pooling is handled within Confluence.

Supply the following information:

- **Driver Class Name** — The Java class name for the appropriate database driver. This will depend on the JDBC driver, and will be found in the documentation for your database. You will also need to put the appropriate database driver 'jar' file in the server's classpath. For the Confluence distribution, this means copying the jar file into the `<confluence-install>/lib` directory.
- **Database URL** — The JDBC URL for the database you will be connecting to. This will depend on the JDBC driver, and will be found in the documentation for your database.
- **User Name** — A valid username which Confluence will use to access your database.
- **Password** — The password corresponding to the above username.

You will also need to know:

- The size of the connection pool Confluence should maintain. If in doubt, just go with the default provided.
- What kind of database you're connecting to, so you can tell Confluence which dialect it needs to use.

**Option 2: Datasource** — This asks the Java application server for a database connection. You will need to have configured a datasource into your application server.

**Character encoding:**
- We strongly recommend that character encoding is consistent across your database, application server and web application, and that you use **UTF-8** encoding.
- Before setting up your database, please read about configuring character encoding.

**Database name**: When creating a new external database, give it the name ‘confluence’.
Supply the following information:

- **Datasource Name** — The JNDI name of the datasource, as configured in the application server. Note: Some servers will have JNDI names like `jdbc/datasourcename`; others will be of the form `java:comp/env/jdbc/datasourcename`. Consult your application-server documentation.

You will also need to know:

- What kind of database you’re connecting to, so you can tell Confluence which dialect it needs to use.

### 6. Production Installation: Load Content

Select one of the following options:

- **Example Site** — This option will load Confluence's 'Demonstration Space'. Select this if you are using Confluence for the first time, or if you want the Demonstration Space for your other Confluence users. The Demonstration Space helps to familiarise you with Confluence and what it can do for you. You can then continue using your Confluence deployment as normal — there’s no need to reinstall later.

- **Empty Site** — Select this option if you are already familiar with Confluence. You will need to create at least one space before you can start adding content to the site.

- **Restore from Backup** — Select this option if you want to use Confluence data from a previous installation.

### 7. Production Installation: Restore Data from Backup

This option allows you to reload your data from an existing Confluence installation into your new Confluence site during the initial setup procedure. You can choose to upload data from a zipped backup file, or to restore from a
backup file on your file system.

Option 1: Upload a zipped backup to Confluence — This option will load the data from a zipped backup file. To create a backup file from your existing version of Confluence, go to the 'Backup & Restore' section of your Administration Console.

To restore from a zipped backup:

1. Browse for the relevant daily backup file or a file you have created via a manual backup.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Upload and Restore' button.

Option 2: Restore a backup from the filesystem — This option is recommended if you have a very large daily backup file (greater than 100MB), or a daily backup file that is already on the server and doesn't require uploading.

1. Copy the XML backup file into the restore directory inside your confluence Home directory and then refresh the page. You should now see your backup file appear on the 'Restore Data' screen (pictured above), in the box beneath the heading 'Restore a backup from the filesystem'.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Restore' button.

When the restore process has finished, you are ready to log in to Confluence. The system administrator account and all other information has been transferred from your previous Confluence installation.

8. Production Installation: Set Up User Management

You can choose to manage Confluence's users and groups inside Confluence or in JIRA.

- If you do not have Atlassian JIRA installed, or if you would prefer to set up external user management later, choose Manage users and groups within Confluence.
- If you have JIRA installed, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options. It will configure a JIRA user directory for Confluence, and set up application links between JIRA and
Confluence for easy sharing of data. Choose Connect to JIRA.

9. Production Installation: Connect to JIRA

![Confluence setup wizard](image)

Screenshot above: Connecting to JIRA in the Confluence setup wizard

Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:
  
  - http://www.example.com:8080/jira/
  - http://jira.example.com

- **JIRA Administrator Login: Username** – Enter the username of a user with the 'JIRA System Administrators' global permission in JIRA.

- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.

- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.
- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is `jira-users`. (These groups will receive the 'can use' permission in Confluence.)
- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is `jira-administrators`. (These groups will receive the 'Confluence system administrator' and 'Confluence administrator' permissions in Confluence.)

For full details and a troubleshooting guide, see Configuring JIRA Integration in the Setup Wizard.

### 10. Set Up System Administrator

![Setup System Administrator](image)

**Screenshot above: System administrator**

The system administrator has full administrative power over your Confluence instance. This person will be able to add more users, create spaces, and set further Confluence options. Please refer to the overview of global permissions for more information.

**Hint:** If you are evaluating Confluence, set yourself up as the administrator.

1. Enter the following information to set up your system administrator's user account:
   - **Username** — The username under which the system administrator will log in to Confluence, e.g. 'j smith'.
   - **Password** — The password which the system administrator will use to log in.
   - **Confirm** — Enter the same password again.
   - **Name** — The system administrator's full name, e.g. 'John Smith'.
   - **Email** — The system administrator's email address, e.g. 'j smith@example.com'.
2. Click 'Next'.

### 11. Setup is Complete

![Confluence Setup Successful](image)

**Screenshot above: Setup is complete**
Congratulations! You have installed and set up Confluence. Click Start using Confluence to open the Demonstration space in your Confluence wiki. This space contains some sample content and ideas, to help you get started quickly.

Click Further Configuration if you want to go directly to the Administration Console and complete administrator’s tasks including configuring a mail server, adding users, changing the base URL and more. Refer to the Confluence Administrator’s Guide for more information.

12. Fix an Internationalisation Problem

If you are installing Confluence 5.0 and you plan to configure Confluence for a language other than English, you will need to install a patch. This patch is available as a plugin. For more information, please refer to this article in our knowledge base: Nothing Happens when Users Click on the "Create" Button.

Note: This issue will be fixed in Confluence 5.0.1.

RELATED TOPICS

Confluence 101
Documentation Home

Load Content for the Site

This page is part of the Confluence Setup Guide.

Screenshot above: Load content

Select one of the following options:

- **Example Site** — This option will load Confluence's 'Demonstration Space'. Select this if you are using Confluence for the first time, or if you want the Demonstration Space for your other Confluence users. The Demonstration Space helps to familiarise you with Confluence and what it can do for you. You can
then continue using your Confluence deployment as normal — there's no need to reinstall later.

- **Empty Site** — Select this option if you are already familiar with Confluence. You will need to create at least one space before you can start adding content to the site.
- **Restore from Backup** — Select this option if you want to use Confluence data from a previous installation.

**Next Steps**

*Restore your data from backup*, if you have chosen that option.

Start using Confluence — see the [Confluence User's Guide](#).

**RELATED TOPICS**

Confluence Setup Guide  
Universal Wiki Converter  
Confluence User's Guide  
Confluence Documentation Home  

**Restoring from Backup During Setup**

This page is part of the Confluence Setup Guide.

This option allows you to reload your data from an existing Confluence installation into your new Confluence site during the initial setup procedure. You can choose to upload data from a zipped backup file, or to restore from a backup file on your file system.

**Option 1: Upload a zipped backup to Confluence** — This option will load the data from a zipped backup file.

To create a backup file from your existing version of Confluence, go to the 'Backup & Restore' section of your Administration Console.

To restore from a zipped backup:

1. Browse for the relevant daily backup file or a file you have created via a manual backup.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Upload and Restore' button.

**Option 2: Restore a backup from the filesystem** — This option is recommended if you have a very large daily backup file (greater than 100MB), or a daily backup file that is already on the server and doesn't require uploading.

1. Copy the XML backup file into the `restore` directory inside your confluence Home directory and then refresh the page. You should now see your backup file appear on the 'Restore Data' screen (pictured above), in the box beneath the heading 'Restore a backup from the filesystem'.
2. Check 'Build Index' to build the data index, used for the search.
3. Click the 'Restore' button.

When the restore process has finished, you are ready to log in to Confluence. The system administrator account and all other information has been transferred from your previous Confluence installation.

**RELATED TOPICS**

Confluence Setup Guide  
Confluence User's Guide  
Confluence Documentation Home  

**Configuring JIRA Integration in the Setup Wizard**

This page describes the Connect to JIRA step in the Confluence setup wizard.

**Overview**

You can connect your application to a JIRA server, to manage your users via JIRA and share information with
JIRA. When you are installing the application, the setup wizard gives you the opportunity to configure the JIRA connection automatically. This is a quick way of setting up your JIRA integration with the most common options.

You can also configure the JIRA connections via the application administration screens. In that case, you will need to set up connections individually. There are two parts to the integration process:

- A peer-to-peer link between JIRA and the application for sharing information and facilitating integration features. This link is set up via Application Links.
- A client-server link between the application and JIRA for delegating user and group management to your JIRA server.

Requirements: You need JIRA 4.3 or later.

### Connecting to JIRA in the Setup Wizard

[Image of JIRA setup wizard form]

- **Overview**
- **Connecting to JIRA in the Setup Wizard**
- **Troubleshooting**
  - Solution 1: Removing a Partial Configuration – The Easiest Way
  - Solution 2: Removing a Partial Configuration – The Longer Way
- **Notes**
Screenshot above: Connecting to JIRA in the Confluence setup wizard

Enter the following information:

- **JIRA Base URL** – The web address of your JIRA server. Examples:

  - http://www.example.com:8080/jira/
  - http://jira.example.com

- **JIRA Administrator Login: Username** – Enter the username of a user with the ‘JIRA System Administrators’ global permission in JIRA.

- **JIRA Administrator Login: Password** – Enter the password that the above user uses to sign in to JIRA.

- **Confluence Base URL** – JIRA will use this URL to access your Confluence server. The URL you give here will override the base URL specified in your Confluence administration console, for the purposes of the JIRA connection.

- **User Groups** – Specify one or more JIRA groups whose members should be able to use Confluence. The default group is `jira-users`. (These groups will receive the 'can use' permission in Confluence.)

- **Admin Groups** – Specify one or more JIRA groups whose members should have administrative access to Confluence. The default group is `jira-administrators`. (These groups will receive the 'Confluence system administrator' and 'Confluence administrator' permissions in Confluence.)

Troubleshooting

This section describes the possible problems that may occur when integrating your application with JIRA via the setup wizard, and the solutions for each problem.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The setup wizard displays one of the following error messages:</td>
<td>The setup wizard failed to complete registration of the peer-to-peer application link with JIRA. JIRA integration is only partially configured.</td>
<td>Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
<tr>
<td>- Failed to create application link from JIRA server at &lt;URL&gt; to this &lt;application&gt; server at &lt;URL&gt;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Failed to create application link from this &lt;application&gt; server at &lt;URL&gt; to JIRA server at &lt;URL&gt;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Failed to authenticate application link from JIRA server at &lt;URL&gt; to this &lt;application&gt; server at &lt;URL&gt;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Failed to authenticate application link from &lt;application&gt; server at &lt;URL&gt; to this JIRA server at &lt;URL&gt;.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Error Message</td>
<td>Possible Causes</td>
<td>Solution</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Failed to register &lt;application&gt; configuration in JIRA for shared user management. Received invalid response from JIRA: &lt;response&gt;</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
<tr>
<td>Failed to register &lt;application&gt; configuration in JIRA for shared user management. Received: &lt;response&gt;</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
<tr>
<td>The setup wizard successfully established the peer-to-peer link with JIRA, but could not persist the client-server link for user management in your config.xml file. This may be caused by a problem in your environment, such as a full disk.</td>
<td></td>
<td>Please investigate and fix the problem that prevented the application from saving the configuration file to disk. Then remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
<tr>
<td>Error setting Crowd authentication</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Restart your application. You should then be able to continue with the setup wizard. If this solution does not work, please contact Atlassian Support.</td>
</tr>
<tr>
<td>Error reloading Crowd authentication</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Remove the partial configuration if it exists, try the 'Connect to JIRA' step again, and then continue with the setup. Detailed instructions are below.</td>
</tr>
<tr>
<td>An error occurred: java.lang.IllegalStateException: Could not create the application in JIRA/Crowd (code: 500). Please refer to the logs for details.</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Go to JIRA and add some usernames to the group. For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is 'jira-users'. For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.</td>
</tr>
<tr>
<td>Possible causes:</td>
<td>If this solution does not work, please contact Atlassian Support.</td>
<td>Go to JIRA and add some usernames to the group. For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is 'jira-users'. For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.</td>
</tr>
</tbody>
</table>

No users can log in after you have set up the application with JIRA integration.

- There are no users in the group that you specified on the 'Connect to JIRA' screen.
- For FishEye: There are no groups specified in the 'groups to synchronize' section of your administration console.
- For Stash: You may not have granted any JIRA groups or users permissions to log in to Stash.

Go to JIRA and add some usernames to the group.

- For FishEye: Go to the FishEye administration screens and specify at least one group to synchronize. The default is 'jira-users'.
- For Stash: Grant the Stash User permission to the relevant JIRA groups on the Stash Global permissions page.

If this solution does not work, please contact Atlassian Support.
**Solution 1: Removing a Partial Configuration – The Easiest Way**

If the application’s setup wizard fails part-way through setting up the JIRA integration, you may need to remove the partial configuration from JIRA before continuing with your application setup. Please follow the steps below.

Remove the partial configuration if it exists, try the ‘Connect to JIRA’ step again, and then continue with the setup wizard:

1. Log in to JIRA as a user with the ‘JIRA System Administrators’ global permission.
2. Click the ‘Administration’ link on the JIRA top navigation bar.
3. Remove the application link from JIRA, if it exists:
   a. Click ‘Application Links’ in the JIRA administration menu. The ‘Configure Application Links’ page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the ‘Application URL’ matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the ‘Application URL’ matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the ‘Application URL’ matches the base URL of your Stash server.
   c. Click the ‘Delete’ link next to the application link that you want to delete.
   d. A confirmation screen will appear. Click the ‘Confirm’ button to delete the application link.
4. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click ‘Other Applications’ in the ‘Users, Groups & Roles’ section of the JIRA administration screen.
      - In JIRA 4.4: Select ‘Administration’ > ‘Users’ > ‘JIRA User Server’.
   b. Look for a link to your application. It will have a name matching this format:

   `<Type> - <HostName> - <Application ID>`

   For example:

   ```
   FishEye / Crucible - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   Or:

   ```
   Confluence - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   If you have multiple servers of the same type running on the same host, you will need to match the application ID of your application with the one shown in JIRA. To find the application ID:
   - Go to the following URL in your browser:

   `<baseUrl>/rest/applinks/1.0/manifest`

   Replace `<baseUrl>` with the base URL of your application.

   For example:
The application links manifest will appear. Check the application ID in the `<id>` element.

5. In JIRA, click 'Delete' next to the application that you want to remove.

Go back to the setup wizard and try the 'Connect to JIRA' step again.

Solution 2: Removing a Partial Configuration – The Longer Way

If solution 1 above does not work, you may need to remove the partial configuration and then add the full integration manually. Please follow these steps:

1. Skip the 'Connect to JIRA' step and continue with the setup wizard, to complete the initial configuration of the application.
2. Log in to JIRA as a user with the 'JIRA System Administrators' global permission.
3. Click the 'Administration' link on the JIRA top navigation bar.
4. Remove the application link from JIRA, if it exists:
   a. Click 'Application Links' in the JIRA administration menu. The 'Configure Application Links' page will appear, showing the application links that have been set up.
   b. Look for a link to your application. It will have a base URL of the application linked to JIRA. For example:
      - If you want to remove a link between JIRA and FishEye, look for the one where the 'Application URL' matches the base URL of your FishEye server.
      - If you want to remove a link between JIRA and Confluence, look for the one where the 'Application URL' matches the base URL of your Confluence server.
      - If you want to remove a link between JIRA and Stash, look for the one where the 'Application URL' matches the base URL of your Stash server.
   c. Click the 'Delete' link next to the application link that you want to delete.
   d. A confirmation screen will appear. Click the 'Confirm' button to delete the application link.
5. Remove the user management configuration from JIRA, if it exists:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click 'Other Applications' in the 'Users, Groups & Roles' section of the JIRA administration screen.
      - In JIRA 4.4: Select 'Administration' > 'Users' > 'JIRA User Server'.
   b. Look for a link to your application. It will have a name matching this format:

   `<Type> - <HostName> - <Application ID>`

   For example:

   ```plaintext
   FishEye / Crucible - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   Or:

   ```plaintext
   Confluence - localhost - 92004b08-5657-3048-b5dc-f886e662ba15
   ```

   If you have multiple servers of the same type running on the same host, you will need to match the
application ID of your application with the one shown in JIRA. To find the application ID:

- Go to the following URL in your browser:

  <baseUrl>/rest/applinks/1.0/manifest

Replace <baseUrl> with the base URL of your application.
For example:

  http://localhost:8060/rest/applinks/1.0/manifest

- The application links manifest will appear. Check the application ID in the <id> element.

6. Add the application link in JIRA again, so that you now have a two-way trusted link between JIRA and your application:
   a. Click ‘Add Application Link’. Step 1 of the link wizard will appear.
   b. Enter the server URL of the application that you want to link to (the ‘remote application’).
   c. Click the ‘Next’ button.
   d. Enter the following information:
      - ‘Create a link back to this server’ – Tick this check box to add a two-way link between the two applications.
      - ‘Username’ and ‘Password’ – Enter the credentials for a username that has administrator access to the remote application.
        Note: These credentials are only used to authenticate you to the remote application, so that Application Links can make the changes required for the new link. The credentials are not saved.
      - ‘Reciprocal Link URL’ – The URL you give here will override the base URL specified in your remote application's administration console, for the purposes of the application links connection. Application Links will use this URL to access the remote application.
   e. Click the ‘Next’ button.
   f. Enter the information required to configure authentication for your application link:
      - ‘The servers have the same set of users’ – Tick this check box, because the users are the same in both applications.
      - ‘These servers fully trust each other’ – Tick this check box, because you trust the code in both applications and are sure both applications will maintain the security of their private keys.
        For more information about configuring authentication, see Configuring Authentication for an Application Link.
   g. Click the ‘Create’ button to create the application link.

7. Configure a new connection for user management in JIRA:
   a. Go to the JIRA administration screen for configuring the applications that have been set up to use JIRA for user management:
      - In JIRA 4.3: Click ‘Other Applications’ in the ‘Users, Groups & Roles’ section of the JIRA administration screen.
      - In JIRA 4.4: Select ‘Administration’ > ‘Users’ > ‘JIRA User Server’.
   b. Add an application.
   c. Enter the application name and password that your application will use when accessing JIRA.
   d. Enter the IP address or addresses of your application. Valid values are:
      - A full IP address, e.g. 192.168.10.12.
      - A wildcard IP range, using CIDR notation, e.g. 192.168.10.1/16. For more information, see the introduction to CIDR notation on Wikipedia and RFC 4632.
- **Save** the new application.
- 8. Set up the JIRA user directory in the application.
  - **For Confluence:**
    a. Go to the **Confluence Administration Console**.
    b. Click 'User Directories' in the left-hand panel.
    c. **Add** a directory and select type 'Atlassian JIRA'.
    d. Enter the following information:
      - **Name** – Enter the name of your JIRA server.
      - **Server URL** – Enter web address of your JIRA server. Examples:
        ```
        http://www.example.com:8080/jira/
        http://jira.example.com
        ```
    e. **Application name and Application password** – Enter the values that you defined for Confluence in the settings on JIRA.
    f. Define the **directory order** by clicking the blue up- and down-arrows next to each directory on the 'User Directories' screen.
      For details see **Connecting to Crowd or JIRA for User Management**.
  - **For FishEye/Crucible:**
    a. Click **Authentication** (under ‘Security Settings’).
    b. Click **Setup JIRA/Crowd authentication**. Note, if LDAP authentication has already been set up, you will need to remove that before connecting to JIRA for user management.
    c. Make the following settings:

<table>
<thead>
<tr>
<th>Authenticate against</th>
<th>Select a JIRA instance</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application name and password</strong></td>
<td>Enter the values that you defined for your application in the settings on JIRA.</td>
</tr>
<tr>
<td><strong>JIRA URL</strong></td>
<td>The web address of your JIRA server. Examples:</td>
</tr>
</tbody>
</table>
| | ```
| | http://www.example.com:8080/jira/
| | http://jira.example.com
| | ``` |
| **Auto-add** | Select **Create a FishEye user on successful login** so that your JIRA users will be automatically added as a FishEye user when they first log in. |
| **Periodically synchronise users with JIRA** | Select **Yes** to ensure that JIRA will synchronize all changes in the user information on a regular basis. Change the value for **Synchronise Period** if required. |
When Synchronisation Happens | Select an option depending on whether you want to allow changes to user attributes from within FishEye.
---|---
Single Sign On | Select **Disabled**. SSO is not available when using JIRA for user management and if enabled will make the integration fail.

d. Click **Next** and select at least one user group to be synchronised from JIRA. If necessary, you could create a new group in JIRA, such as ‘fisheye-users’, and select this group here.
e. Click **Save**.

- **For Stash:**
  a. Go to the Stash administration area.
  b. Click **User Directories** in the left-hand panel.
  c. Add a directory and select type **Atlassian JIRA**.
  d. Enter the following information:
     - **Name** – Enter the name of your JIRA server.
     - **Server URL** – Enter web address of your JIRA server. Examples:
       
       ```
       http://www.example.com:8080/jira/
       http://jira.example.com
       ```
     - **Application name** and **Application password** – Enter the values that you defined for Stash in the settings on JIRA.
e. Save the directory settings.
  f. Define the directory order by clicking the blue up- and down-arrows next to each directory on the ‘User Directories’ screen.

Notes

- When you connect to JIRA in the setup wizard, the setup procedure will configure **Trusted Applications authentication** for your application. Please be aware of the following security implications:
  - Trusted applications are a **potential security risk**. When you configure Trusted Applications authentication, you are allowing one application to access another as any user. This allows all of the built-in security measures to be bypassed. Do not configure a trusted application unless you know that all code in the application you are trusting will behave itself at all times, and you are sure that the application will maintain the security of its private key.
  - In the next step, you will specify the username and password of your **Confluence system administrator**. If you have connected to JIRA, the setup wizard will add the Confluence administrator’s username and password to both JIRA and Confluence. This is done so that you can still access Confluence even if JIRA is down. Please note that the password in Confluence is not linked to the password in JIRA. If you subsequently change the administrator’s password, only the password in JIRA will change. This is because the JIRA user directory is placed first in the list of user directories. See **Managing Multiple Directories**.

Related Topics

- User Management Limitations and Recommendations
- Confluence Setup Guide
- Configuring Application Links
- Upgrading Confluence
This document describes the procedure for upgrading to the latest version of Confluence, on Windows or Linux.

Notes:

- **Incremental upgrades across major versions.** If you want to upgrade from one major version (first digit of version number) of Confluence to another, we recommend that you upgrade incrementally – do not skip a major version. For example, if you want to move from Confluence 3.x to Confluence 5.x, you should first upgrade from 3.x to 4.x, then from 4.x to 5.x. Note that there is no need for incremental upgrading when moving from one minor or point release to another within the same series. For example, you can move from Confluence 4.0.x directly to Confluence 4.3.x.
- **Last point release recommended.** We strongly recommend that you upgrade to the latest available point version of your target version. For example, if you want to move from Confluence 3.x to Confluence 4.3.x, you should choose Confluence 4.3.7 rather than 4.3.6.
- **Upgrading from an early version of Confluence.** If you are upgrading from a version earlier than Confluence 3.5, you must use the manual upgrade procedure. See Upgrading Confluence Manually.
- **Moving to a different OS, database or file location.** If you are changing the operating system that will run Confluence, the database it is using, or the location of its files, you must use the manual upgrade procedure. See Upgrading Confluence Manually.
- **Clustered Confluence.** The automatic installer/upgrader does not support upgrading clustered installations of Confluence. See Upgrading a Confluence Cluster.

### Upgrading to Confluence 5.0?

If so, please review the [Confluence 5.0 Release Notes](#) for important information about this version of Confluence. Ensure that you have read the [Confluence 5.0 Known Issues](#) in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the [Upgrade Notes Overview](#) page.

Finally, please check the [Supported Platforms](#) page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The [End of Support Announcements for Confluence](#) page has important information regarding supported platforms.

### On this page:

- **Before you Start**
- **Backing Up**
- **Testing the Upgrade in a Test Environment**
  - Upgrade Overview
  - Performing the Upgrade
    - Upgrading Confluence on Windows
    - Upgrading Confluence on Linux
  - Upgrade Check List
    - Back Up Your External Database
    - Check Plugin Compatibility

### Before you Start

- **Changing your Database?**
  
  If you are planning to change to a different database, we recommend that you complete the Confluence
Confluence 5.0 Documentation

1. Note that you need current **software maintenance** to perform the upgrade.
2. Confirm that your **license support period** is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please **update your license** in Confluence before performing the upgrade.
   ! If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on **upgrading beyond current license period**.
4. Check the **release notes** for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the **Upgrade Notes Overview** page. (Each upgrade notes page is a 'child' of its respective release notes page.)
5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence **System Requirements**. A newer version of Confluence may have different requirements than the previous version.
6. If you are using Confluence EAR-WAR edition, check **Installing the Confluence EAR-WAR Edition** to see if there is anything extra you will need to do to get Confluence running.
7. If you are using an external database, familiarise yourself with all **known issues** for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your **Administration** screens, and selecting **Confluence Upgrade Check**. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the **Atlassian Plugin Exchange**. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations **applied to your Confluence installation**.
10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.
11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

**Back Up**

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   ☝ Tip: Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory. The Confluence
installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation.

   The ‘embedded database’ is the HSQLDB database supplied with Confluence for evaluation purposes. You don’t need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database **before** the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The ‘Confluence Installation directory’ is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the ‘Confluence Install directory’.

### Testing the Upgrade in a Test Environment

**Be sure to test the upgrade in a test environment before proceeding on your production server.**

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

   **XML imports**

   Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence 4.0) **is not recommended.** Please **recreate** your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

### RELATED TOPICS

Upgrading Confluence

### Upgrade Overview

The upgrade feature of the Linux and Windows Installers automates the following tasks for you:

1. Backs up the **Installation** and **Home** Directories of the existing Confluence installation to be upgraded.

2. Installs **Confluence 5.0** whilst migrating the following from your existing Confluence installation to the new **Confluence 5.0** installation:
   - TCP port values in your existing Confluence installation's `server.xml` file. **Be aware that other configurations or customisations in this file are not migrated during upgrade, and will need to be re-applied.**
   - Custom values in your existing Confluence installation's `confluence-init.properties` (confluence.home property) and `setenv.sh` / `setenv.bat` files (`JAVA_OPTS` parameters)
The upgrade feature detects and notifies you of any files in the `confluence` subdirectory of your existing Confluence Installation Directory which have been deleted, added or modified from a 'default' Confluence installation. This informs you of any customisations you will need to migrate manually over to your upgraded Confluence installation directory. Note that modifications to files in directories other than `confluence` will not be detected when you upgrade to Confluence 4.0, for example any modifications to start-up scripts under the `bin` directory will not be detected. The next time you upgrade (e.g. to version 4.0.1) the the upgrade feature will cover modifications across the whole Confluence Installation Directory.

**Please Note:**

- The upgrade process requests that you conduct a backup of your database using your database’s backup utilities. If your database does not support online backups, you can stop the upgrade process, shut down Confluence, perform your database backup and then restart the upgrade process to continue on.
- If you have made customisations to your `server.xml` file or any other files in your Confluence installation directory which are not handled by the upgrade wizard, these must be re-applied manually.
- If your attachments and index files are located outside your Confluence Home Directory, then backups of these directories must be performed manually.

Performing the Upgrade

Refer to the appropriate upgrade instructions below for your operating system:

### Upgrading Confluence on Windows

1. Download the Confluence ‘Windows Installer’ (.exe) file (for the new version of Confluence) from the Confluence Download Center.
2. Run the `.exe` file to start the upgrade wizard.
   
   * If a Windows 7 (or Vista) 'User Account Control' dialog box requests if you want to allow the upgrade wizard to make changes to your computer, specify 'Yes'. If you do not, the installation wizard will have restricted access to your operating system and any subsequent installation options will be limited.
3. At the 'Upgrading Confluence?' step, choose the 'Upgrade an existing Confluence installation' option.
4. In the 'Existing Confluence installation directory' field, specify the Confluence Installation Directory of your Confluence installation to be upgraded.
   * The upgrade wizard will attempt to find an existing Confluence installation and use its location to pre-populate this field. However, always verify this location, particularly if you have multiple Confluence installations running on the same machine.
5. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:
   a. At the 'Back up Confluence directories' step, ensure the 'Back up Confluence home' option is selected. This creates 'zip' archive file backups of your existing Confluence Installation and Confluence Home Directories in their respective parent directory locations.
      
      * Please Note: Choosing this option is strongly recommended!
   b. At this point, the upgrade wizard notes any customisations in your existing Confluence Installation Directory which it cannot automatically migrate to your upgraded Confluence installation. If you are notified by the installer about any files containing such customisations, please make a note of the locations of these files as you will need to manually migrate their customisations (which are not mentioned in the overview above) to your upgraded Confluence installation. One relatively common customisation that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the `conf/server.xml` file of the Confluence Installation Directory. *Please Note:* when upgrading from the version that was not installed by the installer the customisations can only be detected in the `confluence` subdirectory of your existing Confluence Installation Directory. Modifications to files in directories other than `confluence` will not be
detected when you upgrade, for example, modifications to `conf/server.xml`. However the next time you upgrade (e.g. to version 4.1.1) the upgrade feature will cover modifications across the whole Confluence Installation Directory.

c. At the 'Upgrade Check List' step, back up your external database and check that any non-bundled plugins will be compatible with your upgraded Confluence version. You may have already conducted the latter (in step 5 of the Before You Start section above).

d. Upon clicking 'Next', your existing Confluence installation will be shut down if it is still running. The upgrade wizard will then:

   i. Back up your existing Confluence installation.
   ii. Delete the contents of the existing Confluence Installation Directory.
   iii. Install the new version of Confluence to the existing Confluence Installation Directory.
   iv. Starts your new (upgraded) Confluence installation.

   ! If you noted any files that contain customisations which must be migrated manually to your upgraded Confluence installation (above), then:

      1. Stop the upgraded Confluence installation.
      2. Migrate the customisations from these files into the upgraded Confluence Installation Directory.
      3. Restart the upgraded Confluence installation.

   6. At the last step of the upgrade wizard, select the option to launch the upgraded Confluence installation in a browser so you can check the upgrade.

   7. If you are upgrading to Confluence 5.0: If the global default language of your Confluence site is not English, you will need to install a patch in the form of a plugin. For more information, please refer to this article in our knowledge base: Nothing Happens when Users Click on The "Create" Button.

Congratulations, you have completed upgrading your Confluence installation on Windows!

Upgrading Confluence on Linux

1. Download the appropriate Confluence 'Linux 64-bit / 32-bit Installer' (.bin) file that suits your operating system (for the new version of Confluence) from the Confluence Download Center.
2. Open a Linux console and change directory (`cd`) to the '.bin' file's directory.
   
   ! If the '.bin' file is not executable after downloading it, make it executable, for example:
   
   `chmod a+x atlassian-confluence-X.Y.bin`

   (where X.Y represents your version of Confluence)
3. Execute the '.bin' file to start the upgrade wizard.
4. When prompted to choose between creating a new Confluence installation or upgrading an existing installation, choose the 'Upgrade an existing Confluence installation' option.
5. Specify the Confluence Installation Directory of your Confluence installation to be upgraded.

   ! The upgrade wizard will attempt to find an existing Confluence installation and will provide its location as a choice. However, always verify this location, particularly if you have multiple Confluence installations running on the same machine.

6. During subsequent steps of the upgrade wizard, you will be prompted to specify or do the following options:

   a. Choose the option to back up Confluence's directories. This creates 'zip' archive file backups of your existing Confluence Installation and Confluence Home directories in their respective parent directory locations.

   ! Please Note:

   • Choosing this option is strongly recommended!

   • At this point, the upgrade wizard notes any customisations in your existing Confluence Installation Directory which it cannot automatically migrate to your upgraded Confluence installation. If you are notified of any files containing such customisations, please make a note of the locations of these files as you will need to manually migrate their customisations...
(which are not mentioned in the overview above) to your upgraded Confluence installation. One relatively common customisation that the upgrade wizard cannot automatically migrate is an SSL configuration defined in the conf/server.xml file of the Confluence Installation Directory. Please Note: when upgrading from the version that was not installed by the installer the customisations can only be detected in the confluence subdirectory of your existing Confluence Installation Directory. Modifications to files in directories other than confluence will not be detected when you upgrade, for example, modifications to conf/serv er.xml. However the next time you upgrade (e.g. to version 4.1.1) the upgrade feature will cover modifications across the whole Confluence Installation Directory.

b. At the 'Upgrade Check List' step, back up your external database and check that any non-bundled plugins will be compatible with your upgraded Confluence version. You may have already conducted the latter (in step 5 of the Before You Start section above).

c. Upon proceeding, your existing Confluence installation will be shut down if it is still running. The upgrade wizard will then:

i. Back up your existing Confluence installation.
ii. Delete the contents of the existing Confluence installation directory.
iii. Install the new version of Confluence to the existing Confluence installation directory.
iv. Starts your new (upgraded) Confluence installation.

⚠️ If you noted any files that contain customisations which must be migrated manually to your upgraded Confluence installation (above), then:

1. Stop the upgraded Confluence installation.
2. Migrate the customisations from these files into the upgraded Confluence Installation Directory.
3. Restart the upgraded Confluence installation.

7. The last step of the upgrade wizard provides you with a link to launch the upgraded Confluence installation in a browser, so you can check the upgrade.

8. **If you are upgrading to Confluence 5.0:** If the global default language of your Confluence site is not English, you will need to install a patch in the form of a plugin. For more information, please refer to this article in our knowledge base: Nothing Happens when Users Click on The "Create" Button.

Congratulations, you have completed upgrading your Confluence installation on Linux!

**Upgrade Check List**

The upgrade wizard requests that you perform the following tasks before it actually commences the upgrade of your existing Confluence installation.

**Back Up Your External Database**

Perform a backup of your external database (using your database's native backup tools) and verify that the backup was created correctly.

- If your database's native backup tools support 'online backups' (i.e. which would typically create a 'snapshot' of your Confluence database while the database is still in use), you can leave the upgrade wizard running while you perform the database backup and then continue on with the wizard after verifying that the database backup was created correctly.
- If your database's native backup tools do not allow you to perform an 'online backup' of your Confluence database, you should:
  1. Quit the upgrade wizard now.
  2. Use your database's native backup tools to perform an 'offline backup' of your Confluence database and verify that this backup was created correctly.
  3. Re-run the Linux / Windows Installer to start the upgrade wizard again and continue from where you left off.
• If you are using HSQLDB as the Confluence internal database, please note that this should be used for evaluating Confluence only. If you happen to accidentally use the HSQLDB database for a production system, quit the upgrade wizard now and use the Migrating Confluence Between Servers procedure to upgrade Confluence.

⚠️ Inconsistent database backups may not restore correctly! If you are unfamiliar with your database's native backup/restore facilities, then test your database backup's integrity by doing the following:

1. Restoring the database backup to a different (test) system,
2. Connecting a test instance of your current Confluence version to this restored database.

Alternatively, use the Migrating Confluence Between Servers procedure to upgrade Confluence instead.

Check Plugin Compatibility

If you have installed any 3rd-party Confluence plugins (i.e. not included in Confluence), please verify that they will be compatible with the version of Confluence you are upgrading to. You can find a plugin's compatibility information from the plugin's home page on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. This can be done by navigating to Browse > Confluence Admin > Configuration > Plugins.

Upgrading Beyond Current Licensed Period

This page explains the recovery process should you mistakenly try to upgrade your Confluence installation to a version beyond your current license entitlement.

License warnings

During an upgrade an obvious indication that your license has expired can be found in your log file. You will see a 'WARN' level entry similar to this:

```
[confluence.upgrade.impl.DefaultUpgradeManager] isUpgradeAllowed
Your license is now outside of it's support period.
You need to renew the license before you can upgrade to this version of Confluence.
```

Related pages:

• Upgrading Confluence
• Working with Confluence Logs
• Confluence Administrator's Guide

When you try to access the Confluence site in your browser, you will see the following warning screen:

<table>
<thead>
<tr>
<th>Time</th>
<th>Level</th>
<th>Type</th>
<th>Description</th>
<th>Exception</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008-02-04 10:51:04</td>
<td>null</td>
<td>(EventType: upgrade)</td>
<td>Cannot proceed with upgrade. Your current license does not entitle you to upgrade to this version of Confluence. Please check that the support period of your license has not expired or that you have the correct partner license. If you wish to renew your license, please contact <a href="mailto:sales@atlassian.com">sales@atlassian.com</a>. If you have a new license, please enter it on this page and restart.</td>
<td>fatal</td>
</tr>
</tbody>
</table>

Updating the Confluence license

1. Contact Atlassian Sales to arrange for a new license to be issued, as instructed on the warning screen illustrated above.
2. Once you have received a suitable license, supply the license key to Confluence:
   - Click link given on the license warning screen, illustrated above.
   - You will first be asked to log in as a Confluence administrator.
   - Then you will be presented with a simplified license administration screen. Enter the credentials of a Confluence system administrator.
   - Copy the license key into the License field and choose Save.

3. Restart Confluence to continue the upgrade.

**Confluence Post-Upgrade Checks**

This article provides a list of items for Confluence Administrators to check after a Confluence upgrade to ensure that it has completed successfully. This list is not exhaustive, but it does cover common upgrade mistakes.

**On this page:**
- Before You Begin
- Upgrade Checklist
  - 1. Layout and Menu
  - 2. Search
  - 3. Permissions
  - 4. Attachments
  - 5. Plugins

**Before You Begin**

After you have completed an upgrade, you should see the following message in the atlassian-confluence log file:

```
2010-03-08 08:03:58,899 INFO [main] [atlassian.confluence.upgrade.AbstractUpgradeManager] upgradeFinished
Upgrade completed successfully
```

If you do not see the line in your log similar to the one above, this means that your upgrade has not completed successfully. Please check our Upgrade Troubleshooting documentation to check for a suitable recommendation or fix. If there are no errors logged or if none of the errors are referenced in the Troubleshooting Upgrades documentation, please contact Atlassian Support using the Support Utilities in your administration console.

**Upgrade Checklist**
Below is a recommended list of items to check after completing an upgrade.

1. Layout and Menu

Visit the Confluence dashboard and check that it is accessible and displays as expected. Test the different Internet browsers that you have in use in your environment. In addition, confirm that the layout appears as expected and that the menus are clickable and functioning.

2. Search

Try searching for content, for example pages, attachments or user names. Check that the expected results are returned.

3. Permissions

Confirm that you can visit a page that has viewing restrictions, but you have permission to view. Confirm that you can edit a page that has edit restrictions but you have permission to edit. Make sure that the permissions of child pages are functioning as well. Involve as many space administrators as possible to confirm they are working. Confirm that anonymous or forbidden users cannot access or modify restricted pages.

4. Attachments

Confirm that attachments are accessible and searchable.

5. Plugins

Outdated third-party plugins can cause upgrade failure. Quite often, they will just be incompatible and simply not work anymore. If you discover that your plugin is no longer working, please check for the latest version for your plugin in the Atlassian Plugin Exchange.

Universal Plugin Manager

Use the Universal Plugin Manager to easily check for plugin compatibility.

RELATED TOPICS

Upgrade Troubleshooting
Upgrading Confluence
Upgrading Confluence EAR-WAR Distribution

This document tells you how to upgrade from one version of Confluence to a later version. These instructions apply to the EAR-WAR Distribution of Confluence, deployed on your own existing application server.

If you want to upgrade the regular Confluence distribution, which includes Apache Tomcat as the application server, please refer to Upgrading Confluence instead.

Please also check the following before you start using this guide:

- The version of Confluence that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The supported platforms for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running Confluence on a cluster, please see Upgrading a Confluence Cluster instead of this document.

Upgrading to Confluence 5.0?

If so, please review the Confluence 5.0 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 5.0 Known Issues in the Confluence Knowledge Base.
Before you Start

1. Note that you need current software maintenance to perform the upgrade.
2. Confirm that your license support period is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade. If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
4. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
6. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
7. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your Administration screens, and selecting Confluence Upgrade Check. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence supplied version in a test environment. You can see the customisations applied to your Confluence installation.

10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.

11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.

Backing Up

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called `confluence-init.properties`, which is located inside the `confluence/WEB-INF/classes` directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation.

   The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes. You don't need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

Testing the Upgrade in a Test Environment

⚠️ Be sure to test the upgrade in a test environment before proceeding on your production server.

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

**XML imports**

⚠️ Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence
Performing the Upgrade

1. Shut down your existing Confluence instance.
2. Download the Confluence EAR-WAR zip file: Go to the Download Center, and click 'Show all' to find the EAR-WAR zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing:
   - 7Zip — Recommended. If in doubt, download the '32-bit.exe' version
   - Winzip
4. Use your unzip program to unzip the installation file. You should now have a new directory called confluence-<version>. In the rest of this document, we will refer to this as the <Installation-Directory>.
   - Do not use spaces in your directory path.
   - You can read more about the Confluence Installation directory.
5. Edit the confluence-init.properties file found at: <Installation-Directory>/confluence/WEB-INF/classes/confluence-init.properties and update 'confluence.home' to point to your existing Confluence Home directory.
   - Make sure you have first backed up your Home directory.
   - Open the confluence-init.properties file in a text editor such as Notepad.
   - Scroll to the bottom and find this line:

   ```properties
   # confluence.home=c:/confluence/data
   ```
   - Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home.
   - Update the directory name after the = sign, to point to your existing Confluence Home directory.
6. If you are using Tomcat, you need to update either your confluence.xml or server.xml (depending on where you have defined the Confluence context descriptor) to point to the location of the new Confluence installation (also remember to copy over any customisations such as a tomcat datasource if you have one).
7. If you have delegated your user management to JIRA, LDAP or any other external user management system, copy the following files from your old Confluence installation to your new Confluence installation:
   - <Installation-Directory>/confluence/WEB-INF/classes/osuser.xml
   - <Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml (if you are upgrading from Confluence 2.2 or later).

**Upgrading to Confluence 3.5+ and using JIRA user management?**

---

4.0) **is not recommended.** Please **recreate** your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.
8. If you have delegated your user management to Crowd, you will also need to copy the Crowd client library and configuration files from your old Confluence installation to your new Confluence installation: `<Installation-Directory>/confluence/WEB-INF/lib/crowd-integration-client-X.X.X.jar` and `<Installation-Directory>/confluence/WEB-INF/classes/crowd.properties`. If you need more information, please refer to the Crowd documentation.

9. Restart your application server and start Confluence. Please note that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser. (There is no easy and quick way to determine if the indexing process is completed. Please wait for approximately 10 minutes after the server start up before accessing Confluence via a web browser.)

10. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property `hibernate.hbm2ddl.skip_creating_missing_indexes` to `true` to skip automatic index creation.

11. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

12. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

13. Consider any adjustments you need to make to customisations and special configurations, as described below.

Reapplying Customisations to your New Confluence

Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel

After upgrading your Confluence installation to a later version of Confluence, you need to consider any customisations you have applied to your system and other special configurations:

- If you had previously installed **Confluence/Tomcat as a Windows service**, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see Start Confluence Automatically on Windows as a Service.
- If you are using the Confluence distribution and you have previously defined a **CATALINA_HOME**
environment variable, please check that it points to the correct path for the new Confluence Tomcat server.

- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented SSL, edit your new `web.xml` file and copy over any relevant modifications from your old `web.xml` file, which relate to these customisations.

- If you were previously running Confluence on a non-standard port, edit your new `<Installation-Directory>/conf/server.xml` file as described in Change listen port for Confluence.

- If you had previously defined a Tomcat datasource, edit your new `<Installation-Directory>/conf/server.xml` and copy over the datasource definition from your old `server.xml`.

- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Plugin Repository in the Confluence Administration Console.

- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.

- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here.

- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.

- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.

- If you had previously modified the memory flags (Xms and Xmx) in either the `<Installation-Directoy>/bin/setenv.sh` or the `<Installation-Directory>/bin/setenv.bat` file, you may want to make the modifications in your new installation. The parameters are specified in the JAVA_OPTS variable.

- If you had changed the Confluence interface text, you will need to pull over the ConfluenceActionSupport.properties file.

- If you were using a custom SSO authenticator, change `seraph-config.xml` to the correct authenticator.

Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

**RELATED TOPICS**

- Upgrading Confluence
- Upgrading Confluence
- Confluence Installation Guide
- Important Directories and Files
- Site Backup and Restore
- Database Configuration

**Migration from Wiki Markup to XHTML-Based Storage Format**

If you are upgrading to Confluence 4.0 or later from an older version (From Confluence 3.5.x or earlier) then as part of the upgrade an automatic migration of your content will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each wiki.
markup page. The new version will use the new XHTML-based storage format, so that you can edit the page in the Confluence rich text editor.

In addition, if you are upgrading to Confluence 4.3 or later from an older version then as part of the upgrade an automatic migration of your page templates will take place. See Migration of Templates from Wiki Markup to XHTML-Based Storage Format.

Note: Even though the process is non-destructive, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any Confluence upgrade.

Migration process

Depending on the size of your Confluence installation, the migration from wiki markup to the new XHTML-based storage format could prove time consuming. The duration of the migration is difficult to estimate; this is due to a number of site specific factors. As a rough guide, a test dataset we migrated was 130,000 pages, totalling approximately 700Mb, which took six minutes.

The following properties that can be modified to allow finer control over the migration process:

<table>
<thead>
<tr>
<th>Property</th>
<th>Purpose</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>confluence.wiki.migration.threads</td>
<td>The number of concurrent worker threads migrating content</td>
<td>4</td>
</tr>
<tr>
<td>confluence.wiki.migration.batch.size</td>
<td>The number of items migrated in each batch of work</td>
<td>500</td>
</tr>
<tr>
<td>confluence.wiki.migration.versioncomment</td>
<td>The comment associated with the newly migrated version of each piece of content</td>
<td>&quot;Migrated to Confluence 4.0&quot;</td>
</tr>
</tbody>
</table>

(For instructions on setting Confluence system properties see this document.)

Again, due to the large variability in Confluence installations it is hard to give specific recommendations for the above settings. One point to note though that both increasing batch size and the number of threads (or both) will increase the peak memory required for migration. If memory is an issue then as you increase one of these settings consider decreasing the other.

Another factor to be aware of if modifying these defaults is that of the cache settings employed in your site. The migration will quickly populate certain Confluence caches so be sure that if you have customised caches as described here that there is enough memory on the server for these caches should they reach maximum capacity.

Watching the migration logs during the upgrade

To monitor the progress of a site migration you should watch the output in the application log.

Typical logging progress will be shown by multiple log entries at the INFO level of the following format:
There may be a wide array of messages logged from each individual page but any errors are also collected for display in a single migration report once all content has been processed. Here is a typical example of such a report:

Wiki to XHTML Exception Report:
Summary:
  0 settings values failed.
  0 PageTemplates failed.
  2 ContentEntityObjects failed.
Content Exceptions:
  1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown.. Message: The macro link is unknown.
  2) Type: comment, Id: 6919, Title: null, Global Scope. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown.. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new XHTML-based storage format, but will actually consist of wiki markup content wrapped within an XML 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the new Confluence Editor.

However, in some cases a batch of content may actually have completely failed to migrated. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

Unable to start up Confluence. Fatal error during startup sequence: confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require the plugin framework to be available) - com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view any such unmigrated content they will see an exception similar to this:

java.lang.UnsupportedOperationException: The body of this ContentEntityObject ('Page Title') was 'WIKI' but was expected to be 'XHTML'
The solution is to ensure you manually re-run the site migration after the restart.

Re-running the migration – for content that completely failed the migration

A Confluence Administrator can restart the site migration if there was any content that failed migration (see previous section). Only the content that is still formatted in wiki markup will be migrated, so typically a re-migration will take less time than the original migration.

To manually re-run migration:

1. Open this URL in your browser: <Confluence Address>/admin/force-upgrade.action
2. Select wikiToXhtmlMigrationUpgradeTask in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.

---

Re-attempting the migration – for content in 'unmigrated-wiki-markup' macro

The previous section was about dealing with the exceptional circumstance where certain content was left completely unmigrated. The most common migration problem is that the content was migrated but remains formatted as wiki markup on the page, within the body of an 'unmigrated-wiki-markup' macro. Any content which is referenced in the migration report will be found in this state. This content is still viewable and editable but since it is wiki markup it cannot be edited using the full feature set of the rich text editor.

The most common reason for content to be in this state is that the page contains an unknown macro, or a macro that is not compatible with Confluence 4.x.

There are two possible fixes for this situation:

1. Install a version of the macro that is compatible with Confluence 4.x. See Plugin Development Upgrade FAQ for 4.0.
2. Edit the page and remove the problematic macro.

Regardless of the solution you choose, you can then force a re-migration of all the content (including content in templates) that was left wrapped in an 'unmigrated-wiki-markup' macro. This feature is found at <Confluence Address>/admin/unmigratedwikicontent.action
Notes

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Migration of Templates from Wiki Markup to XHTML-Based Storage Format

If you are upgrading to Confluence 4.3 or later from an older version (from Confluence 4.2.x or earlier) then as part of the upgrade an automatic migration of your page templates will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each space template and each global template on your Confluence site. The new version will use the new XHTML-based storage format, so that you can edit the template in the Confluence rich text editor.

Note: Nevertheless, you must be sure to perform a backup of your database and home directory prior to starting the new version of Confluence, as we recommend for any Confluence upgrade.

Watching the migration logs during the upgrade

To monitor the progress of a site migration you should watch the output in the application log.

A typical logging progress will be shown by multiple log entries at the INFO level of the following format:

```
WikiToXhtmlMigrationThread-n - Migrated 22 of 29 PageTemplates.
```

On this page:
- Watching the migration logs during the upgrade
- Re-running the migration
- Notes

Related pages:
- Migration from Wiki Markup to XHTML-Based Storage Format
- Working with Templates
- Upgrading Confluence

There may be a wide array of messages logged from each individual template, but any errors are also collected
for display in a single migration report once all content has been processed. Here is a typical example of such a report:

Wiki to XHTML Exception Report:
Summary:
  0 settings values failed.
  2 PageTemplates failed.
  0 ContentEntityObjects failed.
Content Exceptions:
  1) Type: page, Id: 332, Title: Release Notes 1.0b3, Space: DOC - Confluence 4.0 Beta. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro link is unknown.. Message: The macro link is unknown.
  2) Type: comment, Id: 6919, Title: null, Global Scope. Cause: com.atlassian.confluence.content.render.xhtml.migration.exceptions.UnknownMacroMigrationException: The macro mymacro is unknown.. Message: The macro mymacro is unknown.

Each entry in the report will identify the content that caused migration exceptions as well as displaying the exceptions themselves.

In almost all cases any content reported as errored will have been migrated to the new XHTML-based storage format, but will actually consist of wiki markup content wrapped within an XML 'unmigrated-wiki-markup' macro. This content will still be viewable in Confluence and editable within the Confluence rich text editor.

However, in some cases a batch of content may actually have completely failed to migrate. This is most typically due to an unhandled exception causing a database transaction rollback. This would be reported in the log with a message like this:

Unable to start up Confluence. Fatal error during startup sequence: confluence.lifecycle.core:pluginframeworkdependentupgrades (Run all the upgrades that require the plugin framework to be available) - com.atlassian.confluence.content.render.xhtml.migration.exceptions.MigrationException: java.util.concurrent.ExecutionException: org.springframework.transaction.UnexpectedRollbackException: Transaction rolled back because it has been marked as rollback-only

Confluence provides no further report about this scenario and will also allow Confluence to restart as normal without retrying a migration. If a user tries to view or edit an unmigrated template, the wiki template editor will be used.

The solution is to manually re-run the site migration after the restart, as described below.

Re-running the migration

A Confluence administrator can restart the template migration if any templates have failed the migration (see previous section). Only the templates that are still formatted in wiki markup will be migrated again. Typically, a re-migration will take less time than the original migration.

To manually re-run the migration:

1. Open this URL in your browser: `<Confluence Address>/admin/force-upgrade.action`
2. Select `pageTemplateWikiToXhtmlMigrationUpgradeTask` in the Upgrade task to run dropdown list.
3. Choose Force Upgrade.
Notes

We refer to the Confluence storage format as 'XHTML-based'. To be correct, we should call it XML, because the Confluence storage format does not comply with the XHTML definition. In particular, Confluence includes custom elements for macros and more. We're using the term 'XHTML-based' to indicate that there is a large proportion of HTML in the storage format.

Upgrading Confluence Manually

This document tells you how to upgrade from one version of Confluence to a later version. This document refers to the Confluence distribution that includes Apache Tomcat as the bundled application server. If you want to upgrade an EAR/WAR distribution deployed on your own existing application server, please refer to Upgrading Confluence EAR-WAR Distribution instead.

Please also check the following before you start using this guide:

- The version of Confluence that you will be upgrading to. Refer to the documentation home page to verify the latest Confluence version and to find documentation for older versions.
- The supported platforms for the version that you will be upgrading to. Please see the Supported Platforms page for the version of Confluence that you will be upgrading to, as well as the End of Support Announcements for Confluence.
- If you are running Confluence on a cluster, please see Upgrading a Confluence Cluster instead of this document.

Upgrading to Confluence 5.0?

If so, please review the Confluence 5.0 Release Notes for important information about this version of Confluence. Ensure that you have read the Confluence 5.0 Known Issues in the Confluence Knowledge Base.

Also, we strongly recommend that you check the upgrade notes for every major version of Confluence that you are skipping, since there might be specific changes between Confluence versions that could affect your Confluence installation. The upgrade notes for recent major versions of Confluence are accessible from the Upgrade Notes Overview page.

Finally, please check the Supported Platforms page to ensure that your Java version, operating system, application server, database and browser are supported for this release of Confluence. The End of Support Announcements for Confluence page has important information regarding supported platforms.

On this page:

- Before you Start
1. Note that you need current software maintenance to perform the upgrade.
2. Confirm that your license support period is still valid before you try to upgrade.
3. If your current license has expired but you have a new license with you, please update your license in Confluence before performing the upgrade. If you forget to do this and your license has expired, you will receive errors during the upgrade process. Refer to the instructions on upgrading beyond current license period.
4. Check the release notes for the new version of Confluence you are installing, plus the upgrade notes for any major versions you are skipping. It is important to read these upgrade notes as there might be specific changes between Confluence versions that could affect your Confluence instance. The upgrade notes pages for recent major versions of Confluence are accessible from the Upgrade Notes Overview page. (Each upgrade notes page is a 'child' of its respective release notes page.)
5. Make sure that your environment (e.g. the database system, the operating system, the application server and so on) still complies with the Confluence System Requirements. A newer version of Confluence may have different requirements than the previous version.
6. If you are using Confluence EAR-WAR edition, check Installing the Confluence EAR-WAR Edition to see if there is anything extra you will need to do to get Confluence running.
7. If you are using an external database, familiarise yourself with all known issues for your specific database. Also make sure the Confluence database connector principal (the database user account) has sufficient permissions to modify the database schema.
8. Note which plugins are installed and enabled on your current Confluence instance. Please verify whether a compatible version of the plugin is available in the version of Confluence you are upgrading to. This information is available via the 'Plugins' menu in your Administration screens, and selecting Confluence Upgrade Check. This will tell you which plugins have an updated version which is compatible with your target upgrade version. You can also check the respective home pages for these plugins on the Atlassian Plugin Exchange. Once you have confirmed the availability of compatible versions, you should upgrade your plugins after successfully upgrading Confluence. Please test these first by applying them to the latest Confluence version in a test environment.
9. If you have made any customisations to Confluence, please verify their compatibility in the latest version. For example, if you have modified any layouts or are using your own custom theme, please test these first by applying them to the latest Confluence version in a test environment. You can see the customisations applied to your Confluence installation.
10. Some anti-virus or other Internet security tools may interfere with the Confluence upgrade process and prevent the process from completing successfully. If you experience or anticipate experiencing such an issue with your anti-virus/Internet security tool, disable this tool first before proceeding with the Confluence upgrade.
11. After upgrading, Confluence may need to rebuild its indexes. If this happens, there may be some extra load placed on the server following the upgrade. Make sure to schedule any upgrade of production Confluence outside of hours where people need to use it.
Backing Up

Before you begin the Confluence upgrade, you must back up the following:

1. **Back up your Confluence Home directory.** The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for 'Home directory' would be 'data directory'. The location of the Home directory is stored in a configuration file called *confluence-init.properties*, which is located inside the *confluence/WEB-INF/classes* directory in your Confluence Installation directory. The Confluence installer will automatically prompt you to run a backup, storing the files in a .zip archive at the same level as your Confluence Home directory.

2. **Back up your database.** Perform a manual backup of your external database before proceeding with the upgrade, and double check that the backup was actually created properly. If you are not a database expert, or unfamiliar with the backup-restore facilities of your database, simply restore the backup to a different system to ensure the backup worked before proceeding. This recommendation is generally a good best practice. Surprisingly, many companies get in trouble for broken database backups because they skip this basic but vital "smoke test" of the operation.

   The 'embedded database' is the HSQLDB database supplied with Confluence for evaluation purposes. You don't need to back it up since it is stored in the Confluence home directory. You should not be using this database for production systems at all, so if you happen to be using HSQLDB in a production system, please migrate to a proper database before the upgrade. Read about the various shortcomings of HSQLDB.

3. **Back up your Confluence Installation directory or your Confluence webapp** (if you are using Confluence EAR-WAR edition). The Confluence installer will automatically back up these files, storing the files in a .zip archive at the same level as your Confluence installation directory. The 'Confluence Installation directory' is the directory into which the Confluence application files and libraries have been unpacked (unzipped) when Confluence was installed. Confluence does not modify or store any data in this directory. This directory is also sometimes called the 'Confluence Install directory'.

Testing the Upgrade in a Test Environment

Be sure to test the upgrade in a test environment before proceeding on your production server.

1. Create a snapshot of your current production Confluence environment on a test server, as described in the page on Moving Confluence Between Servers.

   **XML imports**

   Importing an old XML backup file to a new major version (for example, Confluence 3.5 to Confluence 4.0) is not recommended. Please recreate your production instance in a test environment first.

2. Perform the upgrade on your cloned environment.

3. Test all your unsupported plugins and any customisations with the new version before proceeding on your production server. You can read more about supported and unsupported plugins.

Performing the Upgrade

If you are migrating servers or migrating databases, perform those operations in separate steps.

To install Confluence, unzip the new Confluence installation zip file into a directory of your choice and then edit
the configuration files to point your new installation to your existing data files. Follow these instructions:

1. Shut down your existing Confluence instance.
2. Download the Confluence zip file.
3. If you are on Windows, please check your unzip program before extracting the downloaded zip file. Some archive-extract programs cause errors when unzipping the Confluence zip file. You should use a third-party unzip program like 7Zip or Winzip. If you do not have one, please download and install one before continuing:
   - 7Zip — Recommended. If in doubt, download the '32-bit.exe' version
   - Winzip
4. Use your unzip program to unzip the installation file. You should now have a new directory called confluence-<version>, e.g. confluence-4.0.0-std.
   - In the rest of this document, we will refer to this as the <Installation-Directory>.
   - If you decide to change the location from the default, make sure that you choose a different location from your existing Confluence installation, because legacy files may cause problems if you install the new Confluence version into an existing directory.
   - Do not use spaces in your directory path.
   - You can read more about the Confluence Installation directory.
5. Edit the confluence-init.properties file found at: <Installation-Directory>/confluence\WEB-INF\classes\confluence-init.properties and update 'confluence.home' to point to your existing Confluence Home directory.
   - You can read more about the Confluence Home directory.
   - Make sure you have first backed up this directory, as instructed above.
   - Open the confluence-init.properties file in a text editor such as Notepad.
   - Scroll to the bottom and find this line:

```
# confluence.home=c:/confluence/data
```
   - Remove the '#' and the space at the beginning of this line, so that Confluence no longer regards the line as a comment. The line should now begin with confluence.home.
   - Update the directory name after the = sign, to point to your existing Confluence Home directory.
6. If you are running Confluence as a Windows service, use the command prompt and type <Installation-Directory>/bin/service.bat remove Confluence.

   It is vital that you stop and remove the existing service prior to uninstalling the old instance of Confluence! For more information on running Confluence as Windows service, please refer to the Start Confluence Automatically on Windows as a Service topic.

To remove the service installed by the Confluence installer, you need to run the <confluence auto installer installation folder>\UninstallService.bat.

7. If you are using an external database (i.e. not the embedded HSQLDB database supplied for evaluation purposes), copy the jdbc driver jar file from your old Confluence installation to the new Confluence installation. The jdbc driver jar file in the old Confluence installation should be located in either the <Install-Directory>/common/lib or <Installation-Directory>/confluence/WEB-INF/lib directories. Once you have identified this file, copy it to either the <Install-Directory>/lib or <Installation-Directory>/confluence/WEB-INF/lib directories of your Confluence installation.

8. If you have delegated your user management to JIRA, LDAP, Crowd, or any other external user management system, copy the following files from your old Confluence installation to your new Confluence installation:
   - <Installation-Directory>/confluence/WEB-INF/classes/osuser.xml.
- `<Installation-Directory>/confluence/WEB-INF/classes/atlassian-user.xml` (if you are upgrading from Confluence 2.2 or later).

If you are upgrading from an earlier version of Confluence (2.5.5 and earlier) and are copying your existing `atlassian-user.xml` file from your previous instance, please ensure that the hibernate cache parameter in this file has been enabled, to avoid performance related issues. (NOTE: If you use Crowd for your user management, you do not need to do this.):

```xml
<hibernate name="Hibernate Repository"
    key="hibernateRepository" description="Hibernate Repository" cache="true" />
```

9. If you have delegated your user management to Crowd, you will also need to copy the Crowd configuration file from your old Confluence installation to your new Confluence installation: `<Installation-Directory>/confluence/WEB-INF/classes/crowd.properties`. If you need more information, please refer to the Crowd documentation.

10. Consider any adjustments you need to make to customisations and special configurations, as described below.

    - Your new version of Confluence may not function correctly or could encounter problems or errors if these are not implemented.

11. Start your new version of Confluence.

    - **Please note** that Confluence will need to re-index attachments and this can take 5-10 minutes. Please wait until Confluence has finished indexing the attachments before trying to access Confluence via your web browser.

12. During the startup process Confluence will create any missing database indexes. If you created any database indexes on your own, please check those afterwards and remove those that duplicate the indexes added by Confluence. Just in case you run into any errors which prevent Confluence from starting up, you can set the system property `hibernate.hbm2ddl.skip_creating_missing_indexes` to `true` to skip automatic index creation.

13. Visit Confluence in your web browser and log in using a username from your previous Confluence installation. You should be able to log in immediately, without seeing the Setup Wizard.

14. Take a quick look around your Confluence site to confirm that all your spaces and pages are present and everything looks normal. You should see the new Confluence version number in the page footer.

### Reapplying Customisations to your New Confluence

- **Hint: The steps below are for advanced Confluence users, who have applied special settings to their Confluence server and/or Confluence look and feel**

After upgrading your Confluence installation to a later version of Confluence, you need to consider any customisations you have applied to your system and other special configurations:

- If you had previously installed Confluence/Tomcat as a Windows service, uninstall the service (to ensure that the old Confluence cannot start automatically when the server restarts) and reinstall the new one. For details please see Start Confluence Automatically on Windows as a Service.
- If you are using the Confluence distribution and you have previously defined a `CATALINA_HOME`
environment variable, please check that it points to the correct path for the new Confluence Tomcat server.

- If you had previously connected your Confluence installation to an external database via a JNDI datasource or you implemented SSL, edit your new web.xml file and and copy over any relevant modifications from your old web.xml file, which relate to these customisations.

- If you were previously running Confluence on a non-standard port, edit your new <Installation-Di rectory>\conf\server.xml file as described in Change listen port for Confluence.

- If you had previously defined a Tomcat datasource, edit your new <Installation-Directoy>\conf\server.xml and copy over the datasource definition from your old server.xml.

- If you were previously using any plugins, install the latest compatible version and disable any plugins that are incompatible with your new version of Confluence. The easiest way to do this is to use the Plugin Repository in the Confluence Administration Console.

- If you are using any customised themes, please check that they are displaying as expected. Some further customisation may be required to ensure compatibility with your new version of Confluence.

- If you had previously customised the default site or space layouts, you will need to reapply your changes to the new defaults as described here.

- If you had previously modified the Confluence source code, you will need to reapply your changes to the new version.

- If you were previously running Confluence over SSL, you will need to reapply your configuration as described in Running Confluence Over SSL or HTTPS.

- If you had previously modified the memory flags (Xms and Xmx) in either the <Installation-Directory>\bin\setenv.sh or the <Installation-Directory>\bin\setenv.bat file, you may want to make the modifications in your new installation. The parameters are specified in the JAVA_OPTS variable.

- If you had changed the Confluence interface text, you will need to pull over the ConfluenceActionSupport.properties file.

- If you were using a custom SSO authenticator, change seraph-config.xml to the correct authenticator.

Checking for Known Issues and Troubleshooting the Confluence Upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- Check for known issues. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- Did you encounter a problem during the Confluence upgrade? Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

Useful Plugins

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

- Appfire’s Upgrade Assistant for Confluence (UAC) is a commercial plugin that simplifies the upgrade process into an easy-to-use wizard.

RELATED TOPICS

Upgrading Confluence
Upgrading Confluence EAR-WAR Distribution
Confluence Installation Guide
Important Directories and Files
Site Backup and Restore
Database Configuration

**Supported Platforms**

This page describes the supported platforms for Confluence. Please review them before installing Confluence. The information on this page applies to Confluence 5.0.

Further information:

- End of support for various platforms and browsers when used with Confluence: [End of Support Announcements for Confluence](#).
- More information about these supported platforms and hardware requirements: [System Requirements](#).

### Related pages:

- Confluence Installation Guide
- Confluence Setup Guide
- Installing Confluence and JIRA Together
- Server Hardware Requirements Guide
- Supported Platforms FAQ
- Confluence Documentation Home

**Key:** = Supported. = Not Supported

<table>
<thead>
<tr>
<th>Operating systems for Confluence server installation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Windows (including 64-bit)(1)</strong></td>
</tr>
<tr>
<td><strong>Linux / Solaris (1, 2)</strong></td>
</tr>
<tr>
<td><strong>Apple Mac OS X</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Application servers</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Apache Tomcat</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Databases</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PostgreSQL</strong></td>
</tr>
<tr>
<td><strong>MySQL (3)</strong></td>
</tr>
<tr>
<td><strong>Oracle</strong></td>
</tr>
<tr>
<td><strong>Microsoft SQL Server</strong></td>
</tr>
<tr>
<td><strong>HSQLDB (4)</strong></td>
</tr>
</tbody>
</table>

### Java version

| Oracle JRE / JDK | ![1.7](#) |

- **Java version**
  - Oracle JRE / JDK: ![1.7](#)
Microsoft Internet Explorer (Windows) \(^{(5, 6)}\) ▶️ 8, 9
Mozilla Firefox (all platforms) ▶️ Latest stable version supported
Google Chrome (Windows and Mac) \(^{(7)}\) ▶️ Latest stable version supported
Safari (Mac) ▶️ Latest stable version supported

**Web browsers – mobile**

- **Mobile Safari (iOS)** \(^{(8)}\) ▶️ Latest stable version supported
  ▶️ Tested with iOS 5.1
- **Android (Android)** \(^{(9)}\) ▶️ The default browser on Android 4.0.3 (Ice Cream Sandwich)

1. Confluence is a pure Java application and should run on this platform provided the JRE or JDK requirement is satisfied.
2. While some of our customers run Confluence on SPARC-based hardware, Atlassian only officially supports Confluence running on x86 hardware and 64-bit derivatives of x86 hardware.
3. Ensure that you configure your Confluence MySQL database to use the InnoDB storage engine as the MyISAM storage engine could lead to data corruption.
4. Confluence ships with a built-in HSQL database. While this database is fine for evaluation purposes, it is somewhat susceptible to data loss during system crashes. Hence, for production environments, we recommend that you configure Confluence to use an external database.
5. Internet Explorer 8 and 9 do not support the drag-and-drop functionality of HTML5. As Confluence relies on this functionality, the drag-and-drop experience in Internet Explorer 8 and 9 is not complete.
6. Confluence is tested with these versions of Internet Explorer in standards-compliant rendering mode, not compatibility mode. Enabling compatibility mode may cause problems because it emulates older, unsupported rendering modes.
7. Chrome does not have WEBDAV / plugin support so features such as Edit in Word for attachments will not work. Please refer to CONF-23322 for information on the progress of the issue.
8. Confluence does not support editing in Mobile Safari on iOS devices (such as iPhone and iPad). Please refer to CONF-19523 for information on the progress of this issue.
9. Confluence does not support editing on Android devices.

**End of Support Announcements for Confluence**

This page contains announcements of the end of support for various platforms and browsers when used with Confluence. This is summarised in the table below. Please see the sections following for the full announcements.

End of Support Matrix for Confluence

The table below summarises information regarding the end of support announcements for upcoming Confluence releases. If a platform (version) has already reached its end of support date, it is not listed in the table.

<table>
<thead>
<tr>
<th>Platform</th>
<th>Confluence End of Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 5.5.x</td>
<td>Confluence 5.0 (announcement)</td>
</tr>
<tr>
<td>Java 6</td>
<td>Confluence 5.0 (announcement)</td>
</tr>
<tr>
<td>DB2 database</td>
<td>Confluence 4.3 (announcement)</td>
</tr>
<tr>
<td>PostgreSQL 8.2</td>
<td>Confluence 4.3 (announcement)</td>
</tr>
</tbody>
</table>
Why is Atlassian ending support for these platforms?

Atlassian is committed to delivering improvements and bug fixes as fast as possible. We are also committed to providing world class support for all the platforms our customers run our software on. However, as the complexity of our applications grows, the cost of supporting multiple platforms increases exponentially. Each new feature has to be tested on several combinations of application servers, databases, web browsers, etc., with setup and ongoing maintenance of automated tests. Moving forward, we want to reduce the time spent there to increase Confluence development speed significantly.

On this page (most recent announcements first):

- Deprecated Tomcat platform for Confluence (29 August 2012)
- Deprecated Java platform for Confluence (6 August 2012)
- Deprecated Databases for Confluence (1 May 2012)
- Deprecated Databases for Confluence (13 March 2012)
- Deprecated Operating Systems for Confluence (21 July 2011)
- Deprecated Databases for Confluence (7 January 2011)
- Deprecated Web Browsers for Confluence (7 January 2011)
- Deprecated Databases for Confluence (12 October 2010)
- Deprecated Web Browsers for Confluence (12 October 2010)
- Deprecated Databases for Confluence (6 July 2010)
- Deprecated Web Browsers for Confluence (6 July 2010)
- Deprecated Databases for Confluence (24 March 2010)
- Deprecated Application Servers for Confluence (27 January 2010)
- Deprecated Java Platforms for Confluence (27 January 2010)
- Deprecated Web Browsers for Confluence (14 December 2009)

Deprecated Tomcat platform for Confluence (29 August 2012)

This section announces the end of Atlassian support for Tomcat 5.5.x for Confluence. Please note: Apache has announced that support for Apache Tomcat 5.5.x will end on 30 September 2012: End of life for Apache Tomcat 5.5.x.

End of support means that Atlassian will not fix bugs related to the specified version of Tomcat, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Tomcat 5.5.x Support

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tomcat 5.5.x</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

Tomcat 5.5.x notes:

- Confluence 4.3 is the last major version that will support Tomcat 5.5.x. The Confluence 4.3.x bug-fix releases will also continue to support Tomcat 5.5.x.
- Tomcat 6.0.x will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Tomcat 5.5.x. However, we will not fix bugs affecting Tomcat 5.5.x after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Tomcat 5.5.x.
Deprecated Java platform for Confluence (6 August 2012)

This section announces the end of Atlassian support for Java 6 for Confluence. Please note that Oracle has announced the end of public updates for Java 6: [Java SE 6 End of Public Updates Notice](#).

End of support means that Atlassian will not fix bugs related to the specified version of Java, past the support end date for your version of Confluence. The details are below. Please refer to the list of supported platforms details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Java 6 Support

<table>
<thead>
<tr>
<th>Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java 6 (JRE and JDK 1.6)</td>
<td>When Confluence 5.0 is released, due in early 2013</td>
</tr>
</tbody>
</table>

**Java 6 notes:**
- Confluence 4.3 is the last major version that will support Java 6. The Confluence 4.3.x bug-fix releases will also continue to support Java 6.
- Java 7 (JRE and JDK 1.7) will still be supported in Confluence 5.0.
- Confluence 4.3.x and previously-released versions will continue to work with Java 6. However, we will not fix bugs affecting Java 6 after the end-of-life date for your version of Confluence.
- Confluence 5.0 will not be tested with Java 6.

Deprecated Databases for Confluence (1 May 2012)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL 8.2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

**PostgreSQL 8.2 notes:**
- Confluence 4.2 is the last version that will support version 8.2 of PostgreSQL.
- Versions 8.3, 8.4 and 9.0 will still be supported in Confluence 4.3.
- Confluence 4.2 and previously-released versions will continue to work with PostgreSQL 8.2. However, we will not fix bugs affecting PostgreSQL 8.2 after the end-of-life date for your version of Confluence.
- Confluence 4.3 will not be tested with PostgreSQL 8.2.
Deprecated Databases for Confluence (13 March 2012)

This section announces the end of Atlassian support for certain databases for Confluence. End of support means that Atlassian will not fix bugs related to the specified database past the support end date for your version of Confluence.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2</td>
<td>When Confluence 4.3 is released, due in mid 2012</td>
</tr>
</tbody>
</table>

**DB2 notes:**

- Confluence 4.2 is the last version that will support DB2.
- From Confluence 4.3, no versions of DB2 will be supported.
- Confluence 4.2 and previously-released versions will continue to work with DB2. However, we will not fix bugs affecting DB2 after the end-of-life date for your version of Confluence.
- Confluence 4.3 will not be tested with DB2.
- For help with moving from DB2 to a supported database, please refer to the list of supported databases and the guide to migrating to another database.

Deprecated Operating Systems for Confluence (21 July 2011)

This section announces the end of Atlassian support for certain operating systems for Confluence. End of support means that Atlassian will not fix bugs related to running Confluence server on that operating system past the support end date.

We will stop supporting the following operating systems from Confluence 4.0, due in late 2011:

- Mac OS X (as a Confluence server platform).

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

End of Life Announcement for Operating System Support

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X (as a Confluence server platform)</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>

**Mac OS X Notes:**

- Atlassian intends to end support for Mac OS X (as a server platform) in Confluence 4.0 (due for release in late 2011). Confluence 3.5 is the last version that will support Mac OS X.
- The Sun/Oracle JDK/JRE 1.6 is the only JDK platform officially supported by Atlassian. This means that Apple Mac OS X is not a supported operating system for the Confluence server, as the Sun/Oracle JDK does not run on Mac OS X.
- Accessing Confluence as a user from Mac OS X via a compatible web browser will still be...
supported for the foreseeable future.

Deprecation of Databases for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will stop supporting the following database versions from Confluence 4.0, due in late 2011:

- MySQL 5.0.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcements at atlassian dot com.

End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>MySQL (version 5.0 only)</td>
<td>When Confluence 4.0 releases, due in late 2011</td>
</tr>
</tbody>
</table>

MySQL Notes:

- Atlassian intends to end support for MySQL 5.0 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support MySQL 5.0.
- MySQL 5.1 will still be supported.
- 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with MySQL 5.0. However, we will not fix bugs affecting MySQL 5.0 past the support end date.
- Confluence 4.0 will not be tested with MySQL 5.0.

Deprecation of Web Browsers for Confluence (7 January 2011)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will stop supporting the following web browser versions from Confluence 4.0, late middle of 2011:

- Microsoft Internet Explorer 7 (IE7).
- Safari 4.
- Firefox 3.5.

The details are below. Please refer to the list of supported platforms for details of platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcements at atlassian dot com.

End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Internet Explorer (version 7 only)</td>
<td>When Confluence 4.0 releases, late the middle of 2011</td>
</tr>
<tr>
<td>Safari (version 4 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
<tr>
<td>Firefox (version 3.5 only)</td>
<td>When Confluence 4.0 releases, due in late of 2011</td>
</tr>
</tbody>
</table>
- **Internet Explorer Notes:**
  - Atlassian intends to end support for IE7 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support IE7.
  - IE8 will still be supported.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with IE7. However, we will not fix bugs affecting IE7 past the support end date.
  - Confluence 4.0 will not be tested with IE7.

- **Safari Notes:**
  - Atlassian will introduce support for Safari 5 in Confluence 3.5.
  - We intend to end support for Safari 4 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Safari 4.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with Safari 4. However, we will not fix bugs affecting Safari 4 past the support end date.
  - Confluence 4.0 will not be tested with Safari 4.

- **Firefox Notes:**
  - Atlassian will end support for Firefox 3.0 in Confluence 3.5, as previously announced.
  - We intend to end support for Firefox 3.5 in Confluence 4.0 (due for release in the middle of 2011). Confluence 3.5 is the last version that will support Firefox 3.5.
  - Firefox 3.6 will still be supported.
  - 'Support End Date' means that Confluence 3.5 and previously released versions will continue to work with Firefox 3.5. However, we will not fix bugs affecting Firefox 3.5 past the support end date.
  - Confluence 4.0 will not be tested with Firefox 3.5.

 Deprecated Databases for Confluence (12 October 2010)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions:**

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support PostgreSQL 8.1. *Note, PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.*

The details are below. Please refer to the [Supported Platforms](#) for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcements at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>PostgreSQL (version 8.1 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>

- **PostgreSQL (version 8.1 only) End of Support Notes:**
  - Atlassian intends to end support for PostgreSQL 8.1 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. PostgreSQL 8.2 and PostgreSQL 8.4 will still be supported.
  - 'Support End Date' means that Confluence 3.4 and previous released versions will continue to work with the PostgreSQL 8.1. However, we will not fix bugs affecting PostgreSQL 8.1 past the support end date.
  - Confluence 3.5 (due to release in the first half of 2011) will not be tested with PostgreSQL 8.1.
Deprecated Web Browsers for Confluence (12 October 2010)

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

We will **stop supporting the following web browser versions:**

- From Confluence 3.5, due in the first half of 2011, Confluence will no longer support Firefox 3.0. *Note, Firefox 3.5 and Firefox 3.6 will still be supported.*

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox (version 3.0 only)</td>
<td>When Confluence 3.5 releases, due in the first half of 2011</td>
</tr>
</tbody>
</table>

**Firefox (version 3.0 only) End of Support Notes:**

- Atlassian intends to end support for Firefox 3.0 in Confluence 3.5 (due to release in the first half of 2011), with the final support for these platforms in Confluence 3.4. Firefox 3.5 and Firefox 3.6 will still be supported.
- 'Support End Date' means that Confluence 3.4 and previous released versions will continue to work with Firefox 3.0. However, we will not fix bugs affecting Firefox 3.0 past the support end date.
- Confluence 3.5 (due to release in the first half of 2011) will not be tested with Firefox 3.0.

Deprecated Databases for Confluence (6 July 2010)

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

We will **stop supporting the following database versions:**

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Oracle 10g (i.e. Oracle 10.1 and Oracle 10.2). *Note, Oracle 11g (i.e. Oracle 11.1 and Oracle 11.2) will still be supported.*

We have made these decisions in line with Oracle's decision to stop support for Oracle 10g, as per the "Oracle Database (RDBMS) Releases Support Status Summary [ID 161818.1]" article on the Oracle Support site (note, you will need an Oracle Support account to find and view the article). This also will reduce the testing time required for each release and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to Oracle 11g if needed.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.*
<table>
<thead>
<tr>
<th>Oracle (version 10.1 and 10.2 only)</th>
<th>When Confluence 3.4 releases, due in the second half of 2010</th>
</tr>
</thead>
</table>

- **Oracle (version 10.1 and 10.2 only) End of Support Notes:**
  - Atlassian intends to end support for Oracle 10.1 and Oracle 10.2 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Oracle 11.1 and Oracle 11.2 will still be supported.
  - 'Support End Date' means that Confluence 3.3 and previous released versions will continue to work with the Oracle 10.1 and Oracle 10.2. However, we will not fix bugs affecting Oracle 10.1 or Oracle 10.2 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Oracle 10.1 and Oracle 10.2.

**Deprecated Web Browsers for Confluence (6 July 2010)**

This section announces the end of Atlassian support for certain web browser versions for Confluence. End of support means that Atlassian will not fix bugs related to certain web browser versions past the support end date.

**We will stop supporting the following web browser versions:**

- From Confluence 3.4, due in the second half of 2010, Confluence will no longer support Safari 3 or Safari 3.1. *Note, Safari 4 will still be supported.*

The details are below. Please refer to the **Supported Platforms** for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browser</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Safari (version 3 and 3.1 only)</td>
<td>When Confluence 3.4 releases, due in the second half of 2010</td>
</tr>
</tbody>
</table>

- **Safari (version 3 and 3.1 only) End of Support Notes:**
  - Atlassian intends to end support for Safari 3 and Safari 3.1 in Confluence 3.4 (due to release in the second half of 2010), with the final support for these platforms in Confluence 3.3. Safari 4 will still be supported.
  - 'Support End Date' means that Confluence 3.3 and previous released versions will continue to work with the Safari 3 and Safari 3.1. However, we will not fix bugs affecting Safari 3 and Safari 3.1 past the support end date.
  - Confluence 3.4 (due to release in the second half of 2010) will not be tested with Safari 3 and Safari 3.1.

**Deprecated Databases for Confluence (24 March 2010)**

This section announces the end of Atlassian support for certain database versions for Confluence. End of support means that Atlassian will not fix bugs related to certain database versions past the support end date.

**We will stop supporting the following database versions:**

- From Confluence 3.3, due in Q3 2010, Confluence will no longer support DB2 8.2.
Note, DB2 9.7 will still be supported.

We are reducing our database support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in upgrading to DB2 9.7 if needed.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Database Support

<table>
<thead>
<tr>
<th>Database</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>DB2 (version 8.2 only)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- **DB2 (version 8.2 only) End of Support Notes:**
  - Atlassian intends to end support for DB2 8.2 in Q3 2010, with the final support for these platforms in Confluence 3.2. DB2 9.7 will still be supported.
  - 'Support End Date' means that Confluence 3.2 and previous released versions will continue to work with the DB2 8.2. However, we will not fix bugs affecting DB2 8.2 past the support end date.
  - Confluence 3.3 (due to release in Q3 2010) will not be tested with DB2 8.2.

### Deprecated Application Servers for Confluence (27 January 2010)

This section announces the end of Atlassian support for certain application servers for Confluence. End of support means that Atlassian will not fix bugs related to certain application servers past the support end date.

We will **stop supporting the following application servers**:

- From Confluence 3.2, due late Q1 2010, Confluence will no longer support JBoss application servers.
- From Confluence 3.3, due in Q3 2010, Confluence will no longer support Oracle WebLogic, IBM WebSphere or Caucho Resin.

We are reducing our application server platform support to reduce the amount of testing time and help us speed up our ability to deliver market-driven features. We are committed to helping our customers understand this decision and assist them in migrating to Tomcat, our supported application server.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

### End of Life Announcement for Application Server Support

<table>
<thead>
<tr>
<th>Application Servers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>JBoss 4.2.2</td>
<td>When Confluence 3.2 releases, due late Q1 2010</td>
</tr>
<tr>
<td>Oracle WebLogic 9.2</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
<tr>
<td>IBM WebSphere 6.1</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
<tr>
<td>Caucho Resin 3.0, 3.1.6, 3.1.7</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

- **JBoss End of Support Notes:**
  - 'Support End Date' means that Confluence 3.1 and previous released versions will continue to
work with stated application servers. However, we will not fix bugs affecting JBoss application servers.

- Confluence 3.2 will not support JBoss application servers.

**WebLogic, WebSphere and Resin End of Support Notes:**

- Atlassian intends to end support for Oracle WebLogic, IBM WebSphere, and Caucho Resin in Q3 2010, with the final support for these platforms in Confluence 3.2.
- ‘Support End Date’ means that Confluence 3.2 and previous released versions will continue to work with the stated application servers. However, we will not fix bugs affecting Oracle WebLogic, IBM WebSphere, and Caucho Resin application servers past the support end date.
- Confluence 3.3 (due to release in Q3 2010) will only be tested with and support Tomcat 5.5.20+ and 6.0.
- If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

**Why is Atlassian doing this?**

We have chosen to standardise on Tomcat, because it is the most widely used application server in our user population. It is fast, robust, secure, well-documented, easy to operate, open source, and has a huge community driving improvements. It is the de facto industry standard, with several companies available that specialise in providing enterprise grade support contracts for it, ranging from customisations to 24/7 support.

**Deprecated Java Platforms for Confluence (27 January 2010)**

This section announces the end of Atlassian support for certain Java Platforms for Confluence.

We will **stop supporting the following Java Platforms**:

- From Confluence 3.3, due Q3 2010, support for Java Platform 5 (JDK/JRE 1.5) will end.

We are ending support for Java Platform 5, in line with the Java SE Support Roadmap (i.e. "End of Service Life" for Java Platform 5 dated October 30, 2009). We are committed to helping our customers understand this decision and assist them in updating to Java Platform 6, our supported Java Platform.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

**End of Life Announcement for Java Platform Support**

<table>
<thead>
<tr>
<th>Java Platform</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Java Platform 5 (JDK/JRE 1.5)</td>
<td>When Confluence 3.3 releases, due Q3 2010</td>
</tr>
</tbody>
</table>

**Java Platform 5 End of Support Notes:**

- Atlassian intends to end support for Java Platform 5 in Q3 2010.
- ‘Support End Date’ means that Confluence 3.2.x and previous released versions will continue to work with Java Platform 5 (JDK/JRE 1.5), however we will not fix bugs related to Java Platform 5 past the support end date.
- Confluence 3.3 will only be tested with and support Java Platform 6 (JDK/JRE 1.6).
- If you have concerns with this end of support announcement, please email eol-announcement at atlassian dot com.

**Deprecated Web Browsers for Confluence (14 December 2009)**
This section announces the end of Atlassian support for certain web browsers for Confluence.

We will stop supporting older versions of web browsers as follows:

- From Confluence 3.2, due late Q1 2010, support for Firefox 2 and Safari 2 will end.
- From 13 July 2010, in line with Microsoft's Support Lifecycle policy, support for IE6 will end.

The details are below. Please refer to the Supported Platforms for more details regarding platform support for Confluence. If you have questions or concerns regarding this announcement, please email eol-announcement at atlassian dot com.

---

### End of Life Announcement for Web Browser Support

<table>
<thead>
<tr>
<th>Web Browsers</th>
<th>Support End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Firefox 2</td>
<td>When Confluence 3.2 releases, late Q1 2010</td>
</tr>
<tr>
<td>Safari 2</td>
<td>When Confluence 3.2 releases, late Q1 2010</td>
</tr>
<tr>
<td>Internet Explorer 6</td>
<td>When Confluence 3.3 releases (target Q3 2010) or 13 July 2010, whichever is sooner</td>
</tr>
</tbody>
</table>

- **Firefox 2 and Safari 2 Notes:**
  - Confluence 3.1 is the last version to officially support Firefox 2 and Safari 2.
  - You may be able to use these older browser for the most common use cases like viewing and editing content, but official support for these browsers will end once you upgrade to Confluence 3.2.
  - Confluence 3.2 is currently targeted to release late Q1 2010 and will not be tested with Firefox 2 and Safari 2. After the Confluence 3.2 release, Atlassian will not provide fixes in older versions of Confluence for bugs affecting Firefox 2 and Safari 2.

- **Internet Explorer 6 Notes:**
  - Confluence 3.2 (due late Q1 2010) will be the last version to officially support Internet Explorer 6
  - Confluence 3.3 is currently targeted to release Q3 2010 and will **not** support IE6.
  - Atlassian will support IE6 in Confluence until the 13th of July 2010, in line with Microsoft's Support Lifecycle policy. Beyond that date, released versions of Confluence will continue working with IE just as they did before, but we will not fix bugs affecting Internet Explorer 6.
  - You may be able to use Internet Explorer 6 for the most common use cases like viewing and editing content, but official support for this browser will end once you upgrade to Confluence 3.3

### Supported Platforms FAQ

**Q: How does Atlassian choose which JRE versions, application servers and databases to support?**

For application servers and databases, we try to pick a good cross-section of open source options and popular commercial platforms. We then choose which JRE versions to support based on the recommended environments for these servers.

**Q: What is a supported platform?**

A supported platform is one that:

- Confluence is regularly tested on during the development cycle
- One that is available within Atlassian for support technicians and developers to reproduce problems
- Bugs raised against it will be given a high priority

Supporting a platform means we know how to get Confluence running in that environment and can troubleshoot Confluence issues within it. It does not mean we have any particular expertise beyond that. As such, we may not
be able to provide assistance with customising or tuning that application server or database. (Atlassian support is not a substitute for a good database administrator.)

**Q: Can I get assistance with running Confluence on a platform that is not supported?**

If you are running Confluence on an unsupported platform, then we can not guarantee providing any support for it. Furthermore, we will recommend that you switch to a platform which is supported.

**Q: If you write your application to standards like J2EE, JDBC and SQL, doesn’t that mean it should run on any compliant server?**

Confluence is a complicated application and we commonly encounter interesting edge-cases where different servers have interpreted the specifications differently. Then again, each server has its own different collection of bugs.

**Q: How can I get Atlassian to support Confluence on a new platform?**

Supporting a new platform involves a significant investment of time by Atlassian, both up-front costs to set up new testing environments and fix any issues we might encounter and the ongoing costs involved in maintaining the application against this new environment in the future. As such, supporting a new platform is not something we will do unless we know there is significant demand for it.

Please be aware that your interest alone will not be enough for us to add support for your application server or database. We would need to see a significant number of votes on the issue raised in our public JIRA site or a significant level of interest in our forums, before considering supporting that platform.

**Q: My organisation has standardised on an operating environment that Confluence does not support. What can I do?**

In this situation, you have the following two options:

1. Run Confluence in the unsupported environment, with the caveats mentioned above.
2. Make an exception to your standardised operating environment and set up Confluence based on its supported platforms.

**Migrating Confluence Between Servers**

This page describes how to move Confluence between physical servers. It is distinct from other functions. It does not cover database migration, application server migration, or upgrading. Atlassian suggests doing each of these steps separately. See also:

- Upgrading Confluence
- Migrating to Another Database
- Switching to Apache Tomcat

**How to Create a Test or Development Site**

Administrators may need to move a Confluence site from one server to another for upgrades or downtime. This page tells you how to copy a Confluence site from one server to another. For example, you may want to transfer your current production snapshot to a test server as permitted in the licence agreement.

- **Avoid upgrades while migrating.** If you are planning to switch databases, application servers or Confluence versions, firstly perform the application transfer in isolation, and test that it was successful before making other changes.
- Development licenses are available for any Commercial or Academic license. Create one or contact Atlassian for help.
On this page:

- How to Create a Test or Development Site
- Transferring Confluence To Another Server Using The Same Operating System
- Transferring Confluence To Another Server Using a Different Operating System
- Ensuring no contact with production systems
- Migrating from HTTPS to HTTP
- Notes

⚠️ The information on this page does not apply to Confluence OnDemand.

Transferring Confluence To Another Server Using The Same Operating System

If the operating systems on both servers are the same, then the home and install folders can be copied straight into an identical external database and user management setup.

1. On the original server, create zips of the Confluence install and home directories. Copy the zips to the new server.
2. On the new server, unzip the install and home directories. Windows users should avoid unzipping with the Windows built-in extractor, instead use Winzip or the free 7Zip.
3. Modify the location of your war file if need be. If using Tomcat, this is likely in /Conf/Catalina/localhost. You'll want to make sure the docbase attribute is pointing to the right location.
4. This next step is dependent on your database:
   - For users of the internal database, the database content is stored inside the home directory. You should switch to an external database after the transfer is successful. The internal database is for evaluation only and is not recommended for use in Production systems.
   - For external databases stored on another server: change the user account or datasource permissions so that the new server has the same network access permissions as the original. Then confirm from the new server that the hostname can be resolved and is listening for database connections on the expected port.
   - For external databases hosted locally (ie. localhost): on the original server, create a manual database backup using a native db dump backup tool. Copy the database backup to the new server.
4. On the new server, install or upgrade the database version to match the original server.
6. Import the database backup.
7. Add a database user account with the same username and password as the original.
8. Provide the database user with the full access to the imported database.
9. Use a database administration tool to confirm that the user can login from the localhost.
10. This step depends on your database connection:
   a. If you use JDBC (the default option) to connect to the database, to modify any database connection information, go to the Confluence home directory and edit confluence-init.properties by changing the line starting with 'confluence.home='. Ensure it does not point to your production database server.
   b. If you use a data source, follow the instructions for your database type and ensure the data source points to the new database: PostgreSQL, MySQL, SQL Server or Oracle.
11. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration, provide the new server with network or local access to the same hosts as the original. If this is a true test site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change...
the server.xml or atlassian-user.xml files (Confluence 3.4 and below), or modify the directory settings in
Confluence Admin > User Directories (Confluence 3.5 and above) to point to the appropriate test servers.
Note that it might be acceptable to use a production connection here, as users won’t be logging on to the
test system in high volume.
12. If appropriate, make sure no emails are sent out from the test system.
14. Go to Administration > License Details and add your development license key. You can generate one at h
   ttp://my.atlassian.com. There are more details in How Can I Get a License for a Staging Environment?.
15. If you configured Confluence as a Windows service, repeat those instructions.
16. Add your development license key.
17. Some customers have experienced problems with Confluence’s search functions after performing a
   migration, or that the content of their \{recently-updated\} macro is not being updated correctly. Errors
   in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is
   strongly recommended that you perform a rebuild of your content indices after performing a migration.

Transferring Confluence To Another Server Using a Different Operating System

Migrating from Windows to Linux

You will need to replace the backslash with forward slash in the following lines in confluence.cfg.xml:

```xml
<property
    name="attachments.dir">${confluenceHome}/attachments</property>
<property name="lucene.index.dir">${confluenceHome}/index</property>
<property
    name="webwork.multipart.saveDir">${confluenceHome}/temp</property>
```

Using database tools (preferred option)

If you are using the Production backup strategy, follow these steps:

1. Download the proper distribution (the same one you have from your original site) from the Download
   Archive.
2. Copy your Confluence home (not install) directory from your original server (even if it was a different OS).
3. If you are changing the location of the home directory, open the Confluence
   install\confluence\WEB-INF\classes directory and edit confluence-init.properties by changing the line
   starting with 'confluence.home='.
4. For external databases stored locally, on the original server, create a manual database backup using a
   native db dump backup tool.
5. Copy the database backup to the new server.
6. On the new server, install or upgrade the database version to match the original server.
7. Import the database backup.
8. Add a database user account with the same username and password as the original.
9. Provide the user with the full access to the imported database.
10. Use a database administration tool to confirm that the user can login from the localhost.
11. To modify any database connection information, go to the Confluence home directory and edit
    confluence.cfg.xml. The connection URL is set under hibernate.connection.url. Ensure it does not point
to your production database server.
12. If you are using internal user management, skip this step. For users who have JIRA or LDAP integration,
    provide the new server with network or local access to the same hosts as the original.
13. Copy server.xml, atlassian-user.xml, osuser.xml, any patches, and any other customized files velocity or
    properties files. If you are using internal user management, skip this step. For users who have JIRA or
    LDAP integration, provide the new server with network or local access to the same hosts as the original. If
this is a true test site, set up a test of your JIRA site or LDAP server so as not to disrupt production systems and change the server.xml or atlassian-user.xml files to point to the appropriate test servers. Note that it might be acceptable to use a production connection here, as users won’t be logging on to the test system in high volume.

14. If appropriate, make sure no emails are sent out from the test system.
15. Start Confluence.
16. Go to Administration > License Details and add your development license key. You can generate one at http://my.atlassian.com. There are more details in How Can I Get a License for a Staging Environment?
17. If you configured Confluence as a Windows service, repeat those instructions.
18. Add your development license key.
19. Some customers have experienced problems with Confluence’s search functions after performing a migration, or that the content of their {recently-updated} macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you perform a rebuild of your content indices after performing a migration.

Using XML data backups (only for small to medium sized installations)

Note: The XML export built into Confluence is not suited for the backup or migration of large data sets. There are a number of third party tools that may be able to assist you with the data migration. If you would like help in selecting the right tool, or help with the migration itself, we can put you in touch with one of the Atlassian Experts.

If you’re not yet using the Production backup strategy, you can migrate Confluence to a different server machine by creating an XML data backup as usual, and then importing that to Confluence on the new server.

1. Create an XML data backup from Confluence as follows:
   a. Choose the cog icon at top right of the screen, then choose Confluence Admin.
   b. Select Backup & Restore.
   c. Check the Backup Attachments option and click Backup.
2. Identify the version of Confluence that you are currently using. This is displayed at the bottom of each Confluence page.
3. Download Confluence to the new server. Get the version of Confluence that you identified above, but for the operating system of the new server. You may be using either the latest Confluence version, or an older version.
4. Install Confluence on the new server.
5. Go to Administration > License Details and add your development license key. You can generate a license at http://my.atlassian.com. You can find more details in How Can I Get a License for a Staging Environment?
6. Restore your XML data backup from Administration > Backup and Restore.
7. If appropriate, make sure that no email contact can be made with the test system.
8. Some customers have experienced problems with Confluence’s search functions after performing a migration, or that the content of their {recently-updated} macro is not being updated correctly. Errors in the atlassian-confluence.log file corroborate such problems. Hence, to avoid these issues, it is strongly recommended that you rebuild your content indices after performing a migration.

Ensuring no contact with production systems

To ensure no contact with external systems, you will need to disable both inbound and outbound mail services.

1. Disable global outbound mail by running the following database query:
2. Disable space-level mail archiving by running the following database query:

```
SELECT * FROM BANDANA WHERE BANDANAKEY = 'atlassian.confluence.space.mailaccounts';
```

Change 'SELECT' to 'DELETE' in the above queries once you are sure you want to remove the specified accounts.

Once this is done, you can start your test site without any mails being sent or retrieved. Think carefully about other plugins which may access production systems (SQL macro, JIRA macro, etc.). If these write content, or create unwanted load on external systems, they should be disabled promptly after starting the test site.

**Migrating from HTTPS to HTTP**

You may want to migrate from a server secured by SSL to one which is not secured by SSL. For example, this may be useful if you are copying a Confluence site from a production to a test site.

To migrate from HTTPS to HTTP, undo the HTTPS-specific settings that are described on this page: Adding SSL for Secure Logins and Page Security.

**Notes**

- Ricky Sheaves (calebscreek) has written an interesting blog post on Moving Confluence from Windows to (Ubuntu) Linux.
- If you wish to merge two Confluence sites, you can consider using the remote import plugin. This plugin is currently not supported. The supported method would be to export a space and then import each space one by one. The two Confluence sites must be running the same version of Confluence.

**Migrating from Confluence OnDemand to a Confluence Installed Site**

This page is for people who are currently using a Confluence OnDemand site, and wish to move to a Confluence site that is hosted on their own servers.

**Summary**

You will need to download and install a special OnDemand release of Confluence (for example, 'Confluence 5.0-OD-1') and then move your data from your hosted Confluence OnDemand site into your newly installed site. You cannot move your data from Confluence OnDemand to a site installed from the standard Confluence download.

**Instructions**

**Note:** You must do the data export and the Confluence download (both described in the steps below) on the same day. This will ensure that your data and your Confluence installation are of the same version and are therefore compatible.

**To migrate from Confluence OnDemand to a Confluence installed site:**

1. Export the data from your Confluence OnDemand site, using the Confluence backup manager.
   - For instructions, see this page in the Confluence OnDemand documentation: Exporting wiki data.
   - You now have a backup file, also called an XML export, of your Confluence OnDemand data.
2. Download the OnDemand release of Confluence. Go to the Confluence OnDemand download page and
get the latest ‘OD’ release for your operating system. The latest downloads are at the top of the list. For example, get the following files, replacing ‘x’ with the latest number available:

- **For Windows 64-bit:** Get '5.0-OD-x - Windows Installer (64 bit)'
- **For Windows 32-bit:** Get '5.0-OD-x - Windows Installer (32 bit)'
- **For Linux 64-bit:** Get '5.0-OD-x - Linux Installer (64 bit)'
- **For Linux 32-bit:** Get '5.0-OD-x - Linux Installer (32 bit)'
- To install Confluence from an archive on UNIX or Mac OS X: Get '5.0-OD-x - Standalone (TAR.GZ Archive)'
- To install Confluence from an archive on Windows: Get '5.0-OD-1 - Standalone (ZIP Archive)'
- EAR/WAR archives are also available.

3. Install Confluence as described in the Confluence Installation Guide.

4. Import the data from your backup file (XML export) into your new Confluence installation. See Restoring a Site.

5. Log in to your new Confluence site, using the following credentials:
   - **Username:** sysadmin
   - **Password:** sysadmin
   - Change the password immediately after logging in.

6. Change the password immediately after logging in.

---

**On this page:**
- Summary
- Instructions
- Background
- Support, limitations, and recommendations
  - Upgrade required as soon as full release is available
  - Compatibility of third-party plugins
  - PostgreSQL database recommended
  - Confluence license

**Related pages:**
- Confluence Installation Guide
- Confluence Administrator’s Guide

---

**Background**

Backups taken from Confluence OnDemand are only compatible with the current OnDemand release (for example, ‘Confluence 5.0-OD-1’). The reason is that Confluence OnDemand is typically ahead of the downloadable version of Confluence, meaning that you will have new features in Confluence OnDemand that are not yet available in the downloadable version.

It is therefore not possible to migrate your data to a Confluence site installed from the standard Confluence download. You will need to download and install the special OnDemand release of Confluence (for example, ‘Confluence 5.0-OD-1’) as described above.

The advantage is that you will be able to keep the Confluence OnDemand features currently not available to other customers who are using the standard downloadable version of Confluence. However, there are a few major limitations as noted below.

**Support, limitations, and recommendations**

Please note the following points about your Confluence site installed from an OnDemand release.

*Upgrade required as soon as full release is available*

Atlassian Support will support your newly installed Confluence site, running the OnDemand release, until the full Confluence release is available.
For example, if your OnDemand release is 'Confluence 5.0-OD-1', then we will support it until Confluence 5.0 is released.

When the full version is released, you will need to upgrade to the full release in order to continue to receive support.

*Compatibility of third-party plugins*

Because Confluence OnDemand is typically ahead of the downloadable version of Confluence, most third-party plugins will not be compatible with the OnDemand release. You may have some problems with third-party plugins on your Confluence site, until you are able to upgrade to the full release. Note, however, that any third-party plugins that you were using in Confluence OnDemand should be compatible with your newly installed site too.

If you have any questions about the compatibility of third-party plugins with your OnDemand release, please contact the plugin vendors. Contact details are on the Atlassian Marketplace.

*PostgreSQL database recommended*

If you are uncertain about which database to choose for your Confluence site, we recommend PostgreSQL. See Database Setup for PostgreSQL. The Confluence OnDemand site runs on PostgreSQL, and we therefore know it to be compatible with your OnDemand release.

If you decide to choose another supported database and discover any problems with compatibility, please contact Atlassian Support. For a list of supported databases, see Supported Platforms.

*Confluence license*

Your Atlassian OnDemand license cannot be used in a site installed from the downloadable version of Confluence. Please get your new Confluence license at https://my.atlassian.com.

**Confluence Release Notes**

Welcome to this page about all production releases of Confluence wiki. The release notes give up-to-date information about the improvements made in each release. If you are upgrading from an earlier version of Confluence, you will find essential information in the upgrade notes associated with the relevant release notes.

**Latest major release: Confluence 5.0**

With great pleasure, Atlassian presents Confluence 5.0. A cleaner look. A better experience.

Read the full release notes.

**Related pages:**

- Confluence Development Releases
- Confluence Documentation Home

**Summary of major releases**

Looking for a list of highlights in the major Confluence releases? See the Confluence Release Summary.

**All release notes**

Confluence 5.0

- Confluence 5.0.2 Release Notes
- Confluence 5.0.1 Release Notes
- Confluence 5.0 Release Notes

Confluence 4.3
• Confluence 4.3.7 Release Notes
• Confluence 4.3.6 Release Notes
• Confluence 4.3.5 Release Notes
• (Confluence 4.3.4 was an internal release)
• Confluence 4.3.3 Release Notes
• Confluence 4.3.2 Release Notes
• Confluence 4.3.1 Release Notes
• Confluence 4.3 Release Notes

Confluence 4.2

• Confluence 4.2.13 Release Notes
• Confluence 4.2.12 Release Notes
• Confluence 4.2.11 Release Notes
• (Confluence 4.2.9 and 4.2.10 were internal releases)
• Confluence 4.2.8 Release Notes
• Confluence 4.2.7 Release Notes
• Confluence 4.2.6 Release Notes
• Confluence 4.2.5 Release Notes
• Confluence 4.2.4 Release Notes
• Confluence 4.2.3 Release Notes
• Confluence 4.2.2 Release Notes
• Confluence 4.2.1 Release Notes
• Confluence 4.2 Release Notes

Confluence 4.1

• Confluence 4.1.9 Release Notes
• (Confluence 4.1.8 was an internal release)
• Confluence 4.1.7 Release Notes
• Confluence 4.1.6 Release Notes
• Confluence 4.1.5 Release Notes
• Confluence 4.1.4 Release Notes
• Confluence 4.1.3 Release Notes
• Confluence 4.1.2 Release Notes
• (Confluence 4.1.1 was an internal release)
• Confluence 4.1 Release Notes

Confluence 4.0

• Confluence 4.0 Release Notes

Confluence 3.5

• Confluence 3.5.17 Release Notes
• Confluence 3.5.16 Release Notes
• Confluence 3.5.13 Release Notes
• (Confluence 3.5.12 was an internal release)
• Confluence 3.5.11 Release Notes
• (Confluence 3.5.10 was an internal release)
• Confluence 3.5.9 Release Notes
• (Confluence 3.5.8 was an internal release)
• Confluence 3.5.7 Release Notes
• Confluence 3.5.6 Release Notes
• Confluence 3.5.5 Release Notes
• Confluence 3.5.4 Release Notes
• Confluence 3.5.3 Release Notes
• Confluence 3.5.2 Release Notes
• Confluence 3.5.1 Release Notes
• Confluence 3.5 Release Notes

Confluence 3.4

• Confluence 3.4.9 Release Notes
• Confluence 3.4.8 Release Notes
• Confluence 3.4.7 Release Notes
• Confluence 3.4.6 Release Notes
• Confluence 3.4.5 Release Notes
• (Confluence 3.4.4 was an internal release)
• Confluence 3.4.3 Release Notes
• Confluence 3.4.2 Release Notes
• Confluence 3.4.1 Release Notes
• Confluence 3.4 Release Notes

Confluence 3.3

• Confluence 3.3.3 Release Notes
• (Confluence 3.3.2 was an internal release)
• Confluence 3.3.1 Release Notes
• Confluence 3.3 Release Notes

Confluence 3.2

• Confluence 3.2.1 Release Notes
• Confluence 3.2 Release Notes

Confluence 3.1

• Confluence 3.1.2 Release Notes
• Confluence 3.1.1 Release Notes
• Confluence 3.1 Release Notes

Confluence 3.0

• Confluence 3.0.2 Release Notes
• Confluence 3.0.1 Release Notes
• Confluence 3.0 Release Notes

Confluence 2.10

• Confluence 2.10.4 Release Notes
• Confluence 2.10.3 Release Notes
• Confluence 2.10.2 Release Notes
• Confluence 2.10.1 Release Notes
• Confluence 2.10 Release Notes

Confluence 2.9

• Confluence 2.9.3 Release Notes
• Confluence 2.9.2 Release Notes
• Confluence 2.9.1 Release Notes
• Confluence 2.9 Release Notes
Confluence 2.8
- Confluence 2.8.3 Release Notes
- Confluence 2.8.2 Release Notes
- Confluence 2.8.1 Release Notes
- Confluence 2.8 Release Notes
- Confluence 2.8 Beta Release Notes

Confluence 2.7
- Confluence 2.7.4 Release Notes
- Confluence 2.7.3 Release Notes
- Confluence 2.7.2 Release Notes
- Confluence 2.7.1 Release Notes
- Confluence 2.7 Release Notes

Confluence 2.6
- Confluence 2.6.3 Release Notes
- Confluence 2.6.2 Release Notes
- Confluence 2.6.1 Release Notes
- Confluence 2.6 Release Notes

Confluence 2.5
- Release Notes 2.5.8
- Release Notes 2.5.7
- Release Notes 2.5.6
- Release Notes 2.5.5
- Release Notes 2.5.4
- Release Notes 2.5.3
- Release Notes 2.5.2
- Release Notes 2.5.1
- Release Notes 2.5

Confluence 2.4
- Release Notes 2.4.5
- Release Notes 2.4.4
- Release Notes 2.4.3
- Release Notes 2.4.2

Confluence 2.3
- Release Notes 2.3.3
- Release Notes 2.3.2
- Release Notes 2.3.1
- Release Notes 2.3

Confluence 2.2
- Release Notes 2.2.10
- Release Notes 2.2.9
- Release Notes 2.2.8
- Release Notes 2.2.7
- Release Notes 2.2.6a
- Release Notes 2.2.5
• Release Notes 2.2.4
• Release Notes 2.2.3
• Release Notes 2.2.2
• Release Notes 2.2.1
• Release Notes 2.2

Confluence 2.1

• Release Notes 2.1.5
• Release Notes 2.1.4
• Release Notes 2.1.3
• Release Notes 2.1.2
• Release Notes 2.1.1
• Release Notes 2.1

Confluence 2.0

• Release Notes 2.0.3
• Release Notes 2.0.2
• Release Notes 2.0.1
• Release Notes 2.0

Confluence 1.4

• Release Notes 1.4.4
• Release Notes 1.4.3
• Release Notes 1.4.2
• Release Notes 1.4.1
• Release Notes 1.4

Confluence 1.3

• Release Notes 1.3.6
• Release Notes 1.3.5
• Release Notes 1.3.4
• Release Notes 1.3.2
• Release Notes 1.3.1
• Release Notes 1.3

Confluence 1.2

• Release Notes 1.2.3
• Release Notes 1.2.2
• Release Notes 1.2.1
• Release Notes 1.2

Confluence 1.1

• Release Notes 1.1.2
• Release Notes 1.1.1
• Release Notes 1.1

Confluence 1.0

• Release Notes 1.0.3
• Release Notes 1.0.1
• Release Notes 1.0
Notes

How to find a list of known issues

To find a list of known issues in a particular Confluence version, you can create a filter in the Atlassian issue tracker and use the permalink located at the top right of the issue tracker's page to access the filtered report. The following example filter is the list of bugs reported for Confluence 4.3 and now fixed:

https://jira.atlassian.com/secure/IssueNavigator.jspa?reset=true&jqlQuery=project+%3D+CONF+AND+issuetype+%3D+Bug+AND+affectedVersion+%3D+%224.3%22+AND+resolution+%3D+Fixed

Read the JIRA documentation on creating filters.

Confluence Release Summary

This page shows the highlights of the major Confluence releases.

Current Release

For information about the latest release, please go to the Confluence Release Notes.

Confluence 5.0 — 26 February 2013

- A visual refresh
- Updated global navigation
- Content creation made simple
- New sidebar for content discovery
- Editor improvements
- Quick access to recently viewed pages
- Redesigned space administration and space tools
- Improved theming and branding
- Improved user and group management for large sites
- More in the Confluence 5.0 Release Notes

Confluence 4.3 — 4 September 2012

- Workbox notifications
- Personal tasks
- Tasks on pages
- Confluence mobile
- Table sorting and highlighting
- Draggable images and macros
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Default space permissions
- More in the Confluence 4.3 Release Notes

Confluence 4.2 — 10 April 2012

- Page layouts
- Likes
- Quick comments
- Popular content on the dashboard
- Recommended content by email
- Labels on attachments
- Signup invitations via URL
- Easy upgrade, try and buy for plugins
- More in the Confluence 4.2 Release Notes

Confluence 4.1 — 13 December 2011
- Autoconvert for Pasted Links
- Image effects
- Quick find and replace
- Follow Your Network On the Dashboard
- Space attachments macro
- Global PDF stylesheets
- Use any character in page titles
- New translation feature
- More in the release notes

Confluence 4.0 — 19 September 2011
- Brand New Editor
- Simplified Editing Experience
- New Macros
- Faster Editing Experience
- Introducing @mentions
- Improved Page Comparison Functionality
- Email Notification Improvements
- New Confluence Installer and Guided Upgrades
- New Editor Plugin Points for Developers
- More in the release notes

Confluence 3.5 — 16 March 2011
- Easy, Powerful Connections to Active Directory, LDAP and Crowd
- Improved JIRA Integration
- Drag-and-Drop for HTML5 Browsers
- Autowatch and Improved Notification Settings
- Sharing Pages and Blog Posts
- Enhanced Code Macro
- More Administrative Improvements
- "What's New" Feature Tour
- Categories, a New Way of Organising Spaces
- Embedding Audio and Video with the Multimedia Macro
- Infrastructure Changes
- More in the release notes

Confluence 3.4 — 12 October 2010
- New Keyboard Shortcuts, Mac-Friendly Too
- Keyboard Shortcut Dialog
- User Macros in Macro Browser and Autocomplete
- New Plugin Manager
- Improved Performance
- Infrastructure Changes
- More in the release notes
Confluence 3.3 — 7 July 2010

- Confluence Page Gadget
- Autocomplete for Inserting Macros
- Property Panels for Links
- Property Panels for Images
- Manage Watchers
- Email Notifications for Network Activity and Blogs
- Blog Improvements
- Context-Sensitive Help Links
- Security Features
- Infrastructure Changes
- More in the release notes

Confluence 3.2 — 24 March 2010

- Autocomplete for Inserting Links
- Autocomplete for Embedding Images and Documents
- A Link Browser that's Smarter, Smoother, Faster
- New Documentation Theme
- New Easy Reader Theme
- Template Bundles
- Reordering while Moving a Page
- New Keyboard Shortcuts and Editor Hints
- User Interface Enhancements
- More in the release notes

Confluence 3.1 — 8 December 2009

- Introducing Gadgets
- Drag-and-Drop
- Office 2007 Support
- New 'Move Page' Feature
- Enhanced Image Browser
- Draft Comparisons
- Page Restrictions Dialog Box
- Other Editor Enhancements
- New Web Browser Versions Supported
- More in the release notes

Confluence 3.0 — 1 June 2009

- Introducing the Macro Browser
- Enhanced User Profiles
- Introducing Your Network
- New User Status
- New Hover Profile Feature
- Customisable Enhanced PDF Exports
- Improved Rich Text Editor
- Performance Improvements
- Engine Room and Developer Community
- Administration Improvements
- More in the release notes

Confluence 2.10 — 3 December 2008
• Introducing the Widget Connector
• Improved Office Connector Now Bundled
• Introducing Quick Navigation
• 'Did You Mean', OpenSearch and More
• Custom Stylesheets for Confluence Spaces
• Updated JIRA Issues Macro with Custom Fields and Dynamic Display
• Enhanced User and Group Management
• Upgraded Rich Text Editor
• Universal Wiki Converter now with SharePoint Import and More
• Improved Activity Macros
• Plugin Framework 2
• More in the release notes

Confluence 2.9 — 7 August 2008

• Streamlined Search
• Auto Save
• Charts
• Page Tree
• Gallery
• New Tutorial
• More in the Menus
• Alphabetical Page Ordering
• Better Spam Prevention
• Plugin Repository
• Engine Room and Developers' Community
• More in the release notes

Confluence 2.8 — 10 April 2008

• Dynamic menus and simplified screen design
• Page ordering
• Collapsible comments
• Multiple-label filter
• Confluence installer
• Task list
• Performance enhancements
• Administration, management and monitoring
• More in the release notes

Confluence 2.7 — 12 December 2007

• JIRA Issues and Portlet macros use new trusted authentication
• Two-tier administrator permissions
• Inserting images and attaching files during page creation
• Sorting of images in Gallery macro
• Simplified and improved logging
• Performance, maintainability and administration
• More in the release notes

Confluence 2.6 — 27 September 2007

• Fresh look for the Default theme
• Personalised comments and Dashboard
• Space description on Dashboard
- Labels on templates
- Default content for space home pages
- Social Bookmarking plugin now bundled with Confluence
- Back-dating and renaming news items
- More in the release notes

Confluence 2.5 — 29 April 2007
- Introducing flexible page restrictions
- Dynamic task list JRE incompatibilities
- contentbylabel macro supports AND condition
- More in the release notes

Confluence 2.4 — 14 March 2007
- Editable comments
- Page mailing
- More in the release notes

Confluence 2.3 — 5 January 2007
- Confluence Massive — cluster support
- People directory
- Activity plugin — usage statistics
- Blogging RPC plugin — manage news in Confluence using blogger-compatible desktop clients
- WebDAV client support via WebDAV plugin — create, edit, move pages, attachments, etc via WebDAV
- More in the release notes

Confluence 2.2 — 27 April 2006
- Personal spaces
- Localisation/internationalisation — drop-in language packs (similar to JIRA)
- CAPTCHA support — spam protection
- Improved searching
- Improved LDAP performance
- Confluence ships with Tomcat 5.5
- More in the release notes

Confluence 2.1 — 20 December 2005
- Autosave
- Concurrent edit warnings
- LDAP integration with Atlassian User/POLIS
- More in the release notes

Confluence 2.0 — 17 November 2005
- Rich Text Editing — WYSIWYG editor
- Labels
- Dashboard tabs — All, My, Team, New
- RSS builder
- Export pages as Word documents
- Copy pages
- More in the release notes

Confluence 1.4 — 23 May 2005
- New user interface
- Enhanced editing — doing more in the edit interface
- Page permissions
- New plugin types
- Configurable themes
- Completely rewritten Wiki to HTML conversion engine
- More in the release notes

Confluence 1.3 — 30 November 2004

- Mail archiving
- Themes
- Trash can
- More granular space permissions
- More in the release notes

Confluence 1.2 — 23 August 2004

- Page list views — alphabetical, directory view and search view of all pages in a space
- Image thumbnails and thumbnail galleries
- Threaded comments
- Enhanced Search - indexing attachment comments and file names and contextual searching
- New permissions interface
- More in the release notes

**Confluence Release Cycle**

New versions of Confluence are released frequently. Our goals are to:

- Make bug-fixes available to customers sooner
- Give interested customers early access to new features and API changes
- Make Confluence major releases predictable

**Feature Releases**

We aim to release new versions of Confluence every three to four months. These releases will contain the bulk of new functionality.

Feature releases are numbered by incrementing Confluence’s minor version number, so the move from Confluence 2.0 to 2.1 and 2.1 to 2.2 both introduced significant new features to the product. Occasionally we may change to a whole new major version number (Confluence 2.0 was originally slated to be released as 1.5), but that is mostly done for marketing purposes, and shouldn't be considered to have any practical meaning. 😊

Feature releases may not be API-compatible with the previous release. This means that you should test RPC clients, macros and plugins before running them on a newer version of Confluence.

You can find the time line history of our major releases at the downloads archive.

**Bug-Fix Releases**

Confluence bug-fix releases are scheduled every three to four weeks, depending on the number and urgency of the bugs that have been fixed during that particular development cycle. We aim to minimise the time between a bug being reported and a fix being available, without either us or our customers having to manage clumsy sets of manual patches.

Bug-fix releases will contain mostly bug-fixes, plus the occasional minor new feature or enhancement. Enhancements will be limited, however, as the main aim of these point releases is to improve stability, and make no significant API changes.
Bug-fix releases are numbered by incrementing the patch-level. So the first bug-fix release after Confluence 2.2 is 2.2.1, followed by 2.2.2. Occasionally, we will re-issue a bug-fix release because something was faulty with the original download. In that case we will create a "re-issue" release number, for example 2.1.5a or 2.2.1a.

Obviously, we don't expect anyone to upgrade Confluence every two weeks, administrators should keep their own schedule, based on how much of an inconvenience is being caused by any bugs that may have been fixed since. Sometimes, however, a security issue or serious application bug will arise that we feel it is in everyone's best interests to fix as soon as possible. In such cases, we will recommend in the Confluence Release Notes that all customers upgrade to the latest version.

**Milestone Releases**

Occasionally, when possible, we will release preview "milestone releases" of the next major Confluence version. How often and when we do so depends on the particulars of the current development cycle. In situations where we are working on a number of disparate features we may be able to do a number of progressive development releases, whereas in iterations where we are making significant changes to the Confluence internals, we may not have anything suitable for public consumption until quite late in the release cycle.

Milestone releases will be announced in the developer release notes. Milestone releases are published for testing plugins and early feedback about our work, please don’t use them on production systems.

The version number of a milestone release will be the version number of the next major release, suffixed with -m. So Confluence 2.3-m1 will be followed by 2.3-m2, and so on until the ultimate release of the finished Confluence 2.3.

**Upgrade Notes Overview**

Typically, each major release of Confluence comes with upgrade notes, which are specific recommendations for upgrading from the previous major version. If you plan to upgrade and skip a few Confluence versions, you must read the upgrade notes for all major versions between your current version and the version to which you are upgrading, to make sure you do not miss something important.

Please read our general information about upgrading Confluence.

**For example:**

When upgrading from Confluence 3.4 to Confluence 4.0, read the upgrade notes for Confluence 3.5, as well as those for Confluence 4.0.

Also, we strongly recommend that you read the upgrade notes for any minor releases in-between, since they contain important information that will affect your Confluence upgrade.

Below is a list of upgrade notes for previous major releases of Confluence, as well as the upgrade notes for important minor releases:

- Confluence 5.0 Upgrade Notes
- Confluence 4.3 Upgrade Notes
- Confluence 4.2 Upgrade Notes
- Confluence 4.1 Upgrade Notes
- Confluence 4.0 Upgrade Notes
- Confluence 3.5 Upgrade Notes
- Confluence 3.4 Upgrade Notes
- Confluence 3.3 Upgrade Notes
- Confluence 3.2 Upgrade Notes
- Confluence 3.1 Upgrade Notes
- Confluence 3.0.1 Upgrade Notes
- Confluence 3.0 Upgrade Notes
- Confluence 2.10 Upgrade Notes
Confluence 2.9 Upgrade Notes
Confluence 2.8 Upgrade Notes
Confluence 2.7 Upgrade Notes
Confluence 2.6 Upgrade Notes

You will find the upgrade notes attached to the release notes for the relevant version.

**Useful plugins**

Before installing an add-on (also called a plugin) into your Confluence site, please check the add-on’s information page to see whether it is supported by Atlassian, by another vendor, or not at all. See our guidelines on add-on support.

**RELATED TOPICS**

Confluence Release Summary
Confluence Release Notes

**Confluence 5.0.2 Release Notes**

11 March 2013
The Atlassian Confluence team is pleased to announce the release of Confluence 5.0.2, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don’t have Confluence 5.0 yet?

Take a look at the new features and other highlights in the Confluence 5.0 Release Notes.

**Release Notices**

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 5.0.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

**Updates and Fixes in this Release**

**JIRA Issues** (5 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>CONF-28051</td>
<td>Update to the latest patchlevel of bundled JRE - server-side security vulnerability exist.</td>
<td>⬆️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>🚨</td>
<td>CONF-28089</td>
<td>Missing Download link after XML export</td>
<td>⬆️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 5.0.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 5.0.2. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 5.0, read the release notes and upgrade guides for all releases between your version and the latest version. In particular:
   - Please read the Confluence 5.0 Upgrade Notes.
   - Please read the Confluence 4.3 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
   - If your site contains links to a file system (for example [\C:\Foo\Bar\foobarpreso.ppt] these may break when upgrading to Confluence 5.0.2. We recommend that you upgrade directly to Confluence 5.0.3. Refer to CONF-23575 - Authenticate to see issue details for more details.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 5.0.1 Release Notes

27 February 2013

The Atlassian Confluence team is pleased to announce the release of Confluence 5.0.1, which is a bug-fix release.

This release fixes a problem for Confluence sites using a language other than English. When installing or upgrading to Confluence 5.0, the ‘Create’ button does not work if the site is configured to use a language that is not English. This problem is fixed in Confluence 5.0.1.

Don’t have Confluence 5.0 yet?

Take a look at the new features and other highlights in the Confluence 5.0 Release Notes.
Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 5.0 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

**JIRA Issues** (5 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-28237</td>
<td>Confluence Create dialog does not appear if Global Default Language is not English</td>
<td></td>
<td>✏️ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>CONF-27932</td>
<td>When clicking 'Create' button, there is no response from Confluence.</td>
<td></td>
<td>✏️ Resolved</td>
<td>Duplicate</td>
</tr>
<tr>
<td></td>
<td>CONF-27338</td>
<td>Cannot use JIRA for User Management during Installation - process hangs and will not continue</td>
<td></td>
<td>✏️ Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>CONF-28399</td>
<td>Completed administrator tasks reappear after restart of application</td>
<td>✅️</td>
<td>✏️ Resolved</td>
<td>Cannot Reproduce</td>
</tr>
<tr>
<td></td>
<td>CONF-27733</td>
<td>Deadlocks when re-ordering Dynamic Tasklist</td>
<td>✅️</td>
<td>✏️ Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>

Confluence 5.0.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 5.0.1. For details of the fixes in this release, please read the release notes.
Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you **back up your Confluence Home directory and database**. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about [finding your Home directory](#).

2. If your version of Confluence is earlier than 5.0, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 5.0 Upgrade Notes.
   - If you are upgrading from 3.4 or earlier, please also read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes
   - If your site contains links to a file system (for example `C:\Foo\Bar\foobarpreso.ppt`) these may break when upgrading to Confluence 5.0.1. We recommend that you upgrade directly to Confluence 5.0.3. Refer to [CONF-23575 - Authenticate](#) to see issue details.

3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

**Confluence 5.0 Release Notes**

![Download](#)

**26 February 2013**

With great pleasure, Atlassian presents **Confluence 5.0**. A cleaner look. A better experience.

**Highlights of Confluence 5.0**

- A visual refresh
- Updated global navigation
- Content creation made simple
- New sidebar for content discovery
- Editor improvements
- Quick access to recently viewed pages
- Redesigned space administration and space tools
- Improved theming and branding
- Improved user and group management for large sites
- More goodness
- Infrastructure changes

**More**

- Read the [upgrade notes](#) for important information about this release.
- See the full list of [issues resolved in this release](#).

**Thank you for your feedback**

- 🌟 Over 25 feature and improvement requests fulfilled
- 🌟 More than 875 votes satisfied
- Video of what's new
A visual refresh

Confluence 5.0 introduces a modernised look and feel that is consistent with other Atlassian applications and follows the new Atlassian Design Guidelines.

Updated global navigation

We have made a number of changes to the Confluence header, to improve usability and visual design. If you’re using other Atlassian products, such as JIRA or Stash, you will also notice more cross-product consistency.

- **New application navigator.** This appears on the left of the header if your Confluence site is linked to other applications. Using the application navigator, people can move easily from Confluence to JIRA or other linked Atlassian applications. Administrators can add more links too. For example, link to your internal HR systems, corporate applications, external web links, and so on.
- **Space directory and people directory immediately accessible.** The new header includes options pointing directly to the space and people directories. Add-ons will also be able to add items to the head. For example, Team Calendars will add a ‘Calendars’ option.
- **Consolidated help menu.** A new top-level help icon presents links to online help, keyboard shortcuts, and other useful pages.
- **Consolidated administrator menu.** Site administrators can access add-on management, user management and general administrative settings, directly from the cog icon in the header.
- **Browse menu removed.** The ‘Browse’ menu in earlier Confluence versions contained a mishmash of options, some relating to the current space, some to the entire site, and some random options like keyboard shortcuts. Now things are much tidier and will feel familiar to users of JIRA too:
  - Site-level items now appear on the left of the header: Dashboard, space directory and people directory.
  - Space-related items are now in the sidebar (see Sidebar below).

Note that the 'Browse' menu remains available in the Documentation theme, which does not include the...
new sidebar.

### Content creation made simple

Just choose 'Create' in the new header. You can create an empty page, a blog post, or a page based on a template. Confluence will even suggest the space where your new page will go, based on the spaces you have visited or created content in recently.

Rest assured, we've looked after power users too. Press 'C' on your keyboard to open the 'Create' dialog quickly. You can also navigate around the dialog using your keyboard.

Note: The 'Add' option no longer appears at top right of Confluence pages. It is replaced by the 'Create' option.

To add a comment, scroll to the bottom of the page or press 'M' on your keyboard.
New sidebar for content discovery

Location, location, location! Confluence spaces now have a new sidebar, containing useful links and navigation aids. The sidebar helps people viewing a space answer these questions:

- Where am I?
- What is in this space?
- What are the most important links that I should be aware of?

The sidebar appears on the left of every page in spaces that use the default Confluence theme.

*Space navigation in one place*

From the sidebar you can choose a content type (pages, blog) or go to a different part of the space. Contextual navigation options appear at the bottom of the sidebar, based on the type of content you are viewing. For pages, the navigation section displays the children of the current page. For a blog, the navigation section shows a history of blog posts.

Space administrators can access the redesigned 'Space tools' pages from the sidebar, as well as the option to configure the sidebar.
Customising your sidebar

Space administrators can configure what is displayed in the top section of the sidebar.

- **Configure your space logo and name.** Customising the space details for your team or project has never been easier.
- **Show or hide pages and blog.** Perhaps you don't need a blog in your space, or perhaps you are using only the blog? You can show or hide the links, so that people don't stray into a content desert.
- **Add space shortcuts.** Help your team members and colleagues find important pages and other content by adding shortcut links on the sidebar. This is a great way of encouraging collaboration and improving productivity.
Collapse the sidebar to make best use of the space available. Click and drag the border, or use the keyboard shortcut: ` '[' . With the sidebar collapsed, you can still access the sidebar options.

Editor improvements

*Instant-load editor*

Increased speed means increased productivity. Confluence 5.0 instantly loads the editor when you choose 'Edit'. You don't have to wait for a full page refresh. Even faster: Type 'E' to start editing a page.

*Responsive new design*

With a new visual refresh, the responsive editor toolbar and footer maximise your editing space based on the size of your screen. This is useful for lower resolution devices such as projectors. When your browser window reduced to a certain size, the buttons and spacing in the editor toolbar and footer will shrink – perfect when doing presentations or taking notes during a meeting.
New and improved macros

We have made improvements to some existing macros and introduced a new one:

- **WYSWYG YouTube video macro placeholders.** When you paste a link to a YouTube video, you will see a preview – right there in the editor.

  Before:
  ![Before](https://example.com/before.png)

  After:
  ![After](https://example.com/after.png)

- **New Content Report Table macro.** This new macro makes it easy to generate a report like the Content by Label macro, but in tabular format. See [Content Report Table Macro](#).

- **Including excerpts across spaces.** The Excerpt Include macro can now include content from another space. When you type the name of the page into the Excerpt Include macro dialog, Confluence will offer a list of matching pages including those from other spaces. The wiki markup option is also available. You can type the space key followed by a colon and the page name, like this: `MYSPACE:My page name`.
- **Nested Expand macros.** You can now include one Expand macro inside another.
- **Metadata Details and Details Summary macros renamed.** The Metadata Details and Details Summary macros have been renamed to be more descriptive, and make it clearer that these two macros are used as a set. The functionality of the macros has not changed, and an upgrade task will automatically change the names over. The wiki markup and storage format names have not changed.

<table>
<thead>
<tr>
<th>Old Name</th>
<th>New Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata Details macro</td>
<td>Page Properties macro</td>
</tr>
<tr>
<td>Details Summary macro</td>
<td>Page Properties Report macro</td>
</tr>
</tbody>
</table>

Quick access to recently viewed pages

Finding pages you have visited recently is now easier than ever. A new dialog displays a list of your recent pages that you can search through and navigate quickly. Open the dialog by clicking on the user menu then choose ‘Recently Viewed’, or use the keyboard shortcut ‘\fg\’ then ‘\r\’.
Redesigned space administration and space tools

Our design team has given some love to the space administration pages and other space tools, so they now have that special Confluence 5.0 magic too. When you visit the new 'Space tools' option, we automatically take you to the permissions screen, since this is the most-used space administration page.

Note: In spaces using the default theme, the 'Browse' menu is gone. It is replaced by the options in the new sidebar.

If you have an add-on that adds an option to the space administration screens, you should test your add-on against this release and adjust the location of the option if necessary.
Improved theming and branding

**Site logo**

In the new Confluence header, you can customise the look and feel to fit your company branding by uploading your corporate logo. Details are in the documentation.

**Automatic colour schemes**

To make it easier to theme your Confluence site, upon uploading a new logo we automatically detect the primary colours and use magic to configure the site colour scheme to match.
Improved user and group management for large sites

We have made a number of improvements to user and group management, which are especially useful on sites with a large number of users.

**Improved LDAP performance**

We have removed unnecessary data retrievals when synchronising LDAP directories, which gives a marked improvement in performance. See issues CWD-3034 and CONF-23943.

**Improved group administration UI**

When browsing the list of groups, you can now search for group names containing a specific string, and adjust the number of groups displayed on a page. We have also improved the pagination when searching through groups. You can now choose whether to show 10, 20 or 50 results per page.
Improvements to the people directory

This release delivers three improvements to the people directory, with 180+ votes between them:

- Exclude deactivated users from the people directory by default, and provide the option to include them required (CONF-16477, fixed in Confluence 4.3.3). Similarly, exclude externally-deleted users from the people directory by default. Details are in the documentation: Searching the People Directory.

- Fix the bug that caused the people directory to appear empty or to show inconsistent results, after user have been deleted from LDAP or another external user management system (CONF-11467, fixed in Confluence 4.3.3).

- Make sure users from LDAP appear in the people directory and search results even when not logged in (CONF-6404, fixed in Confluence 4.3.2).

More goodness

Exporting blog posts to PDF

Need to share that company announcement as a PDF document? Just like pages, you can now export blog posts to PDF. Go to ‘Tools’ > ‘Export to PDF’.

Deleting a version of a page

Want to delete a specific version of a page? Now you can. Go to ‘Tools’ > ‘Page History’ and choose the option to remove a particular version of the page. This improvement satisfies more than 250 votes!
**In-page notifications about comments and edits**

Let’s say you are viewing a page, and someone adds a comment to that page, or updates the page. Wouldn’t it be cool to know about the comment or the update immediately? Now you can! Confluence displays a popup notification near the bottom of the screen. Choose ‘Show’ to see the comments, or ‘Ignore’ to dismiss the notification.

**Improved way to customise default space content – now via templates**

Want to customise the home page of all new spaces created in Confluence? Administrators can now edit a template for the home pages of site spaces and personal spaces. The process is quick and easy, and does not impact your existing spaces.

**Easier customisation of site welcome message**

You can now use a template to configure the top left section of the dashboard (the ‘site welcome message’). This gives you the full power of the rich text editor to create the welcome message.
Infrastructure changes

These are points of interest for plugin and add-on developers.

- **Atlassian Design Guidelines.** Confluence 5.0 introduces a modernised look and feel that is consistent with other Atlassian applications. These changes include a major upgrade to AUI (the Atlassian User Interface). We have also upgraded the version of jQuery that Confluence support your plugin will look different if it uses AUI. If it does not yet use AUI, your plugin will look out of place in Confluence 5.0. We recommend that you follow the new Atlassian Design Guidelines. See our guide to Maintaining web resources during ADG rollout.
- **AUI upgrade.** Confluence 5.0 includes the latest version of AUI 5.0.
- **UPM upgrade.** Confluence 5.0 ships with version 2.8.1 of the Universal Plugin Manager. Note that you can upgrade your version of UPM at any time, via the add-on manager in your Confluence administration console.
- **AppLinks upgrade.** Confluence 5.0 includes version 3.10.6 of Application Links. Note that people with 'Confluence Administrator' permissions can now configure application links. Previously you needed 'System Administrator' permissions to configure application links.
- **New and changed APIs.**
  - Pluggable 'Create' experience: See Writing a create content plugin for Confluence
  - Pluggable sidebar: See Adding space shortcuts
  - New Web-UI module for Confluence 5 space sidebar: system.space.sidebar/main
  - How to add an administration task in the new Confluence header, visible when the user clicks the cog icon, then Administration: See Creating admin console tasks for your add-on
  - How to ensure that your macro will be displayed on mobile devices: New mobile render mode for macros.
  - Web item plugin modules which use the "system.space" section will now appear as tabs under Space Tools.
- **More updates for developers.** Please see our guide to preparing for Confluence 5.0.
The Confluence 5.0 team

Development

Adrien Ragot
Agnes Ro
Alexander Dickson
Anatoli Kazatchkov
Ángel Eduardo García Hernández
Anna Katrina Dominguez
Chris Kiehl
Craig Petchell
Dave Loeng
David Richard
David Rizzuto
David Taylor
Don Willis
Edith Tom
Esther Asenjo Reyes
Fabian Kraemer
Ivan Loire
Jesper Särnesjö
Joe Xie
Jonathan Raoult
Julien Michel Hoarau
Kenny MacLeod
Matthew Erickson
Niraj Bhawnani
Olli Nevalainen
Paul Curren
Peggy Kuo
Richard Atkins
Ryan Ackley
Sam Tardif
Steve Haffenden
Steven Lancashire
Wesley Walser
William Archinal
Xavier Sanchez Taixe

Architecture

Charles Miller

Plugin updates

David Chui
Kai Chong
Ong Kang Leng
Philip Cher

Management

Product management

Bill Arconati
John Masson
Sherif Mansour

**Product marketing management**
Ryan Anderson
Terrence Caldwell
Matthew Hodges

**Development manager**
Matt Ryall

**Support**

**Sydney support**
Michael Seager
Denise Unterwurzacher
David Mason
Lachlan Dally

**Amsterdam support**
Yilin Mo
John Inder
Alex Conde
Peter Koczan
Ruchi Tandon

**Brazil support**
Alyson Reis
Guilherme Heck
Rodrigo Adami
Tiago Comasseto
Luiz Carlos Junior
Guilherme Nedel
Bernardo Acevedo
William Zanchet

**Kuala Lumpur support**
Joachim Ooi
Husein Alatas
Septa Cahyadiputra
Foogie Sim
Hanis Suhailah
Rian Josua Masikome
Amalia Sanusi

**San Francisco support**
Adam Laskowski
Tim Wong
Robert Chang
Ryan Goodwin
Andrew Campbell
Daniel Borcherding

**Service Enablement**
Renan Battaglin
Confluence 5.0 Upgrade Notes

Below are some important notes on upgrading to Confluence 5.0. For details of the new features and improvements in this release, please read the Confluence 5.0 Release Notes.

On this page:

- Preparing your team for Confluence 5
- Upgrade notes – user interface and editor
  - Changes to 'Browse' menu and space administration options
  - Changes to the dashboard
  - Renamed macros: Metadata Details and Details Summary
  - Global spaces renamed 'site spaces'
- Upgrade notes – administration
  - Space logo is now round
  - Default space content now managed in global templates
  - Welcome message now managed in global templates
  - New getting-started guide on dashboard
  - Confluence administrator permission now sufficient to configure application links
  - Custom themes, layouts and CSS will probably break
- Upgrade notes - functionality removed or replaced
  - Easy Reader theme is no longer available
  - Advance warning of plans to merge Documentation theme with the default theme
  - Destination of links to top level of space is no longer configurable
  - Office Connector configuration restricted to system administrators
  - Permission for page-level exports no longer configurable
  - Direct access to labels view no longer available via menus
  - Ability to add space labels no longer available
  - JavaScript configuration option
- Upgrade notes – integration and supported platforms
  - Team Calendars 3.1 or later required
  - End of support for Google Gears
  - End of support for Java 6
  - End of support for Tomcat 5.5
- Upgrade procedure
- Checking for known issues and troubleshooting the Confluence upgrade

Preparing your team for Confluence 5

Confluence 5.0 introduces a number of significant changes to the user experience: A new way of creating
content, a redesigned header, a new sidebar, and other changes to the look and feel of your site. People in your organisation will need to be aware of the coming changes, so that they can plan and prepare for them. We have written a guide to help you: Planning for Confluence 5.

In addition, if you are upgrading from Confluence 3.5 or earlier please note that the change to the Confluence editing experience is significant. See the guide to Planning for Confluence 4.

Upgrade notes – user interface and editor

Changes to 'Browse' menu and space administration options

For all spaces using the default theme, the 'Browse' menu has gone. It is replaced by options in the new sidebar. For help on preparing Confluence users for this change, see Planning for Confluence 5.

If your Confluence site includes plugins (add-ons) that add options to the 'Browse' menu:

- The options now belong under 'Space tools' in the sidebar. They will appear there if the plugin author has already updated the plugin for Confluence 5.0.

- The options may appear in the help menu (accessible from the Confluence header) after upgrade. This will happen if the plugin author has not yet updated the plugin for Confluence 5.0. See our guidelines for plugin developers: Browse Menu and Space Tools changes in Confluence 5.0.

Changes to the dashboard

The 'Dashboard' link has been removed from the header. To go to the Confluence dashboard, click the site logo.

Renamed macros: Metadata Details and Details Summary

We have renamed the following macros: Metadata Details is now Page Properties. Details Summary is now Details Summary Report. When you upgrade to Confluence 5.0 or later, an upgrade task will automatically rename all existing Metadata Details and Details Summary macros on your Confluence pages. The wiki markup and storage format code for these macros has not changed.

Global spaces renamed 'site spaces'

Global spaces are now known as 'site spaces'. The functionality of spaces has not changed. Macros that use the @global parameter are unchanged.

Upgrade notes – administration

Space logo is now round

As part of the refresh of the Confluence user interface, we have changed the shape of the space logo. Existing logos may be affected, and may not look good in the new round format.

We have added a simple way for space administrators to crop and update logos, directly from the space sidebar. Go to a page in the space and choose 'Configure sidebar'. Then choose the edit icon next to the space name. For step-by-step instructions, see Changing a Space's Logo.

Default space content now managed in global templates

The 'Default Space Content' option has been removed from the Administrator Console. New site templates are available for customising the homepage content of new site and personal spaces. These site templates are available on the 'Global Templates' screen of the Administration Console. An upgrade task will convert any existing default space content (created using the old wiki markup editor) to the new format. The 'Default Space Content' template will show as 'Edited' with your custom content inside.

Welcome message now managed in global templates
The welcome message that appears in the top left of your Confluence dashboard can now be customised via a site template, available on the 'Global Templates' screen of the Administration Console. This means you can use the rich text editor to edit the content. An upgrade task will convert your existing welcome message (created using the old wiki markup editor) to the new format. The default welcome message template will show as 'Edited' with your custom content inside.

**New getting-started guide on dashboard**

By default, the Confluence dashboard now displays a quick-start guide for administrators, under the site welcome message on the left. This section of the dashboard is visible to Confluence administrators and system administrators only. It is not configurable via the web interface, but you can update or remove it by editing the site layout as described in Customising the Getting Started Guide on the Dashboard.

**Confluence administrator permission now sufficient to configure application links**

Confluence 5.0 includes version 3.10.6 of Application Links. Note that people with 'Confluence Administrator' permissions can now configure application links. For example, they can link Confluence to JIRA. Previously, you needed 'System Administrator' permissions to perform this function. Confluence administrators will be able to add, modify and remove application links and project links. However, Confluence administrators can configure only OAuth authentication for application links.

**Custom themes, layouts and CSS will probably break**

To achieve the new look and feel of Confluence 5.0, we have made major changes to the CSS and layouts of the Confluence pages. If your Confluence site or any spaces use a custom theme or custom CSS, they will probably no longer work after the upgrade.

If you are using the Confluence default theme or the Confluence Documentation theme, no action is required.

If you are using the Easy Reader theme, your site and affected spaces will be moved to the Confluence default theme. See below.

If you are using a third-party theme, please use the plugin manager in your Confluence Administration Console to check if there is a new version of the theme that is compatible with Confluence 5.0. See Checking Add-on Compatibility with Application Updates.

If you have applied a custom theme, we recommend that you revert to the Confluence default theme before upgrading to Confluence 5.0. See how to apply a theme to a site or to a space.

If you have applied custom CSS, you will need to update the CSS after the upgrade. See our guide to styling Confluence with CSS. Confluence 5.0 introduces many new CSS rules to the application as well as heavily modifying existing CSS. You will need to update your CSS to reflect these changes. In order for your CSS to continue working you will need to ensure that any new rules added to Confluence are appropriately overridden in your CSS. Additionally you will probably want to go through your CSS and remove any overrides that are no longer required.

If you have applied custom decorators or layouts, you will need to update them after the upgrade. See our guide to customising your site and space layouts. Confluence 5.0 introduces many new markup patterns. If you do not have some or all of these patterns in place, you may find that your custom decorator does not look the way it is supposed to. The best way to update your decorator is to compare it to the decorators used in Confluence 5.0 and adapt yours to follow the same patterns.

These URLs may be useful, if your CSS breaks to the extent that you cannot access the options via the Confluence UI:

- Choosing a theme for the entire site:
Upgrade notes - functionality removed or replaced

**Easy Reader theme is no longer available**

Confluence 5.0 and later releases do not include the Easy Reader theme. We are moving towards a single Confluence theme that presents a simplified default experience. At the same time, we want to make it easy for add-on developers to extend Confluence with custom themes. Our analysis has shown that very few Confluence sites use the Easy Reader theme.

If your Confluence site currently uses the Easy Reader theme, the site and the spaces that use the theme will be automatically transferred to the default theme when you upgrade to Confluence 5.0.

**Advance warning of plans to merge Documentation theme with the default theme**

This is an advance notice that we plan to merge the functionality of the Confluence Documentation theme with the Confluence default theme. We do not yet have a specific date for this plan, and we are interested in your feedback. The new default theme, to be introduced in Confluence 5.0, includes a sidebar with contextual navigation. Our plan for a later release is to include all the features of the Documentation theme into the default theme, and then remove the Documentation theme from Confluence.

If you are interested in this change and would like to give us feedback, please add a comment on this blog post: Advance warning of plans to merge Documentation theme with the default theme. We are especially interested to know which features of the Documentation theme you use and value the most.

**Destination of links to top level of space is no longer configurable**

We have removed a little-used option from the Confluence site configuration. Up to now, Confluence had an option called 'View Space Goes to Browse Space'. The option determined what happened when people clicked a link that pointed to the root of a space. For example: http://my.confluence.com/display/MYSPACE

If the option was set, Confluence would direct people to the 'Browse Space' view instead of the space home
page. Now this option has gone, and Confluence will always direct people to the home page of the space when they click such a link.

How does this affect you?

- You do not need to do anything.
- The 'View Space Goes to Browse Space' configuration no longer applies to any spaces, even if you had previously selected this option.
- When people click a link that ends in the space key, like http://my.confluence.com/display/MYS PAC E, they will go to the space home page.

Office Connector configuration restricted to system administrators

Configuration of the Office Connector was previously available to both Confluence administrators and system administrators. In Confluence 5.0 and later, this action is now available to system administrators only. See Global Permissions Overview.

Permission for page-level exports no longer configurable

Previous versions of Confluence offered a configurable permission in the space administration interface, to control who can export pages to PDF and Microsoft Word. In Confluence 5.0 and later, this permission is no longer configurable. People who have permission to view the page will also be able to export the page to PDF and Word.

Note that this affects page exports only. The space export permission is still present and configurable.

Direct access to labels view no longer available via menus

In earlier versions of Confluence, people could get to the labels view by choosing 'Browse' > 'Labels'. Now that the 'Browse' menu has gone from the default theme, this option is no longer available.

To find the labels view:

- Where you see a label on a page, blog post or attachment, choose the label to go to the labels view. (Any page or blog post that has labels will have them listed together in a block at the bottom of the page.)
- You will also see labels in the 'Attachments' view or in a listing of attachments provided by the Attachments macro.

Alternatively, visit the following URL:

<MY.CONFLUENCE.SITE>/labels/listlabels-alphaview.action?key=MYSPACEKEY.

For example: https://confluence.atlassian.com/labels/listlabels-alphaview.action?key=DOC

Note: The Documentation theme retains the 'Browse' menu in Confluence 5.0, and thus the 'Browse > Labels' option is still accessible.

Ability to add space labels no longer available

In order to simplify the use of labels in spaces, we have removed the ability to add space labels. Existing space labels will remain, but you will be unable to add new space labels to your spaces. Space categories are not affected by this change.

JavaScript configuration option

We have removed an option from the general configuration section of the Administration Console that allowed for JavaScript to be served in the footer instead of the header. JavaScript will now always be served in the header.
Upgrade notes – integration and supported platforms

**Team Calendars 3.1 or later required**

If you are using the Team Calendars add-on for Confluence, you will need to upgrade to Team Calendars 3.1 or later. Earlier versions of this add-on will not work with the new design in Confluence 5.0.

**End of support for Google Gears**

Confluence no longer supports Google Gears for drag-and-drop.

**End of support for Java 6**

As previously announced, from this release onwards we no longer offer support for Java 6 (JRE and JDK 1.6). Please see End of Support Announcements for Confluence.

**End of support for Tomcat 5.5**

As previously announced, from this release onwards we no longer offer support for Tomcat 5.5.x. Please see End of Support Announcements for Confluence.

Upgrade procedure

**Note: Upgrade to a test environment first.** Test your upgrades in your test environment before rolling them into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
2. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, read the 2.2 release notes too.
   - If your site contains links to a file system (for example \C:\Foo\Bar\foobarpreso.ppt] these may break when upgrading to Confluence 5.0. We recommend that you upgrade directly to Confluence 5.0.3. Refer to CONF-23575 - Authenticate to see issue details for more details.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.
5. **“Create” option not activated on some sites:** If the global default language of your Confluence site is not English, you will need to install a patch in the form of a plugin. For more information, please refer to this article in our knowledge base: Nothing Happens when Users Click on The “Create” Button.

⚠️ The upgrade to Confluence 5 results in a reindex of all the users' personal information once the upgrade has complete. Installations with a large user base (> 10,000) may experience some delays in indexing of new content immediately after the upgrade. This may result in searching and update streams being out of date for a short period of time immediately after the upgrade.

Checking for known issues and troubleshooting the Confluence upgrade
After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

- **Check for known issues.** Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

- **Did you encounter a problem during the Confluence upgrade?** Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

- **If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.**

### Issues Resolved in Confluence 5.0

Below are the issues resolved in Confluence 5.0, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. The Confluence 5.0 Release Notes describe the new features in this release.

#### Features and Improvements

**JIRA Issues** (27 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>✉️</td>
<td>CONF-996</td>
<td>Allow removal of page version history for Space Administrators</td>
<td>✔️ Closed</td>
<td>Fixed</td>
<td>253</td>
</tr>
<tr>
<td>👀</td>
<td>CONF-5752</td>
<td>Allow the excerpt-include macro to work across spaces</td>
<td>✔️ Resolved</td>
<td>Fixed</td>
<td>111</td>
</tr>
<tr>
<td>✉️</td>
<td>CONF-16477</td>
<td>Provide the ability to filter out deactivated users from the people directory</td>
<td>✔️ Resolved</td>
<td>Fixed</td>
<td>109</td>
</tr>
<tr>
<td>✉️</td>
<td>CONF-5599</td>
<td>Export news (blog posts) to PDF</td>
<td>✔️ Closed</td>
<td>Fixed</td>
<td>90</td>
</tr>
<tr>
<td>✉️</td>
<td>CONF-6561</td>
<td>Add searching or filtering to Manage Groups screen</td>
<td>✔️ Closed</td>
<td>Fixed</td>
<td>36</td>
</tr>
<tr>
<td>✉️</td>
<td>CONF-26984</td>
<td>Add custom logo to</td>
<td>✔️ Closed</td>
<td>Fixed</td>
<td>29</td>
</tr>
<tr>
<td>Issue</td>
<td>Title</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Score</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>--------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td>CONF-8641</td>
<td>Better pagination when searching through groups</td>
<td>![Closed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>CONF-1573</td>
<td>Ability to delete a revision of a page</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>CONF-24665</td>
<td>Add ability to create links using non-standard protocols</td>
<td>![Closed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>CONF-9127</td>
<td>Group browser needs some work to be useable for large LDAP group membership</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-20820</td>
<td>Improve Pagetree and Children macro performance on large spaces, PermissionManager.getPermittedEntities()</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>CONF-23261</td>
<td>Administration Tasks Plugin Point</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-20946</td>
<td>Support @self spaceKey within livesearch macro</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-26083</td>
<td>Edit Default Space Content with the new editor</td>
<td>![Resolved](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-14548</td>
<td>Confluence's implementation of home pages</td>
<td>![Closed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>![Fixed](<a href="https://atlassian.com/issue%E5%88%A5%E5%80%8B">https://atlassian.com/issue別個</a> examination of the image)</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>
is unconventional.

- **CONF-28159**: Allow User picker to show more than 10 users per search. [Resolved] Fixed 1
- **CONF-27860**: Please remove "add" Menu in space detail view. [Resolved] Fixed 1
- **CONF-26225**: Mobile support for 3rd party macros. [Resolved] Fixed 1
- **CONF-24201**: Ability to nest Expand macros. [Closed] Fixed 1
- **CONF-21761**: View page restriction of a child page will be lost once the parent page is removed. [Closed] Fixed 1
- **CONF-27573**: Improve @mention discoverability by prefixing all @mentions with the @ symbol. [Resolved] Fixed 0
- **CONF-27080**: Make table cell colour buttons more intuitive. [Resolved] Fixed 0
- **CONF-26565**: Enhance task list email notification. [Resolved] Fixed 0
- **CONF-26134**: Render the image of embedded youtube videos in the editor. [Resolved] Fixed 0
- **CONF-25868**: Use the new... [Closed] Fixed 0
### Editor for setting the site
Welcome Message

**CONF-23022**
Allow to set default location for newly added pages

- [ ] Closed
- Fixed
- 0

**CONF-16730**
Space Admin - Default to "Permissions" Section

- [ ] Resolved
- Fixed
- 0

### Bugs Fixed

**JIRA Issues** (45 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-11467</td>
<td>People Directory empty or not displaying the proper number of people - When users have been deleted from an External User Management</td>
<td>![ ] Closed</td>
<td>Fixed</td>
<td>51</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22440</td>
<td>Windows key toggle left-hand navigation bar in Documentation theme.</td>
<td>![ ] Closed</td>
<td>Fixed</td>
<td>37</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-6404</td>
<td>Users from LDAP do not appear in people directory or search results until they have logged in</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
<td>24</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-22283</td>
<td>Display URL is not used when inserting jira</td>
<td>![ ] Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td>Issue ID</td>
<td>Description</td>
<td>Resolution</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-6861</td>
<td>Long strings of characters with no spaces don't wrap in table cells in PDF</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-24678</td>
<td>Copying a page to a different space results in no attachments coming with that page</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-17113</td>
<td>import doc: blocking issue OutOfMemory Error: Java heap space</td>
<td>Closed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-9703</td>
<td>Permissions checking on {children} tags consuming large amounts of CPU time</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-25944</td>
<td>Failure when converting editor format to storage format.</td>
<td>Closed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-26546</td>
<td>Inserting an autoformat emoticon in a scrolled page causes the page to jump</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-23782</td>
<td>Extra spaces are inserted when macro placeholders are inserted</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONF-27028</td>
<td>Background color of Macro Browser is black (instead of grey) in IE8</td>
<td>Resolved</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>JIRA Key</td>
<td>Description</td>
<td>Resolution</td>
<td>Status</td>
<td>Priority</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------</td>
<td>--------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>CONF-27002</td>
<td>A closing div tag for sign up section is wrongly placed in login.vm</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-23943</td>
<td>Group Lookup for Delegated Authentication Directory should not query for all membership attributes</td>
<td>Resolved</td>
<td>Fixed</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>CONF-27876</td>
<td>Shameful bug in abbreviation used for kilobytes while uploading the page</td>
<td>Closed</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-27336</td>
<td>Invalid HTTP response when hitting a 4xx or 5xx error. So Not Permitted/500jsp will never be shown to user</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-27274</td>
<td>Wiki markup for Space/Page Links in Header for Theme Configuration does not work.</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-27267</td>
<td>Widget Connector does not work with Viddler</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-23165</td>
<td>Can't dismiss &quot;Add some more Users&quot; task</td>
<td>Resolved</td>
<td>Fixed</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>CONF-27744</td>
<td>When typing a comment quickly, always</td>
<td>Closed</td>
<td>Fixed</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
CONF-26704 Making tables sortable

CONF-25724 attachment list in document uses twice the space (two lines) due to label edit icon (OnDemand and local)

CONF-28874 Move page dialog - page title displayed wrong when language is German

CONF-28823 Cannot create a Table of Contents macro along with a Tasklist Macro?

CONF-28060 "View in JIRA" button is broken for the JIRA issue macro in the Editor with equals sign in JQL

CONF-27785 No 'spade' in symbols dialog

CONF-27741 Able to delete/destroy page layout within the editor

CONF-27734 Layout icon incorrect: 50:50 has 66:33 icon instead
<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Description</th>
<th>Status</th>
<th>Resolution</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-27521</td>
<td>Help link on &quot;Add Page&quot; dropdown dialog is incorrect</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-27200</td>
<td>Recommended updates being sent to users who have unsubscribed</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-26729</td>
<td>Certain JavaScript resource requests are slow due to the ThreadLocalCache not being initialised</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-26570</td>
<td>Web panels defined for atl.footer don't get shown on admin pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-26423</td>
<td>Using bullet point macro on a large page causes the screen to scroll annoyingly</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-26143</td>
<td>Navmap Macro should not include deleted pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-25814</td>
<td>XML export page link is still accessible - /pages/exportpage.action?pageId=</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-23829</td>
<td>Mouse cursor is misplaced after bullet list indentation</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
</tr>
<tr>
<td>CONF-23828</td>
<td>Copy and paste a word somewhere in</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
</tr>
</tbody>
</table>
between the line makes the mouse cursor jumped to the end of line after hitting Backspace button

CONF-23827 Mouse cursor jumped to the end of line after inserting the auto formatting of asterisk or dash button in Firefox 8

Resolved Fixed 0

CONF-22965 User icons are not shown in search results

Resolved Fixed 0

CONF-21466 The error message is not appropriate for the blank username and password field

Resolved Fixed 0

CONF-15007 Bug in DownloadGate keeper

Resolved Fixed 0

CONF-12732 Author search populates the author incorrectly

Resolved Fixed 0

CONF-12731 Double-clicking the "Search" button, clears the author for "author-based" search

Resolved Fixed 0

CONF-12181 Editing space permissions for unknown key causes permissions to be removed from global permissions

Resolved Fixed 0
Confluence 4.3.7 Release Notes

29 January 2013
The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.7, which is a bug-fix release.

Don't have Confluence 4.3 yet?
Take a look at the new features and other highlights in the Confluence 4.3 Release Notes.

Release Notices
Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.7 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

Updates and Fixes in this Release

JIRA Issues (18 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-24665</td>
<td>Add ability to create links using non-standard protocols</td>
<td></td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>CONF-27533</td>
<td>Upgrade from 4.2 to 4.3.x fails when using Oracle</td>
<td></td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td></td>
<td>CONF-27635</td>
<td>Importing XML site backup from SQL Server-based or PostgreSQL-based Confluence to MySQL-based Confluence fails due to size limit for DATA column in</td>
<td></td>
<td>Closed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
AO_9412A1_A OREGISTRATION table

CONF-27526 Invalid object name 'SYS.OBJECT S' on MSSQL

CONF-27513 Importing XML site backup fails due to size limit for DESCRIPTION column in AO_9412A1_A OREGISTRATION table

CONF-25384 Error Testing LDAP Authentication: Write operations are not allowed in read-only mode (FlushMode.NEVER):

CONF-21575 Space Admin loads slowly for large spaces

CONF-15228 Upgrade task fails with Oracle when trying to create an index that already exists

CONF-28227 Bug Page is shown as changed, after another page that is linked from this page was moved to another space

CONF-27834 OS_PROPERTY ENTRY User Property
<table>
<thead>
<tr>
<th>Issue ID</th>
<th>Title</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-27720</td>
<td>Dashboard page layout problem due to invalid html</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27600</td>
<td>Attempting to import a space backup that doesn't include comments when a comment has been liked results in &quot;not-null property references a null or transient value: com.atlassian.confluence.like.LikeEntity.content&quot; error</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27597</td>
<td>Upgrading Confluence from 3.3.x and below to 4.x directly can fail with “Cannot drop the index 'ATTACHMENTTDATA.attach_idver_idx'”</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27589</td>
<td>Likes fails when user has invalid follower</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27322</td>
<td>Page history should not get indexed by Google</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27115</td>
<td>Upgrade PDFBox to</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 4.3.7 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.7. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.3 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

3. Download the latest version of Confluence.

4. Follow the instructions in the Upgrade Guide.

Confluence 4.3.6 Release Notes

15 January 2013
The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.6, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.3 yet?

Take a look at the new features and other highlights in the Confluence 4.3 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.6 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.
If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

Updates and Fixes in this Release

**JIRA Issues** *(8 issues)*

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗</td>
<td>CONF-26221</td>
<td>XSS vulnerability in the &quot;import word document&quot; page action through the page name</td>
<td></td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-27519</td>
<td>The Retry dialog in Confluence Mobile fails to dismiss</td>
<td>🟤</td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-27775</td>
<td>Deleted link reappears</td>
<td>🟤</td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-25937</td>
<td>Editing an existing link produces a strange behavior in IE8</td>
<td>🟤</td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-23633</td>
<td>Actions doeditpage,do movepage,doc createpage do not require XSRF token</td>
<td>🟤</td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-27773</td>
<td>HibernateAlterTableExecutor doesn't detect ignorable exception with non-english locales</td>
<td>⬇️</td>
<td>🟢 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>✗</td>
<td>CONF-27613</td>
<td>Render decorator within a transaction to avoid</td>
<td>⬇️</td>
<td>🟢 Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 4.3.6 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.6. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

3. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.

In particular:
- Please read the Confluence 4.3 Upgrade Notes.
- Please read the Confluence 3.5 Upgrade Notes.
- If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.3.5 Release Notes

18 December 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.5. This release includes some nice improvements to tables and macros.

Note: Confluence 4.3.4 was an internal release and was not made publicly available.

Don’t have Confluence 4.3 yet?

Take a look at the new features and other highlights in the Confluence 4.3 Release Notes.

Download Latest Version

Simplified table highlighting

We have separated the table header and highlighting options in the editor toolbar.

You can now mark a row or column as a table header, by choosing the heading row icon: or the heading
To highlight cells with a background colour, select the cells and then choose the colour from the highlight menu:

Release notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.5 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

Updates and fixes in this release

**JIRA Issues** (31 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>CONF-26698</td>
<td>Separate row/column highlight from the new background colouring</td>
<td></td>
<td>✅ Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-24035</td>
<td>Allow Confluence to integrate over HTTPS with remote systems secured with SSLv3</td>
<td></td>
<td>✅ Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-21761</td>
<td>View page restriction of a child page will be lost once the parent page is removed</td>
<td></td>
<td>✅ Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>📝</td>
<td>CONF-27294</td>
<td>Webwork direct method invocation can bypass</td>
<td></td>
<td>✅ Closed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
CONF-27470  ORA-01795 is thrown when Scheduled Job for Workbox Notifications is run

CONF-27548  Attachment links from external sources with spaces in their filename throw 404

CONF-27504  Workbox notifications are not sorted by created date when using MySQL

CONF-27428  The standard Confluence footer is not displayed when developing a new custom theme

CONF-27224  Share button default text is no longer gray, sends "Add optional note" in email if no note is added

CONF-27022  Likes are not imported when doing a Space export/import

CONF-26994  No option to 'Open' attachment

CONF-26993  Expand macro not working in
<table>
<thead>
<tr>
<th>Ticket</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-26985</td>
<td>captcha is broken for comments on On Demand Documentation</td>
</tr>
<tr>
<td>CONF-26396</td>
<td>Editor buttons disabled when invalid macro used</td>
</tr>
<tr>
<td>CONF-25296</td>
<td>IE8 Security Warning (Mixed Mode Prompt) When Editing a Page in SSL</td>
</tr>
<tr>
<td>CONF-23449</td>
<td>Code macro removes all leading white space till first character</td>
</tr>
<tr>
<td>CONF-23248</td>
<td>ContentPermissionConstraintUpgradeTask fails when there is NULL in CONTENT_PERM.CPS_ID or CONTENT_PERM_SET.CONTENT_ID</td>
</tr>
<tr>
<td>CONF-22241</td>
<td>Clicking on a Thumbnail Attachment with a Code Block Macro in a page gives Script Error in IE 8</td>
</tr>
<tr>
<td>CONF-16062</td>
<td>UTF-8 (international characters) supporting in code macros</td>
</tr>
<tr>
<td>#</td>
<td>Issue</td>
</tr>
<tr>
<td>-----</td>
<td>-----------</td>
</tr>
<tr>
<td>CONF-27446</td>
<td>Missing Mentions Notifications</td>
</tr>
<tr>
<td>CONF-27302</td>
<td>Twitter not working with the Widget Connector</td>
</tr>
<tr>
<td>CONF-27255</td>
<td>QuickReload: pollingDelay is not reset when becoming active again</td>
</tr>
<tr>
<td>CONF-27226</td>
<td>Copy-paste data-uri based images works in edit mode, fails on save</td>
</tr>
<tr>
<td>CONF-26697</td>
<td>Confluence Base Url With Path /pages Breaks Confluence Functionalties</td>
</tr>
<tr>
<td>CONF-26659</td>
<td>Widget Connector needs to deal with changed YouTube embed links</td>
</tr>
<tr>
<td>CONF-25394</td>
<td>Macros don't support absolute icon urls</td>
</tr>
<tr>
<td>CONF-24741</td>
<td><code>{toc-zone}</code>'s &quot;printable=false&quot; attribute incorrectly affects on-screen view in Confluence 4</td>
</tr>
<tr>
<td>CONF-24286</td>
<td>En dash in heading title breaks anchor links</td>
</tr>
</tbody>
</table>
Confluence 4.3.5 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.5 from an earlier version of Confluence. For details of the fixes in this release, please read the release notes.

Upgrade notes

Advance warning: Easy Reader theme will not be bundled with Confluence 5.0 or later

This is an advance notice that Confluence 5.0 and later releases will not include the Easy Reader theme. We are moving towards a single Confluence theme that presents a simplified default experience. At the same time, we want to make it easy for add-on developers to extend Confluence with custom themes. Our analysis has shown that very few Confluence sites use the Easy Reader theme.

If your Confluence site currently uses the Easy Reader theme, your site and spaces will be automatically transferred to the default theme when you upgrade to Confluence 5.0.

Upgrade procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.
3. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   • Please read the Confluence 4.3 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.3.3 Release Notes

19 November 2012
The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.3. This release includes some neat improvements:

- In-app notifications from JIRA and other Confluence sites
- Improved API for in-app notifications and tasks
- Android support in Confluence mobile
- Improvements to the people directory
- Release notices
- Updates and fixes in this release
- JIRA Issues (35 issues)

Don’t have Confluence 4.3 yet?
Take a look at the new features and other highlights in the Confluence 4.3 Release Notes.

In-app notifications from JIRA and other Confluence sites

Wishing you could have all your notifications in just one spot? Your Confluence workbox can now display notifications from JIRA and from other Confluence sites. To receive JIRA notifications, you need JIRA 5.2 or later. Follow the guide to Configuring Workbox Notifications, then see the power of workbox in action. More...

Improved API for in-app notifications and tasks

We are delighted to announce full support for the in-app notifications and tasks APIs – the API is no longer experimental. This release also introduces better internationalisation support for plugins using the notifications and tasks API. See our developer’s guide.
Android support in Confluence mobile

Confluence mobile now supports the default browser on Android devices (Android 4.0.3 Ice Cream Sandwich) as well as iOS. See Supported Platforms for details.

Improvements to the people directory

This release delivers two improvements to the people directory, with 160 votes between them:

- Exclude deactivated users from the people directory by default, and provide the option to include them if required (CONF-16477). Similarly, exclude externally-deleted users from the people directory by default. Details are in the documentation: Searching the People Directory.
- Fix the bug that caused the people directory to appear empty or to show inconsistent results, after users have been deleted from LDAP or another external user management system (CONF-11467).

Release notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.3 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

Updates and fixes in this release

**JIRA Issues** (35 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-26749</td>
<td>Allow setting metadata as JSON string for Notifications and Tasks</td>
<td></td>
<td>🌟 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-26708</td>
<td>Mywork item description attributes</td>
<td></td>
<td>🌟 Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-25529</td>
<td>Android ICS</td>
<td></td>
<td>🌟 Closed</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Default Browser support for Confluence Mobile

CONF-21788 Link updater changes last modifier of linking page ➔ Closed Fixed

CONF-27736 Opening a link to an undefined page loads a 404 ➔ Closed Fixed

CONF-27735 Unable to break out of a numbered sublist ➔ Closed Fixed

CONF-27082 Confluence will not start if the old build number is shorter than the new build number but starts with a higher number ➔ Resolved Fixed

CONF-26751 Persistent XSS in the removepage.action page through the title of the parent page being deleted ➔ Resolved Fixed

CONF-26665 translations are not picked up by the confluence-dashboard-macros plugin ➔ Resolved Fixed

CONF-26619 Incorrect captcha causes button string to show ➔ Closed Fixed
i18n key and gives a strange error message

CONF-25994 cut paste of paragraph + bullets loses the paragraph content

CONF-23410 Can't break out of a list item after shift+enter

CONF-22338 Attachments with + signs are allowed to be uploaded but fail

CONF-27749 Hitting Shift+enter in a long, scrolled table jumps the browser down to the current cursor position

CONF-26799 SQL injection in DefaultReferral Manager

CONF-26740 Layout problems with Chrome 22

CONF-26729 Certain JavaScript resource requests are slow due to the ThreadLocalCache not being initialised

CONF-26124 Confluence loads anonymous accessible pages slowly after SSO session times
out but crowd.token_key cookie still exists

<p>| CONF-26089 | On a long page, hitting shift+enter on Chrome will jump your current line to the top of the viewport | Resolved | Fixed |
| CONF-12150 | Nonvalidated input causing NullPointerException from ViewBlogPosts ByDateAction | Resolved | Fixed |
| CONF-11467 | People Directory empty or not displaying the proper number of people - When users have been deleted from an External User Management | Resolved | Fixed |
| CONF-27809 | Attachments having special characters have spaces replaced by + in their filenames on download | Resolved | Fixed |
| CONF-27746 | The &quot;Learn more about templates&quot; link is hard coded and wrong. Change to use help-paths.properties. Check for others. | Closed | Fixed |</p>
<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Description</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-27738</td>
<td>PDF icon doesn't show up in link browser / attachments screen</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27604</td>
<td>Workbox points to confluence link instead of JIRA one</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27087</td>
<td>Visiting user profiles breaks 'Recently Viewed' dialog</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-27054</td>
<td>&quot;Edit&quot; and &quot;Remove&quot; buttons in the Macro properties panel are hardcoded to English</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26823</td>
<td>HibernateDraft Dao#getDraft is not cached</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26487</td>
<td>Follow user search field results render incorrectly</td>
<td>Closed</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26348</td>
<td>Find &amp; Replace - Cmd+F should focus find input if previous find session aborted</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26277</td>
<td>Copying a favorite page adds label 'favorite' automatically to the target page</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25365</td>
<td>Shift+enter in a list item with a</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
Confluence 4.3.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.3 from an earlier version of Confluence. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.
   Tip: Another term for ‘Home directory’ would be ‘data directory’. Read more about finding your Home directory.
2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.
3. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   • Please read the Confluence 4.3 Upgrade Notes.
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.3.2 Release Notes

15 October 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.2. This release includes some nifty improvements and bug fixes:
Excerpt Include macro across spaces

The Excerpt Include macro can now include content from another space. When you type the name of the page into the Excerpt Include macro dialog, Confluence will offer a list of matching pages, including those from other spaces.

Alternatively, you can type the space key followed by a colon (:) and the page name, like this:

Ability to nest Expand macros

You can now put one Expand macro inside another, and Confluence will correctly show and hide the contents of all Expand macros, including the nested ones. Here is an example.


More macros in Confluence mobile

We have made a large number of macros compatible with Confluence mobile. This means that many more macros will now work as expected when you access a page on your iPhone or iPad.

The following macros work in Confluence mobile:

- Anchor Macro
- Change-History Macro
- Chart Macro
- Cheese Macro
- Children Display Macro
- Column Macro
- Content by Label Macro
- Contributors Summary Macro
- Details Summary Macro
- Excerpt Include Macro
- Excerpt Macro
- Global Reports Macro
- HTML Include Macro
- HTML Macro
- IM Presence Macro
- Include Page Macro
- Info Macro
- Labels List Macro
Lorem ipsum Macro
Page Properties Macro
Multimedia Macro
Noformat Macro
Note Macro
Panel Macro
Popular Labels Macro
Profile Picture Macro
Recently Used Labels Macro
Related Labels Macro
RSS Feed Macro
Search Results Macro
Section Macro
Space Jump Macro
Status Macro
Table of Contents Macro
Table of Content Zone Macro
Tip Macro
View File Macro
Warning Macro
Widget Connector Macro

Are you using the Zen Foundation theme? All the Zen macros work in Confluence mobile now too.

For plugin developers – making your macros work in Confluence mobile

Have you written a Confluence macro as a plugin? In Confluence 4.3.2 and later, you can make your macros work in Confluence mobile. For many macros there is little effort involved. Confluence mobile will render a macro if it contains a device type specification of "mobile". For more complex macros, you may need to convert the CSS and JavaScript too. Details are in this document: Making your macro render in Confluence mobile.

Release notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.2 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

Updates and fixes in this release

**JIRA Issues** (44 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>CONF-26493</td>
<td>Autoconvert for HR after space not just enter</td>
<td></td>
<td>![ ]</td>
<td>Closed</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-26225</td>
<td>Mobile support for 3rd party macros</td>
<td></td>
<td>![ ]</td>
<td>Resolved</td>
</tr>
<tr>
<td>![ ]</td>
<td>CONF-24201</td>
<td>Ability to nest</td>
<td></td>
<td>![ ]</td>
<td>Closed</td>
</tr>
</tbody>
</table>
Expand macros

CONF-26342 There is a reflected XSS flaw in the settings.action of dailysummary settings.action. Resolved Fixed

CONF-27216 Cannot see image property panel, and general issues with images Closed Duplicate

CONF-26589 Reflected XSS within the username parameter of the /user/non-system/username rest resource Resolved Fixed

CONF-23176 JIRA issues macro export to PDF Resolved Fixed

CONF-27745 Tablesort icons are repeating incorrectly in tasklist, contentbylabel, RSVP and attachments macros Closed Fixed

CONF-26742 Slow Upgrade Due to UserIndexingUpgradeTask introduced in Confluence 4.3.1 Resolved Fixed

CONF-26504 Unable to drag image across to neighbouring cell (IE9) Closed Fixed

CONF-26502 it is too easy to Closed Fixed
<table>
<thead>
<tr>
<th>Issue</th>
<th>Description</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-26270</td>
<td>Reflected XSS in the pageld request parameter in 500page.jsp</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-26032</td>
<td>Due to a bug in Crowd, user-group memberships for groups containing slashes are not fetched correctly from Active Directory</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-25022</td>
<td>Changing username case in LDAP causes external group memberships to disappear</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-16396</td>
<td>Jira issues macro squashes toc macro</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-13708</td>
<td>Jira issues mappings don't support status with umlaut (internationalized text)</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-12947</td>
<td>Do not allow older versions of Confluence to run against newer Confluence homes</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
<tr>
<td>CONF-12233</td>
<td>Cosmetic (priority) icon</td>
<td>Resolved</td>
<td>Fixed</td>
</tr>
</tbody>
</table>
not shown when using jira issues in Confluence

Users from LDAP do not appear in people directory or search results until they have logged in

Gallery macro won't display images with single quotes in the name

Allow the excerpt-include macro to work across spaces

Multiple lines a table heading are not rendered as bold.

View file macro does not detect an office file attached during editing (through insert link/attachment) straight away

When I click to stop watching a page I no longer see a message that I've stopped watching

Single row tables should not be converted to sortable tables
CONF-26584  Click an image, or macro placeholder can sometimes activate drag and drop behaviour.

CONF-26523  Can't connect to LDAP over SSL when using Java 7

CONF-26518  Race condition in quick search leads to incorrect results

CONF-26503  Dragging content into body macro causes placeholder to shake

CONF-26501  Dragging content towards the bottom of a page causes editor to jump

CONF-26500  dragging something from one th to another th will highlight the source th

CONF-26497  Sorting little triangle on top of table columns is drawn opposite than expected

CONF-26496  When I add a linefeed to a table header, it unbolds and
<table>
<thead>
<tr>
<th>Issue Key</th>
<th>Description</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONF-26404</td>
<td>RSS feeds: relative path for inserted images</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>CONF-26325</td>
<td>Unable to preview Global template with users that only has Confluence Administrator right only</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>CONF-25961</td>
<td>NPE when defining LDAP directory and having wrong password</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>CONF-25955</td>
<td>Anchor link text occasionally truncated.</td>
<td>Resolved Can't Reproduce</td>
</tr>
<tr>
<td>CONF-23961</td>
<td>JIRA Issues macro renders HTML tags in static rendering mode</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>CONF-23092</td>
<td>template containing variable with jira or jiraissues macro adds &quot;&quot;, JIRA Issues&quot; to page title</td>
<td>Resolved Fixed</td>
</tr>
<tr>
<td>CONF-19056</td>
<td>jiraissues macro fail to render components when there is &gt;1 component when</td>
<td>Resolved Fixed</td>
</tr>
</tbody>
</table>
Confluence 4.3.2 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.2 from an earlier version of Confluence. For details of the fixes in this release, please read the release notes.

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

   Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

3. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.

   In particular:
   - Please read the Confluence 4.3 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.

4. Download the latest version of Confluence.

5. Follow the instructions in the Upgrade Guide.
Confluence 4.3.1 Release Notes

18 September 2012

The Atlassian Confluence team is pleased to announce the release of Confluence 4.3.1, which is a bug-fix release.

The complete list of fixes is at the bottom of this page.

Don't have Confluence 4.3 yet?

Take a look at the new features and other highlights in the Confluence 4.3 Release Notes.

Release Notices

Upgrading from a previous version of Confluence should be fairly straightforward. Please read the Confluence 4.3.1 Upgrade Notes. We strongly recommend that you back up your confluence.home directory and database before upgrading.

If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.

Updates and Fixes in this Release

JIRA Issues (17 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Priority</th>
<th>Status</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🏷️</td>
<td>CONF-26003</td>
<td>Confluence should have the html-migration plugin disabled by default</td>
<td>🕔  Resolved</td>
<td></td>
<td>Duplicate</td>
</tr>
<tr>
<td>🏷️</td>
<td>CONF-25909</td>
<td>XSS vulnerability in Office Connector plugin</td>
<td>🕔  Resolved</td>
<td></td>
<td>Fixed</td>
</tr>
<tr>
<td>🏷️</td>
<td>CONF-25362</td>
<td>SpaceDescription is null inside SpaceRemove Event</td>
<td>🕔  Closed</td>
<td></td>
<td>Fixed</td>
</tr>
<tr>
<td>🏷️</td>
<td>CONF-26122</td>
<td>Cannot delete a space</td>
<td>🕔  Resolved</td>
<td></td>
<td>Fixed</td>
</tr>
<tr>
<td>🏷️</td>
<td>CONF-26120</td>
<td>Cannot add personal space after removing it - probably</td>
<td>🕔  Resolved</td>
<td></td>
<td>Duplicate</td>
</tr>
</tbody>
</table>
because the space is not actually deleted

CONFLUENCE 4.x ships with html-migration module enabled and subsequently breaks the html macro

The table drop-down is positioned over the button instead of beneath it using the quick comment editor

CASE-SENSITIVE DN causes partial synchronization of LDAP membership.

Panel macro cannot handle links in the title

Support empty base DN definitions in a User Directory

Widget Connector does not work well in Preview

{panel} macro - Link Alias Doesn’t Work in ‘title=’ parameter

Table of contents does not link to the
Correct anchor when there are duplicate headers

CONF-26488

Chrome + Inline Tasks: Enter+Enter creates a <div/>

Closed

Fixed

Pressing Escape in Wiki Markup Dialog breaks future usages in editing session

CONF-26299

Closed

Fixed

(regression)
Deleted comment email styling has changed - used to be red

CONF-25576

Resolved

Fixed

Table of Contents Macro 'style=none' not working

CONF-23794

Resolved

Fixed

Confluence 4.3.1 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3.1 from an earlier version of Confluence. For details of the fixes in this release, please read the release notes.

Upgrade Notes

Note added on Friday 28 September: The Confluence 4.3.1 release contains an upgrade task that will cause the upgrade to take a long time, for Confluence sites with a large user base. For more information, please refer to this issue: CONF-26742 - Authenticate to see issue details

Upgrade Procedure

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home directory and database. The Confluence Home directory is the folder where Confluence stores its configuration information, search indexes and page attachments. If you are using the embedded HSQLDB database supplied for evaluation purposes, the database files are also stored in this directory.

Tip: Another term for 'Home directory' would be 'data directory'. Read more about finding your Home directory.

2. If your version of Confluence is earlier than 3.5.x, then you should upgrade to Confluence 3.5.x before upgrading to Confluence 4.3.x.
3. If your version of Confluence is earlier than 4.3, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   - Please read the Confluence 4.3 Upgrade Notes.
   - Please read the Confluence 3.5 Upgrade Notes.
   - If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
4. Download the latest version of Confluence.
5. Follow the instructions in the Upgrade Guide.

Confluence 4.3 Release Notes

4 September 2012

With great pleasure, Atlassian presents Confluence 4.3. Keep up with what's happening, rediscover your team's focus, and take action faster – even while on the go!

Highlights of Confluence 4.3

- Workbox notifications
- Personal tasks
- Tasks on pages
- Confluence mobile
- Table sorting and highlighting
- Draggable images and macros
- Rich text templates
- Space archiving
- Improved user invitations and signup options
- Default space permissions
- Other improvements
- Infrastructure changes

More

- Read the upgrade notes for important information about this release.
- See the full list of issues resolved in this release.

Thank you for your feedback

★★ Over 20 feature and improvement requests fulfilled
★★ More than 960 votes satisfied

Video of what's new

---

Workbox notifications

The new Confluence workbox collects your notifications from page watches, shares and mentions. Use the inline actions to comment on, like, or watch a page. More...
Do you want to mark a notification for later attention? Add it to your task list and come back to it later.

Personal tasks

As part of your workbox, you can now create and manage all your tasks in Confluence: personal tasks, tasks from notifications, and tasks assigned to you on Confluence pages. Plan your day's work, drag your tasks into order of priority, make notes, and mark your tasks as complete – all in one place. More...
Tasks on pages

It's now really simple to track your team's tasks on a page: project tasks, meeting action items, checklists, and whatever takes your fancy.

1. **Create task lists**
   Choose the new task icon in the editor to add a task list.

2. **Assign tasks using mentions**
   You can @mention a user within a task to assign it to that person. The task will appear in the user's personal task list.

3. **Notify assignees**
   Users receive a notification when a task has been assigned to them. In addition, page watchers will be notified when tasks in a page are marked as complete.

4. **Track tasks from anywhere**
   View all your assigned tasks in your workbox. Add notes, prioritise the tasks, and mark them as complete.

More...
Confluence mobile

Stay productive on the go with a new, super-responsive interface optimised for iOS 5. With Confluence mobile you can:

- Manage your personal tasks and notifications.
- Browse popular content, recent blog posts and network activity.
- Search Confluence for content and people.
- Like pages, blog posts and comments.
- Add comments to pages and blog posts.
- View the profiles of your colleagues. Tap to call, SMS or email them directly from your mobile device.

More...
Table sorting and highlighting

Sortable tables are here! They’re colourful and easier to read too.

- **Column sorting**
  When viewing a page, click a column header to sort the table by the values in the column.

- **Cell highlighting**
  Fill cells, rows and columns with a background colour to highlight important information.

**Custom Highlighting**
Highlight important information with custom background colors for cells and rows.
Draggable images and macros

Within the Confluence editor, you can drag and drop images and macros anywhere on the page that you are editing. This feature is supported in the following browsers: Chrome, Firefox, and Internet Explorer 9.

Rich text templates

The template editor now supports rich text content, just like the page editor. You no longer need to use wiki markup to create and update templates. This means that you can convert an existing page to a template. And easy to add form fields, known as variables, to your templates. More...
Space archiving

Do you need to make a space's content less visible, but keep the space available on your Confluence site? Archive it! When a space is archived, the pages and other content do not appear in the Confluence search results, activity streams, or dropdown menus. In the space directory, the archived space will appear on a new archive tab. More...

Improved user invitations and signup options

If you want to invite people to sign up to Confluence, you can email an invitation directly from the Confluence user administration screen. To further encourage people to sign up, the login screen includes a signup option too.

If you choose to add users manually, Confluence can send them an email message informing them of their new account.

If you want to allow only people from within your organisation to sign up, use the new domain restriction option. People will only be able to sign up if their email address belongs to one of the domains specified. Confluence will send the person an email message, asking them to click a link to confirm their email address. More...
Default space permissions

Confluence administrators can now set the default permissions that will be applied to new spaces. The default permissions are configurable for groups, and not for individual users or anonymous users. Note that the space permissions scheme remains as flexible as before. Space administrators can change the space permissions at any time, including the anonymous permissions, group permissions and individual user permissions.

Secure Sign-ups

Reinstate the responsibility of creating new accounts without losing any control.

We’ve also simplified the way you create spaces. The quick ‘Add Space’ option at the top of the dashboard leads you into the new, simplified dialog for adding global spaces, shown below. Adding a personal space is even simpler.
Other improvements

• **Removing attachment versions.** You can now delete a specific version of an attachment.

• **Mentions now available via the ‘Insert’ menu.** In Confluence 4.0 we introduced @mentions, a handy way of mentioning someone in a page or comment. Now we have added this user mention option to the editor’s ‘Insert’ menu, to help new users discover this useful feature.

• **Multiple new drafts.** You can now have more than one draft of a new page or blog post in the same space. (In earlier versions of Confluence, you could have multiple drafts of existing pages, but only one new draft.)

• **Reduced memory usage by up to 2 MB per plugin.** We have improved the implementation of the Atlassian template renderer, reducing memory usage by up to 2 megabytes per plugin, for those plugins that bundle their own Velocity templates.

• **Support for MySQL 5.5.** Reminder: We support MySQL 5.5 as well as 5.1. We announced this support with the Confluence 4.2.3 release, and made it applicable to Confluence 4.2 and later.

• **Session resource management.** Confluence now aggressively expires HTTP sessions that appear to come from bots or web crawlers, by lowering the idle timeout for sessions that only perform a single request. This significantly reduces the resource consumption by HTTP sessions on public-facing.
Confluence servers, or on servers integrated with third-party search appliances. This functionality is supplied by the Atlassian Bot Session Killer plugin, now bundled with Confluence.

- **Faster switching of dashboard tabs.** Switching between the activity tabs on the dashboard no longer causes the entire dashboard to reload.

## Infrastructure changes

Here are some points of interest for plugin developers.

- **JIRA Portlets gone.** We have removed the JIRA Portlet code from Confluence. We deprecated the use of JIRA portlets in Confluence 4.2 (see the [Confluence 4.2 upgrade notes](#)) and the JIRA Portlet plugin is no longer bundled in Confluence 4.3.

- **Improved data storage for plugin developers.** In previous versions of Confluence, Bandana was the primary data storage mechanism available to plugin developers. Confluence 4.3 ships with [Active Objects](#), a new ORM (object relational mapping) layer for Atlassian products, implemented as a plugin. It enables easier, faster, and more scalable data access and storage than the existing Bandana and PluginSettings APIs. Active Objects in Confluence is still under rapid development, and is currently used by only a few plugins. If you would like to experiment with it, we would love to hear your feedback.

- **API changes.** Please see our [guide to preparing for Confluence 4.3](#).

- **Experimental API for workbox notifications and tasks.** Confluence 4.3 introduces the workbox for managing notifications and tasks. We have an experimental API available and we’re requesting your feedback! Here is your chance to help us shape the notifications and tasks API. Details are in our [guide preparing for Confluence 4.3](#).

## The Confluence 4.3 team

**Development**

Alex Dickson  
Jonathan Raoult  
Adrien Ragot  
Edith Tom  
Anatoli Kazatchkov  
Ryan Ackley  
Richard Atkins  
Peter Camilleri  
Niraj Bhawnani  
Joseph Clark  
Paul Curren  
Anna Dominguez  
Matthew Erickson  
Steven Haffenden  
Chris Kiehl  
Fabien Kraemer  
Daniel Kjellin  
Steve Lancashire  
David Loeng
Craig Petchell
Sam Tardif
David Taylor
Wesley Walser
Don Willis
Joe Xie
Shihab Hamid
Charles O'Farrell
Olli Nevalainen
Peggy Kuo
Nabeelah Ali

Architecture
Charles Miller

Plugin updates
David Chui
Philip Cher
Kai Fung Chong

Management

Product management
Bill Arconati
Helen Hung
John Masson
Sherif Mansour

Product marketing management
Ryan Anderson
Terrence Caldwell
Matthew Hodges

Development manager
Matt Ryall

Support

Sydney support
Michael Seager
Denise Unterwurzacher
David Mason
Ray Elsleiman

Amsterdam support
Dennis Kromhout van der Meer
Yilin Mo
John Inder
Alex Conde
Peter Koczan

Brazil support
Alyson Reis
Guilherme Heck
Rodrigo Adami
Tiago Comasseto
Confluence 4.3 Upgrade Notes

Below are some important notes on upgrading to Confluence 4.3. For details of the new features and improvements in this release, please read the Confluence 4.3 Release Notes.

On this page:

- Preparing your team for Confluence 4
- Upgrade notes
  - End of support for DB2 and PostgreSQL 8.2
  - Removal of JIRA Portlet macro
  - Active Objects bundled
  - Migration of templates from wiki markup to the rich text format
  - Advance notice: End of support for Java 6 in Confluence 5.0
  - Advance notice: End of support for Tomcat 5.5.x in Confluence 5.0
  - Plain text emails no longer available
- Upgrade procedure
- Checking for known issues and troubleshooting the Confluence upgrade
If you are upgrading to Confluence 4 for the first time (coming from Confluence 3.5 or earlier) then please note that the change to the Confluence editing experience is significant. People in your organisation will need to be aware of the coming changes, so that they can plan and prepare for them. We have written some guides to help you:

Planning for Confluence 4

- Confluence 4 Editor FAQ
- Confluence 4 Editor - What's Changed for Users of the Old Rich Text Editor
- Confluence 4 Editor - What's Changed for Wiki Markup Users
- Quick Administrator Tips To Prepare for Confluence 4
- Trying Confluence 4 Yourself
- Giving Feedback on Confluence Releases
- Confluence 4 Editor - Customer Feedback

Upgrade notes

**End of support for DB2 and PostgreSQL 8.2**

As previously announced, from this release onwards we no longer offer support for the following database platforms:

- No versions of DB2 database are supported. For help with moving from DB2 to a supported database, please refer to the list of supported databases and the guide to migrating to another database.
- Version 8.2 of PostgreSQL database is not supported.

Please see End of Support Announcements for Confluence.

**Removal of JIRA Portlet macro**

The JIRA Portlet macro is no longer supported. Gadgets replaced portlets in JIRA 4.0 and Confluence 3.1. We deprecated the use of JIRA portlets in Confluence 4.2 (see the Confluence 4.2 upgrade notes) and have removed the portlet code in Confluence 4.3. Pages that contain the macro will no longer display information drawn from JIRA. Instead, they will show an error reporting that the macro does not exist. To prevent this behaviour, please upgrade to a version of JIRA that supports gadgets, and follow the instructions in How to Migrate from JIRA Issues and JIRA Portlets to Gadgets.

**Active Objects bundled**

Confluence 4.3 ships with the Active Objects plugin. If you have previously installed Active Objects into your Confluence 4.2 site, you will need to uninstall it before upgrading to Confluence 4.2. This is because user-installed plugins override bundled plugins.

**Migration of templates from wiki markup to the rich text format**

As part of the Confluence upgrade, an automatic migration of your page templates will take place. This is a non-destructive process. Your existing content is not overwritten. Instead, the migration process will create a new version of each space template and each global template on your Confluence site. The new version will use the new XML storage format, so that you can edit the templates in the Confluence rich text editor.

This process is automatic, and you should not need to take any action. For more details about the upgrade process, see Migration of Templates from Wiki Markup to XHTML-Based Storage Format.

**Advance notice: End of support for Java 6 in Confluence 5.0**

We are planning to end support for Java 6 (JRE and JDK 1.6) in Confluence 5.0. See End of Support
Announcements for Confluence.

Advance notice: End of support for Tomcat 5.5.x in Confluence 5.0

We are planning to end support for Tomcat 5.5.x in Confluence 5.0. See End of Support Announcements for Confluence.

Plain text emails no longer available

Emails are now only available in HTML format, which allows for the display of images and formatted content, such as changes made and the full content of the updated page or blog post.

Upgrade procedure

Note: Upgrade to a test environment first. Test your upgrades in your test environment before rolling them into production.

If you are already running a version of Confluence, please follow these instructions to upgrade to the latest version:

1. Before you upgrade, we strongly recommend that you back up your Confluence Home Directory and database. See the documentation on backing up your Confluence site. If you are using an external database, perform a database backup.
2. If your version of Confluence is earlier than 4.2, read the release notes and upgrade guides for all releases between your version and the latest version.
   In particular:
   • Please read the Confluence 3.5 Upgrade Notes.
   • If you are upgrading from 2.1 or earlier, please also read the 2.2 release notes.
   • If your site contains links to a file system (for example [\C:\Foo\Bar\foobarpreso.ppt] these may break when upgrading to Confluence 4.3.x. We recommend that you upgrade directly to Confluence 5.0.3. Refer to CONF-23575 - Authenticate for more details.
3. Download the latest version of Confluence.
4. Follow the instructions in the Upgrade Guide.

Checking for known issues and troubleshooting the Confluence upgrade

After you have completed the steps required to upgrade your Confluence installation, check all the items on the Confluence post-upgrade checklist to ensure that everything works as expected. If something is not working correctly, please check for known Confluence issues and try troubleshooting your upgrade as described below:

• Check for known issues. Sometimes we find out about a problem with the latest version of Confluence after we have released the software. In such cases we publish information about the known issues in the Confluence Knowledge Base. Please check the known issues for the relevant release on this page of the Knowledge Base and follow the instructions to solve the problem.

• Did you encounter a problem during the Confluence upgrade? Please refer to the guide to troubleshooting upgrades in the Confluence Knowledge Base.

• If you encounter a problem during the upgrade and cannot solve it, please create a support ticket and one of our support engineers will help you.

Issues Resolved in Confluence 4.3

Below are the issues resolved in Confluence 4.3, ordered by number of votes. For the full details of the fixes, improvements and new features, please take a look at our issue tracker. The Confluence 4.3 Release Notes describe the new features in this release.

Features and Improvements
### JIRA Issues (27 issues)

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td>📋</td>
<td>CONF-11744</td>
<td>Creating a template using the rich text editor</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>143</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-3079</td>
<td>Need ability to remove specific versions of an attachment</td>
<td>🔄 Closed</td>
<td>Fixed</td>
<td>127</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-6482</td>
<td>Custom background colour for rows or cells in table</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>126</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-3921</td>
<td>Archive spaces</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>117</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-2559</td>
<td>Customizable default permissions for newly created space</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>106</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-19524</td>
<td>Add official support for Mobile Safari on the iPad</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>76</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-2493</td>
<td>Sortable Tables</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>61</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-4591</td>
<td>User signup with email verification</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>23</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-6488</td>
<td>When creating new user, optionally send the new user an email with their account information and reset password link</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>14</td>
</tr>
<tr>
<td>📋</td>
<td>CONF-8577</td>
<td>Add support for wireless devices to view and contribute</td>
<td>🔄 Resolved</td>
<td>Fixed</td>
<td>13</td>
</tr>
<tr>
<td>Conf Number</td>
<td>Description</td>
<td>Status</td>
<td>Resolution</td>
<td>Count</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>CONF-7644</td>
<td>Create super lightweight alternate theme for mobile users</td>
<td>Resolved</td>
<td>Fixed</td>
<td>13</td>
<td></td>
</tr>
<tr>
<td>CONF-6318</td>
<td>Headings should produce unique anchors so that headings with identical text can still be referred to</td>
<td>Resolved</td>
<td>Fixed</td>
<td>11</td>
<td></td>
</tr>
<tr>
<td>CONF-5520</td>
<td>Allow deletion of individual version attachments</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>CONF-12555</td>
<td>Create Multiple Drafts of News/Pages</td>
<td>Resolved</td>
<td>Fixed</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>CONF-24563</td>
<td>Cannot drag and drop within the new editor</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-23144</td>
<td>Tasks in Confluence</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>CONF-27010</td>
<td>Draggable images and macros</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-26525</td>
<td>Add &quot;archive space&quot; to the XML-RPC API</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-26057</td>
<td>Rework likes i18n to be sentence based rather than word based</td>
<td>Closed</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CONF-25658</td>
<td>Allow OnDemand a la carte instances to</td>
<td>Resolved</td>
<td>Fixed</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
select permissions when creating spaces

CONF-25657 Simplify create space permissions

Resolved Fixed 0

CONF-25292 Enable gzip transfer encoding by default

Resolved Fixed 0

CONF-25000 Better wording on the Like feature for Anonymous users

Closed Fixed 0

CONF-23756 Move to vertical positioning of the labels on the login form

Resolved Fixed 0

CONF-21965 Administration Console message for no mail server configured should provide a link to mail server configuration

Resolved Fixed 0

CONF-21845 Confusing label on CAPTCHA screen

Resolved Fixed 0

CONF-20368 The ability to change gzip settings should require sysadmin (rather than admin) privileges

Resolved Fixed 0

Bugs Fixed

JIRA Issues (40 issues)
<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Summary</th>
<th>Status</th>
<th>Resolution</th>
<th>Votes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CONF-4540</td>
<td>Complex headings generate invalid anchors</td>
<td>Resolved</td>
<td>Fixed</td>
<td>21</td>
</tr>
<tr>
<td></td>
<td>CONF-12930</td>
<td>Styles are lost in Confluence Digest mail (Confluence Changes in the last 24 hours)</td>
<td>Resolved</td>
<td>Fixed</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>CONF-25327</td>
<td>When editing subsequently saving a global template, labels for the template are duplicated</td>
<td>Resolved</td>
<td>Fixed</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>CONF-17962</td>
<td>Table of contents does not link to the correct anchor when there are duplicate headers</td>
<td>Resolved</td>
<td>Fixed</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>CONF-23672</td>
<td>web-panels do not get upgraded after plugin upgrade</td>
<td>Resolved</td>
<td>Fixed</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>CONF-25642</td>
<td>External developers are unable to compile plugins against Confluence 4.2</td>
<td>Resolved</td>
<td>Fixed</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>CONF-25518</td>
<td>Mention @user email notification doesn't work on page or comment edit</td>
<td>Resolved</td>
<td>Fixed</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>CONF-23794</td>
<td>Table of Contents Macro 'style=none' not working</td>
<td>Resolved</td>
<td>Fixed</td>
<td>4</td>
</tr>
</tbody>
</table>
CONF-26238  Backup Manager not working in OnDemand
Resolved Fixed 3

CONF-26050  Web Resource still calls com.atlassian.jira.gadgets.common instead of com.atlassian.jira.gadgets.common-lite
Resolved Fixed 2

CONF-23665  Cannot save Page after trying to insert a status macro with a % character
Resolved Fixed 2

CONF-26045  PageTemplate Manager API change in 4.3 without deprecation
Resolved Fixed 1

CONF-26040  Misleading statement of 'Like' status in Deutsch
Closed Fixed 1

CONF-26019  Editor freezes when moving down with cursor and pasting status macro
Resolved Fixed 1

CONF-25965  "n people like this" link does not work in IE8
Closed Fixed 1

CONF-25434  Korean characters swallowed when typed into template variables. Cursor also behaves strangely in
Resolved Fixed 1
| CONF-22804 | Code Macro's parameter case sensitivity is causing issues. | Resolved | Fixed | 1 |
| CONF-26772 | Missing semicolon from method escapeXMLChararacters in source code. | Resolved | Fixed | 0 |
| CONF-26599 | Adding Custom Banner prevents page editor from saving or previewing | Resolved | Fixed | 0 |
| CONF-26588 | Adding new labels to an attachment with versions duplicates the labels. | Resolved | Fixed | 0 |
| CONF-26373 | The "Like" popup box doesn't display in IE8 | Resolved | Fixed | 0 |
| CONF-26340 | Opening Notifications panel throws ActiveObjectsSQLException | Resolved | Fixed | 0 |
| CONF-26248 | The LucidChart plugin is automatically enabled for every OnDemand customer | Resolved | Fixed | 0 |
| CONF-26231 | Export space doesn't keep the stylesheet | Resolved | Fixed | 0 |
CONF-26206  Tags in template are duplicate

CONF-26170  French translation of "Child Pages" ("enfants") is wrong

CONF-26014  Macro browser does not work in 4.3-beta1

CONF-25995  Confluence 4.2.9 and 4.3-beta1 can not upgrade due to invalid cast

CONF-25701  Scheduled Job Admin fails to load when running Confluence in Dev mode

CONF-25683  User reports being unable to 'Like' a Comment with IE8

CONF-25670  Either Jira or jira should autoformat to JIRA

CONF-25603  Warnings during Confluence setup: "Cannot find web resource module for: confluence.aui.staging:..."

CONF-25586  Unnecessary warning in Confluence backup: "There
really are map items, such as ..."

CONF-25350 '/users/userpic ker.action' exposes users loginids and full names in instance with anonymous access enabled

CONF-25348 Fix Turkish translation for the comment summary in "Confluence Like Plugin"

CONF-25322 The vulnerability exists in the standalone and also in the online demonstration enviroment.

CONF-24932 Tasklist sometimes enters tasks multiple times if enter is pressed while script is running.

CONF-23622 {code:xml} Macro Renders XML Schema Locations Incorrectly

CONF-23595 Code Macro has trouble displaying unicode characters during edit

CONF-15051 IM Presence
NG Plugin (v 2.3) includes outdated links to Wildfire / Openfire

Getting Help and Support

Find an answer to your question. Looking for a real person to solve a problem? We're here too!

**Online help**

Read the online documentation for detailed information about using and administering Confluence.

**Hint:** There are cute buttons at the bottom of every page, with links to useful locations. They are at the bottom of this page too.

**Support articles**

Refer to the Confluence Knowledge Base for troubleshooting, technical announcements, known issues and workarounds.

**Support team**

For one-on-one help from our support team, add a support request in the Confluence Support (CSP) project at Atlassian Support. A support engineer will follow up with you quickly.

If you do not have an account yet, you can create one before adding the support request – follow the prompts on the Atlassian Support screen. When creating your support request, please provide as much detail as possible. This will help us resolve your issue faster. See Troubleshooting Problems and Requesting Technical Support.

**Online forum**

If you cannot find what you need in the documentation, try asking a question in our discussion forum, Atlassian Answers. A number of skilled Atlassians, Atlassian Experts and customers are active participants on that forum.

**Features and bugs**

We love to hear your requests for new features and improvements! You can add a request in the Confluence (CONF) project in our JIRA issue tracker.

Alas, bugs do happen. If you find one, we will do our best to fix it. Please lodge a bug report in the issue tracker.

**Other resources**

Yes, there's more.

- Confluence Developer Documentation
- Confluence Resources
- Website Resources

**Confluence Resources**

*Resources for evaluators*

- Free trial

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
- Feature tour

**Resources for administrators**

- Confluence knowledge base
- Guide to installing an Atlassian integrated suite
- The big list of Atlassian gadgets

**Resources for developers**

- Atlassian Developers site
- Developer topics on Atlassian Answers

**Downloadable documentation**

- Confluence documentation in PDF, HTML and XML formats
- Setting up local online Confluence documentation

**Add-ons and plugins**

- Documentation for the Confluence SharePoint Connector
- Atlassian Marketplace

**Support**

- Atlassian Support
- Support policies

**Training**

- Atlassian training

**Answers**

- Confluence at Atlassian Answers

**Mailing lists**

- Visit http://my.atlassian.com to sign up for mailing lists relating to Atlassian products, such as technical alerts, product announcements and developer updates.

**Feature requests and bug reports**

- Issue tracker for Confluence

**Confluence Tutorial Videos**

This page contains videos giving tutorials on some of the Confluence functionality. The videos are intended to supplement, not replace, the online Confluence documentation.

⚠️ **Videos and Confluence version number**

The Confluence tutorial videos below are all recorded in Confluence 4.x. While there are commonalities between different versions of Confluence, you may find that the example scenarios in the tutorials differ from your Confluence site.

✅ Watch a full product demonstration of Confluence on Atlassian's website

---

Created in 2013 by Atlassian. Licensed under a Creative Commons Attribution 2.5 Australia License.
Confluence Overview
  - Content Structure
  - Space Directory

Editor Features
  - Autocomplete for Links, Media, and Macros
  - Autoconvert for Pasted Links
  - Autoformatting of Wiki Markup
  - Drag and Drop File Sharing
  - How to Build a Kick Ass Confluence Wiki Page in 10 minutes
  - Inserting Links
  - Image Effects
  - Table and Image Editing
  - Using Macros
  - Autosave and Versioning
  - Commenting

Sharing and Notifications
  - Share Button
  - Watch Content
  - Build a Network

Search
  - Quick Navigation
  - Advanced Search

Permissions
  - Global
  - Space
  - Page

JIRA Integration

Administration
  - Managing Groups
  - Installing Plugins
  - Importing and Exporting Content

Confluence Overview

Content Structure

Space Directory

Editor Features

Autocomplete for Links, Media, and Macros

Autoconvert for Pasted Links

Autoformatting of Wiki Markup

Drag and Drop File Sharing

How to Build a Kick Ass Confluence Wiki Page in 10 minutes
Local Confluence Documentation

This page tells you how to set up a copy of the Confluence documentation on your own local Confluence site.

Reasons for Setting up your own Local Documentation

You may wish to run the documentation locally. In addition, you may want to point Confluence's links at your
If you are working in an environment without an internet connection, you will need a local copy of the documentation. If you have customised Confluence, you may wish to update the documentation to reflect your changes. You may want to change the look and feel of the documentation to integrate it into your company's intranet. Confluence's interface contains links to help pages in the online documentation on confluence.atlassian.com. You may wish to point these help links to a different destination. Possible reasons include:

- You want to point the help links to a destination behind your firewall.
- You may want to link to a translated version of the documentation.

### On this page:
- Reasons for Setting up your own Local Documentation
- Setting up your Local Online Documentation
  - Additional Documentation Spaces Required
- Redirecting Confluence's Help Links to your Local Documentation
  - Changing the Base URL for your Help Links
  - (Optional) Changing the Links for Individual Help Pages
  - Example of the Help Property File
  - Example of a Help Link
- More Notes about Help Links

### Setting up your Local Online Documentation

#### To set up your own Confluence site with a copy of our Confluence documentation:

1. Install Atlassian Confluence, if you have not already installed it. (If you do not already have Confluence, ask for a free evaluation license or a starter license. You can use 'Anonymous' access to allow your users to view the documentation.)
2. Download the XML source code for the Confluence documentation. Note that the Confluence version of the XML source needs to be the same major Confluence version as your local Confluence site. For example, if the Confluence version in the XML is 3.0, you can import it into a Confluence site running version 3.0, 3.0.1 or 3.0.2. But you cannot import it into Confluence 2.9 nor into Confluence 3.1.
3. Import the XML file into your Confluence site. This will create a new space with key 'DOC'. Note: If there is already a 'DOC' space in your Confluence site, you must remove it before importing the new space. For detailed instructions, see the Confluence documentation on Restoring a Space.
4. Remove or adjust the customised header, footer and left-hand navigation bar in your new space. **Explanation:** When you create your new space from our XML source code, the space will inherit the Confluence 'Documentation' theme. The XML source code also includes the customisations we have made to the header, footer and left-hand navigation bar. These customisations include references to our Atlassian Documentation space. Since your Confluence site does not have that space, you will see errors like this in the left-hand navigation bar, header and footer in your new space:

   "Unable to render {include} Couldn't find a space with key: ALLDOC"

To fix these errors, take one of the following steps:

- Customise the navigation, header and footer sections to suit your Confluence site or environment. See our documentation on configuring the Documentation theme.
- Or restore the default left-hand navigation bar, by removing all content from the navigation, header and footer sections and selecting the 'Page Tree' check box. See our documentation on configuring the Documentation theme.
- Or change the theme of your space to the Confluence default theme or another theme of your choice.
5. Download the XML source code for the additional documentation spaces listed below and import them into your Confluence site too.

6. *(Optional)* Follow the steps in the next section if you want to redirect Confluence's help links to point to your local documentation.

**Additional Documentation Spaces Required**

**Why You Need the Additional Documentation Spaces**

The Confluence documentation shares some content with other Atlassian products, such as JIRA. For the sake of efficiency, we reuse the same content across documentation spaces. You will notice that some of our pages contain an *(include)* macro that draws in content from another space.

For example, the following macro includes content from the Application Links (APPLINKS) space into the Confluence documentation space:

```
{include:APPLINKS:_securityTrustedApps}
```

You will need to import those documentation spaces into your Confluence site, to ensure that the reused content is accessible in your Confluence documentation.

**Determining the Version Required**

We supply different versions of the documentation, for each version of the software or plugin concerned. To see which version you need, take a look at the space key in the *(include)* macro concerned.

- If the space key has a number at the end, that number indicates the version. For example, 012 means version 1.2, and 011 means version 1.1.
- If the space key does not include a number, you need the latest version of the documentation.

Here is an example of an include macro that requires version 1.2 of the Application Links documentation:

```
{include:APPLINKS012:_securityTrustedApps}
```

This example requires the *latest* version of the Application Links documentation:

```
{include:APPLINKS:_securityTrustedApps}
```

**List of Spaces Required**

Retrieve the relevant version of the XML backups from these pages:

- Application Links
- User Management

**Redirecting Confluence's Help Links to your Local Documentation**

In some parts of the Confluence user interface, you will see hyperlinks that point to the documentation for detailed information. These hyperlinks are Confluence's help links. You can redirect Confluence's help links to point to your local documentation.

There are two types of configuration changes you can make to the help property file:

- Change the base URL that determines the destination website of all your help links.
- *(Optional)* Change the page name for each individual help link.
Changing the Base URL for your Help Links

The help links and base URL are contained in a property file. In summary, you will need to do the following:

- Make a copy of the property file that Confluence uses to control the help links.
- Place the copy in a given directory where it will override the default property file.
- Update the copy with your own values.

To change the destination of your Confluence help links:

1. Copy the `confluence-x.x.x.jar` file from your `{CONFLUENCE-INSTALLATION}\confluence\WEB-INF\lib` directory and place it in a temporary location.
   
   **Note:** Do not remove the JAR, just make a copy of it.

2. Unzip the `confluence-x.x.x.jar` file into your temporary location and copy the `help-paths.properties` file.

3. Put the copy of the `help-paths.properties` file into your `{CONFLUENCE-INSTALLATION}\confluence\WEB-INF\classes` directory.

   **Note:** The property file will override the file in the JAR.


5. Change the help prefix, found at the top of the file. By default, the help prefix looks like this:

   ```text
   help.prefix=http://docs.atlassian.com/confluence/docs-{0}/{1}
   ```

   If you want to point your help links the ‘DOC’ space in your local Confluence site, your URL prefix will look like this:

   ```text
   help.prefix=http://confluence.mycompany.com/display/DOC/
   ```

   In addition, you can use the following special characters in the URL:

   - `{0}` – Optional. This value will be replaced with the version of Confluence running on your site.
   - `{1}` – Optional. This value will be replaced with the page name from the configuration file.


(Optional) Changing the Links for Individual Help Pages

If necessary, you can also change the individual page names to point to specific pages in your local documentation. You may want to do this if you are using a translated version of the documentation, for example, or your own custom guide rather than a copy of the Atlassian documentation.

The help links for each page are contained in a the same property file as the help prefix, described above.

To change the destination for each page:

1. Follow steps 1 to 4 described above, to put your copy of the `help-paths.properties` file into your `{CONFLUENCE-INSTALLATION}\confluence\WEB-INF\classes` directory, and edit your new `help-paths.properties` file.

2. Change the individual page names to point to specific pages in your local documentation. In our example file below, the first key-value pair looks like this:
help.restore.site=Restoring+a+site

You could change it to something like this:

help.restore.site=My+page+about+Restoring+Confluence

3. Restart Confluence.

Example of the Help Property File

Below is an example of part of the Confluence help-paths.properties file.

```properties
help.prefix=http://docs.atlassian.com/confluence/docs-{0}/{1}
## Page Names
help.restore.site=Restoring+a+site
help.manually.backup.site=Manually+Backing+Up+The+Site
help.configure.server.URL=Configuring+the+Server+Base+URL
help.configure.time.date.format=Configuring+Time+and+Date+Formats
help.edit.user.details=Editing+User+Details
```

The first line (help.prefix) shows the destination website of the help links. This value forms the first part of the destination URL.

- {0} – Optional. This value will be replaced with the version of Confluence running on your site.
- {1} – Optional. This value will be replaced with the page name from the configuration file.

Below the description '## Page Names' there are a number of key-value pairs.

- The key (such as help.restore.site) is an identifier used by Confluence to find the help link for a specific screen or dialogue.
- The page name (such as Restoring+a+site) is the URL-encoded page name that forms the last part of the destination URL.

Example of a Help Link

Here is an example of a Confluence screen with two help links, one on the words ‘our online documentation’ and another on ‘More about daily backups’:

Screenshot: Example of help links in Confluence
More Notes about Help Links

- Make sure that you keep all the key-value pairs for the page names in the help-paths.properties file. If you want to point them all to the same location, you should retain all the keys and replace all the page names with the same name. For example:

  ```properties
  help.prefix=http://myguide.mycompany.com

  ## Page Names
  help.restore.site=My+guide
  help.manually.backup.site=My+guide
  help.configure.server.URL=My+guide
  help.configure.time.date.format=My+guide
  help.edit.user.details=My+guide
  ```

- In the above instructions on configuring help links, we assume that you want to host your local documentation on your own Confluence site. Instead, you could choose to point the Confluence help links to an entirely different set of documentation, on a website or intranet. After reading through the instructions above, you will have an idea of how to adapt them for your own purposes.

- The help-paths.properties file is currently in the confluence-x.x.x.jar in the WEB-INF/lib directory. Instead, it should be a config file in the WEB-INF/classes directory. This will make it easy for people to change the values in the file and repoint their help links. It will also standardise the help design with that of JIRA and other Atlassian applications. This issue is tracked at CONF-20105.

Confluence SharePoint Connector

- Display SharePoint document libraries, calendars, links, discussions and more on your Confluence wiki pages. Edit SharePoint's Office documents directly from Confluence and save them back to SharePoint.
- Embed Confluence pages and Confluence page trees into a SharePoint page. Click through from SharePoint to Confluence.
- Enjoy automatic login (single sign-on) between Confluence and SharePoint.
- Search Confluence and SharePoint content together, retrieving a unified set of results.

Please refer to the SharePoint Connector documentation for more information.
Support Policies

Welcome to the support policies index page. Here, you'll find information about how Atlassian Support can help you and how to get in touch with our helpful support engineers. Please choose the relevant page below to find out more.

- Bug Fixing Policy
- How to Report a Security Issue
- New Features Policy
- Patch Policy
- Security Advisory Publishing Policy
- Security Patch Policy
- Severity Levels for Security Issues

To request support from Atlassian, please raise a support issue in our online support system. To do this, visit support.atlassian.com, log in (creating an account if need be) and create an issue under Confluence. Our friendly support engineers will get right back to you with an answer.

Bug Fixing Policy

Summary

- Atlassian Support will help with workarounds and bug reporting.
- Critical bugs will generally be fixed in the next maintenance release.
- Non-critical bugs will be scheduled according to a variety of considerations.

Raising a Bug Report

Atlassian Support is eager and happy to help verify bugs — we take pride in it! Please open a support request in our support system providing as much information as possible about how to replicate the problem you are experiencing. We will replicate the bug to verify, then lodge the report for you. We'll also try to construct workarounds if they're possible.

Customers and plugin developers are also welcome to open bug reports on our issue tracking systems directly. Use http://jira.atlassian.com for the stand-alone products and http://studio.atlassian.com for JIRA Studio and Atlassian OnDemand.

When raising a new bug, you should rate the priority of a bug according to our JIRA usage guidelines. Customers should watch a filed bug in order to receive e-mail notification when a "Fix Version" is scheduled for release.

How Atlassian Approaches Bug Fixing

Maintenance (bug fix) releases come out more frequently than major releases and attempt to target the most critical bugs affecting our customers. The notation for a maintenance release is the final number in the version (ie the 1 in 3.0.1).

If a bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions) then it will be fixed in the next maintenance release provided that:

- The fix is technically feasible (i.e. it doesn't require a major architectural change).
- It does not impact the quality or integrity of a product.

For non-critical bugs, the developer assigned to fixing bugs prioritises the non-critical bug according to these factors:
• How many of our supported configurations are affected by the problem.
• Whether there is an effective workaround or patch.
• How difficult the issue is to fix.
• Whether many bugs in one area can be fixed at one time.

The developers responsible for bug fixing also monitor comments on existing bugs and new bugs submitted in JIRA, so you can provide feedback in this way. We give high priority consideration to security issues.

When considering the priority of a non-critical bug we try to determine a 'value' score for a bug which takes into account the severity of the bug from the customer's perspective, how prevalent the bug is and whether roadmap features may render the bug obsolete. We combine this with a complexity score (i.e. how difficult the bug is). These two dimensions are used when developers self serve from the bug pile.

Further reading

See Atlassian Support Offerings for more support-related information.

How to Report a Security Issue

Finding and Reporting a Security Vulnerability

If you find a security bug in the product, please open an issue on http://jira.atlassian.com in the relevant project.

• Set the priority of the bug to 'Blocker'.
• Provide as much information on reproducing the bug as possible.
• Set the security level of the bug to 'Developer and Reporters only'.

All communication about the vulnerability should be performed through JIRA, so that Atlassian can keep track of the issue and get a patch out as soon as possible.

If you discover a security vulnerability, please attempt to create a test case that proves this vulnerability locally before opening either a bug or a support issue. When creating an issue, please include information on how the vulnerability can be reproduced; see our Bug Fixing Policy for general bug reporting guidelines. We will prioritise fixing the reported vulnerability if your report has information on how the vulnerability can be exploited.

Further reading

See Atlassian Support Offerings for more support-related information.

New Features Policy

Summary

• We encourage and display customer comments and votes openly in our issue tracking system, http://jira.atlassian.com.
• We do not publish roadmaps.
• Product Managers review our most popular voted issues on a regular basis.
• We schedule features based on a variety of factors.
• Our Atlassian Bug Fixing Policy is distinct from our Feature Request process.
• Atlassian provides consistent updates on the top 20 feature/improvement requests (in our issue tracker systems).

How to Track what Features are Being Implemented

When a new feature or improvement is scheduled, the 'fix-for' version will be indicated in the JIRA issue. This happens for the upcoming release only. We maintain roadmaps for more distant releases internally, but because these roadmaps are often pre-empted by changing customer demands, we do not publish them.
How Atlassian Chooses What to Implement

In every major release we aim to implement highly requested features, but it is not the only determining factor. Other factors include:

- **Customer contact**: We get the chance to meet customers and hear their successes and challenges at Atlassian Summit, Atlassian Unite, developer conferences, and road shows.
- **Customer interviews**: All product managers at Atlassian do customer interviews. Our interviews are not simply to capture a list of features, but to understand our customers' goals and plans.
- **Community forums**: There are large volumes of posts on answers, of votes and comments on jira.atlassian.com, and of conversations on community forums like groups on LinkedIn.
- **Customer Support**: Our support team provides clear insights into the issues that are challenging for customers, and which are generating the most calls to support
- **Atlassian Experts**: Our Experts provide insights into real-world customer deployments, especially for customers at scale.
- **Evaluator Feedback**: When someone new tries our products, we want to know what they liked and disliked and often reach out to them for more detail.
- **In product feedback**: The JIRA Issue Collectors that we embed our products for evaluators and our Early Access Program give us a constant pulse on how users are experiencing our product.
- **Usage data**: Are customers using the features we have developed?
- **Product strategy**: Our long-term strategic vision for the product.

How to Contribute to Feature Development

**Influencing Atlassian's release cycle**

We encourage our customers to vote on feature requests in JIRA. The current tally of votes is available online in our issue tracking system, http://jira.atlassian.com. Find out if your improvement request already exists. If it does, please vote for it. If you do not find it, create a new feature or improvement request online.

**Extending Atlassian Products**

Atlassian products have powerful and flexible extension APIs. If you would like to see a particular feature implemented, it may be possible to develop the feature as a plugin. Documentation regarding the plugin APIs is available. Advice on extending either product may be available on the user mailing-lists, or at Atlassian Answers.

If you require significant customisations, you may wish to get in touch with our partners. They specialise in extending Atlassian products and can do this work for you. If you are interested, please contact us.

Further reading

See Atlassian Support Offerings for more support-related information.

**Patch Policy**

Atlassian will only provide software patches in extremely unusual circumstances. If a problem has been fixed in a newer release of the product, Atlassian will request that you upgrade your instance to fix the issue. If it is deemed necessary to provide a patch, a patch will be provided for the current release and the last maintenance release of the last major version only.

Patches are issued under the following conditions:

- The bug is critical (production application down or major malfunction causing business revenue loss or high numbers of staff unable to perform their normal functions).
- A patch is technically feasible (i.e., it doesn't require a major architectural change)

OR
• The issue is a security issue, and falls under our Security Patch Policy.

Atlassian does not provide patches for non-critical bugs.

Provided that a patch does not impact the quality or integrity of a product, Atlassian will ensure that patches supplied to customers are added to the next maintenance release. Customers should watch a filed bug in order to receive e-mail notification when a “Fix Version” is scheduled for release.

Patches are generally attached to the relevant http://jira.atlassian.com issue.

Further reading

See Atlassian Support Offerings for more support-related information.

Security Advisory Publishing Policy

Publication of Security Advisories

When a critical severity security vulnerability in an Atlassian product is discovered and resolved, Atlassian will inform customers through the following mechanisms:

• We will post a security advisory in the latest documentation of the affected product at the same time as releasing a fix for the vulnerability.
• We will send a copy of all posted security advisories to the 'Technical Alerts’ mailing list for the product concerned.
  Note: To manage your email subscriptions and ensure you are on this list, please go to my.atlassian.com and click ‘Communications Centre’ near the top right of the page.
• If the person who reported the vulnerability wants to publish an advisory through some other agency, such as CERT, we will assist in the production of that advisory and link to it from our own.

If you want to track non-critical severity security vulnerabilities, you need to monitor the issue trackers for the relevant products on http://jira.atlassian.com. For example, https://jira.atlassian.com/browse/JRA for JIRA and https://jira.atlassian.com/browse/CONF for Confluence. Security issues in trackers will be marked with a "security" label. All security issues will be listed in the release notes of the release where they have been fixed, similar to other bugs.

One of the ways to monitor updates to security issues is subscribing to the results of a sample search via email or RSS.

Further reading

See Atlassian Support Offerings for more support-related information.

Security Patch Policy

Product Security Patch Policy

Atlassian makes it a priority to ensure that customers’ systems cannot be compromised by exploiting vulnerabilities in Atlassian products.

Scope

This page describes when and how we release security patches and security upgrades for our products. It does not describe the whole of disclosure process that we follow. It also excludes OnDemand, since OnDemand will always be patched by Atlassian without additional notifications.

Critical vulnerabilities

When a Critical security vulnerability is discovered by Atlassian or reported by a third party, Atlassian will do all of the following:

• Issue a new, fixed release for the current version of the affected product as soon as possible, usually in a
Issue a binary patch for the current release.
• Issue a binary patch for the latest maintenance release of the previous version of the product.
• Patches for older versions or releases normally will not be issued.

Patches will be attached to the relevant JIRA issue. You can use these patches as a “stop-gap” measure until you upgrade your installation in order to fully fix the vulnerability.

Non-critical vulnerabilities
When a security issue of a **High, Medium or Low** severity is discovered, Atlassian will do all of the following:

• Include the fix into the next scheduled release, both for the current and previous maintenance versions.
• Where practical, provide new versions of plugins or other components of the product that can be upgraded independently.

You should upgrade your installation in order to fix the vulnerability.

Other information
Severity level of vulnerabilities is calculated based on **Severity Levels for Security Issues**.

Visit our general [Atlassian Patch Policy](https://confluencelassian.com) as well.

**Examples**

**Example 1:** A critical severity vulnerability is found in a (hypothetical current release) JIRA 5.3.2. The last bugfix release in 5.2.x branch was 5.2.3. In this case, a patch will be created for 5.3.2 and 5.2.3. In addition, new bugfix releases, 5.3.3 and 5.2.4, which are free from this vulnerability, will be created in a few days.

**Example 2:** A high or medium severity vulnerability is found in the same release as in the previous example. The fix will be included into the currently scheduled releases 5.3.3 and 5.2.4. Release schedule will not be brought forward and no patches will be issued. If the vulnerability is in a plugin module, then a plugin upgrade package may still be supplied.

**Further reading**

See [Atlassian Support Offerings](https://confluencelassian.com) for more support-related information.

**Severity Levels**

Atlassian security advisories include a severity level. This severity level is based on our self-calculated CVSS score for each specific vulnerability. CVSS is an industry standard vulnerability metric. You can learn more about CVSS at [FIRST.org](https://confluencelassian.com) web site.

CVSS scores are mapped into the following severity ratings:

• Critical
• High
• Medium
• Low

An approximate mapping guideline is as follows:

<table>
<thead>
<tr>
<th>CVSS score range</th>
<th>Severity in advisory</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 – 2.9</td>
<td>Low</td>
</tr>
<tr>
<td>3 – 5.9</td>
<td>Medium</td>
</tr>
</tbody>
</table>
Below is a summary of the factors which illustrate types of vulnerabilities usually resulting in a specific severity level. Please keep in mind that this rating does not take into account details of your installation.

### Severity Level: Critical

Vulnerabilities that score in the critical range usually have most of the following characteristics:

- Exploitation of the vulnerability results in root-level compromise of servers or infrastructure devices.
- The information required in order to exploit the vulnerability, such as example code, is widely available to attackers.
- Exploitation is usually straightforward, in the sense that the attacker does not need any special authentication credentials or knowledge about individual victims, and does not need to persuade a target user, for example via social engineering, into performing any special functions.

For critical vulnerabilities, it is advised that you patch or upgrade as soon as possible, unless you have other mitigating measures in place. For example, if your installation is not accessible from the Internet, this may be a mitigating factor.

### Severity Level: High

Vulnerabilities that score in the high range usually have some of the following characteristics:

- The vulnerability is difficult to exploit.
- Exploitation does not result in elevated privileges.
- Exploitation does not result in a significant data loss.

### Severity Level: Medium

Vulnerabilities that score in the medium range usually have some of the following characteristics:

- Denial of service vulnerabilities that are difficult to set up.
- Exploits that require an attacker to reside on the same local network as the victim.
- Vulnerabilities that affect only nonstandard configurations or obscure applications.
- Vulnerabilities that require the attacker to manipulate individual victims via social engineering tactics.
- Vulnerabilities where exploitation provides only very limited access.

### Severity Level: Low

Vulnerabilities in the low range typically have very little impact on an organisation's business. Exploitation of such vulnerabilities usually requires local or physical system access.

**Further reading**

See [Atlassian Support Offerings](https://confluence.atlassian.com) for more support-related information.

**Troubleshooting Problems and Requesting Technical Support**

This document tells you how to troubleshoot problems in Confluence and how to obtain technical support from Atlassian.

**Troubleshooting a Problem**

If you have a problem with Confluence, please follow the steps below.

**To diagnose a problem and search for a solution:**

1. If you are not a Confluence administrator, report your problem to the person in charge of your Confluence site and ask them to follow up on the issue.
2. Use the inbuilt log scanner (see below) to check your Confluence logs for errors and attempt to match.
them against known issues in our knowledge base and bug tracker.
3. Check our knowledge base for solutions to known issues.
4. Check our issue tracker for known bugs.
5. If your problem may be related to a plugin, you can enter plugin safe mode by temporarily disabling any third party plugins.
6. If you are having problems configuring a feature, please take a look at the appropriate guides:
   - Confluence Installation Guide
   - Confluence Setup Guide
   - Confluence Administrator's Guide
   - Configuring Confluence
   - Database Configuration
7. Check the following guides for troubleshooting specific problems:
   - Issues related to your database server: Database Troubleshooting.
   - Issues related to user management: Requesting Support for External User Management.
8. If the above tools and documentation do not solve your problem, please create a support request and attach your support zip file. If you believe you have found a bug, you may wish to create a bug report instead. Instructions for both are given below.

On this page:
- Troubleshooting a Problem
- Scanning your Confluence Logs to Match Known Issues
- Raising a Support Request with a Plugin Author
- Raising a Support Request with Atlassian
  - Method 1: Using the Support Request Form via the Confluence Administration Console
  - Method 2: Raising a Support Request via the Internet
- Creating a Support Zip File via the Confluence Administration Console
- Logging a Bug Report

Related pages:
- Requesting Support for External User Management
- Requesting Performance Support
- Confluence Knowledge Base
- Confluence Administrator's Guide

Scanning your Confluence Logs to Match Known Issues

Confluence provides an inbuilt log scanner that will check your Confluence logs for errors and attempt to match them against known issues in our knowledge base and bug tracker.

The log scanner is known as Hercules, or the Atlassian support bot. It uses a set of patterns that we have discovered in our knowledge base and issue tracker.

To use the Confluence log scanner:

1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Choose 'Atlassian Support Tools' in the left-hand panel.
4. Choose the 'Log Scanner' tab.
5. Choose 'Scan' to scan the Confluence log file in its default location, or change the location if necessary then choose 'Scan'.
6. The log scanner will return a list of links, pointing to articles in our knowledge base and/or bug reports in
our issue tracker.

- The latest-reported problems are displayed first. By default only the most recent 10 matches are displayed. If you have more than 10 matches and want to display all results, click the 'Show All' link that appears on the top of the results page.
- Choose a link to read the reported problem and possible solutions or workarounds.

Screenshot: The log scanner

Raising a Support Request with a Plugin Author

If you have a plugin-related issue, please check whether the plugin is supported by Atlassian or by the plugin developer.

- Visit the plugin's home page in the Atlassian Marketplace.
- Check the 'Supported By' entry under the version information on the right side.
- If the plugin is not supported by Atlassian, you need to contact the plugin author directly.

You can read more about Atlassian support for plugins.

Raising a Support Request with Atlassian

There are two ways to raise a support request with Atlassian:

- **Method 1: (Recommended)** Complete the support request form via your Confluence Administration Console, as described below. A possible problem with this method is that your mail may not be forwarded correctly, due to restrictions imposed by your mail server. For example, the zip of your log files might be too large for your mail server to forward.
- **Method 2:** Raise a support request via our support site on the Internet, as described below. Create a support zip file via your Confluence Administration Console, as described below, and attach the zip file to the support request.

Method 1: Using the Support Request Form via the Confluence Administration Console

The advantage of this method is that it is convenient. The disadvantage is that your mail may not be forwarded correctly due to a problem (for example, the zip file is too large) or due to a security restriction on your mail server.

You can also use this method to append system information to an existing support request.

To submit a support request via the Confluence Administration Console:
1. Log in as a user with Confluence Administrator or System Administrator permissions.
2. Choose the cog icon at top right of the screen, then choose Confluence Admin.
3. Make sure that SMTP email is set up on your Confluence site and your mail server allows zip files.
5. Choose the ‘Support Request’ tab.
6. Provide as much information as possible, following these guidelines:
   - ‘Contact Email’ – This will default to the email address of the logged-in user.
     Note: This email address will be used to find your support account on the Atlassian Support System. If no matching account is found, a new account will be created. Confluence will also send all further notifications and updates to this address.
   - ‘Summary’ – Enter a short and meaningful description of the problem.
   - ‘Description’ – Enter as much information as possible, including any error messages that are appearing and any steps the support team can take to reproduce the problem.
7. In the section titled ‘Support Data to Attach’, select the types of additional information you would like to be included in a zip file that will be attached to your support request.
8. Choose the ‘Send’ button.
9. Confluence will submit your request via email to the Atlassian support site. If you do not already have a support account, Confluence will automatically request one for you. The submitted request will include all the system and environment information which you see on the support request form. It will also include a zipped copy of your Confluence log file. Refer to Working with Confluence Logs for information about the log files.
   Log files can be very big. It is possible that your email server may bounce the message if it is too large. With the default log4j configuration, the log file could be up to 20Mb in size. If you have customised the log settings, the maximum size could be even larger. Please check whether the email message has been successfully sent, and consult your email administrator if you need special provisions for this email message.
10. Once you have submitted your support request, you will receive email updates about its progress. These emails will give you the support request number.

You can view the status of your support request and add any additional information required by visiting the Atlassian Support System at any time.

Screenshot: The support request form on the Confluence Administration Console
Method 2 Raising a Support Request via the Internet

If your Confluence instance is not configured with SMTP mail or your Confluence instance is not running, you can raise a support request via the Atlassian Support System on the Internet.

To raise a support request via the Internet:

1. If you do not already have a free Atlassian support account, create one here.
2. Log in to https://support.atlassian.com and select ‘Create New Issue’.
3. Lodge a detailed description of your problem in the new support request.
4. Fill in all applicable information about your system, such as application server, database, etc.
5. If Confluence is running, go to the ‘System Information’ screen in your Administration Console and copy the text of your system information into the request.
6. Create a support zip file, as described below to attach to the request. If your instance does not start up, refer to Working with Confluence Logs for information about the log files.
7. If your problem concerns user management or performance, please take a look at the additional requirements in Requesting Support for External User Management or Requesting Performance Support.
8. Once your request is lodged, wait to be notified by email of updates.

Creating a Support Zip File via the Confluence Administration Console

We recommend that you attach a support zip file to every interaction with the Atlassian support team. You can use this method to append system information to an existing support request. The tool described below will also dump your system information to the logs before zipping them.

**To create a support zip file via the Confluence Administration Console:**

1. Log in as a user with System Administrator or Confluence Administrator permissions.
2. Go to the Administration Console and choose 'Atlassian Support Tools' under 'Administration' in the left-hand panel. Choose 'Support Zip'. Ensure that everything is checked, then choose the 'Create' button.
3. Confluence will create the support zip file and display its location on the screen. Log in to the Confluence server to retrieve the file.
4. Attach the zip file to the support case you raised on our support system, as described above.

**Screenshot: Creating a support zip file**

![Support Zip]

Logging a Bug Report

If you have found a bug, the easiest way to report it is to:

- Create numbered instructions on how to reproduce the bug.
- Log it as a support request, as described above.
- The Atlassian support team will confirm your bug and lodge a bug report.

Alternatively, you can check to see if anyone else has reported the bug, then log a bug report yourself.

**To log a bug report:**

1. Go to the Confluence issue tracker.
2. Type keywords for your problem into the search box on the left under 'Query'.
3. Choose 'Search' to find any existing bug reports that match your problem.
4. Read through the summaries of the bugs shown. If any summary describes your problem, you may wish to set a watch to be notified of updates.
5. If there are no existing bug reports that match your problem, log the new bug in the issue tracker. Include information on how to duplicate the problem.
6. Sometimes it may be useful to include the result of the 500 error page, which you will find at this location:

   https://<domain><host>:<port>/500page.jsp

7. Once your issue is lodged, wait to be notified by email of updates.

Content Anonymiser for Data Backups

Atlassian may request a copy of the entities.xml file from a customer’s exported zip file (backup file), in order to diagnose database corruption or to find a bug in Confluence.

If your data is confidential, you can run an anonymiser program over your entities.xml file to remove all your data and leaving only the structure of the export.

Usage

To run the Content Anonymiser on your backup file:

1. Download the anonymiser JAR (attached to this page).
2. Extract the entities.xml file from your zipped backup file to the same directory as the JAR.
3. Use the command prompt to go to the directory where all three files are located.
4. To create cleaned.xml, run the command

   java -jar confluence-export-cleaner-1.1-jar-with-dependencies.jar entities.xml cleaned.xml

5. Re-ZIP cleaned.xml with its exportDescriptor.properties to ensure we (eg. Atlassian Support) knows exactly which version of Confluence does the XML backup exported from.

How it works

The Content Anonymiser program replaces all the text content in file entities.xml with 'x' characters. For example, the word "Atlassian" will be transformed to "xxxxxxxxxx". The resulting cleaned.xml file is expected to have the same size as the original file.

This release of the Content Anonymiser uses STX, a fast and efficient XML transformation technology. It should not require a lot of memory to run, even for a large backup.

Development

For Atlassian developers:

- Source code.
- Maven repository.

Enabling Detailed SQL Logging

Confluence uses the open source persistence framework Hibernate. This page tells you how to configure Confluence’s logging to report individual SQL requests that are sent to the database by Hibernate. It is useful for troubleshooting the following events:
- XML site backups that fail to import.
- Exceptions caused by an illegal database operation.

Enable SQL logging via the Administration Console
Since the 2.7 release, you can also enable SQL logging at runtime via the Administration Console — read the instructions. This runtime option does not allow you to enable logging of SQL parameter values.

To enable detailed SQL logging in Confluence, you need to modify `log4j.properties`, located in `confluence/WEB-INF/classes`.

After you have enabled hibernate logging, please replicate the action that is causing the error in the first place. This is the best way to ensure that the Confluence log file contains relevant SQL logging.

If you require support assistance with a database related problem, it is advisable to enable detailed SQL logging before sending us the log files. This will assist us in determining what SQL queries were running during the reported problem.

If the entries mentioned below are not defined in the `log4j.properties` file, you can manually add the entries to the file in the 'Hibernate Logging' section.

To Log SQL Queries
Stop Confluence, then change the following lines in `log4j.properties` from ERROR to DEBUG:

```
## log hibernate prepared statements/SQL queries (equivalent to setting
'hibernate.show_sql' to 'true')
## DEBUG, TRACE or ALL is required to see query strings
log4j.logger.net.sf.hibernate.SQL=DEBUG
```

To Log SQL Queries with Parameters
1. Stop Confluence
2. Uncomment the following lines in `log4j.properties`:

```
## log hibernate prepared statement parameter values. Note: due to
  caching in net.sf.hibernate.type.NullableType, requires restart to
take effect
## TRACE or ALL is required to see parameter values
## Note that log4j.appender.confluencelog.Threshold (or other
  appenders) also must be TRACE or ALL to see any trace messages in
the logs
log4j.logger.net.sf.hibernate.type=TRACE
```

3. Change the following lines in `log4j.properties` from DEBUG to TRACE:

```
log4j.appender.confluencelog.Threshold=TRACE
```

4. Restart Confluence

This needs to be done along with the changes to log SQL queries above (whether by the UI or by modifying the properties file).
**To Disable Batched Updates for Simpler Debugging**

Stop Confluence, then edit `databaseSubsystemContext.xml`:

- In Confluence 2.5.x and earlier, the `databaseSubsystemContext.xml` file is at `confluence/WEB-INF/classes/databaseSubsystemContext.xml`
- From Confluence 2.6.x, the `databaseSubsystemContext.xml` file is available in the `confluence-2.6.0.jar` file located in the `<confluence-install>/WEB-INF/lib` directory.

Uncomment the `<prop>` line in the following location:

```xml
<!-- it can be useful to disable batching during debugging, as HSQLDB doesn't report the exact statement which fails in batch mode -->
<prop key="hibernate.jdbc.batch_size">0</prop>
```

**RELATED TOPICS**

- Troubleshooting SQL exceptions
- Working with Confluence Logs

**Generating a Heap Dump**

Sometimes you may see that Confluence is holding onto a chunk of memory over a period of time (for example, tenured space is increasing close to Xmx). In such a situation, it is useful to find out what is stacking up in the memory by analysing the heap dump.

**On this page:**

- Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error
- Manually Generating a Heap Dump when Confluence Stops Responding
- Submitting a Heap Dump to Atlassian Support

**Tips when getting a heap dump**

If you have a large Xmx size, please limit your Xmx size to 1024m. This will help to keep Confluence heap dump smaller while still containing sufficient information to analyse it.

**Automatically Generating a Heap Dump when Confluence Hits OutOfMemory Error**

Typically, we would like to analyse the heap dump produced when Confluence died from an OutOfMemory Error. For this, you can add additional JVM parameters like below:

```
-XX:+HeapDumpOnOutOfMemoryError -XX:HeapDumpPath=<path to this heap dump file>
```

If you do not set the HeapDumpPath parameter, by default the heap dump will be saved in the folder where Tomcat is run from.

If you are setting these parameters in the Windows registry (when running Confluence on Windows as a service), be sure that each parameter is on its own line.

**Manually Generating a Heap Dump when Confluence Stops Responding**

It is also possible to get a heap dump manually using a JDK bundled tool called `jmap`, although we recommend that you use the automatic method above for best result.

**For Linux/Solaris-based Operating Systems:**

Please execute the following command on Linux OS:
$JAVA_HOME/bin/jmap -dump:format=b,file=heap.bin <pid>

For Windows:
Please find your Confluence process ID (see below) and then execute the command below on a Windows command line:

%JAVA_HOME%\bin\jmap -dump:format=b,file=heap.bin <pid>

To find out the process ID for your Java process in Windows, you can use Process Explorer from Microsoft. This is what it looks like:

Using Process Explorer to find your Tomcat process ID

Tomcat run from startup.bat script
Tomcat run as Windows Service

Submitting a Heap Dump to Atlassian Support
Please zip the file and then send it to Atlassian Support.

RELATED TOPICS
Getting Java Crash Log File
Memory Usage and Requirements
Garbage Collector Performance Issues
Generating a Thread Dump
How to Fix Out of Memory Errors by Increasing Available Memory

Generating a Thread Dump

- Stack Traces and Security
- Method 1: Generating a Thread DumpExternally
- Method 2: Generating a Thread Dump via the Administration Console

If Confluence is performing poorly, behaving unexpectedly or stops responding and you can generate a thread dump to help diagnose the cause of the problem. Furthermore, if you wish to contact Atlassian Support for assistance about it, you should include a thread dump in your support enquiry to help the Support team determine the cause of the problem.

A thread dump will show the state of each thread in the JVM, including a stack trace. Thread dumps are only useful if they are taken at the appropriate time. They normally need to be taken at or close to the time when the application is experiencing problems.

Information about what locks are being held and waited upon by a thread are not produced by Confluence's Thread Dump tool. If you require this information, then generate a thread dump externally.
Stack Traces and Security

To help debug support cases and provide legendary support, Confluence provides stack traces through the web interface when an error occurs. These stack traces include information about what Confluence was doing at the time, and some information about your deployment server.

Only non-personal information is supplied such as operating system and version and Java version. With proper network security, this is not enough information to be considered dangerous. No usernames or passwords are included.

Method 1: Generating a Thread Dump Externally

If Confluence stops responding or you require information on locks being held and waited upon by threads, then use one of methods described in Generating a Thread Dump Externally.

Atlassian support may ask you to use this method if a thread dump generated using method 2 does not include enough information to diagnose the problem.

Method 2: Generating a Thread Dump via the Administration Console

For Confluence 2.10.3 or below
This feature was introduced in Confluence 3.0. If you are using a prior version then please consult this documentation on Generating a Thread Dump Externally.

To generate a Thread Dump from the Administration Console:

1. Choose the cog icon at top right of the screen, then choose Confluence Admin.
2. Select 'Thread Dump' in the left-hand panel.
3. Click the 'Generate Now' button in the centre of the page. The output is displayed in a new text box that appears just below the button.
4. Copy the contents of the thread dump in the text box and save it to a text file.

Screenshot: Example of a generated thread dump from the Confluence administration console
Scheduling Thread Dumps via the Administration Console

If you were asked by Atlassian Technical Support to generate regular thread dumps, please set the Thread Dump Scheduler to take 2 to 3 thread dumps with a 30 seconds time interval in between so the Support team can observe any important patterns that may assist with the diagnosis of the problem. Attach the log file to the support ticket.

Example: Scheduling thread dumps from the Confluence administration console

Generating a Thread DumpExternally

If Confluence stops responding and you cannot access its integrated Generate Thread Dump feature, it is possible to create thread dumps outside the application. External thread dumps are also useful if you require information on locks being held or waited upon by threads.

Take Multiple Thread Dumps

Typically you’ll want to take several dumps about 10 seconds apart, in which case you can generate several dumps and output the stack traces to a single file as follows:

Generating a Thread Dump on Linux, including Solaris and other Unixes

1. Identify the java process that Confluence is running in.: This can be achieved by running a command similar to:

   \[ ps -ef | grep java. \]

2. Find the process ID of the JVM and use the ps command to get list of all processes:

   \[ kill -3 <pid> \]

   This will not kill your server (so long as you included the "-3" option, no space in between).

The thread dump will be printed to Confluence’s standard output (catalina.out).

Generating Thread Dumps on Windows

From the console

If you are running Confluence through a console, rather than as a service, you can click on the console and press <CTRL> + BREAK

Using jstack
The JDK ships with a tool named **jstack** for generating thread dumps.

1. Identify the process. Launch the task manager by, pressing **Ctrl + Shift + Esc** and find the Process ID of the Java (Confluence) process. You may need to add the PID column using **View -> Select Columns ...**
2. Run `jstack <pid>` to Capture a Single Thread Dump. This command will take one thread dump of the process id `<pid>`, in this case the pid is 22668:

   
   ```
   adam@track:~$ jstack -l 22668 > threaddump.txt
   ```

   This will output a file called threaddump.txt to your current directory.

   **Common issues with jstack:**
   - You must run jstack as the same user that is running Confluence
   - If the jstack executable is not in your $PATH, then please look for it in your `<JDK_HOME>/bin` directory
   - If you receive `java.lang.NoClassDefFoundError: sun/tools/jstack/JStack` check that tools.jar is present in your JDK's lib directory. If it is not, download a full version of the JDK.
   - If you see the following message: 'Not enough storage is available to process this command,' see this article.

**Output**

Standard logging for Confluence Stand-alone is sent to the atlassian-confluence.log, in the confluence-home directory, not in the confluence-install directory. Thread dumps are an exception since they dump the threads of the entire application server - they'll appear in the catalina.out file in the application directory's logs folder. You can search for the term "thread dump" in the log file for the beginning of the dump. Submit this along with the atlassian-confluence.log in your support ticket.

**Thread Dump Analysis Tools**

- **Samurai**
- **Thread Dump Analyzer TDA** TDA 1.0 Final can be obtained from the [java.net](http://java.net)

**Getting Java Crash Log File**

If you discovered that Confluence died without manual intervention, there may be something goes wrong during a local Java session. Java will produce a log file that looks like the following: hs_err_pid20929.log.

The location of this log file is usually in the directory where Tomcat is run eg. /bin folder. For Windows Services, it should be located in where Windows Services are run, eg. c:\Windows\System32 if you are on 32 bit.

**Useful VM Option**

If using Java 6, it's possible to define the path to the hs_err_pid file.

Add the following JVM Parameter to your existing ones:

   ```
   -XX:ErrorFile=./hs_err_pid<pid>.log
   ```

**RELEVANT TOPICS**

Generating a Heap Dump
Java Crashes

Profiling using the YourKit Plugin

There is a plugin for Confluence 2.2 and later which allows easy profiling using the YourKit profiler. No license is required to generate a memory or CPU snapshot, but you will need at least an evaluation license to analyse the results.

On this page:

- Configuring YourKit in your JVM
  - Windows Configuration
  - Linux/Mac OS X Configuration
- Performance Impact
- Installing the YourKit Plugin
- Plugin Source Code

Configuring YourKit in your JVM

Download YourKit 6.0 for your platform and follow the installation instructions to install it.

⚠️ Note: YourKit version 7 is not compatible with the Confluence yourkit plugin.

The following instructions apply to Confluence and Tomcat installations with the Oracle (previously Sun) JDK. They should be easily applicable to other application servers and JVMs, however. The YourKit documentation covers this in more detail.

Windows Configuration

On Windows, add to your PATH environment variable the bin/win32/ directory underneath the YourKit installation directory. For example, you might add "C:\Program Files\YourKit Java Profiler 6.0.12\bin\win32" to your PATH, via Control Panel, System, Advanced, Environment Variables.

To configure Confluence's JVM to use the YourKit agent, you need to add a parameter to JAVA_OPTS in the bin/setenv.bat file in your Confluence application directory. This file controls the startup parameters for Tomcat, so you'll need to restart it after making the changes.

Add the 'agentlib' parameter to the end like this:

```
set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx256m -agentlib:yjpagent
```

Linux/Mac OS X Configuration

On Unix-based systems, include the installation directory in the library path environment variable, as shown below:

- For the Mac: export DYLD_LIBRARY_PATH=$DYLD_LIBRARY_PATH:/path/to/yourKitAgent
- For other Unix-based systems: export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/path/to/yourKitAgent

In general, to configure the JDK, you add the agentlib parameter:

```
java -agentlib:yjpagent ...
```

You can add this to Tomcat’s bin/setenv.sh like this:
JAVA_OPTS="-Xms128m -Xmx256m $JAVA_OPTS -Djava.awt.headless=true -agentlib:yjpagent "

Performance Impact

Running YourKit can have detrimental effects on performance.

To minimize performance problems use the following modifications to the agentlib parameter:

-agentlib:yjpagent=disablecounts,disablealloc,disablej2ee

See also Profiling overhead: how to reduce or avoid in the YourKit documentation.

Installing the YourKit Plugin

Download the plugin and upload it into Confluence through the Administration, Plugins page.

A new menu option, "YourKit Profiling" will appear under the 'Administration' heading. Click it and you should see the options to take a memory or CPU snapshot.

This profiler dump will be saved to a local temp directory, and the path shown once it is complete. For the CPU snapshot, this will take at least 30 seconds. For the memory snapshot, 10-15 seconds.

Screenshot: You can take a memory or CPU snapshot

Why would I do this?

Analysing a profiler dump enables Atlassian Support (or you, if you are interested) to see exactly what is happening in your application: what classes are using the memory, what is using CPU and so on. This can help us debug tricky performance problems which would otherwise be impossible to analyse remotely.

Take a CPU snapshot if:

- Confluence is sometimes unresponsive
- Pages take a long time to load
- Confluence's CPU usage is peaking.

Take a memory snapshot if:

- Confluence's memory usage is higher than you expect
- You are getting OutOfMemoryError's in your logs.

i If you run into situations where Confluence is unresponsive and you are not able to trigger a memory snapshot, please ensure that you start Confluence with the onexit=memory parameter in the JVM options (as in the example below) and simply shut down Confluence. Before shutting down a memory snapshot will be created.
Plugin Source Code

The source code for this Confluence plugin is available from Subversion and browseable in Fisheye. The JAR produced by `mvn package` includes a copy of the YJP redistributable bundled in META-INF/lib/.

Contributing to the Confluence Documentation

Would you like to share your Confluence hints, tips and techniques with us and with other Confluence users? We welcome your contributions.

On this page:

- Tweeting your Hints and Tips – Tips via Twitter
- Blogging your Technical Tips and Guides – Tips of the Trade
- Contributing Documentation in Other Languages
- Updating the Documentation Itself
  - Getting Permission to Update the Documentation
  - Our Style Guide
  - How we Manage Community Updates

Tweeting your Hints and Tips – Tips via Twitter

Do you have hints and tips about Confluence wiki to share with the world? Even more, would you like to see your tips appear on a page in the Atlassian documentation? Just tweet with the hash tag "#ConfluenceTips" and see your hint appear in our documentation. Then grab a [badge for your blog!](#) More...

Blogging your Technical Tips and Guides – Tips of the Trade

Have you written a blog post describing a specific configuration of Confluence or a neat trick that you have discovered? Let us know, and we will link to your blog from our documentation. More....

Contributing Documentation in Other Languages

Have you written a guide to Confluence in a language other than English, or translated one of our guides? Let us know, and we will link to your guide from our documentation. More....

Updating the Documentation Itself

Have you found a mistake in the documentation, or do you have a small addition that would be so easy to add yourself rather than asking us to do it? You can update the documentation page directly.

Getting Permission to Update the Documentation

Please submit the [Atlassian Contributor License Agreement](#).

Our Style Guide

Please read our short [guidelines for authors](#).

How we Manage Community Updates

Here is a quick guide to how we manage community contributions to our documentation and the copyright that applies to the documentation:

- Monitoring by technical writers. The Atlassian technical writers monitor the updates to the
documentation spaces, using RSS feeds and watching the spaces. If someone makes an update that needs some attention from us, we will make the necessary changes.

- **Wiki permissions.** We use wiki permissions to determine who can edit the documentation spaces. We ask people to sign the Atlassian Contributor License Agreement (ACLA) and submit it to us. That allows us to verify that the applicant is a real person. Then we give them permission to update the documentation.

- **Copyright.** The Atlassian documentation is published under a Creative Commons CC BY license. Specifically, we use a Creative Commons Attribution 2.5 Australia License. This means that anyone can copy, distribute and adapt our documentation provided they acknowledge the source of the documentation. The CC BY license is shown in the footer of every page, so that anyone who contributes to our documentation knows that their contribution falls under the same copyright.

**RELATED TOPICS**

Tips via Twitter  
Tips of the Trade  
Author Guidelines  
Atlassian Contributor License Agreement

**Tips of the Trade**

Below are some links to external blog posts, videos and articles containing technical tips and instructions on setting up and using Confluence. This page presents an opportunity for customers and community authors to share information and experiences.

The references here are specific to Confluence wiki and are technical 'how to' guides written by bloggers who use Confluence. For general information on wiki comparisons, wiki adoption, best practices and business cases, please refer to the Atlassian website and to our evaluator resources.

⚠️ **Please be aware that these are external blogs and articles.**

Most of the links point to external sites, and some of the information is relevant to a specific release of Confluence. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of Confluence. Unless explicitly stated, Atlassian does not offer support for third-party extensions or plugins. The information in the linked blog posts has not been tested or reviewed by Atlassian. We recommend that you test all solutions on a test server before trying them on your production site.

On this page:

- DGC IV: Confluence Upgrades  
- Tracking Atlassian Confluence usage with Google Analytics  
- Moving Confluence from Windows to (Ubuntu) Linux  
- Plugging Memory Leaks in Confluence  
- Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format  
- Using a wiki for technical documentation  
- Wiki docs --- release management  
- Using a wiki for online help  
- Content re-use on a wiki  
- Starting out with your technical documentation on a wiki  
- Universal Wiki Converter - Now with SSL Support  
- Confluence wiki to Eclipse Help (and DocBook, PDF) the easy way – Scroll FTW  
- Playing with DITA2Confluence part 1 and part 2  
- Converting from FrameMaker to Confluence
- The Confluence Reporting HOWTO
- Drawing diagrams on a wiki page
- Organisation is Key
- Creating FAQs
- Styling Tabs in Confluence 2.10
- How to determine the context your macro is being rendered in
- Video: Confluence overview
- Video: Macro browser

## Administration

### DGC IV: Confluence Upgrades
- By: Igor Minar, on 'Igor Minar's Blog'
- About: Upgrading Confluence, on relatively large public-facing Confluence sites
- Date: 25 July 2010
- Related documentation: Upgrading Confluence

### Tracking Atlassian Confluence usage with Google Analytics
And Using the Google Analytics Javascript API to show pageviews from Atlassian Confluence
- By: David Simpson, on blog 'david simpson'
- About: Setting up Google Analytics for Confluence
- Date: 18 March 2009 and 11 September 2009
- Related documentation:
  - How Do I Get More Statistics from Confluence?
  - How to Enable User Access Logging

### Moving Confluence from Windows to (Ubuntu) Linux
- By: Ricky Sheaves, on blog 'flimflam' (calebscreek)
- About: Moving Confluence to its own dedicated environment: Ubuntu 8.04 with a MySQL backend
- Date: 19 October 2008
- Related documentation: Migrating Confluence Between Servers

### Plugging Memory Leaks in Confluence
- By: Don Willis, on blog 'Atlassian developer blog'
- About: Identifying memory leaks in Confluence and fixing them
- Date: 1 October 1007
- Related documentation: Performance Tuning

## Confluence for Technical Documentation

**Advanced tips on the Confluence 4 editor, wiki markup and the XML storage format**
Using a wiki for technical documentation

- By: Sarah Maddox, on blog 'ffeathers'
- About:
  - Overview — what a wiki is and does.
  - Workflow — draft, review, publish.
  - Tracking — page history, notification of updates, reverting to a previous version.
  - Permissions.
  - Adding structure to your documentation — table of contents, left-hand navigation bar, logical page ordering, content re-use.
  - Release management on a wiki.
  - Using spaces for version control.
  - How a wiki is useful in agile development.
- Date: 21 November 2009

Wiki docs --- release management

- By: Sarah Maddox, on blog 'ffeathers'
- Date: 17 November 2007
- About:
  - Using spaces for version control
  - Release management on a wiki
  - Archiving documentation on a wiki
- Related documentation: The Copy Space plugin

Using a wiki for online help

- By: Sarah Maddox, on the 'Atlassian Blog'
- About: Pointing online help links to version-controlled wiki documentation spaces
- Date: 13 December 2007

Content re-use on a wiki

- By: Sarah Maddox, on blog 'ffeathers'
- About: Content reuse and defining an inclusions library
- Related documentation:
  - Excerpt Macro
  - Excerpt Include Macro
  - Include Page Macro
- Date: 29 July 2008

Starting out with your technical documentation on a wiki

- By: Sarah Maddox, on blog 'ffeathers'
- About: Choosing your wiki and planning your documentation
- Date: 4 November 2007
### Content Conversion

**Universal Wiki Converter - Now with SSL Support**
- By: Laura Kolker, on the 'Atlassian Blog'
- About: Configuring the **UWC** for two new features:
  - A Trac Converter module
  - SSL support
- Date: 6 March 2009
- Related documentation: [Importing Content from Another Wiki](#)

**Confluence wiki to Eclipse Help (and DocBook, PDF) the easy way – Scroll FTW**
- By: Sarah Maddox, on blog 'ffeathers'
- About: Using the Scroll Wiki Exporter plugin to convert Confluence content to Eclipse Help, DocBook XML and PDF
- Date and Confluence version: 8 May 2010; Confluence 3.2.1
- Related documentation: The [Scroll Wiki Exporter plugin](#)

**Playing with DITA2Confluence part 1 and part 2**
- By: Sarah Maddox, on blog 'ffeathers'
- About: Using the [DITA2Confluence](#) tool to convert documentation from DITA XML to Confluence pages
- Date and Confluence version: October 2008; Confluence 2.9
- Related documentation: The [DITA2wiki project on SourceForge](#)

**Converting from FrameMaker to Confluence**
- By: David Stephensen, in the Confluence User Community wiki space
- About: Converting content from native FrameMaker format to Confluence wiki using Mif2Go, FrameScript and Far.
- Date and Confluence version: 3 June 2010; Confluence 3.1
Usage Tips

The Confluence Reporting HOWTO

- By: Jim Severino and John Rotenstein, Atlassian Internal Systems, on the 'Atlassian Blog'
- About:
  - Using Confluence as a reporting and business intelligence tool
- Date and Confluence version: August 2009; Confluence 3.0
- Related documentation: The Confluence Reporting HOWTO

Drawing diagrams on a wiki page

- By: Sarah Maddox, on blog 'ffeathers'
- About:
  - Using the Gliffy plugin to draw diagrams on a Confluence page
  - Links to other tools for displaying flowcharts, graphs etc based on editable content in the wiki page
- Date and Confluence version: 4 July 2009; Confluence 3.0
- Related documentation: The Gliffy plugin

Organisation is Key

- By: Matt Hodges, on the 'Atlassian Blog'
- About: Designing the structure of a Confluence space using an inclusions library, macros and tabbed pages
- Date and Confluence version: 17 March 2009; Confluence 2.10

Creating FAQs

- By: Matt Hodges, on the 'Atlassian Blog'
- About: Designing the FAQ (frequently asked questions) section of your Confluence space
- Date and Confluence version: 2 April 2009; Confluence 2.10

Styling and Customisation

Styling Tabs in Confluence 2.10

- By: Jens Schumacher, on the 'Atlassian Blog'
- About: Using CSS to change the look of the tabs in Confluence
- Date and Confluence version: 12 January 2009; Confluence 2.10
- Related documentation: Styling Confluence with CSS

Development

How to determine the context your macro is being rendered in

- By: Cheryl Jerozal, on the 'Atlassian Blog'
- About: Discovering find out the current render context (including PDF document, feed reader, email notification, etc) from within your macro
- Date and Confluence version: 25 June 2009; Confluence 3.0
- Related documentation: Macro Module
Videos

To speed up the loading of the page and ensure correct export to PDF, HTML and XML formats, we will just link to the videos rather than including them into the wiki page.

Video: Confluence overview

- By: Matt Hodges, on the Atlassian website
- About:
  - Confluence Overview
  - Create and edit
  - Tracking updates and blogs
  - Security and permissions
  - Attachments and the Office Connector
  - Search and discover
  - Plugins
- Date and Confluence version: July 2009; Confluence 3.0
- Related documentation: Confluence documentation

Video: Macro browser

- By: David Cook, on the ‘Atlassian Blog’
- About: Using the new Confluence macro browser in Confluence 3.0
- Date and Confluence version: 18 June 2009; Confluence 3.0
- Related documentation: Working with Macros

Have you written a technical tip for Confluence?
Add a comment to this page, linking to your blog post or article. We will include it if the content fits the requirements of this page.

Feedback?
Your first port of call should be the author of the linked blog post. If you want to let us know how useful (or otherwise) a linked post is, please add a comment to this page.

Other Sources of Information
Confluence Documentation
Evaluator Resources
Atlassian Website
Atlassian Answers
Atlassian Blog
Confluence Plugins

Tips via Twitter

This page displays a continuously-updated list of tweets from Atlassians and others, giving hints and tips about Confluence wiki. Anyone can write a tip and have it show on this page. The live Twitter stream shows recent tweets containing the word ‘ConfluenceTips’ or the tag ‘#ConfluenceTips’. We also include tweets from or to ‘@ConfluenceTips’.

Want to join in? Just tweet with the word ‘#ConfluenceTips’ somewhere in the text. Then grab a badge for your blog. 😊

- Viewing the Tweets in Twitter
- Adding a Confluence Tweets Badge to your Blog
• Adding your own Tip

⚠️ Please be aware that anyone can tweet anything.
Atlassian does not monitor the tips in this Twitter stream. Anyone can Tweet anything they like. We display these tips because we believe most people will do the right thing and tweet good tweets. Please check that a tweet is relevant to you before following its advice.

Viewing the Tweets in Twitter
If you prefer, you can view the search in Twitter itself.

Adding a Confluence Tweets Badge to your Blog
Would you like to let other people know that you Tweet your Confluence tips? Use the code samples below to add a badge to your blog or another social site.

Choose one of these options to add the badge:

• Badge only
  Copy the code below and paste it into your blog to include just the badge with a link to this documentation page:


This is what you will get:

![I tweet my Confluence tips. Do you?](http://atlss.in/ConfluenceTips)

• Badge and words
  Copy the code below and paste it into your blog to include the badge and some words encouraging other people to tweet too:
Adding your own Tip

Quick guide to tweeting a tip

Just tweet with the word '#ConfluenceTips' somewhere in the text. Your tweet will appear in the Twitter stream on this page.

Would you like to share your information and experiences via Twitter and have your tweet appear on this page? Awesome! Here are the full instructions.

To tweet a Confluence tip,

1. Go to Twitter.com in your browser.
2. If you already have a Twitter username, sign in to Twitter now. If you do not have a Twitter username, sign up for one and follow the Twitter instructions to confirm your account details.
3. Enter your tip into the Twitter text box labelled 'What's happening'. Note that your tip can contain a maximum of 140 characters:
   - Type the words for your tip.
   - If you want people to click through to a web page to see more details about your tip, enter a web address. If the web address is long, you can convert it to a shortened address at bit.ly or one of the other web services that offer URL shortening.
   - Include the key word #ConfluenceTips somewhere in your tweet. This will ensure that your tip appears in the Twitter stream on this documentation page.
4. Click 'Tweet' to send your tweet.
5. Refresh this documentation page to see your tweet appear. It may take a few minutes, depending on the volume of tweets that Twitter is handling.

Other Sources of Information

Tips of the Trade (Not applicable to Confluence OnDemand.)

Confluence Documentation
Evaluator Resources
Atlassian Website
Atlassian Answers
Atlassian Blog
Confluence Plugins

Confluence Documentation in Other Languages

Below are some links to Confluence documentation written in other languages. In some cases, the documentation may be a translation of the English documentation. In other cases, the documentation is an alternative guide written from scratch in another language. This page presents an opportunity for customers and community authors to share documentation that they have written in other languages.

⚠️ Please be aware that these are external guides.

Most of the links point to external sites, and some of the information is relevant to a specific release of Confluence. Atlassian provides these links because the information is useful and relevant at the time it was written. Please check carefully whether the information is still relevant when you read it, and whether it is relevant to your version of Confluence. The information in the linked guides has not been tested or reviewed by Atlassian.

On this page:

- Tutoriel – Travailler avec des images dans Confluence
- Deutsches Handbuch für Confluence
- Confluence

<table>
<thead>
<tr>
<th>French</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tutoriel – Travailler avec des images dans Confluence</td>
</tr>
<tr>
<td>By: Yann Debonnel on the TechSolCom blog</td>
</tr>
<tr>
<td>Topic: Overview of using images in Confluence, a translation of a guide developed during our doc sprint</td>
</tr>
<tr>
<td>Confluence version: Based on Confluence 3.4</td>
</tr>
<tr>
<td>Date added: 9 December 2010</td>
</tr>
<tr>
<td>Latest related English documentation: Displaying Images</td>
</tr>
</tbody>
</table>
Adding Your Own Guide to this Page

Have you written a guide for Confluence in another language? Add a comment to this page, linking to your guide. We will include it if the content fits the requirements of this page.

Giving Feedback about One of the Guides

If you have feedback on one of the guides listed above, please give the feedback to the author of the linked guide.

If you want to let us know how useful (or otherwise) one of these guides is, please add a comment to this page.

Other Sources of Information

Confluence documentation
Atlassian website
Atlassian blog
Confluence plugins